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Welcome to Sage 100 Contractor
Sage 100 Contractor—A better way to run your business
Welcome to Sage 100 Contractor. Sage 100 Contractor is an integrated, construction-specific, estimating, accounting, and
project management software solution. Whether you are a general contractor, a subcontractor, or service contractor, Sage
100 Contractor manages your business using one system.

Sage 100 Contractor provides many features that are beneficial for customers with complex environments that may include
remote connections, many simultaneous users, and/or multiple companies.

What is New in the Latest Release?
For detailed information about program enhancements, fixes, known issues, and comments for this release, refer to the
Release Notes. To open the Release Notes installed on your system, click Home & Resources tab > Printable
Documentation > Release Notes or Resources > Printable Documentation > Release Notes if you have Activity Centers
hidden.

About Sage Advisor Update
Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100
Contractor. You can also use Sage Advisor Update to download updates for your Sage products.

IMPORTANT: Youmust be connected to the Internet to use Sage Advisor Update.

Double-click the Sage Advisor Update icon in yourWindows system tray at any time to:

l View andmanually check for updates that are available for your Sage products.

l Specify the frequency and time of day to check for updates.

l Specify a location on your computer to download updates.

l Set up email notifications.

l View update history for your Sageprograms.

l View the status of your Sage Business Care plan.

You can also open Sage Advisor Update by clickingStart > Programs > Sage > Sage Advisor Update.

For help on using Sage Advisor Update, see the help for that application.

TIP: Use theCustomize settings in theWindows system tray tomake sure you can view the Sage Advisor Update
icon and notifications from the System Tray in your Taskbar.

About Sage Payment Solutions
Using Sage Payment Solutions with Sage 100 Contractor saves you time, helps you get paid faster, and eliminates the



- 2 -

need to enter payment information twice. Simply enter your customer's check or credit card payment details once in Sage
100 Contractor, and the payment will be processed in Sage 100 Contractor and Sage Payment Solutions, in one easy step.

With the integration between Sage 100 Contractor and Sage Payment Solutions, you can process check and credit card
transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check
and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant
vault, protecting you from exposure to non-compliance penalties and credit card fraud.

In addition to providing integrated payment processing, Sage Payment Solutions also offers gift and loyalty card programs,
merchant cash advances and loans, non-profit and healthcare payment solutions, andmore.

To learnmore about Sage Payment Solutions, visit http://na.sage.com/us/sage-payment-solutions.

Electronic receipt processing workflow
1. Open a Sage Payment Solutions account, linking it to the bank account to which you want to Sage Payment

Solutions to deposit funds.

2. When you have received your Merchant ID andMerchant ID from Sage Payment Solutions, enter these credentials
on the Electronic Receipts Setup tab in the 7-2 Company Informationwindow. Also on this tab:

l Enter the Sage 100 Contractor ledger account that represents the bank account used to receive deposits
from Sage Payment Solutions.

l Specify whether to allow client credit card and bank account information to be securely stored in the Sage
Exchange Vault.

3. Use the 3-3-2 Electronic Receiptswindow to record and post credit card receipts and ACH checks in your Sage
100 Contractor general ledger and to transfer the payment details to Sage Exchange.

Alternatively, you can use the Electronic Receipts window to keep your Sage 100 Contractor ledger up to date by
recording and posting receipts that you entered directly in Sage Exchange using Sage Virtual Terminal,

4. Use the 1-3 Journal Transactionswindow to view the journal entry created for an electronic receipt, to view details
of an electronic receipt, and to print a copy of an electronic receipt.

About Sage Exchange
Sage Exchange is a secure payment-processing application that connects Sage 100 Contractor to Sage Payment
Solutions, allowing you to process credit card transactions and ACH checks (virtual checks) directly in Sage 100
Contractor without having to enter the transaction separately elsewhere.

NOTE: To process credit card receipts and ACH checks using Sage Exchange, and to store client credit card and
bank account information in the Sage Exchange Vault, youmust have a valid account with Sage Payment Solutions.

Installing the Sage Exchange Desktop

The required components of Sage Exchange are downloaded and installed as needed. For example, if themost recent
version of Sage Exchange is not already installed on your machine, you are prompted to download and install Sage
Exchange when you process an electronic receipt in the 3-3-2 Electronic Receiptswindow or validate your merchant
account credentials in the 7-2 Company Informationwindow.

The Sage Exchange Vault

Sage Exchange can also store clients' credit card details securely in an online vault system. This feature allows you to
save and reuse credit card information without storing it in your company database, keeping sensitive client information
secure, and reducing your exposure to credit card fraud.

http://na.sage.com/us/sage-payment-solutions
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You select the option to use the Sage Exchange Vault to store client credit card and bank account information on the
Electronic Receipts Setup tab in the 7-2 Company Informationwindow.

If a particular client does not want you to store this information, you can easily override the company setting by selecting
Do not use the Sage Exchange vault to store credit card and bank account information for the client on the Billing
and Payment tab in the 3-6 Receivable Clients window.

If you choose to store credit card or bank account information in the vault, you enter this information when you process an
electronic receipt for a client. This information is stored anonymously in the Sage Exchange Vault along with a vault ID that
is returned to Sage 100 Contractor.

Only the vault ID is associated with the client record in Sage 100 Contractor. The next time you process an electronic
receipt for that client, Sage Exchange uses the vault ID to identify the last credit card or bank account number used for the
client, or you can enter a different credit card or bank account number.

About Sage Virtual Terminal
Sage Virtual Terminal is a secure website that you can use to:

l Review, process, or void current transactions

l View reports on transactions, batches, and expiring credit cards

l Export reports to an Excel spreadsheet, PDF, or XPS file

l Print receipts for credit card transactions

l Settle credit card transactions

Each electronic receipt you process through Sage Exchange is recorded in Sage Virtual Terminal, so you can sign in
anytime to view current transaction information and reports.

Accessing Sage Virtual Terminal

When you sign up for a Sage Payment Solutions merchant account, you'll receive amerchant ID (VT ID), username, and
password that you can use to sign in to Sage Virtual Terminal.

To view reports on credit card transactions, batches, expiration, andmore for your Sage Payment Solutions merchant
account, sign in to Sage Virtual Terminal at https://www.sagepayments.net/virtualterminal.

For additional reporting resources, including 12-month summaries of transactions and chargebacks, daily credit card
batches for selected date ranges, andmonthly statement searches, you can also sign in to
https://www.myvirtualreports.com.

Finding Support and Resources

To learnmore about Sage Virtual Terminal and find training and support resources:

l Sign in to Sage Virtual Terminal and use the Helpmenu to find step-by-step tutorials.

l Visit the Self Service Portal at na.sage.com/sage-payment-solutions to search the Knowledge Base, browse
merchant forms and resources, or contact the Sage Payment Solutions support team.

https://www.sagepayments.net/virtualterminal
https://www.myvirtualreports.com/
http://na.sage.com/sage-payment-solutions
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Sage 100 Contractor Printed and Printable Documentation

About this Guide—Sage 100 Contractor User Guide
TheSage 100 Contractor User Guide provides extensive explanation of Sage 100 Contractor functions and tools as well as
hundreds of procedures for completing tasks.

After the introductory chapter, theSage 100 Contractor User Guide provides a chapter of information for each section of the
program, from “1-General Ledger” through “13-Review & Reporting.”

Following those 13 sections are a series of appendices, “A. Sage 100 Contractor Features” through “J. Working with Sage
Construction Anywhere.” These appendices provide support information, including a suggested timetable of office
procedures, information about federal, state, and local tax setup. A Glossary of Sage 100 Contractor terms follows the
appendices.

TheSage 100 Contractor User Guide is a printable
book version of the in-product Help.

Sage 100 Contractor and Your Business
Sage 100 Contractor and Your Business provides basic information about key relationships in your business and how they
interact with Sage 100 Contractor. This book also explores Sage 100 Contractor’s underlying concepts for working with
general ledger, accounts payable, accounts receivable, andmore. In addition, you will find detailed information about Sage
100 Contractor general operational features, accounting, analysis, payroll, accounts receivable, accounts payable, and
more.

Sage 100 Contractor Installation and License Administration Guide
TheSage 100 Contractor Installation and License Administration Guide provides explicit information about how to install
Sage 100 Contractor and set up the software in your specific environment. It also provides information on how to set up and
administer licensing. This guide is a “must read” for all systems administrators and business owners.

Sage 100 Contractor Product Overview
Sage 100 Contractor Product Overview provides background information to help you understand the core functionality of
Sage 100 Contractor and how to use it to manage your business. If you are new to Sage 100 Contractor, then we highly
recommend that you read the specific background information about the tasks that you will perform. If you are a company
owner or administrator, we recommend that you read all the information in this guide.

Sage 100 Contractor User Guide
 TheSage 100 Contractor User Guide is a printable-PDF version of the Sage 100 Contractor Help. You will find that the
Sage 100 Contractor User Guide is themost comprehensive yet. It provides extensive explanation of Sage 100 Contractor
functions and tools as well as hundreds of procedures for completing tasks.

Sage 100 Contractor Release Notes
TheRelease Notes document provides information about enhancements and previously reported issues in the software
that have been resolved for the current release.

It also provides, where applicable, information and comments about recently discovered issues that have not yet been
resolved before the latest software release.
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Printing Sage 100 Contractor Documentation
Links to the printable documentation are located under the Home& Resources tab > Printable Documentationmenu on the
Sage 100 Contractor main window.

IMPORTANT: Youmust have the Adobe®Reader® installed on your computer to view and print Sage 100
Contractor guides. To download this free software for viewing and printing documents in PDF format, visit
http://get.adobe.com/reader/

To print a Sage 100 Contractor printable document:
1 On themain window, click Home & Resources tab > Printable Documentation.

2 From themenu list, select the printable document you want to open. Adobe Reader opens and loads the guide.

3 From the Filemenu, click Print.

4 To print a section of pages, from the Adobe ReaderPrintwindow, select Print Range > Pages from, and type a range
of pages.

Customer Support and Resources

Before you contact Customer Support
Before you decide to contact the customer support call center, be sure to take advantage of the resources available to you.
These services are available 24 hours a day, 7 days a week.

Sage 100 Contractor Help
From anywhere within the software, you can access this comprehensive library of easy-to-find topics to learnmore about
specific procedures, topics, fields, or buttons.

Sage Knowledgebase
Depending on your Sage service plan, we also offer a web-based Sage Knowledgebase and online user community forums
at www.sagecre.com or through the in-product menu. Our staff maintains an extensive knowledge database of questions
and answers covering everything from frequently asked questions tomore complex problems and solutions. In addition, we
keep all product reference documentation available in the Knowledgebase. This online tool is the same tool we use in our
customer support call center to help answer your call.

To access the Technical Support Knowledgebase:
1 Click http://na.sage.com/us/sage-construction-and-real-estate.

2 On theWelcome page, in the left column, click Knowledgebase Search to open a list of products.

3 CompleteStep 1 by selecting Sage 100 Contractor from the list of products.

4 CompleteStep 2 by entering a search term in the box.

5 Click Search. The search results appear below the box.

Sage 100 Contractor InfoCenter
Find Sage 100 Contractor software notices and all the information you need, such as industry news, products, services,
new enhancements, tips, training, special offers andmore.

http://www.na.sage.com/sage-100-contractor/infocenter-news

http://get.adobe.com/reader/
http://www.sagecre.com/
http://www.sagecre.com/customerlogon
http://www.sagemasterbuilder.com/lp/InfoCenter-News
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Technical Documentation Available
A number of guides are included in the software. Access important release information such as system requirements,
software enhancements, quickly and easily. Click the Home& Resources tab > Printable Documentation or Resources >
Printable Documentation if you have Activity Centers hidden to see the available PDF files. You can also find the PDF files
in the Documentation folder in \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\.

Sage 100 Contractor Virtual Conference
Interact with and learn from Sage Construction and Real Estate senior leadership, product experts, and fellow customers
online. Get the latest information on product updates as well as network and share experiences with your peers. Check the
Sage 100 Contractor InfoCenter at http://www.na.sage.com/sage-100-contractor/infocenter-news for current virtual
conference information.

Contacting Customer Support
Contact Customer Support in the United States and Canada at:

Toll free: 800-866-8049

Or 503-690-6775

www.sagecre.com

Hours of Operation
Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Timewith the exceptions listed below.

l Every Thursday from 2 p.m. to 3 p.m. Pacific Time, closed for staff meetings.

l Standard United States holidays.

l Quarterly company meetings.

You can also submit your request for customer support online 24 hours a day, seven days a week by logging on to
http://na.sage.com/us/sage-construction-and-real-estate. Our customer support team will reply to your questions during
normal support hours.

Any additional closures will be communicated by our regular customer email newsletters.

When You Contact Customer Support
Depending on your Sage service plan, youmay be able to contact the Sage Customer Support Call Center to work with one
of our highly trained customer support professionals. Before you call, be sure to have the following information on hand so
we can handle your call efficiently.

Question How to Find the Answer

What is your Sage client
ID number?

Your client ID number can be found on correspondence you receive from Sage. If you do
not know your Sage client ID, contact the person at your company whomaintains your
relationship with Sage.

What software version
are you using?

To find the version, open Sage 100 Contractor; clickHelp > About Sage 100 Con-
tractor and note the number listed.

http://www.sagemasterbuilder.com/lp/InfoCenter-News
http://www.sagecre.com/
http://www.sagecre.com/customerlogon
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Question How to Find the Answer

What application or area
in the software are you
calling about?

On themenu list, identify the application and number where are you are work (i.e.
Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).

How can we help you? Walk through the exact steps you completed with asmuch detail and accuracy as
possible.

Is there an error mes-
sage? Write down the exact wording of themessage.

Can you reproduce the
issue?

Were you able to walk through the same steps that led to the problem and see
whether it happened again?

Is this the first time the
problem has happened?
Does the problem occur
on one workstation or sev-
eral?

Ask other users if they have experienced the same problem. Have them test at their
workstation to see if they experience the same problem. Also, have the original
user try other workstations to see whether the problem is specific to that user.

Has anything changed
with your software, hard-
ware, or workflow?

Ask your network administrator for technical information regarding anything that
may have changed behind the scenes: upgrades to Sage 100 Contractor, new
third-party software installations, moving of data from one server to another, new
printers or print driver installation, or anything else that might affect the network.

Does the problem hap-
pen in the sample data
sets?

Select [File> Open Company], then change the drive letter on the dropdown to
C:, select Sample Company.

What kind of network are
you using? If you do not know, contact your network administrator.

What operating system is
on your computer? For Vista: Click [Start], type winver in the ‘start search’ window and click [OK].

What printers and print
drivers are installed? If you do not know, contact your network administrator.

When was your last
backup? If you do not know, contact your network administrator.

Responding to You
Our analysts work with you to respond accordingly to the urgency of your issue. Call urgencies range from a simple
explanation of software settings to critical situations in which work is stopped or data integrity is compromised. Some calls
may warrant further research and followup, in which case our support analyst will place your call in his/her in-progress work
list. At every step of the way, we work with you to until a resolution or agreement can be reached.

Depending on your Sage Service plan, youmay check the status or update, or even create a new support ticket online:

1 Visit www.sagecre.com.

2 Click the [Customer Support] button.

3 Logon to the Sage Customer Portal.

4 Next, select the Support tab and choose the [Self Service] button.

http://www.sagecre.com/
http://www.sagecre.com/
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Training Resources
When you choose to take online classes from Sage or work with a Sage business partner, you will learn how to use Sage
100 Contractor to support your business. Contact your business partner to find out about training options or visit Sage
University at http://www.sageu.com.

Online Classes
Online classes help youmaximize your use of Sage 100 Contractor. Online classes are a convenient training option for your
company and new users to learnmore about Sage 100 Contractor so you can get themost out of the software. You can
select from classes on all aspects of Sage 100 Contractor, including project management, estimating, scheduling, service
management and payroll. Each online class is led by an instructor with years of experience using Sage 100 Contractor.
During the class, you will be able to follow along as the instructor demonstrates functions and workflows in Sage 100
Contractor. In the online live session, you can ask questions and benefit from hearing answers to other students' questions.

For more information, visit http://www.sageu.com.

Getting Started as a New User
We recommend that all new users should begin with our New Customer Training (NCT) series, which is included in our
Essentials Training Package in recorded format for 24/7 access. If you prefer live online training led by an instructor, you
can register for the Realtime Learning version of these NCT courses. For more information, visit http://www.sageu.com.

Business Partners
To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of
business partners. Business partners have local expertise and regional knowledge working with contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation,
implementation, and training. They're fully equipped to help you get where you want to be. For more information, contact
your Sage 100 Contractor business partner.

Business Forms
Sage 100 Contractor is designed to work with generic checks and forms that are available frommany sources. There is no
single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and checks through
Sage Construction and Real Estate Forms by calling 800-760-7929 or by visiting www.sagecreforms.biz.

Sage 100 Contractor Add-on Modules
There are currently 5 add-onmodules for use with Sage 100 Contractor: “Estimating,” "Equipment," "Document Control,"
"Inventory," and the combined “Service Receivables/Inventory.”

Estimating
The Sage 100 Contractor Estimating Basic module allows you to stay on top of the estimating process from start to finish
thanks tomultiple takeoff options, industry-specific pricing databases, and integration with Sage 100 Contractor accounting
modules. By automating and streamlining your estimating processes, you'll ensure that every detail is accounted for and
your cost projections are accurate.

Global variables, formulas, and templates make your estimating process easier andmore accurate. You can selectively
factor in cost increases, lock prices to prevent accidental edits, and add notes for clarity. Windows functionality (such as

https://sageu.csod.com/
https://sageu.csod.com/
https://sageu.csod.com/
http://www.sagecreforms.biz/
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cut, copy, and paste) allows you to import blocks of information from other estimates with just a few clicks of themouse.
All grids areMicrosoft® Excel® compatible—you will not have to learn a new interface if you have been using
spreadsheets. After the takeoff is complete, you can generate the budget, the proposal, requests for proposals, purchase
orders, and subcontracts. You can even email them directly to your subs and suppliers without printing them out.

With the data import feature, you can import a parts list or update prices directly from your suppliers. The simple assembly
tools help you build new assemblies without leaving your takeoff (available in 9-5 Takeoffs). With just a few mouse clicks,
you can copy, adjust, or create assemblies from scratch.

For more information on the Estimating add-onmodule, visit http://na.sage.com/sage-100-contractor/modules/estimating.

You can also step up to the next level with Sage Estimating Standard and Extended versions, powered by trade-specific
cost databases, enabling you to turbo-charge takeoffs and final proposals. Input your own costs into a pre-built database or
choose a database pre-populated with costs. For more information about Sage Estimating, visit http://na.sage.com/sage-
estimating.

Equipment
Build your bottom line by better managing equipment. Track and charge all equipment costs directly to your jobs, helping
your company recoup these outlays. Sage 100 Contractor equipment management includes:

l Job allocation capabilities. Improve job cost data—and job profitability analysis—by allocating equipment costs to
specific jobs.

l Maintenance reports. Take advantage of down time and optimize your schedule with up-to-the-minute equipment
maintenance schedule reports.

l Financial information. Makemore informed decisions by analyzing depreciation information with automatically
created reports and disbursements.

l Analysis reports. Use cost, maintenance, and revenue records to quickly determine equipment profitability.

l Rent, lease, or buy analysis. Compare ownership, lease, or rental options tomake the right equipment decisions for
your company.

l Cost recovery analysis. Determine the optimal cost recovery rate for each piece of equipment.

For more information on the Equipment add-onmodule, visit http://na.sage.com/sage-100-contractor/modules/service-
management .

Document Control
Complete project documentation with all the forms you need. Avoid disputes and communicate effectively with employees,
customers, and subcontractors with Sage 100 Contractor document control capabilities. Create and track responses to
critical project documents such as:

l Requests for Information (RFIs). Document your requests andmatch to information received.

l Transmittals and submittals. Track all correspondence and replies.

l Plan records. Maintain plan revisions and document the delivery of critical reports to all parties.

l Daily field reports. Generate a complete diary of job site information including payroll, subcontract, units complete,
equipment use, meetings, incidents, andmore.

l Punch lists. Effectively and completely close each phase of every job with up-to-the-minute to-do lists, including
who is assigned to the work and who is responsible for payment.

For more information on the Document Control add-onmodule, visithttp://na.sage.com/sage-100-
contractor/modules/project-management.

http://na.sage.com/sage-100-contractor/modules/estimating
http://na.sage.com/sage-estimating
http://na.sage.com/sage-100-contractor/modules/service-management
http://na.sage.com/sage-100-contractor/modules/project-management
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Inventory
Keeping track of inventory items is easy with integrated estimating, purchase orders, accounts payable, job-costing, and
service work orders. Whether you need to track inventory for a central warehouse or for a number of locations and service
trucks, Sage 100 Contractor Inventory can handle it.

Inventory also canmanage both basic stock and serialized items for all locations, bin numbers, Materials Safety Data
Numbers (MSDN), manufacturer identification, andmultiple vendors with different order numbers for the same part.

Truck restocking can be run from the work orders completed each day so that your warehouse staff can restock trucks at
night after your service technicians bring them in.

You canmove inventory in Sage 100 Contractor from one location to another, apply inventory to a job, re-price inventory,
post shrinkage, or create finished goods inventory from stock items and labor. A template feature can save repetitive
transactions for future use.

Resource reports from service work orders let you see which items will be needed in the future, making the ordering easy.
And since Estimating integrates into Inventory, your estimators will always know if items are in stock and what your latest
price is for any item.

For more information on the Service Receivables and Inventory add-onmodule, visit http://na.sage.com/sage-100-
contractor/modules/service-management.

Service Receivables and Inventory
Service Receivables include service contracts, service routes, service dispatch, on-call work orders, quotes, point-of-sale
and billing-of-service work andmaterials. This option is integrated with the Inventory module for automatic decrementing of
inventory from work orders. You canmaintain your service truck inventory with parts assigned to truck or warehouse
inventory.

Service dispatch is displayed in 15-minute, hourly or daily increments. Work orders are displayed with user-definable color
codes showing client, priority, and ZIP Code. You can review information about equipment installed at the client’s site.
Items can be billed individually or as part of an assembly. The flat-rate billing option allows you to create and print your own
price book for technicians to use. The same parts and assemblies databases are used for estimating and for service,
making it easy to keep your entire system updated.

Service Receivables seamlessly integrates with payroll to eliminate the need for duplicate entry of labor hours.

http://na.sage.com/sage-100-contractor/modules/service-management
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Chapter 1: General Ledger
As the backbone of the accounting system, General Ledger pulls together information from Payroll, Accounts
Receivable, Accounts Payable, Inventory, Service Receivables, Equipment Management, and other features. You
can alsomake direct entries for cash, checks, deposits, journal transactions, and recurring transactions.

A tight audit trail creates a well-protected system from accounting to job costs and automatically audits all stored balances
back to their original entries.

General Ledger maintains true subsidiary ledgers with lookup windows for each controlling account to simplify data entry to
all 12 accounting periods for the current fiscal year, and you can control posting to any period. Entries made to the prior year
automatically update the prior year’s ending balances as well as the current year’s beginning balances.

TIP: Sage 100 Contractor devotes an entire program section tomajor accounting reports in 2-Accounting Reports.

General Ledger Reports

1-1 Checks and Bank Charges

About checks and bank charges
Using 1-1 Checks/Bank Charges, you can produce general ledgerchecks, transfer funds between cash accounts, enter
bank charges, and cancel check numbers. When entering a check, you can break down costs by creating separate line
items, and you can even post each item to a different ledger account. To pay a vendor, however, you create the check
using 4-3 Vendor Payments.

Suppose you want to issue a check to a telephone company for last month’s bill. To indicate to Sage 100 Contractor that a
check will be printed for the transaction, you type a placeholder consisting of four zeros (0000) in theCheck# box. Then
when selecting check records for printing, you indicate the check number at which you want to begin printing. As Sage 100
Contractor prints checks, it substitutes the placeholder in the posted record with the appropriate check number.

You can also enter transactions that do not require printed checks. For example, youmight issue a hand written check and
will not need to print a check. In this case, you enter the check number you issued in theCheck# box.

In the grid, you can itemize the expenses and post them to different expense accounts. When you indicate a direct expense
account, equipment expense account, orWIP account, Sage 100 Contractor requires you to create a job cost record in the
Job Cost Distribution window. Job cost records aremaintained in a separate database from the accounting data, and
therefore do not impact the general ledger.

Entering general ledger checks
For reference, you can enter the purchase order number in theOrder# box.

When you enter a vendor number in theVendor box, Sage 100 Contractor increases theVendor 1099 balance by the total
amount of the check.

When entering a bank charge, use the bank’s transaction number as thecheck number. You can also use a dummy number
that is outside the check number range, such as 99999, for all bank charges.
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To enter a general ledger check
1 Open 1-1 Checks/Bank Charges.

2 In theAccount# box, enter the ledger account number for the checking account

3 In theCheck# box, type 0000.

a When you print the check, Sage 100 Contractor assigns the check number to the record.

b If you have already issued the check, enter the check number in theCheck# box.

4 In theDate box, enter the transaction date of the check.

5 In theDescription box, enter a brief statement about the transaction.

6 In theStatus list, click the status of the entry.

7 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theAccount cell, enter the ledger account number.

c In theSubaccount cell, enter the subsidiary account number.

d In theDebit Amount cell, enter the amount.

8 Repeat step 7 for each item that you want to include in the check.

9 On the Filemenu, click Save.

Entering outstanding checks or bank charges
Whenworking with a bank charge, you can type Bank Charge in theCheck# box on the 1-1 Checks/Bank Charges
window. You can also type it as BCmm/dd/yyyy (wheremm/dd/yyyy is the actual date of the bank charge). Sage 100
Contractor saves the information and displays the resulting transaction the 1-5 Bank Reconciliation window with Bank
Charge in the transaction number (Trans#) column in the checks area.

CAUTION: Do not enter a vendor number. It would otherwise affect theVendor 1099balances. TheVendor 1099
balances are set up later.

To enter outstanding checks or bank charges
1 Open 1-1 Checks/Bank Charges.

2 In theAccount# box, enter the ledger account number for the bank account.

3 In theCheck# box, enter the check number.

4 In theDate box, enter the transaction date of the check.

5 In theDescription box, enter a brief statement about the transaction.

6 In theStatus list, click 1-Open.

7 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theAccount cell, enter the clearing account number.

c In theDebit Amount cell, enter the amount.

8 Repeat step 7 for each item that you want to include in the check.

9 On the Filemenu, click Save.
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10 Repeat steps 3–9 until you have entered all outstanding checks for the account.

Setting the default ledger checking account to a new account
To set the default ledger checking account to a new account:
1 Open 1-1 Checks/Bank Charges.

2 In theAccount# box, type the number of the checking account that you want to set as the default.

3 Press the Enter key.

4 Click in theAccount # box, and then press the F7 key.

5 On the Field Properties Account#window, verify that the account you want to be the default is in theDefault Entry to
box, and click OK.

6 Close 1-1 Checks/Bank Charges, and then open it again.

7 When the window opens, note that theAccount# box defaults to the new account.

Printing general ledger checks
You can print general ledger checks from the 1-1 Checks/Bank Chargeswindow; however, youmust first complete the
check entry process.
To print general ledger checks
1 Open 1-1 Checks/Bank Charges.

2 Click thePrint Records button. 1-1 Report Printing opens.

3 In theAccount box, enter the account number, and click thePrint Records button.

4 In theCheck Printingwindow, enter a valid check number and a date.

5 In the confirmation box, click OK.

6 In theAssign/Post Checkswindow, select Assign Check Numbers, and click Continue.

The check prints.

About reprinting checks
Occasionally a check is misprinted or lost. Sage 100 Contractor provides an easy way to reprint checks without having to
enter a new record. You can recall a check record and reassign it a placeholder consisting of four zeros (0000) in the check
number box or transaction number box. When you reprint the check, Sage 100 Contractor assigns the record the new check
number.

You can reprint a general ledger check using a two-step process. First you locate the check you want to reprint in 1-3
Journal Transactions and change its number. Then you print it from theReport Printingwindow.

Sage 100 Contractor automatically updates the existing ledger record and associated job cost/equipment records with the
new check number when it assigns the new check number to the existing ledger record.

IMPORTANT: When you reprint a general ledger check, the transaction record remains unchanged, but no record of
the original check exists. Tomaintain an accurate check register, cancel the original check number.

To reprint a general ledger check:
1 Open 1-3 Journal Transactions, and select the check record that you want to reprint.

2 In the Trans# box, delete the original check number, and type 0000.

3 On the Filemenu, click Save.
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4 Open 1-1 Checks/Bank Charges.

5 Click thePrint Records button. 1-1 Report Printing opens.

6 In theAccount box, enter the account number, and click thePrint Records button.

7 In theCheck Printingwindow, enter a valid check number and a date.

8 In the confirmation box, click OK.

9 On theAssign/Post Checkswindow, select Assign Check Numbers, and click Continue.

The check prints.

Cancelling check numbers
When you cancel a check number, Sage 100 Contractor creates a record for the check number. Suppose that you
accidentally print an invoice on a few check forms. Because you cannot use the forms now, you have to cancel the check
numbers.

IMPORTANT: To cancel a series of check numbers, youmust cancel each number through a separate transaction.

To cancel a check number
1 Open 1-1 Checks/Bank Charges.

2 In theAccount# box, enter the ledger account number for the checking account.

3 In theCheck# box, enter the check number you want to cancel.

4 In theDate box, enter the date.

5 In theDescription box, enter a brief statement about the transaction.

6 In theStatus list, click 3-Void.

7 On the Filemenu, click Save.

About voiding checks

IMPORTANT: You cannot void a transaction in a different period than that in which it was originally posted.

When you create an accounts payable, general ledger, or equipment check and save it, Sage 100 Contractor posts the
check to the general ledger. You cannot void these checks in the 1-3 Journal Transactionswindow unless the status is 1-
Open. When you do void a check, Sage 100 Contractor assigns the check status 3-Void and adjusts the invoice and
vendor balances accordingly. If the check was applied to an invoice and the invoice was closed, Sage 100 Contractor
reopens the invoice and adjusts the balance to what is due. Best practices in accounting procedures require that you do not
void transactions that have been processed by the bank. Therefore, it is not possible to void transactions with a status of 2-
Cleared.

After voiding all payments made to an invoice, you can void the invoice itself. Best practices in accounting procedures
require that you do not void transactions that have been processed by the bank. Therefore, it is not possible to void
transactions with a status of 2-Cleared.

IMPORTANT: You cannot void a transaction in a different period than that in which it was originally posted.

To void a check:
1 Open 1-3 Journal Transactions.

2 Using the data control, select the record of the check (Trans#) you want to void.
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3 Verify that theStatus is 1-Open. checks

4 If necessary, in theStatus drop-down list, change the status to 1-Open.

5 On theEditmenu, click Void Transaction.

Payroll checks are processed by Sage 100 Contractor differently from other types of checks. Therefore, you need to void
payroll checks through the 5-2-2 Payroll Recordswindow. To void a payroll check, void the timecard record that Sage 100
Contractor used to create the check. This reverses the amounts applied to the employee quarterly totals and year-to-date
totals, and voids the job costs.

Voiding general ledger checks from an archived year
TheVoid Transaction command on theEditmenu is not available for cash transactions posted to archived years. To
maintain an audit trail, youmust reverse transactions posted to archived years.

To reverse the general ledger check, you enter a reversing transaction, and then clear both the original check and the
reversing transaction. This task is in two parts.

NOTE: Checks and deposits from a prior year can also be cleared in the 1-5 Bank Reconciliation window. For each
item you want to clear, select the item, and then click theClear button.

Part 1—Enter the reversing transaction:
1 Open 1-2 Deposits and Interest, and then from theEditmenu, choosePeriod.

2 In thePosting Periodwindow, select the fiscal year, and then double-click 0-Prior Year.

3 At themessage verifying that you want to use this period, click Yes.

4 In theAccount# box, enter the account from which the original check was drawn.

5 In theDeposit# box, enter the original check number.

6 In theDate box, enter the date of the original check.

7 In theDescription box, enter a brief statement about the transaction.

8 In the grid, enter the following information:

a In theAccount column, enter the general ledger account that was debited in the original transaction.

b In theCredit Amount column, enter the original amount of the check.

9 From the Filemenu, select Save.

Part 2—Clear the original check and reversing transaction:
1 Open 1-5 Bank Reconciliation.

2 In theAccount# box, enter the bank account number.

3 In theStatement Cutoff Date box, enter the date of the transactions.

NOTE: The date of the reversing transaction shouldmatch the original check date.

4 Click theDisplay Items button.

5 In the grid, select the original check and the reversing transaction and then click theClear button.

6 From the Filemenu, select Save.
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Finding and resolving unprinted checks when closing the books
When there is a credit to an account in the cash range with a transaction number of 0000 when you are closing the books,
Sage 100 Contractor displays amessage stating that unprinted checks were found.

TIP: This message is informational only. It does not stop you from closing your books; however, you should resolve
the unprinted checks issue.

To find and resolve unprinted checks:
1 Open 2-5 General Journals.

2 Print the 2-5-21 General Journal report with the following settings:

a In theAccount box, use the range for all cash accounts listed in 1-8 General Ledger Setup.

b In the Trans# box, select Equal, and type 0000.

c In theCredit box, select Greater or =, and type $0.01.

3 If the transaction is an unprinted check, open 1-1 Checks/Bank Charges and click thePrint Records button to print the
check if desired. If you don’t need to print a check, open 1-3 Ledger Transactions, and change the Trans# to anything
other than 0000.

NOTE: If it is aSource 16-Payroll, click on theGo To Source button to change theCheck#. It's highly unusual that
the check number would have been changed to 0000 unless the paycheck had to be reprinted immediately.

1-2 Deposits & Interest
You can enter deposits and accrued interest for checking or savings accounts in the 1-2 Deposits/Interestwindow. When
you enter a deposit, enter individual checks or accrued interest as separate line items. If you have cash receipts for
receivable or service invoices, enter these transactions using the 3-3-1 Cash Receiptswindow.

To enter a deposit:
1 Open 1-2 Deposits/Interest.

2 In theAccount# box, enter the cash account number.

3 In theDeposit# box, enter the deposit transaction number.

4 In theDate box, enter the date of the deposit.

5 In theDescription box, enter a brief statement about the transaction.

6 In theStatus list, click the status of the entry.

7 In the grid, do the following:

a In theDescription cell, enter a brief statement about the transaction.

b In theAccount cell, enter the general ledger account number.

c In theSubaccount cell, enter the subsidiary account number.

d In theCredit Amount cell, enter the amount.

8 Repeat step 7 for each item that you want to include in the deposit.

9 On the Filemenu, click Save.



- 17 -

About deposits on jobs
Some contracts require a client to supply a deposit before work can begin. When you receive the deposit, you need to
decide how to enter the deposit, as well as when and how to apply the deposit when invoicing the client. This often depends
on the terms agreed upon in the contract. The following outlines themost commonmethods for handling job deposits:

You can enter the check for the job deposit in the 1-2 Deposits/Interestwindow. If you only receive a few deposits each
fiscal year, deposit the check to the checking account and credit theDeposits on Jobs account. If you receive numerous
deposits, create a subsidiary account for each deposit using the job number as the subsidiary account number. This
enables you to track deposits independently.

You can enter the job deposit as a receivable credit in the 3-2 Receivable Invoices/Creditswindow, debiting theDeposits
on Jobs account and crediting the accounts receivable account. You can enter the deposit as an open credit, assigning it
invoice status 1-Open, and invoice type 2-Memo.

Later, you can apply the credit as you enter receivable invoices or you can apply the credit as you enter receipts in the 3-3-1
Cash Receiptswindow. The credit affects the statement balance, but does not affect the contract balance.

TIP: By entering the job deposit as a credit, you can supply the client with a copy of the credit. This allows the client
to see how you applied the job deposit to invoices. Another way to inform the client about the job deposit is to send the
client a statement detailing the activity for the job.

IMPORTANT: Best practices in accounting procedures require that you do not void transactions that have been
processed by the bank. Therefore, it is not possible to void transactions with a status of 2-Cleared.

To void a deposit:
1 Open 1-3 Journal Transactions.

2 Using the data control, select the record of the deposit (Trans#) you want to void.

3 Verify that theStatus is 1-Open.

4 If necessary, in theStatus drop-down list, change the status to 1-Open.

5 On theEditmenu, click Void Transaction.

TIP: After voiding all payments made to an invoice, you can void the invoice itself.

Transferring Funds Among Accounts
You can transfer funds between accounts in the 1-1 Checks/Bank Charges or the 1-2 Deposits/Interest window. When
you transfer funds directly from one account to another, Sage 100 Contractor creates a single record for the transfer. The
record of the transfer appears in the check reconciliation of both accounts until you clear it from one account or the other.
After clearing the transaction for one account, it does not appear in the reconciliation for the other account. As this might
prove confusing, it is a good idea to use a clearing account when transferring funds.

While using a clearing account requires a few extra steps, this type of transfer has a distinct advantage over the direct
method. To transfer the funds using a clearing account requires you to enter two transactions. When reconciling bank
statements, each account then has a transaction to clear. If you decide to use a clearing account for this purpose, create a
clearing account in theCash Accounts range in the general ledger.

About clearing accounts
Some transactions can become quite complex. With clearing accounts, you can create transactions that prove you have
posted the amounts correctly. In addition, clearing accounts provide ameans of posting transactions or balances to
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accounts that normally do not allow direct posting. Clearing accounts do not carry a balance for any length of time. If you
want to hold a transaction in an account, use a suspense account.

Before posting a transaction, make sure the clearing account does not contain a balance. Posting a transaction to a clearing
account moves a balance into the account. Tomove the balance from the clearing account, post a transaction or series of
transactions against the clearing account. When the account balance reaches zero, you have completely posted the
balance.

Suppose that you have transferredmoney from a general checking account to a payroll checking account. Using a clearing
account, you would create a transaction in each account.

Window of entry Debit Credit

Checks/Bank Charges Clearing General Checking

Deposits/Interest Payroll Checking Clearing

To create a clearing account:
1 Open 1-7 General Ledger Accounts.

2 In the data control box, enter the ledger account number in the cash accounts range of 1000 to 1999.

3 In theShort Name box, enter a brief description of the clearing account.

IMPORTANT: If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must
be set up before posting transactions. In theSubsidiary list, click 1-Subaccounts or 2-Departments.

4 As required, in theSubsidiary list, click 1-Subaccounts or 2-Departments.

You can assign a cost type to ledger accounts, providing an additional way to verify transactions are posted
to the proper accounts. When you post a transaction that has cost types, Sage 100 Contractor compares the
transaction’s cost type with the ledger account cost type. If the cost types do not match, Sage 100
Contractor provides a warning, but does not prevent posting the transaction.

5 In theCost Type list, click the cost type you want to assign the ledger account.

6 On the Filemenu, click Save.
To enter clearing account transfers:
1 Open 1-1 Checks/Bank Charges. In theAccount# box, enter the source account.

2 In theCheck# box, enter the bank transaction number or a dummy transaction number.

3 In theDate box, enter the date of transfer.

4 In theDescription box, enter a brief statement about the transfer.

5 In theVendor box, enter the vendor number.

6 In theStatus list, click 1-Open.

7 In the grid, do the following:

a In theAccount cell, enter the clearing account to which you are transferring funds.

b If the account selected has subsidiary accounts, enter the number in theSubaccount cell.

c In theDebit Amount cell, enter the amount of the transfer.

8 On the Filemenu, click Save.

9 Open 1-2 Deposits/Interest. In theAccount# box, enter the destination account number.
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10 In theDeposit# box, enter the bank transaction number or a dummy transaction number.

11 In theDate box, enter the date of the transfer.

12 In theDescription box, enter a brief statement about the transfer.

13 In theStatus list, click 1-Open.

14 In the grid, do the following:

a In theAccount cell, enter the clearing account from which funds originate.

b If the account selected has subsidiary accounts, enter the number in theSubaccount cell.

c In theCredit Amount cell, enter the amount of the transfer.

15 On the Filemenu, click Save.

TIP: You can verify the complete transfer of funds by viewing the clearing account balance in 1-7 General Ledger
Accounts.

To enter direct transfers:
1 Open 1-1 Checks/Bank Charges.

2 In theAccount# box, enter the source account.

3 In theCheck# box, enter the bank transaction number or a dummy transaction number.

4 In theDate box, enter the date of transfer.

5 In theDescription box, enter a brief statement about the transfer.

6 In theVendor box, enter the vendor number.

7 In theStatus list, click 1-Open.

8 In the grid, do the following:

a In theAccount cell, enter the account to which you are transferring funds.

b In theDebit Amount cell, enter the amount of the transfer.

9 On the Filemenu, click Save.

NOTE: You can also use 1-2 Deposits/Interest to transfer funds. Because you aremaking a deposit, enter the
destination account in theAccount# box. Then in theAccount column, enter the account number from which the
funds originate.

About suspense accounts
Suppose your company receives a corporate tax refund, and you want to deposit the check, but you do not know how to
correctly post the transaction. The correct approach is to deposit the check and credit it to a suspense account in theCash
Accounts range. The amount remains in the suspense account until you determine where to post the credit.

Suspense accounts provide a temporary location where you can post a transaction until you determine the proper accounts.
Similar in function to a clearing account, suspense accounts allow transactions to pass through the account. When you
post transactions to a suspense account, however, the transactions can remain for an extended time until you determine
the proper accounts.

It is a good idea to use a suspense account in the account range to which you will eventually post the transactions. For
example, you are not sure how to post a transaction related to equipment. You can use a suspense account in the
Equipment range of ledger accounts.
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1-3 Journal Transactions
Use the 1-3 Journal Transactionswindow to review most accounting records. You can also enter adjusting journal entries
and change the status of bank account records. You cannot, however, enter transactions or adjusting journal entries for the
Accounts Payable, Accounts Receivable, Service Receivables, Inventory.

Best accounting practices require that you do not void transactions that have been processed by the bank. Therefore, it is
not possible to void transactions with a status of 2-Cleared.

NOTE: You can create a template for journal transactions from the Filemenu from an existing record or from scratch.

Instead of creating the transaction from scratch, you can begin with an existing Journal Transaction template. From File,
select Load/Delete Template.
To enter a journal transaction:
1 Open 1-3 Journal Transactions.

2 In the Trans# box, enter the transaction number.

3 In theDate box, enter the transaction date.

4 In theDescription box, enter a brief statement about the line item.

5 In theStatus list, click the record status.

6 In the grid, do the following:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the ledger account you want.

c In theSubaccount cell, enter the subsidiary account you want.

d In the appropriateDebit Amount orCredit Amount cell, enter the amount.

7 Repeat step 6 for each item.

8 On the Filemenu, click Save.

TIPS:
l If the transaction references a purchase order number, enter it in theOrder# box.

l When using over/under billing, you can reverse the entry in the next period.

Editing records in 1-3 Journal Transactions
Some fields are generally available to be edited and have a white background. Editing those fields and saving the record
just updates the current record.

Some fields have a gray background and are generally not editable. However, in some instances, gray fields in 1-3 Journal
Transactions can be edited. In editing one of these gray background fields, amessage displays advising that you are
attempting to edit a posted transaction. Tomaintain the audit trail, saving an unlocked transaction creates a new
transaction and voids the currently displayed transaction record. Sales taxes and inventory valuations are recalculated at
current rates if applicable.

You can edit the locked field, such as the Account in the grid, by double-clicking on the field and clicking [Yes] to confirm
unlocking the posted transaction.

Because the original record is voided, a new field was added in the header to all of themenus that shows the original record
number. This allows you to view all the related original edited records which are now void.
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NOTE: Youmust be the Supervisor user or have both save and void rights to unlock a posted transaction. If you save
the transaction after unlocking fields, a new record is created without having to reenter all the information.

IMPORTANT: To prevent data corruption, the ability to edit records in 1-3 Journal Transactions is limited. You
cannot change the record number.

To edit records in journal transactions
1 Open 1-3 Journal Transactions.

2 Using the data control, select the record.

3 Edit the record.

4 On the Filemenu, click Save.

Reversing a transaction in the next period
When entering aWIP adjustment in the 1-3 Journal Transactionswindow, you can reverse the transaction in the following
period. Doing so allows you to calculate the over or under billing without having to compensate for previous WIP
adjustments.

When you select theReverse in Next Period check box and post the transaction, Sage 100 Contractor simultaneously
posts the transaction you entered and a reversing entry the next period.

To reverse a transaction in the next period, select theReverse in Next Period check box.

NOTE: If posting a transaction to period 12, you cannot select theReverse in Next Period check box. Post the
transaction, and then after closing the books for the fiscal year manually post the reversing entry to period 1.

Changing the journal transaction record status

IMPORTANT: You cannot change the status of a record to 3-Void. Instead, youmust void the record.

To change the record status:
1 Open 1-3 Journal Transactions.

2 Using the data control, select the record.

3 In theStatus list, click 1-Open or 2-Cleared.

4 On the Filemenu, click Save.

TIP: If you accidentally clear a check or deposit in 1-5 Bank Reconciliation, you can change the status of the record
from 2-Cleared back to 1-Open. After changing the status, the record appears in the 1-5 Bank Reconciliation
window.

Voiding records in 1-3 Journal Transactions
Records in 1-3 Journal Transactions can have a status of 1-Open or 2-Cleared.

l Best accounting practices require that you do not void transactions that have been processed by the bank.
Therefore, it is not possible to void transactions with a status of 2-Cleared.

l You can void an electronic receipt that has not been settled in Sage Exchange. If it has been settled and you
proceed to void the transaction in Sage 100 Contractor, the program will attempt to create a credit transaction in
Sage Exchange. If it cannot create the credit transaction, youmust log on to Sage Exchange to correct the receipt
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manually.

You can void records with a status of 1-Open.

About zeroing out the clearing account
Previously you entered the ledger account balances for the bank accounts, and those balances already reflect the impact of
the outstanding transactions. Entering the outstanding bank transactions, however, affects the ledger balance. To clear the
effect of the outstanding transactions, post a journal transaction for the net balance of the clearing account.

For example, suppose you are entering the outstanding transactions for a checking account. You enter $500 in checks and
$750 in deposits. This is posted to the bank account and the cash clearing account. Because of the entries, the bank
account has a net debit of $250 and the clearing account has a net credit balance of $250. Therefore, you post a journal
transaction crediting the bank account and debiting the clearing account for $250.

Once you have zeroed out the clearing account, the items have no impact on the ledger account balances. You can then
clear the open items when you next reconcile the account.

IMPORTANT: We strongly recommend that you work on one account at a time from start to finish beforemoving on
to the next account.

To zero out the clearing account:
1 Open 1-3 Journal Transactions.

2 In the Trans# box, enter the transaction number.

3 In theDate box, enter the transaction date.

4 In theDescription box, enter a brief statement.

5 In theStatus list, click 2-Cleared.

6 On a grid line, do the following for the bank account:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the ledger account you want.

c In the appropriateDebit Amount orCredit Amount cell, enter the amount.

7 Repeat step 7 for the clearing account.

8 On the Filemenu, click Save.

9 To verify that the clearing account has a zero balance, double-click anAccount box to display a Lookupwindow. You
can then locate the account and review its balance.

1-4 Recurring Journal Transactions
Every business has transactions that occur on a regular calendar basis. You can set up any transaction as a recurring
transaction if it consistently posts the same amount on a regular basis. However, Sage 100 Contractor does not
automatically post the recurring transactions to the general ledger. You retain complete control over posting the
transactions. You can even set a reminder to prompt users in a specific security group when it is time to post recurring
transactions.

Look at the posting date of a transaction to determine when to post the transaction. After posting the transaction, Sage 100
Contractor advances the posting date based on the transaction cycle. The transaction date does not control or affect the
period to which you are posting the transaction. If you need to post a recurring transaction to a different period, change the
posting period.
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Examples of recurring transactions
The best transactions to set up on a recurring basis are those with amounts that do not vary and post on a regular cycle.
Recurring transactions cannot be set up for direct expenses, equipment expenses, inventory, or service receivables.

Transaction Description

Recurring
Payments Regular payments such as rents, vehicle insurance, janitorial services, and subscriptions or dues.

Pre-paid
Expenses

Payments made for a time longer than a single period, such as a quarterly vehicle insurance payment that
you need to expensemonthly. Create a recurring transaction to post themonthly expense rate, rather than
the quarterly rate.

Depreciation

You can depreciate items such as office equipment on amonthly basis. After obtaining the annual
depreciated amount from your company accountant, calculate themonthly depreciation. Then set up a
transaction to post themonthly depreciation. You can depreciate the value of equipment used on a job in
the 8-6 Equipment Depreciationwindow.

Setting up recurring journal transactions
You can set up a recurring transaction for printing a check. In the Trans# box, type four zeros (0000). In theVendor# box
enter the vendor number for whom you are printing the check. Sage 100 Contractor increases theVendor 1099 balance by
the total amount of the check. Then, in theAccount column, indicate the checking account number.

After posting the transaction, you can print the check from the 1-1 Checks/Bank Chargeswindow with other checks. As
you have posted the transaction, do not enter it in 1-1 Checks/Bank Charges.
To set up a recurring journal transaction:
1 Open 1-4 Recurring Journal Transactions.

2 In the Trans# box, enter the transaction number.

3 In theNext Date box, enter the next date when the transaction needs to post.

4 In theCycle box, enter the transaction cycle.

NOTE: In Sage 100 Contractor, you can base the frequency of the cycle on days, months, or a specific day of the
month. Billing, transaction, invoice, and other cycles are represented by these symbols: ##DY, ##MO, and ##TH.
Following are some examples that explain what the symbols represent.

l ##DY—30DY means due 30 days from the date of the invoice.

l ##MO—02MOmeans due twomonths from the date of the invoice.

l ##TH—25TH means due on the 25th day of eachmonth regardless of the date of the invoice.

5 In theDescription box, enter a brief statement about the line item.

6 In the grid, do the following:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the ledger account.

c In theSubaccount cell, enter the subsidiary account.

d Enter the amount in the appropriateDebit Amount orCredit Amount cell.

7 Repeat step 6 for each item.

8 On the Filemenu, click Save.
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Setting up automatic reminders to post recurring transactions
When a user logs on to a company, Sage 100 Contractor checks the posting dates of recurring transactions. If there are
transactions to post and the user is part of theRecur. Trans. Group, Sage 100 Contractor prompts you with a reminder.
You can set up reminders for recurring transactions by following this procedure.
To set up reminders for recurring transactions:
1 Open 7-2 Company Information.

2 In theCompany Name box, enter the company name.

3 In theRecur. Trans. Group (Recurring Transactions Group) box, select the security group responsible for posting
recurring transactions.

IMPORTANT: If you want to post to a different period, youmust change the posting period.

To post a single recurring transaction:
1 Open 1-4 Recurring Journal Transactions.

2 Select the transaction.

3 On thePostmenu, click This Transaction Only.

To post a group of transactions, use a cutoff date. Sage 100 Contractor posts all transactions through the indicated date.

IMPORTANT: If you want to post to a different period, youmust change the posting period.

To post a group of recurring transactions:
1 Open 1-4 Recurring Journal Transactions.

2 On thePostmenu, click Multiple Transactions.

3 ThePosting Cutoffwindow appears.

4 In theCutoff Date box, enter the cutoff date, and click OK.

1-5 Bank Reconciliation
IMPORTANT: When your cursor is in the grid area of the 1-5 Bank Reconciliation window, no function keys except
F1 are available. Youmay launch the calculator (F3) after displaying the 1-5 Bank Reconciliation window by clicking
in theStatement Cutoff Date text box and then pressing F3.

The 1-5 Bank Reconciliation window, similar to a check register, displays transactions that have not cleared. As you
compare the bank statement to the transactions in 1-5 Bank Reconciliation, clear the transactions listed on the bank
statement.

You can display transactions using a specific date. In theStatement Cutoff Date box, enter the statement ending date to
display all transactions through the specified date. Sage 100 Contractor does not display transactions entered after the
indicated date.

Sage 100 Contractor displays transactions in transaction number order. If a check number falls out of numbered sequence,
Sage 100 Contractor displays an asterisk (*) next to the transaction number.

After clearing transactions, save the changes. Cleared items do not appear in the 1-5 Bank Reconciliation window.

TheStatement Beginning Balance box displays the balance as of the last reconciliation. The amount in theStatement
Beginning Balance box does not change until you have cleared transactions and saved the changes.
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When you display records for a checking account, theStatement Ending Balance box displays the balance as of the last
reconciliation. As you change the status of transactions, the amount in theStatement Ending Balance box changes. A P
displayed with a transaction in theRecord# column indicates that the transaction is from a prior year.

After clearing the transactions, the ending balance in 1-5 Bank Reconciliation shouldmatch the ending balance of your
bank statement. After reconciling the account with the statement and you save the changes, Sage 100 Contractor rolls the
amount in theStatement Ending Balance box to theStatement Beginning Balance box.

NOTE: When saving a reconciliation as Final, the records are updated permanently. You cannot undo a reconciliation
once you have clicked [Final].

Sage 100 Contractor lets you save a trial reconciliation that is only partially completed. You can then return later to finish
the reconciliation.

TIP: The default location when saving the Bank Reconciliation Report as a .pdf file is \MB\your company\Reports.
You can save it to a different location.

Reconciling bank accounts with bank statements

IMPORTANT:

When your cursor is in the grid area of the 1-5 Bank Reconciliation window, no function keys except F1 are available. You
may launch the calculator (F3) after displaying the 1-5 Bank Reconciliation window by clicking in theStatement Cutoff
Date text box and then pressing F3.

Before you reconcile a bank account with a bank statement, enter any extra charges or income in 1-3 Journal
Transactions that appear on your bank statement that you have not already entered in Sage 100 Contractor. These include
automatic transfers, interest, or check charges. Tomaintain accurate records, it is a good idea to reconcile accounts each
month when you receive the bank statements.

If you need to clear amajority of the transactions, it might be easier to clear all transactions and reopen only the items that
do not appear on your bank statement. Select all items, and then click theClear button. Then you can reopen individual
items by selecting the item and clicking theOpen button.
To reconcile a bank account with a bank statement:
1 Open 1-5 Bank Reconciliation.

2 In theAccount# box, enter the bank account number.

3 In theStatement Cutoff Date box, enter the statement ending date.

4 Click theDisplay button.

5 For each item you want to clear, select the item and click theClear button.

6 Compare the amount displayed in theStatement Ending Balance box to the ending balance on the statement.

7 If the amount in theStatement Ending Balance box does not match the ending balance on the bank statement, you
need to determine the cause of the discrepancy and correct the problem.

8 On the Filemenu, click Save.

IMPORTANT: To save a copy of the Reconciliation report for future reference, make sure theCreate PDF of the
report file check box is selected before you click [Final]. If check box is cleared before you click Final, a report is not
created. You cannot go back and perform the reconciliation again to create the same report.

9 On theSave Bank Reconciliation window, do one of the following:

a If you are not finished reconciling the account, click the Trial button.
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b If you are finished reconciling the account, click the Final button.

NOTE: A "P" displayed with a transaction in theRecord# column indicates that the transaction is from a prior year.

About saving trial reconciliations
Sage 100 Contractor lets you save a reconciliation that is only partially completed. Sage 100 Contractor saves each
transaction with the status that you have assigned to it. You can then return later to finish the reconciliation.

NOTE: When you display the trial reconciliation, Sage 100 Contractor displays any records entered since saving the
trial reconciliation.

To save a trial reconciliation:
1 Open 1-5 Bank Reconciliation.

2 In theAccount# box, enter the bank account number.

3 On the Filemenu, click Save.

4 On theSave Bank Reconciliation window, click the Trial button.
To recall a trial reconciliation:
1 Open 1-5 Bank Reconciliation.

2 In theAccount# box, enter the bank account number.

3 Click theDisplay button.

TIP: When you save a trial reconciliation, the next time you recall the reconciliation, the checks and deposits that
were cleared still display with aClear status. However, any new transactions appear with anOpen status. The
computed balance will be the same. To start the reconciliation over again, clear out the trial reconciliation.

IMPORTANT: To save a copy of the Reconciliation report for future reference, make sure theCreate PDF of the
report file check box is selected before you click [Final]. If check box is cleared before you click Final, a report is not
created. You cannot go back and perform the reconciliation again to create the same report.

To clear a trial reconciliation:
1 Open 1-5 Bank Reconciliation.

2 In theAccount# box, enter the bank account number.

3 Click theDisplay button.

4 Select theStatus column.

5 Click theOpen button.

6 On the Filemenu, click Save.

7 On theSave Bank Reconciliation window, click the Final button.

Reconciliation-in-process check box
In the 1-3 Journal Transactionswindow, Sage 100 Contractor selects theActive in Check Reconciliation check box on
all transactions that are included in trial bank reconciliation. After the reconciliation is completed, Sage 100 Contractor
clears the check box.
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About clearing outstanding bank transactions
Before entering outstanding transactions, youmay need to clear existing transactions. Such transactions are usually the
result of entering the beginning and period balances.

If you posted individual transactions to enter the ledger account balances usingMethod 4 as described in the topic Methods
for entering financial activity for the current year, clear the items that have been cleared by the bank.

For the first time reconciliation for a new company, work on only one account at a time. For each bank account, enter the
open bank transactions that are part of the startup ledger balances. If you have written checks or made deposits that are not
included in the startup ledger balances, do not enter them at this time. Wait until you have finished entering all start up data.

Because the effect of the outstanding bank transactions are already encompassed by the ledger account balances set up
earlier, post the transactions to a clearing account in the period prior to the current period. Suppose you are setting up during
period 7. Post each open transaction to period 6. Then post the journal transaction to the end of period 6.

Working on the outstanding items for one bank account at a time helps prevent startup errors. After entering the checks and
deposits, enter the journal transaction to zero out the clearing account. Compare your results to the last reconciliation. Then
proceed to the next bank account. You can use the same clearing account to enter the balances for each bank account.
To clear an outstanding bank transaction:
1 Open 1-5 Bank Reconciliation.

2 In theAccount# box, enter the ledger account number for the bank account.

3 Click theDisplay button.

4 For each item you want to clear, select the item and click theClear button.

5 On the Filemenu, click Save.

6 Repeat steps 2–5 for each bank account.

Comparing open transactions with bank statements
It is often easier to discover errors with a printed copy of the bank reconciliation. You can then compare the records
assigned 1-Open status with the bank statement for discrepancies.
To compare open transactions with the bank statement:
1 Open 1-5 Bank Reconciliation.

2 On themenu bar, click Print Records.

About incorrect statement beginning balances
When the amount in theStatement Beginning Balance box does not agree with the ending balance from the previous
reconciliation and your account reconciled last period, examine the transactions since the last reconciliation.

Determine the difference between the statement beginning balance in Sage 100 Contractor and the statement ending
balance from the last statement you reconciled. Then try searching for a transaction with that amount. It might prove helpful
to print a copy of the check register from 2-6 Check Register.

It is possible that you accidentally cleared a transaction before it cleared the bank. If this is the cause of the error, change
the transaction status back to 1-Open.

Look for a transaction that you cleared in a prior reconciliation that has status 1-Open. If you find such a transaction, clear
the transaction in 1-5 Bank Reconciliation.

A voided transaction can also create an incorrect beginning balance. If a transaction was accidentally voided, you need to
re-enter the transaction.
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Locating specific amounts in 2-5 General Journals
When the bank reconciliation does not agree with the bank statement, search the journals for a specific amount.
To locate a specific amount:
1 Open 2-5 General Journals.

2 Select theShort Journal report.

3 If you are searching for a deposit, enter the amount in theDebit box.

4 If you are searching for a credit, enter the amount in theCredit box.

5 On the Filemenu, click Print Preview.

About reconciliation errors
When you cannot reconcile an account with the bank statement, you need to determine the cause of the error. You can
display all open records when you eliminate the statement cutoff date. This allows you to immediately search for
transactions assigned to an incorrect date or period.

Common reconciliation errors
The following table lists some common reconciliation errors.

Type of
Error Correction

Incorrect
posting

If you posted a transaction with an incorrect amount, the transaction amount between the reconciliation report
and bank statement differs.

Incorrect
bank
posting

Checks occasionally clear the bank for a different amount. Look at themagnetic coding at the base of the
check to determine the amount paid by the bank. Compare this amount to the amount appearing on the bank
statement and to the actual amount for which the check was written.

Incorrect
dates

If a transaction appears on the bank statement but does not appear in the 1-5 Bank Reconciliation window,
youmight have posted the transaction with incorrect dates. To locate the transaction, use 1-3 Journal
Transactions and search for themissing transaction.

Missing
entries

When charges or credits appear on the bank statement but do not appear in your records, post the charges and
reopen 1-5 Bank Reconciliation.

Returned
items

If the bank returns a check due to insufficient funds, reverse the check and post the charge for insufficient
funds.

Forged
items

While rare, it is possible that someone has altered a check amount. Another possibility is that someone has
stolen check forms and forged checks.

It is important to identify forgery and alert the bank, thereby eliminating additional problems and preserving
your ability to recover lost funds.

Processing prior year reconciliation items into the next fiscal year
If you notice that checks, deposits, or adjustments aremissing from your bank reconciliation after archiving a fiscal year,
this topic can help you to resolve those issues.
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Solutions

Youmight bemissing checks, deposits, adjustments, or a combination of these. Choose the solution according to your
situation:

l Solution A: You aremissing checks or negative adjustments.

l Solution B: You aremissing deposits or positive adjustments.

l Solution C: You aremissing a combination of checks, deposits, and adjustments.

Solution A
1 Open 1-1 Checks/Bank Charges, and enter eachmissing check.

2 Then for each one do the following:

a In theAccount# box, enter the account from which original check was written.

b In theCheck# box, enter the original check number.

c In theDate box, enter the date of the original check.

d In theDescription box, type a description.
It could be the description from the original entry. Youmay want to make a note that this was re-entered after the entry
was removed during the close books process at year-end.

e Type information in other boxes in the header section, as required.

f Leave theStatus set to 1-Open.

3 In the grid, do the following:

a In theAccount cell, enter a clearing account in the cash range. If you do not have a clearing account set up, go to 1-7
General Ledger Accounts and create one. Be sure the number is in theCash Accounts range defined in 1-8
General Ledger Setup.

b In theDebit cell, type the amount of the original check.

4 From theEditmenu, select Period and then select Period 00 – Prior Year. Any entries posted toPeriod 00 cannot be
voided after they have been entered. Verify all of your entry information is correct before you save the entry.

5 Save the entry.

6 Repeat steps 1 through 3 for eachmissing check.

7 Enter a deposit in 1-2 Deposits/Interest for the total amount of checks from step 1,

8 Then do the following:

a In theAccount# box, enter the original cash account from the original check.

b In theDeposit# box, type an entry, as required.

c In theDate box, enter the date of original check.
If there aremultiple checks, youmay use the last day of your last fiscal year.

d In theDescription box, type a description, as required.

e Type information in other boxes in the header section, as required.

f Leave theStatus set to 1-Open.

9 In the grid, do the following:

a In theAccount cell, use the same cash clearing account used in step 1.
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b In theCredit Amount cell, type the total of all checksentered in step 1.

10 From theEditmenu, select Period and double-click Period 00 – Prior Year. Any entries posted toPeriod 00 cannot
be voided after they have been entered. Verify all of your entry information is correct before you save the entry.

11 Save the entry, but select Nowhen prompted toPost to Archive because it already exists in the archive.

12 Open 1-3 Journal Transactions, and find the deposit transaction created in steps 5 through 7; then change the Status
to 2-Cleared, and finally save the transaction.

Solution B
1 Open 1-2 Deposits/Interest, and enter eachmissing deposit.

2 Then for each one do the following:

a In theAccount# box, enter the account to which the original check was entered.

b In theDeposit# box, enter the original deposit number.

c In theDate box, enter the date of the original deposit.

d In theDescription box, type a description.

e Leave theStatus set to 1-Open.

3 In the grid, do the following:

a In theAccount cell, enter a clearing account in the cash range. If you do not have a clearing account set up, go to 1-7
General Ledger Accounts and create one. Be sure the number is in theCash Accounts range defined in 1-8
General Ledger Setup.

b In theCredit Amount cell, type the amount of original deposit.

4 From theEditmenu, select PEriod and then select Period 00 – Prior Year. Any entries posted toPeriod 00 cannot be
voided after they have been entered. Verify all of your entry information is correct before you save the entry.

5 Save the entry, but select Nowhen prompted toPost to Archive because it already exists in the archive.

6 Repeat steps 1 through 3 for eachmissing deposit.

7 Open 1-1 Checks/Bank Charges, and enter the total amount of the deposit from step 1.

8 Then do the follow for each item:

a In theAccount# box, type the cash account from which original deposit was entered.

b In theCheck# box, type a number, as required.

c In theDate box, type the date of original deposit.

d In theDescription box, type a description.

e Type information in other boxes in the header section, as required.

f Leave theStatus set to 1-Open.

9 In the grid, do the following:

a In theAccount cell, enter the same clearing account used in step 1.

b In theDebit cell, type the total of all deposits entered in step 1.

10 From theEditmenu, select PEriod and then select Period 00 – Prior Year.

11 Save the entry, but select Nowhen prompted toPost to Archive because it already exists in the archive.

12 Open 1-3 Journal Transactions, and find the check transaction created in steps 5 through 7; then change theStatus to
2-Cleared, and finally save the transaction.
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Solution C
1 Create the checks as stated in Solution A steps 1, 2, 3, and 4, but skip all other steps.

2 Create the deposits as stated in Solution B steps 1, 2, 3, and 4, but skip all other steps.

3 Open 2-4-21 General Ledger report.

4 In theAccount selection box, enter the cash clearing account used in steps 1 and 2.

5 From the Filemenu, select Print Preview.

6 Note the Totals in theBalance column, and write this amount down. You will need it later.

7 Open 1-3 Journal Transactions, create an adjusting entry to zero out the amount in your cash clearing account.

8 Do the following:

a In the Trans# box, type any transaction number; for example ADJ2007.

b In theDate box, type the date of your fiscal year-end.

c In theDescription box, type a description.

9 In the grid, do the following:

a Row 1—Account box: Enter the same cash account used for your checks and deposits.

b If the noted amount from step 3 was positive, debit that amount.

c If the noted amount from step 3 was negative, credit that amount.

d Row 2—Account box: Enter the same cash clearing account used for your checks and deposits.

e If the noted amount from step 3 was positive, credit that amount.

f If the noted amount from step 3 was negative, debit that amount.

10 From theEditmenu, select PEriod and then select Period 00 – Prior Year. Any entries posted toPeriod 00 cannot be
voided after they have been entered. Verify all of your entry information is correct before you save the entry.

11 Save the entry, but select Nowhen prompted toPost to Archive because it already exists in the archive.

12 From the Filemenu, select Recall the transaction.

13 Change theStatus to 2-Cleared.

Reconciling beginning and ending balances
There are several reasons a statement ending balancemay not match the next month’s beginning balance.

Causes

l A transaction with a future date that falls beyond theStatement Cutoff Datewas entered. See clearing the
Statement Cutoff date.

l A transfer was made from one cash account to another cash account without using a clearing account. When the
first cash account is reconciled, it balances correctly. When the second account is reconciled, the transaction is
already cleared so the beginning balance is off by the amount of cleared transaction. See transferring cash without
using a clearing account.

l The status of a transaction was changed outside of the 1-5 Bank Reconciliation. For example, the status of a
transaction was changed in 1-3 Journal Transactions to 2-Cleared. See have you changed the status of any
transaction that posts to your cash account through 1-3 Journal Transactions?
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IMPORTANT: This step-by-step reconciliation process will help you locate the out-of-balance cause and provide a
solution. More than one causemay apply, however, and if you resolve a problem in one of the steps below, fix it, and
then look at the 1-5 Bank Reconciliation balances again. If they are still out or balance, continue to the next step.

In the 1-5 Bank Reconciliation window, do you type a Statement Cutoff Date? If you do, clear the
Statement Cutoff Date. Are the balances still wrong?

Consider the following:

l If the balances are correct, you have a transaction with a future date (a date beyond theStatement Cutoff Date you
entered) which has been cleared.

l If the balances are still incorrect, but you see the transaction on the bank reconciliation grid, that transaction has a
future date. If the date of the transaction is incorrect, go to 1-3 Journal Transactions and change the date to the
correct date.

l If the balances are still incorrect, proceed to step 2.

Is this the first bank reconciliation of the new fiscal year?

l If yes, youmay have prior year outstanding transactions that were removed during the close fiscal year process.
See the topic, Processing prior year reconciliation items in to the next fiscal year.

l If no, continue with step 3.

Did you transfer cash from one cash account to another cash account without using a clearing
account?

If yes, follow these steps to correct the problem:

l Find the cleared items from the first cash account.

l Open 1-3 Journal Transactions, and change theStatus on the transaction to 1-Open.

l Void the transaction.

l Re-enter the transfer in two transactions using a clearing account. See the topic Entering clearing account transfers.

l Display the transaction that represents the cash account that was previously cleared, and change the Status to 2-
Cleared.

l Open 1-5 Bank Reconciliation to verify the balances are correct.

Have you changed the status of any transaction that posts to your cash account through 1-3 Journal
Transactions?

If yes, the beginning balance will be incorrect. To correct the beginning balance, open 1-3 Journal Transactions and
display the transaction.

If the status is Open change it toCleared

If the status is Cleared, change it toOpen.

If you do not know whether or not the status of any transactions has been changed, refer to the topic Creating a query for
transaction status changes made in 1-3 Journal Transactions.
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Entering clearing account transfers
To enter clearing account transfers:
1 Open 1-1 Checks/Bank Charges. In theAccount# box, enter the source account.

2 In theCheck# box, enter the bank transaction number or a dummy transaction number.

3 In theDate box, enter the date of transfer.

4 In theDescription box, enter a brief statement about the transfer.

5 In theVendor box, enter the vendor number.

6 In theStatus list, click 1-Open.

7 In the grid, do the following:

a In theAccount cell, enter the clearing account to which you are transferring funds.

b If the account selected has subsidiary accounts, enter the number in theSubaccount cell.

c In theDebit Amount cell, enter the amount of the transfer.

8 On the Filemenu, click Save.

9 Open 1-2 Deposits/Interest. In theAccount# box, enter the destination account number.

10 In theDeposit# box, enter the bank transaction number or a dummy transaction number.

11 In theDate box, enter the date of the transfer.

12 In theDescription box, enter a brief statement about the transfer.

13 In theStatus list, click 1-Open.

14 In the grid, do the following:

a In theAccount cell, enter the clearing account from which funds originate.

b If the account selected has subsidiary accounts, enter the number in theSubaccount cell.

c In theCredit Amount cell, enter the amount of the transfer.

15 On the Filemenu, click Save.

TIP: You can verify the complete transfer of funds by viewing the clearing account balance in 1-7 General Ledger
Accounts.

Creating a query for finding transaction status changes made in 1-3 Journal
Transactions
This query’s output shows you entries that were cleared on previous bank reconciliations and helps you find entries that do
not appear on the 1-5 Bank Reconciliation.

Creating the query for finding transaction status changes:
1 Open 1-3 Journal Transactions.

2 Select File > Find to display the list of available queries.

3 In theQuery Listwindow, select Open Ledger Transactions—by Period, and then click Edit.

4 In the upper left area of theDisplay Fieldswindow, click Ledger Transaction Lines.

5 That action selects the table from which you can pick fields for the query.
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6 Under Fields, double-click the following fields to select them for display:

l lgtnln.lgract Account

l lgtnln.dbtamt Debit Amount

l lgtnln.crdamt Credit Amount

The new fields appear with the original fields under Fields to Display. If you select an incorrect field, click
the field under Fields to Display, and press the Delete key. Then click Next to accept your changes in the
Display Fieldswindow.

7 Click Next through theGroup Fields andSort Fieldswindows.

8 In theSelection Fieldswindow, double-click the lgtnln.lgract Account field. It will be added to the list of fields under
Fields to Select By.

9 Click Next to display theSelection Criteriawindow, and then click Next again to return to theQuery Listwindow.

To run the query:

This query can be used to reconcile previous bank statements again and to look for journal transactions on the results of the
query that are not on the bank statements. If you discover a transaction on the bank statement that is not on the results of
the query, then the status on a transaction has been changed from 2-Cleared to 1-Open or 3-Void.

1 In theQuery List, click theOpen Ledger Transactions—by Period query, and then click Run.

2 In the Selection Criteria window:

a Leave thePeriod, Record#, andSource fields blank.

b In theStatus field, type 2 to display Cleared transactions.

c In theAccount field, enter the cash account you want to reconcile.

3 Click Run to display the transactions within the selection criteria. These results can be printed or exported.

4 Select File > Print to print the information, or select File > Save As to export the information.

1-6 Period and Fiscal Year Management
The 1-6 Period and Fiscal Year Management window provides options for advancing to the next fiscal year and archiving
data from your previous fiscal accounting year. The 1-6 Period and Fiscal Year Management window includes the following
options:

l Change Period—Opens theChange Periodwindow. You can set the posting period to any period from 0 to 12. If
you are on period 12, you can also advance the period to the next fiscal year. When you advance the posting period,
the program performs an audit automatically and logs the audit results. For more details about this functionality, see
the topics in the section, Change Posting Periods.

l Audit Books—Opens theAudit Bookswindow. Click at any time to perform an audit, and the audit results are
logged. For more details about this functionality, see the topics in the section, Audit the Books.

l Recalculate Balances - Opens theRecalculate Balanceswindow. Click to recalculate account, job, vendor,
client, and equipment balances. Recalculating the balances repairs certain period audit errors, and the remaining
audit errors are logged. For more details about this functionality, see the topics in the section, Recalculate Balances.

l Archive Fiscal Year—Click to open theArchive Datawindow. Formerly the Close Year wizard, the Archive Data
wizard leads you through the process of archiving your data from previous fiscal periods. You can archive up to 12
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periods at one time. You do not have to close your fiscal year before archiving your data. For more details about this
functionality, see Archive Data at year end.

NOTE: Archive Fiscal Year is only available if your posting period is set to 12.

ll Manage Period Availability. If you log on to Sage 100 Contractor as a Supervisor, click Manage Period
Availability to open theManage Period Availabilitywindow. Use theManage Period Availability window to
restrict other operator's access to selected posting periods. Youmust be logged on as a Supervisor to make
changes in this window.

l Audit History—Every time you initiate an audit, the program logs audit history in the window’s grid. TheAudit
Historywindow displays three columns, Date, User Name, andAudit Result. The results displayed can be:

l Audit successful—No errors were found.

l Repair successful—Errors were found and repaired when the balances were recalculated.

l [n] errors detected - A number of errors that couldn’t be repaired and were logged.
For more details about this functionality, see the topics in the section, Audit History.

About year-end processes
Sage 100 Contractor includes separate year-end processes:

l A process for closing payroll (calendar year close)

l A process for advancing the fiscal year

l A process for archiving data in General Ledger

For many companies, the fiscal year end is the same as the calendar year end on December 31, while other companies
have a fiscal year end other than December 31. Throughout this document we provide steps for both your fiscal year end
and your calendar year end.

The fiscal and calendar year end can be a busy time. To keep your ledgers current and accurate, audit your books monthly.
Sage recommends performing an additional audit several weeks before your year end to resolve any errors before beginning
transactions for the next fiscal year. However, as of the 19.2 release, if you are on period 12 of your current fiscal year, you
can begin entering transactions for period 1 of the new fiscal year even if you are still resolving auditing errors.

After you resolve any audit errors and archive your data, make at least two backups of your data for your permanent
records.

The time required to complete your year-end processes depends onmany factors, such as the size of your company, any
audit errors, and any accounting adjustments. If all of the following conditions are true, youmay be able to finish your year
end in a few hours:

l You have already prepared backup.

l You have been keeping up with accounting period audits.

l You only have repairable period audit errors.

How do fiscal years and calendar years differ?

The end of your fiscal year is determined by your company. The calendar year ends on December 31. Payroll requires
closing only at the end of the calendar year.

When you reach the calendar year end, advance your general ledger fiscal period to the next fiscal year using 1-6 Period
and Fiscal Year Management, and then close the payroll year in 5-3-8 Close Payroll Year.
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As of the 19.2 release, Sage 100 Contractor no longer requires a separate closing procedure for the end of your fiscal year.
You create separate archives for your Payroll data and the rest of your accounting data. If your fiscal year ends on a date
other than December 31, you need to close Payroll only at calendar year end.

What happens when you advance the fiscal year?

Beginning with version 19.2, Sage 100 Contractor no longer requires you to close your books at the end of the fiscal year.
When you advance the fiscal year (from period 12 of the current year to period 1 of the next fiscal year), Sage 100
Contractor audits your accounting records to verify that valid, balanced transactions support the account balances. If no
errors are present, Sage 100 Contractor advances the accounting period to period 1 of the next fiscal year. Periods 2-12 of
the new fiscal year become available.

If you are on period 12 of your current fiscal year, you can begin entering transactions for period 1 of the new fiscal year by
selectingPeriod 1 from thePosting Periodwindow or by changing the company period in 1-6 Change Period.

Sage 100 Contractor does not archive your data automatically when you advance the fiscal year. You can archive your data
after advancing the fiscal year by clicking [Archive Fiscal Year] from within the 1-6 Period and Fiscal Year Management
window.

What about entering transactions?

Beginning with the 19.2 release, if you are on period 12 of your current fiscal year, you can enter transactions for period 1 of
the next fiscal year. Periods 2-12 of the next fiscal year become available when you advance to period 1 of the next fiscal
year using the Change Period window.Change Period window. If you need tomake adjustments to the previous fiscal year,
you can do so by posting transactions to period 0.

When a fiscal year's data is no longer needed in the current books, archive your data, which removes your ledger data from
the current books and places it in a company archive. Creating an archive removes all accounting activity from the oldest
fiscal year in your company and adjusts the current balances for asset, liability, and equity accounts and sub-accounts, as
well as jobs, vendors, service clients, and equipment to match the archive year's ending balances. Income and expense
balances roll into the Retained Earnings account beginning balance.

The archive company contains all the data from the oldest 12 periods (your oldest fiscal year) existing in your company at
the time you create the archive. If you havemore than 12 periods of data in your company that require archiving, perform the
archive process more than once.

To post a period 00-Prior Year transaction, post the transaction to period 00 of the current year. Then, to post the
transaction to the archive, open the archive company then post the transaction to period 12. As of the version 19.2 release,
Sage 100 Contractor no longer supports posting simultaneously to period zero of the current company and period 12 of the
archive company.

You do not need to have every transaction entered in Sage 100 Contractor in order to close the year successfully. All cash
transactions (checks and deposits) and payroll transactions should be completed and posted prior to closing your year-end
accounting books. Sage 100 Contractor, however, is designed to handle income or expenses (AR invoices and AP
invoices) that you receive after you close your accounting year, so that you only have to enter these transactions once.

How does Sage 100 Contractor handle audit errors?

Every time you close a period, and when you advance the fiscal year, Sage 100 Contractor audits all transactions to verify
that complete and balanced transactions support each account balance. If any transactions are out of balance, you are
prompted to print an audit report. The audit report provides information you can use to resolve the errors.

Audit errors that refer specifically to periods contain the word “Period” in the row. You can resolvemost period audit errors
by recalculating the ledger balances: open 1-6 Period and Fiscal Year Maintenance > Recalculate Balances, then
Recalculate Balances again.
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Any remaining audit errors require assistance from Sage Customer Support. You can contact us at 800-866-8049. Be
prepared to provide your company name, telephone number, and the company contact person. A Sage Customer Support
analyst may request additional reports to help determine the cause and resolution of the error.

Change Posting Periods
About the Change Period window

Use theChange Period window to change the default current posting period for the entire program. If you are on period 12
of your current fiscal year, the window allows you to select period 1 of the next fiscal year. This feature replaces the "close
year" requirement for previous Sage 100 Contractor releases. Instead of closing your fiscal year, select period 1 of the next
fiscal year. You can then archive your data at your earliest convenience.

Click the arrow key to the right of theChange Period to box Posting Periodwindow to select the default period and fiscal
year.

When you advance to the next posting period or a future posting period, for example from period 1 to period 2 or 2 to 9, the
program performs an audit automatically. The audit results are logged in theAudit Historywindow. After the audit has
been completed, you click the button to change the period.

To change the posting period, underPeriod Selection, type a period number or click the arrow button to open thePosting
Periodwindow from which you can select a posting period.

TIP: No audit is performed when you go backward, for example, from period 2 to period 1.

Standard posting procedures and reporting

If you do not have standard posting procedures, it is a good idea to establish them for your company. For example, post any
corrections to the current fiscal period unless there are other reasons not to do so. Set a date when you change the period
eachmonth. You can post to prior accounting periods after changing the period, but it is essential to change prior periods so
that reports are accurate.

Suppose you have issued financial reports to a lender based on information from period 3. Now in period 5, you find that you
need tomake a correction related to data in period 3. Posting the corrections to period 3 changes the data in that period,
which impacts the financial reports you have already produced and sent to the lender. To avoid any problems this might
cause, it is better to post the corrections to the current fiscal period.

Changing posting periods

You use theChange Periodwindow to change from one posting period to another, either forward or backward.

IMPORTANT: Changing posting periods requires that you have opened the company with exclusive access.

To change a period:

1 Open 1-6 Period and Fiscal Year Management, and click Change Period.

2 On theChange Periodwindow, click the arrow next to theChange period to box.

3 On thePosting Periodwindow, double-click a posting period.
Alternatively, you can type a number in the box.

4 Click Change Period.

5 Do one of the following:

a The program performed an audit, and you accept the posting period. Click Yes to change the period.

b The program changed the posting period you selected. Click Yes to change the period.
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Locking access to posting periods

CAUTION: Do not confuse changing periods with locking access to a fiscal period. Locking access to a posting
period only prevents posting.

If you log on to Sage 100 Contractor as a Supervisor, you can control which fiscal periods accept posting by locking access
to any posting periods except the current period. When you lock access to a fiscal period, operators cannot post to that
period.

For example, suppose it is the end of period 6, and access to all other periods is locked. When you close the books, Sage
100 Contractor opens period 7, which becomes the current period. You then have tomanually lock period 6.

You can restrict access to posting periods on any window that deals with posting periods. These windows appear
throughout Sage 100 Contractor. For example, you can lock access in these windows: 1-1 Checks/Bank Charges, 1-2
Deposits/Interest, 1-3 Journal Transactions, 1-4 Recurring Journal Transactions, 3-2 Receivable Invoices/Credits,
4-2 Payable Invoices/Credits, 11-2 Work Orders/ Invoices/Credits, 12-2 Inventory Allocation, andmore.

IMPORTANT: To lock access to posting periods, you first must log on to Sage 100 Contractor as supervisor.

To lock access to posting periods:

1 In the 1-6 Period and Fiscal Year Management window, click Manage Period Availability.

2 In theManagement Period Availability window, select the period to which you want to restrict access.

3 Click Lock Access.

NOTE: To open access to a posting period if it is locked, click Open Access.

About posting to period 0

When you want to enter the startup balances and invoices for a new company or when you want to adjust the beginning
balances for a company, post to period 0. Period 0 is not part of the fiscal year. Therefore, Sage 100 Contractor does not
include transactions posted to period 0 in any year-to-date reports.

TIP: Sage 100 Contractor posts the transactions to the selected fiscal period until you change the period again or
close the window.

When you post to the asset or liability accounts in period 0, Sage 100 Contractor adjusts the beginning balances. If you
post to income or expense accounts in period 0, Sage 100 Contractor adjusts the beginning balance of theRetained
Earnings ledger account because income and expense accounts do not have beginning balances.

Posting to period 0 does not affect the data in your archive company. Change archive company totals by opening the
archive company andmaking changes directly. When you change data in an archive, make new backups of the archived
data. The archived records are your permanent records.

Audit the Books
About the Audit Books window and auditing the books

When you audit the books of a company, Sage 100 Contractor verifies that the accounts are balanced and that valid
transactions support the balances.

You can audit the books at any time by opening 1-6 Period and Fiscal Year Management > Audit Books and clicking
theAudit Books button. When you audit the books, the program does not make any changes, but it does log any errors
using theAudit History function.
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When you advance to a new period in the future, the program audits the books automatically as part of the process to
change the default posting period.

When you start a new company or suspect data corruption, it is a good idea to audit the books and recalculate balances. If
unbalanced data exists, the program alerts you so that you can correct the errors as early as possible.

TIP: Additional entries cannot fix imbalances and errors. If recalculating balances does not fix the errors, youmay
have accounting errors that can only be fixed with the help of Customer Support.

About audit errors

When you advance to the next posting period, click theAudit Books button, or archive a fiscal year, Sage 100 Contractor
audits the books to verify that valid, balanced transactions support each account balance. If the books are out of balance,
then the program notifies you that there are audit errors.

Sage 100 Contractor tracks audit errors in a log. You can access the log from theView Audit History link on the 1-6
Period and Fiscal Year Managementwindow.

Period Audit Errors

Some audit errors refer specifically to periods. If period audit errors exist, theAudit report displays them prominently. For
example, a period audit error will contain the wordPeriod in the row.

You can resolvemost period audit errors by recalculating the ledger balances. To recalculate the ledger balances, open 1-6
Period and Fiscal Year Management > Recalculate Balances, and then click Recalculate Balances.

Audit Errors Requiring Customer Support Assistance to Repair

Any remaining audit errors cannot be repaired by clickingRecalculate Balances on 1-6 Period and Fiscal Year
Management > Recalculate Balances. These audit errors might originate in accounts receivable, jobs, vendors, service
clients, equipment, or other areas of the program where transactions originate.

CAUTION: Resolving remaining audit errors after a repair requires assistance from Customer Support. You can
contact them at 800-866-8049. Be prepared to provide your company name, telephone number, and the company
contact person. At that time, a Customer Support technicianmay request additional reports to help determine the
cause of the error.

Additional audit error reports are now included with Sage 100 Contractor to assist Customer Support technicians in
identifying the transaction sources of audit errors.

Recalculate Balances
About the Recalculate Balances window and repairing the balances

ClickingRecalculate Balances recalculates and repairs the ledger balances, audits, andmay resolve period audit errors.
For example, if you notice “Period” errors on the error report, clickingRecalculate Balances often resolves them.

Resolving remaining audit errors after a repair requires assistance from Customer Support. You can contact them at 800-
866-8049. Be prepared to provide your company name, telephone number, and the company contact person. At that time, a
Customer Support technicianmay request additional reports to help determine the cause of the error.

During the repair, Sage 100 Contractor recalculates account and subsidiary account balances. In addition, Sage 100
Contractor recalculates balances for jobs, vendors, service clients, and equipment.

To repair the ledger balances:

1 Open 1-6 Period and Fiscal Year Management.

2 Click theRecalculate Balances button.
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IMPORTANT: After completing the ledger balance repair, Sage 100 Contractor audits the books. Resolving
remaining audit errors after a repair requires assistance from Customer Support. You can contact them at 800-866-
8049. Be prepared to provide your company name, telephone number, and the company contact person. At that time,
a Customer Support technicianmay request additional reports to help determine the cause of the error. There are
specific audit error reports to help Customer Support technicians identify the transactions related to some audit errors.

Audit History
About the Audit History window

You access this window from 1-6 Period and Fiscal Year Management by way of theView Audit History link located at
the bottom-left of the window. Every time you initiate an audit, the program logs audit history in the window’s grid.

TheAudit Historywindow displays three columns, Date, User Name, andAudit Results. The results displayed can be:

Audit successful—No errors were found.

Repair successful—Errors were found and repaired when the balances were recalculated.

[n] errors detected - A number of errors that couldn’t be repaired and were logged.

TheAudit Historywindow also provides menu commands for saving your audit history in several file formats and for
printing the audit history file.

Viewing audit history

Each time you change the default posting to the next or future period or close the accounting at fiscal year-end, the program
performs a full audit of the accounting. If the audit finds discrepancies in the accounting, they are logged. You can view the
log using the link on 1-6 Period and Fiscal Year Management.

To view the audit history:

1 Open 1-6 Period and Fiscal Year Management, and click theView Audit History link.

2 TheAudit Historywindow opens providing a list of your audit history.

3 Use themenu commands to open or print the audit history file.

Archiving data at year end
What is a company archive?

Over the course of a year, the accounting and payroll databases grow as you enter records. Like amanual accounting
system where youmight move the previous year’s records to storage boxes or a storage facility, you canmove Sage 100
Contractor records to an archive file.

When you no longer need a fiscal year's data, you canmove it out of your company data and into a separate company for
storage. This separate company is known as an archive. It is a copy of the earliest fiscal year in your existing company
data. Creating an archive removes the accounting activity from the oldest fiscal year in your current company and adjusts
the beginning balances for asset, liability and equity accounts and sub-accounts, as well as jobs, vendors, service clients,
and equipment to match the archive year’s corresponding ending balances. Income and expense balances for the archive
year roll into the Retained Earnings account beginning balance.

At year end, if I don't have enough hard disk drive space to create an archive company, what can I do?

You can create a company archive at any time. If you do not have enough disk space, free up disk space by deleting
unnecessary files or programs ormanually copy the data to another hard disk drive, CD, or DVD.
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When do I create the company archive?

You canmake a company archive at any time; you do not have to advance the fiscal year first. Sage 100 Contractor takes
the oldest fiscal year (12 periods of data) andmoves it out of your current company into an archive company.

IMPORTANT:

l If you delay creating a company archive to the point where you havemore than 1 fiscal year requiring archive, you
may perform the archive process more than once.

l Youmust advance to the next fiscal year if you have only one year's worth of data.

l The company folder cannot be in the same fiscal year that you are trying to archive.

Where in the program do I create a company archive?

Create your company archives using 1-6 Period and Fiscal Year Maintenance. Create an archive of your Payroll data
using 5-3-8 Close Payroll Year.

What about data backup?

To prevent loss of data, we highly recommend that youmake two backups of the company data before creating the
company archive. Remember that the backups are your permanent records, and therefore we recommend that you always
store one copy off site for added security. After creating the company archive, review it to make certain that all records
were copied correctly. If you find that the archive is incomplete, restore from a backup and create a new archive.

Archive Data wizard overview

You can archive your company data at any time to preserve it for future access. You do not have to archive your records
prior to advancing to the next fiscal year.

IMPORTANT: The archive process archives only one year of data at one time. If you accumulatemore than one year
of data before you archive, youmust run the archive process for each year.

You can also use the Archive Data wizard to remove old jobs and invoices.

The archive process:

l Moves your oldest fiscal year data into a separate archive company.

l Removes all accounting activity for the oldest fiscal year in your company.

l Adjusts the beginning balances for asset, liability and equity accounts and sub-accounts, as well as jobs, vendors,
service clients and equipment to match the archive year’s corresponding ending balances. Income and expense
balances for the archive year roll into the Retained Earnings account beginning balance.

Before you begin

l Allow sufficient time to proceed through the entire archive process for each company you keep on Sage 100
Contractor. The time it takes to archive each company will vary.

l Ensure that your accounting and payroll systems are as up to date as possible.

l Ensure that you have two backups of your company data.

The archiving process

The archiving process consists of the following steps.



- 42 -

Preparation

During thePreparation step, the Archive Data wizard:

l Rebuilds indexes after removing deleted records

l Searches for unprinted checks

l Audits the general ledger

l Audits inventory, if you use the Inventory module

l Creates a temporary backup

If issues are found or errors are encountered, the process stops and the text on this button changes to [Resume
Preparation]. Click [Resume Preparation] to continue running subsequent tasks to see if there are additional items that
require your attention.

NOTE: General ledger audit errors must be fixed before you can proceed with archiving. Exit the wizard and contact
Customer Support to correct the errors before you proceed.

Maintenance Options

You can select one or more of the following tasks to perform on the database after archiving your data.

l Remove jobs with Closed or Refused status, and all related records. (Only jobs that do not have job costs or ledger
activity in the current books are removed .)

l Remove payable invoices with Paid or Void status and no Job #.

l Remove service invoices with Paid, Completed, or Void status (option not displayed if you do not have service
invoices).

l Remove purchase orders with Closed status and no Job #.

Archive Data

During this step, the wizard performs the following tasks:

l Creates the company archive. During this process the wizard:

l Copies company data to the designated company archive folder. (The copied data includes Images,
Attachments, Aatrix Forms, Direct Deposit and Reports subfolders.)

l Removes accounting data that was posted to a fiscal year later than the year you are archiving, and
recalculates ending balances, invoice balances (where payment was recorded in a future year), and inventory
quantities, as necessary.

NOTE: If jobs, vendors, employees, and equipment records created in subsequent years exist at the
time you archive, these records are copied to the archive company, although the associated accounting
data is removed.

l Verifies the archive

l Removes fiscal year information from the archived year for the current company

l Performs maintenance tasks, if any were selected

l Verifies the current company
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Finished

l Create backup of the company archive:When backing up your data, be sure tomake a full backup and not an
incremental or differential backup. An incremental or differential backup only records alterations to the data since the
last backup.

l Make changes to existing general ledger accounts:You canmake prior year adjustments by posting
transactions to period 0—Prior Year.

l Transactions posted to period 0—Prior Year update the beginning balance in your current company.

l Prior year adjustments posted to income and expense accounts update the Retained Earnings account in the
current year in period zero(0).

l Change security in the archive company: If required, change security in the archive company by changing the
rights of all user groups in 7-3-1 Security Groups to No for Save, Delete, Void, Change Period, and Print Checks.
This prevents users from accidentally saving or printing records in the archive.

l Print filtered reports for the archive company:When printing the 6-1-7 Over/Under Billing, 6-1-8 Bonding,
and 6-1-12 Committed Cost reports for the archive company, print by fiscal period to exclude information for jobs,
vendors, employees, and equipment records created in subsequent years.

Preparation for Archiving Your Data

The following tasks are performed during this step in the wizard.

l Rebuild Indexes

l Search for unprinted checks

l General ledger audit

l Inventory audit (optional, but strongly recommended if you use the Inventory module)

l Create temporary backup

When completed, each task displays one of the following icons:

l The green icon indicates that the task ran successfully.

l An orange icon indicates that the task has issues that should be reviewed before continuing.

l A red icon indicates that the task “failed” and you cannot close the books until the issue is resolved.

To begin preparation:

1 Click [Begin Preparation] to start performing all the tasks on this page.

NOTE: If issues are found or errors are encountered, the process stops and the text on this button changes to
[Resume Preparation]. Click [Resume Preparation] to continue running subsequent tasks to see if there are
additional items that require your attention.

2 After all tasks have been completed without errors, click [Next].

NOTE: While Sage 100 Contractor does create a temporary backup in this wizard step, you should always create the
backup copy suggested before you begin.

Issue—Search for unprinted checks

This task searches for checking account transactions that have "0000" as the Transaction #, whichmay indicate that this
check entry was never printed. If any such transaction records are found, click [View Results] to see the records in a grid.
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n If it is an unprinted check (a physical check needs to be produced for this transaction), you'll need to exit the wizard, go to
1-1 Checks/Bank Charges, and print the check(s).

n If this check was printed but just needed the Transaction # assigned, drill down to the transaction record and enter the
appropriate Transaction #.

n After making all needed corrections, click [Try Again] to run this task again.

Issue—Ledger audit

The wizard will not continue if audit errors are found. Click the [View Results] link for an audit report, then cancel out of the
wizard to resolve the audit errors.

Issue—Inventory Audit (if Inventory data exists)

If there are no audit errors but the total value of parts does not match the ledger balance for the Inventory account, you can
post an adjusting entry for the difference.

General Maintenance for Archiving Data

You can select one or more of the following options to be performed on the database after archiving your data.

l Remove jobs with Closed or Refused status, and all related records.

l Remove payable invoices with Paid or Void status and no Job #.

l Remove service invoices with Paid, Completed, or Void status (this option does not appear if you do not have
service invoices).

l Remove purchase orders with Closed status and no Job #.

When the archive process removes a job record, it also removes job-related records, including schedules, job costs,
takeoffs, progress billing, time andmaterials setup, closed purchase orders, subcontracts, change orders, budgets,
proposals, and accounts payable and receivable invoices assigned status 4-Paid or 5-Void.

NOTE: The archive process does not remove a closed job unless the job has a $0 balance and all invoices and
credits have been assigned status 4-Paid or 5-Void.

If you select theRemove service invoices with Paid, Completed, or Void status dated prior to orRemove purchase
orders with Closed status and no Job # dated prior to options, youmust provide a date in the date field before clicking
[Next].

About removing jobs at fiscal year end

CAUTION: If you need to review any deleted records, refer to the company’s archive or restore a backupmade prior
to the archiving of your fiscal year.

When archiving your accounting data, you can remove job records from the company database. When a job is completed,
fully invoiced, completely paid, and you do not want to carry its data into the next fiscal year, change the job record status
to 6-Closed.

IMPORTANT: All jobs with a job record status of 2-Refusedwill also be removed when archiving your data if you
select theRemove jobs with closed or refused statusmaintenance option.

When Sage 100 Contractor removes a job record, it also removes job-related records, including schedules, takeoffs,
progress billing, time andmaterials setup, closed purchase orders, subcontracts, change orders, budgets, proposals, and
accounts payable and receivable invoices assigned status 4-Paid or 5-Void.
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The archive process does not remove a closed or refused job unless the job has a zero balance, no open payable
invoices/credits, no job costs in the current books, no payable invoices/credits in the current books (even if they are paid or
void), and no balance in aWIP account. You can confirm that the jobs meet the criteria for removal.

NOTE: If jobs, vendors, employees, and equipment records created in subsequent years exist at the time you
archive, these records are copied to the archive company, although the associated accounting data is removed.

Removing and Verifying Refused/Closed Jobs

Use theRemove Refused/Closed Jobswindow to select and remove jobs with aClosed orRefused status from your
current company.

NOTE: Youmust have Supervisor permissions and exclusive company access to open this window.

When Sage 100 Contractor removes a job record, it also removes job-related records, including schedules, job costs,
takeoffs, progress billing, time andmaterials setup, closed purchase orders, subcontracts, change orders, budgets,
proposals, and accounts payable and receivable invoices assigned status 4-Paid or 5-Void.

Before removing jobs, make sure jobs assigned status 2-Refused or 6-Closedmeet the criteria for removal—$0 balance
and all invoices and credits are status 4-Paid or 5-Void, for example. Verify jobs selected for removal by clicking [Verify
Job Removal].

To remove refused or closed jobs:

1 Create a backup copy of your current company.

2 Open 3-5 Jobs (Accounts Receivable) and select Options > Remove Refused/Closed Jobs.

3 In theRemove Refused/Closed Jobswindow, select either theRefused orClosed jobs status option to display a
corresponding list of jobs.

4 Select one or more jobs from the list for removal or click [Remove All] to select all jobs in the list.

5 Click [Verify Job Removal]. Sage 100 Contractor checks each selected job to confirm its status and confirm that it is
ready to be removed. If a job cannot be removed for one or more reasons (it has outstanding invoices against it, for
example), Sage 100 Contractor displays the reasons in amessage.

6 Click [Remove Jobs] after verifying the selected jobs to remove them from your company.

Archiving Your Fiscal Year

The following tasks are performed during this step in the wizard.

l Preparation

l General Maintenance

l Archive your data: Archives 12 periods of data in one company

You can click [Next] only when all tasks have been completed successfully.

To archive your data:

1 From the introductory window, click [Next] then click [Preparation] to begin.
A progress bar shows next to each task as it is running.
When completed, each task displays one of the following icons:
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l The green icon indicates that the task ran successfully.

l An orange icon indicates that the task has issues that should be reviewed before continuing.

l A red icon indicates that the task “failed” and you cannot continue until the issue is resolved. Click View Results
link to display detailed information about the error.

2 Click [Next].

3 Select one or moremaintenance options you want to perform prior to archiving then click [Next].

4 Type a name for the company archive in theEnter name for the company archive box. The box cannot contain any
special characters.

NOTE: If the archive folder already exists, it must be empty. Click [Yes] to continue the process or click [No] to go
back to the window.

5 Click [Archive Data] to begin the archive process.

6 Click [Close] to finish the archiving process.

Finishing the Archive Data process

Create backup of the company archive

When backing up data as part of the archiving process, it is important to count the number of files and folders in your
company.

1 InWindows Explorer, right-click the company folder and select Properties.

2 On thePropertieswindow, theGeneral tab, look in the list for theContains line for the number of files and folders.

Write this number down so that you can refer to it after you havemade the two copies. The number of files and folders must
be exactly the same in both the company and the backup copy.

NOTE: If you are working across a network, youmust back up company folders, report folders, and form folders that
reside at the server.

We strongly recommend that you back up:

l Each company folder that contains financial data (\MB7\your company\)

l Custom reports and custom form designs

l Shared custom reports on a network—Back up theCustom Reports folder in theMB7 folder on your
network.

l Shared custom report forms on a network—Back up theReport Forms folder in theMB7 folder on your
network.

l Private custom reports on a local drive—Back up theCustom Reports folder located inUsers>{User
Name}>AppData>Local>Sage>Sage 100 Contractor.

l Private report forms on a local drive—Back up theReport Forms folder located inUsers>{User Name}
>AppData>Local>Sage>Sage 100 Contractor.

CAUTION: When backing up your data, be sure tomake a full backup and not an incremental or differential backup.
An incremental or differential backup only records alterations to the data since the last backup.
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Make changes to existing general ledger accounts

You canmake prior year adjustments by posting transactions to period 0 in the current company folder and then logging into
the archive company to update the ending balance.

l Transactions posted to period 0 update the beginning balance in your current company.

l Prior year adjustments posted to income and expense accounts update the Retained Earnings account in the current
year.

Change security in the archive company

If required, change security in the archive company by changing the rights of all user groups in 7-3-1 Security Groups to
No forSave, Delete, Void, Change Period, andPrint Checks. This prevents users from accidentally saving or printing
records in the archive.

NOTE: By setting Groups toNo, reports can still be printed, but checks cannot be printed. Then each user will have
access to everything they had access to before closing. They will be able to print reports but only view checks.

Year-End Checklists
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Fiscal Year-End Processes

Preparing for fiscal year end

The following instructions assume that these steps are performed at the Sage 100 Contractor server location. Sage
strongly recommends this method because it avoids network irregularities that can disrupt the closing process.

IMPORTANT: Youmust have exclusive access to your company file to perform these steps.

Each task listed below should be completed in preparation for fiscal year end. Resolve audit errors as found during each
step.

l Verify posting period

l Backup and verification

l Rebuild indexes

l Inventory audit (optional, but we strongly recommend it if you use the Inventory module)

l Verify checks

l Job status and removal

l Print reports and record counts for verification

IMPORTANT: Youmust complete these preparation steps prior to archiving the general ledger.

NOTE: These steps assume you will not have your bank statement before you archive. If you have your bank
statement, youmay complete your bank reconciliation before you archive in the current company or after you archive
in the new company file. If you do your bank reconciliation after you close your books in the new file, the archive file is
not updated. If you want the archive file updated, you will need to do the bank reconciliation again in your archive.

Verify Posting Period

In 1-6 Period and Fiscal Year Management > Change Period, ensure the posting period is set toPeriod 12.

Backup and verification

Back up and validate your company file by following your regular backup and verification procedures.

Rebuild indexes

Open 7-4 Rebuild Indexes, select Options > Rebuild All Tables, and then click Start.

Inventory audit (optional, but strongly recommended if you use the Inventory module)

If you use inventory, open 12-5 Inventory Audit, click Audit.

Verify checks

Verify that there are no unprinted checks.

To find and resolve unprinted checks:

1 Open 2-5 General Journals.

2 Print the 2-5-21 General Journal report with the following settings:
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a In theAccount box, use the range for all cash accounts listed in 1-8 General Ledger Setup.

b In the Trans# box, select Equal, and type 0000.

c In theCredit box, select Greater or =, and type $0.01.

3 If the transaction is an unprinted check, open 1-1 Checks/Bank Charges, and then click thePrint Records button to
print the check, if desired. If you don’t need to print a check, open 1-3 Ledger Transactions, and change the Trans# to
anything other than 0000.

NOTE: If it is aSource 16-Payroll, click on theGo To Source button to change theCheck#. It's highly unusual that
the check number would have been changed to 0000 unless the check had to be reprinted immediately.

Period Audit Errors

Some audit errors refer specifically to periods. If period audit errors exist, theAudit report displays them prominently. For
example, a period audit error will contain the wordPeriod in the row.

You can resolvemost period audit errors by recalculating the ledger balances. To recalculate the ledger balances, open 1-6
Period and Fiscal Year Maintenance > Recalculate Balances, and then click Recalculate Balances.

Audit Errors Requiring Customer Support Assistance to Repair

Any remaining audit errors cannot be repaired by clickingRecalculate Balances on 1-6 Period and Fiscal Year
Maintenance > Recalculate Balances. These audit errors might originate in accounts receivable, jobs, vendors, service
clients, equipment, or other areas of the program where transactions originate.

CAUTION: Resolving remaining audit errors after a repair requires assistance from Customer Support. You can
contact Customer Support at 800-866-8049. Be prepared to provide your company name, telephone number, and the
company contact person. At that time, a Customer Support technicianmay request additional reports to help
determine the cause of the error.

Additional audit error reports are now included with Sage 100 Contractor to assist Customer Support technicians in
identifying the transaction sources of audit errors.

Job status and removal

Verify that the status on each job in 3-5 Jobs (Accounts Receivable) is correct. Any job that should be removed at
year-endmust have a status of 6-Closed or 2-Refused.

NOTE: If you need to change several jobs' statuses to 6-Closed, you can use a Picklist window to closemultiple jobs
at once. To access this command, open 3-5 Jobs (Accounts Receivable) and select Update > Closed Status.

Print reports and record counts for after year-end verification

Print the following reports that will be used for verification purposes after the books have been closed:

l 2-2-21 Balance Sheet report for period 12

l 2-3-21 Income Statement report for periods 1 through 12

l 3-1-3-26 AR Invoice Aging report for period 12

l 4-1-3-26 AP Invoice Aging report for period 12
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NOTE: If you pay retainage in the next year for a prior year invoice and then print this report for the prior year,
the report will show a reduced Retention amount, and the amount paid in the future period is allocated to the
Current period or an aging period. Therefore, you should always print these reports as part of your year-end
processing to ensure that you have a set of reports that reflect the true amount of retainage outstanding at year
end.

l 5-1-2-41 Payroll Check Register report with “totals for status” equal to 3-Posted

l 6-1-6-21 Job Cost Totals report for periods 1 through 12

l 11-1-3-26 Service Invoice Aging report for period 12, if you use Service Receivables

TIP: If you archive your data at year end, you can also print the reports from the Archive, later.

Advance the General Ledger period for fiscal year end

Back up your Sage 100 Contractor data

Back up and verify two copies of your Sage 100 Contractor data. Put one copy in a safe storage area. Save at least one
of your backups to a separate removable storage device.

NOTE: A backup created at this point in the process reveals whether or not the program has discovered data problems
during the year-end close. You can use this backup to verify data integrity if you have to close again.

Advance the fiscal period

Open 1-6 Period and Fiscal Year Management > Change Period; and underChange period to, select period 1 of
the next fiscal year.

You are now in the current fiscal year in your company file.

TIP: What actions does Sage 100 Contractor take when you advance the fiscal year?

NOTE: You do not have to advance the fiscal year before you canmake transactions in it. If you are on period 12 of your
current fiscal year, period 1 of the next fiscal year is available for transactions. Periods 2-12 of the next fiscal year
become available after you advance the year.

Archive your fiscal year (recommended)

You can perform this step at any time; however, youmust advance to the next fiscal year before archiving your previous
year. Sage 100 Contractor moves the oldest 12 periods of data into a separate archive company. For example, if you need
to archive Fiscal year 2013 youmust advance to at least period 1 of year 2014 before archiving year 2013. If you havemore
than 12 periods of data to archive, perform this stepmore than once.

Open 1-6 Period and Fiscal Year Management > Archive Fiscal Year. Perform all steps in the wizard, including
selecting the appropriate maintenance options for removing invoices, purchase orders, or job-related records.

NOTE: There are different ways to name your archive company file. We suggest it include the following information. For
example, you could name it “2013GL [Your Company Name]” or “2013 PR [Your Company Name].”
- The year of the archive file.
- The type of archive file you aremaking.
- The name of the company.

Rebuild indexes and tables

Open 7-4 Rebuild Indexes, select Options > Rebuild All Tables, and then click Start.
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Verification tasks after archiving your data

Verification tasks in the new company

Open 3-5 Jobs (Accounts Receivable), and verify that the jobs you selected to be removed have been removed.

IMPORTANT: If a backup needs to be restored, and the file re-closed, delete the archive file that was created and the
current company file as they are not valid or correct files.

New Fiscal Year Preparation

Make changes to existing general ledger accounts

At this point, you canmake changes to existing general ledger accounts andmake entries for the new fiscal year.

To post a period 00-Prior Year transaction, post the transaction to period 00 of the current year. Then, to post the
transaction to the archive, open the archive company then post the transaction to period 12. As of the version 19.2 release,
Sage 100 Contractor no longer supports posting simultaneously to period zero of the current company and period 12 of the
archive company.

Prior year adjustments posted to income and expense accounts update theRetained Earnings account in the current year
in period zero(0).

Change security in the archive company

If you archived your previous fiscal year after advancing the fiscal period (recommended), change security in the
archive company if required by changing the rights of all user groups in 7-3-1 Security Groups toNo forSave, Delete,
Void, Change Period, andPrint Checks. This prevents users from accidentally saving or printing records in the archive.

By setting Groups toNo, reports can still be printed, but checks cannot be printed. Then each user will have access to
everything they had access to before closing. They will be able to print reports but only view checks.

For additional security, in 7-3-2 User List, change the password for the supervisor.
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Calendar Year End Processes (Closing the Payroll and Verifying 1099 Balances)

About closing the payroll

At the end of the calendar year, close the payroll to prepare for the new calendar year. During the close, Sage 100
Contractor removes all payroll records and resets the quarter-to-date and year-to-date totals $0. It is important to note that
closing payroll does not affect the accrued vacation, sick, and compensation times in the employee records that you
choose to retain. You can also delete old or unnecessary employee records.

Before entering timecards for the new calendar year, audit, back up, and then close/archive the payroll. Although youmay
back up your company data at any time, in the context of closing the payroll, it makes sense to back up your data after you
have audited it and corrected any errors.

Closing payroll can be time consuming, and the time necessary to create an archivemay be considerable depending on the
number of payroll records and employees contained in each company. We recommend creating a schedule of tasks to
perform leading up to the close. For example, consider auditing the payroll a month in advance of the scheduled closing
date. This should provide enough time to resolve any errors that might exist.

While it is not recommended, Sage 100 Contractor lets you close payroll with uncomputed records, unposted records, even
payroll audit errors. If you close with unfinished work, youmust go back to the archive later and compute and post the
records, repair the audit errors, and then adjust the payroll records in the active company. From the archive, you can also
prepare and print the state and federal reports and theW-2 forms.

It is important to understand the differences between closing the payroll and the accounting. All companies close payroll at
the end of the calendar year, but not all companies close the fiscal year at the end of the calendar year.

Preparation for archiving the Payroll year and verifying 1099 Balances

IMPORTANT: The following instructions assume that these steps are performed at the Sage 100 Contractor server
location. Sage strongly recommends this method because it avoids network irregularities that can disrupt the closing
process.

Each task listed below should be completed in preparation for a calendar year-end close. Resolve audit errors as found
during each step.

l Back up and verification

l Payroll audit

l Employee status and removal

l Print reports for after-close verification

l Verify vendor information

IMPORTANT: Youmust have exclusive access to your company file to perform these steps.

Back up and verification

Back up and validate your company file by following your regular backup and verification procedures.

Payroll audit

Open 5-3-7 Payroll Audit, click Audit.

If payroll is outsourced, it is okay to close with payroll audit errors.

If you have any errors, first try to resolve them by clickingRepair in 5-3-7 Payroll Audit.
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Employee status and removal

Open 5-2-1 Employees, and review employee statuses.

If you want to remove employees, they must have a status of Quit, Laid Off, Terminated, orDeceased.

Print reports for after-close verification

Open 5-2-2 Payroll Records, and select File > Count, and write down the number of files.

The number of files will be used for verification purposes after the books have been closed.

Print the 5-1-2-41 Payroll Check Register ~Totals Page report.

This report will be used for verification purposes after the books have been closed.

Verify vendor information

Verify Vendor Tax ID andVendor 1099 Types by printing the 4-1-1-31 Vendor List report. Be sure to verify that the
tax ID for each vendor is correct.

Verify 1099 balances using the 4-1-5-61 Vendor Payment report by date.

Payroll close for calendar year end

Before you begin to close your payroll, make sure that you are in your current company and not in your general ledger
archive company.

Back up and verification

Back up and verify two copies of your Sage 100 Contractor data.

Put one copy in a safe storage area. Make at least one of your backups on a separate removable storage device.

NOTE: You can use this back-up to verify data integrity if you have to close again.

Designate your archive, select employee removal options, and close year

Open 5-3-8 Close Payroll Year, and enter a name for the archive.
NOTE: There are different ways to name your payroll archive company file. We suggest including the following
information. For example: 2013 Payroll [Your Company Name].

l The year of the archive file.

l The type of archive file you aremaking.

l The name of the company.

Select employee removal options.

Click Close Payroll.

NOTES:

l During close, the program removes all 5-2-2 Payroll Records and resets all employee year-to-date totals.

l The payroll archive company is different than the general ledger archive company.
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Rebuild indexes and tables

Open 7-4 Rebuild Indexes, select Options > Rebuild All Tables, and then click Start.

NOTE: The program is now in the new payroll year.

Verification tasks after closing the payroll year

Verification tasks

In the current file, open 5-2-2 Payroll Records, select File > Count, and verify that you find zero records.

In the payroll archive company, open 5-2-2 Payroll Records, select File > Count, and compare this record count to
the record count done in the preparation steps above.

In the archive company, print the 5-1-2-41 Payroll Check Register~Totals Page report and compare it to the one
printed during preparation. If the verification of the record count andPayroll Check Register report do not match what was
expected, there was a problem during the close process. Restore themost recent backupmade before closing payroll and
re-close by starting with the Payroll Close steps.

NOTE: If a backup needs to be restored, and the file re-closed, delete the payroll archive company file created during the
payroll close process as it is not a valid or correct file.

Backup and validate files

Back up and validate your current and archive company files.

New Calendar Year Preparation

Install year-end tax update

Install the year-end tax update included in the software notice.

Rebuild indexes

When you open your current company for the first time, you will be prompted to rebuild indexes. Click Start to rebuild all
tables.

Update payroll calculations

Update any state or local payroll calculations, as needed, in 5-3-1 Payroll Calculations. Delete calculations that will
no longer be used or update rates if required.

Adjust theDefault Max to the correct maximums for the selectedMax Type. Save the calculations, recall the
calculations, and select Options > Update Employees > ALL Employees.

IMPORTANT: Updating employee calculations using 5-3-1 Payroll Calculations > Options > Update Employees
for calculations that involve different rates per employee can cause values to be reset to zero. For example, updating
the employee 401 (k) maximum will cause this to happen because the setting varies per employee. If you have
variable rates on your payroll calculations, do not update your employee rates from 5-3-1 Payroll Calculations.
Calculations that involve different rates per employee need to be updated in each employee's record on the
Calculations tab of 5-2-1 Employees.

NOTES:

l Maximums for the new year can be found by searching on the topic at http://www.irs.gov/.

l TheDefault Maxmay need to be updatedmanually with employees who are having wages garnished.

http://www.irs.gov/
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Change security in the archive company

If required, change security in the archive company by changing the rights of all user groups in 7-3-1 Security Groups
toNo forSave, Delete, Void, Change Period, andPrint Checks. This prevents users from accidentally saving or printing
records in the archive.

By setting Groups toNo, reports can still be printed, but checks cannot be printed. Then each user will have access to
everything they had access to before closing. They will be able to print reports but only view checks.

For additional security, in 7-3-2 User List, change the password for the supervisor.

Print year-end reports

Print required year-end reports:

l W-2s from 5-4-1 Federal Forms

l 1099 from 4-5 Vendor 1099 Forms

l 941 from 5-4-1 Federal Forms

Preparing payroll for the new calendar year

Before you process your first payroll in the new year, we recommend that you adjust rates for unemployment, adjust
thresholds for payroll calculations, and reset vacation and sick accrual.

Make the corrections and adjustments from themenu optionPayroll Calculations (5-3-1) in your active company folder:

l Correct State Unemployment default rates and default maximums. Do not forget to select Options > Update
Employees > Employeeswith this calculation after saving the changes.

l Correct Social Security default maximums. Do not forget to select Options > Update Employees > All
Employees after saving the changes.

l Correct State Disability Insurance default rates and default maximums. Do not forget to select Options > Update
Employees > Employeeswith this calculation after saving the changes.

l Correct 401K default maximums. After saving the changes and only if all employees with this calculation have the
samemaximum, select Options > Update Employees > Update Maximum Only > All Employeeswith this
calculation. Do not update the rate from 5-3-1 because this has to be done for each individual employee in the 5-2-1
> Compensation tab.

l Delete, alter, or add payroll calculations (5-3-1). If the changes apply to all employees with these calculations,
carefully select the appropriate update option from theOptionsmenu.

l Reset sick and vacation accrual for eligible employees (5-2-1 > Compensation tab) only if leftover hours do not
carry over to the next year.

l Adjust Employees (5-2-1) calculationmaximums to reflect what has been collected in prior years on the
Calculations tab. For example, youmay need to adjust employee loan repayment or employee garnishment
maximums.

NOTE: Formore information on closing the payroll year, look in Help and search for “closing.”

Processing vendor 1099s at calendar year end

At the end of the calendar year, finish entering all vendor payments for the calendar year, back up the company data, and
close the payroll. Verify the vendor 1099 balances and print the 1099s.
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To process vendor 1099s at calendar year end:

1 Back up the company data, close the payroll, and create your payroll archives. If your fiscal year ends at the same time
as the calendar year (December 31), advance the fiscal period and create the necessary accounting archives before
printing your 1099s (recommended).

2 If you have already archived your fiscal year, open the archive company then open 4-1-5 Vendor Payment Journal and
do the following steps; otherwise, proceed to step 3:

a In your archive company, select the 4-1-5-61 Vendor 1099 Payments report.

b Print the report.

c Review the report for accuracy.

d If you discover any discrepancies in the vendor 1099 amounts listed, open 4-4 Vendors (Accounts Payable) and
select the vendor; then select Options > 1099 Balance Startup/Adjustment andmake the correction.

e Open 4-5 Vendor 1099 Forms to process your 1099s.

3 If you have not yet archived your fiscal year—either because your fiscal year does not end on your calendar year or
because you have not yet archived your data—perform the following steps:

a In your current company, select the 4-1-5-61 Vendor 1099 Payments report.

b Print the report.

c Review the report for accuracy.

d If you discover any discrepancies in the vendor 1099 amounts listed, open 4-4 Vendors (Accounts Payable) and
select the vendor; then select Options > 1099 Balance Startup/Adjustment andmake the correction.

e Open 4-5 Vendor 1099 Forms to process your 1099s.

If your fiscal year does not end on the calendar year, youmay need to perform steps 2 and 3, depending on when you last
archived your data, to ensure you get all vendor 1099 balances for the calendar year.

TIP: Print an individual vendor payment journal for each vendor, andmail it to the vendor for additional verification.
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Combined General Ledger, Payroll, and 1099 Year End

Preparation for General Ledger, Payroll, and 1099 Year End

The following instructions assume that these steps are performed at the Sage 100 Contractor server location. Sage 100
Contractor strongly recommends this method because it avoids network irregularities that can disrupt the closing process.

IMPORTANT: Youmust have exclusive access to your company file to perform these steps.

Each task listed below should be completed in preparation for a combined fiscal year end and calendar year end. Resolve
audit errors as found during each step.

l Verify Posting Period

l Backup and verification

l Record counts

l Inventory audit (optional)

l Verify checks

l Job status and removal

l Payroll Audit

l Reconcile quarterlies

l Employee status and removal

l Verify vendor information

l Print reports for after-close verification

NOTE: These steps assume you will not have your bank statement before your year end. If you have your bank
statement, youmay complete your bank reconciliation before your year end in the current company or after you
archive your fiscal year in the new company file. If you do your bank reconciliation after you archive your data, the
archive file is not updated. If you want the archive file updated, you will need to do the bank reconciliation again in your
archive.

Verify Posting Period

In 1-6 Period and Fiscal Year Maintenance > Change Period, the posting periodmust be set toPeriod 12.

Backup and verification

Back up and validate your company file by following your regular backup and verification procedures.

Record Counts

On the 5-2-2 Payroll Recordswindow, select File > Count, and then write down the record number counts. This
record count will be used for verification after closing payroll.

Inventory Audit (optional)

If you use inventory, open 12-5 Inventory Audit, click Audit.

Verify checks

Verify that there are no unprinted checks.
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To find and resolve unprinted checks:

1 Open 2-5 General Journals.

2 Print the 2-5-21 General Journal report with the following settings:

a In theAccount box, use the range for all cash accounts listed in 1-8 General Ledger Setup.

b In the Trans# box, select Equal, and type 0000.

c In theCredit box, select Greater or =, and type $0.01.

3 If the transaction is an unprinted check, open 1-1 Checks/Bank Charges and click thePrint Records button to print the
check if desired. If you don’t need to print a check, open 1-3 Ledger Transactions, and change the Trans# to anything
other than 0000.

NOTE: If it is aSource 16-Payroll, click on theGo To Source button to change theCheck#. It's highly unusual that
the check number would have been changed to 0000 unless the check had to be reprinted immediately.

Job status and removal

Verify that the status on each job in 3-5 Jobs (Accounts Receivable) is correct. Any job that should be removed at
year-endmust have a status of 6-Closed or 2-Refused.

NOTE: If you need to change several jobs' statuses to 6-Closed, you can use a Picklist window to closemultiple jobs
at once. To access this command, open 3-5 Jobs (Accounts Receivable) and select Update > Closed Status.

Payroll Audit

Open 5-3-7 Payroll Audit, and click Audit.
NOTE: If Payroll is outsourced, it is okay to close with payroll audit errors.

IMPORTANT: If there are audit errors, resolve them before continuing.

Period Audit Errors

Some audit errors refer specifically to periods. If period audit errors exist, theAudit report displays them prominently. For
example, a period audit error will contain the wordPeriod in the row.

You can resolvemost period audit errors by recalculating the ledger balances. To recalculate the ledger balances, open 1-6
Period and Fiscal Year Maintenance > Recalculate Balances, and then click Recalculate Balances.

Audit Errors Requiring Customer Support Assistance to Repair

Any remaining audit errors cannot be repaired by clickingRecalculate Balances on 1-6 Period and Fiscal Year
Maintenance > Recalculate Balances. These audit errors might originate in accounts receivable, jobs, vendors, service
clients, equipment, or other areas of the program where transactions originate.

CAUTION: Resolving remaining audit errors after a repair requires assistance from Customer Support. You can
contact Customer Support at 800-866-8049. Be prepared to provide your company name, telephone number, and the
company contact person. At that time, a Customer Support technicianmay request additional reports to help
determine the cause of the error.

Additional audit error reports are now included with Sage 100 Contractor to assist Customer Support technicians in
identifying the transaction sources of audit errors.

Reconcile quarterlies

Reconcile quarterlies.
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Employee status and removal

Review employee statuses in 5-2-1 Employees, and change employee statuses as needed.

If you want to remove employees, they must have a status of Quit, Laid Off, Terminated, orDeceased.

Verify vendor information

Verify Vendor Tax ID andVendor 1099 Types by printing the 4-1-1-31 Vendor List report.

IMPORTANT: Be sure to verify that the tax ID for each vendor is correct. For more information, see the Help topic,
About 1099 types.

Verify 1099 balances using the 4-1-5-21 Vendor Payment report by date.

Print reports for after year-end verification

Print the following reports to use for verification purposes after year end:

l 2-2-21 Balance Sheet report for period 12

l 2-3-21 Income Statement report for periods 1 through 12

l 3-1-3-26 AR Invoice Aging report for period 12

l 4-1-3-26 AP Invoice Aging report for period 12

NOTE: If you pay retainage in the next year for a prior year invoice and then print this report for the prior year,
the report will show a reduced Retention amount, and the amount paid in the future period is allocated to the
Current period or an aging period. Therefore, you should always print these reports as part of your year-end
processing to ensure that you have a set of reports that reflect the true amount of retainage outstanding at year
end.

l 5-1-2-41 Payroll Check Register report with totals for status equal to 3-Posted

l 6-1-6-21 Job Cost Totals report for periods 1 through 12

l 11-1-3-26 Service Invoice Aging report for period 12, if you use Service Receivables

TIP: If you archive your data at year end, you can also print the reports from the Archive, later.

General Ledger actions for combined fiscal year end and calendar year end

Back up your Sage 100 Contractor data

Back up and verify two copies of your Sage 100 Contractor data. Put one copy in a safe storage area. Save at least one
of your backups to a separate removable storage device.

NOTE: A backup created at this point can be used to verify whether or not the program has data problems during the
year-end process. You can use this backup to verify data integrity.

Advance the Fiscal Period

Open 1-6 Period and Fiscal Year Management > Change Period; and under Change period to, select period1 of
the next fiscal year.

You are now in the current fiscal year in your company file. Payroll will be closed from the current fiscal year company file.
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Archive your fiscal year (recommended)

You can perform this step at any time; however, Sage recommends archiving your data after advancing your fiscal period.
Sage 100 Contractor moves the oldest 12 periods of data into a separate archive company. If you havemore than 12
periods of data to archive, perform this stepmore than once.

Open 1-6 Period and Fiscal Year Management > Archive Fiscal Year. Perform all steps in the wizard, including
selecting the appropriate maintenance options for removing invoices, purchase orders, or job-related records.

NOTE: There are different ways to name your archive company file. We suggest it include the following information. For
example, you could name it “2013GL [Your Company Name]” or “2013 PR [Your Company Name].”
- The year of the archive file.
- The type of archive file you aremaking.
- The name of the company.

IMPORTANT: Do not rebuild indexes for your company database at this time, even if prompted. Rebuilding indexes
for the company database will be performed later in the process.

Payroll Close for combined fiscal year end and calendar year end

IMPORTANT: Before you begin to close your calendar year in payroll, make sure that you are in your current
company and not in your archive company.

Select employee removal options and close payroll

During close, the program removes the employee records from 5-2-2 Payroll Records and resets all employeeYear to
Date totals.

Open 5-3-8 Close Payroll Year, and enter and archive name.

Select Employee removal options, and click Close Payroll.

Rebuild Indexes

Open 7-4 Rebuild Indexes, and select Options > Rebuild All Tables > Start.
NOTE: You are now in the new year for your payroll and fiscal years.

Verification tasks for year end

After finishing the year-end process, you can verify the process was successful by doing the following tasks.

Verification tasks in the new company

Open 3-5 Jobs (Accounts Receivable), and verify that the jobs you selected to be removed have been removed.

Open 5-2-2 Payroll Records, select File > Count and verify that you find zero records.

New Calendar Year Preparation

Install year-end tax update

Install the year-end tax update included in the software notice.

Rebuild indexes

When you open your current company for the first time, you will be prompted to rebuild indexes. Click Start to rebuild all
tables.
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Update payroll calculations

Update any state or local payroll calculations, as needed, in 5-3-1 Payroll Calculations. Delete calculations that will
no longer be used or update rates if required.

Adjust theDefault Max to the correct maximums for the selectedMax Type. Save the calculations, recall the
calculations, and select Options > Update Employees > ALL Employees.

IMPORTANT: Updating employee calculations using 5-3-1 Payroll Calculations > Options > Update Employees
for calculations that involve different rates per employee can cause values to be reset to zero. For example, updating
the employee 401 (k) maximum will cause this to happen because the setting varies per employee. If you have
variable rates on your payroll calculations, do not update your employee rates from 5-3-1 Payroll Calculations.
Calculations that involve different rates per employee need to be updated in each employee's record on the
Calculations tab of 5-2-1 Employees.

NOTES:

l Maximums for the new year can be found by searching on the topic at http://www.irs.gov/.

l TheDefault Maxmay need to be updatedmanually with employees who are having wages garnished.

Change security in the archive company

If required, change security in the archive company by changing the rights of all user groups in 7-3-1 Security Groups
toNo forSave, Delete, Void, Change Period, andPrint Checks. This prevents users from accidentally saving or printing
records in the archive.

By setting Groups toNo, reports can still be printed, but checks cannot be printed. Then each user will have access to
everything they had access to before closing. They will be able to print reports but only view checks.

For additional security, in 7-3-2 User List, change the password for the supervisor.

Print year-end reports

Print required year-end reports:

l W-2s from 5-4-1 Federal Forms

l 1099 from 4-5 Vendor 1099 Forms

l 941 from 5-4-1 Federal Forms

Preparing payroll for the new calendar year

Before you process your first payroll in the new year, we recommend that you adjust rates for unemployment, adjust
thresholds for payroll calculations, and reset vacation and sick accrual.

Make the corrections and adjustments from themenu optionPayroll Calculations (5-3-1) in your active company folder:

l Correct State Unemployment default rates and default maximums. Do not forget to select Options > Update
Employees > Employeeswith this calculation after saving the changes.

l Correct Social Security default maximums. Do not forget to select Options > Update Employees > All
Employees after saving the changes.

l Correct State Disability Insurance default rates and default maximums. Do not forget to select Options > Update
Employees > Employeeswith this calculation after saving the changes.

l Correct 401K default maximums. After saving the changes and only if all employees with this calculation have the
samemaximum, select Options > Update Employees > Update Maximum Only > All Employeeswith this

http://www.irs.gov/
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calculation. Do not update the rate from 5-3-1 because this has to be done for each individual employee in the 5-2-1
> Compensation tab.

l Delete, alter, or add payroll calculations (5-3-1). If the changes apply to all employees with these calculations,
carefully select the appropriate update option from theOptionsmenu.

l Reset sick and vacation accrual for eligible employees (5-2-1 > Compensation tab) only if leftover hours do not
carry over to the next year.

l Adjust Employees (5-2-1) calculationmaximums to reflect what has been collected in prior years on the
Calculations tab. For example, youmay need to adjust employee loan repayment or employee garnishment
maximums.

NOTE: Formore information on closing the payroll year, look in Help and search for “closing.”

Processing vendor 1099s at calendar year end

At the end of the calendar year, finish entering all vendor payments for the calendar year, back up the company data, and
close the payroll. Verify the vendor 1099 balances and print the 1099s.

To process vendor 1099s at calendar year end:

1 Back up the company data, close the payroll, and create your payroll archives. If your fiscal year ends at the same time
as the calendar year (December 31), advance the fiscal period and create the necessary accounting archives before
printing your 1099s (recommended).

2 If you have already archived your fiscal year, open the archive company then open 4-1-5 Vendor Payment Journal and
do the following steps; otherwise, proceed to step 3:

a In your archive company, select the 4-1-5-61 Vendor 1099 Payments report.

b Print the report.

c Review the report for accuracy.

d If you discover any discrepancies in the vendor 1099 amounts listed, open 4-4 Vendors (Accounts Payable) and
select the vendor; then select Options > 1099 Balance Startup/Adjustment andmake the correction.

e Open 4-5 Vendor 1099 Forms to process your 1099s.

3 If you have not yet archived your fiscal year—either because your fiscal year does not end on your calendar year or
because you have not yet archived your data—perform the following steps:

a In your current company, select the 4-1-5-61 Vendor 1099 Payments report.

b Print the report.

c Review the report for accuracy.

d If you discover any discrepancies in the vendor 1099 amounts listed, open 4-4 Vendors (Accounts Payable) and
select the vendor; then select Options > 1099 Balance Startup/Adjustment andmake the correction.

e Open 4-5 Vendor 1099 Forms to process your 1099s.

If your fiscal year does not end on the calendar year, youmay need to perform steps 2 and 3, depending on when you last
archived your data, to ensure you get all vendor 1099 balances for the calendar year.

TIP: Print an individual vendor payment journal for each vendor, andmail it to the vendor for additional verification.
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1-7 General Ledger Accounts

Learning about Ledger and Subsidiary Accounts
In the 1-7 General Ledger Accountswindow, you can view a summary of activity for an account broken down by fiscal
period. As an aid to organizing the financial data, you can use subsidiary accounts or departments.

You canmanually enter a budget for each ledger account that takes into consideration the activity of each period within the
fiscal year. Over the course of the fiscal year, you can generate reports detailing the budget versus actual account activity.
Sage 100 Contractor also stores period balances for the previous fiscal year. When you close the books at the fiscal year-
end, Sage 100 Contractor transfers the period balances from the This Year column to the Last Year column.

Comparisons between the account activity of the current year and the budget or account activity for the prior year provide a
valuable way for you to analyze the company finances. The comparisons enable you to create budgets with greater
accuracy, determine areas in the company that are over or under budgeted, and compare projections to the actual activity.

Because the 1-7 General Ledger Accountswindow only displays account activity, you cannot enter adjusting entries in
this window. If you need to correct a period balance, you can enter the transaction using the 1-3 Journal Transactions
window.

In ledger accounts, you can organize data using departments or subsidiary accounts. Departments allow you to group data
across the income and expense accounts, whereas subsidiary accounts allow you to divide data under a single, controlling
ledger account. Sage 100 Contractor also allows you to set up summary accounts, which allow you to combine ledger
accounts for financial reports.

Ledger accounts are divided into two categories: permanent accounts (also called balance sheet accounts) and temporary
accounts (also called profit and loss or income statements). Assets, liabilities, and equity accounts are referred to as
permanent accounts. With permanent accounts, a period’s ending balance carries forward to become the beginning balance
for the following period. Therefore, the period balances provide you with a running total over the course of a fiscal year.

The income and expense accounts are referred to as temporary accounts. With temporary accounts, the balance for each
period is recorded separately. When a period closes, the following period starts with a zero balance. Temporary accounts
only provide the activity for each individual period and not the year to date.

When you choose a pre-built chart of accounts, Sage 100 Contractor creates the ledger accounts. You can then edit the
ledgers to create the type of accounts needed. When you post the first transaction to a company’s books, Sage 100
Contractor locks the system of ledger account ranges. To change the account number for a ledger account after having
posted a transaction to it, create a new ledger account manually and transfer the balance through an adjusting journal entry.

You can rename a ledger account at any time. Sage 100 Contractor uses the short name forPicklists andmost accounting
reports, and uses the long name for theBalance Sheet, Financial Report, and Income Statement reports.

Subsidiary: If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must be set
up before posting transactions. In theSubsidiary list, click departments or subsidiary accounts.

Summary Account: Using summary accounts, you can combinemultiple ledgers into a single ledger for generating a
financial report in 2-8 Financial Reports. When you generate a financial report, Sage 100 Contractor looks to the
Summary Account box in each ledger. If Sage 100 Contractor finds an account number, it combines the balance of that
account into the indicated summary account.

Account Type: Displays the account range to which an account belongs and whether the account maintains a debit or
credit balance. Ledger accounts that fall within specific account ranges are assigned certain properties:
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l Ledgers in theCash Accounts range cannot use subsidiary accounts.

l When posting toWIP Assets orDirect Expense ranges, Sage 100 Contractor requires you to create job costs
before posting transactions.

l When posting to equipment accounts, Sage 100 Contractor requires you to create equipment costs.

Starting Balance: Displays the account balance at the beginning of the fiscal year, and that balance does not change by
posting transactions to period zero.

Beginning Balance: Displays the account balance at the beginning of the fiscal year. The beginning balance is adjusted to
reflect any postings made to period zero. Temporary accounts start with a $0 balance, and permanent accounts carry
forward the ending balance from the prior fiscal year.

Ending Balance: Displays the ending balance as it appears in period 12 for permanent accounts. It is important to note
that with temporary accounts, Sage 100 Contractor displays the total of all period balances. Posting to period 0 changes the
beginning balances of the active company, and changes the ending balances in the archived company.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

About account ranges
You can set up the ranges for the ledger accounts. TheAccount Range boxes determine the overall range of accounts for
the entire chart of accounts. If you are creating a chart of accounts manually, indicate the lowest and highest account
numbers in the range. Then set the individual accounts ranges within the chart of accounts. The range for a chart of
accounts usually begins with one (100, 1000, or 10,000) and ends with eight (800, 8000, or 80,000). You can create ledger
accounts that use up to ten digits. The range of the largest chart of accounts that you can create is 1,000,000,000 to
9,999,999,999.

When an account is set up, its account number cannot exceed the range limit. Suppose theCurrent Liabilities range of
accounts is from 200 to 249. You cannot create a current liability using an account number below 200 or above 249.

NOTE: You cannot use decimals in the account numbers.

Designating ledger accounts to accept departments
After you determine that your company is going to use departments to track income and expenses, youmust designate
which ledger accounts will accept departments.

IMPORTANT: Before you create departments, youmust designate ledger accounts to accept departments.

To designate ledger accounts to accept departments:
1 Open 1-7 General Ledger Accounts.

2 Open the account that you want to designate to accept departments.

3 In the Subsidiary box drop-downmenu, select 2-Departments and then click Save.

4 Repeat steps 1 through 3 to designate other accounts.
To create a ledger account:
1 Open 1-7 General Ledger Accounts.

2 In the data control box, enter the ledger account number.

3 In theShort Name box, enter a brief description of the ledger account.
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4 If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must be set up before
posting transactions. In theSubsidiary list, click 1-Subaccounts or 2-Departments.

5 On the Filemenu, click Save.

TIP: Summary accounts let you combine ledger accounts for reports.

Creating summary accounts
Using summary accounts, you can combinemultiple ledgers into a single ledger for generating a financial report in 2-8
Financial Reports. When you generate a financial report, Sage 100 Contractor looks to theSummary Account box in
each ledger. If Sage 100 Contractor finds an account number, it combines the balance of that account into the indicated
summary account.

Suppose that you have four cash accounts: 1000-General Checking, 1002-Payroll Checking, 1011-Petty Cash, and
1020-Savings. To combine all the cash account balances into the General Checking ledger account, enter [1000] in the
Summary Account box of thePayroll Checking, Petty Cash, andSavings ledger accounts.

Youmust always use the lowest account number of the ledgers you want to combine. In the above example, the cash
accounts used 1000-General Checking for the summary account because it had the lowest account number.
To combine ledger accounts into a summary account:
1 Open 1-7 Ledger Accounts, and select the account.

2 In theSummary Account box, enter the ledger account number to which you want to add the current account balance.

3 On the Filemenu, click Save.

TIPS:
l The Financial Report uses the long name of each account. Before printing the report, you can change the long

name of each summary account to accurately represent the data.

l The Financial Report gives you the ability to produce a single report that combines two or more companies.

l If you produce summarized reports frequently, create accounts dedicated to this purpose. Dedicated summary
accounts eliminate the need to rename summary accounts each time you produce a report.

About controlling accounts
A controlling account is a ledger account in the general ledger that summarizes the balances for a group of similar
subsidiary accounts. With specific, dedicated controlling accounts, the program uses the accounts you designate to
automatically post certain transactions to the correct ledger accounts.

When you select a pre-built chart of accounts, Sage 100 Contractor assigns the account numbers to the ledger accounts.
You can change the account numbers during setup; each account numbermust fall within the correct range.

UnderControlling Accounts, Sage 100 Contractor uses the accounts you designate to automatically post certain
transactions to the correct ledger accounts. For example, when you post a receivable invoice, you do not need to supply the
accounts receivable ledger account. After posting a transaction to the general ledger, Sage 100 Contractor locks the
account numbers for the accounts underControlling Accounts. The account numbers will appear shaded.

You can change the account numbers on theReceivables, Payables, Equipment, and Inventory tabs whether or not you
have posted transactions. If you change the account number on theReceivables, Payables orEquipment tabs, you will
have tomove the balances to the new account through a journal transaction.
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Verifying the date and period
When you save a transaction, Sage 100 Contractor can compare the transaction date to the period to ensure you post to the
correct period. If the transaction date does not fall under the correct posting period, Sage 100 Contractor provides a
warning, but does not prevent posting the transaction.

To verify the date and period, in the 1-8 General Ledger Setupwindow, select theVerify Date/Period check box.

Adding ledger accounts to an existing account structure
When you first set up your account structure, you would typically use the pre-build chart of accounts. The pre-build chart of
accounts may not have all the accounts that you need for your business needs; however, you can add ledger accounts to
the your existing account structure.

To add a ledger account to an existing account structure:
1 Open 1-7 General Ledger Accounts, and click the data control drop-down arrow.

2 On the Ledger Accountswindow, review the account numbers that are available in theCurrent Liabilities range. If you
have three business credit cards by three different issuers, determine three account numbers to use.

3 Close the Ledger Accountswindow, and in the data control box, enter a ledger account number.

4 In theShort Name and Long Name boxes, type names.
For example, for a bank issued credit card, you could type, “Bank name—VISA.”

5 Press Ctrl+S or File > Save.

Deleting ledger accounts
You cannot delete an account if it has a balance or any activity during the fiscal year.
To delete a ledger account:
1 Open 1-7 General Ledger Accounts.

2 Using the data control, select the ledger account number.

3 On theEditmenu, click Delete Account.

About general ledger accounts

In the 1-7 General Ledger Accountswindow, you can view a summary of activity for an account broken down by fiscal
period. As an aid to organizing the financial data, you can use subsidiary accounts or departments.

You canmanually enter a budget for each ledger account that takes into consideration the activity of each period within the
fiscal year. Over the course of the fiscal year, you can generate reports detailing the budget versus actual account activity.
Sage 100 Contractor also stores period balances for the previous fiscal year. When you archive at the fiscal year-end, Sage
100 Contractor transfers the period balances from the This Year column to the Last Year column.

Comparisons between the account activity of the current year and the budget or account activity for the prior year provide a
valuable way for you to analyze the company finances. The comparisons enable you to create budgets with greater
accuracy, determine areas in the company that are over or under budgeted, and compare projections to the actual activity.

Because the 1-7 General Ledger Accountswindow only displays account activity, you cannot enter adjusting entries in
this window. If you need to correct a period balance, you can enter the transaction using the 1-3 Journal Transactions
window.

In ledger accounts, you can organize data using departments or subsidiary accounts. Departments allow you to group data
across the income and expense accounts, whereas subsidiary accounts allow you to divide data under a single, controlling
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ledger account. Sage 100 Contractor also allows you to set up summary accounts, which allow you to combine ledger
accounts for financial reports.

Learning more about ledger accounts

Ledger accounts are divided into two categories: permanent accounts (also called balance sheet accounts) and temporary
accounts (also called profit and loss or income statements). Assets, liabilities, and equity accounts are referred to as
permanent accounts. With permanent accounts, a period’s ending balance carries forward to become the beginning balance
for the following period. Therefore, the period balances provide you with a running total over the course of a fiscal year.

The income and expense accounts are referred to as temporary accounts. With temporary accounts, the balance for each
period is recorded separately. When a period closes, the following period starts with a zero balance. Temporary accounts
only provide the activity for each individual period and not the year to date.

When you choose a pre-built chart of accounts, Sage 100 Contractor creates the ledger accounts. You can then edit the
ledgers to create the type of accounts needed. When you post the first transaction to a company’s books, Sage 100
Contractor locks the system of ledger account ranges. To change the account number for a ledger account after having
posted a transaction to it, create a new ledger account manually and transfer the balance through an adjusting journal entry.

You can rename a ledger account at any time. Sage 100 Contractor uses the short name forPicklists andmost accounting
reports, and uses the long name for theBalance Sheet, Financial Report, and Income Statement reports.

Subsidiary: If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must be set
up before posting transactions. In theSubsidiary list, click departments or subsidiary accounts.

Summary Account: Using summary accounts, you can combinemultiple ledgers into a single ledger for generating a
financial report in 2-8 Financial Reports. When you generate a financial report, Sage 100 Contractor looks to the
Summary Account box in each ledger. If Sage 100 Contractor finds an account number, it combines the balance of that
account into the indicated summary account.

Account Type: Displays the account range to which an account belongs and whether the account maintains a debit or
credit balance. Ledger accounts that fall within specific account ranges are assigned certain properties:

l Ledgers in theCash Accounts range cannot use subsidiary accounts.

l When posting toWIP Assets orDirect Expense ranges, Sage 100 Contractor requires you to create job costs
before posting transactions.

l When posting to equipment accounts, Sage 100 Contractor requires you to create equipment costs.

Starting Balance: Displays the account balance at the beginning of the fiscal year, and that balance does not change by
posting transactions to period zero.

Beginning Balance: Displays the account balance at the beginning of the fiscal year. The beginning balance is adjusted to
reflect any postings made to period zero. Temporary accounts start with a $0 balance, and permanent accounts carry
forward the ending balance from the prior fiscal year.

Ending Balance: Displays the ending balance as it appears in period 12 for permanent accounts. It is important to note
that with temporary accounts, Sage 100 Contractor displays the total of all period balances. Posting to period 0 changes the
beginning balances of the active company, and changes the ending balances in the archived company.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

About account ranges

You can set up the ranges for the ledger accounts. TheAccount Range boxes determine the overall range of accounts for
the entire chart of accounts. If you are creating a chart of accounts manually, indicate the lowest and highest account
numbers in the range. Then set the individual accounts ranges within the chart of accounts. The range for a chart of
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accounts usually begins with one (100, 1000, or 10,000) and ends with eight (800, 8000, or 80,000). You can create ledger
accounts that use up to ten digits. The range of the largest chart of accounts that you can create is 1,000,000,000 to
9,999,999,999.

When an account is set up, its account number cannot exceed the range limit. Suppose theCurrent Liabilities range of
accounts is from 200 to 249. You cannot create a current liability using an account number below 200 or above 249.

NOTE: You cannot use decimals in the account numbers.

Designating ledger accounts to accept departments

After you determine that your company is going to use departments to track income and expenses, youmust designate
which ledger accounts will accept departments.

IMPORTANT: Before you create departments, youmust designate ledger accounts to accept departments.

To designate ledger accounts to accept departments:

1 Open 1-7 General Ledger Accounts.

2 Open the account that you want to designate to accept departments.

3 In the Subsidiary box drop-downmenu, select 2-Departments and then click Save.

4 Repeat steps 1 through 3 to designate other accounts.

About controlling accounts

A controlling account is a ledger account in the general ledger that summarizes the balances for a group of similar
subsidiary accounts. With specific, dedicated controlling accounts, the program uses the accounts you designate to
automatically post certain transactions to the correct ledger accounts.

When you select a pre-built chart of accounts, Sage 100 Contractor assigns the account numbers to the ledger accounts.
You can change the account numbers during setup; each account numbermust fall within the correct range.

UnderControlling Accounts, Sage 100 Contractor uses the accounts you designate to automatically post certain
transactions to the correct ledger accounts. For example, when you post a receivable invoice, you do not need to supply the
accounts receivable ledger account. After posting a transaction to the general ledger, Sage 100 Contractor locks the
account numbers for the accounts underControlling Accounts. The account numbers will appear shaded.

You can change the account numbers on theReceivables, Payables, Equipment, and Inventory tabs whether or not you
have posted transactions. If you change the account number on theReceivables, Payables orEquipment tabs, you will
have tomove the balances to the new account through a journal transaction.

Working with Subsidiary Accounts

Using subsidiary accounts, you can arrange financial information into related categories under a single ledger account,
providing quick access to specific information. A ledger account that uses subsidiary accounts is known as the controlling
account. You use subsidiary accounts primarily with asset and liability accounts, but you can also use subsidiary accounts
with income and expense accounts.

NOTE: You cannot create subsidiary accounts for cash accounts.

Suppose that you want to track telephone expenses. You can split the telephone account into subsidiary accounts such as
Basic Service, Long Distance, Cellular, andPaging. The Telephone ledger account then provides you with the overall
expenses as well as a breakdown of the expenses by the subsidiary accounts.
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Sage 100 Contractor automatically sets up subsidiary accounts for accounts receivable, accounts payable, and service
receivables using the job, vendor, and client numbers as the subsidiary account numbers. However, Sage 100 Contractor
does not provide access to these subsidiary accounts through the Ledger Accountswindow because you can view the
subsidiary account balances in the Job, Vendor, andClientwindows. Sage 100 Contractor also sets up subsidiary
accounts forEquipment Assets, Equipment Depreciation, andEquipment Loans using the equipment numbers as the
subsidiary account numbers. Similarly, you view the subsidiary account balances for equipment in theEquipmentwindow.

Setting up subsidiary accounts takes careful planning. Like ledger accounts, you cannot change the subsidiary account
number after posting a transaction to a subsidiary account. It is important to note that you can always add subsidiary
accounts to an existing controlling account.

You cannot make a ledger account into a controlling account if that ledger account that has had any activity or carried a
balance. You can, however, create a new controlling account, set up subsidiary accounts, and transfer the balance from the
ledger account into the subsidiary accounts of the new controlling account.

Creating subaccounts automatically

Subaccounts can be created automatically when you create and save a job in the 3-5 Jobs (Accounts Receivable)
window, when the job is specified forWIP posting. This will create the subaccounts with the same job number and name as
the job.

To allow for the generation of subaccounts from 3-5 Jobs for any given general ledger account, youmust specify for each
general ledger account that you want to activate this feature.
To set up automatic subaccount generation:
1 Open 1-7 General Ledger Accounts.

2 Using the data control, select or specify the ledger account.

3 In theSubsidiary list, click 1-Subaccounts.

4 Select Job# as Subaccount#.

5 Repeat steps 2–3 for all general ledger accounts that you want to activate this feature for.

6 Open 3-5 Jobs (Accounts Receivable).

7 Using the data control, select or create the job.

8 Complete any necessary data.

9 Select Post expenses to WIP asset account.

10 On the Filemenu, click Save.

11 A prompt appears listing all the general ledger accounts that you designated as controlling accounts. You have the
option of automatically creating subaccounts under each of the displayed accounts.

12 Select OK.

TIP: When creating subaccounts, either manually or automatically, it is critical to plan wisely before youmake your
designations.

To view subsidiary accounts:
1 Open 1-7 General Ledger Accounts.

2 Select the ledger account.

3 Click theSubaccount button.
To delete a subaccount:
1 Open 1-7 General Ledger Accounts.
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2 Using the data control, locate the ledger account with the subaccount you want to delete.

3 Ledger accounts with subaccounts display 1 – Subaccounts in theSubsidiary box.

4 From theEditmenu, select Delete Account.

5 On the verify delete message, click Yes.

Transferring balances from ledger accounts to subsidiary accounts

IMPORTANT: Before you can transfer the balance from a ledger account to a subsidiary account, youmust create
the new controlling account and subsidiary accounts or departments.

To transfer balances from a ledger account to a subsidiary account:

1 Open 1-3 Journal Transactions.

2 In the Trans# box, enter the transaction number.

3 In theDate box, enter the transaction date.

4 In theDescription box, enter a brief statement about the transaction.

5 In the grid, create a line that clears the old ledger account’s balance:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the ledger account you want to clear.

c Enter the amount in the appropriateDebit Amount cell orCredit Amount cell.

6 In the grid, create as many lines as necessary tomove the balance into the appropriate subsidiary accounts under the
new controlling account:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the controlling account.

c In theSubaccount cell, enter the subsidiary account you want.

d Enter the amount in the appropriateDebit Amount cell orCredit Amount cell.

7 On the Filemenu, click Save.

Setting up controlling ledger accounts and subaccounts

IMPORTANT:

l You cannot create subsidiary accounts for accounts receivable, accounts payable, or equipment.

l If you transfer an account balance to a new controlling account with subsidiary accounts, do not delete the original
ledger account. The original account is necessary tomaintain a complete audit trail through the current fiscal year.

l If departments are set up during the fiscal year, departmental income statements will not include non-
departmentalized transactions.

To set up a controlling ledger account and subaccounts:

1 Open 1-7 General Ledger Accounts.

2 Using the data control, select the ledger account.

3 In theSubsidiary list, click 1-Subaccounts or 2-Departments.

4 On the Filemenu, click Save, and then recall the ledger account.
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5 On theOptionsmenu, click Subaccount.

6 In theSubsidiary Accountswindow, do the following tomanually create a subaccount:

a In the data control box, enter the subsidiary account or department number.

b In theShort Name box, enter the short name.

c In the Long Name box, enter the short name.

d On the Filemenu, click Save.

7 Repeat step 6 for each subsidiary account to be located under the controlling account.

TIPS:
TIPS:

l You can automatically create subaccounts for jobs that are using theWIP posting feature.

l To create a new ledger account, enter the account number in the data control box.

Verifying the date and period

When you save a transaction, Sage 100 Contractor can compare the transaction date to the period to ensure you post to the
correct period. If the transaction date does not fall in the correct posting period, Sage 100 Contractor provides a warning,
but does not prevent posting the transaction.

To verify the date and period, in the 1-8 General Ledger Setupwindow, select theVerify Date/Period check box.

Creating summary accounts

Using summary accounts, you can combinemultiple ledgers into a single ledger for generating a financial report in 2-8
Financial Reports. When you generate a financial report, Sage 100 Contractor looks to theSummary Account box in
each ledger. If Sage 100 Contractor finds an account number, it combines the balance of that account into the indicated
summary account.

Suppose that you have four cash accounts: 1000-General Checking, 1002-Payroll Checking, 1011-Petty Cash, and
1020-Savings. To combine all the cash account balances into the General Checking ledger account, enter [1000] in the
Summary Account box of thePayroll Checking, Petty Cash, andSavings ledger accounts.

Youmust always use the lowest account number of the ledgers you want to combine. In the above example, the cash
accounts used 1000-General Checking for the summary account because it had the lowest account number.

To combine ledger accounts into a summary account:

1 Open 1-7 Ledger Accounts, and select the account.

2 In theSummary Account box, enter the ledger account number to which you want to add the current account balance.

3 On the Filemenu, click Save.

TIPS:
l The Financial Report uses the long name of each account. Before printing the report, you can change the long

name of each summary account to accurately represent the data.

l The Financial Report gives you the ability to produce a single report that combines two or more companies.

l If you produce summarized reports frequently, create accounts dedicated to this purpose. Dedicated summary
accounts eliminate the need to rename summary accounts each time you produce a report.
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Adding ledger accounts to an existing account structure

When you first set up your account structure, you would typically use the pre-build chart of accounts. The pre-build chart of
accounts may not have all the accounts that you need for your business needs; however, you can add ledger accounts to
the your existing account structure.

To add a ledger account to an existing account structure:

1 Open 1-7 General Ledger Accounts, and click the data control drop-down arrow.

2 On the Ledger Accountswindow, review the account numbers that are available in theCurrent Liabilities range. If you
have three business credit cards by three different issuers, determine three account numbers to use.

3 Close the Ledger Accountswindow, and in the data control box, enter a ledger account number.

4 In theShort Name and Long Name boxes, type names.
For example, for a bank issued credit card, you could type, “Bank name—VISA.”

5 Press Ctrl+S or File > Save.

Deleting ledger accounts

You cannot delete an account if it has a balance or any activity during the fiscal year.

To delete a ledger account:

1 Open 1-7 General Ledger Accounts.

2 Using the data control, select the ledger account number.

3 On theEditmenu, click Delete Account.

1-8 General Ledger Setup
One of the first tasks when creating a new company in Sage 100 Contractor is to set up the general ledger structure. When
you select a pre-built ledger, Sage 100 Contractor creates the ledger accounts for you.

You can also set up the general ledger manually. If you choose to enter the account ranges, controlling accounts, and
posting accounts manually, Sage 100 Contractor will not create the ledger accounts. You will then need to create each
ledger account in the 1-7 General Ledger Accountswindow.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

NOTE: Unless you have prior experience setting up general ledgers, it is a good idea to choose a pre-built chart of
accounts.

Accounting setup considerations
Before you begin to set up your general ledger and other parts of accounting, there are several things that you should
consider. For example, what is your startup date? It is going to take days and perhaps a couple of weeks to set up your
company, so you need to have a startup date for your company in Sage 100 Contractor. You alsomust know your
company’s fiscal year-end. In addition, you’ll need to consider the amount of information that you plan to bring into Sage 100
Contractor and its level of detail.

Here is a list of suggested information:
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l Balance sheet and income statement as of now: If it’s currently mid-year, you have tomerge the income
statement from Sage 100 Contractor with the prior system for year-to-date reporting.

l Balance sheet as of beginning of fiscal year and year-to-date activity as of Sage 100 Contractor start date:
You do not needmonth-by-month income statements, and you do not need prior year history.

l Balance sheet as of the beginning of the fiscal year and activity for each month: You do not need details. All
detailed informationmust come from your prior system.

l Balance sheet as of beginning of fiscal year and all transactions: Starting up your accounting this way
requires a lot of work unless only a few hundred entries need to bemade.

In addition, you need the following information:

l A chart of accounts

l Listing of open accounts payable invoices

l Listing of accounts receivable invoices (including fully paid) for jobs that are in progress

l Job information: names, clients, and addresses

l Contract amounts

l Payroll information regarding employee balances, unions, company deductions, local taxes, and so forth.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

Pre-built chart of accounts
When you select the pre-built chart of accounts, Sage 100 Contractor automatically sets up the account ranges, controlling
account numbers, posting account numbers, and then creates the ledger accounts. You can thenmodify the ledger setup to
meet your particular needs. However, you will then need to edit the ledger accounts to match any changes made in the 1-8
General Ledger Setupwindow.

You can select from four different pre-built charts of accounts:

l General Contractor Accounts (Four-Digit or Five-Digit)

l Subcontractor Accounts (Four-Digit or Five-Digit)

l HomeBuilder Accounts

l Remodeler Accounts

After setting up the chart of accounts, you can edit account numbers, delete unnecessary accounts, and set up controlling
accounts for subsidiary accounts or departments in the 1-7 Ledger Accountswindow. If you change a controlling or
posting account number in 1-8 General Ledger Setup, youmust also change the ledger account number.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

Selecting pre-built general ledger structure
When you create a new company in Sage 100 Contractor, youmust set up aminimum number of items in addition to
selecting a chart of accounts. Youmust also set program defaults for the following:
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l Date for the Fiscal Year End.

l Set theCurrent Period, which is the program default posting period.

l Select an inventory Valuation Method (if you have the Inventory add-onmodule).

IMPORTANT: When you create a new company and set up accounting, youmust set the program default Current
Period. After that initial setup, you can only change theCurrent Period using 1-6 Period/Fiscal Year Management
> Change Period.

To select a pre-built general ledger structure:
1 Open 1-8 General Ledger Setup.

2 On theOptionsmenu, select one of the four pre-built chart of accounts.

3 Modify the account ranges.

IMPORTANT: Youmust make any changes to the account structure or to ledger accounts before posting
transactions to the general ledger.

4 In the Fiscal Year End box, enter the date of the fiscal year-end.

5 Do one of the following:

a To begin entering transactions for the current fiscal year, enter the number of the current period in theCurrent Period
box.

b To enter a few startup transactions, set the current period in theCurrent Period box. You can change the period in the
window of entry for individual transaction records without changing the programs default for the current posting period.

c To enter a large number of startup transactions, type 0 in theCurrent Period box. Then after entering the startup
transactions, enter the current accounting period in theCurrent Period box using 1-6 Period/Fiscal Year
Management.

6 On the Filemenu, click Save.

TIP: After selecting an account structure, print the entire chart of accounts from 2-7 Chart of Accounts. Review the
accounts and determine which accounts you want to edit or delete before you enter any transactions.

About posting periods
Based on the fiscal year-end date in the 1-8 General Ledger Setupwindow, Sage 100 Contractor determines the current
default posting period, which is used program-wide. TheCurrent Period in 1-8 General Ledger Setup corresponds to the
Change Period in 1-6 Period/Fiscal Year Management > Change Period.

NOTE: When you create a new company, youmust set the program default Current Period. After the initial setup,
you can only change theCurrent Period using 1-6 Period/Fiscal Year Management > Change Period. When you
create a new company from existing company data, the new company's default posting period is set to the same
posting period as the existing company. If you want to change the default posting period, you can only change it using
1-6 Period/Fiscal Year Management > Change Period.

In any accounting transactions window, such as 4-2 Payable Invoice/Credits, you can, if necessary, post individual
transaction records to a different posting period. The following bullet points describe some of the features related to posting
periods:

Accounting transaction windows contain aChange the posting period button that displays the posting period to which
you are posting transactions. By changing the posting period, you can post transactions to the specified period until you
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change the period again or close the window. When the window opens again, the posting period is set to the current default
posting period.

Users at different workstations can work in the samewindow and post to different periods. For example, while Andy and
Melissa are entering invoices in theAccounts Payable Invoiceswindow, Andy finds a few invoices that need posting to a
previous period. While Melissa continues entering invoices in the current fiscal period, Andy can change the fiscal period
and enter those invoices.

When you change the posting period to something other than the default current posting period, Sage 100 Contractor
changes the color of thePosting Period button to yellow.

At the end of the period, open 1-6 Period/Fiscal Year Management > Change Period and advance the current default
posting period to the next one.

When advancing to the next posting period, the program performs a complete audit of the books. If you discover audit
errors, you can view them and possibly repair the ledger balances at that time rather than at the end of the fiscal year.

IMPORTANT: We strongly recommend that you recalculate balances to repair discrepancies if they are discovered
during audits at the end of each posting period. Repairing audit errors as you advance to the next posting period is
muchmore efficient than waiting until the year-end close to repair a year’s worth of audit errors.

You can restrict users from posting transactions to previous or future periods.

If you have an archive from the previous year, you can simultaneously post transactions to period 0 of the current year and
period 12 in the archive.

When using Sage 100 Contractor across a network, changing the current period using 1-6 Period/Fiscal Year
Management > Change Period affects all workstations that access Sage 100 Contractor.

About starting balances
You can enter the starting balances for asset and liability accounts by posting a journal transaction—usually to period zero.
As journal transactions can contain up to 999 lines, it is possible to enter most starting balances in a single journal
transaction. Enter each account balance on a separate line.

Larger companies may not be able to enter the balances in one transaction. If you need to enter two journal transactions,
use a clearing account to create a balanced entry.

At the end of the first transaction, enter the clearing account number and the amount necessary to balance the transaction.
In the second journal transaction, finish entering the starting balances. Then at the end of the second transaction, enter the
clearing account number and the amount necessary to balance the transaction. After you complete the entry of the starting
balances, the clearing account returns to a zero balance.
To enter starting balances:
1 Open 1-3 Journal Transactions.

2 On theEditmenu, click PEriod. Select period 0.

3 In the Trans# box, enter the transaction number.

4 In theDate box, enter the transaction date.

5 In theDescription box, type Starting balances.

6 In theStatus list, click 1-Open.

7 In the grid, do the following:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the ledger account you want.
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c In theSubaccount cell, enter the subsidiary account you want.

d Enter the amount in the appropriateDebit Amount cell orCredit Amount cell.

8 Repeat step 7 for each account.

9 On the Filemenu, click Save.

Methods for entering financial activity for the current year
After you have entered the starting balances, enter the net activity of the ledger accounts for the current year. It is important
to note that you cannot directly enter the startup balances for the dedicated ledger accounts: Accounts Receivable,
Accounts Payable, Service Receivables, and Inventory.

You can choose from four methods for entering the net activity. Entering the current activity for ledger accounts is nearly
identical to entering the starting balances. Remember to adjust the posting period as necessary, and provide a description
of what is reflected in the period balances.

Each successivemethod provides more detail for reports than the previous method and requires more time to enter data.
Read each of themethods thoroughly before deciding which to use. Except where noted, youmust first enter the starting
balances of all the ledger accounts.

Method 1

When you post the starting balances, include all the period activity in the beginning balance. Post a single journal
transaction to the period before the current posting period. Suppose you are setting up a new company during period 2. The
net activity for period 1 is added to the starting balances. In the journal transaction, enter the total for each ledger account
(beginning balance + period one net activity) and post the transaction to the end of period 1.

Method 1 is best suited for use near the start of a fiscal year. Themethod does not include the entry of historical
information. It is not recommended for use during themiddle of the fiscal year.

Method 2

Post the starting balances to period 0; then post a journal transaction that contains the net activity for each ledger account
during the current fiscal year. Post the transaction to the period before the current posting period. Suppose you are setting
up during period 7. Create a journal transaction that contains the net activity for each account through the end of period 6.
Then post the journal transaction to the end of period 6.

Method 2 provides data for a Year-to-Date Income Statement, and lets you view the entire activity for the year, but does not
provide data for reports in periods before the setup.

When you close the books at the fiscal year-end, the balances roll over to the Last Year column in the Ledger Accounts
window. This method does not set up individual period balances, so the period balances do not represent the true period
activity.

Method 3

Post the starting balances to period 0; then in each of the prior periods, post a journal transaction that contains the net
activity of each ledger account for that period. Suppose you are setting up during period 7. Create and post a journal
transaction that contains the net activity for each account during period 1. Then repeat the process for periods 2 through 6.

Method 3 provides accurate period balances. Each account contains its correct period balances for the current fiscal year.
When you close books at the fiscal year-end, the balances roll over to the Last Year column in the Ledger Accounts
window. The ledger accounts therefore reflect the true activity in each period. This method lets you generate reports that
compare data from the previous year to data in the current year.
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Method 4

Post the starting balances to period 0; then enter each transaction for the current year. Method 4 requires a great deal of
work. This method is only practical when no accounting has been posted for the current year, or it is only a few weeks into
the new fiscal year.

About dedicated accounts
Sage 100 Contractor does not let you post journal transactions directly to theAccounts Receivable, Accounts Payable,
Service Receivables, or Inventory ledger accounts; you can only post to those accounts through invoices. Therefore,
entering the starting balances is a two-part process.

During the first part of the process, theAccounts Receivable, Accounts Payable, Service Receivables, and Inventory
balances are posted to clearing accounts. Later, the individual open invoices are posted against the clearing accounts,
thereby moving the balances into the proper accounts.

Similarly, you cannot directly post to the Inventory ledger account. Normally, youmove inventory into the accounting
system through payable invoices. For startup purposes, however, it is necessary to post a journal transaction to an
Inventory clearing account. Later, the inventory is posted against the clearing account and allocated to specific inventory
locations and parts, thereby moving the balances into the Inventory ledger account.

In this portion of the setup process, post the starting balances to the clearing accounts. If you are using a pre-built general
ledger structure, Sage 100 Contractor already has the necessary clearing accounts established. At the fiscal year-end, you
can delete the setup clearing accounts, as they are no longer needed.

IMPORTANT: After posting the invoice and allocations for inventory, your clearing accounts should have a zero
balance. If not, review your data to find out why.

About setting up accounts for posting equipment
Direct Equipment: Enter the ledger account to which you are posting equipment expenses attributable to a job.

When you enter a direct equipment expense in the 5-5 Daily Payroll or 8-4 Equipment Allocationwindows, Sage 100
Contractor posts a debit to the account in theDirect Equipment box, and a credit to the account in theEquipment
Revenue box.

Equipment Repair: Enter the ledger account to which you are posting equipment expenses attributable to equipment
repair or maintenance.

When you enter an equipment expense for repairs or maintenance in the 5-5 Daily Payroll or 8-4 Equipment Allocation
window, Sage 100 Contractor posts a debit to the account in theEquipment Repair box, and a credit to the account in the
Equipment Revenue box.

Equipment Revenue: Enter the ledger account to which you are posting equipment expenses.

When you enter an equipment expense, Sage 100 Contractor always posts the credit to the account in theEquipment
Revenue box.

About setting up accounts for posting payable invoices
Sage 100 Contractor uses the accounts indicated on thePayables tab in the 1-8 General Ledger Setupwindow to post
payable invoice transactions.

Workers’ Compensation: Enter the ledger account to which you are posting the charge to subcontractors forWorkers’
Compensation insurance.

Discounts Earned: Enter the ledger account to which you are posting discounts taken on payable invoices.
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PO Sales Tax Expense:When using the 12-4 Purchase Order Receiptswindow to enter materials received, Sage 100
Contractor posts sales taxes to the account indicated in thePO Sales Tax Exp. box.

Freight

WIP Cost Account: Enter theWIP cost account to which you are posting freight costs.

When posting the invoiced costs against a job, Sage 100 Contractor looks at theWIP Posting check box in the job file. If
you selected theWIP Posting check box, Sage 100 Contractor posts freight costs to the account in theWIP Cost
Account box.

Direct Cost Account: Enter the direct cost account to which you are posting freight costs.

When posting the invoiced costs against a job, Sage 100 Contractor looks at theWIP Posting check box in the job file. If
theWIP Posting check box is clear, Sage 100 Contractor posts freight costs to the account in theDirect Cost Account
box.

Overhead Costs Account: Enter the overhead cost account to which you are posting freight costs.

When posting the invoiced costs to overhead (posting the invoice without a job number), Sage 100 Contractor posts costs
to the account in theOverhead Cost Account box.

NOTE: When posting the invoiced costs against a job, Sage 100 Contractor assigns the total of the freight costs to
the first job cost record.

Variance

Variances inmaterials costs are posted to theOverhead Costs Account.

NOTE: Freight costs and the variance inmaterials costs each appear as separate lines in the journal transaction.

About setting up accounts for posting receivable invoices
Sales Tax Payable: Enter the ledger account to which you are posting sales tax.

Finance Charges: Enter the ledger account to which you are posting the finance charges.

When printing client statements, you can create the finance charges for overdue invoices. Select the Calculate Finance
Charges check box, and generate the statements. Sage 100 Contractor uses the finance rate set up in the job record to
compute the finance charge and create a separate invoice for the amount.

Discounts Given: Enter the ledger account to which you are posting discounts given to cash receipts.

WIP Payroll: Enter the ledger account to which you are postingWIP payroll.

When posting the invoiced costs against a job, Sage 100 Contractor looks at theWIP Posting check box in the job file. If
you selected theWIP Posting check box, Sage 100 Contractor posts payroll costs to the account in theWIP Payroll box.

Retained Earnings: Enter the ledger account to which you are posting the net profit when closing the books at the fiscal
year-end.

You can change the account numbers on the Receivables tab regardless of whether you have posted transactions. If you
change the account number, you have tomove the balances to the new account through a journal transaction.

Accounting setup considerations
Before you begin to set up your general ledger and other parts of accounting, there are several things that you should
consider. For example, what is your startup date? It is going to take days and perhaps a couple of weeks to set up your
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company, so you need to have a startup date for your company in Sage 100 Contractor. You alsomust know your
company’s fiscal year-end. In addition, you’ll need to consider the amount of information that you plan to bring into Sage 100
Contractor and its level of detail.

Here is a list of suggested information:

l Balance sheet and income statement as of now: If it’s currently mid-year, you have tomerge the income
statement from Sage 100 Contractor with the prior system for year-to-date reporting.

l Balance sheet as of beginning of fiscal year and year-to-date activity as of Sage 100 Contractor start date:
You do not needmonth-by-month income statements, and you do not need prior year history.

l Balance sheet as of the beginning of the fiscal year and activity for each month: You do not need details. All
detailed informationmust come from your prior system.

l Balance sheet as of beginning of fiscal year and all transactions: Starting up your accounting this way
requires a lot of work unless only a few hundred entries need to bemade.

In addition, you need the following information:

l A chart of accounts

l Listing of open accounts payable invoices

l Listing of accounts receivable invoices (including fully paid) for jobs that are in progress

l Job information: names, clients, and addresses

l Contract amounts

l Payroll information regarding employee balances, unions, company deductions, local taxes, and so forth.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

About general ledger setup
One of the first tasks when creating a new company in Sage 100 Contractor is to set up the general ledger structure. When
you select a pre-built ledger, Sage 100 Contractor creates the ledger accounts for you.

You can also set up the general ledger manually. If you choose to enter the account ranges, controlling accounts, and
posting accounts manually, Sage 100 Contractor will not create the ledger accounts. You will then need to create each
ledger account in the 1-7 General Ledger Accountswindow.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

NOTE: Unless you have prior experience setting up general ledgers, it is a good idea to choose a pre-built chart of
accounts.

Pre-built chart of accounts
When you select the pre-built chart of accounts, Sage 100 Contractor automatically sets up the account ranges, controlling
account numbers, posting account numbers, and then creates the ledger accounts. You can thenmodify the ledger setup to
meet your particular needs. However, you will then need to edit the ledger accounts to match any changes made in the 1-8
General Ledger Setupwindow.

You can select from four different pre-built charts of accounts:
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l General Contractor Accounts (Four-Digit or Five-Digit)

l Subcontractor Accounts (Four-Digit or Five-Digit)

l HomeBuilder Accounts

l Remodeler Accounts

After setting up the chart of accounts, you can edit account numbers, delete unnecessary accounts, and set up controlling
accounts for subsidiary accounts or departments in the 1-7 Ledger Accountswindow. If you change a controlling or
posting account number in 1-8 General Ledger Setup, youmust also change the ledger account number.

CAUTION: You cannot delete a chart of accounts after you set it up and save it, and you cannot edit it after you have
entered a transaction. Call Customer Support or your business partner if you needmore information.

About posting periods
Use the Posting Period window to select the period where you want to post your transactions.

In any accounting transactions window, such as 4-2 Payable Invoice/Credits, you can post individual transaction records
to a different posting period. For example, if you need to post a transaction to period 1 of a new fiscal year, but you are still
currently in period 12 of the current fiscal year, use this window to post the transaction to period 1 of the new fiscal year.

NOTE: If you want to change the default posting period for all transactions, you can only change it using 1-6 Period
and Fiscal Year Management > Change Period.

Period 1 of the next fiscal year becomes available only after you advance your current fiscal period to period 12 (see See
"Changing posting periods". Advance your current period to period 1 to make periods 2 through 12 available for the next
fiscal year.

To use Posting Period:

Select the period to which you want to post transactions and click [Select].

Important Posting Period features

The following bullet points describe some of the features related to posting periods:

n Accounting transaction windows contain aChange the posting period button that displays the posting period to which
you are posting transactions. By changing the posting period, you can post transactions to the specified period until you
change the period again or close the window. When the window opens again, the posting period is set to the current
default posting period.

n Users at different workstations can work in the samewindow and post to different periods. For example, while Andy and
Melissa are entering invoices in theAccounts Payable Invoiceswindow, Andy finds a few invoices that need posting to
a previous period. While Melissa continues entering invoices in the current fiscal period, Andy can change the fiscal
period and enter those invoices.

n When you change the posting period to something other than the default current posting period, Sage 100 Contractor
changes the color of thePosting Period button to yellow.

n At the end of the period, open 1-6 Period and Fiscal Year Management > Change Period and advance the current
default posting period to the next one.

n When advancing to the next posting period, the program performs a complete audit of the books. If you discover audit
errors, you can view them and possibly repair the ledger balances at that time rather than at the end of the fiscal year.
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IMPORTANT: We strongly recommend that you recalculate balances to repair discrepancies if they are discovered
during audits at the end of each posting period. Repairing audit errors as you advance to the next posting period is
muchmore efficient than waiting until year-end to repair a year’s worth of audit errors.

n You can restrict users from posting transactions to previous or future periods.

n If you have an archive from a previous year, you can post transactions to the archive; however, youmust open the
archive company first. Sage 100 Contractor does not post entries simultaneously to period 12 of an archive company and
period 0 of the current company.

n When using Sage 100 Contractor across a network, changing the current period using 1-6 Period and Fiscal Year
Management > Change Period affects all workstations that access Sage 100 Contractor.

Selecting pre-built general ledger structure
When you create a new company in Sage 100 Contractor, youmust set up aminimum number of items in addition to
selecting a chart of accounts. Youmust also set program defaults for the following:

l Date for the Fiscal Year End.

l Set theCurrent Period, which is the program default posting period.

l Select an inventory Valuation Method (if you have the Inventory add-onmodule).

IMPORTANT: When you create a new company and set up accounting, youmust set the program default Current
Period. After that initial setup, you can only change theCurrent Period using 1-6 Period/Fiscal Year Management
> Change Period.

To select a pre-built general ledger structure:
1 Open 1-8 General Ledger Setup.

2 On theOptionsmenu, select one of the four pre-built chart of accounts.

3 Modify the account ranges.

IMPORTANT: Youmust make any changes to the account structure or to ledger accounts before posting
transactions to the general ledger.

4 In the Fiscal Year End box, enter the date of the fiscal year-end.

5 Do one of the following:

a To begin entering transactions for the current fiscal year, enter the number of the current period in theCurrent Period
box.

b To enter a few startup transactions, set the current period in theCurrent Period box. You can change the period in the
window of entry for individual transaction records without changing the programs default for the current posting period.

c To enter a large number of startup transactions, type 0 in theCurrent Period box. Then after entering the startup
transactions, enter the current accounting period in theCurrent Period box using 1-6 Period/Fiscal Year
Management.

6 On the Filemenu, click Save.

TIP: After selecting an account structure, print the entire chart of accounts from 2-7 Chart of Accounts. Review the
accounts and determine which accounts you want to edit or delete before you enter any transactions.
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About starting balances
You can enter the starting balances for asset and liability accounts by posting a journal transaction—usually to period zero.
As journal transactions can contain up to 999 lines, it is possible to enter most starting balances in a single journal
transaction. Enter each account balance on a separate line.

Larger companies may not be able to enter the balances in one transaction. If you need to enter two journal transactions,
use a clearing account to create a balanced entry.

At the end of the first transaction, enter the clearing account number and the amount necessary to balance the transaction.
In the second journal transaction, finish entering the starting balances. Then at the end of the second transaction, enter the
clearing account number and the amount necessary to balance the transaction. After you complete the entry of the starting
balances, the clearing account returns to a zero balance.

About dedicated accounts
Sage 100 Contractor does not let you post journal transactions directly to theAccounts Receivable, Accounts Payable,
Service Receivables, or Inventory ledger accounts; you can only post to those accounts through invoices. Therefore,
entering the starting balances is a two-part process.

During the first part of the process, theAccounts Receivable, Accounts Payable, Service Receivables, and Inventory
balances are posted to clearing accounts. Later, the individual open invoices are posted against the clearing accounts,
thereby moving the balances into the proper accounts.

Similarly, you cannot directly post to the Inventory ledger account. Normally, youmove inventory into the accounting
system through payable invoices. For startup purposes, however, it is necessary to post a journal transaction to an
Inventory clearing account. Later, the inventory is posted against the clearing account and allocated to specific inventory
locations and parts, thereby moving the balances into the Inventory ledger account.

In this portion of the setup process, post the starting balances to the clearing accounts. If you are using a pre-built general
ledger structure, Sage 100 Contractor already has the necessary clearing accounts established. At the fiscal year-end, you
can delete the setup clearing accounts, as they are no longer needed.

IMPORTANT: After posting the invoice and allocations for inventory, your clearing accounts should have a zero
balance. If not, review your data to find out why.

Entering starting balances
To enter starting balances:
1 Open 1-3 Journal Transactions.

2 On theEditmenu, click PEriod. Select period 0.

3 In the Trans# box, enter the transaction number.

4 In theDate box, enter the transaction date.

5 In theDescription box, type Starting balances.

6 In theStatus list, click 1-Open.

7 In the grid, do the following:

a In theDescription cell, enter a brief statement about the line item.

b In theAccount cell, enter the ledger account you want.

c In theSubaccount cell, enter the subsidiary account you want.
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d Enter the amount in the appropriateDebit Amount cell orCredit Amount cell.

8 Repeat step 7 for each account.

9 On the Filemenu, click Save.

Methods for entering financial activity for the current year
After you have entered the starting balances, enter the net activity of the ledger accounts for the current year. It is important
to note that you cannot directly enter the startup balances for the dedicated ledger accounts: Accounts Receivable,
Accounts Payable, Service Receivables, and Inventory.

You can choose from four methods for entering the net activity. Entering the current activity for ledger accounts is nearly
identical to entering the starting balances. Remember to adjust the posting period as necessary, and provide a description
of what is reflected in the period balances.

Each successivemethod provides more detail for reports than the previous method and requires more time to enter data.
Read each of themethods thoroughly before deciding which to use. Except where noted, youmust first enter the starting
balances of all the ledger accounts.

Method 1

When you post the starting balances, include all the period activity in the beginning balance. Post a single journal
transaction to the period before the current posting period. Suppose you are setting up a new company during period 2. The
net activity for period 1 is added to the starting balances. In the journal transaction, enter the total for each ledger account
(beginning balance + period one net activity) and post the transaction to the end of period 1.

Method 1 is best suited for use near the start of a fiscal year. Themethod does not include the entry of historical
information. It is not recommended for use during themiddle of the fiscal year.

Method 2

Post the starting balances to period 0; then post a journal transaction that contains the net activity for each ledger account
during the current fiscal year. Post the transaction to the period before the current posting period. Suppose you are setting
up during period 7. Create a journal transaction that contains the net activity for each account through the end of period 6.
Then post the journal transaction to the end of period 6.

Method 2 provides data for a Year-to-Date Income Statement, and lets you view the entire activity for the year, but does not
provide data for reports in periods before the setup.

When you close the books at the fiscal year-end, the balances roll over to the Last Year column in the Ledger Accounts
window. This method does not set up individual period balances, so the period balances do not represent the true period
activity.

Method 3

Post the starting balances to period 0; then in each of the prior periods, post a journal transaction that contains the net
activity of each ledger account for that period. Suppose you are setting up during period 7. Create and post a journal
transaction that contains the net activity for each account during period 1. Then repeat the process for periods 2 through 6.

Method 3 provides accurate period balances. Each account contains its correct period balances for the current fiscal year.
When you close books at the fiscal year-end, the balances roll over to the Last Year column in the Ledger Accounts
window. The ledger accounts therefore reflect the true activity in each period. This method lets you generate reports that
compare data from the previous year to data in the current year.

Method 4

Post the starting balances to period 0; then enter each transaction for the current year. Method 4 requires a great deal of
work. This method is only practical when no accounting has been posted for the current year, or it is only a few weeks into
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the new fiscal year.

Creating ledger accounts
To create a ledger account:
1 Open 1-7 General Ledger Accounts.

2 In the data control box, enter the ledger account number.

3 In theShort Name box, enter a brief description of the ledger account.

4 If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must be set up before
posting transactions. In theSubsidiary list, click 1-Subaccounts or 2-Departments.

5 On the Filemenu, click Save.

TIP: Summary accounts let you combine ledger accounts for reports.

About setting up accounts for posting equipment
Direct Equipment: Enter the ledger account to which you are posting equipment expenses attributable to a job.

When you enter a direct equipment expense in the 5-5 Daily Payroll or 8-4 Equipment Allocationwindows, Sage 100
Contractor posts a debit to the account in theDirect Equipment box, and a credit to the account in theEquipment
Revenue box.

Equipment Repair: Enter the ledger account to which you are posting equipment expenses attributable to equipment
repair or maintenance.

When you enter an equipment expense for repairs or maintenance in the 5-5 Daily Payroll or 8-4 Equipment Allocation
window, Sage 100 Contractor posts a debit to the account in theEquipment Repair box, and a credit to the account in the
Equipment Revenue box.

Equipment Revenue: Enter the ledger account to which you are posting equipment expenses.

When you enter an equipment expense, Sage 100 Contractor always posts the credit to the account in theEquipment
Revenue box.

About setting up accounts for posting payable invoices
Sage 100 Contractor uses the accounts indicated on thePayables tab in the 1-8 General Ledger Setupwindow to post
payable invoice transactions.

Workers’ Compensation: Enter the ledger account to which you are posting the charge to subcontractors forWorkers’
Compensation insurance.

Discounts Earned: Enter the ledger account to which you are posting discounts taken on payable invoices.

PO Sales Tax Expense:When using the 12-4 Purchase Order Receiptswindow to enter materials received, Sage 100
Contractor posts sales taxes to the account indicated in thePO Sales Tax Exp. box.

Freight

WIP Cost Account: Enter theWIP cost account to which you are posting freight costs.

When posting the invoiced costs against a job, Sage 100 Contractor looks at theWIP Posting check box in the job file. If
you selected theWIP Posting check box, Sage 100 Contractor posts freight costs to the account in theWIP Cost
Account box.
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Direct Cost Account: Enter the direct cost account to which you are posting freight costs.

When posting the invoiced costs against a job, Sage 100 Contractor looks at theWIP Posting check box in the job file. If
theWIP Posting check box is clear, Sage 100 Contractor posts freight costs to the account in theDirect Cost Account
box.

Overhead Costs Account: Enter the overhead cost account to which you are posting freight costs.

When posting the invoiced costs to overhead (posting the invoice without a job number), Sage 100 Contractor posts costs
to the account in theOverhead Cost Account box.

NOTE: When posting the invoiced costs against a job, Sage 100 Contractor assigns the total of the freight costs to
the first job cost record.

Variance

Variances inmaterials costs are posted to theOverhead Costs Account.

NOTE: Freight costs and the variance inmaterials costs each appear as separate lines in the journal transaction.

About setting up accounts for posting receivable invoices
Sales Tax Payable: Enter the ledger account to which you are posting sales tax.

Finance Charges: Enter the ledger account to which you are posting the finance charges.

When printing client statements, you can create the finance charges for overdue invoices. Select the Calculate Finance
Charges check box, and generate the statements. Sage 100 Contractor uses the finance rate set up in the job record to
compute the finance charge and create a separate invoice for the amount.

Discounts Given: Enter the ledger account to which you are posting discounts given to cash receipts.

WIP Payroll: Enter the ledger account to which you are postingWIP payroll.

When posting the invoiced costs against a job, Sage 100 Contractor looks at theWIP Posting check box in the job file. If
you selected theWIP Posting check box, Sage 100 Contractor posts payroll costs to the account in theWIP Payroll box.

Retained Earnings: Enter the ledger account to which you are posting the net profit when closing the books at the fiscal
year-end.

You can change the account numbers on the Receivables tab regardless of whether you have posted transactions. If you
change the account number, you have tomove the balances to the new account through a journal transaction.

About 2-8 Financial Reports
A Financial Report gives you the ability to summarize ledger accounts and consolidate company books into a single
cohesive report (combined financial) that combines an income statement with a balance sheet for presentation to financial
institutions.

You can combine ledger account balances together under a summary account. The summary account provides you with a
means of combiningmany similar accounts under a single heading.

IMPORTANT: You can only consolidate company
books into a single financial report if all the data is on
the same network drive.
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NOTE: To consolidate the company books, Sage 100
Contractor combines the general ledgers based on the
account numbering structures. It is important that the
different companies use the same ledger structures;
otherwise, the combined financial data is meaningless.

Printing Financial Reports
To print a financial report:
1 Open 2-8 Financial Reports.

2 In thePeriod box, enter the fiscal period.

3 Click thePrint Records button.

4 In theCombine Companies dialog box, select the companies you want to combine by clicking on the check boxes, and
click OK.

5 Sage 100 Contractor prints your report automatically.

1-9 Company Departments
Company departments help organize income and expense data and provide ameans to evaluate the profit and loss for a
company. Departments and subsidiary accounts both arrange data in meaningful ways, but with a significant difference in
how the data is used. While a single controlling account uses a set of subsidiary accounts tailored to the controlling
account, income and expense controlling accounts share departments.

With departments in place, you can analyze your income and expenses. For example, to determine which departments are
profitable, you can generate a departmental income statement. You can also view a department balance for either all ledger
accounts or for a specific ledger account.

After you set up the controlling accounts and create your list of departments, you can add the departments to the controlling
accounts. Because Sage 100 Contractor simultaneously updates departments to all controlling accounts, you can add
departments, or change the department names or numbering structure at any time.

IMPORTANT: Before you create departments, youmust designate ledger accounts to accept departments.

You cannot transform a ledger account into a controlling account if that ledger account has had any activity or carries a
balance. The ideal time to create departments is at the start of a new fiscal year after all account balances have been
cleared. If necessary, however, you can create departments for a ledger account in themiddle of the fiscal year. To do this,
create a new controlling account to handle departments, and transfer the balance from the ledger account into the
departments in the new controlling account.

Departments and subsidiary accounts both provide tools to evaluate the profit and loss for companies. Both arrange data in
meaningful ways; however, there are significant differences in how the data is used. A single controlling account uses a set
of subsidiary accounts tailored to the controlling account. In contrast, income and expense controlling accounts share the
same set of departments, and each controlling account that uses departments has the same set of subsidiary accounts.

Creating departments

IMPORTANT: Before you create departments, you
must designate ledger accounts to accept
departments.
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To create a department:
1 Open 1-9 Company Departments.

2 In theDepartment# box, enter the department number.

3 In theDepartment Name box, enter a description of the department.

4 Repeat steps 2–3 for each department.

5 On the Filemenu, click Save.
To assign departments:
1 Open 1-9 Company Departments.

2 On themenu bar, click Update Accounts.

TIP: If a ledger account is not set up to use departments, Sage 100 Contractor does not create any departments for
that ledger account.

About Company Departments
Company departments help organize income and expense data and provide ameans to evaluate the profit and loss for a
company. Departments and subsidiary accounts both arrange data in meaningful ways, but with a significant difference in
how the data is used. While a single controlling account uses a set of subsidiary accounts tailored to the controlling
account, income and expense controlling accounts share departments.

With departments in place, you can analyze your income and expenses. For example, to determine which departments are
profitable, you can generate a departmental income statement. You can also view a department balance for either all ledger
accounts or for a specific ledger account.

After you set up the controlling accounts and create your list of departments, you can add the departments to the controlling
accounts. Because Sage 100 Contractor simultaneously updates departments to all controlling accounts, you can add
departments, or change the department names or numbering structure at any time.

IMPORTANT: Before you create departments, youmust designate ledger accounts to accept departments.

You cannot transform a ledger account into a controlling account if that ledger account has had any activity or carries a
balance. The ideal time to create departments is at the start of a new fiscal year after all account balances have been
cleared. If necessary, however, you can create departments for a ledger account in themiddle of the fiscal year. To do this,
create a new controlling account to handle departments, and transfer the balance from the ledger account into the
departments in the new controlling account.

Departments and subsidiary accounts both provide tools to evaluate the profit and loss for companies. Both arrange data in
meaningful ways; however, there are significant differences in how the data is used. A single controlling account uses a set
of subsidiary accounts tailored to the controlling account. In contrast, income and expense controlling accounts share the
same set of departments, and each controlling account that uses departments has the same set of subsidiary accounts.

Creating departments

IMPORTANT: Before you create departments, you
must designate ledger accounts to accept
departments.

To create a department:
1 Open 1-9 Company Departments.

2 In theDepartment# box, enter the department number.
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3 In theDepartment Name box, enter a description of the department.

4 Repeat steps 2–3 for each department.

5 On the Filemenu, click Save.

Assigning departments
To assign departments:
1 Open 1-9 Company Departments.

2 On themenu bar, click Update Accounts.

TIP: If a ledger account is not set up to use departments, Sage 100 Contractor does not create any departments for
that ledger account.
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Chapter 2: Accounting Reports
Working with Accounting Reports
Sage 100 Contractor provides the 2-Accounting Reportsmodule for important reports that aremore general in scope for
the purpose of reporting on your company as a whole. There are other reports in other Sage 100 Contractor modules, but
they tend to bemore focused on certain areas. For example, in 2-Accounting Reports, you’ll find 2-2 Balance Sheet and
2-3 Income Statement. If you needmore detail, in 6-Project Management, you’ll find such reports as 6-1-1 Job Status
Report and 6-1-8 Bonding Report.

For a listing of all the other reports available in Sage 100 Contractor, see Appendix B, Sage 100 Contractor Reports.

2-1 Trial Balance Reports
Report Name Locked

21—Trial Balance Yes

31—Trial Balance~Working Yes

2-2 Balance Sheet Reports
Report Name Locked

21—Balance Sheet Yes

31—Balance Sheet~This Year/Last Year Comparison Yes

2-3 Income Statement Reports
Report Name Locked

21—Income Statement Yes

31—Income Statement~Period and YTD Yes

32—Income Statement~This Year/Last Year Comparison Yes

33—Income Statement~Actual/Budget Comparison Yes

34—Income Statement~All Periods
For details about printing this report on legal-sized paper, see
the note in the Help topic, About report printing.

Yes

41—Dept. Income Statement Yes

51—Dept. Income Statement~Period/Year Yes
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Report Name Locked

53—Dept. Income Statement~Actual/Budget Comparison Yes

61—General Ledger Cost Comparison Yes

71—Income Summary~with Subaccount Detail Period
and YTD Yes

2-4 General Ledger Reports
Report Name Locked

21—General Ledger Yes

31—General Ledger~Land Yes

41—General Ledger~Summary Yes

51—Subsidiary Ledger Yes

53—Subsidiary Ledger~Land Yes

61—Subsidiary Summary Yes

2-5 General Journal Reports
Report Name Locked

21—General Journal Yes

31—Journal Summary Yes

2-6 Check Register Reports
Report Name Locked

21—Check Register~Checks Only Yes

31—Check Register Yes

41—Check Register~Deposits Only Yes

2-7 Chart of Accounts Reports
Report Name Locked

21—Chart of Accounts No

22—Chart of Accounts~with Notes No

31—Chart of Subsidiary Accounts No

41—Subsidiary Account Balances No
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2-8 Financial Reports
Report Name Locked

21—Financial Report Yes

2-9 Statement of Cash Flows Reports
Report Name Locked

21—Statement of Cash Flows Yes
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Chapter 3: Accounts Receivable
Working with Accounts Receivable
Using Sage 100 Contractor’s robust accounts receivable system, you can receive payments, customize invoices,
statements, overdue reminders, andmore to present your clients with professional and personalized documents. You can
also use the sales information in the client database to track customers from initial contact to job completion.

Sage 100 Contractor provides call sheets and aging reports to improve collection efficiency. For example, you can produce
aging reports at any time, which can reflect the end of any prior fiscal period tomatch financial reports for the same period.

The billing options available are contract, progress (American Institute of Architects, or AIA, format; custom and generic)
unitary, and time andmaterials billing, plus loan draws.

Each billing option offers records of prior and current billing application; prior ones aremaintained in full detail so that you
can examine earlier transactions for amounts carried forward.

3-1 Receivable Reports
See Appendix B for a complete list of 3-1 Receivable Reports.

3-2 Receivable Invoices & Credits

Invoices (Accounts Receivable)
The 3-2 Receivable Invoices/Creditswindow lets you enter transactions that affect receivable accounts. You can create
invoices or credit invoices, track retention, or view a history of payments for a specific invoice.

You can also create a simple invoice based on the percentage of work completed for the contract. This type of billing is
suitable for subcontractors or small projects.

TheReceivable Invoiceswindow also provides the ability to enter taxable and non-taxable items on an invoice at the
same time. When you enter a tax district number in the Tax District text box, you can select the items to tax in the Taxable
column. If you leave the Tax District text box blank, Sage 100 Contractor assumes each item is non-taxable.

About receivable invoice status

The status of a receivable record indicates its location in the process.

IMPORTANT: You can change the status of records assigned status 1-Open, 2-Review, or 3-Dispute to another of
the first three status settings. However, you cannot assign status 4-Paid or 5-Void.

Status Description

1-Open Indicates a record posted to the general ledger.

2-Review Indicates themanagement or bookkeeping staff should
review the record.
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Status Description

3-Dispute Indicates a record disputed by the client.

4-Paid Indicates a record paid in full.

5-Void Indicates a voided record.

NOTE: When an invoice or credit is fully paid, Sage 100 Contractor automatically assigns status 4-Paid. If you void
the record, Sage 100 Contractor automatically assigns status 5-Void.

About receivable invoice types

Type Description

1-Contract

Use type 1-Contractwhen the invoice affects the billing
for the contract.

A receivable invoice assigned type 1-Contract increases
the job balance, and a credit invoice with this type reduces
the job balance.

2-Memo

Use type 2-Memowhen the invoice does not affect the job
billing for the contract.

For example, when you enter a job deposit as a credit
invoice, assign it 2-Memo so that the credit does not affect
the invoiced to date amount.

You can also use this type with bad debts. Entering a
credit invoice assigned 2-Memo does not reduce the
invoiced to date amount, but clears the debt.

Entering receivable invoices

You can review the record totals before saving the invoice or credit. On theOptionsmenu, click Calculate.

You can provide part numbers on an invoice. Sage 100 Contractor only includes the parts on the invoice, and does not use
the part information elsewhere.

When you enter a tax district number in the Tax District text box, you can select which items to tax. In the Taxable
column, type Yes if the item is taxable, or No if the item is non-taxable.
To enter a receivable invoice
1 Open 3-2 Receivable Invoices/Credits.

2 Do the following:

a In the Invoice# text box, enter the invoice number.

b In theDate text box, enter the date of the invoice.

c In the Job text box, enter the job number.

d If the job uses phases, enter the phase number in thePhase text box.

e In theDescription text box, enter a brief statement about the invoice.

f In theDue Date text box, enter the invoice due date.
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g In theDiscount Date text box, enter the due date by which youmust receive payment for the client to receive the
discount.

h In theStatus list, click the invoice status.

i In the Type list, click the invoice type. The contract affects the invoiced balance when Type 1-Contract is selected.
Type 2-Memo does not affect the invoiced balance.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity of items.

c In thePrice cell, enter the price for a single item.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 In theDiscount text box, enter the discount for early payment.

6 On the Filemenu, click Save.

7 In theRetention text box, enter the amount of retention.

Voiding receivable invoices

If you discover an invoice was entered incorrectly, determine the best method to correct the error. For example, if the error
is in the header information, you can edit the information contained in any of the text boxes, except in the Job and Tax
District text boxes, and re-save the record.

When the invoice contains an incorrect job number, tax district, ledger account, or amount, void the invoice and then re-
enter it with the correct information. By voiding and re-entering the invoice, you create a clear audit trail.

There are also circumstances when you cannot void the original record. For example, you cannot void a credit invoice that
has been applied in full, or an invoice posted to period 0. Because you cannot void these types of transactions, it is
necessary to enter an adjusting invoice.

Before voiding an invoice, reverse all the payments posted to it. You can then enter the invoice correctly and reapply the
payments.

You can void a receivable invoice with an assigned status of 1-Open, 2-Review, or 3-Dispute.

When voiding an invoice that contains discretionary taxes, Sage 100 Contractor also voids the tax amount. If the voided
invoice reduces the discretionary taxes below the billingmaximum, Sage 100 Contractor continues to calculate the
discretionary taxes until the tax maximum is met.
To void a receivable invoice
1 Open 3-2 Receivable Invoices/Credits.

2 Using the data control, select the record.

3 If an amount appears in thePaid text box, reverse the payments.

4 On theEditmenu, click Void Invoice.

Creating invoices based on contract balances

You can create a receivable invoice for a job based on the amount of work completed. Using the original contract amount or
the new contract amount and the amount you have invoiced to date, Sage 100 Contractor determines the balance remaining
on the contract.
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When you supply the percentage of the contract that is completed, Sage 100 Contractor computes the amount to bill. This
method is similar to progress billing, but does not provide a detailed breakdown by cost code of the progress. Instead, the
invoice contains a single line describing the percentage of work completed and the invoice amount. This method of billing is
best suited for subcontractors.
To create an invoice based on the contract balance
1 Open 3-2 Receivable Invoices/Credits.

2 Enter the invoice.

3 On theOptionsmenu, click Contract Summary.

4 Choose the type of invoice you want to create by selecting thePercentage of Contract orPercentage of New
Contract option.

5 In thePercent Complete text box, enter the total amount of the contract that is completed.

6 TheAmount to Bill text box displays the computed amount. You can edit both figures if necessary.

7 Click OK.

NOTE: Sage 100 Contractor automatically increments the new contract amount as change orders are approved. The
amount billed does not change, but the percent billed changes since it is determined from the new contract amount.

About receivable credits

IMPORTANT: You cannot reverse a credit invoice after applying it to an invoice. If you apply a credit invoice to the
wrong invoice, make adjusting invoice entries to correct the error.

Many situations could cause you to enter a credit invoice. Suppose a client provides a prepayment on a job, or overpays an
invoice. In either case, it is necessary to reduce the accounts receivable.

When you save a credit invoice, Sage 100 Contractor reduces the job balance. However, the credit invoice retains status 1-
Open until you apply it against other invoices in the 3-3-1 Cash Receiptswindow. After you have applied the credit
balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the
credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after
applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the
credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit
invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the 3-3-1 Cash
Receiptswindow.

Recalculating invoices or credits

After making changes, you can recalculate the new totals.
To recalculate an invoice or credit

To calculate the invoice balances, on theOptionsmenu, click Calculate.

Issuing refund checks to customers
Situations arise where youmight have to issue a refund check to a customer. This process progresses through several
windows andmultiple steps.

You begin the process to issue a refund in 3-2 Receivable Invoices, then you work in 1-3 Journal Transactions, 1-1
Checks/ Bank Charges, and you complete the process in 3-2 Receivable Invoices.

Refunding a service receivables check uses a procedure similar to refunding an accounts receivable check.
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To issue a refund check to a customer:
1 Open 3-2 Receivable Invoices, and create a type 2-Memo accounts receivable invoice. In 11-2 Service Receivables,
create an invoice with a status of 1-Open.

2 In the Invoice# box, enter 0000.

3 In the grid, in theQuantity column, type 1.

4 In the grid in thePrice column, type the amount of the refund.

5 In the grid, use your checking account as the offsetting account.

IMPORTANT: Youmust use transaction number 0000 in order to print the check. If you have recorded other journal
transactions with the 0000 number and they are still in an open status, they will also print when you print the check.

6 From the Filemenu, select Save.

7 From the Filemenu, select Recall.

8 Click Go to Transaction to open the 1-3 Journal Transactionswindow for this invoice.

9 In thePayee box, enter the name of the customer.

10 From the Filemenu, select Save.

11 Open 1-1 Checks/Bank Charges.

12 From the Filemenu, select Print.

13 From the drop-down list in the first field on the first line, choose the appropriate report form.

14 In the blank field on theAccount line, enter the appropriate checking account number.

TIP: If you need a list of accounts, double-click in the blank field.

15 From the Filemenu, choosePrint.

16 Verify that the check number and date are correct, and then click OK to print the check.

17 Open 3-2 Receivable Invoices, change the number in the Invoice# box tomatch the printed check number.

NOTE: In 11-2 Service Receivables, you cannot change the Invoice #.

18 Create a credit to apply to the invoice created in step 1.

Managing old debts in accounts receivable
Sometimes there are situations where you have completely billed a contract, but you never receive full payment. You can
post a credit invoice to the job, crediting theBad Debt Expense account, for the uncollected amount. By not applying the
credit to the open invoice, the credit invoice creates a $0 job balance but the invoice remains open. If you eventually collect
the remaining contract balance, you can still post the payment to the invoice and void the credit.

At the fiscal year-end, you can close the job and remove it from the job database as long as it meets all the closing criteria.

About accounts receivable payment history
Each time you post a payment to an invoice, Sage 100 Contractor creates a separate record of the payment. To review the
individual payments made to a particular invoice, you can select the invoice and display its payment history.

When you void an accounts receivable payment, Sage 100 Contractor deletes the historical record of the payment and
increases the invoice balance by the amount of the voided check.
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Suppose you void a payment that applies to five invoices. Sage 100 Contractor deletes the record for payment in each of
the related invoice histories and increases each invoice’s balance appropriately.

When you reverse a cash receipt, Sage 100 Contractor creates an additional record in the payment history for a negative
amount.

You can use the payment history to reconstruct account balances for aging reports. To do this, first determine the fiscal
period for which you want to recreate the aging. Then subtract the payments made after that fiscal period from the ending
balance.
To view accounts receivable payment history for an invoice:
1 Open 3-2 Receivable Invoices/Credits.

2 Select the invoice for which you want to view a payment history.

3 On theOptionsmenu, click Payment History.

Receivable Credits

IMPORTANT: You cannot reverse a credit invoice after applying it to an invoice. If you apply a credit invoice to the
wrong invoice, make adjusting invoice entries to correct the error.

Many situations could cause you to enter a credit invoice. Suppose a client provides a prepayment on a job, or overpays an
invoice. In either case, it is necessary to reduce the accounts receivable.

Here are some points to consider:

l When entering cash receipts, you can apply the credit invoice.

l You can review the record totals before saving the invoice or credit. On theOptionsmenu, click Calculate.

l You can provide part numbers on an invoice. Sage 100 Contractor only includes the parts on the invoice, and does
not use the part information elsewhere.

l When you enter a tax district number in the Tax District text box, you can select which items to tax. In the Taxable
column, type Yes if the item is taxable, or No if the item is non-taxable.

When you save a credit invoice, Sage 100 Contractor reduces the job balance. However, the credit invoice retains status 1-
Open until you apply it against other invoices in the 3-3-1 Cash Receiptswindow. After you have applied the credit
balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.
To enter a credit invoice
1 Open 3-2 Receivable Invoices/Credits.

2 Do the following:

a In the Invoice# text box, enter the credit invoice number.

b In theDate text box, enter the date of the invoice.

c In the Job text box, enter the job number.

d If the job uses phases, enter the phase number in thePhase text box.

e In theDescription text box, enter a brief statement about the invoice.

f In theDue Date text box, enter the invoice due date.

g In theDiscount Date text box, enter the due date by which payment must be received for the discount to apply.

h In theStatus list, click the invoice status.

i In the Type list, click the invoice type.
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3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the price for a single item.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 On the Filemenu, click Save.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the
credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after
applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the
credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit
invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the 3-3-1 Cash
Receiptswindow.
To enter a credit invoice and apply it to an invoice
1 Open 3-2 Receivable Invoices/Credits.

2 Do the following:

a In the Invoice# text box, enter the credit invoice number.

b In theDate text box, enter the date of the invoice.

c In the Job text box, enter the job number.

d If the job uses phases, enter the phase number in thePhase text box.

e In theDescription text box, enter a brief statement about the invoice.

f In theReference# text box, enter the receivable invoice number to which you want to apply the credit.

g In theDue Date text box, enter the invoice due date.

h In theDiscount Date text box, enter the due date by whichmust be received for the discount to apply.

i In theStatus list, enter the invoice status.

j In the Type list, enter the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the price for a single item.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 On the Filemenu, click Save.

3-3-1 Cash Receipts
You use the 3-3-1 Cash Receiptswindow to enter payments for receivable invoices, discounts for early payment of
invoices, and overpayments. You can also reverse payments.
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You also use theCash Receiptswindow to reverse payments and discounts. To reverse payments, enter a negative
amount in the paid column and discount column if you have taken a discount. If the reversal is for a credit invoice enter a
positive amount in the paid column.
To enter a payment against an invoice:
1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount text box, enter the ledger account number for the cash account.

b In theDeposit# text box, enter the deposit number.

c In theDate text box, enter the deposit date.

d In theDescription text box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient text box, enter the client number.

b In the Job text box, enter the job number.

4 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

5 Click theDisplay button.

6 In the grid, do the following:

a In thePaid cell, enter the total amount received.
Do not include any discount or credit in this amount.

b If you are using discounts, in theDisc Available cell, enter the amount of the discount.
If you are not using discounts, skip step b.

IMPORTANT: To enter an overpayment for an invoice, the total of thePaid andDiscount cells must equal the
amount in theBalance text box. Then in theOverpayment cell, enter the amount paid in addition to the invoice
payment, not the total amount.

7 Repeat step 6 for each invoice you want to pay.

8 On the Filemenu, click Save.

TIP: If you do not enter a job number or client number, Sage 100 Contractor displays all invoices.

Entering payments and applying credits to invoices simultaneously
You can simultaneously enter a payment and apply a credit invoice. Suppose a job has a $500.00 credit invoice, a $1,000
invoice, and a $3,000 invoice. The client sends a payment of $3,500, the total amount due. You can apply the credit to
either invoice, then apply the payment to the remaining balance.
To enter a payment and apply a credit to an invoice:
1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount text box, enter the ledger account number for the cash account.

b In theDeposit# text box, enter the deposit transaction number.
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c In theDate text box, enter the deposit date.

d In theDescription text box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient text box, enter the client number.

b In the Job text box, enter the job number.

4 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

5 Click theDisplay button.

6 In the grid, do the following:

a In thePaid cell, enter the total amount received.

b In theDiscount Available cell, enter the amount of the discount.

c To apply the credit in thePaid cell of the credit invoice, enter the credit as a negative amount.

7 Repeat step 6 for each item.

8 On the Filemenu, click Save.

Applying credit invoices to receivable invoices
You can apply the balance of a credit invoice to one or more receivable invoices. It is also possible to apply only a portion of
the credit invoice balance to an invoice and apply the remaining balance later.
To apply a credit invoice to a receivable invoice:
1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount text box, enter the ledger account number for the cash account.

b In theDeposit# text box, enter the deposit transaction number.

c In theDate text box, enter the deposit date.

d In theDescription text box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient text box, enter the client number.

b In the Job text box, enter the job number.

4 Do one of the following:

a Click theService Invoices tab.

b Click theContract Invoices tab.

5 Click theDisplay button.

6 In the grid, do the following:

a In thePaid cell, enter the credit as a negative amount.

7 Repeat step 6 for each invoice to which you want to apply a credit.

8 On the Filemenu, click Save.
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Reversing cash receipts

IMPORTANT: After you apply a credit invoice to an invoice and save the transaction, you cannot reverse the credit.
If you have applied a credit invoice to the wrong invoice, enter an invoice to correct the error.

To reverse a cash receipt:
1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount text box, enter the ledger account number for the cash account.

b In theDeposit# text box, enter the deposit transaction number.

c In theDate text box, enter the deposit date.

d In theDescription text box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient text box, enter the client number.

b In the Job text box, enter the job number.

4 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

5 Consider the following:

a If the invoices are partially paid, theOpen only option should be selected.

b If the invoices are completely paid, select thePaid only option.

c If you have a combination of paid and partially paid invoices, select theAll option.

6 Click theDisplay button.

7 In the grid, do the following:

a In thePaid cell, enter the amount as a negative amount.

b In theDiscount cell, enter the discount amount, if any, as a negative amount.

8 Repeat step 7 for each payment you want to reverse.

9 On the Filemenu, click Save.

NOTES:
l When you reverse a payment made to an invoice with status 4-Paid, Sage 100 Contractor changes the status

to 1-Open.

l After reversing all payments made to an invoice, you can void the invoice.

Reversing an Accounts Receivable Credit Applied to an Invoice with a Reference
Number
To reverse an applied credit:
1 Open 3-3-1 Cash Receipts.

2 In the Job field, select the correct Job.

3 Click the [All Invoices] button.
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4 Click [Display Invoices].

5 On theContract Invoices tab grid, locate the accounts receivable invoice and the accounts receivable credit which was
applied to the invoice.

6 On the grid line for the accounts receivable credit memo, click theDiscount field and enter the amount of the credit you
wish to reverse as a positive sum.

7 On the grid line for the accounts receivable invoice, click theDiscount field and enter the amount of the credit you wish
to reverse as a negative sum.

8 In theAccount field, enter the correct cash account.

9 In theDeposit # field, enter a number.

10 In theDescription field, enter a description.

11 In theDate field, enter the correct date.

12 Select the correct Posting Period.

13 Select File > Save.

Entering receivable two-party checks
There are several ways to handle two-party checks. If the other payee has signed the check over to your company, deposit
and receive the check normally. When you have to sign over the check to a second payee, it is necessary to enter two
transactions in the accounting. Make the first transaction in 3-3-1 Cash Receipts, and the second in 4-3-1 Select Invoices
to Pay and 4-3-2 Pay Vendors.
To enter a receivable two-party check:
1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount text box, enter the cash clearing account number.

b In theDeposit# text box, enter the deposit transaction number.

c In theDate text box, enter the deposit date.

d In theDescription text box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient text box, enter a client number.

b In the Job text box, enter a job number.

4 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

c Click theDisplay button.

5 In the grid, do the following:

a In thePaid cell, enter the total amount received. Do not include any discount or credit in this amount.

b In theDiscount Available cell, enter the amount of the discount.

6 Repeat step 5 for each invoice.

7 On the Filemenu, click Save.

8 Open 4-3-1 Select Invoices to Pay.
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9 In the Invoice Selectionwindow:

a Enter the selection criteria.

b Select other options as desired.

c Click OK.

10 Locate the invoice.

11 In theSet to Pay text box, enter the total amount to be paid.

12 Do not include a discount in this amount.

13 On the Filemenu, click Save.

14 Open 4-3-2 Pay Vendors.

15 Select the payee.

16 Select Check in the Pay By field.

17 Click [OK]. Print the check to blank paper in the 4-3-5 Report Printing window.

NOTE: The account used should be the same check clearing account used when you received the two party check,
not your regular checking account.

TIPS:
l Entering the two transactions produces the same audit trail as if you cashed the client’s payment and then sent

a check to the vendor. If you do not have to send a check, immediately print the check on blank paper instead
of a check form. This will help prevent any confusion about the transaction the next time you print checks.

l It is a good idea to include a note referencing the client check number in both transactions. This connects the
two transactions together, providing a clear audit trail.

About cash receipts
In the 3-3-1 Cash Receiptswindow, you can enter payments for invoices, discounts for early payment of invoices, and
overpayments. You can also reverse payments using this window.

If you have amerchant account with Sage Payment Solutions, you can use the 3-3-2 Electronic Receiptswindow to enter
credit card and ACH payments electronically for your clients.

For information about electronic receipts, see See "About electronic receipts"

Applying receipts

To process receipts, you display client invoices in the 3-3-1 Cash Receiptswindow, select the invoice being paid, and
then enter the amount of the payment and any applicable discount or overpayment. If the payment includes a credit invoice,
you enter a negative amount for that invoice.

If a client pays more than the net amount of an invoice but less than the invoice balance, Sage 100 Contractor applies the
payment to the retention. For example, suppose you created an invoice for $1000minus 10% retention, resulting in a net
total of $900. The client, however, sends a $950 payment. After entering the payment in cash receipts, the total balance
due is $50 and theRetention column shows a balance of $50. It is important to note that this is not a substitute for
releasing retention.

Entering overpayments

When a client pays more than the total balance of an invoice, you can enter the additional money as an overpayment. The
total amount of thePaid andDiscount cells must equal the amount in theBalance cell before Sage 100 Contractor allows
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you to enter the overpayment. When you save the cash receipts, Sage 100 Contractor reduces the job balance by the
amount of the overpayment. In addition, the invoice now carries a negative balance and acts as a credit invoice.

Suppose a client informs you that he is going on vacation for a few weeks. The client wants to make sure you have enough
money to continue building while he is gone, so instead of paying the $5,000 he was billed, he pays $10,000. For the
invoice, enter $5,000 in thePaid cell and $5,000 in theOverpayment cell. After saving transactions, the invoice now
carries a –$5,000 balance. The next time you invoice the client, you can apply the credit.

Applying discounts

Sometimes clients receive a discount for early payment. Sage 100 Contractor automatically determines whether a discount
is available based on the due date you indicated on the invoice. When a discount is available, it is shown in theDiscount
Available text box. If a discount is not available, you can still apply a discount to an invoice.

About reversing payments and discounts

TheCash Receiptswindow also allows you to reverse payments and discounts. To reverse payments, you enter a
negative amount in thePaid column and in the discount column, if the client took a discount.

If the reversal is for a credit invoice, you enter a positive amount in thePaid column.

3-3-2 Electronic Receipts
You use the 3-3-2 Electronic Receiptswindow to process credit card and ACH payments for receivable invoices.

NOTE: Before you can process electronic receipts, youmust open amerchant account with Sage Payment
Solutions. Youmust also enter your merchant credentials, as well as the general ledger account associated with your
merchant account, in the 7-2 Company Informationwindow.

For more information about Sage Exchange and the Sage Exchange Vault, see See "About Sage Exchange".

For conceptual information about processing electronic receipts, see See "About electronic receipts".

Entering a payment against an invoice
Entering an electronic payment is similar to entering a cash receipt. Because you enter electronic invoices for only one
client at a time,you need to enter only the Client number in the transaction header.
To enter a payment against an invoice:
1 Open 3-3-2 Electronic Receipts.

2 In theClient text box, enter the client number.

3 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

4 Click theDisplay button.

5 For each invoice you want to pay, in the grid:

a In thePaid cell, enter the total amount received.
Do not include any discount or credit in this amount.

b If you are using discounts, in theDisc Available cell, enter the amount of the discount.
If you are not using discounts, skip step b.
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IMPORTANT: To enter an overpayment for an invoice, the total of thePaid andDiscount cells must equal the
amount in theBalance text box. Then in theOverpayment cell, enter the amount paid in addition to the invoice
payment, not the total amount.

If you use the company option to store client information in the Sage Exchange Vault:

l You can select Save payment information to save payment information that you enter for a transaction and client
securely in the Sage Exchange Vault.

l If you processed a payment for the client previously, you can choose to use the same payment method as before.

If you also saved the client's payment information in the vault:

l If the last payment method was a credit card, the optionUse last credit card is displayed instead of Use
last payment method. If you select this option, when you click Process and Post, the credit card details
stored in the vault for this customer appear on the Sage Exchange integration screen. You can change the
credit card information on the Sage Exchange screen.

l If the last payment method was ACH, the optionUse last bank account appears instead. If you select this
option, when you click Process and Post, the banking information stored in the vault for this customer
appear on the Sage Exchange integration screen. You can change the banking information on the Sage
Exchange screen.

CAUTION: If you do not want to use the same payment method used previously for the customer, youmust
clear theUse last credit card orUse last bank account option before you submit the payment to Sage
Payment Solutions. If one of these options is selected when you click Process and Post, you will not be able
to change the payment method in Sage Exchange.

6 Choose to process and post the payment, or only post the payment to your ledger, as follows:

l To process the payment through Sage Payment Solutions and post the transaction to your ledger, click Process
and Post.

A separate Sage Exchange integration window appears, where you can proceed with payment (entering credit card
or bank account information as needed), cancel the payment, or change payment card details or banking
information.

l To post a payment to your ledger that has already been processed through Sage Virtual Terminal or through a third-
party payment service, click Post Only.

A separateElectronic Receiptwindow appears, where you enter details about the receipt, including the date,
reference number, payer's name, the last four digits of the deposit account number, and the type of credit card used.

You can also select ACH as the payment type.

Entering payments and applying credits to invoices simultaneously
You can simultaneously enter a payment and apply a credit invoice. Suppose a job has a $500.00 credit invoice, a $1,000
invoice, and a $3,000 invoice. The client sends a payment of $3,500, the total amount due. You can apply the credit to
either invoice, then apply the payment to the remaining balance.
To enter a payment and apply a credit to an invoice:
1 Open 3-3-2 Electronic Receipts.

2 In theClient text box, enter the client number.

3 Do one of the following:

a Click theContract Invoices tab.

a Click theService Invoices tab.
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4 Click theDisplay button.

5 For each item in the grid:

a In thePaid cell, enter the total amount received.

b In theDiscount Available cell, enter the amount of the discount.

c To apply the credit in thePaid cell of the credit invoice, enter the credit as a negative amount.

6 Choose to process and post the payment, or only post the payment to your ledger, as follows:

l To process the payment through Sage Payment Solutions and post the transaction to your ledger, click Process
and Post.

A separate Sage Exchange integration window appears, where you can proceed with payment (entering credit card
or bank account information as needed), cancel the payment, or change payment card details or banking
information.

l To post a payment to your ledger that has already been processed through Sage Virtual Terminal or through a third-
party payment service, click Post Only.

A separateElectronic Receiptwindow appears, where you enter details about the receipt, including the date,
reference number, payer's name, the last four digits of the deposit account number, and the type of credit card used.

You can also select ACH as the payment type.

Applying credit invoices to receivable invoices
You can apply the balance of a credit invoice to one or more receivable invoices. It is also possible to apply only a portion of
the credit invoice balance to an invoice and apply the remaining balance later.
To apply a credit invoice to a receivable invoice:
1 Open 3-3-2 Electronic Receipts.

2 In theClient text box, enter the client number.

3 Do one of the following:

a Click theService Invoices tab.

b Click theContract Invoices tab.

4 Click theDisplay button.

5 For each invoice to which you want to apply a credit, in the grid, enter the credit as a negative amount in thePaid cell.

6 Choose to process and post the payment, or only post the payment to your ledger, as follows:

l To process the payment through Sage Payment Solutions and post the transaction to your ledger, click Process
and Post.

A separate Sage Exchange integration window appears, where you can proceed with payment (entering credit card
or bank account information as needed), cancel the payment, or change payment card details or banking
information.

l To post a payment to your ledger that has already been processed through Sage Virtual Terminal or through a third-
party payment service, click Post Only.

A separateElectronic Receiptwindow appears, where you enter details about the receipt, including the date,
reference number, payer's name, the last four digits of the deposit account number, and the type of credit card used.

You can also select ACH as the payment type.
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About electronic receipts
If you have amerchant account with Sage Payment Solutions, you can use the 3-3-2 Electronic Receiptswindow to enter
credit card and ACH payments electronically for your clients.

NOTE: Before you can process electronic receipts, youmust enter your Sage Payment Solutions merchant ID and
merchant key, as well as the general ledger account associated with your merchant account, on the Electronic
Receipts Setup tab in the 7-2 Company Informationwindow.

Processing electronic receipts is very similar to processing cash receipts using the 3-3-1 Cash Receiptswindow, with a
few notable differences:

l You process an electronic receipt for one client at a time. Therefore:

l You need to enter only the Client number in the transaction header.

l You display invoices for the selected client in the grid.

l If you use the company option to store client information in the Sage Exchange Vault:

l You can select Save payment information to save payment information that you enter for a transaction and
client securely in the Sage Exchange Vault.

l If you processed a payment for the client previously, you can choose to use the same payment method as
before.

If you also saved the client's payment information in the vault:

l If the last payment method was a credit card, the optionUse last credit card is displayed instead of
Use last payment method. If you select this option, when you click Process and Post, the credit
card details stored in the vault for this customer appear on the Sage Exchange integration screen. You
can change the credit card information on the Sage Exchange screen.

l If the last payment method was ACH, the optionUse last bank account appears instead. If you
select this option, when you click Process and Post, the banking information stored in the vault for
this customer appear on the Sage Exchange integration screen. You can change the banking
information on the Sage Exchange screen.

CAUTION: If you do not want to use the same payment method used previously for the customer, you
must clear theUse last credit card orUse last bank account option before you submit the payment to
Sage Payment Solutions. If one of these options is selected when you click Process and Post, you will
not be able to change the payment method in Sage Exchange.

l Rather than clicking Save to store receipt transactions, you use the following icons or Options menu items:

l You click Process and Post to process a receipt electronically through Sage Payment Solutions, where it
will be deposited to your bank account, and post the transaction to your Sage 100 Contractor General Ledger.

l You click Post to post a transaction to your Sage 100 Contractor general ledger that you entered directly
through the Sage Virtual Terminal or using another payment processing service.

Applying receipts

To process receipts, you display client invoices the 3-3-2 Electronic Receiptswindow, select the invoice being paid, and
then enter the amount of the payment and any applicable discount or overpayment. If the payment includes a credit invoice,
you enter a negative amount for that invoice.

If a client pays more than the net amount of an invoice but less than the invoice balance, Sage 100 Contractor applies the
payment to the retention. For example, suppose you created an invoice for $1000minus 10% retention, resulting in a net
total of $900. The client, however, sends a $950 payment. After entering the payment in cash receipts, the total balance
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due is $50 and theRetention column shows a balance of $50. It is important to note that this is not a substitute for
releasing retention.

Entering overpayments

When a client pays more than the total balance of an invoice, you can enter the additional money as an overpayment. The
total amount of thePaid andDiscount cells must equal the amount in theBalance cell before Sage 100 Contractor allows
you to enter the overpayment. When you save the cash receipts, Sage 100 Contractor reduces the job balance by the
amount of the overpayment. In addition, the invoice now carries a negative balance and acts as a credit invoice.

Suppose a client informs you that he is going on vacation for a few weeks. The client wants to make sure you have enough
money to continue building while he is gone, so instead of paying the $5,000 he was billed, he pays $10,000. For the
invoice, enter $5,000 in thePaid cell and $5,000 in theOverpayment cell. After saving transactions, the invoice now
carries a –$5,000 balance. The next time you invoice the client, you can apply the credit.

Applying discounts

Sometimes clients receive a discount for early payment. Sage 100 Contractor automatically determines whether a discount
is available based on the due date you indicated on the invoice. When a discount is available, it is shown in theDiscount
Available text box. If a discount is not available, you can still apply a discount to an invoice.

3-4 Statements
NOTE: If you have purchased the Service Receivables Add-onModule, invoices from Service Receivables are also
included on theClient Contract Statement.

A statement summarizes the activity of invoices, payments, credit invoices, and retention for a job. Statements help keep
clients informed of the financial activity for a job. It is a good idea to print the statements at the end of eachmonth and send
them to your clients.

When printing a statement, Sage 100 Contractor automatically generates a receivable invoice using the finance rate from
the job record. The statement only includes the finance amount in the statement if theCalculate Finance Charges check
box has been selected. Service receivable finance charge invoices, however, are based on the finance rate defined for
client in 3-6 Receivable Clients.

You can create the finance charges by printing the statements, or you can click thePrint preview and Drilldown (when
available) button to review it before printing it. You can also print a single statement for a client with whom you have
multiple job contracts. TheClient Contract Statement lists the invoices by job and provides the total amount and
remaining balance of each invoice.

NOTE: In some states, it is illegal to charge finance charges on top of finance charges. To exclude finance charges
from a statement, in the 3-4 Report Printingwindow, clear theCalculate Finance Charges check box. You can
create a separate finance charge statement manually in 3-2 Receivable Invoices/Credits.

3-5 Jobs (Accounts Receivable)
When you create a job in the 3-5 Jobs (Accounts Receivable)window, Sage 100 Contractor creates a record containing
job-related information such as important contract dates, job financial information, and job-related contacts. In addition, the
3-5 Jobs (Accounts Receivable)window provides a variety of tools to help youmanage contracts, such as pre-liens and
lien releases. Youmay also create phases or bid items to divide work into moremanageable sections.

Billing information such as the client, job architect, engineer, or project lender, may also be included as part of the job
record. For example, when you supply the client number, Sage 100 Contractor includes the client information on invoices
printed for that job. If you include the architect or engineer’s name in the job record when using progress or unitary billing,
Sage 100 Contractor uses that information when creating a progress or unitary bill. If you include the lender, Sage 100
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Contractor uses the lender information when creating a loan draw document. You can also set job level security for each
job.

Youmay manage all your jobs directly from yourProject Work Center. Youmay also create a desktop shortcut toProject
Work Center and place it on theSage 100 Contractor Desktop. This gives you the power to access all your job-related
data from one place.

Entering jobs
If you select thePost expenses to WIP asset account check box, and you have selected Job# as Subaccount# on a
general ledger account(s), upon job save, you will be prompted to create subaccounts under those ledger accounts.

Upon saving the job, Sage 100 Contractor checks the client’s balance for any past due invoices and displays amessage
indicating the amount past due, if any. To turn this option off, in theOptionsmenu, click Check Client Balance.
To enter a job:
1 Open 3-5 Jobs (Accounts Receivable).

2 Do the following:

a In the data control text box, enter the job number.

b In the Job Name text box, enter the full job name.

c In theShort Name text box, enter an abbreviated name for the job.

d In the Job Status list, click the job status.

e In the Job Type list, click the type of job.

3 In theGeneral Information tab, do the following:

a In theClient text box, enter the client number.

b In theAddress 1, Address 2, City, State, and Zip text boxes, enter the client's address.

c If the job is in a sales tax district, enter the district in theSales Tax District text box.

d If the job is in a local payroll-tax district, enter the district in thePayroll Locale text box.

e In the Income Account text box, enter the default income account.

f If you departmentalize income, enter the default department number in theDepartment text box.

g If the job requires certified payroll reporting, click theRequires certified payroll reporting check box.

h If the job requires posting payroll toWIP asset accounts, select thePost expenses to WIP asset account check
box.

i In theDue Terms text box, enter the cycle for the date when the invoice is due.

j In theDiscount Terms text box, enter the cycle by which payment must be received for the discount to apply.

k In theDiscount Rate text box, enter the discount rate.

l In the Finance Rate text box, enter the annual finance rate.

m In theRetainage Rate text box, enter the rate of retention.

n If the customer provides a purchase order for the job, enter the purchase order number in theClient PO# text box.

o If the customer provides a contract number for the job, enter the contract number in theContract# text box.

p In theContract Amount text box, enter the amount of the original contract.

4 In the Contacts and Personnel tab, do the following:
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a In theArchitect text box, enter the vendor number of the architect or engineer.

b In the Lender text box, enter the vendor number of the lending institution.

c In theEstimator text box, enter the employee number of the estimator.

d In theSalesperson text box, enter the employee number of the salesperson.

e In theSupervisor text box, enter the employee number of the job supervisor.

f In the Job Access List text box, click theEdit list of users with security access to job button to select up to 5
users with security access to this job.

g In theContact grid, do the following:

i In theContact Name text box, enter the contact's name.

NOTE: The first contact in the list is considered to be the primary contact in reports.

ii In the Job Title text box, enter the contact's job title.

iii In thePhone# text box, enter the contact’s telephone number.

iv In theExtension text box, enter the contact's telephone extension, as necessary.

v In theEmail text box, enter the contact's email address.

vi In theCell Phone# text box, enter the contact’s cellular number.

vii In the Fax# text box, enter the contact’s fax number.

viii In theOther# text box, enter the contact’s other telephone number.

ix In theOther Description text box, enter the contact’s other telephone number description.

x In theNotes text box, enter any applicable notes about the contact.

5 In theProject Dates and Sales Information tab, do the following:

a In theProject Dates section, enter the job dates in the appropriate text boxes.

b In theSales Information section, enter the project and sales details in the appropriate text boxes.

6 If you are using phases, click [Phases] and enter the phases.

7 If you are using bid items, click [Bid Items] and enter the bid items.

8 On the Filemenu, click Save.
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TIPS:
l ThePost expenses to WIP asset account check box does not affect whether the job appears in theWIP

report.

l The contract dates allow you to track important aspects of the project, but Sage 100 Contractor does not use
these dates for any reports or documents.

Setting up the default taxability of cost types for jobs
In some regions, work that is normally not taxable becomes taxable when performing certain services on a job. Sage
100 Contractor provides you the ability to manage the taxability of cost types for a specific job. Sage 100 Contractor
uses the tax rate from the sales tax district indicated in the job record, but uses the cost type taxability you set up in
the Taxable Cost Types dialog box.
To set up the default cost type taxability:

1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 On theOptionsmenu, click Taxable Cost Types.

3 Do the following:

a In theMaterials text box, type [Y] if the cost type is taxable or [N] if the cost type is not taxable.

b In the Labor text box, type [Y] if the cost type is taxable or [N] if the cost type is not taxable.

c In theEquipment text box, type [Y] if the cost type is taxable or [N] if the cost type is not taxable.

d In theSubcontract text box, type [Y] if the cost type is taxable or [N] if the cost type is not taxable.

e In theOther text box, type [Y] if the cost type is taxable or [N] if the cost type is not taxable.

f For each customized user-defined cost type, type [Y] if the cost type is taxable or [N] if the cost type is not
taxable.

4 Click [OK].

NOTE: If you leave aCost Type text box blank, Sage 100 Contractor uses the default indicated in the Tax
Districtwindow.

About contract terms

IMPORTANT: When entering the discount date and due date for a job, youmust also indicate the billing cycle.

Term Description

Finance
Rate Enter the finance rate to apply when payments are late.

Retention
Rate

Enter the percent of the entire contract withheld as retention. When you enter an invoice, Sage 100
Contractor automatically calculates retention for the invoice.

Discount
Rate Enter the discount rate.

Due Date Indicates the date payment is due.

Discount
Terms Indicates the date by which payment is due for the client to receive a discount.

Contract
Amount Indicates the total amount of the contract, excluding sales tax.
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TIP: If you have indicated a client number in the job record, Sage 100 Contractor uses the term rates from the client
record.

About beginning and ending balances for jobs
The 3-5 Jobs (Accounts Receivable)window displays the contract balance for the current fiscal year.

Box Description

Beginning
Balance

Displays the balance of outstanding invoices at the beginning of the fiscal year.

TheBeginning Balance box only displays an amount when the ending balance carries
over to a new fiscal year.

Ending
Balance

Displays the total balance to-date for outstanding invoices posted to the job for the
current fiscal year.

About job status
The job status lets you follow the condition of a job, and does not affect your ability to post to a job. You can change the
status of a job record at any time and still post invoices or credits to it.

NOTE: The Job Status list is not editable. The six existing job statuses are defaults for the program.

Status Description

1-Bid You are currently bidding for the job.

2-Refused
You submitted a bid for the job, but it was awarded to another contractor.

At the fiscal year-end, you can remove job files assigned status 2-Refused.

3-Contract You won the contract but have not begun work.

4-Current Work is in progress on the contracted job.

5-Complete
You have completed work on the contracted job.

At the fiscal year-end, Sage 100 Contractor does not remove job files assigned this status.

6-Closed
You have completely invoiced the job and received full payment and have approved the
deletion of the job file.

At the fiscal year-end, you can remove job files assigned status 6-Closed.

Setting up job types
You can classify jobs that your company performs by contract, work performed, or any other means.

Example 1: Invoice Method

The following table shows a list for a general contractor based on themethod of invoicing:

Job Type # Type Name

1 Time andMaterials Projects
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Job Type # Type Name

2 Progress Billing Projects

3 Government Projects

Example 2: Type of Work

The following table shows a list based on the type of work performed:

Job Type # Type Name

1 Remodeling

2 New Residential

3 New Commercial

4 Schools

5 Tenant Improvements

To set up job types:
1 Open 3-5 Jobs (Accounts Receivable).

2 Next to the Job Types list, click the detail button.

3 In the Job Type# text box, enter the number of the job type.

4 In the Type Name text box, enter a description of the job type.

5 In theNotes text box, enter notes about the job type.

6 Repeat steps 3–5 for each job type.

7 On the Filemenu, click Save.
To assign status 5-Complete to a group of jobs:
1 Open 3-5 Jobs (Accounts Receivable).

2 On theUpdatemenu, click Completed Status.

3 In thePicklistwindow, select the jobs to which you want to assign status 5-Complete.

4 Click the check mark button.
To close a job:
1 Open 3-5 Jobs (Accounts Receivable), and select the job that you want to close.

2 In theCurrent Balance text box, verify that the job-ending balance is $0.00.

3 On theOptionsmenu, click Invoices.

4 Verify that the status of each invoice/credit is 4-Paid and close theReceivable Invoiceswindow.

5 In theStatus list, click 6-Closed.

6 On the Filemenu, click Save and close the Jobswindow.

7 Open 4-1-2-23 AP Invoice List~with Payments, and print the report for job that you are closing.

8 Verify that all the invoices are paid or void.

TIPS:
l Add a copy of thePayable Invoice List report to the physical job file.

l You can always post invoices or credits to a job assigned status 6-Closed. Posting an invoice or credit invoice

l When you close the books at the fiscal year-end, you can remove all closed jobs and their related records.



- 117 -

To close a group of jobs:
1 Open 3-5 Jobs (Accounts Receivable).

2 On theUpdatemenu, click Closed Status.

3 In thePicklistwindow, double-click the jobs to which you want to assign status 6-Closed.

4 Alternatively, you can select a job, press the Ctrl key, and then drag the cursor over several jobs. Red text indicates the
jobs are selected.

5 Click the check mark button.

6 Open 4-1-2-23 AP Invoice List~with Payments, and print the report for jobs that you are closing.

7 Verify that all the invoices are paid or void.

8 Open 3-1-2-23 AR Invoice List~with Payments, and print the report for jobs that you are closing.

9 Verify that all the invoices are paid or void.

Deleting jobs
Deleting a job in the 3-5 Jobs (Accounts Receivable)window requires that the job have a status of Closed orRefused. In
addition, the job cost records existing in the current year must have a status of Open.

Youmay not delete a job in 3-5 Jobs (Accounts Receivable) if:

l There is a balance in aWIP Asset subaccount that matches the job number, and;

l The job is marked as Post expenses to WIP asset account in 3-5 Jobs (Accounts Receivable), and;

l TheWIP Asset account is marked to use the Job# as Subaccount in 1-7 Ledger Accounts.

These restrictions helpmaintain the balance between job costs and the general ledger and the consistency between
deleting jobs in 3-5 Jobs (Accounts Receivable) and removing jobs in 1-6 Period/Fiscal Year Management.

To delete a job:
1 Open 3-5 Jobs (Accounts Receivable).

2 Using the data control, select the record.

3 On theEditmenu, click Delete Job.

NOTE: If aWIP job with a balance does not have any current year job costs, youmay delete it, but first you have to
clear thePost expenses to WIP asset account check box.

Accounts Receivable Retention
Many job contracts include retention. When you create a receivable invoice, Sage 100 Contractor withholds retention at the
rate specified in the job file. If you do not set up a default rate in the job file, you can withhold a flat amount on each
individual invoice.

Posting an invoice declares the gross amount of the invoice as income. However, a percentage of the gross amount is
withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice
amount). Therefore, retention is already declared as income but is not yet due. Consequently, Sage 100 Contractor does
not include retention in the invoice aging, and does not apply finance charges to it.

When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been
declared income, so you only need to release the retention that has been withheld. You can release retention on each
invoice individually, or you can release the retention for the entire job at one time. Having released the retention, you can
then send the client a statement reflecting the amount that is due your company.
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Changing retention rates for jobs
In the 3-5 Jobs (Accounts Receivable)window, you can change the retention rate for a job contract simply by entering the
new rate in theRetention Rate text box. Sage 100 Contractor will calculate retention for all new invoices using the new
rate, while existing invoices maintain the previously calculated retention.

You can also apply the new retention rate to all existing job invoices. When you increase the retention rate, Sage 100
Contractor calculates the new amount of retention based on the gross invoice amount. If the invoice balance is smaller than
the calculated retention, Sage 100 Contractor adjusts the retention accordingly. For example, the retention is increased
from 5% to 10% for a job and the change is applied to all job invoices. A $1,000 invoice is 95% paid and the remaining $50
balance is for retention. Because the invoice is already 95% paid, Sage 100 Contractor cannot recalculate retention at the
10% rate on this invoice. Consequently, Sage 100 Contractor does not change the retention for the invoice.

Applying a decreased retention rate can also affect previous invoices. While retention is decreased, the net balance due on
invoices can increase. Suppose you decrease the retention from 10% to 5% for a job and apply the decrease to all job
invoices. The net amount due for a $1,000 invoice was originally $900, but is changed to $950. If client had paid $900, the
client now owes an additional $50, and the last $50 is withheld as retention.
To change the retention rate for a job:
1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 In theRetentionRate text box, enter the new rate.

3 If the new retention rate only applies to new invoices, go to step 5.

4 On theUpdatemenu, click Recalculate Retention.

5 In theNew Due Date for Invoices text box, enter the due date you want to assign the invoices.

6 UnderSelect Recalculation Option, do one of the following:

a Select to updateOnly invoices with Retention, or

b Select to updateAll invoices.

7 Click OK.

8 On the Filemenu, click Save.

Entering retention as a flat rate for accounts receivable invoices
You can add a retention rate to the entire job which applies a single retention rate to all the job invoices. You can also enter
retention to individual invoices as a flat rate.
To enter retention as a flat rate for accounts receivable retention:
1 Open 3-2 Receivable Invoices/Credits.

2 Locate the invoice to which you want to add retention.

3 Under the grid, locate theRetention box, type an amount, and the press Enter key.

4 Select File > Save.

Releasing retention for jobs
If you need to release retention, print a progress billing report, and then print a job statement to request final payment, see
the topic Releasing retention for jobs and printing statements.

To release retention for a job:
1 Open 3-5 Jobs (Accounts Receivable), and then select the job.
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2 Under the Terms area, select theRetention Rate value, and then click the Delete key.

3 On theUpdatemenu, click Recalculate Retention.

4 On theRecalculate Retentionwindow in theNew Due Date for Invoices box, type a new due date.

5 Under theRecalculation Option area, do one of the following:

a Select to updateOnly invoices with Retention, or

b Select to updateAll invoices.

6 Click OK.

7 On the Filemenu, click Save.

TIP: You can verify that retention has been released by clicking the Invoices button (bottom of the window) and
reviewing theNet Due amount.

Releasing retention for jobs and printing statements
When you bill a customer for retention for a job that is 100 percent complete, it is not necessary to create a new invoice.
The retention is included on the invoices created from 3-7 Progress Billing applications. This three-part procedure shows
you how to release retention, print a progress billing report, and then print a job statement to request final payment.

IMPORTANT: All past due accounts receivable invoices must have been collected before completing this procedure.

If you need to print a retention invoice instead of a statement, see the topic Creating final retention invoices.

Part 1—To close the current bill, release retention, and print a progress billing report

1. Open 3-7 Progress Billing.

2. Open the last application with aStatus 3-Posted for the job.

3. Click Next.

4. To themessage, Reminder: A new record will be created and this one will become Closed. Do you want to
continue? click Yes.

5. Be sure to note the amount in theRetention Rate box.

6. From theUpdatemenu, select Release Retention.

7. To themessage, This will reset all retention rates to zero and recalculate the application. Do you want to
continue? click Yes.

8. On theCalculate grid, choose amethod to calculate theProgress Billing and click OK.

NOTE: TheRetention Total amount becomes theCurrent Due amount.

9. From the Filemenu, select Save.

10. From the Filemenu, select Recall.

11. From theOptionsmenu, select Submit Application.

12. From the Filemenu, select Print.

13. Print the appropriate Progress Billing report, reports 21—42, and send this report to your customer to show the
retention amount is now due.

14. Close the 3-7 Report Printingwindow.

NOTE: The final application remains in Submitted status because there is not an invoice amount to post.
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Part 2—To recalculate the retention and due dates

IMPORTANT: If you complete this part and have not received payments for amounts outside of retention, the current
balance due will reflect retention and any outstanding amounts. This could be perceived that current receivables are
overstated.

1. Open 3-5 Jobs (Accounts Receivable), and select the job.

2. In the Terms section of the window, clear theRetention Rate.

3. From theUpdatemenu, select Recalculate Retention.

4. On theRecalculate Retentionwindow, enter theNew Due Date for Invoices and select the appropriate
Recalculation option.

5. Click OK, and to themessage to confirm the number of open invoices found, click OK again.

6. From the Filemenu, click Save.

7. Then, on the 3-5 Jobs (Accounts Receivable)window, click the Invoices button and review theNet Due amount
to verify the retention has been released.

Part 3—To print a 3-4 Statement for detailed billing information

1. Open 3-4 Statements.

2. Select the 21-Job Statements report.

3. In the Job# box, type the job number.

4. Select the Include Paid Invoices check box.

5. Select the Include Payment History check box.

6. From the Filemenu, click Print.

7. On theStatement Variableswindow, type theStatement Date, and click OK.

8. The statement prints showing all outstanding amounts due, including the released retention.

9. Close the 3-4 Report Printingwindow.

About accounts receivable retention

Many job contracts include retention. When you create a receivable invoice, Sage 100 Contractor withholds retention at the
rate specified in the job file. If you do not set up a default rate in the job file, you can withhold a flat amount on each
individual invoice.

Posting an invoice declares the gross amount of the invoice as income. However, a percentage of the gross amount is
withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice
amount). Therefore, retention is already declared as income but is not yet due. Consequently, Sage 100 Contractor does
not include retention in the invoice aging, and does not apply finance charges to it.

When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been
declared income, so you only need to release the retention that has been withheld. You can release retention on each
invoice individually, or you can release the retention for the entire job at one time. Having released the retention, you can
then send the client a statement reflecting the amount that is due your company.

Changing retention rates for jobs

In the 3-5 Jobs (Accounts Receivable)window, you can change the retention rate for a job contract simply by entering the
new rate in theRetention Rate text box. Sage 100 Contractor will calculate retention for all new invoices using the new
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rate, while existing invoices maintain the previously calculated retention.

You can also apply the new retention rate to all existing job invoices. When you increase the retention rate, Sage 100
Contractor calculates the new amount of retention based on the gross invoice amount. If the invoice balance is smaller than
the calculated retention, Sage 100 Contractor adjusts the retention accordingly. For example, the retention is increased
from 5% to 10% for a job and the change is applied to all job invoices. A $1,000 invoice is 95% paid and the remaining $50
balance is for retention. Because the invoice is already 95% paid, Sage 100 Contractor cannot recalculate retention at the
10% rate on this invoice. Consequently, Sage 100 Contractor does not change the retention for the invoice.

Applying a decreased retention rate can also affect previous invoices. While retention is decreased, the net balance due on
invoices can increase. Suppose you decrease the retention from 10% to 5% for a job and apply the decrease to all job
invoices. The net amount due for a $1,000 invoice was originally $900, but is changed to $950. If client had paid $900, the
client now owes an additional $50, and the last $50 is withheld as retention.

To change the retention rate for a job:

1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 In theRetentionRate text box, enter the new rate.

3 If the new retention rate only applies to new invoices, go to step 5.

4 On theUpdatemenu, click Recalculate Retention.

5 In theNew Due Date for Invoices text box, enter the due date you want to assign the invoices.

6 UnderSelect Recalculation Option, do one of the following:

a Select to updateOnly invoices with Retention, or

b Select to updateAll invoices.

7 Click OK.

8 On the Filemenu, click Save.

Entering retention as a flat rate for accounts receivable invoices

You can add a retention rate to the entire job that applies a single retention rate to all the job invoices. You can also enter
retention to individual invoices as a flat rate.

To enter retention as a flat rate for accounts receivable retention:

1 Open 3-2 Receivable Invoices/Credits.

2 Locate the invoice to which you want to add retention.

3 Under the grid, locate theRetention box, type an amount, and the press Enter key.

4 Select File > Save.

Releasing retention for jobs

If you need to release retention, print a progress billing report, and then print a job statement to request final payment, see
the topic Releasing retention for jobs and printing statements.

To release retention for a job:

1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 Under the Terms area, select theRetention Rate value, and then click the Delete key.

3 On theUpdatemenu, click Recalculate Retention.

4 On theRecalculate Retentionwindow in theNew Due Date for Invoices box, type a new due date.
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5 Under theRecalculation Option area, do one of the following:

l Select to updateOnly invoices with Retention

l Select to updateAll invoices.

6 Click OK.

7 On the Filemenu, click Save.

TIP: You can verify that retention has been released by clicking the Invoices button (bottom of the window) and
reviewing theNet Due amount.

Releasing retention on receivable invoices

To release retention on a receivable invoice:

1 Open 3-2 Accounts Receivable Invoices, and then select the invoice.

2 In theRetention text box, delete the amount.

3 On the Filemenu, click Save.

Creating final retention invoices

The preferredmethod to request final payment for retention is to print a progress bill report.

IMPORTANT: Because retention has been included in the previous progress billing applications, youmust credit the
retention amount before you can create a separate retention invoice. Follow the six parts of this procedure to release
retention, create a retention credit, apply the credit, and create your retention invoice.

Part 1—To close your current bill, release retention, and print a progress billing report
1 Open 3-7 Progress Billing.

2 Open the last application with aStatus 3-Posted for the job, and click Next.

3 To themessage, Reminder: A new record will be created and this one will become Closed. Do you want to
continue? click Yes.

4 Note the amount in theRetention box.

5 From theUpdatemenu, select Release Retention.

6 To themessage, This will reset all retentionrates to zero and recalculate the application. Do you want to
continue? click Yes.

7 On theCalculate grid, choose amethod to calculate the Progress Billing and click Calculate.

8 TheRetention amount becomes the Invoice Amount.

9 From the Filemenu, select Save.

10 From the Filemenu, select Recall.

11 From theOptionsmenu, select Submit Application.

12 From the Filemenu, select Print.

13 Print the appropriate Progress Billing report, reports 21—42 and send this report to your customer to show the retention
amount is now due.

14 Close the 3-7 Report Printingwindow.
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NOTE: The final application remains inSubmitted status because there is not an invoice amount to post.
Part 2—To recalculate the retention and due dates
1 Open 3-5 Jobs (Accounts Receivable), and display the job.

2 In the Terms section of the window, clear theRetention Rate.

3 From theUpdatemenu, select Recalculate Retention.

4 On theRecalculate Retentionwindow, enter theNew Due Date for Invoices and select the appropriate
Recalculation option.

5 Click OK.

6 To themessage to confirm the number of open invoices found, click OK.

7 From the Filemenu, select Save.

8 On 3-5 Jobs (Accounts Receivable), click Invoices and review theNet Due amount to verify that the retention has
been released.

Part 3—To create a retention credit invoice for the amount of the retention due

In this part, you are going to create a retention credit invoice and use the amount of retention due as thePrice of the credit.

1 Open 3-2 Receivable Invoices/Credits.

2 Do the following:

a In the Invoice# text box, enter the credit invoice number.

b In theDate text box, enter the date of the invoice.

c In the Job text box, enter the job number.

d If the job uses phases, enter the phase number in thePhase text box.

e In theDescription text box, enter a brief statement about the invoice.

f In theDue Date text box, enter the invoice due date.

g In theDiscount Date text box, enter the due date by which payment must be received for the discount to apply.

h In theStatus list, select the invoice status.

i In the Type list, select the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the amount of the retention due.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 On the Filemenu, click Save.
Part 4—To apply the credit to retention
1 1. In 3-3-1 Cash Receipts apply the credit to all open retention.

2 2. Apply the retention credit invoice created to all open retention invoices.

NOTE: For detailed instructions on applying a credit to open invoices see the link below.
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3 Open 3-3-1 Cash Receipts.

4 Do the following:

a In theAccount box, type the ledger account number for the cash account.

b In theDeposit# box, type the deposit number.

c In theDate box, type the deposit date.

d In theDescription box, type a brief statement about the transaction.

5 Do one of the following:

a In theClient box, type the client number.

b In the Job box, type the job number.

6 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

7 Click theDisplay button.

8 In the grid, do the following:

a In theCredit cell of the original invoice, type the amount as a positive number.

b In theCredit cell of the credit invoice, type the amount as a negative number.

IMPORTANT: the amounts in theCredit columnmust balance to zero.

9 Repeat step 6 for each credit you want to apply.

10 On the Filemenu, click Save.
Part 5—To create an invoice for the retention due amount

In Part 5, you are going to create an invoice using the amount of retention due as thePrice of the invoice.

1 Open 3-2 Receivable Invoices/Credits.

2 Do the following:

a In the Invoice# box, type the invoice number.

b In theDate box, enter the date of the invoice.

c In the Job box, type the job number.

d If the job uses phases, type the phase number in thePhase box.

e In theDescription box, type a brief statement about the invoice.

f In theDue Date box, enter the invoice due date.

g In theDiscount Date text box, type the due date by which youmust receive payment for the client to receive the
discount.

h From theStatus list, select the invoice status.

i In the Type list, click the invoice type.

NOTE: Select an Invoice typeMemo if you do not want the transaction to effect the job balances

3 In the grid, do the following:
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a In theDescription cell, type a brief statement about the item.

b In theQuantity cell, type the quantity of items.

c In thePrice cell, type the amount of retention due as thePrice of the invoice.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 From the Filemenu, click Save.
Part 6—To print a 3-4 Statement for detailed billing information
1 Open 3-4 Statements.

2 Select the 21-Job Statements report.

3 In the Job# box, type the job number.

4 Select the Include Paid Invoices check box.

5 Select the Include Payment History check box.

6 From the Filemenu, select Print.

7 7. On theStatement Variableswindow, type theStatement Date, and click OK.

8 Your statement details all outstanding amounts due, including the retention invoice.

9 Close the 3-4 Report Printingwindow.

Updating retention for jobs

To update retention for a job:

1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 In theRetention Rate text box, type a new rate.

3 On theUpdatemenu, click Recalculate Retention.

4 TheRecalculate Retentionwindow opens.

5 In theNew Due Date for Invoices text box, type the due date you want to assign the invoices.

6 UnderSelect Recalculation Option, do one of the following:

a Select to updateOnly invoices with Retention, or

b Select to updateAll invoices.

7 Click OK.

8 On the Filemenu, click Save.

About billing retention

After releasing the retention for a job contract or invoice, you can print a statement reflecting the release of retention. If your
client requires an invoice for the released retention, you canmodify theStatement form design to resemble an invoice.

Editing statements to bill for retention

To edit a statement to create an invoice for retention:

1 Open 3-4 Statements.

2 TheReport Window opens.
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3 On themenu bar, click Edit, then click Form Design.

4 Consider maximizing the Form Designwindow to bring everything into view.

5 Delete the form title, Statement, and enter a new title.

6 Delete the gray detail box.

7 In its place, type a sentence such as the following: This invoice requests payment for all previously withheld retention.

8 Do any of the following:

a Delete theAging text boxes and the boxes.

b Delete theContract Summary boxes.

9 On the Filemenu, click Save.

About job documents
The 3-1-8 Job Documentwindow opens to aReport Printerwindow that prints documents designed in the 13-5
Form/Report Page Designmenu for jobs. The types of job documents created can include transmittal forms, form letters,
contracts, and proposal forms. When designing a job document, you canmerge information from the job, client, employee,
and vendor files. Save the job documents using the *.docs_job file name extension.

Job Phases
About job phases

NOTE: Job phases, in contrast to bid items, affect estimates and some billing items and follow through the entire job.

IMPORTANT: Phase 0-None is merely a place holder representing the fact that you are not using phases. To use
phases, youmust begin with phase 1 or higher.

Using phases in a job affects all its aspects, for example:

l Job schedules

l The job budget

l All document control

l Purchase orders

l Subcontracts

l Change orders

l Proposals

l Project management reports and analysis

l Job costs

l Change orders

l Payables

l Billing

Phases organize jobs and can represent different sections of a job, such as different buildings or lots. You can also use
phases to distinguish different types of work, such as change orders or site work. Because phases flow through the entire
job, they do not restrict which billingmethods you can use.
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Suppose a contract is for the construction of five houses. To track costs that benefit the entire project, create a phase for
the project costs. Then create a phase for each lot. The list of phases might look like following:

Phase # Description

100 Project costs

200 116Maple Street

300 124Maple Street

400 130Maple Street

500 140Maple Street

600 160Maple Street

Phases can include the billing amount andmodel number. The billing amount represents the total amount you are billing for
the phase. When working on subdivisions, you can track whichmodel home to build on each lot by assigning the
appropriate model number to each phase.

You can also include a unit of measure and quantity measured in each phase. To continue the example above, the plans
provide the total square footage for each house; therefore, enter square feet as the units and the total square footage of the
house as the quantity.

Entering job phases

NOTE: Job phases, in contrast to bid items, affect estimates and some billing items and follow through the entire job.

To use Phases, youmust begin with Phase 1 or higher. Phase 0-None is a place holder if you are not using Phases.

To enter job phases:

1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 From theOptionsmenu, select Job Phases.

3 On the Job Phaseswindow, in thePhase# column, enter the phase number.

4 In theDescription column, enter a brief statement about the phase.

5 Do any of the following, as required:

a In theBilling Amount column, enter the amount that you want to bill per phase when creating invoices by phase.

b In theRetention column, enter the retention rate for the phase.

c In theModel column, enter themodel.

d In theUnit column, enter the unit of measurement.

e In theQuantity column, enter themeasurement.

6 Repeat steps 3–4 for each phase.

7 Repeat step 5 for each phase only as required.

8 On the Filemenu, click Save.

TIP: Instead of setting a retention rate for the entire job, you can set a separate retention rate for each phase.
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Bid Items
About bid items

IMPORTANT: Bid items, in contrast to job phases, only affect estimates and some billing items and do not follow
through the entire job.

Bid items provide a way to divide estimates into smaller parts. You use bid items to segment estimates into smaller units
and/or to satisfy external requirements for bidding and billing a job. Bid items affect these line items: Daily Field Reports,
Proposal, andUnitary Billing.

Bid items can be entered in either 9-5 Takeoffs or in 3-5 Jobs (Accounts Receivable). There are four bid item types: 1-
Base Bid, 2-Allowance, 3-Alternate, and 4-Change Order. Bid items may follow the general schema of the Construction
Specifications Institute (CSI), such as 1-General Conditions, 2-Site Work, 3-Concrete, etc., or they may be specific to
your business needs.

Bid items can provide a solution when a client or lender requires you to submit a proposal based on bid items. Some
contractors even use bid items internally as another way to track project data. The bid item categories can differ from job to
job and are not necessarily determined by types of work performed. After the list of bid items is set up for a job, you can use
the bid items when creating an estimate budget and proposal. In addition, you can create unitary bills by bid item. You can
also use the Item Code column to reference alphanumeric codes, which are required by many projects.

You can provide overhead and profit rates for each bid item. When you calculate a takeoff the first time, Sage 100
Contractor applies the appropriate overhead and profit rates to the extended costs of the assemblies and parts listed under
each bid item. You can update or change the overhead and profit rates from theBid Itemswindow at any time.

Examples of bid items

Some jobs require contractors to use bid items as ameans of breaking apart costs into different categories. Bid items can
vary greatly from job to job. Some jobs might only use a few bid items, while others might use well over 100 bid items.

The following example illustrates a short list of bid items for the repair of a water system:

Row Item# Item Code Description

1 0 None 1—Base Bid

2 1000 Tie in to 8” water main

3 2000 6” water line

4 3000 4” water line

5 5000 Fire hydrant

6 6000 Water service with meter

Some jobs require amore extensive list of bid items. The following example illustrates amore comprehensive list for the
construction of an elementary school:

Row Item# Item Code Description

1 0 None 1—Base Bid

2 1000 General requirements

3 2000 Rough grading/utilities
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Row Item# Item Code Description

4 3000 Site concrete

5 5000 Paving

6 6000 Landscaping

7 7000 Foundation slabs

8 8000 Wood framing

9 9000 Insulation

About bid item types

As you enter bid items, you can assign each item a type.

Item Type Description

1-Base Bid Indicates standard items on the proposal.

2-Allowance

Indicates that the item provides for an allowance in the
costs.

Suppose you are building a residential home but the
client has yet to decide on carpets. A carpet allowance
sets the costs for carpets at a specified amount, which
is included in the contract.

3-Alternate

Indicates the cost for the work performed based on
additions or alternate plans.

Suppose that plans for a commercial building call for an
asphalt roof and an alternate cost for a ceramic tile roof.
On the proposal, you can list the cost for the asphalt
roof. Then you can list the additional cost for the
ceramic tile roof as the alternate.

4-Change
Order

Indicates the bid item contains only change work. In a
takeoff, you can create a bid item for each change order.
When you export change orders from a takeoff, Sage
100 Contractor only exports information contained in bid
items with this type.

About using phases and bid items together

There are significant differences and some similarities to understand when using phases and bid items in jobs. For
example, both phases and bid items can be used in the 9-5 Takeoffswindow to develop an estimate for a job. However,
phases affect all aspects of a job while bid items only affect job estimates.

Phases, for example, affect and follow through the entire job, including:

l Schedules

l Budgets

l All document control
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l Purchase orders

l Subcontracts

l Change orders

l Proposals

l Project management reports and analysis

l Job costs

l Change orders

l Payables

l Billing

Phases organize jobs and can represent different sections of a job, such as different buildings or lots. You can also use
phases to distinguish different types of work, such as change orders or site work. Because phases flow through the entire
job, they do not restrict which billingmethods you can use.

Bid items, by contrast, only affect estimates and some billing items and do not follow through the entire job. You use bid
items to segment an estimate into smaller units and/or to satisfy external requirements for bidding and billing a job. Bid
items affect these items: Units inDaily Field Reports, Proposals based onBid Items andUnitary Proposals, and
Unitary Billing.

In an estimate, phases and bid items can work together like a spreadsheet. You can enter data in a takeoff grid for a
specific combination of bid item and phase through theBid Items and Job Phases windows accessible on the Takeoff
Details tab on 9-5 Takeoffs.

IMPORTANT: Bid item 0-None andPhase 0-None
are place holders if you are not using bid items or
phases. To use bid items and/or phases, youmust
begin numbering them with 1 or higher.

Entering bid items

To enter bid items:

1 Open 3-5 Jobs (Accounts Receivable), and select the job.

2 Do one of the following:

a On theOptionsmenu, click Bid Items.

b Click the detail button next toBid Item in 9-5 Takeoffs.

3 In the Item# text box, enter your bid item number.

4 In the Item Code text box, enter the bid item code required by the client.

5 In theDescription text box, enter a brief statement about the bid item.

6 In theUnit text box, enter the unit of measurement.

7 In theQuantity text box, enter the number of units.

8 In the Item Type text box, enter the bid item type: 1-Base Bid, 2-Allowances, 3-Alternate, or 4-Changes.
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9 In theOverhead text box, enter the default overhead rate.

10 In theProfit text box, enter the default profit rate.

11 Repeat steps 3–10 for each bid item.

12 On the Filemenu, click Save.

Pre-liens
About pre-lien notices

In thePre-Lien Informationwindow, provide the appropriate names and addresses for pre-lien notices. Your particular
circumstances will determine what information to supply. Suppose that Jones Electrical was subcontracted to do the
electrical work in a commercial building. Because Jones Electrical has to supply a pre-lien notice to the contractor, it is
therefore necessary to complete the text boxes underContractor.

Sage 100 Contractor comes with a system report form design for a pre-lien and a public lien. To include different information
in the printed pre-liens, change the fields in the pre-lien or public lien form designs.

To print an example of a pre-lien notice, open 3-1-10
Pre-Lien Notices, print one of the examples, 21-Pre-
Lien Notice and 31-Pre-Lien Notice~CA Public
Works.

Entering pre-lien notices

CAUTION: In the Sage 100 Contractor application, functionality regarding pre-liens and public liens is based on
requirements in California. Check with an attorney or the local builder’s exchange to determine your rights under the
laws of your state, and then customize the form design tomeet the state requirements.

To enter a pre-lien notice:

1 Open 3-5 Jobs (Accounts Receivable), and then select the job.

2 On theOptionsmenu, click Pre-Lien Information.

3 In theDescription of Work text box, enter a brief statement about the work you are performing.

4 Do any of the following:

a Under Lender, enter the lender’s name and address.

b UnderContractor, enter the contractor’s name and address.

c UnderOwner, enter the owner’s name and address.

d UnderContracted By, enter the name and address of the person or company who contracted your company.

e UnderSubcontractor, enter the subcontractor’s name and address.

5 On the Filemenu, click Save.

Printing pre-lien notices

To print pre-lien notices:

1 Open 3-1-10 Pre-Lien Notices.

2 The 3-1-10 Report Printingwindow opens for printing pre-lien notices.

3 On theReport Criteria tab, select a report style.
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4 In the Job# drop-down box, select the operator, and then the job number.

5 For example, youmay enterEqual for the operator.

6 Click thePrint preview and Drilldown (when available) to preview your pre-lien notice.

7 If everything looks correct, click thePrint records button.

Paygroups for Jobs
About job-specific paygroups

Companies that work different prevailing-wage jobs at the same time can use paygroups tomanage the wage and benefit
requirements for each job. For each prevailing-wage job, you can set up a table of paygroups and employee positions.

When you enter a job number on a timecard, Sage 100 Contractor looks at the job record to determine if it contains a table of
paygroups. Sage 100 Contractor then compares the employee’s position number from the employee record with the
position number assigned to each paygroup in the job record. When Sage 100 Contractor matches the employee’s position
with a position assigned to a paygroup, it inserts the paygroup in the timecard line.

Because Sage 100 Contractor uses employee positions to determine the correct paygroup, it is important to assign a
different employee position to each paygroup in the table. Otherwise, Sage 100 Contractor uses the first paygroup it finds
with the correct position, ignoring other paygroups that contain the same employee position.

In some companies, employees perform different types of work over the course of a job, and a single paygroup cannot
cover the different wages and benefits paid based on the type of work performed. Therefore, it is necessary to set up the list
of job-specific paygroups differently.

Entering job-specific paygroups

You can set up the job-specific paygroups to handle employees who work a variety of positions on a single job.

To enter job-specific paygroups:

1 Open 3-5 Jobs (Accounts Receivable).

2 Select the job.

3 On theOptionsmenu, click Job Paygroups.

4 In thePosition cell, enter the employee position.

5 In thePaygroup cell, enter the paygroup number.

6 If the job involves piecework, enter the rate in thePiece Rate cell. Otherwise, Sage 100 Contractor uses the rates
specified in thePaygroupswindow.

7 Repeat steps 3–6 for each paygroup.

8 On the Filemenu, click Save.

TIP: You can set up the job-specific paygroups to handle employees who work a variety of positions on a single job.

Setting up job-specific paygroups for employees working multiple positions

When an employee works a variety of positions on a job, you can use paygroups to control the payment of wages and
benefits according to the position worked. To do this, you set up a “dummy” paygroup that does not contain any rates. Then
you set up the job paygroup positions in the 3-5 Jobs (Accounts Receivable)window to refer only to the dummy
paygroup.
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When you enter a timecard, Sage 100 Contractor selects a paygroup by comparing an employee’s position to the list of job-
specific paygroups and the associated positions. Regardless which position you enter in the timecard, Sage 100 Contractor
selects the dummy paygroup. You can then use a Lookupwindow to select the correct paygroup based on the position
worked by the employee.

Suppose you are setting up paygroups for job number 200, a prevailing-wage contract for a housing development. Each
member of the crew performs several different tasks, so you set up the following paygroups in 5-3-4 Paygroups. Paygroup
number 200-Sonoma Job is a dummy paygroup and does not use any wage rates. Paygroups 210-Project Manager, 220-
Superintendent, and 230-Foreman are assigned wage rates.

Then the list of job-specific paygroups is set up using only paygroup 200-Sonoma Job. Because each employee is working
several different positions, enter the dummy paygroup on a separate line for each employee position required by job 200.

When entering a timecard information for job 200, Sage 100 Contractor selects paygroup 200-Sonoma Jobwhen the
employee’s file contains position 5, 6, or 7. You can then enter the appropriate paygroup, or select a paygroup by displaying
aPicklist.

IMPORTANT: As you press the Enter key tomove through the grid, notice that as youmove from cell to cell, Sage
100 Contractor autopopulates the cell with information in bold text. You have to press Enter again for Sage 100
Contractor to accept that information and write it to the database. As long as there is bold text in a cell, that
information is not yet recognized. Pressing the drop-down arrow in a cell with bold text does not open the “dummy”
paygroup.

To set up job-specific paygroups:

1. Open 5-3-4 Paygroups.

2. Create a dummy paygroup for the job that uses the job name and job number as the paygroup description.

Do not include any rates in this paygroup.

3. Enter the actual paygroups you want to use for the job, and include the wage and benefit rates.

When creating the paygroups, organize the paygroups by job.

When numbering the paygroups, skip a few numbers between groups in case you need to add other paygroups later.

4. Open 3-5 Jobs (Accounts Payable).

5. From theOptionsmenu, select Job Paygroups.

6. Set up job paygroups using a “dummy” paygroup for each of the positions.

For each position that requires you to use a separate paygroup, enter the dummy paygroup on a separate line and
assign an employee position to it.

7. When you are finished, the job-specific paygroups table should contain a list of the same dummy paygroup assigned
different employee positions.

8. Open 5-2-2 Job Payroll Records.

9. Create a timecard.

10. Press the Enter key tomove through the grid to the paygroups.

11. Go back to the paygroup cell, and click the drop-down arrow.

12. The correct job paygroup appears.
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TIP: To display only the job paygroups from the grid, use the ENTER key tomove through the “dummy” paygroup that
defaults into the grid cell of the timecard lines. Then go back to the timecard line. The dummy paygroup is no longer
bold. Click the drop-down arrow to display the Lookupwindow. Now only the correct Job Paygroups appear.
Alternatively, you can enter the correct Job Paygroup number in the timecard line cell, and then click the drop-down
arrow to display the dummy Job Paygroups.

3-6 Receivable Clients

About receivable clients
Use the 3-6 Receivable Clientswindow to store information about past, current, and future clients as well as manage the
sales process and track client related issues. To helpmanage sales, you can keep track of referrals, appointments, and call
back dates. You can even keep track of when you last mailed a brochure to a client. In addition, you can set up customized
lists to provide information about the lead source, region, company size, and to whichmailing list they have been assigned.

Using information from the client database, you can create all kinds of client-related documents and reports. For example,
theGreeting text box, in which you can enter a personalized greeting such as the owner’s nickname, provides a way to
personalize documents. When creating the form design, you can insert a field representing the information in theGreeting
text box. Then when you print the document, Sage 100 Contractor replaces the field with the information from theGreeting
text box.

Entering receivable clients
Be sure to enter all the important information regarding receivable clients. Entries made in the 3-6 Receivable Clients
window are used for other functions, such as fax and email scheduling.

IMPORTANT: Sage 100 Contractor uses information entered on the 3-6 Receivable Clientswindow andVendors
window for other functions such as the scheduling and sending of faxes and email messages. If fax numbers and
email addresses for clients are not entered in these windows, then client and vendor contacts do not appear on the fax
and email distribution lists.

To enter a receivable client:
1 Open 3-6 Receivable Clients.

2 In the data control text box, enter the client number.

3 In theClient Name text box, enter the full client name.

4 In theShort Name text box, enter a brief name for the client.

5 In theStatus list, click the client status.

6 In the Type list, click the client type.

7 On theGeneral Information tab, do the following:

a In theAddress 1, Address 2, City,State, and Zip text boxes, enter the address information.

b In theCross Street text box, enter the nearest cross street.

c In theMap Location text box, enter themap coordinates.

d In the Tax District list, click the sales tax district.

e In theDue Terms text box, enter the cycle for the date when the invoice is due.

f In theDiscount Terms text box, enter the cycle by which payment must be received for the discount to apply.

g In theDiscount Rate text box, enter the discount rate.
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h In the Finance Rate text box, enter the annual finance rate.

i In theContact grid, do the following:

i In theContact Name text box, enter the contact's name.

IMPORTANT: The first contact in the list is considered to be the primary contact in reports.

ii In the Job Title text box, enter the contact's job title.

iii In thePhone# text box, enter the contact’s telephone number.

iv In theExtension text box, enter the contact's telephone extension, as necessary.

v In theEmail text box, enter the contact's email address.

vi In theCell# text box, enter the contact’s cellular number.

vii In the Fax# text box, enter the contact’s fax number.

viii In theOther# text box, enter the contact’s other telephone number.

ix In theOther Description text box, enter the contact’s other telephone number description.

x In theNotes text box, enter any applicable notes about the contact.

8 On theOther Addresses tab, do the following:

a In theBill Address 1, Bill Address 2, Bill City, Bill State, andBill Zip text boxes, enter the billing address
information.

b In theShip Address 1, Ship Address 2, Ship City, Ship State, andShip Zip text boxes, enter the shipping
location information.

9 On theBilling and Payment tab, do the following:

a In theCredit Card Type text box, enter the type.

b In theCredit Card# text box, enter the client’s credit card number.

c In theCardholder Name text box, enter the name as it appears on the credit card.

d In theExpiration text box, enter the date of expiration.

e In theDiscount text box, enter the client's discount rate (%) on products.

f In thePO# text box, enter the purchase order number for service invoices.

g In theSales Tax Exempt# text box, enter the sales tax exemption number for service invoices.

h UnderPart Billing Basis, select how you want to bill the client for parts.

10On theSales and Marketing tab, do the following:

a In thePurchase text box, enter the date of the last product purchase.

b In theReceived text box, enter the date you received the sales lead.

c In theCall Back text box, enter the date when the account manager should next call the client.

d In theContact text box, enter the date when the client was last contacted.

e In theReference text box, enter the date when you last contacted the client for a reference.

f In theGreeting text box, enter a greeting or name that you want to use for client documents.

g In theMail Piece, click the type of mail piece last sent to the client. Youmust manually update the information in the
Mail Piece text box.
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h In theDate Mailed text box, enter the last piece of mail that was mailed to the client. Youmust manually update the
information in theMail Piece text box.

i In theProduct list, click the last product purchased by the client.

j In theSource list, click the source of the lead.

k In theArea list, click the region where the client is located.

l In theSize list, click the company size.

m In theMail List list, click themail list.

n In theManager text box, enter the employee number for the employeemanaging the client’s account.

o In theSalesperson text box, enter the employee number for the employee who sold the account.

11 (Optional) In theUser Def , User Def2, User Def3, User Def4, andUser Def5 text boxes, enter the user-defined
information as necessary.

12On the Filemenu, click Save.

Setting up receivable client status
Use the client status to provide information about your clients such as sales cycles, credit limits, or other client
characteristics. You can even design the status settings to separate client prospects, current clients, and past clients.

Example 1: Using client status settings for credit limits

Client Status # Status Name

1 NoCredit

2 Credit Limit $1000

3 Credit Limit $2000

4 NoCredit Limit

Example 2: Using client status settings for current and past clients

Client Status # Status Name

1 Contact

2 Prospect

3 Current Customer

4 Customer 2–5 Years Ago

5 Customer 6–10 Years Ago

6 DoNot Accept Contract Again

To set up client status:
1 Open 3-6 Receivable Clients.

2 Next to theStatus list, click the detail button.

3 In theClient Status# text box, enter the status number.

4 In theStatus Name text box, enter a description of the client status.
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5 Repeat steps 3-4 for each status.

6 On the Filemenu, click Save.

Setting up receivable client types
Client types allow you to categorize clients. A subdivision developer, for example, can use client types to list the
subdivisions, or the release of homes in subdivisions or to track the interests of prospective home buyers. For some
companies such as service/repair contractors, the geographic area is more important because all the clients are
homeowners or commercial businesses.

To set up client types:

1 Open 3-6 Receivable Clients.

2 Next to the Type list, click the detail button.

3 TheClient Typeswindow opens.

4 In theClient Type# column, enter the type number.

5 In the Type Name column, enter a description of the client type.

6 Repeat steps 4–5 for each type.

7 On the Filemenu, click Save.

Setting up receivable client sizes
In theClient Sizewindow, you can set up a list of the different sizes of your clients’ projects.

For example, a developer might use the following list to classify the size of house built for a client:

Client Size # Size Description

1 < 1500 sq. ft.

2 1501–2000 sq. ft.

3 2001–2500 sq. ft.

4 > 2501 sq. ft.

Or, an electrical contractor might use the following list to classify service panels by ampere:

Client Size # Size Description

1 < 1000 amp

2 1001–2000 amp

3 > 2001 amp

To set up client sizes:
1 Open 3-6 Receivable Clients.

2 Click theSales and Marketing tab.

3 On the right side of the window, next to theSize drop-down, click the detail button.

4 TheClient Size Listwindow opens.
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5 In theClient Size# text box, enter the client size number.

6 In theSize Description text box, enter a brief statement about the client size.

7 Repeat steps 5–6 for each size.

8 On the Filemenu, click Save.

Setting up receivable client product lines
In theClient Product Linewindow, you can set up a list of the different products you supply.

To set up client product lines:
1 Open 3-6 Receivable Clients.

2 Click theSales and Marketing tab.

3 Next to theProduct drop-down, click the detail button.

4 In theProduct# text box, enter the product number.

5 In theDescription text box, enter a brief statement about the product.

6 Repeat steps 4–5 for each product.

7 On the Filemenu, click Save.

Setting up product discounts for receivable clients
Setting up a product discount for a client is a three-step process using 3-6 Receivable Clients, 9-2 Parts, and 11-2 Work
Orders/Invoices/Credits.

To set up product discounts for clients:
1 Open 3-6 Receivable Clients, and select a client.

2 On theGeneral Information tab, in theDiscount Rate text box, enter the product discount.

3 For example, entering 10means that your client gets a 10 percent discount.

4 Click theBilling and Payment tab. UnderPart Billing Basis, select either Last Cost, Average Cost (Inventory), or
Billing Amount.

5 Click Save.

6 Open 9-2 Parts, and locate the part that you want to discount for the client.

7 UnderCost/Billing, enter the appropriate cost in the appropriate text box.

8 If this is an inventory item and you need to job cost in 11-2 Work Orders/Invoices/Credits, under Inventory/Ordering,
select theRequired from Inv. check box.

9 Click Save.

10 Open 11-2 Work Orders/Invoices/Credits, and select the same client as you did on 3-6 Receivable Clients.

11 Select aStatus of 1-Open and select a Type.

12 Click the Invoice Details tab, and enter thePart#.

13 TheDescription text box auto-populates with the part description.

14 ThePrice text box auto-populates with the discounted price.

15 Click Save.
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NOTES:
l Last Cost in 3-6 Receivable Clientsmaps toDefault Cost in 9-2 Parts.

l Average Cost (Inventory) in 3-6 Receivable Clientsmaps toAverage Cost in 9-2 Parts.

l Billing Amount in 3-6 Receivable Clientsmaps toBilling Amountin 9-2 Parts.

Tax Districts and Tax Entities
About tax districts and tax entities

Most states andmany cities impose taxes on sales. The seller must add the tax to the selling price and then pay the taxes
to the government. In the construction trades, contractors are usually not responsible for collecting taxes. However, certain
types of work require contractors to collect and remit sales taxes to the appropriate government agency. The Tax Districts
window provides the flexibility necessary tomanage, compute, and report the individual sales taxes levied by state,
county, andmunicipal governments.

When you create an invoice, Sage 100 Contractor determines the sales taxes from the indicated tax district. A tax district is
comprised of a group of tax entities to which you report the taxes collected within that particular region. Before you can
create a tax district, youmust create the tax entities.

After you have set up the various tax entities, you can build different tax districts from them. For a given tax district you can
include five tax entities, indicate which cost types are taxable, and indicate whether profit is taxable. To calculate taxes,
Sage 100 Contractor separately computes the tax for each entity contained in the tax district, but on the invoice provides a
total of the taxes.

Suppose a contractor works in a given state. In the state the sales tax rate is 7.25 percent, and in addition, a given county
has a 0.25 percent sales tax rate. Before creating a tax district, the tax entities, titled (State) and (Name) County, are set
up, each with its specified rate. The contractor then creates tax district 1-(Name) County, CA, which contains the tax
entities (State) and (Name)County. When setting up job records for projects in the county, the contractor can include the
tax district. Later when entering invoices, Sage 100 Contractor automatically uses tax district 1-(Name) County, CA and
computes the appropriate state and county taxes.

You can also set up tax entities to compute discretionary surtaxes. When calculating the taxes for a job, both the sales tax
and the discretionary surtax apply until the total of the taxable items on the billing invoice(s) equal or exceed themaximum.
At that time, the discretionary surtax no longer applies, and only the sales tax continues to apply.

Sales tax requirements differ from region to region. In one region youmight not have to report any sales tax, while in another
region youmight need to report taxes on everything but subcontract work. Before setting up the tax districts, consult the
local tax agencies to determine the correct tax rates.

Setting up tax districts

To set up tax districts:

1 Open 3-6 Receivable Clients.

2 Next to the Tax District list, click the detail button.

3 In theDistrict# text box, enter the number you want to assign the tax district.

4 Do the following:

a In theDistrict Name text box, enter a description of the tax district.

b In the Tax Entity 1 text box, enter the tax entity number.

c In theMaterial text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

d In the Labor text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.
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e In theEquipment text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

f In theSubcontract text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

g In theOther text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

h In theUser Defined Type 6 text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

i In theUser Defined Type 7 text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

In theUser Defined Type 8 text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

In theUser Defined Type 9 text box, type [Yes] to tax this cost type. Type [No] if the cost type is not taxable.

In theProfit text box, type [Yes] to tax the profit. Type [No] if the profit is not taxable.

5 Repeat step 4 for each item.

6 On the Filemenu, click Save.

TIP: You can assign up to five tax entities to a single tax district.

Setting up tax entities

To set up tax entities:

1 Open 3-6 Receivable Clients.

2 Next to the Tax District list, click the detail button.

3 Right-click in a blank Tax Entity cell to display the grid menu. Click Display Detail/Add Record to display the editable
Tax Entitieswindow.

4 In the Tax Entity# text box, enter the number you want to assign the tax entity.

5 In theEntity Name text box, enter a brief description of the tax entity.

6 In theRemit To text box, enter the name to which you remit payments.

7 In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

8 In the Tax Rate text box, enter the tax rate.

9 In theBilling Limit text box, enter themaximum dollar amount.

Sage 100 Contractor stops calculating the tax when the total of the taxable items on the billing invoice(s) equal or exceeds
themaximum.

10 In the Limit Type text box, enter the number representing the calculation limit.

The limit type establishes how Sage 100 Contractor determines when the amount in theBilling Limit text box is met.

11 Repeat steps 4–10 for each tax entity.

12 On the Filemenu, click Save.

About tax entity limit types

Some states assign limits to the amount of taxes you collect. Check with your state tax agency.

Type Number Description

1-Invoice Applies the billingmaximum to a single invoice.
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Type Number Description

2-Job Applies the billingmaximum to a job.

3-Service Contract Applies the billingmaximum to a service record
assigned status 10-Contract.

4-Service Location
Applies the billingmaximum to a single service
location. A client might havemultiple locations and
the limit applies to each location.

5-Client Applies the billingmaximum to a client.

Opening tax entities

The Tax Districtwindow can also be accessed from 3-5 Jobs (Accounts Receivable). Next to theSales Tax District
list, click the detail button, then follow step 3.

To open a tax entity:

1 Open 3-6 Receivable Clients.

2 Next to the Tax District list, click the detail button.

3 The Tax Districtswindow appears.

4 Select a Tax Entity text box. Do one of the following to display or select the tax entity.

a Click the drop-down arrow to open the Tax Entities Lookupwindow. Double-click the selection that you want to copy
into the Tax Districtwindow.

b If you know the Tax Entity you want to select, type it directly in the text box.

c If you want to enter a new Tax Entity, type it in the text box. You will be prompted with amessage to create a new one
and the Tax Entitywindow will display.

Changing the sales tax rate

To change the sales tax rate:

1 Open 3-5 Jobs (Accounts Receivable).

2 At the right end of theSales Tax District box, click theView/Add Records button.

3 On the Tax Districtswindow in the Tax Entity 1 column, click in the first blank cell.

4 On your keyboard, press F6.

5 On the Tax Entitieswindow, make the necessary changes and then select File > Save.

6 On the Tax Districtswindow select File > Save.

About receivable client documents

In the 3-1-7 Client Documentwindow, you can print documents designed in 13-5 Form/Report Page Design for clients.
The types of client documents created can include transmittal forms, form letters, contracts, and proposal forms. When
designing a client document, you canmerge information from the client files. Save the client documents using the *.docs_
client file name extension.
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Service Contracts
Entering service contracts for clients

In theService Contractswindow, you can track the locations or equipment covered by a contract you have with the client.
For each client, you can enter multiple contracts.

To enter service contracts for a client:

1 Open 3-6 Receivable Clients.

2 Select the client.

3 On theOptionsmenu, click Service Contracts.

4 In theContract# text box, enter the contract number.

5 In theDescription text box, enter a brief statement about the contract.

6 In theExpiration text box, enter the date when the contract expires.

7 In the Type text box, enter the number of the service contract type.

8 In theCoverage list, select the coverage.

a If you click All Locations/All Equipment, go to step 9.

b If you click Specified Locations Only, then enter the locations in the Locations Grid.

c If you click Specified Equipment Only, then enter the client’s equipment in theEquipment Grid.

9 On the Filemenu, click Save.

Setting up service contract types

If you perform service work, you can categorize the types of service contracts you fulfill.

Example 1: Service contract types using projects

Contract # Description

1 Time andMaterials Projects

2 Progress Billing Projects

3 Government Projects

Example 2: Service contract types using time increments

Contract # Description

1 Weekly

2 Monthly

3 Bi-monthly

4 Semi-yearly

5 Yearly
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To set up service contract types:

1 Open 3-6 Receivable Clients.

2 Select the client.

3 On theOptionsmenu, click Service Contracts.

4 Next to the Type list, click the detail button.

5 In theContract# text box, enter the number.

6 In theDescription text box, enter a brief statement about the type of contract.

7 Repeat steps 5–6 for each type.

8 On the Filemenu, click Save.

Setting up client service areas based on regions

Some service companies dispatch technicians based on geographic regions. In theService Areaswindow, you can set up
a list of the different areas in which your clients are based.

To set up a list of client service areas:

1 Open 3-6 Receivable Clients.

2 Click theSales and Marketing tab.

3 Next to theArea text box, click the detail button.

4 In theArea# text box, enter the area number.

5 In theDescription text box, enter a brief statement about the area.

6 Double-click theDispatch Color text box.

7 Double-click the color you want to use.

8 Repeat steps 3–7 for each service area.

9 On the Filemenu, click Save.

NOTE: Both client records and service receivable records use the same table of service areas.

Entering the service locations for clients

For service work, you can set up a table of the different locations that youmust service.

To enter service locations for a client:

1 Open 3-6 Receivable Clients.

2 On theOptionsmenu, click Locations.

3 In theClient Locationswindow, do the following:

a In the Location# text box, enter the number you want to assign the client location.

b In theName text box, enter a brief description of the location.

c In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

d In thePhone# text box, enter the telephone number for the location.

e In theContact text box, enter the name of the person to contact at the location.

f In theArea drop-down, select the client region.
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g In theMap Locate text box, enter themap coordinates.

h In theCross Street text box, enter the name of the nearest cross street.

i In the Tax District text box, enter the number of the tax district within which the location falls.

j (Optional) In theUser Defined text box, enter the user-defined information as necessary.

4 Repeat step 3 for each location.

5 On the Filemenu, click Save.

Entering appointments

In theAppointmentswindow, you can track appointments made with clients.

To enter appointments:

1 Open 3-6 Receivable Clients.

2 On theOptionsmenu, click Appointments. TheAppointmentswindow opens.

3 In theDate text box, enter the date when the appointment is to occur.

4 In theStart text box, enter the time when the appointment begins.

5 In theEnd text box, enter the time when the appointment ends.

6 In theAppt. Type text box, enter the type number for the kind of appointment.

7 In theEmployee text box, enter the employee number of the person who has the appointment.

8 In theNotes text box, you can enter a note about the appointment.

9 Repeat steps 3–8 for each appointment.

10 On the Filemenu, click Save.

TIP: You can also access theCalendar by pressing F2, and then you can enter appointments by clicking
Appointment on theEditmenu to open theCalendar Appointmentswindow.

Entering the equipment owned by a client

For service work, you canmaintain records of the client’s equipment you install, service, or repair.

To enter equipment owned by a client:

1 Open 3-6 Receivable Clients.

2 On theOptionsmenu, click Equipment.

3 In theEquipmentwindow, do the following:

a In theEquipment# text box, enter the equipment number.

b In theDescription text box, enter a brief statement about the equipment.

c In theManufacturer text box, enter the name of the equipment manufacturer.

d In theMan Part# text box, enter the part number assigned by themanufacturer.

e In theSerial# text box, enter the serial number of the equipment.

f In theClient Location text box, enter the location number for the location of the equipment.

g In theSite Location text box, enter the location of the site.

h In the Installed Date text box, enter the date when you installed the equipment.
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i In the In Service Date text box, enter the date when the item will start being used.

j In theOEM Warranty Exp text box, enter the original equipment manufacturer’s warranty expiration date.

k In theStart Date text box, enter the starting date.

l In theExpiration Date text box, enter the expiration date of the warranty.

m In the Last Service text box, enter the date when the equipment was last serviced.

n In theService Cycle text box, enter the cycle when the next service is due.

o In theNext Service text box, enter the date when the equipment is scheduled for its next service.

p (Optional) In theUser Defined text box, enter the user-defined information as necessary.

4 Repeat step 3 for each piece of equipment.

5 On the Filemenu, click Save.

Lead Management
About client lead management

Use theSales and Marketing tab in the 3-6 Receivable Clientswindow tomanage clients and sales leads. You can
provide information such as the date when you received the sales lead, indicate the source of the lead, and determine which
mail list to use for that particular client.

Using the client information, you can create custom reports to examine your customer base, create targeted customer
newsletters or marketing campaigns, or even create amailing list for holiday cards.

Setting up client lead sources

Lead sources let you track how the company gets job leads. With this information, you canmake informed decisions about
how to effectively market your business. Suppose that AAA Contracting places an advertisement in the telephone book
and adds it to the list of lead sources. As new leads come in the office staff notes when a new client selected the company
based on that particular advertisement. To determine how many new leads resulted from the advertisement, the owner
prints a list of clients using the lead source as a selection criterion.

You can also include referrals from industry professionals such as architects, as well as frommaterials suppliers and
subcontractors. If you want to track referrals from companies, leave plenty of room in the numbering system to add new
referrals as they come in.

To set up a lead source list:

1 Open 3-6 Receivable Clients.

2 Click theSales and Marketing tab.

3 Next to theSource list, click the detail button.

4 In the Lead Source# text box, enter the lead source number.

5 In theSource Name text box, enter a description of the lead source.

6 Repeat steps 4–5 for each source.

7 On the Filemenu, click Save.

Setting up client mail lists

You can create amailing list to group clients together for targetedmailings. Assigning a client to a specific mailing list
allows you to print client lists or documents using themailing list as a selection criterion.
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Following are two examples of how you can set upmail list categories:

Example 1: Categories using Mail Types

Mail List # List Name

1 Direct Mail Pieces

5 Newsletters

9 Greeting Cards

Example 2: Categories using Customer Type

Mail List # List Name

1 Bathroom Remodels

2 Kitchen Remodels

3 HomeOwners

4 Commercial Customers

To set up client mail lists:

1 Open 3-6 Receivable Clients.

2 Click theSales and Marketing tab.

3 Next to theMail List drop-down list, click theView/Add records button.

4 On theClient Mail Listwindow, in theMail List# column, enter themail list number.

5 In the List Name column, enter a description of themail list.

6 Repeat steps 4–5 for eachmail list.

7 On the Filemenu, click Save.

Entering by whom the client was referred

In theReferred Bywindow, you can note who referred the client to your company.

To enter by whom the client was referred:

1 Open 3-6 Receivable Clients.

2 On theOptionsmenu, point toReferrals, then click Referred By.

3 In theClient cell, enter the client number of the client who provided a referral to the current customer.

4 In theDate cell, enter the date of the referral.

5 In theSale (Y/N) cell, type Y if the referral resulted in a sale, or N if the referral did not result in a sale.

6 Repeat steps 3–5 for each referral.

7 In the Filemenu, click Save.

Entering whom the client has referred

In theReferredwindow, you can note who the client has referred to your company.
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To enter whom the client has referred:

1 Open 3-6 Receivable Clients.

2 On theOptionsmenu, point toReferrals, then click Referred.

3 In theReferred cell, enter the client number of the client who was referred to your company.

4 In theDate cell, enter the date of the referral.

5 In theSale (Y/N) cell, type Y if the referral resulted in a sale, or N if the referral did not result in a sale.

6 Repeat steps 3–5 for each referral.

7 On the Filemenu, click Save.

3-7 Progress Billing

About progress billing for jobs
The 3-7 Progress Billingwindow provides a system for creating progress billings, with each new application building on
the previous submitted application for a job. Then under each job, Sage 100 Contractor assigns each application its own
application number. Most progress bills are printed on AIA certificates.

Creating a progress bill requires that you provide some basic information in theProgress Billing Setupwindow. You can
provide the name of the architect and the architect’s job number for the project, as well as the income posting account, tax
district number, retention rates, and amaximum for retention.

To create an application, import the cost codes or divisions from the job’s budget or proposal. You can then select several
ways to automatically update the cost information from the job cost records. When you select thePercent from Costs
option, Sage 100 Contractor displays the actual job costs and calculates the percent of work completed by comparing the
job costs against the budget. You can instead select either the From Cost Amounts or From Billing Amounts option to
display only the amounts for each cost code.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application,
submit the record in Sage 100 Contractor by clicking theSubmit button. Sage 100 Contractor then changes the
application’s status to 2-Submitted. When the billing is approved, post the billing by clicking thePost button. Sage 100
Contractor creates an invoice, posts it to the general ledger, and then changes the application’s status to 3-Posted. When
you want to create the next application, click theNext button. Sage 100 Contractor assigns the posted application status 4-
Closed, moves the costs from theCurrent Quantity column to thePrevious Quantity column, and advances the number
in theApplication# text box.

You can also update the costs of the change work to the progress bill. You can either incorporate the changes to the costs
in the cost codes or divisions, or include the total amount of the change order as a separate line item.

AIA Certificates
You can print billing information on the American Institute of Architects (AIA) forms with single sheet printers, such as inkjet
or laser printers. Sage 100 Contractor prints most information for you; however, Sage 100 Contractor does not complete the
change order summary table. You can complete the table yourself, or print aChange Order List and submit the report with
the AIA certificate.

When printing an AIA Certificate, use theAIA Fill design in conjunction with the G702 andG703 forms. Architects
routinely require contractors to use these forms when billing for work based on the percentage of completion. You can only
purchase the certificate forms from the AIA, which holds the copyrights to the certificates.
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Sage 100 Contractor also provides a second AIA style design. The design, titledAIA Form Fill (andAIA Form
Fill~Rounded), prints the billing information on a blank page. While this form fill is similar to the AIA Certificate, most
architects require the actual AIA Certificate. Check with the job architect before using theAIA Form Fill.

NOTE: Place the AIA pages in the correct order before printing; Sage 100 Contractor prints the contract summary
first, followed by the continuation sheets.

Entering setup data for progress bills
In order to create a progress bill, you have to provide some basic information in theProgress Billing Setupwindow, such
as the name of the architect, the architect’s job number for the project, the income posting account, the tax district number,
the retention rates, and amaximum for retention.

To enter setup data for a progress bill:
1 Open 3-7 Progress Billing and click theSetup button at the bottom left.

2 In theProgress Billing Setupwindow, in theArchitect text box, enter the vendor number of the architect or engineer.

3 In theArchitect’s Job# text box, enter the number the architect uses to refer to the job.

4 In the Income Account text box, enter the income account.

5 If you are using subsidiary accounts, enter the account number in theSubaccount text box.

6 In the Tax District text box, enter the number of the sales tax district.

7 In the User Def1 and User Def2 text boxes, enter the user-defined information as necessary.

8 In the Retention section, do the following:

a In thePrimary Rate text box, enter the rate of retention.

b In theMaximum Amount text box, enter themaximum amount to withhold based on the primary rate of retention.

c In theMaterial Rate text box, enter the rate of retention for storedmaterials.

d In theSecondary Rate text box, enter the rate of retention to apply when the billings exceed the primary maximum.

9 On themenu bar, click Save.

Creating new progress bills for jobs
When you create a new progress bill for a job, you can enter the scheduled costs for each cost code or division in the
Scheduled column. After saving the first application, Sage 100 Contractor does not allow any changes to the scheduled
costs unless theAllow Editing Scheduled $ option is selected. On subsequent applications, enter changes to costs in
theChanges column.

In theCurrent Stored column, you can enter the amount of material currently being stored. When you create the next
application, Sage 100 Contractor moves the costs from theCurrent Stored column to thePrevious Stored column. As
you complete work, remove the costs for items no longer being stored. To remove costs, enter the costs as a negative
amount.

To create a new progress bill for a job:
1 Open 3-7 Progress Billing.

2 In the header, do the following:

a In the Job text box, enter the job number.

b If the job uses phases, enter the phase number in thePhase text box.
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c In theDescription text box, enter a brief statement about the work completed.

d In theApplication# text box, enter the number of the application you are submitting.

e In theBilling Date text box, enter the date ending the period for which you are submitting the request.

f In theBilling Cycle text box, enter the billing cycle.

g In theSubmitted text box, enter the submittal date.

h In theApproved text box, enter the approval date.

3 UnderBilling Basis, select theBill by cost codes orBill by cost divisions option.

4 On theOptionsmenu, click Setup and complete theProgress Billing Setupwindow.

5 Do one of the following:

a On theOptionsmenu, select Import, then click Import Budget.

b On theOptionsmenu, select Import, then click Import Proposal.

6 In the grid, do the following:

a In theCurrent Complete text box, you can enter the costs incurred. If you provide the costs incurred, do not provide
the percent of work completed in the% Completed text box.

b In theRetentionRate text box, you can accept the default primary rate from theProgress Billing Setupwindow, or
you can enter a different rate for the item.

c In theCurrent Stored text box, enter the current cost of materials stored for the job.

d In the% Completed text box, you can enter the percent of work completed. If you provide the percent of work
completed, do not provide the current costs incurred in theCurrent Complete text box.

e In the Taxable text box, type Yes if the item is taxable or No if the item is non-taxable.

7 Repeat step 10 for each item.

8 On themenu bar, click Calculate to select one option in theCalculate Gridwindow, then click [Calculate].

a Calculate the Current column based on the amounts entered in the Percentage column (this is based on the
amount entered in the% Completed text box in step 10e)

b Calculate the Percent column based on the amounts entered in the Current and Stored columns (this is
based on the amounts entered in the Current Complete and Current Stored text boxes in step 10a and 10c,
respectively)

NOTE: Sage 100 Contractor creates a separate series of applications for each phase.

Creating new progress bills manually
Here is some additional information. In theCurrent Stored column, you can enter the amount of material currently being
stored. When you create the next application, Sage 100 Contractor moves the costs from theCurrent Stored column to
thePrevious Stored column. As you complete work, remove the costs for items no longer being stored. To remove costs,
enter the costs as a negative amount.

IMPORTANT: TheOptionsmenu commandAllow Editing Scheduled $ can only be turned on and off by a
supervisor. This command allows anyone to edit theScheduled column on any application that has a status of 1-
Open or 2-Submitted.

To create a new progress bill manually:
1 Open 3-7 Progress Billing.
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2 In the header, do the following:

a In the Job text box, enter the job number.

b If the job uses phases, enter the phase number in thePhase text box.

c In theDescription text box, enter a brief statement about the work completed.

d In theApplication# text box, enter the number of the application you are submitting.

e In theBilling Date text box, enter the date ending the period for which you are submitting the request.

f In theBilling Cycle text box, enter the billing cycle.

g UnderBilling Basis, select theCost Codes orDivisions option.

3 On theOptionsmenu, click Setup, and then enter the appropriate information in theProgress Billing Setupwindow.

4 After entering the information, from the Filemenu, click Save.

5 In the grid, do the following:

a Depending on the billing basis, right-click theCost Code orDivisions text box, and select Display Picklist
Window.

b Create aPicklist of cost codes or divisions, and then click the check mark button to insert the list into the grid.

c If a vendor is associated with the item, enter the vendor number in theVendor text box.

d In theScheduled text box, enter the scheduled amount.

e In theCurrent Complete text box, you can enter the costs incurred. If you provide the costs incurred, do not provide
the percent of work completed in thePercent Complete text box.

f In theRetention Rate text box, you can accept the default primary rate from theProgress Billing Setupwindow, or
you can enter a different rate for the item.

g In theCurrent Stored text box, enter the current cost of materials stored for the job.

h In thePercent Complete text box, you can enter the percent of work completed. If you provide the percent of work
completed, do not provide the current costs incurred in theCurrent Complete text box.

i In the Taxable text box, type Yes if the item is taxable or No if the item is non-taxable.

6 Repeat step 5 for each item.

7 On themenu bar, click Calculate to select one option in theCalculate Gridwindow, then click [Calculate].

a Calculate the Current column based on the amounts entered in the Percentage column (this is based on the
amount entered in the% Completed text box in step 10e)

b Calculate the Percent column based on the amounts entered in the Current and Stored columns (this is
based on the amounts entered in the Current Complete and Current Stored text boxes in step 10a and 10c,
respectively)

NOTE: Sage 100 Contractor creates a separate series of applications for each phase.

About updating costs in progress bills from change orders
You can automatically or manually update costs in the progress bill from change orders. Choose from twomethods to
automatically update the costs from change orders. You can either incorporate the changes to costs in the individual cost
codes, or include the total amount of the change order as a separate line item.
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IMPORTANT: When using theAppend as New Lines option, do not change theDescription values as you have
entered them into the grid. Sage 100 Contractor uses an exact match of the text in theDescription column tomatch
the items from theChange Order grid to theProgress Billing grid.

Method 1: Incorporate changes to costs in the individual cost codes

When you select theAdd to Existing Lines option in 3-7 Progress Billing, Sage 100 Contractor only updates cost codes
or divisions present in both the change order and the progress bill. If the change order contains cost codes that do not
correspond to cost codes or divisions in the progress bill, Sage 100 Contractor will notify you. Review the new cost codes
in the change orders, and if necessary, manually add the new cost codes or divisions and update the progress bill again.
Sage 100 Contractor displays the amount of change to each cost code in theChanges column and the new contract
amount in theContract column.

Method 2: Include the total amount of the change order as a separate line item

Instead of updating the individual cost codes, you can append each change order as a separate line item at the end of the
progress bill. Suppose the client approves change order number 1, and you only want to show the total amount of the
changes on the progress bill. When you select theAppend as New Lines option, Sage 100 Contractor creates a separate
line for each change order. Sage 100 Contractor inserts the statement Change Order #1 in theDescription column, and
displays the total amount of the change order in theChanges column and the new contract amount in theContract column.

Updating costs in progress bills from change orders automatically
You can update the data from change orders as often as necessary.

To automatically update costs from change orders:
1 Open 3-7 Progress Billing.

2 Using the data control, select the last application for the job and phase you want to update.

3 On theUpdatemenu, point toChange Orders, and click Add to Existing Lines.

4 If Sage 100 Contractor finds cost codes or divisions that are not present in the progress bill, review the change orders
andmanually enter the cost codes or divisions that you want to include in the progress bill.

5 Repeat steps 3-4 until you have resolved all cost codes.

6 On themenu bar, click Calculate to select one option in theCalculate Gridwindow, then click [Calculate].

a Calculate the Current column based on the amounts entered in the Percentage column (this is based on the
amount entered in the% Completed text box in step 10e)

b Calculate the Percent column based on the amounts entered in the Current and Stored columns (this is
based on the amounts entered in the Current Complete and Current Stored text boxes in step 10a and 10c,
respectively)

Updating costs in progress bills from change orders manually
When you recalculate the progress bill, the contract balances reflect the effect of the change orders.

To manually update costs from change orders:
1 Open 3-7 Progress Billing.

2 Using the data control, select the last application of the job and phase you want to update.

3 Select a cost code.

4 In theChanges text box, enter the amount of change.
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5 Repeat steps 3–4 for each cost code you want to update.

6 On themenu bar, click Calculate to select one option in theCalculate Gridwindow, then click [Calculate].

a Calculate the Current column based on the amounts entered in the Percentage column (this is based on the
amount entered in the% Completed text box in step 10e)

b Calculate the Percent column based on the amounts entered in the Current and Stored columns (this is
based on the amounts entered in the Current Complete and Current Stored text boxes in step 10a and 10c,
respectively)

Appending costs from change orders to progress bills

IMPORTANT: If you are using this update option, do not change theDescription values as you have entered them
into the grid. Sage 100 Contractor uses an exact match of the text in theDescription column tomatch the items from
theChange Order grid to theProgress Billing grid.

To append costs from change orders to progress bills:
1 Open 3-7 Progress Billing.

2 Using the data control, select the last application of the job and phase you want to update.

3 On theUpdatemenu, point toChange Orders, and click Append as New Lines.

4 On themenu bar, click Calculate.

TIP: You can update the data from change orders as often as necessary.

About progress billing retention
Many job contracts include retention. In theProgress Billing Setupwindow, you can set up rates and a ratemaximum.

When you calculate a progress bill for the first time, Sage 100 Contractor inserts the primary retention rate for completed
work in theRetention Rate column for all line items. If certain line items require different rates of retention, type the rates in
the appropriateRetention Rate cells. If you leave aRetention Rate cell blank, Sage 100 Contractor will not compute
retention for that particular line item. You can then recalculate the retention for the application.

Some contracts stipulate that retention should stop accruing after a certain amount of the contract has been billed. To
restrict the amount of retention withheld, type themaximum amount of retention to withhold in theMaximum Amount box
from theProgress Billing Setupwindow. When the total retention withheld, calculated from the rates for each line item,
equals or exceeds themaximum, Sage 100 Contractor stops withholding retention on the printed progress billings and the
posted receivable invoices. However, within theProgress Billing window, Sage 100 Contractor continues to calculate the
total retention.

You can also set up a secondary retention rate. When the total retention withheld exceeds the amount in theMaximum
Amount box, Sage 100 Contractor applies the rate in theSecondary Rate box from theProgress Billing Setupwindow.
Sage 100 Contractor does not replace the original rates in theRetention Rate column of the progress bill with the
secondary rate because it uses the original rates to compute the total retention for comparison against themaximum. The
secondary rate applies to each line item that has a retention rate; you cannot change the secondary rate on a line by line
basis.

If you want to withhold retention for storedmaterials, type the rate in theMaterial Rate box. When you enter costs for
storedmaterials in theCurrent Stored column, Sage 100 Contractor calculates the retention using the rate in theMaterial
Rate box from theProgress Billing Setupwindow.

While you include retention on billings, payment is not due until you complete the project. Posting an invoice declares the
gross amount of the invoice as income. However, a percentage of the gross amount is withheld as retention, so the client is
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actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already
declared income but is not yet due. Consequently, Sage 100 Contractor does not include retention in the invoice aging, and
does not apply finance charges to it.

When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been
declared income, so you simply release the retention in both progress billing and accounts receivable. You can release
retention on each invoice individually, or you can release the retention for the entire job at one time. You can then send the
client a statement reflecting the amount that is due your company.

Releasing retention for progress bills
You can bill for work and release retention on the same billing. After you create or update the progress bill, remove the
retention rates and post an invoice.

To only release retention for specific line items, delete the rate in theRet. Rate text box of each line item for which you
want to release retention. Then calculate the application.

If you need to release retention and print a statement, see the topic Releasing retention for progress bills and printing
statements.
To release retention for a progress bill:
1 Open 3-7 Progress Billing.

2 Select the last Application (with status 3-Posted) for which you want to release retention, and click theNext button
located at the center bottom of the window.

3 To themessage, Reminder: A new record will be created and this one will become Closed. Do you want to
continue? click Yes.

4 Note the amount in the Total Retention field.

5 On theUpdatemenu, click Release Retention.

6 To themessage, This will reset all retention rates to zero and recalculate the application. Do you want to
continue? click Yes.

7 On theCalculate Gridwindow, choose amethod to calculate the Progress Billing and click [Calculate].

8 On the Filemenu, click Save.

Then, release the retention in accounts receivable.

Releasing retention for progress bills and printing statements
When you bill a customer for retention for a job that is 100 percent complete, it is not necessary to create a new invoice.
The retention is included on the invoices created from 3-7 Progress Billing applications.
Part 1—To close your current bill, release retention, and print a progress billing report
1 Open 3-7 Progress Billing.

2 Open the last application with aStatus 3-Posted for the job, and click Next.

3 To themessage, Reminder: A new record will be created and this one will become Closed. Do you want to
continue? click Yes.

NOTE: Be sure to note the amount in theRetention Total field.

4 From theUpdatemenu, select Release Retention.

5 To themessage, This will reset all retention rates to zero and recalculate the application. Do you want to
continue? click Yes.
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6 On the Calculate grid, choose amethod to calculate the progress billing, and click OK.

NOTE: The Retention Total amount becomes theCurrent Due amount.

7 From the Filemenu, select Save.

8 From the Filemenu, select Recall.

9 From theOptionsmenu, select Submit Application.

10 From the Filemenu, select Print.

11 Print the appropriate progress billing report, reports 21—42, and send this report to your customer to show the retention
amount is now due.

12 If the job is continuing and you need to create a new application, post the application.

13 Close the 3-7 Report Printing window.
Part 2—Recalculate the retention and due dates

If you complete this step and have not received payments for amounts outside of retention, the current balance due will
reflect retention and any outstanding amounts.

1 Open 3-5 Jobs (Accounts Receivable), and display the job.

2 In the Terms section of the window, clear theRetention Rate.

3 From theUpdatemenu, select Recalculate Retention.

4 On theRecalculate Retentionwindow, enter theNew Due Date for invoices, and select the appropriate
Recalculation Option.

5 Click OK, and to themessage to confirm the number of open invoices found, click OK.

6 From the File menu, select Save.

TIP: On the 3-5 Jobs (Accounts Receivable)window, click Invoices and review theNet Due amount to verify the
retention has been released.

Part 3—Print statement for detailed billing information
1 Go to 3-4 Statements.

2 Select the 21-Job Statements report.

3 In the Job# box, type the job number.

4 Select the Include Paid Invoices check box.

5 Select the Include Payment History check box.

6 From the Filemenu, select Print.

7 On theStatement Variableswindow, type theStatement Date.

8 Click OK.

9 Your statement prints showing all outstanding amounts due, including the released retention.

10 Close the 3-4 Report Printingwindow.

Processing progress bills
The following bullet points provide some important insights about processing progress bills:
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l You can calculate retention using a rate for completed work and another rate for storedmaterials.

l Sage 100 Contractor computes and posts sales tax only when you create an invoice from the progress bill. Because
AIA certificates do not include sales taxes, you can print a separateSales Tax Report in the 3-1-11 Sales Tax
Reportwindow to notify the client of the applicable sales taxes.

l The calculation of sales tax is based on the tax district you have entered in theProgress Billing Setupwindow.

NOTE: You can include sales tax as a line item in the progress bill. If you enter a grid line for sales tax manually,
Sage 100 Contractor includes the amount as part of the total on the 3-2 Accounts Receivable invoice.The sales tax
amount is not broken out separately in the sales tax field of the accounts receivable invoice.

l In theCurrent Stored column, you can enter the amount of material currently being stored. When you create the
next application, Sage 100 Contractor moves the costs to thePrev. Stored column. As you complete work, remove
the costs for items no longer being stored. To remove costs, enter the costs as a negative amount in theCurrent
Stored column, then enter the costs as a positive amount in theCurrent Comp. column. (Otherwise, the negative
amount in theCurrent Stored column subtracts from the actual Current Complete and reduces the invoice
amount.)

l You can bill for work and release retention on the same application. After updating the application, remove the
retention rates.

To process a progress bill:
1 Open 3-7 Progress Billing.

2 Do one of the following:

a Create the progress bill automatically.

b Create the progress bill manually.

3 If you have issued change orders for the job, update the progress bill application to reflect the affects of the change
orders.

4 Update the costs.

5 You can then adjust the amounts in theCurrent Completed cells, or the percent of work completed in thePercent
Completed cells.

6 Calculate the project costs.

7 Print the progress bill application.

8 When you submit the progress bill application, do the following:

a In theSubmitted text box, enter the date you submitted the request. If you leave theSubmitted text box blank, Sage
100 Contractor enters the current date for you.

b On theOptionsmenu, click Submit Application.

9 After submitting the application, you can create an invoice by posting the application. On theOptionsmenu, click Post
Application.

10 Prepare the next progress bill application.

Preparing the next progress bill
After submitting an application, you can prepare the next application. Sage 100 Contractor will assign the current
application status 4-Closed, move the costs from theCurrent Completed column to thePrevious Completed column,
and advance the number in theApplication# text box.
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To prepare the next progress bill:
1 Open 3-7 Progress Billing.

2 Using the data control, select the last application for the job and phase.

3 On theOptionsmenu, click Create Next Application.

Releasing retention for jobs and printing statements
When you bill a customer for retention for a job that is 100 percent complete, it is not necessary to create a new invoice.
The retention is included on the invoices created from 3-7 Progress Billing applications. This procedure shows you how to
release retention, print a progress billing report, and then print a job statement to request final payment.

IMPORTANT: All past due accounts receivable invoices must have been collected before completing this procedure.

Part 1—To close the current bill, release retention, and print a progress billing report
1 Open 3-7 Progress Billing.

2 Open the last application with aStatus 3-Posted for the job.

3 Click Next.

4 To themessage, Reminder: A new record will be created and this one will become Closed. Do you want to
continue? click Yes.

5 Be sure to note the amount in theRetention Rate box.

6 From theUpdatemenu, select Release Retention.

7 To themessage, This will reset all retention rates to zero and recalculate the application. Do you want to
continue? click Yes.

8 On theCalculate grid, choose amethod to calculate theProgress Billing and click OK.

NOTE: TheRetention Total amount becomes theCurrent Due amount.

9 From the Filemenu, select Save.

10 From the Filemenu, select Recall.

11 From theOptionsmenu, select Submit Application.

12 From the Filemenu, select Print.

13 Print the appropriate Progress Billing report, reports 21—42, and send this report to your customer to show the retention
amount is now due.

14 Close the 3-7 Report Printingwindow.

NOTE: The final application remains in Submitted status because there is not an invoice amount to post.
Part 2—To recalculate the retention and due dates

IMPORTANT: If you complete this part and have not received payments for amounts outside of retention, the current
balance due will reflect retention and any outstanding amounts. This could be perceived that current receivables are
overstated.

1 Open 3-5 Jobs (Accounts Receivable), and select the job.

2 In the Terms section of the window, clear theRetention Rate.

3 From theUpdatemenu, select Recalculate Retention.
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4 On theRecalculate Retentionwindow, enter theNew Due Date for Invoices and select the appropriate
Recalculation option.

5 Click OK, and to themessage to confirm the number of open invoices found, click OK again.

6 From the Filemenu, click Save.

7 Then, on the 3-5 Jobs (Accounts Receivable)window, click the Invoices button and review theNet Due amount to
verify the retention has been released.

Part 3- To print a 3-4 Statement for detailed billing information
1 Open 3-4 Statements.

2 Select the 21-Job Statements report.

3 In the Job# box, type the job number.

4 Select the Include Paid Invoices check box.

5 Select the Include Payment History check box.

6 From the Filemenu, click Print.

7 On theStatement Variableswindow, type theStatement Date, and click OK.
The statement prints showing all outstanding amounts due, including the released retention.

8 Close the 3-4 Report Printingwindow.

Voiding progress bills
You can void an application assigned status 4-Closed. If the application precedes a series of applications, Sage 100
Contractor reopens the application, assigning it status 2-Submitted, and voids the subsequent applications. If you have
posted an application, and payments have beenmade to the invoice, youmust reverse the payments before voiding the
application.

Suppose you have just created application 3. However, application 3 contains an error caused in application 2. To remove
the error, it is necessary to correct application 2 and recreate application 3. When you void application 2, Sage 100
Contractor changes its status from 4-Closed to 2-Submitted. In addition, Sage 100 Contractor changes the status of
application 3 to 5-Void. You can thenmake the necessary adjustment to application 2, and from it create application 3.

To void a progress bill:
1 Open 3-7 Progress Billing.

2 Using the data control, select the record.

3 On theEditmenu, click Void Application.

3-8 Loan Draw Requests

About loan draw requests
The 3-8 Loan Draw Requestswindow provides a system for creating loan draw applications. For each job, you create a
series of applications with each new application building on the previous application submitted to the lender. Under each
job, Sage 100 Contractor assigns each application its own application number.

To create the first loan draw application, import the cost codes from the job’s budget or proposal. You can then select from
several ways to automatically update the cost information from the job cost records. When you select thePercent from
Costs option, Sage 100 Contractor displays the actual job costs and calculates the percent of work completed by
comparing the job costs against the budget. You can instead select the From Cost Amounts or From Billing Amounts
option to display only the amounts for each cost code.
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If the lender requires specific classes that differ from your cost codes, you canmanually enter the lender’s classes.
However, there is no relationship between the lender’s classes and your cost codes. Therefore, you will have to update the
loan draw applications manually.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application to
the lender, submit the record in Sage 100 Contractor by clicking theSubmit button. Sage 100 Contractor then changes the
application’s status to 2-Submitted. When you want to create the next application, click theNext button. Sage 100
Contractor assigns the submitted application status 4-Closed, and then creates the next application in the series.

In the 6-4-1 Change Orderswindow, you can also automatically update the costs of the change work to the loan draw
application. You can either incorporate the changes to costs in the individual cost codes, or include the total amount of the
change order as a separate line item.

Creating new loan draw applications automatically
If the lender requires a classification system other than cost codes, enter the classification system in theDescription
column.

Loan draws do not post to the general ledger and do not affect accounts receivable. After the lender transfers funds to your
account, enter a deposit that credits the loan-payable subsidiary account for the loan.

To automatically create a new loan draw application:
1 Open 3-8 Loan Draw Requests.

2 In the Job text box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase text box.

4 In theDescription text box, enter a brief statement about the work completed.

5 In theBilling Date text box, enter the date ending the period for which you are submitting the request.

6 In theApplication# text box, enter the number of the application you are submitting.

7 In the Loan# text box, enter your loan number.

8 In the Lender text box, enter the vendor number of the lender.

9 Do one of the following:

a On theOptionsmenu, point to Import, then click Import Budget.

b On theOptionsmenu, point to Import, then click Import Proposal.

10 On themenu bar, click Calculate.

11 On the Filemenu, click Save.

NOTE: Sage 100 Contractor creates a separate series of applications for each phase.

Creating new loan draw applications manually
If the lender requires a classification system other than cost codes, enter the classification system in theDescription
column.

Loan draws do not post to the general ledger and do not affect accounts receivable. After the lender transfers funds to your
account, enter a deposit that credits the loan-payable subsidiary account for the loan.
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To manually create a new loan draw application:
1 Open 3-8 Loan Draw Requests.

2 In the header, do the following:

a In the Job text box, enter the job number.

b If the job uses phases, enter the phase number in thePhase text box.

c In theDescription text box, enter a brief statement about the work completed.

d In theBilling Date text box, enter the date ending the period for which you are submitting the request.

e In theApplication# text box, enter the number of the application you are submitting.

f In the Loan# text box, enter your loan number.

g In the Lender text box, enter the vendor number of the lender.

3 In aCost Code text box, right-click, and select Display Picklist Window.

4 Create aPicklist of cost codes, and then click the check mark button to insert them in theCost Code column.

5 In the grid, in theScheduled cell, enter the scheduled amount.

6 Then do one of the following:

a In theCurrent cell, you can enter the costs incurred. If you provide the costs incurred, do not provide the percent of
work completed in the% Comp cell.

b In the% Comp cell, you can enter the percent of work completed. If you provide the percent of work completed, do not
provide the current costs incurred in theCurrent cell.

7 Repeat steps 5 and 6 for each item.

8 On themenu bar, click Calculate.

9 On the Filemenu, click Save.

NOTE: Sage 100 Contractor creates a separate series of applications for each phase.

Preparing the next loan draw application
After submitting a loan draw application, you can create the next application. Sage 100 Contractor assigns the current
application status 4-Closed, moves costs from theCurrent column to thePrevious column, and advances the number in
theApplication# text box.

To create the next loan draw application:
1 Open 3-8 Loan Draw Requests.

2 Using the data control, select the last application for the job and phase you want to update.

3 On theOptionsmenu, click Create Next Application.

TIP: Loan draws do not post to the general ledger and do not affect accounts receivable. After the lender transfers
funds to your account, enter a deposit that credits the loan-payable subsidiary account for the loan.

About updating costs in loan draw applications from change orders
You can automatically or manually update costs in the loan draw application from change orders. Choose from two
methods to automatically update the costs from change orders. You can either incorporate the changes to costs in the
individual cost codes, or include the total amount of the change order as a separate line item.
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When you select theAdd to Existing Lines option, Sage 100 Contractor only updates cost codes present in both the
change order and the loan draw application. If the change order contains cost codes that do not appear in the loan draw
application, Sage 100 Contractor will notify you. Review the new cost codes in the change orders, and if necessary,
manually add the new cost codes to the loan draw application and update the loan draw application again. Sage 100
Contractor displays the amount of change to each cost code in theChanges column and the new contract amount in the
Contract column.

Instead of updating the individual cost codes, you can append each change order as a separate line item at the end of the
loan draw application. Suppose the client approves change order number 1, and you only want to show the total amount of
the changes on the loan draw application. When you select theAppend as New Lines option, Sage 100 Contractor
creates a separate line for each change order. Sage 100 Contractor inserts the statement Change Order# 1 in the
Description column, and displays the total amount of the change order in theChanges column and the new contract
amount in theContract column.

IMPORTANT: If you are using theAppend as New
Lines option, do not change theDescription values
as you have entered them into the grid. Sage 100
Contractor uses an exact match of the text in the
Description column tomatch the items from the
Change Order grid to the Loan Draw grid.

When the lender requires a classification system that differs from your cost codes, manually enter the costs of the change
work.

Updating costs from change orders for loan draws automatically
Consider these points:

l If Sage 100 Contractor finds cost codes that are not present in the loan draw application, review the change orders,
and thenmanually enter the cost codes that you want to include in the loan draw.

l You can update the data from change orders as often as necessary.

l Loan draws do not post to the general ledger and do not affect accounts receivable. After the lender transfers funds
to your account, enter a deposit that credits the loan-payable subsidiary account for the loan.

To update costs from change orders for loan draws:
1 Open 3-8 Loan Draw Requests.

2 Using the data control, select the last application of the job and phase you want to update.

3 On theUpdatemenu, point toChange Orders, and click Add to Existing Lines.

4 Repeat step 3 until you have resolved all cost codes.

5 On themenu bar, click Calculate.

Updating costs from change orders for loan draws manually
Loan draws do not post to the general ledger and do not affect accounts receivable. After the lender transfers funds to your
account, enter a deposit that credits the loan-payable subsidiary account for the loan.

To manually update costs from change orders:
1 Open 3-8 Loan Draw Requests.

2 Using the data control, select the last application of the job and phase you want to update.
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3 Select a cost code.

4 In theChanges text box, enter the amount of change.

5 Repeat steps 3–4 for each cost code you want to update.

6 On theOptionsmenu, click Calculate.

NOTE: When you recalculate the loan draw, the contract balances reflect the effect of the change orders.

Appending costs from change orders to loan draw applications
Loan draws do not post to the general ledger and do not affect accounts receivable. After the lender transfers funds to your
account, enter a deposit that credits the loan-payable subsidiary account for the loan.

You can update the data from change orders as often as necessary.

IMPORTANT: If you are using this update option, do not change the entries in theDescription column on 3-8 Loan
Draw Requests as you have entered them into the grid. Sage 100 Contractor uses an exact match of the text in the
Description column tomatch the items from theChange Order grid to the Loan Draw grid.

To append costs from change orders to loan draw applications:
1 Open 3-8 Loan Draw Requests.

2 Using the data control, select the last application of the job and phase you want to update.

3 On theUpdatemenu, point toChange Orders, and click Append as New Lines.

4 On themenu bar, click Calculate.

About updating project costs automatically
You can choose from threemethods to automatically update the costs from the job cost records. Because the costs only
represent an estimate of the work actually completed, you can edit the amounts in theCurrent orPercent Complete
columns.

Option What it does

Percent
from Costs

Updates the current costs from the job costs, and
computes the percent of work completed by comparing the
budgeted costs to the total job costs.

From Cost
Amounts

Updates the current costs from the job costs. Use this
when a project has no budget entered in Sage 100
Contractor.

From Billing
Totals

Updates the current costs using the Billing Amounts from
the job costs. Use this in conjunction with Time and
Materials Billing.

When the lender requires a classification system that
differs from your cost codes, manually enter the costs
incurred since the last application in theCurrent text
box for each cost code.
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Processing loan draw applications
To process a loan draw application:
1 Open 3-8 Loan Draw Request.

2 Do one of the following:

a Automatically create the loan draw application.

b Manually create the loan draw application.

3 If you have issued change orders for the job, update the loan draw application to reflect the effects of the change orders.

4 Update the costs.

5 You can then adjust the amounts in theCurrent cells, or the percent of work completed inPercent Completed cells.

6 Calculate the project costs.

7 When you submit the loan draw application to the lender, do the following:

a In theSubmitted text box, enter the date you submitted the request. If you leave theSubmitted text box blank, Sage
100 Contractor enters the current date for you.

b On theOptionsmenu, click Submit Application.

8 Prepare the next loan draw application.

Voiding loan draw applications
You can void an application assigned status 4-Closed. If the application precedes a series of applications, Sage 100
Contractor reopens the application, assigning it status 2-Submitted, and voids the subsequent applications.

Suppose you have just created application 3. However, application 3 contains an error caused in application 2. To remove
the error, youmust correct application 2 and recreate application 3. When you void application 2, Sage 100 Contractor
changes its status from 4-Closed to 2-Submitted and changes the status of application 3 to 5-Void. You can thenmake
the necessary adjustment to application 2, and from it create application 3.

To void a loan draw application:
1 Open 3-8 Loan DrawRequests.

2 Using the data control, select the record.

3 On theEditmenu, click Void Application.

3-9 Unitary Billing

About unitary billing for jobs
With certain types of work, it is more difficult to estimate the amount of work necessary to complete the job. For example,
with grading or excavation work it proves easier for a contractor to bill for the number of units of earth moved. TheUnitary
Billingwindow provides a system for creating a series of unit-based applications, with each new application building on the
previous application for a job.

Creating a unitary bill requires that you provide some basic information in theUnitary Billing Setupwindow. You can
provide the name of the architect and the architect’s job number for the project, as well as the income posting account, tax
district number, and the retention rate.
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To create an application, import the bid items from the job’s unitary proposal. You can then enter the number of units of work
completed. If change orders are issued, you can also enter the units of change. When you calculate the application, Sage
100 Contractor determines the billing amount based on the units of change and the units of work completed.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application,
submit the record in Sage 100 Contractor by clicking theSubmit button. Sage 100 Contractor then changes the
application’s status to 2-Submitted. When the billing is approved, post the billing by clicking thePost button. Sage 100
Contractor creates an invoice, posts it to the general ledger, and then changes the application’s status to 3-Posted. When
you want to create the next application, click theNext button. Sage 100 Contractor assigns the posted application status 4-
Closed, moves the costs from theCurrent Quantity column to thePrevious Quantity column, and advances the number
in theApplication# text box.

Entering setup data for unitary bills
In order to create a unitary bill, you have to provide some basic information in theUnitary Billing Setupwindow, such as
the name of the architect, the architect’s job number for the project, the income posting account, the tax district number,
and the retention rate.

To enter setup data for a unitary bill:
1 Open 3-9 Unitary Billing and click theSetup button at the bottom left.

2 In theUnitary Billing Setupwindow, in theArchitect text box, enter the vendor number of the architect or engineer.

3 In theArchitect’s Job# text box, enter the number the architect uses to refer to the job.

4 In the Income Account text box, enter the income account.

5 If you are using subsidiary accounts, enter the account number in theSubaccount text box.

6 In the Tax District text box, enter the number of the sales tax district.

7 In theRetention Rate text box, enter the rate of retention.

8 On themenu bar, click Save.

Creating new unitary bills using Unitary Proposal
When you create a new unitary bill for a job, you can enter the unit price and quantity of units scheduled for each bid item in
theUnit Price andScheduled Quantity columns. After saving the first application, Sage 100 Contractor does not allow
any changes to the scheduled quantities. On subsequent applications, enter any changes to the quantity of units in the
Change Quantity column.

IMPORTANT: After posting the first application, the unit price cannot be edited.

To create a new unitary bill using Unitary Proposal:
1 Open 3-9 Unitary Billing.

2 In the Job text box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase text box.

4 In theDescription text box, enter a brief statement about the job.

5 In theApplication# text box, enter the number of the application you are submitting.

6 In theBilling Date text box, enter the date ending the period for which you are submitting the request.

7 In theBilling Cycle text box, enter the billing cycle.

8 On theOptionsmenu, click Import Unitary Proposal.
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9 On theOptionsmenu, click Setup and complete theUnitary Billing Setupwindow.

10 In the grid, do the following:

a In the Item Code cell, enter the client’s item code.

b In theCurrent Quantity cell, enter the current number of units for which you want to bill.

c In theRetention Rate cell, you can accept the default retention rate from theUnitary Billing Setupwindow, or you
can enter a different rate for the item.

d In the Taxable cell, type Yes if the item is taxable or No if the item is non-taxable.

11 Repeat step 10 for each item.

12 On themenu bar, click Calculate.

13 On the Filemenu, click Save.

Creating new unitary bills manually
When you create a new unitary bill for a job, you can enter the unit price and quantity of units scheduled for each bid item in
theUnit Price andScheduled Quantity columns. After saving the first application, Sage 100 Contractor does not allow
any changes to the scheduled quantities. On subsequent applications, enter any changes to the quantity of units in the
Change Quantity column.

IMPORTANT: After posting the first application, the unit price cannot be edited.

To manually create a new unitary bill:
1 Open 3-9 Unitary Billing.

2 In the header, do the following:

a In the Job text box, enter the job number.

b If the job uses phases, enter the phase number in thePhase text box.

c In theDescription text box, enter a brief statement about the job.

d In theApplication# text box, enter the number of the application you are submitting.

e In theBilling Date text box, enter the date ending the period for which you are submitting the request.

f In theBilling Cycle text box, enter the billing cycle.

3 On theOptionsmenu, click Setup, and then complete theUnitary Billing Setupwindow.

4 In aBid Items text box, right-click, and then select Display Picklist Window.

5 Create aPicklist of bid items, and then click the check mark button to insert the list into the grid.

6 In the grid, do the following:

a In the Item Code cell, enter the client’s item code.

b In theDescription cell, enter a brief statement about the bid item.

c In theUnit cell, enter the unit of measurement.

d In theUnit Price cell, enter the price per unit.

e In theScheduled Quantity cell, enter the quantity of units.

f In theCurrent Quantity cell, enter the current number of units for which you want to bill.
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g In theRetention Rate cell, you can accept the default retention rate from theUnitary Billing Setupwindow, or you
can enter a different rate for the item.

h In the Taxable cell, type Yes if the item is taxable or No if the item is non-taxable.

7 Repeat step 6 for each item.

8 On themenu bar, click Calculate.

9 On the Filemenu, click Save.

Importing unitary proposals into Unitary Billing
To import a unitary proposal into Unitary Billing:
1 Open 3-9 Unitary Billing.

2 In the Job text box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase text box.

4 In theDescription text box, enter a brief statement about the job.

5 In theApplication# text box, enter the number of the application you are submitting.

6 In theBilling Date text box, enter the date ending the period for which you are submitting the request.

7 In theBilling Cycle text box, enter the billing cycle.

8 On theOptionsmenu, click Import Unitary Proposal.

Updating the total quantity from field reports
When you update, Sage 100 Contractor fills in the total number of units completed based on the daily field reports.

To update the total quantity from field reports:
1 Open 3-9 Unitary Billing.

2 Using the data control, select the last application for the job and phase.

3 On theUpdatemenu, click Total Quantity from Daily Field Report.

About unitary billing retention
Many job contracts include retention. While you include the retention on the billings, payment is not due until you complete
the project. In theUnitary Billing Setupwindow, you can set the retention rate.

When you calculate a unitary bill the first time, Sage 100 Contractor inserts the retention rate for completed work in theRet.
Rate column for all line items, then it calculates the retention. If the retention rate differs between line items, you can enter
the individual rates in the appropriateRetention Rate cells. If you leave aRet. Rate cell blank, Sage 100 Contractor does
not compute the retention for that particular line item.

To change the retention rate for the entire project, first change the rate in theRetention Rate box in theUnitary Billing
Setupwindow. Then change the rates in theRet. Rate column and recalculate the unitary bill. If you lower the rate of
retention, you effectively release a portion of the retention previously withheld.

Posting an invoice declares the gross amount of the invoice as income. However, a percentage of the gross amount is
withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice
amount). Therefore, retention is already declared income but is not yet due. Consequently, Sage 100 Contractor does not
include retention in the invoice aging, and does not apply finance charges to it.
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When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been
declared income, so you simply release the retention in both unitary billing and accounts receivable. You can release
retention on each invoice individually, or you can release the retention for the entire job at one time. You can then send the
client a statement reflecting the amount that is due your company.

Releasing retention for unitary bills
To release retention for a unitary bill:
1 Open 3-9 Unitary Billing.

2 Select the record for which you want to release retention.

3 On theOptionsmenu, click Setup.

4 In theRetentionRate text box, delete the rate.

5 On the Filemenu, click Save.

6 In theRet. Rate column, delete the rate.

7 On theOptionsmenu, click Calculate.

8 On the Filemenu, click Save.

9 Release the retention in accounts receivable.

TIP: To only release retention for specific line items, delete the rate in theRetentionRate text box of each line item
for which you want to release retention. Then calculate the application.

About changing unitary bills
You cannot use the 6-4-1 Change Orderswindow to update unitary billing. Change orders must be entered in 3-9 Unitary
Billing on an entry by entry basis.

To change the unit price, you need to create two additional lines to the billing; one that backs out the units you need to back
out and one that brings them back in at the correct price.

To change the quantity, you need only make the adjustments in theQuantity column.

Adding change orders to 3-9 Unitary Billing
If change orders are issued for a job, you can enter the units of change in your billing. When you calculate the billing
application, Sage 100 Contractor determines the billing amount based on the units of change and the units of work
completed.

To enter the units of change:

1 Open 3-9 Unitary Billing.

2 Using the data control, select the last application of the job and phase you want to update.

3 On the appropriate bid item line, enter the units of the change in theChange Qty column.

NOTE: You can create a new bid item line for the change if it does not apply to one of the existing lines.

4 Repeat step 3 for each line item you want to update.

5 On themenu bar, click Options, thenCalculate.
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Processing unitary bills
If you provide a tax district number in theUnitary Billing Setupwindow, you can select which items to tax. In the Taxable
column, type Yes if the item is taxable or No if the item is non-taxable.

Sage 100 Contractor only computes and posts sales tax when you create an invoice from the unitary bill. You can include
sales tax as a line item in the unitary bill. However, if youmanually enter a line for sales taxes in the grid, Sage 100
Contractor ignores the line and will compute and post the sales taxes when you create the invoice.

You can bill for work and release retention on the same application. After updating the application, remove the retention
rates.

To process a unitary bill:
1 Open 3-9 Unitary Billing.

2 Do one of the following:

a Create the unitary bill automatically.

b Create the unitary bill manually.

3 If you have issued change orders for the job, enter the approved changes. In theChange Quantity column, enter the
quantity of units of change.

4 In theCurrent Quantity column, enter the quantity of units completed for each item.

5 On themenu bar, click Calculate.

6 Print the unitary bill application.

7 When you submit the unitary bill application, do the following:

a In theSubmitted text box, enter the date you submitted the request. If you leave theSubmitted text box blank, Sage
100 Contractor enters the current date for you.

b On theOptionsmenu, click Submit Application.

8 After submitting the application, you can create an invoice by posting the application. On theOptions, menu, click Post
Application.

9 Prepare the next unitary bill application.

Preparing the next unitary bill
After submitting an application, you can prepare the next application. Sage 100 Contractor will assign the current
application status 4-Closed, move the costs from theCurrent Qty column to thePrevious Qty column, and advance the
number in theApplication# text box.

To prepare the next unitary bill:
1 Open 3-9 Unitary Billing.

2 Using the data control, select the last application for the job and phase.

3 On theOptionsmenu, click Create Next Application.

Voiding unitary bills
You can void an application assigned status 4-Closed. If the application precedes a series of applications, Sage 100
Contractor reopens the application, assigning it status 2-Submitted, and voids the subsequent applications.
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Suppose you have just created application 3. However, application 3 contains an error caused in application 2. To remove
the error, youmust correct application 2 and recreate application 3. When you void application 2, Sage 100 Contractor
changes its status from 4-Closed to 2-Submitted. In addition, Sage 100 Contractor changes the status of application 3 to
5-Void. You can thenmake the necessary adjustment to application 2, and from it then create application 3.

IMPORTANT: If you have posted an application, and payments have beenmade to the invoice, youmust reverse the
payments before voiding the application.

To void a unitary bill:
1 Open 3-9 Unitary Billing.

2 Using data control, select the record.

3 On theEditmenu, click Void Application.

3-10 Time and Materials

About time and materials billing
You can bill clients on a cost-plus basis, which is the cost for time andmaterials plus overhead and profit. Sage 100
Contractor uses the job cost records as the basis for the billing amounts on the time andmaterials (T&M) invoices.

When setting up a job for T&M billing, you can:

l Assign separate overhead and profit markup rates to each cost type.

l Assign a shownmarkup rate to each cost type.

l Assign a hiddenmarkup rate to each cost type. When you calculate T&M invoices, Sage 100 Contractor adds the
hiddenmarkup to the job cost. The other markups shown, overhead and profit, are computed on top of the new billing
amount. The hiddenmarkup does not appear on the T&M invoice.

l Assign wage rate and equipment rate tables to the job. You can use the tables in place of using labor and equipment
costs plus hiddenmarkup. In addition, you can set aminimum daily charge, which is theminimum number of hours
per laborer , or you can set theminimum units per piece of equipment to charge.

Suppose you own a backhoe and determine it is necessary to charge aminimum of three hours to recover the costs of
ownership, maintenance, andmobilization. At a job site, you only use the backhoe for one hour. When you allocate the
equipment use, Sage 100 Contractor bills the client for three hours instead of one.

Consider the following additional points:

l If equipment records contain rental billing rates, Sage 100 Contractor creates the job cost with the rental billing rate
in theBilling Amount text box and with theOverride check box selected. The program uses this amount when
calculating the T&M Invoices even if anEquipment Rate table is selected for the T & M job.

l If you want to use the T & M Equipment Rate table youmust either: (1) clear theOverride check box on the job
cost record and exclude billing rates from the equipment record before the job cost records are created; or (2) enter
the job cost record directly into 6-3 Job Cost record.

l If equipment records do not contain billing rates when you calculate the T & M invoices, Sage 100 Contractor
replaces the billing amount with the rate from theEquipment Rate table. If anEquipment Rate table is not
assigned to the T&M job, Sage 100 Contractor replaces the billing amount with the cost plus hiddenmarkup.
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3-10-1 T&M Billing Setup
Setting up time and materials jobs

The following are additional points to consider when setting up T&M jobs:

l When you indicate the tax district in 3-5 Jobs, Sage 100 Contractor includes the sales tax on the time andmaterials
bill.

l Sage 100 Contractor does not create job costs for payroll until you compute timecards.

l If the client requires you to provide source documents and invoices, do not use the hiddenmarkup. Otherwise, the
amounts displayed on your time andmaterials invoices will not match the amounts on the source documents and
invoices.

l When using a wage rate table, the hiddenmarkup does not apply to labor .

l When using an equipment rate table, the hiddenmarkup does not apply to equipment.

To set up a job for time and materials billing:

1 Open 3-10-1 T&M Billing Setup.

2 In the data control text box, enter the job number of the job you want to set up.

3 In theWage Rate text box, enter the wage rate table you want to use.

4 In theEquipment Rate text box, enter the equipment rate table you want to use.

5 In theHidden column, enter themarkup rate that the customer does not see.

NOTE: T&M hiddenmarkups do not increase the T&M invoice for labor if a wage rate is present.

6 In theShown column, enter themarkup rate.

7 In theOverhead column, enter themarkup rate for overhead.

8 In theProfit column, enter themarkup rate for profit.

9 In the Income Account text box, enter the ledger account number.

10 In theSubaccount text box, enter the subaccount number, as needed.

11 On the Filemenu, click Save.

Creating time and materials invoices by phase

IMPORTANT: It is necessary to follow these steps in this exact order. Each phasemust be computed separately.

To create time and materials invoices by phase:

1 Compute the invoice by job and phase using the 3-10-2 Compute T&M Invoiceswindow.

2 Print the invoice using the 3-10-3 Print T&M Invoiceswindow.

3 Post the invoice using the 3-10-4 Post T&M Invoiceswindow.

4 Repeat steps 1–3 for each phase.

Voiding time and materials invoices

When voiding a time andmaterials invoice, you can reset the billing status of the job cost records.



- 170 -

To void time and materials invoices:

1 Open 3-2 Receivable Invoices/Credits.

2 Using data control, select the record.

3 If an amount appears in thePaid text box, reverse the payments.

4 On theEditmenu, click Void Invoice.

NOTE: To reset the billing status of the job cost records to 1-Open, click Yes. Resetting the billing status lets you re-
invoice those job costs.

NOTE: To retain billing status 3-Billed on the job cost records, click No. Sage 100 Contractor leaves the job cost
billing status as Billed and the job cost record as 1-Open.

3-10-2 Compute T&M Invoices
About computing time and materials invoices

Sage 100 Contractor computes billing amounts from job cost records assigned billing status 1-Open. When you compute a
single job and phase, you can include the phase on the invoice. If you computemore than one job and phase at a time,
invoices are posted by job, not by job and phase.

In the Job Costswindow, the In Process check box indicates the cost record has been computed. If you do not want to
invoice the cost at all, change the billing status.

In the Time and Materials Billingwindow, theCalculated check box indicates that invoices have been calculated in the
Time and Materials Billingwindow for the jobs computed. When you post invoices, Sage 100 Contractor clears the
Calculated check box.

NOTE: During the compute, the window's status bar displays “Skipping job XXX without a billing setup” when it is
computing records across a range of jobs and some of the jobs do not have T&M billing setup.

Computing time and materials invoices

During the compute, the window's status bar displays “Skipping job XXX without a billing setup” when it is computing
records across a range of jobs and some of the jobs do not have T&M billing setup.

To compute a time and materials invoice:

1 Open 3-10-2 Compute T&M Invoices.

2 In the Invoice Date text box, enter the date you want to assign the invoices.

3 Select the criteria to choose the invoices you want to calculate.

4 Click Compute.

3-10-3 Print T&M Invoices
About the 3-10-3 Print T and M Invoices window

Clicking 3-10-3 Print T&M Invoices launches the 3-10-3 Report Printingwindow to be used to for printing T&M invoice
reports and viewing sample reports.
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About the time and materials parts details addendum

CAUTION: The addendummust be printed after the T&M invoice is computed, but before it is posted. You will not be
able to create the addendum before the T&M invoice has been computed or after the invoice has been posted, as no
records will exist.

The 3-10-3 Print T&M Invoices, 61-Parts Details Addendum Report can be printed and attached to a regular invoice.
The addendum will obtain the parts data from Accounts Payable, Recurring Payables, PO Receipts, and Inventory.

The addendum lists the following:

l Part #

l Part name

l Quantity

Processing time and materials invoices

Consider these points when processing time andmaterials invoices:

l When you post time andmaterials invoices, Sage 100 Contractor assigns billing status 3-Billed to the cost records.

l You can select which invoices to print or post in 3-10-4 Post T&M Invoices. All computed invoices are printed or
posted.

l You can create an addendum to the invoice to list the parts’ details associated with the invoice.

To process a time and materials invoice:

1 Enter all the payables and receivables to date for the job.

2 Compute the invoices.

3 Open 3-10-3 Print T&M Invoices.

4 Print and review the invoices.

5 Edit the job cost records, if necessary.

6 Repeat steps 4 and 5 until you create the final invoice you want to send the client.

7 On 3-10-4 Post Invoices, post the invoices.

3-10-4 Post T&M Invoices
About posting T&M invoices

After you have printed your T&M invoices using the 3-10-3 Print T&M Invoiceswindow, you can then post them to the
general ledger using the 3-10-4 Post T&M Invoiceswindow.

Posting time and materials invoices

To post time and materials invoices:

1 Open 3-10-4 Post T&M Invoices.

2 Select the invoices you want to post.

3 Click Post.
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3-10-5 T&M Wage Rates
About wage rates for time and materials billing

You can assign a table of wage rates to a time andmaterials (T&M) job in the 3-10-1 T&M Billing Setupwindow. Sage 100
Contractor determines the billing amounts using the wage rate table instead of the labor costs.

You can set up wage rates for:

l Employees assigned specific cost codes. For example, you create two lines in the table for Michael. On the first
line, you assignMichael a cost code for rough carpentry and the associated wage rates. On the second line, you
assign him a cost code for supervision and the associated wage rates. WhenMichael supervises, Sage 100
Contractor knows to bill out his time differently from when he works as a carpenter.

l Employees. For example, you list Michael, Robert, Steve, andGerald in the table with the appropriate wage rates.
Because there are no cost codes assigned to the employees, Sage 100 Contractor bills for employee time based on
the billing rates assigned to each employee.

l Cost codes. For example, you list cost codes for rough carpentry and finish carpentry and the associated wage
rates. Nomatter who performs rough or finish carpentry, that employee is billed out at the appropriate rate based on
the cost code.

l No employee or cost code. You can only enter one set of default wage rates—rates that do not have employees
and cost codes attached to the wage rates.

For example, you set up a line that does not reference an employee or cost code and has the following wage rates at $15,
$22.50, and $30. Sage 100 Contractor bills out the work using the indicated rates for any employee or cost code that does
not appear in the list.

Sage 100 Contractor first computes billing amounts for employees appearing in the wage rate table that have been
assigned cost codes.

Next, Sage 100 Contractor computes billing amounts for employees appearing in the table that have not been assigned
cost codes.

Then Sage 100 Contractor computes billing amounts for cost codes appearing in the table that have not been assigned to
specific employees.

Finally, Sage 100 Contractor computes billing amounts for all remaining employees and cost codes that do not appear in the
wage rate table.

Entering time and materials wage rates

Consider these the following points when entering time andmaterials wage rates:

l If the employee works under multiple cost codes, enter the employee on a separate line for each cost code.

l When using a wage rate table, hiddenmarkups do not apply to labor .

To enter T&M wage rates:

1 Open 3-10-5 T&M Wage Rates.

2 In theDescription text box, enter a brief statement about the wage rates table.

3 In theEmployee cell, enter the employee number.

4 If you want to assign a cost code to an employee, enter the cost code in theCost Code cell.

5 In theRate 1 cell, enter the regular billing rate.
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6 In theRate 2 cell, enter the overtime billing rate.

7 In theRate 3 cell, enter the premium billing rate.

8 If you want to charge for aminimum number of hours, enter theminimum in theMinimum Hours cell.

9 If an employee works less than theminimum number of hours, Sage 100 Contractor bills for theminimum number of
hours.

10Repeat steps 3–8 for each employee you want to include.

11On the Filemenu, click Save.

3-10-6 T&M Equipment Rates
About equipment rates for time and materials billing

You can assign a table of equipment rates to a time andmaterials (T&M) job in the T&M Billing Setupwindow. Sage 100
Contractor determines the billing amounts using the equipment rate table instead of the equipment costs.

You can set up equipment rates for:

l Equipment types. For example, you list large excavators andmedium excavators in the table with the appropriate
billing rates. Nomatter which specific piece of equipment within the type performs work, it is billed out at the
appropriate rate assigned to its type.

l Equipment. For example, you list individual backhoes in the table each with its own billing rate. Sage 100
Contractor bills for each piece of equipment according to the rates assigned to each piece of equipment.

Entering time and materials equipment rates

You can set up the table of equipment rates to charge a flat rate instead of equipment costs plus markup.

To enter T&M equipment rates:

1 Open 3-10-6 T&M Equipment Rates.

2 In theDescription box, enter a brief statement about the equipment rates table.

3 In the grid in theEquipment Type cell, enter the equipment number.

4 In the grid in theEquipment cell, enter the equipment number.

5 In the grid in theOperated cell, enter the rate for equipment operation.

6 In the grid in the Idle cell, enter the rate for idle equipment.

7 In the grid in theStandby cell, enter the rate for equipment at standby.

8 If you want to charge for aminimum number of hours, enter theminimum in theMinimum Hours cell.

9 If equipment is used less than theminimum number of hours, Sage 100 Contractor bills for theminimum number of
hours.

10 On the Filemenu, click Save.

NOTE: When using an equipment rate table, hiddenmarkups do not apply to equipment.
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3-10-7 T&M Journal
About 3-10-7 T and M Journal

Clicking 3-10-7 T&M Journal launches the 3-10-7 Report Printingwindow to be used to for printing T&M journal reports
and viewing sample reports.

3-10-8 T&M Summary
About 3-10-8 T and M Summary

Clicking 3-10-8 T&M Summary launches the 3-10-8 Report Printingwindow to be used to for printing T&M Summary
reports and viewing sample reports.

Job Costs and Time and Materials
About editing job costs for time andmaterials invoices

Editing the billing amount of job cost records

About billing status for job costs

Changing the billing status of job cost records

About editing job costs for time and materials invoices

Job cost records display the time andmaterials billing information. In the job cost records, you can change the billing status
of a record, control whether a specific job cost record is taxable, or override the billing amount.

The billing amount is comprised of the job cost plus the hiddenmarkup. You can change the billing amount, but Sage 100
Contractor does not apply the hiddenmarkup to the new billing amount.

By overriding the billing amount, you can:

l Increase the billing amounts. Suppose that halfway through a job contract you negotiate a volume discount with
the lumber vendor. Because the contract stipulates that you do not have to pass contractor discounts to the client,
you need to increase the billing amounts.

l Reduce the billing amounts. For example, the contract stipulates that the cost for site work is not to exceed
$15,000 but the subcontractor billed you for $16,500. To reflect the cap placed on the cost for site work in the
invoice, reduce the billing amount.

l Create job costs for work that does not cost you anything to produce. Suppose a potential client requests
design plans for some home remodeling work, but will only pay a $1,000 design fee to the contractor who wins the
job contract. When the client awards the contract to you, enter a job cost for the design fee in the Job Costs
window.

l Include a job cost on an invoice, but not bill for the work. On a remodeling job, suppose your crew applies the
wrong texture to the walls of a room. The crew re-textures the room correctly but youmust bear the costs of the
mistake and cannot charge the client for it. On the invoice, you can show the work was performed twice, but you are
only charging for the correct work. In each job cost record that you want to show but not charge for, you can delete
the billing amount.

l Exclude a job cost from an invoice and not bill for the work. For example, assume that you posted a payable
invoice to the wrong job. A reversing entry corrects the error, but the original error and the reversing entry show on
the time andmaterials invoice. To remove both transactions from the invoice, change the bill status to 2-Not
Billable in each of the two job cost records.
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Editing the billing amount of job cost records

When you compute invoices, Sage 100 Contractor calculates the billing amount from the job cost plus hiddenmarkup. If the
cost is for labor or equipment and you have assigned a wage or equipment table to the job, Sage 100 Contractor calculates
the billing amount from the table. You can alsomanually replace the calculated billing amount.

To edit the billing amount of a job cost record:

1 Open 6-3 Job Costs.

2 Using the data control, select the record.

3 In theBilling Amount text box, enter the billing amount.

4 Select theOverride Calculation check box.

5 On the Filemenu, click Save.

About billing status for job costs

Sage 100 Contractor uses the billing status for time andmaterials invoices.

Status Description

1-Open The job cost has not been calculated or posted.

2-Not Billable The job cost is not billable and will not appear on an
invoice.

3-Billed The job cost has been calculated and posted to the
general ledger.

Changing the billing status of job cost records

To change the billing status of a job cost record:

1 Open 6-3 Job Costs, and using the data control, select a job cost record.

2 From the Time and Materials Billing section of the window, in theBilling Status list, click the new billing status.

3 On the Filemenu, click Save.

3-11 Recurring Receivables

About recurring receivables
In the 3-11 Recurring Receivableswindow, you can set up recurring receivable transactions. Only transactions that have
a consistent amount from invoice to invoice and post on a regular basis make good candidates for being set up as recurring
receivables.

Sage 100 Contractor does not automatically post recurring receivable transactions; you retain complete control of when to
post transactions. You can even set a reminder to prompt users in a specific security group when it is time to post the
recurring transactions.

Look at the posting date of a transaction to determine when to post the transaction. After posting a transaction, Sage 100
Contractor advances the posting date based on the transaction cycle. The transaction date does not control or affect the
period to which you are posting the transaction. If you need to post a recurring transaction to a different period, change the
posting period.
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To prevent the possible duplication of invoice numbers, Sage 100 Contractor assigns a unique invoice number to each
recurring receivable transaction. The invoice number is actually the combination of a record number and an invoice
sequence number.

Setting up recurring receivable transactions in 3-11 Recurring Receivables
To set up a recurring receivable transaction:
1 Open 3-11 Recurring Receivables.

2 Do the following:

a In the Job text box, enter the job number.

b If the job uses phases, enter the phase number in thePhase text box.

c In theDescription text box, enter a brief statement about the transaction.

d In theNext Date text box, enter the next date when the transaction needs to post.

e In theCycle text box, enter the transaction cycle.

f In theDue Terms text box, enter the cycle for the date when the invoice is due.

g In theDiscount Terms text box, enter the cycle for the date by which the vendor must receive payment for the
discount to apply.

h In theStatus list, click the invoice status.

i In the Type list, click the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the line item.

b In theQuantity cell, enter the quantity purchased.

c In thePrice cell, enter the price per unit.

d In theAccount cell, enter the ledger account.

4 Repeat step 3 for each item.

5 On the Filemenu, click Save.

Posting single recurring transactions in 3-11 Recurring Receivables

IMPORTANT: If you want to post to a different period, youmust change the posting period.

To post a single recurring receivable transaction:
1 Open 3-11 Recurring Receivables.

2 Select the transaction.

3 On thePostmenu, click This Invoice Only.

Posting groups of recurring transactions in 3-11 Recurring Receivables
To post a group of transactions, use a cutoff date. Sage 100 Contractor posts all transactions through the indicated date.

IMPORTANT: If you want to post to a different period, youmust change the posting period.
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To post a group of recurring transactions:
1 Open 3-11 Recurring Receivables.

2 On thePostmenu, click Multiple Invoices.

3 ThePosting Cutoffwindow appears.

4 In theCutoff Date box, enter the cutoff date, and click OK.

Accounts Receivable Startup Information
Methods for entering historical accounts receivable records

IMPORTANT: We strongly recommend that you work with your business partner and accounting professionals
before you begin with accounts receivable startup.

You can choose from threemethods of entry. Each successivemethod provides more detail for reports than the previous
method, and requires more time to enter data. Nomatter whichmethod you select, post the transaction to the period before
the current posting period. For example, if you are setting up during period 7, post the records to period 6.

Method 1

For each job, enter a single and separate record for the total outstanding balance. While this method is the quickest, it has
numerous limitations:

l The statements do not list the invoices.

l The agings do not reflect the invoices entered during startup because the balance is entered as a single amount.

l The detail for prime contract audits is limited.

Method 2

For each job, enter a record for the outstanding balance of each unpaid or partially paid item. When entering a partially paid
invoice, make two separate entries.

UsingMethod 2, you enter a significant amount of information with each item.

Method 3

For each job, enter a record for each receivable invoice or credit. Not only are you entering the outstanding balances for
unpaid and partially paid items, but also fully paid invoices and credits. When entering a partially paid invoice, make two
separate entries.

Assign paid record status 4-Paid.

Assign open records status 1-Open.

Enter all items in chronological order so that Statements andContract Audits display the invoices in sequence.

It is not necessary to enter the individual parts as line items in the grid. A single line containing a quantity, price, and ledger
account number is all that is necessary.

About entering partially paid items on receivable invoices

IMPORTANT: We strongly recommend that you work with your business partner and accounting professionals
before you begin with accounts receivable startup.

If you have partially paid items, youmust enter them as two separate transactions. For example, an invoice is fully paid but
the retention has not been fully released. The first transaction contains the paid amount, which is entered in thePaid box,
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and is assigned status 4-Paid. The second transaction contains the grid entry for the retention. The entire amount is
entered in theRetention box, and is assigned status 1-Open.

Use the same invoice or credit number for both transactions. But for the paid invoice, type PD at the end of the invoice or
credit number. The open record retains the original invoice or credit number.

Some invoices may have discounts or retention. You can include the discount or retention by entering the amount in the
Discount Available orRetention box.

About entering accounts receivable invoices and credits

IMPORTANT: We strongly recommend that you work
with your business partner and accounting
professionals before you begin with accounts
receivable startup.

Post the accounts receivable items against the same clearing account used earlier to enter the accounts receivable
balances. The process transfers the balances into theAccounts Receivable ledger account.

When entering the receivable items, post the records to the appropriate posting periods. Post any open items from the prior
year to period 0.
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Chapter 4: Accounts Payable
Working with Accounts Payable
This section of Sage 100 Contractor, 4-Accounts Payable, contains the following subsections:

l 4-1 Payable Reports—You can run reports to gather and analyze data about your payables. For more information,
see

l 4-2 Payable Invoice/Credits—You can enter transactions, create invoices or credit invoices that affect vendors,
track and release retention, view a history of payments for specific invoices, and print and post two-party checks.
For more information, see

l 4-3 Vendor Payments—You can print (single-party or two-party) checks, vouchers, and lien waivers for payable
invoices and apply credit invoices to invoices. For more information, see

l 4-4 Vendors (Accounts Payable)—You can access to vendor information for payable invoices, 1099 balances,
orderingmaterials, and subcontract management. Create a vendor record for each business that sends you invoices
and each business to which you owemoney or make regular payments. For more information, see

l 4-5 Vendor 1099—The program tracks andmaintains balances for the 1099 reports. Including the vendor number on
a vendor check or general ledger check, increases the 1099 balance for that vendor. Voiding the check, decreases
the 1099 balance by the check amount for that vendor.

l 4-6 Recurring Payables—You can set up recurring payable transactions that have a consistent amount from
invoice to invoice and post them on a regular basis. This feature allows you to retain complete control of when to
post transactions.

l 4-7 Credit Card Management—You can set up the accounting tomanage your business credit cards as part of
your regular accounting. Features include setting up accounts, entering receipts, reconciling statements, and paying
your credit card bill.

Using theAccounts Payable tools in Sage 100 Contractor, you canmanage payable invoices with an accounts payable
system that is fully integrated with purchase orders, subcontracts, change orders, job costing, and inventory functions. For
example, you can enter a purchase order number to complete your invoice entry in one step. The payable invoice window
automatically fills in and performs job costing to ensure that you’re not overcharged or receiving items that you have not
approved.

The system automatically posts recurring invoices for expenses such as rent, loan payments, and vehicle purchases. You
can track Workers’ Compensation, liability insurance, and license expiration dates of subcontractors. You can even track
individual subcontracts, enabling you tomanage retention and prevent payment in case there is a dispute.

You can select from awide variety of check and voucher formats or create your own. Choosemultiple check stubs or
special check reports to list all invoices paid and automatically generate lien releases with checks or vouchers. You can
make partial payments and designatemultiple payees on any invoice, and then you can decide which credits to apply to a
payment prior to running checks. You can run aging reports “as of” the end of any prior period tomatch financials even after
the period has been closed. The extensive reporting options include compliance reports and 1099 forms.

Most businesses use credit cards for purchases and payments and Sage 100 Contractor helps youmanage your credit card
accounts. You can create and edit card issuer accounts and then andmanage your receipts and charges. Then you can
follow those tasks with reconciling your statements andmonitoring your payments.
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4-1 Payable Reports
See Appendix B for a complete list of 4-1 Payable Reports.

Accounts Payable Startup
Methods for entering historical accounts payable records

You can choose from threemethods of entry when entering the open invoices and credits forAccounts Payable. Each
successivemethod provides more detail for reports than the previous method, and requires more time to enter data.

Nomatter whichmethod you select, post the transaction to the period before the current posting period. For example, if you
are setting up during period 7, post the records to period 6.

Method 1

For each vendor, enter a single and separate record for the total outstanding balance. While this method is the quickest, it
has numerous limitations:

l You cannot print aSet to Pay report, which details the invoices that are being paid when printing A/P checks.

l The list of invoices paid by a check is not included on the check stub.

l The agings do not reflect the invoices entered during startup because the balance is entered as a single amount.

l The detail for subcontract audits is inaccurate.

Method 2

For each vendor, enter a record for the outstanding balance of each unpaid or partially paid item. When entering a partially
paid invoice, make two separate entries.

UsingMethod 2, you enter a significant amount of information with each item. There is one limitation—the detail for
subcontract audits is inaccurate.

Method 3

For each vendor, enter a record for each payable invoice or credit for current projects. Not only are you entering the
outstanding balances for unpaid and partially paid items, but also fully paid invoices and credits. When entering a partially
paid invoice, make two separate entries.

l Assign paid records status 4-Paid.

l Assign open records status 1-Open.

Enter all items in chronological order so that Statements andContract Audits display the invoices in sequence.

It is not necessary to enter the individual parts as line items in the grid. A single line containing a quantity, price, and ledger
account number is all that is necessary.

NOTE: A paid invoice will not be included in the 6-1-
12 Committed Cost Report.

About partially paid items on payable invoices

If you have partially paid items, youmust enter them as two separate transactions. For example, you have an invoice that
is fully paid, but the retention has not been fully released. The first transaction contains the paid amount, which is entered in
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thePaid box, and is assigned status 4-Paid. The second transaction contains the grid entry for the retention. The entire
amount is entered in theRetention box, and is assigned status 1-Open.

Use the same invoice or credit number for both transactions. But for the paid invoice, type PD at the end of the invoice or
credit number. The open record retains the original invoice or credit number.

About job numbers on payable invoices

Sage 100 Contractor uses the job numbers for job cost records, selecting invoices for payment, and a variety of reports.
The job number is not required. However, if you want to include the job number, youmust include it at the time of entry.

Entering accounts payable invoices and credits

Earlier you entered the beginning balance for theAccounts Payable ledger account, posting it to a clearing account. Next
you post the payable items against the same clearing account. Doing so transfers the balances into theAccounts Payable
ledger account.

When entering the payable items, post the records to the appropriate posting periods. Post any open items from the prior
year to period 0.

4-2 Payable Invoices & Credits

About payable invoices
In the 4-2 Payable Invoices/Creditswindow, you can enter transactions that affect vendor accounts. You can create
payable invoices or credit invoices, track and release retention, or view a history of payments for a specific invoice.

Another critical tool for managing vendors is the ability to print and post two-party checks. From the 4-2 Payable
Invoices/Creditswindow, you can access theSecondary Payeeswindow tomanage such invoices. Secondary payees
aremost often involved with subcontractor invoices because they have sub-vendor suppliers who have lien rights to the
project. It is critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.

A number of other features enhance record entry. When you select theManufacturer Details option, Sage 100 Contractor
includes themanufacturer’s name and part number in the description of each part. To helpmanage inventory, select the
Allow Freight/Variance option to post variances in material or freight costs. When you have finished entering records, use
the batch list to verify the invoice totals against the actual invoice totals. TheUse PO Sales Tax option is enabled
automatically. If you enter an invoice using information from a purchase order, the sales tax is calculated automatically.

Some states do not require subcontractors to carry Workers’ Compensation insurance. In these states, the subcontractors
use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of
coverage from payments to the subcontractor. Check with your state for compliance requirements as the laws vary in each
state. When entering a payable invoice for a subcontractor, you can calculate the cost of coverage and add it to the invoice
as a credit.

Use theRemove Paid/Void Invoices option to remove paid or voided invoices meeting the following criteria:

l The status is Paid or Void.

l The invoice does not have a job number.

l Associated payments have been posted prior to the current year.

About the 4-2 Payable Invoices/Credits Budget Verification option
When you enable theBudget Verification option, Sage 100 Contractor checks the cost codes used in the budget against
the cost codes used to post an invoice. If there is any discrepancy, the program notifies you.
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When viewing theBudget Recap by cost codes, youmay notice that division cost codes are in all capital letters and have
no assigned amount. These division cost codes have been used as place holder cost codes. When the 4-2 Payable
Invoices/Credits Budget Verification option is activated and when using place holder cost codes, be sure to avoid
posting to the place holder cost codes instead of the budgeted cost codes.

NOTES:
l You can be notified when your costs exceed the budget when you activate theOver Budget Warning.

l Budget verification can also be used for payroll records at 5-2-2 Payroll Records > Options > Budget
Verification.

Entering payable invoices
Consider the following points when entering payable invoices:

l When using the Inventorymodule, you can assign inventory to a specific location.

l To track parts using the serial numbers, enter each part as a separate item. Then for each item, enter the serial
number in thePart Serial# box. Sage 100 Contractor does not check for duplicate entry of serial numbers.

l If you enter an invoice using information from a purchase order, the sales tax will automatically default into the
invoice. You can choose to deactivate the automatic sales tax feature and to enter the sales tax manually.

To enter a payable invoice:
1 Open 4-2 Payable Invoices/Credits.

2 In the Invoice# box, enter the invoice number.

3 TheOrder# box andSubcontract# box aremutually exclusive. Do one of the following:

a If the invoice is for a purchase order, in theOrder# box enter the purchase order number, and press the Enter key.

b If the invoice is for a subcontract, in theSubcontract# box enter the subcontract number, and press the Enter key.

4 After pressing the Enter key, the programmay autofill some boxes and grid cells with data and values.

TIP: You can turn on an option to verify the contract balance against the invoice.

5 In theVendor box, enter the vendor number.

6 In the Job box, enter the job number.

7 If the job uses phases, enter the phase number in thePhase box.

8 In theDescription box, enter a description.

9 In the Invoice Date box, enter the date of the invoice.

10 In theDue Date box, enter the invoice due date.

11 In theDiscount Date box, enter the discount due date. This is the last day by which the vendor can receive payment for
you to receive a discount.

12 If needed, in theShipping# box, enter the shipping tag or ticket number.

13 If needed, in theReference# box, enter an invoice or credit number to apply this entry to.

14 If needed, check theHot List button to add the record to the hot list.

15 In theStatus list, click the invoice status.

16 In the Type list, click the invoice type.
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17 (Optional) In theUser Def andUser Def2 text boxes, enter the user-defined information as necessary.

18 When consideringWorkers’ Compensation rates and use tax:

a If the vendor is set up with aWorkers’ Compensation rate, and you want it to be calculated with this record, click the
Wk/Comp button.

b If the vendor is set up with a use tax rate and you want it to be calculated with this record, click theUse Tax button.

IMPORTANT: You have tomanually click theWk/Comp button and theUse Tax button in order for the record to
calculate the vendor's Workers' Compensation rate and use tax rate. You can set up the use tax rate and theWorkers'
Compensation rate on the Invoice Details tab of 4-4 Vendors (Accounts Payable).

19 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In thePrice cell, enter the price per unit.

c In theAccount cell, enter the ledger account number.

20 Repeat step 19 for each item.

21 Below the grid, in theDiscount box, enter the discount for early payment. By default, Sage 100 Contractor calculates
the discount amount using the rate from the vendor record.

22 In theRetention box, enter the amount of retention. By default, Sage 100 Contractor calculates the retention (if
applicable) using the rate from the subcontract, which is found in 6-7-1-Subcontracts.

23 Save the invoice.

NOTE: If you enter an invoice using information from a purchase order, the sales tax will automatically default into
the invoice. You can choose to deactivate the automatic sales tax feature and to enter the sales tax manually.

Entering accounts payable invoices for subcontract lines
There are situations where youmay need to invoice a portion of a subcontract. For example, youmay want to invoice only
the amount of one or more subcontract lines.

To enter a invoice for a portion of a subcontract:
1 Open 4-2 Payable Invoices/Credits.

2 In the Invoice# box, enter the invoice number.

3 In theSubcontract# text box, enter the contract number, and press the Enter key.
Information from the subcontract autofills the grid.

4 In theDescription box, enter a description.

5 In the grid, locate theQuantity column, and do one of the following:

a Delete the quantity or quantities of the line or lines you do not want to invoice.

b Enter a quantity between 1 and –1. For example, .5 for 50 percent.

6 Click theAutomatically job cost while saving this record toolbar button.

7 Recall the record, and note the amounts displayed in the Invoice Total, Balance, andNet Due boxes located near the
bottom-right of the window.

8 Open 6-7-1 Subcontracts, and recall the subcontract record that you partially invoiced.

9 Note the amounts in the Invoiced andRemaining Total boxes.
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Entering settings for the Invoice Over Purchase Order Warning
TheSet Over PO Warning command notifies you if the invoice exceeds the purchase order for a job. When you select the
Set Over PO Warning option, Sage 100 Contractor compares the invoice total amount (not including sales tax) against the
total PO balance. If it exceeds it, then it is compared against the tolerance settings.

NOTES:
l The Invoice Over PurchaseOrder warning in 4-2 Payable Invoices/Credits is global and set for all vendors

except the vendors that have the Vendor Invoice Over PurchaseOrder warning set in 4-4 Vendors. The
Vendor Invoice Over PurchaseOrder warning set in 4-4 overrides the Invoice Over PurchaseOrder warning
setting in 4-2.

l When you save the Invoice Over PurchaseOrder warning setting in 4-2 Payable Invoices/Credits, if vendors
have Vendor Invoice Over PurchaseOrder warning settings you get the followingmessage with the list of
vendors with settings: The following vendors have their own invoice over POWarning Settings that supersede
this company wide Invoice Over POWarning.

Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

A warning dialog box displays "Warning: The invoiced amount of this record exceeds the remaining balance on the
designated purchase order plus the tolerance amount." You can now save the record by clicking [Yes] or cancel out by
clicking [No]. An alert is also sent to the Dashboard Alert Viewer if you have selectedPayable invoices exceed purchase
order total in the 7-9 Alerts Manager ProgramWarning Subscriptions tab.
To set the Invoice Over Purchase Order Warning
1 In 4-2 Payable Invoices/Credits, select Options > Set Over PO Warning.

2 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a No message—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

3 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

4 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.
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c Percent/not to exceed: Enter the percent of the purchase order allowed in the Tolerance Percent text box, and the
amount of tolerance in the Tolerance Amount Not To Exceed text box.

5 Click OK.

Entering settings for the Vendor Invoice Over Purchase Order Warning
TheSet Over PO Warning command notifies you if invoice quantity amount exceeds the purchase order limit for the
vendor. When you select theSet Over PO Warning option, Sage 100 Contractor compares the invoice total amount (not
including sales tax) against the total PO balance. If it exceeds it, then it is compared against the tolerance settings. The
Percent tolerance is based on a percentage of the PO subtotal amount less the PO canceled amount.

NOTES:
l The existing POWarning field in the Invoice Defaults tab in 4-4 Vendors only shows choices 0, 1, and 2.

Choices 3 and 4 have been replaced by this Vendor Invoice Over PurchaseOrderWarning.

l The Invoice Over PurchaseOrder warning in 4-2 Payable Invoices/Credits is global and set for all vendors
except the vendors that have the Vendor Invoice Over PurchaseOrder warning set in 4-4 Vendors. The Vendor
Invoice Over PurchaseOrder warning set in 4-4 overrides the Invoice Over PurchaseOrder warning setting in
4-2.

l When you save the Invoice Over PurchaseOrder warning setting in 4-2 Payable Invoices/Credits, if vendors
have Vendor Invoice Over PurchaseOrder warning settings you get the followingmessage with the list of
vendors with settings: The following vendors have their own invoice over POWarning Settings that supersede
this company wide Invoice Over POWarning.

Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

A warning dialog box displays "Warning: The invoiced amount of this record exceeds the remaining balance on the
designated purchase order plus the tolerance amount." You can now save the record by clicking [Yes] or cancel out by
clicking [No].
To set the Vendor Invoice Over Purchase Order Warning:
1 Open 4-4 Vendors (Accounts Payable).

2 Select Options, then select Set Over PO Warning.

3 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a No message—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

4 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent
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d Percent/not to exceed

5 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the purchase order allowed in the Tolerance Percent text box, and the
amount of tolerance in the Tolerance Amount Not To Exceed text box.

6 Click OK.

Entering settings for the Invoice Over Subcontract Warning
When you select theSet Over Subcontract Warning option, Sage 100 Contractor compares each line of the invoice
against the corresponding subcontract line.

When an invoice is saved with a subcontract, the individual lines on the invoice are compared to the corresponding lines on
the subcontract line remaining amount, plus the tolerance. The percent of tolerance is calculated from the line's subcontract
amount.

NOTES:
l This option is only visible to the "supervisor" user.

l This warning will not work for subcontracts entered prior to version 14.2 when new columns were added to the
subcontract grid.

Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

To set the invoice over subcontract warning:
1 In 4-2 Payable Invoices/Credits, select Options > Set Over Subcontract Warning.

2 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a Nomessage—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

3 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

4 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:
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a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the subcontract line contract amount allowed in the Tolerance Percent
text box, and the amount of tolerance in the Tolerance Amount Not To Exceed text box.

5 Click OK.

About payable invoice status
The status of a payable invoice record indicates its location in the process.

Status Description

1-Open Indicates a record posted to the general ledger.

2-Review Indicates themanagement or bookkeeping staff should
review the record.

3-Dispute Indicates a record disputed by the vendor.

4-Paid Indicates a record paid in full.

5-Void Indicates a void record.

NOTE: You can change the status of records assigned status 1-Open, 2-Review, or 3-Dispute to any of the first
three status settings, but you cannot assign status 4-Paid or 5-Void.

NOTE: When an invoice or credit is fully paid, Sage 100 Contractor automatically assigns status 4-Paid. If you void
the record, Sage 100 Contractor automatically assigns status 5-Void.

About payable invoice types

Type Description

1-Contract

Use 1-Contractwhen the invoice affects the billing for the
referenced subcontract.

A payable invoice with this type increases the vendor
balance, but a credit invoice assigned this type reduces the
vendor balance.

2-Memo Use 2-Memowhen the invoice does not affect the billing
for the referenced subcontract.

Options for saving payable invoices
From the Filemenu, you can select from three ways to save an invoice.
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Menu
Command What it does

Save

Saves the invoice or credit.

If you indicated an account in the direct expense orWIP
range of accounts, Sage 100 Contractor prompts you to
create a job cost record.

If you indicated an account in the equipment expense range
of accounts, Sage 100 Contractor prompts you to create an
equipment cost record.

Set/Set to Pay

Inserts the invoice total in theSet to Pay box, and saves
the invoice or credit.

If you indicated an account in the direct expense orWIP
range of accounts, Sage 100 Contractor prompts you to
create a job cost record.

If you indicated an account in the equipment expense range
of accounts, Sage 100 Contractor prompts you to create an
equipment cost record.

Save/Autocost

Saves the invoice or credit and creates the cost records for
you.

If you indicated an account in the direct expense orWIP
range of accounts, Sage 100 Contractor automatically
creates a job cost record.

If you indicated an account in the equipment expense range
of accounts, Sage 100 Contractor automatically creates an
equipment cost record.

Entering retention as a flat rate for accounts payable invoices
You can add a retention rate to the entire job which applies a single retention rate to all the job invoices. You can also enter
retention to individual invoices as a flat rate.

To enter retention as a flat rate for accounts payable invoices:
1 Open 4-2 Payable Invoices/Credits.

2 Locate the invoice to which you want to add retention.

3 Under the grid, locate theRetention box, type an amount, and press the Enter key.

4 Select File > Save.

Verifying subcontract balances
When saving a payable invoice for a vendor, Sage 100 Contractor refers to theSet Over Subcontract Warning option to
determine if the invoice amount exceeds the subcontract balance. If the payable invoice does exceed the balance, Sage
100 Contractor provides you with a warning.
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NOTES:
l After setting, the warning stays on until it is manually changed. In addition, youmust be logged in as supervisor

to turn this feature on and off.

l When Subcontracts are exported from 9-5 Takeoffs, the warning that the subcontract exceeds the budget
amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. After
exporting subcontracts through 9-5 Takeoffs, you should run the 6-1-12-21 Committed Costs report for the
correct job to verify that subcontracts have not exceeded the budget.

l To enable the program alert forPayable invoices exceed subcontract youmust have a setting of Warning for
theMessage Type.

To verify subcontract balances:
1 Open 4-2 Payable Invoices/Credits.

2 Select Options, then select Set Over Subcontract Warning.

3 In the Invoice Over Subcontract Warning Settingswindow, select the applicable fields.

4 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a No message—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

5 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

6 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the subcontract line contract amount allowed in the Tolerance Percent
text box, and the amount of tolerance in the Tolerance Amount Not To Exceed text box.

7 Click OK.

Reprinting accounts payable checks
To reprint an accounts payable check:
1 Void the check.

2 Open 4-3 Vendor Payments.

3 Select the invoices for payment.

4 Set the invoice you want to pay.

5 Print the check.
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Viewing accounts payable payment history for invoices
Each time you post a payment to an invoice, Sage 100 Contractor creates a separate record of the payment. To review the
individual payments made to a particular invoice, you can select the invoice and display its payment history.

Suppose you void a payment that applies to five invoices. Sage 100 Contractor deletes the record for payment in each of
the related invoice histories and increases each invoice’s balance appropriately.

When you reverse a cash receipt, Sage 100 Contractor creates an additional record in the payment history for a negative
amount.

When you void an accounts payable check, Sage 100 Contractor deletes the historical record of the check and increases
the invoice balance by the amount of the voided check.

To view accounts payable payment history for an invoice:
1 Select the invoice for which you want to view a payment history in 4-2 Payable Invoices/Credits.

2 On theOptionsmenu, click Payments.

TIP: You can use the payment history to reconstruct account balances for aging reports. To do this, first determine
the fiscal period for which you want to recreate the aging. Then subtract the payments made after that fiscal period
from the ending balance.

About managing old debts in accounts payable
Sometimes there are situations where a subcontract or invoice will never be fully paid. To clear the debt from the books,
you can post a credit invoice against a specific invoice to theBad Debt Expense account. Sage 100 Contractor then
changes the status of both invoices to 4-Paid.

If you enter a credit invoice but do not reference it against a specific invoice, apply the credit in the 4-3 Vendor Payments
window. Then print a $0 check to blank paper using a check number outside the normal range of check numbers.

Charging for Workers Compensation insurance on invoices
Insurance charges appear as credits on the subcontractor’s invoice, but are not included on theWorkers’ Compensation
report. Sage 100 Contractor creates the report from payroll records.

To charge for insurance on an invoice:
1 Open 4-2 Payable Invoices/Credits.

2 Create the payable invoice.

3 Click theComp button.

4 On the Filemenu, click Save.

About payable credits
There aremany circumstances when youmight have to enter a credit invoice. Suppose you returnmaterials to a vendor.
With the return of thematerials, it is necessary to reduce the accounts payable.

When you save a credit invoice, Sage 100 Contractor reduces the vendor balance. However, the credit invoice retains
status 1-Open until you apply it against other invoices in theVendor Paymentswindow. After you have applied the credit
balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.
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You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the
credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after
applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the
credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit
invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in theVendor
Paymentswindow.

IMPORTANT: You cannot reverse a credit invoice after applying it to an invoice. If you have applied a credit invoice
to the wrong invoice, make reversing entries to correct the error.

Credit invoices and applying them to invoices in 4-2 Payable Invoices-Credits
When you apply a credit, Sage 100 Contractor adjusts the invoice and vendor balance. If the credit has a balance after
applying it to an invoice, Sage 100 Contractor assigns the credit status 1-Open, but if the entire amount of the credit is
applied, Sage 100 Contractor assigns it status 4-Paid.

To enter a credit invoice and apply it to an invoice:
1 Open 4-2 Payable Invoices/Credits.

2 Do the following:

a In the Invoice# text box, enter the credit invoice number.

b If the credit invoice is for a purchase order, in theOrder# text box enter the purchase order number.

c If the credit invoice is for a subcontract, in theSubcontract# text box enter the subcontract number.

d In theVendor text box, enter the vendor number.

e In the Job text box, enter the job number.

f If the job uses phases, enter the phase number in thePhase text box.

g In theDescription text box, enter a brief statement about the credit.

h In the Invoice Date text box, enter the invoice date.

i In theDue Date text box, enter the date payment is due.

j In theDiscount Date text box, enter the due date. This is the last day by which the vendor can receive payment for
you to receive a discount.

k In theShipping text box, enter the shipping tag or ticket number.

l In theReference# text box, enter the payable invoice number to which you want to apply the credit.

m In theStatus list, click the invoice status.

n In the Type list, click the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the credit.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the price for a single item.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 Save the credit invoice.
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Applying a vendor check to an outstanding accounts payable credit invoice
If you already have a credit invoice in 4-2 Payable Invoices/Credits, and you have received a check from a vendor, use
this procedure to apply the check to your account.

NOTE: This procedure assumes that you do not have any outstanding invoices to apply the credit against and that
you do not plan to do business with this customer in the future. The vendor check is a final pay-off check.

To apply a vendor check to an outstanding accounts payable credit invoice:
1 Open 4-2 Accounts Payable Invoices/Credits.

2 Locate the outstanding credit invoice.

3 From themenu, select Edit > Copy Invoice.

4 From themenu, select File > New.

5 From themenu, select Edit > Paste Invoice.

6 Type the original Invoice# in theReference# box.

7 Change the original Invoice# to the check number sent by the vendor.

8 In the grid, change the originalQuantity to a positive value.

9 For example, if the number is -1, change it to 1.

10 Press the Enter key, and verify that the Total is now a positive value.

11 In the grid, change the original Account to the checking account that will receive the deposit.

12 Save the invoice, and on themessage stating that the reference invoice was found, select Yes to apply this invoice to
the original payable credit invoice.

Entering open credit invoices
When you apply a credit, Sage 100 Contractor adjusts the invoice and vendor balance. If the credit has a balance after
applying it to an invoice, Sage 100 Contractor assigns the credit status 1-Open, but if the entire amount of the credit is
applied, Sage 100 Contractor assigns it status 4-Paid.

To enter an open credit invoice:
1 Open 4-2 Payable Invoices/Credits.

2 Do the following:

a In the Invoice# text box, enter the credit invoice number.

b If the credit invoice is for a purchase order, in theOrder# text box, enter the purchase order number.

c If the credit invoice is for a subcontract, in theSubcontract# text box, enter the subcontract number.

d In theVendor text box, enter the vendor number.

e In the Job text box, enter the job number.

f If the job uses phases, enter the phase number in thePhase text box.

g In theDescription text box, enter a brief statement about the credit.

h In the Invoice Date text box, enter the invoice date.

i In theDue Date text box, enter the date payment is due.
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j In theDiscount Date text box, enter the date the discount expires. This is the last day by which the vendor can
receive payment for you to receive a discount.

k In theShipping text box, enter the shipping tag or ticket number.

l In theReference# text box, enter the payable invoice number to which you want to apply the credit.

m In theStatus list, click the invoice status.

n In the Type list, click the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the credit.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the price for a single item.

d In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 Save the credit invoice.

TIP: Whenmaking vendor payments, you can apply the credit invoice.

Reversing accounts payable checks from an archived year
In your current company, create a 4-2 Payable Invoice that debits your checking account. When you use your checking
account in the grid of the invoice, and post the invoice to period 00-Prior Year, your checking account is increased by the
amount of the check, and your beginning balances are adjusted.

IMPORTANT: When you reverse a check from an archived year, it’s usually necessary to reverse the resulting prior
year invoice.

To reverse an accounts payable check from an archived year:
1 Open the 4-2 Payable Invoices/Creditswindow in the current directory.

2 From theEditmenu, choosePeriod, and from thePosting Period list, double-click Archived Fiscal Year – Period 0.

3 In the confirmationmessage, click Yes to verify that you want this period.

4 In the Invoice# box, type the check number for the check you are reversing.

5 In theVendor box, type the vendor number.

6 In theDescription box, type an appropriate description.

7 In the Invoice Date box, type the original invoice due date.

8 In theDue Date box, type the date of the original check.

9 In theDiscount Date box, type the original discount date.

10 From the Type drop-down list, select 2-Memo.

11 In the grid:

a In the description box, type a description.

b In theQuantity box, type 1.

c In thePrice box, type the amount of the check you are reversing.

d In theAccount box, enter the checking account from which the original check was posted.
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12 From the Filemenu, Save to record the transaction.

13 If the check was originally posted to a year that you have archived, youmust also reverse the transaction in period 12 for
the archived year and company.

TIP: Select the archived year and company using the 7-2 Company Informationwindow..

The prior year accounts payable check is now reversed.

NOTES:
l The reversing entry created using the steps above appears as a deposit to checking in the general ledger and

creates a new zero difference between the original AP check and the AP invoice created to reverse it.

l If you need to repay the invoice that the reversed check originally paid, pay this invoice.

l If you need to reverse the AP invoice from prior year, see the topic, Reversing accounts payable invoices from
a prior year.

Reversing accounts payable invoices from a prior year
Providing you have not archived the year in which it was posted, you can reverse an accounts payable invoice from a prior
year by voiding it, just as you would for an invoice posted in the current year.

To reverse an accounts payable invoice that was posted in a year that you have archived, youmust enter an accounts
payable credit invoice.

To reverse an accounts payable invoice from an archived year:
1 Open the 4-2 Payable Invoices/Creditswindow in the current directory.

2 Display the account payable invoice you need to reverse.

3 From theEditmenu, select Copy Invoice.

4 From the Filemenu, select New.

5 From theEditmenu, select Paste Invoice.

6 In the Invoice# box type an entry so that you can recognize it in the window. For example, add CR to the end of the
invoice number.

7 From theEditmenu, choosePeriod, and in thePosting Period list, double-click Archived Fiscal Year – Period 0.

8 In the confirmationmessage, click Yes to verify that you want this period.

9 In the grid, change theQuantity to a negative number.

10 Press the Enter key.

11 In theReference# check box, enter the invoice number that you are applying the credit against.

12 From the Filemenu, select Save.

13 In the confirmationmessage, click Yes to apply the credit to the referenced invoice. ThePayable Invoices Job Costs
window appears (if you have job costs).

NOTE: If you havemore than one invoice to which you need to apply credit, set the credit and invoices to pay, and
then print a $0.00 dollar check.

14 In the grid, do the following:

a In the Job box, enter the job.
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b In theDescription box, enter a description.

c In theCost Code box, enter the cost code.

d In theCost Type box, enter the cost type.

e In theCost Amount box, enter the cost as a negative amount.

15 From the Filemenu, select Save.

16 If the invoice was originally posted to a year that you have archived, youmust also reverse the transaction in period 12
for the archived year and company.

TIP: Select the archived year and company using the 7-2 Company Informationwindow..

The prior year accounts payable invoice is now reversed.

About voiding payable invoices
If you discover an invoice was entered incorrectly, you need to determine the best method to correct the error. For example,
if the error is in the header information, you can often correct the error by editing that information.

When the invoice contains an incorrect job number, tax district, ledger account, or amount, you can void the invoice and
then re-enter it with the correct information. By voiding and re-entering the invoice, you create a clear audit trail.

There are also circumstances when you cannot void the original record. For example, you cannot void a credit invoice that
has been applied in full or an invoice posted to period 0. Because you cannot void these types of transactions, it is
necessary to enter an adjusting invoice.

Before voiding an invoice, however, you need to reverse all the payments posted to it. Then you can enter the invoice
correctly and reapply the payments.

Voiding payable invoices
Consider these points before voiding payable invoices:

l Before you void an invoice, consider displaying the payment history to determine which checks to void.

l Display the payment history to determine which checks to void. Before voiding each check, note its record status.

l If you void payments, youmay need to re-enter the payments through the 4-3 Vendor Paymentswindow. Print the
checks to blank paper because you do not need to reissue the checks. If a payment covers more than one invoice,
re-enter the check for all affected invoices.

After reentering payments, assign the correct record status to each payment through the 1-3 Journal Transactions
window.

To void a payable invoice:
1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, select the record.

3 If an amount appears in thePaid box, click thePayments button to obtain the Trans# (the same as the check number),
and then void the payments.

4 On theEditmenu, click Void Invoice.
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Freight Costs
About allowing freight costs and variances in materials costs

You can allow or prevent the entry of freight costs and variances to the cost of materials in the 4-2 Payable
Invoices/Creditswindow. Before entering an invoice, make sure theAllow Freight/Variance command on theOptions
menu is selected.

Entering freight costs and variances in materials costs

Sage 100 Contractor creates a payable invoice from a record saved in the 12-4 Purchase Order Receiptswindow. You
have the option of selecting the invoice’s status (2-Review or 3-Dispute) when entering purchase order receipts. When you
receive the invoice, enter the freight costs or variances in materials costs in the 4-2 Payable Invoices/Creditswindow.

Consider these points before entering the costs and variances:

l You can only post freight costs or variances in materials costs to an invoice assigned status 1-Open, 2-Review, or
3-Dispute.

l Sage 100 Contractor allows one entry per text box. You can enter a freight amount, save the invoice, then go back
later to the same invoice and add a variance amount. After an amount is entered in a text box, that box is unavailable
and is no longer available.

l Freight costs and the variance inmaterials costs each appear as separate lines in the journal transaction.

l When posting the invoiced costs against a job, Sage 100 Contractor assigns the freight costs to the first job cost
record.

To enter freight costs or variances in materials costs:

1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, select the invoice.

3 In theVariance text box, enter the total variance in the cost of materials.

4 In the Freight text box, enter the shipping costs.

5 On the Filemenu, click Save.

Sales and Use Taxes
Using the purchase order sales tax

When you enter a new invoice using information from a specific purchase order, the sales tax defaults from the selected
purchase order to the new invoice in the 4-2 Payable Invoices/Creditswindow. The sales tax appears in the grid and
calculates into the total. If changes aremade to theQuantity orPrice columns in the grid, theSales Tax and Total
amounts are recalculated automatically.

If necessary, you can overwrite the imported sales tax amount in the grid manually. If you do that, however, Sage 100
Contractor no longer computes the sales tax for the record automatically if youmake any subsequent changes to the
Quantity orPrice.

NOTE: Each line item on a purchase order is not independently designated as taxable or non-taxable. The entire
purchase order is subject to one designation and the sales tax from the purchase order will be imported to the invoice
accordingly.

You can choose to clear theUse PO Sales Tax option and then calculate and add the sales tax to the invoicemanually.
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To deactivate the Use PO Sales Tax option:

1 Open 4-2 Payable Invoices/Credits.

2 On theOptionsmenu, click Use PO Sales Tax.

About use taxes for payable invoices

Some states levy a use tax on out-of-state purchases. Sage 100 Contractor adds two lines to the invoice. The first line for
the use tax debits the same ledger and subsidiary accounts indicated on the first row. For example, if the first row debits the
Materials ledger account, the use tax also debits theMaterials ledger account.

The second line for the use tax debits a negative amount to theSales Tax Payable account, increasing the balance. The
Sales Tax Payable account is set up on theReceivables tab in the 1-8 General Ledger Setupwindow.

Charging use tax on invoices

Consider these points before charging use tax on invoices:

l Sage 100 Contractor adds two lines to the invoice. The first line for the use tax debits the same ledger and
subsidiary accounts indicated on the first row. For example, if the first row debits theMaterials ledger account, the
use tax also debits theMaterials ledger account.

l The second line for the use tax debits a negative amount to theSales Tax Payable account as indicated on the
Receivables tab in the 1-8 General Ledger Setupwindow, thus increasing its balance.

To charge use tax on an invoice:

1 Open 4-2 Payable Invoices/Credits.

2 Create the payable invoice.

3 Click theUse Tax button.

4 On the Filemenu, click Save.

Work in Progress and Percentage Complete Accounting
About work in progress (WIP)

Many contractors refer to any project in the process of completion as a work-in-progress (WIP). You can print aWIP report
for any job to determine theWIP adjustment for percentage complete accounting. Using this adjustment, you can post a
transaction that allows you to compare the revenue generated during a given fiscal period to the expenses incurred during
the same fiscal period.

WIP also refers to amethod of accounting used with speculative projects. Because the contractor owns the project, the
contractor must declare improvements to the property as an asset. When the contractor sells the property, he or she then
declares the revenue and expense.

Work in progress accounting

CAUTION: Consult your accountant for detailed information about WIP transactions before proceeding to useWIP
accounting.

Contractors who own and develop projects sometimes use a different method of accounting than those who develop
projects for a client. When a contractor is involved in speculative work, bookkeepers or accountants often use work-in-
progress (WIP) accounting. Because the company owning the project is performing the work, the company cannot expense
the costs incurred during improvement of the property. While improvements do not generate income, they increase the
value of the asset.
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InWIP accounting, when you improve the property the costs incurred are posted toWIP accounts, located in the asset
range of the general ledger. Liabilities, such as loans, post to the standard liability accounts until the sale of the property.
Upon completion and sale of the project, the expenses and income are declared.

IMPORTANT: If you have turned on theWIP Verification for job costs, and are posting job costs to a job that is
markedPost expenses to WIP asset account, you cannot post to a direct expense account. A message appears:
WIP Posting is not = to job costs. Youmust correct your posting before you can save.

IMPORTANT: If you have turned on theWIP Verification for job costs, and are posting job costs to aWIP (Asset)
ledger account for a job that is marked forPost expenses to WIP asset account, a message appears:WIP Posting
is not = to job costs. Youmust correct your posting before you can save.

When you create the asset accounts for a speculative project, designate at least oneWIP account in the asset range. It is
far more common, however, to establish a ledger account for each cost type such as labor , materials, or equipment. The
pre-built ledger account structures supplied with Sage 100 Contractor includeWIP accounts. If your company is working on
several speculative projects, set up subsidiary accounts using the job number as the subsidiary account number.

Setting up WIP verification

WIP verification can be turned on or off for each transaction that has job costs associated with it.

IMPORTANT:

If you have turned on theWIP Verification for job costs, and are posting job costs to a job that is markedPost expenses
to WIP asset account, you cannot post to a direct expense account. A message appears:WIP Posting is not = to job
costs. Youmust correct your posting before you can save.

If you have turned on theWIP Verification for job costs, and are posting job costs to aWIP (Asset) ledger account for a job
that is marked forPost expenses to WIP asset account, a message appears:WIP Posting is not = to job costs. You
must correct your posting before you can save.

To set up WIP verification:

1 Open the transaction that has job costs on it.

2 For example, from 4-2 Payable Invoices/Credits, open a transaction.

3 From themainmenu, click Costs, then click Job Costs.

4 From the Job Costswindow menu, click Options.

5 From theOptionsmenu, clickWIP Verification.

6 Click Options again to verify that there is a check mark in front of theWIP verification.

About percentage complete accounting

Using percentage complete accounting, also referred to as over/under billing, you declare income during the period that you
earn it, determined by the percentage of work completed. The percentage complete accountingmethod allows you to
compare the expenses and income generated during the same period. Otherwise, reports such as income statements
provide amisleading view of the profitability because it contains the expenses for the current period and income for
previous periods.

Instead of determining theWIP adjustment manually, you can print the 6-1-7 Over/Under Billing Report to determine the
over or under billing for any job currently in progress. Because the report calculates theWIP adjustment, you only need to
post the necessary journal transactions.

Sage 100 Contractor uses the following process to determine theWIP adjustment. To establish the percentage of work
completed, the program divides the accumulated costs by the amount of the current budget. Then to determine the income
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earned, it multiplies the revised contract (the amount of the original contract plus approved change orders) by the
percentage of work completed. Finally, the program subtracts the total amount of the receivable invoices assigned type 1-
Contact from the amount of income earned. The resulting amount is theWIP adjustment.

For example, a contractor is working on a home remodel that was budgeted at $100,000 and contracted for $150,000. With
$50,000 in costs at the time of billing, the project is 50% complete. The contractor has therefore earned 50% of the
contracted amount, which is $75,000. As the contractor has not previously billed anything for the project, there are no billed
invoices to deduct from the earnings. The resulting $75,000WIP adjustment is posted in the 1-3 Journal Transactions
window.

Usually anOver Billing account is set up in thePayable range of accounts and anUnder Billing account is set up in the
Receivable range of accounts. In addition, anOver/Under Billing account is set up in the Income range of accounts.
When you have determined the amount of theWIP adjustment, post a journal transaction. If theWIP adjustment is a
positive amount, debit the receivable account and credit the income account. If theWIP adjustment is a negative amount,
credit the payable account and debit the income account.

NOTE: Some companies reverse theWIP adjustment in the subsequent fiscal period.

4-3 Vendor Payments

About 4-3 Vendor Payments
This section of Sage 100 Contractor includes 4-3-1 Select Invoices to Pay , 4-3-2 Pay Vendors, and 4-3-3
ACH Payment File Manager.

4-3-1 Select Invoices to Pay

When you open 4-3-1 Select Invoices to Pay, the program displays the Invoice Selectionwindow on top of it. The
Invoice Selectionwindow provides several ways to select criteria by which you pick the vendors you want to pay. After
you set your search criteria and click OK, the vendor data populates the grid on 4-3-1 Select Invoices to Pay. To review a
record, select a row and click theDrill Down button. To pay the full amount on the invoice, select a row and click thePay
button. You can also type an amount in theSet to Pay column. Save your work, and open 4-3-2 Pay Vendors.

4-3-2 Pay Vendors

In 4-3-2 Pay Vendors, you see the list of vendors in the grid. The invoices are totaled by vendor. Use theSelect All button
to pay all vendors, or click a check box to pick individual vendor to pay.

You can select several methods of payment using thePay By drop-down list: Check, Voucher, Credit Card, or
ACH Payment. A text link also provides a way to print lien waivers for payable invoices. You can also apply credit invoices
to invoices.

You can print several reports directly from text links on the window.

l Print Set to Pay Report

l Print Check Transmittal Report

l Print LienWaivers

Using thePay By box, you can select to pay by:

l Check

l Voucher
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l Credit Card

l ACH Payment

4-3-3 ACH Payment File Manager

When you open 4-3-3 ACH Payment File Manager, you can retract an ACH payment batch. This removes all vendor
payment records associated with that batch number, and voids the associated general ledger payment. Using the Options
menu, you can alsoPrint ACH Payment File Report andReprint or Email ACH Payment Email Receipts.

About the Invoice Selection window
When you click 4-3-1 Set Invoices to Pay on themenu tree, the program displays the Invoice Selectionwindow
overlaying the 4-3-1 Set Invoices to Paywindow. You use the Invoice Selectionwindow to set the criteria by which the
invoices will be displayed in the 4-3-1 Set Invoices to Pay grid area.

The window offers six sets of criteria. The following list describes some examples of what you find:

l UnderSelection Criteria: Vendor, Job, Due Date, Disc. Date

l UnderPay Options: Exclude Vendors with Overdue Certificates, Pay Retentions

l UnderSort: Record#, Vendor, Job, Vendor/Job

l UnderStatus: Open, Review, Dispute

l UnderSort By: Number, Name

l UnderDisplay: All Invoices, Job Invoices Only

TIPS:
l Save a specific combination of criteria by clickingDefaults > Save.

l If you do not select any criteria, the programs selects allOpen invoices.

Selecting invoices
You use the Invoice Selectionwindow to set the criteria by which the invoices will be displayed in the 4-3-1 Set Invoices
to Pay grid area.

To select invoices:
1 On the Invoice Selectionwindow, do any of the following as required:

a UnderSelection Criteria, enter selection criteria.

b UnderPay Options, select from among the check boxes.

c Under Include, accept the default status of Open status invoices, or select a different status.

d UnderSort on, select the sort criteria.

e UnderSort By, select to either sort the invoices by Number orName.

2 Click Display Invoices.

TIP: You can save the selection criteria set up by clickingDefaults > Save.

TIP: If you do not select any criteria, the programs selects allOpen invoices.
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About 4-3-1 Select Invoices to Pay
When you open 4-3-1 Select Invoices to Pay, the program displays the Invoice Selectionwindow first with the primary
window in the background. This allows you to set the criteria by which you will select invoices. After you select the criteria
and click OK, the program populates the 4-3-1 Select Invoices to Paywindow with invoices.

The window contains five buttons providing tools for working with the selected invoices.

When you click:

l Open—Assigns the status of Open to selected invoices.

l Review—Assigns the status Review to selected invoices.

l Pay—Sets selected invoices to pay their full default amount.

l No Pay—Removes the set to pay amount for the selected invoices.

l Past—Sets selected invoices to pay with a discount, even if they are past the discount date.

To pay the full invoice balance, select the invoice and click thePay button. If you do not want to pay the entire balance of
the invoice, enter a different amount. For example, you canmake partial payments to vendors and their second payees by
entering aSet To Pay amount for any amount less than the stated invoice.

If an invoice was previously set to pay and you decided not to pay it at this time, then select the invoice, and click theNo
Pay button.

When the invoices are displayed, select an invoice and enter the amount to pay and any applicable discount. If the invoice
has already been set to pay, that amount appears on theSet To Pay column. When you set an invoice to pay, Sage 100
Contractor deducts the available discount from the invoice balance and displays the result in theSet To Pay column.

If the payment date to receive a discount has passed, Sage 100 Contractor displays past in theDiscount column next to
the discount amount and does not deduct the discount from the invoice balance. To take the discount, select the invoice,
and click thePast button instead of thePay button.

IMPORTANT:
l Youmust save your changes in order for the program to recognize theSet To Pay amount.

l If vendors’ certificates are expired, invoices will not appear unless you clear theExclude Vendors with
Overdue Certificates check box on the Invoice Selectionwindow.

l If you select Exclude Vendors with Overdue Certificates and have indicatedYes in theStop Pay text box in
theCertificateswindow in 4-4 Vendors (Accounts Payable), the program excludes the vendors from the
invoice selection in 4-3-1 Select Invoices to Pay.

About 4-3-2 Pay Vendors
Using the 4-3-2 Pay Vendorswindow, you can print checks, vouchers, and lien waivers for payable invoices. You can also
pay by ACH payment or print zero dollar checks.

In addition to printing regular, single-party checks, you can print two-party checks with a secondary payee. When working
with secondary payees, the grid displays the secondary payee name appended to the vendor, along with the word “and.”
This is similar to the way the payee appears on the printed check.

When you open the 4-3-2 Pay Vendorswindow after setting invoices to pay using 4-3-1 Set Invoices to Pay, the selected
vendors appear in the grid area. When you select a vendor using thePayee check box, the program displays the amount in
the Total Selected for Payment box. Then you select amethod of payment. You can pay by check, voucher, credit card,
or ACH payment. You can click theChange the posting period button in the top right to change the posting period.
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Printing Reports and Waivers

The window displays three text links:

l Print Set to Pay Report—Opens the 4-3-1 Report Printingwindow with the 21-Set to Pay Report selected.

l Print Check Transmittals - Opens the 4-3-2 Report Printingwindow with the 21-Check Transmittal Report
selected.

l Print Lien Waivers—Opens the 4-3-3 Report Printingwindow with the 21-Lien Waiver selected.

Vendor ACH Payment File Creator
When you create an ACH file, payment information is recorded for vendors who have authorized ACH payments to their
accounts. Once the file is created, transfer the file using your bank's specified procedure.

1 On theVendor ACH Payment File Creatorwindow, enter the appropriate Transaction Date, Deposit Date and click
theCreate File button.

2 Click the [Save] button to save theACH Payment file.

3 Click [OK].

4 Do one of the following:

a Click [Yes] to print and email the 4-3-7-21 ACH Payment Receipt report.

b click [No] to exit.

5 If you clicked [Yes], click the Print toolbar button.

6 Click [Yes] to send the emails to those listed for emailing and print the 4-3-7-21 ACH Payment Receipt for those
without an email address, or click [No] to send all of the ACH Payment Receipts to the printer.

NOTE: If you are sending throughMicrosoft Outlook and amessage is displayed about a program sending an email
message on your behalf, click [Allow].

7 If you clicked [Yes] in step 6, you can also print the ACH Payment Receipts that were emailed by clicking [Yes] to print
the emailed payments receipts, or click [No] to exit, which will just print the ACH payment receipts for those that were
not emailed.

Printing vendor payment checks
Before printing vendor payment checks, consider these two points:

l If applicable and before printing checks, youmust print lien waivers. Click thePrint lien waivers text link in the
lower-left corner of the window.

l If the amount of payment to a vendor results in a zero amount through the application of a credit, youmust print a $0
check. Printing the $0 check is necessary to complete the invoice payment process. In theReport Printing
window, select thePrint $0 Checks check box.

CAUTION: Only print accounts payable checks from one company and from one computer at a time. Printing
accounts payable checks from one company andmore than one computer at a timemay cause duplicate check
numbers and duplicate payments.

To print vendor payment checks:
1 Open 4-3-2 Pay Vendors.

The total invoices of the vendors you have selected using 4-3-1 Set Invoices to Pay appear in the grid area.
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2 Click theSelect All button, or alternatively select vendors individually.

3 Click thePay By drop-down arrow, and select either to pay by check, voucher, or credit card.

4 Click OK.

a If you are paying by check, on the 4-3-5 Report Printingwindow, select theReport Form that suits your business.
Your choices are 21-Open Stub, 22-Formatted Stub, and 23-No Job Stub. Then click thePrint records icon.
When you print checks, Sage 100 Contractor creates ledger transactions. You can also specify the sorting of the
invoices on your check stub. Select the option to sort the invoices in the 4-3-5 Report Printingwindow. Sage 100
Contractor prints the invoice numbers on the check stub; however, sometimes more than one check stub is required to
print all the invoices. You can print additional check stubs with void checks to complete the printing of the invoices. In
theReport Printingwindow, select theMultiple Checks check box.

b If you are paying by voucher, on the 4-3-4 Report Printingwindow, select the appropriateReport Form and click the
Print records icon.

c If you are paying by credit card, the program displays theCredit Card Selectionwindow. Specify aCard Issuer
Account, aCredit Card, a Trans#, a Trans Date, and click OK.

Printing separate checks per invoice by vendor
When you enter a vendor or edit a vendor’s information, you can specify that you want the system to print separate checks
per invoice for that vendor when you pay them.

To print separate checks per invoice by vendor:
1 Open 4-4 Vendors (Accounts Payable), and select a vendor.

2 Select theSeparate Checks check box.

3 On the file menu, click File > Save.

Applying open credits to payable invoices
When applying an open credit to a payable invoice, consider the following:

l If the amount of payment to a vendor results in a zero amount through the application of a credit, youmust print a $0
check. Printing the $0 check is a necessary procedure to complete the invoice payment process. In theReport
Printingwindow, select thePrint $0 Checks check box.

l Sage 100 Contractor prints the invoice numbers on the check stub; however, sometimes more than one check stub
is required to print all the invoices. You can print additional check stubs with void checks to complete the printing of
the invoices. In theReport Printingwindow, select theMultiple Checks check box.

To apply an open credit to a payable invoice:
1 Open 4-3-1 Set Invoices to Pay.

2 On the Invoice Selectionwindow, select the invoices you want to display in the 4-3-1 Set Invoices to Pay grid area,
and click OK.

3 Select an invoice.

4 Under theSet to Pay column for that invoice, enter the amount to which you want to apply a credit. This must be a
positive amount.

5 Locate the credit invoice, and enter the credit amount to apply. This must be a negative amount.

6 Repeat steps 3, 4 and 5 for each invoice to which you want to apply a credit.

7 On the Filemenu, click Save.
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Applying accounts payable credits to accounts payable invoices
When you need to apply accounts payable invoices and accounts payable invoice credits, use 4-3-1 Set Invoices to Pay.

TIP: Credit invoices (invoices with a negative value) appear in the grid under the Invoice Total column along with
other invoices. Setting the invoice selection criteria to display invoices by vendor will group invoices together.

To apply credits to invoices:
1 Open 4-3-1 Set Invoices to Pay.

2 On the Invoice Selectionwindow underSelection Criteria, select a vendor or a job, and click OK.
The grid populates with all open invoices for that vendor or job.

3 In theSet to Pay column, enter the invoice amount to pay, and repeat for all invoices that need to be paid. This must be a
positive amount.

4 Locate the credit invoice, and enter the credit amount to apply. This must be a negative amount.

5 Click File > Save.

6 Open 4-3-2 Pay Vendors, and select the check boxes of the vendor payee.

7 As required, click theChange the posting period icon to select the appropriate posting period, and then click OK.

8 On 4-3-5 Report Printing, on theReport Criteria tab:

9 Select the desired report number.

10 Select the desiredReport Form from the list.

11 In theVendor field, type the vendor number.

12 Select thePrint $0 Checks box.

13 From the Filemenu, click Print.

14 On theCheck Printingwindow, in theChecking Account box, type the appropriate cash account.

15 In theStarting Check Number box, type the appropriate check number.

16 In theCheck Date box, type the date of the check.

17 Click OK.

18 To themessage, Reminder: [number] check(s) will be printed, verify that the information is correct, and then click
OK.

19 Finally, select Assign check numbers for ALL checks on theAssign/Post Checkswindow if the check has
correctly printed.

Changing the status of payable invoices
In the 4-3-1 Set Invoices to Paywindow, you can change the status of an invoice between 1-Open and 2-Review. You
cannot change the status of invoices that have a status of 3-Dispute, 4-Paid, or 5-Void.

To change the status of payable invoices:
1 Open 4-3-1 Set Invoices to Pay.

2 On the Invoice Selectionwindow underSelection Criteria, select criteria with which to populate the grid area on 4-3-1
Set Invoices to Pay.

3 Review the Status column for invoices whose status you want to change.
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4 Select the row of that invoice, and then click Open orReview.

About vendor payment reports
The 4-3-2 Pay Vendorswindow provides text links to these reports.

Report To

Print Set to
Pay report

Review the invoices for each vendor that you have set to pay. The report provides the
invoice balance, invoice retention, discount available, and the amount set to pay for each
invoice. The report also summarizes the data for each vendor and provides grand totals.

Print check
transmittals

Lists the invoices that you are paying. When the list of invoices is too long to fit the
checkstub, you can supply the vendor with a check report.

TheMinimum Number of Invoices box on the Check Transmittal Minimum Invoice Number
window controls theminimum number of invoices that the payment references.

To set aminimum number before writing a check, enter a number in theMinimum Number
of Invoices box.

Leave the box blank if you do not need to set aminimum number of invoice references.

When you print theCheck Transmittal Report, Sage 100 Contractor determines which
checks meet theminimum and prints a report for each.

Print lien
waivers

Displays the lien waiver information for the contractor for invoice or invoices that are set to
pay.

NOTE: The check report uses the set-to-pay information; therefore, youmust print the check report before printing
the vendor checks.

Lien Waivers and Vouchers
About lien waivers

A lien waiver is a document signed by a contractor, subcontractor, or other supplier of goods or services stating that the
supplier has been paid for the work performed or goods supplied and waiving the supplier's right to file a claim against the
property.

In the 3-5 Jobs (Accounts Receivable)window, you can track the lien waivers that you receive for each job. You can also
print lien waivers for vendors receiving payment through the 4-3 Vendor Paymentswindow.

IMPORTANT: Youmust print lien waivers before printing payable checks or vouchers. You can also save the lien
waiver as a PDF file and reprint it later.

Entering lien waivers

To enter a lien waiver:

1 Open 3-5 Jobs (Accounts Receivable).

2 Using the data control, select the job.

3 On theOptionsmenu, click Lien Waivers.

4 In thePre-lien# text box, enter the pre-lien number.
The pre-lien number is a reference number provided by the vendor.

5 In theVendor text box, enter the vendor number of the vendor who sent the pre-lien.
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6 If the pre-lien includes a second vendor, enter the vendor number in theSecond Vendor text box.

7 In theReceived text box, typeYes if you received a pre-lien from the vendor.

8 In theDate Received text box, enter the date when you received the pre-lien.

9 In the First Date text box, enter the date when the vendor first appeared on the job.

10 In the Last Date text box, enter the date when the vendor finished the job.

11 In the Lien Rights text box, typeYes if the vendor has lien rights.

12 In the Joint Check text box, typeYes if the vendor is paid with a joint check.

13 In the Final Waiver text box, type Yes if you have received the final lien waiver from the vendor.

14 In the Final Date text box, enter the date when the final lien waiver was received.

15 Repeat steps 4–14 for each pre-lien you receive.

16 On the Filemenu, click Save.

Printing lien waivers

You can print lien waivers for subcontractors to sign upon receipt of payment. The waiver details the invoices, invoice
balances, and amount paid. The generic text can bemodified so that the lien waiver complies with your state requirements.

IMPORTANT: Youmust print lien waivers before printing payable checks or vouchers. You can also save the lien
waiver as a PDF file and reprint it later.

To print a lien waiver:

1 Open 4-3-1 Set Invoices to Pay.

2 On the Invoice Selectionwindow underSelection Criteria, select criteria with which to populate the grid area on 4-3-1
Set Invoices to Pay.

3 On 4-3-1 Set Invoices to Pay for each invoice, enter the amount you want to pay in theSet to Pay box.

4 Click File > Save, and then open 4-3-2 Pay Invoices.

5 Select the check boxes of the invoices for which you want print lien waivers, and then click the text link, Print Lien
Waivers.

6 On the 4-3-3 Report Printing window on theReport Criteria tab, select the report number, report form, and set the
criteria.

7 On the toolbar, click one of the printing options, such as thePrint records icon.

Paying by vouchers

Lending institutions use vouchers to control the job expenditures of a contractor’s speculative work. When you are ready to
pay materials suppliers and subcontractors, print and send the vouchers to the lender. The lender then pays the vendors
based on the amounts indicated on the vouchers.

Because the lender is making the payments, vouchers do not affect your cash balance. They do, however, affect the
balance of your Loan Payable account.

To pay by voucher:

1 Open 4-3-2 Pay Vendors.
Invoices that you have selected using 4-3-1 Set Invoices to Pay appear in the grid area.

2 Click theSelect All button, or alternatively select invoices individually.
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3 Click thePay By drop-down arrow, and select pay by Voucher.

4 Click [Pay Vendors].

5 On the 4-3-5 Report Printingwindow, select the appropriateReport Form and click thePrint records icon.

6 Enter a transaction to record the loan disbursement.

7 Select the [Update 1099 Balance] check box to add the voucher to the 1099 balances when printing vouchers.

8 Click [OK].

TIP: The vouchers work like checks in that you can print vouchers to paper. The program displays these options:
Post ALL vouchers, Post vouchers through voucher#, orDo not post any vouchers.

Posting loan disbursements

After printing the vouchers, you need to enter a transaction showing the lender’s disbursement of funds to the vendors.

For speculative jobs, enter a transaction in the 1-2 Deposits and Interestwindow that debits theVoucher Clearing
account and credits the Loan Payable account.

For all other jobs, enter a transaction in the 3-3-1 Cash Receiptswindow that debits theVoucher Clearing account and
credits the appropriate receivable invoices.

4-4 Vendors (Accounts Payable)
Vendor records provide quick access to vendor information for payable invoices, 1099 balances, orderingmaterials, and
subcontract management. Create a vendor record for each business that sends you invoices and each business to which
you owemoney or make regular payments. These vendors may include subcontractors, architects, engineers, and lenders.

In the 4-4 Vendors (Accounts Payable) window, you can review vendor-related information such as subcontracts,
purchase orders, and invoices. You can also record any additional certificates a vendor is required to supply.

l Vendor financial information tab fields

l Vendor invoice defaults tab fields

l Vendor other defaults tab fields

l Vendor ACH Payment Setup fields

l Vendor purchase order warnings

l Vendor types

l Vendor records

l Vendor certifications and expiration dates

l Vendor remittance

l Workers' Compensation rates on vendor records

l Vendor use taxes

l Deleting vendors

IMPORTANT: Sage 100 Contractor uses information entered in the 3-6 Receivable Clientswindow and 4-4
Vendors (Accounts Payable)window for other functions such as scheduling and sending faxes and email
messages. If fax numbers and email addresses for vendors are not entered in these windows, then client and vendor
contacts do not appear on the fax and email distribution lists.
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Internal vendors
Youwould select the Internal Vendor check box to keep track of someone you need in the vendor database, but not
someone from whom you get invoices. Flagging a vendor as “internal” causes the program to display amessage if you try to
enter a payable invoice for that vendor. Examples of internal vendors are architects, engineers, or other professionals who
are involved with projects that you work on, but you are not the one contracting with them because you are not the general
contractor or owner. Youmight, however, want to keep that information in the job record. Internal vendors may also be
fictitious entities, such as a generic lumber supply or generic tile subcontractor. Youmight want to use that entity for putting
a “type” of vendor on parts for estimating and bid request reasons.

Vendor financial information fields

Box What it does

1099 Type

Indicates the type of 1099 status.

l 0—Undetermined

l 1—Miscellaneous

l 2—Rent

l 3—Sole Proprietor

l 4—Interest

l 5—No 1099

Beginning
Balance

Displays the beginning balance of outstanding invoices for
your current books. You cannot enter or edit an amount in
this box.

Current
Balance

Displays the beginning balance of outstanding invoices for
your current books. You cannot enter or edit an amount in
this box.

Vendor invoice defaults
The information you provide on the Invoice Defaults tab helps Sage 100 Contractor post an invoice and create the job cost
records.

Default What it does

Due Terms

Determines the date by which payment is due.

In Sage 100 Contractor, you can base the frequency of the cycle on days, months, or a specific day of the
month. Billing, transaction, invoice, and other cycles are represented by these symbols: ##DY, ##MO, and
##TH.

Following are some examples that explain what the symbols represent.

l ##DY—30DY means due 30 days from the date of the invoice.

l ##MO—02MOmeans due twomonths from the date of the invoice.

l ##TH—25TH means due on the 25th day of eachmonth regardless of the date of the invoice.
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Default What it does

Discount
Terms Determines the date by which payment is due for your business to receive a discount.

Discount
Rate Determines the discount rate for early payment.

Use Tax
Rate Determines the use tax on out-of-state purchases.

Work
CompRate

Sets up the vendor record of a subcontractor with the employer’s compensation rate. When entering the
payable invoice, you can charge the subcontractor for coverage based on the invoiced amount. The charge
appears as a credit on the subcontractor’s invoice.

Ledger
Account

Determines the default ledger account to which invoices are posted. For amaterials supplier, for example,
enter thematerials expense account number. When you enter a payable invoice, thematerial expense
account defaults to the grid.

Some vendors may not post to one account regularly. If there is not a common account used by a vendor,
leave the Ledger Account box blank.

Cost Code

Determines the cost code to which you post the vendor. Because cost codes may vary each time you post
a record, consider leaving theCost Code box blank.

Alternately, you can enter the lowest numbered cost code used by the vendor. You can then use the
Lookupwindow to display cost codes starting in the appropriate area.

Cost Type Determines the cost type to which you post the vendor. Usually the cost type corresponds to the ledger
account.

Invoice
Status

If you want to review all invoices or payments for a vendor, assign the vendor record Invoice status 2-
Review. Otherwise, Sage 100 Contractor assigns status 1-Open.

Purchase
Order
Warning

Restricts the ability to save payable invoices.

Allow
Duplicate
Invoice
Number

Lets you enter duplicate invoice numbers for a vendor.

The Invoice Number text box in thePayable Invoiceswindow can be set up to require a unique invoice
number. TheAllow Duplicate Invoice Number check box lets you supersede the requirement for a unique
invoice number for specific vendors such as the phone company.

Separate
check for
each
invoice

Tells the system to print separate checks for each invoice for each vendor.

Put on the
Hot List Automatically puts the vendor's invoices on the Hot List.

Other vendor defaults
The information you provide on theOther Defaults tab helps Sage 100 Contractor create or export records.
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Default What it does

Purchase
Order Type

Determines the type of purchase order you normally
create for the vendor.

Subcontract
Type

Determines the type of subcontract you normally create
for the vendor.

Vendor ACH Payment Setup fields
Field Description

ACH Account Status

l 0—None

l 1—Prenote

l 2—10 day wait

l 3—Active

l 4—Inactive

Account Type
l 1—Checking

l 2—Savings

Routing# Vendor's bank routing number, a nine digit code.

Bank Account Number Vendor's bank account number.

Email Receipt to The email address to receive the vendor ACH payment receipt.

Vendor purchase order warnings
When saving a payable invoice for a vendor, Sage 100 Contractor refers to the selectionmade in thePurchase Order
Warning list in the vendor’s record. If the payable invoice does not meet the criteria, Sage 100 Contractor provides you
with a warning. These warnings are set on the Invoice Defaults tab of 4-4 Vendors and warn if there is no PO available for
the invoice or you can require a PO for the invoice.

Status Description

0-None Provides no warning.

1-Warn if no
PO

Provides a warning if the invoice does not contain a purchase order number, but allows you to save the
invoice.

2-Require PO Requires a purchase order number to save the invoice.

Vendor Invoice Over Purchase Order settings

TheSet Over PO Warning option in 4-4 Vendors notifies you if the invoice quantity amount exceeds the purchase order.
When you select theSet Over PO Warning option in the Options menu, Sage 100 Contractor compares the invoice total
amount (not including sales tax) against the total PO balance. The Vendor Invoice Over PurchaseOrder warning settings
supersedes the settings for Invoice Over PurchaseOrder warning settings in 4-2. How?

Setting up vendor types
You can use vendor types to group or categorize vendors. Types give you the ability to select specific vendors when
printing bid requests, vendor lists, or other vendor related documents.
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If you create a long list of vendor types, you can simplify it by abbreviating vendor categories. For example, useM for
material suppliers andS for subcontractors in the Type Name. For example, the description for a lumber supplier is M-
Lumber, and an electrical supplier is S-Electrical.
To set up vendor types

1. Open 4-4 Vendors (Accounts Payable).

2. Next to theVendor Type list, click the detail button.

3. TheVendor Typewindow opens.

4. In theVendor Type# text box, enter the type number.

5. In the Type Name text box, enter a description of the vendor type.

6. Repeat steps 3–5 for each type.

7. On the Filemenu, click Save.

Entering vendor records
Consider these points before entering vendor records:

l Be sure to enter all the important information regarding vendors. Entries made in the 4-4 Vendors (Accounts
Payable)window are used for other functions, such as fax and email scheduling.

l Some states levy a use tax on out-of-state purchases. You can enter the use tax rate in the 'Use Tax' Rate text box.

l In some states, subcontractors are not required to carry Workers’ Compensation insurance. The general contractor
often covers the liability of the subcontractor through the general contractor’s policy. You can enter the general
contractor’s rate in theWork Comp Rate text box.

l Select the Internal Vendor check box tomark the vendor as an internal supplier, which only affects vendor reports.

l Select theSeparate check for each invoice check box to tell the system to print separate checks for each invoice
for each vendor.

To enter a vendor
1 Open 4-4 Vendors (Accounts Payable).

2 In the data control text box, enter the vendor number.

3 In theVendor Name text box, enter the full vendor name.

4 In theShort Name text box, enter a brief name for the vendor.

5 In theVendor Type list, click the vendor type.

6 In theGeneral Information tab, do the following:

a In theOwner text box, enter the name of the person to contact at the vendor’s office.

b In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

c In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

d In theMinority Type list, click the type of minority if applicable.

e In the Tax District text box, enter the sales tax district number.

7 In the Financial Information tab, do the following:

f In the Federal Id# text box, enter the vendor’s Federal Identification Number.

g In theState Id# text box, enter the vendor’s State Identification number.
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h In theAccount# text box, enter your account number the vendor uses to identify your company.

i In the License# text box, enter the contractor’s license number.

j In theResale# text box, enter the vendor’s resale number.

k In the 1099 Type list, click the 1099 status.

8 As necessary, select the Internal Vendor check box.

9 Click the Invoice Defaults tab, then do the following:

a In theDue Terms text box, enter the cycle for the date when the invoice is due.

b In theDiscount Terms text box, enter the cycle for the date by which the vendor must receive payment for the
discount to apply.

c In theDiscount Rate text box, enter the discount rate.

d In the 'Use Tax' Rate text box, enter the use tax rate.

e In theWork Comp Rate text box, enter the workers' compensation rate.

f In the Ledger Account text box, enter the ledger account to which you want to post.

g In theCost Code text box, enter the default cost code.

h In theCost Type list, click the default cost type to assign.

i In the Invoice Status list, click the status to assign an invoice or credit.

j In thePO Warning list, click the warning status you want to assign to the vendor.

k If you need to send a separate check for each invoice, select theSeparate check for each invoice check box.

l If you want to automatically put the vendor's invoices on the Hot List, select thePut on the Hot List check box.

m If you want to allow duplicate invoice numbers, select theAllow duplicate invoice numbers check box.

10Click theOther Defaults tab, then do the following:

a In theRFP Type list, click the type of RFP you often create for the vendor.

b In theDescription text box, enter the default description for RFPs.

c In thePurchase Order Type list, click the type of order you often create for the vendor.

d In theDescription text box, enter a brief statement about the purchase order.

e In theSubcontract Type list, click the type of subcontract you often create for the vendor.

f In theDescription text box, enter a brief statement about the subcontract.

11 Click theACH Payment Setup tab, then do the following:

a Select theEnable ACH payment box.

b In the ACH Account Status, select one of the following statuses:

i 0—None

ii 1—Prenote

iii 2—10 day wait

iv 3—Active

v 4—Inactive

c In the Account Type, select one of the following account types:
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i 1—Checking

ii 2—Savings

d In theRouting# text box, enter your vendor’s bank routing number.

e In theBank Account# text box, enter the vendor's bank account number.

f In theEmail Receipt to text box, enter the email address to receive the ACHpayment receipt.

12Click theContact grid, do the following:

a In theContact Name text box, enter the contact's name.

IMPORTANT: The first contact in the list is considered to be the primary contact in reports.

b In the Job Title text box, enter the contact's job title.

c In thePhone# text box, enter the contact’s telephone number.

d In theExtension text box, enter the contact's telephone extension, as necessary.

e In theEmail text box, enter the contact's email address.

f In theCell# text box, enter the contact’s cellular number.

g In the Fax# text box, enter the contact’s fax number.

h In theOther# text box, enter the contact’s other telephone number.

i In theOther Description text box, enter the contact’s other telephone number description.

j In theNotes text box, enter any applicable notes about the contact.

13 Enter the vendor licenses and certificates.

14 On the Filemenu, click Save.

15 If you want to set the vendor's 1099 balance for the calendar year:

a Refresh the vendor record by clicking the back arrow button (next to the record number in the upper left-hand corner),
and then clicking the forward arrow button to advance to the new record again.

b Select Options > 1099 Balance Startup/Adjustment to open the 1099 Balance Startup/Adjustment window.

c Select the current date in theAdjustment Date box; then type the vendor's starting 1099 balance in the 1099 Balance
Startup/Adjustment box.

d Click [Save].

Vendor certificates and expiration dates
You can track the expiration dates forWorkers’ Compensation, liability insurance, contractor’s licenses, and other required
certificates and licenses. When you enter a certificate or license, always enter an expiration date. If you do not have a date,
enter one that is obviously expired such as 01/01/1980. Later, you can determine which vendors have insurance or licenses
that have expired.

IMPORTANT: The 4-1-5-31 Vendor Worker's Comp Report requires that theWorkers’ Compensation insurance
certificate information be in Row 1 of theCertificateswindow grid.

You can control whether you receive a warning that a certificate has expired when creating a subcontract. You can also
stop payment to a vendor if a certificate has expired.
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When selecting vendor invoices for payment, you can exclude vendors with expired licenses. You can also print
documents that you can send to vendors with expired licenses, requesting the new expiration dates to update your records.
When you do not need dates for vendors such as lending institutions, leave the text boxes blank.

Reports on vendor certificates and expiration dates

You can run insurance reports to view which vendors have current and/or expired certificates. How?

l 4-1-1-41 Insurance Report

l 4-1-1-42 Insurance Report~by Vendor Type

l 4-1-1-43 Insurance Report~Alpha

l 4-1-1-46 Insurance Report~with Notes

l 4-1-1-47 Insurance Report~by Vendor Type; with Notes

l 4-1-1-48 Insurance Report~Alpha; with Notes

In theCertificateswindow, you can create a list of the certificates a vendor must supply. For example, youmight list the
Workers’ Compensation insurance certificate, liability insurance certificate, contractor’s license, and hazardous materials
certificate.

Because you can generate expired certificate reports based on a specific line number, consider entering the certificates in a
specific order for each vendor. For example, Row 1 is theWorkers’ Compensation insurance certificate, Row 2 is the
liability insurance certificate, and Row 3 is the contractor’s license.
To enter vendor certificates
1 Open 4-4 Vendors, and display the vendor.

2 On theOptionsmenu, click Certificates.

3 In theDescription text box, enter a brief statement about the certificate.

a For example, typeWorkers’ Compensation.

4 In theReceived text box, enter the date you received the certificate.

5 In theExpires text box, enter the date when the certificate has expired.

6 In theWarning text box, type Y if you want to receive a warning. Type N if you do not want to receive a warning even
though the certificate has expired.

7 TheWarning column lets you control whether you receive a warning when creating a subcontract for a vendor with an
expired certificate. Youmust select Exclude Vendors with Overdue Certificates orWarn on Vendors with Overdue
Certificates in the 4-3 Vendor Paymentswindow. To activate these options, click theSelection button in 4-3 Vendor
Payments.

8 In theStop Pay text box, type Y to stop payments to the vendor when the certificate expires. Type N if you want to pay
the vendor even though the certificate has expired.

9 TheStop Pay column lets you control payments to the vendor by accessing the Invoice Selectionwindow from the 4-3
Vendor Paymentswindow. In the Invoice Selectionwindow, youmust also select Exclude Vendors with Overdue
Certificates in order to exclude those vendors whomeet the expiration criteria from receiving payment. It does not affect
payments through the 1-1 Checks/Bank Chargeswindow.

10 Repeat steps 3–7 for each certificate.

11 On the Filemenu, click Save.
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Setting up vendor remittance
On occasion, it is necessary to substitute a different name on a vendor check. In theVendor Remitwindow, you can add
more lines to the grid by clicking in the last cell in the last row and pressing the ENTER key.

When you print the vendor checks, Sage 100 Contractor looks to the vendor remit table. If the vendor appears in the table,
Sage 100 Contractor uses the payee information from the table in place of the information from the vendor record.

To set up vendor remittance:
1 Open 4-4 Vendors (Accounts Payable).

2 On theOptionsmenu, click Vendor Remit.

3 TheVendor Remit Informationwindow opens.

4 In theVendor cell, enter the vendor number.

5 In thePayee Remit cell, enter the payee’s name.

6 In theAddress 1 cell, enter the payee’s address.

7 In theAddress 2 cell, enter any remainder of the payee’s address, if necessary.

8 In theCity/State cell, enter the payee’s city and state.

9 In the Zip cell, enter the payee’s ZIP Code.

10 Repeat steps 3–9 for each vendor you want to include.

11 On the Filemenu, click Save.

Deleting vendors
If a vendor has current year ledger activity or open invoices from a prior year, you cannot delete that vendor.

CAUTION: When you delete a vendor, all prior year, paid, or void invoices related to that vendor are also deleted.
This can affect invoices associated with current jobs. In addition, because the vendor has been deleted, only the
vendor number will appear in job cost records.

To delete a vendor
1 Open 4-4 Vendors (Accounts Payable).

2 Using the data control, select the record.

3 On theEditmenu, click Delete Vendor.

Setting up Workers Compensation rates for payable invoices
Some states do not require subcontractors to carry Workers’ Compensation insurance. In these states, the subcontractors
use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of
coverage from payments to the subcontractor. Check with your state for compliance requirements as the laws vary in each
state.

Sage 100 Contractor uses theWorkers’ Compensation account indicated on thePayables tab in theGeneral Ledger
Setupwindow to post payable invoice transactions.

To set up a Workers’ Compensation rate for payable invoices:
1 Open 4-4 Vendors (Accounts Payable).

2 Using the data control, select the vendor.
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3 Click the Invoice Defaults tab.

4 In theWork Comp Rate box, enter the rate at which you are charging the subcontractor.

5 On the Filemenu, click Save.

6 Open 1-8 General Ledger Setup.

7 On thePayables tab, enter the ledger account to which you are posting the charge to subcontractors in theWorkers’
Compensation box.

8 On the Filemenu, click Save.

TIP: The credit does not appear on theWorkers’ Compensation report, which only uses data from payroll records. To
track and report the costs, create a separateWorkers’ Compensation ledger account.

Setting up use taxes for payable invoices
Some states levy a use tax on out-of-state purchases.

To set up use tax for a payable invoice:
1 Open 4-4 Vendors (Accounts Payable).

2 Using the data control, select the vendor.

3 Click the Invoice Defaults tab.

4 In theUse Tax Rate text box, enter the use tax rate.

5 On the Filemenu, click Save.

6 Open 1-8 General Ledger Setup.

7 On theReceivables tab, enter the ledger account to which you are posting sales tax.

8 On the Filemenu, click Save.

About 4-4 Vendors (Accounts Payable)
Vendor records provide quick access to vendor information for payable invoices, 1099 balances, orderingmaterials, and
subcontract management. Create a vendor record for each business that sends you invoices and each business to which
you owemoney or make regular payments. These vendors may include subcontractors, architects, engineers, and lenders.

In the 4-4 Vendors (Accounts Payable) window, you can review vendor-related information such as subcontracts,
purchase orders, and invoices. You can also record any additional certificates a vendor is required to supply.

You would select the Internal Vendor check box to keep track someone you need in the vendor database, but not
someone from whom you get invoices. Flagging a vendor as “internal” cause the program to display amessage if you try to
enter a payable invoice for that vendor.

Examples of internal vendors are architects, engineers, or other professionals who are involved with projects that you work
on, but you are not the one contracting with them because you are not the general contractor or owner. Youmight, however,
want to keep that information in the job record.

Internal vendors may also be fictitious entities, such as a generic lumber supply or generic tile subcontractor. Youmight
want to use that entity for putting a “type” of vendor on parts for estimating and bid request reasons.

Entering vendor records
Consider these points before entering vendor records:
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l Be sure to enter all the important information regarding vendors. Entries made in the 4-4 Vendors (Accounts
Payable)window are used for other functions, such as fax and email scheduling.

l Some states levy a use tax on out-of-state purchases. You can enter the use tax rate in the 'Use Tax' Rate text box.

l In some states, subcontractors are not required to carry Workers’ Compensation insurance. The general contractor
often covers the liability of the subcontractor through the general contractor’s policy. You can enter the general
contractor’s rate in theWork Comp Rate text box.

l Select the Internal Vendor check box tomark the vendor as an internal supplier, which only affects vendor reports.

l Select theSeparate check for each invoice check box to tell the system to print separate checks for each invoice
for each vendor.

IMPORTANT: Sage 100 Contractor uses information entered in the 3-6 Receivable Clientswindow and 4-4
Vendors (Accounts Payable)window for other functions such as scheduling and sending faxes and email
messages. If fax numbers and email addresses for vendors are not entered in these windows, then client and vendor
contacts do not appear on the fax and email distribution lists.

To enter a vendor:
1 Open 4-4 Vendors (Accounts Payable).

2 In the data control text box, enter the vendor number.

3 In theVendor Name text box, enter the full vendor name.

4 In theShort Name text box, enter a brief name for the vendor.

5 In theVendor Type list, click the vendor type.

6 In theGeneral Information tab, do the following:

a In theOwner text box, enter the name of the person to contact at the vendor’s office.

b In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

c In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

d In theMinority Type list, click the type of minority if applicable.

e In the Tax District text box, enter the sales tax district number.

7 In the Financial Information tab, do the following:

f In the Federal Id# text box, enter the vendor’s Federal Identification Number.

g In theState Id# text box, enter the vendor’s State Identification number.

h In theAccount# text box, enter your account number the vendor uses to identify your company.

i In the License# text box, enter the contractor’s license number.

j In theResale# text box, enter the vendor’s resale number.

k In the 1099 Type list, click the 1099 status.

8 As necessary, select the Internal Vendor check box.

9 Click the Invoice Defaults tab, then do the following:

a In theDue Terms text box, enter the cycle for the date when the invoice is due.

b In theDiscount Terms text box, enter the cycle for the date by which the vendor must receive payment for the
discount to apply.

c In theDiscount Rate text box, enter the discount rate.
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d In the 'Use Tax' Rate text box, enter the use tax rate.

e In theWork Comp Rate text box, enter the workers' compensation rate.

f In the Ledger Account text box, enter the ledger account to which you want to post.

g In theCost Code text box, enter the default cost code.

h In theCost Type list, click the default cost type to assign.

i In the Invoice Status list, click the status to assign an invoice or credit.

j In thePO Warning list, click the warning status you want to assign to the vendor.

k If you need to send a separate check for each invoice, select theSeparate check for each invoice check box.

l If you want to automatically put the vendor's invoices on the Hot List, select thePut on the Hot List check box.

m If you want to allow duplicate invoice numbers, select theAllow duplicate invoice numbers check box.

10Click theOther Defaults tab, then do the following:

a In theRFP Type list, click the type of RFP you often create for the vendor.

b In theDescription text box, enter the default description for RFPs.

c In thePurchase Order Type list, click the type of order you often create for the vendor.

d In theDescription text box, enter a brief statement about the purchase order.

e In theSubcontract Type list, click the type of subcontract you often create for the vendor.

f In theDescription text box, enter a brief statement about the subcontract.

11 Click theACH Payment Setup tab, then do the following:

a Select theEnable ACH payment box.

b In the ACH Account Status, select one of the following statuses:

i 0—None

ii 1—Prenote

iii 2—10 day wait

iv 3—Active

v 4—Inactive

c In the Account Type, select one of the following account types:

i 1—Checking

ii 2—Savings

d In theRouting# text box, enter your vendor’s bank routing number.

e In theBank Account# text box, enter the vendor's bank account number.

f In theEmail Receipt to text box, enter the email address to receive the ACHpayment receipt.

12Click theContact grid, do the following:

a In theContact Name text box, enter the contact's name.

IMPORTANT: The first contact in the list is considered to be the primary contact in reports.

b In the Job Title text box, enter the contact's job title.
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c In thePhone# text box, enter the contact’s telephone number.

d In theExtension text box, enter the contact's telephone extension, as necessary.

e In theEmail text box, enter the contact's email address.

f In theCell# text box, enter the contact’s cellular number.

g In the Fax# text box, enter the contact’s fax number.

h In theOther# text box, enter the contact’s other telephone number.

i In theOther Description text box, enter the contact’s other telephone number description.

j In theNotes text box, enter any applicable notes about the contact.

13 Enter the vendor licenses and certificates.

14 On the Filemenu, click Save.

15 If you want to set the vendor's 1099 balance for the calendar year:

a Refresh the vendor record by clicking the back arrow button (next to the record number in the upper left-hand corner)
then clicking the forward arrow button advance to the new record again.

b Select Options >  1099 Balance Startup/Adjustment to open the 1099 Balance Startup/Adjustment window.

c Select the current date in theAdjustment Date box, and then type the vendor's starting 1099 balance in the 1099
Balance Startup/Adjustment box.

d Click [Save].

1099 Balance Startup and Adjustment
Use the 1099 Balance Startup and Adjustmentwindow to set or adjust the 1099 balance for the calendar year for a
selected vendor.

Sage 100 Contractor tracks vendor 1099 totals by calendar year. If you are transferring vendor totals from another software
package, use this window to add the previous 1099 total to the calendar year.

NOTE: If you have vendor voucher totals from a Sage 100 Contractor version prior to 19.2, Sage 100 Contractor adds
those totals to the 1099 balance automatically.

To make adjustments for your 1099 totals:
1 Open the 4-4 Vendors (Accounts Payable)window and select the vendor whose totals you want to adjust then click
Options >  1099Balance Startup/Adjustment.

2 In the 1099 Balance Startup/Adjustmentwindow, set the adjustment date by clicking in theAdjustment Date box and
typing the date in DD/MM/YYYY format.
Sage 100 Contractor tracks 1099 totals by calendar year. The 1099 balance displayed in theCurrent 1099 Balance For
Calendar Year box changes according to the date you enter.

3 Type the adjustment amount in the 1099 Balance Startup/Adjustment box. For example, if you know you paid the
selected vendor a $500 voucher earlier in the calendar year, but the 1099 total does not reflect it, type 500 in the 1099
Balance Startup/Adjustment box to add it.
TheResulting1099 Balance box displays the new 1099 balance.

4 Click [Save] to close the window and save your changes.

5 Repeat steps 1-5 for any other vendors whose 1099 totals you want to adjust.
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Update or Delete 1099 Adjustments by Date

When you upgrade from a version earlier than 19.2, Sage 100 Contractor may need tomake adjustments to 1099 starting
balances to adapt your existing data for multi-year functionality in the new version.

Occasionally, these automatic adjustments can be assigned to the wrong fiscal year, or they may duplicate existing
adjustments (made if you reset 1099 starting balances before upgrading, for example). In such cases, you need to use the
Update or Delete 1099 Adjustments by Datewindow to reassign the dates or to remove all adjustments that were
created for a specific date by the upgrade process.

You open theUpdate or Delete 1099 Adjustments by Datewindow by clicking theUpdate or delete existing
adjustments link on the 1099 Balance Startup/Adjustmentwindow.

NOTE: Youmust be logged in as Supervisor to view the Update or Delete 1099 Adjustments by Date link and to
modify these adjustments.

To change the date of existing adjustments:
1 In theUpdate or Delete 1099 Adjustments by Datewindow, in the Date of existing adjustments box, specify the
date assigned to the adjustments you want to change. All existing 1099 adjustments that have the date you specify will
be assigned the new date that you specify in the next step.

TIP: To check the dates of existing adjustments, click View all existing adjustments.

2 In theNew date to assign to adjustments box, type the date you want to assign to the adjustments.

NOTE: Youmust enter dates in both date fields.

3 Click [Update] to assign the new date.

4 Click Yes at themessage asking you to confirm the changes.
To remove all existing adjustments for a specific date:
1 In theUpdate or Delete 1099 Adjustments by Datewindow, in the Date of existing adjustments box, specify the
date assigned to the adjustments you want to delete. All existing 1099 adjustments that have the date you specify will be
removed for all vendors.

TIP: To check the dates of existing adjustments, click View all existing adjustments.

2 Click [Delete] to remove all the adjustments for the specified date.

3 Click Yes at themessage asking you to confirm the deletions.

About vendor payment reports

1099 Balance Startup and Adjustment
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About vendor financial information

Box What it does

1099 Type

Indicates the type of 1099 status.

l 0—Undetermined

l 1—Miscellaneous

l 2—Rent

l 3—Sole Proprietor

l 4—Interest

l 5—No 1099

Beginning
Balance

Displays the beginning balance of outstanding invoices for
your current books. You cannot enter or edit an amount in
this box.

Current
Balance

Displays the current books' total balance for outstanding
invoices to date. You cannot enter or edit an amount in this
box.

About vendor invoice defaults
The information you provide on the Invoice Defaults tab helps Sage 100 Contractor post an invoice and create the job cost
records.

Default What it does

Due Terms

Determines the date by which payment is due.

In Sage 100 Contractor, you can base the frequency of the cycle on days, months, or a specific day of the
month. Billing, transaction, invoice, and other cycles are represented by these symbols: ##DY, ##MO, and
##TH.

Following are some examples that explain what the symbols represent.

l ##DY—30DY means due 30 days from the date of the invoice.

l ##MO—02MOmeans due twomonths from the date of the invoice.

l ##TH—25TH means due on the 25th day of eachmonth regardless of the date of the invoice.

Discount
Terms Determines the date by which payment is due for your business to receive a discount.

Discount
Rate Determines the discount rate for early payment.

Use Tax
Rate Determines the use tax on out-of-state purchases.
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Default What it does

Work
CompRate

Sets up the vendor record of a subcontractor with the employer’s compensation rate. When entering the
payable invoice, you can charge the subcontractor for coverage based on the invoiced amount. The charge
appears as a credit on the subcontractor’s invoice.

Ledger
Account

Determines the default ledger account to which invoices are posted. For amaterials supplier, for example,
enter thematerials expense account number. When you enter a payable invoice, thematerial expense
account defaults to the grid.

Some vendors may not post to one account regularly. If there is not a common account used by a vendor,
leave the Ledger Account box blank.

Cost Code

Determines the cost code to which you post the vendor. Because cost codes may vary each time you post
a record, consider leaving theCost Code box blank.

Alternately, you can enter the lowest numbered cost code used by the vendor. You can then use the
Lookupwindow to display cost codes starting in the appropriate area.

Cost Type Determines the cost type to which you post the vendor. Usually the cost type corresponds to the ledger
account.

Invoice
Status

If you want to review all invoices or payments for a vendor, assign the vendor record Invoice status 2-
Review. Otherwise, Sage 100 Contractor assigns status 1-Open.

Purchase
Order
Warning

Restricts the ability to save payable invoices.

Allow
Duplicate
Invoice
Number

Lets you enter duplicate invoice numbers for a vendor.

The Invoice Number text box in thePayable Invoiceswindow can be set up to require a unique invoice
number. TheAllow Duplicate Invoice Number check box lets you supersede the requirement for a unique
invoice number for specific vendors such as the phone company.

Separate
check for
each
invoice

Tells the system to print separate checks for each invoice for each vendor.

Put on the
Hot List Automatically puts the vendor's invoices on the Hot List.

About other vendor defaults
The information you provide on theOther Defaults tab helps Sage 100 Contractor create or export records.

Default What it does

Purchase
Order Type

Determines the type of purchase order you normally
create for the vendor.

Subcontract
Type

Determines the type of subcontract you normally create
for the vendor.
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About purchase order warnings
When saving a payable invoice for a vendor, Sage 100 Contractor refers to the selectionmade in thePurchase Order
Warning list in the vendor’s record. If the payable invoice does not meet the criteria, Sage 100 Contractor provides you
with a warning. These warnings are set on the Invoice Defaults tab of 4-4 Vendors and warn if there is no PO available for
the invoice or you can require a PO for the invoice.

Status Description

0-None Provides no warning.

1-Warn if no
PO

Provides a warning if the invoice does not contain a purchase order number, but allows you to save the
invoice.

2-Require PO Requires a purchase order number to save the invoice.

Vendor Invoice Over Purchase Order settings

TheSet Over PO Warning option in 4-4 Vendors notifies you if the invoice quantity amount exceeds the purchase order.
When you select theSet Over PO Warning option in the Options menu, Sage 100 Contractor compares the invoice total
amount (not including sales tax) against the total PO balance. The Vendor Invoice Over PurchaseOrder warning settings
supersedes the settings for Invoice Over PurchaseOrder warning settings in 4-2. How?

Setting up vendor types
You can use vendor types to group or categorize vendors. Types give you the ability to select specific vendors when
printing bid requests, vendor lists, or other vendor related documents.

If you create a long list of vendor types, you can simplify it by abbreviating vendor categories. For example, useM for
material suppliers andS for subcontractors in the Type Name. For example, the description for a lumber supplier is M-
Lumber, and an electrical supplier is S-Electrical.

To set up vendor types:

1. Open 4-4 Vendors (Accounts Payable).

2. Next to theVendor Type list, click the detail button.

3. TheVendor Typewindow opens.

4. In theVendor Type# text box, enter the type number.

5. In the Type Name text box, enter a description of the vendor type.

6. Repeat steps 3–5 for each type.

7. On the Filemenu, click Save.

About vendor certificates and expiration dates
You can track the expiration dates forWorkers’ Compensation, liability insurance, contractor’s licenses, and other required
certificates and licenses. When you enter a certificate or license, always enter an expiration date. If you do not have a date,
enter one that is obviously expired such as 01/01/1980. Later, you can determine which vendors have insurance or licenses
that have expired.

IMPORTANT: The 4-1-5-31 Vendor Worker's Comp Report requires that theWorkers’ Compensation insurance
certificate information be in Row 1 of theCertificateswindow grid.
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You can control whether you receive a warning that a certificate has expired when creating a subcontract. You can also
stop payment to a vendor if a certificate has expired.

When selecting vendor invoices for payment, you can exclude vendors with expired licenses. You can also print
documents that you can send to vendors with expired licenses, requesting the new expiration dates to update your records.
When you do not need dates for vendors such as lending institutions, leave the text boxes blank.

Reports on vendor certificates and expiration dates

You can run insurance reports to view which vendors have current and/or expired certificates. How?

l 4-1-1-41 Insurance Report

l 4-1-1-42 Insurance Report~by Vendor Type

l 4-1-1-43 Insurance Report~Alpha

l 4-1-1-46 Insurance Report~with Notes

l 4-1-1-47 Insurance Report~by Vendor Type; with Notes

l 4-1-1-48 Insurance Report~Alpha; with Notes

Entering vendor certificates
In theCertificateswindow, you can create a list of the certificates a vendor must supply. For example, youmight list the
Workers’ Compensation insurance certificate, liability insurance certificate, contractor’s license, and hazardous materials
certificate.

Because you can generate expired certificate reports based on a specific line number, consider entering the certificates in a
specific order for each vendor. For example, Row 1 is theWorkers’ Compensation insurance certificate, Row 2 is the
liability insurance certificate, and Row 3 is the contractor’s license.

IMPORTANT: The 4-1-5-31 Vendor Worker's Comp Report requires that theWorkers’ Compensation insurance
certificate information be in Row 1 of theCertificateswindow grid. To verify that Workers’ Compensation insurance
certificate information is in Row 1, follow this procedure to view the information in theCertificateswindow.

To enter vendor certificates:
1 Open 4-4 Vendors, and display the vendor.

2 On theOptionsmenu, click Certificates.

3 In theDescription text box, enter a brief statement about the certificate.

a For example, typeWorkers’ Compensation.

4 In theReceived text box, enter the date you received the certificate.

5 In theExpires text box, enter the date when the certificate has expired.

6 In theWarning text box, type Y if you want to receive a warning. Type N if you do not want to receive a warning even
though the certificate has expired.

7 TheWarning column lets you control whether you receive a warning when creating a subcontract for a vendor with an
expired certificate. Youmust select Exclude Vendors with Overdue Certificates orWarn on Vendors with Overdue
Certificates in the 4-3 Vendor Paymentswindow. To activate these options, click theSelection button in 4-3 Vendor
Payments.

8 In theStop Pay text box, type Y to stop payments to the vendor when the certificate expires. Type N if you want to pay
the vendor even though the certificate has expired.
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9 TheStop Pay column lets you control payments to the vendor by accessing the Invoice Selectionwindow from the 4-3
Vendor Paymentswindow. In the Invoice Selectionwindow, youmust also select Exclude Vendors with Overdue
Certificates in order to exclude those vendors whomeet the expiration criteria from receiving payment. It does not affect
payments through the 1-1 Checks/Bank Chargeswindow.

10 Repeat steps 3–7 for each certificate.

11 On the Filemenu, click Save.

Setting up vendor remittance
On occasion, it is necessary to substitute a different name on a vendor check. In theVendor Remitwindow, you can add
more lines to the grid by clicking in the last cell in the last row and pressing the Enter key.

When you print the vendor checks, Sage 100 Contractor looks to the vendor remit table. If the vendor appears in the table,
Sage 100 Contractor uses the payee information from the table in place of the information from the vendor record.

To set up vendor remittance:
1 Open 4-4 Vendors (Accounts Payable).

2 On theOptionsmenu, click Vendor Remit.

3 TheVendor Remit Informationwindow opens.

4 In theVendor cell, enter the vendor number.

5 In thePayee Remit cell, enter the payee’s name.

6 In theAddress 1 cell, enter the payee’s address.

7 In theAddress 2 cell, enter any remainder of the payee’s address, if necessary.

8 In theCity/State cell, enter the payee’s city and state.

9 In the Zip cell, enter the payee’s ZIP Code.

10 Repeat steps 3–9 for each vendor you want to include.

11 On the Filemenu, click Save.

Deleting vendors
If a vendor has current year ledger activity or open invoices from a prior year, you cannot delete that vendor.

CAUTION: When you delete a vendor, all prior year, paid, or void invoices related to that vendor are also deleted.
This can affect invoices associated with current jobs. In addition, because the vendor has been deleted, only the
vendor number will appear in job cost records.

To delete a vendor:
1 Open 4-4 Vendors (Accounts Payable).

2 Using the data control, select the record.

3 On theEditmenu, click Delete Vendor.

About vendor documents
4-1-6 Vendor Documents prints documents designed in 13-5 Form/Report Page Design for vendors. The type of vendor
documents created can include transmittal forms, form letters, contracts, and proposal forms. When designing a vendor
document, you canmerge information from the vendor files. Save the vendor documents using the *.docs_vendor file name
extension.
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Setting up Workers Compensation rates for payable invoices
Some states do not require subcontractors to carry Workers’ Compensation insurance. In these states, the subcontractors
use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of
coverage from payments to the subcontractor. Check with your state for compliance requirements as the laws vary in each
state.

Sage 100 Contractor uses theWorkers’ Compensation account indicated on thePayables tab in theGeneral Ledger
Setupwindow to post payable invoice transactions.

To set up a Workers’ Compensation rate for payable invoices:
1 Open 4-4 Vendors (Accounts Payable).

2 Using the data control, select the vendor.

3 Click the Invoice Defaults tab.

4 In theWork Comp Rate box, enter the rate at which you are charging the subcontractor.

5 On the Filemenu, click Save.

6 Open 1-8 General Ledger Setup.

7 On thePayables tab, enter the ledger account to which you are posting the charge to subcontractors in theWorkers’
Compensation box.

8 On the Filemenu, click Save.

TIP: The credit does not appear on theWorkers’ Compensation report, which only uses data from payroll records. To
track and report the costs, create a separateWorkers’ Compensation ledger account.

Setting up use taxes for payable invoices
Some states levy a use tax on out-of-state purchases.

To set up use tax for a payable invoice:
1 Open 4-4 Vendors (Accounts Payable).

2 Using the data control, select the vendor.

3 Click the Invoice Defaults tab.

4 In theUse Tax Rate text box, enter the use tax rate.

5 On the Filemenu, click Save.

6 Open 1-8 General Ledger Setup.

7 On theReceivables tab, enter the ledger account to which you are posting sales tax.

8 On the Filemenu, click Save.

Secondary Payees
TheSecondary Payeeswindow provides a way to add secondary payees to invoices. Secondary payees aremost often
involved with subcontractor invoices because they have sub-vendor suppliers who have lien rights to the project. It is
critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.
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There are several ways to enter the secondary payees. You can do so when you enter a new subcontractor’s invoice in the
4-2 Payable Invoices/Creditswindow by entering the name and amount payable to each supplier in theSecondary
Payeeswindow. You can also add one or more secondary payees to existing vendor invoices.

You will notice upon looking at theSecondary Payeeswindow that it has threemain parts: the grid, the vendor line, and the
totals line.

Grid Columns Description

Secondary Payee The name for the second party that will appear on the two-party check.

Amount The total amount that should be paid on two-party checks to the payee.

Paid The total amount of payment made to this payee. This column is not editable.

Balance TheAmountminus thePaid as calculated by Sage 100 Contractor. This column is not editable.

To Pay The amount scheduled for a two-party check. This column allows you to enter or edit the amount.

The vendor line appears under the grid. The information in the vendor line reflects information related to the grid columns for
the vendor on the invoice.

Vendor Line Description

Vendor Name Displays the vendor name and the invoice information that applies directly to the vendor.

Amount The amount is reduced as entry is made in theAmount column in the grid. In other words, the vendor
receives whatever funds remain after the secondary payee(s) are paid.

Paid The total amount of payment that has beenmade directly to the vendor.

Balance TheAmountminus thePaid. It is likewise adjusted whenever theAmount on this line changes.

To Pay The amount scheduled for payment directly to the vendor. This text box allows you to enter or edit the
amount.

The totals line appears under the double line and reflects the entire invoice. The To Pay total reflects the sum of all To Pay
amounts on this window. Upon saving it is sent back to its corresponding field at the bottom of the 4-2 Payable
Invoices/Creditswindow.

Retention values are not reflected on this window. Retention that is entered on 4-2 Payable Invoices/Credits is held
against the vendor’s balance. You cannot hold a portion of the invoice retention against a secondary payee. However, you
can pay 90% on one check and the remaining 10% on a later check.

Discounts are not reflected on this screen. They are applied against the vendor’s balance. You cannot apply a portion of the
invoice’s discount against the balance of a secondary payee.

After saving the information in theSecondary Payeeswindow and subsequently the 4-2 Payable Invoices/Credits
window, the next logical step could be to print and post the checks using the 4-3 Vendor Paymentswindow. You will
notice that the single invoice appears in the grid as multiple lines with the second payee lines directly under the vendor's
portion. When you sort the grid, these lines stay together.

Here is an example. Suppose you subcontracted the electrical work on the construction of a home. Upon completion of the
job, the subcontractor sends an $8,500 invoice, the amount of the contract. The invoice lists three suppliers and the
associated costs: a materials supplier—$2,000; a lighting supplier—$1,500; and an equipment supplier for a backhoe to
perform ground work—$300. To ensure that each of the subcontractor’s suppliers is paid, you can print a two-party check
for each supplier.
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When you print checks from the 4-3 Vendor Paymentswindow, Sage 100 Contractor prints four checks based on the
amounts in theSecondary Payeeswindow. A check to the subcontractor andmaterials supplier for $2,000; a check to the
subcontractor and lighting supplier for $1,500; a check to the subcontractor and equipment supplier for $300; and a check to
the subcontractor for $4,700, which is the vendor’s portion that is not attributed to a second payee.

NOTES:
l No information on theSecondary Payeeswindow may be edited when the invoice has a status of 4-Paid or 5-

Void.

l You can addmultiple additional secondary payees to an invoice.

l You can change amounts to be paid to secondary payees as long as no payment has beenmade.

l You can change the name of the secondary payee as long as no payments have beenmade.

l You can remove secondary payees as long as no payments have beenmade.

Entering payable invoices that include secondary payees
In your contracting work, you receive a payable invoice from a new vendor for their work. Part of the invoice is to be paid as
a two-party check to one of their suppliers. Use the following procedure to handle this situation.

NOTES:
l Youmust manually click theWk/Comp button and theUse Tax button in order for the record to calculate the

vendor's workers' compensation rate and use tax rate. You can set up the use tax rate and the compensation
rate on the Invoice Default tab of 4-4 Vendors (Accounts Payable).

l Payable invoice status can be: 1-Open, 2-Review, 3-Dispute, 4-Paid, or 5-Void.

l Payable invoices can have two different types: 1-Contract and 2-Memo.

l Payable invoices can be saved as: Save, Save/Set To Pay, andSave/Autocost.

l If you enter an invoice using information from a purchase order, the sales tax will automatically default into the
invoice. You can choose to deactivate the automatic sales tax feature and to enter the sales tax manually.

To enter a payable invoice that includes a secondary payee
1 Open 4-2 Payable Invoices/Credits.

2 Do the following:

a In the Invoice# box, enter the invoice number.

b If the invoice is for a purchase order, in theOrder# box enter the purchase order number.

c If the invoice is for a subcontract, in theContract# box enter the subcontract number. You can turn on an option to
verify the contract balance against the invoice.

d In theVendor box, enter the vendor number.

e In the Job box, enter the job number.

f If the job uses phases, enter the phase number in thePhase box.

g In theDescription box, enter a description.

h In the Invoice Date box, enter the date of the invoice.

i In theDue Date box, enter the invoice due date.

j In theDiscount Date box, enter the discount due date. This is the last day by which the vendor can receive payment
for you to receive a discount.
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k In theShipping# box, enter the shipping tag or ticket number.

l In theReference# box, enter an invoice or credit number to apply this entry to.

m In theStatus list, click the invoice status.

n In the Type list, click the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In thePrice cell, enter the price per unit.

c In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 Below the grid, in theDiscount box, enter the discount for early payment. By default, Sage 100 Contractor calculates the
discount amount using the rate from the vendor record.

6 In theRetention box, enter the amount of retention. By default, Sage 100 Contractor calculates the retention (if
applicable) using the rate from the subcontract, which is found on 6-7-1 Subcontracts.

7 Click theSecondary Payees button. TheSecondary Payeeswindow opens.

8 In theSecond Payee column, enter the name of the secondary payee.

9 In theAmount column, enter the amount payable to the secondary payee.

10 Click theSave toolbar button, which saves your entries and closes the window.

11 When consideringWorkers’ Compensation rates and use tax:

p If the vendor is set up with aWorkers’ Compensation rate, and you want it to be calculated with this record, click the
Wk/Comp button.

p If the vendor is set up with a use tax rate and you want it to be calculated with this record, click theUse Tax button.

IMPORTANT: You have tomanually click theWk/Comp button and theUse Tax button in order for the record to
calculate the vendor's Workers' Compensation rate and use tax rate. You can set up the use tax rate and theWorkers'
Compensation rate on the Invoice Details tab of 4-4 Vendors (Accounts Payable).

12 In 4-2 Payable Invoices/Credits, click Save.

Adding secondary payees to existing payable invoices

NOTE: You can add secondary payees as long as the amount does not cause the vendor’s balance to become
negative.

In your contracting work, you receive and enter a payable invoice from a existing vendor for subcontract work. You enter
and save the invoice, which exists in your database with a record number. Subsequently the contractor informs you that a
portion of that invoice should be paid as a two-party check to one of the vendor’s suppliers. Use the following procedure to
handle this situation.
To add a secondary payee to an existing payable invoice
1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, locate and open the existing invoice.

3 Click theSecondary Payees button. TheSecondary Payeeswindow opens.

4 In theSecond Payee column, enter the name of the secondary payee.

5 In theAmount column, enter the amount to be paid to the secondary payee.
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6 Click theSave toolbar button, which saves your entries and closes the window.

7 In the 4-2 Payable Invoices/Creditswindow, click Save.

Increasing amounts payable to second payees

IMPORTANT: You can increase the amount payable to secondary payees as long as the amount does not cause the
vendor’s balance to become negative.

In your contracting work, you enter and save a payable invoice from a vendor for their work. The invoice is to be paid with
one check going to the vendor in addition to a two-party check going to one of their suppliers. The vendor requests that you
increase the amount of the two-party check. Use the following procedure to handle this scenario.
To increase the amount payable to a second payee
1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, locate and open the existing invoice.

3 Click theSecondary Payees button.

4 TheSecondary Payeeswindow opens.

5 In theAmount column, increase the payable amount.

6 Click theSave button.

7 Open 4-3 Vendor Payments to print and post the checks.

Decreasing amounts payable to secondary payees

IMPORTANT: The amount to be paid to secondary payees cannot be decreased to less than the amount already
paid.

In your contracting work, you enter and save a payable invoice from a vendor for their work. The invoice is to be paid with
one check going to the vendor in addition to a two-party check going to one of their suppliers. The vendor requests that you
decrease the amount of the two-party check. Use the following procedure to handle this situation.
To decrease the amount payable to a second payee
1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, locate and open the existing invoice.

3 Click theSecondary Payee button.

4 TheSecondary Payeewindow opens.

5 In theAmount column, decrease the payable amount.

6 Click theSave button.

7 Open 4-3 Vendor Payments to print and post the checks.

About secondary payees

TheSecondary Payeeswindow provides a way to add secondary payees to invoices. Secondary payees aremost often
involved with subcontractor invoices because they have sub-vendor suppliers who have lien rights to the project. It is
critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.

There are several ways to enter the secondary payees. You can do so when you enter a new subcontractor’s invoice in the
4-2 Payable Invoices/Creditswindow by entering the name and amount payable to each supplier in theSecondary
Payeeswindow. You can also add one or more secondary payees to existing vendor invoices.
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You will notice upon looking at theSecondary Payeeswindow that it has threemain parts: the grid, the vendor line, and the
totals line.

Grid Columns Description

Secondary Payee The name for the second party that will appear on the two-party check.

Amount The total amount that should be paid on two-party checks to the payee.

Paid The total amount of payment made to this payee. This column is not editable.

Balance TheAmountminus thePaid as calculated by Sage 100 Contractor. This column is not editable.

To Pay The amount scheduled for a two-party check. This column allows you to enter or edit the amount.

The vendor line appears under the grid. The information in the vendor line reflects information related to the grid columns for
the vendor on the invoice.

Vendor
Line Description

Vendor
Name Displays the vendor name and the invoice information that applies directly to the vendor.

Amount The amount is reduced as entry is made in theAmount column in the grid. In other words, the vendor receives
whatever funds remain after the secondary payee(s) are paid.

Paid The total amount of payment that has beenmade directly to the vendor.

Balance TheAmountminus thePaid. It is likewise adjusted whenever theAmount on this line changes.

To Pay The amount scheduled for payment directly to the vendor. This text box allows you to enter or edit the amount.

The totals line appears under the double line and reflects the entire invoice. The To Pay total reflects the sum of all To Pay
amounts on this window. Upon saving it is sent back to its corresponding field at the bottom of the 4-2 Payable
Invoices/Creditswindow.

Retention values are not reflected on this window. Retention that is entered on 4-2 Payable Invoices/Credits is held
against the vendor’s balance. You cannot hold a portion of the invoice retention against a secondary payee; however, you
can pay 90% on one check and the remaining 10% on a later check.

Discounts are not reflected on this screen. They are applied against the vendor’s balance. You cannot apply a portion of the
invoice’s discount against the balance of a secondary payee.

After saving the information in theSecondary Payeeswindow and subsequently the 4-2 Payable Invoices/Credits
window, the next logical step could be to print and post the checks using the 4-3 Vendor Paymentswindow. You will
notice that the single invoice appears in the grid as multiple lines with the second payee lines directly under the vendor's
portion. When you sort the grid, these lines stay together.

Here is an example. Suppose you subcontracted the electrical work on the construction of a home. Upon completion of the
job, the subcontractor sends an $8,500 invoice, the amount of the contract. The invoice lists three suppliers and the
associated costs: a materials supplier—$2,000; a lighting supplier—$1,500; and an equipment supplier for a backhoe to
perform ground work—$300. To ensure that each of the subcontractor’s suppliers is paid, you can print a two-party check
for each supplier.

When you print checks from the 4-3 Vendor Paymentswindow, Sage 100 Contractor prints four checks based on the
amounts in theSecondary Payeeswindow. A check to the subcontractor andmaterials supplier for $2,000; a check to the
subcontractor and lighting supplier for $1,500; a check to the subcontractor and equipment supplier for $300; and a check to
the subcontractor for $4,700, which is the vendor’s portion that is not attributed to a second payee.
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In additional, consider the following points:

l No information on theSecondary Payeeswindow may be edited when the invoice has a status of 4-Paid or 5-Void.

l You can addmultiple additional secondary payees to an invoice.

l You can change amounts to be paid to secondary payees as long as no payment has beenmade.

l You can change the name of the secondary payee as long as no payments have beenmade.

l You can remove secondary payees as long as no payments have beenmade.

Entering payable invoices that include secondary payees

In your contracting work, you receive a payable invoice from a new vendor for their work. Part of the invoice is to be paid as
a two-party check to one of their suppliers. Use the following procedure to handle this situation.

NOTES:
l Youmust manually click theWk/Comp button and theUse Tax button in order for the record to calculate the

vendor's workers' compensation rate and use tax rate. You can set up the use tax rate and the compensation
rate on the Invoice Default tab of 4-4 Vendors (Accounts Payable).

l Payable invoice status can be: 1-Open, 2-Review, 3-Dispute, 4-Paid, or 5-Void.

l Payable invoices can have two different types: 1-Contract and 2-Memo.

l Payable invoices can be saved as: Save, Save/Set To Pay, andSave/Autocost.

l If you enter an invoice using information from a purchase order, the sales tax will automatically default into the
invoice. You can choose to deactivate the automatic sales tax feature and to enter the sales tax manually.

To enter a payable invoice that includes a secondary payee:

1 Open 4-2 Payable Invoices/Credits.

2 Do the following:

a In the Invoice# box, enter the invoice number.

b If the invoice is for a purchase order, in theOrder# box enter the purchase order number.

c If the invoice is for a subcontract, in theContract# box enter the subcontract number. You can turn on an option to
verify the contract balance against the invoice.

d In theVendor box, enter the vendor number.

e In the Job box, enter the job number.

f If the job uses phases, enter the phase number in thePhase box.

g In theDescription box, enter a description.

h In the Invoice Date box, enter the date of the invoice.

i In theDue Date box, enter the invoice due date.

j In theDiscount Date box, enter the discount due date. This is the last day by which the vendor can receive payment
for you to receive a discount.

k In theShipping# box, enter the shipping tag or ticket number.

l In theReference# box, enter an invoice or credit number to apply this entry to.

m In theStatus list, click the invoice status.

n In the Type list, click the invoice type.



- 233 -

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In thePrice cell, enter the price per unit.

c In theAccount cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 Below the grid, in theDiscount box, enter the discount for early payment. By default, Sage 100 Contractor calculates the
discount amount using the rate from the vendor record.

6 In theRetention box, enter the amount of retention. By default, Sage 100 Contractor calculates the retention (if
applicable) using the rate from the subcontract, which is found on 6-7-1 Subcontracts.

7 Click theSecondary Payees button. TheSecondary Payeeswindow opens.

8 In theSecond Payee column, enter the name of the secondary payee.

9 In theAmount column, enter the amount payable to the secondary payee.

10 Click theSave toolbar button, which saves your entries and closes the window.

11 When consideringWorkers’ Compensation rates and use tax:

a If the vendor is set up with aWorkers’ Compensation rate, and you want it to be calculated with this record, click the
Wk/Comp button.

b If the vendor is set up with a use tax rate and you want it to be calculated with this record, click theUse Tax button.

IMPORTANT: You have tomanually click theWk/Comp button and theUse Tax button in order for the record to
calculate the vendor's Workers' Compensation rate and use tax rate. You can set up the use tax rate and theWorkers'
Compensation rate on the Invoice Details tab of 4-4 Vendors (Accounts Payable).

12 In 4-2 Payable Invoices/Credits, click Save.

Adding secondary payees to existing payable invoices

NOTE: You can add secondary payees as long as the amount does not cause the vendor’s balance to become
negative.

In your contracting work, you receive and enter a payable invoice from a existing vendor for subcontract work. You enter
and save the invoice, which exists in your database with a record number. Subsequently the contractor informs you that a
portion of that invoice should be paid as a two-party check to one of the vendor’s suppliers. Use the following procedure to
handle this situation.

To add a secondary payee to an existing payable invoice:

1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, locate and open the existing invoice.

3 Click theSecondary Payees button. TheSecondary Payeeswindow opens.

4 In theSecond Payee column, enter the name of the secondary payee.

5 In theAmount column, enter the amount to be paid to the secondary payee.

6 Click theSave toolbar button, which saves your entries and closes the window.

7 In the 4-2 Payable Invoices/Creditswindow, click Save.

Increasing amounts payable to second payees

Important:
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You can increase the amount payable to secondary payees as long as the amount does not cause the vendor’s balance to
become negative.

In your contracting work, you enter and save a payable invoice from a vendor for their work. The invoice is to be paid with
one check going to the vendor in addition to a two-party check going to one of their suppliers. The vendor requests that you
increase the amount of the two-party check. Use the following procedure to handle this scenario.

To increase the amount payable to a second payee:

1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, locate and open the existing invoice.

3 Click theSecondary Payees button.

4 TheSecondary Payeeswindow opens.

5 In theAmount column, increase the payable amount.

6 Click theSave button.

7 Open 4-3 Vendor Payments to print and post the checks.

Decreasing amounts payable to secondary payees

IMPORTANT: The amount to be paid to secondary payees cannot be decreased to less than the amount already
paid.

In your contracting work, you enter and save a payable invoice from a vendor for their work. The invoice is to be paid with
one check going to the vendor in addition to a two-party check going to one of their suppliers. The vendor requests that you
decrease the amount of the two-party check. Use the following procedure to handle this situation.

To decrease the amount payable to a second payee:

1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, locate and open the existing invoice.

3 Click theSecondary Payee button.

4 TheSecondary Payeewindow opens.

5 In theAmount column, decrease the payable amount.

6 Click theSave button.

7 Open 4-3 Vendor Payments to print and post the checks.

Retention

About accounts payable retention
Many job subcontracts include retention. When you create a payable invoice, Sage 100 Contractor withholds retention at
the rate specified in the subcontract record. If you do not indicate a retention rate in the subcontract record, you can
withhold a flat amount on each individual invoice.

Posting a payable invoice declares the entire amount of the invoice as an expense. However, a percentage of the gross
amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net
invoice amount). Therefore, retention is already declared as an expense, but is not paid out yet. Consequently, Sage 100
Contractor does not include retention in the invoice aging.
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When you are ready to pay the subcontractor for retention, it is not necessary to create a new invoice. You can release
retention on each invoice individually, or you can release the retention for the entire subcontract at one time.

Paying retention on payable invoices
When you select thePay Retentions check box, Sage 100 Contractor includes retention in the invoice balances displayed
in theBalance column.
To pay retention on a payable invoice
1 Open 4-3-1 Select Invoices to Pay.

2 In the Invoice Selectionwindow, select the criteria for the invoices you want to pay.

3 UnderPay Options, select thePay Retentions check box.

4 Click OK.

5 In theSet to Pay text box, enter the amount you want to pay.

6 Or, select the invoice. Then on theOptionsmenu, click Pay.

7 Repeat step 6 for each invoice you want to pay.

8 On the Filemenu, click Save.

9 Print the vendor checks.

Releasing retention on payable invoices
To release retention on a payable invoice:
1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, select the invoice.

3 In theRetention text box, reduce or delete the retention.

4 On the Filemenu, click Save.

About accounts payable retention

Many job subcontracts include retention. When you create a payable invoice, Sage 100 Contractor withholds retention at
the rate specified in the subcontract record. If you do not indicate a retention rate in the subcontract record, you can
withhold a flat amount on each individual invoice.

Posting a payable invoice declares the entire amount of the invoice as an expense. However, a percentage of the gross
amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net
invoice amount). Therefore, retention is already declared as an expense but is not paid out yet. Consequently, Sage 100
Contractor does not include retention in the invoice aging.

When you are ready to pay the subcontractor for retention, it is not necessary to create a new invoice. You can release
retention on each invoice individually, or you can release the retention for the entire subcontract at one time.

Paying retention on payable invoices

When you select thePay Retentions check box, Sage 100 Contractor includes retention in the invoice balances displayed
in theBalance column.

To pay retention on a payable invoice:

1 Open 4-3 Vendor Payments.

2 On theOptionsmenu, click Invoice Selection.
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3 In theVendor Paymentwindow, select the criteria for the invoices you want to pay.

4 UnderPay Options, select thePay Retentions check box.

5 Click OK.

6 In theSet to Pay text box, enter the amount you want to pay.

7 Or, select the invoice. Then on theOptionsmenu, click Pay.

8 Repeat step 6 for each invoice you want to pay.

9 On the Filemenu, click Save.

10 Print the vendor checks.

Releasing retention on payable invoices

To release retention on a payable invoice:

1 Open 4-2 Payable Invoices/Credits.

2 Using the data control, select the invoice.

3 In theRetention text box, reduce or delete the retention.

4 On the Filemenu, click Save.

Batches
Batch numbers group together invoices that you enter in thePayable Invoiceswindow during a single session. To verify
the accuracy of the invoices entered, you can display a list of the invoices and compare the entered amounts against the
actual invoice amounts.

Sage 100 Contractor maintains a separate series of batch numbers for each user name.

When you open a payable invoice window, Sage 100 Contractor establishes the next batch number in your series by
determining the largest batch number last used and incrementing it by 1. Sage 100 Contractor assigns the batch number to
each new transaction you enter until the window is closed.

When entering a new record, you can change the batch number. For example, youmight want to include an invoice in a prior
batch. If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it
changes back to the new batch number.

After you save an invoice, you cannot change its batch number.

Changing batch numbers
If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it changes back
to the new batch number.
To change the batch number
1 Open 4-2 Payable Invoices/Credits.

2 In theBatch text box, enter the batch number you want to assign to the invoice.

Viewing batch lists for invoices being entered
To view the batch list for invoices being entered
1 Open 4-2 Payable Invoices/Credits.

2 On theOptionsmenu, click Batch List.
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Viewing prior batch lists
Consider the following points before viewing a prior batch list:

l Each user name has its own series of batch numbers. Sage 100 Contractor shows you the batch list for the user
namewith which you have logged on to Sage 100 Contractor.

l To view the batch list of another user, select an invoice from the batch you want to view. Then on theOptions
menu, click Batch List.

To view a prior batch list
1 Open 4-2 Payable Invoices/Credits.

2 In theBatch text box, enter the number of the batch you want to view.

3 On theOptionsmenu, click Batch List.

About batch totals

Batch numbers group together invoices that you enter in thePayable Invoiceswindow during a single session. To verify
the accuracy of the invoices entered, you can display a list of the invoices and compare the entered amounts against the
actual invoice amounts.

Sage 100 Contractor maintains a separate series of batch numbers for each user name.

When you open a payable invoice window, Sage 100 Contractor establishes the next batch number in your series by
determining the largest batch number last used and incrementing it by 1. Sage 100 Contractor assigns the batch number to
each new transaction you enter until the window is closed.

When entering a new record, you can change the batch number. For example, youmight want to include an invoice in a prior
batch. If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it
changes back to the new batch number.

After you save an invoice, you cannot change its batch number.

Changing batch numbers

If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it changes back
to the new batch number.

To change the batch number:

1 Open 4-2 Payable Invoices/Credits.

2 In theBatch text box, enter the batch number you want to assign to the invoice.

Viewing batch lists for invoices being entered

To view the batch list for invoices being entered:

1 Open 4-2 Payable Invoices/Credits.

2 On theOptionsmenu, click Batch List.

Viewing prior batch lists

Consider the following points before viewing a prior batch list:
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l Each user name has its own series of batch numbers. Sage 100 Contractor shows you the batch list for the user
namewith which you have logged on to Sage 100 Contractor.

l To view the batch list of another user, select an invoice from the batch you want to view. Then on theOptions
menu, click Batch List.

To view a prior batch list:

Open 4-2 Payable Invoices/Credits.

In theBatch text box, enter the number of the batch you want to view.

On theOptionsmenu, click Batch List.

About 4-5 Vendor 1099 Forms and eFiling by Aatrix
The 4-5 Vendor 1099 Forms and eFiling by Aatrixwindow is an integration portal into Aatrix. When youmove beyond
this window, for example, by clicking View History or Run Report, you are working in the Aatrix software that is integrated
into Sage 100 Contractor.
How does my business information in Sage 100 Contractor get into Aatrix forms?

When you select a report such as 2013 1099-MISC and the Year 2013 and then click Run Report, Sage 100 Contractor
searches its database for information relevant to that form and inserts it into the Aatrix form.

How do I know the forms are up to date?
Aatrix makes a strong point of keeping all its forms up to date. If Aatrix determines that you do not have the latest forms,
you see amessage window that provides four choices:

l Automatic Update: Update forms automatically over the Internet.

l Download Update: Update forms by manually downloading an update from any computer with an Internet
connection.

l Continue Expired: Continue processing without the required update. Forms will bemarked as expired and cannot
be filed.

l Cancel: Cancel without processing forms.

About Federal 1099forms
According to the IRS and Federal tax law, payments totaling $600 or moremade to independent contractors over the course
of the calendar year must be reported to the IRS. Sage 100 Contractor maintains balances for the 1099 reports regardless
of the 1099 status assigned to a vendor record. When you include the vendor number on a vendor check or general ledger
check, Sage 100 Contractor increases the 1099 balance for that vendor. If you later void the check, Sage 100 Contractor
decreases the 1099 balance by the check amount.

On the 1099 form, the name appearing at the top of thePayee text box must correspond to the identification number in the
Federal Id# text box. For sole proprietors, the federal government uses the owner’s social security number as the Federal
Identification Number. Therefore, the owner’s namemust appear above the business name on the 1099 form.

For vendors assigned status 3-Sole Proprietor, Sage 100 Contractor automatically prints the name from theOwner Name
text box in the vendor record above the company name on the 1099 form.
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About 1099types
You can locate the list of 1099 types on the 4-4 Vendors (Accounts Payable)window under Financial Information, in a
drop-down list with the title 1099.

NOTE: The 1099 is tracked by vendor and not by 1099 type.

1099 Type Description

0-
Undetermined No choice has beenmade.

1-
Miscellaneou
s

The vendor provides a service, but the vendor is not incorporated.

Sage 100 Contractor prints the vendor’s 1099 balance in box 7 of the 1099 form.

2-Rent
The vendor provides a service, but the vendor is not incorporated. Use this type only when the vendor
provides a service to your business by renting office space, yard space, equipment, and so on.

Sage 100 Contractor prints the vendor’s 1099 balance in box 1 of the 1099 form.

3-Sole
Proprietor

The vendor provides a service but the vendor is not incorporated.

Sage 100 Contractor prints the vendor’s 1099 balance in box 7 of the 1099 form.

4-Interest Sage 100 Contractor can print interest for this vendor.

5-No 1099
The vendor does not provide a service, or the vendor is incorporated.

Sage 100 Contractor does not print a 1099 for a vendor with this type.

NOTE: When the company has no workforce other than the owner, the federal government does not provide a federal
identification number to the company. Instead, use the owner’s social security number. For status 3-Sole Proprietor,
enter the owner’s social security number in the Federal Id# text box. In addition, enter the owner’s name in theOwner
text box. When you print the 1099, Sage 100 Contractor prints the social security number and the owner’s name on the
1099.

Verifying 1099 balances
Using one of twomethods, you can verify your 1099 balance at calendar year prior to processing 1099 forms:

n Verify the 1099 balance for each vendor using 4-4 Vendors (Accounts Payable) > Options > 1099 Balances. Verify
the 1099 balance and type assigned to each vendor. As a precaution, it is a good idea to confirm each vendor’s 1099
balances with the vendor. Print andmail to each vendor an individual journal detailing the payments you havemade to
that vendor over the calendar year.

n Print a 4-1-5 Vendor Payment Journal, which consists of the total payments to vendors over the course of the year,
and compare it to the 1099 Balances report. If a discrepancy exists, make corrections using the 1099 Balance Startup
and Adjustment window for the appropriate vendor record.



- 240 -

4-6 Recurring Payables

About recurring payables
In the 4-6 Recurring Payableswindow, you can set up recurring payable transactions. Only transactions that have a
consistent amount from invoice to invoice and post on a regular basis make good candidates for being set up as recurring
payables.

Sage 100 Contractor does not automatically post recurring payable transactions; you retain complete control of when to
post transactions. You can even set a reminder to prompt users in a specific security group when it is time to post the
recurring transactions.

Look at the posting date of a transaction to determine when to post the transaction. After posting a transaction, Sage 100
Contractor advances the posting date based on the transaction cycle. The transaction date does not control or affect the
period to which you are posting the transaction. If you need to post a recurring transaction to a different period, change the
posting period.

To prevent the possible duplication of invoice numbers, Sage 100 Contractor assigns a unique invoice number to each
recurring payable transaction. The invoice number is actually the combination of a record number and an invoice sequence
number.

For example, when you enter the first recurring payables record, Sage 100 Contractor assigns it invoice number
RP00010001 (RP—recurring payable, 0001—record number, 0001—invoice sequence number). Each time you post the
transaction, Sage 100 Contractor advances the invoice sequence number within the invoice number. The next invoice
number in the sequence becomes RR00010002.

Setting up recurring payable transactions in 4-6 Recurring Payables
When your cursor is in a text entry box, the status bar (located at bottom left corner of the window) displays
information about what to enter and how to enter it.

To set up a recurring payable transaction:
1 Open 4-6 Recurring Payables.

2 In the upper part of the window, do the following:

a In theVendor box, enter the vendor associated with this recurring payable transaction.

b In theDescription box, enter a brief statement about the transaction.

c In theNext Date text box, enter the next date when the transaction needs to post.

d In theCycle text box, enter the transaction cycle.

e In theDue Terms text box, enter the cycle for the date when the invoice is due.

f In theDiscount Terms text box, enter the cycle for the date by which the vendor must receive payment for the
discount to apply.

g In theStatus list, click the invoice status.

h In the Type list, click the invoice type.

3 In the grid, do the following:

a In theDescription cell, enter a brief statement about the line item.

b In theQuantity cell, enter the quantity purchased.

c In thePrice cell, enter the price per unit.
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d In theAccount cell, enter the ledger account.

4 On the Filemenu, click Save.

Posting single recurring transactions in 4-6 Recurring Payables

IMPORTANT: If you want to post to a different period, youmust change the posting period.

To post a single recurring transaction:
1 Open 4-6 Recurring Payables.

2 Select the transaction.

3 On thePostmenu, click This Invoice Only.

Posting groups of recurring transactions in 4-6 Recurring Payables
To post a group of transactions, use a cutoff date. Sage 100 Contractor posts all transactions through the indicated date.

IMPORTANT: If you want to post to a different period, youmust change the posting period.

To post a group of recurring transactions:
1 Open 4-6 Recurring Payables.

2 On thePostmenu, click Multiple Transactions.

3 ThePosting Cutoffwindow appears.

4 In theCutoff Date box, enter the cutoff date, and click OK.

4-7 Credit Card Management

About 4-7 Credit Card Management
Accounting for your business credit cards is now tightly integrated into your business accounting. Features include setting
up accounts, entering receipts, reconciling statements, and paying your credit card bills.

l 4-7-1 Add/Edit Issuer Accounts—Add credit card issuer accounts in your general ledger in theCurrent Liabilities
range of accounts. Return to this window to edit issuer account information. When you set up issuer accounts you
are prompted to add credit cards as subaccounts for the issuer accounts.

l 4-7-2 Add/Edit Credit Cards—Add credit cards as subaccounts of the card issuer account. You can add one card
or multiple cards to one issuer account. Return to this window to edit credit card information.

l 4-7-3 Enter Credit Card Receipts—Enter the data from hardcopy credit card receipts. You have a choice of
entering a vendor or not. If you enter a vendor, the program creates a paid accounts-payable invoice and a general
ledger transaction. If there is no vendor on the receipt, the program only creates a general ledger transaction.

l 4-7-4 Enter Recurring Charges—If you have charges with a constant recurring amount, enter them in this window.
This amount is charged to your credit card on a regular basis.

l 4-7-5 Reconcile Credit Card Statements—Verify credit card charges and payments. When you review your
statement, the program organizes the information for each credit card by issuer account and by credit card.
Payments are listed at the top of the grid. If there is a question about the charge or payment, you can click a link to
go to the transaction. The program also provides a way to add transactions “on-the-fly” right from this window.
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l 4-7-6 Pay Credit Cards—Sends credit card payment information through your general ledger accounting. Creates a
ledger transaction in 1-3 Journal Transactions. You can then print a check in 1-1 Checks/Bank Charges if you
use “0000” for the transaction number.

4-7-1 Add & Edit Issuer Accounts
Sage 100 Contractor credit cardmanagement begins by creating an issuer account for each entity that issues cards. For
example, banks issue credit cards such as Visa®, MasterCard®, and so forth. Youmay also have oil company credit cards
or store credit cards for your employees.

At the bottom of the 4-7-1 Add/Edit Issuer Accountswindow, there are two buttons, Add Card Issuer andEdit Card
Issuer.

TheAdd Card Issuer window provides a link that opens the Ledger Accountwindow in read-only mode so that you can
see which account number to enter. After you have chosen an appropriate general ledger account number, enter it in the
Issuer GL Account box to create the account.

When you enter the information to add an issuer account, the program creates a credit card issuer account in your general
ledger in theCurrent Liabilities range of accounts.

When you set up issuer account and click Save, you are prompted to add credit cards as subaccounts of the issuer
accounts.

Adding a new card issuer account can be done directly
in 4-7--1 Add/Edit Issuer Account > Add Card
Issuer. There is no need to use 1-7 General Ledger
Accounts.

Adding card issuer accounts
Before you can add a credit card to your accounting, you need to enter information for a credit card issuer account. Adding a
card issuer account creates a general ledger account for this credit card issuer.

NOTE: Adding a new card issuer account can be done directly in 4-7-1 Add/Edit Issuer Account > Add Card
Issuer. There is no need to use 1-7 General Ledger Accounts.

To add a card issuer account:
1 Open 4-7-1 Add/Edit Issuer Accounts, and click Add Card User.

2 In the Issuer GL Account box, enter a general ledger account number in theCurrent Liabilities range.

3 Formore information about available accounts in theCurrent Liabilities range, click theView existing accounts link.

4 The Ledger Accountswindow that opens is for viewing accounts only. If you open the Ledger Accountswindow, you
need to close it before you proceed.

5 In the Issuer Name box, enter a name.

For example, you could use the name of the card issuer, such as “My Bank—Visa.”

6 In thePayee box, type the name of the entity to whom you send the credit card payment check.

7 Enter information in the other boxes, as needed.

8 Select File > Save.
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Editing card issuer account information
Use this window to edit information about the credit card issuer. Note that you cannot edit the information in the Issuer GL
Account box. If you need to delete a ledger account, see the topic, Deleting ledger accounts for more information.
To edit a card issuer account information:
1 Open 4-7-1 Add/Edit Issuer Accounts.

2 Select an issuer account that you want to edit, and then click Edit Card Issuer.

3 In the Issuer Name box, edit the name.

4 Edit information in the other boxes, as needed.

5 Select File > Save.

4-7-2 Add & Edit Credit Cards
When you add a credit card, you are adding a credit card as a subaccount of a card issuer account. One issuer account can
havemultiple credit cards as subaccounts. For example, let’s suppose you have an oil company issuer account and 20
employees. You can add 20 cards to that issuer account, one for each employee.

When you need to reconcile your account, all the credit cards appear in the reconciling grid under the names of the credit
cards so that you can understand the charges for each employee.

Adding credit cards
Before you can add credit cards, youmust have already established card issuer accounts.

IMPORTANT: Do not use the entire credit card number on the card. Youmight consider using the last four digits of
the card number to assist in card identification.

To add a credit card:
1 Open 4-7-2 Add/Edit Credit Cards.

2 Click the drop-down arrow withSelect Card Issuer Account, and select an account.

3 Click Add Card.

4 In theCredit Card Account box, type a number.

The program increments the credit card numbers by one. If you begin your credit card account numbers with 101, the next
credit card for this account is 102.

5 Type a description.

For example, you could type the name of the employee who has this card, such as, Dave’s MasterCard.

6 Click Save.

Editing credit cards
You can edit theDescription information for a credit card; however, you cannot change the credit card subaccount number.
To edit a credit card:
1 Open 4-7-2 Add/Edit Credit Card.

2 Click the drop-down arrow withSelect Card Issuer Account and select an account.

3 Click Edit Card.

4 Edit the description.
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5 Click Save.

4-7-3 Enter Credit Card Receipts
Use this window for entering credit card receipts. The window’s grid functions very much like the grid in 4-2 Payable
Invoices/Credits. You have the choice of entering a vendor for this record or not and to job cost automatically if there is an
associated job and vendor.

Why should I consider entering a vendor?

If you enter a vendor, the program creates a paid invoice when you save the record. If you look in 1-3 Journal
Transactions, you see that two journal transactions have been created. This is a typical journal transaction and a record of
the payment (the paid invoice).

NOTE: If necessary, you can void the payment and the invoice will be re-opened.

If you do not enter a vendor, the program creates a typical journal transaction without creating a paid invoice.

NOTE: You can job cost automatically when you have entered a vendor on the record. You have to job cost manually
if the record has no vendor.

Entering credit card receipts
If you already have card issuer accounts and credit cards set up, the window opens with the first Card Issuer Account in
view.

You can click the drop-down arrow to select a different Card Issuer Account from the list, or you can click theAdd/View
records icon to enter a new Card Issuer Account or a new Credit Card.

When working with theVendor and Job boxes, you can select one from a list, or you can click theAdd/View records icon
to enter a new Vendor or Job.
To enter credit card receipts:
1 Open 4-7-3 Enter Credit Card Receipts.

2 In theCard Issuer Account box, select a card issuer account.

3 In theCredit Card box, select a credit card.

4 (Optional) UnderEntering a vendor creates a paid invoice when saved, enter aVendor, if required.

5 In thePayee box, enter the payee/merchant name.

6 In theDescription box, enter a description.

7 In the Trans# box, enter the credit card transaction number.

8 In the Invoice Date box, accept the default transaction date or enter a different transaction date.

9 In the grid, you are only required to enter information under the column titles with blue text.

10 In theDescription column, click a cell and enter a description.

11 Press the Enter key tomove through the grid, and accept or type information in each cell, as required.

12 Do one of the following:

a If a job and vendor have been entered, click theAutomatically job cost while saving the current record icon.

b If you are not job costing automatically, click File > Save.
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4-7-4 Enter Recurring Charges
If you have charges with a constant recurring amount such as amonthly bill for storage rental, you can set this up as a
recurring credit card charge. As you enter a recurring credit charge record, you can choose to post it to an account such as
Overhead Expense orAdmin Expense. When you save the record, you can choose to post it then or later use thePost >
Post All Pending Charges command.

NOTE: You cannot post in theDirect Expense, Equipment Expense, orWIP Posting account ranges.

When Sage 100 Contractor starts up and you are amember of theRecur. Trans. Group (security group for recurring
transactions) in 7-2 Company Information, the program displays amessage reminding you of transactions that are due. If
you do not choose to post immediately, the program will continue to remind you to post the recurring transactions every
time you launch the program if you are amember of theRecur. Trans. Group.

NOTE: If you do not have the permission to post recurring transactions, you will not see themessage.

Entering recurring credit card charges

Enter recurring credit card changes that are a fixed amount and will be paid according to a specific billing cycle.
To enter a recurring credit card charge:
1 Open 4-7-4 Enter Recurring Charges.

2 In theCard issuer Account, click the drop-down arrow and select an account.

Alternatively, you can click theAdd/View Records button tomake a new selection or view existing selections.

3 In theCredit Card box, click the drop-down arrow and select a credit card.

Alternatively, you can click theAdd/View Records button tomake a new selection or view existing selections.

4 In thePayee Name box, enter the payee’s name.

5 In theDescription box, enter a description of the transaction.

6 In theAccount box, click the drop-down arrow and select an account.

Alternatively, you can click Add/View Records button tomake a new selection or view existing selections.

7 In theAmount box, enter the amount of the transaction.

8 In theNext Date box, type the next date in the billing cycle that you want to post the transaction.

9 In theCycle box, type the specific billing cycle.

10 Click Save.

When you are prompted to post the transaction, you can post it immediately or you can post it later.

4-7-5 Reconcile Credit Card Statements
When you open 4-7-5 Reconcile Credit Card Statements, the program populates theCard Issuer Account box with the
first account in your list. Click the drop-down arrow to select a different card issuer account, if necessary. When you click
Display, the program displays the payments and charges for that card issuer account in the grid. The grid displays the
payments in the top lines of the grid and the changes below them.

As you review the payments and charges, you can click theVerify button (near the top right of the window) to place a check
mark in theVerified column. To remove the verified check mark, click Open.
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With a your cursor in a cell, click Go to Transaction to open the transaction record (near bottom left) if there is a question
about the charge or payment.

To add transactions “on-the-fly,” click theAdd Transaction button to open 4-7-3 Enter Credit Card Receipts and add the
new transaction.

When you click Save, you can choose to save a Trial reconciliation or a Final reconciliation. Selecting theCreate a PDF
of the report file check box before saving the Final reconciliation saves the reconciliation report file.

Reconciling credit card statements
After you get your bank statement, you reconcile the statement’s payments and charges against what you have entered in
Sage 100 Contractor.
To reconcile a credit card statement:
1 Open 4-7-5 Reconcile Credit Card Statements.

2 Select aCard Issuer Account, and then click Display.

3 Select a row, and then do any of the following:

a Click Verify.

b Click Go to Transaction to view a transaction or to open a verified transaction.

c Click Add Transaction to add amissing transaction. This opens 4-7-3 Enter Credit Card Receipts. When you save
the record, the new transaction is added to the reconciliation.

4-7-6 Pay Credit Cards
You can enter credit card payments using the 4-7-6 Pay Credit Cardswindow. When you open the window, select the
card issuer account that you want to pay. The program populates the window’s grid area with information about the credit
card, the current balance, and last reconciled balance. You then enter the required information and the amount to pay in the
To Pay column for each credit card.

Suppose you want to issue a check to a telephone company for last month’s bill. To indicate to Sage 100 Contractor that a
check will be printed for the transaction, you type a placeholder consisting of four zeros (0000) in theCheck# box.

You can then print the check directly from 4-7-6 Pay Credit Cards:

1 Click thePrint icon on 4-7-6 Pay Credit Cards to open 1-1 Checks/Bank Charges.

2 Then print the check from the 1-1 Checks/Bank Chargeswindow.

You can also enter transactions that do not require printed checks. For example, youmight issue a hand-written check and
will not need to print a check. In this case, you enter the check number you issued in theCheck# box.

Paying credit cards
Use this window to enter the amount to pay on your credit card statement. When youmake a payment in 4-7-6 Pay Credit
Cards, the program creates a ledger transaction in 1-3 Journal Transactions.
To pay a credit card:
1 Open 4-7-6 Pay Credit Cards.

2 Select aCard Issuer Account, and press Enter.

3 Select aCash Account#, and press Enter.

4 In theCheck# box, do one of the following:
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a Type 0000 to print the check in 1-1 Checks/Bank Charges.

b If the check has been hand-written, type the check number.

5 In theDate box, type the transaction date.

6 In theDescription box, type the transaction description.

7 In thePayee box, type a payee or merchant name.

8 In the grid in the To Pay column, click in a cell, and type an amount to pay.

9 Save the payment and print the check, if necessary.

10 Depending on your workflow, the next steps might be to open 1-1 Checks/Bank Charges and print a check or open 4-7-
5 Reconcile Credit Card Statements and verify the payments on your credit card statement.
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Chapter 5: Payroll
Working with Payroll
You can automatically calculate all payroll simply by entering the job, cost code, and time worked. Payroll helps generate
accurate labor and job costs by calculating all accruals as well as basic pay items for each line on every timecard. You can
even include liability insurance (based on per $1000) and small tool costs, which are automatically posted to job costs in
your payroll calculations.

Advanced features enable you tomanage prevailing-wage, union benefits, and qualified benefit plans. You can set up a
benefit system and assign it to a paygroup. For example, you can set variable-rate payroll to override basic employee
calculations as well as calculate rates and benefits only for the assigned localities or specific unions.

UsingPayroll, you can take advantage of benefit-cost offsets in addition to separately classified shop and site time.
Customizable entry windows speed up your daily operations.

5-5 Daily Payroll, which enables daily batch entry of employee time, is ideal for larger companies. You can import
employee time from 6-11-6 Daily Field Reports or theService Receivables add-onmodule to verify payroll hours. 5-5
Daily Payroll also integrates with 8-Equipment Management so that you can allocate equipment repair time and costs to
projects.

Here are more features of Sage 100 Contractor Payroll:

l Supports Workers’ Compensation systems, including split rates, hourly calculations, and employee and employer
portions.

l Calculates standard 401(k), 408(k), “cafeteria,” and qualified benefit plans.

l Includes direct deposit capabilities.

l Automatically prints Certified Payroll andminority reports for any timeframe and job.

l Calculates union payroll reports.

l Supports multi-state andmulti-local tax district reporting, including reciprocity.

l Supports electronic reporting and filing.

l Supports piece work payment.

l Applies per diem to any job for accurate job costing of employee reimbursements.

l Automatically converts to weekly, biweekly, or semi-monthly timecards.

5-1 Payroll Reports
See Appendix B for a complete list of 5-1 Payroll Reports.

About certified payroll reports
To verify the payment of the prevailing wages to employees working a Davis-Bacon or prevailing-wage project, government
agencies require contractors to submit Certified Payroll reports. The governing agency determines the frequency with
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which youmust submit the reports.

In 5-5-1 Daily Payroll Entry or 5-2-2 Payroll Records, type Yes in theCertified text box to include the wages benefits of
a payroll line in theCertified Payroll report. If you type No or leave theCertified text box blank, Sage 100 Contractor does
not include the wages in the payroll data for theCertified Payroll report.

Certified reports 5-1-6-21 Certified Payroll Report, 5-1-6-31 Department of Labor, and 5-1-6-51 Alaska Certified
Payroll have the option to exclude or include social security numbers andmask the numbers if desired.

TIP: You can print aCertified Report or aMinority Report from 5-1-6 Certified Payroll Report.

About the 5-1-6-41 Minority Report
The 5-1-6-41 Minority Report has been designed to closely match the Federal EEOC form. It includes categories ofWhite
and Two or more races, which were not on the previous report. New columns display Minority Percentage and Female
Percentage.

IMPORTANT:
l You cannot use this report to file your Federal EEOC report. Use the report to gather the information you use to

fill out the Federal form.

l The percentage totals display Minority Percent and Female Percent. The program does not capture the
percentage of Two or more races.

The changed report prints three pages:

l Number of Hours Worked—Displays a breakdown of Total hours worked, Minority percent, and Female percent.

l Number of hours worked by Journey Workers, Apprentices, and Trainees—Displays a breakdown of Total
hours worked, Minority percent, and Female percent.

l Number of Employees—Displays a breakdown of Total hours worked, Minority percent, and Female percent.
Use the information on this page to fill out the Federal form with your employee data.

About the 5-1-11 DOL WH-347 Certified Payroll Forms by Aatrix
If you are required to submit weekly payrolls for Federal or Federally-aided construction-type contracts and subcontracts,
use FormWH-347 and the state* reports provided by Aatrix. Properly filled out, these forms satisfy the requirements of
Regulations, Parts 3 and 5 (29 C.F.R., Subtitle A), as to payrolls submitted in connection with contracts subject to the
Davis-Bacon and related Acts.

NOTE: Aatrix forms are not available forWashington State due to state regulations.

While completion of FormWH-347 is optional, it is mandatory for covered contractors and subcontractors performing work
on Federally financed or assisted construction contracts to respond to the information collection contained in 29 C.F.R. §§
3.3, 5.5(a). The Copeland Act (40 U.S.C. § 3145) requires contractors and subcontractors performing work on Federally
financed or assisted construction contracts to "furnish weekly a statement with respect to the wages paid each employee
during the preceding week." U.S. Department of Labor (DOL) Regulations at 29 C.F.R. § 5.5(a)(3)(ii) require contractors to
submit weekly a copy of all payrolls to the Federal agency contracting for or financing the construction project,
accompanied by a signed "Statement of Compliance" indicating that the payrolls are correct and complete and that each
laborer or mechanic has been paid not less than the proper Davis-Bacon prevailing wage rate for the work performed. DOL
and federal contracting agencies receiving this information review the information to determine that employees have
received legally required wages and fringe benefits.

Under the Davis-Bacon and related Acts, the contractor is required to pay not less than prevailing wage, including fringe
benefits, as predetermined by the Department of Labor. The contractor's obligation to pay fringe benefits may bemet either
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by payment of the fringe benefits to bona fide benefit plans, funds or programs or by making payments to the covered
workers (laborers andmechanics) as cash in lieu of fringe benefits.

This payroll provides for the contractor to show on the face of the payroll all monies to each worker, whether as basic rates
or as cash in lieu of fringe benefits, and provides for the contractor's representation in the statement of compliance on the
payroll (as shown on page 2) that he/she is paying for fringe benefits required by the contract and not paid as cash in lieu of
fringe benefits.

Enter benefit rates in 5-3-4 Paygroups

*State Certified Payroll Forms available with Sage 100 Contractor:

l Alabama

l Alaska

l Arizona

l Arkansas

l California

l Colorado

l Connecticut

l Delaware

l Florida

l Georgia

l Hawaii

l Idaho

l Illinois

l Indiana

l Iowa

l Kansas

l Kentucky

l Louisiana

l Maine

l Maryland

l Massachusetts

l Michigan

l Minnesota

l Mississippi

l Missouri

l Montana

l Nebraska
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l Nevada

l New Hampshire

l New Jersey

l New Mexico

l New York

l North Carolina

l North Dakota

l Ohio

l Oklahoma

l Oregon

l Pennsylvania

l Rhode Island

l South Carolina

l South Dakota

l Tennessee

l Texas

l Utah

l Vermont

l Virginia

l West Virginia

l Wisconsin

l Wyoming

5-2 Payroll Processing

5-2-1 Employees
About 5-2-1 Employees

Using the 5-2-1 Employeeswindow, you create an employee record for each employee whoworks during the calendar
year. The record stores personal and work-related information, and acts as the source for each employee’s hourly pay
rates, salary rates, or paygroups. In addition, you can accrue sick and vacation time, provide direct deposit for employees,
and automatically recover payroll advances.

On theCompensation tab, you can enter information about Paygroups, Standard Regular Rate, Commission%,
Salary, Accrued Sick, Sick Rate, andmore. UnderMark on W-2, you can select the check boxes Retirement Plan and
Third-Party Sick Pay to include the appropriate values when preparing theW-2 electronic file.

On theDirect Deposit tab, you enter employees’ direct deposit information and email address for the direct deposit pay
stub.
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On theCalculations tab, you can select which payroll calculations to use and customize the calculation rates for each
employee. Each employee record stores its own calculation rates; you can create one payroll calculation but set up
different calculation rates for each employee. When you trial-compute or final-compute payroll, Sage 100 Contractor uses
calculation rates from the employee records to compute the deductions and benefits for each employee.

On theAdditional Contacts tab, you can addmultiple additional contacts for each employee.

IMPORTANT: Contacts entered in employee records are not synchronized with Outlook due to security reasons.

You can also create generic employee records for scheduling resources. A single, generic employee can represent an entire
crew, such as a framing crew. Use the generic employee to assign employee resources to tasks in a schedule, thereby
preventing the over-allocation of labor . For service work, you can use the generic employee as a placeholder for scheduling
work orders in the 11-3 Dispatch Boardwindow.

IMPORTANT: Do not enter more than one employee record for any one employee. For example, if youmake a
mistake on an employee record, do not correct themistake by making a second record for that employee.

Entering employee records

Consider the following points before entering employee records:

l When you select theExempt from certified reporting check box, Sage 100 Contractor excludes the employee
from the Certified Payroll report.

l If an employee is exempt from overtime pay, select theExempt from overtime pay check box. When entering
timecards for an employee that works more than 8 hours in a single day, pay type 1-Regular defaults to thePay
Type box.

l If your company works in Alaska, youmust provide additional residential information for state certified payroll
reports.

To enter an employee record:

1 Open 5-2-1 Employees.

2 In the data control text box, enter the employee identification number.

3 In the First Name text box, enter the employee’s first name.

4 In theM.I. text box, enter the employee’s middle initial.

5 In the Last Name text box, enter the employee’s last name.

6 In theStatus list, click the work status of the employee.

7 On theGeneral Information tab, do the following:

a In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

b (Optional) In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

c If the employee usually operates a piece of equipment, enter the equipment number in theEquipment text box.

IMPORTANT: If a job or equipment number does not appear on a timecard line, Sage 100 Contractor posts the
payroll based on the employee’s position.

d In thePhone# text box, enter the employee’s telephone number.

e In the Fax# text box, enter the employee’s fax number.

f In theHome# text box, enter the employee’s home telephone number.

g In thePager# text box, enter the employee’s pager number.
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h In theCell# text box, enter the employee’s cellular number.

i In theEmail text box, enter the employee’s email address.

8 In theHuman Resources tab, do the following:

a In theEmployment Type list, click the category.

b In theGender list, click employee’s gender.

c In theBenefit Status list, click the employee’s benefit status.

d In theHeritage list, click the employee’s heritage.

IMPORTANT: When you select theAlways use employee comp code check box, Sage 100 Contractor inserts the
workers’ compensation code from the employee’s record into the timecard. Otherwise, Sage 100 Contractor inserts
the workers’ compensation code associated with the cost code entered in the timecard.

e In theComp Code list, click the worker’s compensation code.

f In thePosition list, click the employee’s position.

g In theUnion list, click the union to which the employee belongs.

h In theResidence Locale text box, enter the local payroll tax district for the employee's residence.

i In theWork Locale text box, enter the payroll tax district for the employee's work location (for salaried employees).

j In the Tax State text box, enter the abbreviation for the state in which the employee lives.

k In theSocial Security# text box, enter the employee’s social security number.

l In theBirth Date text box, enter the employee’s date of birth.

m In theHire Date text box, enter the date when the employee was hired.

n In the Last Raise text box, enter the date when the employee last received a raise.

o In the Inactive text box, enter the date when the employee record became inactive.

IMPORTANT: After verifying an employee’s citizenship, select the I-9 Verification check box.

p Check theEligible under HIRE Act of 2010, Exempt from certified reporting, andExempt from overtime pay
boxes as necessary for the employee.

9 On theCompensation tab, do the following:

a In thePay Period list, click the cycle of the pay period.

b In thePaygroup text box, enter the paygroup number.

c In theRegular Hourly Rate (rate 1) text box, enter the employee’s regular hourly rate.

d In theOvertime Hourly Rate (rate 2) text box, enter the employee’s overtime hourly rate.

e In thePremium Hourly Rate (rate 3) text box, enter the employee’s premium hourly rate.

f If the employee is paid a salary, enter the amount in theSalary text box. If the employee is salaried, do not enter a
paygroup or hourly rates.

IMPORTANT: If salaried employees are paid overtime, youmust enter a standard regular rate as well as standard
overtime rate.

g In theCommission% box, enter the rate (%) of the sales commission.

h In theAdvances Due box, enter the total amount of outstanding advances due, or leave it blank.
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i In theAccrued Sick text box, enter the total accrued hours of sick time.

j In theSick Rate text box, enter the rate at which sick time accrues.

k In theSick Accrual Method list, click themethod used to accrue the sick time.

l In theAccrued Vacation text box, enter the total accrued hours of vacation time.

m In theVacation Rate text box, enter the rate at which vacation time accrues.

n In theVacation Accrual Method list, click themethod used to accrue vacation time.

o UnderW-2 Options, select either or bothRetirement Plan and Third-Party Sick Pay boxes to include that
information in theW-2 electronic file.

10Click theDirect Deposit tab, and do one of the following:

a If the employee uses direct deposit:

i Click theEnable direct deposit box.

ii Enter the information for one or more (up to four) direct deposits.

iii Add the employee email address to receive the direct deposit pay stub.

b If the employee does not use direct deposit, do nothing.

11Click theCalculations tab. Review the payroll calculations and rates, andmake any adjustments.

12 On theAdditional Contacts tab, enter any additional contacts or emergency contacts for each employee.

13 On the Filemenu, click Save.

Viewing employee earnings

Consider the following points when viewing employee earnings:

o Gross wages are determined from the salary, hourly pay, piecework pay, andmiscellaneous pay. Because add-on
and per diem pay is not included, taxable wages may be higher than the gross wages. All non-taxable deductions are
excluded.

o Social Security wages are determined from the total compensation subject to the Social Security tax, including add-
ons. All deductions subject to Social Security are excluded.

o Medicare wages are determined from the total compensation subject to Medicare, including add-ons. All deductions
not subject to Medicare are excluded.

To view employee earnings:

1 Open 5-2-1 Employees.

2 Using the data control, select an employee record.

3 On theOptionsmenu, click Earnings.

Adding employee license types

If an employee acquires a new license, you can add that license type to your list of license types.

To add an employee license type:

1 Open 5-2-1 Employees.

2 Using the data control, select an employee.

3 At the bottom of the 5-2-1 Employeeswindow, click the Licenses button.
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4 TheEmployee Licenseswindow appears.

5 In the License Type column, click in a cell, then press the F6 key to open the License Typeswindow.

a In a cell in the License# column, enter a license type number.

b In a cell in the License Type column, type the description of the license type.

c From the File menu, click Save.

6 Using the lookup window, add the new license type to the employee.

Tracking employee licenses

You can track employee licenses with Sage 100 Contractor.

To track an employee license:

1 Open 5-2-1 Employees.

2 Using the data control, select an employee.

3 At the bottom of the 5-2-1 Employeeswindow, click the Licenses button.

4 TheEmployee Licenseswindow appears.

5 Do one of the following:

a In the License Type column, click in a cell, then press the F6 key to open the License Types lookup window and
enter a license type number in the License# column and the license type in the License Type column.

b Alternatively, in a cell in the License Type column, click the drop-down arrow, and then double-click an existing
license type to select it.

6 On theEmployee Licenses window, in a cell in the License# column, type the license number of the employee’s
license.

7 On theEmployee Licenseswindow, in a cell in theExp. Date column, type the license expiration.

8 On theEmployee Licenseswindow, in theNotes column, type notes about the employee license as needed.

9 Repeat steps 4–8 for each license.

10 On themenu bar, click File > Save.

11 TheEmployee Licenseswindow closes.

Adding employee training types

You can add to the types of training that your employees acquire.

To add an employee training type:

1 Open 5-2-1 Employees.

2 Using the data control, select an employee.

3 At the bottom of the 5-2-1 Employeeswindow, click the Training button.

4 TheEmployee Trainingwindow appears.

5 In a cell the Training Type column, double-click, and then press the F6 key to open the Training Types lookup window.

6 In a cell in the Training Type# column, type a training type number.

7 In a cell in the Training Type column, type the description of the training type.

8 From the File menu, click Save.



- 257 -

Tracking employee training

You can track employee training with Sage 100 Contractor.

To track an employee’s training:

1 Using the data control, select the employee.

2 At the bottom of the 5-2-1 Employeeswindow, click the Training button.

3 TheEmployee Trainingwindow appears.

4 Do one of the following:

a Click in a cell in the Training Type column, and then press the F6 key to open the Training Types lookup window to
enter Training Type# and a Type Name.

b Alternatively, in a cell the Training Type column, click the drop-down arrow, and then double-click an existing training
type to select it.

5 In the Last Date text box, enter the date when the employee last received training.

6 In the Training Cycle text box, enter the cycle when the employee next receives training.

7 In theNext Date text box, enter the next date that training will be presented.

8 In theNotes column, enter notes about the employee training as needed.

9 Repeat steps 4–8 for each license; however, only step 4 is required.

10 On themenu bar, click File > Save.

11 TheEmployee Trainingwindow closes.

Entering the Alaska domicile information

Becausemany workers are from outside the state, the State of Alaska requires residential information on each employee of
the contracted company. The information is included on the Alaska Certified Payroll report supplied to the state
government.

To enter Alaska domicile information:

1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 On theOptionsmenu, click Alaska Domicile.

4 In theAddress 1, Address 2, City, State, and Zip text boxes, enter the employee’s address.

5 In theCertificate# text box, enter the employee’s job certificate number.

6 In theApprentice% text box, enter the percent rate of journeyman pay received by the employee.

7 In theBargaining text box, enter the name of the collective bargaining agreement.

8 In theOccupation text box, enter the Alaska State occupational code.

9 In theArea text box, enter the regional area code.

10 In the License# text box, enter the employee’s license number.

11 On the tool bar, click theSave button.

NOTE: Employees assigned occupation code 1210 are excluded from the State Quarterly Report.
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Recovering payroll advances

There are two ways to recover a payroll advance: You can let Sage 100 Contractor deduct as much as possible each pay
period until the advance has been recovered, or you can deduct a flat amount each pay period.

Example 1: Automatically deduct the balance due

Sage 100 Contractor automatically deducts the balance due from the employee’s net paycheck. If the balance due exceeds
the net amount of the paycheck, Sage 100 Contractor deducts the net paycheck. When you print checks, Sage 100
Contractor prints a $0 paycheck for the employee.

Example 2: Deduct a flat amount each pay period

When Sage 100 Contractor recovers a portion of the advance, it adjusts the balance of the payroll advance due your
company. Sage 100 Contractor attempts to deduct the balance due each pay period until it recovers the full amount of the
advance.

You can control themaximum amount deducted from an employee’s paycheck. When Sage 100 Contractor recovers a
portion of the advance, it adjusts the balance of the payroll advance due your company. Sage 100 Contractor deducts the
amount each pay period until it recovers the full amount of the advance.

To recover a payroll advance:

1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theRate text box of thePayroll Advance row, enter the amount to deduct.

5 On the Filemenu, click Save.

TIP: You can view the balance of the payroll advance due your company in theCompensation tab in theAdvances
Due text box.

About employee documents

In the 5-1-10 Employee Documentswindow, you can print documents designed in 13-5 Form/Report Page Design. The
types of employee documents you can create include form letters and timecards. When designing an employee document,
you canmerge information from the employee records. Save the employee documents using the *.docs_employee file
name extension.

HIRE Act

Businesses that hire new employees may qualify for two tax incentives under the Hiring Incentives to Restore Employment
(HIRE) Act. This new tax law was signed into law onMarch 18, 2010. Businesses that hire new employees will not have to
pay the employer's share of Social Security tax (6.2% of wages) from the date of hire through the end of 2010.

Additionally, businesses that retain a newly hired employee for at least 52 consecutive weeks can qualify for a tax credit of
up to $1,000. Both tax breaks are available for new hires who have been unemployed for at least 60 days immediately prior
to beginning their new job.

To be eligible, the employeemust sign theW-11 Affidavit form.

There are twomethods of handling the HIRE Act in Sage 100 Contractor. Method 1 is recommended, for the following
reasons:
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l Continues to job cost the employer FICA tomatch how jobs were estimated.

l Can declare the federal tax credit as income to the company, rather than reduced expense.

NOTE: Whichever method you choose, pick one and
do not change it for 2010.

Method 1: Continue to compute employer FICA for eligible employees and the handling of this information at
the reporting level.

1 If you continued to compute employer FICA for each employee’s account eligible under the HIRE Act:

a Check the “Eligible Under HIRE Act” on 5-2-1 Employees for eligible employees

b Make sure you have no Payroll Audit Errors.

2 Use the Federal Tax Report to determine the amount of your federal tax deposit with the check box selected: “Subtract
Employer FICA for HIRE Act.” This will subtract computed employer FICA for employees that have the “Eligible Under
HIRE Act” checked in 5-2-1 Employees.

3 To Adjust GL for this Employer Credit: (This method will leave your job costs unchanged.)

a Create a new Income account called HIRE Act Income or equivalent.

b In menu 1-3 General Ledger, enter the following adjustment:

i Debit the FICA Payable liability account for the amount of the federal tax credit.

ii Credit the new Income account for the amount of the federal tax credit.

For example, if you have employer Social Security for qualified employees totaling $850, you would enter the following GL
adjustment:

Debit Credit

2300 FICA payable
account 850.00

4015 HIRE Act Income 850.00

This adjustment will increase your income by $850 and reduce your FICA liability account by $850. This adjustment should
be done with each payroll/or at the time of each federal deposit to ensure your liability account balance is accurate.

Method 2: If you either zeroed out the employer FICA rate or made the calculation no longer active for eligible
employees under the HIRE Act:

1 If you elect to skip computing employer FICA for each employee eligible under the HIRE Act:

a Check the “Eligible Under HIRE Act” on 5-2-1 Employees for eligible employees

b Set the employer FICA calculation on 5-2-1 Employees to inactive

c Make sure you have no Payroll Audit Errors

2 Use the Federal Tax Report to determine the amount of your federal tax deposit. The “Subtract Employer FICA for HIRE
Act” check box will not need to be checked since you have no calculated employer FICA amounts for these employees.

3 Before computing the first payroll check dated in 2011, be sure to activate the employer FICA calculation.
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Employee Payroll Calculations

About calculations in employee records

When setting up a new employee record, Sage 100 Contractor inserts the package of default payroll calculations, including
the calculation rates andmaximums, on theCalculations tab. Each employee record has its own set of payroll calculation
rates, maximums, and totals. You can edit the calculation rates andmaximums in one employee record without affecting
others. When you compute payroll, Sage 100 Contractor reads the calculation rates andmaximums from theCalculations
tab.

Before editing the individual calculation rates andmaximums, familiarize yourself with how payroll calculations are set up.
Most calculations that refer to tax tables do not allow editing. Sage 100 Contractor determines the tax table number, but
does not display the data in theCalculations tab.

You canmanage themarital status settings, allowances, and withholding amounts for federal and state tax calculations.
For example, Steve works in Kansas and Nebraska. In Kansas, Steve claims married-joint status, but in Nebraska, he
claims married-separate status. In theMarital column, you can enter the appropriate marital status for the Kansas and
Nebraska income tax calculations.

You can also control whether a payroll calculation is active or inactive. When you type No in theActive cell for a
calculation, Sage 100 Contractor does not include that payroll calculation in the compute for timecards. For example, John
was given a $500 payroll advance, and thePayroll Advances calculation in John’s employee record was set up to recover
$100 per paycheck. But John has said that the next few weeks are difficult and that he would like to suspend the repayment
for a little while. In John’s employee record, type No in theActive cell of thePayroll Advance calculation. When you are
ready to resume recovering the advance, typeYes in theActive cell of thePayroll Advance calculation.

Contractors who work on prevailing-wage jobs are required tomatch the difference between prevailing wages and benefits,
and actual wages and benefits paid to each employee. For each employee whoworks the prevailing-wage job, you can
enter the credit in theOffset column. When you compute payroll, Sage 100 Contractor applies the credit. Tomanage payroll
for prevailing-wage jobs, set up paygroups.

TIPS:
l Some states use additional tax tables to collect county taxes with the state taxes. To calculate the correct

taxes, enter the tax rate or table number in the Table# cell of the calculation.

l You can withhold an additional flat amount for federal taxes or state taxes. To withhold a flat amount for a
calculation, enter the amount in theAdd W/H cell of the calculation.

About applying the Labor Burden when calculating Payroll

Social Security, Medicare, Workers’ Compensation, federal and state unemployment and union contributions add to the
costs of having employees on jobs. These additional labor costs are typically labeled as “burden.” Timecard lines and
payroll calculations determine the burden from 5-2-2 Payroll Records.

A 6-3 Job Costs record is created for every line on the grid of the 5-2-2 Payroll Records that has a job entered when the
payroll record has been saved and final computed from the 5-2-3 Compute Payroll window. Payroll calculationmethods
determine how the burden amounts are computed and applied.

Per Pay Period computes a flat rate that is determined by hours on the time card lines.

Percentage calculations are based on rate of pay multiplied by the percentage of burden toGross Wages.

Workers Comp is based on Tables. The rate for each employee could be different as determined by theComp Code,
Liability, andExperience Mod. Note that Overtime is applied as regular hours.

Percentage of Other Calculations are based on formulas to find the percentage of a percentage of burden toGross
Wages.
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Setting up vacation on the 5-2-1 Employees Compensation tab

Keep inmind the following:

l When processing payroll, the system increases accrued sick and vacation time in the employee record based on the
rate you have set up.

l When paying an employee for sick or vacation time use Pay Type 4 for sick time and Pay Type 5 for vacation time
on the timecard lines. When processing Payroll, the system decreases the sick and vacation time in the employee
record.

Accrued Vacation box - If this is a flat amount per year, enter amount available to each employee at beginning of each
year and do not use an accrual rate.

Vacation Rate box—Enter the rate at which vacation time accrues according to your company policy.

Vacation Method—Enter themethod used to accrue vacation time, per hour or per period.

There is no general ledger accrual created by the entry
on the 5-2-1 Employeeswindow. A payroll calculation
must be set up if you want an accrual for the general
ledger and job cost purposes.

Setting up sick time on the 5-2-1 Employees Compensation tab

Keep inmind the following:

l When processing payroll, the system increases accrued sick and vacation time in the employee record based on the
rate you have set up.

l When paying an employee for sick or vacation time use Pay Type 4 for sick time and Pay Type 5 for vacation time
on the timecard lines. When processing Payroll, the system decreases the sick and vacation time in the employee
record.

There is no general ledger accrual created by the entry
on the 5-2-1 Employeeswindow. A payroll calculation
must be set up if you want an accrual for the general
ledger and job cost purposes.

Accrued Sick box—If this is a flat amount per year, enter amount available to each employee at beginning of each year
and do not use an accrual rate.

Sick Rate—Enter the rate at which sick time accrues according to your company policy.

Sick Method—Enter themethod used to accrue sick time, per hour or per period.

RegardingSick Method: This accrual is on the
employee records only. There is no general ledger
accrual created by the entry on the 5-2-1 screen. A
payroll calculationmust be set up if you want an
accrual for the general ledger and job cost purposes.
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Adding payroll calculations to employee records

When setting up a new employee record on 5-2-1 Employees, Sage 100 Contractor inserts the package of default payroll
calculations, calculation rates, andmaximums on theCalculations tab. You can insert additional payroll calculations at
any time.

To add payroll calculations:

1 Open 5-2-1 Employees.

2 Click theCalculations tab.

3 In theCalculation column, in an empty cell, click once, and then click the down arrow button to display thePayroll
Calculations Lookupwindow.

4 Select and insert the calculation(s).

TIP: Alternatively, you can right-click in an empty cell of theCalculation column and select from themenu of Pick
Lists. Press the F5 key to open thePayroll Calculations Lookup, or F8 to open thePayroll Calculations Lookup
window as aPicklist.

About non-union shops and prevailing-wage jobs

When an open-shop contractor receives a contract for a Davis-Bacon job, the contractor is required to provide his
employees the wages and benefits package as stipulated by the governing agency, usually union scale for the area.

For example, a union local might provide a health care benefit that the open-shop contractor does not. For work performed
on the prevailing-wage job, the contractor is required to pay his employees themoney that would otherwise be paid for a
health care benefit if it were a union shop.

The governing agency determines the prevailing wage and benefits package requirements for each job. Tomanage the
requirements for each prevailing-wage job, use paygroups to set up a separate wage group for each category of worker.
When entering a timecard, you specify the paygroup on each timecard line, and Sage 100 Contractor uses the wages and
benefits package from the paygroup in place of the wages and benefits package in the employee record.

When your company offers a benefit that is also in the prevailing benefits package, your company receives a credit,
determined by the job’s governing agency. In some cases, youmight be required to pay the employee the difference
between the regular benefit and the prevailing benefit. Set up the payroll calculation for the benefit as a cash add-on, and
include the offsetting credit for the new calculation in the employee’s record. When you compute payroll, Sage 100
Contractor uses the offset credit to determine the difference between the benefit provided and the prevailing benefit. The
employee is paid the difference as cash.

For example, you pay a health benefit of $180 per month on behalf of Joe, and $120 per month on behalf of Bill using
Calculation A: Company Health (paid by the employer). The requirements for a prevailing-wage job include a $2 per hour
health benefit. To calculate the required health benefit correctly, you set up a new calculation, calledCalculation B:
Davis/Bacon Health (cash add-on) and add it to the employee records. The new calculation has a calculation type 2-Add
to Gross, and a rate of $2 per hour.

The governing agency, after reviewing the health benefit you supply, determines you get a $1 per hour credit for Joe’s health
care benefit and a $0.67 per hour credit for Bill’s health care benefit.

After setting up the paygroups and benefits packages, which includes Calculation B, enter the health care credit in the
Calculations tab of the employee records. In Joe’s employee record, enter the $1 credit in theOffset cell forCalculation
B. Then in Bill’s employee record, enter the $0.67 credit in theOffset cell forCalculation B.

Joe and Bill work 40 hours on the prevailing-wage job. When entering their timecards, you indicate the appropriate
paygroups. When you compute payroll, Sage 100 Contractor determines the amount to add to each check, which is the
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difference between the health benefit you provide and the prevailing health care benefit [(benefit rate – offsetting credit) *
hours worked].

Joe receives an additional $40 [($2 – $1) * 40] on his check; and Bill receives an additional $53.20 [($2 – $0.67) * 40] on his
check. For the certified payroll report, Sage 100 Contractor computes the health benefit at $2 per hour for both Joe and Bill.

For companies that perform considerable amounts of prevailing-wage work, you can create a table of paygroups to use with
each job. When you enter the job number on a timecard, Sage 100 Contractor determines which paygroup to use based on
the employee’s position.

Entering offset credits for prevailing-wage jobs

Note that if the employer is paying benefits in excess of the required prevailing-wage benefit, the offset cannot exceed the
benefit amount.

To enter offset credits for a prevailing-wage job:

1 Set up the paygroups for the prevailing-wage job.

2 Open 5-2-1 Employees.

3 Click theCalculations tab.

4 Using the data control, select the employee.

5 In the $ Offset cell of the prevailing-wage benefit calculation, enter the credit amount.

6 On the Filemenu, click Save.

7 Repeat steps 4–6 for each employee working the prevailing-wage job.

About calculating state unemployment insurance (SUI) in a multiple state environment

CAUTION: The rules for paying SUI for interstate employment are complicated and for definitions and determination
of how these rules apply to each employee, you should refer to your accountant or CPA.

The 50 states have agreed on a “uniform definition of employment” to prevent duplicate contributions for the services of a
multi-state worker. Under this Uniform Definition of Employment, there are four basic factors that must be considered when
determining employment coverage. These factors are as follow in order of importance:

l The place where work is Localized

l The site of the Base of Operations

l The place from which Operations is Directed or Controlled

l The Employee's Residence

l The SUI Calculation, rate, andmaximum (the first factor) should be entered on the 5-2-1 Employeeswindow for the
single state that is determined to apply to that employee.

IMPORTANT: All SUI calculations that are active on the calculation tab of an employee’s record in 5-2-1 Employees
> Payroll > Payroll Processing > Employees populate on each timecard. Any SUI calculation that does not apply
to a timecardmust be overridden to zero dollars manually.

Creating payroll records that differentiate among multiple states

Creating payroll records that differentiate amongmultiple states requires several steps, which are listed below.

To create payroll records that differentiate among multiple states:

1 Create a table of states.
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2 Create employee timecards in 5-2-2 Payroll Records, and use a locale on each line based on the state in which the
employee worked.

3 Process your payroll as usual.

About updating employee calculations

When you change a default rate or maximum for a payroll calculation, you can update the change to theCalculations tab in
the employee records. You have two choices, either update the default rate and themaximum or update only themaximum.
This is done using 5-3-1 Payroll Calculations.

Options > Update Employees > Update Default Rate and Maximum:

Command What it does

ALL
Employees

Updates all employee records, regardless of the
employee’s status.

‘Current’
Employees Updates employee records assigned status 1-Current.

Employees
with this
Calculation

Updates employee records that contain the payroll
calculations on theCalculations tab in the employee
records.

Options > Update Employees > Update Maximum Only:

Command What it does

ALL
Employees

Updates all employee records, regardless of the
employee’s status with themaximum only.

‘Current’
Employees

Updates employee records assigned status 1-Current
with themaximum only.

Deleting payroll calculations from employee records

When a payroll calculation no longer applies to an employee, you can delete it from the employee’s record.

To delete a payroll calculation from an employee record:

1 On 5-2-1 Employees, click theCalculation tab.

2 Select the calculation.

3 Press the Delete key.

Changing the pay period from weekly to biweekly

To change the pay period from weekly to bi-weekly:

1 Open 5-2-1 Employees.

2 Display an employee.

3 Click theCompensation tab.

4 From thePay Periodmenu, select Bi-Weekly.

5 Select File > Save.

6 Repeat Steps 1 through 5 for each employee.
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5-2-2 Payroll Records
About 5-2-2 Payroll Records

In the 5-2-2 Payroll Recordswindow, you can enter timecards for employees as well as hand-computed records,
advances, bonuses, and third-party payments. Payroll records for advances, bonuses, and salaried employees do not
require timecard information. For non-salaried employees, you enter timecards with a breakdown of the hours spent working
each job or repairing equipment.

When you enter a payroll record, Sage 100 Contractor inserts default information from the job and employee records. You
can accept or change any of the default information. After timecard entry, you can compute the timecards.

Youmight find this additional functionality beneficial too. The related scope of work recorded in 6-11-6 Daily Field Report
line notes from the employees grid can be imported into 5-2-2 Payroll Records using theOptions > Data Import > Import
Daily Field Reports. This provides a way for that information to become part of your payroll and job costing records.

Also, you can choose whether to use an employee's work locale or residence locale as the default in timecards when the
timecard line does not specify a job or when the specified job does not include a locale. When you click Options > Default
Option for Locale Column, a separate window opens where you specify your choice. Your selection determines the
default for the Locale Column in all time-entry windows, including the 5-5-1 Daily Payroll Entrywindow and the Sage
Construction Anywhere plug-in, as well in as the 5-2-2 Payroll Recordswindow.

A trial-compute allows you to review the amounts computed for each payroll calculation andmake any necessary
adjustments. On theCalculations tab, you can review the accuracy of computed amounts or override the calculation
results by supplying different amounts. After you final-compute timecards, the computed amounts cannot be changed;
Sage 100 Contractor posts the job and equipment costs, and updates the wage and payroll calculation balances in the
employee records.

About payroll record status

The status indicates the condition of the payroll record.

IMPORTANT: A ledger transaction for a reversed
payroll record is not reversed until you re-post it to the
general ledger using thePost button on the 5-2-6 Post
Payroll to GLwindow.

Status Description

1-Open Not yet computed.

2-Computed Indicates a final-compute or hand-compute.

3-Posted You have posted the record.

4-Reversed You have voided but not posted the record.

5-Void You have either voided the record or reversed and posted
the record.

About payroll record types

The payroll record type indicates what kind of payroll record you are entering.
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Type Description

1-Regular A record timecard entry.

2-Bonus A lump sum paid to an employee.

3-Hand Computed An adjusting entry made to the payroll calculation
balances in an employee record.

4-Start Up An entry that is not journalized.

5-Advance An entry that advances funds to an employee.

6-Third Party Third-party sick pay.

About pay types

The pay type categorizes the timecard line and determines the rate of pay. A pay type is required for each timecard line.
Pay types 1 through 6 use the hourly rates indicated in the employee record or paygroup. For pay type 7, enter the rate in the
Piece Rate column.

Pay Type Computes pay at

1-Regular Standard pay rate.

2-Overtime Standard overtime pay rate.

3-Premium Double-time pay rate (often for night shift, holidays,
etc.)

4-Sick
Standard pay rate for sick leave.

Decreases the accrued sick hours in the employee
record.

5-Vacation
Standard pay rate for vacation.

Decreases the accrued vacation hours in the
employee record.

6-Holiday
Standard pay rate for holidays.

Use type 6-Holiday for employees who do not work
on a holiday, but are paid for the day.

7-Piece

Piece rate by the piece completed.

In theHours cell, enter the number of hours worked.

In thePiece Rate cell, enter the rate for each piece
completed.

In thePieces cell, enter the number of pieces
completed.

8-Per Diem
Lump sum for traveling expenses, etc.

In thePay Rate cell, enter the amount.
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Pay Type Computes pay at

9-Miscellaneous
Lump sum for bonuses, etc.

In thePay Rate cell, enter the amount of the
payment.

Checking for budgeted cost codes and cost types

When you select theBudget Verification command, Sage 100 Contractor compares the cost codes and cost types in the
timecard against the cost codes and cost types in the budgets. When you save the record, Sage 100 Contractor notifies
you if a line item does not appear in the budget of a job.

To check for budgeted cost codes and cost types:

Open 5-2-2 Payroll Records.

On theOptionsmenu, click Budget Verification.

About payroll record errors

Payroll record errors result from inaccurate timecard entry, employee record setup, or payroll calculation setup. Before
attempting to correct the error, determine its cause. In most cases correct the setup problem first, and then correct the
payroll record error.

IMPORTANT: If the wrong payroll posting accounts were set up in the 5-3-3 Employee Positionswindow, void the
erroneous payroll records. Voiding the payroll records first ensures that reversing transactions are posted to the same
accounts. Then enter the correct posting accounts in the 5-3-3 Employee Positionswindow. Finally, enter the
correct payroll records.

There are two status settings:

l 1-Open: Sage 100 Contractor has not created cost records, printed paychecks, or posted payroll to the general
ledger. You can edit most information in the record. If the record is a duplicate, you can delete it. If you have
assigned the wrong payroll type, void the record.

l 2-Computed: If you have not printed a check, void the original record. Then enter a new record with the correct data.
You can trial-compute the record tomake sure all the data is correct before the final-compute.

If you printed a check but did not issue it to the employee, void the original record. Then enter a new record with the correct
data. You can trial-compute the record tomake sure all the data is correct before the final-compute. Tomaintain an accurate
audit trail, cancel the check number of the erroneous check.

If you issued the check to the employee, void the original record. Then enter a payroll advance for the net amount of the
check. Tomaintain an accurate audit trail, enter the original check number in theCheck Number box. Then enter a new
record with the correct data. You can trial-compute the record tomake sure all the data is correct before the final-compute.

Sage 100 Contractor recovers the payroll advance from the subsequent paychecks. If you overpaid the employee due to
error, and the subsequent check results in a net $0 amount, print the check to plain paper and provide a copy to the
employee. If you underpaid the employee due to error, print the new paycheck and give it to the employee. Always provide
the employee with a copy of the correct payroll information.

About images included with employee records

You can assign the image of an employee to the employee’s record. Sage 100 Contractor supports the following types of
images: .bmp, .jpeg/.jpg, .gif, .emf, .wmf, and .ico files.
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Assigning images to records

You can assign a single image or a series of images to a record. When you include an image in a file, Sage 100 Contractor
saves a copy to the Images folder, which is located in the \MB7\company folder.

For a series of images, the images must use the correct naming convention. Assign each image in the series to the record.
Sage 100 Contractor copies the image files to the appropriate folder for you.

To assign an image to a record:

1 Using the data control, select the record to which you want to assign an image.

2 On theEditmenu, click Image.

3 Click Browse.

4 In theAssign Image dialog box, choose the image you want to assign to the record and click Open.

5 Click OK.

Entering Payroll

About entering payroll records

For each non-salaried employee, you enter a separate record with a breakdown of his or her time on the Timecard tab. On
each timecard line you can enter the hours worked on a specific job, or the hours worked performing repairs and
maintenance on a piece of equipment. Each timecard line also requires a pay type, which indicates the type of wages to
compute the wages for the line. When you final-compute the payroll, Sage 100 Contractor creates the job and equipment
costs based on the timecard lines.

There are two ways to enter payroll records for salaried employees. Most salary records only require the salary amount and
do not need a breakdown of the employee’s hours. If you need to create job or equipment costs for a salaried employee’s
time, you then need to classify his or her time on the Timecard tab.

Payroll records for hand-computed checks, advances, and third-party payments do not use timecard information. A hand-
computed check lets you adjust the payroll calculation balances stored in an employee’s record. You can enter a bonus as
a separate record from a timecard, or you can include in on the timecard.

Entering timecards

Consider the following points before entering timecards:

l To determine the default Workers’ Compensation code, Sage 100 Contractor first checks to see if theUse Emp
Comp Code check box on 5-2-1 Employees is selected for that employee record. If not, then Sage 100 Contractor
looks to theComp Code1 column on 6-5 Cost Codes to determine the default Workers’ Compensation code. If it
does not find a compensation code there, then it looks back to theComp Code text box on 5-2-1 Employees for
theWorkers’ Compensation code and uses that one for determining the default.

l To determine the department number for posting, Sage 100 Contractor first looks to the job. If Sage 100 Contractor
does not find a department, Sage 100 Contractor then looks at the cost code. If it does not contain a department
number, Sage 100 Contractor then looks to the employee position.

l You can enter negative hours. To compute payroll records correctly, enter the timecard line containing the negative
hours first. This ensures deductions, benefits, or other calculations that use calculationmaximums compute
properly.

l Tomake sure all payroll records are final-computed and posted, enter checks for pay advances, bonuses, or layoffs
using the same period ending date as regular payroll.
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l You can display a summary of the local payroll taxes computed for a timecard.

l You can compute an employee’s hourly rate per piece by using piece pay.

IMPORTANT: TheDirect Deposit check box appears “selected” only if theUse Direct Deposit check box is
selected on theCompensation tab of 5-2-1 Employees.

To enter a timecard:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.

5 In theCheck Date text box, enter the date when the check is to be issued.

6 In theCheck# text box, type 0000.

When you print the check, Sage 100 Contractor assigns the check number to the record.

7 If you have already issued the check, enter the check number in theCheck# text box.

8 In thePayroll Type list, click 1-Regular.

9 In theQuarter text box, enter the payroll quarter.

10In theState text box, enter the tax state.

11 In the Timecard tab, do the following:

a In theDate cell, enter the date on which the employee worked.

b If the employee worked on a job, enter the job number in the Job cell. If the employee worked on equipment, enter the
equipment number in theEquipment cell.

c If the job is in a local payroll tax district, enter the local payroll district number in the Locality cell. This field's default
value is from theWork Locale field that is assigned in the employee's record in 5-2-1 Employees in theHuman
Resources tab.

d If the job requires certified payroll, type Yes in theCertified cell.

e If the job uses phases, enter the phase number in thePhase cell.

f If the employee worked on a job or repaired equipment, enter the cost code number in theCost Code cell.

g In thePay Type cell, enter the pay type.

h If you are using paygroups, enter the paygroup number in thePaygroup cell.

i In thePay Rate cell, enter the employee’s pay rate.

j In theHours cell, enter the number of hours the employee worked.

k In theComp Code cell, enter theWorkers’ Compensation code number.

l If you are using departments, enter the department number in theDepartment cell.

m In theAbsences cell, enter the user-defined reason for the employee’s absence.

12 Repeat step 11 for each payroll item.

13 On the Filemenu, click Save.
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About absences

TheAbsence column on the Timecard tab of 5-2-2 Payroll Records can be used to record user-defined descriptions of
employee absences when entering information on employee timecards. This column is optional.

TheAbsences cell is for informational purposes only and does not affect the employee’s pay. ThePay Type cell on the
Timecard tab of 5-2-2 Payroll Records controls the designation of the type of pay for that employee and is required.

About Autofill Pay Rate

If you use security to hide thePay Rate column in 5-2-2 Payroll Records, you can turn onAutofill Pay Rate to fill in the
default Pay Rate automatically for users that do not have access to pay rate information.

l Only a user logged in as Supervisor has rights to turn this option on and off.

l Security must be defined for thePay Rate column for user(s) that can and cannot access it. For users who cannot
view Pay Rate information, theAutofill Pay Rate is automatically filled in when the user finishes entering a
timecard.

To turn on Autofill Pay Rate:

1 Open 5-2-2 Payroll Records.

2 Click Options.

3 Click Autofill Pay Rate.

Importing service records

When service records contain a date of completion and the actual hours worked, you can create a timecard from the service
records.

IMPORTANT:

The service records only contain the dates and hours worked. Review the timecard and enter any additional information.

To import service records:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.

5 On theOptionsmenu, point to Import Data and click Service Orders.

Entering per diem payments

Per diem payments cover expenses incurred by the employee during the course of work. Usually expenses are limited to
travel, food, and lodging. Themaximum rates are set by the Internal Revenue Service.

The company incurs the expense of per diem, not the employee. Therefore, the per diem provided to the employee is non-
taxable. In the 5-3-1 Payroll Calculationswindow, set up a payroll calculation that exempts the per diem from taxes.

To enter per diem payments:

1 Open 5-2-2 Payroll Records.

2 In the Type list, click 8-Per Diem.
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3 In thePay Rate text box, enter the amount.

TIP: If you enter a job number on the timecard line, Sage 100 Contractor will job cost the per diem when you final-
compute the timecard.

About piece pay

Piece pay can be used both for the 5-5-1 Daily Payroll Entry payroll method and the 5-5-2 Payroll Records payroll
method.

For either method, enter thePay Type, Hours (hours worked to complete the pieces), Piece Rate (rate per piece) and
Pieces to calculate theHourly Rate for Pieces. Entering the hours is optional. If you do not enter the number of hours
worked for that day, theHourly Rate for Pieceswill not calculate.

IMPORTANT:

l If you are entering the pay information in theDaily Payroll, theHourly Rate for Pieceswill not display until a
timecard has been created for that employee.

l The pay informationmust have aPay Type of 7-Piece to be entered as piece pay.

About payroll advances

When you give a payroll advance to an employee, Sage 100 Contractor debits thePayroll Advance ledger account and
records the amount in theAdvances Due text box in the employee’s record. Payroll advances are considered a type of
short-term loan and are not subject to payroll deductions.

You can deduct the advance from the employee’s next paycheck, or a flat amount each pay period until the advance has
been recovered. As you recover the advance, Sage 100 Contractor updates theAdvances Due text box to reflect the
current amount due. When the amount in theAdvances Due text box reaches $0, Sage 100 Contractor stops making a
deduction from the employee’s pay.

About employee loans

Some companies provide long term loans or interest-bearing loans to employees. Instead of writing a payroll check for the
advance, write a general ledger check to the employee. Post the amount to the loans receivable account. If you don't have
a subaccount for loans receivable, you can set one up.

If you give several employees long term loans, consider using subsidiary accounts to track each loan separately. Because
loans are posted to different ledger accounts than payroll advances, set up a separate payroll calculation to recover the
loan.

Entering wages for salaried employees

A salaried employee receives the same pay regardless of how many hours are worked. So it is usually not necessary to
provide the number of hours worked.

IMPORTANT: When a salaried employee is subject to a local payroll tax, enter the hours worked and the local tax
district number on the Timecard tab.

To enter wages for a salaried employee:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.
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5 In theCheck Date text box, enter the date when the check is to be issued.

6 In theCheck# text box, type 0000.

When you print the check, Sage 100 Contractor assigns the check number to the record.

7 If you have already issued the check, enter the check number in theCheck# text box.

8 In thePayroll Type list, click 1-Regular.

9 In theQuarter text box, enter the payroll quarter.

10In theState text box, enter the tax state.

11 In theSalary text box, enter the salary.

12 On the Filemenu, click Save.

TIP: You can job cost payroll for salaried employees.

Job costing salaried employees

If a salaried employee spends time working on a job or repairing equipment, you can create the appropriate job or equipment
cost records. On the Timecard tab, enter the hours the employee has spent working jobs or repairing equipment during the
pay period. Also, include the hours spent in an overhead or administrative capacity.

When you compute payroll, Sage 100 Contractor calculates the gross hourly wage (employee salary / total hours = gross
hourly wage). If a salaried employee works more than 40 hours in a week, the calculated gross hourly wage is lower.
Therefore, to compute a gross hourly wage based on a 40-hour week, enter a timecard line for negative hours and attribute
them to a dummy job (created strictly for this purpose). The dummy job allows you to enter all hours worked without
affecting the costs attributed to the jobs or equipment.

Suppose Robert, a salaried administrator, worked eight hours as a carpenter on a job. He also worked 32 hours as an
administrator. The first timecard line contains the job, cost code, payroll line type, hours, andWorkers’ Compensation
code. The second timecard line contains the payroll line type, non-job or equipment related hours worked, and theWorkers’
Compensation code. When you final-compute the payroll record, Sage 100 Contractor attributes the cost of eight hours
labor to the job and 32 hours labor to administration.

To job cost a salaried employee:

1 Open 5-2-2 Payroll Records.

2 In theEmployee box, enter the employee number.

3 In thePeriod Start box, enter the date when the payroll period begins.

4 In thePeriod End box, enter the date when the payroll period ends.

5 In theCheck Date box, enter the date when the check is to be issued.

6 In theCheck# box, type 0000.

When you print the check, Sage 100 Contractor assigns the check number to the record.

7 If you have already issued the check, enter the check number in theCheck# text box.

8 In thePayroll Type list, click 1-Regular.

9 In theQuarter box, enter the payroll quarter.

10In theState text box, enter the tax state.

11 In theSalary box, enter the salary.
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12 In the Timecard tab, do the following:

a In theDate cell, enter the date on which the employee worked.

b If the employee worked on a job, enter the job number in the Job cell.

c If the employee repaired equipment, enter the equipment number in theEquipment cell.

d If the job is in a local payroll tax district, enter the local payroll district number in the Locality cell.

e If the job requires certified payroll, type Yes in theCertified cell.

f If the job uses phases, enter the phase number in thePhase cell.

g If the employee worked on a job or repaired equipment, enter the cost code number in theCost Code cell.

h In thePay Type cell, enter the payroll line type.

i In theCompensation Code cell, enter theWorkers’ Compensation code number.

j If you are using departments, enter the department number in theDepartment cell.

13 Repeat step 12 for each payroll item.

14 On the Filemenu, click Save.

TIPS:
l To compute payroll records correctly, enter the timecard line containing the negative hours first. This ensures

deductions, benefits, or other calculations that use calculationmaximums compute properly.

l When a salaried employee is subject to a local payroll tax, enter the local payroll tax district on the Timecard
tab.

Payroll Bonuses

About bonus checks

IMPORTANT: Sage 100 Contractor does not support the higher bonus rate of 35% for supplemental wages which
exceed onemillion dollars in a year.

You can enter bonus checks in two ways.

l As a separate paycheck. Sage 100 Contractor computes Federal Income Tax based on the federal bonus tax rate.

l Include it in a regular paycheck. Sage 100 Contractor computes Federal Income Tax and State Income Tax using
the standard tax tables.

Entering bonuses as separate records

IMPORTANT: Always trial-compute and review the amounts on theCalculations tab. Sage 100 Contractor does not
compute the state income tax for all states. Youmay have tomanually compute the amount of state income tax to
withhold, and enter it in on theCalculations tab.

Some deductions or benefits might not apply to bonuses. Check with your benefits plan administrator, as well as any other
state and local agencies to determine which deductions and benefits apply.

To enter a bonus as a separate record:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.
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5 In theCheck Date text box, enter the date when the check is to be issued.

6 In theCheck# text box, type 0000.

7 When you print the check, Sage 100 Contractor assigns the check number to the record.

8 If you have already issued the check, enter the check number in theCheck# text box.

9 In thePayroll Type list, click 2-Bonus.

10 In theQuarter text box, enter the payroll quarter.

11 In theStatetext box, enter the tax state.

Important:

If the bonus is to be job costed, enter the bonus amount in thePay Rate column, and using pay type 9-Misc, put the bonus
in the grid.

If the bonus does not need to be job costed, it can be entered in theSalary text box.

12 On the Filemenu, click Save.
If necessary, you can override a calculated amount.

Including bonuses in salaried employee payroll records

To include a bonus in a salaried employee’s record:

Open 5-2-2 Payroll Records, browse to the payroll record for the salaried employee, and click the Timecard tab.

In the Timecard tab, do the following:

1. In theDescription cell, enter a brief statement about the bonus.

2. In thePay Type cell, enter type 9-Miscellaneous.

3. In thePay Rate cell, enter the amount of the bonus.

4. In theCompensation Code cell, enter theWorkers’ Compensation code number.

5. If you are using departments, enter the department number in theDepartment cell.

On the Filemenu, click Save.

Including bonuses in employee timecards

To include a bonus in an employee’s timecard:

1 Enter the timecard for the employee.

2 On a separate timecard line, do the following:

a In theDescription cell, enter a brief statement about the bonus.

b If you want to job cost the bonus, enter the job number in the Job cell.

c If the job is in a local payroll tax district, enter the local payroll district number in the Locality cell.

d If the job requires certified payroll, type Yes in theCertified cell.

e If the job uses phases, enter the phase number in thePhase cell.

f If the employee worked on a job, enter the cost code number in theCost Code cell.

g In thePay Type cell, click 9-Miscellaneous.

h In thePay Rate cell, enter the amount of the bonus.
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i In theCompensation Code cell, enter theWorkers’ Compensation code number.

j If you are using departments, enter the department number in theDepartment cell.

3 On the Filemenu, click Save.

Hand-computed Checks

About hand-computed checks

IMPORTANT: When adjusting any calculation balances, it is important to consider the impact to the employee’s
taxable wages. Additional adjustments to the wages may be necessary.

Use hand-computed payroll checks tomake small adjustments to the calculation balances stored in an employee record.
When you assign pay type 3-Hand Computed to a payroll record, Sage 100 Contractor limits entry to theCalculations
tab.

To adjust the balance of an employer cost, enter a negative sum to deduct from the balance, or enter a positive sum to add
to the balance. The adjustment does not affect the employee’s net wages.

To adjust employee costs, transfer the sum from one calculation balance to another. Depending on which balance you are
adjusting, you can offset the net check amount to Federal Income Tax, State Income Tax, orPayroll Advance.

l Use Federal Income Tax to adjust federal taxes such as Social Security or Medicare.

l UseState Income Tax to adjust state taxes such as state disability insurance.

l UsePayroll Advance to change the amount of the net paycheck.

Suppose that you have over-deducted $10 for Social Security from Dick’s gross wages. On theCalculations tab, you enter
–$10 in theAmount cell for theEmployee Social Security calculation. Then in the Amount cell of FIT, enter $10. Sage
100 Contractor deducts the $10 from theEmployee Social Security balance and adds it to the FIT balance. Rather than
moving the balance to FIT, you could enter the amount inPayroll Advance. Sage 100 Contractor would then add $10 to the
employee’s next paycheck.

Entering hand-computedchecks to adjust employee deduction balances

IMPORTANT: Sage 100 Contractor does not create job costs for hand-computed checks.

To enter a hand-computed check to adjust employee deduction balances:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.

5 In theCheck Date text box, enter the date when the check is to be issued.

6 In theCheck# text box, enter a dummy check number, such as 9999.

7 In thePayroll Type list, click 3-Hand Computed.

8 In theQuarter text box, enter the payroll quarter.

9 In theState text box, enter the tax state.

10 If theSalary box is autofilled, delete the amount.

11 Click theCalculations tab.

12 If the calculation balance is too high, do the following:
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a In theAmount cell, enter the sum you want to deduct from the balance as a negative.

b In theAmount cell of the payroll calculation to which you aremoving the sum, enter the sum as a positive.

13If the calculation balance is too low, do the following:

c In theAmount cell, enter the amount you want to add.

d In theAmount cell of the payroll calculation from which you are taking the sum, enter the sum as a negative.

14 On the Filemenu, click Save.

TIP: Sage 100 Contractor assigns a hand-computed check status 2-Computed. It is not necessary to perform a
final-compute to post the record.

Entering hand-computedchecks to adjust employer cost balances

IMPORTANT: Sage 100 Contractor does not create job costs for hand-computed checks.

To enter a hand-computed check to adjust employer cost balances:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.

5 In theCheck Date text box, enter the date when the check is to be issued.

6 In theCheck# text box, enter a dummy check number, such as 9999.

7 In thePayroll Type list, click 3-Hand Computed.

8 In theQuarter text box, enter the payroll quarter.

9 In theState text box, enter the tax state.

10If theSalary box is autofilled, delete the amount.

11Click theCalculations tab.

a If the calculation balance is too high, in theAmount cell, enter the sum you want to deduct from the balance as a
negative.

b If the calculation balance is too low, in theAmount cell, enter the amount you want to add.

12On the Filemenu, click Save.

TIP: Sage 100 Contractor assigns a hand-computed check status 2-Computed. It is not necessary to perform a
final-compute to post the record.

About third-party sick pay

In some states, a third party pays for employees receiving sick pay or disability insurance. In most instances, the employer
is responsible for reporting the deductions and wages. If your company is responsible for reporting the sick pay wages, you
can enter payroll records using pay type 6-Third Party.

When you post a payroll record with pay type 6-Third Party, Sage 100 Contractor:
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l Adds the employee costs to the calculation balances stored in the employee’s record.

l Adds the employer costs to the calculation balances stored in the employee’s record.

l Posts the employer costs to the general ledger.

For more information about third-party sick pay, see IRS publication 15A, The Employer’s Supplemental Tax Guide.

Entering third-party sick pay

Consider the following points before entering third-party pay:

l For third-party sick pay to bemarked onW-2s, you need to select the Third-Party Sick Pay check box on the
Compensation tab of the 5-2-1 Employeeswindow.

l Before saving the record, compare the calculation balances stored in the employee record with the payroll
calculationmaximums.

l Because you enter the calculation amounts, Sage 100 Contractor assigns the record status 2-Computed.
Therefore, Sage 100 Contractor does not check to see if the calculationmaximums have been exceeded.

To enter third-party sick pay:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.

5 In theCheck Date text box, enter the date when the check is to be issued.

6 In theCheck# text box, enter a dummy check number.

7 In thePayroll Type list, click 6-Third Party.

8 In theQuarter text box, enter the payroll quarter.

9 In theState text box, enter the tax state.

10 In theSalary text box, enter the amount of the employee’s gross wage.

11 In theCalculations tab, do the following:

a For each employee cost paid by the third party, enter the amount in the appropriateAmount cell.

b For each employer cost, enter the amount in the appropriateAmount cell.

12 On the Filemenu, click Save.

Employee Record Calculations

About calculations in payroll records

TheCalculations tab in the 5-2-2 Payroll Recordswindow lets you view the deduction and benefit amounts for a timecard
after the trial or final-compute. After setting up a new employee record or adding a new payroll calculation to an employee
record, it is a good idea to review the computed amounts after a trial-compute. The review ensures that the payroll
calculation and the calculation rates in the employee record have been set up correctly.

For a single timecard, you can alsomanually enter an amount for a payroll calculation and override what Sage 100
Contractor would otherwise compute. During a trial or final-compute, Sage 100 Contractor looks at theOverride column.
When anOverride cell contains Yes, Sage 100 Contractor uses the amount you have entered for that calculation. After you
have performed a final-compute for timecards, you cannot change the computed amounts on those timecards.
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Suppose that you advance Rob $500, and set up a calculation to recover the advance at a rate of $50 per paycheck. One
week, Rob works far more than usual and suggests that you deduct $200 from this paycheck. If you were to change the
calculation rate for the payroll advance in Rob’s employee record, you would then have to change the rate back after the
final-compute. Because the $200 deduction is only for one paycheck, adjust the computed amount on the timecard. On the
Calculations tab, locate thePayroll Advance calculation, enter $200 in theAmount cell, and type Yes in theOverride
cell.

You can also use theCalculations tab to adjust the deduction or benefit balances for a specific employee. When you enter
a hand-computed check, you can subtract from the balance of one payroll calculation and add it to another.

Overriding payroll record calculations

Before the final-compute for payroll records, you can override the calculated amounts. If you know the amount, enter it
while entering the timecard. Otherwise, it is a good idea to trial-compute the payroll records first. Then when reviewing the
trial-computed record, enter the amount.

To override a payroll record calculation:

1 Open 5-2-2 Payroll Records.

2 Enter the timecard.

3 On the Filemenu, click Save.

4 Open 5-2-3 Compute Payroll, and select Trial-compute the payroll record(s).

Important:

After final-computing a payroll record, you cannot change the amounts on theCalculations tab.

5 In the 5-2-2 Payroll Recordswindow, select the record you want to change.

6 Click theCalculations tab.

7 For each payroll calculation that you want to change, do the following:

8 In theAmount cell, enter the amount that you want to use.

9 In theOverride cell, type Yes.

10 On the Filemenu, click Save.

TIP: When a payroll record is assigned status 1-Open or 2-Bonus, type Yes in anOverride cell for Sage 100
Contractor to use the amount you enter.

Reprinting Payroll Checks

Reprinting unposted payroll checks

Sage 100 Contractor automatically updates the existing ledger record and associated job cost/equipment records with the
new check number when it assigns the new check number to the existing payroll record.

To reprint an unposted payroll check:

1 Open 5-2-2 Payroll Records.

2 Select the timecard for which you want to reprint the check.

3 In theCheck# text box, delete the original check number.

4 In theCheck# text box, type 0000.

5 On the Filemenu, click Save.
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6 Print the check again and assign the new check number in 5-2-4 Payroll Checks.

7 Cancel the original check number tomaintain an accurate check register.

Reprinting previously posted payroll checks

Sage 100 Contractor automatically updates the existing ledger record and associated job cost/equipment records with the
new check number when it assigns the new check number to the existing payroll record.

To reprint a previously posted payroll check:

1 Open 5-2-2 Payroll Records.

2 Select the timecard for which you want to reprint the check.

3 In theCheck# text box, delete the original check number.

4 In theCheck# text box, type 0000.

5 On the Filemenu, click Save.

6 Print the checkagain.

7 Cancel the original check number tomaintain an accurate check register.

Voiding payroll records

CAUTION: Voiding payroll records is not possible from 5-2-2 Payroll Records if the record has a status of 2-
Cleared in the general ledger. To void a posted payroll record, youmust change its status in 1-3 Journal
Transactions to 1-Open. Changing general ledger transactions with a status of 2-Cleared is not a recommended best
practice in accounting.

When you void a payroll record, it is voided in the period in which it was entered. All parts of the record are voided, such as
withholding taxes, Social Security, and so forth.

To reissue another check, you have to create new payroll record and process it as you normally process your payroll
records.

To void a payroll record:

1 Open 5-2-2 Payroll Records.

2 Using the data control, select the record.

3 From theEditmenu, select Void Payroll Record.

4 Re-open the payroll record and note that the status has been changed to 5-Void.

Voiding payroll records and re-entering the correct data for previously issued checks

CAUTION: Voiding payroll records is not possible from 5-2-2 Payroll Records if the record has a status of 2-
Cleared in the general ledger. To void a posted payroll record, youmust change its status in 1-3 Journal
Transactions to 1-Open. Changing general ledger transactions with a status of 2-Cleared is not a recommended best
practice in accounting.

To void a payroll record and re-enter the correct data for a previously issued check:

1 Open 5-2-2 Payroll Records.

2 Using the data control, select the record.

3 Void the record.

4 Enter a payroll advance for the net amount of the erroneous check.
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5 In the record for the advance, enter the original check number in theCheck Number text box.

6 Enter a payroll record with the correct data.

7 Open 5-2-3 Compute Payroll.

8 Trial-compute and review the record.

9 If the record is correct, you can final-compute the record and print the check.

TIPS:
l Always provide the employee with a copy of the correct payroll information. If you overpaid the employee due

to error and the subsequent check results in a net $0 amount, print the check to plain paper.

l If you underpaid the employee due to error, print the new paycheck and give it to the employee.

Reversing payroll records

Youmay need to reverse posted payroll records rather than void them directly if your accounting is based on a fiscal year
rather than a calendar year.

For example, let’s suppose you have closed the general ledger for the fiscal year, but you cannot simply void payroll
records that belong to that fiscal year’s general ledger. You have to reverse them. After you reverse the void payroll records,
you have to re-post them because reversing payroll records has the effect of voiding them.

To reverse a payroll record:

1 Open 5-2-2 Payroll Records.

2 Select a record, and then click Edit > Void Payroll Record.

3 If you have closed the general ledger for that fiscal year, Sage 100 Contractor displays amessage stating that you
cannot directly void the ledger transaction for this payroll record. There is no general ledger record to void in the current
year.

4 To themessage, click OK.

5 You see a secondmessage stating that the payroll record and cost records have been voided. A reversing transaction
will need to be posted.

6 On this message, click OK.

7 Youmay notice that record assumes the status of Reverse.

NOTE: The payroll record at this point is not reversed in the general ledger. You still have onemore step to complete.

8 Open 5-2-6 Post Payroll to GL.

TIP: You can post to any period that you need to.

9 In theRecord# text box, enter the record number.

10 Click thePost button.

11 To verify that the reversal has been posted, go to the payroll record and verify that the status has changed to 5-Void. At
the bottom left corner of the payroll record click Go to Transaction and verify that the 1-3 Journal Transaction is
correct.

Correcting payroll records associated with paid T and M invoices

Completing this task requires that you complete five procedures:
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l Part A—Reverse the payment

l Part B—Void the T&M invoice

l Part C—Void and re-create the payroll record

l Part D—Recompute and post the T&M invoice

l Part E—Repay the T&M invoice in the 3-3-1 Cash Receiptswindow

Part A—To reverse the cash receipt payment.
1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount box, enter the ledger account number for the cash account.

b In theDeposit# box, enter the deposit transaction number.

c In theDate box, enter the deposit date.

d In theDescription box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient box, enter the client number.

b In the Job box, enter the job number.

4 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

5 Consider the following:

a If the invoices are partially paid, select theOpen only option.

b If the invoices are completely paid, select thePaid only option.

c If you have a combination of paid and partially paid invoices, select theAll option.

6 Click theDisplay button.

7 In the grid, do the following:

a In thePaid (Cash) cell, enter the amount as a negative amount.

b In theDiscount cell, enter the discount amount, if any, as a negative amount.

8 Repeat step 7 for each payment you want to reverse.

9 On the Filemenu, click Save.

TIP: When you reverse a payment made to an invoice with status 4-Paid, Sage 100 Contractor changes the status to
1-Open.

10 After reversing all payments made to an invoice, you can void the invoice.
Part B—Void the T&M invoice
1 Open 3-2 Receivable Invoices/Credits.

2 Display the invoice that you need to void.

3 From theEditmenu, select Void Invoice.
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4 To themessage, This invoice was created from Time and Materials Billing. Are you sure you want to continue?
click Yes.

TIP: Formore information, see the topic, .

5 To themessage, You are about to void this record. Do you want to continue? click Yes.

6 To themessage, Do you want to reset 'Billing Status' to Open on the job cost records? click Yes.
Part C—Void and re-create the payroll record.
1 Open 5-2-2 Payroll Records.

2 Display the record you need to correct.

3 From theEditmenu, select Copy Payroll Record.

4 From theEditmenu, select Void Payroll Record.

5 To themessage, You are about to void this record. Do you want to continue? click Yes.

6 To themessage, Ledger transaction found for this payroll record. Do you want to have the existing transaction
altered to 'Void'? click Yes.

TIP: AnswerNo to post a new, reversing transaction.

7 To themessage, Payroll record, cost records, and ledger transaction have all been voided, click OK.

8 From theEdit menu, select Paste Payroll Record.

9 Make the necessary changes to the payroll record.

10 From the Filemenu, select Save.

11 Recompute and re-post the payroll as usual.
Part D—Recompute and re-post the T&M invoice
1 Open 3-10-2 Compute T&M Invoices.

2 In the Invoice Date box, enter the date you want to assign the invoices.

3 Select the criteria to choose the invoices you want to calculate.

4 Click Compute.

5 Next, you have to post time andmaterials invoices:

a Open 3-10-4 Post T&M Invoices.

b Select the invoices you want to post.

c Click Post.
Part E—Repay the T&M invoice using the 3-3-1 Cash Receipts window

To enter a payment against an invoice:

1 Open 3-3-1 Cash Receipts.

2 Do the following:

a In theAccount text box, enter the ledger account number for the cash account.

b In theDeposit# text box, enter the deposit number.

c In theDate text box, enter the deposit date.
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d In theDescription text box, enter a brief statement about the transaction.

3 Do one of the following:

a In theClient text box, enter the client number.

b In the Job text box, enter the job number.

4 Do one of the following:

a Click theContract Invoices tab.

b Click theService Invoices tab.

c Click theDisplay button.

5 In the grid, do the following:

a In thePaid (Cash) cell, enter the total amount received.

b Do not include any discount or credit in this amount.

i If you are using discounts, in theDisc Available cell, enter the amount of the discount.

ii If you are not using discounts, skip step b.

IMPORTANT: To enter an overpayment for an invoice, the total of thePaid (Cash) and Discount cells must equal
the amount in theBalance text box. Then in theOverpayment cell, enter the amount paid in addition to the invoice
payment, not the total amount.

6 Repeat step 6 for each invoice you want to pay.

7 On the Filemenu, click Save.

TIP: If you do not enter a job number or client number, Sage 100 Contractor displays all invoices.

5-2-3 Compute Payroll
About computing payroll records

You can perform a trial-compute or a final-compute of the payroll records. During a compute, Sage 100 Contractor
calculates the wages, deductions, benefits, and employer costs for each timecard.

After a trial-compute, you can review the individual payroll records, check the accuracy of the payroll calculations, and
make any last-minute adjustments. Before the final-compute, you can override a payroll calculation in a specific record and
provide the amount you want Sage 100 Contractor to use.

When a final-compute is completed, Sage 100 Contractor changes the status of the records to 2-Computed and creates
the job costs. In the employee records, Sage 100 Contractor updates the quarterly and year-to-date totals for gross wages,
Social Security, andMedicare. Sage 100 Contractor also updates the quarterly totals of the payroll calculations.

After you have done the final-compute of the payroll, you can print payroll checks and post the records. If the posting period
has changed between the time of the final compute and posting to the general ledger, Sage 100 Contractor updates the
posting period of the job cost records.

Job costs are created as part of the final compute of the payroll. At that time, however, neither the check number nor the
accounting period of the check transaction is available. The job cost records are updated later with the check number when
the check is printed. Then the accounting period and the ledger transaction link are updated when the check is posted to the
general ledger.

Computing payroll records

Consider the following points before computing payroll records:
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l Job costs are created as part of the final compute of the payroll. At that time, however, neither the check number nor
the accounting period of the check transaction is available. The job cost records are updated later with the check
number when the check is printed. Then the accounting period and the ledger transaction link are updated when the
check is posted to the general ledger.

l You can limit the compute to a specific pay period. In thePay Period Ending text box, enter the date when the pay
period ended.

l After the final-compute, verify that the records computed correctly. You can print aPayroll Check report, including
the deductions, from 5-1-2 Payroll Check Register. After posting the payroll, you can print the report again when it
includes the check numbers.

Example of Trial Compute using the Sample Company

1 Open the Sample Company.

2 Open 5-2-3 Compute Payroll.

3 Click Display pick list window next to theEmployee Pick List text box.

4 Select employees 1, 2, 4, 6, 12, & 13 and click Insert Selected Items in the toolbar.

5 Click Trial Compute.

6 Click theCompute button.
Sage 100 Contractor shows a reminder window that 4 records will be computed.

7 Click theOK button to continue.
The payroll compute is complete.

To compute payroll records:

1 Open 5-2-3 Compute Payroll.

2 To trial compute the payroll records, click Trial Compute.

3 To final compute the payroll records, click Final Compute.

4 Click OK.

5-2-4 Payroll Checks
About 5-2-4 Payroll Checks

Clicking 5-2-4 Payroll Checks launches the 5-2-4 Report Printingwindow for printing payroll check reports and viewing
sample reports.

5-2-5 Direct Deposit File Manager
About direct deposit

Direct deposit allows your employees to have their paychecks deposited directly into their bank account. Banks require
electronic delivery of payroll information by companies wanting to provide employees with direct deposit. Sage 100
Contractor supports the creation of a file in automatic clearing house (ACH) format. You can then send this file to your
bank. Your bank will extract records from the file and create files that are routed through ACH providers to the various
employee banks.
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NOTES:
l Contact your bank to determine any delivery requirements, including encryption, additional file format

requirements, or other requirements. After establishing and agreeing on amethod of delivery with your bank,
you can create the file and deliver it in the agreed-uponmethod.

l Whenever any changes aremade to your direct deposit file format by changing any of the formatting options,
you should contact your bank and request a retest to be sure your bank is ready for the changes.

l After creating theDirect Deposit File, Sage 100 Contractor prompts you to print aDirect Deposit File
Report that shows yourDirect Deposit File information. If you do not print that report at that time and need to
reprint the report, useOptions > Reprint Direct Deposit Report.

Two documents can be created during a direct deposit run: theDirect Deposit File and theDirect Deposit File Report.

l Direct Deposit File—TheDirect Deposit file is created in Automated Clearing House (ACH) format and is saved as
a .txt file used by the bank. By default it is saved in the x:\MB7\companyname\Direct Deposit folder (where x: is
your network drive). The next time you save your direct deposit file, Sage 100 Contractor defaults to the directory
where the file was last saved. The exact location of your direct file appears on theDirect Deposit File Report.

l Direct Deposit File Report—The generated report is saved in the \MB7\companyname\Reports folder as an .rtf or
.pdf.

Printed checks have a unique check number and an electronic deposit number that correspond to the payroll record number.
Sage 100 Contractor users with checks pre-printed with check numbers should process check runs in sequence.

Printing direct deposit payroll checks creates and prints a non-negotiable check and supplies the employee with a record of
the payroll. You have three options for printing direct deposit checks in 5-2-4 Payroll Checks.

Direct deposit is limited to employee payroll only. Sage 100 Contractor does not support electronic payment or electronic
transfer of funds for such things as:

l Federal, state, or local taxes

l Child care support payments

l Wage garnishment

About setting up direct deposit

Before you begin to set up and process direct deposit, consider the following:

l Obtain the account and routing numbers from each employee for the bank accounts into which they want their
paycheck deposited.

l Determine if your bank requires a pre-notification.

l Contact your bank to determine any delivery requirements, including encryption, additional file format requirements,
or other requirements specific to an individual bank.

Setting up direct deposit involves entering information in two windows, 7-2 Company Information and 5-2-1 Employees.

UnderPayroll Direct Deposit Setup in the 7-2 Company Information window, you set up the parameters that control
themovement of information between your company and your bank. This is where you enter your company bank account
number, routing number, and account type, which is either checking or savings. There are also three check boxes located
underAccount Type that specify the format of the file type sent to the bank.

CAUTION: Whenever any changes aremade to your direct deposit file format by changing any of the formatting
options, you should contact your bank and request a retest to be sure your bank is ready for the changes.
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You can set up direct deposit of paychecks using theDirect Deposit tab in 5-2-1 Employees. The employeemust provide
you with the following information for each account to which he or she wants funds deposited: account type, routing
number, account number, rate type, and rate. You can deposit funds in up to four different bank accounts for an employee.

IMPORTANT:

l Sage 100 Contractor does not support an employee receiving a combination of direct deposit and a physical
paycheck.

l Account status is set by the payroll administrator. It is not provided by the employee.

About Direct Deposit File Manager

When you create a direct deposit file, payroll information is recorded for employees who have authorized direct deposit to
their accounts. After the file is created, transfer the file using your bank’s specified procedure.

IMPORTANT: Before creating a direct deposit file, youmust first establish a procedure with your bank for
transferring the file.

When you create a new company, a direct deposit folder is created within the company folder.

The default file name is set to the check date and company name. Invalid characters (/ \:*?"<>|) in the file namewill be
stripped out by Sage 100 Contractor.

Creating a direct deposit file

You can create a direct deposit file that contains a batch of payroll records. This is the file that you send to your company’s
bank.

NOTE: All computed records with that check date that have theEnable direct deposit check box selected are
included in the direct deposit file.

To create a direct deposit file:

1 Open 5-2-5 Direct Deposit File Manager.

2 Enter thePayroll Check Date.

3 Enter theDate Funds Available.

4 Enter the File Creation Date.

5 Click Start.

6 When you are done creating the file, Sage 100 Contractor prompts you to print a report showing your file information.

Setting up company information for direct deposit

Setting up direct deposit involves entering information in the 7-2 Company Information. UnderDirect Deposit
Information in the 7-2 Company Information window, you set up the parameters that control themovement of
information between your company and your bank.

This is where you enter your company bank account number, routing number, and account type, which is either checking or
savings. There are also three check boxes located underAccount Type that specify the format of the file type sent to the
bank.

To set up company information for direct deposit:

1 Open 7-2 Company Information.
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2 Click thePayroll Direct Deposit Setup tab.

3 Complete the following in theCompany bank information for direct deposit section:

a In theRouting# text box, enter your company’s bank routing number.

b In theAccount# text box, enter your company’s bank account number.

c In theAccount Type, select your company’s bank account type.

4 In theOptions for direct deposit ACH file section, fill out and select the appropriate options for your direct deposit
ACH file:

a Origin Bank Name—optional bank name for the 'Immediate Origin Bank Name ' field

b Destination Bank Name—optional bank name for the 'Immediate Destination Bank Name' field

c Optional Bank Routing#—Optional bank routing number for the 'Immediate Destination' field

d ID Code Designator (ICD)—select blank or any number between 1—9 for the company identification fields.

e For 'Immediate Origin Name' in file header record, select your company name orOrigin Bank Name

f For 'Immediate Destination Name in file header record, select blank orDestination Bank Name

g For 'Immediate Origin' in file header record, select your company FEIN or your routing#

h For 'Immediate Destination' in file header record, select your routing# orOptional Bank Routing#

i For File formatting options, select or clear the check boxes appropriate to the preferences of your financial
institution.

i Include company debit line

ii Include optional hard return

iii Include optional "9" fill

NOTE: If you have any questions about which check boxes to select, contact your financial institution.

Setting up employee records for direct deposit

An employee can have direct deposit for up to four separate accounts.

The four lines of direct deposit information are read by Sage 100 Contractor according toRate Type first. It looks first at 1-
Dollar Amount, then 2-Percent of Net, and lastly, 3-Remainder of Check. If multiple lines are set to 1-Dollar Amount,
Sage 100 Contractor looks at the lines in order from top to bottom.

When you processing payroll checks through 5-2-4 Report Printing for employees that are set up for direct deposit, Sage
100 Contractor displays amessage that lists these employees with their full name and direct deposit email address. Pay
stubs for employees with direct deposit are processed individually, and a password-protected PDF is emailed to each
employee. After the emailing is completed, you can also print pay stubs for the employees receiving the email and assign
the check numbers.

NOTES:
l The direct deposit information text boxes may be edited whether or not theEnable Direct Deposit check box

is selected. Validation rules do not apply until the check box is selected and the record is saved.

l Whenever any changes aremade to your direct deposit file format by changing any of the formatting options,
you should contact your bank and request a retest to be sure your bank is ready for the changes.

l Employees receiving emailed pay stubs are required to enter the last four digits of their social security number
before they can view the pay stub.
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To set up an employee record for direct deposit:
1 Open 5-2-1 Employees.

2 In the data control text box, enter the employee identification number.

3 Click theDirect Deposit tab.

4 Click theEnable Direct Deposit check box to enable direct deposit.
This automatically selects theDirect Deposit check box in 5-2-2 Payroll Records. If checked, all standard payroll
checks are included in the direct deposit file. A non-cashable paycheck is issued for history and employee information.

5 In theStatus list, click the status of the account.

6 In theAccount Type list, click the account type.

7 In theRouting# text box, enter the routing number of the bank.

8 In theAccount# text box, enter the employee’s bank account number. Your account numbermay start with zero(s).
Check with your bank.

9 In theRate Type list, click the type of deposit.

10 In theAmount/Rate text box, enter the rate.

11 In the Direct Deposit Email text box, enter the employee's email address for the direct deposit pay stub.

12 Repeat steps 5–11 for each account.

Creating and processing direct deposit pre-notes

Before you begin to process direct deposit for your employees, some banks require you to send them a pre-notification (pre-
note) so they can verify the account numbers are valid.

IMPORTANT: Not all banks require a pre-note for every employee. Contact your bank to determine pre-note
requirements.

Creating and processing a direct deposit pre-note is a four part process.

Part 1—Set up the employee's account:

1 Open 5-2-1 Employees, and display the employee.

2 Click theCompensation tab, and select theUse Direct Deposit box.

3 From theStatusmenu, select 1-Prenote.

4 In theRouting# box, type the routing number of the employee’s bank.

5 In theAccount# box, type the employee’s bank account number.

6 From theRate Typemenu, select the type of deposit.

7 In theRate box, type the rate.

8 From the Filemenu, select Save.

9 If required by your bank, repeat steps 1-8 above for each employee.

Part 2—Enter and process sample payroll records:

1 Open 5-2-2 Payroll Records.

2 In theEmployee box, enter the employee.

3 In thePeriod Start box, type the period start.
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4 In thePeriod End box, type the period end.

5 In theCheck Date box, type today's date.

6 In theCheck# box, type a sample check number.

7 From thePayroll Typemenu, select 3-Hand Computed.

8 In theQuarter box, enter the quarter.

9 In theState box, type the state.

10In theSalary box, type .01.

11From the Filemenu, select Save.

12Open 5-2-5 Direct Deposit File Manager.

13In thePayroll Check Date box, type the check date.

14In the Deposit Date box, type the deposit date.

15Click Start.

16To themessage, [number] records will be processed for direct deposit, click [OK].

17After the direct deposit file is processed, the Select Destination File window appears.

18Select the location in which to save the file and click [Save].

19The default destination is X:\MB7\[Company Name]\Direct Deposit (where X: is your network drive).

20The file you save is the direct deposit pre-note you send to your bank.

21To themessage, Direct Deposit Process Complete click [OK].

22To themessage, Do you want to print the Direct Deposit file report? click [Yes].

23From the Filemenu, select Print.

Part 3—Enter and process regular payroll checks for your employees.

1 When you enter the regular timecards, clear the Direct Deposit box on the 5-2-2 Payroll Records.

Part 4—After you receive notification from the bank, void the sample payroll records and change the employee's
account status to 3-Active.

1 Open 5-2-2 Payroll Records.

2 Display each sample payroll record.

3 From theEditmenu, select Void Payroll Record.

4 To themessage, You are about to void this record. Do you want to continue? click [Yes].

5 Open 5-2-1 Employees, and display each employee who is set up for direct deposit.

6 Click theCompensation tab.

7 UnderDirect Deposit Information, click theStatusmenu and select 3-Active.

8 From the Filemenu, select Save. 

Processing direct deposit

It is important to establish a routine for direct deposit entry. If you are unfamiliar with direct deposit entry or do not have a
standard set of procedures, use the following guidelines to help you through the process. Youmay not need to perform
every step outlined.
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Pay stubs for employees that are set up for direct deposit are processed individually when you process payroll checks
through 5-2-4 Report Printing, Sage 100 Contractor. For each pay stub, the program creates a PDF file that is password-
protected with the last four digits of the employee’s social security number.

CAUTION: Whenever any changes aremade to your direct deposit file format by changing any of the formatting
options, you should contact your bank and request a retest to be sure your bank is ready for the changes.

To process direct deposit payroll:

1 Enter your company's direct deposit information in thePayroll Direct Deposit Setup tab of 7-2 Company Information.

NOTE: Only Account#, Account Type, andRouting# are required entries in this section. Optional information
should be entered as required by your financial institution.

2 Open 5-2-1 Employees and enter the direct deposit information on theDirect Deposit tab.

3 Open 5-2-2 Payroll Records and enter timecards.

4 Open 5-2-3 Compute Payroll and enter record criteria.

5 To print a check register for reviewing purposes, open 5-1-2 Payroll Check Register and do the following:

a Select either the print a check register for direct deposit records only or the printed check records only check
box.

b Enter record criteria.

6 Open 5-2-4 Payroll Checks and do the following:

a Print check stubs and non-negotiable checks.

b Specify a check date when prompted.

c Assign check numbers when prompted.

7 Open 5-2-5 Direct Deposit File Manager and do the following:

a Enter the batch criteria to create a direct deposit file, or on theOptions menu, click Retract a Direct Deposit Batch
to retract a direct deposit batch.

b Select the destination for the direct deposit data. The default destination is the Direct Deposit folder under the
company name. You can accept the default name or create your own.

8 Open 5-1-2 Payroll Check Register, select the register you want to print, and print a file copy.

9 Open 5-2-6 Post Payroll to GL and post payroll.

Retracting a direct deposit file

IMPORTANT: A direct deposit batch should only be retracted if the payroll records are in aComputed status. If
payroll records are in aPosted status when the direct deposit batch is retracted, a new direct deposit batch cannot be
created unless the payroll records are voided and recreated.

You can retract a batch of payroll records after you have created a direct deposit file. Retracting a direct deposit batch
enables you to clear a direct deposit batch number from employee payroll records. Retracting a direct deposit batch will not
affect the General Ledger. Use this function when you need tomake an adjustment to the payroll records included with this
batch file.

To retract a direct deposit batch file:

1 Open 5-2-5 Direct Deposit File Manager.

2 From theOptionsmenu, select Retract Direct Deposit Batch.
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3 Enter theBatch Number.

4 Click Retract.

Reprinting a Direct Deposit Report

You can reprint the direct deposit report by following the instructions below. The report is printed from a direct deposit .txt
file.

To reprint a direct deposit report:

1 Open 5-2-5 Direct Deposit File Manager.

2 From theOptionsmenu, select Reprint Direct Deposit Report.

3 On theSelect the Direct Deposit Filewindow, select the direct deposit file that you want to reprint as a report, and click
Open.

4 After the program validates the file, it is sent to the printer.

IMPORTANT: As required by business needs, you can set up security to restrict access to this option.

Use Direct Deposit check box

If checked, all standard payroll checks are posted to a file. A non-cashable paycheck is issued for history and employee
information. If unchecked, all standard payroll checks are printed on check forms as physical checks.

Account status

NOTE: Account status is set by the payroll administrator, not provided by the employee.

Status Definition

0-None The account is assigned no status.

1-Prenote

The account is assigned 1-Prenote (Pre-notification) when
your bank prefers to check that the account numbers are
valid.

IMPORTANT: Many banks will not process
Prenotes. Check with your bank.

NOTE: This includes the accounts in the direct
deposit file with no dollar amounts.

2-10 Day
Wait

The account should be changed to 2-10 Day Wait after the
account has been processed as 1-Prenote. Otherwise, the
next check could be included again as aPrenotewhen the
next direct deposit file is processed (if the check date is the
same).

NOTE: This account will be included in the direct
deposit file when it is created. A physical check must
be distributed to the employee.

3-Active When active, the payroll information will be included in the
direct deposit file with its respective dollar amounts.

4-Inactive The account is inactive.
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Account type

TheAccount Type is used in the direct deposit file to determine the Trans Code.

Account Type Description

1-Checking The direct deposit account is a checking account.

2-Savings The direct deposit account is a savings account.

Routing number

TheRouting# is provided by the employee from the employee’s bank.

Account number

TheAccount# is the employee’s bank account number.

Rate type

Rate Type determines if the rate is a percentage or dollar amount.

Rate Type Description

0-None The rate type is set to none.

1-Dollar amount The amount is in dollars.

2-Percent of net pay The amount is a percentage of the total.

3-Remainder of check The amount is whatever is left over from the
other designated deposits.

NOTE: The four lines of Direct Deposit are read by Sage 100 Contractor according toRate Type first. It looks first at
1-Dollar amount, then 2-Percent of net pay, and last, 3-Remainder of check. If all lines are set to 1-Dollar
amount, Sage 100 Contractor looks at the lines in order from top to bottom.

If… Then...

It is a single row entry and theRate
Type is 2-Percent of Net… …TheRatemust equal 100%.

It is amultiple row entry and the
Rate Type is 2-Percent of Net…

…TheRatemust equal 100 or the
last row must be set toRemainder
of Check.

It is a single row entry and theRate
Type is 1-Dollar Amount…

…A second row must be created
and set toRemainder of Check.

It is a single row entry and theRate
Type is 3-Remainder of Check…

…The system assumes this is the
entire check.

Rate

The rate can be assigned a percentage number or a dollar amount, depending on whichRate Type is selected. If the total
percent of net equals 100, a 3-Remainder of check line is not required.
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IMPORTANT: When a line is set to 3-Remainder of check, theAmount/Rate cell is disabled. The remainder of the
check will automatically be determined by Sage 100 Contractor and put into the designated account.

5-2-6 Post Payroll to GL
About posting payroll

You can enter timecards, compute payroll, and even print payroll checks without posting the payroll records. When you are
ready, you can post individual payroll records or all payroll records for a specified pay period.

When you post payroll, Sage 100 Contractor:

l Debits gross payroll:

Job costs post to the direct expense account. If you have selected thePost Payroll to WIP check box in the job
record, payroll posts to aWIP account. If theWIP account uses subsidiary accounts, payroll posts to a subsidiary
account that uses the job number as the account number.

Equipment repair or maintenance costs post to the equipment/shop account.

All remaining costs post to the overhead or administrative account, which is determined by the employee position.

l Debits payroll expenses to the ledger accounts as indicated in the payroll calculation.

l Credits net payroll to the checking account entered in thePayroll Postingwindow.

l Credits the ledger accounts as indicated in the payroll calculation.

If you do not specify which records or pay periods to post, Sage 100 Contractor posts all payroll records assigned 2-
Computed or 4-Reverse. After posting is complete, Sage 100 Contractor changes records with status 2-Computed to
status 3-Posted, and records with status 4-Reverse to status 5-Void.

Changing the default bank account when posting payroll

To change the default bank account when posting payroll:

1 Log in as Supervisor.

2 Open 5-2-4 Report Printing window, and click Print.

3 On theCheck Printingwindow, click thePayroll Checking Account box once, and then press F7.

4 On the Field Propertieswindow, enter the checking account number in theDefault Entry box and then click OK.

Each time you run payroll checks, the system will default to the account you selected.

Posting payroll in detail

When you post payroll records to the general ledger, Sage 100 Contractor creates a journal transaction for each payroll
record. Each payroll calculation in a payroll record becomes a separate line in the associated journal transaction.

To post payroll in detail:

1 Open 5-2-6 Post Payroll to GL.

2 In theChecking Account text box, enter the ledger account number for the checking account.

3 Do one of the following:

a To post all previously unposted pay periods, leave thePay Period Ending text boxes empty.

b To limit the posting to a range of pay periods, do the following:

i In the first Pay Period Ending text box, enter the ending date of the first pay period you want to post.
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ii In the secondPay Period Ending text box, enter the ending date of the last pay period you want to post.

4 Do one of the following:

a To post all previously unposted records, leave theRecord# text boxes empty.

b To limit the posting to a range of records, do the following:

i In the first Record# text box, enter the first payroll record you want to post.

ii In the secondRecord# text box, enter the last payroll record you want to post.

5 Do one of the following:

a Leave theRecord Pick List box empty

b Create aRecord Pick List of payroll records to post.

c Do not select thePost in Summary check box.

d Leave theSummary Acct text box empty.

6 Click Post Payroll.

Posting payroll in summary

CAUTION: The journal transaction containing the summary of the payroll expenses does not tie into the job costs
created during the final-compute of the payroll records. Therefore, the job cost reconciliation report does not include
those journal transactions.

Summary posting provides an advantage over detailed posting for companies with very large payrolls. It reduces the total
number of line items posted to the general ledger, and it also reduces the detail posted for each employee paycheck.

The following compares detailed posting to summary posting:

l In detailed posting, Sage 100 Contractor creates a journal transaction for the total cost of each paycheck. Each
journal transaction contains line items for the labor costs and each payroll calculation.

l In summary posting, Sage 100 Contractor requires you to provide a clearing (summary) account in addition to a
checking account, where the clearing account temporarily holds the net pay.

Posting creates a separate journal transaction for the net amount of each paycheck, which posts to the clearing account
and the checking account. Then Sage 100 Contractor creates a journal transaction containing a summary of the payroll
expenses. The expenses post to the accounts as directed in the setup for each payroll calculation; the net amount of the
payroll records posts against the clearing account. After the summary posting is complete, the clearing account balance
returns to its original balance.

ThePost Payroll to GLwindow has six text boxes in which to enter information. Use thePay Period Ending and
Record# text boxes to select a range of pay periods and records. Alternatively, you can use theRecord Pick List to select
a specific pay period and record.

In addition, consider the following points:

l You can limit the posting to a range of pay periods. In the first Pay Period Ending text box, enter the ending date of
the first pay period you want to post. In the secondPay Period Ending text box, enter the ending date of the last
pay period you want to post.

l You can limit the posting to a range of records. In the first Record# text box, enter the first payroll record you want to
post. In the secondRecord# text box, enter the last payroll record you want to post.

To post payroll in summary:

1 Open 5-2-6 Post Payroll to GL.
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2 In theChecking Account text box, enter the ledger account number for the checking account.

3 In thePay Period Ending text boxes, enter the pay period ranges.

4 Do one of the following:

a In theRecord# text boxes, enter the record number ranges.

b Next to theRecord Pick List text box, click Display pick list window to select a specific list of record numbers.

5 Select thePost in Summary check box.

6 In theSummary Account text box, enter the clearing account number.

7 Click Post Payroll.

TIP: You can create aRecord Pick List of payroll records to post.

Payroll Processing Guidelines
Processing payroll

It is important to establish a routine for payroll entry. If you are unfamiliar with payroll entry or do not have a standard set of
procedures, use the following guidelines to help you through the process. Youmay not need to perform every step outlined.

TIP: The individual payroll records can also be printed from 5-2-2 Payroll Records.

To process payroll:

1 Open 5-2-1 Employees, and do the following:

a Enter any new employee records.

2 Open 5-3-4 Paygroups and enter any new paygroups.

3 Do one of the following:

a Open 5-2-2 Payroll Records, and enter the timecards.

b Open 5-5-1 Daily Payroll Entry, and enter the daily records.

4 Open 5-2-8 Timecard Journal.

5 Select one of the reports from the range of 5-2-8-51 through 5-2-8-72.

6 Then print the report and verify the timecard data.

7 If you enter any corrections, print a new file copy of the report.

8 Open 5-2-3 Compute Payroll and do the following:

a If you have added or changed employees, paygroups, or payroll calculations, trial-compute the records.

b Open 5-1-2 Payroll Check Register.

c Select Report 5-1-2-21 Payroll Check Register with Calculations.

d Print the report.

e Carefully review the timecards, employees, paygroups, and calculated amounts.

f If you have changed the timecard calculations, then trial-compute the payroll, print the report, and review it again.

g When you have resolved all errors, final-compute the records in 5-2-3 Compute Payroll.

9 Open 5-2-4 Payroll Checks. Then print the payroll checks.
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10Open 5-1-2 Payroll Check Register. Select the register (report) you want to print and print a file copy.

11Open 5-2-6 Post Payroll to GL. Post payroll.

Historical Payroll Records
Methods for entering historical payroll records

When setting up payroll, it is important to provide the historical payroll information for the current calendar year. The
historical information is necessary to correctly calculate taxes such as Social Security, as well as to provide data for payroll
reports summarizing, for example, W-2 forms.

Choose from four methods for entering the payroll history. The first method is the quickest way to enter the historical data,
and each successivemethod is more complex. Before selecting amethod, consider the importance of your payroll data.
Themore data you enter now, the greater the level of detail will be later on when you need information.

When the payroll data has posted to the general ledger in your previous system, the ledger account balances already
include payroll costs. Assign payroll type 4-Startup to the historical payroll records.

If you have payroll data that is not posted to the general ledger in your previous system, enter separate records for the
unposted data. Assign those records payroll type 3-Hand Computed and post them. Later, when entering the ledger
account balances, be sure the ledger balances do not include the payroll data assigned payroll type 3-Hand Computed.
The ledger account balances must accurately reflect the payroll records that have not been posted.

If you have anAdd/Deduct orAdd to Gross taxable item, then go to the 5-3-7 Payroll Auditwindow and run the repair to
read taxable wages correctly.

Method 1

Enter a single payroll record for each employee that contains the year-to-date totals. If you are in mid-quarter, you will not be
able to print the 941 and other quarterly payroll reports.

Method 2

Enter a record for each payroll quarter for each employee. You can generatemore reports than in the first method, including
some quarterly reports at the end of the current quarter.

IMPORTANT: Some reports require manual correction.

The 941 report for the current quarter shows a liability on a single day, representing the startup data. Youmust manually
adjust the data in the report from the beginning of the quarter to the point when you began to process payroll in Sage 100
Contractor.

Method 3

Enter a record for each employee in each of the prior payroll quarters. Then in the current quarter, enter an individual payroll
record for each paycheck.

Reports contain the complete payroll data for the current payroll quarter. This is the recommendedmethod.

Method 4

Enter each individual payroll record for every employee. This method is practical only when there are a few employees or
you are starting up during the first quarter of the calendar year.

NOTE: Reports contain the complete payroll data for the payroll year.
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Entering historical payroll records

To enter historical payroll records:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the beginning date for the quarter.

4 In thePeriod End text box, enter the ending date for the quarter.

5 In theCheck Date text box, enter the date of the last payroll check for the quarter.

6 In theCheck# text box, enter the employee number.

7 In thePayroll Type list, do one of the following:

a If the startup payroll has been posted to theGeneral Ledger in your old system, you should not post the startup
payroll record. Click 4-Startup.

b If the startup payroll is not posted to theGeneral Ledger in your old system, you need to post the startup record. Click
3-Hand Computed.

8 In theQuarter text box, enter the payroll quarter.

9 In theState text box, enter the tax state.

10 In theSalary text box, enter the amount of the wages. This figure is always the gross wage.

11 Click theCalculations tab.

12 In theAmount cell of each payroll calculation, enter the amount.

13 On the Filemenu, click Save.

14 Repeat steps 2–13 for each employee.

TIPS:
l After entering all of the records, you can verify the data. Open 5-1-2 Payroll Check Register, select the

Deduction and Total Page check boxes, and print the report. If you find incorrect records, void and re-enter
them.

l If you assigned status 3-Hand Computed to any payroll records, post the payroll.

5-3 Payroll Management

5-3-1 Payroll Calculations
About payroll calculations

Payroll calculations act as the rules for computing deductions, benefits, and employer costs. You canmanually set up
payroll calculations, or you can create the set of standard calculations supplied by Sage 100 Contractor.

CAUTION: Setting up payroll calculations can be complex. If you need assistance, consult your business partner.

After you have set up the calculations, you can add them to the employee records. Each employee recordmaintains its own
list of calculation rates, calculationmaximums, and quarterly totals for the payroll calculations. On theCalculations tab in
the 5-2-1 Employeeswindow, you can edit the calculation rates andmaximums for one employee record without affecting
the others.



- 298 -

When you compute payroll, Sage 100 Contractor reads the calculation rates andmaximums from the employee record, and
uses those rates with the payroll calculations. Depending on the type of calculation you want to set up, Sage 100
Contractor: (1) makes certain calculation selections for you that you cannot change; and (2) makes certain suggestions
about what youmay change:

l Federal and state taxes (Social Security, Medicare and FUTA ): Sage 100 Contractor contains the tax tables
necessary for computing federal and state income taxes. For each state that your employees work in, set up a
payroll calculation to compute the state income tax. While some states do not levy an income tax, the calculation is
still necessary tomaintain accurate wage information.

To compute taxes correctly, some states require additional setup in the employee records. For details on setting up
tax calculations for specific states andmunicipalities, see Appendix D—Tax Setup Information

NOTE: Do not set upmore than one calculation for Tax Type 3 (Employer Social Security) or Tax Type 4
(Employer Medicare). Doing so will cause audit errors.

l Local payroll tax districts: Many counties andmunicipalities levy income taxes. You can specify the correct local
payroll-tax districts and then assign the locales to the appropriate job and employees.

l Calculated amounts that add to or deduct from pay for specific reasons: In some cases, it is necessary to
create different payroll calculations for the same purpose. For example youmay need different methods to calculate
wage garnishments, retirement plans or union deductions.

Building Payroll Calculations

l Creating standard payroll calculations: To get started, we recommend that you take advantage of the standard
calculations that Sage 100 Contractor can automatically create for you. If you choose to create the set of standard
calculations, you will need to review and possibly adjust and/or manually add additional calculations later.

l Setting up payroll calculations: You can set up payroll calculations manually by defining each type of calculation that
you will need. There aremany parameters for each calculation that must be carefully reviewed before setup.

About pre-built standard payroll calculations

Sage 100 Contractor comes with a set of standard payroll calculations. We recommend that you use these standard payroll
calculations as a starting point.

You can only use the pre-built standard calculations for a new company that does not already have the calculations set up.
It is important to review andmodify the standard calculations after you set them up to ensure they meet your regional
requirements.

Sage 100 Contractor creates the following calculations:

l Social Security—Employee

l Medicare—Employee

l Federal Income Tax—Employee

l Social Security—Employer

l Medicare—Employer

l Federal Unemployment—Employer (FUTA)

l Per Diem

l Advances

l Workers’ Compensation
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l Liability Insurance

l State Income Tax—Employee

l State Disability Insurance—Employee

l State Unemployment Insurance—Employee

Creating standard payroll calculations

IMPORTANT:
l If you choose to create the standard calculations, youmust do this before setting up any calculations manually.

l Even though some states do not have state income tax, the state income tax calculation needs to be set up in
the 5-3-1 Payroll Calculationswindow so that theWorkers’ Compensation report prints correctly.
Additionally, the state income tax calculation needs to be set up so that W-2 forms calculate correctly.

l For details on setting up tax calculations for specific states andmunicipalities, see Appendix D-Tax Setup
Information.

To create standard payroll calculations

NOTE: You can only use the pre-built standard calculations for a new company that does not already have the
calculations set up. It is important to review andmodify the standard calculations after you set them up to ensure they
meet your regional requirements.

1 Open 5-3-1 Payroll Calculations.

2 On themenu bar, click Options, then click Create Standard Calculations.

3 Carefully review each standard payroll calculation.

4 Some of the account numbers may need to bemodified. If you used the Sage 100 Contractor standard 4-digit or 5-digit
chart of accounts and have not mademodifications, the account numbers will be correct. If you have used or created
another chart of accounts or modified one of the standard ones, you will need to carefully review each of the account
numbers.

5 For each state tax calculation, youmust enter the state abbreviation in theState text box.

6 For the State Disability Insurance and the State Unemployment Insurance calculations, youmust enter theDefault
Rate, Default Maximum, andMax Type.

7 Set up any additional calculations.

Setting up payroll calculations

The taxes that are subject to calculation vary by state or region. Verify the selections with your accountant, or if it is a
benefit, the benefit plan administrator.

For details on setting up tax calculations for specific states andmunicipalities, see Appendix D-Tax Setup Information.

CAUTION: Verify that all your calculations are correct before computing your payroll by running a trial-compute. If
you are unsure about the results, contact Customer Support or your business partner for assistance.

To set up payroll calculations
1 Open 5-3-1 Payroll Calculations.

2 In the data control box, enter the number you want to assign the new calculation.

3 In theDescription box, enter a brief statement about the calculation.

4 In the Tax Type list, click the tax type.
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5 In theCalculation Type list, click the calculation type.

6 In theCalculation Method list, click themanner in which the calculation is computed.

IMPORTANT: When you use calculationmethod 17-Tables for federal or state income taxes, Sage 100 Contractor
sets the rate. The rate does not appear in the payroll calculation or the employee record.

7 When available, do the following:

a In theDefault Rate box, enter the standard calculation rate.

b In theDefault Max box, enter the calculationmaximum.

c In theMax Type list, click the type of maximum for the calculation.

8 In the Job Expense, Shop Expense, Overhead Expense, andAdmin Expense boxes, enter the ledger account
number that you want to debit.

9 In theCredit Account box, enter the ledger account number that you want to credit.

10In theCredit Subaccount box, enter the ledger subaccount number that you want to credit.

a (Optional) If you want to use the employee number as the subsidiary account number, click Use employee# as
subaccount.

IMPORTANT: TheCredit Account andCredit Subaccount are typically liability accounts. Youmust specify a
Credit Account, but aCredit Subaccount is only necessary dependent upon your general ledger setup.

11 UnderSubject to, verify the deductions to which the calculation is subject.

12 Under Tax Area:

a If the calculation is for a specific state, enter the state abbreviation in the Tax State box.

b If the calculation is for a specific local payroll tax district, click the district number in the Tax Locale list.

13 UnderReporting:

a To include the calculation on a union report, select the union from theUnion list.

b To include the payroll calculation on certified payroll reports, select the type of benefit in theBenefit list.

14 To report the calculation total in box 11, 12, 13, or 14 of theW-2, enter the box number in theW-2 Box field.

15 To include a special code on theW-2, enter the code in theW-2 Code box.

16 Select the following payroll calculation check boxes if applicable:

a Use in Paygroup Benefits

b Display on Check

c Disposable Earnings

d Default to New Employees

17 On the Filemenu, click Save.

About calculations in employee records

When setting up a new employee record, Sage 100 Contractor inserts the package of default payroll calculations, including
the calculation rates andmaximums, on theCalculations tab. Each employee record has its own set of payroll calculation
rates, maximums, and totals. You can edit the calculation rates andmaximums in one employee record without affecting
others. When you compute payroll, Sage 100 Contractor reads the calculation rates andmaximums from theCalculations
tab.
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Before editing the individual calculation rates andmaximums, familiarize yourself with how payroll calculations are set up.
Most calculations that refer to tax tables do not allow editing. Sage 100 Contractor determines the tax table number, but
does not display the data in theCalculations tab.

You canmanage themarital status settings, allowances, and withholding amounts for federal and state tax calculations.
For example, Steve works in Kansas and Nebraska. In Kansas, Steve claims married-joint status, but in Nebraska, he
claims married-separate status. In theMarital column, you can enter the appropriate marital status for the Kansas and
Nebraska income tax calculations.

You can also control whether a payroll calculation is active or inactive. When you type No in theActive cell for a
calculation, Sage 100 Contractor does not include that payroll calculation in the compute for timecards. For example, John
was given a $500 payroll advance, and thePayroll Advances calculation in John’s employee record was set up to recover
$100 per paycheck. But John has said that the next few weeks are difficult and that he would like to suspend the repayment
for a little while. In John’s employee record, type No in theActive cell of thePayroll Advance calculation. When you are
ready to resume recovering the advance, typeYes in theActive cell of thePayroll Advance calculation.

Contractors who work on prevailing-wage jobs are required tomatch the difference between prevailing wages and benefits,
and actual wages and benefits paid to each employee. For each employee whoworks the prevailing-wage job, you can
enter the credit in theOffset column. When you compute payroll, Sage 100 Contractor applies the credit. Tomanage payroll
for prevailing-wage jobs, set up paygroups.

NOTE:

l Some states use additional tax tables to collect county taxes with the state taxes. To calculate the correct taxes,
enter the tax rate or table number in the Table# cell of the calculation.

l You can withhold an additional flat amount for federal taxes or state taxes. To withhold a flat amount for a
calculation, enter the amount in theAdd W/H cell of the calculation.

Adding payroll calculations to employee records

When setting up a new employee record on 5-2-1 Employees, Sage 100 Contractor inserts the package of default payroll
calculations, calculation rates, andmaximums on theCalculations tab. You can insert additional payroll calculations at
any time.
To add payroll calculations
1 Open 5-2-1 Employees.

2 Click theCalculations tab.

3 In theCalculation column, in an empty cell, click once, and then click the down arrow button to display thePayroll
Calculations Lookupwindow.

4 Select and insert the calculation(s).

TIP: Alternatively, you can right-click in an empty cell of theCalculation column and select from themenu of Pick
Lists. Press the F5 key to open thePayroll Calculations Lookup, or F8 to open thePayroll Calculations Lookup
window as aPicklist.

About tax tables for setting up federal and state tax calculations

Even though some states do not have state income tax:

n The state income tax calculation needs to be set up in the 5-3-1 Payroll Calculationswindow so that the reports
based on state wages are accurate and print correctly.

n State income tax calculations for employees must be set up in the 5-2-1 Employeeswindow so that the payroll
calculations compute correctly.
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Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state you
work in, create a payroll calculation for state income tax. The calculation is necessary tomaintain the correct gross wage
totals for each employee, and to ensure accurate state quarterly reports, state tax reports, andW-2 forms.

If you work in a state that does not levy an income tax, you still need to create a payroll calculation. For those states, a tax
is not calculated but Sage 100 Contractor stores the state wage for state reports. In addition, some calculations use the
state wage to compute additional deductions such as state unemployment or disability. For those types of calculations, it is
important to select theState Income Tax check box. Otherwise, the payroll calculationmay not compute the deduction
correctly.

For details on setting up tax calculations for specific states andmunicipalities, see Appendix D-Tax Setup Information.

About local payroll taxes

Many counties andmunicipalities levy income taxes. In the Local Payroll Taxeswindow, set up the table of local payroll
tax districts and their rates. You can then assign the locales to the appropriate job and employee records. If an employee
lives in a locale, add the locale to the employee’s record. If a job site is located in a locale, add the locale to the job record.

There are a variety of ways to set up the districts:

l Some districts base the taxes on whether the employee lives inside or outside the locality. The resident rate applies
to employees that work and live in the same locality, while the non-resident rate applies to employees who work in
the locality but live elsewhere. During the payroll compute, Sage 100 Contractor compares the locale in the job
record to the locality in the employee record. If the districts match, Sage 100 Contractor computes taxes at the
resident rate. If the district numbers differ, Sage 100 Contractor computes taxes at the non-resident rate.

l In some regions, employees are subject to several taxes, such as city and county income taxes. As Sage 100
Contractor only lets you assign one locality to a job record, employee record, or timecard line, you can combine
districts in the Local Payroll Taxwindow to form a new district. You can then assign the combined district as
needed.

l When a local payroll tax applies to employees regardless where they work, you can set up the district to work like
state income tax.

l When employees work multiple states but there are no local payroll tax districts, use the districts to control how
Sage 100 Contractor computes state income tax for each timecard line.

Each locality requires a corresponding payroll calculation. In most circumstances, each payroll calculation uses calculation
method 17-Tables, and refers to the table of localities for the rates.

About calculation types

The calculation type determines how a payroll calculation affects a timecard. For example, when you assign a payroll
calculation 1-Deduct from Employee, Sage 100 Contractor deducts the result of the calculation from the employee’s
wages.

For most payroll calculations, the program determines the calculation type and the taxes that a calculation is subject to
based on the tax type.

If you select tax type 0-None, however, you instead of the program can select the calculation type.

Calculation type 1-Deduct from Employee

Payroll Taxes: For each payroll tax, set up a payroll calculation. If your company performs work in different states , set up
a payroll calculation for every state in which you work, regardless of whether the state levies an income tax. In addition, set
up a payroll calculation for each local payroll tax district, such as city and county.
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At the calendar year-end, verify the tax rates andmaximums for each calculation. Sage 100 Contractor provides Federal
and State tax updates each year.

Payroll Advance: Create a calculation for payroll advances. Sage 100 Contractor automatically recovers the advance for
you.

Tool Purchases: Some companies allow employees to purchase personal tools from vendors using the company account.
You can set up a payroll calculation to deduct the employee’s purchases from his or her paycheck.

When you post the vendor’s original invoice for the tool purchase, post it to theSmall Tools account in theOverhead
Expense range of accounts. To then deduct the tool purchases from an employee’s paycheck, set up the payroll
calculation to post a credit to theSmall Tools account. Because the amount deducted from an employee’s paycheck
varies based on the cost of the tools purchased, select calculationmethod 18-Variable (manual calculation).

While you can deduct the cost of tools from the employee’s paycheck, it is a better practice for employees to reimburse tool
purchases through personal checks, made payable to your company.

Health Insurance: Create a payroll calculation to deduct the employee’s portion of the cost for medical insurance. Usually
this is a fixed amount per month.

If you need to deduct the health insurance each pay period, convert themonthly amount to a per-period amount. From the
monthly amount, compute the annual amount and divide by the number of pay periods in a year. If your company pays its
employees weekly, for example, divide the annual amount by 52. Then enter the per-period amount in each employee’s
record on theCalculations tab.

When employees cannot earn paychecks regularly, due to weather or other circumstances, set up theHealth Insurance
calculation with amaximum type of 6-Dollars/Month. Then on theCalculations tab in the employee records, enter an
accelerated rate and amonthly maximum for the payroll calculation.

Garnishments: (Child support, Previous Year Income Taxes, Court Judgments, etc.) Create a payroll calculation for each
type of garnishment. If similar garnishments require different methods of calculation, create a separate calculation for each
garnishment.

Suppose you need to garnish the wages of two employees for child support, and a third employee’s wages for back taxes.
The first employee’s garnishment is for a set dollar amount each pay period and the second employee’s garnishment is for a
percentage of the net pay. Set up two separate calculations for child support garnishments, though both can post to the
same payable account. Then set up a third calculation for the garnishment of back taxes, which posts to a different payable
account.

If you want to post each garnishment to a different ledger account, create the separate ledger accounts in theCurrent
Liabilities range of accounts. Select theEmployee Number as Subaccount check box to post the garnishment to a
subsidiary ledger account using the employee’s record number as the subsidiary account number.

Somemethods of computing garnishments might be too complex for Sage 100 Contractor to automatically calculate, such
as a percentage of the net pay with aminimum ormaximum amount. In this case, set up a payroll calculation with a variable
calculationmethod.

Pension Plans: Some businesses set up pension plans such as a 401(k), to which employees contribute. In general, 401
(k) deductions are not subject to Federal and state income taxes. Check with your state agencies to determine what is
taxable.

Many pension plans allow employees to contribute a flat amount or a percent of the employee’s paycheck. Youmay need to
create two payroll calculations and assign the appropriate calculation to each employee based on how he or she wants to
contribute.

To create a pension plan deduction, set up the payroll calculation with tax type 19-Elective Deferral and calculation type 1-
Deduct from Employee. Because each employee can choose the flat amount or percent of his or her paycheck to
contribute, enter the employee’s amount or rate in theCalculations tab of each employee record.
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To post the credit, set up a separate ledger account in theCurrent Liabilities range of accounts. Select theEmployee
Number as Subaccount check box to post each employee’s contribution to a subsidiary ledger account using the
employee’s record number as the subsidiary account number. The subsidiary accounts help youmanage the individual
employee contributions, and know what amount to pay on behalf of each employee.

Calculation type 2-Add to Gross

Cash benefits for prevailing wage: Non-union contractors working Davis-Bacon or prevailing-wage jobs must pay
employees a cash equivalent to the union wage and benefits. After setting up the paygroups, set up a payroll calculation for
each benefit, such as vacation, pension, and health and welfare.

Because the benefit is being paid as cash, set up the calculation using calculation type 2-Add to Gross, and post the credit
to the ledger account number of the payroll checking account. Sage 100 Contractor adds the result of the calculation to the
employee’s gross wage.

TIP: You can include cash benefits in theCertified Payroll report. In theBenefit list, click the type of benefit the
calculation represents.

Calculation type 3-Employer Cost

NOTE: Calculations type 3-Employer Cost can be used can be used to accrue virtually any type of employer cost.

Payroll Taxes: For each payroll tax, set up a payroll calculation. If your company performs work in different states , set up
a payroll calculation for every state in which you work, regardless whether the state levies an income tax. In addition, set
up a payroll calculation for each local payroll tax district (city, county, etc.).

At the calendar year-end, verify the tax rates andmaximums for each calculation. Federal and State tax updates are
available each year.

Workers’ Compensation Insurance:When you set up a payroll calculation forWorkers’ Compensation, Sage 100
Contractor uses the rates set up in theWorkers’ Compensation window. Select 17-Tables as the calculationmethod.

Liability Insurance: You can set up the liability insurance calculation to use the rates from theWorkers’ Compensation
window. Select 17-Tables as the calculationmethod, and credit the account to which you post the insurance payments.

Generally, liability insurance covers field employees and sometimes the owner, but not office employees. For each exempt
employee, change the payroll calculation’s rate to 0 on theCalculations tab of the employee record.

Some companies compute the liability insurance as a percent of gross pay. In the Tax Type list, click 0-None. In the
Calculation Method list, click 1-Percent Gross Pay. The rate is usually the same as the payroll rate on the insurance
policy.

Health Insurance: Set up a payroll calculation to deduct the employer’s portion of the cost for medical insurance. The
amount is usually a fixed rate per month.

To deduct the health insurance each pay period, convert themonthly amount to a per-period amount. First, convert the
monthly amount to an annual amount, then divide by the number of pay periods in a year. If your company pays its
employees weekly, for example, divide the annual amount by 52.

Pension Plans: Some businesses set up pension plans, such as a 401(k), to which employers contribute. In the Tax Type
list, click 0-None. In theBenefit list, click 2-Pension to include thematching amount on Certified Payroll reports.

To create a pension deduction, set up the payroll calculation as follows: tax type 0-None and calculation type 3-Employer
Cost. Because each employee can choose to contribute either a flat amount or percent of his or her paycheck, youmight
have to create two calculations.
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To post the credit, you can post to the same account used to post the employees’ deduction for the pension plan, or you can
set up a separate ledger account in theCurrent Liabilities range of accounts. Whether you post the employer portion of
the pension plans to subsidiary accounts depends on your particular needs.

Union shops or open shops that perform Davis-Bacon or prevailing-wage work should not use subsidiary accounts to track
the individual matching amounts. Tomake the payment, each subsidiary account would have to be referenced on the
check. Instead, you can use the certified payroll reports to track the amounts paid. If you are using paygroups, you need to
enter the pension rates in thePaygroup Benefitswindow.

Select theEmployee Number as Subaccount check box to post each employee’s contribution to a subsidiary ledger
account using the employee’s record number as the subsidiary account number. The subsidiary accounts help youmanage
the individual employee contributions, and know what amount to pay on behalf of each employee.

Tool Use:You can recover the cost of small tools by setting up a calculation for a flat rate per hour that applies to all
working field employees. To determine the hourly rate, look at the amount your company spent purchasing small tools for a
time, such as the previous year. Then divide that amount by the number of hours worked by field employees during the
same time. For employees that do not work in the field, change the rate to 0 in the Calculations tab in the employee records.

Calculation type 4-Add/Deduct

Vehicle use: Some companies provide a vehicle to an employee as a benefit.

Set up the payroll calculation with calculation type 4-Add/Deduct (taxable). The calculation adds the dollar value to the
gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an
increase to the taxable wage.

Union Vacation: Contractors are responsible for computing the taxes for vacation pay and filing the necessary reports.
When dealing with two or more unions, youmight need to create a separate payroll calculation to compute the union
vacation for each union local.

Set up the payroll calculation with calculation type 4-Add/Deduct (taxable). The calculation adds the dollar value to the
gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an
increase to the taxable wage.

To include the calculation in the default set of paygroup benefits, select theUse in Paygroup Benefits check box.

Calculated type 5-Accrued Hours

You can use calculation type 5-Accrued Hours to create a calculation that builds up hours. For example, you could use
this calculation to keep track of hours used to determine an employee’s vacation time. A payroll calculation that uses
calculation type 5-Accrued Hours does not post to the general ledger or create job costs.

About calculation types

The calculation type determines how a payroll calculation affects a timecard. For example, when you assign a payroll
calculation 1-Deduct from Employee, Sage 100 Contractor deducts the result of the calculation from the employee’s
wages.

For most payroll calculations, the program determines the calculation type and the taxes that a calculation is subject to
based on the tax type.

If you select tax type 0-None, however, you instead of the program can select the calculation type.

About tax types

The tax type helps define the purpose of a calculation. For example, in the Tax Area of 5-3-1 Payroll Calculations, you
only have to provide the state abbreviation for the calculation and the ledger account numbers for posting. Sage 100
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Contractor already contains the tax table data for each state. The tax type also determines if a calculation is included in
certain payroll or wage reports, such as the Federal Quarterly Payroll Report 941, or theW-2 form.

Depending on the type of calculation you want to set up, Sage 100 Contractor makes certain selections that you cannot
edit, or makes certain suggestions that you can change. For example, when you select tax type 5-Federal Income Tax,
Sage 100 Contractor sets up the entire calculation to which you cannot make any changes. When you select tax type 13-
Local Income TaxSage 100 Contractor only selects the calculation type and to which taxes the calculation is subject; you
determine the rest. When you select tax type 0-None, you can determine everything. Sage 100 Contractor may make
additional suggestions based on the calculation type or calculationmethod.

When setting up a new payroll calculation, look through the Tax Type list to see if a type exists for the calculation you want
to set up. If you do not find a specific type for the calculation you want to set up, select 0-None.

For details on setting up tax calculations for specific states andmunicipalities, see Appendix D—Tax Setup Information.

Setting up payroll calculations

The taxes to which calculations are subject vary by state or region. Verify the selections with your accountant, or if it is a
benefit, the benefit plan administrator. For details on setting up tax calculations for specific states andmunicipalities, see
Appendix D-Tax Setup Information.

CAUTION: Verify that all your calculations are correct before computing your payroll by running a trial-compute. If
you are unsure about the results, contact Customer Support or your business partner for assistance.

To set up payroll calculations:

1 Open 5-3-1 Payroll Calculations.

2 In the data control box, enter the number you want to assign the new calculation.

3 In theDescription box, enter a brief statement about the calculation.

4 In the Tax Type list, click the tax type.

5 In theCalculation Type list, click the calculation type.

6 In theCalculation Method list, click themanner in which the calculation is computed.

IMPORTANT: When you use calculationmethod 17-Tables for federal or state income taxes, Sage 100 Contractor
sets the rate. The rate does not appear in the payroll calculation or the employee record.

7 When available, do the following:

a In theDefault Rate box, enter the standard calculation rate.

b In theDefault Max box, enter the calculationmaximum.

c In theMax Type list, click the type of maximum for the calculation.

8 In the Job Expense, Shop Expense, Overhead Expense, andAdmin Expense boxes, enter the ledger account
number that you want to debit.

9 In theCredit Account box, enter the ledger account number that you want to credit.

10In theCredit Subaccount box, enter the ledger subaccount number that you want to credit.

a (Optional) If you want to use the employee number as the subsidiary account number, click Use employee# as
subaccount.

IMPORTANT: TheCredit Account andCredit Subaccount are typically liability accounts. Youmust specify a
Credit Account, but aCredit Subaccount is only necessary dependent upon your general ledger setup.
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11 UnderSubject to, verify the deductions to which the calculation is subject.

12 Under Tax Area:

a If the calculation is for a specific state, enter the state abbreviation in the Tax State box.

b If the calculation is for a specific local payroll tax district, click the district number in the Tax Locale list.

13 UnderReporting:

a To include the calculation on a union report, select the union from theUnion list.

b To include the payroll calculation on certified payroll reports, select the type of benefit in theBenefit list.

14 To report the calculation total in box 11, 12, 13, or 14 of theW-2, enter the box number in theW-2 Box field.

15 To include a special code on theW-2, enter the code in theW-2 Code box.

16 Select the following payroll calculation check boxes if applicable:

a Use in Paygroup Benefits

b Display on Check

c Disposable Earnings

d Default to New Employees

17 On the Filemenu, click Save.

About payroll calculation defaults

IMPORTANT: TheDefault Rate, Default Max andMax Type boxes in 5-3-1 Payroll Calculations are defaults.
When you create standard payroll calculations, these amounts are automatically created for many of the calculations.
This information from 5-3-1 Payroll Calculations is not used to compute payroll; however,Max Type is used when
the records are computed.

Default Rate

When entering the default rate, ask yourself this question: Will a default rate helpmewhen entering new employees?

Some calculations apply to all employees and have fixed rates, such as Social Security andMedicare taxes. Other
calculations apply to all employees but may have varying rates, such as health insurance premiums and other benefits.
Some other additional calculations apply to only a subset of employees andmay have fixed rates too.

When entering default rates, it is very important to remember that this field is only a default. The actual rate used when
payroll records are computed comes from either the individual employee record or the paygroup.

If there is a common rate, youmay want to enter it so that it will then default to the employee record when entering a new
employee. Youmay feel, however, that it is “safer” to require yourself to directly enter the rate for each employee to ensure
having the correct rate every time rather than having an incorrect default accepted.

Moreover, some default calculations apply to only a subset of employees andmay have varying rates, such as child
support and other wage garnishments. There is no common rate for this group because this calculation doesn't apply to
most employees, and therefore the common rate is actually zero.

Default Max

When considering the default maximum, use the same criteria as you use for the default rate. Ask yourself this question:
Will a maximum rate helpmewhen entering new employees?
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Max Type

Wage-based maximum types mean that the calculation stops computing when the employee’s wages reach the
maximum level.

This kind of maximum is usually used in connection with tax calculations because they are usually published in this style
by the government agency. For example, the IRS states something like this: Social Security tax is 6.2% on all wages up to
$87,000.

l Per Quarter andPer Year types are based on wages that are subject to Medicare.

l Per Check andPer Month types are based on unadjusted gross wages.

Dollar-based maximum types mean that the calculation stops computing when the amount of the calculation reaches the
maximum level.

This kind of maximum is useful when a dollar amount needs to be calculated without regard to the employee’s earnings. For
example, youmay want to calculate an employer-matching 401(k) at 50% of what the employee contributes, but the
matching is not to exceed $1,000 per year.

l Per Year types are based on all computed payrolls to date.

l Per Quarter types are based on all computed payrolls assigned to the same quarter number that is on the current
payroll record.

l Per Month types are based on all computed payrolls that have a check date in the samemonth as the current
payroll record.

IMPORTANT: It is important to enter the correct check date on the payroll records prior to computing so that
Sage 100 Contractor is aware of themonth to which the current payroll is assigned.

l Per Check types are based solely on the current payroll record.

About pre-built standard payroll calculations

Sage 100 Contractor comes with a set of standard payroll calculations. We recommend that you use these standard payroll
calculations as a starting point.

You can only use the pre-built standard calculations for a new company that does not already have the calculations set up.
It is important to review andmodify the standard calculations after you set them up to ensure they meet your regional
requirements.

Sage 100 Contractor will create the following calculations:

l Social Security—Employee

l Medicare—Employee

l Federal Income Tax—Employee

l Social Security—Employer

l Medicare—Employer

l Federal Unemployment—Employer (FUTA)

l Per Diem

l Advances
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l Workers’ Compensation

l Liability Insurance

l State Income Tax—Employee

l State Disability Insurance—Employee

l State Unemployment Insurance—Employee

Creating standard payroll calculations

IMPORTANT:
l If you choose to create the standard calculations, youmust do this before setting up any calculations manually.

l Even though some states do not have state income tax, the state income tax calculation needs to be set up in
the 5-3-1 Payroll Calculationswindow so that theWorkers’ Compensation report prints correctly.
Additionally, the state income tax calculation needs to be set up so that W-2 forms calculate correctly.

l For details on setting up tax calculations for specific states andmunicipalities, see Appendix D-Tax Setup
Information.

To create standard payroll calculations:

NOTE: You are only able to create standard calculations in a new company.

1 Open 5-3-1 Payroll Calculations.

2 On themenu bar, click Options, then click Create Standard Calculations.

3 Carefully review each standard payroll calculation.

4 Some of the account numbers may need to bemodified. If you used the Sage 100 Contractor standard 4-digit or 5-digit
chart of accounts and have not mademodifications, the account numbers will be correct. If you have used or created
another chart of accounts or modified one of the standard ones, you will need to carefully review each of the account
numbers.

5 For each state tax calculation, youmust enter the state abbreviation in theState text box.

6 For the State Disability Insurance and the State Unemployment Insurance calculations, youmust enter theDefault
Rate, Default Maximum, andMax Type.

7 Set up any additional calculations.

Updating the FICA and Medicare rates and the Default Rate and the Default Max

After closing your payroll year-end and before entering payroll for the new calendar year, youmay need to update the FICA
andMedicare rates andmaximums. Once the updates aremade, you can update all your employees simultaneously by
following this procedure.

TIP: This proceduremay also be used to update any payroll calculation.

To update FICA and other rates simultaneously:

1 Open 5-3-1 Payroll Calculations.

2 In theDefault Rate box, type the default rate.

3 In theDefault Max box, type the default max.

4 From the Filemenu, select Save.
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5 To themessage that states, Reminder: Use the 'Options' menu to update Rate/Maximum change(s) to employee
records, click OK.

6 From the Filemenu, select Recall.

7 From theOptionsmenu, select Update Employees > ALL Employees.

8 To themessage that states, Reminder: ALL employees will be updated with this calculation's default rate and
maximum. (This calculation will be added to employees who do not currently have it.) Do you want to
continue? click Yes.

9 To themessage that states, [number] employees have been updated, click OK.

10 All of your employees are now updated with the new FICA and other rates andmaximums.

About setting up posting accounts for payroll calculations

Many payroll calculations require you to provide the posting accounts. Sage 100 Contractor reads and posts each timecard
line amount based on the ledger accounts in the payroll calculation setup.

When the timecard line indicates a job number, Sage 100 Contractor debits the direct labor account.

When the timecard line indicates an equipment number (for repair or maintenance), Sage 100 Contractor debits the shop
labor account.

When the timecard line does not indicate a job or equipment number, Sage 100 Contractor looks at the employee’s position
to determine whether to post the account to an overhead or administrative labor account.

You can control the job, shop, overhead, and administration labor expense accounts and the credit account for each payroll
calculation. The employee positions setup determines to which accounts Sage 100 Contractor posts. Sage 100 Contractor
debits employer burden for payroll taxes, Workers’ Compensation, benefits and liability insurance to the accounts indicated
in the chart below.

In the example below, Sage 100 Contractor debits gross wages to accounts 5400, 5600, 6400, or 7400 based on the
settings in 5-3-3 Employee Positions.

Debit Job Shop Overhead Administration

Payroll tax 5410 5610 6410 7410

Workers’ Comp 5420 5620 6420 7420

Benefits 5430 5630 6430 7430

Liability 5440 5640 6440 7440

Gross Wage 5400 5600 6400 7400

NOTE: A payroll calculation using calculation type 1-Deduct from Employee does not allow entry of the posting
accounts. Instead, Sage 100 Contractor refers to the posting accounts assigned to the employee position. When you
compute timecards, Sage 100 Contractor looks at the employee position to determine where to post labor expenses.

Payroll calculation check boxes

l Emp# as Subaccount: Posts payroll to subsidiary accounts that use the employee numbers as the subsidiary
account numbers. The credit account must first be set up as a controlling account. Sage 100 Contractor
automatically creates the subsidiary accounts for you.

l Use in Paygroup Benefits: Allows you to select that particular calculation for a paygroups benefit package.
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l Display on Check: Includes the result of the calculation on the paycheck stub.

l Disposable Earnings: Indicates that the deduction is discretionary and that the deduction amount will be
calculated as part of the net amount.

For example, a 401(k) deduction for an employee is a discretionary deduction. Disposable Earnings should be
checked. Even though the amount of the employee’s paycheck will not include the amount of the 401(k) deduction,
the starting net amount will include the 401(k) deduction.

l Default to New Employees: Includes the payroll calculation in the group of payroll calculations that default to the
Calculations tab when creating a new employee record.

About tax areas

Some payroll calculations are set up for specific state taxes or local payroll taxes.

l Tax State:When a payroll calculation is statewide, such as state income tax or state disability, provide the state
abbreviation.

l Tax Locale:When a payroll calculation is for a local payroll tax district, select the locale from the list.

About tax tables for setting up federal and state tax calculations

IMPORTANT: Even though some states do not have state income tax:

(1) The state income tax calculation needs to be set up in the 5-3-1 Payroll Calculationswindow so that the reports
based on state wages are accurate and print correctly.

(2) State income tax calculations for employees must be set up in the 5-2-1 Employeeswindow so that the payroll
calculations compute correctly.

Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state you
work in, create a payroll calculation for state income tax. The calculation is necessary tomaintain the correct gross wage
totals for each employee, and to ensure accurate state quarterly reports, state tax reports, andW-2 forms.

If you work in a state that does not levy an income tax, you still need to create a payroll calculation. For those states, a tax
is not calculated but Sage 100 Contractor stores the state wage for state reports. In addition, some calculations use the
state wage to compute additional deductions such as state unemployment or disability. For those types of calculations, it is
important to select theState Income Tax check box. Otherwise, the payroll calculationmay not compute the deduction
correctly.

For details on setting up tax calculations for specific states andmunicipalities, see Appendix D-Tax Setup Information.

About reviewing rates in tax tables

When setting up a payroll calculation for federal or state income taxes, Sage 100 Contractor sets the appropriate rate but
does not display it in the payroll calculation or in the employee record.

Other federal or state calculations such as Social Security, Medicare, State Unemployment Insurance, and State Disability
do not use tax tables. When you set up a calculation for social security, for example, Sage 100 Contractor suggests a
default rate andmaximum, but the default rate andmaximum is not part of the tax tables.

It is recommended that you perform a yearly review and update the calculation rates andmaximums in each payroll
calculation. Then update the changes to the employee records.

For details on setting up tax calculations for specific states andmunicipalities, see Appendix D—Tax Setup Information.
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About Union and Benefit in payroll calculations

UnderReporting in the 5-3-1 Payroll Calculationswindow, there are four text boxes in which youmay have to enter
values. Two of them areUnion andBenefit:

l Union: You can assign a calculation to a specific union. When you print a union report, Sage 100 Contractor
includes the payroll calculation totals assigned to the union.

l Benefit: You can select the type of benefit for which the calculation is used. When you print certified payroll reports,
Sage 100 Contractor includes the payroll calculation totals for the benefit.

About W-2 Box and W-2 Code in payroll calculations

UnderReporting in the 5-3-1 Payroll Calculationswindow, there are four text boxes in which youmay have to enter
values. Two of them refer to calculations onW-2 forms.

o W-2 Box: To include the total of a payroll calculation on theW-2, you can provide theW-2 box number. Use this for
amounts that youmust include in boxes 11 through 14 on theW-2.

Note:

The following list of W-2 codes became effective for the
2007 tax year.

o W-2 Code: You can provide the special W-2 code, required by certain entries on theW-2.

Valid W-2 Box 12 codes:

l A: Uncollected Social Security tax on tips

l B: UncollectedMedicare tax on tips

l C: Taxable cost of group-term life insurance greater than $50,000

l D: Elective deferrals under a Section 401(k) cash or deferred arrangement (plan)

l E: Elective deferrals under a Section 403(b) salary reduction agreement

l F: Elective deferrals under a Section 408(k)(6) salary reduction SEP

l G: Elective deferral and employer contributions under a Section 457(b) plan

l H: Elective deferrals under a Section 501(c)(18)(D) tax-exempt plan

l J: Non-taxable sick pay

l K: 20% excise tax on excess golden parachute payments

l L: Substantiated employee business expense reimbursements

l M: Uncollected Social Security or RRTA tax on taxable cost of group-term life insurance greater than $50,000 (for
former employees)

l N: UncollectedMedicare tax on cost of group-term life insurance greater than $50,000 (former employees only)

l P: Excludablemoving expense reimbursements paid directly to employee

l Q: Non-taxable combat pay

l R: Employer contributions to your Archer MSA
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l S: Employee contributions under a 408(p) SIMPLE plan

l T: Adoption benefits

l V: Income from exercise of non-statutory stock option(s).

l W:Employer’s contribution to a Health Savings Account (HSA)

l Y: Deferrals under a section Section 409A non-qualified compensation plan (For more information, see Internal
Revenue Bulletin: 2005-47, Code Sec. 409A.)

l Z: Income under Code Sec. 409A on a non-qualified deferred compensation plan.

l AA:Designated Roth contributions under a Section 401(k) plan.

l BB: Designated Roth contributions under a Section 403(b) plan

l CC:HIRE exempt wages and tips

l DD: Cost of employer-sponsored health coverage

l EE: Designated Roth contributions under a governmental section 457(b) plan

Setting up an advance earned income credit (EIC) calculation

Suggested settings for an advance EIC calculation:

1 Open 5-3-1 Payroll Calculations.

2 In theDescription box, type a description, for example, “Advance EIC.”

3 From the Tax Type drop-down list, select 17—Advance EIC Payments.

4 Press the Tab key.

5 TheCalc Type box autofills with 2—Add to Gross and theCalc Method box autofills with 18- Variable (manual calc).

6 TheMax Type box autofills with 0—None.

7 From the Job Acct, Shop Acct, Ovh Acct, andAdmin Acct box drop-down lists, select a Fica/FIT payable account.

8 From theCredit Acct drop-down list, select aGeneral Checking account.

9 TheW-2 Box autofills to “9.”

5-3-2 Workers' Compensation
About Workers Compensation

In the 5-3-2 Workers’ Compensation window, you can set up the table for workers’ compensation codes, rates, and
experiencemodifiers. Sage 100 Contractor uses the table in conjunction with the workers’ compensation payroll calculation
to compute the premium for each code category. How you set up the workers’ compensation codes depends on the
requirements for each state.

l Some states use two-tiered codes, where two rates apply to a single category of work.

l Some states require the employer to pay for general liability insurance. Often the liability rates are based on the risk
groups, but are not affected by the experiencemodification.

l Some states use a dollar per hour rate instead of a percent; some use both.

l Some states do not require subcontractors to carry workers’ compensation insurance. Often the general contractors
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carry the liability insurance burden for the subcontractor.

l The states of Ohio and New York may include a workers’ compensation value in theMaximum Wage column.

Use the compensation codes from the insurer's policy or report whenever possible. Companies with multiple policies may
find that the policies share compensation codes. If this occurs, youmay need to create a separate numbering system for
Sage 100 Contractor to use. Then include each state’s compensation code at the end of the description.

After you have set up the table, you can assign the workers’ compensation codes to the cost codes and employee records.
When you enter a timecard, Sage 100 Contractor first looks to the cost code. If Sage 100 Contractor does not find a
compensation code, Sage 100 Contractor then looks to the employee record.

It is a good idea to write the expiration dates of your workers’ compensation policies on your company calendar. Also, write
a reminder on the calendar onemonth prior to the policy expiration so you can get quotes for the next policy term. When you
renew the policies, adjust the rates and experiencemodifications in the 5-3-2 Workers’ Compensation Codeswindow.

A few states have special requirements for calculating workers’ compensation. For more details, see Appendix D: Tax
Setup Information and help topics about these state’s specific workers’ compensation requirements.

Entering workers’ compensation codes

In 5-3-2 Workers’ Compensation, you set up the table for workers’ compensation codes, rates, and experiencemodifiers.
Sage 100 Contractor uses the table in conjunction with the workers’ compensation payroll calculation to compute the
premium for each code category. How you set up the workers’ compensation codes depends on the requirements for each
state.

NOTE: In some state, subcontractors are not required to carry workers’ compensation liability insurance. The general
contractor often charges the subcontractor for the cost of coverage on the general contractor’s policy for the duration
of the project.

To enter workers’ compensation codes:

1 Open 5-3-2 Workers’ Compensation.

2 In theCode# cell, enter the compensation code number.

3 In theDescription cell, do the following:

a Enter a brief description of the code.

b If you created a numbering system for multiple state compensation codes, enter the insurance company’s
compensation code following the description.

4 If you work in multiple states and havemultiple policies, do the following:

a Enter the two-letter state abbreviation in theState cell.

b Open 5-3-1 Payroll Calculations and set up the corresponding payroll calculation with tax type 11-Workers
Compensation, and enter the two-letter state abbreviationin theState cell for each state.

5 If the premium is computed using a percentage, enter the rate in theEmployer % cell.

6 If the premium is computed using a dollar per hour rate, do the following:

a Enter the employee’s rate in theEmployee Hrly cell.

b Enter the employer’s rate in theEmployer Hrly cell.

7 In the Liability cell, enter the rate for your liability insurance.

IMPORTANT: If your company is required to carry liability insurance, enter the rate in the Liability column.
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8 In theExper Mod cell, enter themodification number.

9 If you have a second experiencemodification, enter themodification number in theAdd Exper Mod cell.

10If there is amaximum wage limit, in theMaximum Wage cell, enter themaximum wage.

11Repeat steps 2–10 for each compensation code.

12On the Filemenu, click Save.

TIP: Companies that operate in a single state do not need to assign the state abbreviation to either the compensation
codes or the payroll calculation for worker’s compensation.

About split rates for workers' compensation

In a split rate system forWorkers’ Compensation, a category of work uses two different rates. Some states, such as
California, use a two-tiered system of rates based on employee pay. The wages an employee earns determines the rate at
which the insurance company computes Workers’ Compensation.

Each rate uses a different code; enter each rate on a separate line in the 5-3-2 Workers’ Compensation window. It is a
good idea to also include the wage cutoff point in the description.

Suppose you are entering the split rates for electrical and concrete work. Enter each cost code as a separate line. In the
description, include the wage cutoff.

For example:

Code # Description State Employer %

5140 > $20 Electrical CA 3.9300

5190 < $20 Electrical CA 8.8200

5201 < $17 Flatwork Concrete CA 9.8600

5205 > $17 Flatwork Concrete CA 8.4200

Workers’ compensation for subcontractors

Some states do not require subcontractors to carry workers’ compensation insurance. In these states, the subcontractors
may use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of
coverage from payments to the subcontractor. Check with your state for compliance requirements, as the laws vary in each
state.

You can set up the vendor record of a subcontractor with the employer’s compensation rate. When entering the payable
invoice, you can charge the subcontractor for coverage based on the invoiced amount. The charge appears as a credit on
the subcontractor’s invoice.

The credit does not appear on theWorkers’ Compensation report, which only uses data from payroll records. To track and
report these costs, it is a good idea to create a separateWorkers’ Compensation ledger account.

5-3-3 Employee Positions
About employee positions

Employee positions determine how you post payroll costs to the general ledger. Create employee positions that represent
the type of work performed by employees such as office workers, job supervisors, and laborers. The list does not need to
be complex. However, youmust create at least one employee position.
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After creating the employee positions, assign them to employee records. When you post a payroll record, Sage 100
Contractor looks at the position in an employee’s record, and the ledger accounts in the employee positions table:

l When a timecard line contains a job number, payroll posts to the ledger account in the Job Wages cell.

l When a timecard line contains an equipment number (for maintenance or repair), payroll posts to the ledger account
in theEquipment Wages cell.

l When a payroll record does not contain timecard lines, or a timecard line does not contain a job number or equipment
number, Sage 100 Contractor posts to the ledger account in theOther Wages cell.

You can also add a department to each position. When you post a payroll record, Sage 100 Contractor first looks to the job
record for a department number. If Sage 100 Contractor does not find a department number in the job record, it next looks to
the cost code. If the cost code does not contain a department number, Sage 100 Contractor then looks to the employee
position.

Setting up employee positions

The 5-5-5 Employee Positionswindow provides a way for you to classify employee positions.

Note that if you have set up departments to represent different offices, create duplicate employee positions for each office.
Then assign the positions for each office to the corresponding departments.

To set up employee positions:

1 Open 5-3-3 Employee Positions.

2 In thePosition# cell, enter the position number.

3 In theDescription cell, enter a brief statement about the position.

4 In the Job Wages cell, enter the direct labor account.

5 In theEquipment Wages cell, enter the equipment/shop labor account.

6 In theOther Wages cell, enter the overhead labor or administrative labor account.

7 If relevant, in theDepartment cell, enter or select a department.

8 If relevant, in theNotes cell, type a note and then save it.

9 Repeat steps 2–8 for each position.

10 On the Filemenu, click Save.

5-3-4 Paygroups
About paygroups

Use paygroups tomanage wages and the benefit packages for union shops, or open shops working Davis-Bacon projects.
You can include the paygroups in the employee record or in the job record to provide the correct paygroup when entering
timecards. The paygroup then becomes the source for wages and benefits on the timecard lines.

l For union shops, set up a paygroup for each combination of pay scale and benefits package that you need to report.
Then assign the appropriate paygroup to each employee record. During timecard entry, Sage 100 Contractor assigns
the paygroup from the employee record to each timecard line.

When working with multiple unions, it is a good idea to provide the union number at the beginning of the paygroup
description. Place the important information at the beginning of the description. For example, 80% Apprentice
instead of Apprentice—80%.
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l In open shops, the requirements between the prevailing-wage projects can vary, and employees can work under a
variety of pay categories. For each prevailing-wage project, set up the appropriate paygroups for each combination
of pay scale and benefits package that you need to report. Then in the job record, you can list only the paygroups for
that job. When you enter a job number on a timecard line, Sage 100 Contractor looks for a list of paygroups. If the job
record contains a list of paygroups, it then uses the employee’s position to determine the appropriate paygroup and
inserts it on the timecard line.

When creating the paygroups, organize the paygroups by job or geographic area. When numbering the paygroups, skip a
few numbers between groups in case you need to add other paygroups later. Youmay also want to include a job or area
description in the paygroup name. This allows quick identification of the correct paygroup when entering timecards.

Each union or prevailing-wage project has specific requirements as to how the benefits are calculated. Tomanage the
different benefit packages, you can assign an independent set of payroll calculations to each paygroup. It is important to
review each benefit you provide and determine if it meets the requirements set forth by the governing agency. If not, you will
need to create a new payroll calculation.

Entering paygroups

To enter paygroups:

1 Open 5-3-4 Paygroups.

2 In thePaygroup# cell, enter the paygroup number.

3 In theName cell, enter a brief description of the paygroup.

4 In theClassification cell, enter a description of the type of work performed. Sage 100 Contractor includes this
information on certified payroll reports.

5 If you want the paygroup to supersede the benefits in the employee record, type Yes in theOverride cell.

6 In theRate 1 cell, enter the rate for regular pay.

7 In theRate 2 cell, enter the rate for overtime pay.

8 In theRate 3 cell, enter the rate for premium pay.

9 In thePiece Rate cell, enter the rate of pay per completed piece.

10 In theUnion cell, enter the union number.

11 Repeat steps 2–10 for each paygroup.

12 On the Filemenu, click Save.

13 Set up the benefits package for each paygroup.

Updating employee pay rates

When employee pay rates change in paygroups, you can update the employee records.

IMPORTANT: When you update pay rates, do not do it in a window with a specific employee in view. It’s best to
update employee pay rates in a blank window. This gives Sage 100 Contractor a chance to refresh the records when
you bring them into view after the updating process.

To update employee pay rates:

1 Open 5-2-1 Employees.

2 On themenu bar, click Options.

3 Point toUpdate Employees from Paygroups, then click Update Payrates
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Use higher rate

When you click Use Higher Rate (Emp or Paygrp) from theOptionsmenu in 5-2-2 Payroll Records, Sage 100
Contractor compares the hourly wage in the employee record to the hourly wage in the paygroup, then inserts the highest
wage.

For example, if an individual carpenter’s regular rate of pay is $40 per hour, but the regular rate in the paygroup for
carpenters is $35 per hour, with theUse Higher Rate (Emp or Paygrp) option selected, the overtime differential is based
on $40 per hour individual carpenter’s rate rather than $35 per hour paygroup rate.

About setting up payroll calculations for paygroup benefit packages

Use the 5-3-4 Paygroupswindow to assign each paygroup its own set of payroll calculations that Sage 100 Contractor
uses to compute its associated benefits. First you select the payroll calculations, and then you assign each a rate. When
you perform the final compute of the payroll, 5-3-4 Paygroups is the source for the benefit rates.

In some cases, the calculationmethods or the taxes to which a calculation is subject differ from union to union or from job
to job. When the calculationmethod or taxes differ for a similar payroll calculation, you have to set up a separate payroll
calculation.

For each paygroup benefit, create a separate payroll calculation in 5-3-1 Payroll Calculations in theCalc Method drop-
down list, using the following guidelines:

l You can usemost calculationmethods for paygroups with the following exceptions:

2-%Total Taxable Wages

10-Per Day

11-Per Pay Period,

17-Tables

18-Variable (manual calc)

Benefits set up using thesemethods are excluded from reports.

l Some payroll calculations are computed after a paygroup benefit has been computed and its result has been added
to the gross wages. In theCalc Method list, click 3-%Gross + Paygroup Benefits. For example, youmight need
to compute union dues after the vacation benefit has been added to the gross wage.

l Calculationmethod 3-%Gross + Paygroup Benefits requires the calculation to have a calculation number larger
than that of the calculation that adds the benefit to the gross wage. Sage 100 Contractor executes each payroll
calculation in the order established by the calculation numbers.

l To use the calculation for paygroup benefit packages only, select theUse in Paygroup Benefits check box.

l To include the calculation on a union report, underReporting, select the union from theUnion drop-down list. Union
reports can only be included with the calculations of their own union number. If you are using union reports and have
more than one union, youmust create a set of calculations for each union.

l To include the calculation on certified payroll reports, underReporting, select the type of benefit in theBenefit list.

You can use the same payroll calculation in different paygroups, but assign different rates. Suppose that in county A you
have performed Davis-Bacon work. Recently, you won a Davis-Bacon contract in county B from the same government
agency. The governing agency has not changed the calculationmethods, but the wage and benefit rates differ. In setting up
the paygroups for the new contract, you can use the same benefit calculations but assign different rates to them.
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Entering benefits packages for paygroups

To enter the benefits package for a paygroup:

1 Open 5-3-4 Paygroups.

2 In thePaygroup# column, click in the cell of the paygroup that you want to assign benefits.

3 Click theBenefits button.

A window opens corresponding to the paygroup that you selected.

4 In theCalculation column, click the cell in which you want to insert the benefit, and then click the down arrow button.

5 ThePayroll Calculationswindow opens.

6 To select the benefit type, double-click the item.

7 In theRate column, in the appropriate cell, enter the rate for each benefit.

8 On the Filemenu, click Save.

TIP: Alternatively, you can right-click in theCalculations column, and chooseDisplay Picklist Window; or you can
click in the column and press the F8 key to display aPicklistwindow. You can choosemultiple benefits from a
Picklist. Select several items, and then click the check mark button.

Updating employee benefits

When youmake changes to the benefits in a paygroup, update the employee records. Sage 100 Contractor updates all
employee records.

To update employee benefits:

1 Open 5-2-1 Employees.

2 On themenu bar, click Options.

3 Point toUpdate Employees from Paygroups, then click Update Benefits.

4 In the confirmationmessage, click Yes orNo to continue.

5 In the next confirmationmessage, click OK.

5-3-5 Payroll Unions
Setting up payroll unions

There are two ways to create the table of unions.

You can create a numbering system for the unions that is independent of the union numbers, using the Local number as the
union name or part of the union name.

For example:

Union # Union Name

1 Local 27

2 Local 194

3 Local 689



- 320 -

The other method is to simply use the union numbers. If you have employees who work out of different locals for the same
union, enter each local as a separate union. This provides you with the ability to create reports about each local.

For example, a large electrical contractor has employees working out of several National Brotherhood of Electrical Workers
(NBEW) locals:

Union # Union Name

27 NBEW Local 27

194 NBEW Local 194

689 NBEW Local 689

To set up payroll unions:

1 Open 5-3-5 Payroll Unions.

2 In theUnion# cell, enter the union number you want to use.

3 In theUnion Name cell, enter a brief statement about the union.

4 In theAddress 1 cell, enter the street address.

5 In theAddress 2 cell, enter any additional address information.

6 In theCity cell, enter the city.

7 In theState cell, enter the state abbreviation.

8 In the Zip cell, enter the ZIP Code.

9 In thePhone# cell, enter the telephone number.

10 Repeat steps 2–9 for each union.

11 On the Filemenu, click Save.

IMPORTANT: When union benefits change, it is necessary to adjust the system’s calculations in 5-3-1 Payroll
Calculations and 5-3-4 Paygroups.

5-3-6 Local Payroll Tax
About local payroll taxes

Many counties andmunicipalities levy income taxes. In the Local Payroll Taxeswindow, set up the table of local payroll
tax districts and their rates. You can then assign the locales to the appropriate job and employee records. If an employee
lives in a locale, add the locale to the employee’s record. If a job site is located in a locale, add the locale to the job record.

There are a variety of ways to set up the districts:

Some districts base the taxes on whether the employee lives inside or outside the locality. The resident rate applies to
employees that work and live in the same locality, while the non-resident rate applies to employees who work in the locality
but live elsewhere.

During the payroll computation, Sage 100 Contractor compares the locale in the job record to the locality in the employee
record. If the districts match, Sage 100 Contractor computes taxes at the resident rate. If the district numbers differ, Sage
100 Contractor computes taxes at the non-resident rate.
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In some regions, employees are subject to several taxes, such as city and county income taxes. As Sage 100 Contractor
only lets you assign one locality to a job record, employee record, or timecard line, you can combine districts in the Local
Payroll Taxwindow to form a new district. You can then assign the combined district as needed.

When a local payroll tax applies to employees regardless where they work, you can set up the district to work like state
income tax.

When employees work multiple states but there are no local payroll tax districts, use the districts to control how Sage 100
Contractor computes state income tax for each timecard line.

Each locality requires a corresponding payroll calculation. In most circumstances, each payroll calculation uses calculation
method 17-Tables, and refers to the table of localities for the rates.

Entering local payroll tax districts

Consider the following points before entering payroll tax districts:

l Some regions have reciprocal agreements. Using theDifferential column, you can indicate that the local payroll tax
district for the job site has a reciprocal agreement.

l When you have local tax districts in different states, group the tax districts by state using the district numbers.

IMPORTANT: If employees work in New York City or Yonkers, youmust set up a special tax district in order to
calculate taxes correctly.

IMPORTANT: Do not use local payroll tax districts for State Unemployment or other non-income tax purposes.

To enter local payroll tax districts:

1 Open 5-3-6 Local Payroll Taxes.

2 In theDistrict# cell, enter the district number.

3 In theDistrict Name cell, enter a description of the district.

4 In theResident Rate cell, enter the rate paid by residents.

5 In theNon-resident Rate cell, enter the rate paid by non-residents.

IMPORTANT:

If the district does not make a distinction between residents and non-residents, enter the same rate in theResident Rate
andNon-resident Rate cells.

6 In the Tax State cell, enter the state abbreviation.

7 Repeat steps 2–6 for each tax district.

8 On the Filemenu, click Save.

9 Set up the payroll calculation type for each district created.

Viewing the details for local payroll tax districts

You can display a summary of the local payroll taxes computed for a timecard. The summary displays totals of payroll
calculations set up with calculationmethod 17-Tables.

IMPORTANT: The effective tax rate only applies to local payroll tax districts set up to compute reciprocal taxes.
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To view the details for local payroll tax districts:

1 Open 5-2-2 Payroll Records.

2 Using the data control, select the payroll record.

3 On theOptionsmenu, click Local Tax District.

Combining local payroll tax districts

You can combine individual districts to create a new district. The combined district does not require a payroll calculation,
because Sage 100 Contractor uses the payroll calculations already set up for the individual districts. You can then assign
the combined district to the appropriate job or employee records.

A combined local payroll tax district only requires a district number, district name, and the district numbers you want to
combine. Suppose you have already set up tax districts 2 and 3, which calculate a city income tax and a county income
tax. A recently hired employee lives in an area where both districts apply. Because you can only assign one district to an
employee record, create a new district that combines the existing districts. You create district 4 with the following
description: City & County (2,3). You can then assign district 4 to the employee record.

To combine local payroll tax districts:

1 Open 5-3-6 Local Payroll Tax.

2 In theDistrict# cell, enter the district number of the new combined district.

IMPORTANT: The combined district must appear in the list after the districts you are combining. For example, you
cannot create a district on line 1 that combines districts on lines 2 and 3.

3 In theDistrict Name cell, enter the name of the district and the district numbers that you want to combine.

4 For example, enter district namedCity & County (2, 3) in the district name cell to combine the tax districts.

IMPORTANT: Be sure to separate the districts using commas and enclose them in parentheses.

5 In the Tax State cell, enter the state for the district.

6 On the Filemenu, click Save.

TIP: Combined districts do not require tax rates. The districts you are combining already contain the tax rates.

Creating a table of states

When employees work in different states during a single pay period, use the local payroll tax districts to indicate the state
on each timecard line. While some regions may not levy local income taxes, you can still use local payroll tax districts to
assign the correct state to timecard lines. You can set up local payroll tax districts that only contain a state (leave the
Resident Rate andNon-resident Rate cells blank).

Localities give you line-by-line control over the state for which Sage 100 Contractor computes income taxes. The state
assigned to a locality takes priority over the state assigned to the entire payroll record. When Sage 100 Contractor finds a
locality assigned to a timecard line, Sage 100 Contractor computes the income tax for that state specified in the local
payroll tax district.

To create a table of states:

1 Open 5-3-6 Local Payroll Taxes.

2 In theDistrict# cell, enter the district number.

3 In theDescription cell, enter a brief statement about the district.
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4 In theState cell, enter the state abbreviation.

5 Repeat steps 2–6 for each state.

6 On the Filemenu, click Save.

7 Set up the payroll calculation for each state.

About reciprocal agreements and local payroll tax districts

Suppose cities A and B have a reciprocal agreement. City A has a local tax of 0.75% and City B has a local tax of 0.5%.
Rick lives in city A but works in city B. When Rick is paid, City B receives its 0.5% tax and City A, because of the
reciprocal agreement, receives 0.25%, which is the difference between the taxes.

When you set up a locale in the 5-3-6 Local Payroll Taxwindow, you can indicate that a locale is subject to a reciprocal
agreement. In theDifferential column, you can indicate that the locale where the project is located has a reciprocal
agreement by typing Yes. You can then assign the locale to the job record. When you compute payroll, Sage 100
Contractor compares the non-resident rate of the job’s locale to the resident rate of the employee’s locale. If the rate for the
employee’s locale is greater, Sage 100 Contractor calculates the difference and withholds the amount from the employee’s
pay.

Setting up payroll calculations for local payroll tax districts

IMPORTANT: If you use calculationmethods 2-Percent Total Taxable Wages, or 7-Percent Other Calculation,
local payroll taxes will not be displayed on the Local Tax Reports and the wages will not be displayed on theW-2
forms.

To set up a payroll calculation for a local payroll tax district:

1 Open 5-3-1 Payroll Calculations.

2 In the Tax Type list, click 13-Local Income Tax.

3 In theCalculation Method list, select 17-Tables.

4 The payroll calculation uses the rates from 5-3-6 Local Payroll Taxes.

5 In the Tax Locale drop-down box, select the locale that uses the calculation.

6 Youmust create a payroll calculation for each locale. Some local payroll tax districts allow employees an annual
exemption.

7 In theStd Allow text box, enter the annual dollar amount for standard allowances. This is the amount withheld for single,
married, and so forth.

8 In theAdd Allow text box, enter the annual dollar amount for additional allowances. This is an additional amount to be
withheld.

Setting up a local payroll tax district like a state income tax

CAUTION: Do not assign the locality as the default on theGeneral information tab of the 5-2-1 Employees
window. Also, do not assign the locality to a job record.

Some regional taxes function like a state income tax. The same rate applies regardless of where the employee works. Use
the following guidelines to set up the local payroll tax district.

IMPORTANT: Do not enter rates in theResident Rate andNon-resident Rate cells. Sage 100 Contractor will use
the rate from the payroll calculation.

To set up a local payroll tax district like a state income tax:

1 Open 5-3-1 Payroll Calculations.
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2 In the Tax Type list, click 13-Local Income Tax.

3 In theCalculation Method list, click 2-Percent Total Taxable Wages.

4 In theDefault Rate cell, enter the income tax rate.

5 In the Tax Locale list, click the local payroll tax district.

6 Update the new payroll calculation to theCalculations tab in 5-2-1 Employees as needed.

CAUTION: After you include the payroll calculation on theCalculations tab of the employee records, Sage 100
Contractor uses the payroll calculation like the state and federal income tax calculations.

5-3-7 Payroll Audit
About auditing payroll

You can repair and audit the stored balances of each employee record before filing the quarterly or yearly payroll reports.
The repair recalculates the gross wage, Social Security, andMedicare totals from the payroll records. The audit compares
them to the totals stored in the employee records. The repair also recalculates the quarterly totals for each payroll
calculation and compares them to the quarterly totals stored in the employee records.

If a recalculated total does not match the stored total, a variance exists. Audit variances can result from several factors:

l Incorrectly computed Social Security or Medicare taxes on hand-computed checks.

l Changes to payroll calculations after computing payroll records.

l Hardware failure or power outage.

The audit also looks for check dates that do not fall within the correct payroll quarter. When the check date is wrong, you
can enter the correct check date in the existing record. When the quarter is wrong, void the original record and re-enter the
record using the correct quarter.

When the audit is complete, print thePayroll Audit report—it identifies the employee records containing variances, the
payroll records referencing an incorrect check date or quarter, and un-computed and un-posted payroll records. Some
variances can be repaired by Sage 100 Contractor.

Auditing payroll

When the audit is complete, print thePayroll Audit Report. The audit report lists all errors uncovered during the audit,
regardless of whether you have already resolved them.

To audit the payroll:

1 Open 5-3-7 Payroll Audit.

2 Click theAudit button.

Repairing the payroll balances

During the repair for variances, Sage 100 Contractor recalculates the quarterly and year-to-date totals for Social Security
wages, Medicare wages, and gross wages from the payroll records assigned status 2-Computed or status 3-Posted.
Additionally, Sage 100 Contractor recalculates the quarterly totals of each payroll calculation and runs an audit.

To repair the payroll balances:

1 Open 5-3-7 Payroll Audit.

2 Click theRepair button.
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NOTE: The repair only recalculates the balances based on how the payroll calculations have been set up. It cannot
repair data resulting from incorrectly set up payroll calculations.

Changing the check date on payroll records

To change the check date on a payroll record:

1 Open 5-2-2 Payroll Records.

2 Using the data control, select the payroll record.

3 In theCheck Date text box, enter the correct check date.

4 On the Filemenu, click Save.

Changing the payroll quarter on payroll records

To change the payroll quarter on a payroll record:

1 Open 5-2-2 Payroll Records.

2 Using the data control, select the payroll record.

3 In theQuarter text box, enter the correct quarter number.

4 On the Filemenu, click Save.

5-3-8 Close Payroll Year
About closing the payroll

At the end of the calendar year, close the payroll to prepare for the new calendar year. During the close, Sage 100
Contractor removes all payroll records and resets the quarter-to-date and year-to-date totals $0. It is important to note that
closing payroll does not affect the accrued vacation, sick, and compensation times in the employee records that you
choose to retain. You can also delete old or unnecessary employee records.

Before entering timecards for the new calendar year, audit, back up, and then close/archive the payroll. Although youmay
back up your company data at any time, in the context of closing the payroll, it makes sense to back up your data after you
have audited it and corrected any errors.

Closing payroll can be time consuming, and the time necessary to create an archivemay be considerable depending on the
number of payroll records and employees contained in each company. We recommend creating a schedule of tasks to
perform leading up to the close. For example, consider auditing the payroll a month in advance of the scheduled closing
date. This should provide enough time to resolve any errors that might exist.

While it is not recommended, Sage 100 Contractor lets you close payroll with uncomputed records, unposted records, even
payroll audit errors. If you close with unfinished work, youmust go back to the archive later and compute and post the
records, repair the audit errors, and then adjust the payroll records in the active company. From the archive, you can also
prepare and print the state and federal reports and theW-2 forms.

It is important to understand the differences between closing the payroll and the accounting. All companies close payroll at
the end of the calendar year, but not all companies close the fiscal year at the end of the calendar year.

Close payroll and archive

If you enter transactions between closing accounting and closing payroll, create separate backups and archives of the
accounting and payroll. This ensures you have permanent records of all your data.

Before you begin to close your payroll, make sure that you are in your current company and not in your general ledger
archive company.
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IMPORTANT: You cannot enter payroll data that has check dates in the new calendar year until payroll for the
previous year is closed.

Back up and verification

Back up and verify two copies of your Sage 100 Contractor data. Put one copy in a safe storage area. Make at least one of
your backups on a separate removable storage device.

NOTE: You can use this back-up to verify data integrity if you have to close again.

Designate your archive, select employee removal options, and close year

1. Open 5-3-8 Close Payroll Year, and enter a name for the archive. There are different ways to name your payroll
archive company file. We suggest including the following information. For example: 2013 Payroll [Your Company
Name]. </li>

l The year of the archive file.

l The type of archive file you aremaking.

l The name of the company.

2. Select employee removal options.

3. Click Close Payroll.

NOTES:

l During close, the program removes all 5-2-2 Payroll Records and resets all employee year-to-date totals.
l The payroll archive company is different than the general ledger archive company.

Rebuild indexes and tables

Open 7-4 Rebuild Indexes, select Options > Rebuild All Tables, and then click Start.

NOTE: The program is now in the new payroll year.

About deleting employee records

CAUTION: Exercise caution when deleting employee records. Cost records use employee information for cost
reports. This includes but is not limited to job costs, equipment costs, and service receivables. Moreover, current job
records might contain references to old employee records.

When closing the payroll, you can delete employee records based on the status assigned to the employee record. You can
remove records assigned status 3-Quit, 4-Laid Off, 5-Terminated, and 7-Deceased.

Suppose that you often re-hire employees. Youmight not want to delete certain employee records. Sage 100 Contractor
lets you review each employee record before deletion when you select theApprove Each Employee’s Removal check
box.

CAUTION: You can usually delete the employee records of former office employees. Nevertheless, make sure the
job cost records do not refer to the office employee records you want to delete.

Verifying the payroll archive

To verify the payroll archive:

1 Open Sage 100 Contractor, and select the company that you want to archive and close.
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2 Open 5-2-2 Payroll Records, click theCount button, and note the total number of records.

3 Open 4-2 Accounts Payable Invoices, click theCount button, and note the total number of records.

4 Open 5-3-8 Close Payroll Year. Archive and close the payroll.

5 Exit Sage 100 Contractor.

6 Launch Sage 100 Contractor, and select the archive you have just created.

7 Open 5-2-2 Payroll Records, click theCount button, and note the total number of records.

8 Open 4-2 Accounts Payable Invoices, click theCount button, and note the total number of records.

Compare the record totals taken before archiving from each of the three databases before archiving to those taken from the
archive. When the totals agree, the records have been archived correctly. If you find that the archive is incomplete, restore
a backup and create new archives.

Preparing payroll for the new calendar year

Before you process your first payroll in the new year, we recommend that you adjust rates for unemployment, adjust
thresholds for payroll calculations, and reset vacation and sick accrual.

Make the corrections and adjustments from themenu optionPayroll Calculations (5-3-1) in your active company folder:

l Correct State Unemployment default rates and default maximums. Do not forget to select Options > Update
Employees > Employeeswith this calculation after saving the changes.

l Correct Social Security default maximums. Do not forget to select Options > Update Employees > All
Employees after saving the changes.

l Correct State Disability Insurance default rates and default maximums. Do not forget to select Options > Update
Employees > Employeeswith this calculation after saving the changes.

l Correct 401K default maximums. After saving the changes and only if all employees with this calculation have the
samemaximum, select Options > Update Employees > Update Maximum Only > All Employeeswith this
calculation. Do not update the rate from 5-3-1 because this has to be done for each individual employee in the 5-2-1
> Compensation tab.

l Delete, alter, or add payroll calculations (5-3-1). If the changes apply to all employees with these calculations,
carefully select the appropriate update option from theOptionsmenu.

l Reset sick and vacation accrual for eligible employees (5-2-1 > Compensation tab) only if leftover hours do not
carry over to the next year.

l Adjust Employees (5-2-1) calculationmaximums to reflect what has been collected in prior years on the
Calculations tab. For example, youmay need to adjust employee loan repayment or employee garnishment
maximums.

NOTE: Formore information on closing the payroll year, look in Help and search for “closing.”

About 5-3-9 HR Forms
The 5-3-9 HR Forms by Aatrix window is an integration portal into Aatrix software. When youmove beyond this window by
clickingGo to Forms, you actually begin working in Aatrix software that has been integrated into Sage 100 Contractor.

On themenu bar, you have access to the following options:
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l Update Forms—Displays amessage window that prompts you to update Aatrix forms if updates are available.

l Register Aatrix Software—Displays the Aatrix Software Registration window. Registering allows you to fill out and
print current reports for the duration of your service andmaintenance contract.

NOTE: When you are working in Aatrix software, you have access to Aatrix Help. Sage 100 Contractor Help does
not duplicate Aatrix Help.

To go to forms:
1 Open the 5-3-9 HR Forms by Aatrix window.

2 If you are prompted to register, we strongly recommend that your register Aatrix software through Sage 100 Contractor.

3 Click Go to Forms.

4 Follow the instructions on the window, or refer to Aatrix Help.

5-4 Federal and State Tax Filing
5-4-2 State Forms

About Sage 100 Contractor integration with Aatrix
What is Aatrix®?

Aatrix is a leading provider of tax-form filing and compliance services. It is in business to help you complete state and
federal payroll reports directly from your software. Now that Aatrix has been integrated into Sage 100 Contractor, you have
the ability to fill out report forms, print, and then send them to federal and state entities.

In addition, if you enroll with Aatrix and set up an account, you can file reports electronically through Aatrix while working
within Sage 100 Contractor.

Whether you print and send your tax reports or you files the reports electronically, with Aatrix integration there is no longer
any need to create these tax reports manually.

What do I get if I register Aatrix through Sage 100 Contractor?

If you choose to register, you can fill out and print Aatrix report forms, and then send them to federal or state entities.

If you choose not to register, you can still use Aatrix in “Evaluate” mode; however, the forms you print will have a “DEMO”
watermark. You cannot file them with federal and state entities.

How do I register?

As soon as you open the Sage 100 Contractor windows, 5-4-1 Federal Tax Forms by Aatrix® or 5-4-2 State Tax Forms
by Aatrix®, you are prompted to register Aatrix through your Sage 100 Contractor so that it is associated with your Sage
Service Plan.

As a benefit for our customers, registering Aatrix through Sage 100 Contractor allows you to use Aatrix forms. We
recommend that you register immediately to take advantage of this valuable service.

Can I file electronically when I register?

Registering through Sage 100 Contractor allows you to use all the Aatrix report forms for your tax reports and then print
them. Registering the Aatrix software through Sage 100 Contractor does not enroll you with an Aatrix account for filing
electronically. To use electronic filing, you have to register for an Aatrix account.
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How do I enroll with Aatrix so that I can file electronically?

Formore information about enrolling with Aatrix and set up an account for efiling, visit https://efile.aatrix.com/

What is the Aatrix fee structure for electronic filing?

Formore information about Aatrix fees, visit
https://partner.aatrix.com/sagemasterbuilder.

Can I file W-2s electronically?

Formore information about filingW-2s electronically, visit
http://efile.aatrix.com/SMB029/info.aspx.

How do I use Aatrix with Sage 100 Contractor?

Basically, open either 5-4-1 Federal Tax Forms and eFiling by Aatrix or 5-4-2 State Tax Forms and eFiling by Aatrix.
Select a state (state forms only), a report, set criteria, and then click Run Report orView History.

When you click Run Report, you can review the report and enter any missing information. Then you go to the next step to
save and print the form. If you have an account with Aatrix, then you can file electronically by forwarding the completed
reports to the Aatrix eFile® center for electronic filing.

When you click View History, you can review and work with reports through theOpen Reportwindow.

How can I get acquainted with Aatrix integration before I use it for my company?

You can open the Sample Company and then open either 5-4-1 Federal Tax Forms and eFiling by Aatrix or 5-4-2 State
Tax Forms and eFiling by Aatrix. Select a state (state forms only), a report, set criteria, and then click Run Report or
View History. This will also give you a chance to open the Aatrix Help, which provides details information about how the
Aatrix processes works.

What technical support options do I have if I run into a problem with Aatrix?

If you have a problem with Aatrix or Sage 100 Contractor, call 800-849-8049 (Sage Customer Support for Sage 100
Contractor).

Common features with Aatrix integration windows
Common features with Aatrix integration windows

The 5-4-1 Federal Tax Forms by Aatrix® and 5-4-2 State Tax Forms by Aatrix® integration windows have common
features and behavior. They are both integration portals into Aatrix software. When you run some option commands or click
buttons, such as View History orRun Report, you actually begin working in Aatrix software that has been integrated into
Sage 100 Contractor.

Does Aatrix software have its own Help system?

When you click the Help button in 5-4-1 Federal Tax Forms by Aatrix® and 5-4-2 State Tax Forms by Aatrix®, you
open Sage 100 Contractor Help.

Aatrix software provides its ownHelp. When you click the Help icon after clickingView History orRun Report, you open
the Aatrix Help.

Where does the list of reports and descriptions come from?

The list of reports in the left pane and the report descriptions in the right pane of the 5-4-1 Federal Tax Forms by Aatrix®
and 5-4-2 State Tax Forms by Aatrix® windows are provided by Aatrix.

https://efile.aatrix.com/
https://partner.aatrix.com/sagemasterbuilder
http://efile.aatrix.com/SMB029/info.aspx
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As you click various reports in the list on the left, the description changes in the right pane. Reports have different selection
criteria. Youmay have to enter search criteria based on aYear, aYear and aPeriod, a First Check Date and a Last
Check Date, or no criteria.

How do I know the forms are up to date?

Aatrix guarantees to keep all its report forms up to date. Before you can actually work with Aatrix report forms, Aatrix
determines whether or not you have the latest forms. If you don’t, you are prompted to update the forms.

The first time you open (with Internet access) either Aatrix integration window and click View History orRun Report, the
program displays amessage window that provides four choices:

Automatic Update:Update forms automatically over the Internet.

Download Update:Update forms by manually downloading an update from any computer with an Internet connection.

Continue Expired:Continue processing without the required update. Forms will bemarked as expired and cannot be filed.

Cancel:Cancel without processing forms.

What happens when using the Automatic Update process?

Aatrix displays theAatrix Update Client—Update Listwindow with a list of the items that are new or out-of-date and will
be updated. When you click Next, the updating process begins and runs to completion. Click Closewhen your program
versions and forms have been updated.

IMPORTANT: UsingAutomatic Update requires Internet access.

What happens when using the Download Update process?

Aatrix displays theDownload Updatewindow with instructions for manually downloading an update. Follow the
instructions in the windows provided by Aatrix.

How does my tax information in Sage 100 Contractor get into Aatrix forms?

When you select a report such as 2012 940 Report or the 2012 W-2/W-3 and then click Run Report, Sage 100 Contractor
queries your company data and inserts a selection of values and information into the report form. The report form opens in
Aatrix software. Then you provide any required or missing information that the query was unable to provide.

What is the Company Setup Wizard?

If you have not yet set up your company information, Aatrix prompts you to do so using theCompany Setup Wizard. This
wizard guides you through the process of verifying your company data for your federal and state report forms. In additional
to basic name and address company information, theCompany Setup Wizard prompts for information about State &
Local Tax Items.

How do I fill out the report?

After opening 5-4-1 Federal Tax Forms by Aatrix® or 5-4-2 State Tax Forms by Aatrix® and selecting report criteria,
click Run Report. Sage 100 Contractor queries your data and opens the Aatrix form with as much data filled in as possible.
Then you tab through the report and fill in any required and/or missing information. A red box indicates required information.
In some cases, you click an ellipsis button to open an additional window to select data to be linked to specific boxes in the
form.

In addition, when the Sage 100 Contractor query discovers duplication in some special state tax payroll calculations, the
program displays thePayroll Calculation Assignmentswindow. Use this window to assign Sage 100 Contractor payroll
calculations to special state tax descriptions.
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IMPORTANT: CompletingW-2/W-3 forms requires a slightly different process and will take longer than completing
other forms. Give yourself plenty of time when preparingW-2/W-3 forms. Aatrix requires that W-2/W-3 forms be
delivered two days before the deadline when filing electronically.

What happens when I click View History?

If you have saved any reports whether complete or not, clickingView History opens theOpen Reportwindow.

TIP: The system displays theOpen Reportwindow only If you have updated the forms, completed theCompany
Information Wizard, and run a report and saved it.

TheOpen Reportwindow displays any reports that have been saved. You can select individual reports by clicking the
check box. The window provides buttons for performing other tasks. For more information, refer to the Aatrix Help provided
with the window.

How do I add new state and local tax items after I have set up my company in Aatrix?

When you are setting up you company in Aatrix, the wizard references state and local tax items that have been set up
previously in Sage 100 Contractor. To add state or local tax items, set them up in Sage 100 Contractor first, then from an
Aatrix report window, click Tools > Company Setup. Click Next to get to theState & Local Tax Items page, and click
Add. This page also provides tools for editing and removing items.

Refer to these topics for setting up tax items in Sage 100 Contractor:

l Setting up tax districts

l Setting up tax entities

l About local payroll taxes

l Entering local payroll tax districts

Registering Aatrix through Sage 100 Contractor
As a benefit for our customers, registering Aatrix through Sage 100 Contractor allows you to use Aatrix forms until
September 30, 2014. We recommend that you register immediately to take advantage of this valuable service.

To register to use Aatrix through Sage 100 Contractor:
1 Open either 5-4-1 Federal Tax Forms by Aatrix® and 5-4-2 State Tax Forms by Aatrix®.

2 On theAatrix® Software Registrationwindow, read the information in the yellow box.

3 In theSage Customer ID# box, type the number you use when you contact Sage Customer Support.

4 In theRegistered Company Name box, type the name you used when you purchased youmaintenance and support
plan. This is your official company name in the Sage system.

5 In the Federal Employer ID# box, type your employer identification number, also know as EIN.

6 Click Register.

7 Sage 100 Contractor displays amessage with your Aatrix software expiration date.

8 Click OK.
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5-4-1 Federal Forms
Running reports with 5-4-1 Federal Tax Forms and eFiling by Aatrix®

The 5-4-1 Federal Tax Forms and eFiling by Aatrixwindow is an integration portal into Aatrix software. When youmove
beyond this window, for example, by clickingView History orRun Report, you actually begin working in Aatrix software
that has been integrated into Sage 100 Contractor.

On themenu bar, you have access to the followingOptions:

l Update Forms—Displays amessage window that prompts you to update Aatrix forms if updates are available.

l View History—Displays theOpen Reportwindow, which allows you to open, view, or access existing reports.

l Register Aatrix Software—Displays the Aatrix Software Registration window. Registering allows you to fill out and
print current reports for the duration of your service andmaintenance contract.

NOTE: When you are working in Aatrix software, you have access to Aatrix Help. Sage 100 Contractor Help does
not duplicate Aatrix Help.

To run a report:

1 Open 5-4-1 Federal Tax Forms and eFiling by Aatrix.

2 If you are prompted to register, we strongly recommend that your register Aatrix software through Sage 100 Contractor.

3 From the list in the left pane, select a report.

4 In theYear box, select a year.
If there are other selections, such as aPeriod and aYear, a First Check Date and a Last Check Date, select them as
required. Theremay be no selection options.

5 Click Run Report.

6 Follow the instructions on the window, or refer to Aatrix Help.

Viewing report history with 5-4-1 Federal Tax Forms and eFiling by Aatrix®

The 5-4-1 Federal Tax Forms and eFiling by Aatrixwindow is an integration portal into Aatrix software. When youmove
beyond this window, for example, by clickingView History orRun Report, you actually begin working in Aatrix software
that has been integrated into Sage 100 Contractor.

NOTE: When you are working in Aatrix software, you have access to Aatrix Help. Sage 100 Contractor Help does
not duplicate Aatrix Help.

To run view report history:

1 Open 5-4-1 Federal Tax Forms and eFiling by Aatrix.

2 If you are prompted to register, we strongly recommend that your register Aatrix software through Sage 100 Contractor.

3 From the list in the left pane, select a report.

4 In theYear box, select a year.

If there are other selections, such as aPeriod and aYear, a First Check Date and a Last Check Date, select them.

5 >Click View History.

Sage 100 Contractor queries the data. When theOpen Reportwindow opens, you are working in the Tax Forms and e-
Filing by Aatrix® window, which is Aatrix software that has been integrated with Sage 100 Contractor.
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6 Follow the instructions on the window, or refer to Aatrix Help.

5-4-2 State Forms
Running reports with 5-4-2 State Tax Forms and eFiling by Aatrix®

The 5-4-2 State Tax Forms and eFiling by Aatrixwindow is an integration portal into Aatrix software. When youmove
beyond this window, for example, by clickingView History orRun Report, you actually begin working in Aatrix software
that has been integrated into Sage 100 Contractor.

On themenu bar, you have access to the followingOptions:

l Update Forms—Displays amessage window that prompts you to update Aatrix forms if updates are available.

l View History—Displays theOpen Reportwindow which provides information about saved reports. .

l Payroll Calculation Assignments—Displays thePayroll Calculation Assignmentswindow. If you have
multiple payroll calculations for state unemployment insurance or state disability insurance, then query process
cannot determine to which field on the report they belong. You use thePayroll Calculation Assignments grid
select and link the Aatrix tax description to a the appropriate Sage 100 Contractor payroll calculation.

l Register Aatrix Software—Displays the Aatrix Software Registration window. Registering allows you to fill out and
print current reports for the duration of your service andmaintenance contract.

NOTE: When you are working in Aatrix software, you have access to Aatrix Help. Sage 100 Contractor Help does
not duplicate Aatrix Help.

To run a report:

1 Open the 5-4-2 State Tax Forms and eFiling by Aatrixwindow.

2 If you are prompted to register, we strongly recommend that your register Aatrix software through Sage 100 Contractor.

3 From the drop-downState list box, select a state.

4 In theYear box, select a year.
If there are other selections, such as a First Hire Date and Last Hire Date, aPeriod and aYear, a First Check Date
and a Last Check Date, select them as required.

5 Click Run Report.
Sage 100 Contractor queries the data. When theOpen Reportwindow opens, you are working in the Tax Forms and e-
Filing by Aatrix® window, which is Aatrix software that has been integrated with Sage 100 Contractor.

6 Follow the instructions on the window, or refer to Aatrix Help.

Assigning payroll calculations to tax descriptions

When Sage 100 Contractor queries your company data for filling in the values in an Aatrix report, it looks for a one-to-one
relationship between tax descriptions and Sage 100 Contractor payroll calculations. If you havemultiple payroll
calculations for state unemployment insurance or state disability insurance, then query process cannot determine to which
tax description it belongs. You use thePayroll Calculation Assignments grid to assign a description to a the appropriate
Sage 100 Contractor payroll calculation.

The program provides access to thePayroll Calculation Assignmentswindow in two ways:

l Click Options > Payroll Calculation Assignments. The program displays thePayroll Calculation Assignments
window with all states for which you have payroll calculations, and the tax descriptions with no payroll calculations
assigned. Make your assignments, then click Close.
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l With a state selected, click Run Report. The program displays thePayroll Calculation Assignments window
with the state for which you have tax descriptions with no payroll calculations assigned. Make your assignments,
then click Continue to continue running the report.

The window’s three columns display the following:

l State—The state you selected on the 5-4-2-State Forms and eFiling by Aatrixwindow.

l Tax Description—The state tax description used in the Aatrix form that needs an assigned payroll calculation.

l Payroll Calculation—When you click the drop-down arrow, the program displays a list with choices of
<<unassigned>> and the names of at least twomore payroll calculations. Youmust assign one of them to the tax
description.

For example, let’s suppose that you are filling out theDE- 6 Report for California. When you run the report, and the query
discovers that two state unemployment calculations. The query cannot determine to which tax description it should be
assigned. At that point, the program displays thePayroll Calculation Assignmentswindow. You need tomake the
assignment. In the grid, you click the drop-down arrow under thePayroll Calculations column to see this view:

State Tax Description State

CA Employment
Training Tax

<<unassigned>>
1047—CA State Unemployment
2003—CA—Employment Training

The next step here would be to select 2003—CA—Employment Training, and then click theContinue button, so that the
program can complete the query and fill in the report form with your company data.

NOTE: If you need to change the assignment, click Options > Payroll Calculation Assignments. Locate for the
payroll calculation you need to change, click <<unassigned>> to clear the selection, and then click Save to close the
window. Then click Options > Payroll Calculation Assignments again. Locate for the payroll calculation you need
to change, assign it to the description, and then click Save to close the window.

To assign payroll calculations to tax descriptions:

1 On thePayroll Calculation Assignments window under thePayroll Calculation column, click the drop-down arrow.

2 From the list of Sage 100 Contractor payroll calculations, select one.

3 Click Continue to run the report, or click Sage to save your assignments.

Viewing report history with 5-4-2 Federal Tax Forms and eFiling by Aatrix®

The 5-4-2 State Tax Forms and eFiling by Aatrixwindow is an integration portal into Aatrix software. When youmove
beyond this window, for example, by clickingView History orRun Report, you actually begin working in Aatrix software
that has been integrated into Sage 100 Contractor.

NOTE: When you are working in Aatrix software, you have access to Aatrix Help. Sage 100 Contractor Help does
not duplicate Aatrix Help.

To view report history:
1 Open 5-4-2 Federal Tax Forms and eFiling by Aatrix.
You do not need to select a state to view report history.

2 If you are prompted to register, we strongly recommend that your register Aatrix software through Sage 100 Contractor.
How?

3 Click View History.
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Sage 100 Contractor queries the data. When theOpen Reportwindow opens, you are working in the Tax Forms and e-
Filing by Aatrix® window, which is Aatrix software that has been integrated with Sage 100 Contractor.

4 Follow the instructions on the window, or refer to Aatrix Help.

5-5 Daily Payroll

5-5-1 Daily Payroll Entry
About 5-5-1 Daily Payroll Entry

You enter payroll data on the 5-5-1 Daily Payroll Entrywindow daily for all the employees as well as for allocating
equipment use. From the daily entries, you can generate daily reports to review the daily costs of labor and equipment use.

You can attribute an employee’s time to jobs, operation of equipment on jobs, or the repair andmaintenance of equipment.
Suppose Dan spends the afternoon repairing the engine of a backhoe. Tomake the repairs, Dan uses a forklift to lift the
engine out of the backhoe. On a single line, you can enter Dan’s time spent repairing equipment, what piece of equipment
was repaired the backhoe—and, what equipment was operated—the forklift.

You can also enter time for equipment at the job site that does not require an operator. For example, a generator does not
require an operator, but you charge for the time it is in use and idle. On a single line, you can enter both the operated and idle
time.

Youmight find this additional functionality beneficial too. The related scope of work recorded in 6-11-6 Daily Field Report
line notes from both employees and equipment grids can be imported into 5-5-1 Daily Payroll Entry using theOptions >
Import Daily Field Report. This provides a way for that information to become part of your payroll and job costing records.

The 5-5-1 Daily Payroll Entrywindow only allows you to enter times for employees who worked jobs or repaired
equipment and times for equipment that was used. The 5-5-2 Payroll Recordswindow allows you to enter records for
salary, bonuses, adjustments to deduction and benefit balances, startup data, advances, or third-party sick pay.

At the end of a payroll period, you can convert the daily payroll records into timecards. Each timecard contains the hours
worked by an individual employee. After conversion, you can only review timecards in thePayroll Recordswindow.

About entering daily payroll records

The 5-5-1 Daily Payroll Entrywindow combines the 8-4 Equipment Allocation and 5-2-2 Payroll Recordswindows
into one location where you can enter the employee and equipment times for a single day. On a single line, you can enter
the time for:

l An employee whoworked on a job.

l An employee who operated equipment on a job.

l An employee who repaired equipment.

l An employee who repaired equipment using other equipment.

l Equipment that was operated, sat idle, or sat on standby at a job site.

Some equipment, such as an air compressor or generator, does not require an employee to operate it. If a line only contains
the time equipment was operated, sat idle, or sat on standby, Sage 100 Contractor creates the equipment costs.

At the end of a pay period, convert the daily payroll records into timecards. At the time of conversion, Sage 100 Contractor
creates the equipment costs. After conversion, you can view the timecards in the 5-2-2 Payroll Recordswindow.
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Entering time for employees

You can capturemany types of information when entering the time for an employee. However, you do not need to put a
value in every cell. Enter only the information that is appropriate for your business needs.

It is important to note that entering information in certain cells is conditional and based on the value in another cell. For
example, if you enter a value of 1-Regular in thePay Type list, thePiece Rate andPiece cells are unavailable. Likewise, if
you enter 7-Piece Pay in thePay Type list, then thePay Rate andHours cells are unavailable. This situation also applies
to paygroups.

When entering the time for employees and equipment, create a separate row in the grid when there is a change to the job or
equipment cost data (job, phase, equipment repaired/operated, cost code, pay type, pay rate, etc.)

For example, suppose an employee operates a backhoe in themorning and a dump truck in the afternoon, both at the same
job site. You would create two rows in the grid. The first row indicates the time the employee operated the backhoe. The
second row indicates the time the employee operated the dump truck.

To enter time for an employee:

1 Open 5-5-1 Daily Payroll Entry.

2 The date box automatically defaults to today’s date.

3 In theEmployee cell, right-click and chooseDisplay Lookup Window orDisplay Detail/Add Record.

4 Then select an employee or add a new employee, as needed.

5 Enter information in the other cells in the row as needed. You can use the right-click function in some of the cells. In other
cells, you can just click to enter a value.

a In theDescription cell, enter the worker’s job description.

b In theService Order# cell, enter the service order number.

c In the Job cell, enter the job.

d In theEquip Repaired cell, enter the piece of equipment that was repaired.

e In the Locality cell, enter the local payroll tax district number.

f If the job has a certified payroll, in theCertified cell, type Yes.

g If the job has phases, in thePhase cell, enter the phase number.

h In theCost Code cell, enter the cost code number.

i In thePay Type cell, enter the pay type.

j If you are using paygroups, in thePaygroup cell, enter the paygroup number.

k In thePay Rate cell, enter the employee’s pay rate.

l In theHours cell, enter the number of hours the employee worked.

m If you are paying a piece rate, in thePiece Rate cell, enter the rate.

n If you are paying a piece rate, in thePiece cell, enter the number of pieces.

o In theComp Code cell, enter theWorkers’ Compensation code number.

p If you are using departments, in theDepartment cell, enter the department number.

6 Use the next nine rows to enter information about equipment:

a In theOperated Equipment cell, to cost a piece of equipment, enter the equipment number.
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b In theOperated cell, enter the number of operated hours you want to cost.

c In theStandby cell, enter the number of standby hours you want to cost.

d In the Idle cell, enter the number of idle hours you want to cost.

e In theRental Unit cell, enter the number of the rented piece of equipment.

f In theOperated Rental cell, to cost a piece of equipment, enter the equipment number.

g In theStandby Rental cell, enter the number of rental standby hours you want to cost.

h In the Idle Rental cell, enter the number of rental standby hours you want to cost.

i Use the next three rows for entering additional information.

7 You can rename theUser Defined column, and enter user-defined information.

TIP: To change the name of a user-defined column, click a cell of the column, and then press F7 to open the Field
Propertieswindow. In theUser Description andUser Prompt text boxes, type the new name and entry prompt.

8 In theNotes cell, enter a note about this row.

9 In theAbsence cell, enter the reason for an absence.

10 Repeat steps for each employee and/or piece of equipment.

11 On the Filemenu, click Save.

IMPORTANT: When all daily payroll records have been entered for the pay period, convert the daily records into
timecards.

TIP: You can compare the budgeted costs to the actual costs.

TIP: You can compute an employee’s hourly rate per piece by using piece pay.

Entering time for equipment

When entering the equipment time, create a separate line when there is a change to the job or equipment cost data (job,
phase, equipment repaired/operated, cost code, pay type, pay rate, etc.).

To enter time for equipment:

1 Open 5-5-1 Daily Payroll.

2 In theDate text box, enter the date.

3 If the equipment was used on a job, enter the job number in the Job cell.

4 If the job uses phases, enter the phase number in thePhase cell.

5 If you entered a job number, enter the cost code number in theCost Code cell.

6 In theOperated Equipment cell, enter the equipment number.

7 In theCost Unit cell, accept the default value, or enter a different value.

8 In theOperated Hours cell, enter the number of hours you ran the piece of equipment that day.

9 In theStandby Hours cell, enter the number of hours the piece of equipment was on standby.

10 In the Idle Hours cell, enter the number of hours the piece of equipment was idle.

11 If you are using time andmaterials billing, in theRental Unit cell, enter the rental unit number.

12 In theOperated Rental cell, enter the number of units that the piece of equipment was operated.
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13 In theStandby Rental cell, enter the number of units that the piece of equipment was on standby.

14 In the Idle Rental cell, enter the number of units the piece of equipment was idle.

15 Repeat steps 3–14 for each piece of equipment.

16 On the Filemenu, click Save.

TIP: You can compare the budgeted costs to the actual costs.

Importing daily field reports

You can create a timecard from the daily field reports. The daily field reports only contain cost codes, paygroups, pay types,
and the hours worked or pieces completed. Review the timecard and enter any additional information.

To import daily field reports:

1 Open 5-2-2 Payroll Records.

2 In theEmployee text box, enter the employee number.

3 In thePeriod Start text box, enter the date when the payroll period begins.

4 In thePeriod End text box, enter the date when the payroll period ends.

5 On theOptionsmenu, point to Import Data, and click Daily Field Reports.

Creating timecards for daily payroll

To begin processing payroll, convert the daily payroll records into timecards. You can then review the timecards in the 5-2-2
Payroll Records window.

To create timecards:

1 Open 5-5-1 Daily Payroll Entry.

2 On theOptionsmenu, click Timecards.

3 In theBeginning Date box, enter the date of the first daily record you want to convert.

4 In theEnding Date box, enter the date of the last daily record you want to convert.

5 In thePayroll Quarter box, enter the payroll quarter.

6 Click OK.

NOTES:
l When you create timecards, Sage 100 Contractor posts the costs for equipment time to theGeneral Ledger

and creates the job or equipment cost records.

l When you final-compute payroll, Sage 100 Contractor posts the costs for labor to theGeneral Ledger and
creates the job cost records.

Viewing daily payroll totals

After entering the daily payroll, you can view the payroll totals for the day or since the last time timecards were created. You
can sort the report by employee, job, equipment repaired, or equipment used.

To view daily payroll totals:

1 Open 5-5-1 Daily Payroll Entry.

2 On theOptionsmenu, point to Totals By, point toDay or Period, and click the report you want to view.
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5-5-2 Daily Job Reports
About 5-5-2 Daily Job Reports

Clicking 5-5-2 Daily Job Reports launches the 5-5-2 Report Printingwindow to be used to for printing Daily Job Reports
and viewing sample reports.

5-5-3 Daily Labor Reports
About 5-5-3 Daily LaborReports

Clicking 5-5-3 Daily Labor Reports launches the 5-5-3 Report Printingwindow to be used to for printing daily labor
reports and viewing sample reports.

5-5-4 Daily Equipment Reports
About 5-5-4 Daily Equipment Reports

Clicking 5-5-4 Daily Equipment Reports launches the 5-5-4 Report Printingwindow to be used to for printing daily
equipment reports and viewing sample reports.
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Chapter 6: Project Management
6-1 Job Reports
See Appendix B for a complete list of 6-1 Job Reports.

6-2 Budgets

About budgets
A budget represents a summary of the hard costs detailed in a takeoff, and provides the basis for all budgeted versus actual
cost, hour, or unit comparisons. In addition, you can use the budget as the basis for the proposal you provide to the client.

The costs for a budget are categorized by cost code, and each cost code is further divided into cost types. Furthermore,
you can include the hours necessary to complete the work for each cost code. For work performed on a unit basis (include
the quantity of units to be performed for each cost code), Sage 100 Contractor automatically computes the cost per unit.

There are several ways to create a budget: you can export the data from a takeoff, import a file, or create a budget
manually. After the budget is completed, you can set the original budget. If at any point the budget is changed, you can
compare it to the original.

If it becomes necessary to adjust the costs in a budget, you enter the changes by issuing change orders. Change orders
allow you to alter the budgeted costs independent from the budget itself.

Sage 100 Contractor also provides a way for you to be warned when you are over budget. The program determines the
costs to date for the jobs by cost code and cost type. It then compares the data to the original budget plus change orders.
When you save the record, Sage 100 Contractor notifies you if costs exceed the budgeted amount for a job. You can enable
the Over Budget Warning option using the 1-3 Journal Transactions or 4-2 payable Invoices/Creditswindows.

Creating budgets
Typically, you create a job before creating a budget. You can create new jobs in 3-5 Jobs (Accounts Receivable).

IMPORTANT: In order to match historical job costs with a budget, youmust enter them both by the samemethod.

Consider the following points before creating a budget:

l If you do not break costs apart into cost types, enter the total cost of each cost code in theOther column.

l If you perform unit-based work or issue unit-based change orders, Sage 100 Contractor automatically calculates the
unit costs (based on the units entered in theCost Code). Enter the quantity of units in theQuantity box.

l If you anticipate changes and want to preserve the current budget, set the original budget.

IMPORTANT: Only four of the buttons in the data control activate areas in 6-2 Budgets: First, Previous, Next, and
Last. TheDisplay Lookup drop-down arrow displays theAccounts Receivable Lookupwindow, and the detail
button displays the 3-5 Jobs (Accounts Receivable)window.
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To create a budget:
1 Open 6-2 Budgets.

2 Using the data control, select a specific job.

3 In thePhase list, click the phase for which you want to create a budget.

4 To populate the budget grid with cost code values, do one of the following:

a To import cost codes from a Lookupwindow, right-click the cell and click Display Lookup Window, or click the
drop-down arrow. Then double-click each item to import it into the budget.

b To import cost codes from aPicklistwindow, right-click the cell and click Display Pick List Window. Then double-
click the items that you want to import into the budget. Next, click the Insert Selected Items button to import all the
selected items into the budget.

c To import a *.budget_grid file, click Options, point to Import, then click Grid File. Browse to the appropriate file, then
double-click it.

5 In the grid, do the following:

a In theHours cell, enter the estimated hours if the cost code has associated labor costs.

b In theMaterial cell, enter thematerial costs.

c In the Labor cell, enter the labor costs.

d In theEquipment cell, enter the equipment costs.

e In theSubcontract cell, enter the subcontract costs.

f In theOther cell, enter themiscellaneous costs.

6 Repeat step 5 for each cost code.

7 On the Filemenu, click Save.

NOTE: If you exported the budget from Takeoffs, Sage 100 Contractor inserts the data from the takeoff.

Setting the original budget
When you set the original budget, Sage 100 Contractor copies the budget information to theOriginal columns. With the
original budget preserved, you can compare it to the current budget. The original budget information is for reference only.

To set the original budget:
1 Create the budget.

2 On theOptionsmenu, click Set Budget.

Enabling the Over Budget Warning
TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select the
Over Budget Warning command, Sage 100 Contractor determines the costs to date for the jobs by cost code and cost
type. It then compares the data to the original budget plus change orders. When you save the record, Sage 100 Contractor
notifies you if costs exceed the budgeted amount for a job.
To set the Over Budget Warning:
1 Open 1-3 Journal Transactions or 4-2 Payable Invoices/Credits.

2 Display the last record, and from themenu select Costs > Job Costs.
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3 On the Job Costswindow from themenu select Options > Set Over Budget Warning.

4 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a No message—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

5 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

6 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the budget plus approved changes by job, phase, cost code, and cost type
allowed in the Tolerance Percent text box, and the amount of tolerance in the Tolerance Amount Not To Exceed
text box.

7 Click OK.

Entering the settings for Cost Over Budget Warning
TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select theSet
Over Budget Warning option, Sage 100 Contractor determines the Actual + Committed costs to date for the job and
phase by cost code and cost type.

It then compares the data to the original budget plus approved change orders. When you save the record, Sage 100
Contractor notifies you if costs exceed the budget plus approved change orders for a job and phase, cost code and cost
type, plus the tolerance.
Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

A warning dialog box displays "Warning: The actual plus committed costs exceeds the budget and approved changes plus
the tolerance amount." You can now save the record by clicking [Yes] or cancel out by clicking [No]. An alert is also sent to
the Dashboard Alert Viewer if you have selected Job costs exceed budget for cost code in the 7-9 Alerts Manager
ProgramWarning Subscriptions tab.

NOTE: To enable the program alert for Job costs exceed budget for cost code youmust have a setting of Warning
for theMessage Type in the job cost screen.

To set the Over Budget Warning:
1 Open 1-3 Journal Transactions or 4-2 Payable Invoices/Credits.
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2 Display the last record, and from themenu select Costs > Job Costs.

3 On the Job Costswindow from themenu select Options > Set Over Budget Warning.

4 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a No message—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

5 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

6 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the budget plus approved changes by job, phase, cost code, and cost type
allowed in the Tolerance Percent text box, and the amount of tolerance in the Tolerance Amount Not To Exceed
text box.

7 Click OK.

Entering the settings for Purchase Order Over Budget Warnings
TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select theSet
PO Over Budget Warnings option, Sage 100 Contractor determines the Actual + Committed costs to date for the job and
phase by cost code and cost type.

It then compares the data to the original budget plus approved change orders. When you save the record, Sage 100
Contractor notifies you if costs exceed the budget plus approved change orders for a job and phase, cost code and cost
type, plus the tolerance.

NOTES:
l When PurchaseOrders are exported from 9-5 Takeoffs, the warning that the purchase order exceeds the

budget amount plus approved change orders for the job/phase/cost code/ cost type combination is not
displayed. After exporting purchase orders, you should run the 6-1-12-21 Committed Costs report for the
correct job to verify that purchase orders have not exceeded the budget.

l To enable the program alert for Job costs exceed budget for cost code youmust have a setting of Warning
for theMessage Type in the job cost screen.

l If you decreased a grid line but the purchase order is still over budget, the PurchaseOrder Over Budget warning
will not display a second time when the record saves. To get the warning a second time, increase one of the
amounts or quantities in the grid.

Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount
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Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

A warning dialog box displays "Warning: The actual plus committed costs exceeds the budget and approved changes plus
the tolerance amount." You can now save the record by clicking [Yes] or cancel out by clicking [No]. An alert is also sent to
the Dashboard Alert Viewer if you have selected Job costs exceed budget for cost code in the 7-9 Alerts Manager
ProgramWarning Subscriptions tab.

To set the Over Budget Warning:
1 In 6-6-1 Purchase Orders, select Options > Set Over Budget Warning.

2 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a Nomessage—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

3 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

4 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the budget plus approved changes by job, phase, cost code, and cost type
allowed in the Tolerance Percent text box, and the amount of tolerance in the Tolerance Amount Not To Exceed
text box.

5 Click OK.

Entering the settings for Subcontract Over Budget Warnings
TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select theSet
Subcontract Over Budget Warnings option, Sage 100 Contractor determines the Actual + Committed costs to date for
the job and phase by cost code and cost type.

It then compares the data to the original budget plus approved change orders. When you save the record, Sage 100
Contractor notifies you if costs exceed the budget plus approved change orders for a job and phase, cost code and cost
type, plus the tolerance.
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NOTES:
l When Subcontracts are exported from 9-5 Takeoffs, the warning that the subcontract exceeds the budget

amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. We
recommend that after exporting subcontracts you should run the 6-1-12-21 Committed Costs report for the
correct job to verify that subcontracts have not exceeded the budget.

l If you decreased a grid line but the subcontract is still over budget, the Subcontract Over Budget warning will
not display a second time when the record saves. To get the warning a second time, increase one of the
amounts or quantities in the grid.

Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

To set the Over Budget Warning
1 In 6-7-1 Subcontracts, select Options > Set Over Subcontract Warning.

2 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a Nomessage—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

3 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

4 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the budget plus approved changes by job, phase, cost code, and cost type
allowed in the Tolerance Percent text box, and the amount of tolerance in the Tolerance Amount Not To Exceed
text box.

5 Click OK.

About displaying budget recaps
You can display a cost code or phase summary of the budget for review before printing the final budget.

The cost code recap summarizes the cost types for each cost code across the job phases. Additionally, Sage 100
Contractor provides a summary of the budgeted hours to complete each cost code.
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The phase recap summarizes the cost types in each phase and provides a summary of the budgeted hours to complete
each phase of the project.

Displaying and printing budget cost code or phases recaps
1 Open 6-2 Budgets.

2 Using the data control, locate a job.

3 From theOptionsmenu, select Recap and one of the following:

a Cost Codes

b Phases

4 On theBudget Recapwindow, click thePrint records button.

5 On theGrid Printingwindow, click Print Preview and Drilldown (when available) orPrint Records.

Deleting budgets
To delete a budget:
1 Open 6-2 Budgets.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Budget.

Exporting and Importing Budgets
About exporting files from 6-2 Budgets, 6-9 Proposals, and 6-10 Unitary Proposals

Depending on the type of work that you perform, youmight need a few files or a large library. Careful thought should go into
the creation of each file that you build. Themark of a good file is one that requires little modification. Themore you have to
change a file to suit a specific situation, the less time it saves you. Remember that a file can include as much or as little
information as you want.

You can either use an existing record as the basis for a file or build a file completely from scratch. When using an existing
record, most of the work is already completed. Simply recall the record, modify it to meet your needs, then export it as a file.

In the 6-2 Budgets, 6-9 Proposals, and 6-10 Unitary Proposalswindows, you can create various kinds of files: a
budget/proposal/unitary proposal file or a grid file. The former contains the information spanning all phases of a project,
whereas the latter contains the information from a single grid.

Window Exportable file types

6-2 Budgets Budget, Grid

6-9 Proposals Proposal, Grid

6-10 Unitary Proposals Unitary Proposal, Grid

Exporting budget files

To export a budget file:

1 Open 6-2 Budgets.

2 On theOptionsmenu, point toExport, then click Budget File.

3 Name the file, then click Save.
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NOTE: Files are specific to the company in which you save them.

Exporting budget grid files

You can create a file from a phase of an existing budget.

Consider the following points before exporting a budget grid file:

l Sage 100 Contractor only creates a file for the currently displayed grid.

l Files are specific to the company in which you save them.

To export a budget grid file:

1 Open 6-2 Budgets.

2 In the data control box, enter the job number for the budget that you want to use.

3 In thePhase drop-down list, select the phase.

4 Edit the content of the phase as needed.

5 On theOptionsmenu, point toExport, then click Grid File.

6 Name the file, then click Save.

TIP: Instead of using a budget from an existing job, you can create a new budget.

Importing budget files

IMPORTANT: When you import a file, the file writes over any data already contained in the window.

IMPORTANT: Before you import a file, youmust first create and export a budget file to be imported to your project.

To import a budget file:

1 Open 6-2 Budgets.

2 Using the data control, enter the job number of the job for which you want to create a budget.

3 On theOptionsmenu, point to Import, and click Budget File.

4 Select the file that you want to import, then click OK.

6-3 Job Costs

About job costs
Job costs provide detailed information about costs, giving you themeans to track the costs of a project using cost codes
and cost types. This functionality provides you with another way to analyze costs and refine the estimating or budgeting
process.

When you post a transaction to theDirect Expense orWIP range of accounts, Sage 100 Contractor prompts you to create
a job cost record in the Job Cost Distributionwindow. Job cost records aremaintained in a separate database from the
accounting data, and therefore do not impact the general ledger.

IMPORTANT:
If you have turned onWIP Verification for job costs, and are posting job costs to a job that is marked forWIP

If you have turned onWIP Verification for job costs, and are posting job costs to aWIP (Asset) ledger account for a

,

If a text box is shaded, you cannot directly edit the data; you can only change it through an accounting entry.
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Methods for entering historical job cost records
You can enter historical cost records for each job. There aremany ways to enter the cost records. Select amethod
appropriate for each job. While somemethods require additional time and effort, those samemethods producemore
detailed reports than the faster methods of entry.

Method 1

Method 2

Method 3

Method 4

Method 5

Method 6

Method 7

For example, youmight only need the total amount of job costs for a project that is nearly complete, whereas youmight
need the individual job costs for a job that is just beginning.

IMPORTANT: Sage 100 Contractor does not automatically create job costs for payroll records assigned payroll
record type 3-Hand Computed or 4-Startup. If you are using thePayrollmodule and have entered the year-to-date
payroll history, determine the job costs associated with payroll and figure those costs into the appropriate historical
cost entries.

Method 1

For each job, enter one cost record. Determine the amount from the total costs to date for the job at the time the general
ledger was set up. It is recommended that you assign the record cost type 5-Other. Post each record to the period just prior
to the current period.

Because you are entering a single amount that may cover many cost codes, create a special cost code for this purpose.
Youmight name the cost code something likeUnassigned or Lump Sum orStart Up.

This method provides you withBonding, Over/Under Billing, and Job Cost Totals reports. Reports based on cost
codes, cost types, or accounting periods do not contain any detailed data.

IMPORTANT: If your budget is set up to reflect the original budget costs, theCost to Budget report will show
discrepancies.

Method 2

For each job, enter one cost record for each cost code. Determine the amount from the total costs to date for each cost
code for each job at the time the general ledger was set up. It is recommended that you assign the record cost type 5-Other.
Post each record to the period just prior to the current period.

This method provides reports with an accurate breakdown of costs for each cost code except in Journal reports orCurrent
Cost Summary reports. Reports based on cost types or accounting periods do not contain any detailed data.

IMPORTANT: If your budget is set up to reflect the original budget costs, theCost to Budget report will show
discrepancies.

Method 3

For each job, enter one cost record for each cost code in the prior fiscal year and another cost record for the current fiscal
year. First, determine the accumulated costs for each cost code in the prior fiscal year. Then enter a separate cost record
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for each cost code. Post each record to period 0. It is recommended that you assign the record cost type 5-Other.

Next, determine the accumulated costs for each cost code in the current fiscal year. Then enter a separate cost record for
each cost code. Post each record to the period just prior to the current period.

This method provides reports with an accurate breakdown of costs for each cost code during the previous and current fiscal
years, but does not provide accurate Journal reports. Reports based on cost types or accounting periods do not contain
any detailed data.

IMPORTANT: If your budget is set up to reflect the original budget costs, theCost to Budget report will show
discrepancies.

Method 4

For each job, enter one cost record for each combination of cost code and cost type. Determine the amount from the total
costs to date for the job at the time the general ledger was set up. Post each record to the period just prior to the current
period.

This method provides reports with an accurate breakdown of costs for each cost code and cost type, but does not provide
accurate Journal orCurrent Cost Summary reports. Reports-based accounting periods do not contain any detailed data.

Method 5

For each job, enter one cost record for each combination of cost code and cost type in the prior fiscal year, and another cost
record for each combination of cost code and cost type in the current fiscal year.

First, determine the accumulated costs for each combination of cost code and cost type in the prior fiscal year. Then enter a
separate cost record for each combination of cost code and cost type. Post each record to period 0.

Next, determine the accumulated costs for each combination of cost code and cost type in the current fiscal year. For each
combination of cost code and cost type, enter a separate cost record. Post each record to the period just prior to the current
period.

This method provides reports with an accurate breakdown of costs for each cost code and cost type during the previous
and current fiscal years, but does not provide accurate Journal orCurrent Cost Summary reports. Reports based on
accounting periods do not contain any detailed data.

Method 6

For each job, enter one cost record for each combination of cost code and cost type in the prior fiscal year, and enter
another cost record for each combination of cost code and cost type in the current fiscal year.

First, determine the accumulated costs for each combination of cost code and cost type in the prior fiscal year. Then enter a
separate cost record for each combination of cost code and cost type. Post each to period 0.

Next, determine the accumulated costs for each combination of cost code and cost type in each period during the current
fiscal year. For each combination of cost code and cost type, enter a separate cost record. Post each record to the
appropriate accounting period.

Suppose you are starting up in period 7. Determine the accumulated costs for each combination of cost code and cost type
in each period. Then enter a cost record for each combination of cost code and cost type in periods 1 through 6.

This method provides reports with an accurate breakdown of costs for each cost code and cost type during the previous
and current fiscal years. Reports on job cost journals do not provide detailed data.



- 351 -

Method 7

For each job, enter each cost record. First, enter the cost records in the prior fiscal year, posting each to period 0. Then in
the current fiscal year, enter each cost record, posting each record to the appropriate period.

This method provides reports with an accurate breakdown of costs for each cost code and cost type during the previous
and current fiscal years. Because individual costs for a job have been entered, reports on job cost journals provide fully
detailed reports.

Entering historical job cost records

IMPORTANT:
In order to match historical job costs with a budget, youmust enter them both by the samemethod.

6-1-12 Reports do not work with historical job costs.

Be sure to select the correct posting period.

To enter a historical job cost record:
1 Open 6-3 Job Costs.

2 In theData Control box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase box.

4 In the Trans# box, type Start Up.

5 In theDate box, enter the date. Be sure to enter the same date used in the Ledger Account balance setup.

6 In theDescription box, type Start Up.

7 In theCost Code box, enter the cost code.

8 In theCost Type list, click the cost type.

9 In theCost box, enter the amount.

10 In theBilling Status list, click 1-Open.

11 On the Filemenu, click Save.

TIP: You can void historical job cost records.

Entering job costs
When you post payable transactions to theExpense range of accounts, Sage 100 Contractor displays the Job Cost
Distributionwindow.

To enter job costs:
1 In the Job box, enter the job number.

2 In thePhase box, enter the phase number.

3 In theDate box, enter the transaction date.

4 In theDescription box, enter a brief statement about the job cost.

5 In the Transaction# box, enter the transaction number.

6 In theCost Code box, enter the cost code number using the lookup window, then press Enter.

7 In theCost Type box, select the cost type.
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8 Repeat steps 1–7 for each item for which you want to create a cost record.

9 On the Filemenu, click Save.

TIPS:
l You can create aPicklist of jobs or phases and then distribute the costs evenly among the selected items. On

theAllocatemenu, click Job Allocate orPhase Allocate.

l You can compare the budgeted costs to the actual costs.

l You can receive a warning if you exceed the budget.

Voiding job costs
You can only void a historical job cost record that does not originate from another source in Sage 100 Contractor. When you
void a transaction in the window of original entry, Sage 100 Contractor also voids the cost record.

To void a job cost item:
1 Open 6-3 Job Costs.

2 Using the data control, select the record.

3 On theEditmenu, click Void Cost Record.

Entering the settings for Cost Over Budget Warning
TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select theSet
Over Budget Warning option, Sage 100 Contractor determines the Actual + Committed costs to date for the job and
phase by cost code and cost type.

It then compares the data to the original budget plus approved change orders. When you save the record, Sage 100
Contractor notifies you if costs exceed the budget plus approved change orders for a job and phase, cost code and cost
type, plus the tolerance.
Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A

A warning dialog box displays "Warning: The actual plus committed costs exceeds the budget and approved changes plus
the tolerance amount." You can now save the record by clicking [Yes] or cancel out by clicking [No]. An alert is also sent to
the Dashboard Alert Viewer if you have selected Job costs exceed budget for cost code in the 7-9 Alerts Manager
ProgramWarning Subscriptions tab.

NOTE: To enable the program alert for Job costs exceed budget for cost code youmust have a setting of Warning
for theMessage Type in the job cost screen.

To set the Over Budget Warning:
1 Open 1-3 Journal Transactions or 4-2 Payable Invoices/Credits.

2 Display the last record, and from themenu select Costs > Job Costs.

3 On the Job Costswindow from themenu select Options > Set Over Budget Warning.



- 353 -

4 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a No message—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

5 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

6 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the budget plus approved changes by job, phase, cost code, and cost type
allowed in the Tolerance Percent text box, and the amount of tolerance in the Tolerance Amount Not To Exceed
text box.

7 Click OK.

About job cost reconciliation
Because discrepancies can appear over time, it is important to reconcile the job cost records with the ledger transactions.
During the reconciliation, Sage 100 Contractor compares the ledger transactions with the job cost records and reports any
discrepancies that exist.

The reconciliation determines if ledger transactions aremissing job cost records, or if variances exist between the cost
amount of the ledger transaction and the job cost records. After the audit is complete, print the Job Cost Reconciliation
report, which lists ledger transactions that aremissing cost records or have variances in excess of $1.

To determine the cause of each error, review the ledger transaction in the 1-3 Journal Transactionswindow or in the
window of original entry. If a transaction does not have a corresponding job cost record, look for situations where cost
records have been deleted. For example, when you delete a job Sage 100 Contractor deletes all associated records,
including the job cost records.

It is also important to search the job cost records thoroughly. Because historical records do not tie to ledger transactions, it
is possible to already have a cost record for a ledger transaction. Make sure that a historical record does not already exist
before creating a cost record. If you cannot locate a cost record, you can enter a historical cost record.

Resolving audit variances does not eliminate them from the Job Cost Reconcile report, and they will appear on
subsequent reports for the fiscal year. It is a good idea to retain a printed copy of the report and any notes you havemade to
help identify and resolve errors. You can then use the report with future job cost reconciliation reports to identify the job cost
errors you have already resolved.

NOTE: Sage 100 Contractor does not report duplicate or extra job cost records because they are not associated with
a specific ledger transaction. Additionally, Sage 100 Contractor cannot audit historical job cost records as they were
not created by posting ledger transactions.
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Reconciling job costs
To reconcile job costs:
1 Open 6-3 Job Costs.

2 On theOptionsmenu, click Reconcile.

Changing the taxability of job cost records
When you compute invoices, sales taxes for job costs are calculated based on whether the cost type is taxable. In the job
record, you can indicate which cost types are taxable.

To change the taxability of a job cost record:
1 Open 6-3 Job Costs.

2 Using the data control, select the record.

3 Select or clear theSubject to sales tax check box.

4 Click theOverride Billing Amount check box.

5 On the Filemenu, click Save.

About committed cost reports
This report allows you to see what the committed costs are on a job. The committed costs aremonies that you’ve
committed to spend but have not spent yet. The report looks to new or unfilled purchase orders, subcontracts, and payroll
records that have not been final-computed. It allows you to determine the percentage of labor burden applied to all open
payroll records. It calculates the remaining budget based on the budget plus changes, less costs to date and committed
costs.

Job Cost Distribution
About job cost distribution

When you post payable transactions to theExpense range of accounts, Sage 100 Contractor displays the Job Cost
Distributionwindow.

In the Job Cost Distributionwindow, you can break apart costs to create individual line entries that reference jobs,
phases, cost codes, and cost types. You can also select jobs or phases using aPicklist and distribute the cost equally
among the selections.

When job costing a transaction from the 1-1 Checks/Bank Chargeswindow or the 4-2 Payable Invoices/Credits
window, Sage 100 Contractor uses the vendor record to determine which cost code and cost type to use. If the vendor
record does not contain a cost code or cost type, youmust supply the information.

The Ledger Total box displays the total debits less credits posted toDirect Expense orWIP accounts. As you enter the
costs, Sage 100 Contractor shows the total amount costed in the Job Cost Total box. To save the job cost record, the
amount in the Job Cost Total box must equal the amount in the Ledger Total box.
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6-4 Change Orders

6-4-1 Change Orders
About change orders

The 6-4-1 Change Orderswindow provides functionality for managing changes to a prime contract or subcontract. Change
orders allow you to track changes independent of a project’s budget, providing a clear audit trail for pending, approved, and
refused changes.

Depending on the type of change work you need to perform, you can enter change orders that alter the job’s budget,
proposal, or subcontracts, or any combination of the three. On thePrime Change Details tab, you can enter changes to
costs that affect the bid amount. In theBudget and Sub Change Details tab, you can enter cost changes that affect your
budgeted costs such as subcontract changes, or work for which you do not want to charge the client.

Change orders are now more closely integrated with subcontracts. When you create a change order using the 6-4-1
Change Orderswindow for a subcontract, information is displayed on the 6-7-1 Subcontractswindow in columns named
Changes, New Contract, andRemaining. This tight integration provides more control over your contracts and your
invoicing by providing accessible information.

The 6-4-1 Change Orderswindow has two tabs, Prime Change Details andBudget and Sub Change Details.

Prime Change Details tab

ThePrime Change Details tab allows you to track changes to a project and segregate changes to the contract (proposal)
from changes to your budget (costs).

Prime Changes are change orders that alter the job proposal. Prime Changes allow you to track changes independent of a
project proposal, providing a clear audit trail for pending, approved, and refused changes.

From approved prime changes, you can create receivable invoices and purchase orders. When you select theCreate A/R
Invoice orCreate Purchase Order command on theOptionsmenu, Sage 100 Contractor opens the appropriate window
and inserts the relevant information. To complete the invoice or purchase order, you enter the parts and any additional
information.

Budget and Sub Change Details tab

Change orders have two components: Prime ChangeOrders and Budget and Sub ChangeOrders. ChangeOrders allow
you to track changes to a project and segregate changes to the contract (proposal) from changes to your budget (costs).
Depending on the type of change work you need to perform, you can enter change orders that alter the job budget, proposal,
or subcontracts, or any combination of the three. Overall, change orders provide a convenient way tomanage changes to a
contract or subcontract.

Subcontracts work in conjunction with change orders and accounts payable, providing you with better control over change
work and billing. You can review billings, approved and open change orders, or a summary of the subcontract information.
You can also set up retention for a subcontract. When you create an invoice for the subcontract, the program uses the rate
indicated in the subcontract record.

Because theSub Change Orderswindow provides for managing changes to a budget or subcontract, youmay enter cost
changes that affect your budgeted costs (such as subcontract changes) or cost changes that affect work for which you do
not want to charge the client.

When changes are approved, Sage 100 Contractor reflects the changes to costs in the contract and job cost reports, but
the original budget remains unchanged.From approved change orders, you can create receivable invoices and purchase
orders. When you select theCreate Invoice orCreate Purchase Order command on theOptionsmenu, Sage 100
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Contractor opens the appropriate window and inserts the relevant information. To complete the invoice or purchase order,
you enter the parts and any additional information.

You can also record which plans and documents you send as attachments with the change order, as well as to whom you
route the change orders.

Attachments and Routing

The 6-4-1 Change Orderswindow also supports Attachments andRouting. You can drag and drop files onto the window
to create an attachment that can be emailed to customers or printed. The Routing command allows you to keep track of
where and to whom you have sent attachments.

TIP: TheAttachments command is located underEdit > Attachments.

Upgrade check box

Another important feature of the 6-4-1 Change Orderswindow is Upgrade check box. TheUpgrade check box controls
what information is included in important reports. Here are two examples:

For anUpgrade Price to appear on theHomebuilders reports and to be added to theSales Price Totals on the reports,
Upgrademust be selected, and that specific change order must have an approvedPrime Change Order amount.

For theUpgrade Budget to appear on theHomebuilders reports and be added to the Total Budget, Upgrademust be
selected, and that specific change order must have an approvedBudget amount.

How change orders affect budgets and proposals and subcontracts

You canmake changes to the budgeted costs, bid amounts, and subcontracts using the 6-4-1 Change Orderswindow.
When you print contract-related reports, Sage 100 Contractor computes the new contract amounts based on the amount in
theContract box in the 3-5 Jobswindow and approved changes. In cost analysis reports, Sage 100 Contractor computes
the new costs based on the costs from the budget and approved change orders.

Sage 100 Contractor does not alter the original budget created in the 6-2 Budgetswindow nor does it alter the original
proposal created in the 6-9 Proposalswindow. It does, however, update subcontract totals while retaining the original
subcontract amount when change orders are created using theBudget and Sub Change Details tab. These totals can be
viewed in 6-7-1 Subcontracts. You can also use the subcontracts window to invoice the entire subcontract or specific
change order lines of the subcontract.

After work begins on a contract, enter any changes to the budget or proposal as a change order. As you create the change
order, determine whether the costs affect bid amounts, budgeted costs, or both.

For example, suppose you forgot to estimate the cost of somework required in a project. To include the costs in the budget
and charge the client, enter the changes to the bid amount on thePrime Change Details tab in 6-4-1 Change Orders.
Then on theBudget and Sub Change Details tab, enter the changes to costs.

Otherwise, if youmerely want to add the costs to the budget without charging the client, enter only the changes to the costs
in theBudget and Sub Change Details tab.

Alternatively, you can set the original budget andmanually enter the changes to costs in the affected cost codes. Likewise,
you can set the original proposal and enter the changes in the affected cost codes. In addition, you can use a separate cost
code for each change order.

About entering change orders

The 6-4-1 Change Orderswindow contains a header area and two tabs, and at the bottom, boxes that report various
values that youmay be following.

The header area contains boxes for entering information such as: Job, Phase, Description, Date, Status, and so forth.
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IMPORTANT: TheStatus box selection sets the status for both tabs, however; you can override theStatus box
selection by entering a status in theApproved column on theBudget and Sub Change Details tab except for those
with a status of Void and Rejected.

Tabs

The window has two tabs, Prime Change Details, andBudget and Sub Change Details. Tomake changes to a job’s
contract amount, you enter the change on thePrime Change Details tab. To change a budget or subcontract, you enter
the changes in theBudget and Sub Change Details tab.

The changes to the contract amount (3-5 Jobs (Accounts Receivable), and the budget amount (6-2 Budgets) do not
appear in the window of origin. They only appear in reports or in sub-menus of the windows of origin. This functionality
maintains the separation of the original amounts and the changes.

For example, to see the changes in a contract, youmay view thePrime Contract Audit report. To see the changes in the
budget, youmay view various project management reports, such as the Job Cost Summary report. To see the changes in
a subcontract, youmay view the subcontract Audit report.

On the 3-5 Jobs (Accounts Receivable)window, on themenu bar, youmay also view changes in the contract amount by
clickingOptions > Contract Summary.

On the other hand, changes to the subcontract do appear in the 6-7-1 Subcontractswindow. After creating a change order
against a subcontract, the program updates the changes as well as the original totals. On the 6-7-1 Subcontractswindow,
on themenu bar, youmay also view changes in the budget amount by clickingOptions > Summary.

Change order work may require an adjustment to the job contract and the budget. For example, a general contractor has
begun work on a kitchen remodel project and the client wants to change the sink called for in the plans. The plumbing
subcontractor tells the general contractor to add $75 for the sink upgrade.

In creating the change order, the contractor enters the $75 change to the subcontract in theBudget and Sub Change
Details tab. Because the client requested the change, the contractor charges $25 for the upgrade in addition to the $75 in
added costs. On thePrime Change Details tab, the contractor enters a request for an additional $100. After saving the
sub change, the change information appears with the subcontract record in 6-7-1 Subcontracts.

Sometimes youmight only want to change the contract amount. Suppose, from the above example, the sink the client
wants costs the same amount as the sink from the plans. Because the client requested the change, the contractor charges
$25 for the change work. On thePrime Change Details tab, the contractor enters a request for an additional $25.

Under certain conditions, youmight have to adjust only the budget. Suppose the specification for the faucet requires a
specific model that costs $100. However, due to somemiscommunication, the subcontractor installed amodel costing
$150 and refuses to take the loss. In theBudget and Sub Change Details tab, the contractor enters a budget change for
$50.

TIP: To include a detailed description of the change order work, type a note for the change order “record” rather than
typing a note in a grid row or including an attached document. To open theNoteswindow, click theNotes icon on the
toolbar.

About automatic numbering for change orders

When you create a new change order for a job, Sage 100 Contractor provides the next change order number in the
sequence. You do not have to accept the suggested change order number, and can enter your own number instead.

Use the following guidelines:

l When a change order number uses only a number, Sage 100 Contractor increments the change order number by
one. For example, you create change order 1 for job 220. The subsequent change order numbers would be 2, 3, 4,
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and so on.

l If a change order number uses a dash ( – ), Sage 100 Contractor increments the number to the right of the dash by
one. The dash lets you include the job or subcontract number in the change order number sequence this helps
identify to which job or subcontract the change order belongs.

Suppose you are creating the first change order for job 220. By including the job number, the first change order
number would be 220-1. The subsequent change orders for the job would be 220-2, 220-3, and so on.

You can also use the same numbering convention for subcontract change orders. Suppose you are creating a
change order for subcontract 850 on job 220. When entering the first change to the subcontract on theBudget and
Sub Change Details tab, you enter 850-1 in theChange# box. Later, when you enter another change order for that
subcontract, the next change order number would be 850-2.

l When a change order number combines letters and numbers, Sage 100 Contractor cannot increment the change
order number. For example, if you created change order AAA5 for job 220, Sage 100 Contractor cannot suggest the
next change order number.

NOTE: The change order numbers in each phase of a job are independent from the change order numbers in the other
phases of the job. Suppose job 220 has two phases, and you create change order 220-1 in phase 1. In phase 2, you
can also create change order 220-1. This lets you track the number of change orders in each phase.

Entering prime and sub changes for contracts and budgets

On thePrime Change Details tab, Sage 100 Contractor calculates the amount requested for each line item using the
following formula: (estimated cost * overhead rate * profit rate = amount requested). TheSubcontract column displays the
subcontract number and its record number. If the amount of change is negative, enter a negative amount. If this change
order is for an upgrade, select theUpgrade check box. This data will then be used on specific reports.

On thePrime Change Details tab, enter the amounts approved by the client in theApproved cells. Sage 100 Contractor
uses the amounts in theApproved cells when you create the accounts receivable invoice.

To include a detailed description of the change order work, type a note for the change order “record” rather than typing a note
in a grid row or including an attached document. To open theNoteswindow, click theNotes icon on the toolbar.

To enter prime and sub changes:

1 Open 6-4-1 Change Orders.

2 In the Job box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase box.

4 In theDescription box, enter a brief statement about the change order or use the lookup window to enter an existing
description.

5 In theChange# box, enter the change order number.

When creating a series of change orders for a job, Sage 100 Contractor suggests the next number in sequence
automatically.

6 In theReason box, enter the reason using the lookup window, then press the Enter key.

7 (Optional) In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

8 In theOrder Date box, enter the date of the change order.

9 In theSubmitted box, enter the date of when the change was submitted.

10In theStatus list, click the status.

11In the Type list, click the type.
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12On thePrime Change Details tab, do the following for each item affecting the job contract:

a In theDescription cell, enter a brief statement about the change work.

b In theEstimated cell, enter the amount of change to the contracted amount.

c If you want to include overhead, enter the rate in theO/H Rate cell.

d If you want to include profit, enter the rate in theProfit Rate cell.

e In theRequested cell, enter the amount you are requesting.

f In theCost Code cell, enter the cost code using the lookup window.

g In theCost Type cell, enter the cost type using the lookup window.

13In theBudget and Sub Change Details tab, do the following for each item affecting the budget:

a In theDescription cell, enter a brief statement about the change work.

b If you want to change the budgeted hours, enter the amount of change in theBudget Hours cell.

c If you want to change the budgeted units, enter the amount of change in theBudget Units cell.

d If you want to change the budgeted amount, enter the amount of change in theBudget Amount cell.

e If the change work affects a vendor, enter the vendor number in theVendor cell.

f If you want to change a subcontract, enter the record number of theSubcontract cell.

g In theChange# cell, enter the change order number you want to assign the subcontract.

h In theStatus cell, select the sub change status.

14In theCost Code cell, enter the cost code.

a In theCost Type cell, enter the cost type.

15In theBudget and Sub Change Details tab, do the following for each item that does NOT affect a subcontract:

a In theDescription cell, enter a brief statement about the change work.

b If you want to change the budgeted hours, enter the amount of change in theBudget Hours cell.

c If you want to change the budgeted units, enter the amount of change in theBudget Units cell.

d If you want to change the budgeted amount, enter the amount of change in theBudget Amount cell.

e In theCost Code cell, enter the cost code using the lookup window, then press Enter.

f In theCost Type cell, enter the cost type using the lookup window, then press Enter.

16On the Filemenu, click Save.

Entering prime changes for contracts

On thePrime Change Details tab, enter changes to costs that affect the job contract. For example, the client might
request changes that do not incur costs to you, but you want to charge the client for the changes.

Consider the following points before entering prime changes:

l If the amount of change is negative, enter a negative amount.

l On thePrime Change Details tab, Sage 100 Contractor calculates the amount requested for each line item using
the following formula: (estimated cost * overhead rate * profit rate = amount requested).

l If this change order is for an upgrade, select theUpgrade check box. This data will then be used on specific reports.



- 360 -

l On thePrime Change Details tab, enter the amounts approved by the client in theApproved cells. Sage 100
Contractor uses the amounts in theApproved cells when you create the invoice.

To enter prime changes:

1 Open 6-4-1 Change Orders.

2 In the Job box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase box.

4 In theDescription box, enter a brief statement about the change order or use the lookup window to enter an existing
description.

5 In theChange# box, enter the change order number.

When creating a series of change orders for a job, Sage 100 Contractor suggests the next number in sequence
automatically.

6 In theReason box, enter the reason using the lookup window, then press the Enter key.

7 (Optional) In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

8 In theOrder Date box, enter the date of the change order.

9 In theSubmitted box, enter the date of when the change was submitted.

10 In theStatus list, click the status.

11 In the Type list, click the type.

12 On thePrime Change Details tab, do the following for each item affecting the job contract:

a In theDescription cell, enter a brief statement about the change work.

b In theEstimated cell, enter the amount of change to the contracted amount.

c If you want to include overhead, enter the rate in theO/H Rate cell.

d If you want to include profit, enter the rate in theProfit Rate cell.

e In theRequested cell, enter the amount you are requesting.

f In theCost Code cell, enter the cost code using the lookup window.

g In theCost Type cell, enter the cost type using the lookup window.

13 On the Filemenu, click Save.

Entering sub changes for budgets

On theBudget and Sub Change Details tab, you can enter changes to subcontracts that have no effect on the job
contract.

Consider the following points before entering sub changes for budgets:

l If the amount of change is negative, enter a negative amount.

l TheSubcontract column displays the subcontract number and its record number.

l If this change order is for an upgrade, select theUpgrade check box. This data will then be used on specific reports.

To enter a budget sub change:

1 Open 6-4-1 Change Orders.

2 In the Job box, enter the job number.
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3 If the job uses phases, enter the phase number in thePhase box.

4 In theDescription box, enter a brief statement about the change order or use the lookup window to enter an existing
description.

5 In theChange# box, enter the change order number.

When creating a series of change orders for a job, Sage 100 Contractor suggests the next number in sequence
automatically.

6 In theReason box, enter the reason using the lookup window, then press the Enter key.

7 (Optional) In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

8 In theOrder Date box, enter the date of the change order.

9 In theSubmitted box, enter the date of when the change was submitted.

10In theStatus list, click the status.

11In the Type list, click the type.

12In theBudget and Sub Change Details tab, do the following for each item affecting the budget:

a In theDescription cell, enter a brief statement about the change work.

b If you want to change the budgeted hours, enter the amount of change in theBudget Hours cell.

c If you want to change the budgeted units, enter the amount of change in theBudget Units cell.

d If you want to change the budgeted amount, enter the amount of change in theBudget Amount cell.

e If the change work affects a vendor, enter the vendor number in theVendor cell.

f If you want to change a subcontract, enter the record number of theSubcontract cell.

g In theChange# cell, enter the change order number you want to assign the subcontract.

h In theStatus cell, select the sub change status.

i In theCost Code cell, enter the cost code using the lookup window, then press Enter.

j In theCost Type cell, enter the cost type using the lookup window, then press Enter.

13On the Filemenu, click Save.

About adding change orders to subcontracts

It is likely that you will have to add one or more change orders to subcontracts during the course of a project.

NOTE: 6-7-1 Subcontracts control subcontract records and their interaction and integration with 6-4-1 Change
Orders and 4-2 Payable Invoices/Credits. Changes made to records in 6-4-1 Change Orders and in 4-2 Payable
Invoices/Credits are displayed in 6-7-1 Subcontracts.

The process of entering a change order for a contract is straight forward. You begin by referencing the job in the header
section of the widow. Then after entering the required information, such as Description, Change#, Date, andStatus in the
header, you enter information in the tabs, Prime Change Details andBudget and Sub Change Details.

On thePrime Change Details tab, you only need to enter required information forDescription, Cost Code, andCost
Type. Then you click theBudget and Sub Change Details tab to enter the changes.

There is a new column, Subcontract Line, in theBudget and Sub Change Details grid. Five of the columns of the grid
now act as a unit. These columns are:
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l Vendor—Enter a vendor, or accept the default vendor.

l Subcontract—Enter a subcontract number, or accept the default subcontract number.

l Subcontract Line- Select the line to affect in the subcontract, leave the cell blank to create a new line in the
subcontract.

l Change#—Enter aChange#, or accept the default Change#.

l Status—Enter aStatus.

IMPORTANT:
These five columns act as a unit. In addition to required fields, a valuemust be entered under each of these columns
except Subcontract Line to be able to save the change order record.

If theSubcontract Line cell is blank, you have to enter aCost Code andCost Type.

If you enter data in theSubcontract Line cell, Cost Code andCost Type autofill.

Change a line or create a new line in a 6-7-1 Subcontract record

When entering a subcontract change, you can add or subtract the existing value of a subcontract record line or you can add
a new line to the subcontract record. When working in the grid with your cursor in the a cell under theSubcontract Line
column, you can press F5 to open theSubcontract Lines lookup window. Then select the line you want to affect by
double-clicking it. Alternatively, leaving theSubcontract Line cell blank when creating a new line in the grid, creates a new
line in the subcontract record.

After saving the record, you can see the changes to the subcontract record by opening the subcontract in 6-7-1
Subcontracts. In the grid, notice that theChanges columnwill have an entry in the line you selected when creating the
change. The change is also displayed in the details summary boxes at the bottom of the window.

Adding change orders to subcontracts

When you add a change order to a subcontract, you can add a new line to a subcontract or you can change an existing
subcontract line.

To add a change order to a subcontract:

1 Open 6-4-1 Change Orders.

2 In the Job box, enter a job, and then in theDescription box, type a brief description.

3 In theChange# box, accept the change order number entered by the program, or type a new customizable change order
number.

4 In theDate box, accept the date, or type a new one.

5 In the Status box, select 2—Open or 1- Approved.

6 On thePrime Change Details tab in the grid under theDescription column, enter a description.

You can enter more information on this tab, but it’s not required.

7 On theBudget and Sub Change Details tab in the grid underDescription, enter a description, and press the Enter key
tomove to theBudget Amount column.

8 UnderBudget Amount, enter an amount, and then press the Enter key.

9 UnderVendor, enter a vendor, and then press the Enter key.

10UnderSubcontract, accept the autofilled subcontract, and then press the Enter key.

11UnderSubcontract Line, do one of the following:
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a Press F5 or the click the arrow, and from theSubcontract Lines lookup window, double-click the line to which you
want to add the change order.

b Skip theSubcontract Line entry.

12 Press the Enter key tomove toChange# and enter a change number.

13 UnderStatus, enter a status, and then press the Enter key.

14 TheCost Code andCost Type autofill from information on the subcontract record if you enter a value for Subcontract
Line.

15 If theSubcontract Line cell is blank, enter aCost Code andCost Type.

16 From themenu, select File > Save.

After saving the record, you can see the changes to the subcontract record by opening the subcontract in 6-7-1
Subcontracts. In the grid, notice that theChanges columnwill have an entry in the line you selected when creating the
change. Alternatively, if no subcontract line was selected on the change order, a new subcontract line is entered for the
change. The change is also displayed in the details summary boxes at the bottom of the window.

Creating accounts receivable invoices from change orders

You can create accounts receivable invoices from the 6-4-1 Change Orderswindow.

IMPORTANT: The change order status must be 1-Approved to use this function.

To create an accounts receivable invoice from a change order:

1 Open 6-4-1 Change Orders.

2 Select the change order.

3 On theOptionsmenu, click Create A/R Invoice.

Creating purchase orders from change orders

IMPORTANT: The change orderStatusmust be 1-Approved to use this function.

To create a purchase order from a change order:

1 Open 6-4-1 Change Orders.

2 Select the change order.

3 On theOptionsmenu, click Create Purchase Order.

About change order status

In the header, you can assign a status to the entire change order. On theBudget and Sub Change Detail tab, you can
also assign a status to each line in the grid of a subcontract change order.

For example the status of the change order record in the header can be 2—Open, and the setting for a line in the grid under
Status on the Budget and Sub Change Details tab can be set to 1—Approved. With a line in grid set to 1—Approved, that
line can be invoiced while leaving the entire record with a status of 2—Open.
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Status Description

1-Approved

Approved by the client/responsible party.

The contract and the reports, change order aging, billings,
job status, and job cost, reflect the changes.

If the Approved column on the Budget and Sub Change
Details tab under Status is set to 1—Approved, this line
can be invoiced.

2-Open

The client/responsible party has not approved the
changes yet.

Only the change order aging and job status reports reflect
the changes.

3-Review
The changes are under review.

Only the change order aging and job status reports reflect
the changes.

4-Disputed The change order is in dispute.

5-Void The change order is void.

6-Rejected
Rejected by the client/responsible party.

Does not apply to subcontracts.

Setting up change order types

You can create a list of change order types, allowing you to categorize change orders. A general contractor, for example,
might create types to track contract changes, internal changes, and back charges to subcontractors.

The following is an example of change order types:

CO Type # Type Name

10 Field Engineering

20 Architect Initiated

30 Field Request

70 Sub Backcharge

80 Cross Charge

90 Internal Request

To set up change order types:

1 Open 6-4-1 Change Orders.

2 Next to the Type list, click the detail button.

3 In theCO Type# cell, enter the type number.

4 In the Type Name cell, enter a description of the change order type.

5 Repeat steps 2–4 for each type.
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6 On the Filemenu, click Save.

Viewing lists of change orders for jobs

You can view a list of the prime contract change orders.

To view a list of change orders for a job:

1 Open 3-5 Jobs (Accounts Receivable).

2 On theOptionsmenu, click Change Orders.

About displaying subcontract descriptions

When creating a change order that affects a subcontract, you can display the subcontract description under the
Subcontract column in theBudget and Sub Changes Details tab.

When you select theDisplay Subcontract Desc. command on theOptionsmenu, Sage 100 Contractor displays the
subcontract description after the subcontract record number and the subcontract number.

Deleting change orders

To delete a change order:

1 Open 6-4-1 Change Orders.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Change Order.

6-4-2 Print Change Orders
About 6-4-2 Print Change Orders

Clicking 6-4-2 Print Change Orders launches the 6-4-2 Report Printingwindow for printing change order reports and
viewing sample reports.

6-4-3 Print Subcontractor Orders
About 6-4-3 Print Subcontract Orders

Clicking 6-4-3 Print Subcontract Orders launches the 6-4-3 Report Printingwindow for printing subcontract order
reports and viewing sample reports.

6-4-4 Prime Change List
About 6-4-4 Prime Change List

Clicking 6-4-4 Prime Change List launches the 6-4-4 Report Printingwindow for printing Prime Change List reports and
viewing sample reports.

6-4-5 Subcontract Change List
About 6-4-5 Subcontract Change List

Clicking 6-4-5 Subcontract Change List launches the 6-4-5 Report Printingwindow to be used to for printing
Subcontract Change List reports and viewing sample reports.
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6-4-6 Prime Contract Audit
About 6-4-6 Prime Contract Audit

Clicking 6-4-6 Prime Contract Audit launches the 6-4-6 Report Printingwindow for printing Payroll Check reports and
viewing sample reports.

6-5 Cost Codes

About cost codes and divisions
Cost codes are an important part of the job costing system. They allow you to separate costs into different categories and
compare budgeted costs to actual cost for a job. Each cost code is assigned to a division, which provides a way to group
cost codes for subtotaling on reports. Sage 100 Contractor organizes job costs in order of detail by job and phases, cost
codes, and cost types.

NOTE: Cost codes are company-specific, not job-specific.

A commonmistake when creating a cost code list for general contractors is building a long list that contains toomuch
detail. It is unnecessary to include trades that the contractor does not perform or subcontract. Unless a general contractor
performs the work, one cost code is usually sufficient. For example, a general contractor rarely needs separate cost codes
for rough electrical, electrical trim, electrical fixtures, and alarm. Including such trades only creates an unwieldy cost code
list, which leads to errors in data entry.

The cost code list for most single-trade subcontractors can be very short; a dozen codes are usually sufficient. Some
contractors, though, may needmore cost codes. Mechanical subcontractors, for example, may need approximately twenty
codes to break down both plumbing and HVAC work.

Divisions are used to group cost codes. Because Sage 100 Contractor uses divisions to subtotal costs for cost-based
reports, many contractors create divisions based on the Construction Specifications Institute (CSI) divisions. However,
you do not have to rely on the CSI structure for divisions and can create your own.

NOTE: Although there is no report that prints cost codes by division, you can print the cost codes from the 6-5 Cost
Codeswindow. The report lists the costs codes and divisions assigned to them.

About Workers' Compensation codes
AssigningWorkers’ Compensation codes to cost codes provides the correct compensation code based on the type of work
performed during timecard entry. Youmay need to create additional cost codes for the combination of cost codes and
Workers’ Compensation codes to work correctly.

In a split rate system forWorkers’ Compensation, a category of work uses two different rates. Some states, such as
California, use a two-tiered system of rates based on employee pay. The wages an employee earns determines the rate at
which the insurance company computes Workers’ Compensation.

For split rates, Sage 100 Contractor uses a wagemaximum to determine which code to use. For wages that are less than or
equal to the wagemaximum, Sage 100 Contractor assigns the first compensation code to the timecard. When employee
wages exceed the wagemaximum, Sage 100 Contractor assigns the second compensation code.

Entering cost codes

CAUTION: Carefully plan your cost code structure before implementing it. After you have entered transactions into
the system with a set of cost codes, it is a complex process to change them.
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IMPORTANT: For equipment, be sure to create cost codes for tracking costs of ownership, maintenance, repair, and
operation. The equipment cost codes should include but are not limited to interest, insurance, taxes/license, major
overhaul, repairs, scheduled service, tires, and fuel.

To enter cost codes:
1 Open 6-5 Cost Codes.

2 In theCost Code# cell, enter the cost code number.

3 In theDescription cell, enter a brief statement about the cost code.

4 In theUnit cell, enter the unit of measure for rough costs.

5 In theDivision cell, enter the division to which the cost code belongs.

6 In theCompCode1 cell, enter the compensation code.

7 If your state uses split Workers’ Compensation rates, do the following:

a In theWage Maximum cell, enter the wage breakpoint.

b In theCompCode2 cell, enter the second compensation code.

8 In theDepartment cell, enter the department number.

9 Repeat steps 2–8 for each cost code.

10 On the Filemenu, click Save.

Adding new cost codes to an existing cost code structure
You can add new cost codes to an existing cost code structure in Sage 100 Contractor by adding a new row to the bottom
of the grid. When you save and then re-open 6-5 Cost Codeswindow, Sage 100 Contractor sorts the new cost code into its
correct position in the existing structure.

TIP: Before adding a new cost code, analyze your existing cost code structure tomake sure that the new cost code
fits into the existing structure correctly.

NOTE: Sage 100 Contractor only requires entries in theCost Code#, Description, andDivision columns. You only
need to addmore information as required for your business.

To add a new cost code to an existing cost code structure:
1 Open 6-5 Cost Codes.

2 Scroll to the bottom of the window, and add a new row by placing your cursor in the last cell of the last row and pressing
the Enter key.

3 In theCost Code# cell, type a number.

4 In theDescription cell, type a description.

5 In theDivision cell, click the drop-down arrow and select a cost code division.

6 From the Filemenu, select Save.

Entering divisions
Divisions allow you to group cost codes. Because Sage 100 Contractor uses divisions to subtotal costs for cost-based
reports, many contractors create divisions based on the Construction Specifications Institute (CSI) structure. You do not
have to rely on the CSI structure for divisions, however, you can create your own.
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NOTE: Although there is no report that prints cost codes by division, you can print the cost codes from the 6-5 Cost
Codeswindow. The report lists the costs codes and divisions assigned to them.

To enter divisions:
1 Open 6-5 Cost Codes.

2 In a cell in theDivision column, click once, and then press the F6 key to display theCost Divisionswindow.

3 Alternatively, you can right-click in a cell and then select theDisplay Detail/Add Record command to display theCost
Divisions window.

4 In theDivision# cell, enter the number you want to assign the division.

5 In theDescription cell, enter a brief statement about the division.

6 Repeat steps 3–4 for each division.

7 On the Filemenu, click Save.

Setting up cost types
Cost types allow you to arrange costs into categories. Each cost code acts as a controlling account for the nine cost types.
Cost types can be selected and defined from several menus, including 4-4 Vendors (Accounts Payable), the Invoice
Details tab, and 6-3 Job Costs. Cost types will be displayed on grids throughout the system.

Only nine cost types are available in Sage 100 Contractor. Cost types 1 through 5 are preset by the system. Cost types 6
through 9 can be defined by the user.

Cost Types

1—Material

2—Labor

3—Equipment

4—Subcontract

5—Other

6—User Def Type 6

7—User Def Type 7

8—User Def Type 8

9—User Def Type 9

To set up cost types 6—9:
1 Next to theCost Type list, click the detail button.

2 In the Type Name box, enter the name you want to assign the cost type.

3 On the Filemenu, click Save.

Importing cost codes
If you have a cost code list from another source, you can import it. Arrange the data in the following order: Cost Code#,
Description, Unit, Division, Comp Code1,Wage Max, Comp Code2, andDepartment. Then save the file in comma
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delimited (*.cma), tab delimited (*.tab), or comma-quote (*.qte) file format. You can also copy and paste from a spreadsheet
using the clipboard (Ctrl+C, Ctrl+V).

Because Sage 100 Contractor uses cost code numbers as themeans to access all other cost code information, replacing
the existing cost codes can seriously affect the accuracy of many reports. The imported cost codes overwrite existing cost
codes. If your active company uses the same cost code numbers as the file you import, the existing cost codes will be
overwritten.

IMPORTANT:
Before importing a file from other software, youmust create a compatible comma-delimited, tab-delimited, comma-
quote file using a spreadsheet program, word processing program, or other software.

Youmust import theCost Divisions separately before you import theCost Codes.

When importing cost codes into a company with existing cost divisions, use a placeholder in your import file to avoid
overwriting information in theDivision column. A placeholder in a comma-delimited file would be, for example, a
comma, two quotationmarks, and another comma (," ",).

To import cost codes:
1 Open 6-5 Cost Codes.

2 On the Filemenu, point toOpen, and select the type of file you want to import.

3 TheOpenwindow appears.

4 Browse to and select the file you want to import.

5 Click Open.

6 Sage 100 Contractor imports the cost codes.

7 Click Save.

Importing cost divisions
If you have a cost division list from another source, you can import it. Arrange the data in the following order: Division# and
Description. Then save the file using a comma delimited (*.cma), tab delimited (*.tab), or comma-quote (*.qte) format. You
can also copy and paste from a spreadsheet using the clipboard (Ctrl+C, Ctrl+V).

IMPORTANT:
Youmust import cost codes separately and after you have imported cost divisions.

Cost Division is a required entry. You cannot save data in the 6-5 Cost Codeswindow without inserting cost
divisions.

To import cost divisions:
1 Open 6-5 Cost Codes.

2 In theDivision column, click in a cell.

3 Right-click the cell, then click Display Detail/Add Record.

4 TheCost Divisionswindow appears.

5 On the Filemenu, point toOpen, and select the type of file you want to import.

6 Select the file you want to import, then click Open.

7 Sage 100 Contractor imports the cost divisions file into theCost Divisionswindow.

8 Save theCost Divisionswindow.
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9 In 6-5 Cost Codes, click in a cell in theDivision column, then click the drop-down arrow.

10 TheCost Divisionswindow appears.

11 Double-click the cost division you want to insert into the 6-5 Cost Codeswindow.

12 Click Save.

Setting Up A Cost Code Numbering System
About cost code numbering systems

When creating cost codes, use a simple numbering system to avoid the introduction of errors and to divide the cost codes
into major categories. When starting with a 4-digit number system, for example, make each thousand a division, such as
1000-General Requirements, 2000-Site Work, 3000-Concrete, and 4000-Masonry.

CAUTION: Carefully plan your cost code structure before implementing it. After you have entered transactions into
the system with a set of cost codes, it is a complex process to change them.

The Construction Specifications Institute (CSI) has designed a set of cost codes intended for cost and specification
purposes. General contractors often adopt the system for estimating and cost accounting, and subcontractors often use an
extended numbering system defined by the CSI code list.

NOTE: Cost codes are company-specific, not job-specific.

About cost code numbering for general contractors

A commonmistake when creating cost codes is building a long list that contains toomuch detail. It is not necessary to
include trades that the contractor does not perform or subcontract. Unless a general contractor performs the work, one cost
code is usually sufficient. For example, a general contractor rarely needs separate cost codes for Rough Electrical,
Electrical Trim, Electrical Fixtures, and Alarm. Including such trades only creates an unwieldy cost code list. While you can
use a single cost code in place of many cost codes, how do you track costs?With each payable invoice, the contractor
creates job costs that detail the type of work performed. Continuing with the example above, an electrical subcontractor on
most jobs submits three to six invoices to the general contractor. By printing a Job Cost Journal for the specific job, the
journal details each electrical cost entry made to the job as well as the total electrical costs.

There are circumstances in which having several cost codes are useful. If you have allowances in a contract, you will want
to track those costs separately. For example, youmight use Electrical and Electrical Fixtures as separate cost codes,
allowing you to separate the electrical costs. Over the course of the project, you can provide the owner with a report
detailing the total amount spent on allowance items. You can always enter a change order to adjust the prime contract
based on the over/under amount of the allowance.

When building the list of cost codes, it is best to begin with a small list with room for expansion. Over time you can add
more cost codes in the appropriate sections.

For ease of use, many general contractors use the Construction Specifications Institute (CSI) divisions. Be aware that the
CSI numbering system classifies materials and workmanship in a construction project and not cost breakdowns. In most
cases, the first two levels of the CSI system work for cost codes. If you decide to use the CSI divisions, use themain 16
divisions. To provide room for growth in the cost code list, add two or three zeros after each division number.

While creating the cost codes, keep inmind that you will assign a cost type to each job cost. It is unnecessary, therefore, to
create cost codes that break apart costs into materials, labor , equipment, subcontracts, and so forth.

About cost code numbering for subcontractors

The cost code list for most single-trade subcontractors can be very short; a dozen codes are usually sufficient. Some
contractors, though, may needmore cost codes. Mechanical subcontractors, for example, may need twenty codes or more
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to breakdown both plumbing and HVAC work.

Some subcontractors use numbers that reflect the related CSI divisions. For example, a drywall subcontractor may use
9250 for Stocking, 9255 for Hanging, 9260 for Taping, 9265 for Spraying, 9270 for Knockdown, and 9275 for Cleanup.
General contractors or owners rarely require such detail in a cost code list.

Cost codes for cost and specification purposes

Two organizations specifically publish information regarding cost codes for cost and specification purposes:

l The Construction Specifications Institute (CSI) publishes information about the description, categorization, naming,
and numbering for construction specifications.

l The Associated General Contractors has adapted this numbering system for cost code categorization, which is
published jointly with CSI. Ask for theAGC Cost Classification Index.

You can look for more information regarding construction at these two websites, or do a keyword search for "construction
cost codes" on the Internet

6-6 Purchase Orders

6-6-1 Purchase Orders
About purchase orders

A purchase order lists thematerials needed from a specific vendor for a specific job. You can create purchase orders
manually for each vendor, or export data from the takeoff to create purchase orders automatically for each vendor. In
addition, you can create purchase orders for the subcontractors on a given project.

With large projects, you can createmaster purchase orders. A master contains all the parts needed from a vendor, but
allows you to create smaller purchase orders to help schedule the flow of materials to the job site. For example, you can
stagger the purchase and delivery of framingmaterials to better coincide with the different phases of construction.

After creating purchase orders, you can generate job cost reports to determine committed costs. As you receive shipments
of materials, employees can enter the quantities of materials received using the 12-4 Purchase Order Receiptswindow,
which creates a payable invoice with status 2-Review. When you receive the payable invoice from the vendor, you can
review the invoice record andmake any necessary adjustments.

Use theRemove Closed Purchase Orders option to remove purchase orders with aClosed status and no job number.

About manufacturer details

You can include themanufacturer’s name and part number in theDescription column. When theManufacturer Details
option on theOptionsmenu is selected, Sage 100 Contractor automatically includes themanufacturer’s name and part
number in the purchase order from the corresponding information in 9-2 Parts. Sage 100 Contractor only includes the
manufacturer’s information at the time that you enter data.

Creating purchase orders for jobs

Consider the following points before creating purchase orders for jobs:

l You can turn on an option to open a job’s schedule when the purchase orderScheduled date changes.

l When you enter a new payable invoice using a purchase order, the purchase order sales tax will automatically
default into the new invoice. You can choose to deactivate the automatic purchase order sales tax feature and to
enter the sales tax manually into the invoice.

http://www.csinet.org/
http://www.agc.org/
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l You can assignmaterials being purchased to an inventory location. In the Inventory Location cell, enter the
inventory location number.

l As you enter items, Sage 100 Contractor uses the information on the Invoice Defaults tab in the vendor record.
However, you can post to different ledger accounts. In theAccount cell, enter the account to which you want to
post the cost of the items.

l To control purchasing, some companies have an individual whomust review and authorize purchase orders. After
authorizing the purchase order, enter the approval date in theApproved box.

To create purchase orders for jobs:

1 Open 6-6-1 Purchase Orders.

2 In theOrder# box, do one of the following:

a Enter the purchase order number.

b Leave theOrder# box blank to automatically assign an order number.

TIP: In a networked environment, do not assign an order number. Sage 100 Contractor assigns an order number
when you save the record.

3 In theOrder Date box, enter the date of the purchase order. Sage 100 Contractor automatically prefills the text box with
today's date.

4 In theVendor box, enter the vendor number.

5 In theAttention box, enter the name of the person to whom you are sending the purchase order.

6 In theDescription box, enter a brief statement about the order.

7 In the Job box, enter the job number.

8 If the job uses phases, enter the phase number in thePhase box.

9 In theEquipment box, enter a piece of equipment using the lookup window, and then press the Enter key.

10In the Task box, enter a scheduled task using the lookup window, then press the Enter key.

11In the Tax District box, enter the sales tax district number.

The entire purchase order is subject to sales tax.

12 In theApproved box, enter the date the purchase order was approved.

13 In theScheduled box, enter the scheduled date of delivery.

14 In theDelivery box, enter the actual date of delivery.

NOTE: If you are having items sent to a delivery site, enter the address information in theAddress 1, Address 2,
City, State, and Zip text boxes.

15 In theVia box, enter themeans of delivery.

16 In the Terms box, enter the payment terms.

17 In theStatus list, select the status of the purchase order.

18 In the Type list, select the type of order.

19 In theOrdered by box, enter the employee name using the lookup window, then press the Enter key.

20(Optional) In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

21 In the grid, do the following:
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a In thePart# cell, enter the part number.

b In theDescription cell, enter a brief statement about the item.

c In theAlpha Part# cell, enter the alpha part number.

d In theUnit cell, enter the unit of measurement.

e In theQuantity cell, enter the number of items you want to purchase.

f In thePrice cell, enter the cost for one item.

g In theCost Code cell, enter the cost code you want to use.

h In theCost Type cell, enter the cost type.

22 Repeat step 16 for each item you want to purchase.

23 On the Filemenu, click Save.

NOTE: When you enter the receipt of materials in the 12-4 Purchase Order Receiptswindow or create a payable
invoice that references a purchase order, Sage 100 Contractor updates the To Date cells with the number of items
received.

About purchase order status

In the header, you can assign a status to the purchase order.

You can run reports where the selection criteria allows you to view purchase orders with different statuses, for example,
report (6-6-2) 21-PurchaseOrder List.

Status Description

1-Open
Indicates the purchase order has been
approved by someone with authority in the
company to approve purchase orders.

2-Review

Indicates the purchase order should be
reviewed by someone with authority in the
company to review purchase orders.
Important: Before you create an invoice, the
purchase order should be reviewed. You can
enter an invoice with a status of 2-Review, but
the program warns you about it.

3-Dispute

Indicates a purchase order in dispute with the
vendor. The authority reviewing the purchase
order is disputing the charges, quantities, etc.
of the purchase order.

4-Closed Indicates all items contained in the purchase
order have been purchased or canceled.

5-Void Indicates the purchase order is void.

6-Master

Tracks all materials to be purchased from the
vendor for an entire project.

With amaster purchase order, you can create
individual purchase orders to the vendor. The
master allows you to control the ordering and
shipping of materials to the job site.
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Setting up purchase order types

You can create a list of purchase order types, allowing you to categorize purchase orders. A general contractor, for
example, might create types to track jobs, work orders, inventory, vehicles, office, and professionals (attorneys,
accountants).

The following is an example of purchase order types:

PO Type # Type Name

1 JobMaterials

2 TempUtilities

3 Equipment

4 Office

To set up purchase order types:

1 Open 6-6-1 Purchase Orders.

2 Next to the Type list, click the detail button.

3 In thePO Type# cell, enter the type number.

4 In the Type Name cell, enter a description of the purchase type.

5 Repeat steps 3–4 for each type.

6 On the Filemenu, click Save.

About closing purchase orders automatically

You can automatically close a purchase order. When theAutomatic Close command on theOptionsmenu is selected,
Sage 100 Contractor automatically assigns status 4-Closed to a purchase order when receiving against the purchase order
in 4-2 Payable Invoices/Credits or 12-4 Purchase Order Receipts, and the sum of the To Date andCanceled columns
equal the sum of theQuantity column.

NOTE: TheAutomatic Close option is only available if you have supervisor user rights.

Closing purchase orders manually

When the sum of the To Date andCancelled columns equal the sum of theQuantity column, close the purchase order.

To manually close a purchase order:

1 Open 6-6-1 Purchase Orders.

2 Select the purchase order.

3 In theStatus list, click 4-Closed.

4 On the Filemenu, click Save.

Issuing purchase orders

You can issue an individual purchase order. Note that TheBatch number will incrementally increase by one (1) each time
you issue a purchase order.
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To issue a purchase order:

1 Open 6-6-1 Purchase Orders.

2 Select thePurchase Order you want to issue. The purchase order must have a status of 1-Open in order to be issued.

3 On theOptionsmenu, click Issue this Purchase Order.

4 The Issued date andBatch number appear in the lower left-hand corner of the window.

Issuing batches of purchase orders

You can issue a batch of purchase orders. Note that printing from thePurchase Order Issue Batchwindow will display
thePurchase Order Issue Batch report.

To issue a batch of purchase orders:

1 Open 6-6-1 Purchase Orders.

2 Select and open any purchase order record.

3 On theOptionsmenu, click Issue Purchase Order Batch.

4 TheSelect Purchase Orders to Issuewindow appears. Purchase orders must have a status of 1-Open in order to be
issued.

5 Select theSelection Criteria, Sort, andSort By options that you want to use to identify the purchase orders to be
issued, and click OK.

6 ThePurchase Order Issue Batchwindow appears.

7 Review the window to confirm the selected purchase orders should be issued.

8 Double-click in the Issue column to select and clear records.

9 Double-click in any other cell in a row to display a purchase order for review.

10 Select a row and click Go to PO to display the selected purchase order.

11 Click theSelection button to display theSelect Purchase Orders to Issuewindow, where you canmake further
selectionmodifications.

12 Confirm that the appropriate purchase orders are selected, and click Save to issue the purchase orders.

The Issued date andBatch number displays in the lower left-hand corner of each purchase order window.

Retracting purchase orders

You can retract an individual purchase order.

To retract a purchase order:

1 Open 6-6-1 Purchase Orders.

2 Select thePurchase Order you want to retract.

3 On theOptionsmenu, click Retract this Purchase Order.

4 The Issued date andBatch number will clear in the lower left-hand corner of the window.

Retracting batches of purchase orders

You can retract a batch of purchase orders. Note that printing from thePurchase Order Retract Batchwindow displays
thePurchase Order Retract Batch report.
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To retract a batch of purchase orders:

1 Open 6-6-1 Purchase Orders.

2 Select and open any purchase order record.

3 On theOptionsmenu, click Retract Purchase Order Batch.

4 ThePurchase Orders Retract Batchwindow appears.

5 In theBatch# box, enter the batch number you want to retract, and click Display.

6 Review the window to confirm the selected purchase orders should be retracted.

7 Double-click in theRetract column to select and clear records.

8 Double-click in any other cell in a row to display a purchase order for review.

9 Select a row and click Go to PO to display the selected purchase order.

10 Confirm that the appropriate purchase orders are selected for retraction.

11 Click Save to retract the purchase orders.

12 The Issued date andBatch number will clear in the lower left-hand corner of each purchase order window.

NOTE: Printing from thePurchase Order Retract Batchwindow displays thePurchase Order Retract Batch
report.

Voiding purchase orders

Be aware that voiding a purchase order does not impact the accounting records.

To void a purchase order:

1 Open 6-6-1 Purchase Orders.

2 Using the data control, select the record.

3 In theStatus list, click 5-Void.

Canceling ordered items

To cancel an ordered item:

Open 6-6-1 Purchase Orders.

Select the purchase order.

In theCanceled cell, enter the quantity you want to cancel.

On the Filemenu, click Save.

Deleting purchase orders

To delete a purchase order:

1 Open 6-6-1 Purchase Orders.

2 Using the data control, select the record.

3 On theOptionsmenu, click Delete.
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Opening job schedules when purchase order dates change

A command in thePurchase Orderwindow can be activated to automatically give you the option of opening and editing a
job’s schedule if theScheduled date for a purchase order for that job changes.

The following criteria must be in place for this command to work:

l A jobmust be specified on the purchase order.

l A task must be specified on the purchase order.

l A schedulemust be entered and saved for the same job andmust include the same task as specified on the
purchase order.

To open a job’s schedule when purchase order dates change:

1 Open 6-6-1 Purchase Orders.

2 Select thePurchase Order for which you want to activate the option.

3 On theOptionsmenu, click Open Job Schedule When PO Scheduled Date Changes.

4 On the Filemenu, click Save.

5 If a change is now made to theScheduled box, amessage displays offering you the option of opening and editing the
corresponding schedule.

Master Purchase Orders
About master purchase orders

To control the ordering and arrival of materials at a job site, use amaster purchase order. Think of themaster purchase
order as a contract with the vendor, which lists all thematerials you intend to purchase over the course of the project. You
might even supply each of your vendors with copies of themaster orders.

From themaster, you create smaller purchase orders for thematerials necessary to complete the next series of tasks. The
master tracks the total quantity of items ordered and cancelled for a particular vendor and job. After creating themaster
purchase order, you can create all the smaller purchase orders to ensure you have accounted for all materials on themaster
purchase order. You then only need to assign the appropriate delivery dates and print the purchase orders as you need
them.

Creating master purchase orders

To create a master purchase order:

1 Open 6-6-1 Purchase Orders.

2 Create the purchase order.

3 In theStatus list, click 6-Master.

Creating purchase orders from masters

To create a purchase order from a master:

1 Open 6-6-1 Purchase Orders.

2 Select themaster purchase order.

3 In theCurrent column, enter the part quantities you want to order at this time.

4 On theOptionsmenu, click Create New Order.
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Sage 100 Contractor automatically creates the purchase order, assigns a record number, and displays it.

6-6-2 Purchase Order List
About 6-6-2 Purchase Order List

Clicking 6-6-2 Purchase Order List launches the 6-6-2 Report Printingwindow for printing PurchaseOrder List reports
and viewing sample reports.

6-6-3 Purchase Order Audit
About 6-6-3 Purchase Order Audit

Clicking 6-6-3 Purchase Order Audit launches the 6-6-3 Report Printingwindow for printing PurchaseOrder Audit
reports and viewing sample reports.

6-6-4 Purchase Order Materials
About 6-6-4 Purchase Order Materials

Clicking 6-6-4 Purchase Order Materials launches the 6-6-4 Report Printingwindow for printing PurchaseOrder
Materials reports and viewing sample reports.

6-7 Subcontracts

6-7-1 About Subcontracts
About subcontracts

Many general contractors enter into subcontracts with other contractors to perform specific types of work. In the 6-7-1
Subcontractswindow, you can create subcontracts, review change work and invoices that affect subcontracts, and gain
tighter control of subcontract billings. You can export items from a takeoff to create subcontracts automatically, or you can
enter the subcontracts manually.

When using phases tomanage larger projects, look at the amount of work a subcontractor is providing and determine
whether you want to create a single subcontract for the entire job or a subcontract for each phase within the job. If the
amount of work is relatively small or does not vary from phase to phase, it might be easier to create a single subcontract.
For large amounts of work, or if the complexity of work varies between phases, consider creating a subcontract for each
phase.

From a takeoff, you can export items assigned status 4-Subcontract by job, or by job and phase.

l When you export the subcontracts by job, Sage 100 Contractor creates a subcontract that lists each phase in which
the subcontractor performs work.

l When you export the subcontracts by job and phase, Sage 100 Contractor creates a separate subcontract for each
phase in which the subcontractor performs work.

Subcontracts work in conjunction with change orders and accounts payable invoices, providing you with better control over
change work and billing. You can review billings, approved and open change orders, or a summary of the subcontract
information, including a line-by-line summary of the invoiced amounts. You can also set up retention for a subcontract.
When you create an invoice for the subcontract, Sage 100 Contractor uses the rate indicated in the subcontract record.
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About subcontract status

The subcontract status lets you follow the condition of a subcontract. You can change the status of a subcontract record at
any time.

NOTE: TheSubcontract Status list is not editable. The six existing subcontract statuses are defaults for the
program.

Status Description

1-Bid You are currently accepting bids from subcontractors.

2-Refused A subcontractor's bid that has been refused.

3-Contract You have awarded the contract to the subcontractor, but
they have not begun work.

4-Current Work is in progress on the contracted work.

5-Complete The subcontractor has completed work.

6-Closed The subcontractor has been paid in full for all contracted
work.

Status 2-Refused has no impact on reporting.

Entering subcontracts

When entering a subcontract, you can save it without entering values or data in all the boxes. Only boxes with blue titles are
required. During the active life of the subcontract, youmay need to enter values or data in other boxes as its status
changes. For example, if you are going to invoice a subcontract or part of a subcontract, youmay need to enter data in the
Contract Date box, Retention box, or other boxes.

When working in the 6-7-1 Subcontracts grid, you can enter values or data in several ways. For example, if you click in a
cell, you can type in it. Some grid cells are also linked to Quick Lists and lookup windows. Click the drop-down arrow to
open the window and select items from the list. When the program is set up with descriptions, cost codes, and cost types,
the grid autofills with default values when you press the Enter key tomove through the grid cells.

To enter a subcontract:

1 Open 6-7-1 Subcontracts.

2 In the Job box, enter the job number.

3 If the job uses phases, enter the phase number in thePhase box.

4 In theVendor box, enter the vendor number of the subcontractor performing the work.

5 In theSubcontract# box, enter the subcontract number. If you leave theSubcontract# box blank, Sage 100 Contractor
enters the next contract number for you.

6 In theDescription box, enter a brief statement about the subcontract, for example, Electrical work.

7 In theCost Division text box, enter a cost division using the lookup window, and then press the Enter key.

8 (Optional) In theUser Def1 andUser Def2 text boxes, enter the user-defined information as necessary.

9 In theContract Date box, enter the date when the contract begins.

10 Do any of the following, as needed:

a In theApproved box, enter the date the subcontract was approved.
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b In theScheduled Start box, enter the date the subcontract is scheduled to begin.

c In theScheduled Finish box, enter the date the subcontract is scheduled to end.

d In theActual Start box, enter the date the subcontract actually started.

e In theSubst Complete box, enter the date whenmost of the work is to be completed.

f In theActual Finish box, enter the date when the subcontract is to be completed.

11 From the drop-down list of statuses, select a status, or accept the default status.

12 In the Type drop-down list, select the type of order, for example, Electrical, Plumbing, and so forth.

g InPref Bond, Bid Bond, andRetention boxes enter values.

13 In lines in the grid, do the following:

a In theDescription cell, type a description, or enter a description using the Quick List, and then press the Enter key.

b In theCost Code cell, type a cost code, or enter a cost code using the lookup window, or accept the default cost
code, and then press the Enter key.

c In theCost Type cell, type a cost type, or enter a cost type using the lookup window, or accept the default cost type,
and then press the Enter key.

d In theOriginal Contract cell, enter the dollar amount of the subcontract or part of the subcontract.

14 Repeat steps 10-11 for each item in the subcontract.

15 On the Filemenu, click Save.

Entering the settings for Subcontract Over Budget Warnings

TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select theSet
Subcontract Over Budget Warnings option, Sage 100 Contractor determines the Actual + Committed costs to date for
the job and phase by cost code and cost type.

It then compares the data to the original budget plus approved change orders. When you save the record, Sage 100
Contractor notifies you if costs exceed the budget plus approved change orders for a job and phase, cost code and cost
type, plus the tolerance.

NOTES:
l When Subcontracts are exported from 9-5 Takeoffs, the warning that the subcontract exceeds the budget

amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. We
recommend that after exporting subcontracts you should run the 6-1-12-21 Committed Costs report for the
correct job to verify that subcontracts have not exceeded the budget.

l If you decreased a grid line but the subcontract is still over budget, the Subcontract Over Budget warning will
not display a second time when the record saves. To get the warning a second time, increase one of the
amounts or quantities in the grid.

Example: Using the Flat Amount with Warning

Message Type Warning

Tolerance Type Flat amount

Tolerance Amount $100

Tolerance Percent N/A

Tolerance Amount Not To Exceed N/A
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To set the Over Budget Warning
1 In 6-7-1 Subcontracts, select Options > Set Over Subcontract Warning.

2 In theMessage Type dropdown, the choices aremutually exclusive. Select one of the following:

a Nomessage—nomessage is generated. All options for tolerance are grayed out.

b Warning—awarning and/or alert is generated, but you are allowed to save the record.

c Not allow—awarning and/or alert is generated, but you are not allowed to save the record.

3 If you selectWarning orNot Allow, youmust select one of the following choices in the Tolerance Type dropdown:

a No tolerance

b Flat amount

c Percent

d Percent/not to exceed

4 Once a Tolerance Type has been selected, enter the applicable amount or percent for the type:

a Flat amount: Enter the amount in the Tolerance Amount text box.

b Percent: Enter the percent in the Tolerance Percent text box.

c Percent/not to exceed: Enter the percent of the budget plus approved changes by job, phase, cost code, and cost type
allowed in the Tolerance Percent text box, and the amount of tolerance in the Tolerance Amount Not To Exceed
text box.

5 Click OK.

Reviewing subcontracts

You can review a summary of a subcontract.

To review a subcontract:

1 Open 6-7-1 Subcontracts.

2 Select the subcontract.

3 On theOptionsmenu, click Summary.

Reviewing subcontract invoices

You can review a summary of payable invoices for a subcontract.

To review a subcontract invoice:

1 Open 6-7-1 Subcontracts.

2 Select the subcontract.

3 On theOptionsmenu, click Invoices.

Reviewing subcontract change orders

You can review a summary of change orders for subcontracts that are not rejected or void.

To review a summary of change orders for a contract:

1 Open 6-7-1 Subcontracts.

2 Select the subcontract.
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3 On theOptionsmenu, click Changes.

Releasing retention for subcontracts

To release retention for a subcontract:

1 Open 6-7-1 Subcontracts.

2 Select the subcontract.

3 In theRetention box, do one of the following:

p Enter the new rate of retention.

p Leave the box blank for zero retention.

4 On theOptionsmenu, click Recalculate Retention.

5 In theNew Due Date for Invoices box, enter the due date you want to assign the invoices.

6 UnderRecalculation Option, do one of the following:

p Select to updateOnly invoices with Retention, or

p Select to updateAll invoices.

7 Click OK.

8 On the Filemenu, click Save.

Setting up subcontract types

You can create a list of subcontract types, allowing you to categorize your subcontracts. A general contractor, for example,
might create types to track electrical, plumbing, and roofing subcontractors.

The following is an example of subcontract types:

Subcontract Type # Type Name

1 Flooring

10 Fireplace

16 Electrical

17 Plumbing

20 Sitework

29 Landscape

30 Concrete

40 Masonry

50 Steel

To set up subcontract types:

1 Open 6-7-1 Subcontracts.

2 Next to the Type list, click the detail button.

3 In theSubcontract Type# cell, enter the type number.

4 In the Type Name cell, enter a description of the purchase type.



- 383 -

5 Repeat steps 3–4 for each type.

6 On the Filemenu, click Save.

Deleting subcontracts

IMPORTANT:
You cannot delete a subcontract record if it already has an invoiced or changed amount.

You cannot delete a grid line if it already has an invoiced or changed amount.

To delete a subcontract:

1 Open 6-7-1 Subcontracts.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Subcontract.

6-7-2 Print Subcontracts
About 6-7-2 Print Subcontracts

Clicking 6-7-2 Purchase Order List launches the 6-6-2 Report Printingwindow for printing Print Subcontracts reports
and viewing sample reports.

6-7-3 Subcontract List
About 6-7-3 Subcontract List

Clicking 6-7-3 Subcontract List launches the 6-7-3 Report Printingwindow for printing Subcontract List reports and
viewing sample reports.

6-7-4 Subcontract Audit
About 6-7-4 Subcontract Audit

Clicking 6-7-4 Subcontract Audit launches the 6-7-4 Report Printingwindow to be used to for printing Subcontract Audit
reports and viewing sample reports.

6-8 Cost-to-Complete

6-8-1 About cost to complete
About cost to complete

CAUTION: TheCost to Complete report relies on accurate and up-to-date job costs. Be sure to post all job costs
and enter any recent change orders before updating the report.

In the 6-8-1 Cost to Completewindow, you can generate a report estimating the costs necessary to complete a project
currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves the
current budget, job costs, and the gross wages for uncomputed payroll records. Over the course of the project, you can
update the current budget and job costs in theCost to Completewindow to create a new report.

Enter the estimated percent of work completed or costs to complete the project, and calculate the report. If you provide the
percent of work completed, Sage 100 Contractor computes an estimate of the remaining costs to complete the project and
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the amount by which you are over or under budget. If you provide the estimated costs to complete the project, Sage 100
Contractor computes the percent of work completed and the amount over or under budget.

While the computed payroll records include the labor burden, the gross wages for uncomputed payroll records do not. To
increase the accuracy of the report, you can provide a labor burden rate, which Sage 100 Contractor uses to calculate and
add in the estimated labor burden for uncomputed payroll records.

Entering the costs to complete jobs

To enter the costs to complete a job:

1 Open 6-8-1 Cost to Complete.

2 Using the data control, select the job.

3 If you have job phases, in thePhase list, click the phase.

NOTE: Youmust select and update each phase separately.

4 In the Labor Burden box, enter the rate of labor burden.

5 On themenu bar, click Options, and thenUpdate.

6 Select a cost code.

7 In theCost to Complete cell, enter the remaining costs to complete the work.

IMPORTANT: Do not enter values in both theCost to Comp andActual Percent columns.

8 Repeat steps 6–7 for each cost code.

9 On theOptionsmenu, click Percentage from Cost to Complete.

10Edit the record, and recalculate if necessary.

11On the Filemenu, click Save.

Entering the percentage of work completed on jobs

To enter the percent of work completed on a job:

1 Open 6-8-1 Cost to Complete.

2 Using the data control, select the job.

3 In thePhase list, click the phase. Youmust select and update each phase separately.

4 In the Labor Burden box, enter the rate of labor burden.

5 On themenu bar, click Options, and then click Update.

6 Select a cost code.

7 In theActual Percent cell, enter the percent of work actually completed.

IMPORTANT: Do not enter values in both theCost to Comp andActual Percent columns.

8 Repeat steps 6–7 for each cost code.

9 On theOptionsmenu, point toCalculate, then click Cost to Complete from Percentage.

10 Edit the record, and recalculate if necessary.

11 On the Filemenu, click Save.
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Updating Cost to Complete reports

To update a Cost to Complete report:

1 Open 6-8-1 Cost to Complete.

2 Using the data control, select the job.

3 In thePhase list, click the phase. Youmust select and update each phase separately.

4 On theOptionsmenu, click Update.

ApplyingLabor Burden in 6-8-1 Cost to Complete

Labor burden refers to job-related payroll overhead costs. These employer-incurred costs are in addition to the direct wages
and include taxes, insurance, and benefits. The additional costs for labor burden can account for up to 35% of the total
wages.

To apply the labor burden in Cost to Complete:

1 Open 6-8-1 Cost to Complete, and open a job.

2 In the Labor Burden box, type the percentage that you want to have applied.

3 From theOptionsmenu, select one of the calculationmethods, then save the record.

4 From theOptionsmenu, select Update.

5 To themessage, click Yes.

Deleting Cost to Complete reports

To delete a Cost to Complete report:

1 Open 6-8-1 Cost to Complete.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Cost/Complete.

6-8-2 Hours to Complete
About hours to complete

In theHours to Completewindow, you can generate a report estimating the number of hours necessary to complete a
project currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves
the current budget, job costs, and the gross wages for uncomputed payroll records. Over the course of the project, you can
update the current budget and job costs in theHours to Completewindow to create a new report.

CAUTION: TheHours to Complete report relies on accurate and up-to-date job costs. Be sure to post all job costs
and enter any recent change orders before updating the report.

Enter the percent of hours completed or estimated hours to complete the project, and calculate the report. If you provide the
percent of hours completed, Sage 100 Contractor computes an estimate of the remaining hours to complete the project and
the amount by which you are over or under budget. If you provide the estimated hours to complete the project, Sage 100
Contractor computes an estimate of the percent of hours completed and the amount by which you are over or under budget.

Entering the hours to complete jobs

To enter the hours to complete a job:

1 Open 6-8-2 Hours to Complete.
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2 Using the data control, select the job.

3 In thePhase list, click the phase.

Youmust select and update each phase separately.

4 On themenu bar, click Update.

5 Select a cost code.

6 In theHours to Complete cell, enter the remaining hours to complete the work.

7 Repeat steps 6–7 for each cost code.

8 Edit the record if necessary.

9 On the Filemenu, click Save.

Entering the percentage of hours completed on jobs

To enter the percentage of hours completed on a job:

1 Open 6-8-2 Hours to Complete.

2 Using the data control, select the job.

3 In thePhase list, click the phase.

NOTE: Youmust select and update each phase separately.

4 On themenu bar, click Update.

5 Select a cost code.

6 In theActual Percent cell, enter the hours of work actually completed.

7 Repeat steps 5–6 for each cost code.

8 Edit the record if necessary.

9 On the Filemenu, click Save.

Updating Hours to Complete reports

To update an Hours to Complete report:

1 Open 6-8-2 Hours to Complete.

2 Using the data control, select the job.

3 In thePhase list, click the phase.

NOTE: Youmust select and update each phase separately.

4 On themenu bar, click Update.

Deleting Hours to Complete reports

To delete an Hours to Complete report:

1 Open 6-8-2 Hours to Complete.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Hours/Complete.
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6-8-3 Units to Complete
About units to complete

In the 6-8-3 Units to Completewindow, you can generate a report to review the number of units to complete on a project
currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves the
current budget. Over the course of the project, you can update the current budget in theUnits to Completewindow to
create a new report.

You can enter the estimated units completed and calculate the report. Sage 100 Contractor computes the budgeted cost
per unit, the actual cost per unit, and the units by which you are over or under budget.

Entering the estimated number of units to complete jobs

To enter the estimated number of units to complete a job:

1 Open 6-8-3 Units to Complete.

2 Using the data control, select the job.

3 In thePhase list, click the phase.

NOTE: Youmust select and update each phase separately.

4 On themenu bar, click Update.

5 Select a cost code.

6 In theUnits Complete cell, enter the units of work actually completed.

7 Repeat steps 5–6 for each cost code.

8 Edit the record if necessary.

9 On the Filemenu, click Save.

Updating Units to Complete reports

To update a Units to Complete report:

1 Open 6-8-3 Units to Complete.

2 Using the data control, select the job.

3 In thePhase list, click the phase.

NOTE: Youmust select and update each phase separately.

4 On themenu bar, click Update.

Deleting Units to Complete reports

To delete a Units to Complete report:

1 Open 6-8-3 Units to Complete.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Units/Complete.
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6-9 Proposals

About proposals
The proposal is a document presented to a client, providing a breakdown of the contracted amount by cost code or bid item.
Sage 100 Contractor provides several ways to create a proposal: you can export the data from a takeoff, import a budget,
import a file, or create a proposal manually. After the proposal is completed, you can set the original proposal. After
negotiating the price with your client, you can edit the current proposal and compare it with the original.

If it becomes necessary to adjust the selling price in a proposal, enter the changes by issuing change orders. Change
orders allow you to alter the selling price independent from the proposal itself.

About creating proposals
There aremany ways to create proposals—from entering the cost codes or bid items manually, to selecting a list of cost
codes or bid items in aPicklist, to importing a budget or file. Furthermore, you can export a takeoff to create a proposal by
bid item or cost code.

While it is faster and easier to import a proposal, you can also build a proposal manually by entering the individual cost
codes and amounts for each cost type, including the overhead and profit.

Creating proposals from budgets
To create a proposal from a budget:
1 Open 6-9 Proposals.

2 Using the data control bar, select a specific job.

IMPORTANT:
Only four of the buttons in the data control activate areas in 6-9 Proposals: First, Previous, Next, and Last.

TheDisplay Lookup drop-down arrow displays theAccounts Receivable Lookupwindow, and the detail button
displays the 3-5 Jobs (Accounts Receivable)window.

3 In thePhase list, click the phase.

4 UnderProposal Basis, click Cost Codes.

5 On theOptionsmenu, point to Import and click Budget.

6 In theOverhead/Profit by Cost Type dialog box, enter the overhead and profit rates for each cost type. Then click OK.

7 Adjust the individual amounts to reflect what you want to charge the client.

8 On the Filemenu, click Save.

TIPS:
l To reapply the overhead and profit rates, delete the current proposal and import the budget again.

l If you anticipate changes and want to preserve the current proposal, set the original proposal.

Creating proposals from bid items
To create a proposal from bid items:
1 Open 6-9 Proposals.
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2 Using the data control, select the job.

3 If the job uses phases, in thePhase drop-down list, select the phase.

4 Select Use Bid Items for proposal lines.

5 In theBid Items cell, right-click, then click Display Picklist Window.

6 Create aPicklist of bid items, and click the check mark button to insert them into the grid.

7 For each bid item, enter the proposed amounts (including the overhead and profit) for each cost type.

8 Set the original proposal.

9 On the Filemenu, click Save.

Creating proposals from cost codes
To create a proposal from cost codes:
1 Open 6-9 Proposals.

2 Using the data control, select the job.

3 If the job uses phases, in thePhase drop-down list, select the phase.

4 Select theUse Cost Codes for proposal lines option.

5 In aCost Code cell, right-click, then click Display Picklist Window.

6 Create aPicklist of cost codes, and click the check mark button to insert the list of cost codes into the grid.

7 For each cost code, enter the proposed amounts (including the overhead and profit) for each cost type.

8 Set the original proposal.

9 On the Filemenu, click Save.

Setting the original proposal
When you set the original proposal, Sage 100 Contractor copies the proposal information to theOriginal columns. With the
proposal preserved, you can compare it to the current proposal. The original proposal information is for reference only.

To set the original proposal:
1 Create the proposal.

2 On theOptionsmenu, click Set Proposal.

About displaying a proposal recap
You can display a cost code, bid item, or phase summary of the proposal for review before printing the final proposal. The
cost code recap summarizes the cost types for each cost code across the job phases. The bid item recap summarizes the
bid items across the job phases. The phase recap summarizes the cost types in each phase.

Rounding up amounts
After creating a proposal, you can round amounts up to the nearest $1, $10, or $100. Sage 100 Contractor rounds up all bid
amounts across all phases.

To round up amounts, on theOptionsmenu, point toRound Up Amounts, and then click the amount by which you want
to round up.
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Deleting proposals
To delete a proposal:
1 Open 6-9 Proposals.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Proposal.

Exporting and Importing Proposal Files
About exporting and importing files

Files save you time performing repetitious work by providing the structure for documents such as budgets or proposals.
You can create files that provide only a brief outline or contain nearly complete information or anywhere in between.

Suppose that you are building homes in a residential subdivision. Because there is only onemodel of home, the basic
budget for each home does not change. Rather than re-entering the same budget information for each home you intend to
build, you can create a file from the first budget. Then for each new home, import the budget file and enter any minor
modifications to suit the needs of that particular project.

If the subdivision contains four different models of homes, you can create four budget files. When you begin work on a new
home, import its budget file for the particular model andmodify it as needed.

Perhaps you do a great deal of home construction, and one budget cannot accurately reflect somany different projects. You
can create a budget file that only contains a list of cost codes. When you import the budget file, you can enter the
appropriate figures as dictated by the job.

When creating a file, either you can use an existing record as the basis for the file, or you can build the file from scratch.

Exporting proposal files

You can create a file from an existing proposal. Sage 100 Contractor only creates a file for the currently displayed grid. Files
are specific to the company in which you save them.

To export a proposal file:

1 Open 6-9 Proposals.

2 In the data control box, enter the job number for the proposal that you want to use.

3 In thePhase list, click the phase, then edit the content of the phase.

4 On theOptionsmenu, point toExport, and then click Proposal File.

5 Name the file, and click Save.

TIP: Instead of using a proposal from an existing job, you can create a new proposal.

Exporting proposal grid files

Be aware that Sage 100 Contractor only creates a file for the currently displayed grid and that files are specific to the
company in which you save them.

To export a proposal grid file:

1 Open 6-9 Proposals.

2 In the data control, click the drop-down arrow to display a Lookupwindow with a list of jobs.
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3 Double-click the job from which you want to make a proposal.

4 Data from the job populates the grid.

5 If you are exporting a proposal for aPhase, select the phase.

6 On theOptionsmenu, point toExport, then click Grid File.

7 TheExport template proposal grid file opens.

8 Name the file, and click Save.

TIP: Instead of using a proposal from an existing job, you can create a new proposal.

Importing proposal files

To import a proposal file:

1 Open 6-9 Proposals.

2 In the data control box, enter the job number of the job for which you want to create a proposal.

3 On theOptionsmenu, point to Import, then click Proposal File.

4 Select the file that you want to import, and click OK.

IMPORTANT: When you import a file, the file writes over any data already contained in the grid.

6-10 Unitary Proposals

About unitary proposals
The proposal is a document presented to a client, providing a breakdown of the contracted amount by bid item. There are
two ways to create a unitary proposal: you can import a file, or you can create a proposal manually. After the proposal is
completed, you can set it as the original. After negotiating the price with your client, you can edit the current proposal while
retaining the original.

If it becomes necessary to adjust the selling price in a proposal, you enter the changes by issuing change orders. Change
orders allow you to alter the selling price independent from the proposal itself.

Creating unitary proposals
To create a unitary proposal:
1 Open 6-10 Unitary Proposals.

2 Using the data control, select the job.

3 If relevant, in thePhase list, click the phase.

4 In a bid list cell, right-click, then click Display Picklist Window.

5 Create aPicklist of bid items, and then click the check mark button to insert them into the grid.

6 In the grid, do the following:

a In theUnit cell, enter the unit of measurement.

b In theQuantity cell, enter the quantity of units of work to be performed.

c In theUnit Price cell, enter the cost per unit (including the overhead and profit).

7 Repeat step 6 for each item.
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8 On the Filemenu, click Save.

TIP: If you anticipate changes and want to preserve the current proposal, set the original proposal.

Deleting unitary proposals
To delete a unitary proposal:
1 Open 6-10 Unit Proposals.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Proposal.

About displaying a unitary proposal recap
You can display a bid item or phase summary of the proposal for review before printing the final unitary proposal. The bid
item recap summarizes the bid items across the job phases. The phase recap summarizes the cost types in each phase.

Exporting and Importing Unitary Proposal Files
Exporting unitary proposal files

You can create a file from an existing proposal.

IMPORTANT: Files are specific to the company in which you save them.

To export a unitary proposal file:

1 Open 6-10 Unitary Proposals.

2 In the data control box, enter the job number for the proposal that you want to use.

3 In thePhase list, click the phase. Edit the content of the phase as needed.

4 On theOptionsmenu, point toExport, and click Proposal File.

5 Name the file, and click Save.

TIP: Instead of using a proposal from an existing job, you can create a new proposal.

Exporting unitary proposal grid files

You can create a file from an existing unitary proposal.

IMPORTANT:
l Sage 100 Contractor only creates a file for the currently displayed grid.

l Files are specific to the company in which you save them.

To export a unitary proposal grid file:

1 Open 6-10 Unitary Proposals.

2 In the data control box, enter the job number for the proposal that you want to use.

3 If the job uses phases, in thePhase list, select the phase.

4 On theOptionsmenu, point toExport, then click Unitary Proposal File.
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5 Name the file, and click Save.

TIP: Instead of using a proposal from an existing job, you can create a new proposal.

Importing unitary proposal files

IMPORTANT: When you import a file, the file writes over any data already contained in the grid.

To import a unitary proposal file:

1 Open 6-10 Unitary Proposals.

2 In the data control box, enter the job number of the job for which you want to create a proposal.

3 On theOptionsmenu, point to Import, then click Unitary Proposal File.

4 Select the file that you want to import, and click OK.

6-11 Document Control

About document control
This functionality is available only if you have the Document Control Module.

Sage 100 Contractor’s Document Controlmodule provides complete control of all your project management documents.
These include Requests for Information (RFIs), Requests for Proposal (RFPs), transmittals, submittals, daily field reports,
and correspondence.

Document Control tools help youmanage correspondence, keep track of project plans, maintain a project hot list, and
stay on top of punch list items. A customizable templatemakes daily field reports accurate and accessible.

When using the functionality of Document Control, all your documents integrate with estimating, change orders, purchase
orders, subcontracts, and payroll. This makes the process of project management complete, fast, accurate, and reliable.

6-11-1 Requests for Proposal
About Request for Proposal

A Request for Proposal (RFP) is a document you send to vendors or subcontractors containing a list of parts needed or
work to be performed. The vendor or subcontractor uses the RFP to create a proposal for you. Look for menu 6-11-1
Request for Proposal.

TIP: You can set up RFPs to be numbered sequentially with an association to a job and phase.

About RFP and RFI numbering by job and phase

Sage 100 Contractor supports RFP and RFI numbering by job, and if the job has phases, by job and phase. This feature
makes it easier to keep track of RFIs and RFPs because they are associated with the job in which they were initiated.

Because this is a new feature, when you first open the 6-11-1 Requests for Proposal or 6-11-2 Requests for
Informationwindows after an upgrade installation, the program displays a default setting window with instructions for
changing the RFP (Request# box) and RFI (RFI# box) default setting toNext by Job default instead of the previous default
setting of Next.

TIP: With new installations, the default setting is Next by Job and the program does not display this window.

The following table describes the actions of each button on the default settings window when you click it.

http://www.na.sage.com/sage-100-contractor/modules/project-management
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Button Action

Yes Changes the default setting forRequest# orRFI#
to Next by Job.

No Retains Next as the default setting.

Ask Me Later

Retains Next as the default setting, but the
program prompts you tomake a selection by
displaying the default settings window each time
you open either 6-11-1 Requests for Proposal or
6-11-2 windows.

Help Opens this Help topic.

Rules for using RFP/RFI Numbering by Job

The program uses this functionality using specific rules. Following are some ideas to keep inmind.

l When beginning a new numbering scheme for your RFP/RFIs, type a pattern like this [number][hyphen][number]
(without brackets), for example, 216-1, with 216 representing the job number and 1 representing the first RFP or RFI
record. When creating the next new RFP or RFI record, the program looks for the final hyphen (—) and increments
the number following the it by 1 in the new record, for example, 216-2, 216-3, and so forth.

l Numbering for jobs with phases could look like this: 216-1-1, 216 for the job, 1 for phase, and 1 for the first RFP or
RFI. This numbering schemewould increment to 216-1-2, 216-1-3 automatically in new records.

l If 216-1-3 were the last RFI or RFP for phase 1, then when you create the next RFP or RFI record, the program
would insert 216-1-4. Youmust replace the -1- with -2- to represent phase 2. The result would look like this: 216-2-4.
The program then increments the subsequent new records to 216-2-5, 216-2-7, and so forth.

l In the numbering scheme described above, the program increments the number that it finds after the final hyphen. If
you do not type a hyphen as part of the entry, the program increments the number by 1. For example, the number 216
increments to 217.

IMPORTANT: To increment the numbering, the program looks for the final number in a series of numbers preceded
by a hyphen. The program does not recognize an alpha character preceded by a hyphen in the final position and will
not increment it, for example from “a” to “b.”We strongly recommend that you use an “all-number” numbering scheme.

Creating RFPs

When creating an RFP, youmust enter information in the boxes with blue titles to be able to save it. Entering information in
the other boxes is optional, but we recommend entering additional information for legal traceability. During the life of this
document, youmay enter information several times for tracking purposes, such as when you receive information back
regarding this RFP.

NOTE: To use RFP numbering by job, click once in theRequest# box and press the F7 key. On the Field
Propertieswindow, verify that the setting is Next by Job, or change the setting from Next toNext by Job.

To create an RFP:

1 Open 6-11-1 Request for Proposal.

2 In the Job box, enter the job for which you are requesting the proposal.

3 If the job uses phases, enter the phase number in thePhase box.

4 In theRequest# box, accept the number auto-filled by the program, or type a numbering scheme that works for your
needs, for example “job number”—(phase number, if used)—RFP number, 216-1-1.
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5 In theDatebox, accept the default date or type a new one.

6 In theVendor box, enter the vendor from whom you are requesting the proposal.

7 In theDescription box, enter a brief statement about the proposal.

8 As needed, do any of the following:

a In theRequest by box, enter the employee who is creating the request (optional but recommended).

b In theStatus list, click the request status.

c In the Type list, click the request type (optional but recommended).

9 As needed, in the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity (optional but recommended).

c In thePrice cell, enter the price of the item (optional but recommended).

10 On the Filemenu, click Save.

IMPORTANT: Four date boxes are available for storing pertinent information related to the RFP:

l Prices Rec’d: Enter the date that you receive the proposal pricing.

l Prices Expire: Enter the date upon which the proposal pricing will expire.

l Approved: Enter the date the proposal was approved.

l Delivery: Enter the date the proposal was delivered.

Creating purchase orders from RFPs

To create a purchase order from an RFP:

1 Open 6-11-1 Requests for Proposal.

2 Using the data control, select the record.

3 On theOptionsmenu, click Create Purchase Order.

Setting up RFP types

You can create a list of Request for Proposal types, allowing you to categorize the RFPs. The following is an example of
Request for Proposal types:

Request Type # Type Name

1 Materials

2 Equipment

3 Subcontract

4 Other

To set up RFP types
1 Open 6-11-1 Requests for Proposal.

2 Next to the Type list, click the detail button.

3 TheRFP Typeswindows appears.

4 In theRequest Type# box, enter the type number.
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5 In the Type Name box, enter the type name.

6 On the Filemenu, click Save.

Deleting RFPs

To delete an RFP:

1 Open 6-11-1 Requests for Proposal.

2 Using the data control, select the record.

3 On theEditmenu, click Delete RFP.

6-11-2 Requests for Information
About Requests for Information

A request for information (RFI) is a document you send to general contractors, architects, or engineers asking for
information. When you receive the information, you can include it in the RFI record. There is a business advantage to
adding information about clients or vendors. When you enter such information on a request for information, the document is
legally traceable.

The entry in theClient box andVendor box on the 6-11-2 Requests for Informationwindow aremutually exclusive. On a
new request for information record when you enter a client, the vendor entry is cleared and the client address and contact
name are automatically placed into theAttention box andAddress boxes. Also on a new record, when you enter a vendor,
the client information is cleared and replaced with the vendor information.

TIPS:
l To check spelling, click in the text entry areas and then press the F7 key. On the Field Properties Text

window, select theCheck Spelling check box and click OK.

l You can set up RFIs to be numbered sequentially with an association to a job and phase.

Creating RFIs

When creating an RFI, youmust enter information in the boxes with blue titles to be able to save it. Entering information in
the other boxes is optional, but we recommend entering client or vendor information for legal traceability. During the life of
this document, youmay enter information several times for tracking purposes, such as when you receive information back
regarding this RFI.

NOTE: To use RFI numbering by job, click once in theRFI# box and press the F7 key. On the Field Properties
window, verify that the setting is Next by Job, or change the setting from Next toNext by Job.

To create an RFI:

1 Open 6-11-2 Request for Information.

2 In the Job box, enter a job.

3 If the job uses phases, enter the phase number in thePhase box.

4 In theRFI# box, accept the number auto-filled by the program, or type a numbering scheme that works for your needs, for
example “job number”—(phase number, if used)—RFP number, 216-1-1.

5 In theDivision box, enter the division (optional).

6 In theDescription box, enter a brief statement about the request.

7 In theClient orVendor box, enter a client or vendor (optional but recommended).
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8 Do any of the following (optional):

a In theAttention box, enter the name of the person whom you want to be informed.

b If no address information has been entered automatically by the program in theAddress, City, State, and Zip text
boxes, enter address information.

9 Select theHot List and Lock Edit check boxes.

10 In theStatus box, select a status.

11 Do any of the following (optional):

a In theRFI Type box, select the RFI type.

b In theRequest by box, select or enter the employee number.

c In theAnswered by box, select or enter a name.

d In theRequired, Returned, andApproved boxes, enter dates.

e In theDate box, enter the date or accept the default date.

12 In the Information Requested box, enter your request for additional information.

13 Select any of the following (optional):

a Plan Change

b ChangeOrder

c Schedule Change

14 In the Information Supplied box, enter information (optional).

15 On the Filemenu, click Save.

TIPS:
l When the request is returned, enter the date in theReturned box. Then enter the information provided in the

Information Supplied box.

l When the request is approved, enter the date in theApproved box.

Setting up RFI types

You can create a list of RFI types, allowing you to categorize the RFIs. The following is an example of RFI types:

RFI Type # Type Name

1 Initial Request

2 Second Request

3 Change Request

To set up RFI types
1 Open 6-11-2 Requests for Information.

2 Next to theRFI Type list, click the detail button.

3 In theRFI Type# box, enter the type number.

4 In the Type Name box, enter a description of the type.

5 On the Filemenu, click Save.
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Deleting RFIs

To delete an RFI:

1 Open 6-11-2 Requests for Information.

2 Using the data control, select the record.

3 On theEditmenu, click Delete RFI.

6-11-3 Transmittals
About transmittals

A transmittal is a cover sheet that lists all the documents being sent. The individual to whom you sent the documents signs
the transmittal as proof that all the items were received.

There is a business advantage to adding information about clients or vendors. When you enter such information on a
transmittal, the document is legally traceable.

The entry in theClient box andVendor box on the 6-11-3 Transmittal window aremutually exclusive. On a new
transmittal record when you enter a client, the vendor entry is cleared and the client address and contact name are
automatically placed into theAttention box andAddress boxes. Also on a new record, when you enter a vendor, the client
information is cleared and replaced with the vendor information.

Creating transmittals

Only the boxes with blue title are required. Consider entering client or vendor information for legal traceability. You can
always addmore information to transmittals later.

NOTE: You can add set up routing by clicking theRouting button at the bottom of the window.

To create a transmittal:

1 Open 6-11-3 Transmittals.

2 In the Job box, click the drop-down arrow to select the job.

3 If the job uses phases, enter the phase number in thePhase box.

4 If the job uses divisions, enter the division number in theDivision box.

5 In theDescription box, enter a description.

6 Do any of the following, as necessary:

a In theSent by box, enter the person who sent the transmittal.

b In theClient orVendor box, enter a client or vendor.

c In theAttention box, enter the name of the person whom you want to be informed.

d In theAddress, City, State, and Zip text boxes, enter that information.

7 In the Type list, select the type.

8 In theSent box, enter the sending date.

9 Do any of the following, as necessary:

a In theSent Via box, select a sendingmethod.

b In theReceived box, enter a date.
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10 Select Hot List and Lock Edit.

11 In the grid, in theDescription cell, enter a brief statement about the item.

12 On the Filemenu, click Save.

Entering routing slips

You can track to whom you send documents, as well as the date when you receive the documents back.

To enter a routing slip:

1 On theOptionsmenu, click Routing.

2 In theRouted To box, enter the name of the person to whom you are sending the change orders.

3 In theDescription box, enter a brief statement about the document.

4 In theDate Sent box, enter the date you sent the documents.

5 In theDate Needed By box, enter the date by which youmust receive the documents.

6 In theDate Returned box, enter the date when the documents were returned.

7 On the Filemenu, click Save.

Setting up transmittal types

You can create a list of transmittal types, allowing you to categorize the transmittals. The following is an example of
transmittal types:

Transmittal Type # Type Name

10 Job Startup

20 Mid-Project Update

30 Job Closeout

To set up transmittal types
1 Open 6-11-3 Transmittals.

2 Next to the Type list, click the detail button.

3 In the Transmittal Type# box, enter the type number.

4 In the Type Name box, enter a description of the type.

5 On the Filemenu, click Save.

Deleting transmittals

To delete a transmittal:

1 Open 6-11-3 Transmittals.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Transmittal.
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6-11-4 Submittals
About submittals

You can provide submittal documents with all material samples supplied to the general contractor, client, vendor, or
architect. The submittal lists each sample you are providing for review. Look for menu command 6-11-4 Submittals.

There is a business advantage to adding information about clients or vendors. When you enter such information on a
submittal, the document is legally traceable.

The entry in theClient box andVendor box on the 6-11-4 Submittalswindow aremutually exclusive. On a new submittal
record, when you enter a client, the vendor entry is cleared and the client address and contact name are automatically
placed into theAttention box andAddress boxes. Also on a new record, when you enter a vendor, the client information is
cleared and replaced with the vendor information.

Creating submittals

Only the boxes with an asterisk in the title are required. Consider entering client or vendor information for legal traceability.

NOTE: You can set up routing by clicking theRouting button at the bottom of the window.

To create a submittal:

1 Open 6-11-4 Submittals.

2 In theSubmittal# box, enter the submittal number.

3 In the Job box, click the drop-down arrow to select the job.

4 If the job uses phases, enter the phase number in thePhase box.

5 In theDescription box, enter a description.

6 Do any of the following, as necessary:

a In theClient orVendor box, enter a client or vendor.

b In theAttention, box enter to whom you want this information to be alerted.

7 In theAddress 1, Address 2, City, State, and Zip text boxes, enter that information.

8 In the Type list, select a submittal type.

9 In theDate box, accept the date, or enter a different date.

10 Do any of the following, as necessary:

a In theSent by box, enter the person who sent the submittal.

b In theSent Via box, select a sendingmethod.

c In theRequired andReceived boxes, enter dates.

11 Select Hot List and Lock Edit.

12 In the grid, in theDescription cell, enter a brief statement about the item.

13 On the Filemenu, click Save.

Setting up submittal types

The following is an example of submittal types:
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Submittal Type # Type Name

1 Material Supplier

4 Subcontractor

1 Open 6-11-4 Submittals.

2 Next to the Type list, click View/Add records.

3 In theSubmittal Type# box, enter the type number.

4 In the Type Name box, enter a description of the type.

5 On the Filemenu, click Save.

Deleting submittals

To delete a submittal:

1 Open 6-11-4 Submittals.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Submittal.

6-11-5 Plan Records
About plan records

In the 6-11-5 Plan Recordswindow, you can enter and track the revisions made to plans. In addition, you can track who
has received the plans.

Entering and tracking a set of plans

To enter and track a set of plans:

1 Open 6-11-5 Plan Records.

2 Do the following:

a In thePlan# box, enter the revision number.

b In the Job box, enter the job number.

c If the job uses phases, enter the phase number in thePhase box.

d In theDate box, enter the date.

e In theDescription box, enter a brief statement about the set of plans.

f In the grid, in theDescription cell, enter a brief statement about the plan revisions.

3 On the Filemenu, click Save.

Tracking to whom you have distributed plans

You can enter the date when the plans were returned in theDate Returned column.
To track to whom you have distributed plans
1 Open 6-11-5 Plan Records.

2 Using the data control, select the record.

3 On theOptionsmenu, click Plan Distribution.
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4 In theSubcontractor box, enter the vendor number of the subcontractor to whom you provided a set of plans.

5 In theContact box, enter the name of the contact person.

6 In theCopies box, enter the number of copies sent.

7 In theDate Sent box, enter the date when you sent the plans.

8 On the Filemenu, click Save.

Deleting plan records

To delete a plan record:

1 Open 6-11-6 Plan Records.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Plan Record.

6-11-6 Daily Field Reports
About daily field reports

You can track the conditions and events that occur at the job site on a daily basis. You can keep track of the employees and
subcontractors working on the job, what equipment was used, and how many units of work were completed. In addition,
you can track incidents, meetings, and field orders.

Creating daily field reports

To create a daily field report:

1 Open 6-11-6 Daily Field Reports.

2 Do the following:

a In theDate box, enter the date.

b In the Job box, enter the job number.

c If the job uses phases, enter the phase number in thePhase box.

d In theDescription box, enter a description.

3 On theEmployees tab, do the following:

a In theEmployee cell, enter the employee number.

b In theCost Code cell, enter the cost code number.

c In thePay Type cell, enter the pay type.

4 On theSubcontractors tab, do the following:

a In theVendor cell, enter the vendor number of the subcontractor.

b In theDescription cell, enter a brief statement about the work.

c On theEquipment tab, do the following:

i In theEquipment cell, enter the number of the equipment used.

ii In theDescription cell, enter a brief statement about the work.

iii On theUnits tab, in theBid Item cell, enter the bid item under which you worked.

5 Enter any incidents.



- 403 -

6 Enter any meetings.

7 Enter any field orders.

8 On the Filemenu, click Save.

Entering meetings in Daily Field Reports

When enteringmeetings in Daily Field Reports, it is important to understand that Sage 100 Contractor is designed to set up
uniquemeeting types to help youmaintain detailed records.

Let’s suppose that you hold a team safety meeting every morning before work. Then at noon, you hold a short safety
meeting. When you setup your meeting types, you have to create onemeeting type for the safety meetings, another type
for teammeetings.

NOTE: Twomeeting types cannot be saved with the same number even though the descriptions are different.

To enter a meeting:

1 Open 6-11-6 Daily Field Reports.

2 Using the data control, select the record.

3 On theOptionsmenu, click Meetings.

4 In theMeeting Type cell, enter the type of meeting held.

5 In theDescription cell, enter a brief statement about themeeting.

6 In thePresent cell, enter who attended themeeting.

7 On the Filemenu, click Save.

About incidents

Incidents provide a way for you to associate information with a record. The incident itself provides the information that
points to a file containing the information, such as *.doc (Word document, a *.jpg (graphic), a *.pdf (Adobe portable
document format), an *.xls (Excel spreadsheet), and so forth. The attachment is not the file itself.

The incident may contain the following information:

l The Incident Type (required)

l Incident Description

l Incident Time

l AndNotes about the incident.

Here is an example of an incident associated with a job site. Let's suppose a lumber company has delivered some flashing
to your job. You go to the job site to verify the delivery, you notice that the flashing has been run over and is ruined. You take
a digital photo of the damages and save the graphic file in a folder under your \MB7 folder. Then back at the office, you
create an incident on the Daily Field Report that refers to the graphic file. When the lumber company investigates your
claim, you have a record of that incident.

Entering incidents is accessible on 6-11-6 Daily Field Reports from theOptions > Incidents and the Incidents button.

Entering incidents in Daily Field Reports

To enter an incident:

1 Open 6-11-6 Daily Field Reports.
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2 Using the data control, select the record.

3 On theOptionsmenu, click Incidents.

4 In the Incident Type column, enter the type of incident.

5 In the Time column, enter the time when the event occurred.

6 In theNotes column, double-click in a cell, and type a note, as required.

7 On the Filemenu, click Save.

Entering field orders in Daily Field Reports

To enter a field order:

1 Open 6-11-6 Daily Field Reports.

2 Using the data control, select the record.

3 On theOptionsmenu, click Orders.

4 In theOrder# cell, enter the order number.

5 In theDescription cell, enter a brief statement about the order.

6 On the Filemenu, click Save.

Setting up meeting types

You can createmeeting types to classify conferences. The following is an example of meeting types:

Meeting Type Description

1 Field Personnel Meeting

2 On-Site Safety Meeting

11 On-JobOwner/Architect

19 Punch List

To set up meeting types
1 Open 6-11-6 Daily Field Reports.

2 Using the data control, select the record.

3 On theOptionsmenu, click Meetings.

4 In aMeeting Type cell, right-click, then click Display Detail/Add Record.

5 TheMeeting Typewindow appears.

6 In the Type# cell, enter themeeting type number.

7 In the Type Name cell, enter a description of themeeting type.

8 Repeat steps 6–7 for each type.

9 On the Filemenu, click Save.

Setting up incident types

You can create incident types to track events on the work site. The following is an example of incident types:
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Type # Type Name

1 Altercation

2 Injury

3 Project Damage

4 Property Damage

5 Earthquake

To set up incident types
1 Open 6-11-6 Daily Field Reports.

2 Using the data control, select the record.

3 On theOptionsmenu, click Incidents.

4 In an Incident Type cell, right-click, then click Display Detail/Add Record.

5 The Incident Typewindow appears.

6 In the Type# cell, enter a type number.

7 In the Type Name cell, enter an incident type description.

8 Repeat steps 6–7 for each type.

9 On the Filemenu, click Save.

Deleting field reports

To delete a field report:

1 Open 6-11-6 Daily Field Reports.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Daily Report.

6-11-7 Punch Lists
About punch lists

You can create a punch list in the 6-11-7 Punch Listswindow. This feature helps you with project reviews at the job site
with an architect, engineer, or client inspecting the work, and helps you create a list of items to complete.

Creating punch lists

If you need to keep track of the vendor associated with this punch list, you can type the vendor name in theNotes. Then
when you print the report with notes, you see the vendor’s name.

To create a punch list:

1 Open 6-11-7 Punch List.

2 Do the following:

a In the Job box, enter the job number.

b If the job uses phases, enter the phase number in thePhase box.

c In theDescription box, enter a brief statement about the items.
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3 In the grid, do the following:

a In the Item# cell, enter the item number.

b In theDescription cell, enter a brief statement about the item.

4 Repeat step 3 for each item.

5 On the Filemenu, click Save.

TIP: You can hide the completed items, and display only the items yet to be completed.

Hiding items on punch lists

To hide punch list items:

1 Open 6-11-7 Punch List.

2 Using the data control, select the record.

3 On theOptionsmenu, click Hide Completed Items.

Deleting punch lists

To delete a punch list:

1 Open 6-11-7 Punch List.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Punch List.

6-11-8 Correspondence
About correspondence

Documenting correspondence is a very important part of business record keeping. Using the various 6-11-8
Correspondencemenu commands, you can write letters and keep records of your correspondence with clients,
subcontractors, architects, engineers, and so forth.

For example, if you are having a dispute with vendor about amissed payment or a dispute with a client about a change
order, you can use the 6-11-8 Correspondencewindow features and options to track and record the correspondence with
the other party.

There are several useful tools available with the 6-11-8 Correspondencewindow. You can create Quick Lists for
frequently used descriptions and for creating a list of attachments. There is anEditmenu command for creating
correspondence notes. On theOptionsmenu, theRouting command tracks to whom the correspondence was sent, the
date sent, the expected return date (if any), the date returned, and any notes.

TIP: To check spelling, click in the text entry area and then press the F7 key. On the Field Properties Textwindow,
select theCheck Spelling check box and click OK.

Likemany Sage 100 Contractor windows, the 6-11-8 Correspondencewindow provides access to theReport Printer
window where you can create output such print, print to screen, fax, and email. You can also export the correspondence to
Microsoft Excel. In addition, you can schedule the correspondence to be delivered via fax or email.

Creating client or vendor correspondence

To create client or vendor correspondence:

1 Open 6-11-8 Correspondence.



- 407 -

2 Do the following:

a In the Job box, enter the job number.

b If the job uses phases, enter the phase number in thePhase box.

c In theDescription box, enter a description.

3 In theStatus list, click the status of the correspondence.

4 In the Type list, click the type you want to assign to the correspondence.

5 Type the letter that you want to send.

6 On the Filemenu, click Save.

Setting up correspondence types

To set up correspondence types:

1 Open 6-11-8 Correspondence.

2 Next to the Type drop-down list on the right side of the window, click theAdd/View Records button.

3 In theCorrespondence Type# cell, enter the type number.

4 In the Type Name cell, enter a description of the type.

5 On the Filemenu, click Save.

Deleting correspondence

To delete correspondence:

1 Open 6-11-8 Correspondence.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Correspondence.

6-11-9 Project Hot List
About Project Hot List

TheProject Hot List is a record of items that require immediate attention. You can display a hot list by job or by supervisor.
You can then drill down to review a specific record.

You can access theProject Hot List from the 6-11-9 Project Hot List or the 6-12 Project Work Centerwindows.

IMPORTANT: Selection by supervisor is not available when accessing theProject Hot List from 6-12 Project
Work Center.

You can include the following standard information on the Project Hot List:

l Invoices

l Change orders

l Purchase orders

l Subcontracts

l Proposals
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l Progress bills

l Loan draws

l Unitary bills

l Recurring payables

l Recurring receivables

Optional information you can include on the Project Hot List:

You can display more items in yourProject Hot List, from both the 6-11-9 Project Hot List and 6-12 Project Work
Centerwindows, such as:

l Requests for information

l Requests for proposals

l Transmittals

l Submittals

l Plan records

l Daily field reports

l Punch lists

l Correspondence

Displaying a Project Hot List

Consider the following when displaying a Project Hot List:

l The records display automatically in the 6-12 Project Work Centerwithout selectingDisplay Records.

l To view a specific record in the list, select the record’s row and double-click, or select the row and then click Drill
Down.

To display a Project Hot List:

1 Open 6-11-9 Project Hot List or 6-12 Project Work Center, or click the desktop shortcut.

2 Do one of the following:

a In the Job box, enter or select the job number.

b In the Job Supervisor box, enter the employee number of the job supervisor.

IMPORTANT: Selection by supervisor is not available when accessing theProject Hot List from 6-12 Project
Work Center.

3 In the Table drop-down list, select the table you want to view.

4 To select from the standard tables, select Display Records.

Removing records from Project Hot Lists

Note that the removed item appears in italic font until you click theDisplay Records button again or refresh the window.

To remove a record from a Project Hot List:

1 Select the record you want to remove.
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2 Click Drill Down.

3 In the original record, clear theHot List check box.

4 On the Filemenu, click Save.

6-12 Project Work Center

About Project Work Center
The first time you open theProject Work Center, the job box displays the last job entered in the current company.
However, you can also view any other available jobs in that company. After that, the last accessed job is the default when
you openProject Work Center. If you have not created any jobs in your company, you are prompted to create one from the
3-5 Jobs (Accounts Receivable)window when you openProject Work Center.

Project Work Center displays the following information for a selected job:

l A customizable menu tree displaying accessible menu commands.

l TheProject Hot List.

l Contact and current financial information about the selected job.

IMPORTANT: All selections and defaults are user-specific and company-specific.

Customizable Menu Tree

The left side of the window displays amenu tree for accessible Sage 100 Contractor menu commands for the selected job.
Selecting amenu command displays the form or record pre-loaded with the job’s information for you to view or update.

In some cases, a list of associated items of that type for the selected job appears and you can then select the appropriate
item. The following selections display a list:

l 3-2 Receivable Invoices/Credits

l 3-7 Progress Billing

l 4-2 Payable Invoices/Credits

l 6-4-1 ChangeOrders

l 6-6-1 PurchaseOrders

l 6-7-1 Subcontracts

Themenu tree defaults with all possible menu commands available. This is customizable through theCustomize Project
Work Center Menuwindow.

Project Hot List

The upper right side of the window displays theProject Hot List. TheProject Work Center lets you view andmanage
information from the standard tables in theProject Hot List. WithDocument Control, you also have access to the
enhanced functionality available from the 6-11-9 Project Hot Listwindow.

Project Work Center Job Contact and Financial Data

The bottom of the window displays important information at a glance for each selected job. This information is “display only”
and cannot be edited. However, as information is changed in Sage 100 Contractor for a specific job, this information is
updated.
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Project Work Center Desktop Shortcut

Job information is available directly from theSage 100 Contractor Desktop by creating a desktop shortcut icon in the 6-12
Project Work Centerwindow. This feature enables you to view important data andmanage all your jobs from one location.
Project Work Center is highly customizable for each user’s needs.

IMPORTANT: Youmust create the desktop shortcut once. TheProject Work Center shortcut will then be
accessible from the desktop or in the 6-12 Project Work Centerwindow.

About customizing the Project Work Center menu
Themenu tree on the left side of theProject Work Centerwindow is highly customizable.

To customize the Project Work Center menu:
1 Open 6-12 Project Work Center.

2 Select Customize Project Work Center Menu.

3 TheCustomize Project Work Center Menuwindow appears.

4 Select or clear themenu commands that you want to display on themenu tree in theProject Work Centerwindow.

5 Click Save Menu.

IMPORTANT:
l Youmust select Save Menu to reflect your changes. If you close the window without selectingSave Menu,

your modifications will be lost.

l The customized selections are user-specific and company-specific.

The following rules apply when making your selections:

l Selecting or clearing an upper-level node selects or clears all its children and grandchildren.

l At least one lower-level nodemust be selected.

l When selecting a lower-level node in a family that is not selected, the parents and grandparents of that node are then
also selected and are displayed when your choices are saved.

TIP: You can use your mouse or keyboard arrow keys to navigate themenu tree.

Project Work Center job contact and financial information
The bottom of theProject Work Centerwindow displays contact and financial information for the selected job. This
information is “display only.” However, as youmake changes in Sage 100 Contractor that affect the selected job, this
information is refreshed.

The following client information appears:

l Client name

l Contact name

l Email address

l Phone number
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l Fax number

l Cell number

The following financial information about the job appears:

l Contract Amount

l Approved Changes

l Total Contract

l Costs to Date

l Original Budget

l Budget for Changes

l Total Budget

l Costs as % Budget
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Chapter 7: Utilities
Working with Utilities
The 7-Utilitieswindows enable you to setup security, create users, create companies, and to perform maintenance
functions. The supervisor user with exclusive access rights must perform many of these tasks.

List of 7-Utilities Windows

l 7-1 Create New Company—Create a new blank company or copy selected data from an existing open company to
create a new company.

l 7-2 Company Information—Enter company information into the system, such as address, license numbers, tax
numbers, direct deposit information, andmore.

l 7-3 Company Security—Contains two sub-menu windows:

l 7-3-1 Security Groups—Create security groups and set security for Save, Delete, Void, Print Checks, and
more.

l 7-3-2 User List—Set up a list of users in the current company. To save time, you can also copy user
defaults.

l 7-4 Rebuild Indexes—Rebuilds the database indexes for the company that is currently open.

l 7-5 Update Databases—Rebuilds the database indexes for all the companies that located in the current company's
drive.

l 7-6 Repair Database—Opens the Support Password window. This is only need to repair damaged databases. You
need to contact Customer Support for assistance. Database damage can be caused by a power failure or hard disk
failure.

IMPORTANT: Themaintenance task carried out in 7-6 Repair Database requires contact with Customer
Support.

l 7-7 Scheduled Reports Manager—View and delete events recorded when scheduled reports are executed.

l 7-8 Contact Manager—7-8 Contact Manager allows you to add and update 3-5 Jobs (Accounts Receivable), 3-6
Receivables Clients, and 4-4 Vendors (Accounts Payable) contact records in your Outlook contacts .

l 7-9 Alerts Manager—Use 7-9 Alerts Manager to view, created, edit, and import custom alerts and program alerts
that are viewable in the Dashboard and email.

Specify Sage License Server

About specifying the license server
Before you can use Sage 100 Contractor with your activated license, you have to launch the program and specify the
computer on your network that is designated the license server. There are two ways to specify the license server:

You can select the computer from the list of computers on your network,
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Or,

You can enter the IP Address or name of the computer

What is the license server, and why do I need it?

The license server is software running on a computer that manages the Sage 100 Contractor products that you purchased.
Products can be defined as a “core product,” additional “modules,” and a number of “license uses.” The computers running
your Sage products have to be connected to the computer running the license server so that the correct products are
available to you.

Where is the license server located?

During the Sage 100 Contractor installation, a computer on your network is specified as the license server. When you
activate your product license on that computer using License Administration, the Sage products and features are registered
on andmanaged from that specific computer.

We recommend that the computer specified as the license server be the same computer that stores and provides access to
company files and data. This arrangement keeps the Sage 100 Contractor products and their attributes on the same
computer with your company files and data. The computer specified as the license server should be continuously available
to other network computers running Sage 100 Contractor.

Selecting the Sage license server computer
Onemethod is to select the computer running the Sage license server from the list of network computers.
To use this method of selecting a server from the list of network computers, you must have already clicked the
appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network computers:

l On theSelect License Serverwindow from the list of network computers, select the computer running the Sage
license server.

l On theSelect License Serverwindow from the list of network computers, select the computer running the Sage
license server.

Entering the IP Address or name of the computer
Onemethod is to enter the IP Address or name of the computer running the Sage license server.

NOTE: To use this method of selecting a server from the list of network computers, you have already clicked the
appropriate link on the Specify Sage License Server window.

To enter the IP Address or name of the computer running the Sage license server:
1 In the box, type the IP Address or name of the computer.

2 Click OK.

Changing the license server
You can change the specified location of the license server. For example, if there is a hardware failure or you buy a new
server, then you have to specify the license server the next time you launch Sage 100 Contractor.

NOTE: When you change the license server, the Sage 100 Contractor program closes and restarts.

To change the license server when you're already logged into a company:
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1 Do one of the following:

a Go to the Administration Activity Center tab and select Licensing > Change License Server.

b From the Sage 100 Contractor menu, click Licensing, and then click Change License Server.

NOTE: The Licensingmenu is only available if you have hidden all Activity Centers using the Settings button.

2 TheChange License Serverwindow opens. The window presents two choices.

3 Click one of the following links, and follow the instructions:

a Select the computer from the list of computer on your network.

b Enter the IP Address or name of the computer.
To change the license server before logging into a company:
1 Open Sage 100 Contractor.

2 Click [Cancel] in the Company List window.

3 Click theChange License Server link in the bottom right corner.

4 TheChange License Serverwindow opens. The window presents two choices.

5 Click one of the following links, and follow the instructions:

a Select the computer from the list of computer on your network.

b Enter the IP Address or name of the computer.

Determining the name of a computer

NOTE: If you are trying to determine the name of the computer running the Sage license server, youmust complete
this procedure on that computer.

To determine the name of a computer:
1 On yourWindows desktop, click Start, Settings, and thenControl Panel.

2 From the list, scroll to and double-click System.

3 TheSystem Propertieswindow appears.

4 Locate the line Full computer name, and write it down or type it into a note that you can print.

5 Click Cancel.

Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server, youmust complete
this procedure on that computer.

To determine the IP Address of a computer:
1 Click Start, thenRun.

2 In theOpen box, type cmd, then click OK.

3 The \Windows\...\cmd.exewindow appears.

4 At the prompt, type ipconfig.

For example, youmight see H:\. Type ipconfig after the drive letter.
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When you press the Enter key, the system displays several address, among which is the IP Address of the computer.
You'll see a number formatted similar to this one:
IP Address . . . . . . . .172.20.22.142

What is an IP Address?
Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP) address. This
numeric address of a computer on the Internet is written as a set of four numbers separated by periods (each number can
range from 0 to 255). An example of an IP Address is 123.123.4.5.

NOTE: If you are trying to determine the IP Address of the computer running the Sage license server, youmust
complete the procedure on that computer.

What is a server?
There aremany kinds of servers. Some servers are denoted by their hardware configuration and a specialized operating
system. Other servers consist of specialized software applications running on standard computers.

Some servers are called “file servers” andmay be a powerful computer dedicated to storing files and data. For example,
Sage 100 Contractor company data can be stored on a file server computer. Any Sage 100 Contractor user on the same
network as the file server computer can access and store data there.

A server can also be a software application that provides a specific kind of service to client software running on other
computers. The term server can refer to a particular piece of software, such as the Sage license server. When we refer to
the Sage license server, we are describing a computer that is running the Sage license server software.

Running Sage 100 Contractor Connected
Launching and running Sage 100 Contractor connected

NOTE: If you are having a problem running Sage 100 Contractor connected, it is very likely a network problem or your
computer’s connectivity to your network. If problems persist, consult with your local system administrator.

The desired Sage License Server Connection State is:

l License use acquired from server. This connection state allows you to use all the power of the Sage 100
Contractor product that you purchased and licensed.

Prerequisites for a launching and running connected include:

l An activated Sage 100 Contractor product license.The administrator user activates the product license using the
functions of the License Administration program.

l A network connection, if you are on a network. This only pertains to working in a network environment and does not
pertain to a single computer running in a stand-alone environment.

l The Sage license server that has been specified from the computer running Sage 100 Contractor.

l An available license use.

l Being a user and having access to a Sage 100 Contractor company.

To launch and run Sage 100 Contractor connected:

1 Double-click the Sage 100 Contractor desktop icon.

2 TheSpecify Sage License Serverwindow appears.
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3 Choose one of the following:

a Select the Sage license server from the list of computer on your network.

b Enter an IP Address or name of the computer that is the Sage license server.

4 When you have satisfied the conditions to specify the Sage license server, click OK.

Sage 100 Contractor begins its launch process.

5 On theCompany Listwindow, select a company, or click Cancel.

6 From theCompany Listwindow, select a company.

7 On theUser Name and Passwordwindow, enter your user name and password.

8 Sage 100 Contractor opens the company.

You are now running Sage 100 Contractor connected.

About the Sage 100 Contractor license use status

You can view the current state of your Sage license use in the About Sage 100 Contractor window. Your license use status
is defined by several factors involving your network connectivity and the availability of license uses. The following table
presents license use status definitions:

About Sage 100
Contractor window

displays
License use status definition

License use not
acquired

You don’t have a license use. (You haven’t logged into a company database yet, or
requesting a use at login failed to retrieve one.)

License use acquired
from server Normal operating condition when you're logged into a company.

License use returned
to server

You’re at themainmenu and logged out of the company database after having
acquired a license use previously.

License use lost from
server

You’re previously acquired license use has been taken back by the license server
because you’ve lost communication. You’re in the “restricted” condition.

License use is
checked out

Equivalent to “License use acquired from server” except that you’re using a checked
out license.

Connection not estab-
lished

There’s a communication error and themachine can’t talk to the license server. (The
server isn’t available, the licensing service isn’t running on the server, or it’s not open on
the designated port.)

NOTE: If the computer running the Sage license server becomes disconnected from the other computers on your
network, or if your computer becomes disconnected from the Sage license server, youmay see an alert message
from Sage 100 Contractor telling you that you are disconnected.

Viewing the Sage license server connection state

You can view the current connection state of the Sage license server. This may help you in situations where your Sage
license server connection status is not what you expect it to be. Viewing the connection state can help you troubleshoot
problems.
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To view the Sage license server connection state:

1 From the Sage 100 Contractor main window, click Help, then click About Sage 100 Contractor.

2 TheAbout Sage 100 Contractorwindow appears.

3 In the lower right of the window just above theClose button, look forSage License Server Connection State.

4 The text in the box displays the current connection state.

Company List Window

About the Company List window
When you launch Sage 100 Contractor, the first window that appears is Company List. From this window, you select the
location of active company or archive company you want to open, then you select the company itself, and click OK.

For example, if you have installed Sage 100 Contractor and the Sample Company, and this is the first time you have
launched the program, then the Sample Company appears in the list underShow active companies.

You can select Show active companies to see all the active companies on a selected drive, or select Show archives to
see all the archive companies located on a selected drive.

NOTE: Tomark a company so it shows up as an archive company, you need to select Set as Company Archive
under the Options menu in 7-2 Company Information.

In a network environment, clicking the drop-down arrow displays all the local drives and all the network drives that you have
access to.

NOTE: In most business situations, the company that you use tomanage your business is not located on your local
computer. It is located on a server computer on your local area network. The server computer could be a dedicated
server computer in a client/server configuration or it could be a colleague’s computer in the next office using a peer-to-
peer configuration.

If you can see the shared network drive in the list, then you can access the Sage 100 Contractor company located on that
drive.

If you cannot see the drive where the company is located, then ask yourself these questions or consult with your network
administrator to locate your company.

l Have you lost your network connection? If you have, then you cannot access network drives and the Sage 100
Contractor company.

l Has the server lost its network access or crashed? If that has happened, then you can access the server and the
Sage 100 Contractor company after rebooting.

l Has the Sage 100 Contractor company beenmoved to a different computer and drive? If that’s true, then you have to
map to the network drive in its new location.

Mapping a network drive to access a company
Youmay have tomap to a network drive to access a Sage 100 Contractor company if it is not located on a drive on your
local computer. Let’s suppose that the company has beenmoved to network drive Z: Now to access the company data,
you have tomap to drive Z.

To map a network drive:
1 From the computer that needs a drivemapped, right-click theMicrosoft Windows Start button, and then choose Explore.
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2 From the Tools menu, selectMap Network Drive.

3 In [Drive] field, accept the default drive letter or press the down arrow to assign another drive letter.

4 Click [Browse].

5 Click the plus next to the name below Microsoft Windows Network.

6 Click the plus sign next to the server to display the shared directories.

7 Select the drive or the directory that is shared and contains theMB7 folder.

NOTE: Do not select theMB7 folder. Select the shared directory that theMB7 folder resides in.

8 Click [OK].

9 Select Reconnect at Logon and click Finish.

10 Open Sage 100 Contractor. From the drop-down list, select the drive letter entered in step 3.

11 Select the company file in themain window.

12 Click [OK].

If you are still unable tomap a network drive after following these procedures, please contact your system administrator, or
a local IT Professional.

For additional information, refer to article 308582 inMicrosoft's knowledgebase.

7-1 Create New Company
It’s best to create a separate company for each company for which you keep books. When you create a new company,
Sage 100 Contractor creates a folder for that company on a drive under the \MB7 folder.

There are two ways to create a new company:

l Create a new company containing no existing company information.

l Create a new company based on an existing company’s information.

New company containing no existing company information
As a first step, Sage 100 Contractor creates a database for the new company. In the case of a new company containing no
existing company information, Sage 100 Contractor creates a company database with table headings, but no other
information.

After creating a new company with no references to an existing company’s information, the next step is to enter new
company information on the 7-2 Company Information window. When you enter company information, you will find it
helpful to have the following:

l Complete company address

l License number

l Federal tax identification number

l State tax identification number

l Resale number

l Telephone and fax numbers



- 420 -

l Email address

l Direct deposit information, which is the account number, routing number, and the account type.

IMPORTANT: You cannot create a company with the following characters in the company name: : ?/ \ |@ . # $ % ^ &
( )

To create a new company containing no existing company information:
1 Open 7-1 Create New Company.

2 UnderOptions, select Create a new company.

3 Click theDrive drop-down arrow, and select a drive from the list.

4 TheDrive choice is preset to create a new company on C:\MB7.

5 In theCompany Name text box, type the name of the new company.

6 Click Create Company.

A message window displays the company information, and requests that you verify it to continue creating the new
company.

7 To continue, click Yes.

8 TheCreate New Company Progresswindow opens and displays the progress. When the company has been created,
the window displays Progress complete.

9 On theCreate New Company Progresswindow, click Close.

10 On the 7-1 Create New Companywindow, click Close.

11 After creating the new company, youmay proceed to 1-8 General Ledger Setup to set up your accounting structure,
fiscal year date, current period, and inventory valuationmethod (if you have the Inventory Add-onModule).

TIP: You can also access theCreate New Company function by selecting File, thenNew Company from themenu
bar.

New company based on an existing company’s information
Setting up new blank companies is labor-intensive. That is why Sage 100 Contractor provides a utility that can create a new
company from an existing company’s data. Using this utility will save you a lot of time and effort when creating new
companies. Before you start, however, it is important to determine that you have an existing company that is a goodmatch
for your new company.

In using this method, selected information from the existing company populates the database tables in the new company.
The existing information consists of list information (clients, accounts, employees, etc.) and external files (with no existing
job information). No transactions are part of the transferred information.

When you choose to create a new company based on an existing company’s information, it contains the following:
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Type Includes, but not limited to

List data

Clients

Accounts

Employees

Cost Codes

Parts

Vendors

External files with no job
reference

Takeoff template files

Takeoff grid files

Bitmap images for clients, employees,
etc.

Attachments

If a field within a table contains transactional data, it is not copied.

Type Includes, but not limited to

Transactional data
directly related to jobs

Accounts receivable

Field reports

Inventory allocations

Payroll records

Transactional data
contained in a field within
a table

Accounts payable—beginning balance
and ending balance

Employees—Qtr1 gross, Qtr2 gross,
etc.

Ledger accounts—beginning balance
and ending balance

Keep inmind that each new company requires aminimum of 50megabytes of hard disk space, and as you enter
information for each company, it requires more space. The number of company folders you can retain on your hard disk is
only limited by the amount of available hard disk space. A company database can be created on any local or network drive;
however, youmust have been given the rights to write to that selected drive by your network administrator.

Before you start to create a new company from an existing company, review the following information:

l You cannot copy a company: (1) If you do not have the correct level of administrative rights; (2) If the company is in
use and exclusive access is denied.

l When creating a new company based on an existing company’s information and regardless of the drive location,
Sage 100 Contractor companies must be created under the \MB7\ folder.

l Do not create a new company based on an existing company for a backup. For more information about backing up
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company data, see theSage 100 Contractor Help topic, About backing up data.

l Creating a new company from an existing company can only performed by a supervisor user with exclusive access.

TIPS:
l Before creating a company on a network drive, consult your network administrator.

l By storing each company’s information in a separate folder, you can back up and restore company information.

IMPORTANT: You cannot create a company with the following characters in the company name: :?/ \ |@ . # $ 
% ^ & ( )

To create a new company based on an existing company’s information:
1 As the supervisor user, open the company that you are going to use to base your new company withExclusive
Access.

2 Open 7-1 Create New Company.

3 Select Create a new company based on (The existing company name appears here.).

4 Click theDrive drop-down arrow, and select a drive from the list.

5 In theCompany Name text box, type the name of the new company.

6 Click Create Company.

A message window displays the company information, and requests that you verify it to continue creating the new
company.

7 To continue, click Yes.

8 TheCreate New Company Progresswindow opens and displays the progress. When the company has been
created, the window displays Progress complete.

9 On theCreate New Company Progresswindow, click Close.

10 Then on the 7-1 Create New Companywindow, click Close.

After creating the new company, youmay proceed to 1-8 General Ledger Setup to set up your accounting structure,
fiscal year date, current period, and inventory valuationmethod (if you have the Inventory Add-onModule).

About creating companies
It’s best to create a separate company for each company for which you keep books. When you create a new company,
Sage 100 Contractor creates a folder for that company on a drive under the \MB7 folder.

There are two ways to create a new company:

l Create a new company containing no existing company information

l Create a new company based on an existing company’s information

New company containing no existing company information
As a first step, Sage 100 Contractor creates a database for the new company. In the case of a new company containing no
existing company information, Sage 100 Contractor creates a company database with table headings, but no other
information.
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After creating a new company with no references to an existing company’s information, the next step is to enter new
company information on the 7-2 Company Information window. When you enter company information, you will find it
helpful to have the following:

l Complete company address

l License number

l Federal tax identification number

l State tax identification number

l Resale number

l Telephone and fax numbers

l Email address

l Direct deposit information, which is the account number, routing number, and the account type.

IMPORTANT:
l

l You cannot create a company with the following characters in the company name: : ?/ \ |@ . # $ % ^ & ( )

To create a new company containing no existing company information:
1 Open 7-1 Create New Company.

2 UnderOptions, select Create a new company.

3 Click theDrive drop-down arrow, and select a drive from the list.

4 TheDrive choice is preset to create a new company on C:\MB7.

5 In theCompany Name text box, type the name of the new company.

6 Click Create Company.

A message window displays the company information, and requests that you verify it to continue creating the new
company.

7 To continue, click Yes.

8 TheCreate New Company Progresswindow opens and displays the progress. When the company has been created,
the window displays Progress complete.

9 On theCreate New Company Progresswindow, click Close.

10 Then on the 7-1 Create New Companywindow, click Close.

11 After creating the new company, youmay proceed to 1-8 General Ledger Setup to set up your accounting structure,
fiscal year date, current period, and inventory valuationmethod (if you have the Inventory Add-onModule).

TIP: You can also access theCreate New Company function by selecting File, thenNew Company from themenu
bar.

New company based on an existing company’s information
Setting up new blank companies is labor-intensive. That is why Sage 100 Contractor provides a utility that can create a new
company from an existing company’s data. Using this utility will save you a lot of time and effort when creating new
companies. Before you start, however, it is important to determine that you have an existing company that is a goodmatch
for your new company.
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In using this method, selected information from the existing company populates the database tables in the new company.
The existing information consists of list information (clients, accounts, employees, etc.) and external files (with no existing
job information). No transactions are part of the transferred information.

When you choose to create a new company based on an existing company’s information, it contains the following:

Type Includes, but not limited to

List data

Clients

Accounts

Employees

Cost Codes

Parts

Vendors

External files with no job
reference

Takeoff template files

Takeoff grid files

Bitmap images for clients, employees,
etc.

Attachments

If a field within a table contains transactional data, it is not copied.

Type Includes, but not limited to

Transactional data
directly related to jobs

Accounts receivable

Field reports

Inventory allocations

Payroll records

Transactional data
contained in a field within
a table

Accounts payable—beginning balance
and ending balance

Employees—Qtr1 gross, Qtr2 gross,
etc.

Ledger accounts—beginning balance
and ending balance

Keep inmind that each new company requires aminimum of 50megabytes of hard disk space, and as you enter
information for each company, it requires more space. The number of company folders you can retain on your hard disk is
only limited by the amount of available hard disk space. A company database can be created on any local or network drive;
however, youmust have been given the rights to write to that selected drive by your network administrator.

Before you start to create a new company from an existing company, review the following information:
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l You cannot copy a company: (1) If you do not have the correct level of administrative rights; (2) If the company is in
use and exclusive access is denied.

l When creating a new company based on an existing company’s information and regardless of the drive location,
Sage 100 Contractor companies must be created under the \MB7\ folder.

l Do not create a new company based on an existing company for a backup. For more information about backing up
company data, see theSage 100 Contractor Help topic, About backing up data.

l Creating a new company from an existing company can only performed by a supervisor user with exclusive access.

TIPS:
l Before creating a company on a network drive, consult your network administrator.

l By storing each company’s information in a separate folder, you can back up and restore company information.

IMPORTANT: You cannot create a company with the following characters in the company name: :?/ \ |@ . # $ 
% ^ & ( )

To create a new company based on an existing company’s information:
1 As the supervisor user, open the company that you are going to use to base your new company withExclusive
Access.

2 Open 7-1 Create New Company.

3 Select Create a new company based on (The existing company name appears here.).

4 Click theDrive drop-down arrow, and select a drive from the list.

5 In theCompany Name text box, type the name of the new company.

6 Click Create Company.

A message window displays the company information, and requests that you verify it to continue creating the new
company.

7 To continue, click Yes.

8 TheCreate New Company Progresswindow opens and displays the progress. When the company has been
created, the window displays Progress complete.

9 On theCreate New Company Progresswindow, click Close.

10 Then on the 7-1 Create New Companywindow, click Close.

After creating the new company, youmay proceed to 1-8 General Ledger Setup to set up your accounting structure,
fiscal year date, current period, and inventory valuationmethod (if you have the Inventory Add-onModule).

Creating a new company containing no existing company information

IMPORTANT:

l Before creating a company on a network drive, consult your system or network administrator.

l You cannot create a company with the following characters in the company name: : ?/ \ |@ . # $ % ^ & ( )

To create a new company containing no existing company information:
1 Open 7-1 Create New Company.

2 UnderOptions, select Create a new company.



- 426 -

3 Click theDrive drop-down arrow, and select a drive from the list.

4 TheDrive choice is preset to create a new company on C:\MB7.

5 In theCompany Name text box, type the name of the new company.

6 Click Create Company.

A message window displays the company information, and requests that you verify it to continue creating the new
company.

7 To continue, click Yes.

8 TheCreate New Company Progresswindow opens and displays the progress. When the company has been created,
the window displays Progress complete.

9 On theCreate New Company Progresswindow, click Close.

10 Then on the 7-1 Create New Companywindow, click Close.

11 After creating the new company, youmay proceed to 1-8 General Ledger Setup to set up your accounting structure,
fiscal year date, current period, and inventory valuationmethod (if you have the Inventory Add-onModule).

TIP: You can also access theCreate New Company function by selecting File > New Company from themenu
bar.

Creating a new company based on existing company information
Before you create a new company from an existing company, note the following:

l You cannot copy a company if:

l You do not have the correct level of administrative rights.

l The company is in use and exclusive access is denied.

l When creating a new company based on an existing company’s information and regardless of the drive location,
Sage 100 Contractor companies must be created under the \MB7\ folder.

l Do not create a new company based on an existing company for a backup. For more information about backing up
company data, see theSage 100 Contractor Help topic, About backing up data.

l Creating a new company from an existing company can only performed by a supervisor user with exclusive access.

When you create a new company from existing company data, the new company's default posting period is set to the same
posting period as the existing company. If you want to change the default posting period, you can only change it using 1-6
Period/Fiscal Year Management > Change Period.

When you choose to create a new company based on an existing company’s information, it contains the following:
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Type Includes, but not limited to

List Data

Clients

Accounts

Employees

Cost Codes

Parts

Vendors

External Files with no job
reference

Takeoff template files

Takeoff grid files

Bitmap images for clients, employees,
etc.

If a field within a table contains transactional data, it is not copied.

Type Includes, but not limited to

Transactional data
directly related to jobs

Accounts receivable

Field reports

Inventory allocations

Payroll records

Transactional data
contained in a field within
a table

Accounts payable—beginning balance
and ending balance

Employees—Qtr1 gross, Qtr2 gross,
etc.

Ledger accounts—beginning balance
and ending balance

IMPORTANT: You cannot create a company with the following characters in the company name: :?/ \ |@ . # $ % ^ &
( )

To create a new company based on an existing company’s information:
1 As the supervisor user, open the company that you are going to use to base your new company withExclusive Access.

2 Open 7-1 Create New Company.

3 Select Create a new company based on (The existing company name appears here.).

4 Click theDrive drop-down arrow, and select a drive from the list.

5 In theCompany Name text box, type the name of the new company.

6 Click Create Company.

A message window displays the company information, and requests that you verify it to continue creating the new
company.
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7 To continue, click Yes.

8 TheCreate New Company Progresswindow opens and displays the progress. When the company has been created,
the window displays Progress complete.

9 On theCreate New Company Progresswindow, click Close.

10 Then on the 7-1 Create New Companywindow, click Close.

After creating the new company, youmay proceed to 1-8 General Ledger Setup to set up your accounting structure, fiscal
year date, current period, and inventory valuationmethod (if you have the Inventory Add-onModule).

7-2 Company Information

Entering company information
After you have created a blank new company, you have to enter the company information.

l General Information

l Payroll Direct Deposit Setup

l Vendor ACH Payment Setup

l Electronic Receipts Setup

NOTE: To process electronic receipts, youmust have a valid account with Sage Payment Solutions,
including amerchant ID and key.

l Email and Fax Configuration

To enter general information:
1 In theCompany list, click the company.

2 Open 7-2 Company Information.

3 In theCompany Name text box, enter the company name.

4 In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address information.

5 In thePhone# text box, enter the telephone number.

6 In the Fax# text boxes, enter the fax telephone number.

7 In theEmail text box, enter the company email address.

8 In the License# text box, enter the contractor license number.

9 In theResale# text box, enter the company’s State Resale License Number.

10 In the Federal Tax Id# text box, enter the company’s Federal Identification Number.

11 (Optional) In theUser Def1 andUser Def2 text box, enter the user-defined information as necessary.

12 In theRecur. Trans. Group (Recurring Transactions Group) text box, select the security group responsible for posting
recurring transactions.

IMPORTANT: If you do not enter a security group in theRecurring Transactions Group text box, Sage 100
Contractor does not provide a reminder that recurring transactions need to be posted.

13 In the lower left of the window, click theState Tax Id# button to enter the company’s state tax identification in theState
Tax Id# window. 
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IMPORTANT: If you are planning to fileW-2 data electronically, enter the federal and state tax identification numbers
without blank spaces or hyphens between numbers.

To enter payroll direct deposit setup information:
1 Click thePayroll Direct Deposit Setup tab.

2 Complete the following in theCompany bank information for direct deposit section:

a In theRouting# text box, enter your company’s bank routing number.

b In theAccounting# text box, enter your company’s bank account number.

c In theAccount Type, select your company’s bank account type.

3 In theOptions for direct deposit ACH file section, fill out and select the appropriate options for your direct deposit
ACH file:

a Origin Bank Name—optional bank name for the 'Immediate Origin Bank Name ' field

b Destination Bank Name—optional bank name for the 'Immediate Destination Bank Name' field

c Optional Bank Routing#—Optional bank routing number for the 'Immediate Destination' field

d ID Code Designator (ICD)—select blank or any number between 1—9 for the company identification fields.

e For 'Immediate Origin Name' in file header record, select your company name orOrigin Bank Name

f For 'Immediate Destination Name in file header record, select blank orDestination Bank Name

g For 'Immediate Origin' in file header record, select your company FEIN or your routing#

h For 'Immediate Destination' in file header record, select your routing# orOptional Bank Routing#

i For File formatting options, select or clear the check boxes appropriate to the preferences of your financial
institution.

i Include company debit line

ii Include optional hard return

iii Include optional "9" fill

NOTE: If you have any questions about which check boxes to select, contact your financial institution.

To enter vendor direct deposit setup information:
1 Click theVendor ACH Payment Setup tab.

NOTE: If there is a routing number in the payroll direct deposit setup, Sage 100 Contractor will ask if you want to
copy the information from thePayroll Direct Deposit Setup tab. This copies and pre-fills all options, except for the
Posting Cash Account number.

2 Complete the following in theCompany bank information for ACH payments section:

a In theRouting# text box, enter your company’s bank routing number.

b In theAccounting# text box, enter your company’s bank account number.

c In theAccount Type, select your company’s bank account type.

d In thePosting Cash Account, display the lookup window and select the applicable cash account.

3 In theOptions for ACH payment file section, fill out and select the appropriate options for your direct deposit ACH file:

a Origin Bank Name—optional bank name for the 'Immediate Origin Bank Name ' field
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b Destination Bank Name—optional bank name for the 'Immediate Destination Bank Name' field

c Optional Bank Routing#—Optional bank routing number for the 'Immediate Destination' field

d ID Code Designator (ICD)—select blank or any number between 1—9 for the company identification fields.

e For 'Immediate Origin Name' in file header record, select your company name orOrigin Bank Name

f For 'Immediate Destination Name in file header record, select blank orDestination Bank Name

g For 'Immediate Origin' in file header record, select your company FEIN or your routing#

h For 'Immediate Destination' in file header record, select your routing# orOptional Bank Routing#

i For File formatting options, select or clear the check boxes appropriate to the preferences of your financial
institution.

i Include company debit line

ii Include optional hard return

iii Include optional "9" fill

NOTE: If you have any questions about which check boxes to select, contact your financial institution.

To set up your company to process electronic receipts:
1 Make sure you have your Sage Payment Solutions merchant ID andmerchant key handy.

NOTE: Sage sends you these credentials when you purchase a Sage Payment Solutions account.

2 On the Electronic Receipts tab:

a In theMerchant ID andMerchant Key fields, enter your Sage Payment Solutionsmerchant credentials.

b To ensure that you have entered the correct information and that your account is valid, click Validate Credentials.

c In thePosting Cash Account field, enter the general ledger cash account associated with the bank account to which
you will deposit electronic receipts. (This account should correspond to the bank account used in Sage Exchange.)

d If you want to use the Sage Exchange Vault to store credit card and bank account information from your client, select
Allow client credit card and bank account information to be securely stored in the Sage Exchange Vault.

For information about the Sage Exchange Vault, see About Sage Exchange.

To configure Email and Fax:
1 Fill in the information on theEmail and Fax Configuration tab after reading the following information:

l User authentication is typically required for emailing through an ISP’s simplemail transfer protocol
(SMTP) server. An example of an email server name is “smtp.att.sbcglobal.net.” 

l Server namemust be SMTP server name, not a numeric IP address. An example of an IP address is
“10.227.16.33.”

l Different ISPs may use different terms when referring to user authentication. In general, however,
user authenticationmeans verifying the identity of the user by means of a “user name” and
“password.”

l In this context using an ISP’s SMTP server to send email through Sage 100 Contractor, user
authentication refers to verifying a user’s identity at the ISP’s SMTP server. It does not refer to your
Sage 100 Contractor username and password or to your network username and password.
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l Some Internet-based email providers do not support SMTP protocol. For more details, contact the
Internet-based email providers that you use.

2 In theSMTP Mail Configuration section, do the following:

a In theEmail Server text box, enter the name of the email server.

b In thePort# box, type the email server port number.

c Select Requires authentication, if the Internet service provider (ISP) service handling your email service requires
user authentication.

d Select Uses SSL for email, if required by the Internet service provider.

3 In the Fax Configuration section, type your fax line number in thePhone Dial Out text box.

TIP: You can change the email server and fax line access selections to accommodate sending reports frommultiple
locations with different requirements.

4 On the Filemenu, click Save.

To set a company as an archive:
1 Select Options from themenu.

2 Select Set as Company Archive.

NOTE: Anyone can set a company as an archive, but only the Supervisor user can remove this setting.

Setting up state tax identification numbers
Many companies work in several different states , and have a different tax identification number for each. You can create a
table containing all the different tax identification numbers.

To set up a state tax identification number:
1 Open 7-2 Company Information.

2 Click theState Tax Id# button.

3 In the State cell, enter the state abbreviation.

4 In theState Tax Id# cell, enter the taxpayer identification number.

7-3 Company Security

Security features of Sage 100 Contractor
Sage 100 Contractor provides a variety of security features that allow you to restrict access to data in each company. You
can do the following:

l Create a list of users and passwords for each company. This list provides themeans to restrict access to individual
companies. Restricting access to a company also restricts access to its archive.

l Create groups of users. Security groups provide a way to collect users together in meaningful sets such as project
managers, payables clerks, or payroll clerks. With groups established, you can then assign each user to up to five
security groups.
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l Control the admission of users to windows through security groups and assign access rights to each security group.

l Control items within windows such as text boxes, lists, check boxes, and grid columns. By limiting what information
a security group can enter or view in a window, you also restrict access to that same information in queries and
reports. For example, youmight not want to allow the payroll clerks security group access to salaries and wage
rates in the employee files. The payroll clerks will not be able to view salaries and wage rates in the employee files,
or while entering timecards, or by running any payroll reports.

Each company in Sage 100 Contractor can use different user names, passwords, security groups, and access rights. You
only have to set up security groups and access rights one time for each company. As you add or remove users from the
User List, you can simply assign or reassign users to the proper security groups.

IMPORTANT: Many actions in Sage 100 Contractor can only be performed when logged on as supervisor. When
setting up security, it is critical that you add a password for the user name supervisor.

7-3-1 Security Groups
About security groups

Use the 7-3-1 Security Groups window to set up security groups for your company’s employees.

Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The 7-3-
1 Security Groups window contains a grid with numbered rows on the left and eight columns:

l Group# (User input is required to save the record.)

l Group Name (User input is required to save the record.)

l Save

l Delete

l Void

l Chg Period

l Print Checks

l Notes

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will
have rights toSave, Delete, andVoid records, as well as to change the accounting period and print checks. Youmay use
the Notes column to add any pertinent information about each group.

While youmight create security groups for specific employees, it is a good idea to build each security group for the tasks
performed by the employee. This allows you to add or remove employees from security groups rather than having to build
new security groups for each new employee.

As the company size increases, the need for additional security groups increases. For example, a large company has an
office staff that includes several accounts payable clerks, an accounts receivables clerk, a payroll clerk, a controller,
project managers, and estimators. In this company, six different security groups are set up to accommodate the specific
needs of the employees engaged in six different task areas.

In addition to creating task-oriented security groups, it is a good idea to create one security group with full access to the
entire program. This allows owners or managers to log in with full access, but prevents unauthorized access to program
features that only a user logged in as supervisor can use.
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It is important to consider the scope of tasks performed by users as well as the number of users that access Sage 100
Contractor. Before designing security groups, examine which users need access to specific windows in Sage 100
Contractor. After you set up the security groups, you can then set up window andmenu-level security.

For example, a small company has three clerks: a general accounting clerk, an accounts payable and accounts receivable
clerk, and a payroll clerk. For this company, it is only necessary to create three security groups. The first group, titled
Payroll Clerk, only provides access to payroll operations. The second group, titledA/P A/R Clerk, provides access to
accounts payable and accounts receivable operations. The third group, titledGeneral Ledger Clerk, provides access to
general ledger operations not covered by accounts payable and accounts receivable.

Consider the following before setting up security groups:

l Do you need to create separate security groups for employees who perform specific tasks? For example, does your
company have a payables clerk who only enters payables data?

l Do you need to create separate security groups for accounts payable, accounts receivable, and payroll supervisors,
or can you just create one group for the supervisors?

l Do estimators perform different tasks than project managers?

l Do you need to provide differing levels of access to owners, controllers, or managers?

l Are you going to use the Sage 100 Contractor API to integrate with other programs? If so, create a security group
namedAPI with a group number such as 51.

IMPORTANT: To use the Sage 100 Contractor API program, youmust create an API security group that is named
exactly API. At least one user must be added to the API security group. You have to set rights to save, void, etc.

Setting up security groups

To set up a security group:

1 Open 7-3-1 Security Groups.

2 In theGroup# cell, type a group number.

3 In theGroup Name cell, type group name.

4 In theSave cell, if you want to allow the group to save records, type Yes. If not, type No.

5 In theDelete cell, if you want to allow the group to delete records, type Yes. If not, type No.

6 In theVoid cell, if you want to allow the group to void records, type Yes. If not, type No.

7 In theChange Period cell, if you want to allow the group to change the posting period, type Yes. If not, type No.

8 In thePrint Checks cell, if you want to allow the group to print checks, type Yes. If not, type No.

9 To store information that may be relevant or important to that specific group, type a note in theNotes cell.

10 Repeat steps 2–9 for each security group.

11 On the Filemenu, click Save.

TIPS:
l Security is set up for each individual company, not for the entire program. Each company can use different user

names and passwords. If you havemore than one company, you have to set up passwords for multiple
companies.

l You can control the ability of security groups to access specific windows.



- 434 -

Setting up a security group for using the API

The Sage 100 Contractorapplication program interface (API) allows you to use third-party programs to perform the same
tasks that you would perform when using different Sage 100 Contractor windows. The API allows the third-party program to
insert, as well as delete, modify, or retrieve data from one or more existing Sage 100 Contractor company databases.

Using the Sage 100 Contractor API to access Sage 100 Contractor company data requires a license use. That is why you
have to set up an API security group using 7-3-1 Security Groups. Then you have to assign a user to the API security
group using 7-3-2 User List.

NOTE: In the case that there are nomore license uses available, the API program responds with an alert message.

To set up a security group for using the API:

1 Open 7-3-1 Security Groups.

2 In theGroup# cell, type a group number, such as 51.

3 In theGroup Name cell, type API.

IMPORTANT: The API security groupmust be named exactly API.

4 In theSave cell, typeYes.

5 In theDelete cell, if you want to allow the users of the API group to delete records, typeYes. If not, type No.

6 In theVoid cell, typeYes. If not, typeNo.

7 In theChg Period cell, typeYes. If not, typeNo.

8 In thePrint Checks cell, typeYes. If not, typeNo.

9 To store information that may be relevant or important to that specific group, type a note in theNotes cell.

10 On the Filemenu, click Save.

TIPS:
l Before you can use the API security group to access Sage 100 Contractor company data, you have to assign a

user to the API security group.

l Security is set up for each individual company, not for the entire program. Each company can use different user
names and passwords. If you havemore than one company, you have to set up passwords for multiple
companies.

About setting field properties

You launch the Field Propertieswindow by pressing the F7 key when in another data entry window, for example, 4-2
Payable Invoices/Credits. In the Field Propertieswindow, you can set up the default properties for almost any text box,
check box, grid cell, or columnwithin a window. You can set the following options:

l Default Entry to: Provides a list of entries from which you can select the default. Enter the default data, or click the
item in the list you want to appear as the default entry.

l Permit Access to: Lets you select which user groups have access to a window, text box, list, or grid column. If no
user groups are selected, then all user groups have access. If the user groups appear shaded, then you cannot
restrict access.

l When a user group is not granted access to a window, that user group cannot open the window. In addition,
the user group cannot access the information by printing documents or reports.
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l When a user group is not granted access to a text box or list, that user group cannot enter or access
information in that text box or list, or access the information using a query, quick list, or Lookupwindow. In
addition, the user group cannot access the information by printing documents or reports.

l When a user group is not granted access to a grid column, that grid column is hidden from view and is not
accessible by the user group. In addition, the user group cannot access the information by printing
documents or reports.

l Skip During Entry: During data entry, Sage 100 Contractor skips over the field or list. You can still enter data when
you select it.

l Require Entry: Requires an entry, or Sage 100 Contractor will not save the record.

l Require List Match: Requires that the entry match an item on theQuick List.

l Require Unique: Prevents users from entering duplicate information. This is available for indexed text boxes that
let you enter character-based information.

l When you select this property for the Invoice# box in 3-2 Receivable Invoices, 6-6-1 Purchase Orders, or
6-7-1 Subcontracts, Sage 100 Contractor ignores records that have status 5-Void.

l When you select this property for theWork Order and Invoice# boxes in 11-2 Work
Orders/Invoices/Credits, Sage 100 Contractor ignores records that have status 5-Void.

l When you select this property for the Invoice# box in 4-2 Payable Invoices, Sage 100 Contractor ignores
records that have status 5-Void for a given vendor. You can set up a vendor to use duplicate invoice
numbers.

l Lock After Save: Prevents users from editing the information after saving the record. Only users logged in as
supervisor can edit the information.

l Lock Quick List: Prevents users from editing aQuick List. Only users logged in as supervisor can edit the
information.

l Check Spelling: Checks the spelling when youmove to another text box or cell. If Sage 100 Contractor finds a
misspelled word, it displays theSpelling dialog box.

l Mixed Case: Allows text entry in upper and lower case.

l Upper Case: Displays text only in upper case.

l Lower Case: Converts entry to lower case text.

l User Defined Field Type: Lets you select the type of information the field accepts.

l System Description: Displays the default description of the field.

l User Description: Lets you change the description of the field. To display the system description again, delete the
user description.

l System Prompt: Displays the default prompt that appears in the status bar at the bottom of the window.

l User Prompt: Allows you to change the default prompt in the status bar at the bottom of the window. When the user
prompt is deleted, the system prompt is restored.

Setting up properties

Using the F7 key, you can set up the default properties for almost any text box, list, check box, grid cell, or columnwithin a
window.

IMPORTANT:
l Access to set up these properties is limited to the supervisor user.

l You cannot restrict access to system-required fields.
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For example, youmay want to autopopulate certain fields in a window to speed up the work. In some cases, it is essential
for certain fields to be hidden from view for business purposes.

To set up properties for a text box or list or check box or column:

1 On the Filemenu, click Open Company.

2 Log in as supervisor.

3 Navigate to the window that you want to set up or change.

4 Place your cursor in a text box or grid cell, or select a check box or column.

5 Press F7.

6 The Field Propertieswindow appears.

7 Select the appropriate check boxes or type entries in the text boxes to set their properties.

7-3-2 User List
About the 7-3-2 User List window

The 7-3-2 User List window controls major features dealing with users and program security.

If you are a supervisor user, you can use the grid in this window to set up a list of user names for each company folder to
help control access to Sage 100 Contractor.

By setting up security groups and assigning the groups to user names, you can further limit access to certain modules or
windows, and text boxes, lists, and columns within windows.

Because Sage 100 Contractor determines access through the user names, a user can log on to Sage 100 Contractor from
any workstation in a network environment.

By selecting theDisplay Passwords check box, a supervisor user can view, set and/or change users’ passwords.

If you want certain users to only see the job-related information for the jobs they manage, you can assign them to job-level
security using the Subject to Job Security column.

NOTE: Any user can be amember of the API security group; however, we recommend that you create a specific user
to use the API, for example, “APIUser.”

Setting up user names and passwords

Use the 7-3-2 User Listwindow to set up new users and user passwords in your company. You can also copy existing
user defaults to create new users.

Here is a list of suggestion of things to do when setting up user names and passwords:

l Print a list of the user names and security groups—but do not include the passwords—to include in your files. When
employees have questions about access, you can refer to the printed list.

l Consider using the employee’s job title as their user name. That way, if the employee leaves the position, their
security and report defaults can be used by the next person in that job. For example, instead of entering Leslie in the
User Name cell, useAccountant instead.

TheUser List contains a permanent name, supervisor.

Security is set up for each individual company, not for the entire program. Each company can use a different list of users
and passwords.
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Within a company, security groups control access. After assigning users to security groups, grant the access rights to the
security groups.

CAUTION: Security does not prevent access to databases by highly skilled computer users. Security only manages
data access through Sage 100 Contractor.

IMPORTANT:
l Tomaintain security, we strongly recommend that you set up a password for the supervisor user. Be sure to

write it down and keep it in a safe place.

l Only the supervisor user has rights to set up user names and passwords.

l Youmay receive aRuntime Error 75 error message upon exiting Sage 100 Contractor if the system has been
set up without giving users sufficient rights to update registries.

To set up user names and passwords:

1 Open 7-3-2 User List.

2 Select theDisplay Passwords check box.

3 In theUser Name cell, enter the user’s name.

4 In thePassword cell, enter a password.

5 In theGroup 1 cell, click once in the cell, and from the drop-down list, select a security group.
For example, owners/comptrollers could be in Group 1.

6 In theGroup 2 cell, click once in the cell, and from the drop-down list, select a security group.
For example, employees with access to general ledger accounts could be in Group 2.

7 In theGroup 3 cell, click once in the cell, and from the drop-down list, select a security group.
For example, employees with access to payroll could be in Group 3.

8 In theGroup 4 cell, click once in the cell, and from the drop-down list, select a security group.
For example, employees with access to accounts receivable could be in Group 4.

9 In theGroup 5 cell, click once in the cell, and from the drop-down list, select a security group.
For example, employees with access to accounts payable could be in Group 5.

10 In theSubject to Job Security cell, click once in the cell, and type Y if the user is subject to job level security access.

11 Repeat steps 3–10 for each user.

12 Click File > Save.

Setting up an API user and password

Before you can use the API to access company data, you have to set up an API security group, and then assign a specific
user or users to that group.

Any user can be amember of the API security group except supervisor; however, we recommend that you create a specific
user or set of users to use the API, for example, “APIUser1, APIUser2.”

IMPORTANT:
l Only the supervisor user has rights to set up user names and passwords.

l The API will not accept “supervisor” as a user name.

To set up an API user and password:

1 Open 7-3-2 User List.
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2 Select theDisplay Passwords check box.

3 In theUser Name cell, enter a user name, such as APIUser.

4 In thePassword cell, enter a password.

5 In theGroup 1 cell, click once in the cell, and from the drop-down list, select the API group.

6 Repeat steps 3–5 for each API user.

7 Click File > Save.

About passwords for multiple companies

Passwords help prevent users from opening the wrong company and entering data in it. Security allows you to set up a
different list of user names and passwords in each company. However, providing users altogether different passwords for
each company can prove confusing.

Suppose you have three companies: Northern Contractors, Western Contractors, and Southern Contractors. Instead of
creating three different passwords for each user, assign each user one password that he or she uses to access all the
companies.

To prevent users from accidentally opening and entering data in the wrong company, add an abbreviation of the company
name to the password. The example below illustrates the passwords for a single user to access three different companies.

Company Password

Northern Contractors Bear Northern

Western Contractors BearWestern

Southern Contractors Bear Southern

Displaying passwords

You can hide or display the passwords for users.

To display the passwords for users, select theDisplay Passwords check box.

About the supervisor user

When you log on to Sage 100 Contractor as supervisor, you have access rights to the entire Sage 100 Contractor
application.

IMPORTANT: Tomaintain security, we strongly recommend that you set up a password for the supervisor user. Be
sure to write it down and keep it in a safe place.

Following is a list of actions you can only perform when logged on to Sage 100 Contractor as supervisor:

l Create security groups in 7-3-1 Security Groups.

l Grant access rights to security groups for windows and items within windows such as text boxes, lists, and grid
columns in 7-3-1 Security Groups.

l Grant job-level security to specific users in 7-3-2 User List.

l Use the F7 key to display the Field Properties dialog box to set the individual security properties for a text box, list,
check box, or grid column, as well as set security for certain menu commands from themainmenus. You can also
customize the window, set defaults in specific fields, and set system user prompts.

l Create user names and passwords, and assign user names to security groups in 7-3-1 User List.
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l Create new companies in 7-1 Create New Company.

l Make and save changes to the General Ledger in 1-8 General Ledger Setup.

l Archive the accounting at the fiscal year-end in 1-6 Period/Fiscal Year Management.

l Close payroll at the calendar year-end, which starts on 5-4-5 Close Payroll Year.

l Restrict posting to specific accounting posting periods, for example, 4-2 Payable Invoices/Credits and other
windows.

About copying user defaults

IMPORTANT: Copying existing user defaults to a new user does not copy the existing user’s security settings.

Copying user defaults speeds up the process of setting up a new user or users who are going to be working in Sage 100
Contractor in a way similar to an existing user.

Copying user defaults from one user to another copies all defaults associated with that existing user. For example, it copies
grid views and reporting defaults that have been saved throughout Sage 100 Contractor.

Copying user defaults does not copy security settings to the new user because security is based on groups, not individual
users. In addition, desktop settings are not copied to the new user because desktop settings are computer-specific.

To copy user defaults, youmust log in as the supervisor user. You access theCopy User Defaultswindow through the
Optionsmenu on the 7-3-2 User Listwindow.

Copying user defaults from one user to another

Rather than create or edit user defaults one at a time, use this procedure to copy user defaults from one user to another user
or multiple users.

If you need to clear user defaults in the event of amistake, for example, you can copy the existing user defaults. To clear
defaults, create a new user (who has no defaults), and then copy that user's defaults to one with defaults. The result is that
theCopy To user has no defaults.

IMPORTANT:
l To perform this task, youmust open and log into a company as supervisor.

l Youmust have set up at least two users for this functionality to be active.

To copy user defaults from one user to another:

1 Open 7-3-2 User List.

2 Click theCopy User Default button.

3 TheCopy User Defaultwindow opens.

4 UnderCopy From, select a user.

5 Then do one of the following:

a UnderCopy To, select a user.

b UnderCopy To, select several users.

6 Click OK.
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About window and menu-level security

Window-level security lets you limit a security group’s ability to open specific windows within Sage 100 Contractor. You
can set up window-level security on amenu command that opens a window or sub-level window.

Suppose a small company has three security groups: General Ledger Clerk, A/P A/R Clerk, andPayroll Clerk. Using
the window andmenu-level security, you can allow only members of theGeneral Ledger Clerk group access to windows
related to general ledger operations; theA/P A/R Clerk group to accounts payable and accounts receivable operations;
and thePayroll Clerk group to payroll operations.

For menu commands that open a window, Sage 100 Contractor only allows access by users in the selected security groups
and applies the access rights.

For menu commands that open a different menu item, Sage 100 Contractor only allows access by users in the selected
security groups. For example, you can provide theGeneral Ledger Clerk group access throughmenu 1-General Ledger.
However, this does not apply the access rights to the items under menu 1-General Ledger.

Setting up window and menu-level security

CAUTION: Without window andmenu-level security set up, Sage 100 Contractor gives all access rights to the user
opening the window.

To set up window and menu-level security:

1 Log on to the company as supervisor.

2 Select themenu command, and then press F7.

3 Select the groups to which you want to provide access.

4 Click OK.

About access rights regarding window and menu-level security

CAUTION: Without window andmenu-level security set up, Sage 100 Contractor gives all access rights to the user
opening the window.

When you assign a user to a security group, that user gains the access rights associated with its security group. Sage 100
Contractor applies the access rights only when you have set up window-level andmenu-level security on amenu command
that opens a window.

Suppose a security group titledGeneral Ledger Clerk has been assigned only the right to save and delete records. Each
window under the general ledger—1-1 Checks/Bank Charges, 1-2 Deposits/Interest, 1-3 Journal Transactions, 1-4
Recurring Journal Transactions, 1-5 Bank Reconciliation, 1-6 Period/Fiscal Year Management, 1-7 Ledger
Accounts, 1-8 General Ledger Setup, and 1-9 Company Departments—is then set up with window andmenu-level
security. Only theGeneral Ledger Clerk group has the ability to open those windows.

l Example 1: WhenGerald (in theGeneral Ledger Clerk group) opens the 1-1 Checks/Bank Chargeswindow, the
access rights only permit him to save and delete records.

l Example 2: A security group titledPayroll Clerk has been assigned the rights to save records, change posting
periods, print checks, and void or delete records. Each window under payroll is set up with window andmenu-level
security. Only thePayroll security group has the ability to open those windows.

l Example 3: When Dianna (in both theGeneral Ledger Clerk andPayroll Clerk groups) opens any of the payroll
windows, she has the access rights assigned to thePayroll Clerk group. And when Dianna opens any of the
general ledger windows, she has the access rights assigned to theGeneral Ledger Clerk group.

To set up window and menu-level security
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1 Log on to the company as supervisor.

2 Select themenu command, and then press F7.

3 Select the groups to which you want to provide access.

4 Click OK.

Window and menu-level access rights definitions

If you are using window andmenu-level security, you can assign access rights to each security group.

Right What it does

Save/Delete Lets the security group save and delete records.

Void Lets the security group void records.

Change Period Lets the security group change posting periods.

Print Checks Lets the security group print checks.

Exclusive Access
About exclusive access

While users in a network environment can simultaneously work in the same company’s data, some operations require
access to a company be restricted to a single user.

For example, exclusive access is required when rebuilding indexes, copying a company to create a new one, or archiving
the accounting at the fiscal year-end. To protect the data, limit the access of a company to a single workstation during
rebuilding indexes and archiving the fiscal year.

Setting exclusive access

To set exclusive access:

1 From the Sage 100 Contractor main window, on the Filemenu, click Open Company.

2 In theCompany Listwindow, select the company you want.

3 Type your user name and password in the appropriate text boxes.

4 Select theExclusive Access check box.

5 Click OK.

TIP: If the company is already open, you can change the access by selectingChange Username/Access from the
Filemenu. TheUser Name and Passwordwill display and you can select theExclusive Access check box.

Clearing exclusive access

If the company is already open, you can change the access by selectingChange Username/Access from the Filemenu.
TheUser Name and Passwordwill display and you can clear theExclusive Access check box.

To clear exclusive access:

From the Sage 100 Contractor main window, on the Filemenu, click Open Company.

In theCompany Listwindow, select the company you want.

Type your user name and password in the appropriate text boxes.
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Clear theExclusive Access check box.

Click OK.

7-4 Rebuild Indexes

Indexing the database

CAUTION: Back up your data before rebuilding indexes for the database files. If a problem occurs, you can restore
the original data.

As you add or delete information, the amount of space required on the disk drive for storage increases. The actual data,
however, might not require as much storage space. You can remove the deleted data and rebuild the indexes for the
database tables thereby reducing the size of the company file on the disk drive.

When you compact database tables, Sage 100 Contractor creates a new database file using the existing file. This process
requires enough space on the hard disk for two versions of the company database. After rebuilding the indexes, Sage 100
Contractor deletes the old database tables.

IMPORTANT: After installing or reinstalling Sage 100 Contractor, youmust rebuild the indexes of existing
companies.

It is important to prevent users from accessing data while rebuilding the index. That is why youmust open the company
with exclusive access when you index the database.

To rebuild the indexes:
1 From the Sage 100 Contractor main window, on the Filemenu, click Open Company.

2 In theUser Name and Passwordwindow, select theExclusive Access check box, then log in with your user name
and password.

3 From the Sage 100 Contractor mainmenu, select 7-4 Rebuild Indexes.

4 Click theStart button.

5 Sage 100 Contractor rebuilds the indexes.

6 When the rebuilding is complete, click theClose button.

NOTE: If this is a brand new installation of Sage 100 Contractor, and you do not have a pre-existing company, you do
not need to rebuild indexes.

Secure database encryption of sensitive fields
Sage 100 Contractor now encrypts the following sensitive fields by default:

n Credit Card # on Payment Information tab in 3-6 Receivable Clients

n Federal ID # in 4-4 Vendors (Accounts Payable)

n Social Security # onGeneral Information tab in 5-2-1 Employees

n Account # on Direct Deposit tab in 5-2-1 Employees

n Federal Tax ID # in 7-2 Company Information
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n State Tax ID # in 7-2 Company Information

n Card/Chk # on Invoice Details tab in 11-2 Work Orders/Invoices/Credits

You can turn off encryption of sensitive fields onmenu 7-4 Rebuild Indexes in the Options menu by selecting Database
Security Encryption and clicking [Off]. If you turn off encryption, further updates of Sage 100 Contractor will not turn
encryption back on unless youmanually change the setting.

7-5 Update Databases

Update databases for multiple companies

CAUTION: Back up your data before rebuilding indexes for each company that will be updated. If a problem occurs,
you can restore the original data.

After installing a new version of Sage 100 Contractor, youmust update the indexes of existing companies. You can update
the databases for multiple companies without having to load each company using 7-5 Update Databases.

This menu option is only available for the "supervisor" user. Only companies that are not in the current version of Sage 100
Contractor are displayed for selection. Once the "supervisor" user starts the update process, the program opens each
company with exclusive access and when the update is finished for each company, exclusive access is relinquished.

NOTE: If exclusive access can't be acquired for a selected company, a warningmessage is displayed and that
company is skipped for processing.

To update the databases for multiple companies:
1 Log into your company with the "Supervisor" user name and password. Exclusive access is not required.

2 From the Sage 100 Contractor mainmenu, select 7-5 Update Databases.

3 Select the companies to update.

a You can click [Select All] to select all the companies listed or individually choose companies.

NOTE: Only companies that require updating and are located on the drive specified when logging in are displayed in
the list.

4 Click theStart button.

5 Sage 100 Contractor rebuilds the indexes.

6 When the updating is complete, the Updated companies is displayed listing each company that successfully updated.
Click [OK] to close the Update Database window.

7 Click [Close] to closemenu 7-5 Update Databases.

NOTE: If the update process is cancelled, exclusive access is relinquished for the company currently updating and
all remaining companies that have not yet finished. The process can be restarted at a later time for the remaining
companies that have not been updated.

7-6 Repair Database

Support password for repairing a database
Sage 100 Contractor does not support data entry that would cause your system to be out of balance. In most cases, you
can correct entries entered by mistake by posting adjusting entries, journal transactions, or voiding and re-entering
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transactions.

While you can correct some audit errors, for example, by running the repair option in the 1-6 Period/Fiscal Year
Managementwindow, most database errors require help from Technical Support.

We recommend that you always run the repair option in the 1-6 Period/Fiscal Year Managementwindow before calling
Technical Support. The repair option rebuilds the balances from the ledger transactions.

Additionally, if a hardware or software failure occurs, youmay find it necessary to repair the database because of incorrect
or missing data. The following are possible causes for missing data:

l Power failure during the reading or writing of data.

l Turning off the computer’s power supply before exiting Sage 100 Contractor.

l Hard disk failure.

l Other programs causingMicrosoft Windows® to fail while a database is open.

l Using a disk cache utility. Disk caching does not immediately write data to the hard disk.

To ensure data integrity, you can only initiate repairs with the assistance of Technical Support. If you have a current support
contract, Technical Support can help you to repair the database inmost cases. There are circumstances, however, when
repair to the database is not possible. If this occurs, youmust restore themost recent backup.

To get help with database repair or audit errors:
1 Contact Technical Support.

2 Follow the instructions given to you by Technical Support.

7-7 Scheduled Reports Manager

About 7-7 Scheduled Reports Manager
In 7-7 Scheduled Reports Manager, you can view and delete events recorded when scheduled reports are executed.

We recommend that you regularly view the reports manager.

IMPORTANT: If you do not enter a password or you enter one that is not valid when you schedule the report, the
scheduled report will not run.

For each report, the following information will display:

l ID

l Report: Displays the report number and report title.

l Schedule: Displays the current scheduled day and time.

You can do the following for each scheduled report:

l Edit Schedule/Output: Edit the frequency, recurrence, and schedule options for the selected report.

l Edit Selection Criteria: Edit the selection criteria for the selected report.

l Delete: Delete the selected report.
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NOTES:
l The reports manager displays events related to scheduled reports for all companies to which you have access.

l If you need to call Customer Support for help on a scheduled report issue, have the ID, the Report, and the
Schedule information available.

Deleting scheduled reports
We recommend that you regularly view the 7-7 Scheduled Reports Manager and delete reports that you no longer need.

To delete a scheduled report:
1 Open 7-7 Scheduled Reports Manager.

2 Select the row for the report you want to delete.

3 Click [Delete].

The selected scheduled report will be deleted. More than one report can be deleted at the same time.

7-8 Contact Manager

About 7-8 Contact Manager
Contact Manager allows you to add and update 3-5 Jobs (Accounts Receivable), 3-6 Receivables Clients, and 4-4
Vendors (Accounts Payable) contact records in your Outlook contacts.

The contacts are added in a Sage 100 Contractor folder in Outlook. Updates made in Outlook to those Sage 100 Contractor
contacts can be synchronized and saved back to the contact records in Sage 100 Contractor.

NOTE: Any contacts added to the Sage 100 Contractor folder that were originated in Outlook cannot be added back
into Sage 100 Contractor. Contacts must originate in Sage 100 Contractor.

From this window, you can:

l Manage contacts frommultiple companies

l Sync with Outlook

l Sort contacts by contact type, contact record, short name, contact name

l Drill down into single contact record

Syncing contacts with Outlook
You can sync your Sage 100 Contractor contact records with Outlook.

Adding Sage 100 Contractor contacts to Outlook:
1 Double click in the Link with Outlook column of the contact you want to add to the sync.

2 The word Add appears, indicating this contact record will be synced.

3 Repeat until you've selected all the contacts that you want to send to Outlook.

4 Click the Sync With Outlook button.

NOTE: If a contact is listedmultiple times in Sage 100 Contractor, it may contain different values for the same field.
In these cases, you're presented with a conflict resolution window where you can decide which value should be used
in the Outlook record. See "Resolving conflicts with contact records" for more information.
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Syncing Sage 100 Contractor contacts with Outlook:
1 Click the Sync With Outlook button.

l All contacts that show Sync in the Link with Outlook column are updated in Outlook.

l All contacts that show Add in the Link with Outlook column are added to Outlook.

2 Any conflicts are presented to you on the conflict resolution window.

IMPORTANT: If presented the followingmessage, “Unable to continue: Sage 100 Contractor unable to connect
to Outlook,” then close Sage 100 Contractor andmake sure you are not running Sage 100 Contractor with
administrator privileges.

Sorting contacts in 7-8 Contact Manager
You can sort the contact records using the followingmethods:

l Sorting by column

l Sorting by company

Sorting by column
1 Click on column header to select entire column.

2 Right-click anywhere in column and select Sort by Column NameColumn.

Sorting by company
1 Click Manage contacts from multiple companies.

2 Select companies to view.

3 Companies are displayed (unless sorted by column) by contact type first, in the following order:

l Client

l Job

l Vendor

Manage contacts from multiple companies
Manage contacts frommultiple companies by clickingManage contacts from multiple companies and selecting the
appropriate companies in the navigation window.

IMPORTANT: Youmust have the appropriate
security rights to display the contacts from a company.

Displaying a single contact record using Drill Down
To drill down a contact record:
1 Click a single row or click any columnwithin that row.

2 Click the Drill Down on the bottom left of the window.
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The source contact record data entry screen for the currently selected row is opened in the appropriate window. For
example, clicking on a row with a job contact type drills down to the contact record in the 3-5 Jobs (Accounts Receivable)
window.

Resolving conflicts with contact records
Conflicts are displayed with a bold red label, and show that there aremultiple values existing for at least one field in this
contact record.

To resolve conflicts:
1 Select the list for the field with a conflict.

2 Select the correct value for this field.

3 (Optional) Click the adjacent Update Sage 100 Contractor contact records to also update Sage 100 Contractor
contact records when updating the Outlook contact record.

4 Click [Finish].

NOTE: If you do not click the Update Sage 100 Contractor contact records check box when correcting contact record
conflicts, the conflict may be presented again the next time you synchronize records with Outlook.

Update Sage 100 Contractor contact records
If Sage 100 Contractor detects conflicts when attempting to sync with Outlook, you can update just the Outlook contact
information, or update both the Outlook contact information and the Sage 100 Contractor contact records.

To update Sage 100 Contractor contact records:
Click the Update Sage 100 Contractor contact records button next to the Full Name field.

NOTE: If you do not click the Update Sage 100 Contractor contact records check box when correcting contact record
conflicts, the conflict may be presented again the next time you synchronize records with Outlook.

7-9 Alerts Manager

About 7-9 Alerts Manager
Alert Queries tab:

Alert queries allow you to create a query that is executed automatically every day at a specified time, with the defined
results returned only when the query’s conditions aremet. You can choose to receive the alert notifications for any
particular custom alert via email, dashboard or both.

You can:

l Create new custom alerts

l Import alerts

l Edit existing custom alerts

l Copy an existing custom alert

l Delete a custom alert

l Activate a custom alert (if there any existing custom alerts that are disabled or snoozed)
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l Snooze a custom alert

l Disable a custom alert

Process my alert queries every day at:

If you have not previously selected a value, the list box appears without any text. Otherwise, the previously selected time is
displayed when the window opens. A value is required if there are any custom alerts, or there are any program alerts that
are set to Email for the Alert Method.

l When required, the label text is blue; otherwise it’s black.

l The timemust be selected from the list; there is no ability to directly enter or a time or further modify a selected time.

l If the user is currently using amachine that’s different from themachine on which they previously saved the time,
the 7-9 window opens with this label and list box disabled and amessage informs the user that they can do anything
else in this window except change the processing time.

When the 7-9 window is closed and the selected time has changed, the program saves the changes to the windows Task
Scheduler and the database.

Program Warning Subscriptions tab:

Program warnings are defined as warnings that are given to the user during processing that the user chooses to ignore.
Program warning subscriptions allow you to subscribe to be alerted when these program warnings are ignored and the
transaction is processed anyway. You can choose to be notified for the particular program warning via email or dashboard.

Events Log:

The event log provides detailed insight into the daily processing of the custom alerts. You can view the log for all custom
alerts or view the log for a period of days (7 days, 14 days, and 30 days).

Email from:

This text box shows you what email account is sending the email notifications. Clicking the [Email Settings] button opens
a window to change the email account information.

Creating Alert Queries in 7-9 Alerts Manager
You can create custom alerts.

To create a custom alert:
1 Open 7-9 Alerts Manager.

2 Click [New].

3 Enter the alert name and click [Next].

4 Select the table that holds the primary data for the report by either navigating to themenu where the records can be found
or select List Tables by Name to view an alphabetical list of all tables, then click [Next].

5 Double-click on fields in the Fields list on the right to include in the alert notification.

6 Sort, reorder, and delete columns as necessary in the bottom left panel and click [Next].

NOTE: Youmay choose fields from another table by selecting a different table from the Tables list on the left at any
time.

7 Select the fields for alert selection criteria.
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8 Select the comparison option from the list.

NOTE: Date fields use special variables, such as 'Today,' or some specific number of days in the future or past. The
comparison 'Occurs during' offers variables representing entire weeks or months.

9 Click [Next].

10 Choose one or more of the following options to select how to receive your alert notifications:

a My Dashboard

b Other Dashboard

c Email

11 In the Alert Schedule section, choose one of the following options:

a Daily

b Weekly (select a day of the week from drop-downmenu)

c Monthly (enter a day of themonth)

12 (Optional) If you selected the Email option for your alert notification, do the following:

a Enter at least one email address in the "Email To" address field.

b (Optional) Enter an email address in the "Email CC" address field.

c Enter an email subject line. A default subject line is provided, but you can change it.

d (Optional) Enter any explanatory text for the report of the alert notification. Text appears above report information.

e Select the importance of the email.

f (Optional) Check the "Request Read Receipt" box.

13 (Optional) To test how the alert would look if sent to the Dashboard or to email, do the following:

a Click [Send Test to Dashboard] to view how the alert would appear in the Dashboard.

b Click [Send Test to Email] to view how the alert would appear in an email message.

14 Click [Finish].

Importing alert queries in 7-9 Alerts Manager
You can import alert queries into Sage 100 Contractor.

To import an alert query:
1 Open 7-9 Alerts Manager.

2 Click [Import].

3 Select the alert query name and click [Import].
The Alert wizard opens and steps you through importing the alert query. You can leave the settings from the alert query
being imported, or customize the alert query based on your needs.

Activating an alert query
If you've disabled an alert query and want to make it active, you can activate the alert query.

To activate a custom alert:
1 Open 7-9 Alerts Manager.
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2 Select alert query to activate.

3 Click [Activate].

Disabling an alert query
You can disable an alert query instead of deleting an alert query, if you want to have the alert query available to activate
later without creating it again.

To disable an alert query:
1 Open 7-9 Alerts Manager.

2 Select an alert query to disable.

3 Click [Disable].

Deleting an alert query
You can delete an alert query.

NOTE: Make sure you want to permanently delete the alert. You can also disable the custom alert. How?

To delete an alert query:
1 Open 7-9 Alerts Manager.

2 Select the alert query to delete.

3 Click [Delete].

Snoozing a custom alert
You can snooze a custom alert to skip the processing of the alert.

The available day options for snoozing are:

l 1 day

l 2 days

l 3 days

l 4 days

l 5 days

l 6 days

l 7 days

l 14 days

l 30 days

Snoozing an alert query changes the status to Snoozed and updates the Snoozed Until field with the appropriate date.

To snooze an alert query:
1 Open 7-9 Alerts Manager.

2 Select alert query to snooze.
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3 Click [Snooze] and select the days for snoozing.

About Program Warnings
Program warnings are displayed to users during processing, but a user can continue with processing regardless of a
warning.

If you want to be alerted whenever a user ignores a program warning, subscribe to the program warning in the 7-9 Alerts
Managerwindow. You can choose to be notified about a particular program warning by email or through the dashboard.

Transaction date doesn't match the posting period

When you save a transaction, Sage 100 Contractor can compare the transaction date to the period to ensure you post to the
correct period. If the transaction date does not fall in the correct posting period, Sage 100 Contractor warns you, but does
not prevent you from posting the transaction.

To verify the date and period, in the 1-8 General Ledger Setupwindow, select the Verify Date/Period check box. How?

Subcontract exceeds budget for cost code

When you save a subcontract, Sage 100 Contractor can warn you if actual plus committed costs for a cost code exceed
the budget (including changes and the tolerance amount). Sage 100 Contractor does not prevent you from saving the
subcontract when it displays a warning.

To use this warning, in the 6-7-1 Subcontractswindow, select Options > Set Subcontract Over Budget Warnings, and
then set theMessage Type toWarnings and specify a tolerance type.

PO exceeds budget for cost code

When you save a purchase order, Sage 100 Contractor can warn you if actual plus committed costs for a cost code exceed
the budgeted amount (including changes and the tolerance amount). Sage 100 Contractor does not prevent you from saving
the purchase order when it displays a warning.

To use this warning, in the 6-6-1 Purchase Orderswindow, select Options > Set PO Over Budget Warnings, and then
set theMessage Type toWarnings and specify a tolerance type.

Job Costs exceed budget for cost code

TheOver Budget Warning command notifies you if costs exceed the budgeted amount for a job. When you select the Over
Budget Warning command, Sage 100 Contractor determines the costs to date plus committed costs for the jobs by phase,
cost code, and cost type. It then compares the data to the original budget plus change orders. When you save the record,
Sage 100 Contractor notifies you if costs exceed the budgeted amount for a job.

To use this warning, the Set Over Budget Warning optionmust be selected and configured for any Job Cost entry window.
How?

Job costs posted with no budget for cost code

When you select the Budget Verification command, Sage 100 Contractor compares the cost codes and cost types on the
job cost screen against the cost codes and cost types in the budgets. When you save the record, Sage 100 Contractor
notifies you if a line item does not appear in the budget of a job.

To use this warning, the Budget Verification optionmust be selected in a Job Cost entry window. How?

Payable invoices exceed subcontract total

When saving a payable invoice for a vendor, Sage 100 Contractor refers to the Set Over Subcontract Warning option to
determine if the invoice amount exceeds the subcontract balance. If the payable invoice does exceed the balance, Sage
100 Contractor provides you with a warning.
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To use this warning, 4-2 AP Invoice > Options > Set Over Subcontract Warningmust be selected and configured.
How?

NOTE: When Subcontracts are exported from 9-5 Takeoffs, the warning that the subcontract exceeds the budget
amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. After
exporting subcontracts through 9-5 Takeoffs, you should run the 6-1-12-21 Committed Costs report for the correct
job to verify that subcontracts have not exceeded the budget.

Payable invoice posted without an expected PO

When saving a payable invoice for a vendor, Sage 100 Contractor refers to the selectionmade in the PurchaseOrder
Warning list in the vendor’s record. If the payable invoice does not meet the criteria, Sage 100 Contractor provides you with
a warning.

To use this warning, 4-4 Vendor > Invoice Defaults Tab > PO Warning > 1—Warn if no POmust be selected.

Payable invoices exceed purchase order total

When saving a payable invoice for a vendor, Sage 100 Contractor refers to the selectionmade in the Set Over PO Warning
settings in 4-2 Payable Invoices/Credits or 4-4 Vendors (Accounts Payable). The setting in 4-4 Vendors (Accounts
Payable) overrides the setting in 4-2 Payable Invoices/Credits. If the payable invoice does not meet the criteria, Sage 100
Contractor warns you.

To use this warning, 4-4 Vendor > Options > Set Over PO Warningmust be selected and configured. How?

NOTE: When PurchaseOrders are exported from 9-5 Takeoffs, the warning that the purchase order exceeds the
budget amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. After
exporting purchase orders, you should run the 6-1-12-21 Committed Costs report for the correct job to verify that
purchase orders have not exceeded the budget.

Inventory location has insufficient part quantity on service invoice

When you select the Verify Stock on Save command, Sage 100 Contractor checks whether you have enough stock in the
specified inventory location. If there is not enough stock available, Sage 100 Contractor warns you.

To use this warning, 11-2 > Options > Verify Stock on Savemust be selected. How?

Inventory location has insufficient part quantity on inventory allocation

When you select the Verify Stock on Save command, Sage 100 Contractor checks whether you have enough stock in the
specified inventory location. If there is not enough stock available, Sage 100 Contractor warns you.

To use this warning, 12-2 Inventory Allocation > Options > Verify Stock on Savemust be selected. How?

Troubleshooting the 7-9 Alerts Manager
This topic describes how to resolve problems that can occur with the 7-9 Alerts Manager.

You set up alerts, but you are not receiving messages

If you set up alerts for certain conditions in your Sage 100 Contract data, but you do not receive any alerts, either the
conditions did not exist when the alerts were processed or the Alerts Manager did not process the alerts according to the
schedule for some reason.

You can select an option to receive a warning when the Alerts Manager fails to process alerts.
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TIP: We recommend that you select theShow warning at login when alert processing misses option in the 7-9
Alerts Managerwindow.

If the Alerts Manager did not process alerts as expected, you need to determine why. The following situations are possible
causes, which you should check and rectify, as follows:

l The computer that was set up to process the alerts may have been replaced with a different computer.

You need to configure the new computer to process the alerts. See Alerts processing is set up to run on a computer
that is no longer functioning.

l The computer that was set up to process the alerts may not have been working at the time the alerts were supposed
to have been processed. For example, it may have been turned off, or it could be hibernating or malfunctioning.

Do not schedule processing for a time when the computer will be offline. Either reschedule alert processing, or
ensure that the computer will not hibernate when alerts are scheduled for processing.

l If the computer is permanently disabled, you need to set up the alerts on a different computer. See Alerts processing
is set up to run on a computer that is no longer functioning.

Theremay be a problem with theWindows Task Scheduler service. You need to ensure that:

l The Task Scheduler service is running.

l The Task Scheduler record exists in the Task Scheduler window.

For information on usingWindows Task Scheduler, see theWindows help.

Alerts processing is set up to run on a computer that is no longer functioning

If the computer that is set up to process alerts becomes disabled or is replaced, you need to set up processing on a different
computer.

Open 7-9 Alerts Manager, and then, on theOptionsmenu, click Allow me to set up processing on this computer.

NOTE: You need administrator rights for a computer to set up a computer to process alerts.

You receive multiple messages for the same alert conditions

This condition can occur if you have set up processing onmore than one computer.

Decide which computer should process the alerts.

On the other computer(s), open 7-9 Alerts Manager, and then, on theOptionsmenu, click Remove my alert processing
from this computer.

Data Backup

About backing up data
Backing up your accounting data is critical to ensuring its safety and integrity. Having backups of your data can solvemany
problems and can also help Customer Support to isolate and identify errors. While you can replace program files or
computer hardware, you will not be able to replace accounting data without a backup.

CAUTION: When backing up your data, be sure tomake a full backup and not an incremental or differential backup.
An incremental or differential backup only records alterations to the data since the last backup.
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There aremany causes for data file corruption, ranging from faulty hardware to power fluctuations. If you do not have a
backup routine established before losing data, you will have to re-enter all your accounting data. With a recent backup,
however, you can restore your data.

Problems with your data are not always immediately apparent, and data entry can continue for some time without
discovering any errors. In a strong backup routine, you create a series of backups over time that would allow you to restore
a backupmade prior to the introduction of the errors.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company.

To see the number of files and folder in a company folder:
1 InWindows Explorer, right-click the company folder and select Properties.

2 On thePropertieswindow, theGeneral tab, look in the list for theContains line for the number of files and folders.

3 Write this number down so that you can refer to it after you havemade the two copies. The number of files and folders
has to be exactly the same in both the company and the backup copy.

IMPORTANT: Sage 100 Contractor software itself does not provide ameans to back up your data because the
backup process is dependent on your hardware and operating system. You need to set up a backup procedure using a
tape drive, DVD, or third-party backup software before entering data in Sage 100 Contractor.

Which files to back up in Sage 100 Contractor
When you back up your company data, we recommend that you back up your company financial data as well as all your
custom reports and forms. If you are runningmultiple Sage 100 Contractor companies, back all of them up.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company.

To see the number of files and folder in a company folder:
1 Properties.

2 On thePropertieswindow, theGeneral tab, look in the list for theContains line for the number of files and folders.

Write this number down so that you can refer to it after you havemade the two copies. The number of files and folders have
to be exactly the same in both the company and the backup copy.

CAUTION: If you are working across a network, youmust remember to back up company folders, report folders, and
form folders that reside at the server.

We strongly recommend that you back up:

l Each company folder that contains financial data (\MB7\Your Company\)

l TheSage 100 Contractor folder (\Users\Username\AppData\Local\Sage\Sage 100 Contractor)

l TheReport Forms folder (\Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\Report Forms)

CAUTION: When backing up your data, be sure tomake a full backup and not an incremental or differential backup.
An incremental or differential backup only records alterations to the data since the last backup.

An example of one backup method
There are various methods for backing up your data. Depending on the amount of data entry you routinely perform, you
might consider making full daily backups. It is also a good idea to regularly take one backup off the business premises or
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store them in a fireproof safe. If a burglary or fire occurs, a copy of your data is safe from harm.

One reliable procedure, requiring a tape drive andmultiple sets of tapes, requires you tomake daily andmonthly backups.

The daily backup process:

For the daily backup process, you need 10 tapes.

1 Label five of the tapes as Week A, with a tape designated for each weekday.

2 Label the other five tapes as Week B, with a tape designated for each weekday.

3 Start with the set of tapes labeledWeek A.

Monday night when youmake the backup use the tape labeledMonday, on Tuesday use the tape labeled Tuesday, and so
forth.

4 At the start of the next week, use the set of tapes labeledWeek B tomake your backups.

At the end of two weeks, you will have a data backup for each day.

5 At the start of the third week, use the set of tapes labeledWeek A again.

Over the course of a year, you will cycle through the two sets of tapes. Be sure to store themost recent Friday backup off
site.

The monthly backup process:

For themonthly backups, you need a separate set of three tapes labeledMonth A, Month B, andMonth C respectively.

1 Like the weekly backups, use each tape to back up the data for a different month, cycling through each of the tapes over
the course of the year.

2 After making amonthly backup, write themonth and year on the label to help you track which tape to use next.

3 Be sure to remove themost recent monthly backup off site.

CAUTION: When backing up your data, be sure tomake a full backup and not an incremental or differential backup.
An incremental or differential backup only records alterations to the data since the last backup.

Backing up your data to a CD or DVD
This topic suggests a generic way to back up your data to a CD or DVD.

CAUTION: If you are working across a network, youmust remember to back up company folders, report folders, and
form folders that reside at the server.

IMPORTANT: Backing up to a CD or DVD successfully depends on your computer system, including hardware and
software. To back up to a CD or DVD, youmust have access to a CD or DVD (Read/Write capability), and the
appropriate CD or DVD media.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company. To see the number of files and folder in a company folder, inWindows Explorer, right-click the company folder
and select Properties. On thePropertieswindow, theGeneral tab, look in the list for theContains line for the number of
files and folders. Write this number down so that you can refer to it after you havemade the two copies. The number of files
and folders have to be exactly the same in both the company and the backup copy.

IMPORTANT: If the number of files and folders in the original version do not match the numbers in the copy, you
must repeat the process. It is imperative that the copy is an exact duplicate of the original company.

To back up your data to a CD or DVD:
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1 Place the CD or DVD media in the CD or DVD.

2 On yourWindows desktop, right-click [Start > Explore].

3 InWindows Explorer, locate the \Users\Username\AppData\Local\Sage\Sage 100 Contractor folder, right-click and from
themenu select [Copy].

4 Locate the CD or DVD drive, and click it.

5 Then in the right-pane, right-click and select [Paste].

6 InWindows Explorer, locate the \MB7\ folder, right-click and from themenu select [Copy].

7 Locate the CD or DVD drive, and click it.

8 Then in the right-pane, right-click and select [Paste].

Depending on your hardware and software, the folder will be copied to the CD or DVD media. For further information or
support, contact your CD or DVD manufacturer.

Data Maintenance

Performing general Sage 100 Contractor maintenance
Performing regular maintenance is critical to maintaining data integrity. It is highly recommended that you perform regular
maintenance on your system to avoid the possibility of system failure or data loss. For amuchmore detailed list of tasks
that can help youmaintain your Sage 100 Contractor system, see, “Timetable of Office Procedures.”

To perform general Sage 100 Contractor maintenance:
1 Back up all your Sage 100 Contractor companies and data.

2 Perform a general ledger repair and audit using 1-6 Period/Fiscal Year Management.

3 If there is an error, find and repair it, and run 1-6 Period/Fiscal Year Management again.

4 If there is still an error, call Customer Support.

5 After all errors have been repaired, rebuild indexes with 7-4 Rebuild Indexes.

Printers

Installing printers
Operating systemmanufactures and printer manufacturers provide printer drivers, not Sage 100 Contractor. To print more
than simple text requires printer drivers specific to your brand andmodel of printer. Generic text-only printer drivers work
with all printers, though they cannot print graphics.

We recommend using laser or ink jet printers with Sage 100 Contractor because they are able to print graphics. You can
also use dot matrix printers for producing accounting reports and checks.

To install printers:
1 On theStartmenu, point toSettings, and click Printers.

2 Double-click theAdd Printers icon.

3 Follow the instructions in theAdd Printer Wizard.

NOTE: Refer to your operating system’s documentation for more information about installing printers.
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Installing the Generic-Text Only printer driver
To install the Generic/Text Only printer driver:
1 Click theStart button, point toSettings, then click Printers.

2 Double-click theAdd Printer icon.

3 Follow the directions in theAdd Printer Wizard. Be sure to do the following:

a UnderManufacturers, select Generic.

b UnderPrinters, select Generic/Text Only.

c Then underAvailable Ports, select File.

Printing to file using the Generic-Text Only driver
To print to file using the Generic/Text only driver:
1 On themenu bar, click Print Records.

2 In theReport Type list, click the report that you want to print.

3 In thePrinters list, click Generic/Text Only.

4 In the Form Design list, click the form design that you want.

5 On theSelection Criteria tab, enter the criteria that you want to use for selecting data.

6 To preview the document, click thePreview button.

7 On themenu bar, click Print Records.

8 Name the file and navigate to the folder where you want to save it, then click OK.

Printer driver errors
Depending on your hardware and software configurations, some printer drivers may not work. Following are some possible
solutions to errors caused by printer drivers:

l Install themanufacturer’s printer drivers supplied with the printer. Some printers require themanufacturer’s drivers
and not the drivers supplied with the operating system.

l For your brand of printer, select a printer driver of an earlier model. For example, an HP4 LaserJet can use HP Series
ll drivers; an Epson LQ 580 can use Epson LQ 500 drivers.

l Select a printer driver that your printer emulates. Consult the printer manual to determine the type of printer your
printer can emulate, as well as for instructions on setting up the emulation. When emulating a different printer some
features may be lost.

NOTE: Please refer to your printer manual or contact the printer manufacturer regarding printer or printer driver related
problems.

Changing the default printer driver
You can assign a different printer driver as the default for each report.

To change the default printer driver:
1 Open theReport Printingwindow.

2 In theReport Type list, click the report to which you want to assign a printer.
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3 In thePrinters list, click the printer you want as the default.

4 On theDefaultmenu, click Save Defaults.

NOTE: For further information about printer drivers, refer to your printer manual.
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Chapter 8: Equipment Management
Working with Equipment Management
Working withEquipment Management provides many benefits. You can allocate equipment costs to jobs so that you’ll
always know the project’s true costs. You can track your equipment maintenance, repair costs, and earned income. You
can calculate cost recovery rates simply by entering your ownership and operating costs into theCost Recovery
calculation tool and letting Sage 100 Contractordetermine the appropriate operate, idle, and standby rates.

If you rent a truck or hire a piece of equipment, you can enter the information in the 5-5-1 Daily Payroll Entrywindow or the
8-4 Equipment Allocationwindow to ensure that the equipment supplier bills you properly. Equipment time entered into
payroll can include repairs performed by your employees as well as equipment used to service other equipment.

You can categorize equipment by type. For time andmaterials billing, you can get hourly, daily, weekly, or monthly rates.
You can create checks for lease or equipment payments and automatically keep track of remaining loan balances. In
addition you can use the locator function to discover where the equipment was last used.

Here aremore benefits of working withEquipment Management:

l Manage equipment maintenance.

l Create equipment loan payments and post depreciation automatically.

l Determine cost recovery rates based on ownership andmaintenance.

l Use cost records to review the profitability of equipment ownership.

8-1 Equipment Reports
See Appendix B for a complete list of 8-1 Equipment Reports.

About equipment documents
8-1-6 Equipment Documents prints documents designed in 13-5 Form/Report Page Design for equipment.

The types of equipment documents created can include rate cards andmileage reports. When designing an equipment
document, you canmerge information from the job, client, employee, and vendor files. Save the equipment documents
using the *.docs_equipment file name extension.

8-2 Equipment Costs

About equipment costs
Equipment costs provide detailed information about ownership andmaintenance costs for equipment, provide another way
to analyze costs, and refine the estimating or budgeting process. When you post a transaction to theEquipment/Shop
Expense range of accounts, Sage 100 Contractor creates equipment cost records in the 8-2 Equipment Costswindow.
Equipment cost records do not impact the general ledger.

IMPORTANT:
l If a text box is shaded, you cannot directly edit the data. You can only change it through an accounting entry.

l Sage 100 Contractor does not create equipment cost or revenue records from time andmaterials invoices.
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About equipment cost distribution
When you post transactions to theEquipment/Shop Expense range of accounts, Sage 100 Contractor displays
Equipment Costswindow regarding cost distribution. InEquipment Costs, you can break apart costs to create individual
line entries that reference equipment, cost codes, and cost types.

The Ledger Total box displays the total debits less credits posted toEquipment Expense accounts. As you enter cost
records, Sage 100 Contractor shows the total amount in theEquipment Total box. To save the equipment cost record, the
amount in theEquipment Total box must equal the amount in the Ledger Total box.

Entering equipment costs
When you post transactions to theEquipment/Shop Expense range of accounts, Sage 100 Contractor displays the 8-2
Equipment Costswindow regarding cost distribution.

To enter equipment costs:
1 Open 8-2 Equipment Costs.

2 In theEquipment text box, enter the equipment number.

3 In theDescription text box, enter a brief statement about the equipment cost.

4 In theCost Code text box, enter the cost code.

5 In theCost Type text box, enter the cost type.

6 In theCost text box, enter the cost of the item.

7 Repeat steps 2–6 for each item that you want to create a cost record.

8 On the Filemenu, click Save.

Voiding equipment costs
To void an equipment cost:
1 Open 8-2 Equipment Costs.

2 Using the data control, select the record.

3 On theEditmenu, click Void Cost Record.

IMPORTANT:
l TheVoid Cost Record command is only available if the equipment record that you want to void originated in 8-

2 Equipment Costs.

l You can only void a historical equipment cost if it does not originate from another source in Sage 100
Contractor.

l When you void a transaction in the window of original entry, Sage 100 Contractor also voids the cost record.

Working with Historical Equipment Costs and Records
Methods for entering historical equipment cost records

You can enter historical cost records for each piece of equipment. There aremany ways to enter the cost records. Select a
method appropriate for the piece of equipment. While somemethods require additional time and effort, thosemethods
producemore detailed reports than the faster methods of entry.
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For example, youmight only need the total costs for an older piece of equipment, whereas youmight want the individual
costs for a new piece of equipment.

IMPORTANT: Sage 100 Contractordoes not automatically create equipment costs for payroll records assigned
payroll record type 3-Hand Computed or 4-Startup. If you are using thePayrollmodule and have entered the year-to-
date payroll history, determine the equipment costs associated with payroll and figure those costs into the appropriate
historical cost entries.

Method 1

For each piece of equipment, enter one equipment cost record. Determine the amount from the total cost to date for the
equipment at the time when the general ledger was set up. It is recommended that you assign the record cost type 5-Other.
Post each record to the period just prior to the current period.

Because you are entering a single amount that may cover many cost codes, create a special cost code for this purpose.
Youmight name the cost code something likeUnassigned or Lump Sum Start Up.

This method provides reports based on cost codes, cost types, or accounting periods that do not contain any detailed data.

Method 2

For each piece of equipment, enter one equipment cost record for each cost code. Determine the amount from the total
costs to date for each cost code for each piece of equipment at the time when the general ledger was set up. It is
recommended that you assign the record cost type 5-Other. Post each record to the period just prior to the current period.

This method provides reports with an accurate breakdown of costs for each cost code except in Journal reports orCurrent
Cost Summary reports. Reports based on cost types or accounting periods do not contain any detailed data.

Method 3

For each piece of equipment, enter one cost record for each cost code in the prior fiscal year and another cost record for the
current fiscal year. First, determine the accumulated costs for each cost code in the prior fiscal year. Then enter a separate
cost record for each cost code, posting each to period 0.

Next, determine the accumulated costs for each cost code in the current fiscal year. For each cost type, enter a separate
cost record. Post each record to the period just prior to the current period.

This method provides reports with an accurate breakdown of costs for each cost code, but does not provide accurate
Journal orCurrent Cost Summary reports. Reports based on cost types or accounting periods do not contain any
detailed data.

Method 4

For each piece of equipment, enter one cost record for each combination of cost code and cost type in the prior fiscal year.
Then enter another cost record for each combination of cost code and cost type in the current fiscal year.

First, determine the accumulated costs for each combination of cost code and cost type in the prior fiscal year. Then enter a
separate cost record for each combination of cost code and cost type, posting each to period 0.

Next, determine the accumulated costs for each combination of cost code and cost type in the current fiscal year. For each
combination of cost code and cost type, enter a separate cost record. Post each record to the appropriate accounting
period.

Suppose you are starting up in period 7. Determine the accumulated costs for each combination of cost code and cost type
in each period. Then enter a cost record for each combination of cost code and cost type in periods 1 through 6.

This method provides reports with an accurate breakdown of costs for each cost code and cost type during the previous
and current fiscal years.
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Entering historical equipment cost records

To enter a historical equipment cost record:

1 Open 8-2 Equipment Costs.

2 In theEquipment text box, enter the equipment number.

3 In the Trans# text box, type Start Up.

4 In theDate text box, enter the date. Be sure to enter the same date used in the Ledger Account balance setup.

5 In theDescription text box, type Start Up.

6 In theCost Code text box, enter the cost code.

7 In theCost Type list, click the cost type.

8 In theCost text box, enter the amount.

9 On the Filemenu, click Save.

TIPS:
l Be sure to select the correct posting period.

l You can void historical job cost records.

Methods for entering historical equipment revenue records

Equipment revenue records provide information about the income generated by equipment. You can analyze revenue
generated by a piece of equipment and adjust cost recovery rates tomaintain profitability. Equipment revenue records do
not impact the general ledger.

Look over each of themethods outlined below. Method 1 is by far the simplest, but it is also themost limited for reports.
Method 2 is themost commonly usedmethod. Method 3 provides themost detail, but requires more time and effort.

Method 1

For each piece of equipment, enter one equipment revenue record. Determine the amount from the total revenue to date for
the equipment at the time when the general ledger was set up.

Because you are entering a single amount that may cover many cost codes, create a special cost code for this purpose.
Youmight name the cost code something likeUnassigned or Lump Sum orStart Up.

Reports based on cost codes or accounting periods do not contain any detailed data.

Method 2

For each piece of equipment, enter one equipment revenue record for each cost code. Determine the amount from the total
revenue from the total revenue to date for each cost code for each piece of equipment at the time when the general ledger
was set up.

Provides reports with an accurate breakdown of costs for each cost code. Reports based on accounting periods do not
contain any detailed data.

Method 3

For each piece of equipment, enter an equipment revenue record for each cost code in the prior fiscal year and another
revenue record for the current fiscal year. First, determine the accumulated costs for each cost code in the prior fiscal year.
Then enter a separate revenue record for each cost code. Post each record to period 0.
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Next, determine the accumulated revenue for each cost code in the current fiscal year. Then enter a separate revenue
record. Post each record to the appropriate accounting period.

Suppose you are starting up in period 7. Determine the accumulated revenue of each cost code in each period. Then enter a
revenue record for each cost code in periods one through six.

Reports will contain an accurate breakdown of costs for each cost code except in Journal reports orCurrent Cost
Summary reports.

8-3 Equipment Records

About equipment
In the 8-3 Equipmentwindow, you can create an equipment record to helpmanage billing andmaintenance. By supplying
the loan information, you can create loan payments and post depreciation.

For each piece of equipment, determine its cost recovery rate based on the ownership andmaintenance costs. When you
enter payroll or equipment allocation records, Sage 100 Contractor uses the cost recovery rate to create the appropriate job
or equipment cost records. Using the cost records, you can review the profitability of equipment.

Entering equipment records
To enter an equipment record:
1 Open 8-3 Equipment.

2 In the data control text box, enter the equipment number.

3 In theShort Name text box, enter the short name of the equipment.

4 In theDescription text box, enter the description of the equipment.

5 On theEquipment Information tab, do the following:

a In theSerial# text box, enter the equipment’s serial number.

b In the License# text box, enter the license number.

c In thePUC# text box, enter the Public Utility Commission number for the equipment.

d In the Interest Acct text box, enter the ledger account number for equipment loan interest.

e In theDeprec Acct text box, enter the ledger account number for equipment depreciation.

f In theDepartment text box, enter the department number.

g In theStatus list, click the status of the equipment.

h In theEquip. Type list, click the type of equipment.

i In the Last Location text box, enter the location where the equipment was last used.

j In thePurchased text box, enter the date when you purchased the equipment.

k In theOriginal Hours text box, enter the number of hours of use when you purchased the equipment.

l In theOriginal Miles text box, enter the number of miles of use when you purchased the equipment.

m In theHours text box, enter the current hours of equipment use.

n In theMiles text box, enter the current miles of use.

o In the Loan Type list, click the type of loan you have for the equipment.
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p In the Lender text box, enter the vendor number of the lender.

q In the Loan# text box, enter the loan number.

r In the Interest Rate text box, enter the loan’s interest rate.

s In thePayment text box, enter themonthly payment amount for the loan.

t In thePay Date text box, enter the next due date for payment.

u In theDepreciation text box, enter the flat amount to depreciate.

6 Calculate the cost recovery rate.

7 On the Filemenu, click Save.

TIP: You can store an image of the equipment with an equipment record.

Setting up equipment types
You can set up a list of equipment types, allowing you to categorize equipment. The following is an example of equipment
types.

Equip Type # Type Name

1 Forklift

2 Boom truck

3 Loader

4 Platform lift

To set up equipment types:
1 Open 8-3 Equipment.

2 Next to theEquip. Type text box, click the detail button.

3 In theEquipment Type# text box, enter the number.

4 In the Type Name text box, enter a description of the type.

5 Repeat steps 3–4 for each type.

6 On the Filemenu, click Save.

Deleting equipment records
To delete an equipment record:
1 Open 8-3 Equipment.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Equipment.

Costs of Operation
About costs of operation

This functionality is only available if you have the Equipment Module.

http://www.na.sage.com/sage-100-contractor/modules/service-management
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In 8-3 Equipment on theCost Recovery/Rental Rates tab, underCost of Operation, enter the costs to operate the
equipment per unit of use. Include the labor costs for the fueling andmaintenance work, but do not include the labor costs
for equipment operation. The labor costs associated with equipment operation are handled through payroll.

When you calculate the rates, Sage 100 Contractor computes the total operating costs per unit and displays that rate in the
Operating Total text box.

About equipment cost recovery

This functionality is only available if you have the Equipment Module.

You can remove the guesswork associated with recovering equipment costs. On theCost Recovery/Rental Rates tab of
8-3 Equipment, you can provide the cost to own and operate the equipment for a resource consumption period as well as
the estimated use for the resource consumption period. You can then compute an estimated per-unit rate to recover costs.

Through the cost recovery rate, you post the costs for owning and operating equipment to the job. The accounting
transaction posts a debit to the Job Expenses account in theDirect Expense range, and a credit to theEquipment
Revenue controlling account in theEquipment/Shop Expense range. The transaction increases direct expenses and
reduces overhead expenses, resulting in amore realistic view of job profits. At the same time, Sage 100 Contractor creates
a job cost record and an equipment revenue record.

To determine the cost recovery rate, project the use and costs that you can expect based on records from previous years.
Do not include the cost of labor in the operational costs because job costs created in Sage 100 Contractor include the
equipment operator’s time. It is a good idea to review the cost recovery rate every year andmake adjustments. If you
discover that the equipment use is considerably higher or lower than expected, evaluate the cost recovery rates sooner.

About rental units

This functionality is only available if you have the Equipment Module.

Some contractors rent out their equipment to other contractors. You can charge the client a flat fee using billing rate while
tracking job costs using the cost recovery rate. Sage 100 Contractor uses the billing rates from theCost and Billing
Rates tab in the 8-3 Equipmentwindow.

Billing Unit Description

1-Hours Creates a charge using the hourly rate.

2-Days Creates a charge using the day rate.

3-Weeks Creates a charge using the weekly rate.

4-Months Creates a charge using themonthly rate.

5-Miles Creates a charge using the per-mile rate.

6-Mobilization
Creates a charge using themobilization rate.

Do not make an entry to theOperated Rental,
Standby Rental, or Idle Rental cells.

7-Not Billable

The cost does not appear on time andmaterials
invoices.

Do not make an entry to theOperated Rental,
Standby Rental, or Idle Rental cells.

http://www.na.sage.com/sage-100-contractor/modules/service-management
http://www.na.sage.com/sage-100-contractor/modules/service-management
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Entering costs to determine recovery rates

To enter costs to determine a recovery rate:

1 Open 8-3 Equipment.

2 Using the data control, select the equipment.

3 Click theCost Recovery/Rental Rates tab.

4 UnderResource Consumption, do the following:

a In theStart Date box, enter the beginning date of the resource consumption period.

b In theEnd Date box, enter the ending date of the resource consumption period.

c In theStart Value box, enter the worth of the equipment at the beginning of the resource consumption period.

d In theEnding Value box, enter the estimated worth of the equipment at the end of the resource consumption period.

5 UnderEstimated Use, do the following:

a In theUnit list, click the unit of measurement by which you track usage.

b In theEstimated Use box, enter the projected number of units of use during the resource consumption period.

6 UnderCosts of Ownership, do the following:

a In the Insurance box, enter the amount you pay for insurance during the resource consumption period.

b In the Tax/License box, enter the amount of total fees for taxes and licenses during the resource consumption period.

c In the Inspection box, enter the amount for inspections during the resource consumption period.

d In theStorage box, enter the amount for storing the equipment during the resource consumption period.

e In theOverhaul box, enter the estimated amount for major repair work during the resource consumption period.

f In the Financing box, enter the amount you pay in loan interest during the resource consumption period.

g In theCost of Capital box, enter the amount of potential interest lost to investment in equipment during the resource
consumption period.

TIP: By investing in equipment, you have given up the ability to earnmoney through other investments. To calculate
the potential interest lost for theCost of Capital box, multiply the average equity in the equipment for the resource
consumption period by the average yield you cold get on a certificate of deposit.

h In theOther Cost box, enter any additional costs per unit not otherwise covered.

7 UnderCost of Operation, do the following:

a In the Fuel and Oil box, enter the cost per unit for fuel and oil.

b In theOil Change box, enter the cost per unit to change the oil.

c In the Fluid Change box, enter the cost per unit to change the fluids.

d In theMaintenance box, enter the cost per unit for maintenance.

e In the Tires box, enter the cost per unit for tires.

f In theMinor Repair box, enter the cost per unit for minor repairs.

g In theOther Cost box, enter any additional costs per unit not otherwise covered.

h In theMobilization Rental Rate box, enter the flat rate to charge for equipment mobilization.

8 On themenu bar, click Calculate.
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9 Enter the cost recovery and rental rates.

Entering cost recovery and rental rates

Cost recovery is the cost of owning and operating a piece of equipment on a per-unit basis and changing that cost to on-
going projects. As equipment is changed to projects, you are recovering its costs.

To enter cost recovery and rental rates:

1 Open 8-3 Equipment.

2 Using the data control, select the equipment.

3 Click theCost Recovery/Rental Rates tab.

4 UnderCost Recovery, enter the rates at which you recover costs. These rates can differ from the rates displayed under
Actual Cost.

5 UnderHourly/Mileage Rental Rate, enter the hourly or per mile billing rates.

6 UnderDaily Rental, enter the billing rates per day.

7 UnderWeekly Rental, enter the billing rates per week.

8 UnderMonthly Rental, enter the billing rates per month.

9 On the Filemenu, click Save.

About estimated use

In 8-3 Equipment on theCost Recovery/Rental Rates tab, underEstimated Use, select the unit of measurement, and
enter the amount of use expected over the resource consumption period.

When selecting the unit of measurement, consider how you track and report the actual use. Contractors often charge by the
hour for large equipment such as backhoes and dump trucks, but charge by the day for pickups or large compressors.

To estimate the use, examine previous equipment records spanning the same amount of time as the indicated resource
consumption period. In the estimate, include only equipment use. Ownership costs already include idle time, you do not
need to include these costs in the estimated use. Likewise, do not include transport time as the job estimate usually covers
these costs separately.

About resource consumption

This functionality is only available if you have the Equipment Module.

In 8-3 Equipment on theCost Recovery/Rental Rates tab, underResource Consumption, enter the starting and ending
date of the resource consumption period, and the value of the equipment at the start and end of the resource consumption
period.

The starting value represents the current street value and the ending value represents an estimate of the equipment’s worth
at the end of the resource consumption period. In theValue Consumed box, Sage 100 Contractor displays the amount of
change in real market value at the end of the resource consumption period.

Suppose you own aD4 bulldozer worth $40,000 at the start of the year that will be worth $37,500 at the year-end. The
consumed value is $2,500 for the year.

NOTE: The consumed value, the difference between the starting and ending values, does not represent the
depreciated value of the equipment.

http://www.na.sage.com/sage-100-contractor/modules/service-management
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About costs of ownership

In 8-3 Equipment on theCost Recovery/Rental Rates tab, underCost of Ownership, enter all the costs that you incur
over the resource consumption period resulting from ownership.

l In theOverhaul box, you can enter the cost of major repair work. It can be difficult to estimate the cost of major
repairs; use an average cost if the data is available.

l In theCost of Capital box, you can enter the cost of having themoney invested in equipment. By investing the
money in equipment, you lose the ability to earn additional money through other types of investments. To determine
the cost of capital for equipment, multiply the average equity in the equipment for the resource consumption period
by the average yield you could expect from a certificate of deposit.

If you own a backhoe, for example, youmight have an average equity of $25,000 for the year. If you had placed that money
in a safe investment with a 10% return, your cost of capital would be $2500 (25,000 x 10%).

When you calculate the rates, Sage 100 Contractor computes the actual cost of owning the equipment per unit of use, (total
cost of ownership + value consumed) / estimated use = ownership rate, and displays the rate in theOwnership Rate text
box.

Entering equipment maintenance

You can schedule and track themaintenance of each piece of equipment.

To enter equipment maintenance:

1 Open 8-3 Equipment.

2 Using the data control, select the equipment.

3 On theOptionsmenu, click Maintenance.

4 In theDescription text box, enter a brief statement about themaintenance.

5 In theCost Code text box, enter the cost code for the work performed.

IMPORTANT: Sage 100 Contractor updates the equipment maintenance schedule when you final-compute the
payroll records. The cost code in the payroll records must also be found in the equipment maintenance table.

6 If you base the performance of maintenance on a cycle of days, do the following:

a In theComplete Date text box, enter the date whenmaintenance is completed.

b In theCycle Days text box, enter the number of days in the service cycle.

c In theSchedule Date text box, enter the date when to perform themaintenance.

7 If you base the performance of maintenance on a cycle of units, do the following:

a In theComp Units (completed units) text box, enter the number of units when the service is actually performed.

b In theCycle Units text box, enter the number of units in the service cycle.

c In theSchedule Units text box, enter the next number of units when to perform themaintenance.

8 In theEmployee text box, enter the employee number who performed themaintenance.

9 On the Filemenu, click Save.
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Expensing Small Tools and Small Equipment
Using expense pools to recover costs for small tools or equipment

Small tools such as brooms, saws, nail guns, and shovels are always used on projects. Attempting to recover individual
costs for small items proves cumbersome. By grouping small tools together into expense pools, you can track the cost for
the group of items and post the costs as a direct expense.

In payroll, you can set up a payroll calculation to allocate small tool costs. First, determine the total cost for small tools,
including costs for maintenance, during a resource consumption period. Separately, establish the total number of man-
hours spent working jobs during the same resource consumption period. Then divide the total of the small tool costs by the
total man-hours to determine the hourly cost recovery rate.

IMPORTANT: To ensure its accuracy, you should evaluate the cost recovery rate routinely.

To set up an expense pool:

1 Open 5-3-1 Payroll Calculations.

2 Set up a payroll calculation with the following criteria:

a In theCalculation Method list, click 8-Per Hour (all hours).

b In theDefault Rate cell, enter the cost recovery rate.

c In theCredit Account cell, enter theOverhead ledger account number to which tool purchases are posted.

3 Update the calculation to all employees:

a When you enter a timecard, Sage 100 Contractor uses the employee’s hours to compute and allocate job costs for the
expense pool. The calculation does not affect employee paychecks.

TIP: By including the per man-hour costs for small tools in estimates, you increase the accuracy of takeoffs.

8-4 Equipment Allocation

About equipment allocation
Use the 8-4 Equipment Allocationwindow in conjunction with the 5-2-2 Payroll Recordswindow to enter job and
equipment cost records. You can enter the operated, standby, and idle time for equipment used at the job site, and you can
enter equipment used to repair other equipment.

In the 5-2-2 Payroll Recordswindow, you can only enter the time an employee spends working at the job site or repairing
equipment. When an employee operates equipment at the job site, enter the employee’s time in the 5-2-2 Payroll Records
window. Then in the 8-4 Equipment Allocationwindow, enter the time spent operating the equipment.

When the employee uses a piece of equipment to repair another piece of equipment, enter the equipment repaired and
employee’s time in thePayroll Recordswindow. Then in the 8-4 Equipment Allocationwindow, enter the equipment
that was repaired and time spent operating the equipment used in the repair.

NOTE: The 5-5-1 Daily Payroll Entrywindow lets you enter all the costs in a single window. Therefore it is not
necessary to use the 8-4 Equipment Allocationwindow.
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Entering job costs for equipment time and materials billing
To enter job costs for time and materials billing:
1 Open 8-4 Equipment Allocation.

2 In theDate cell, enter the date of equipment use.

3 In theDescription cell, enter a brief statement about the work.

4 In the Job cell, enter the job number.

5 In thePhase cell, enter the phase number.

6 In theCost Code cell, enter the cost code number.

7 In theOperated Equipment cell, enter the equipment number.

8 In theOperated cell, enter the number of units that the equipment was operated.

9 In theStandby cell, enter the number of units that the equipment was on standby.

10 In the Idle cell, enter the number of units that the equipment was idle.

11 In theRental Unit cell, enter the number for the type of unit by which you bill the equipment.

12 In theOperated Rental cell, enter the number of units for which you are billing.

13 In theStandby Rental cell, enter the number of units for which you are billing.

14 In the Idle Rental cell, enter the number of units for which you are billing.

15 Repeat steps 2–14 for each piece of equipment for which you want to create a cost record.

16 On the Filemenu, click Save.

TIP: In the 6-3 Job Costwindow, you can edit the equipment details that Sage 100 Contractor uses to create time
andmaterials invoices.

Entering equipment costs for repair work
To enter equipment costs for repair work:
1 Open 8-4 Equipment Allocation.

2 In theDate cell, enter the date of equipment use.

3 In theDescription cell, enter a brief statement about the work.

4 In theEquipment Repaired cell, enter the equipment number for the repaired equipment.

5 In theCost Code cell, enter the cost code number.

6 In theOperated Equipment cell, enter the equipment number used tomake repairs.

7 In theOperated cell, enter the number of units that the equipment was operated tomake repairs.

8 Repeat steps 2–7 for each piece of equipment for which you want to create a cost record.

9 On the Filemenu, click Save.
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TIPS:
l When a cost record is incorrect, make an adjusting entry in 8-4 Equipment Allocation.

l If you attribute too few hours to equipment, create a new cost entry for the difference in the appropriate
Operated, Standby, or Idle column.

l If you attribute toomany units to a piece of equipment, create a new cost entry for a negative amount in the
appropriateOperated, Standby, or Idle column.

Entering job costs for equipment
To enter job costs for equipment:
1 Open 8-4 Equipment Allocation.

2 In theDate cell, enter the date of equipment use.

3 In theDescription cell, enter a brief statement about the work.

4 In the Job cell, enter the job number.

5 In thePhase cell, enter the phase number.

6 In theCost Code cell, enter the cost code number.

7 In theOperated Equipment cell, enter the equipment number.

8 In theOperated cell, enter the number of units that the equipment was operated.

9 In theStandby cell, enter the number of units that the equipment was on standby.

10 In the Idle cell, enter the number of units that the equipment was idle.

11 Repeat steps 2–10 for each piece of equipment for which you want to create a cost record.

12 On the Filemenu, click Save.

TIPS:
l When a cost record is incorrect, make an adjusting entry in the 8-4 Equipment Allocationwindow.

l If you attribute too few hours to equipment, create a new cost entry for the difference in the appropriate
Operated, Standby, or Idle column.

l If you attribute toomany units to a piece of equipment, create a new cost entry for a negative amount in the
appropriateOperated, Standby, or Idle column.

8-5 Equipment Payments

About equipment payments
In the 8-5 Equipment Paymentswindow, you can print checks for equipment payments. When an equipment payment is
due, Sage 100 Contractor automatically sets the amount to pay using the financial information established in the equipment
record.

To set Sage 100 Contractor to print a check for a piece of equipment, select the equipment, and then click thePay button. If
you decide not to make the equipment payment at this time, select the equipment, and then click theNo Pay button.

When you print a check for an equipment payment, Sage 100 Contractor decreases the loan balance by the check amount
and advances the due date. When the loan balance reaches 0, the equipment record no longer appears in theEquipment
Paymentswindow.
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Selecting equipment for payment
To select equipment for payment:
1 Open 8-5 Equipment Payments.

2 Select the equipment, and click thePay button.

3 On the Filemenu, click Print Checks.

NOTE: When you print an equipment check, Sage 100 Contractor decreases the loan balance by the check amount
and advances the due date.

8-6 Equipment Depreciation

About equipment depreciation
In the 8-6 Equipment Depreciationwindow, you can post the depreciation for equipment. You can change or delete the
amount to depreciate, and you can post depreciation to specific pieces of equipment.

When you save a record in 8-6 Equipment Depreciation, Sage 100 Contractor posts the depreciation for each piece of
equipment with the amount in theDepreciation cell.

Posting equipment depreciation
To post equipment depreciation:
1 Open 8-6 Equipment Depreciation.

2 On theOptionsmenu, click Post Depreciation.

When the depreciation posts, a message window appears confirming that the depreciation has been posted.

TIP: You can change the amount of depreciation for a piece of equipment. Select the equipment, and enter the new
amount in theDepreciation cell.

Posting depreciation for specific pieces of equipment
Youmay have to post depreciation on specific pieces of equipment from time to time.

To complete this task, youmay have to remove the depreciation values for equipment. Consider writing those values down
so that they can be put back after posting the specific pieces of equipment.

To post depreciation on specific pieces of equipment:
1 Open 8-6 Equipment Depreciation.

2 In theDepreciation column, remove the values for equipment that you do not want to post

3 In theDepreciation column, keep or change the values for the equipment that you do want to post.

4 As needed, click theChange the posting period button to change thePeriod.

5 Click thePost button.

When the depreciation posts, a message window appears confirming that the depreciation has been posted.
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8-7 Equipment Revenue

About equipment revenue
In the 8-7 Equipment Revenuewindow, you can review the revenue generated by a piece of equipment. When you
allocate equipment to a job, Sage 100 Contractor creates two records: a job cost record and an equipment revenue record.
The job cost record reflects the cost of using the equipment on a particular job; the revenue record reflects the value earned
by the equipment.

By tracking the revenue produced by a piece of equipment, you can review its profitability and refine the cost recovery
rates. In 8-7 Equipment Revenue, you can review and edit existing revenue records. If a text box is shaded, you cannot
directly edit the data. Enter an adjusting entry through 8-4 Equipment Allocation.

IMPORTANT: Sage 100 Contractor does not create equipment cost or revenue records from time andmaterials
invoices.

Entering historical equipment revenue records
When billing for time andmaterials, Sage 100 Contractor uses the billing rates in place of the cost recovery rates and does
not create cost and revenue records.

To enter a historical equipment revenue record:
1 Open 8-7 Equipment Revenue.

2 In theEquipment text box, enter the equipment number.

3 In the Trans# text box, type Start Up.

4 In theDate text box, enter the date.

5 In theDescription text box, typeStart Up.

6 In theCost Code text box, enter the cost code.

7 In theRevenue text box, enter the revenue generated by the equipment.

8 On the Filemenu, click Save.

Voiding equipment revenue records

IMPORTANT: You can only void an equipment revenue record that originates in 8-7 Equipment Revenue. If you
need to void an equipment revenue record that originated elsewhere, youmust void it in the window where you created
it.

To void an equipment revenue record:
1 Open 8-7 Equipment Revenue.

2 Using the data control, select the record.

3 On theEditmenu, click Void Equipment Revenue.
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Chapter 9: Estimating
Working with estimating, assemblies, and parts
This functionality is available only if you have the EstimatingModule.

You can boost your profitability by creatingmore accurate plan takeoffs and estimates. These estimates can be used to
generate proposals, budgets, purchase orders, subcontracts automatically because Sage 100 Contractor is completely
integrated. You can update your parts prices using spreadsheets supplied by vendors, distributors or parts services.

You can save job estimates as templates for future use and take advantage of simple formulas to further streamline the
estimating process and improve accuracy. The Sage 100 ContractorEstimatingmodule provides tools for you to
selectively factor in cost increases, lock prices to prevent accidental edits, and add notes for clarity.

There are special tools for homebuilders and remodelers. TheEstimatingmodule comes with a start-up database with
thousands of parts and assemblies. Assemblies are collections of parts andmaterials that can be quantified with a single
entry.

Sage 100 Contractor’s Estimatingmodule also includes the following features:

l Update parts information from your vendors.

l Organize your estimates by custom bid items and phases into workflow or billing requirements.

l You can fully integrate your estimating data, including full material, labor , equipment, and subcontract details with
scheduling, project management, and accounting functions.

What is assembly estimating?
Assembly estimating is a simple, accurate way to create takeoffs. It also streamlines themanagement of material costs,
quotes, and ordering because each assembly includes all the necessary parts and labor to complete a unit of work.

For example, an interior door assembly might include the door, frame, hinges, trim, doorknob, shims, and nails, and the
quantity of each part necessary to complete the work. When creating a takeoff, you can insert the interior door assembly
instead of each of the individual parts needed. You only need to then enter the quantity of interior door assemblies needed in
the project. When you compute the takeoff, Sage 100 Contractor determines the total number of parts needed to complete
the door assemblies.

Assembly estimating is more precise and useful than unit price estimating, which only provides a flat rate per unit of
measurement. Suppose you are estimating costs to frame a house, and the cost of nails has increased recently. Unit price
estimatingmakes it difficult to calculate the new cost per unit reflecting the additional costs. You can only add an amount to
the takeoff that you hope compensates for the increased cost of nails.

Assembly estimatingmakes it easier to keep costs up to date. When you update the parts database or a portion thereof,
Sage 100 Contractor also updates the part costs in the assemblies, ensuring that you will use themost current costs when
you create a takeoff.

To increase the accuracy of your takeoffs, you can create part records for labor costs. As you build the assemblies, include
the appropriate labor parts. In some instances, youmight need to add several different part records for labor to account for

http://www.na.sage.com/sage-100-contractor/modules/estimating
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the different types of work required. An assembly for installing a sink, for example, might include labor for setting the
cabinet, roughing in the plumbing, installing wiring for a disposer unit, and setting the sink and finishing the plumbing.

Assembly estimating has many benefits:

l Each assembly contains all the necessary parts. It becomes impossible to forget parts that are used infrequently.

l You can generate complete parts lists from the takeoff, which lets you obtain materials quotes before submitting the
final bid.

l You can adjust prices according to difficulty factors or site-specific conditions.

l Creation of purchase orders directly from the takeoff, eliminating errors often encountered in unit price takeoffs or
separatematerials billing processes.

l The accuracy of takeoffs increases as you refine the assemblies.

l You can build a library of modified assemblies.

Pre-Built Data Sets

Home Builder Data
About Home Builder estimating data

When you create a new company and build a chart of accounts in the 1-8 General Ledger Setupwindow, you can
automatically install the Home Builders’ set of data. Estimating data can be used as a starting point for your takeoffs,
saving you time when creating estimates. This includes a specialized chart of accounts, cost codes, tasks and the
following estimating data:

l Parts

l Assemblies

l Part/Assembly Classes

l Takeoff Grid files

NOTE: When you install the estimating data, you will be prompted with amessage to select the lumber species to be
used to create the installed assemblies and grids. You should choose the species that youmost commonly work with.

Setting up Home Builder Accounts

When you select theHome Builder Accounts from 1-8 General Ledger Setup, Sage 100 Contractor automatically sets
up the account ranges, controlling account numbers, posting account numbers, and then creates the ledger accounts. You
can thenmodify the ledger setup tomeet your particular needs. However, you will then need to edit the ledger accounts to
match any changes made in the 1-8 General Ledger Setupwindow.

After setting up the chart of accounts, you can edit account numbers, delete unnecessary accounts, and set up controlling
accounts for subsidiary accounts or departments in the Ledger Accounts window. If you changed a controlling or posting
account number in 1-8 General Ledger Setup, youmust also change the ledger account number.

IMPORTANT: The option to install the Home Builders Accounts is only available when you set up a new company.
After ledger accounts have been set up and utilized in any given company, you cannot install a new system of
accounts, and you will not see theOptionsmenu anymore.
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To set up Home Builder Accounts in the General Ledger:

1 Open 1-8 General Ledger Setup.

2 On themenu bar, click Options, then click Home Builders Accounts.

3 A prompt appears and asks whether you want to install the Home Builder estimating data, tasks, and cost codes. If you
select Yes, theEstimating Data Setupwindow appears.

4 UnderCost Codes, select CSI orHome Builder as your base cost code list. You canmodify this later if necessary

5 Under Framing Species, select the wood species to base your estimating data on.

NOTE: The sampleCost Code list and Task List contain starter sets aimed at meeting the needs of home builders.
Youmay need tomodify these lists to better meet your company’s needs.

Remodeler Data
About Remodeler estimating data

When you create a new company and build a chart of accounts in the 1-8 General Ledger Setupwindow, you can
automatically install the Remodelers set of data. Estimating data can be used as a starting point for your takeoffs, saving
you time when creating estimates. This includes a specialized chart of accounts, cost codes, tasks and the following
estimating data:

l Parts

l Assemblies

l Part/Assembly Classes

l Takeoff Grid files

NOTE: When you install the estimating data, you will be prompted with amessage to select the lumber species to be
used to create the installed assemblies and grids. You should choose the species that youmost commonly work with.

Setting up Remodeler Accounts

When you select theRemodeler Accounts from the 1-8 General Ledger Setup, Sage 100 Contractor automatically sets
up the account ranges, controlling account numbers, posting account numbers, and then creates the ledger accounts. You
can thenmodify the ledger setup tomeet your particular needs. However, you will then need to edit the ledger accounts to
match any changes made in the 1-8 General Ledger Setupwindow.

After setting up the chart of accounts, you can edit account numbers, delete unnecessary accounts, and set up controlling
accounts for subsidiary accounts or departments in the Ledger Accountswindow. If you changed a controlling or posting
account number inGeneral Ledger Setup, youmust also change the ledger account number.

IMPORTANT: The option to install the Remodeler Accounts is only available when you set up a new company. After
ledger accounts have been set up and utilized in any given company, you cannot install a new system of accounts.

To set up Remodeler Accounts in the General Ledger:

1 Open 1-8 General Ledger Setup.

2 On themenu bar, click Options, then click Remodeler Accounts.

3 A prompt appears asking you whether you want to install the Remodeler estimating data, tasks and cost codes.

4 Click Yes.

5 TheEstimating Data Setupwindow appears.
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6 Do the following:

a UnderCost Codes, select CSI orRemodeler as your base cost code list. You canmodify this later if necessary.

b Under Framing Species, select the wood species upon which to base your estimating data.

NOTE: The sampleCost Code list and Task List contain starter sets aimed at meeting the needs of remodelers.
Youmay need tomodify these lists to better meet your company’s needs.

9-1 Takeoff Reports
See Appendix B for a complete list of 9-1 Takeoff Reports.

9-2 Parts

About 9-2 Parts
The Service Receivables functionality is only available if you have purchased the Service Receivables Add-OnModule.

In the parts database you canmanage costs, track part inventories, and even assign an image to individual part records.
You do not have to limit part records to buildingmaterials; you can even create part records for labor costs. To set up a parts
database, enter the parts manually or import an existing database. If you subscribe to a part pricing service, you can update
the prices in the parts database as you receive the latest service updates.

For each part record, you can set up a list of parts vendors that indicates the vendor with whom you prefer to do business.
When creating a takeoff, Sage 100 Contractor can select the preferred vendors for parts.

With inventory locations, Sage 100 Contractor tracks the total inventory that you currently have. When using the Inventory
module, Sage 100 Contractor reduces the quantity on hand when you assign parts status 4-Shipped. If you are using
Service Receivables, Sage 100 Contractor reduces the part quantity on hand based on invoices with status 1-Open, 2-
Review, 3-Dispute, or 4-Paid.

With service work, parts use a billing price. When you indicate a part in theService Receivablesmodule, Sage 100
Contractor uses the billing price instead of the cost price.

Entering parts
Consider the following points before entering parts:

NOTES:
l If you are entering dimensional lumber, enter the lumber dimensions following a specific format.

l Parts that inventory activity or quantity remaining cannot be deleted from the system until year-end.

l You can create part records for labor parts.

l You can include an image of the part.

l You can include the location of a specifications document.

To enter a part:
1 Open 9-2 Parts.

2 Do the following:

a In the data control text box, enter the part number.

http://na.sage.com/sage-100-contractor/modules/service-management
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b In theDescription text box, enter the part name.

c In theAlpha Part# text box, enter the vendor’s part number.

d In theUnit text box, enter the unit of measurement.

3 In theGeneral Information tab, do the following:

a In thePart Class text box, enter the part class number.

b In theCost Code text box, enter the default cost code to use with takeoffs.

c In theCost Type list, click the cost type.

d In the Task text box, enter the task number for scheduling and critical pathmanagement.

e In theManufacturer text box, enter themanufacturer’s name.

f In theManuf. Part# text box (manufacturer’s part number), enter the part number assigned by themanufacturer.

g In theMSDS# text box (Material Safety Data Sheet number), enter theMSDS number for the part.

4 In theCost, Billing and Ordering tab, do the following:

a In theDefault Cost text box, enter the cost of the part.

b In the Last Updated text box, enter the date when you last updated the part price. When you import or update a part,
Sage 100 Contractor automatically changes the date.

c In theMarkup % text box, enter themarkup rate.

d In theBilling Amount text box, enter the default billing amount.

e In theMinimum Order Qty (quantity) text box, enter theminimum number of parts to order.

f In thePackage Quantity text box, enter the number of parts contained in a package. When using this part in a takeoff,
Sage 100 Contractor rounds up the quantity to the next package of parts.

g In theUnit Weight text box, enter the weight in pounds for shipping.

5 In the Labor tab, do the following:

a In the Labor Part# text box, enter the associated labor part.

b In theQuantity text box, enter the quantity.

6 In the Inventory tab, do the following:

a If the part is normally kept in stock by your company, select theStock Item check box. The inventory valuation
methodmust be designated in order to select this option. After the check box is selected and activity has occurred for
that part in the system, the check box will be unavailable and cannot be cleared.

b If the part uses serial numbers, click theSerialized Item check box.

c If it is mandatory that the part come from inventory, click theRequired from Inv. check box.

d In theDefault Location text box, enter the inventory location.

e In theBin# text box, enter the number of the bin where the part is located.

f In theReorder Quantity text box, enter the level of inventory at which you need to reorder the part.

7 In theService Equipment tab, do the following if the part is used in service work:

a If you want to add the part to a client’s equipment list, select theService Equipment Item check box.

b In theOEM Warranty Duration text box, enter the number of months of the OEMwarranty.

8 On the Filemenu, click Save.
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About the check boxes in the 9-2 Parts window
Inventory tab

l Stock Item: Indicates the part is normally carried in your inventory.

l Serialized Item: Indicates the part uses a serial number. When you receive parts, Sage 100 Contractor requires
you to provide the serial number for each part.

l Required from Inv.: Requires you to enter a service location on the work order or invoice.

Service Equipment tab

l Service Equipment Item: Adds the part to a client’s list of service equipment in the client record.

Including part notes
When you include part notes, the notes appear in theNotes column.

To include part notes, on theOptionsmenu, click Include Parts Notes.

Assigning specifications files to part records
Parts may need to have specifications files associated with them. Youmay assign specifications files to parts using the 9-
2 Partswindow.

To assign a specifications file to a part record:
1 Open 9-2 Parts.

2 In theGeneral Information tab, locate theSpec File box.

3 Click the drop-down arrow.

4 TheAssign Filewindow opens.

5 Click the drop-down arrow by the Look in text box, and select the specification file.

6 Click Open.

7 The path to the specifications file appears in theSpec File box. When accessing this part subsequently, you can use the
Spec File drop-down arrow to access the specification file.

About creating part records for items other than materials
You can create part records for subcontractors, equipment, labor, general requirements, or other miscellaneous items. You
can then include those items in assemblies or as individual items in the takeoffs to increase their accuracy.

l Subcontracts: For each type of subcontractor, create a part record that does not include a cost. When you add the
subcontract part to the takeoff, you can then supply an estimated price based on the scope of the project, or enter
the subcontractor’s bid.

l Equipment: For each piece of equipment, create a part record. Use the part’s cost recovery rate as the cost in the
part record.

l Labor: For each employee position, create a part record.
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l General Requirements: For each requirement such as permits or temporary facilities, create a part record. If the
item has a fixed amount, you can enter the amount in part record as its cost. If the amount changes on a job to job
basis, you can supply the price in the takeoff when you add the part.

Setting up part records for labor
You can increase the accuracy of takeoffs and service invoices by creating part records for labor costs.

To set up part records for labor :
1 For each employee position, create a part record.

2 Assign the record cost type 2-Labor.

3 Use the hourly gross wage plus burden as the last cost.

The burden includes but is not limited to:

l state taxes

l local taxes

l liability insurance

l Workers’ Compensation

l employer paid benefits

l employer paid pension plans

l employer paid vacation and sick time

l employer paid union fees

4 Assign the labor part records to assemblies.

For example, an assembly for installing a sink might include labor parts for setting the cabinet, roughing in the plumbing,
installing wiring for a disposer unit, and setting the sink and finishing the plumbing.

Parts Inventory
About taking inventory of parts

For a selected part, you can view a breakdown of its quantities by inventory location. The breakdown also provides the
quantity available for use, when stock was last added or removed, and the date when inventory was last taken. For
serialized parts, you can also view a list of the serial numbered parts assigned to a specific inventory location.

Viewing the inventory for parts

To view the inventory for a part:

1 Open 9-2 Parts.

2 Using the data control, select the part.

3 Click the Inventory button.

TIP: To view the inventory for a different part, use the data control.
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About parts inventory status

Column Description

Quantity On
Hand Displays the total quantity of stock in the location.

Quantity
Available

Displays the quantity of stock available. If you place
a hold on stock, Sage 100 Contractor does not
include it in the quantity available.

Last Stocked
Date

Displays the date when you last added inventory to
the location.

Last Picked Date Displays the date when you last removed inventory
from the location.

Last Count Date
Enter the date when inventory was taken last.

This is for reference only.

Must Count
Enter Yes if you are to count the part during inventory.

Enter No if you do not include the part when taking
inventory.

Beginning
Quantity

Displays the quantity on hand at the start of the fiscal
year.

When you close the accounting books at the fiscal
year-end, Sage 100 Contractor assigns the quantity
on hand to theBeginning Quantity column.

Minimum
Restock Level

Enter theminimum quantity to keep in stock.

This is for reference only.

Maximum
Restock Level This is for reference only.

Viewing serial numbers of parts in an inventory location

To view serial numbers of parts in an inventory location:

1 Open 9-2 Parts.

2 Using the data control, select the part.

3 Click theSerial# button.

Barcodes
About barcodes

Sage 100 Contractor uses the part record number for the barcode. You can also use barcodes to track inventory if you have
the Inventory add-onmodule.
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Selecting the barcode format

To select the barcode format:

1 Open 9-2 Parts.

2 On theOptionsmenu, select Default Barcode Format.

3 At the bottom of theDefault Barcode Formatwindow, click the drop-down arrow to display the list of choices.

4 Make a selection, then click OK.

NOTE: Sage 100 Contractor uses the part record number for the bar coding.

Viewing the barcode format

To view the barcode format:

1 Open 9-2 Parts.

2 Using the data control, select the part.

3 On theOptionsmenu, click View Barcode.

Changing part numbers into barcodes

Sage 100 Contractor can interpret part numbers to appear as barcodes using special barcode fonts. There are two barcode
fonts that install with Sage 100 Contractor. They areBC C39 3 to 1 HD Wide andBC UPC HD Wide. When you edit the
font for tkfprt.recnum to one of the barcode fonts, then it appears as a barcode in a report and can be printed as a label.

To change part numbers into barcodes on a report:

1 Open 9-2 Parts.

2 Click thePrint Records button. The 9-2 Report Printingwindow opens.

3 Create a report using the part description.

For example, you can use report 21-Part Record as a starting point, and then save it with a different name.

4 In theReport Printingwindow, click theModify Report button.

5 TheReport Writerwindow opens.

6 Select the tkfprt.recnum field, then click Edit the font for the text area.

7 Select one of the barcode fonts, for example, BC C39 3 to 1 HD Wide, then click OK.

8 Save the report, then close theReport Printingwindow.

9 From the 9-2 Report Printingwindow, click thePrint Record to Screen button to preview the report. The part number
now appears as a barcode.

Vendor Pricing
About vendor pricing

In each part record, you can set up a table of vendors, their material part numbers, and prices. Each vendor can be assigned
a preference number. When creating a takeoff, you can have Sage 100 Contractor determine which vendor is preferred or
which vendor has the lowest price, and insert the appropriate vendor and cost in the takeoff.

In the 9-7 Maintain Parts Databasewindow, you can assign whole lists of vendors to part records, part classes, or the
entire parts database. Then in each part record, you can assign thematerial part numbers and prices.
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Entering vendor prices for part records

To enter vendor prices for a part record:

1 Open 9-2 Parts. Using the data control, select the part.

2 On theOptionsmenu, click Vendors.

3 In thePreference# text box, enter the vendor preference number.

4 In theVendor text box, click the drop-down arrow to open a Lookupwindow, and select a vendor.

5 In theOrder# text box, enter thematerial part number for the vendor.

6 In theDisc. Rate text box, enter the vendor’s discount rate for the part.

7 In thePrice text box, enter the part cost from that vendor.

8 Click in the Last Update text box to automatically insert the date that the part was last updated.

9 Repeat steps 4–5 for each vendor.

10 In the Filemenu, click Save.

11 Repeat steps 2–10 for each part.

TIP: You can change the preference numbers or even delete a vendor. Such changes, however, are specific to the
part record and do not affect the list of vendors in other part records.

9-3 Assemblies

About assemblies
An assembly represents a collection of parts necessary to complete a single unit of work. For example, an interior door
assembly can include the door, frame, hinges, trim, doorknob, shims, and nails. Some other examples of assemblies are
kitchen cabinets, linear feet of wall, door installation, window installation, roof framing, roofing installation, bathtubs,
showers, pipe runs per foot, and conduit runs per foot.

For each part in an assembly, provide the quantity of the part needed to complete the work. Otherwise, Sage 100
Contractor sets the part’s quantity to 0. If labor , equipment, or subcontractors are set up as parts, you can include them in
assemblies as well.

When you insert the assembly in a takeoff, all the parts in the assembly also display. You can then enter the number of
assemblies required and have Sage 100 Contractor calculate the extended quantity of parts.

Suppose the project plans show five interior doors. In the takeoff, insert the interior door assembly and enter 5 as the
assembly quantity. When you compute the takeoff, Sage 100 Contractor computes the extended quantity of parts needed
to build five interior door assemblies.

You can also set labor andmarkup rates for assemblies used in service work. Then for each assembly you can set its flat
rates. When you insert an assembly in a work order or invoice in theService Receivable Invoiceswindow, Sage 100
Contractor uses the flat rate.

If youmake a change to the part cost for a part used in one or more assemblies, select theUpdate All Assembly Part
Costs option to update all assemblies with all current part costs.

More information about assemblies
Before setting up any assemblies, think about your methods for creating takeoffs, and consider how to build, organize, and
use the assemblies. You can include formulas, waste factors, and parts for items other than buildingmaterials—such as
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labor, equipment, and subcontracts.

Some assemblies might not require certain parts to complete the work. As a rule, include a part in an assembly if you need
it at least 5% of the time. It is easier to delete unnecessary parts than it is to remember to add those seldom-used parts.

You can also include part records for labor. Because an assembly contains the parts for an entire unit of work, include the
labor parts for the different types of work performed. An assembly for installing a sink, for example, might include labor
parts for setting the cabinet, roughing in the plumbing, installing wiring for a disposer unit, and setting the sink and finishing
the plumbing. For each labor part, set the quantity equal to the time required to complete the work for that portion of the
task.

Assemblies must be practical. Assemblies that encompass too large a portion of a project are unwieldy, and assemblies
that contain only one or two parts often provide little help. For example, an assembly for an 1800 square foot, 2 bedroom 2
bath home is too large. Not every 1800 square foot, 2 bedroom 2 bath home is the same. Likewise, a kitchen sink assembly
containing a single part, a sink, is too small and is not useful.

There are certain circumstances where one or two items in an assembly are appropriate. For example, when running pipe
youmight want to use a separate assembly for each type of part (such as ells, unions, and tees) that includes the part and
the labor part.

For some types of work, it might be easier to create two assemblies instead of one. Suppose that you perform a great
number of water heater installations. You create an assembly that contains the basic parts and labor necessary for the
water heater installation except for the water heater itself. Then you create an assembly for each type of water heater and
its associated labor and tank-specific parts. When creating a takeoff for the water heater installation, select the basic
installation assembly and then select the specific tank assembly.

Some parts rely on additional information such as a linear or cubic dimension to determine the quantity needed. You can
use formulas to compute dimensions, quantities, or prices. You can also use formulas for tasks that produce large amounts
of wastematerials. Wastematerials add to the job costs, and by compensating for waste, takeoffs becomemore accurate.

You can control whether a part is connected to or disconnected from an assembly, which determines whether Sage 100
Contractor computes the part’s extended quantity in a takeoff based on the assembly quantity. You can also connect labor
parts to an assembly or to a part in the assembly, allowing you to control how Sage 100 Contractor computes the quantity
of labor.

Entering assemblies
Consider the following points before entering assemblies:

l Include all the items that youmight need in the assembly. It is easier to delete unnecessary parts in a takeoff than it
is to remember to add seldom-used parts.

l You can include an image of the assembly.

l You can use the Formula text box to declare the value of variables. In the Formula text box, enter a variable
followed by an equal sign (=) and separate each variable using a comma. For example: SqFt=, LnFt=,.

l Do not declare the value of the variables in the assembly. When you enter the assembly in a takeoff, you can enter
the values for the variables.

To enter an assembly:
1 Open 9-3 Assemblies.

2 In the data control text box, enter the assembly number.

3 In theDescription text box, enter a brief statement about the assembly.

4 In theUnit text box, enter the unit of measurement.



- 486 -

5 In the Formula text box, enter the assembly formula.

6 In theAssembly Class list, click an assembly class number.

7 Click theParts Details grid. Then do the following for each part that you need in the assembly:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts that you need in the assembly.

8 On themenu bar, click Calculate.

9 Review the assembly.

10 On the Filemenu, click Save.

Entering markups for assemblies
Note that you can save themarkup information without applying it to any assembly classes by clicking theSave button.

To enter markups for assemblies:
1 Open 9-3 Assemblies.

2 Enter the travel, technician, and assistant time on the Flat Rate tab.

3 In the Options menu, select Update Flat Rate Assemblies.

4 In theApply to Class boxes, enter the range of assembly classes to which you want themarkup rates to apply.

5 UnderCalculation Options, do any of the following:

a Select theUse new part prices check box to use the last cost from the part records.

b Select theApply labor rates check box to assign the labor rates indicated under Labor Rates to all assemblies using
flat rate billing.

c Select theApply markups check box to assign themarkup rates indicated underMarkup Rates to all assemblies
using flat rate billing.

6 Under Labor Rates, do the following:

a In the Travel box, enter the hourly labor rate for travel time.

b In the Technician box, enter the hourly labor rate for a technician.

c In theAssistant box, enter the hourly labor rate for an assistant.

7 UnderMarkup Rates, do the following:

a In theMaterial box, enter themarkup rate for materials.

b In the Labor box, enter themarkup rate for labor.

c In theEquipment box, enter themarkup rate for equipment.

d In theSubcontract box, enter themarkup rate for subcontracts.

e In theOther box, enter themarkup rate for additional items.

f In the Travel box, enter themarkup rate for travel.

g In the Technician box, enter themarkup rate for the technician’s labor.

h In theAssistant box, enter themarkup rate for the assistant’s labor.

i In theMiscellaneous box, enter themarkup rate for miscellaneous items.
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j In theOverhead box, enter themarkup for overhead.

k In theService Contract Discount box, enter the discount rate for clients with service contracts.

8 Click Update Assemblies.

Entering flat rate details
Companies that perform service work often bill customers using a flat rate based onmaterials, labor, and travel costs. Sage
100 Contractor computes both standard and contract rates for primary and add-on tasks.

Consider the following points before entering flat rate details:

l You canmanually change themarkup rates or selling prices. If you change the selling price, Sage 100 Contractor
ignores markup rate. If you delete amarkup rate, Sage 100 Contractor does not change the amount in theSell
column.

l You can change the time and cost for travel, technicians, and assistants as well as the rate in theService Contract
Discount box.

l Select thePrint in Book check box to add the assembly flat rate to your flat rate book.

l Select thePrint Parts check box to include the parts in your flat rate book. When printing the price book, select the
Part Details check box.

l Select the Taxable check box to include tax on the assembly.

To enter flat rate details:
1 Open 9-3 Assemblies.

2 Click the Flat Rate tab.

3 In the Time column, do the following:

a In the Travel cell, enter theminutes of travel time.

b In the Technician cell, enter theminutes of repair time allotted to a technician.

c In theAssistant cell, enter theminutes of repair time allotted to an assistant.

4 On themenu bar, click Calculate.

About connecting parts to assemblies
In an assembly, you can determine whether the part is connected to or disconnected from the assembly. When a part is
connected, Sage 100 Contractor computes the part’s extended quantity in a takeoff based on the assembly quantity. When
you insert a part in an assembly, the part automatically connects to the assembly and displays a red assembly arrow icon
next to the part.

You can also include a part but not connect it to the assembly, which lets you control the quantity independent from the
assembly. Suppose you have an assembly for installing light fixtures, and the assembly includes a ladder. You do not need
to purchase a new ladder with each job; including the ladder in the assembly serves as a reminder to bring it when installing
the light fixtures. So the quantity for the ladder is zero, and the part is disconnected from the rest of the assembly. When a
part is disconnected, the assembly icon cell is blank.

If the part is for labor, you have the additional choice of connecting it to a buildingmaterial part in the assembly instead of
the assembly itself. When connected to a buildingmaterial part, Sage 100 Contractor computes the extended quantity for
the labor part based on the extended quantity of thematerial part. If that material part is connected to the assembly, the
part’s extended quantity is determined from the assembly quantity. Next to the labor part, Sage 100 Contractor displays a
green assembly icon arrow.
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Changing the connections of parts

Icon What it does

Red arrow
pointing left Connects the part to the assembly.

Green arrow
pointing right Connects the labor part to the part above it.

Blank Unconnected. The assembly quantity does
not affect the part quantity.

To change the connection of a part to an assembly, double-click the assembly icon cell next to the part.

Including assembly notes
When you include assembly notes, the notes appear in theNotes column.

To include assembly notes:
1 Open 9-5 Takeoffs.

2 On theOptionsmenu, click Include Assembly Notes.

Hiding the parts in assemblies
To hide the parts in assemblies:
1 Open 9-5 Takeoffs.

2 On theOptionsmenu, click Hide Assembly Parts.

9-4 Part-Assembly Classes

About assembly and part classes
Classes let you organize parts and assemblies so you can locate what you need when creating a takeoff, purchase order,
or other document. In the 9-4 Part/Assembly Classeswindow, you can set up separate hierarchies for parts and
assemblies. In each hierarchy, sort the parts and assemblies into meaningful groups.

When you open the 9-4 Part/Assembly Classeswindow for the first time, it contains a single class titled 0-All Classes.
This permanent class contains all the parts and assemblies in the databases. If you cannot locate a part or assembly
because it was assigned to an incorrect class or a class was deleted without moving the contents elsewhere, look in 0-All
Classes.

Assign a class number to each class you create. The class number can contain up to six digits and does not need to relate
to the part or assembly numbers. Under each class, you can create additional classes referred to as subclasses.

Subclasses provide ameans of creating smaller and smaller groups of assemblies or parts. The subclass should not be so
broad that you have to look through a huge number of items or so small as to contain only a few items. Generally, a
subclass should contain nomore than 40 or 50 items. If the number of items in a subclass becomes too large, createmore
subclasses to better group the items.

Suppose that you are setting up classes for doors, and determine that you need to create classes for metal doors, wood
doors, glass doors, special doors, and door installation. With somany different types of metal and wood doors, you decide



- 489 -

to further subdivide the categories. Under themetal door class, you create classes for pre-hungmetal doors, field-hung
metal doors, overhead-rigid metal doors, coilingmetal doors, entrancemetal doors, and security and gatemetal doors.
Under the class for wood doors, you create classes for pre-hung wood doors, field-hung wood doors, garage wood doors,
and entrance wood doors.

About the Part-Assembly Classes menu
ThePart/Assembly Classesmenu is accessible by right-clicking in thePart Classmenu tree orAssembly Classmenu
tree in the 9-4 Part/Assembly Classeswindow.

The following provides more information regarding its functionality:

l The name and number of the part/assembly are displayed in the class tree.

l You cannot create as many unassigned classes as you want without saving. Youmust save each one as it is
created by pressing the Enter key.

l The Fully Expand command expands just one class instead of the entire tree.

l Click the part class you want to add to or change, and then use theEditmenu or right-click menu to create a new
class.

Important:

The Fully Expand commandwill not appear unless Collapse
All has been selected from theOptions menu.

ThePart/Assembly Classesmenu includes the following commands:

l Fully Expand: Click this command to open every sub-class below the selected class.

l Insert: Click this command to insert a new part/assembly class above the position of your cursor.

l Indent: Click this command tomove the selected class to the right (build sub-classes). If the class has “children” or
sub-classes, you will be asked whether you want to include them in themove.

l Outdent: Click this command tomove the selected class to the left. If the class has “children” or sub-classes, they
are automatically included in themove.

l Rename: Click this command to renumber and/or rename the selected class.

l Delete: Click this command to delete the selected class.

Creating a class structure
Consider the following points before creating a class structure:

l Take the time to carefully plan the class structure. The benefits of a detailed class structure are lost if it is too
complex. Your goal is to be able to locate parts or assemblies without having to navigate through toomany
subclasses.

l After setting up the classes, you can assign classes to part records by editing the record in 9-2 Parts or by updating
the parts database through the 9-7 Maintain Parts Databasewindow.

To create a class structure:
1 Open 9-4 Part/Assembly Classes.

2 Do one of the following:
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a Click thePart Classes tab.

b Click theAssembly Classes tab.

3 Create a new class using one of the followingmethods:

a Click Insert on theEditmenu.

b Right-click in the tree, and click Insert.

4 Click theAppend New button (at the bottom) to add a class at the bottom of the tree.

5 In the outlined text box to the left (class number box), enter the class number.

6 In the outlined text box to the right (class description box), enter a brief statement about the class.

7 Press the Enter key. You can then use the arrow buttons tomove the classes.

8 On the Filemenu, click Save.

Fully expanding the part-assembly class tree
Fully Expand is a command available both on thePart/Assembly Edit menu and from the right-click menu. This feature
opens every sub-class below it.

To fully expand the part/assembly class tree:
1 In the 9-4 Part/Assembly Classeswindow, click a part class to select it.

2 Do one of the following:

a On theEditmenu, click Fully Expand.

b On the right-click menu, click Fully Expand.

Deleting part-assembly classes
Delete is a command available both on thePart/Assembly Editmenu and from the right-click menu. This feature allows
you to delete the selected class.

NOTE: All items under a class are also deleted. Before you delete a class, move its contents to another class using
9-7 Maintain Parts Database.

To delete a part/assembly class:
1 Open 9-4 Part/Assembly Classes.

2 Click a part class to highlight it.

3 On theEditmenu or the right-click menu, click Delete.

Indenting part-assembly classes
Indent is a command available both on thePart/Assembly Editmenu and from the right-click menu. This feature builds
sub-classes by moving the selected class to the right. If the class has “children” or sub-classes, you will be asked whether
you want to include them in themove.

To indent a part/assembly class:
1 Open 9-4 Part/Assembly Classes.

2 Click a part class to highlight it.

3 Select Indent from theEditmenu or the right-click menu.
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NOTE: The right arrow button also indents the class.

Inserting part-assembly classes
Insert is a command available both on thePart/Assembly Editmenu and from the right-click menu. This feature inserts a
new part/assembly class above the position of your cursor.

To insert a part/assembly class:
1 Open 9-4 Part/Assembly Classes.

2 Click a part class to highlight it.

3 Select Insert from theEditmenu or the right-click menu.

Outdenting part-assembly classes
Outdent is a command available both on thePart-Assembly Editmenu and from the right-click menu. This featuremoves
the selected class to the left. If the class has “children” or sub-classes, they are automatically included in themove.

To outdent a part/assembly class:
1 Open 9-4 Part/Assembly Classes.

2 Click a part class to highlight it.

3 Select Outdent from theEditmenu or the right-click menu.

NOTE: The left arrow button also outdents the class.

Renaming part-assembly classes
Rename is a command available both on thePart/Assembly Editmenu and from the right-click menu. This feature allows
you to renumber and/or rename the selected class.

To rename a part/assembly class:
1 Open 9-4 Part/Assembly Classes.

2 Click a part class to highlight it.

3 Select Rename from theEditmenu or the right-click menu.

Positioning classes using the arrow buttons
You can use the arrow buttons tomove the classes to different positions in the class hierarchy.

Button What it does

Left arrow Moves an item back one level in the hierarchy.

Right arrow Moves an item forward one level in the hierarchy.

Locating a part or assembly
The Lookupwindow is split. The left half displays the classes, and the right half displays the contents of the class that you
select.



- 492 -

To locate a part or assembly:
1 In the Lookupwindow, click the triangle next to the class you want to open or close.

2 The color of the triangle indicates whether you can display more subclasses.

Color Description

Red The class cannot be expanded any further (end of the
branch).

Blue Currently selected class showing all subclasses.

Green Contains subclasses and can be opened by clicking on the
plus sign (always displays a plus sign).

TIP: You can select a number of items and insert them in the window using aPicklist.

About setting up parts and part classes for lumber
You can set up cut materials as separate part records and then use the part classes tomanage the pricing blocks. For each
length of dimensional lumber, create a separate part record. When entering a part record for lumber, enter the dimensions in
theDescription box before any other description. When you update prices using theBoard Footagewindow, Sage 100
Contractor uses the dimensions to compute the new cost or billing rates.

Sage 100 Contractor assumes that you enter the first two dimensions in inches and the third dimension in feet. If you want
to indicate different dimensions, use a quotationmark (") to indicatemeasurements in inches and an apostrophe (‘) to
indicatemeasurements in feet. For example, you can enter 2x4x8 or 2x4x72" as the dimensions.

You can also enter fractions or decimals. For example, you can enter 2´4´92-1/4" Doug Fir #2 or 2´4´92.25" Doug Fir #2.
Note that a hyphen separates the fraction from the dimension. The hyphen is necessary for Sage 100 Contractor to
recognize the fraction.

When designing part classes for lumber, base the classes on the lumber species, then grade, then dimensions, and finally
length. Within each species and grade, prices per board foot sometimes depend on the lengths you want to purchase.
Some vendors discount the prices for lengths under 10 feet. Others charge higher prices for lengths over 16 feet. For
lengths over 20 feet, most vendors charge premium prices at each cut length.

Therefore, you should create a part class for each of these price blocks within a species and grade. This will allow you to
locate the dimensional lumber you need when creating a takeoff. This also allows you to update the lumber costs and billing
rates by part class.

For example, a vendor charges $0.38 per linear foot for lengths up to 20 feet and $0.87 per linear foot for lengths 20 feet and
above for Douglas Fir #2 2x4s. You would then set up two part classes for Douglas fir 2x4s based on where the price
breaks exist.

9-5 Takeoffs

About takeoffs and estimating
Using Sage 100 Contractor 9-5 Takeoffs, estimating is fast, accurate, and fully integrated into scheduling, project
management and accounting. By combining the best features of databases and spreadsheets, we have developed one of
the strongest assembly estimating systems available.

Global variables, formulas, and templates make your estimating process easier andmore accurate. You can selectively
factor in cost increases and lock in prices to prevent accidental edits and add notes for clarity. Microsoft Windows
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functionality, such as cut, copy, and paste, allows you to import blocks of information from other estimates with just a few
mouse clicks. You can even copy and paste an estimating grid into aMicrosoft Excel worksheet if that suits your business
needs. In addition, you can export assembly estimating notes to change orders, purchase orders, RFPs, subcontracts, and
work orders.

The phases and bid items features provide a way to divide jobs and estimates into smaller segments for greater efficiency
in project management. Phases, for example, affect and follow through the entire job, including schedules, budgets, all
document control, purchase orders, subcontracts, change orders, proposals, project management reports and analysis, job
costs, change orders, payables, and billing. Phases can represent different sections of a job and can help you distinguish
among different types of work such as change orders or site work. Because phases flow through the entire job, they do not
restrict which billingmethods you can use.

Bid items, in contrast, only affect estimates and some billing items and do not follow through the entire job. You use bid
items to segment an estimate into smaller units and/or to satisfy external requirements for bidding and billing a job. Bid
items affect these line items: Daily Field Reports, Proposal, andUnitary Billing.

At the time you create a takeoff, Sage 100 Contractor uses the prices for materials from the parts database. When you
receive quotes from vendors, you can update the takeoff. In theVendor Price Updatewindow, you can select the vendor
and Sage 100 Contractor displays all the parts contained in a takeoff for that vendor. You can then enter the quoted prices
without searching the takeoff for each instance of a particular part. Some contractors receive pricing updates from vendors
or part pricing services, which provide updated prices for parts through the parts database. After updating the parts
database, you can update prices in a takeoff.

After the takeoff is complete, you can export information to generate budgets, proposals, requests for proposals, purchase
orders, service work orders, andmore. You can examine and analyze the anticipated project costs through a variety of
takeoff reports. In addition, you can even fax them directly to your subcontractors and suppliers without printing them out.

You can control the bid amount on takeoffs by entering a value in theOverridden Bid Totals line. This value overrides all
other calculated amounts in the takeoff and locks the estimated amount. While it is locked, the overridden amount remains
the same regardless of changes to amounts on the Takeoff Details grid.

Export notes can be created in a takeoff in theExport Notes column, and then you can export them to change orders,
purchase orders, requests for proposals, subcontracts, and work orders. These notes can be created for each line item in
your takeoff and can communicate important job information to vendors, subcontractors, suppliers, and clients.

About the tabs in 9-5 Takeoffs
There are five tabs in the 9-5 Takeoffswindow:

l Project Values

l Takeoff Details

l Recaps

l Insurance, Tax and Bonding

l Bid Summary

Each tab provides tools for working with and viewing different aspects of the project’s estimates.

Project Values tab:

The 9-5 Takeoffswindow opens with theProject Values tab in view. You use theProject Values tab to declare the value
for project variables, which Sage 100 Contractor then uses throughout the entire takeoff. For example, youmight use
certain measurements, such as a building’s total square footage or exterior perimeter, in formulas throughout a takeoff.
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Takeoff Details tab:

Use the Takeoff Details tab to set up bid items and phases, followed by enter parts and assemblies into the grid. The
columns define the parts and assemblies withPart#, Description, Unit, Quantity, Cost, andmore.

Recaps tab:

Use the buttons at the bottom of the window to break down your takeoff by Bid Items, Phases, Assemblies, Cost
Codes, Cost Types, Tasks, Vendors, andCost Code by Bid Item.

Insurance, Tax and Bonding tab:

Use this tab to calculate and include costs related to liability, use tax, and bonding.

Bid Summary tab:

Use this tab to adjust the bid summary to your business requirements.

l Takeoff Summary shows the calculated totals for the estimate.

l Apply Margin Override provides a way for you to apply a gross margin override of a specified percentage.

l Apply Markup to Ext Price applies themarkup to the extended price.

l This proceeding amount is calculated into the followingCalculated Bid Totals line.

l TheBid Amount can further be adjusted up or down and locked tomeet business requirements.

NOTES:
l Apply Margin Override andApply Markup to Ext Price aremutually exclusive. You can use one or the

other, but not both.

l You can set the default properties in many of the text boxes, check boxes, and grid cells to provide security
control.

l The insurance, sales tax, and bonding amounts are not reflected in the takeoff totals, grid, or any recaps.
These amounts are displayed individually on theBid Summary tab.

Viewing takeoff recaps
On theRecaps tab in 9-5 Takeoffs, you can display a summary of cost data for a takeoff. This allows you to review costs
before exporting the data to create budgets, purchase orders, or subcontracts.

Type What it displays

Assembly
Sage 100 Contractor breaks down the financial data for
each assembly by cost, extended price, combined
overhead and profit, and gross margin.

Bid Item
Sage 100 Contractor breaks down the financial data for
each bid item by cost, extended price, combined overhead
and profit, and gross margin.

Cost Code
Sage 100 Contractor breaks down the financial data for
each cost code by cost, extended price, combined
overhead and profit, and gross margin.
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Type What it displays

Cost Type

Sage 100 Contractor breaks down the financial data for
each cost type by budget, overhead, percentage of
overhead, profit, percentage of profit, extended price, gross
margin, and profit margin.

Phase
Sage 100 Contractor breaks down the financial data for
each phase by cost, extended price, combined overhead
and profit, and gross margin.

Task
Sage 100 Contractor breaks down the financial data for
each task by cost, extended price, combined overhead and
profit, and gross margin.

Vendor
Sage 100 Contractor breaks down the financial data for
each vendor by cost, extended price, combined overhead
and profit, and gross margin.

Cost Code
by Bid Item

Sage 100 Contractor breaks down the financial data for
each cost code by bid item by cost, extended price,
combined overhead and profit, and gross margin.

About the Takeoff Launch
When you click the 9-5 Takeoffsmenu, you first see the Takeoff Launchwindow. The window has two sections:

Open an existing takeoff -

Double-click a takeoff in the list to launch it in the 9-5 Takeoffswindow. You can use theSortmenu to sort the list by:

l Last Edited Date

l Job Number

l Job Name

Create a new takeoff -

This combo box has several entry points:

l Enter a unique number in the Job# text box, and you are prompted to create a new takeoff in 3-5 Jobs (Accounts
Receivable).

l Click the drop-down arrow to view the job list in theAccounts Receivable lookup window. Click a status to located
existing takeoffs. Double-click a takeoff to open it.

l Click theDetail button to open the 3-5 Jobs (Accounts Receivable)window to create a new job from which to
build a takeoff.

Creating takeoffs
The 9-5 Takeoffswindow offers many possibilities for creating takeoffs for your construction projects. You can create a
new takeoff or import an existing *.takeoff file to create a new takeoff from an existing takeoff.

To create a takeoff:
1 Open 9-5 Takeoffs.
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This opens the Takeoff Launchwindow.

2 Using Takeoff Launch, open an existing takeoff or create a new takeoff using a new or existing job.

3 In 9-5 Takeoffs, do one of the following:

a To import an existing takeoff file, on the Importmenu, click Takeoff File.

b In theBid Item list, select the bid item you want to work on.

c To edit the bid items, click the detail button next toBid Item.

4 Enter the project values.

5 If you want to use a grid file, select the bid item and phase. Then on the Importmenu, click Grid File.

6 In thePart Cost Default list, click the part pricing that you want to use.

7 On theUpdatemenu, click Takeoff from Database to update prices in the takeoff.

8 In each grid, do the following:

a Select and insert assemblies. Review each assembly to addmissing parts, delete unnecessary parts, and edit part
quantities as needed.

b Select and insert individual parts.

c Declare the values for local variables in assembly and part formulas.

d Verify that you have entered quantities for assemblies and parts where needed.

e Verify the cost codes, cost types, tasks, and vendors.

f Enter rough estimate values if you don't have exact values.

g Enter the overhead and profit rates.

9 On themenu bar, click Options, thenCalculate, or click the calculate button.

10 On the Filemenu, click Save.

TIP: When you receive a quote for materials, you can update part prices in a takeoff by the vendor.

Setting automatic reminders to save takeoffs
You can help safeguard takeoffs from data loss using theRemind to Save command, which provides a reminder for you to
save work. You can even set the interval when Sage 100 Contractor provides the reminder.

To set an automatic reminder to save takeoffs:
1 Open 9-5 Takeoffs.

2 On theOptionsmenu, click Remind to Save.

3 Select the interval for the reminder.

4 Click OK.

Deleting takeoffs
To delete a takeoff:
1 Open a takeoff in 9-5 Takeoffs.

2 On theEditmenu, click Delete Takeoff.
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Locking takeoff rows
You can use the lock feature to prevent changes to specific rows in a takeoff while updating part costs.

To lock a takeoff row:
1 Open 9-5 Takeoffs.

2 On the Takeoff Details tab, locate the row you want to lock.

3 Double-click the lock cell.

Sorting takeoffs
You can sort existing takeoffs by last edited date, job number, or job name.

To sort a takeoff:
1 Click 9-5 Takeoffs to open the Takeoff Launch dialog box.

2 On themenu bar, click Sort.

3 Click Last Edited Date, Job Number, or Job Name to select how the list is sorted.

Your selection will be saved as the default sort order.

Pricing and Quantities
Selecting the part pricing for takeoffs

Before creating a takeoff, select the part or vendor pricing that you want to use.

To select the part pricing for a takeoff:

1 In the Takeoff Launchwindow, create a new takeoff or select an existing takeoff.

2 In 9-5 Takeoffs, from thePart Cost Default drop-down list, select your preferred pricing.

3 The choices areDefault Cost, Billing Amount, Average Cost, Lowest Vendor, orPreferred Vendor.

Selecting part cost defaults

ThePart Cost Default list allows you to select the part pricing you want to use.

To select default part cost pricing:

1 Click the drop-down arrow next to thePart Cost Default text box to see the list of part cost defaults.

2 Click the default you want to use. It will be automatically saved with your takeoff.

Displaying the manufacturer details

You can include themanufacturer’s name and part number in theDescription column. Sage 100 Contractor only includes
themanufacturer’s information at the time that you create a takeoff.

To display the manufacturer details:

1 Open 9-5 Takeoffs.

2 On theOptionsmenu, click Manufacturers Details.
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Using minimum part quantities in takeoffs

With theMinimum Quantities by Takeoff command selected, Sage 100 Contractor determines the total extended
quantity for each part for the entire takeoff when you calculate it.

If the quantity from the takeoff is less than theminimum order quantity, Sage 100 Contractor determines the difference and
adds the amount to the extended part quantity where the part first appears in the takeoff.

If the quantity from the takeoff is greater than theminimum order quantity, Sage 100 Contractor determines the quantity
necessary to order the next complete package. Sage 100 Contractor then adds the amount to the extended part quantity
where the part first appears in the takeoff.

To use minimum part quantities in a takeoff:

1 On theUpdatemenu, point to Takeoff and click Minimum Quantities by Takeoff.

Using minimum part quantities in phases

With theMinimum Quantities by Phase command selected, Sage 100 Contractor determines the total extended quantity
for each part by phase when you calculate it.

If the quantity from the phase is less than theminimum order quantity, Sage 100 Contractor determines the difference and
adds the amount to the extended part quantity where the part first appears in the phase.

If the quantity from the phase is greater than theminimum order quantity, Sage 100 Contractor determines the quantity
necessary to order the next complete package. Sage 100 Contractor then adds the amount to the extended part quantity
where the part first appears in the phase.

To use minimum part quantities in a phase:

1 On theUpdatemenu, point to Takeoff and click Minimum Quantities by Phase.

Updating Parts Information
Updating part information in a takeoff or grid

IMPORTANT: Youmust type and between two numbers in theValue text box when using the between operator.

Before saving, review the changes. After you save, you cannot reverse the update.

To update part information in a takeoff or grid:

1 Open a takeoff in 9-5 Takeoffs.

2 Do one of the following:

a On theUpdatemenu, point toGrid, and click Grid Parts.

b On theUpdatemenu, point to Takeoff, and click Takeoff Parts.

3 UnderSearch Fields, do the following:

a In the Field list, click the type of information for which you are searching.

b In theOperator list, click themath operator.

c In theValue text box, enter the value for which you are searching.

4 UnderChange Fields, do the following:

a In the Field list, click the type of information that you want to update.
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b In the Type list, click how you want to update the data.

c In theValue text box, enter the value that you want to apply.

5 Click Update.

Updating part costs

You can update part costs in a takeoff grid or an entire takeoff. When you update by part cost, Sage 100 Contractor updates
the costs using the last cost amount from the parts database.

IMPORTANT: Before saving, review the changes. After you save, you cannot reverse the update.

To update part costs:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following.

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

3 Do one of the following:

a On theUpdatemenu, point toGrid, point toPrices from Parts Database, and click Use Default Cost.

b On theUpdatemenu, point to Takeoff, point toPrices from Parts Database, and click Use Default Cost.

Updating part costs by average cost

You can update part costs in a takeoff grid or an entire takeoff. When you update, Sage 100 Contractor updates the cost
using the average inventory cost from the parts database.

CAUTION: Always make a backup of your data before you update prices or add parts.

IMPORTANT: Before saving, review the changes. After you save, you cannot reverse the update.

To update the part cost by average cost:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following:

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

3 Do one of the following:

a On theUpdatemenu, point toGrid, point toPrices from Parts Database, and click Average (Inventory) Cost.

b On theUpdatemenu, point to Takeoff, point toPrices from Parts Database, and click Average (Inventory) Cost.

Updating part costs using the preferred vendor

You can update part costs in a takeoff grid or an entire takeoff. Sage 100 Contractor updates the costs using the preferred
vendor.

IMPORTANT: Before saving, review the changes. After you save, you cannot reverse the update.
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To update part costs using the preferred vendor:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following.

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

3 Do one of the following:

a On theUpdatemenu, point toGrid, point toPrices from Parts Database, and click Use Preferred Vendor and
Cost.

b On theUpdatemenu, point to Takeoff, point toPrices from Parts Database, and click Use Preferred Vendor and
Cost.

Updating part costs using the vendor with the lowest price

You can update part costs in a takeoff grid or an entire takeoff. Sage 100 Contractor updates the costs and vendors from
the vendor preference list.

IMPORTANT: Before saving, review the changes. After you save, you cannot reverse the update.

To update the part cost using the vendor with the lowest price:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following:

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

3 Do one of the following:

a On theUpdatemenu, point toGrid, point toPrices from Parts Database, and click Use Lowest Cost Vendor.

b On theUpdatemenu, point to Takeoff, point toPrices from Parts Database, and click Use Lowest Cost Vendor.

Updating vendor prices in takeoffs

To update vendor prices in a takeoff:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following:

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

3 Do one of the following:

a On theUpdatemenu, point toGrid and click Prices from Vendor (manual).

b On theUpdatemenu, point to Takeoff and click Prices from Vendor (manual).

4 TheVendor Price Updatewindow appears.

5 In theVendor drop-down list, select the vendor that you want to update.

6 Do one of the following:

a In thePrice column, enter the per part price for each part that you want to update.
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b In theExtended column, enter the total price for each part that you want to update.

7 Click Update.

NOTE: Parts for the selected vendor display in part number order.

Updating part costs using the takeoff vendor

You can update part costs in a takeoff grid or an entire takeoff. Sage 100 Contractor updates the costs in the takeoff from
the parts database for the vendor assigned to a particular part for that takeoff.

IMPORTANT: Before saving, review the changes. After you save, you cannot reverse the update.

To update the part cost using the takeoff vendor:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following:

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

c In theUpdatemenu, point toGrid, then point toPrices from Parts Database, then click Based on Takeoff
Vendors.

3 To update the entire takeoff, on theUpdate menu, point to Takeoff, then point toPrices from Parts Database, then
click Based on Takeoff Vendors.

A message appears with the following details about the update, prompting you to continue:

l Part prices for the grid are updated based on the assigned vendor’s price for the part.

l If the part is not found in the database, then no changes aremade to that part.

l If the assigned vendor’s price is zero and the part cost default exists for the part, then that cost is used.

l For all other instances, no changes aremade to that part’s price.

Updating part costs by billing amount

CAUTION: Always make a backup of your data before you update prices or add parts.

Important:

Before saving, review the changes. After you save, you cannot reverse the update.

To update the part cost by billing amount:

1 Open a takeoff in 9-5 Takeoffs.

2 To update a specific grid, do the following:

a In theBid Item list, select the bid item.

b In thePhase list, select the phase.

3 Do one of the following:

a On theUpdatemenu, point toGrid, then point toPrices from Parts Database, then click Use Part Billing Amount.

b On theUpdatemenu, point to Takeoff, point toPrices from Parts Database, then click Use Part Billing Amount.
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Change Orders
About takeoffs and change orders

You can estimate change order work without modifying the original takeoff. For each change order, create a new bid item
and assign it bid item type 4-Change Order. In the takeoff, select the new bid item and enter the changes. To reduce a
quantity or remove an assembly or part entirely, back out the cost by entering the item with a negative quantity. To add
assemblies or parts, enter the necessary items in the change order bid item. After you are finished entering change work,
you can export the change orders.

Suppose that you are building a residential home, and the client decides to upgrade the bathtub to a whirlpool bathtub. In the
takeoff, you create bid item 3-CO 1 whirlpool tub. In the takeoff grid for bid item 3-CO 1 whirlpool tub, you enter the part
for the tub and assign it a negative quantity to back out the original cost. You then enter the part for the whirlpool bathtub
using a positive quantity.

Entering change orders in takeoffs

To enter change orders in a takeoff:

1 Open a takeoff in 9-5 Takeoffs.

2 Next to theBid Item list, click the drop-down arrow and select a change order, or create a new change order if
necessary.

3 If you are using phases, select the phase from the phase list or click to add a new phase item.

4 Do the following for each assembly or part that you want to reverse from the takeoff:

a In theAssembly column, enter the assembly that you want to remove.

b In thePart column, enter the individual parts that you want to remove.

c In theQuantity column, enter a negative number.

5 Do the following for each assembly or part that you want to add to the takeoff:

a In theAssembly column, enter the assembly number.

b In thePart column, enter the part number for each individual part.

c In theQuantity column, enter the quantity.

6 On themenu bar, click Calculate.

7 On the Filemenu, click Save.

Overhead and Profits
About overhead and profit rates

You can choose from three different methods to set up the overhead and profit rates:

l Assign different overhead and profit rates by bid item.

l Assign overhead and profit rates by cost types.

l Assign overhead and profit rates by typing the overhead and profit rate values in the appropriate grid cells.

NOTE: Sage 100 Contractor only calculates overhead and profit for each item that has an overhead or profit rate in
the grid.
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Entering overhead and profit rates for bid items

Note that Sage 100 Contractor updates all bid items in the takeoff with the indicated rates.

To enter overhead and profit rates for bid items:

1 Open a takeoff in 9-5 Takeoffs.

2 Next to theBid Item list, click the detail button.

3 In theOverhead column, enter the overhead rate for each cost type.

4 In theProfit column, enter the profit rate for each cost type.

5 Click Save.

Entering overhead and profit rates for cost types

To enter overhead and profit rates for cost types:

1 Open a takeoff in 9-5 Takeoffs.

2 Do one of the following:

a On theUpdatemenu, point toGrid and click Overhead/Profit by Cost Type.

b On theUpdatemenu, point to Takeoff and click Overhead/Profit by Cost Type.

3 In theOverhead text box for each cost type, enter the overhead rate for each cost type.

4 In theProfit text box for each cost type, enter the profit rate for each cost type.

5 Click Update.

Including bonding costs in 9-5 Takeoffs

In the 9-5 Takeoffswindow, you can use the Insurance/Tax/Bonding tab to include the charge for bonding in the final bid
amount where the charge is based on the sales price while also being a component of the sales price. You only have to
supply the bonding limits and rates. Sage 100 Contractor computes the bonding amounts and adds them to the bid total for
you.

Suppose you won a $100,000 contract, which requires 2 percent bonding. That would be an additional $2,000 for a bid
amount of $102,000. Because the bonding is considered part of the contract, however, you need to include an additional 2
percent on the $2,000 for an additional $40, resulting in a bonding of $2040.82. The bid total, including the bonding,
becomes $102,040.82.

Bonding is usually considered to be overhead; however, you can include the bonding amount in the budget. Select the
Include in budget check box.

TIP: If you have entries in text boxes that are consistent, you can set up defaults to make the entry more automatic.

To include bonding costs in the final bid amount:

1 In 9-5 Takeoffs, click the Insurance/Tax/Bonding tab.

2 UnderBonding, do the following:

a In the Limit Amount text box for Limit 1, enter the limit as a dollar amount of the contract that is subject to bonding.

b In theRate text box for Limit 1, enter the percentage rate at which you calculate the bonding. Using this rate, Sage
100 Contractor computes the bonding amount up to the limit entered for Limit 1.

c In the Limit Amount text box for Limit 2, enter the limit as a dollar amount of the contract that is subject to bonding.
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d In theRate text box for Limit 2, enter the percentage rate at which you calculate the bonding. Using this rate, Sage
100 Contractor computes the bonding amount from Limit 1 through Limit 2.

e In theRate text box for Limit 3, enter the percentage rate at which you calculate the bonding. Using this rate, Sage
100 Contractor computes the bonding amount from Limit 2 up.

f In theCost Code text box, enter the cost code number to which you want to assign the bonding costs.

g In theCost Type list, click the cost type to which you want to assign the bonding costs.

h In theBid Item list, click the bid item to which you want to assign the bonding costs.

i In thePhase list, click the phase to which you want to assign the bonding costs.

Including liability insurance costs in 9-5 Takeoffs

In the 9-5 Takeoffswindow, you can use the Insurance/Tax/Bonding tab to specify what percentage of the project
(contract, labor costs, subcontract costs) is subject to liability insurance and the rate at which it is computed. When you
supply the percentage of the contract subject to liability insurance and the rate, Sage 100 Contractor automatically
computes the amounts and adds them to the bid total.

CAUTION: Are the overall liability costs already built into the overhead rate? If so, do not use the
Insurance/Tax/Bonding tab.

CAUTION: Are liability costs for payroll built into the labor burden? If so, do not use thePayroll text boxes on the
Insurance/Tax/Bonding tab.

IMPORTANT: There are several ways to compensate for liability insurance costs, and it is important to understand
how your company does this.

Also consider the following points:

l Liability insurance is usually considered to be overhead; however, you can include it in the budget. Select the
Include in budget check box.

l If you have entries in text boxes that are consistent, you can set up defaults to make the entry more automatic.

To include liability insurance costs in the final bid amount:

1 In 9-5 Takeoffs, click the Insurance/Tax/Bonding tab.

2 Under Liability Insurance, do the following:

a In theSubject text box for payroll, enter the percentage of the payroll that is subject to liability insurance.

b In theRate text box for payroll, enter the percentage rate at which you calculate the liability insurance. Using this rate,
Sage 100 Contractor only computes insurance costs for all items assigned cost type 2-Labor.

c In theSubject text box for subcontracts, enter the percentage of the subcontracts that is subject to liability insurance.

d In theRate text box for subcontracts, enter the percentage rate at which you calculate the liability insurance. Using
this rate, Sage 100 Contractor only computes insurance costs for all items assigned cost type 2-Labor.

e In theSubject text box for the bid, enter the percentage of the contract that is subject to liability insurance.

f In theRate text box for the bid, enter the percentage rate at which you calculate the liability insurance. Using this rate,
Sage 100 Contractor computes the insurance costs for the entire estimate.

g In theCost Code text box, enter the cost code number to which you want to assign the liability costs.

h In theCost Type list, click the cost type to which you want to assign the liability costs.

i In theBid Item list, click the bid item to which you want to assign the liability costs.
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j In thePhase list, click the phase to which you want to assign the liability costs.

Including tax costs in 9-5 Takeoffs

In the 9-5 Takeoffswindow, you can use the Insurance, Tax and Bonding tab when you need to include a charge in the
final bid amount where the charge is based on the sales price while also being a component of the sales price. When you
supply the percentage of the contract subject to taxation and the tax rate, Sage 100 Contractor computes the taxes and
automatically adds them to the bid total.

Suppose your state charges a 10% use tax. On a $100,000 contract, the tax is $10,000. Because the use tax is part of the
bid amount and not an addition to the bid amount, you need to also charge an additional 10% on the $10,000 tax resulting in
a tax of $11,111.11. So the total bid amount becomes $111,111.11.

CAUTION: Do not use the Insurance, Tax and Bonding tab if your state requires you to add a tax on top of the
contract price. Refer to your state tax code for more information.

Also consider the following points:

l Liability insurance is usually considered to be overhead; however, you can include it in the budget. Select the
Include in budget check box.

l If you have entries in text boxes that are consistent, you can set up defaults to make the entry more automatic.

To include tax costs in the final bid amount:

1 In 9-5 Takeoffs, click the Insurance, Tax and Bonding tab.

2 UnderUse Tax, do the following:

a In theSubject text box, enter the percentage of the contract that is subject to tax.

b In theRate text box, enter the percentage rate at which you calculate the tax. Using this rate, Sage 100 Contractor
computes the total tax for the takeoff.

c In theCost Code text box, enter the cost code number to which you want to assign the tax.

d In theCost Type list, click the cost type to which you want to assign the tax.

e In theBid Item list, click the bid item to which you want to assign the tax.

f In thePhase list, click the phase to which you want to assign the tax.

Bid Totals
About 9-5 Takeoffs and controlling the bid total on estimates

Sage 100 Contractor provides a way for you to override or control the bid total regardless of the changes to the takeoff
details, insurance, tax, bonding, or margin/markups.

To reduce errors and speed up the workflow, both the calculated andmanual totals appear at the same time on theBid
Summary tab. This total is always in view regardless of which tab you are using. Any changes that occur to the 9-5
Takeoffs tabs, such as Takeoff Details, Insurance/Tax/Bonding, are reflected in theCalculated Bid Totals. This allows
you to see what theBid Amountwould be if it were not locked.

In the following table representing the window section, the calculated bid amount is 67,828.16. This amount has been
overridden and rounded up to 70,000.00. Because the calculated bid amount has been overridden, the Lock Bid Amount
check box has been automatically selected and the lock icon appears on theBid Amount line.
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Profit Gross
Margin Bid Amount

Calculated Bid
total 2843.80 18.16% 67.828.16

Overridden Bid
Total 4787.51 20.38% 70,000.00

(locked)

Bid Amount $70,000.00

NOTE: This functionality does not support overriding
the totals of individual bid items or phases. It only
controls or overrides the final estimate total.

Adjusting bid totals with a bid amount override

You can adjust the bid total with a bid amount override using theBid Summary tab of the 9-5 Takeoffswindow. Using the
Bid Amount text box on theOverridden Bid Totals line, you can enter an amount that overrides the values of the entire
bid.

Be aware of the following points:

l Changing the bid amount supersedes additional profit or margin override from the previous section.

l If the Lock Bid Amount check box is selected and there are amounts for insurance, use tax, or bonding, the
Calculated Bid Totals line will not be the total from the preceding numbers because the currently displayed
amounts for insurance, use tax, and bonding are based on the “overridden” bid amount, whereas theCalculated Bid
Totals line is based on the amounts for insurance, use tax, and bonding that would result if theBid Amountwas not
locked.

l When youmodify the Takeoff Details grid quantities, the changes do not impact the “overridden” total if locked;
however, these changes are reflected in the “calculated” bid total.

l You can clear the Lock Bid Amount check box, which resets theBid Amount to the calculated amount.

To adjust bid totals with a Bid Amount override:

1 Open 9-5 Takeoffs.

2 Using Takeoff Launch, launch the takeoff that you want to adjust.

3 Click theBid Summary tab.

4 At the end of theOverridden Bid Totals line in the text box, enter a value.

5 When you have entered a value, Sage 100 Contractor automatically selects the Lock Bid Amount check box.

Formulas and Variables
About formulas

Formulas let you shorten the steps necessary to complete a takeoff. Suppose you have a concrete assembly that was
designed for pouring slabs. The assembly contains the necessary parts including the forming stakes, rebar, forming ties,
and concrete. Because the part quantities depend on the size of the slab, figuring out the part quantities each time you use
the assembly can create a great deal of work.
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Instead of performing all the necessary mathematical calculations by hand, you can enter a formula and have Sage 100
Contractor calculate dimensions, quantities, or prices for individual parts or assemblies, and even account for waste
material costs. In the above example, you could include a formula to compute the cubic yards of concrete that youmight
need to pour.

With each assembly record, you can enter the formula using variables, which replace actual dimensions. A variable acts as
a placeholder for the actual information. Each time that you insert an assembly, declare the values of the variables
contained in the formula above the assembly. When you calculate the takeoff, Sage 100 Contractor replaces the variables
with the declared values and determines the result.

Some assemblies or parts use values that do not change through a takeoff such as the enclosed square footage or exterior
building perimeter. In this case, a takeoff uses one value for the variable throughout a takeoff. Rather than declaring the
value for each appearance of the variable, declare the value one time on theProject Values tab.

You can assign a formula to individual items in an assembly or to the assembly itself. By assigning a formula to the
assembly, Sage 100 Contractor calculates the results for the entire assembly. For example, you have an assembly for
roofing that uses a formula to calculate the entire square footage, including overhangs and the roof pitch. Individual items in
an assembly can also use formulas. In the same roofing assembly, a line item for roofing paper uses a formula to calculate
the quantity of paper necessary to complete the work plus waste.

In a takeoff, you can use formulas with individual parts. Unlike assemblies, part records do not allow you to include
formulas. As you enter each part in a takeoff, enter the formula that you want to use with it.

About variables

Each time you create a takeoff, the dimensions and prices and quantities of materials change relative to the project
specifications, but the formulas generally remain the same. You could rebuild each formula in a takeoff using the
information from the plans, but amuch quicker way is to build the formulas using variables.

Variables act as placeholders for actual numeric values. The variables allow you to build formulas and save them in the
assemblies without having to enter actual figures until you create a takeoff. As you build a takeoff, you assign a numeric
value to each variable that you are using. Sage 100 Contractor substitutes the declared values for the variables and
computes the results.

IMPORTANT: Using undeclared variables in takeoffs may result in inconsistent or incorrect calculations in Version
14 and all previous versions. We recommend that you declare all variables in takeoffs in order for the calculations to
be correct.

Suppose that you are creating a takeoff for a job to build a shed. As part of the job, you need to pour a cement slab. You can
use a formula to calculate the cubic yards of cement necessary for the pour. In the takeoff, enter the variables for the
length, width, and depth of the slab and declare the value for each. The plans require a 15 by 20 by 1 foot slab, so you enter
L=15, W=20, and D=1 in the takeoff grid.

The cement assembly already contains the formula Q = L *W * D / 27, which defaults to the Formula columnwhen you
enter the assembly in the takeoff. When you calculate the takeoff, Sage 100 Contractor uses the declared values in place
of the variables in the cement assembly and inserts the result in theQuantity column of the cement assembly.

The declared values for variables are limited to the grid in which they are declared. After you declare a value for a variable,
Sage 100 Contractor uses the value with subsequent formulas in that takeoff grid. Suppose that you use phases with the
takeoff for the shed, and enter the exterior framing and siding assemblies in a different phase from the concrete slab.
Though the exterior framing and siding assemblies use the same dimensions for length and width as the cement assembly,
Sage 100 Contractor does not refer to the grid containing the cement assembly to determine values. Rather, youmust
declare the values for the variables in the phase containing the exterior framing and siding assemblies.

If the declared values for variables are constant across multiple takeoff grids, set them up as project values. Project values
allow you to declare the value once for a variable and Sage 100 Contractor uses it throughout the takeoff. Continuing with
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the example, you could declare the values length, width, and depth in theProject Values tab. Sage 100 Contractor would
use the declared values in the respective phases for concrete, and framing and siding.

You can always declare new values for variables. In some instances, formulas share variables but require different values.
Simply declare the new values in the lines preceding the formula requiring them. Sage 100 Contractor uses those values for
the variables through the remainder of the takeoff grid.

About Total Labor Units (TLU)

The formula Q = TLU is used to accumulate the total labor units (TLU) for specific groupings within a takeoff or for the entire
takeoff. Placement of the variable will dictate where the accumulated results are displayed in the grid.

The reserved variable for Total Labor Units (TLU) totals the labor units by looking at each line of the takeoff. On each line,
Sage 100 Contractor finds parts withCost Type = 2-Labor (based on thePart# column) andmultiplies the Labor Unit (as
defined in 9-2 Parts) by the extended quantity of the takeoff line in the grid. The accumulation of these results is assigned to
the TLU variable and displayed in the grid where the formula Q = TLU is next placed. TLU is then reset to 0 and the next
accumulation will begin; results will then display at the next occurrence of the variable.

NOTE: If a part has been assigned a labor part number in addition to labor units, then that particular line of the takeoff
does not affect the TLU. When the part was initially added to the takeoff, the labor part was included so the total labor
for that part will be accounted for in the takeoff.

Entering project values

Youmight use certain measurements such as a building’s total square footage or exterior perimeter in formulas throughout
a takeoff. You do not necessarily have to declare the value for a variable in every takeoff grid. When you declare the value
for variables, Sage 100 Contractor uses these values throughout the entire takeoff.

Consider these points before entering project values:

l Project values affect only the takeoff in which they are set up.

l Include project values with takeoff files. When you import the file, declare the value of the project values.

l You can declare a new value for a global variable in a grid. Simply declare the new values on the lines preceding the
formula that will use them. Sage 100 Contractor will use those values in the takeoff grid until you declare new values
again.

To enter project values:

1 Open 9-5 Takeoffs.

2 In the Takeoff Launchwindow, open a job.

3 Click theProject Values tab.

4 In theDescription cell, enter a brief statement about the variable.

5 In theVariable Name cell, enter the variable you want to use.

6 In theUnits cell, enter the unit of measurement.

7 In theQuantity cell, enter the value of the variable.

Declaring the values for variables

IMPORTANT: Themath evaluator requires that you declare all variables. If themath evaluator finds undeclared
variables in takeoff formulas, the program proceeds through the calculations using zero for each undeclared variable.
Then it displays amessage telling you that you have undeclared variables and lists the lines where they are located in
the takeoff so that you can declare them.
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To solve a formula, assign a value to each variable in each takeoff grid. Suppose that you entered an assembly for cement
in the takeoff grid, and it contains a formula to calculate the cubic yards of cement needed for the project. For each variable,
enter a description and the units of measurement. In theQuantity column, enter the value. Then in the Formula column,
set the variable equal to theQuantity column. The values must precede the formulas; otherwise, Sage 100 Contractor will
not use the values.

Row Assmb# Dscrpt Unit Qty Formula

1 Length feet 15 L=Q

2 Width feet 20 W=Q

3 Depth feet 1 D=Q

4 3001 Cement CuYd 11.11 Q=L*W*D/27

You can declare new values for variables in the same takeoff grid. Some formulas might use the same variables but will
require different values. Simply declare the new values on the lines preceding the formula that will use them. In a takeoff
grid, Sage 100 Contractor uses the assigned values until you declare new values for those same variables.

IMPORTANT: Using undeclared variables in takeoffs may result in inconsistent or incorrect calculations. We
recommend that you declare all variables in takeoffs in order for the calculations to be correct.

About reserved variables

Sage 100 Contractor reserves three variables for specific operations. You can use any of these variables in your part or
assembly formulas to determine the total quantity, price, or labor units.

Variable What it is for

Q When solving an equation for a quantity, Sage 100 Contractor
enters the result in theQuantity cell.

P When solving an equation for a price, Sage 100 Contractor
enters the result in theCost cell.

TLU To solve an equation obtaining totals for labor units.

About solving formulas

Formulas provide the ability to enter mathematical equations that can be used to determine quantities or prices. In a takeoff,
youmust declare the values of the variables in a line preceding the line that contains the formula.

IMPORTANT:
l When using bid items or phases, you have to declare the value of each variable in each grid.

l Sage 100 Contractoruses the value that you assign to a variable until you declare a new value.

l If you do not declare a value for a variable, Sage 100 Contractor ignores the variable and does not assign any
value to it.

In any equation, first indicate what you are solving, such as a price, quantity, or storage of a value that you will use in a later
formula. Suppose that you want to solve for the cubic feet in a cement slab. Q represents the quantity, with L representing
the length in feet, W representing the width in feet, and T representing the thickness in feet. The formula should be: Q = L *
W * T.

In the above formula, Sage 100 Contractor solves the equation and inserts the result in theQuantity cell. Sage 100
Contractor reserves several variables for specific purposes: Q for quantity, P for price, and TLU for total labor units. When
solving for a price, Sage 100 Contractor inserts the result in thePrice cell.
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The variable Q = TLU is used to accumulate the total labor units (TLU) for specific groupings within a takeoff, or for the
entire takeoff. Placement of the variable will dictate where the accumulated results will be displayed in the grid.

The reserved variable for Total Labor Units (TLU) totals the labor units by looking at each line of the takeoff. On each line,
Sage 100 Contractor finds parts withCost Type = 2-Labor (based on thePart# column) andmultiplies the Labor Unit (as
defined in 9-2 Parts) by the extended quantity of the takeoff line in the grid. The accumulation of these results is assigned to
the TLU variable and displayed in the grid where the formula Q = TLU is next placed. TLU is then reset to 0 and the next
accumulation will begin; results will then display at the next occurrence of the variable.

Always begin an equation with the variable for the solution. In the equationW = Q, the solutionW equals the value of
quantity Q, which is the value in theQuantity cell. Whereas in Q = W, the solution for quantity Q equals the value of W. In
this case, Sage 100 Contractor takes the declared value forW and inserts it in theQuantity cell.

Types of calculations you can perform in formulas

You can perform the following basic mathematical operations: addition, subtraction, multiplication, division, calculating
powers, and calculating square roots. When Sage 100 Contractor calculates a formula, it performs operations in
parentheses first. Then Sage 100 Contractor calculates absolute values and square roots and powers, multiplication and
division, and finally addition and subtraction.

Use Function Expression Result

+ Add 21+53 74

– Subtract 45–18 27

* Multiply 5*8 40

/ Divide 72/9 8

^ Calculate powers 5^2 25

( ) Calculate expressions in the
parentheses prior to other expressions. 4*(2+3) 20

SQR Calculates the square root of the
number enclosed in parentheses. SQR(64) 8

ABS Determines the absolute value of the
number enclosed in parentheses.

ABS(–4)

ABS(2)

4

2

Compensating for materials waste in your takeoffs

Wastematerials add to the job costs and impact profitability. By compensating for the costs of wastematerials generated
during certain job tasks, the accuracy of takeoffs improves. As the estimates becomemore accurate, jobs becomemore
profitable.

Suppose that in creating a takeoff for the construction of a new home you calculate the number of pounds of nails
necessary to complete the job and nomore. During the construction, the crew falls short on nails. Consequently, you incur
an unforeseen job cost for the purchase of additional nails, which cuts into profits. A single instance such as this might not
seriously impact the profitability of a single job. However, consider the effect on profitability when dealing with a variety of
materials that generate large amounts of waste.

The following are examples of materials that produce large amounts of waste:



- 511 -

l Concrete and grout

l Concrete reinforcingmaterials

l Brick andmasonry block

l Screws, nails, and other fasteners

l Rough lumber and plywood

l Electrical conduit and wire

l Building wrap and visquene

l Finish lumber

l Roofingmaterials

Keep your takeoffs simple. Waste factors are not necessary for all materials. To compensate for waste, select from two
methods to adjust materials quantities. In the first method, adjust the part quantities in assemblies to include possible
waste. This method is faster in its initial setup; however, as you use the assemblies, it is not as easy to go back and refine
the part quantities.

With the secondmethod, you can create project values for waste factors. As you build formulas that calculate part
quantities, whether for individual parts or parts in assemblies, you can include a variable for waste. Setting up the waste
factors as project values allows you to refine waste factors as you use them.

Suppose that 5 percent of the cement you pour always becomes wastedmaterial. To calculate the quantity plus waste, you
need to increase the quantity by 5 percent. To do this, multiply the quantity formula by 105 percent (expressed as 1.05). The
examples below illustrate how to use project values for waste factors.

Item Formula Description

Visquene Q = “quantity formula” * WCF

WCF (Waste Concrete
Film): Declare the value
equal to 1.2 to allow for
overlapping of adjacent
rolls and loss at the edges
of the slab due to partial roll
width.

Rebar Q = “quantity formula” * WCR

WCR (Waste Concrete
Reinforcing): Declare the
value equal to 1.25 to allow
2 foot overlap when bars
are spliced together and
loss due to unused short
pieces of bar.

Concrete Q = “quantity formula” * WCR
WCR (Waste Concrete):
Declare the value equal to
1.2 to allow for spillage.

Security
Hiding bid total amounts in 9-5 Takeoffs

In business situations where certain amounts and totals must be hidden from view, Sage 100 Contractor provides the
functionality to make sure that your company bid information is kept private. Pressing the F7 key when your cursor is in
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almost any cell, list, check box, grid cell, or column opens the Field Propertieswindow. In the Field Propertieswindow, a
supervisor can set up the security on the 9-5 Takeoffswindow to hide or reveal bid total amounts.

IMPORTANT: The supervisor user may want to hide some of these items and reveal others, but to be able to view 9-
5 Takeoffs from a cost-only perspective, all the items should be hidden.

IMPORTANT: If a report contains a field that is restricted for a user, then that report is unavailable to that user.

To hide bid total amounts:

1 In the 9-5 Takeoffswindow, click the Takeoff Details tab and do the following:

2 In the grid, select theO/H Rate column, press F7, and set the security.

3 Select theOverhead column and press F7.

4 Select theProfit Rate column and press F7.

5 Select theProfit column and press F7.

6 Select theExt Price column and press F7.

7 Click the Insurance/Tax/Bonding tab and do the following:.

a Under Liability Insurance, in theBid line, place your cursor in theAmount cell, press F7, and set the security.

b UnderUse Tax, in theBid line, place your cursor in theAmount cell, press F7, and set the security.

c UnderBonding, in the Limit 1 line, place your cursor in theAmount cell and press F7.

d UnderBonding, in the Limit 2 line, place your cursor in theAmount cell and press F7.

e UnderBonding, in the Limit 3 line, place your cursor in theAmount cell and press F7.

8 Click theBid Summary tab and do the following:

a Place your cursor in theGross Margin Override text box, press F7, and set the security.

b Place your cursor in theBid Amount text box and press F7.

c Place your cursor in theMarkup % text box and press F7.

9 On themenu bar, point toUpdate, thenGrid (or Takeoff), thenOverhead/Profit by Cost Type.

10 In theOverhead/Profit by Cost Typewindow, click in each cell in theOverhead % andProfit % columns, press F7,
and set the security.

11 Close theOverhead/Profit by Cost Typewindow. Do not update.

12 In theBid Itemswindow grid, do the following:

a Click the Takeoff Details tab.

b Next to theBid Items cell, click the detail button.

c Select theOverhead andProfit columns, press F7, and set the security.

Hiding cost total amounts in 9-5 Takeoffs

In business situations where certain amounts and totals must be hidden from view, Sage 100 Contractor provides the
functionality to make sure that your company profit andmargin information is kept private. Pressing the F7 key when your
cursor is in almost any text box, list, check box, grid cell, or column opens the Field Propertieswindow. Using the Field
Propertieswindow, a supervisor can set up the security in the 9-5 Takeoffswindow to hide or reveal cost total amounts.
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IMPORTANT: The supervisor user may want to hide some of these items and reveal others, but to be able to view 9-
5 Takeoffs from a cost-only perspective, all the items should be hidden.

IMPORTANT: If a report contains a field that is restricted for a user, then that report is unavailable to that user.

To hide cost total amounts:

1 In the 9-5 Takeoffswindow, click the Takeoff Details tab and do the following:

a In the grid, select theExt Cost column, press F7, and set the security.

b Select theCost column and press F7.

c Select the Formula column and press F7.

d Select theSales Tax column and press F7.

e Select theO/H Rate column and press F7.

f Select theOverhead column and press F7.

g Select theProfit Rate column and press F7.

h Select theProfit column and press F7.

2 Click the Insurance/Tax/Bonding tab and do the following:

a Under Liability Insurance, click in theSubcontract Amount cell, press F7, and set the security.

b Under Liability Insurance, click in thePayroll Amount cell, press F7, and set the security.

3 Click theBid Summary tab, click in theGross Margin Override cell, press F7, and set the security.

4 On themenu bar, point toUpdate, thenGrid (or Takeoff), thenOverhead/Profit by Cost Type.

5 In theOverhead/Profit by Cost Typewindow, click in each cell in theOverhead % andProfit % columns, press F7,
and set the security.

6 Close theOverhead/Profit by Cost Typewindow. Do not update.

7 In theBid Itemswindow grid, do the following:

a Click the Takeoff Details tab.

b Next to theBid Items cell, click the detail button.

c Select theOverhead andProfit columns, press F7, and set the security.

Hiding the labor parts

You can hide labor parts that have been attached tomaterial parts.

To hide the labor parts:

1 Open 9-5 Takeoffs.

2 Double click to select an existing takeoff.

3 On theOptionsmenu, click Hide Labor Parts.

Takeoff Details Tab Grid Views and View Menus
About the Takeoff Details tab grid menus

The 9-5 Takeoffswindow provides five tabs for working with estimates. Three of the tabs have grids. The Takeoff Details
tab can be constructed from definitions and descriptions of what is needed to complete the work in addition to parts and
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assemblies. This grid can be built and customized to provide information on specific parts of an estimate by displaying
specific views of an estimate.

Four menus interact on the Takeoff Details tab grid to provide functionality for customizing the grid into different views and
for working with values within the grid.

l TheGrid Viewsmenu located on themenu bar.

l TheView drop-downmenu located on the window tabs to the right of theBid Item andPhase drop-downmenus.

l The grid cell right-clickmenu opens when you right-click in any grid cell.

l The column right-clickmenu opens when you select a column heading and right-click it.

NOTES:
l The Takeoff Details tab grid provides moremenu options and thereforemore functionality than the grids on

other windows and tabs and is unique among Sage 100 Contractor grids.

l There are two different ways to work with columns on the Takeoff Details tab grid using themouse right-click.
The program displays various commands depending on which column you have selected and right-clicked or
which column cell you have right-clicked.

l To create permanent grid views, see the topic Right-click grid cell menu (Takeoff Details tab).

l TheRecaps tab does not offer any grid menu functionality.

About the Grid Views menu (Takeoff Details tab)

TheGrid Viewsmenu is located on themenu bar and provides the following the functionality:

l Add New View—Create a new view of the columns you want to see in your estimate.

l Edit Current View—Change an existing grid view.

l Delete Current View—When you do not need a view, you can delete it from theViews list.

l Restore Default View—Restore the default views that are built in to the Takeoff Details tab.

About the View menu for displaying grid column views (Takeoff Details tab)

TheViewmenu is available on the Takeoff Details tab. You can select one of nine default column views from theView
drop-downmenu.

The column views are:

l All (displays every column available)

l Material Survey Entry

l Material Survey Full

l Parts

l Assemblies

l Formulas

l Markups

l Cost Code/Type/Task

l Vendors
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Right-click grid cell menu (Takeoff Details tab)

When you place your cursor in a Takeoff Details tab grid cell and right-click, you open amenu of multiple commands. Many
of the commands are self-explanatory and are typical Windows commands such as cut, copy, paste, insert:

l Display Quick List and/orDisplay Detail/Add Record and/orDisplay Picklist Window or none of them.

l Cut, Copy, Paste

l Insert Row, Cut Row, Clear All Rows

l Show/Hide Columns...—Opens theGrid Viewwindow with which you can select or clear check boxes to show or
hide all the existing columns.

l Save Current Grid View (temporarily saves the Show/Hide Columns... command)

l Autofit All Columns

l Find...—Opens theGrid Find window with which you can search for terms in the grid.

l Enter Key Moves Right

l Enter Key Moves Down

IMPORTANT: There are two different ways to work with columns on the Takeoff Details tab grid using themouse
right-click. The program displays various commands depending on which column you have selected and right-clicked
or which column cell you have right-clicked.

IMPORTANT: To save selected columns permanently, from themenu bar, select Grid Views > Add New View or
Edit Current View.

Right-click grid columns menu (Takeoff Details tab)

When you place your cursor in a column heading and right-click, you open amenu of several commands. These commands
vary depending on the column you select. For example, some columns provide commands for displaying a Lookup
Window, others for displaying aQuick List, and yet others do display either command.

l Display Lookup Window (or)Display Quick List (not displayed in every columnwhen selecting a column and
right-clicking)

l Cut, Copy, Paste

l Hide Selected Column

IMPORTANT: There are two different ways to work with columns on the Takeoff Details tab grid and both are done
using themouse right-click. The program displays various commands depending on which column you have selected
and right-clicked or which column cell you have right-clicked.

Adding new grid views (Takeoff Details tab)

You can create and name your own customized grid views and then add them to theView list on the Takeoff Details tab.

To add a new grid view:

1 Open 9-5 Takeoffs, and click the Takeoff Details tab.

2 On theGrid Viewsmenu, click Add New View.

3 On theAdd Grid Views dialog box, select a check box to add columns, or clear a check boxes to remove columns.

4 In the text box at the top, type a view name, and then click Save this View.
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Editing the columns displayed in a grid view (Takeoff Details tab)

You can temporarily change which columns display in a specific grid view on the Takeoff Details tab.

To edit the columns displayed in a grid view:

1 Open 9-5 Takeoffs, and click the Takeoff Details tab.

2 Right-click in a grid cell.

3 Do the following:

a Select the check boxes by columns you want to display.

b Clear the check box by the columns you want to hide.

4 Click OK.

Deleting the current grid view (Takeoff Details tab)

You can delete custom and default column views in theView list on the Takeoff Details tab.

CAUTION: A custom view that has been deleted cannot be restored. Youmay restore default views by clicking
Restore Default Views. Remember, restoring defaults will remove all additions andmodifications to the grid views
that are currently listed.

To delete the current grid view:

1 Open 9-5 Takeoffs, and click the Takeoff Details tab.

2 From theGrid Viewsmenu, click Delete Current View.

3 When prompted to confirm, click Yes.

Restoring default grid views (Takeoff Details tab)

You can restore the default grid views to theView list in 9-5 Takeoffs.

CAUTION: Restoring defaults will remove all additions andmodifications to the grid views that are currently listed.

To restore default grid views:

1 Open 9-5 Takeoffs, and click the Takeoff Details tab.

2 From theGrid Viewsmenu, click Restore Default Views.

3 When prompted to confirm, click Yes.

Showing and hiding grid columns (Takeoff Details tab)

You can temporarily show or hide columns in the grid using the right-click menu to display theGrid Viewwindow.

To show or hide columns:

1 Open 9-5 Takeoffs, and click the Takeoff Details tab.

2 In the grid, right-click in a cell to display the grid menu and select Show/Hide Columns.

3 In theGrid Viewwindow, select or clear the check boxes beside the column names to select the columns you want to
display or hide.

4 Click OK.
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Saving column widths using the Save Current Grid View command (Takeoff Details tab)

You can resize a columnwidth by clicking and dragging the boundary on the right side of the column heading until the
column is the width you want. Then you can save the columnwidth with theSave Current Grid View command.

NOTE: There are two different ways to customize columns on the 9-5 Takeoffs window grid. Both are done using the
right-click grid menu, but it is important to remember that the commands displayed on the grid menu vary depending in
which column you click and where in the column you click.

To save column widths:

1 Open 9-5 Takeoffs, and click the Takeoff Details tab.

2 Click the right side of a column heading, and drag it to the desired width.

3 Right-click a grid column heading to display themenu, and click Save Current Grid View.

Project Values Tab Grid Menus
About the Project Values tab grid menus

The 9-5 Takeoffswindow provides five tabs for working with estimates. Three of the tabs have grids. You useProject
Values tab to declare the values for project variables. Sage 100 Contractor then uses these values throughout the entire
takeoff. Because it has a different purpose than the Takeoff Details tab, theProject Values tab grid has slightly different
menu commands. For example, you can sort the grid by a specific column.

The grid cell right-clickmenu opens when you right-click in any grid cell.

The column right-clickmenu opens when you select a column heading and right-click it.

NOTE: The Takeoff Details—Recaps tab does not offer any grid menu functionality.

Right-click grid cell menu (Project Values tab)

When you place your cursor in aProject Values tab grid cell and right-click, you open amenu of multiple commands.
Many of the commands are self-explanatory and are typical Windows commands such as cut, copy, paste, insert:

l Display Quick List (or no option)

l Cut, Copy, Paste

l Insert Row, Cut Row, Clear All Rows

l Show/Hide Columns...—Opens the Grid View window with which you can select or clear check
boxes to show or hide all the existing columns.

l Save Current Grid View

l Autofit All Columns

l Find...—Opens the Grid Find window with which you can search for terms in the grid.

l Enter Key Moves Right

l Enter Key Moves Down

IMPORTANT: There are two different ways to work with columns on theProject Values tab grid and both are done
using themouse right-click. The program displays various commands depending on which column you have selected
and right-clicked or which column cell you have right-clicked.
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Right-click grid column heading menu (Project Values tab)

When you place your cursor in a column heading and right-click, you open amenu of several commands. These commands
vary depending on the column you select. For example, some columns provide commands for displaying a Lookup
Window, others for displaying aQuick List, and yet others do display either command.

l Display Quick List (not displayed in every columnwhen selecting a column and right-clicking)

l Cut, Copy, Paste

l Hide Selected Column

l Sort by (column name)Column

IMPORTANT: There are two different ways to work with columns on theProject Values tab grid and both are done
using themouse right-click. The program displays various commands depending on which column you have selected
and right-clicked or which column cell you have right-clicked.

Showing and hiding columns (Project Values tab)

You can temporarily show or hide columns in the grid using the right-click menu to display theGrid Viewwindow.

To show or hide columns:

1 Open 9-5 Takeoffs, and click theProject Values tab.

2 In the grid, right-click in a cell to display the grid menu and select Show/Hide Columns.

3 In theGrid Viewwindow, select or clear the check boxes beside the column names to select the columns you want to
display or hide.

4 Click OK.

Exporting Files from 9-5 Takeoffs
About exporting files from 9-5 Takeoffs

Depending on the type of work that you perform, youmight need a few files or a large library. Careful thought should go into
the creation of each file that you build. Themark of a good file is one that requires little modification. Themore you have to
change a file to suit a specific situation, the less time it saves you. Remember that a file can include as much or as little
information as you want.

You can either use an existing record as the basis for a file or build a file completely from scratch. When using an existing
record, most of the work is already completed. Simply recall the record, modify it to meet your needs, then export it as a file.

Various commands are available on theExportmenu. Many of themenu commands, such as Change Orders,
Proposals, Purchase Orders, Request For Proposal, Subcontracts, Service Work Order, and Takeoff Prices to Part
Prices have submenus with more commands.

Exporting takeoffs to files

Consider the following points before exporting takeoffs to files:

l You canmake a file containingmost all the assemblies and parts necessary, or you canmake one containing a
simple outline.

l Instead of using an existing takeoff, you can create a new takeoff for the file.
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To export a takeoff to a file:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do the following for each grid:

a Delete any unwanted assemblies or parts.

b Delete any unnecessary values for variables.

c Delete any unnecessary quantities.

4 On theExportmenu, click Takeoff File. TheSave Filewindow opens.

5 Name the file, and click Save.

Exporting takeoff prices to parts database
1 Individually select the vendors whose prices you want to update, or click Select All Vendors.

2 UnderExport Options, make your selections:

a Select Update Default Cost to update theDefault Cost in Parts in 9-2 Parts.

b Select Update Billing Amount to update theBilling Amount in 9-2 Parts. This will be calculated by using the
Default Cost and theMarkup %. This option is only available if you have selectedUpdate Default Cost.

3 Select Update vendor prices to update a vendor’s price for any given part.

4 Select Add vendor to part if not already assigned. Sage 100 Contractor determines if the vendor for the part from the
takeoff exists for the given part in the database and adds the vendor and its prices, if necessary.

5 Click theExport button.

Exporting takeoff grids to files

Note that Sage 100 Contractor does not export bid items and job phases with a grid.

To export a takeoff grid to a file:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 In theBid Item list, click the bid item.

4 In thePhase list, click the phase.

5 Do the following in the grid:

a Delete any unwanted assemblies or parts.

b Delete any unnecessary values for variables.

c Delete any unnecessary quantities.

6 On theExportmenu, click Grid File.

7 Name the file. and click OK.

TIP: Instead of using an existing takeoff, you can create a new takeoff for the file.
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Exporting budgets from 9-5 Takeoffs to 6-2 Budgets

To export budgets:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 On theExportmenu, click Budget.

4 Close 9-5 Takeoffs.

5 Open 6-2 Budgets.

6 In the data control box, enter the record number for the budget that you want to view.

NOTE: Because the budget represents your costs, it does not contain markups.

Exporting proposals from 9-5 Takeoffs to 6-9 Proposals

You can export takeoffs from 9-5 Takeoffs to a proposal in 6-9 Proposals eitherBy Bid Item. If there is an override,
markups, or a lockedBid Amount, then the difference between theBid Amount and theExt. Price Total is proportionally
spread among all the proposal lines that are being created in the export.

To export a proposal from 9-5 Takeoffs to 6-9 Proposals:

1 Open 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do one of the following:

a On theExportmenu, point toProposal, then click By Cost Code.

b On theExportmenu, select Proposal, and then select By Bid Item.

4 Close 9-5 Takeoffs.

5 Open 6-9 Proposals.

6 In the data control box, enter the job number for the proposal that you want to view.

Exporting purchase orders from 9-5 Takeoffs to 6-6-1 Purchase Orders

Sage 100 Contractor creates purchase orders for lines assigned to a Vendor.

If a price and/or quantity adjustment is made after purchase orders have been exported, the adjustment must also bemade
to the purchase order in 6-6-1 Purchase Orders.

In addition, if the purchase order has previously been exported, the export amount that is displayed will change to the new
amount even though the full amount has not been exported. An alternatemethod for making the adjustment in 6-6-1
Purchase Orders is to re-export the purchase order with the new amount, and then delete the previously exported
purchase order in 6-6-1 Purchase Orders.

Things to remember when exporting purchase orders from 9-5 Takeoffs to 6-6-1 Purchase Orders:

l Exporting by Job exports the combined Vendor total for all bid items.

l Exporting by Job/Phase exports the combined Vendor total for all bid items.

l Exporting by Change Order exports the combined Vendor total for all Type-4 items.
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l Exporting by Task exports the items with a Vendor and Task. To use this option, a Vendor and Task must be
assigned to the item on the takeoff line.

l When PurchaseOrders are exported from 9-5 Takeoffs, the warning that the purchase order exceeds the budget
amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. After
exporting purchase orders, you should run the 6-1-12-21 Committed Costs report for the correct job to verify that
purchase orders have not exceeded the budget.

To export a purchase order:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do one of the following:

a On theExportmenu, point toPurchase Orders and click Job.

b On theExportmenu, point toPurchase Orders and click Job/Phase.

c On theExportmenu, point toPurchase Orders and click Change Order.

d On theExportmenu, point toPurchase Orders and click Task.

4 Select the purchase orders you want to export, then click Export.

5 Close 9-5 Takeoffs.

6 Open 6-6-1 Purchase Orders.

7 In the data control text box, enter the record number for the purchase order that you want to view.

Exporting subcontracts from 9-5 Takeoffs to 6-7-1 Subcontracts

NOTE: When Subcontracts are exported from 9-5 Takeoffs, the warning that the subcontract exceeds the budget
amount plus approved change orders for the job/phase/cost code/ cost type combination is not displayed. We
recommend that after exporting subcontracts you should run the 6-1-12-21 Committed Costs report for the correct
job to verify that subcontracts have not exceeded the budget.

To export subcontracts:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do one of the following:

a On theExportmenu, point toSubcontracts and select Job.

b On theExportmenu, point toSubcontracts and select Job/Phase.

4 Select the subcontracts you want to export, then select Export.

5 Close 9-5 Takeoffs.

6 Open 6-7-1 Subcontracts.

7 In the data control box, enter the record number for the subcontract that you want to view.

IMPORTANT: Sage 100 Contractor only uses cost type 4-Subcontracts to create subcontracts.

Exporting grids from 9-5 Takeoffs to 11-2 Work Orders

You can export individual grids from a takeoff to the 11-2 Work Orders/Invoices/Creditswindow. When you export, job
and client information are included on the work order record.
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To export a grid to a work order:

1 Open 9-5 Takeoffs, and launch a takeoff.

2 Click the Takeoff Details tab.

3 In theBid Item drop-down list, select a bid item.

4 In thePhase list, select a phase.

5 If there are no phases in your job, it can remain 0-None.

6 On theExportmenu, point toService Work Order, then click Current Grid Only.

7 Sage 100 Contractor launches 11-2 Work Orders/Invoices/Creditswith the exported grid in view.

8 In 11-2 Work Orders/Invoices/Credits, in the Type drop-down list, select an invoice type.

9 On the file menu, click Save.

IMPORTANT: Users must have security access to 11-2 Work Orders/Invoices/Credits in order to export work
orders. Without rights, the export is blocked.

NOTES:
l When exportingCurrent Grid Only, Sage 100 Contractor only exports the grid that you have displayed.

l Theremay be a small variance between the grid total for theExt Price in 9-5 Takeoffs and the work order total
in 11-2 Work Orders. This is due to rounding.

Exporting service work orders from 9-5 Takeoffs to 11-2 Work Orders-Invoices-Credits

You can export individual grids from a takeoff to the 11-2 Work Orders/Invoices/Creditswindow. When you export, job
and client information are included on the work order record.

You can also export an entire takeoff to the 11-2 Work Orders/Invoices/Creditswindow. When you choose this option,
Sage 100 Contractor copies all the lines from all the bid items and phases from the Takeoff Details grids and inserts them
into the Invoice Details grid of the 11-2 Work Orders/Invoices/Creditswindow with a blank line separating each bid item
or phase section.

IMPORTANT: Insurance, use tax, and bonding amounts are required to be zero before you can export a takeoff to 11-
2 Work Orders.

If you have aGross Margin Override, Sage 100 Contractor exports the same as if theBid Amount is locked. Markup
information is inserted directly into the work order in the following ways:Markup % goes to either the Taxable orNon-Tax
Markup % text boxes in the 11-2 Work Orders/Invoices/Creditswindow, andDollar Markup goes to either the Taxable
orNon-Tax Markup $ text boxes in 11-2 Work Orders/Invoices/Credits. Job and client information are included in the
work order record. Tax District and address and contact information are included from the job record or the client
record.Address and contact information are included from the job record or the client record.

During the export process, if there is a Tax District in either the job or client record, then you declare whether or not the
work order is subject to sales tax. Based on your response, theBid Amount from 9-5 Takeoffs is then inserted into the
appropriateBilling Amount cell, and the taxable status of all grid lines is set. If the takeoff is subject to sales tax, but tax
is not included, then any sales tax that is computed on 11-2 Work Orders is added to theBilling Amount resulting in an
increased Invoice Total.

To export a takeoff as a work order:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.
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3 In theBid Item drop-down list, select a bid item.

IMPORTANT: If you are exporting the entire takeoff, selecting a single bid item does not apply. Go to step 5.

4 In thePhase list, select a phase.

5 Do one of the following:

a On theExportmenu, point toService Work Order, and select Current Grid Only.

b On theExportmenu, point toService Work Order, and select Entire Takeoff.

6 Sage 100 Contractor launches 11-2 Work Orders/Invoices/Credits.

7 Continue working with the service work order in the 11-2 Work Orders/Invoices/Creditswindow.

8 In the Type drop-down list, click the drop-down arrow, and select an invoice type.

9 On the Filemenu, click Save.

IMPORTANT: Users must have security access to 11-2 Work Orders/Invoices/Credits in order to export to a
takeoff as a work order. Without rights, the export is blocked.

NOTES:
l If you have locked theBid Amount on 9-5 Takeoffs , have aGross Margin Override, or have selectedSales

Tax to be included in theBid Amount before you export, then Sage 100 Contractor locks theBilling Amount
in 11-2 Work Orders.

l The 11-2 Work Orderswindow calculates sales tax according to the rate applicable to the assigned tax
district.

l Theremay be a small variance between the bid amount in 9-5 Takeoffs and the work order total in 11-2 Work
Orders. This is due to rounding.

l When exportingCurrent Grid Only, Sage 100 Contractor only exports the grid that you have displayed.

Exporting change orders from 9-5 Takeoffs to 6-4-1 Change Orders

To export change orders:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do one of the following:

a On theExportmenu, point toChange Orders and click Job.

b On theExportmenu, point toChange Orders and click Job/Phase.

4 Select the change orders you want to export, then click Export. Sage 100 Contractor automatically selects change
orders you have not yet exported.

5 In the 6-4-1 Change Orderswindow, review and save each change order.

Exporting RFPs from 9-5 Takeoffs to 6-11-1 Requests for Proposal

To export an RFP:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do one of the following:
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a On theExportmenu, point toRequest for Proposal, and click By Job.

b On theExportmenu, point toRequest for Proposal and click By Job/Phase.

4 Accept or decline the question about continuing to export an RFP only with parts that have a vendor.

5 Accept or decline the question about including subcontractors in your RFP.

6 TheExport RFP window appears with a list of vendors and vendor amounts.

7 If necessary, you can clear any check boxes of vendors that you want to exclude from the RFP.

8 To add the requesting employee to the RFP, you can click theEmployee# drop-down arrow, and choose an employee
from the list of employees.

9 Click Export.

10 Open the 6-11-1 Requests for Proposal window. In the data control, click the Last Record button.

11 The last RFP that you just exported appears.

About Export Notes

Export notes can be created in a takeoff in theExport Notes column, located on the far right of the 9-5 Takeoffswindow
grid. You can export them to change orders, purchase orders, requests for proposals, subcontracts, and work orders. These
notes can be created for each line item in your takeoff and can communicate important job information to vendors,
subcontractors, suppliers, and clients.

When you select one of the export commands (exceptWork Orders), from theExPortmenu, an export list window opens
with the option to export theExport Notes selected. To not export theExport Notes, you simply clear the option. For
Service Work Orders exports, you are provided with a yes/no choice to export the notes or not to export.

The following table describes the range of Export Notes available in Sage 100 Contractor.

Sage 100 Contractor Exporting

ChangeOrders
By Job

By Job/Phase

PurchaseOrders

By Job

By Job/Phase

By ChangeOrder

By Task

Request for Proposal
By Job

By Job/Phase

Subcontracts
By Job

By Job/Phase

ServiceWork Orders
Current Grid Only

Entire Takeoff

There are no options to useExport Noteswhen exporting a budget, a proposal by cost code or a proposal by bid item.



- 525 -

You create export notes in theExport Notes column of 9-5 Takeoffs; however, the export notes do not appear in anExport
Notes column in other windows. For example, when exporting a purchase order that includes some export notes, those
notes appear in thePurchase Order grid in theNotes column.

In the case of change orders where there are two grids, the export notes appear in theChange Order Notes column of the
grid on theBudget and Sub Change Details tab.

In the case of work orders, which have twoNotes columns in the grid, the export notes appear in theShop Notes column
in the grid on the Invoice Details tab.

Sage 100 Contractor provides other “note” tools which you should not confuse withExport Notes. There is aNote button in
the 9-5 Takeoffwindow toolbar with the descriptive text Enter notes for the company. There is also aNote columnwith
the takeoff grid where you can enter a note for each line item in the takeoff. You cannot export these notes.

TheExport Notes column is available to all users
depending on their security clearance.

Importing Files to 9-5 Takeoffs
About importing takeoff files

Always import the file that you want to use before entering any other information because an imported file writes over
information that you have already entered in the heading and grid cells. A grid file will only write over information in the
displayed grid.

Importing takeoffs in 9-5 Takeoffs

IMPORTANT: Before importing a file from other software youmust create a compatible comma-delimited or comma-
quote-delimited file using a spreadsheet program, word processing program, or other software.

IMPORTANT: When you import a file, the file writes over any data already contained in the window.

To import a takeoff:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Select a job.

4 On the Importmenu, click Takeoff File.

5 Select the file you want to import, and click OK.

Importing takeoffs using Takeoff Launch

IMPORTANT: Before importing a file from other software youmust create a compatible comma-delimited or comma-
quote-delimited file using a spreadsheet program, word processing program, or other software.

IMPORTANT: When you import a file, the file writes over any data already contained in the window.

To import a takeoff using Takeoff Launch:

1 Open 9-5 Takeoffs.

2 The Takeoff Launch dialog box opens.

3 In the Job# text box, enter the job number for which you want to create a takeoff.

4 Click Open.
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Importing takeoff grid files

IMPORTANT: Before importing a file from other software youmust create a compatible comma delimited or comma-
quote file using a spreadsheet program, word processing program, or other software.

To import a takeoff grid file:

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 In theBid Item list, click the bid item.

4 In thePhase list, click the phase.

5 On the Importmenu, click Grid File.

6 Select the grid file that you want to import, and click OK.

NOTE: When you import a grid file, the new content inserts at the cursor and does not overwrite the existing content.

9-6 Add Parts-Update Prices

About adding parts-updating prices
The 9-6 Add Parts/Update Priceswindow provides a way for you tomanage your parts file and to build andmaintain your
parts database. Somematerials vendors supply pricing data on disks or make downloads available from the Internet, which
you can use to update prices in the parts database. Some companies supply pricing information for a subscription fee.

You can perform the following actions in 9-6 Add Parts/Update Prices:

l Add parts

l Update prices

l Update prices and add new parts simultaneously

You can create templates to save your selections for the different part/price source files that you use. By opening a specific
template, you can perform the desired action without having to reconfigure the window.

More about adding parts-updating prices
You can add parts and update prices, as needed or on a regular basis, frommany different vendors or pricing services’
databases. Suppose that you receive a disk from a local vendor that contains an electronic file with information on all the
parts they can provide to you. Before adding parts or updating prices from this parts database into your company, determine
the organization of information within the file. Carefully examine what information it contains and the order and format in
which it appears. Usually, each line in the file represents a different part. You can thenmap the incoming information to
existing fields in Sage 100 Contractor.

IMPORTANT: You should always back up your database before beginning these procedures.

l When adding parts or updating prices, youmust complete a number of selections.

l You have the option to assign part numbers to the records that you add.

l When updating prices, you can also specify whether you want to update the default cost and billing amount or the
vendor price.
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l You can choose to add new parts to your database while updating your part prices from a source file. It is important
to understand your existing Sage 100 Contractor parts structure before performing this procedure.

l Youmust select the appropriate source file.

l Source file fields must be the same alpha/numeric type as required in Sage 100 Contractor. For example, Part
Number, Cost Codes, andCost Typesmust be numeric.

l Some electronic files contain a heading as the first line (instead of actual parts data) and this information should be
ignored as it is imported. Select the option to ignore the first line.

Field Mapping and Destination Fields

Adding parts and updating prices involves field mapping. Suppose that a local vendor has supplied you with their database
of parts. In the 9-6 Add Parts/Update Priceswindow, you can browse to and select the vendor file you want to import. The
minimum amount of information that youmust enter is Part#, Description, andUnit.

The example contains the following information in theSource File Fields from the source file that you have selected: part
number, description, default price, selling price, and unit. Before you can add parts or update the prices, you use the
Destination Fields to determine what fields in Sage 100 Contractor are to be populated with the information from the
vendor’s database and where to place it in the Sage 100 Contractor parts database.

By selectingSource File Fields and using the arrows to specify theDestination Fields, you will create the desired
mapping. In some cases, the outside databasemight contain information that does not directly relate to any of the
Destination Fields. If you want to include the information, use theUser Def1 andUser Def2 (user-defined fields) as
available fields for storing related information.

NOTE: You can import several different types of files. Be sure to review the vendor’s file type before importing.

About file types for adding parts-updating prices

CAUTION: Attempting to import files of an unsupported typemay produce unpredictable results.

Several file types are supported for adding parts and updating prices on the 9-6 Add Parts/Update Priceswindow.

l Comma delimited

l Comma/quote delimited

l Tab delimited

l Excel (using one of the followingmethods)

l Excel files must be exported as a *.csv file before import into Sage 100 Contractor.

l Excel files can be imported automatically if they contain column headers and the First Line is Header option
is selected when importing the file with an *.xls extension.

l DBF (Xbase)

Saving templates for adding parts-updating prices
Rather than having to configure the Import/Update Partswindow each time you receive price updates from vendors or
pricing services, you can save different import formats and recall them for later use.

To save an import format as a template:
1 Open 9-6 Add Parts/Update Prices.
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2 Set up the template of the database that you want to import by making all your desired selections for that particular
source file.

3 On the Filemenu, click Save As Template.

4 Enter the template name, and then click OK.

Recalling templates for adding parts-updating prices
To recall a template for adding parts/updating prices:
1 Open 9-6 Add Parts/Update Prices.

2 On the Filemenu, select Open Template.

3 Enter the template name, and then click Save.

Adding parts

CAUTION: Always make a backup of your data before you add parts.

To add new parts:
1 Open 9-6 Add Parts/Update Prices.

2 Select Add New Parts.

3 If you want to automatically assign part numbers to the imported parts, select Assign Part#.

4 In theStart# text box, enter the starting number to assign to the new parts. This must be in numeric form only.

5 ChooseSelect Source File, then browse to and select the database file you want to use for adding parts.

6 The path name for the source file appears.

7 TheSource File Fields under Field Mapping appears.

8 If the source file contains descriptive headers or labels as its first line, select First Line is Header.

This line is ignored during the import function.

9 MapwhichDestination Fields from the Sage 100 Contractor database correspond to the importedSource File Fields.

IMPORTANT: At minimum, youmust select Part#, Description andUnit as Destination Fields to bemapped.

10 On the left side of the window, under Field Mapping, select theSource File Fields row and theDestination Fields
cell that you want to map.

11 UnderDestination Fields on the right side of the window, select the corresponding Sage 100 Contractor field by
double-clicking the field. Alternately, select the Sage 100 Contractor field, and then select ENTER or the arrow key to
map the field.

12 Repeat step 5 until you havemapped all Source File Fieldswith correspondingDestination Fields for the parts you
want to add to your Sage 100 Contractor parts database.

13 Click Add/Update.

14 If any failures occur during the process, an error log appears for your review.

NOTE: You can remove field mapping for a specific row by selecting theDestination Field and using the arrow key
tomove it back to theDestination Fields list.
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TIP: You can use your selections to save as a template for future use.

Updating Parts and Prices
Updating part prices

CAUTION: Always make a backup of your data before you add parts or update prices.

Consider the following points before updating part prices:

l Updating only requires aPart#.

l You can remove field mapping for a specific row by selecting theDestination Field and using the right arrow key to
move it back to theDestination Fields list.

l The part numbers from the vendor's source file must match thePart# in Sage 100 Contractor in order for the update
to properly occur.

To update part prices:

1 Open 9-6 Add Parts/Update Prices.

2 Select Update Part Prices and complete the following as necessary:

a If you want Sage 100 Contractor to match parts based on theAlpha Part#, selectMatch Alpha Part#.

b Default Cost/Billing Amount is selected by default. Sage 100 Contractor updates the default cost/billing amount for
parts in the database.

NOTE: Vendor-specific prices will not be applied to new parts but will be applied toDefault Cost/Billing Amount.

c If you want Sage 100 Contractor to update theVendor Price instead of theDefault Cost/Billing Amount of the 9-2
Partswindow, select Vendor Price.

d If you have selectedVendor Price as your updatemethod, in the drop-down list, select the vendor whose source file
you are using.

e The path name for the source file appears in the window.

3 ChooseSelect Source File, browse, and then select the database file to use for adding parts.

a TheSource File Fields under Field Mapping appears.

b If the source file contains descriptive headers or labels as its first line, select First Line is Header. This line is ignored
during the import function.

4 Map theDestination Fields from the Sage 100 Contractor database that correspond to the importedSource File
Fields.

a On the left side of the window, under Field Mapping, select theSource File Fields row and theDestination Fields
cell that you want to map.

b UnderDestination Fields on the right side of the window, select the corresponding Sage 100 Contractor field by
double-clicking the field. Alternately, select the Sage 100 Contractor field and then select ENTER or the arrow key to
map the field.

5 Repeat step 4 until you havemapped all fields you want to import to Sage 100 Contractor from the external database.

6 Click Add/Update.

7 If any failures occur during the process, an error log appears for your review.
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TIP: You can use your selections to save as a template for future use.

Important information about updating prices and adding new parts simultaneously

In the 9-6 Add Parts/Update Priceswindow, you can choose to add new parts to your database from a source file while
updating your part prices. Because youmay be doing this on a regular basis and your vendor may change their file
configuration or numbering scheme, it is important to understand your existing Sage 100 Contractor parts structure before
performing this procedure.

When performing this procedure, there are several things to be aware of:

l Any parts in the source file that are not currently in your parts database will be added to your parts database. You
cannot select specific parts or ranges of parts to add.

l When updating prices and adding parts, all Destination Fields are available for mapping, but only Description,
Unit, Default Cost andBilling Amount (if mapped) are updated. Any new parts are added.

If you have selectedVendor Price from theUpdate Part Pricesmenu, there are additional considerations:

l If you choose to update your part’s Vendor Price and to add parts at the same time, the prices on theVendor
window are updated. However, the update process is not going to attach your selected vendor to any new parts.

l In order for a new added part to have a price entered in the 9-2 Partswindow, youmust map an additional field(s)
from theSource File Fields to theDefault Cost and/orBilling Amount Destination Fields because theVendor
Price can only be updated on existingVendorwindows.

NOTE: If this is the first time you are performing this combined process or if you are unsure about what fields in your
database are affected, we recommend that you perform these processes individually.

Updating prices and adding new parts simultaneously

CAUTION: Always make a backup of your data before you update prices or add parts.

To update prices and add new parts simultaneously:

1 Open 9-6 Add Parts/Update Prices.

2 Select Add New Parts.

a If you want to automatically assign part numbers to the imported parts, select Assign Part#.

b In theStart# text box, enter the starting number to assign to the new parts. This must be in numeric form only.

3 Select Update Part Prices and complete the following as necessary:

a If you want Sage 100 Contractor to match parts based on theAlpha Part#, selectMatch Alpha Part#.

b Default Cost/Billing Amount is selected by default.

NOTE: Vendor-specific prices will not be applied to new parts but will be applied toDefault Cost/Billing
Amount.Sage 100 Contractor updates the default cost/billing amount for parts in the database.

a If you want Sage 100 Contractor to update theVendor Price instead of theDefault Cost/Billing Amount in the 9-2
Partswindow, select Vendor Price.

b If you have selectedVendor Price as your updatemethod, select from the drop-down list the vendor whose source
file you are using.

4 ChooseSelect Source File, browse, and then select the database file to use for adding parts. The path name for the
source file appears in the window.
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a TheSource File Fields under Field Mapping appears.

b If the source file contains descriptive headers or labels as its first line, select First Line is Header.

This line is ignored during the add/update function.

5 MapwhichDestination Fields from the Sage 100 Contractor database correspond to the importedSource File Fields.

a On the left side of the window, under Field Mapping, select theSource File Fields row and theDestination Fields
cell that you want to map.

b UnderDestination Fields on the right side of the window, select the corresponding Sage 100 Contractor field and
click the left arrow key. Alternately, select the Sage 100 Contractor field, and then select ENTER. Alternatively, you
can double-click the field.

IMPORTANT: At minimum, youmust select Part#, Description, andUnit as Destination Fields to bemapped.

The part numbers from the vendor's source file must match thePart# in Sage 100 Contractor in order for the update to
properly occur.

6 Repeat step 5 until you havemapped all fields you want to import to Sage 100 Contractor from the external database.

7 Click Add/Update.

8 If any failures occur during the process, an error log appears for your review.

NOTE: You can remove field mapping for a specific row by selecting theDestination Field and use the right arrow
key tomove it back to theDestination Fields list.

TIP: You can use your selections to save as a template for future use.

9-7 Maintain Parts Database

About 9-7 Maintain Parts Database
In the 9-7 Maintain Parts Databasewindow, you canmake changes to the parts database or set up the vendor preference
list for part records.

To determine the scope of an update, underSelection Criteria, select specific part numbers, part classes, a range of
parts, or the entire database. In the Field list, click the field on which you want to base the update. Then in theOperator
list, click themathematical operator such as equal to or greater than. Then in theValue text box, enter the value for which
you are searching.

Under Fields to Change, specify the information you want to change. Suppose that you add parts from a database that
uses cost codes that differ from your own. In theMaintain Parts Databasewindow, you set up the selection criteria to
choose only those cost codes that you want to change. Then in the Fields list you select Cost Code, in theOperator list
you select Replace With, and in the new Value text box you enter the cost code that you want to use. When you update
the database, Sage 100 Contractor automatically replaces the data in the cost code box from the selected part records with
the information you entered in the new Value text box.

Instead of replacing information, you can factor it. Factoring allows you to increase or decrease values. For example, your
lumber supplier has increased prices by 15 percent. You set up the selection criteria to choose only the lumber parts. Then
in the Fields list you select Default Cost, in theOperator list you select Factor by, and in the new Value text box you
enter 1.15, whichmultiplies the existing amounts by 15 percent.

You can also use theMaintain Parts Databasewindow underAssign Vendor Preferences to set up vendor preference
lists in part records, which allows you to rank the vendors in order of preferred use. Before creating a takeoff, you can elect
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to use only preferred vendors for parts. Then each time you enter an assembly or part in the takeoff, Sage 100 Contractor
uses the price for the preferred vendor.

Setting up a vendor pricing list
Use the selection criteria to select the range of parts to which you want to assign the vendor list. Enter the vendors and
assign each vendor a preference number. The vendor you assign number 1 is the preferred vendor.

To set up a vendor pricing list:
1 Open 9-7 Maintain Parts Database.

2 UnderSelection Criteria, do the following:

a In the Field list, click the field.

b In theOperator list, click the operator.

c In theValue field, enter the value.

3 Repeat step 2 until you have selected all the criteria you want to use.

4 UnderAssign Vendor Preferences, do the following:

a In thePreference# text box, enter the preference number.

b In theVendor text box, enter the vendor number.

c If there is a discount rate, in theDisc. Rate text box, enter the discount rate.

5 Repeat step 4 for each vendor you want to include.

6 Click theAdd Vendors button.

TIP: You can add to a list of existing vendors using the steps above.

Replacing an existing list of vendors for vendor pricing
To replace an existing list of vendors for vendor pricing:
1 Open 9-7 Maintain Parts Database.

2 UnderSelection Criteria, do the following:

a In the Field list, click the field.

b In theOperator list, click the operator.

c In theValue field, enter the value.

3 Repeat step 2 until you have selected all the criteria you want to use.

4 UnderAssign Vendor Preferences, do the following:

a In thePreference# text box, enter the preference number.

b In theVendor text box, enter the vendor number.

c If there is a discount rate, in theDisc. Rate text box, enter the discount rate.

5 Repeat step 4 for each vendor you want to include.

6 Click theReplace Vendor Prices button.
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Updating vendor pricing

IMPORTANT: In order to update vendor pricing, youmust verify information in the 9-2 Partswindow. Theremust be
a value inDefault Cost underCost/Billing. In addition, youmust verify values in theVendorswindow (via 9-2 Parts)
in these columns: Preference#, Vendor, Order#, Disc. Rate, andPrice.

To update vendor pricing:
1 Open 9-7 Maintain Parts Database.

2 UnderSelection Criteria, do the following:

a In the Field list, select the field.

b In theOperator list, select the operator.

c In theValue field, enter the value.

3 Click theUpdate Vendor Prices button.

Maintaining the parts database
To maintain the parts database:
1 Open 9-7 Maintain Parts Database.

2 UnderSelection Criteria, do the following:

a In the Field list, click the field that you want to update.

b In theOperator list, click the operator.

c In theValue text box, enter the value for which you are searching.

3 Repeat step 2 until you have selected all the criteria you want to use.

4 Under Fields to Change, do the following:

a In the Field list, click the field that you want to update.

b In the Type list, click how you want to update the data.

c In theValue text box, enter the value that you want to apply.

5 Repeat step 4 for each field you want to change.

6 Click theUpdate button.

Deleting ranges of parts

CAUTION: To avoid a possible loss of data, always make a backup file before using the 9-7 Maintain Parts
Databasewindow.

To delete a range of parts:
1 Open 9-7 Maintain Parts Database.

2 UnderSelection Criteria, do the following:

a In the Field list, select the field.

b In theOperator list, select the operator.

c In theValue text box, enter the value for which you are searching.
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3 Repeat step 2 until you have selected all the criteria you want to use.

4 Click theDelete button.

9-8 Board Footage

About board footage
You can update lumber costs for selected part classes in the 9-8 Board Footagewindow. To createmanageable pricing
blocks for lumber, use the part classes to segregate lumber by species, grade, and length. This provides the ability to select
part classes for lumber and update the new costs or billing rates per 1000 board feet. Sage 100 Contractor computes the
new prices for the cut materials and updates the part records accordingly.

Entering new cost and billing amounts for lumber classes
Consider the following points:

l Sage 100 Contractor updates the new costs in the Last Cost box, and the new billing prices in theBilling Amount
box in the part records.

l When you leave theCost orBilling cells blank, Sage 100 Contractor does not change the current prices. This
allows you tomake changes only to costs or billing amounts for different lumber classes.

l Use the 9-7 Maintain Parts Databasewindow tomake changes to lumber parts based on selection criteria other
than part classes.

To enter new cost and billing amounts for lumber classes:
1 Open 9-8 Board Footage.

2 In thePart Class column, right-click a cell, then click Display Picklist Window.

3 Alternatively, you can click the drop-down arrow to display the Lookupwindow.

4 Create aPicklist of part classes, and insert the list in theBoard Footagewindow.

5 In theCost/1000Bf column, enter the new cost per 1000 board feet.

6 In theBilling/1000Bf column, enter the new billing amount per 1000 board feet.

7 Click theUpdate button.

8 On the Filemenu, click Save.

9 Sage 100 Contractor saves the part classes for use in the next update session.
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Chapter 10: Scheduling
Working with Scheduling
You can run your schedules and allocate production resources as efficiently as you’d like. The easy-to-use critical path
management (CPM) feature integrates with theEstimating Add-onModule and other data, enabling you to assign
equipment, employees, vendors, and subcontractor to various tasks. You can then generate essential notices and reports.

Sage 100 Contractor has the ability to automatically generate subcontractor and supplier notices that inform them when to
perform work andmake deliveries, as well as call sheets with phone numbers, dates, schedules, and work descriptions to
help youmanage every job.

Sage 100 Contractor can automatically email or fax schedules and project documents to your subcontractors and
customers at set dates and times that you select.

You canmove tasks or extend them as necessary with a few mouse clicks, set task-specific exception days, and create
predecessor relationships. You can control float and avoid liquidated damages by comparing the original timetable to actual
production. Sage 100 Contractor’s scheduling system can document every change as well as indicate when tasks are
running too long. You can even produce cash requirement reports that pull from the estimate the dollar amounts for each
task, merge it with the schedule, and tell you how much cash you will need for the project by the day, week, or month.

Here aremore features found in Sage 100 ContractorScheduling:

l View a graphic display (Gantt chart) of every task.

l Manage tasks across multiple projects by viewing a schedule of all jobs.

l Set milestones, billing, andmaterials orders for any task.

l Produce call lists and subcontractor notices.

l Adjust the schedule andGantt chart to reflect change orders.

l Keep project information handy in a central location with theProject Work Center.

10-1 Scheduling Reports
See Appendix B for a complete list of 10-1 Scheduling Reports.

10-2 Tasks

About Tasks
In the 10-2 Taskswindow, you can create amaster list of tasks. When creating a task list, it is important to tailor the tasks
to the type of work your company performs and the level of detail necessary to effectively schedule projects.

In general, create tasks for every event that requires at least one day of work. To help create the task list, review the
previous schedules of typical projects completed by your company. As you enter tasks, arrange the tasks in the order they
are performed. For example, the tasks Rough Plumbing andRough Electrical come before the task Pour Concrete
Slab.
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As you enter tasks, assign each task a task number. The sequence of task numbers should reflect the order in which tasks
are performed. To allow for expansion of the task list, provide breaks in the sequence of task numbers as you create the
list.

Task lists can vary in length and complexity. A general contractor, for example, might require more than 100 tasks whereas
a subcontractor might require only 15 tasks. When creating the task list, consider the following:

Create tasks based on the type of work, not the person performing the work. You can assign resources to specific tasks
after the client has approved the schedule.

Separate tasks. Somework is performed in stages and should be scheduled as different tasks. With separate tasks, you
can also gain better control over resource allocation.

For example, a drywall subcontractor creates the tasks Stock Drywall, Hang Drywall, and Tape and Texture Drywall.
Separate tasks allow the subcontractor to schedule resources needed for each task.

Combine tasks. Sometimes you can group a series of related tasks into a single task. Before combining tasks, consider
what impact this will have on scheduling dependent tasks and resource allocation.

Suppose a general contractor is creating a task list for residential home construction. Because the drywall is always
contracted out, the contractor creates two tasks: Stock Drywall andHang/Tape/Texture Drywall. While the
subcontractor has to schedule a variety of resources for the individual tasks, the contractor is only concerned with
scheduling the subcontractor as a resource. Therefore, the general contractor can use a single task to schedule the
hanging, taping, and texturing for drywall.

Create separate tasks for milestones, inspections, billings, or other important events.

Setting up task types
Each task uses the assigned color when you view theGantt chart. You can add task types andmodify existing types.

To set up task types:
1 Open 10-2 Tasks.

2 Right-click a Task Type cell, and then select Display Detail/Add Record.

3 In the Task Typeswindow, in the Task Type# cell, enter the number for the task type.

4 In theDescription cell, enter a brief statement about the task type.

5 Double-click the Task Color cell.

6 Double-click the color you want to use.

7 Repeat steps 3–6 for each task type.

8 On the Filemenu, click Save.

Setting up task lists
You can create your own task types, or modify the existing types.

To set up a task list:
1 Open 10-2 Tasks.

2 In the Task# cell, enter the number you want to assign to the task. You can enter up to 10 digits to the left of the decimal
place and three digits to the right.

3 In theDescription cell, enter a brief statement about the task.
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4 In the Task Type cell, enter the task number you want to assign to the task.

5 Repeat steps 2–4 for each task.

6 On the Filemenu, click Save.

About dependencies in scheduling
A dependency links one task to another task. You can set up predecessors between tasks in a single job, or between
different jobs

Relationship Description

1-Start/Finish
The start of task B relies on the completion of
predecessor task A.

Most tasks use the start/finish dependency.

2-Start/Start The start of task B relies on the start of
predecessor task A.

3-Finish/Start The finish of task B relies on the start of
predecessor task A.

4-
Finish/Finish

The finish of task B relies on the finish of
predecessor task A.

About lead and lag time in scheduling
With each dependency, you can assign lead time or lag time. Lead or lag allows you to further adjust the starting date of a
task in relation to its predecessor.

Lag time

Lag provides a delay between tasks. For example, in thePredecessorwindow for the task Stripping Forms, you assign
the task Pouring the Foundation as its predecessor. Because you cannot strip the forms until the concrete is poured,
click 1-Start/Finish in theRelation list. However, the forms cannot be removed until the concrete has cured, so enter 3 in
the Lead/Lag text box. When looking at the schedule, theStripping Forms task cannot start until three days after the
completion of Pouring the Foundation. Therefore, you enter lag as a positive value.

Lead time

Lead provides an overlap between tasks. For example, in thePredecessorwindow for the task Electrical, you assign the
task Roofing as its predecessor and enter 1-Start/Finish in theRelation column. An electrician can begin wiring the
building a couple of days before the roofing task is completed since the structure is now partially covered by roofing. In the
Lag/Lead column, enter -2. When looking at the schedule, theElectrical task can begin two days before the finish of the
Roofing task. Therefore, you enter lead as a negative value.

Entering dependencies for tasks
If a task has a predecessor in another job, Sage 100 Contractor displays the names of the predecessor job and task when
you select thePredecessor check box while in Gantt view. Click the detail button next to that information to display the
predecessor job.

To enter a dependency for a task:
1 Open 10-3 Schedules.

2 Select the task for which you want to set up predecessors.
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3 On theOptionsmenu, click Predecessors.

4 In the Job cell, enter the job number.

5 In thePhase cell, enter the phase number.

6 In thePredecessors cell, enter the task number of the task you want to set as the predecessor.

7 In theRelation cell, enter the type number for the relationship the task has with its predecessor.

8 In the Lead/Lag cell, do one of the following:

a For lead, enter the number of days you want the task to overlap its preceding task as a negative number.

b For lag, enter the number of days you want to delay the task as a positive number.

9 On the Filemenu, click Save.

Drawing dependencies between tasks
To draw dependencies between tasks:
1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule and click theGrid/Gantt button.

3 On theModemenu, click Draw Predecessors.

4 Click the start or finish of a task and drag to the start or finish of another task.

Connect a task to a predecessor, moving from the bot-
tom to the top of the Gantt chart.
You can assign task dependencies between jobs.

About date constraints
In addition to using dependencies, durations, and lag or lead times, you can further constrain when a task begins or ends. In
the schedule grid, you can enter dates for a task that restrict when it may begin or end.

Column Description

Fixed Date

Establishes a permanent date when a task must begin. A
fixed date does not move when a schedule is delayed or
accelerated.

Most tasks do not use a fixed date, and begin or end in
relation to the predecessors tasks.

Not Before

Establishes the earliest date when a task can begin.
Though a task cannot begin before the indicated date, the
task can begin after the date.

If you provide a date in theNot Before column for a critical
task, Sage 100 Contractor adjusts the start and finish
dates for subsequent tasks.



- 539 -

Column Description

Not After

Establishes the latest date when a task can begin.

If you provide a date in theNot After column for a critical
task, Sage 100 Contractor adjusts the start and finish
dates for subsequent tasks.

Late Start Displays the last day a non-critical task can begin and
remain on schedule.

Late Finish Displays the last day a non-critical task can end and
remain on schedule. Only for tasks with float.

10-3 Schedules

About 10-3 Schedules
With 10-3 Schedules, you can create a schedule to plan andmanage a project, regardless of its size. A schedule allows
you to budget time, plan when some tasks begin in relation to other tasks, set milestones, set up tasks for billings or
inspections, and identify scheduling conflicts between resources. Moreover, you can analyze the accuracy of time
estimates, track the progress of jobs, and adjust tasks or resources to keep projects on schedule.

Each schedule is composed of tasks to accomplish over the course of a project. For each task, you can indicate its
duration, predecessor dependency, and any constraints. Sage 100 Contractor then uses the task information and the
project start date to determine the start and finish dates for each task and the project’s finish date.

In Gantt view, you can use themouse tomove tasks, draw predecessor dependencies, or change the duration of tasks.
Changing the duration of a single task in the critical path directly affects the starting times of other tasks and can increase
or decrease the overall length of the project.

Resource allocation to individual tasks provides you with another tool for planning andmanaging a project. After the client
approves the schedule, you can allocate the equipment, subcontractors, and employee resources. For example, after
scheduling resources for a project, you can compare the resource reports between different projects to determine if any
scheduling conflicts exist.

Over the course of the project, you can enter the progress of work by changing the duration of tasks. In Gantt view, you can
review the project, see the effects of gains or delays, and determine the best course of action to keep your project on
schedule.

Tips for managing a project schedule
It is a good idea to review the schedule each day. The duration of a task can change due to a variety of circumstances such
as weather, materials supplier delays, subcontractor delays, or manpower shortages. As delays occur, extend the duration
of the affected tasks. Likewise, for tasks completed ahead of scheduled, shorten the duration for affected tasks.

When you change the duration for a task, enter a note explaining why the change was necessary. The notes can provide
vital information later if questions or disputes about the schedule arise.

Twice a week, determine which tasks will be performed over the next two weeks. Call the subcontractors andmaterials
suppliers associated with the tasks that are two weeks out to remind them when they are expected to arrive. If the start
dates have changed, inform the affected subcontractors andmaterials suppliers of the changes.

Each week, print andmail update notices to the subcontractors andmaterials suppliers who are expected on the job site in
two weeks.
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It is good idea tomeet with the clients twice amonth to discuss the project’s actual progress and how it compares to the
schedule. At themeetings, supply the clients with a copy of the revised schedule. The schedule will help clients to see their
responsibilities (such as when client decisions need to bemade), avoid potential conflicts, and prevent last-minute
problems.

Creating starter schedules from takeoffs
If you have a detailed takeoff created for a job, you can create a starter schedule from the takeoff. The following data
populates the starter:

l Task

l Task description

l Task type (Each task is assigned 1-Work.)

l Duration (Each task has a beginning duration of 1.)

l Vendor

l Start and finish relationship

Also, consider the following important points before creating a start schedule from a takeoff:

l Youmust have detail lines in your takeoff for the selected job in order for the starter schedule to populate.

l Not all scheduled tasks exist in a takeoff. Some tasks that are not associated with parts need to bemanually added
to the schedule (for example, inspections). After the starter schedule has been created, review the schedule tomake
any necessary adjustments.

l Before you create the schedule, be sure that the takeoff contains tasks associated with each part. To check, from 9-
5 Takeoffs, click the Takeoff Details—Recaps tab, and then at the bottom of the window, click the Task button.
Review each task.

To create a starter schedule from a takeoff:
1 Open 10-3 Schedules.

2 In the data control box, enter the job number for the job you want to schedule.

3 In thePhase list, click the phase you want to schedule.

4 In theOptionsmenu, point to Import, then click Takeoff Tasks.

5 The data populates the schedule. For each task, the duration can be adjusted from the default duration of 1 to reflect the
estimated duration of the task.

Displaying takeoff hours by job or job phase
This functionality is available only if you have the EstimatingModule.

You can view a summary of the labor hours for each task in a job or in different phases of a job. The estimated hours to
complete each task with cost type 2-Labor are summed up in theDisplay Takeoff Hours grid or theDisplay Takeoff
Hours by Phase grid. From the estimates, you can calculate the necessary crew sizes for completing a task in a given
period and adjust the schedule accordingly.

For example, for a project in which it is estimated to take 100 worker hours to complete the foundation forming and
reinforcement, a crew of five would complete the task in 20 hours; however, a crew of 10 could complete the work in 10
hours.

http://www.na.sage.com/sage-100-contractor/modules/estimating
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To display takeoff hours by job or job phase:
1 Open 10-3 Schedules.

2 On theOptionsmenu, click Takeoff Hours, then click eitherDisplay Takeoff Hours orDisplay Takeoff Hours by
Phase.

Creating schedules
To create a schedule:
1 Open 10-3 Schedules.

2 In the data control text box, enter the job number for the job you want to schedule.

3 In thePhase list, click the phase.

4 Do one of the following:

a Import a file.

b Import a list of tasks.

5 In the Fixed Date cell of the first task, enter the starting date of the project.

6 For each task, do the following:

a In theDuration cell, enter the duration of the task.

b In the Task Type list, click the task type.

c Enter the constraints, if any, in theNot Before, Not After, or Fixed Date cells.

d Assign the dependencies.

7 Repeat steps 3–5 for each phase.

8 On the Filemenu, click Save.

9 Print the schedule.

10 Review and refine the schedule.

11 Print the schedule and submit it as part of the proposal package.

12 When you receive a signed contract, do the following for each task:

a Assign employee resources.

b Assign equipment resources.

c Assign subcontractor resources.

13 Set the original schedule.

14 On the Filemenu, click Save.

Display-only text boxes

Four display-only text boxes provide scheduling information after you have completed creating a schedule and will
automatically be updated as youmake changes to the schedule:

l First Date: Reflects the Fixed Date in the schedule.

l Last Date: Reflects the Finish Date, which is the last date of the last phase in the schedule.
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l Calendar Days: The number of calendar days between the First Date and the Last Date.

l Work Days: The number ofWork Days between the First Date and the Last Date.

TIP: You can turn on an option to open a job’s schedule when the purchase order scheduled date changes.

About scheduling resources to avoid conflicts
By scheduling resources, you can locate scheduling conflicts between resource assignments. You can assign employees,
equipment, and subcontractors to the tasks in each phase of a project.

Resource scheduling does not automatically warn you of potential conflicts. With the resource information, you can
produce schedules of the resources from 10-1-5 Resource Reports. From the resource reports, you can compare
resources between jobs and determine if any conflicts exist.

You can also produce call sheets and reminder notices for subcontractors using the subcontract resource information.
Select 10-1-4 Subcontractor Call Sheet and 10-1-1 Subcontract Notice.

Assigning employee resources
To assign employee resources:
1 Open 10-3 Schedules. In the data control box, enter the job number.

2 In thePhase list, click the phase.

3 In the Task# column, select the task(s) to which you want to assign employees.

4 On theOptionsmenu, click Employees.

5 In theEmployee cell, do one of the following:

a Enter the employee number.

b Right-click the cell to open the Lookupwindow, then select the employee.

6 In theStart Time cell, enter the time you expect the employee to begin.

7 In theEnd Time cell, enter the time you expect the employee to finish.

8 Repeat steps 5–7 for each employee you want to assign to the task.

9 On the Filemenu, click Save.

Assigning equipment resources
To assign equipment resources:
1 Open 10-3 Schedules. In the data control box, enter the job number.

2 In thePhase list, click the phase.

3 In the Task# column, select the task(s) to which you want to assign equipment.

4 On theOptionsmenu, click Equipment.

5 In theEquipment cell, do one of the following:

a Enter the equipment number.

b Right-click the cell to open the Lookupwindow, then select the equipment.

6 In theStart Time cell, enter the time you expect the equipment to begin.
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7 In theEnd Time cell, enter the time you expect the equipment to finish.

8 Repeat steps 5–7 for each piece of equipment you want to assign to the task.

9 On the Filemenu, click Save.

Assigning subcontractor resources
To assign subcontractor resources:
1 Open 10-3 Schedules. In the data control box, enter the job number.

2 In thePhase list, click the phase.

3 In the Task# column, select the task(s) to which you want to assign equipment.

4 On theOptionsmenu, click Subcontractors.

5 For each subcontractor, do the following:

a Click a cell in theSubcontractor column, or press F5 or F8 to open a Lookup orPicklistwindow.

b Select a subcontractor.

c In theStart Time cell, enter the time you expect the subcontractor to begin.

d In theEnd Time cell, enter the time you expect the subcontractor to finish.

6 On the Filemenu, click Save.

Schedule Views
About Gantt view

TheGantt view provides a visual representation of tasks, such as bar graphics, and shows each task’s duration (including
non-workdays), start and finish dates, and dependencies. The taskbars show the flow of a project across its timeline. You
can resize the Gantt view to display as much or as little of the grid as you want.

After you have created the list of tasks and task durations, you can build a schedule. In the Gantt view, you canmove or
resize tasks and create dependencies between tasks. After adjusting a taskbar, Sage 100 Contractor automatically enters
the changes for you in the grid columns, although you can also edit the grid while in Gantt view. In Gantt view, you can also
display a brief summary of task dates and predecessors for a selected task.

Printing Gantt views

Printing Gantt charts works differently than other report printing. For example, youmust select a form design with either
portrait or landscape orientation. Paper size and the size of the detail section do not matter because the program takes the
selected form design elements and resizes them to fit the selected printer page size.

IMPORTANT: If you are going to use any paper size other than Letter, youmust use thePrint records button on the
toolbar. If you are exporting to PDF or sending the report toWord, you cannot use the toolbar buttons. You have to
manually select the PDF or RTF printer. not use theCreate a PDF file of this report button.

To print a Gantt view:

1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule and click theGrid/Gantt button.

3 When the grid pane appears with half of it displayed as aGantt chart, it verifies the job and schedule.

4 Open 10-1-5 Report Printing.

5 The window opens with 21-Gantt Chart selected on theReport Criteria tab.



- 544 -

6 On the Job# line, in the cell to the right of theCriteria drop-down list, enter the job number.

7 For example, the line could look like this: Job#, Equal, 3-Parking Garage Job.

8 For a quick test, click thePrint preview and Drilldown (when available) button.

9 Beneath theDrive drop-down box, select the printer from the drop-down list.

10 Select the paper size, tray, and quality (dpi) settings.

11 The range of these options depends on your printer’s capabilities.

12 To print specific pages, enter their numbers in the text boxes next toPages.

13 Select how many copies you want by clicking on the up and down arrows next toCopies.

14 To preview the document, click the preview button.

15 On the far-right of the toolbar, click thePrint records button.

Moving tasks

To move a task:

1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule and click theGrid/Gantt button.

3 In theModemenu, selectMove Tasks.

4 Drag the task to the desired position.

Resizing tasks in scheduling

To resize a task:

1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule and click theGrid/Gantt button.

3 In theModemenu, select Resize Tasks.

4 Drag the right end of the task to the desired position.

Viewing task summaries

In Gantt view, you can display a summary of information related to a particular task.

To view a task summary:

1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule and click theGrid/Gantt button.

3 Position the pointer over a task, then right-click.

Viewing the critical path in schedules

You can view the path of all the critical tasks in your schedule.

To view the critical path in a schedule:

1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule.

3 On theOptionsmenu, select Grid/Gantt Chart.
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4 The window appears with a Gantt chart in the right-hand pane.

5 From the check boxes above the chart, select Critical Path.

6 The non-critical tasks appear shaded light gray in the chart.

Importing tasks

You can import tasks into your schedules from the 10-2 Taskswindow.

To import tasks into a schedule:

1 Open 10-3 Schedules.

2 In the Task# column, right-click a cell, and then select the importationmethod.

3 Alternatively, you can click the drop-down arrow to display the Lookupwindow.

4 Double-click the tasks you want to import into the schedule.

5 If you are in aPicklistwindow, double-click all the items you want to import, and then click the check mark button.

Automatically assigning the start-finish dependency

When theStart/Finish command is selected, you can automatically assign the start/finish dependency to tasks as you
import them.

To automatically assign the start/finish dependency:

1 Open 10-3 Schedules.

2 On theOptionsmenu, click Start/Finish.

3 Import tasks into your schedule.

TIP: If you do not want to automatically assign the start/finish dependency, click Start/Finish on theDefaultsmenu
to clear the check mark.

Importing scheduling files

When you import a file, the file writes over any data already contained in the grid.

To import a scheduling file:

1 Open 10-3 Schedules.

2 In the data control box, enter the job number.

3 In thePhase list, select the phase.

4 On theOptionsmenu, point to Import, then click Schedule File.

5 Select the file that you want to import.

6 Click OK.

Setting the original schedule

During the life of projects, schedules will change. Maybe bad weather and unshippedmaterials have delayed one project.
Another project is ahead of schedule because certain tasks were completed faster than expected. In both projects,
changes to the duration of critical tasks could seriously impact other scheduled tasks or the completion date.

When you set the original schedule, Sage 100 Contractor copies the original duration, start date, finish date, and float data
to theOriginal Duration, Original Start, Original Finish, andOriginal Float columns. By comparing the original
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schedule with the current schedule, you can determine what impact the changes are having on the project andmake any
necessary adjustments.

To set the original schedule:

1 Create the project schedule.

2 On theOptionsmenu, click Original Schedule.

TIP: If youmade an error in the original schedule, you canmodify the current schedule and reset the original.

Examining schedules

After creating a schedule, carefully re-examine the task list, task durations, and task dependencies. It is best to discover
and resolve any omissions, errors, or conflicts before you submit the schedule to a client or begin work. On a daily basis,
review the schedule and adjust it to reflect the actual progress of the project.

In general, review how time is budgeted for tasks. If the client has approved the schedule and you have assigned
resources, review the resource assignments as well.

l Identify the critical path.

l Determine the project finish date. Tomeet a specific finish date, youmight need to accelerate the schedule.

l Determine if any tasks aremissing.

l Determine if any tasks are out of order.

l Make sure that tasks are assigned dependencies. Check the dependency of tasks that start on the first day or
continue to the end of the project.

l Remove fixed dates. For most tasks, the start date is determined by the dependency assigned to its predecessor
task, not a fixed date.

l Examine the resource allocation for each task. Have you assigned resources to each task? Are adequate resources
allocated to complete the task on time?

Accelerating schedules

Occasionally it is necessary to accelerate schedules. Depending on the project, onemethod to accelerate a schedulemight
provemore effective than another. It is up to you to determine themost appropriate method.

Consider the followingmethods:

l Shorten the duration of tasks on the critical path. You could add employees and equipment. You could also create
additional workdays.

l Overlap tasks. Overlapping tasks allows for simultaneous work between various tasks.

l Break apart tasks. Dividing large tasks into smaller tasks might allow for simultaneous work between tasks.

l Change the dependency between predecessor tasks. Changing the dependency can allow tasks to begin sooner.

l Add lead to predecessor tasks.

Scheduling and the company calendar

Sage 100 Contractor uses the company calendar as the basis for the project schedule. When you first calculate a schedule,
Sage 100 Contractor retrieves the holidays and non-workdays from the company calendar, adds them to the schedule, and
adjusts the duration of affected tasks.



- 547 -

After the first calculation of the schedule, subsequent changes to the company calendar do not affect the start or finish
dates of tasks in a schedule. Enter any changes such as additional work or non-workdays in the project schedulemanually.

Changing workdays and non-workdays

While in Gantt view, you can switch workdays to non-workdays (or vice versa) for a single task or all tasks across a
specific date. When you select a day within a task, Sage 100 Contractor switches that day within the task to the opposite
status. When you select an entire day, Sage 100 Contractor switches the status of all tasks within that date.

Suppose that you are building the foundation forms for a home and the forms will not be completed until Monday. However,
rain is forecast next Tuesday. To avoid penalties for any potential delays further along in the project, you decide to
accelerate the schedule to finish building the forms and pour the concrete by Saturday. When the rain comes Tuesday,
carpenters can begin the rough framing.

In the schedule, you click the Saturday between the two tasks to change the Saturday status for the tasks Form &
Reinforcing andPour Foundation from non-workday to workday. Alternately, you can change the status of an entire day
by clicking it. In the example, if you change the Saturday from a non-workday to a workday, the status of each task is
changed.

To change workday status:

1 Open 10-3 Schedules.

2 Using the data control, select an existing schedule and click theGrid/Gantt button.

3 On theModemenu, clickWorkday/Non-Workday.

4 To change the status of a day within a task, click the day on the taskbar.

5 To change an entire day, click the day at the top of the Gantt view.

NOTE: When you change the status of a workday or non-workday within a task, that status remains fixed to the day.
As you adjust a schedule to reflect the daily changes, tasks may completely move away from an exception day, and
the exception will no longer affect the task. However, the colored exception day continues to display in the Gantt view
so that if the task moves back, the exception day still applies.

Recalculating the schedule with the company calendar

When you select theAdd off days from company calendar check box, Sage 100 Contractor reviews the company
calendar and updates the schedule when you recalculate.

To recalculate the schedule with the company calendar:

1 Open 10-3 Schedules.

2 Select a schedule.

3 Select theAdd off days from company calendar check box.

About displaying schedule recaps

You can display a summary of scheduled jobs by job status 1-Bid, 3-Contract, or 4-Current. The summary provides a
Gantt view, allowing you to view the start and finish of jobs in relation to each other.

Displaying schedule recaps

To display a recap:

1 Open 10-3 Schedules.

2 On theOptionsmenu, select Recap.
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3 UnderView jobs with the following status, select or clear any of following check boxes:

n 1-Bid

n 3-Contract

n 4-Current

4 From the optionsWeek,Month, Quarter, orYear, select the period you want to view.

Exporting scheduling grid files

IMPORTANT: Scheduling files cannot contain job numbers or phases.

IMPORTANT: Files are specific to the company in which you save them.

To export a scheduling grid file:

1 Open 10-3 Schedules.

2 To create a file from a phase in an existing schedule, do the following:

a In the data control box, enter the job number.

b In thePhase list, click the phase.

c Edit the content of the phase.

TIP: Instead of using a schedule from an existing job, you can create a new schedule.

3 On theOptionsmenu, point toExport 10-3, then click Grid File.

4 Name the file, then click OK.

Deleting schedules

The notes in a schedule about project delays can prove useful if disputes arise. It is a good idea to retain a job’s schedule
with the other job records. When the books are closed for the fiscal year, job records assigned status 6-Closed, and the
associated records, including the schedule, are deleted.

To delete a schedule:

1 Open 10-3 Schedules.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Schedule.

4 UnderRemoval Method, select what you want to delete.

5 Click OK.



- 549 -

Chapter 11: Service Receivables
Working with Service Receivables
This feature is available only if you have purchased the Service Receivables Add-OnModule.

The Sage 100 ContractorService Receivables add-onmodule handles service contracts, service routes, service
dispatch, on-call work orders, quotes, and point-of-sale and billing-of-service work materials. BecauseService
Receivables fully integrates with the Inventory add-onmodule, you can keep inventory up-to-date based on service work
completed.

UsingService Receivables, you can review information about equipment installed at multiple client sites and track how
the equipment is used. You can use service truck inventory to assign parts to trucks or warehouses. In addition, you can
turn your estimates into service work orders.

Here aremore features found in Sage 100 ContractorService Receivables:

l Estimates can be turned into single or multiple work orders.

l Billing can be done during or at the end of a job.

l Payroll hours can be imported from service work orders to payroll.

l Service dispatch can be displayed in 15-minute, hourly, or daily increments.

l Work orders can be displayed with user-defined color codes showing client, priority, and ZIP code.

11-1 Service Reports
See Appendix B for a complete list of 11-1 Service Reports.

11-2 Work Orders, Invoices, & Credits
The 11-2 Work Orders/Invoices/Creditswindow lets you enter transactions that affect service receivable accounts. You
can create quotes, work orders, invoices, credits, and service routes and contracts. You can also view many different
summaries such as service contracts for clients, client equipment, equipment by location, quotes, work orders, and open
invoices.

As you create records, you can schedule the service call and provide the location of the work and the parts and assemblies
necessary to complete the work. When performing service work for insurance recovery, you can also supply the necessary
policy details.

You can enter taxable and non-taxable items at the same time. When you enter a tax district number in the Tax District text
box, you can select the items to tax in theSales Tax column. If you leave the Tax District text box blank, Sage 100
Contractor assumes each item is non-taxable.

In addition, on the Invoice Details tab, you can control the billing amount using the text boxes underMarkups and
Overrides.

http://www.na.sage.com/sage-100-contractor/modules/service-management
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About 11-2 Work Orders-Invoices-Credits
The 11-2 Work Orders/Invoices/Creditswindow lets you enter transactions that affect service receivable accounts. You
can create quotes, work orders, invoices, credits, and service routes and contracts. You can also view many different
summaries such as service contracts for clients, client equipment, equipment by location, quotes, work orders, and open
invoices.

As you create records, you can schedule the service call and provide the location of the work and the parts and assemblies
necessary to complete the work. When performing service work for insurance recovery, you can also supply the necessary
policy details.

You can enter taxable and non-taxable items at the same time. When you enter a tax district number in the Tax District text
box, you can select the items to tax in theSales Tax column. If you leave the Tax District text box blank, Sage 100
Contractor assumes each item is non-taxable.

In addition, on the Invoice Details tab, you can control the billing amount using the text boxes underMarkups and
Overrides.

Use theRemove Paid/Void/Completed Records option to service invoices that meet the following criteria:

n The status is Paid, Completed, orVoid.

n The service invoice and associated payments has been posted prior to the current year.

About setting up service jobs
For service jobs, you need to include a job number on each record. When you post a direct expense, Sage 100 Contractor
creates a cost record using the job number.

It is not necessary to create a job for each quote, work order, or invoice. Instead, create a dummy job that is assigned to all
service records.

For companies with up to 2,000 completed work orders a year, create a single dummy job. After several years, remove the
dummy job when closing the books for the fiscal year. Then create a new dummy job.

Tomake the dummy job identifiable, give it a name such as Service Work.

For companies with up to 10,000 completed work orders a year, create a new dummy job each fiscal year. After keeping a
dummy job for two years, remove the dummy job when closing the books for the fiscal year.

Tomake the dummy job identifiable, give it a name that includes the year. For example, Service 2001, Service 2002,
Service 2003, and so on.

For companies with over 10,000 completed, work orders a year, create a new dummy job each fiscal quarter.

Tomake the dummy job identifiable, give it a name that includes the year and fiscal quarter. For example, Service 2002Q1,
Service 2002Q2, Service 2002Q3, and so on.

There is no correlation between the job number and work order number. You can run job cost reports for a specific work
order.

About entering service receivable items at initial setup
Post the service receivable items against the same clearing account used earlier to enter the service receivable balances.
The process transfers the balances into theService Receivables ledger account.

When entering the receivable items, post the records to the appropriate posting periods. Post any open items from the prior
year to period 0.
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It is not necessary to enter the individual parts as line items in the grid. A single line containing a description, quantity, price,
and ledger account number is all that is necessary.

About setting up service jobs
For service jobs, you need to include a job number on each record. When you post a direct expense, Sage 100 Contractor
creates a cost record using the job number.

It is not necessary to create a job for each quote, work order, or invoice. Instead, create a dummy job that is assigned to all
service records.

For companies with up to 2,000 completed work orders a year, create a single dummy job. After several years, remove the
dummy job when closing the books for the fiscal year. Then create a new dummy job.

Tomake the dummy job identifiable, give it a name such as ServiceWork.

For companies with up to 10,000 completed work orders a year, create a new dummy job each fiscal year. After keeping a
dummy job for two years, remove the dummy job when closing the books for the fiscal year.

Tomake the dummy job identifiable, give it a name that includes the year. For example, Service 2001,Service 2002,Service
2003, and so on.

For companies with over 10,000 completed, work orders a year, create a new dummy job each fiscal quarter.

Tomake the dummy job identifiable, give it a name that includes the year and fiscal quarter. For example, Service 2002Q1,
Service 2002Q2, Service 2002Q3, and so on.

There is no correlation between the job number and work order number. You can run job cost reports for a specific work
order.

Service Receivables Startup

Methods for entering historical service receivable records
When entering service receivable invoices and credits, you can choose from threemethods of entry. Each successive
method provides more detail for reports than the previous method, and requires more time to enter data.

Regardless of whichmethod you select, youmust post the transaction to the period before the current posting period. For
example, if you are setting up during period 7, post the records to period 6.
Method 1

For each client, enter a single and separate record for the total outstanding balance. While this method is the quickest, it
has numerous limitations:

l The statements do not list the invoices.

l The agings do not reflect the invoices entered during startup because the balance is entered as a single amount.

l The detail for prime contract audits is limited.

Method 2

For each client, enter a record for the outstanding balance of each unpaid or partially paid item. When entering a partially
paid invoice, make two separate entries. When usingmethod 2, you will be entering a significant amount of information with
each item.
Method 3

For each client, enter a record for each receivable invoice or credit. Not only are you entering the outstanding balances for
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unpaid and partially paid items, but you are also entering fully paid invoices and credits. When entering a partially paid
invoice, make two separate entries. Then assign paid records status 4-Paid, and assign open records status 1-Open.

Enter all items in chronological order so that statement and contract audits display the invoices in sequence.

Entering service receivable items at initial setup
Post the service receivable items against the same clearing account used earlier to enter the service receivable balances.
The process transfers the balances into theService Receivables ledger account.

When entering the receivable items, post the records to the appropriate posting periods. Post any open items from the prior
year to period 0.

It is not necessary to enter the individual parts as line items in the grid. A single line containing a description, quantity, price,
and ledger account number is all that is necessary.

Methods for entering historical service receivable records

When entering service receivable invoices and credits, you can choose from threemethods of entry. Each successive
method provides more detail for reports than the previous method, and requires more time to enter data.

Regardless of whichmethod you select, youmust post the transaction to the period before the current posting period. For
example, if you are setting up during period 7, post the records to period 6.

Method 1

For each client, enter a single and separate record for the total outstanding balance. While this method is the quickest, it
has numerous limitations:

l The statements do not list the invoices.

l The agings do not reflect the invoices entered during startup because the balance is entered as a single amount.

l The detail for prime contract audits is limited.

Method 2

For each client, enter a record for the outstanding balance of each unpaid or partially paid item. When entering a partially
paid invoice, make two separate entries. When usingmethod 2, you will be entering a significant amount of information with
each item.

Method 3

For each client, enter a record for each receivable invoice or credit. Not only are you entering the outstanding balances for
unpaid and partially paid items, but you are also entering fully paid invoices and credits. When entering a partially paid
invoice, make two separate entries. Then assign paid records status 4-Paid, and assign open records status 1-Open.

Enter all items in chronological order so that statement and contract audits display the invoices in sequence.

About entering service receivable items at initial setup

Post the service receivable items against the same clearing account used earlier to enter the service receivable balances.
The process transfers the balances into theService Receivables ledger account.

When entering the receivable items, post the records to the appropriate posting periods. Post any open items from the prior
year to period 0.

It is not necessary to enter the individual parts as line items in the grid. A single line containing a description, quantity, price,
and ledger account number is all that is necessary.
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Service Quotes, Work Orders, and Invoices

About service invoice types
Service invoice types let you categorize transactions and control to which ledger accounts you post. For each type,
indicate the cash, taxable income, non-taxable income, discounts given, and cost of goods accounts as well as the cost
code and cost type. In addition, you can include a department.

On the Invoice Details tab, Sage 100 Contractor inserts the appropriate income account based on the service invoice type
selected. For taxable items, Sage 100 Contractor suggests the taxable income account. For non-taxable items, Sage 100
Contractor suggests the non-taxable income account. You can change the suggested account if needed.

When you post the work order or invoice, Sage 100 Contractor creates the journal transaction, debiting the service
receivables account and crediting the appropriate taxable or non-taxable accounts for each item. Under certain
circumstances, Sage 100 Contractor also posts to the cash, discounts given, or cost of goods accounts indicated in the
service invoice type.

l Cash Account:When a client or customer pays cash for an over-the-counter sale, enter the invoice and assign it
status 4-Paid. When you post the transaction, Sage 100 Contractor creates additional lines in the journal
transaction-debiting the cash account and crediting the service receivables account.

l Cost of Goods:When the items come from inventory, Sage 100 Contractor creates additional lines in the journal
transaction-debiting the cost of goods account and crediting the inventory account.

You can set up service invoice types to classify the types of work you perform, and provide suggested ledger accounts for
posting transactions. If there are a large number of startup invoices, create a service invoice type designed to post to the
service receivables clearing account.
Example of service invoice types for a plumbing company

Invoice Type # Type Name

1 Over-the-counter

2 Faucet repair

3 Grease/drain clean out

4 Leak detection

5 Back flow test

6 Plumbing repair

7 Old debt

Example of service invoice types for an electrical company

Invoice Type # Type Name

1 New fixture

2 Fixture replacement

3 Rewire

4 New meter/service

5 Upgrademeter/service

6 Troubleshooting
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Invoice Type # Type Name

7 Old debt

About service invoice status
The status of a service record indicates its location in the process.

IMPORTANT: You can change the status of records assigned status 1-Open, 2-Review, or 3-Dispute to another of
the first three status settings. However, you cannot assign status 4-Paid or 5-Void.

Status Description

1-Open Indicates you have invoiced the customer. Sage 100
Contractor posts the record to the general ledger.

2-Review Indicates themanagement or bookkeeping staff should
review the record.

3-Dispute Indicates a record disputed by the client.

4-Paid Indicates a record paid in full.

5-Void Indicates a void record.

6-Quote

Indicates a quote has been provided to a potential
customer. A service call has not been scheduled.

You cannot hold stock for a service record assigned this
status.

7-Work Order

Indicates a service call is scheduled.

You cannot hold stock for a service record assigned this
status. When you post a work order, Sage 100
Contractor assigns the record status 1-Open.

8-Complete Indicates the service work is complete, but you will not
bill the customer for the work.

9-Route
Indicates the work order is for a service route.

You cannot use serialized part numbers in the record.
However, you can enter parts without serial numbers.

10-Contract
Indicates a service provided on a regular basis.

You cannot use serialized part numbers in the record.
However, you can enter parts without serial numbers.

NOTE: When an invoice or credit is fully paid, Sage 100 Contractor automatically assigns status 4-Paid. If you void
the record, Sage 100 Contractor automatically assigns status 5-Void.

Entering quotes or work orders or invoices
Consider the following points before entering quotes, work order, or invoices:
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l To create a quote or work order, you only need to provide the information required in the header.

l To create an invoice, youmust include a price and quantity on the Invoice Details tab; otherwise, Sage 100
Contractor cannot calculate the invoice amount.

l When you save a record assigned status 1-Open, 2-Review, or 3-Dispute, Sage 100 Contractor posts an invoice to
the general ledger.

l The work order shows up on theDispatch Boardwhen theScheduled andPriority text boxes on theDispatch
tab are filled in.

l You can usemarkups and overrides when entering a new quote, work order, or invoice.

To locate an existing client's records, you canmake an entry in thePhone#, orAddress 1, on the Location tab when F9 is
used. Sage 100 Contractor searches the client and client locations and displays the record when it finds an exact match.
When you enter client records, be consistent in how the information is formatted.

Suppose a client's address appears in the client record as 555Main St. When entering a work order for the client, you enter
555Main Street in theAddress 1 text box on the Location tab. Because the address does not precisely match what is
given in the client record, Sage 100 Contractor is unable to find the client record.

Some companies provide technicians with preprinted numbered invoices, which you can track on the service record. After a
technician has provided the customer with an invoice, select the service record and enter the invoice number in the
Invoice# text box. If you leave the Invoice# box blank, Sage 100 Contractor inserts the work order number.

TIP: With the cursor in theOrder# text box, you can have Sage 100 Contractor auto-populate theOrder# and the
Invoice# text boxes by setting theDefault Entry to Next in the Field Properties (F7). Alternatively, on saving a
record, if no Invoice# is assigned, Sage 100 Contractor copies the order number to the invoice number.

To enter a quote, work order, or invoice
1 Open 11-2 Work Orders/Invoices/Credits.

2 In theOrder# text box, enter the work order number.

3 In the Invoice# text box, enter the invoice number.

4 In theDate text box, enter the work order date.

5 In theClient# text box, enter a client number.

6 In theDescription text box, enter a brief statement about the transaction.

7 In the Job text box, enter the job number.

8 In theStatus list, click the invoice status.

9 In the Type list, click the invoice type.

10 If you want to enter the customer or client location, enter the data on the Location tab.

11 If you want to schedule the service call, enter the data on theDispatch tab.

12 If you want to enter the billing information, enter the data on theBilling tab.

13 If you want to enter the parts or assemblies necessary to complete the work, enter the data on the Invoice Details tab.

14 If you want to enter the insurance information, enter the data on the Insurance tab.

15 On the Filemenu, click Save.

About prioritizing work orders and employees

You can assign a priority number to each work order and to each employee assigned to that work order. The priority lets a
dispatcher assess how important a work order is, or how important it is for an employee to go out on a particular job.
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IMPORTANT: If the priority of the employee is different from the priority of the work order, theDispatch Board
displays the employee's priority.

You can customize the 8 selections in the priority dropdown list in 11-2 Work Orders/Invoices/Credits to make it
applicable to your workflow. When you look at the appointment on theDispatch Board, its priority appears as a color in the
upper right corner.

Following are some examples of priorities and their corresponding colors.

Example 1: Default priority levels and colors

Priority Color

1-Emergency Red

2-Urgent Orange

3-Prompt Yellow

4-Low Green

5-Hold Gray

Example 2: Priority levels by service level agreement

Priority Color

1-4 Hour Response Time Red

2-SameDay Response Orange

3-8 Hour Response Time Yellow

4-24 Hour Response Time Green

5-48 Hour Response Time Gray

Entering quotes or work orders or invoices

Consider the following points before entering quotes, work order, or invoices:

l To create a quote or work order, you only need to provide the information required in the header.

l To create an invoice, youmust include a price and quantity on the Invoice Details tab; otherwise, Sage 100
Contractor cannot calculate the invoice amount.

l When you save a record assigned status 1-Open, 2-Review, or 3-Dispute, Sage 100 Contractor posts an invoice to
the general ledger.

l The work order shows up on theDispatch Boardwhen theScheduled andPriority text boxes on theDispatch
tab are filled in.

l You can usemarkups and overrides when entering a new quote, work order, or invoice.

To locate an existing client's records, you canmake an entry in thePhone#, orAddress 1, on the Location tab when F9 is
used. Sage 100 Contractor searches the client and client locations and displays the record when it finds an exact match.
When you enter client records, be consistent in how the information is formatted.
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Suppose a client's address appears in the client record as 555Main St. When entering a work order for the client, you enter
555Main Street in theAddress 1 text box on the Location tab. Because the address does not precisely match what is
given in the client record, Sage 100 Contractor is unable to find the client record.

Some companies provide technicians with preprinted numbered invoices, which you can track on the service record. After a
technician has provided the customer with an invoice, select the service record and enter the invoice number in the
Invoice# text box. If you leave the Invoice# box blank, Sage 100 Contractor inserts the work order number.

TIP: With the cursor in theOrder# text box, you can have Sage 100 Contractor auto-populate theOrder# and the
Invoice# text boxes by setting theDefault Entry to Next in the Field Properties (F7). Alternatively, on saving a
record, if no Invoice# is assigned, Sage 100 Contractor copies the order number to the invoice number.

To enter a quote, work order, or invoice
1 Open 11-2 Work Orders/Invoices/Credits.

2 In theOrder# text box, enter the work order number.

3 In the Invoice# text box, enter the invoice number.

4 In theDate text box, enter the work order date.

5 In theClient# text box, enter a client number.

6 In theDescription text box, enter a brief statement about the transaction.

7 In the Job text box, enter the job number.

8 In theStatus list, click the invoice status.

9 In the Type list, click the invoice type.

10 If you want to enter the customer or client location, enter the data on the Location tab.

11 If you want to schedule the service call, enter the data on theDispatch tab.

12 If you want to enter the billing information, enter the data on theBilling tab.

13 If you want to enter the parts or assemblies necessary to complete the work, enter the data on the Invoice Details tab.

14 If you want to enter the insurance information, enter the data on the Insurance tab.

15 On the Filemenu, click Save.

About insurance information

This functionality performing service work for insurance recovery, you can supply the necessary policy details on the
Insurance Information tab of 11-2 Work Orders/Invoices/Credits.

Entering insurance information

To enter insurance information:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click the Insurance Information tab.

3 Do the following:

a In thePolicy# text box, enter the customer's policy number.

b In thePolicyholder text box, enter the name of the policy holder.

c In thePolicy Address 1, Policy Address 2, City, State, and Zip text boxes, enter the address of the policyholder.

d In thePolicy Phone text box, enter the telephone number of the policyholder.
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e In thePolicy Type text box, enter the kind of policy.

f In theDeductible text box, enter the deductible amount.

g In theCompany text box, enter the name of the insurance company.

h In theAdjuster Name text box, enter the name of the insurance adjuster.

i In theAdjuster Address 1, Adjuster Address 2, City, State, and Zip text boxes, enter the address of the adjuster.

In theAdjuster Phone text box, enter the telephone number of the insurance adjuster.

Entering locations on a work order

To enter a location on a work order:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click the Location tab.

3 Do the following:

a In the Location text box, enter the location.

b In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

c In theContact text box, enter the name of the person to contact at the location.

d In theCross text box, enter the nearest cross street.

e In theMap text box, enter themap coordinates.

f In thePhone# text box, enter the telephone number of the location.

g In thePriority list, click the priority you want to assign the record.

h In theService Area text box, enter the service area.

i In theSalesperson text box, enter the employeemanaging the sale.

j In the Technician text box, enter the technician performing or managing the work.

k If the work is part of a route, in theRoute text box, enter the route number to which you are assigning the work.

4 If the record is part of a service contract or route, do the following:

a In theContract text boxes, enter the beginning and ending dates.

b In theNext Bill text box, enter the date when to next bill the client.

5 In theCycle list, click the billing cycle you want.

6 UnderDate/Time, do the following:

a In the First Call text box, enter the datewhen you received the call. In theSecond Call text box, enter the timewhen
you received the call.

b In the first Dispatch text box, enter the datewhen you dispatched the call. In the secondDispatch text box, enter the
timewhen you dispatched the call.

c In the first Scheduled text box, enter the datewhen the work is to be performed. In the secondScheduled text box,
enter the timewhen the work is to be performed.

d In the first Start text box, enter the datewhen the actual work begins. In the secondStart text box, enter the time
when the actual work begins.

e In the first Finish text box, enter the datewhen the actual work is completed. In the second Finish text box, enter the
timewhen the actual work is completed.
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f In theEstimated Hours text box, enter the estimated number of hours necessary to complete the work.

g In theActual Hours text box, enter the actual number of hours necessary to complete the work.

7 In the grid, do the following:

a In theEmployee cell, enter the employee number.

b In theEquipment cell, enter the equipment number of equipment used on the service call.

c In thePriority cell, enter the priority number reflecting the need for the employee.

d In theScheduled Date cell, enter the datewhen the employee is scheduled to begin.

e In theScheduled Start cell, enter the timewhen the employee is scheduled to begin.

f In theScheduled Finish cell, enter the timewhen the employee is scheduled to finish.

g In theScheduled Hours cell, enter the estimated number of hours necessary to complete the work.

h In theCompleted Date cell, enter the datewhen the work is completed.

i In theActual Start cell, enter the timewhen the actual work begins.

j In theActual Finish cell, enter the timewhen the actual work is completed.

k In theActual Hours cell, enter the actual number of hours necessary to complete the work.

l In theBilled Date cell, enter the datewhen you billed for the work.

8 Repeat step 7 for each employee, for each day worked.

TIP: ThePayroll Recordswindow uses service orders to create timecards. Sage 100 Contractor looks at the grid on
theDispatch tab for the date work is completed and the actual number of hours worked.

Creating multiple work orders and invoices

When you repeat a record, Sage 100 Contractor creates additional copies of the work order or invoice and schedules them
for you.
Example: Scheduling a maintenance call once a month for a year

Suppose you want to schedule amaintenance call for a client once amonth for the next year. After entering the initial work
order, you can have Sage 100 Contractor repeat the record once amonth for an additional 11 times. Sage 100 Contractor
then schedules them at the same time eachmonth for the next 11months.
To schedule a monthly maintenance call for a year
1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the record.

3 On theOptionsmenu, click Copy or Repeat this Record.

4 Select theRepeat this record every option, and do the following:

a Enter 1 in the first number field.

b SelectMonth(s) from the dropdown.

c Enter 11 in the second number field for the amount of times to repeat.

5 Click [Repeat].
To create multiple work orders and invoices
1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the record.
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3 On theOptionsmenu, click Copy or Repeat this Record.

4 Select theRepeat this record every option, and do one the following:

a Days: Enter the number of days in the first number, select Day(s) from the dropdown, and enter the number of times to
repeat in the second number field.

b Weeks: Enter the number of weeks in the first number field, selectWeek(s) from the dropdown, and enter the number
of time to repeat in the second number field.

c Months: Enter the number of months in the first number field, selectMonth(s) from the dropdown, and enter the
number of times to repeat in the second number field.

d Years: Enter the number of months in the first number field, select Year(s) from the dropdown, and enter the number of
times to repeat in the second number field.

5 Click [Repeat].

Copying and repeating records

In 11-2 Work Orders/Invoices/Creditswindow, you now have the ability to copy or repeat a work order. Instead of using
the copy and paste function, this option allows you to designate how often to copy and does not copy information such as
the work order number.

There are two options:

l Copy this record one time only

l Repeat this record

Both options copy and create a new work order, but the repeat option allows you set up how often to copy and repeat this
work order.

When copying the record, the new record has the following features:

l Status is set to what it was in the original record

l Order# and Invoice# advance to the next number, based on your settings

l TheOrder Date and Entered fields are set to today's date

l Several fields are cleared: Call, Dispatch, Scheduled, Start, Finish, and Actual Hours

Creating purchase orders from work orders or invoices

In the 11-2 Work Orders/Invoices/Creditswindow, you can create a purchase order for thematerial contained in a work
order or invoice.

To create a purchase order from awork order or invoice, on theOptionsmenu, click Create Purchase Order.

Deleting service records

You can delete a service record assigned status 6-Quote, 7-Work Order, 8-Completed, 9-Route, or 10-Contract.

To delete a service record:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the record.

3 On theEditmenu, click Delete Record.
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Managing bad debts in service receivables

Sometimes there are situations where you have billed for work, but might never receive full payment. You can post a credit
invoice to the job, crediting theBad Debt Expense account, for the uncollected amount. By not applying the credit to the
open invoice, the credit invoice creates a $0 job balance but the invoice remains open. If you eventually collect the
remaining contract balance, you can still post the payment to the invoice and void the credit.

For service receivables, create a service invoice type for posting bad debts. When setting up the type, enter the usual cash,
discounts given, and cost of goods accounts. In place of the taxable and non-taxable income accounts, enter the account
number for bad debt expense.

With a type for bad debt, you can generate reports detailing your bad debts for only the service work, and even create
reports on a client by client basis.

Customizing the priority dropdown list

You can customize the 8 selections in the priority dropdown list in 11-2 Work Orders/Invoices/Credits to make it
applicable to your workflow. When you look at the appointment on theDispatch Board, its priority appears as a color in the
upper right corner.

Example #1: Priority by Service Level Agreement

For example, if you want to assign priority by service level agreement, you can do the following:

Priority Color

1-4 Hour Response Time Red

2-SameDay Response Orange

3-8 Hour Response Time Yellow

4-24 Hour Response Time Green

5-48 Hour Response Time Gray

Example #2: Priority by County

Priority Color

West County Red

North County Yellow

East County Green

South County Blue

To customize the priority dropdown list
1 Open 11-2 Work Orders/Invoices/Credits.

2 Click theDispatch tab.

3 Click the up arrow to the right of the priority dropdown list.

4 In the Label and Prompt tab, do the following:

a Type a name for the Priority label in the User Description field. Use only letters or numbers, up to 19 characters,
spaces included.
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b Type a prompt to help you identify what information the User Description field. This information displays in the status
bar.

5 In the Item Names and Colors tab, do the following:

a Type text in the fields to customize your section names.

b To change the color for the section name, click the lookup button to the right.

6 If you need to remove a section or insert a section, do the following:

a Click the [Advanced Options] link.

NOTE: Youmust be the Supervisor user to access the AdvancedOptions area.

b Delete the unneeded sections. If a section name is assigned to a record, you cannot delete that section.

c Click [OK].

The changes are reflected in the Section Name and dropdownmenu.

More about Work Orders
About work order deposits

In working with your clients, youmight have to enter a deposit on a work order. Suppose a client provides a prepayment of
$30 on a work order for $160. This amount has to be reflected in the client's invoice or statement and deducted from the
total.

When you save a work order with a deposit, Sage 100 Contractor enters the deposit amount in the general ledger as a credit
to the client. In other words, you have been paid for work that you have not performed. When you print an invoice or
statement, however, the deposit is deducted from the invoice or statement total.

TIPS:
l You can set your invoice and statement forms to recognize deposits on work orders and deduct them from the

total.

l Refunding a service receivables credit uses the same procedure as refunding an accounts receivable check.

Posting single work orders

To post a single work order:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the work order.

3 On thePostmenu, click [This Record Only].

Posting multiple work orders

Sage 100 Contractor provides a list of work orders you can post using the following criteria: Sage 100 Contractor looks at
each work order for a date in the Finish text box. If a date is not found, Sage 100 Contractor then looks for a date in the
Scheduled text box, and finally theDispatch text box. The date foundmust be the same as today's date or earlier.
Otherwise, Sage 100 Contractor does not include the work order in the list of work orders you can post.

To post multiple work orders:

1 Open 11-2 Work Orders/Invoices/Credits.

2 On thePostmenu, click [Multiple Records].
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3 Select the work orders you want to post.

4 Click [Post].

Posting options for work orders

You can handle posting options for work orders three different ways.

l When you use theUse the current date as the Invoice Date option, due dates and discount dates will calculate
from the current date according to the client's terms.

l When you use theUse each record's existing Invoice Date option, existing invoice dates, due dates, and
discount dates will not be adjusted. Missing dates will be calculated.

l When you use theEnter desired Invoice Date when posting option, due dates and discount dates will calculate
from the entered invoice date according to the client's terms.

NOTE: If you are the Supervisor, you can choose one of the three options and select theAlways use the option
selected above check box tomake it the default posting option.

Deleting work orders

When you delete an appointment from theDispatch Board, Sage 100 Contractor deletes the work order.

To delete a work order:

1 Open 11-3 Dispatch Board.

2 Right-click the appointment, and then click [Delete].

Invoice Service Calls
Entering invoice details for service calls

Consider the following points before entering the invoice details for a service call:

l You can usemarkups and overrides when entering invoice details for a service call.

l You can enter an initial deposit for part of the total invoice in thePaid box when the invoice has a status setting of 1
through 4. After you have saved the record, thePaid box is inaccessible.

l You can enter an initial deposit for part of the total invoice in theDeposit box when the invoice has a status of 7-
Work Order. After you have saved the record, theDeposit box is inaccessible.

l You can enter a specified discount available to the customer in theDisc. box.

l You can control the billing of individual items. By using a work order as amaster record, you can create partial
invoices.

To enter the invoice details for a service call:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click the Invoice Details tab.

3 In the grid, do the following:

a In theAssembly# cell, enter an assembly number. Review each assembly to addmissing parts, delete unnecessary
parts, and edit part quantities as needed.

b In thePart# cell, enter a part number.

c In theDescription cell, enter a brief description.



- 564 -

d In theQuantity cell, enter the number of assemblies or parts necessary to complete the work.

e In thePrice column, enter the price per unit.

f In the Ticket# cell, enter the load ticket number or purchase order number.

g In theCost Type cell, enter the type.

h In theSales Tax cell, type Yes if the item is taxable, type No if the item is non-taxable.

i In theAccount cell, enter the ledger account number to be used for posting the invoice.

j In theSubaccount cell, enter the subaccount.

k In the Inv. Location cell, enter the inventory location number.

l If the part has a serial number, enter the serial number in theSerial# cell.

m In theSite Location cell, enter the location where the equipment is installed.

n In theEquipment cell, enter the equipment number of the client's equipment that was serviced.

o You can also enter information into the remaining columns, User Defined, Shop Notes, andOwner Notes.

4 Repeat step 3 for each item you want to include.

Entering billing information for work orders and invoices

CAUTION: To avoid any non-compliance with PCI DSS, we recommend against storing credit card information in
Sage 100 Contractor. Such storage does not comply with the PCI DSS, and thus it creates a possible risk for your
business.

To enter the invoice details for a service call:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click theBilling tab.

3 Do any of the following:

a In the Invoice Date text box, enter the date when you created the invoice.

b In theDue Date text box, enter the invoice due date.

c In theDisc Date text box, enter the due date by which the payment must be received for the discount to apply.

d In theReference# text box, enter the reference number.

e In theSource list, click the source of the lead.

f In theClient PO# text box, enter the client's purchase order number.

g In theResale# text box, enter the customer's resale number.

h In theSalesperson text box, enter the employee number.

i In the Tax District text box, enter the tax district number.

j In thePayment list, click the drop-down button and select themethod of payment.

k In theCard/Check# text box, enter the credit card or check number.

l In theCardholder text box, enter the name on the credit card.

m In theExp Date text box, enter the expiration date of the credit card.
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About the Discount Available box

Some service invoices may have discounts. You can include the discount by entering the amount in the Discount Available
box.

Creating partial invoices

With large projects, you can create a single work order. The work order acts as amaster, and contains all the assemblies
and parts needed to complete the work. Over the course of the job, you can then create smaller invoices. For example, you
can stagger invoicing for a job based on the work completed.

On the work order, Sage 100 Contractor tracks the total quantity invoiced in theBilled to Date column. In addition, it
displays the number of the last invoice created for each item in the Ticket Number column.

To create a partial invoice:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the work order.

3 Click the Invoice Details tab.

4 In theCurrent cell of each item to be invoiced, enter the quantity.

5 On theOptionsmenu, click Create Partial Invoice.

6 Using the data control, select the last record to review the invoice.

NOTE: Markups and overridden billing amounts are not included when creating partial invoices.

About service invoice types

Service invoice types let you categorize transactions and control to which ledger accounts you post. For each type,
indicate the cash, taxable income, non-taxable income, discounts given, and cost of goods accounts as well as the cost
code and cost type. In addition, you can include a department.

On the Invoice Details tab, Sage 100 Contractor inserts the appropriate income account based on the service invoice type
selected. For taxable items, Sage 100 Contractor suggests the taxable income account. For non-taxable items, Sage 100
Contractor suggests the non-taxable income account. You can change the suggested account if needed.

When you post the work order or invoice, Sage 100 Contractor creates the journal transaction, debiting the service
receivables account and crediting the appropriate taxable or non-taxable accounts for each item. Under certain
circumstances, Sage 100 Contractor also posts to the cash, discounts given, or cost of goods accounts indicated in the
service invoice type.

l Cash Account:When a client or customer pays cash for an over-the-counter sale, enter the invoice and assign it
status 4-Paid. When you post the transaction, Sage 100 Contractor creates additional lines in the journal
transaction-debiting the cash account and crediting the service receivables account.

l Cost of Goods:When the items come from inventory, Sage 100 Contractor creates additional lines in the journal
transaction-debiting the cost of goods account and crediting the inventory account.

You can set up service invoice types to classify the types of work you perform, and provide suggested ledger accounts for
posting transactions. If there are a large number of startup invoices, create a service invoice type designed to post to the
service receivables clearing account.
Example of service invoice types for a plumbing company

Invoice Type # Type Name

1 Over-the-counter
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Invoice Type # Type Name

2 Faucet repair

3 Grease/drain clean out

4 Leak detection

5 Back flow test

6 Plumbing repair

7 Old debt

Example of service invoice types for an electrical company

Invoice Type # Type Name

1 New fixture

2 Fixture replacement

3 Rewire

4 New meter/service

5 Upgrademeter/service

6 Troubleshooting

7 Old debt

Setting up service invoice types

Note that the cost code and cost type enable Sage 100 Contractor to create job cost records for service work. When you
include parts from inventory on the service record, Sage 100 Contractor creates the cost record for the cost of the parts
from inventory only. Sage 100 Contractor gets the average cost amount from the part(s) and uses that amount times the
number of parts to post to theCost of Goods account and create a job cost to match.

To set up service invoice types:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Next to the Type list, click the detail button.

3 In the Invoice Type# cell, enter the invoice type number.

4 In the Type Name cell, enter the name of the service invoice type.

5 In theDispatch Color cell, double click to select a color other than the default Peach Puff color.

6 If you departmentalize transactions, enter the department number in theDepartment cell.

7 In theCash Acct cell, enter the account number to which you want to post cash transactions.

8 In the Taxable Income Acct cell, enter the account number to which you want to post taxable income.

9 In theNon-Tax Income Acct cell, enter the account number to which you want to post non-taxable income.

10 In theDisc Given Acct cell, enter the account number to which you want to post discounts.

11 In theCost of Goods Acct cell, enter the account number to which you want to post the cost of goods.
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12 In theCost Code cell, enter a cost code.

13 In theCost Type cell, enter 1-Material.

14 Repeat steps 3-12 for each invoice type.

15 On the Filemenu, click [Save].

TIP: You can create a service invoice type for old debts for which you do not expect payment.

About service invoice status

The status of a service record indicates its location in the process.

IMPORTANT: You can change the status of records assigned status 1-Open, 2-Review, or 3-Dispute to another of
the first three status settings. However, you cannot assign status 4-Paid or 5-Void.

Status Description

1-Open Indicates you have invoiced the customer. Sage 100
Contractor posts the record to the general ledger.

2-Review Indicates themanagement or bookkeeping staff should
review the record.

3-Dispute Indicates a record disputed by the client.

4-Paid Indicates a record paid in full.

5-Void Indicates a void record.

6-Quote

Indicates a quote has been provided to a potential
customer. A service call has not been scheduled.

You cannot hold stock for a service record assigned this
status.

7-Work Order

Indicates a service call is scheduled.

You cannot hold stock for a service record assigned this
status. When you post a work order, Sage 100
Contractor assigns the record status 1-Open.

8-Complete Indicates the service work is complete, but you will not
bill the customer for the work.

9-Route
Indicates the work order is for a service route.

You cannot use serialized part numbers in the record.
However, you can enter parts without serial numbers.

10-Contract
Indicates a service provided on a regular basis.

You cannot use serialized part numbers in the record.
However, you can enter parts without serial numbers.

NOTE: When an invoice or credit is fully paid, Sage 100 Contractor automatically assigns status 4-Paid. If you void
the record, Sage 100 Contractor automatically assigns status 5-Void.
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Recalculating invoices

When youmake changes to an invoice, you can view the new totals by recalculating the invoice.

To recalculate an invoice, on theOptionsmenu click Calculate.

About controlling billing amounts with markups and overrides

IMPORTANT: Markups and overridden billing amounts are not included when creating partial invoices.

With theMarkups and Overrides functionality, you can override or control the billing amount on work orders. You can
round up or down. For example, if the billing amount agreed upon is $837.86, the billed amount may be rounded down to
$825. Conversely, if the billing amount is $837.86, youmay round up the billed amount to $850.

As you enter values andmove through the text boxes, Sage 100 Contractor calculates the billing amount. When using the
Taxablemarkup, the tax rate is set by the tax district rate.

After you havemarked up the total from the grid to meet your business requirements, you can then override theBilling
Amount. When you override the billing amount, Sage 100 Contractor automatically selects the billing amount lock check
box, which prevents theBilling Amount from being recalculated. This locking occurs in both the Taxable andNon-Tax
lines.

About posting markups

When posting a work order, invoice, or credit that has a value in the Total Markups text box(es), additional lines are added
to the ledger transaction for the taxable and non-taxablemarkup amounts. These additional lines use the posting accounts
set up in theService Invoice Type table.

About posting overridden billing amounts

When posting a work order, invoice, or credit for which you have overridden the billing amount, the amounts and posting
accounts shown in the grid are ignored, and the transaction that is created uses the posting accounts set up in the Service
Invoice Type table and the amount from the Billing Amount text box(es).

If the record being posted has markups and the billing amount has been overridden, the transaction is posted according to
the Posting Overridden Billing Amounts rules.

Setting up finance charges for service work

To apply a finance rate, Sage 100 Contractor application needs to know the account to which to post the finance charge.

To set up finance charges for service work:
1 Open 11-2 Work Orders/Invoices/Credits.

2 In the upper right section of the window, next to the Type list, click the detail button.

3 TheService Invoice Typeswindow appears.

4 In the Invoice Type# cell, enter the invoice type number.

5 In the Type Name cell, type Finance Charge.

6 If you departmentalize transactions, enter the department number in theDepartment cell.

7 In theCash Acct cell, enter the account number to which you want to post cash transactions.

8 In theNon-Tax Income Acct cell, enter the account number to which you want to post non-taxable income.

9 In theDisc Given Acct cell, enter the account number to which you want to post discounts.
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10 In theCost of Goods Acct cell, enter the account number to which you want to post the cost of goods.

11 In theCost Code cell, enter a cost code.

12 In theCost Type cell, enter a cost type.

13 On the Filemenu, click [Save].

Adjusting billing amounts with markups

Youmay need to adjust the billing amount with theMarkups and Overrides functionality on the Invoice Details tab of the
11-2 Work Orders/Credits/Invoiceswindow. For example, youmight need to add a percentage or a dollar amount to the
billing amount.

To adjust the billing amount with a markup:

1 Open 11-2 Work Orders/Credits/Invoices.

2 Click the Invoice Details tab.

3 In the data control text box, enter the work order number that you want to adjust with markups.

4 Do one or both of the following:

a In the Taxable orNon-Tax lines, in theMarkup % cell, enter themarkup percentage.

b In the Taxable orNon-Tax lines, in theMarkup $ cell, enter themarkup dollar amount.

5 Click [Save].

Adjusting billing amounts with overrides

Youmay need to adjust the billing amount due with theMarkups andOverrides functionality on the Invoice Details tab of
the 11-2Work Orders/Credits/Invoices window. For example, youmight need to round a total up or down for a client or other
business requirement.

To adjust the billing amount with an override:

1 Open 11-2 Work Orders/Credits/Invoices.

2 In the data control text box, enter the work order number that you want to adjust.

3 Click the Invoice Details tab.

4 UnderMarkups and Overrides, enter the billing amount.

5 Click [Save].

NOTE: When you override the billing amount, Sage 100 Contractor automatically locks the total, which is indicated
by the lock icon next to theBilling Amount.

About posting invoices with billing amount markups

When posting an invoice in 11-2 Work Orders/Invoices/Creditswhere the Total Markup boxes have an amount greater
than 0, additional lines are added to the ledger transaction for the taxable and non-taxablemarkup amounts.

The Taxable Total Markup ledger line uses the Taxable Income ledger account and theDepartment to set up in the
Service Invoice Type. You can recognize this line in the ledger because it is described as the Taxable Markup
Adjustment.

TheNon-Taxable Total Markup ledger line uses theNon-Tax Income ledger account and theDepartment to set up in the
Service Invoice Type. You can recognize this line in the ledger because it is described as theNon-Taxable Markup
Adjustment.
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About posting invoices with overridden billing amounts

On 11-2 Work Orders/Invoices/Credits underMarkups and Overrides, there are two lock check boxes that you can
select. When posting an invoice where either lock check box is selected, a ledger transaction is created without using any
amounts or accounts from the invoice grid lines or any amounts from the Total Markup. When either check box is selected,
the posting amounts only come from theBilling Amount text boxes.

NOTE: The functionality remains unchanged for relieving inventory and Job Costing on the inventory transaction.

About voiding service invoices

If you discover a work order or invoice was entered incorrectly, determine the best method to correct the error. For example,
if the error is in the header information, you can edit the information contained in any of the text boxes, except in theClient
Number or Tax District text boxes text box.

When the invoice contains an incorrect client number, tax district, ledger account, or amount, you can void the invoice and
then re-enter it with the correct information. By voiding and re-entering the invoice, you create a clear audit trail.

There are also circumstances when you cannot void the original record. For example, you cannot void a credit invoice that
has been applied in full. Because you cannot void these types of transactions, it is necessary to enter an adjusting invoice.

Before voiding an invoice, reverse all the payments posted to it. You can then enter the invoice correctly and reapply the
payments.

Voiding service invoices

You can void a service invoice with an assigned status 1-Open, 2-Review, or 3-Dispute.

Note that when voiding an invoice that contains discretionary taxes, Sage 100 Contractor also voids the tax amount. If the
voided invoice reduces the discretionary taxes below the billingmaximum, Sage 100 Contractor continues to calculate the
discretionary taxes until the tax maximum is met.

To void a service invoice:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the record.

3 If an amount appears in thePaid text box, reverse the payments. (See links)

4 On theEditmenu, click Void Record.

More about Service Credits
About service credits

CAUTION: You cannot reverse a credit invoice after applying it to an invoice. If you have applied a credit invoice to
the wrong invoice, make adjusting invoice entries to correct the error.

There are reasons why youmight have to enter a credit invoice. For example, suppose a client provides a prepayment on a
service call or overpays an invoice. In either case, it is necessary to reduce the service receivable account.

When you save a credit invoice, Sage 100 Contractor reduces the client balance. However, the credit invoice retains status
1-Open until you apply it against other invoices in the 3-3-1 Cash Receiptswindow. After you have applied the credit
balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the
credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after
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applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the
credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit
invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the 3-3-1 Cash
Receiptswindow.

Entering credit invoices or credits

When you apply a credit, Sage 100 Contractor adjusts the invoice and job balance. If the credit has a balance after applying
it to an invoice, Sage 100 Contractor assigns the credit status 1-Open, but if the entire amount of the credit is applied, Sage
100 Contractor assigns it status 4-Paid.

Consider the following when entering credit invoices or credits:

l When entering cash receipts, you can apply the credit invoice. How?(See links)

l You can usemarkups and overrides when entering a new invoice or credit. (See links)(See related topics)

l You can review the record totals before saving the credit invoice or credit. On theOptionsmenu, click Calculate.

l You can provide part numbers on an credit invoice. Sage 100 Contractor only includes the parts on the credit invoice,
and does not use the part information elsewhere.

l When you enter a tax district number in the Tax District text box, you can select which items to tax. In the Taxable
column, typeYes if the item is taxable orNo if the item is non-taxable.

To enter a credit invoice or credit:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Do the following:

a In theOrder# text box, enter the order number.

b In theDate text box, enter the date of the client invoice.

c In theClient# text box, enter a client number.

d In theDescription text box, enter a brief statement about the transaction.

e In the Job text box, enter the job number.

f In theStatus list, click the invoice status. (See links)

g In the Type list, click the invoice type. (See links)

3 Click the Invoice Details tab.

4 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the price for a single item.

5 Repeat step 4 for each item.

6 On the Filemenu, click Save.

Entering a credit invoice and applying it to an invoice in 11-2 Work Orders

When you apply a credit, Sage 100 Contractor adjusts the invoice and client balance. If the credit has a balance after
applying it to an invoice, Sage 100 Contractor assigns the credit status 1-Open, but if the entire amount of the credit is
applied, Sage 100 Contractor assigns it status 4-Paid.

Consider the following when entering credit invoices:
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l When entering cash receipts, you can apply the credit invoice. (See links)

l You can usemarkups and overrides when entering a new invoice or credit. (See links)

l You can review the record totals before saving the credit invoice or credit. On theOptionsmenu, click Calculate.

l You can provide part numbers on the credit invoice. Sage 100 Contractor only includes the parts on the credit
invoice, and does not use the part information elsewhere.

l When you enter a tax district number in the Tax District text box, you can select which items to tax. In the Taxable
column, typeYes if the item is taxable orNo if the item is non-taxable.

To enter a credit invoice and apply it to an invoice:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Do the following:

a In theOrder# text box, enter the order number.

b In theDate text box, enter the date of the client invoice.

c In theClient# text box, enter a client number.

d In theDescription text box, enter a brief statement about the transaction.

e In the Job text box, enter the job number, if this credit is for a job.(See links)

f In theStatus list, click the invoice status. (See links)

g In the Type list, click the invoice type.

3 Click the Invoice Details tab.

a In theReference# text box, enter the receivable invoice number to which you want to apply the credit invoice.

NOTE: If you don't reference an existing invoice, the credit can still be applied in 3-3-1 Cash Receipts. You cannot
apply credits using the 3-3-2 Electronic Receipts

4 In the grid, do the following:

a In theDescription cell, enter a brief statement about the item.

b In theQuantity cell, enter the quantity of items as a negative amount.

c In thePrice cell, enter the price for a single item.

5 Repeat step 4 for each item.

6 On the Filemenu, click [Save].

About service receivables and cash receipts

The 3-3-1 Cash Receiptswindow lets you enter cash payments for receivable invoices, service invoices, discounts for
early payment of invoices, and over-payments. You can also apply credit invoices to invoices, or reverse payments.

How you enter the cash receipts determines how many ledger transactions Sage 100 Contractor posts to the general
ledger. Some offices enter the payments at the end of the day, while others enter the payments over the course of the
workday.

When you enter cash receipts at the end of the day, you enter all the payments and save your work. Sage 100 Contractor
posts a single transaction to the general ledger. The transaction represents the day's cash deposit made to the bank, and
that total is what the bank prints on your statement. Reconciling the deposit against the statement is easy because Sage
100 Contractor and your bank show one deposit for that day.
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Tomake reconciliation easier, create a clearing account for cash deposits. In the 3-3-1 Cash Receiptswindow, enter the
cash clearing account in theAccount box in place of the cash account. At the end of the day, enter a single transaction in
the 1-2 Deposits and Interestwindow to transfer the day's balance from the cash clearing account to the bank account.
You can verify the clearing account balance returns to 0 each day. When you receive the bank statement, you then only
need to clear one transaction instead of many.

About entering cash transactions

In addition to performing service work, some companies sell parts or supplies to customers. For such point-of-sale
transactions, it is not necessary to keep records of the customers making the purchases. Because Sage 100 Contractor
requires a client number on every service record, use a dummy client to track the sales. Create a client record titledOver-
the-Counter Sales.

IMPORTANT: If a known client makes a purchase for which you will bill later on, do not use theOver-the-counter
Sales client. Be sure to use the correct client number.

When a customermakes an over-the-counter purchase, you can enter an invoice and assign it to theOver-the-Counter
Sales client. At the end of the day, count out the till and determine the deposit.

In the 3-3-1 Cash Receiptswindow, you can limit the receipts to theOver-the-Counter Sales client. Your deposit from the
till shouldmatch the amount displayed in theDeposit Total text box.

TIP: You can usemarkups and overrides when entering a new cash transaction. (See links)(See related topics)

Displaying payment history on service work

Each time you post a payment to an invoice, Sage 100 Contractor creates a separate record of the payment. To review the
individual payments made to a particular invoice, you can select the invoice and display its payment history.

To display payment history on service work:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Using the data control, select the record.

3 On theViewmenu, click [Payments].

NOTE: When you reverse a cash receipt, Sage 100 Contractor creates an additional record in the payment history for
a negative amount.

TIP: You can use the payment history to reconstruct account balances for aging reports. To do this, first determine
the fiscal period for which you want to recreate the aging. Then subtract the payments made after that fiscal period
from the ending balance.

Service Routes and Contracts
Regularly scheduled work, determined in the terms of the contract, is referred to a service route. A routemight entail routine
inspection, maintenance, or performance of work.

For instance, a street sweeping company sweeps the parking lots for local shopping centers every week. OnMondays and
Tuesdays, the company sweeps lots on the north side of town. OnWednesdays and Thursdays, the company sweeps lots
on the west side of town. And on Fridays, the company sweeps lots on the south side of town. The lots swept on each day
represent a different route.

You can:
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l Create service routes

l Enter service routes

l Post service routes

To create service routes:
1 Open 11-2 Work Orders/Invoices/Credits.

2 Click theView/Add records button next to the Route field in the Location and Dispatch tab.

a In theService Route# cell, enter the route number.

b In theRoute Name cell, enter a brief statement about the route.

3 Repeat step 2 for each route.

4 On the Filemenu, click Save.

Setting up service areas

Some service companies dispatch technicians based on geographic regions. You can assign a service area to a record. On
11-3 Dispatch Board, Sage 100 Contractor uses the color of the service area assigned to the record.

To set up service areas:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click the Location tab.

3 On the right side of the window, next to theService Area drop-down list box, click the detail button.

4 In theArea# cell, enter the area number.

5 In theDescription cell, enter a brief statement about the area.

6 Double-click theDispatch Color cell.

7 Double-click the color you want to use.

8 Repeat steps 4-7 for each service area.

9 On the Filemenu, click [Save].

NOTE: Both client records and service receivable records use the same table of service areas.

Setting up service routes

Regularly scheduled work, determined in the terms of the contract, is referred to a service route. A routemight entail routine
inspection, maintenance, or performance of work.

For example, a street sweeping company sweeps the parking lots for local shopping centers every week. OnMondays and
Tuesdays, the company sweeps lots on the north side of town. OnWednesdays and Thursdays, the company sweeps lots
on the west side of town. And on Fridays, the company sweeps lots on the south side of town. The lots swept on each day
represent a different route.

To set up service routes:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click theView/Add records button next to the Route field in the Location and Dispatch tab.

a In theService Route# cell, enter the route number.
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b In theRoute Name cell, enter a brief statement about the route.

3 Repeat step 2 for each route.

4 On the Filemenu, click Save.

Entering routes

To enter a service route:

1 Open 11-2 Work Orders/Invoices/Credits.

2 In theOrder# text box, enter the order number.

3 In theDate text box, enter the date of the invoice.

4 In theClient# text box, enter a dummy client number.

5 In theDescription text box, enter a brief statement about the transaction.

6 In the Job text box, enter the job number.

7 In theStatus list, click 9-Route.

8 In the Type list, click the invoice type.

9 If you want to enter the customer or client location, or schedule the service call, enter the data on the Location and
Dispatch tab. (See links)

10 If you want to enter the parts or assemblies necessary to complete the work, enter the data on the Invoice Details tab.
(See links)

11 On the Filemenu, click [Save].

TIP: You can usemarkups and overrides when entering a new route.

Entering contracts

To enter a service contract:

1 Open 11-2 Work Orders/Invoices/Credits.

2 In theOrder# text box, enter the order number.

3 In theDate text box, enter the date of the invoice.

4 In theClient# text box, enter a dummy client number.

5 In theDescription text box, enter a brief statement about the transaction.

6 In the Job text box, enter the job number.

7 In theStatus list, click 10-Contract.

8 In the Type list, click the invoice type.

9 Youmay also do the following, if applicable:

a If you want to enter the customer or client location, enter the data on the Location tab.

b If you want to schedule the service call, enter the data on theDispatch tab.

c If you want to enter the parts or assemblies necessary to complete the work, enter the data on the Invoice Details
tab.

10 On the Filemenu, click Save.
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TIP: You can usemarkups and overrides when entering a new contract. (See links)

Entering locations on a work order

To enter a location on a work order:

1 Open 11-2 Work Orders/Invoices/Credits.

2 Click the Location tab.

3 Do the following:

a In the Location text box, enter the location.

b In theAddress 1, Address 2, City, State, and Zip text boxes, enter the address.

c In theContact text box, enter the name of the person to contact at the location.

d In theCross text box, enter the nearest cross street.

e In theMap text box, enter themap coordinates.

f In thePhone# text box, enter the telephone number of the location.

g In thePriority list, click the priority you want to assign the record.

h In theService Area text box, enter the service area.

i In theSalesperson text box, enter the employeemanaging the sale.

j In the Technician text box, enter the technician performing or managing the work.

k If the work is part of a route, in theRoute text box, enter the route number to which you are assigning the work.

4 If the record is part of a service contract or route, do the following:

a In theContract text boxes, enter the beginning and ending dates.

b In theNext Bill text box, enter the date when to next bill the client.

5 In theCycle list, click the billing cycle you want.

6 UnderDate/Time, do the following:

a In the First Call text box, enter the datewhen you received the call. In theSecond Call text box, enter the timewhen
you received the call.

b In the first Dispatch text box, enter the datewhen you dispatched the call. In the secondDispatch text box, enter the
timewhen you dispatched the call.

c In the first Scheduled text box, enter the datewhen the work is to be performed. In the secondScheduled text box,
enter the timewhen the work is to be performed.

d In the first Start text box, enter the datewhen the actual work begins. In the secondStart text box, enter the time
when the actual work begins.

e In the first Finish text box, enter the datewhen the actual work is completed. In the second Finish text box, enter the
timewhen the actual work is completed.

f In theEstimated Hours text box, enter the estimated number of hours necessary to complete the work.

g In theActual Hours text box, enter the actual number of hours necessary to complete the work.

7 In the grid, do the following:

a In theEmployee cell, enter the employee number.
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b In theEquipment cell, enter the equipment number of equipment used on the service call.

c In thePriority cell, enter the priority number reflecting the need for the employee.

d In theScheduled Date cell, enter the datewhen the employee is scheduled to begin.

e In theScheduled Start cell, enter the timewhen the employee is scheduled to begin.

f In theScheduled Finish cell, enter the timewhen the employee is scheduled to finish.

g In theScheduled Hours cell, enter the estimated number of hours necessary to complete the work.

h In theCompleted Date cell, enter the datewhen the work is completed.

i In theActual Start cell, enter the timewhen the actual work begins.

j In theActual Finish cell, enter the timewhen the actual work is completed.

k In theActual Hours cell, enter the actual number of hours necessary to complete the work.

l In theBilled Date cell, enter the datewhen you billed for the work.

8 Repeat step 7 for each employee, for each day worked.

TIP: ThePayroll Recordswindow uses service orders to create timecards. Sage 100 Contractor looks at the grid on
theDispatch tab for the date work is completed and the actual number of hours worked.

About shop notes and owner notes

You can compose notes for the technicians. The shop notes let you include specific instructions or other information on the
work order you provide the technician.

You can also compose notes for the client. The owner notes let you enter notes that you want to include on the printed
invoice.

Like notes elsewhere in Sage 100 Contractor, you can save notes with individual records, as well as with individual rows in
a grid.

Posting service routes

You can post a specific route or a range of routes. To post an invoice, the route recordmust contain at least one scheduled
date for service in theScheduled Date column on theDispatch tab. When a scheduled date is posted and invoiced, Sage
100 Contractor inserts the invoice date in theBilled Date cell.

NOTES:
l Note that when posting a route that has overridden billing amounts, Sage 100 Contractor adjusts theBilling

Amount by multiplying the billing amount from the route by the number of visits in the route posting criteria. If
there are no overrides of the billing amount but additional dollar markup amounts are applied, then those
amounts are alsomultiplied by the number of visits in the route posting criteria.

l When you select theVerify Completion check box, Sage 100 Contractor only posts routes that contain a date
in the Completed Date column on theDispatch tab.

To post a service route
1 Open 11-2 Work Orders/Invoices/Credits.

2 On thePostmenu, click [Service Routes].

3 In theDates text boxes, do the following:

a In the first text box, enter the date to start posting.

b In the second text box, enter the last date through which you want to post.
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4 In theRoutes text boxes, do the following:

a In the first text box, enter the first route.

b In the second text box, enter the last route in the range you want to post.

5 Click the [Post] button.

Posting service contracts

When you post service contracts, Sage 100 Contractor creates the invoices and assigns each invoice status 1-Open. To
post, the service contract must have a date in theNext Bill text box. Sage 100 Contractor advances the billing date based
on the selection in theCycle list.

To post a service contract:

1 Open 11-2 Work Orders/Invoices/Credits.

2 On thePostmenu, click [Service Contracts].

3 In theDates text boxes, do the following:

a In the first text box, enter the date from which you want to start posting.

b In the second text box, enter the last date through which you want to post.

4 Select one of the posting contract options:

a Always post contracts that have billing dates that are past their expiration date.

b Show the contracts that have billing dates past their expiration date so I can decide what to do.

c Never post contracts that have billing dates that are past their expiration date.

5 Click [Post].

Appointments

Assigning appointments to technicians
You can display basic information about the work order.
To display the properties of an appointment:
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment, then click Properties.
To adjust appointment duration
1 Open 11-2 Work Orders/Invoices/Credits.

2 On theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 In the column of the technician, drag the bottom of the appointment down to set the duration of the appointment.
To assign an appointment to a technician
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.
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3 Using the data control, select the day you want to view.

4 In theUnassigned column, find the work order.

5 Drag the work order to the time and employee that you want.

You can copy and paste appointments to other technicians.
To assign a work order to multiple employees
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment, and then select Copy.

5 In the column of the technician to whom you want to assign the work order, click the time, and then click Paste
Dispatch.

You canmove an appointment to a different day.
To reschedule an appointment
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment you want to move.

5 Click Move to.

6 In theCalendar, double-click the date to which you want to assign the appointment.

In theDispatch Board, you can remove a dispatch assigned to a technician. If the dispatch is the only one for a work
order, it moves to theUnassigned column.
To remove a dispatch assigned to a technician
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click on the work order in the technician's column and select Remove this Dispatch.

If no other technicians are assigned to this work order, the dispatchmoves to theUnassigned column.

If other technicians are also assigned to the work order, only the technician that you clicked on will be removed.
To create a new work order from the Dispatch Board
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 In the column of the technician to whom you want to assign the work order, drag your cursor to select the duration of the
appointment.

5 Click New Work Order.

6 Enter the work order.

7 On the Filemenu, click Save.
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TheDispatch Board not only displays work order appointments, but also includes any appointments you have entered in
the company calendar for technicians. You can also add in any other time off for the technician.
To assign time off in the Dispatch Board
1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 In the column of the technician, drag the pointer down to set the duration of the appointment.

5 Click Time off.

Assigning appointments to technicians

To assign an appointment to a technician:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 In theUnassigned column, find the work order.

5 Drag the work order to the time and employee that you want.

Assigning work orders to multiple employees

You can copy and paste appointments to other technicians.

To assign a work order to multiple employees:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment, and then select Copy.

5 In the column of the technician to whom you want to assign the work order, click the time, and then click Paste
Dispatch.

Displaying appointment properties

You can display basic information about the work order.

To display the properties of an appointment:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment, then click Properties.

Adjusting appointment duration

To adjust appointment duration:

1 Open 11-2 Work Orders/Invoices/Credits.

2 On theOptionsmenu, select Dispatch Board.
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3 Using the data control, select the day you want to view.

4 In the column of the technician, drag the bottom of the appointment down to set the duration of the appointment.

Rescheduling appointments

You canmove an appointment to a different day.

To reschedule an appointment:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment you want to move.

5 Click Move to.

6 In theCalendar, double-click the date to which you want to assign the appointment.

Removing a dispatch assigned to a specific technician

In theDispatch Board, you can remove a dispatch assigned to a technician. If the dispatch is the only one for a work
order, it moves to theUnassigned column.

To remove a dispatch assigned to a technician:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click on the work order in the technician's column and select Remove this Dispatch.

If no other technicians are assigned to this work order, the dispatchmoves to theUnassigned column.

If other technicians are also assigned to the work order, only the technician that you clicked on will be removed.

Creating new work orders from the Dispatch Board

To create a new work order from the Dispatch Board:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 In the column of the technician to whom you want to assign the work order, drag your cursor to select the duration of the
appointment.

5 Click New Work Order.

6 Enter the work order.

7 On the Filemenu, click Save.

Emailing work orders to technicians

There are several ways to email work orders to technicians.
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To email all technicians:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 In theDispatch Boardwindow, click Options, then click Email All Technicians and select one of the following options:

a Select [All Dispatches for the Day] to send all currently scheduled dispatches for each technician.

b Select [First Dispatch of the Day] to send just the first scheduled dispatch for each technician.

To email a single work order to a technician:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Right-click on the work order and select Email to Technician.

To email all daily work orders to a technician:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board

3 Left-click on the technician's name in the column header and select Email All.

NOTES:
l If you have chosen to email the technician the duration of the job, if the duration changes on the Dispatch Board

after emailing to a technician (and preference is set up to warn of changes), you will get a dialog box to update
the email to the technician. Also, if the dispatch is moved to a new time, date, deleted or unassigned, you will
also be notified to send an updated or cancellation email to the technician.

l Youmust make the changes to a dispatch on the Dispatch Board with a previously emailed dispatch to send
the technician an email about the updated dispatch. If youmake these changes in the work order, the dispatch
moves to the correct time or date, but no email is sent to the technician and no warning symbol is displayed.

l If the preference for warning is not selected, and information that was emailed changes, you'll see a warning
icon in the work order box.

TIP: Youmust set theWarn me when previously sent information becomes invalid check box in the Dispatch
Board, by going to Settings, then selecting Email Setup. How?

Assigning time off in the Dispatch Board

TheDispatch Board not only displays work order appointments, but also includes any appointments you have entered in
the company calendar for technicians. You can also add in any other time off for the technician.

To assign time off in the Dispatch Board:

1 Open 11-2 Work Orders/Invoices/Credits.

2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 In the column of the technician, drag the pointer down to set the duration of the appointment.

5 Click Time off.
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11-3 Dispatch Board
In the 11-3 Dispatch Boardwindow, you can view appointments in the calendar, view the travel time, view the properties
of a work order, add new employees to the employee list, set preferences, add email addresses to technicians in the
employee list, and configure the email setup information.

If you enter work orders in the 11-2 Work Orders/Invoices/Creditswindow without assigning technicians, theDispatch
Board displays those work orders in theUnassigned column. You can then assign the appointments to technicians by
moving them to the appropriate times and technicians, and Sage 100 Contractor adds that information to the records for
you.

Zoom In or Out

The zoom slider is by default set at 100%. If you have a lot of technicians scheduled for the day, you can zoom out by using
the slider and going to the left, or by clicking the [Ctrl] button and clicking the [-] button. The white area in the grid is the
regular working hours (start and finish times) set by selecting Preferences in the Settings menu.

NOTE: Note that grid lines will draw in the grid beyondmidnight, but that time is not available to schedule.

Viewing appointments in the schedule

You can view appointments in a 1 Day view or a 5 Days view.

1 Day view: In the 1 Day view, the time is shown in hour blocks. The amount of information displayed in the hour block, as
well as column size and width, are set by selecting Preferences in the Settings menu.

5 Days view:At a quick glance, you can see the availability of a technician for today and the next four days by clicking [5
Days]. To see one technician's schedule in an expanded view in the 5 Days view, click the double arrow icon centered
under the technician’s name. Clicking on it when the arrows point to the right expands the column and clicking on it when
the arrows point to the left collapses the column.
To adjust appointment duration
1 Open 11-3 Dispatch Board.

2 Using the data control, select the day you want to view.

3 In the column of the technician, drag the bottom of the appointment down to set the duration of the appointment.
To adjust travel time

In 11-3 Dispatch Board, you can add or edit the travel time for an appointment. Travel time appears as a light green block
above the appointment.

To adjust travel time, drag the top of the appointment up to set the travel time.

You canmove an appointment to a different day.
To reschedule an appointment
1 Open 11-3 Dispatch Board.

2 Using the data control, select the day you want to view.

3 Right-click the appointment you want to move.

4 Click Move to.

5 In theCalendar, double-click the date to which you want to assign the appointment.
To display the properties of an appointment
1 Open 11-3 Dispatch Board.
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2 From theOptionsmenu, select Dispatch Board.

3 Using the data control, select the day you want to view.

4 Right-click the appointment, then click Properties.

When you click Refresh on themenu bar, Sage 100 Contractor updates theDispatch Board to reflect all recent changes
made to appointments.
To refresh the Dispatch Board
1 Open 11-3 Dispatch Board.

2 On themenu bar, select Refresh.

Creating new work orders from the Dispatch Board
To create a new work order from the Dispatch Board:
1 Open 11-3 Dispatch Board.

2 Using the data control, select the day you want to view.

3 In the column of the technician to whom you want to assign the work order, drag your cursor to select the duration of the
appointment.

4 Click New Work Order.

5 Enter the work order.

6 On the Filemenu, click Save.

Setting up employees and vendors for the Dispatch Board
To display a list of service technicians (employees and subcontractors) in theDispatch tab, youmust set up the dispatch
list.
To set up a dispatch list
1 Open 11-3 Dispatch Board.

2 On theSettingsmenu, click Column Setup.

3 In theRecord Type cell, enterE for Employee orV for Vendor.

4 In theEmployee/Vendor cell, click to openDisplay lookup window, and then enter an employee number.

5 In theDisplay As cell, enter the name you want to appear.

6 In the Technician's Email Address cell, enter the email address for the technician.

7 On the Filemenu, click the [Save] button.

Configuring the Dispatch Board email settings
To set the field list options for each company

NOTE: The information sent in the email message will be based upon the field selections youmake here. Every email
sent for the Dispatch Board will use this list.

1 Select the fields you want to see displayed in the email messages.

a To add a field, click on the field name in theAvailable fields box and then click on the [Add] button.

b To remove a field, click on the field name in theShow these fields in this order box and then click the [Remove]
button.
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c To change the order of fields displayed, click on the field name and then click the [Move Up] or [Move Down] button.

2 (Optional) Select the checkbox for "Warnmewhen previously sent information becomes invalid" if you would like a
dialog box to pop up when previously emailed information changes in the Dispatch Board.

To set the email options
1 Open 11-3 Dispatch Board.

2 From theSettingsmenu, select Email Setup.

3 Click [Email Settings].

4 Select one of the following options for how you would like your emails to be sent:

a Select Send email using Microsoft Outlook to useOutlook to send your emails.

i Enter an email address.

b Select Send email using the company's default SMTP connection.

i Enter the email address.

ii Enter the password.

NOTE: Themail server is set up in the Email/Fax Configuration tab of 7-2 Company Information. How? If you have
not set up an email server, theMail Server field will be blank. If you have set up an email server, the IP address is
shown here, but is not editable.

c Select Send email using this alternate SMTP connection to configure the email server setup.

i Enter themail server information and select whether it Requires authentication and/or Uses SSL.

ii Enter the Port #.

iii Enter the email address.

iv (Optional) Enter the password.

5 Click [OK].

6 Verify that the Email from field has the correct email address.

7 Click [OK].

Emailing work orders to technicians
This feature is available only if you have purchased the Service Receivables Add-OnModule.

There are several ways to email work orders to technicians.
To email all technicians
1 Open 11-3 Dispatch Board.

2 In theDispatch Boardwindow, click Options, then click Email All Technicians and select one of the following options:

a Select [All Dispatches for the Day] to send all currently scheduled dispatches for each technician.

b Select [First Dispatch of the Day] to send just the first scheduled dispatch for each technician.
To email a single work order to a technician
1 Open 11-3 Dispatch Board.

2 Right-click on the work order and select Email to Technician.
To email all daily work orders to a technician
1 Open 11-3 Dispatch Board.

http://www.na.sage.com/sage-100-contractor/modules/service-management
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2 Left-click on the technician's name in the column header and select Email All.

NOTE:
l If you have chosen to email the technician the duration of the job, if the duration changes on the Dispatch Board

after emailing to a technician (and preference is set up to warn of changes), you will get a dialog box to update
the email to the technician. Also, if the dispatch is moved to a new time, date, deleted or unassigned, you will
also be notified to send an updated or cancellation email to the technician.

l Youmust make the changes to a dispatch on the Dispatch Board with a previously emailed dispatch to send
the technician an email about the updated dispatch. If youmake these changes in the work order, the dispatch
moves to the correct time or date, but no email is sent to the technician and no warning symbol is displayed.

l If the preference for warning is not selected, and information that was emailed changes, you'll see a warning
icon in the work order box.

TIP: Youmust set theWarn me when previously sent information becomes invalid checkbox in the
Dispatch Board, by going to Settings, then selecting Email Setup. How?

About prioritizing work orders and employees
You can assign a priority number to each work order and to each employee assigned to that work order. The priority lets a
dispatcher assess how important a work order is, or how important it is for an employee to go out on a particular job.

IMPORTANT: If the priority of the employee is different from the priority of the work order, theDispatch Board
displays the employee's priority.

Customizing the priority dropdown list
You can customize the 8 selections in the priority dropdown list in 11-2 Work Orders/Invoices/Credits to make it
applicable to your workflow. When you look at the appointment on theDispatch Board, its priority appears as a color in the
upper right corner.
Example #1: Priority by Service Level Agreement

For example, if you want to assign priority by service level agreement, you can do the following:

Priority Color

1-4 Hour Response Time Red

2-SameDay Response Orange

3-8 Hour Response Time Yellow

4-24 Hour Response Time Green

5-48 Hour Response Time Gray

Example #2: Priority by County

Priority Color

West County Red

North County Yellow

East County Green

South County Blue
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To customize the priority dropdown list
1 Open 11-2 Work Orders/Invoices/Credits.

2 Click theDispatch tab.

3 Click the up arrow to the right of the priority dropdown list.

4 In the Label and Prompt tab, do the following:

a Type a name for the Priority label in the User Description field. Use only letters or numbers, up to 19 characters,
spaces included.

b Type a prompt to help you identify what information the User Description field. This information displays in the status
bar.

5 In the Item Names and Colors tab, do the following:

a Type text in the fields to customize your section names.

b To change the color for the section name, click the lookup button to the right.

6 If you need to remove a section or insert a section, do the following:

a Click the [Advanced Options] link.

NOTE: Youmust be the Supervisor user to access the AdvancedOptions area.

b Delete the unneeded sections. If a section name is assigned to a record, you cannot delete that section.

c Click [OK].

The changes are reflected in the Section Name and dropdownmenu.

About the Dispatch Board

NOTE: If you open the 11-3 Dispatch Boardwindow, you have opened theDispatch Board in view-only mode. In
this window, you can view appointments in the calendar, view the travel time, view the properties of a work order, and
add new employees to the employee list. Because this window is view-only, some options are not available.

All Dispatch Board options are available through 11-2 Work Orders/Invoices/Credits by clickingDispatch Board in the
Optionsmenu, including setting preferences, adding email addresses to technicians in the Employee List, and configuring
the Email Setup information.

If you enter work orders in the 11-2 Work Orders/Invoices/Creditswindow without assigning technicians, theDispatch
Board displays those work orders in theUnassigned column. You can then assign the appointments to technicians by
moving them to the appropriate times and technicians, and Sage 100 Contractor adds that information to the records for
you.

Zoom In or Out

The zoom slider is by default set at 100%. If you have a lot of technicians scheduled for the day, you can zoom out by using
the slider and going to the left, or by clicking the [Ctrl] button and clicking the [-] button. The white area in the grid is the
regular working hours (start and finish times) set by selecting Preferences in the Settings menu.

NOTE: Note that grid lines will draw in the grid beyondmidnight, but that time is not available to schedule.

Viewing appointments in the schedule

You can view appointments in a 1 Day view or a 5 Days view.
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1 Day view: In the 1 Day view, the time is shown in hour blocks. The amount of information displayed in the hour block, as
well as column size and width, are set by selecting Preferences in the Settings menu.

5 Days view:At a quick glance, you can see the availability of a technician for today and the next four days by clicking [5
Days]. To see one technician's schedule in an expanded view in the 5 Days view, click the double arrow icon centered
under the technician’s name. Clicking on it when the arrows point to the right expands the column and clicking on it when
the arrows point to the left collapses the column.

Setting the Dispatch Board preferences
This feature is available only if you have purchased the Service Receivables Add-OnModule.

You can now select which pieces of information are displayed on the graphic that represents the work order on the Dispatch
Board. You can also set regular business hours so that non-standard work hours are grayed out, and have a dialog box warn
when previously emailed (sent) information is changed.

NOTES:
l Preferences are saved for the individual user.

l To restore the original system settings, click the [Restore] button, then click [Save].

To set up the preferences:
1 In the Dispatch Board, from theSettingsmenu, select Preferences.

2 In theGeneral tab, do the following:

a Click to enable or disable real-time dispatch board updates. If this option is enabled, the Dispatch Board automatically
updates with changes from other users in real-time to prevent overbooking.

NOTE: Real-time dispatch board updates are not available on a computer with a checked out license.

b Click to enable or disable warnings when schedule conflicts are created. If this option is enabled, the Dispatch Board
displays a warning every time a schedule conflict is created. If this option is disabled, no warning is displayed.

c Select the default appointment duration for new schedule items: 15minutes, 30minutes, 45minutes, 60minutes, 90
minutes, or 120minutes. The default appointment duration is 30minutes, when you right click in an empty space in the
Dispatch Board. Selecting a new time from the list changes the default appointment duration.

3 In theUnassigned Column tab, do the following: 

a Select how many unassigned items are included in the Unassigned column.

b Select which work items are also displayed in the Unassigned column, in addition toWork Orders.

NOTE: Work Orders are always included.

4 In theBoard Layout tab, do the following:

a Set the size of the one-hour time blocks by click and dragging on the resize handles.

NOTE: Adjusting the width of the time blocks also adjusts the width of the technician columns in the Dispatch Board.

b Set the regular business hours by selecting theBegin the day at andEnd the day at times using the drop-down
menu.

5 In theWork Order Display tab, select the fields you want to see displayed in work orders.

a To add a field, click on the field name in the Available fields box and then click on the [Add] button.

http://www.na.sage.com/sage-100-contractor/modules/service-management
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b To remove a field, click on the field name in the Show these fields in this order box and then click the [Remove] button.

c To change the order of fields displayed, click on the field name and then click the [Move Up] or [Move Down] button.

6 Click [Save].

Configuring the Dispatch Board email settings
This feature is available only if you have purchased the Service Receivables Add-OnModule.

To set the field list options for each company:

NOTE: The information sent in the email message will be based upon the field selections youmake here. Every email
sent for the Dispatch Board will use this list.

1 Select the fields you want to see displayed in the email messages.

a To add a field, click on the field name in theAvailable fields box and then click on the [Add] button.

b To remove a field, click on the field name in theShow these fields in this order box and then click the [Remove]
button.

c To change the order of fields displayed, click on the field name and then click the [Move Up] or [Move Down] button.

2 (Optional) Select the check box for "Warnmewhen previously sent information becomes invalid" if you would like a
dialog box to pop up when previously emailed information changes in the Dispatch Board.

To set the email options:
1 Open 11-3 Dispatch Board.

2 From theSettingsmenu, select Email Setup.

3 Click [Email Settings].

4 Select one of the following options for how you would like your emails to be sent:

a Select Send email using Microsoft Outlook to useOutlook to send your emails.

i Enter an email address.

b Select Send email using the company's default SMTP connection.

i Enter the email address.

ii Enter the password.

NOTE: Themail server is set up in the Email/Fax Configuration tab of 7-2 Company Information. How? If you have
not set up an email server, theMail Server field will be blank. If you have set up an email server, the IP address is
shown here, but is not editable.

c Select Send email using this alternate SMTP connection to configure the email server setup.

i Enter themail server information and select whether it Requires authentication and/or Uses SSL.

ii Enter the Port #.

iii Enter the email address.

iv (Optional) Enter the password.

5 Click [OK].

6 Verify that the Email from field has the correct email address.

7 Click [OK].

http://www.na.sage.com/sage-100-contractor/modules/service-management
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Setting up employees and vendors for the Dispatch Board
To display a list of service technicians (employees and subcontractors) in theDispatch tab, youmust set up the dispatch
list.

To set up a dispatch list:
1 Open 11-3 Dispatch Board.

2 On theSettingsmenu, click Column Setup.

3 In theRecord Type cell, enterE for Employee orV for Vendor.

4 In theEmployee/Vendor cell, click to openDisplay lookup window, and then enter an employee number.

5 In theDisplay As cell, enter the name you want to appear.

6 In the Technician's Email Address cell, enter the email address for the technician.

7 On the Filemenu, click the [Save] button.

About prioritizing work orders and employees
You can assign a priority number to each work order and to each employee assigned to that work order. The priority lets a
dispatcher assess how important a work order is, or how important it is for an employee to go out on a particular job.

IMPORTANT: If the priority of the employee is different from the priority of the work order, theDispatch Board
displays the employee's priority.

You can customize the 8 selections in the priority dropdown list in 11-2 Work Orders/Invoices/Credits to make it
applicable to your workflow. When you look at the appointment on theDispatch Board, its priority appears as a color in the
upper right corner.

Following are some examples of priorities and their corresponding colors.

Example 1: Default priority levels and colors

Priority Color

1-Emergency Red

2-Urgent Orange

3-Prompt Yellow

4-Low Green

5-Hold Gray

Example 2: Priority levels by service level agreement

Priority Color

1-4 Hour Response Time Red

2-SameDay Response Orange

3-8 Hour Response Time Yellow

4-24 Hour Response Time Green

5-48 Hour Response Time Gray
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Customizing the priority dropdown list
You can customize the 8 selections in the priority dropdown list in 11-2 Work Orders/Invoices/Credits to make it
applicable to your workflow. When you look at the appointment on theDispatch Board, its priority appears as a color in the
upper right corner.

Example #1: Priority by Service Level Agreement

For example, if you want to assign priority by service level agreement, you can do the following:

Priority Color

1-4 Hour Response Time Red

2-SameDay Response Orange

3-8 Hour Response Time Yellow

4-24 Hour Response Time Green

5-48 Hour Response Time Gray

Example #2: Priority by County

Priority Color

West County Red

North County Yellow

East County Green

South County Blue

To customize the priority dropdown list
1 Open 11-2 Work Orders/Invoices/Credits.

2 Click theDispatch tab.

3 Click the up arrow to the right of the priority dropdown list.

4 In the Label and Prompt tab, do the following:

a Type a name for the Priority label in the User Description field. Use only letters or numbers, up to 19 characters,
spaces included.

b Type a prompt to help you identify what information the User Description field. This information displays in the status
bar.

5 In the Item Names and Colors tab, do the following:

a Type text in the fields to customize your section names.

b To change the color for the section name, click the lookup button to the right.

6 If you need to remove a section or insert a section, do the following:

a Click the [Advanced Options] link.

NOTE: Youmust be the Supervisor user to access the AdvancedOptions area.

b Delete the unneeded sections. If a section name is assigned to a record, you cannot delete that section.
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c Click [OK].

The changes are reflected in the Section Name and dropdownmenu.

Adjusting travel time
In 11-3 Dispatch Board, you can add or edit the travel time for an appointment. Travel time appears as a light green block
above the appointment.

To adjust travel time, drag the top of the appointment up to set the travel time.

Refreshing the Dispatch Board
When you click Refresh on themenu bar, Sage 100 Contractor updates theDispatch Board to reflect all recent changes
made to appointments.

To refresh the Dispatch Board:
1 Open 11-3 Dispatch Board.

2 On themenu bar, select Refresh.

Overbooking and Partial Invoices Created from Work Orders
The Dispatch board now displays work orders which are assigned to the same technician at the same time on the same day
(overbookings). Additionally, partial invoices created from work orders which are assigned to a technician at the same time
on the same day will displayed on the Dispatch Board.
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Chapter 12: Inventory
Working with Inventory
This functionality is available only if you have the Inventory Add-OnModule.

You can track inventory, whether for a central warehouse or numerous locations and service trucks, with a system fully
integrated with the Estimating and Service Receivables add-onmodules and the purchase order, accounts payable, and job
cost features. You canmanage basic stock and serialized items for all locations, bin numbers, Material Safety Data
Numbers (MSDN), andmanufacturing identifications. Sage 100 Contractor Inventory also supports Last in-First-out (LIFO),
First in-First out (FIFO), or weighted average cost (WAC) accounting practices for inventory management.

Here aremore features found in Sage 100 Contractor Inventory:

l Restock trucks with automated restocking reports.

l Usematerial order reports to create purchase orders to vendors.

l Track inventory by location and serial number.

l Plan upcoming purchases using resource reports from service work orders.

12-1 Inventory Reports
See Appendix B for a complete list of 12-1 Inventory Reports.

Inventory Startup

About inventory
The Sage 100 Contractor inventory control system lets you keep track of your inventory flow, from the time of receipt to the
time of consumption. Inventory control helps track how much of a particular item you have in stock, where it is located,
what quantities are committed to jobs, and even how many to reorder when stock is low.

If you have a variety of places where you store inventory, you can create inventory locations. From themoment you receive
inventory, you can track where it is and who is responsible for it.

The value of your inventory is calculated using the inventory valuationmethod that you designate. Sage 100 Contractor
supports multiple methods including:

l Weighted Average Cost

l LIFO

l FIFO

NOTE: We recommend that you work with your tax accountant and/or advisor when determining which valuation to
use.

http://www.na.sage.com/sage-100-contractor/modules/service-management
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The inventory control system is integrated with the rest of Sage 100 Contractor. When you enter payable invoices, service
receivables credits, or purchase order receipts, Sage 100 Contractor moves the parts into inventory—even individually
serialized parts. In thePartswindow, you can select a part and view how much stock is on hand, how much is available,
and to which locations the stock has been assigned. When you create service invoices, Sage 100 Contractor automatically
removes the parts from inventory.

Additional activity that adds inventory includes:

l Voiding accounts payable credits.

l Entering service receivables credits.

l Voiding service receivables invoices.

l Additional activity that removes inventory includes:

l Entering accounts payable credits.

l Voiding accounts payable invoices.

l Voiding service receivables credits.

The 12-2 Inventory Allocationwindow provides an additional way to add and record inventory. You can enter any other
inventory-related transactions, record themovement of stock among locations, the consumption of stock by your company,
the loss of inventory, and the revaluation of stock.

Entering startup inventory
When you enter inventory into the system for the first time, post the balance to the general ledger using the account for
startup inventory. Later when you allocate your actual inventory parts, you use this inventory startup account on the grid
lines. This process transfers the balance to the regular inventory account in general ledger, leaving a zero balance in the
inventory startup account.

To enter startup inventory:
1 Set up the inventory accounts, valuationmethod, and offset account in 1-8 General Ledger Setup.

2 Set up the parts in 9-2 Parts.

3 Set up 12-3 Inventory Locations.

4 Post individual part inventory amounts in 12-2 Inventory Allocation by entering the part numbers, quantity of each part,
unit cost, serial number, and the startup inventory account number and the destination (location).

5 On the Filemenu, click Save.

About the inventory offset account
There are several unique situations that require posting to a special account in order to keep the inventory account balance
in agreement with the actual value of inventory in stock.

IMPORTANT: Youmust set up an offset account for your company in order to use the inventory functionality.

IMPORTANT: The offset account must fall in the overhead account range. At year-end, the account activity rolls up
with the other overhead accounts.

The offset account accumulates any differences recorded in the system when the item’s invoice price is compared to the
item’s value based on your accounting valuationmethod during the following actions:
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l Processing an accounts payable credit (negative quantity) in the 4-2 Payable Invoices/Creditswindow.

l Processing a purchase order receipt (negative quantity) in the 12-4 Purchase Order Receiptswindow.

l The inventory offset account accumulates dollar amounts that represent differences between the original cost of an
item and the item’s cost at the time of one of the following actions:

l Adjusting valuation through an inventory audit in the 12-5 Inventory Auditwindow.

l Adjustment inventory removal from a previous accounting year (period 0).

12-2 Inventory Allocation

About inventory allocation
Inventory moves into the control system through payable invoices, service receivables credits, inventory allocation, or
purchase order receipts. After the inventory is entered into the system, you can use the 12-2 Inventory Allocationwindow
to track movement among locations and to place stock on hold. You can also post transactions to the general ledger for the
consumption of stock items by your company, the loss or shrinkage of stock items, and the revaluation of stock.

The grid contains Source andDestination columns.

l Source specifies the location inventory was moved from

l Destination specifies the location inventory is moved to

The grid also contains anAccount column. If the transaction affects the general ledger, youmust enter the account
number.

On a single grid line, you can provide information in only two of these three columns and the type of transaction determines
which columns to use. For example, to move inventory to a different location, enter where the inventory is coming from in
theSource cell and where the inventory is moving to in theDestination cell. Or if you want to adjust the quantity for a
particular item for shrinkage, enter the quantity lost to shrinkage in theQuantity cell, the location of the quantity that was
lost in theSource cell, and then enter the overhead expense account in theAccount cell.

About inventory variance reconciliation
When inventory is removed, it can be sold or expensed to accounts including the job costs, equipment, and work in
progress (WIP) account ranges. When this occurs, the cost of the inventory is calculated using the weighted average cost
(WAC) in order to provide themost accuracy when job costing. If you use either the LIFO or FIFO valuationmethods, it has
accounting implications because your inventory general ledger account is reduced by LIFO or FIFO calculations and not by
WAC. As a result, a variance develops between the job costs, equipment andWIP accounts, and the inventory general
ledger account.

Job cost reconciliation is critical in construction accounting. Sage 100 Contractor audits the job and equipment costs and
general ledger values to ensure that they are equal. To do this, you use theReconcile command on theOptionsmenu in 6-
3 Job Costs.

Because LIFO and FIFO dictate that the values will not be equal, this process must now accommodate for variances
between the general ledger and the job and equipment costs that can be explained by the inventory variance. If the
difference between the general ledger and the job and equipment cost values is the variance, there is no discrepancy
between the accounts and the audit should not report those occurrences.

Additionally, two reports provide a way to track and verify the discrepancy among job costs, equipment, andWIP accounts
caused by the LIFO or FIFO inventory variance.
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l The 12-1-3-61 Inventory Variance report reconciles the job, equipment, andWIP costs with the general ledger
costs on individual transactions.

l The 2-3-61 General Ledger Cost Comparison report reconciles the total balance of job, equipment, andWIP
costs with the general ledger costs in a summary.

About inventory status
The status of an inventory record indicates where it is in the process.

Status Description

1-Open Indicates the inventory is available.

2-Review Indicates themanagement or bookkeeping staff
should review the record before shipping.

3-Hold Stock

Indicates inventory reserved for a job or work order.

When you assign an inventory record this status,
Sage 100 Contractor reduces the quantity of stock
that is available.

4-Shipped

Indicates that the inventory was sent to a job or
reserved for a work order.

When you assign an inventory record this status,
Sage 100 Contractor reduces the quantity of stock
that is available and the quantity of stock on hand.

Inventory Valuation
About inventory valuation methods

IMPORTANT: We recommend that you consult with your accountant and tax advisor before selecting an inventory
valuationmethod in Sage 100 Contractor.

Inventory valuationmethods handle the accounting aspects of an inventory account. Your inventory valuationmethod
determines the value of used inventory, which impacts the inventory general ledger account. The actual physical
movement of inventory is not dictated by your inventory valuationmethod selection. In other words, inventory parts can be
used in any order regardless of the valuationmethod used.

Sage 100 Contractor provides three different inventory valuationmethods:

l Weighted Average Cost (WAC)

l Last-in First-out (LIFO)

l First-in First-out (FIFO)

Setting up an inventory valuation method and offset account

In order to use the inventory functionality, youmust designate the inventory valuationmethod and set up an offset account
for your company.

CAUTION: After this selection has beenmade, you cannot change themethod unless there have been no inventory
transactions posted to the system.
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Youmust select your inventory valuationmethod before you can specify a part to be included in your inventory system in 9-
2 Parts.

IMPORTANT: The inventory valuation designation is made at the company level and can differ between companies
depending on your business needs.

IMPORTANT: We recommend that you consult with your accountant and tax advisor before selecting an inventory
valuationmethod in Sage 100 Contractor.

To set up an inventory valuation method and offset account:

1 Open 1-8 General Ledger Setup.

2 On the Inventory tab, select the valuationmethod that you want to designate for the company.

3 In theOffset Account text box, enter the general ledger account that you want to use for the offset account.

4 On the Filemenu, click Save.

Weighted Average Cost (WAC) valuation method

The weighted average cost (WAC)method assumes that when items are removed from inventory, the general ledger
inventory account is reduced by the average cost of all items existing in inventory. This generates an average cost of goods
sold, net income, and an average tax liability of the specific part being removed.

Last-in First-out (LIFO) valuation method

The last-in first-out (LIFO) valuationmethod assumes that when items are removed from inventory, the inventory account is
reduced by the cost of themost recently acquired item existing in inventory. Assuming that the costs to acquire inventory
are subject to inflation, a LIFO cost flow assumption results in higher cost of goods sold, lower net income, and thus a lower
tax liability.

First-in First-out (FIFO) valuation method

The first-in first-out (FIFO)method assumes that when items are removed from inventory, the inventory account is reduced
by the cost of the first item acquired in inventory. This methodmore closely mirrors the actual physical inventory process.
Assuming that the costs to acquire inventory are subject to inflation, a FIFO cost flow assumption results in lower cost of
goods sold, higher net income, and thus a higher tax liability.

Placing stock on hold

After entering a work order, you can reserve the stock for that job. Placing stock on hold reduces the quantity available, but
does not reduce the quantity on hand.

You can also reserve stock when none is available. When you enter stock into inventory, Sage 100 Contractor adjusts the
quantity of stock available.

To place stock on hold:

1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the tag or ticket numbers and letters.

3 In the Job text box, enter the job number.

4 If the job uses phases, enter the phase number in thePhase text box.

5 In theOrder Number text box, enter the order number.

6 In theDate text box, enter the date of the transfer.

7 In theStatus list, click 3-Hold Stock.
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8 In theDescription text box, enter a brief statement about the transaction.

9 In the grid, do the following:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theCost cell, enter the cost of the part.

d In theSource cell, enter the location where the part is coming from.

e In theAccount cell, enter the location where the part is going.

10 Repeat step 9 for each item you want to place on hold.

11 On the Filemenu, click Save.

NOTE: When ready to use the stock you have reserved, change the status of the inventory record from 3-On Hold to
4-Shipped.

Verifying stock availability

IMPORTANT: Selecting this command in the 11-2 Work Orders/Invoices/Creditswindow does not verify stock for
status 7-Work Order.

When you select theVerify Stock on Save command, Sage 100 Contractor makes certain that you have enough stock in
the specified inventory location. If there is not enough stock available, Sage 100 Contractor warns you.

To activate the verify stock on save feature, on theOptionsmenu, click Verify Stock on Save.

Inventory Allocation Records
Entering records for internal consumption

Suppose you repair a broken toilet handle in your office and to do it you pull the handle from your parts stock. The inventory
was consumed by and for the company itself, not for another job or contract. The transaction records the consumption of
inventory as an overhead expense.

To enter a record for internal consumption:

1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the ticket number.

3 In theDate text box, enter the date of the transfer.

4 In theStatus list, click the record status.

5 In theDescription text box, enter a brief statement about the transaction.

6 In the grid, do the following:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theSource cell, enter the location where the part is coming from.

d In theAccount cell, enter the overhead expense account number.

e In theSubaccount cell, enter the subsidiary account you want.

7 Repeat step 6 for each item.
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8 On the Filemenu, click Save.

TIP: You can verify the availability of stock when you save an inventory record.

Entering records for inventory shrinkage

Over time inventory can be lost, misplaced, or used without any records having beenmade. After a physical inventory
count, determine how much inventory has been lost to shrinkage. Tomaintain an accurate count in the inventory system,
enter an adjustment to the quantity on hand for the affected items.

To enter a record for inventory shrinkage:

1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the tag or ticket number/letters.

3 In theDate text box, enter the date of the transfer.

4 In theStatus list, click the record status.

5 In theDescription text box, enter a brief statement about the transaction.

6 In the grid, do the following:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theCost cell, enter the cost of the part.

d In theSource cell, enter the location where the part is coming from.

e In theAccount cell, enter the overhead expense account number.

f In theSubaccount cell, enter the subsidiary account you want.

7 Repeat step 6 for each item.

8 On the Filemenu, click Save.

Entering records for inventory sold to customers

Some companies sell stock items directly to clients. The stock does not relate to a service call, route, or contract. Entering
the sale in 11-2 Work Orders/Invoices/Credits not only creates an invoice but also records themovement of stock.

If you enter the sale on an accounts receivable invoice, however, Sage 100 Contractor cannot record themovement in 12-2
Inventory Allocation. A separate transaction is necessary.

To enter a record for inventory sold to a customer:

1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the tag or ticket number.

3 In theDate text box, enter the date of the transfer.

4 In theStatus list, click the record status.

5 In theDescription text box, enter a brief statement about the transaction.

6 In the grid, do the following:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theSource cell, enter the location where the part is coming from.
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d In theAccount cell, enter the cost of goods account number.

e In theSubaccount cell, enter the subsidiary account you want.

7 Repeat step 6 for each item.

8 On the Filemenu, click Save.

Entering records for inventory used on contracts

When you use inventory on a contract, you can enter a transaction to record its consumption.

To enter a record for inventory used on a contract:

1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the tag or ticket number.

3 In the Job text box, enter the job number.

4 If the job uses phases, enter the phase number in thePhase text box.

5 In theOrder# text box, enter the order number.

6 In theDate text box, enter the date of the transfer.

7 In theStatus list, click the record status.

8 In theDescription text box, enter a brief statement about the transaction.

9 In the grid, do the following:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theSource cell, enter the location where the part is coming from.

d In theAccount cell, enter the job expense account number.

e In theSubaccount cell, enter the subsidiary account you want.

10 Repeat step 9 for each item.

11 On the Filemenu, click Save.

TIP: You can verify the availability of stock when you save an inventory record.

Entering records to re-value existing inventory

There are several reasons why you re-value stock. Items lose value over time, are damaged, or need to be re-valued due to
an incorrect entry.

You can re-value the entire quantity of a stock item by entering two lines in a single inventory transaction. In the first line,
enter the source location of the stock items, the current average cost, and the overhead revaluation account. This removes
the items from inventory at the current cost. Then in the second line, enter the new cost of the stock items, the same
overhead revaluation account, and the destination location. This moves the items back into inventory at the re-valued cost.
The balance remaining in the overhead revaluation account is the difference in value.

Re-valuing a damaged item is similar to the steps outlined above. Suppose you find that you have a water heater with
cosmetic damage. Because a client will not pay full price for it, you need to re-value it. Create a part for a damaged water
heater in thePartswindow. Then in the Inventory Allocationwindow, make the adjusting entry. In the first line, enter the
source location of the water heater, its cost, and the overhead revaluation account. Then in the second line, enter the new
part for damaged water heaters, its adjusted cost, the same overhead revaluation account, and the destination location for
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the re-valued stock items. The transaction leaves the average cost for undamaged items unchanged, and sets the new
value for the damaged item.

To enter a record to re-value existing inventory:

1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the tag or ticket number/letters.

3 In theDate text box, enter the date of the transfer.

4 In theStatus list, click the record status.

5 In theDescription text box, enter a brief statement about the transaction.

6 Enter the original item in the grid:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theCost cell, enter the cost of the part.

d In theSource cell, enter the location where the part is coming from.

e In theAccount cell, enter the overhead revaluation account number.

f In theSubaccount cell, if applicable, enter the appropriate subsidiary account.

7 Repeat step 6 for each item you want to re-value.

8 On the Filemenu, click Save.

12-3 Inventory Locations

Setting up inventory locations
If you have a variety of places where you store inventory, you can create inventory locations. From themoment you receive
inventory, you can track where it is and who is responsible for it.

To set up inventory locations:
1 Open 12-3 Inventory Locations.

2 In the Inv. Location# cell, enter the location number.

3 In the Location Name, enter the location name.

4 In theEmployee cell, enter the employee number of the employee assigned to this location.

5 Repeat steps 2–4 for each location.

6 On the Filemenu, click Save.

NOTE: Becausemany companies assign employees to specific service trucks, you can include the employee
number with the inventory location.

TIP: You can verify the availability of stock when you save a record.

Moving inventory among locations
Companies that have a number of different locations frequently move inventory among them. Moving inventory among
locations does not affect the accounting.
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To record inventory transferred to a new location:
1 Open 12-2 Inventory Allocation.

2 In the Ticket# text box, enter the tag or ticket number.

3 In theDate text box, enter the date of the transfer.

4 In theStatus list, click the record status.

5 In theDescription text box, enter a brief statement about the transaction.

6 In the grid, do the following:

a In thePart cell, enter the part number.

b In theQuantity cell, enter the quantity of parts.

c In theCost cell, enter the cost of the part.

d In theSource cell, enter the location where the part is coming from.

e In theDestination cell, enter the location where the part is going.

7 Repeat step 6 for each item.

8 On the Filemenu, click Save.

You can verify the availability of stockwhen you save a
record.

12-4 Purchase Order Receipts

About purchase order receipts
Vendors often shipmaterials and send an invoice later. In 12-4 Purchase Order Receipts, you can immediately enter
materials and serialized parts, and distribute them to various inventory locations or jobs while waiting for the invoice to
arrive.

The 12-4 Purchase Order Receiptswindow only allows you to enter the quantity of parts, and serial numbers for serialized
parts. On saving the record, Sage 100 Contractor creates a payable invoice (with status 2-Review or 3-Dispute) and posts
it to the general ledger using the accounts indicated on the purchase order.

If the purchase order references a job number, Sage 100 Contractor creates job cost records for thematerials.

If thematerials are for inventory, Sage 100 Contractor assigns thematerials to the inventory location indicated on the
purchase order.

Sales taxes post to the ledger account indicated in thePurchase Order Sales Tax Expense text box on thePayables tab
of the 1-8 General Ledger Setupwindow.

After receiving the invoice, you can recall the payable invoice record and enter any changes due to freight charges or cost
variances.

Entering the receipt of materials
To enter the receipt of materials:
1 Open 12-4 Purchase Order Receipts.

2 In theOrder# text box, enter the purchase order number.
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3 In theShipping# text box, enter the shipping order number provided by the vendor.

4 In theDescription text box, enter a brief statement about the order.

5 In theStatus list, click the status you want to assign the invoice created from this record.

IMPORTANT: The status must be either 2-Review or 3-Dispute.

6 In the grid, do the following:

a In theQuantity cell, enter the quantity of each part received.

b If you receive serialized parts, enter the individual serial number for each item in theSerial# cell.

IMPORTANT: You can only enter the quantity of parts and serial numbers for serialized parts. You cannot add or
delete parts.

7 Repeat step 6 for each item received.

8 On the Filemenu, click Save.

12-5 Inventory Audit

About auditing inventory
The inventory audit performs several checks to verify the following:

l The inventory general ledger account balances with all journal transactions.

l All inventory part quantities are correct.

l The inventory general ledger account balances with the valuation of all parts in inventory.

This audit can be performed at any time and verifies that all parts in inventory and all ledger transactions are valid, helping
youmaintain solid accounting practices.

If the audit does not detect any errors, themessageAudit Completed! appears. If errors are detected, you can view and
print the Inventory Audit Report.

If the audit detects discrepancies between the inventory general ledger account and the total valuation of all parts, a
message appears giving you the option of having Sage 100 Contractor write an automatic journal entry adjustment. The
adjustments aremade to both the general ledger and inventory offset accounts.

Auditing inventory
To audit inventory:
1 Open 12-5 Inventory Audit.

2 Click Audit.

When the audit is complete, print out any applicable Inventory Audit reports. If the audit finds discrepancies between the
general ledger account balances and inventory valuation, you can have the system write an automatic journal entry
adjustment.
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Chapter 13: Review and Reporting
Working with Review and Reporting
Sage 100 Contractor provides over 1200 reports providing you with many ways to understand your business and to
communicate with your clients. Standard reports include selection criteria that allow you to save your personal defaults for
repeated use. For quick access to reports that you use often, you can drag them to theSage 100 Contractor Desktop to
create an icon.

You can drill down into special Dashboard reports and from there to the record source. This featuremakes getting to the
source of financial data just onemouse-click away.

You can also drill down into the 1200 program-wide reports by running a report in print preview, which is available via Print
preview and Drilldown (when available) thePrint preview and Drilldown (when available) button. With your cursor
appearing as amagnifying glass with a red lens, double-clicking rows or fields drills down to report details and records.

Many sections of Sage 100 Contractor havemenu links to reports. For example, in 3-Accounts Receivable you find 3-1
Receivable Reports and 3-1-1 Receivable List reports. On theReport Criteria tab in the 3-1-1 Report Printingwindow,
you see a list of 17 reports. With a report selected, you can then click theSamples tab to view a sample of that report.

You can use 13-3 Report Writer to create your own reports. As a starting point, you canmodify many of the standard
reports to fit your own needs.

From any window with report scheduling functionality, you can schedule the automatic delivery of reports to customers,
subcontractors, and suppliers via fax and email.

Using the tools in 13-5 Form/Report Page Design, you can customize the reports to your company’s design
requirements. You can change the look of any document to fit your needs so that you will not have to purchase expensive,
pre-printed forms.

For a list of all the Sage 100 Contractor reports, see Appendix B, Sage 100 Contractor Reports, see Appendix B: Sage 100
Contractor Reports.

Review and Reporting Reports

Appendix B—List of review and reporting reports
Link to all the review and reporting reports.

Selecting and Creating Reports
Sage 100 Contractor provides over 1200 reports providing you with many ways to understand your business and to
communicate with your clients. Standard reports include selection criteria that allow you to save your personal defaults for
repeated use. For quick access to reports that you use often, you can drag them to theSage 100 Contractor Desktop to
create an icon.

You can drill down into special Dashboard reports and from there to the record source. This featuremakes getting to the
source of financial data just onemouse-click away.
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You can also drill down into the 1200 program-wide reports by running a report in print preview, which is available via Print
preview and Drilldown (when available) thePrint preview and Drilldown (when available) button. With your cursor
appearing as amagnifying glass with a red lens, double-clicking rows or fields drills down to report details and records.

Notes about reports
o When viewing a report, if there is nomagnifying glass cursor on that page, then there are no drillable rows or fields on

that page. For example, the first page of a report may contain design elements and no data, which are not drillable.
The second pagemay contain drillable data.

o If your cursor becomes an hourglass when closing a report, be aware that long reports containing a hundred or more
pages may take a few seconds to close. 

o Running large reports may take several minutes. You can disable drilling down from any Report Printingwindow
for that instance by choosingOptions > Disable print preview drill down to speed up running the report.

To drill down into report information
1 Open a record window (3-5 Jobs (Accounts Receivable), and select a record (for example, 186).

2 Click thePrint records button.

3 Select a report, and click thePrint preview and Drilldown (when available) button.

4 The report appears in “print preview”mode.

Examples of Drilling Down into Report Information
In the following examples, Sage 100 Contractor is running the Sample Company, menu 3-1-3 Receivable Aging, and the
31-Current Job Aging report. The report was run without selection criteria.
Drilling down into rows

A single click on the information reveals whether you are drilling to information contained in a row (notice the arrows at each
end of the row) or an individual field. In this case, the first line contains a drillable row in addition to two drillable fields, Job#
andCurrent Retention.

Job# Description Current + Retention

186 Williams Post Office 149,696.25

201 TrappenMotel 156,053.48

207 Wood Elementary School

Double-clicking the row drills down to the job record 186—Williams Post Office in the 3-5 Jobs (Accounts Receivable)
window.
Drilling down into fields

Drillable information contained in a single field is depicted differently. In a drillable field, you see arrows at each end of the
field.Double-clicking the field opens a grid window that shows the details of the value, as shown in the 31—Job Current
Aging~Current + Retentionwindow.

Notice that the grid window displays the value in addition to the values that have been added together to create the drillable
field value. At the bottom left corner of the grid window is aDrill Down button. By selecting a grid cell in theA/R Invoices
Balance column (9,569.34) and clickingDrill Down, you can drill to the invoice.

From that invoice, you can continue to drill down to information through other reports. In addition, the status bar below the
grid displays the selection criteria of the cell when the query selection criteria contains a “Where” clause.
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This information can help you understand why certain information is in a grid and (equally as important) why certain
information is not in the grid. For example, if you are expecting to see an important invoice on a grid but it’s not showing up,
the information in the status bar can show information revealing that the invoice has incorrect status. This allows you to
locate the invoice and correct its status.

Basic Rules for Drilling Down into Reports

NOTE: We recommend that you try drilling down into your own business’s reports. Hands-on practice with familiar
reports is the best way to understand how drilling down into reports actually works.

o To be drillable, a row or field must have a “non-zero” value.

o Only fields that are located within a detail section of a report may be drillable. Fields on the form design portion of the
report are not drillable. Headings, totals, and no print fields are not drillable.

o Screen review of grid printing is not drillable.

o To be drillable, fields must be placed in a “Group,” “Detail,” or “Subtotal” row type.

About report selection criteria
You can use the selection criteria to limit the scope of documents; however, many reports do not require you to use
selection criteria. If a criterion is left blank, Sage 100 Contractor does not use the criterion when creating the document.

Specific criteria is required to print checks. Youmust provide the first check form number, check date, and ledger account
number of the checking account.

If a document does not include information that you were expecting, examine the selection criteria. If all the criteria are
correct, the scope of the criteria might be too narrow. Try removing some of the criteria.

GAAP-standard reports
Sage 100 Contractor provides several reports to reflect generally accepted accounting principles, or GAAP. These reports
include the following:

l 2-2-0-21 Balance Sheet

l 2-2-0-31 Balance Sheet~This Year/Last Year Comparison

l 2-3-0-21 Income Statement

l 2-3-0-31 Income Statement~Period and YTD

l 2-3-0-32 Income Statement~This Year/Last Year Comparison

l 2-3-0-33 Income Statement~Actual/Budget Comparison

l 2-3-0-41 Dept. Income Statement

l 2-3-0-51 Dept. Income Statement~Period/Year

l 2-3-0-53 Dept. Income Statement~Actual/Budget Comparison

l 2-3-0-71 Income Summary~With Subaccount Detail Period and YTD

l 2-8-0-21 Financial Report

l 2-9-0-21 Statement of Cash Flows
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Viewing reports
You can view a list of reports in three ways:
To view a list of available reports

NOTE: You can view the list of available reports for a particular function or print window from theReport Printing
window. Some reports are editable; if so, aModify Report button appears.

1 Open a Sage 100 Contractor window, for example 3-2 Receivable Invoices/Credits.

2 Select the record you want to view in the data control.

3 In the toolbar, click thePrint Records button.

4 In theReport Printingwindow, click theReport Criteria tab.

5 Double-click the report you want to view or print.
To view a list of all reports by menu command

NOTE: You can only edit a calculated field on an existing report containing an existing calculated field.

1 Open 13-6 Report/Query Lists.

2 The 13-6 Report/Query Listswindow opens.

3 If not already selected, select 21-Report List~by Menu.

4 On the tool bar, click Print preview and Drilldown (when available) to view the report.

5 Alternatively, select other printing and export options.
To view the list of all reports by menu option

NOTE: You can only edit a calculated field on an existing report containing an existing calculated field.

1 Open 13-6 Report/Query Lists.

2 The 13-6 Report/Query Listswindow opens.

3 If not already selected, select 26-Report List~by Menu Option.

4 On the tool bar, click Print preview and Drilldown (when available) to view the report.

5 Alternatively, select other printing and export options.

Viewing sample reports
Sage 100 Contractor provides representative samples of most reports that the system produces. These samples are not
generated from the sample data but are images for you to view. By viewing sample reports, you can get an idea of the
report’s content without having to actually generate the report.
To view a sample report
1 Open a Sage 100 Contractor window, for example 4-2 Payable Invoices/Credits.

2 On the toolbar, click thePrint Records button.

3 In theReport Printingwindow, click theSamples tab.

4 In the reports list, click a report.

5 The sample appears in the right pane.

NOTE: Not all reports have a sample. If there is no sample, amessage appears: There is no example available for
.
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Working with Quick Reports
Sage 100 Contractor’s Quick Reports feature lets you create simple reports for review. When you view aQuick Report,
Sage 100 Contractor displays the report information in a grid.

For example, here are some of the windows in which you can create Quick Reports:

l 1-9 Departments

l 6-5 Cost Codes

l 7-3-1 Security Groups

l 7-3-2 User List

l 9-8 Board Footage

l 10-2 Task List

l 12-3 Inventory Locations

You can change the font styles in individual cells or for the entire grid. In addition, you can hide columns of information.
When you print the report, any information hidden in theQuick Reportwindow will not appear on the printed report.

Although you can change the formatting of a Quick Report, the changes are not saved. They are only used for printing a
Quick Report. For example, open 6-5 Cost Codes, and using theB, I, andU buttons located under themenu bar, apply
bold, italic, or underline formatting to the contents of cells.

You can hide the columns by right-clicking the column heading and selecting theHide Selected Column command from
the drop-downmenu. Then click thePrint Records button. When theGrid Printingwindow opens, click thePrint
preview and Drilldown (when available) button to view a preview of your changes.

In some cases, a grid may display toomany columns for the report to fit on a standard-sized piece of paper even in
landscape orientation. In such cases, we recommend that you export the quick report to Microsoft Excel, which has the
capability to capture all the data on any grid in Sage 100 Contractor.

Setting up a shortcut from a report printing window
To create a shortcut to a specific report:
1 Open any Report Printingwindow.

2 Click theReport Criteria tab.

3 Select a report.

4 In the lower left of the window, click Create a Shortcut to Selected Report.

13-1 Financial Review
At times, financial information is easier to understand when presented in the form of a chart. Sage 100 Contractor can
generate charts for you from data in the ledger accounts of the active company. You can then use the charts to review and
analyze trends in your company.

You can generate charts on financial data from the current fiscal year, or as a comparison between the current and last
fiscal year, for 12 rollingmonths, or as a comparison between the budgeted costs and actual costs. In addition, you can
create line, area, 2-dimensional bar charts, and 3-dimensional bar charts.

After generating a chart, you can print it, save it to file, or copy it to the clipboard so that you can paste the chart in another
report or document.
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NOTE: On 13-1 Financial Review, when viewing charts, be aware thatMean, Standard Deviation, andBest Fit do
not display with bar charts. The statistical methods display as expected only with line and area charts. When working
with these statistical methods, select Format > Line orArea, and then select Statistics > Mean, Standard
Deviation, or Best Fit.

Financial review—Ratios
Sage 100 Contractor uses the ledger account balances to create the ratio for a fiscal period. Use the ratios to identify long
term trends or potential problems.

NOTE: The list uses standardmath symbols, plus (+), minus (–), multiplied by (*), and divided by (/).

The following list provides definitions of menu items under 13-1 Financial Review > Ratio:

l Current Ratio—Measures the relationship between the current assets and current liabilities.
Definition of Current Ratio: Current Assets/Current Liabilities by fiscal period.

l Quick Ratio—Measures the relationship of liquid assets to current liabilities, indicating the short-term debt paying
ability.
Definition of Quick Ratio: (Current Assets – Inventory)/Current Liabilities by fiscal period.

l Gross Profit/Sales—Measures the relationship between gross profit and sales dollars.
Definition of Gross Profit/Sales: (Gross Profit + Other Income)/(Total Operating Income +Other Income) by fiscal
period)

l Net Profit/Sales - Measures the relationship between net profit and sales dollars.
Definition of Net Profit/Sales: Net Income Before Tax/ (Total Operating Income + Other Income) by fiscal period.

l Net Profit/Equity—Measures the amount of income earned for each dollar invested.
Definition of Net Profit: (Operating Income + Other Income) – (Direct Expense + Equip/Shop Expense + Overhead
Expense + Admin Expense).
Definition of Equity: (Equity + Operating Income + Other Income) – (Direct Expense + Equip/Shop Expense +
Overhead Expense + Admin Expense). Note: The Equity amount excludes Owner’s Draw accounts.

l Current Assets/Total Assets—Measures the relationship between the short-term assets and long-term assets.
Definition of Current Assets: Cash + Current Assets + WIP.
Definition of Total Assets: Cash + Current Assets + Wip + Other Assets + Fixed Assets – Accum.Depreciation.

l Return on Assets—Measures the earning power or the profitability of a company’s assets.
Definition of Return on Assets: Total Income—Direct + Shop/Equip + Overhead + Admin Expense / Cash +
Current Assets + Wip—Accum. Depreciation.

l Debt/Worth - Measures the relationship of debt financing to equity financing, or how much a company is leveraged.
Definition of Debt: Total liabilities.
Definition ofWorth: Equity + Total Income—(Direct + Shop/Equip + Overhead + Admin Expense).

l Debt/Assets—Measures the percentage of total assets represented by liabilities.
Definition of Debt: Total liabilities.
Definition of Assets: Cash + Current Assets + Wip + Other Assets + Fixed Assets—Accum. Depreciation.

l Overhead/Direct Expense—Measures the relationship of overhead expenses to job expenses. Total Indirect
Expense/Total Direct Expense.
Definition of Indirect Expense: Overhead + Administrative Expenses.
Definition of Direct Expense: Direct +Equipment + Shop Expenses

Financial Review—Trends
Sage 100 Contractor uses the ledger account balances to graph financial trends.
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NOTE: The list uses standardmath symbols, plus (+), minus (–), multiplied by (*), and divided by (/).

The following list provides definitions of menu items under 13-1 Financial Review > Trends:

l Cash—Charts the balances for all accounts in the cash range by fiscal period.
Compares to the 2-4-21 General Ledger report by cash account range and period.

l A/R—Charts the Accounts Receivable balance by fiscal period.
Compares to the dedicated Accounts Receivable account in 1-7 General Ledger Accounts.

l A/P—Charts the Trade Accounts Payable balance by fiscal period.
Compares to the dedicated Accounts Payable account in 1-7 General Ledger Accounts.

l Sales—Charts the total income.
Compare to the Income Statement by period for the Operating Income balance + Other Income balance.
Budget numbers by period: compare tomenu 1-7 General Ledger Accounts income accounts budgets.

l Gross Profit—Charts the Gross Profit + Other Income by fiscal period.
Compare to the Gross Profit + Other Income from Income Statement by period.
Definition of Gross Profit:Operating Income – (Direct Expense + Equip/Shop Expense).

l Net Profit—Charts the Net Income before Tax by fiscal period.
Compare to the Net Income Before Tax on the Income Statement by period.
Definition of Net Income: Operating Income + Other Income –Direct & Indirect Expenses.

l Breakeven Point—Charts all Expenses by fiscal period.
Compare to the Total Direct & Equip/Shop Expenses + Total Indirect Expenses on the Income Statement by period.

l Working Capital—Charts Current Assets – Current Liabilities by fiscal period. This trend is often used to secure a
line of credit.
Compare to the Balance Sheet by fiscal period.
Budget comes from all current assets and liabilities accounts in menu 1-7 General Ledger Accounts.

Financial Review—Statistics
When generating charts, you can use one of the statistical methods provided:

l Mean: Calculation derived from the sum of a list of numbers divided by the total number of numbers in a list.

l Standard Deviation: Calculation indicating how spread out numbers are from themean.

l Best Fit: Calculation showing a trend line indicated by the values in a series.

NOTE: On 13-1 Financial Review, when viewing charts, be aware thatMean, Standard Deviation, andBest Fit do
not display with bar charts. The statistical methods display as expected only with line and area charts. When working
with these statistical methods, select Format > Line orArea, and then select Statistics > Mean, Standard
Deviation, or Best Fit.

13-2 Project Review
At times, project information is easier to understand when presented in the form of a chart. Sage 100 Contractor can
generate charts for you from several sources. You can then use the charts to review and analyze trends in your company.
You can create several different types of graphs, such as line, area, 2-dimensional bar charts, and 3-dimensional bar
charts. After generating a chart, you can print it, save it to file, or copy it to the clipboard so that you can paste the chart in
another report or document.

Using theGraph option in 13-2 Project Review, you can generate graphs to analyze the following:
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l Cost/Budget by Type
Budget = Job budget + approved budget change orders by cost type.
Cost = Job costs by cost type. (Note that you use the job cost journal by cost type).

l Cost/Budget by Code displays job budget + approved budget change orders by cost code.
Budget = Job budget plus approved budget change orders by cost code.
Cost = Job costs by cost code (Note that you use the job cost journal by cost code).

l Over/Under by Code
Over = Over budget amount by code with positive number above zero.
Under = Under budget amount by code with negative number below zero.

l Gross Profit % by Job displays (A/R invoices – job costs) / A/R invoices.

l Gross Profit $ by Job displays A/R invoices – job costs.

l Cash Flow displays A/R invoices – job costs by week. (Note that one week = 7 days).

13-3 Report Writer
13-3 Report Writer provides tools that allow you to create custom reports to access information stored in the Sage 100
Contractor databases. With 13-3 Report Writer, you canmodify existing reports or create entirely new reports for your
company’s needs.

Before creating a report, you need to understand how 13-3 Report Writer and 13-5 Form/Report Page Designwork
together. In 13-5 Form/Report Page Design, you create the page layout for a single page form or amulti-page form that
includes text, fields, and calculated fields. Most form designs also have a detail box, which indicates to Sage 100
Contractor where the details of the report will be placed.

In 13-3 Report Writer, you create the body of the report that appears in the detail box of the form design. In the design of
the report details, you can include text, fields, and calculated fields. In addition, you can control when the report prints on a
new page or an entirely new form.

13-3 Report Writer allows you to associate a specific form design with a report. When you select the report for printing,
Sage 100 Contractor automatically selects the associated form design. In addition, you can determine the location of the
report in Sage 100 Contractor. You can assign custom reports to 13-4 Report Printing, or to another window that contains
reports similar to the custom report.

You can create new reports from scratch, or you can use existing reports as the basis for new reports. When you display a
Sage 100 Contractor report, Sage 100 Contractor copies the report and displays the copy in the 13-3 Report Writer
window. You can then edit, rename, and save the new report.

Creating new reports
Note that sometimes it is quicker to create a new report by editing an existing report if you only have tomake a few changes
or additions.

To create a new report:
1 Open 13-3 Report Writer.

2 On the New Report Launch window, select eitherCreate a new report using the Wizard orStart with a blank report
and click OK.

Modifying existing reports to create new reports
To locate the report you want to open, you need to know the name of the report. The file name is a combination of:
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l Themenu option where the report is located

l The number of the report.

These two items are combined to form an eight-character file name, for example, 04010221.rpf, is the report that
corresponds to 4-1-2 Payable Invoice, report 21.
To modify an existing report to create a new report
1 Locate the report, and remember its name.

2 Open 13-3 Report Writer.

3 From the New Report Launch wizard, select Browse for an existing report..., and click the [Display System
Reports] button.

NOTE: Alternatively, you can open the report that you want to modify by locating the report on a Report
Printing window, selecting it, and then clickingModify Report button.

4 From the list, locate and double-click the report you want to open, for example, 04010221.rpf.

5 Type a new report title in theReport Title text field.

6 Select a report form for theReport Form text field.

7 Tomodify the grouping and sorting of field, select Edit > Grouping/Sorting....

8 On theDefine Grouping and Sortingwindow, choose a table, double-click items in the Fields list to move them to the
bottom panel.

In the bottom panel, you can do the following:

a Remove groups by right-clicking a group field

b Reorder groups by dragging them into the desired order

c Change sorting by clicking on columns in themain row of the panel

9 Click OK.

10 Tomodify the selection criteria, select Edit > Selection Criteria... .

a On theDefine the Selection Criteriawindow, choose a table, double-click items in the Fields list to move them to
the bottom panel.

b In the bottom panel, you can choose to enter default criteria, or you can leave the criteria blank.

c Click OK.

11 From the Filemenu, select File > Save.

12 To themessage box confirming themodification, click OK.

13 Change the last two digits of the report name to a number between 1 and 20.

14 Select Save.

Using the New Report Launch window
With the New Report Launch window, you can do the following:

l Create a new report using the wizard...

l Browse for an existing report...
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l Start with a blank report

l Open a recent report (last 5 saved reports are listed)

Creating a new report using the wizard
1 Accept the default toCreate a new report using the wizard... and click OK.

This launches the Report Wizard.

2 Enter a report title to be displayed at the top of the report and click Next.

NOTE: You can include a subtitle by adding a '~' and then the subtitle text.

3 Choose the report form on which to print the report and click Next.

NOTE: You can use wildcards in the report form name, such as "*.Report" to be able to select .Report file when
running the report.

4 Select the table that holds the primary data for the report by navigating to themenu where the records can be found.

TIP: You can also list tables by name to view a simple alphabetical list of all data tables. Check List Tables by
Name.

5 Click on the primary table and then click Next.

6 Select fields in the primary table to add to the report.

a Double click on fields from the Fields list on the top right. These fields can be sorted by name if you select the option to
List Fields by Name. You can select fields from related tables by changing the selected table in the list on the top
left.

b In the bottom panel, you can do the following actions:

i Add grouping to the report by dragging columns to the group area in the dark gray band. A maximum of three fields
can be used for grouping.

ii Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in
themain column row by holding the shift key when clicking additional columns.

iii Reorder columns by dragging them to a different location.

iv Remove columns from the report by right-clicking them.

7 Click Next.

8 Select the fields for report selection criteria.

a Double click on fields from the Fields list.

b In the bottom panel, you can do the following actions:

i Select the comparison option to set as the default.

NOTE: For example, if you would like the default to be between or equal, you can set that as the default on the report
printing window.

ii Lock criteria values to fix those values permanently in the report.

NOTE: For example, in an invoice report that should exclude voided invoices , lock the invoice status criteria as
'Less than 5-Void.'
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9 Click Finish.
Browse for an existing report...
1 Select Browse for an existing report... and click OK.

2 click the [Display System Reports] button and select the report, then click Open.
Start with a blank report
1 Select Start with a blank report and click OK.

This selection allows you to create a new report without using the Report Wizard.
Open a recent report

The last 5 saved reports are listed and can be selected.

Modifying reports and form designs
When theModify Report button appears in theReport Printingwindow, you can edit the report design and the form
design. If theModify Report button does not appear, you cannot edit the report design, but you can still edit the form
design. To open 13-5 Form/Report Page Design from aReport Printingwindow, from theEdit menu, click Form
Design.

If the form name does not display in theReport Form field in the Report Printingwindow, click theModify Report
button. This opens the custom report in 13-3 Report Writer. The custom form name is then displayed in the Form field.
Copy the form design to the \Report Forms folder.

IMPORTANT: Some of the over 1100 system reports are “locked,” and you cannot modify the data portion of the
report. In certain cases, some reports allow modification of the design.

Assigning reports to form designs
When you decide to print a report, Sage 100 Contractor selects the form design you assigned to the report design. You can
assign a report design to a specific form or to a group of forms.

Form design uses file name extensions to group similar types of form designs together. To assign a report design to a form
design, you need to determine which form design a specific report uses. When you select a report for preview or printing in
the 13-4 Report Printingwindow, Sage 100 Contractor displays the file name and file name extension of the form design
below theReport list.

For example, you create a new report for income statements titledMy Income Statement and want the new report to use
the same form design as the original report for income statements. Having created the report design, assign it a form design
to use when Sage 100 Contractor generates the report. In the Form text box, you type report.rpt and save the new report.
Later, when you print theMy Income Statement report, Sage 100 Contractor automatically selects the Report.rpt form
design.

Suppose, instead of limiting the report to the Report.rpt form design, you want to be able to select any form design using the
.rpt file name extension when printing theMy Income Statement report. In this situation, use a wildcard in place of the
report name and indicate the file name extension.

In the Form text box, type *.rpt to indicate you want all files using the .rpt file name extension, and save the report. When
you select theMy Income Statement report for printing, you will be able to select from all the form designs using the .rpt
file name extension.

When you save a report design, Sage 100 Contractor saves it as a file. The file name determines where you will find the
report in Sage 100 Contractor. Where form designs use different file name extensions to organize the forms intomeaningful
groups, all report designs use the .rpf file name extension.

You can assign a custom report to:
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l 13-4 Report Printing. Assign the file any name and save it to the \MB7\Custom Reports folder. You can save an
unlimited number of reports to this location.

l A specific location where similar reports are found. For example, if you create a new income statement, youmight
want to make the report available with the other income statements. Each window location can contain up to 20
custom reports. To access a report in a specific window, save the file in the \Program Files (or Program Files (x86))
\Sage\Sage 100 Contractor\System Reports folder.

The filename consists of eight numbers. The first six numbers specify the window location, and the last two numbers are
user-defined andmust fall between 01 and 20.

The following examples explain how to convert the window locations into the correct naming format:

l You created a new departmental income statement and want to access the report from 2-8-1 Departmental Income
Statement. Convert eachmenu and submenu number used to arrive at theDepartmental Income Statement into a
2-digit number, so the file name becomes 020801. As this is your first custom report in this location, add 01 to the
end. The full name of the file becomes 02080101.rpf.

l Somewindows in Sage 100 Contractor are not located under two submenus. To indicate the correct report path, add
two zeros in the report name to represent the last submenu. For example, you create a new income statement and
want to access it from 2-3 Income Statement. The numbers representing the location become 0203. Because you
need six numbers to represent themenu location, add two zeros. The file name then becomes 020300. As this is
your first custom report in this location, add 01 to the end. The full name of the file becomes 02030001.rpf.

Working with Text in 13-3 Report Writer
You can use the following text options in reports:

l Typing text

l Editing text

l Changing fonts

l Aligning text

To type text
1 In 13-3 Report Writer, open the report in which you want to type text.

2 On the Insertmenu, click Text.

3 Click where you want to place the text.

4 Type the text you want to enter.
To edit text
1 In 13-3 Report Writer, open the report in which you want to edit text.

2 Double click on the field you want to edit andmake the changes that you want.

3 On the Filemenu, click Save.
To change fonts
1 In 13-3 Report Writer, open the report in which you want to change fonts.

2 Highlight the field or fields that need font changes.

3 From theEditmenu, click Font.

4 In the Fontwindow, select the Font, Font style, Size, andEffects as needed.
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5 Click OK.
To align text
1 In 13-3 Report Writer, open the report in which you want to align text.

2 Click the text that you want to align.

3 From theEditmenu, click Align Left orAlign Right, as needed.

NOTE: The text aligns itself to where the text begins, and not themargin.

Bands
A report is made up of horizontal bands. Your report can contain as many or as few bands as necessary, and each band can
contain one or more lines. As you create a report, assign each band a type. The order of types assigned to bands
determines the order in which text and fields appear in the report.

Property What it does

Heading Appears at the top of the report.

Group 1 Determines the first level of grouping.

Group 2 Determines the second level of grouping.

Group 3 Determines the third level of grouping.

Detail Provides the detail for the body of a report.

Subtotal 1 Select Subtotal 1when you want to subtotal data from
Group 1.

Subtotal 2 Select Subtotal 2when you want to subtotal data from
Group 2.

Subtotal 3 Select Subtotal 3when you want to subtotal data from
Group 3.

Total Select Total when you want to total data from the entire
report.

No Print

Select No Printwhen you want to include a field in the
report so a calculated field calculates correctly, but do not
need to include the information in the report.

You can place the field on a separate band and assign the
band theNo Print type. When you generate the report, the
band is not included.

You do not have to use every type of band in a report. For example, you create a new report using the following bands:
Heading, Group 1, Group 2, Detail, Detail, and Total. Notice that two detail bands exist. As you build a custom report,
you can createmultiple detail bands to accommodate text, graphics, and fields you want the report to supply. All bands
expand to accommodate the size of a graphic or text you enter in the custom report. Similar bands must be grouped
together and you cannot have bands with theBlank type in the body of the report.

About band properties
When you select a band, you can change its properties by clicking the prp button.
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Property You can:

Font Set the font, font style, and size for the entire band.

Color Set the color of text and objects for the entire band.

¼ height Set the band to one-quarter of the normal band height.

½ height Set the band to one-half of the normal band height.

Full height Set the band to normal height.

To insert a band
1 In 13-3 Report Writer, open the report into which you want to insert a band.

2 Click the band button immediately below the band where you want to insert the new band.

3 On the toolbar, click the ins button.
To delete a band:
1 In 13-3 Report Writer, open the report from which you want to delete a band.

2 Click the band button of the band you want to delete.

3 On the toolbar, click the del button.

Working with Pages in 13-3 Report Writer

About form breaks and page breaks
You can control the point at which Sage 100 Contractor begins printing information on a new form design or a new page.
Initially, when you create a new report design there are no form breaks or page breaks. You can select the form and page
breaks for a custom report based on band types in the Form Break andPage Break lists.

Use the form break to determine when Sage 100 Contractor prints information on a new form. Suppose you create a
Vendor report that lists invoices sorted by job. When printing the report, you want to be able to select a range of vendors
and print a separate list for each vendor. The report contains the following bands and fields:

l TheGroup 1 band contains fields for the vendor number and name.

l TheGroup 2 band contains fields for the job number and job name.

l TheDetail band contains fields for the invoice number and description.

The form break is set toGroup 1, which tells Sage 100 Contractor to print a new form for each vendor.

Use the page break to determine when Sage 100 Contractor prints information on the next page of amulti-page form design.
To continue the example above, the form design you want to use has two pages. The front page includes your company
logo, address, and boilerplate text, and a continuation page includes only your company name. When creating the custom
report, the page break is set toGroup 2, which tells Sage 100 Contractor to print a new continuation page for each job.

You can also let Sage 100 Contractor automatically determine where to place form or page breaks when generating a
report. When you set the form break to automatic and the form design contains a single page, Sage 100 Contractor prints a
new form for each page in the report. However, if the form design contains multiple pages, Sage 100 Contractor prints a
new form when there are nomore pages in the form design to use. When you set the page break to automatic, the report
advances to a new page when the printed page is full.
To insert a form break
1 In 13-3 Report Writer, open the report into which you wish to insert a form break.
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2 In theNew Form list, click the type of band that you want to begin a new form when printing the report. You can choose
from the following options:

l Automatic

l OnDetail

l OnGroup1

l OnGroup2

l OnGroup3

To insert a page break
1 In 13-3 Report Writer, open the report into which you wish to insert a page break.

2 In theNew Page list, click the type of band that you want to begin a new page when printing the report. You can choose
from the following options:

l Automatic

l OnDetail

l OnGroup1

l OnGroup2

l OnGroup3

Tools for Building Reports
You can use the following tools for building form designs:

l Lines

l Boxes

l Logos, Pictures, andObjects

l Fields

NOTE: To undo changes to a form, on theEditmenu, click Undo.

To move a selection:
1 In 13-3 Report Writer, open the report in which you want to move a selection.

2 Select the item you want to move.

3 Drag the selection to the desired location.

4 Tomovemultiple selections at the same time, hold down the [Ctrl] key and drag themouse over the objects to be
selected.

Lines
To draw a line
1 In 13-3 Report Writer, open the report in which you want to draw a line.

2 In the Insertmenu, click Line.

3 Click in the grid to draw the line and drag the pointer.
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To set the line properties
1 Select the line object usingEdit > Select Objects.

2 Right-click on the box and select Properties.

3 Modify the box object properties. You canmodify the following properties:

a LineWidth

b Line Type

i Solid

ii Dash

iii Dot

iv Dot-Dash

c Forecolor (controls the color of the border)

d Position and Size

i Row: Sets the row number for the object

ii Top: Sets the top position relative to the band line

iii Left: Sets the left position relative to the left side of the page

iv Width: Sets the width of the line

v Height: Sets the height of the line

Boxes

NOTE: You can insert a text box directly inside a box or detail area box, or drag an existing text box and drop it into a
box or detail area box.

To draw a box
1 In 13-3 Report Writer, open the report in which you want to draw a box.

2 On the Insertmenu, click Box.

3 Click in the location where you want to place one corner of the box and drag the pointer diagonally to the size you want.
To set the box properties
1 Select the box object usingEdit > Select Objects.

2 Right-click on the box and select Properties.

3 Modify the box object properties. You canmodify the following properties:

a LineWidth

b Line Type

i Solid

ii Dash

iii Dot

iv Dot-Dash

c Forecolor (controls the color of the border)

d Backcolor (controls the color of the interior)
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e Position and Size

i Page: Sets the page number for the object

ii Top: Sets the top position relative to the band line

iii Left: Sets the left position relative to the left side of the page

iv Width: Sets the width of the line

v Height: Sets the height of the line

Logos, Pictures, and Objects
To insert a picture or logo
1 In 13-3 Report Writer, open the report into which you want to insert a graphic.

2 On the Insertmenu, click Picture.

3 TheAssign Picture dialog box appears.

4 Select the bitmap file that you want to insert.

5 Click Open.

6 On theEditmenu, click Select Objects, then click the picture andmove to the appropriate area on the form.
To add a company logo to all report forms

This procedure adds a company logo to all report forms that share the same logo. The sample logo available in Sage 100
Contractor calls one specific file from the \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\Report Forms
folder and inserts it in all reports that display a logo. You can rename your logo file to this name and it will be displayed in
those reports automatically.

1 UsingWindows Explorer, navigate to the \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\Report
Forms folder on the local drive where you installed Sage 100 Contractor or the drive from which you print.

2 Rename the existing sample logo from logo.bmp to originallogo.bmp.

3 Copy your own logo file into the folder, and rename it logo.bmp.

4 Your logo will now automatically display in reports that use a logo.

NOTE: If you re-install Sage 100 Contractor, Sage 100 Contractor saves the logo.bmp file with themost recent date.
It will not overwrite your file.

IMPORTANT: Youmay need to stretch or shrink your logo on the reports.

To adjust the proportions of a picture or object
1 In 13-3 Report Writer, open the report in which you want to reproportion a graphic or object.

2 Drag the picture in the direction that you want to stretch or shrink it.

3 Click the image to change its proportions.
To delete an object
1 In 13-3 Report Writer, open the report in which you want to delete an object.

2 Click the object or text block that you want to delete.

3 Right click on the object or text box, then click Delete.
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Fields
Fields are special codes that instruct Sage 100 Contractor to replace the field with information from a database. For
example, youmight want to include the job number on a report for payable invoices. You can insert theACPINV.JOBNUM
field in the report design. Then, when you generate the report, Sage 100 Contractor fills in the appropriate information for
you.

With fields, you can create form designs and report designs to automatically add or update information in your reports and
documents. Fields provide you access to data throughout Sage 100 Contractor. Because you can place fields in both report
designs and form designs, you need to determine which fields are necessary and then decide where to insert them. It is a
good idea to placemost all fields in the report design if possible, as this lets you reuse a small number of form designs for a
variety of reports.

Like other objects in a form or report design, you can set object properties for fields. When you generate a report or
document, Sage 100 Contractor inserts the information indicated by the field. If the database does not contain information
requested by the field, Sage 100 Contractor leaves the field blank in the resulting report or document. However, you can set
the property of a field to print a zero rather than leaving the field blank.

NOTES:
l For each field you want to insert, create a new text box.

l You can format text or graphics by setting the object properties.

To insert fields
1 In 13-3 Report Writer, open the report into which you want to insert fields.

2 On the Insertmenu, click Text.

3 Insert the pointer where you want to place the text.

4 On the Insertmenu, click Fields.

5 In the Tables by Menu section, click the table that you want to use.

6 In the Fields in {table name} section, double-click the field that you want to use.

Define Grouping and Sorting
If you open an existing report, or create a new report by starting with a blank report, you can define grouping and sorting of
the fields on the report.

l Add grouping to the report by double clicking on the fields in the top right. A maximum of three fields can be used for
grouping.

l Reorder group fields by dragging them to a different location.

l Remove group fields from the report by right-clicking them.

l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group you selected. If no groups are selected, the sort column displays a 1.

Define the Selection Criteria
1 Select the fields for report selection criteria.

2 Double click on fields from the Fields list.

3 In the bottom panel, you can do the following actions:

a Select the comparison option to set as the default.
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NOTE: For example, if you would like the default to be between or equal, you can set that as the default on the report
printing window.

b Lock criteria values to fix those values permanently in the report.

NOTE: For example, in an invoice report that should exclude voided invoices, lock the invoice status criteria as 'Less
than 5-Void .'

Calculated Fields
Sage 100 Contractor enables you to create calculated fields and add them to form designs or report designs. A calculated
field is a type of field representing an expression. When you generate a report, Sage 100 Contractor determines the result of
the calculated field based on information stored in the databases. After creating a calculated field, you can add it to the list
of calculated fields available for use in the design.

About pre-defined calculated fields

Pre-defined calculated fields are fields that Sage 100 Contractor recognizes and automatically replaces with the proper
data. These are locked fields that cannot be changed. Unlike other fields, standard or calculated, which you insert, create
and/or add to the report, pre-defined calculated fields must be typed directly into the form design.

Most, but not all of these pre-defined calculated fields are also global calculated fields. For example, cmpany^cmpnme is
the same as CP^cmpnme. Both fields pull the company name from the database.

IMPORTANT: There is only one difference between
the two types of calculated fields. Pre-defined
calculated fields must be typed directly into the form
design, whereas global calculated fields must be
added from theCalculated Fieldswindow.

The fields listed in the table below work only in 13-5 Form/Report Page Design, not in 13-3 Report Writer. Many of these
pre-defined fields exist in the form designs that comewith Sage 100 Contractor.

Pre-Defined
Field Data

CP^cmpnme Company Name

CP^cmpad1 Company Address 1

CP^cmpad2 Company Address 2

CP^ctyste Company City & State

CP^zipcde Company Zip Code

CP^mallbl Company Mail Label

CP^licnum Company License Number

CP^ctynme Company City Name

CP^state Company State Name

CP^phnnum Company Phone Number

CP^curdte Current Date
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Pre-Defined
Field Data

CP^curtme Current Time

CP^curusr Current User

CP^pagnum Page Number

CP^pagnxt Consecutive Page Number (will ignore new page one
for new groups, etc.)

CP^stetax Company State Tax ID#

CP^fedtax Company Federal Tax ID#

CP^memnte Notes entered on report selection window

CP^select Report Selection Criteria

CP^subttl Report Subtitle

CP^faxnum Company Fax Number

CP^rslnum Company Resale Number

CP^usrdf1 Company User Defined 1

CP^usrdf2 Company User Defined 2

CP^e_mail Company Email address

CP^bnkact Company Bank Account Number (for Direct Deposit)

CP^rtnmbr Company Routing Number (for Direct Deposit)

CP^ntetxt Company Note

CP^rptttl Report Title

CP^rptopt Report Option

CP^stmdte Statement Date (for printing from 3-4 Statements)

Working with global calculated fields

Global calculated fields are a good way to copy a calculation from one report to another. Many pre-defined calculations are
in theGlobal Calculated Fields list, but not all.

A global calculated field is a type of field representing an expression. When you generate a report, Sage 100 Contractor
determines the result of the calculated field based on information stored in the databases. After creating a global calculated
field, you can add it to the list of calculated fields available for use in the design.

Inserting calculated fields in reports

Consider the following points when inserting calculated fields in reports:

l For each calculation that you want to insert, create a new text box.

l After inserting a field, you can format the text by setting the object properties.
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To insert a calculated field in a report:

In the 13-3 Report Writerwindow, open the report into which you want to insert a calculated field.

Select Insert > Text.

1 Click in the text box where you want to place the field.

2 On the Insertmenu, click Fields.

3 Select a table from the list on the left.

4 In the bottom panel, double-click the calculated field you want to insert.

Inserting calculated fields in form designs

Consider the following points when inserting calculated fields in reports:

l For each calculation that you want to insert, create a new text box.

l After inserting a field, you can format the text by setting the object properties.

To insert a calculated field in a form design:

1 In the 13-5 Form/Report Page Designwindow, open the report into which you want to insert a calculated field.

2 Click in the text box where you want to place the field.

3 On the Insertmenu, click Fields.

4 Select a table from the list on the left.

5 In the bottom panel, double-click the calculated field you want to insert.

Creating calculated fields

When you add the calculated field, its name displays in theCalculated Fields list. You can then insert the field as you
would insert any other field.

To create a calculated field:

1 In either 13-3 Report Writer or 13-5 Form/Report Page Design, on the toolbar, select Edit > Calculated Fields.

2 In theCalculated Fieldswindow, in theName text box, enter the name of the calculated field you want to create.

NOTE: TheName text box has a 15 character limit. You can use spaces and special characters in addition to letters
and numbers.

3 In theDescription text box, enter a brief description of the field.

4 Select Do Not Total, if the calculated field should not be totalled.

5 Use theDatabase Fields, Functions, andOperators to build the calculated field expression.

6 To save the calculation, click Save.

NOTE: TheSave button is not available unless all required fields (Name, Description, andCalculated Field
Expression) are filled out.

7 Click Close.

Creating global calculated fields

When you create a global calculated field, it can easily be added to other reports by selecting it from the list of global
calculated fields. This allows you to avoid the task of created the calculated field each time you want to use it in a different
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report.

To create a global calculated field:

1 In either 13-3 Report Writer or 13-5 Form/Report Page Design, select Edit > Calculated Fields.

2 In theCalculated Fieldswindow, in theName text box, enter the name of the calculated field you want to create.

NOTE: TheName text box has a 15 character limit. You can use spaces and special characters in addition to letters
and numbers.

3 In theDescription text box, enter a brief description of the field.

4 Select Do Not Total, if the calculated field should not be totalled.

5 To build the expression, do any of the following:

a In the Tables list, click a table. Then in the Fields list, click the fields you want.

b In the Functions list, click the functions you want.

c UnderOperators, click the operators you want.

6 To save the global calculation, click Save to Global Calculations.

NOTE: TheSave button is not available unless all required fields (Name, Description, andCalculated Field
Expression) are filled out.

7 To save the global calculation to the current report, click Save.

8 Click Close.

Adding calculations to fields

To add a calculation to a field:

1 Open the report or form to which you want to add the calculation.

2 On the toolbar, click theCalculations button.

3 In theCalculated Fieldswindow, locate theCalculation text box, then click the drop-down arrow.

4 In theGlobal Calculated Fields lookup window, locate and double-click the calculation you want to insert.

IMPORTANT: The list is much longer than it looks because there is no vertical scroll bar. To locate your calculation,
type the first few letters of its name.

5 Click theAdd button, then click OK.

6 You return to the Form/Report Page Designwindow.

Important:

If you see an unable to savemessage, click OK and verify that the calculation has been added.

7 Create a text box where you want to add the calculated field.

8 On the Insertmenu, click Fields.

9 In the Insert Fieldswindow, find and select Calculated Fields.

10 In the Fields list, double-click the field you want to insert.

11 From the Filemenu, select Save.
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Editing calculated fields

IMPORTANT: You can only edit a calculated field in
an existing report containing a calculated field.

To edit a calculated field:

1 In either 13-3 Report Writer or 13-5 Form/Report Page Design, on the toolbar, select Edit > Calculated Fields.

2 In theCalculated Fieldswindow, select the calculation from theNametext box list.

3 Make the changes you want to the expression.

4 Edit theName andDescription if desired.

5 To save the calculation, click Save.

6 Click Close.

Editing global calculated fields

To edit a global calculated field:

1 In either 13-3 Report Writer or 13-5 Form/Report Page Design, select Edit > Calculated Fields.

2 In theCalculated Fieldswindow, select the calculation from Select Global Calculation.

3 Make the changes you want to the expression.

4 Make changes to theName andDescription if necessary.

5 To save the global calculation, click Save to Global Calculations.

6 To save the global calculation to the current report, click Save.

7 Click Close.

Inserting text boxes for calculated fields

Part of the process in copying calculated fields is to insert a text box in a report. Then you insert the calculated field into the
text box.

To insert a text box for a calculated field:

1 In 13-3 Report Writer or 13-5 Form/Report Page Design, open the report or form into which you want to insert a
calculated field.

2 Select Insert > Text.

3 Click in the location where you want to insert the form field.

4 Select Insert > Fields.

5 In the bottom panel, double-click the calculated field you want to insert.

Copying calculated fields

Saving calculations to theGlobal Calculated Fields list is a good way to copy a calculation from one report to another.
Many calculations are in theGlobal Calculated Fields list, but not all. Here’s how to add the ones you want.

To save a calculated field to the Global Calculated Fields list:

1 In 13-3 Report Writer, open a report that contains the calculation you want to copy.
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2 Select Edit > Calculated Fields.

3 In theName field, click the drop-down arrow.

4 Click the desired calculation.

5 To add the calculation to the Global Calculated Fields list, click Save to Global Calculations.

6 This adds the desired calculation to theGlobal Calculated Fields lookup window.

Now you can insert the global calculated field into other reports without creating a calculated field for each report.

Deleting calculated fields

IMPORTANT: You can only edit a calculated field on
an existing report containing an existing calculated
field.

To delete a calculated field:

1 In either 13-3 Report Writer or 13-5 Form/Report Page Design, select Edit > Calculated Fields.

NOTE: You cannot delete a calculated field if it is still
in use on the report or form you've opened. Remove
the object from the report or form first, then delete the
calculated field.

2 In theCalculated Fieldswindow, click theName list and select the calculated field that you would like to delete.

3 Click Delete.

4 Click OK.

About expressions

An expression is a formula used to compute the value of a calculated field. An expression can contain fields, constants,
operators, and functions.

The examples below help illustrate the syntax of expressions:

l To calculate the year-to-date activity for a ledger account, the following expression subtracts the beginning balance
from the ending balance:

LGRACT.ENDBAL-LGRACT.BEGBAL

l You can create a single field that inserts the employee’s last name, followed by an ampersand, and the first name.
When you generate the report, Sage 100 Contractor adjusts the placement of the first name relative to the length of
the last name:

EMPLOY.LSTNME&EMPLOY.FSTNME

l The following expression inserts the ledger account number and the ledger account long name. When you generate
the report, Sage 100 Contractor adjusts the placement of the long name relative to the length of the ledger account
number:

LGRACT.RECNUM LGRACT.LNGNME
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About operators

Operators are symbols that represent a type of mathematical or relational process to carry out in an expression. You can
select from the following operators:

Operator Description

+ Addition

– Subtraction

* Multiplication

/ Division

= Equal to

< > Not equal to

( ) Open/close parenthesis.

< Less than

> Greater than

<= Less than or equal to

>= Greater than or equal to

& Ampersand

If( )Then( )Else( ) Tests for a condition.

{S}
Inserts a find and replace field for an alphanumeric
variable.

{N}
Inserts a find and replace field for a numeric
variable.

{D} Inserts a find and replace field for a date variable.

SQL Queries Tests for a condition.

About parentheses

Using the parentheses, you can group operations in an expression to change the order in which they are performed. Without
parentheses, operations are performed in the following order: Multiplication/division, addition/subtraction, and relational
operations (greater than, less than, not equal to, etc.)

l For example, the expression, 4 + 6 / 2, provides the answer 7, and not 5, because division is performed before
addition. When amathematical expression contains operators that have the same rank, operations are performed
left to right. For example, in the expression, 2 + 6 / 3 * 5 – 9, division andmultiplication are first performed before the
addition and subtraction. The first operation divides 6 by 3, which produces 2. The second operationmultiplies 2 by
5, which produces 10. In the third operation, add 2 to 10, which produces 12. In the fourth operation, subtract 9 from
12 to produce 3 as the answer.

By using parentheses, you can change the order of operations in an expression. That is, operations in parentheses are
performed first, then operations outside the parentheses are performed.
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l For example, the expression, (2 + 6 / 3) * 5 – 9, results in an answer of 11, while the expression, (2 + 6 / 3) * (5 – 9),
results in –16 as the answer.

You can also embed parentheses, where operations in the deepest parentheses are performed first.

l For example, the expression, ( (7 + 3) / 2) * 3, contains embedded parentheses. From the example, the first operation
is 7 + 3, the second operation is 10 / 2, and the third operation is 5 * 3, which results in 15 as the answer.

About using If( )Then( )Else( ) in a calculated field

The If( )Then( )Else( ) operator enables you to conditionally return a value. Within the parentheses of the If( )Then( )Else( )
expression, you enter the fields, functions, and constants.

Syntax: If( expression )Then( result1 )Else( result2 )

l Expression is the condition for which you are testing.

l Result1 is returned when the condition in the expression is met.

l Result2 is returned when the condition in the expression is not met.

Example:

A Trial Balance report uses calculated fields containing the If( )Then( )Else( ) operator. The expression

If(LGRACT.DBTCRD=1)Then(LGRACT.BEGBAL)Else( )

determines whether a ledger account maintains a debit balance. If the ledger account is a debit account, Sage 100
Contractor prints the ledger account’s beginning balance on the report in place of the field. Otherwise, the account is not a
debit account and Sage 100 Contractor does not print the balance.

When you set up the ledger account structure, Sage 100 Contractor assigns a value of 1 to debit accounts and a value of 2
to credit accounts. Sage 100 Contractor stores the debit/credit value in a table, which you can query using the
LGRACT.DBTCRD field.

In the above example, the If( ) portion of the expression queries the debit or credit value of each ledger account. If the
LGRACT.DBTCRD field returns a value of 1 for a ledger account, Sage 100 Contractor acts on the field indicated in the
Then( ) portion of the expression, printing the beginning balance for the ledger account indicated by the LGRACT.BEGBAL
field.

However, if the LGRACT.DBTCRD field returns a value not equal to 1, Sage 100 Contractor acts on theElse( ) portion of
the expression. In the example above, Else() does not contain a value; therefore, Sage 100 Contractor does not return
anything.

About variables in calculated fields

Variables act as placeholders for actual numeric values. The variables allow you to build calculated fields and save them
without having to enter actual figures until you generate the report. When you preview or print a report containing a variable,
you assign a numeric value to each variable that you are using. Sage 100 Contractor substitutes the declared values for the
variables and computes the results. You can insert a variable for a date ({D}), number ({N}), or alphanumeric string ({S}).

{S}

The {S} operator lets you insert a variable for an alphanumeric string in the calculated field.

Syntax: [variable{S}]
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l Variable is the variable you want to replace when generating the report.

{N}

The {N} operator lets you insert a variable for a numeric string in the calculated field.

Syntax: [variable{N}]

l Variable is the variable you want to replace when generating the report.

{D}

The {D} operator lets you insert a variable for a date string in the calculated field.

Syntax: [variable{D}]

l Variable is the variable you want to replace when generating the report.

About constants

Constants are parameters or values in an expression that do not change.

Example

Suppose you create an expression for a calculated field that determines the retention of a payable invoice by multiplying the
invoice total times the retention rate.

The retention rate .05 is the constant in the expression:

ACPINV.INVTTL * .05.

About functions

An expression can contain functions, which perform special operations.

You can use a single function to represent the expression in a calculated field, or you can use functions in a larger
expression.

Example:

Suppose you want to include the system date in a report. You create a calculated field called “Todate,” which uses the
DATE$ function as the expression, and insert the field in the report design. When you generate the report, Sage 100
Contractor inserts the system date.

You can also embed functions, which lets you nest functions within each other.

Example:

For example, the expression DAY( DATE$ ) returns only the day of themonth. The function DATE$ locates the system
date, then the DAY( ) function returns only the value for the day. So, if today’s system date is 03/15/2010, the expression
DAY( DATE$ ) returns 15 when you generate the report.
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Function Description

ADDINT$

The ADDINT$ function adds an interval to a date.

Syntax: ADDINT$(interval,number,date)

Interval is the period of time by which you want to increment
a date. Use the following to denote the interval: d = day, w =
week, m = month, q = quarter, y = year.

Number specifies number of intervals by which you want to
increment a date.

Date is the date or date field to which the intervals are added.

Example: To create a list of payable invoices whose
payments are overdue by two days for the given discount
date, use the following expression:

ADDINT$(d,2,acpinv.dscdte)

The expression adds two days to the payable invoice
discount date and compares the new value to the system
date (today’s date) provided by the DATE$ function.

AGED

The AGED function determines if a date falls between two
values.

Syntax: AGED (date,number1,number2)

Date is a date or date field.

Number1 and number2 specify the number of days that the
datemust fall between to return a logical True.

A “1” is returned by the AGED function when the date falls
within the range and “0” returned when it doesn’t.

Example: To create a calculation that checks the age of
receivable invoices based on their due dates, use the
following expression:

AGED(acrinv.duedte, 1, 30)

The expression determines if the due date is less than or
equal to the system date plus 30 days.
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Function Description

CASE

The CASE function conditionally returns a result based on
the value of an item.

Syntax: CASE(item,value-n,result-n,default)

Item is the type of data being checked.

Value-n is the value for which the CASE function is
searching.

Result-n is the result the CASE function returns when the
CASE function finds Value-n.

Default is the result if the CASE function does not find Value-
n.

Example: Suppose you want to print or display a description
of the payable invoice status. To do this, create the following
expression:

CASE(acpinv.status,1,Open,2,Review,3,
Dispute,4,Paid,Void)

The expression includes a value and a result for invoice
statuses 1–4. If the data that is returned by the acpinv.status
field does not match any of the values, then the expression
returns the default found at the end of the expression, Void.

DATE$

The DATE$ function returns the system date.

Syntax: DATE$

No additional information is necessary.

Example: To print or display the system date when the report
was created, insert the following function where you want the
date to appear in your report:

DATE$

If the system date is 09/05/10, the field returns the value
09/05/2010.

DAY

The DAY function returns the number of the day of the
month.

Syntax: DAY(date)

Date is the date field.

Example: To print or display the day of themonth for a
receivable invoice date, use the following expression:

DAY(acrinv.invdte)

If the date is 09/05/2010, the field returns the value 10.
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Function Description

DAY$

The DAY$ function returns of day of themonth as a
character string.

Syntax: DAY$(number)

Number is the number of the day, where 1 through 7
represents Sunday through Saturday.

Example: To print or display the day of the week for a fixed
date in a schedule, use the following expression:

DAY$(schlin.fxddte)

If the fixed date 09/05/2010 falls on aWednesday, the field
returns Wednesday.

LEFT$

The LEFT$ function returns a specified number of characters
beginning at the left-most character.

Syntax: LEFT$(string,number)

String is the field that contains the characters you want to
select.

Number specifies the number of characters you want to
select.

Example: Suppose you are creating an employee list and you
want to include the employee’s first initial and last name. To
print or display the first letter of the employee’s first name,
use the following expression:

LEFT$(employ.fstnme,1)

If the employee’s first name is Ron, Sage 100 Contractor
returns R.
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Function Description

MID$

TheMID$ function returns a number of characters from a
character string, starting at a position you specify.

Syntax: MID$(string,number1,number2)

String is the field that contains the characters you want to
select.

Number1 specifies the position of the first character.

Number2 specifies the number of characters you want to
select.

Example: Suppose you are creating a lumber list, and you
only want to include dimensional lumber that is described in
six characters, such as 2x4x20. You do not want to print or
display other lumber sizes such as 4x8.

MID$(string,1,6)

If the string contains six characters, this function returns six-
character strings, such as 2x4x20.

MONTH

TheMONTH function returns the number of themonth from a
date field.

Syntax: MONTH(date)

Date is the date field.

Example: To print or display themonth for a fixed date in a
schedule, use the following expression:

MONTH(schlin.fxddte)

If the fixed date is 09/05/2010, the field returns the value 9.

MONTH$

TheMONTH$ function returns themonth as a character
string.

Syntax: MONTH$(number)

Number is the number of themonth, where 1 through 12
represents January through December.

Example: To print or display themonth for a fixed date in a
schedule, use the following expression:

MONTH$(schlin.fxddte)

If the fixed date is 09/05/2010, the field returns September.
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Function Description

RIGHT$

The RIGHT$ function returns a specified number of
characters beginning at the right-most character.

Syntax: RIGHT$(string,number)

String is the field that contains the characters you want to
select.

Number specifies the number of characters you want to
select.

Example: Suppose you want to create a list of equipment
that includes themodel year, which you include as the last
information in the equipment description:

RIGHT$(eqpmnt.eqpnme,4)

If the equipment description is Cat 3054T Diesel Engine
2000, Sage 100 Contractor returns 2000.

SPELL$

The SPELL$ function spells out the currency value. Report
Writer returns ***VOID*** if the number is zero or a negative.

Syntax: SPELL$(number)

Number is the number or field you want to spell out.

Example: To print or display the payable invoice balance,
use the following expression:

SPELL$(acpinv.invbal)

If the payable invoice balance is $535.00, the field returns
FIVE HUNDRED THIRTY FIVE DOLLARS.

TRIM$

The TRIM$ function removes the trailing spaces in a
character expression.

Syntax: TRIM$(string)

String is the field from which you want to remove the trailing
spaces.

Example: The employee first name field can contain up to 20
characters. If an employee’s first name is Gerald, which
contains six characters, the employee first name field would
return the name plus 14 empty spaces.

TRIM$(employ.fstnme)

Using TRIM$ removes the trailing 16 spaces.
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Function Description

YEAR

The YEAR function returns the year from a date field.

Syntax: YEAR(date)

Date is the date field.

Example: To print or display the year for a report, use the
following expression:

YEAR(DATE$)

If the system date is 09/05/10, the field returns the value
2010.

About Structured Query Language

With Structured Query Language (SQL), you design expressions to query databases for data that is not available in
standard reports or documents. With SQL, you can apply arithmetic operations to select and obtain new data. This can be
as simple as adding two different fields together, or as complex as computing the billings in excess for a project.

Before you create an SQL expression, it is important to understand how Sage 100 Contractor uses databases to store
information. When you enter information in a window, Sage 100 Contractor stores the information in tables. Depending on
the window, Sage 100 Contractor either stores information in one or two tables.

In windows such as 4-3 Vendor Payments, 3-5 Jobs, or 3-3-1 Cash Receipts a single database table exists, containing
all the information. In other windows such as 4-2 Payable Invoices or 3-2 Receivable Invoices, there are two database
tables. When Sage 100 Contractor uses two tables to store data, the first table stores information from the text boxes and
lists and the second table stores data from the grid.

About SQL syntax

TheSQL Queries operator enables you to return a value that meets specific conditions. Within theSelect From Where
expression, you enter the fields, functions, and constants.

When building an SQL expression, you can use any mathematical or relational operations, as well as language operators.
The placement of operators is critical to proper calculation, and some operators are placed before rather than after the
fields. The following list describes the language operators you can use in an SQL expression:

Operator Description

Select Locates data for the selected field.

Select Sum
Locates and totals all figures for the selected field. You
can useSelect Sum in place of theSelect portion of the
expression.

From Indicates the source database. Usually follows theSelect
portion of the expression.

Where Defines the criteria that datamust meet for use in the
query. Usually follows the From portion of the expression.

Between Defines a range of data. TheBetween operator works
similar to >= and <=.

Inner Join Creates a relationship between two tables.
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Example Syntax:

Syntax: Select table1 From table2 Where value

l Table1 is the data you want to select.

l Table2 is the table from which you want to select the data.

l Value is the value for which the SQL function is searching.

IMPORTANT: The syntax for an SQL expression can
vary greatly depending on the complexity. The syntax
above only outlines a simple SQL expression.

Example:

If you store information in the user-defined fields in 7-2 Company Information, you can use an SQL query to extract the
information.

Syntax: Select USRDF1 From CMPANY

Queries follow these specific guidelines:

l Brackets [ ] let you create separate SQL expressions and perform mathematical operations on them.

l In the query expression, you can use the equal to (=), greater than (>), or less than (<) signs to test for a value
returned by the field.

l Usemathematical operators such as addition (+), subtraction (–), multiplication (*), or division (/) between two or
more SQL queries to create a single expression. Use the operators to combine two or more embedded queries.

Between

TheBetween operator defines a range of numbers similar to using to >= and <=. The range is inclusive of the two numbers
you indicate.

Syntax: Between number1 and number2

l Number1 is the low number.

l Number2 is the high number.

l Example:When you set the range between 5 and 10, the query searches for the numbers 5, 6, 7, 8, 9, and 10.

Inner join

The inner join operator joins two tables and creates a one-to-one relationship between records in the table.

Syntax: Table1 Inner Join table2 on string1=string2

l Table1 is a table

l Table2 is the table you want to join to table1.

l String1 is a field.

l String2 is the field that you want to relate to string1.
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Example:

Suppose you create a change order report that includes the budgeted costs by job. The job number is found in theChange
Order table, and the budgeted amounts and cost codes are found in theSubcontract Change Order Lines table.

13-4 Report Printing

Printing Reports
Clicking thePrint Records button onmany Sage 100 Contractor windows opens aReport Printingwindow that is pre-
loaded with reports specific to the area in which you are working. For example, if you are working in 3-2 Receivable
Invoices/Credits, Sage 100 Contractor opens 3-2 Report Printing.

NOTES:
l Printing reports on legal-sized paper is a special condition.

l Printing Gantt charts works differently than other report printing. For example, youmust select a form design
with either portrait or landscape orientation. Paper size and the size of the detail section do not matter because
the program takes the selected form design elements and resizes them to fit the size of the selected printer
page size.

Report Printing window toolbar

TheReport Printingwindow toolbar buttons providemore versatile tools for working with reports. From right to left:

l Print records- Sends the selected report to the default printer or the printer you select from the printer selection
drop-downmenu.

l Print preview and Drilldown (when available)- Opens the selected report in print preview mode with drill-down
functionality.

l Send report data to Excel—Opens the report in an Excel worksheet.

l Send report to Word—Sends the report to anExport to Filewindow. Click Save to open the report inWord as an
RTF file. The default Save in folder is theReports folder under the company folder.

l Send report as an Outlook email attachment—Launches Outlook with the report attached to an email message
as a PDF file.

l Create a PDF file of this report—Sends the report to anExport to Filewindow. Click Save to open the report in
Adobe Reader as a PDF file. The default Save in folder is theReports folder under the company folder.

l Email this report—Opens theEmail Distributionwindow which provides themeans to send amessage through
Sage 100 Contractor email functionality.

l Fax this report—Opens the Fax Distributionwindow which provides themeans to send a fax through Sage 100
Contractor faxing functionality. (Requires an installed fax/modem)

l Schedule this report—Opens theReport Schedulingwindow which provides themeans for you to schedule
sending the selected report.

l Set the print orientation to landscape or portrait—Becomes available when printing graphs or charts.

l Insert a note into the report—Opens theNoteswindow, and if the form design contains the field for inserting a
note, the text of the note is inserted in the selected report.

l Enter a new record—Clears the selection criteria and resets the form design to the saved default.
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Selection criteria and form designs

In theReport Printingwindow, you can select which report design is printed. Using the selection criteria, you can narrow
the scope of a report to provide only the information you need. In addition, you canmake changes to a report before printing
it.

Report printing allows you to set up printer defaults. Most windows from which you can print have a dedicatedReport
Printingwindow. Suppose that you have two printers: a tractor feed printer that is used to only print checks and a laser
printer that is used to print all other documents. In theReport Printingwindow from which you print general ledger checks,
you can set the dot matrix printer as the default.

IMPORTANT: Scheduling reports to email, fax, or print will not work if the company data is opened exclusively. If
you have a question, youmay review the fileSARAEventLog.txt found in
\Users\Username\AppData\Local\Sage\Sage 100 Contractor\ to see if a scheduled report has been sent or not and if
the company was “opened for exclusive access by another user.”

To print a legal-sized PDF or RTF report:
1 From the printers drop-downmenu, select eitherSage 100 Contractor RTF Export orSage 100 Contractor SagePDF
Export.

2 From theSize drop-downmenu, select Legal.

3 On the right end of the toolbar, click thePrint records button.

NOTE: The report, 2-3-0-34 Income Statement~All Periods, must be printed on legal-sized paper to avoid being
truncated. One-click printing using theCreate a PDF file of this report button on the toolbar, for example, does not
print to legal-sized paper even when selected because one-click buttons use the default printer’s default settings,
which are typically set to letter-sized paper.

Setting report printing defaults
You can save time and effort by setting up your preferences for report types, form designs, selection criteria, and options in
theReport Printingwindow. You can also set preferences for printers, page ranges, page orientation, and number of
copies to print. When you save the defaults, Sage 100 Contractor assigns them to the user name currently logged on to
Sage 100 Contractor.
To enter defaults in a Report Printing window
1 Open theReport Printingwindow for which you want to set up defaults.

2 In the Form Design list, click the form design that you want.

3 On theSelection Criteria tab, enter the criteria that you want to use for selecting data.

4 On theDefaultmenu, click Save Defaults.

Printing documents, grids, or reports
You can print reports, records, or grids frommost windows in Sage 100 Contractor.

IMPORTANT: Edit or delete an existing schedule from 7-7 Scheduled Reports Manager. Schedules cannot be
edited or deleted from theReport Printingwindow.

To print a document, grid, or report
1 From the Filemenu, select Print.

2 In theReport Printingwindow, click theReport Criteria tab, then click the report that you want to print.

3 Select theReport Form from the drop-down list.
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4 In the selection criteria, enter the conditions that you want to use to select data.

5 Select a printer from the drop-down list.

6 Select the paper size, tray, and quality settings. The list of these options depends on your printer.

7 To print specific pages, enter their numbers in the text boxes next toPages.

8 Select how many copies you want by clicking on the up and down arrows next toCopies.

9 To preview the document, click thePreview button.

10Do one of the following:

a From the Filemenu, select Print.

b On the toolbar, click thePrint Records button.

NOTES:
l Reports can be scheduled to be printed, faxed, or emailed at a specific time and frequency.

l Reports can be faxed or emailed immediately to a recipient from this window.

l Use theDefaults command from themenu to save a default report type and automatically have that report at
the top of the list the next time you return toReport Printing.

To save printer settings
1 Select a printer from the drop-down list.

2 Select the paper size in theSize drop-down list.

3 Select the tray settings in the Tray drop-down list.

4 Select the quality in theQuality drop-down list.

5 The list of these options depends on your printer.

6 To print specific pages, enter their numbers in the text boxes next toPages.

7 Select how many copies you want by clicking on the up and down arrows next toCopies.

8 Select Save Printer Settings.

Printing reports to screen—print preview
You can preview reports before you print them by clicking thePrint preview and Drilldown (when available) button. It is
located on each report printing window on the toolbar in the upper right. It is indicated by the button displaying amagnifying
glass.

Viewing reports in print preview also provides the platform for drilling down into report information. When you are viewing a
report in print preview and if there is drillable information on that report page, your cursor becomes amagnifying glass.
When the lens displays a red circle, you can double-click the row or field to drill down to the details of the report information.

About report printing

Clicking thePrint Records button onmany Sage 100 Contractor windows opens aReport Printingwindow that is pre-
loaded with reports specific to the area in which you are working. For example, if you are working in 3-2 Receivable
Invoices/Credits, Sage 100 Contractor opens 3-2 Report Printing.

Report Printing window toolbar

TheReport Printingwindow toolbar buttons providemore versatile tools for working with reports. From right to left:
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l Print records- Sends the selected report to the default printer or the printer you select from the printer selection
drop-downmenu.

l Print preview and Drilldown (when available)- Opens the selected report in print preview mode with drill-down
functionality.

l Send report data to Excel—Opens the report in an Excel worksheet.

l Send report to Word—Sends the report to anExport to Filewindow. Click Save to open the report inWord as an
RTF file. The default Save in folder is theReports folder under the company folder.

l Send report as an Outlook email attachment—Launches Outlook with the report attached to an email message
as a PDF file.

l Create a PDF file of this report—Sends the report to anExport to Filewindow. Click Save to open the report in
Adobe Reader as a PDF file. The default Save in folder is theReports folder under the company folder.

NOTES:
l Printing reports on legal-sized paper is a special condition.

l Printing Gantt charts works differently than other report printing. For example, youmust select a form design
with either portrait or landscape orientation. Paper size and the size of the detail section do not matter because
the program takes the selected form design elements and resizes them to fit the size of the selected printer
page size.

l Email this report—Opens theEmail Distributionwindow which provides themeans to send amessage
through Sage 100 Contractor email functionality.

l Fax this report—Opens the Fax Distributionwindow which provides themeans to send a fax through Sage
100 Contractor faxing functionality. (Requires an installed fax/modem)

l Schedule this report—Opens theReport Schedulingwindow which provides themeans for you to schedule
sending the selected report.

l Set the print orientation to landscape or portrait—Becomes available when printing graphs or charts.

l Insert a note into the report—Opens theNoteswindow, and if the form design contains the field for inserting
a note, the text of the note is inserted in the selected report.

l Enter a new record—Clears the selection criteria and resets the form design to the saved default.

Selection criteria and form designs

In theReport Printingwindow, you can select which report design is printed. Using the selection criteria, you can narrow
the scope of a report to provide only the information you need. In addition, you canmake changes to a report before printing
it.

Report printing allows you to set up printer defaults. Most windows from which you can print have a dedicatedReport
Printingwindow. Suppose that you have two printers: a tractor feed printer that is used to only print checks and a laser
printer that is used to print all other documents. In theReport Printingwindow from which you print general ledger checks,
you can set the dot matrix printer as the default.

IMPORTANT: Scheduling reports to email, fax, or print will not work if the company data is opened exclusively. If
you have a question, youmay review the fileSARAEventLog.txt found in \Program Files (or Program Files (x86))
\Sage\Sage 100 Contractor to see if a scheduled report has been sent or not and if the company was “opened for
exclusive access by another user.”
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To print a legal-sized PDF or RTF report:

1 From the printers drop-downmenu, select eitherSage 100 Contractor RTF Export orSage 100 Contractor SagePDF
Export.

2 From theSize drop-downmenu, select Legal.

3 On the right end of the toolbar, click thePrint records button.

NOTE: The report, 2-3-0-34 Income Statement~All Periods, must be printed on legal-sized paper to avoid being
truncated. One-click printing using theCreate a PDF file of this report button on the toolbar, for example, does not
print to legal-sized paper even when selected because one-click buttons use the default printer’s default settings,
which are typically set to letter-sized paper.

About setting report printing defaults

You can save time and effort by setting up your preferences for report types, form designs, selection criteria, and options in
theReport Printingwindow. You can also set preferences for printers, page ranges, page orientation, and number of
copies to print. When you save the defaults, Sage 100 Contractor assigns them to the user name currently logged on to
Sage 100 Contractor.

Entering defaults in Report Printing windows

To enter defaults in a Report Printing window:

1 Open theReport Printingwindow for which you want to set up defaults.

2 In the Form Design list, click the form design that you want.

3 On theSelection Criteria tab, enter the criteria that you want to use for selecting data.

4 On theDefaultmenu, click Save Defaults.

Printing documents, grids, or reports

You can print reports, records, or grids frommost windows in Sage 100 Contractor.

IMPORTANT: Edit or delete an existing schedule from 7-7 Scheduled Reports Manager. Schedules cannot be
edited or deleted from theReport Printingwindow.

To print a document, grid, or report:

1 From the Filemenu, select Print.

2 In theReport Printingwindow, click theReport Criteria tab, then click the report that you want to print.

3 Select theReport Form from the drop-down list.

4 In the selection criteria, enter the conditions that you want to use to select data.

5 Select a printer from the drop-down list.

6 Select the paper size, tray, and quality settings. The list of these options depends on your printer.

7 To print specific pages, enter their numbers in the text boxes next toPages.

8 Select how many copies you want by clicking on the up and down arrows next toCopies.

9 To preview the document, click thePreview button.

10Do one of the following:

a From the Filemenu, select Print.

b On the toolbar, click thePrint Records button.
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NOTES:
l Reports can be scheduled to be printed, faxed, or emailed at a specific time and frequency.

l Reports can be faxed or emailed immediately to a recipient from this window.

l Use theDefaults command from themenu to save a default report type and automatically have that report at
the top of the list the next time you return toReport Printing.

Saving printer settings

To save printer settings:

1 Select a printer from the drop-down list.

2 Select the paper size in theSize drop-down list.

3 Select the tray settings in the Tray drop-down list.

4 Select the quality in theQuality drop-down list.

5 The list of these options depends on your printer.

6 To print specific pages, enter their numbers in the text boxes next toPages.

7 Select how many copies you want by clicking on the up and down arrows next toCopies.

8 Select Save Printer Settings.

Printing reports to screen—print preview

You can preview reports before you print them by clicking thePrint preview and Drilldown (when available) button. It is
located on each report printing window on the toolbar in the upper right. It is indicated by the button displaying amagnifying
glass.

Viewing reports in print preview also provides the platform for drilling down into report information. When you are viewing a
report in print preview and if there is drillable information on that report page, your cursor becomes amagnifying glass.
When the lens displays a red circle, you can double-click the row or field to drill down to the details of the report information.

Drilling Down into Report Information
About program-wide drill-down into report information

Sage 100 Contractor provides over 1200 in-product reports to enable you to analyze the state of your business frommany
different perspectives. In addition to the information available on reports themselves, you can also “drill down” into the
information in most reports’ rows and fields.

To drill down into report information:

1 Open a record window (3-5 Jobs (Accounts Receivable), and select a record (for example, 186).

2 Click thePrint records button.

3 Select a report, and click thePrint preview and Drilldown (when available) button.

4 The report appears in “print preview”mode.

If there is drillable information on that page of the report, your cursor resembles amagnifying glass; otherwise, it remains an
arrow. When youmove the cursor over values on the report, the lens may display a red circle. The red circle indicates that
you can drill down into that piece of information.
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Examples of Drilling Down into Report Information

NOTE: In the following examples, Sage 100 Contractor is running the Sample Company, menu 3-1-3 Receivable
Aging, and the 31-Current Job Aging report. The report was run without selection criteria.

l Drilling down into rows - A single click on the information reveals whether you are drilling to information contained
in a row (notice the arrows at each end of the row) or an individual field. In this case, the first line contains a drillable
row in addition to two drillable fields, Job# andCurrent Retention.

Job# Description Current + Retention

186 Williams Post Office 149,696.25

201 TrappenMotel 156,053.48

207 Wood Elementary School

Double-clicking the row drills down to the job record 186—Williams Post Office in the 3-5 Jobs (Accounts
Receivable)window.

l Drilling down into fields - Drillable information contained in a single field is depicted differently. In a drillable field,
you see arrows at each end of the field.Double-clicking the field opens a grid window that shows the details of the
value, as shown in the 31—Job Current Aging~Current + Retentionwindow.

Notice that the grid window displays the value in addition to the values that have been added together to create the
drillable field value. At the bottom left corner of the grid window is aDrill Down button. By selecting a grid cell in the
A/R Invoices Balance column (9,569.34) and clickingDrill Down, you can drill to the invoice.

From that invoice, you can continue to drill down to information through other reports. In addition, the status bar
below the grid displays the selection criteria of the cell when the query selection criteria contains a “Where” clause.

This information can help you understand why certain information is in a grid and (equally as important) why certain
information is not in the grid. For example, if you are expecting to see an important invoice on a grid but it’s not
showing up, the information in the status bar can show information revealing that the invoice has incorrect status.
This allows you to locate the invoice and correct its status.

Basic Rules for Drilling Down into Reports

NOTE: We recommend that you try drilling down into your own business’s reports. Hands-on practice with familiar
reports is the best way to understand how drilling down into reports actually works.

l To be drillable, a row or field must have a “non-zero” value.

l Only fields that are located within a detail section of a report may be drillable. Fields on the form design portion of the
report are not drillable. Headings, totals, and no print fields are not drillable.

l Screen review of grid printing is not drillable.

l To be drillable, fields must be placed in a “Group,” “Detail,” or “Subtotal” row type.

Notes about reports

l If there is noModify Report button on the report, youmay be able to drill down into a sub-report, then to a record,
and then subsequent reports or records.

l When viewing a report, if there is nomagnifying glass cursor on that page, then there are no drillable rows or fields on
that page. For example, the first page of a report may contain design elements and no data, which are not drillable.
The second pagemay contain drillable data.
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l If your cursor becomes an hourglass when closing a report, be aware that long reports containing a hundred or more
pages may take a few seconds to close. 

l Running large reports may take several minutes. You can disable drilling down from any Report Printingwindow
for that instance by choosingOptions > Disable print preview drill down to speed up running the report.

Editing reports for drill-down

When you open a report in print preview, you expect to be able to drill down into the report’s information; however, not all
reports contain rows and fields that are immediately drillable. You can edit an existing standard report or a custom report to
be able to drill down to information that might be otherwise unavailable.

The following procedure provides an example of how editing a standard report canmakemore information drillable.

To edit a report for drill-down:

IMPORTANT: The report may contain tables pertaining to different records. In such a case, youmust insert the
appropriate record number field to enable drilling down into specific rows.

1 Open 3-7 Progress Billing, and using data control select a record.

2 On the toolbar, click thePrint records button

3 The 3-7 Report Printingwindow opens. By default, the first report is selected, 21-Progress Billing~by Cost Code.

4 On the tool bar, click thePrint preview and Drilldown (when available) button.

5 The 21—Progress Billing~by Cost Code report window opens. In this example the report contains three pages.

6 Scroll to the second page, and note that fields in the first column are drillable but that none of the fields in the other
columns are drillable. Now let’s edit the report so that the rows are drillable.

7 Exit the report, and on the 3-7 Report Printingwindow, with 21-Progress Billing~by Cost Code selected, click the
Modify Report button.

8 The 13-3 Report Writer window opens.

NOTE: On the left of the report form, you seeHeading, Detail, and Totals. To be drillable, fields must be placed in a
Group, Detail, orSubtotal row type. BecauseHeadings and Totals are not drillable, you insert the text field in the
Details row type.

9 In theDetail row, to insert a text field, click once. If you insert a text field outside the size of a printable page, the query
result for that field will be not be visible to customers.

10 On the toolbar, locate and click the Insert fields from a list button.

11 The Insert a Fieldwindow opens.

12 From the list of Fields in the Progress Billing Lines table, locate and double-click theRecord# line.

IMPORTANT: The field you insert must be a record number pertaining to the rows in the report. Insert a progress
billing record number field to drill down into progress billing rows.

13 That field now appears in the report form.

14 Click File > Save, and save the report under a new name, such as 03070001.

NOTE: Name your edited report using numbers ending in -01 to -20. Numbers -21 through -99 are reserved for
existing reports. If you follow the standard numbering scheme, for example 0307xxxx, the edited reports for 3-7
Progress Billing, are grouped together.
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15 Exit 13-3 Report Writer, and you return to 3-7 Report Printingwith the edited report 01-Progress Billing~by Cost
Code selected.

16 On the tool bar, click thePrint preview and Drilldown (when available) button.

17 The 01—Progress Billing~by Cost Code report window opens.

18 Scroll to the second page.

19 Note that fields in the first column are still drillable. Move your cursor over a value in theContract column, and double-
click to go to the progress billing record number for that row.

TIP: We recommend that you try variations of this procedure on other reports to fine-tune drilling down into standard
or custom reports to better meet your business needs.

Modifying custom reports for drill-down

IMPORTANT: If you havemodified reports, read this information regarding drilling down into report information,
custom reports, and Version 13 or later.

In a few cases, some Sage 100 Contractor reports weremodified so that drilling downworks correctly. Therefore, any
custom reports based on these following reports must bemodified.

Modifiable reports with changed calculated fields

6-1-2 Job Cost Journal modifiable reports 6-1-2-21 through 6-1-2-54

The calculated field jobcst^veenum was changed to allow you to drill down to employees, vendors, and equipment
correctly. Custom reports based on any of these reports must bemodified with the new calculated field jobcst^veenum
found in Version 13 or later reports.

9-5 Takeoff Worksheet modifiable reports 9-5-0-21 through 9-5-0-47

The calculated field tkflin^recnum was changed to allow drilling to the job. Custom reports based on any of these reports
should bemodified with the new calculated field tkflin^recnum found in Version 13 or later reports.

Modifiable reports adjusted for drill-down:

3-10-3-91 T & M Detail Worksheet~with Total Markup Percentage and supplemental report 3-10-3-19 T &
M~Internal Use (Reprint)~ with Total Markup Percentage

The calculated field tmintl^markup was adjusted to the right to allow drilling down on the last column of the report. The tax
Yes/No calculated field was hiding the ability to drill down for this column.

5-1-4-46 Local Tax Report~with Differential

The employee field payrec.empnum was moved to the right to separate it from the timecard record number in order to allow
drilling down to the payroll record.

Working with Mailing Labels and Label Form Designs

Options for printing mailing labels
Sage 100 Contractor provides several form designs for mailing labels in the jobs, clients, vendors, and employee document
windows. You can print labels from the following windows:
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l Print labels for jobs in the 3-1-8 Job Documentswindow.

l Print labels for clients in the 3-1-7 Client Documentswindow.

l Print labels for vendors in the 4-1-6 Vendor Documentswindow.

l Print labels for employees in the 5-1-10 Employee Documentswindow.

Select the appropriate format for your printer type:

l Report 21 is for the laser printer with labels 3 across and 10 down.

l Report 31 is for a dot matrix with tractor feed format.

About label forms
Sage 100 Contractor provides several form designs for mailing labels in the Jobs, Clients, Vendors, andEmployee
Documentwindows. You can use these designs with Avery #5160 laser labels. For tractor feed labels, use theDMLabel1
design.

l In theVendor Documentswindow, you can print company return address labels using the Avery 5160 form
designs.

l Using Form/Report Page Design, you can create form designs to print labels for envelopes, file folders, floppy
disks, etc.

Label forms for laser printers
For laser printers, you can design single column ormultiple column forms. When you print a report or document, Sage 100
Contractor compares the form size and paper size. When the size of a form design is smaller than the paper size, Sage 100
Contractor determines how many forms it can print on a single sheet of paper. For this reason, the size of the forms must
evenly divide into the size of the page.

To determine the form width for multiple column forms, divide the page width by the number of desired columns and round
down to the nearest hundredth of an inch. When determining the form length however, youmust be able to divide the form
height evenly into the page length.

Example: 1-inch wide, three column labels on 8.5-by-11-inch paper

l 8.5 (paper width) / 3 (number of columns) = 2.8333, or 2.83 inches

l 11 (paper length) / 1 (label width) = 11

l The form size is 2.83 by 1 inches.

After creating the form size, add fields to automatically print information from the database onto the labels. When the design
is complete, save the form design with the correct file name extension so that you can access the form design in the correct
Report Printingwindow.

TIP: It is a good idea tomodify an existingmailing label form and save the new form design using a unique name.

Label forms for tractor printers
When you print a report or document, Sage 100 Contractor compares the form size and paper size. Forms for dot matrix
printers usually contain a single column; therefore, set the form width to equal the page width. When determining the form
length however, youmust be able to divide the form height evenly into the page length.
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Example: 1-inch wide, single column labels on 3-by-11-inch tractor feed paper

l 11 (paper length) / 1 (label width) = 11

l The form size is 3 by 1 inches.

After creating the form size, add fields to automatically print information from the database onto the labels. When the design
is complete, save the form design with the correct file name extension so that you can access the form design in the correct
Report Printingwindow.

TIPS:
l It is a good idea tomodify an existingmailing label form and save the new form design using a unique name.

l The page length indicated in your printer drivers can be different from the actual page length. When printing 2-
inch labels, for example, indicate a 14-inch page length in the printer drivers.

Creating part form designs for Avery labels
You can create a new report from a vendor labels report and use it to print your part numbers as barcode labels.

To create a part form design for an Avery label:
1 In the 13-5 Form/Report Page Designwindow, from the Filemenu, select Open.

2 Click the [Display Private/Shared/System Report Forms] button.

3 Locate and double-click Avery5160.Docs_Vendor form in the Full Form Name column.

4 Click the field actpay^mallbl,right-click, then click Delete.

The field disappears from the form.

5 On the Insertmenu, click Text, then click once in the form page to insert a text area.

6 On the Insertmenu, click Fields.

7 The Insert Fieldswindow opens.

8 Select List Tables by Name.

9 In the table list, click Takeoff Parts.

10In the field list, double-click the fieldPart#.

11 Right-click Part# and select Properties.

12 TheObject Propertieswindow opens.

13 Under Font, select eitherBC C39 3 to 1 HD Wide orBC UPC HD Wide in theName drop-down.

14 Click OK.

15 From the Filemenu, select Save.

16 In theSave File dialog box, save the file with the name Avery5160.Docs_Parts.

This form design can now be added to a report to print Avery 5160 labels for parts.

Printing barcodes as labels
You can create a new report from a vendor-labels documents to print your part numbers as barcode labels.

IMPORTANT: For the label page format to print correctly, the label widthmust be at least one inch.
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IMPORTANT: For the barcodes to print correctly, youmust use the correct label printing paper.

To print a barcode as a label:
1 In the 13-3 Report Writerwindow, from the Filemenu, click New.

2 In theReport Titlewindow, enter a report name. For example, you could name the report Parts Label.

3 Click Next, then select thePrimary Table.

4 To print barcode labels, the table to select is Takeoff Parts.

5 Click Next.

6 In theReport Form window, browse to a form design that you previously created.

For example, youmay have created a form design and named it Avery5160.Docs_Parts.

7 Click Open, then click Next.

8 In theDisplay Fieldswindow, select the part number field, which is tkfprt.recnum, then click Next.

9 In theGroup Fields andSort Fields windows, click Next.

10 In theSelection Fieldswindow, select the criteria by which to print the labels, such as Part #, then click Next.

11 In theSelection Criteriawindow, modify the criteria to fit your business requirements, then click Next.

12 In thePage Settingswindow, click Finish.

13 In the 13-3 Report Writerwindow, in the Filemenu, click Save.

14 Open 13-4 Report Printing, and select the report for printing barcodes as labels.

15 Click thePrint Record to Screen button to view the report before printing it.

Make adjustments to the form, as necessary.

16 Click thePrint Records button to print the barcodes as labels.

Using MICR to Print Your Own Checks

About check forms
You can purchase blank or pre-printed check forms from a variety of vendors for tractor feed and laser printers; however, we
recommend Sage Construction and Real Estate Forms. Several check designs come pre-installed, which includes two and
three part formats for both laser and tractor feed printers.

Businesses that usemultiple checking accounts or operatemore than one company may find blank forms more versatile
than pre-printed forms. With blank forms, you can switch between companies or accounts without having to change check
forms.

l When designing a check format, you can incorporate a company logo into the form. Using Form/Report Page
Design, you can insert the bitmap file in the form design of the check.

l If your printer driver provides the ability to print multiple copies and you use a laser printer, you canmake copies of
checks by placing a blank page after every check form. Then in theCopies box, select two copies. When you print
the checks, Sage 100 Contractor prints a duplicate of each check on blank paper.

l To use a tractor feed printer with your check forms, you need to indicate the form length in yourPrinter Setup dialog
box.
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l Most 2-part tractor feed check forms are 7 inches long. If your printer driver does not support the form length, you
need to create a custom form length in the printer setup, obtain 11-inch check forms, or use a different printer driver.

l If the tractor feed printer is connected to a network, you need to set up the custom form length on each workstation
that prints checks.

About checks and Check 21 regulations
The Check Processing for the 21st Century Act (Check 21) requires that banks accept scanned representations of checks
sent electronically in place of the original paper checks. This legislation came into effect in October of 2004 with the dual
purposes of speeding up checkclearing and helping prevent future disruption of the cash flow in the United States if air
traffic were to be halted for any reason.

For all banks to accept the electronic representations of checks, theremust be very strict requirements for how they look.
For example, all fonts must meet certain specifications, and the placement of fields, such as the check dollar amount, must
be standardized. At the present time, however, this only affects machine-printed checks.

The American National Standards Institute (ANSI) administers and coordinates the U.S. voluntary standardization and
conformity assessment system. ANSI regulations have changed the requirements for printing checks, and Sage 100
Contractor has made specific changes to check forms tomeet these requirements. For example, the fonts for the dollar
sign ($) and for text in fields across the check are ANSI-compliant.

Because of the new law, it is important that our customers understand the risks associated with changing the Sage 100
Contractor supported formatting. These risks are detailed below.

The bank’s scanner may not recognize the text and dollar amount and reject the check if these conditions exist:

l If youmove or change the font for the dollar sign ($) or the amount on the check form.

l If you fail to properly update your old check form tomeet the ANSI requirements, the banks at some point will notify
you that your checks are not compliant.

Note that when you install Sage 100 Contractor, you install the new check forms that meet the Check 21 requirements. You
can, however, continue to use the old check forms, which print just as they did before. As you have time, you can transition
to the new check forms.

Check 21 formatting requirements
There are some very important facts to know regarding the Check 21 formatting requirements.

l The font and size of the date and printed dollar amount must be Arial 10-Regular.

l The font and size of the dollar signmust beOCR B MT 12-Regular. This font is now installed with the Sage 100
Contractor product.

l The dollar signmust have a be aminimum clearance of 0.10 of an inch from both the date and from the printed dollar
amount. We recommend one eighth of an inch.

When the bank scans the area on the check containing the amount of the check (the CAR box), it looks for the dollar sign
($), followed by a blank space to locate the printed dollar amount. The asterisk acts as a security device to protect the dollar
amount.

The dollar sign and printed dollar amount must be inside of the CAR box. The date is not part of the Check 21 requirements,
and is not required to be in the CAR box scan area.

A minimum of 0.10" (1/10") is required from the bottom of the pre-printed word “AMOUNT” to the top of the printed dollar
amount.
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We recommendworking in eighths, sixteenths, and
thirty-seconds of an inch becausemost rulers and tape
measures are graduated that way.

About printing your own check forms
Suppose that with each new joint venture project you open a new checking account for that project. Over the course of the
job, youmight write about 100 checks to pay vendors. To write a relatively small number of checks on pre-printed forms is
not cost efficient, as you will not usemost of the checks.

In the 13-5 Form/Report Page Designwindow, you can create check form designs for individual companies or checking
accounts. By creating your own check form designs, you can print the check forms on demand. Many form suppliers carry
blank check stock, and often provide a choice between pre-numbered or unnumbered check stock.

When you need to print a check, you can select the appropriate custom form design for the checking account. With blank
check forms inserted in your laser printer, Sage 100 Contractor prints the design on the blank check stock at the same time
that it prints the checks for you.

Banks use a variety of scanning systems to read checks. Some use an optical character recognition system that scans for
a special font at the bottom of the check. Others usemagnetic ink character recognition (MICR) systems that read
magnetic ink in the font at the bottom of the check. Because your checks might pass through a variety of banks, each using
a different recognition system, we recommend that you design the check forms for recognition by both systems.

Viewing sample MICR checks
To view a sample MICR check:
1 Open 1-1 Checks/Bank Charges, and then click thePrint Records button.

2 Click the drop-down arrow by theReport Form box.

3 Scroll to findSampleCheckMICR.Check_GL.

4 Enter appropriate selection criteria, and click thePrint Record to Screen button.
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Creating your own check forms from blank checks
Sage 100 Contractor uses different check form designs in each location from which you can print checks: 1-1
Checks/Bank Charges, 4-3 Vendor Payments, 5-2-4 Payroll Checks, and 8-5 Equipment Payments. If you are using
blank checks, you need to create a new check form design for each company and checking account in each location from
which you intend to print checks.

Suppose that your company only uses two checking accounts. One account is strictly for payroll while the other covers all
other payments. For the payroll checking account, create one form that Sage 100 Contractor uses when you print checks
from the 5-2-4 Payroll Checkswindow. For the general checking account, you need to create three separate forms to print
checks from each of the remaining locations.

When designing your own checks, place three different fields on the bottom of the check design and formatted with the
MICR font.

l In the left corner, the check numbermust be printed.

l In themiddle, the routing number and account numbermust print.

l In the right corner, the check amount must print.

Youmust purchase and install theMICR fonts in order to print the appropriate information on your checks.

TheMICR fonts allow you to type the special characters on your checks that banks use to read the routing number,
account number, and the amount.

IMPORTANT: Be sure that you are using theMICR toner cartridge when usingMICR fonts.

IMPORTANT: Confirm that your checks are printing correctly by taking a sample check produced with data from a
sample company to your bank to ensure that all data is conveyed correctly.

To create your own check forms:
1 Open 13-5 Form/Report Page Design.

2 From the Filemenu, click Open, then select the form design you want to edit.

TIP: If you do not know the name of the form design to edit, open theReport Printingwindow as if you were printing
checks. On theEditmenu, click Form Design.

3 In the upper left portion of the check, draw a text box. Then enter the company information and bank information.

4 In the upper right corner of the check, draw a text box. Then from the Insert menu, click Fields, thenCalculated Fields.

5 TheCalculated Fieldswindow appears.

6 Select theCheck Number field.

7 In the left bottom corner, draw a text box that will contain the check number.

8 Click Edit, thenCalculated Fields.

9 Click the drop-down arrow next to theCalculation box to display theGlobal Calculated Fieldswindow, then select
Micro code check number (lgtnln^chknmc) from the list.

10 Click Add to add toCalculated Fields for this form.

11 From the Insertmenu, click Fields, thenCalculated Fields, then select theMicro code check number.

12 From theEditmenu, click Font.

13 Select theAdvMICR font, apply to theMicro code check number, then click OK.
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14 In themiddle of the form at the bottom, type in the routing number and account number. From theEditmenu, click Font.
Select theAdvMICR font, and click OK.

15 Repeat steps 7–12, and instead of selectingMicro code check number, selectMicro code check amount
(lgtnln^chkamc).

16 From the Insertmenu, click Fields, thenCalculated Fields, then select theMicro code check amount.

17 From theEditmenu, click Font.

18 Select theAdvMICR font, apply to theMicro code check amount, and click OK.

19 From the Filemenu, click Save, then save each form with a unique name and the correct file name extension.

20 Verify the routing number, checking account number, and the symbols. Then verify the placement of theMICR line.

TIP: You can view a sampleMICR check.

MICR fonts and toner cartridges
Preprinted check forms use aMagnetic Ink Character Recognition (MICR) font at the base of the check where the routing
number, checking account number, and individual check number is printed using amagnetic ink. Printing your own check
forms, therefore, requires a specific MICR TrueType font, also referred to as E-13B, which you use to encode the required
information on the base line of your check. You will also need aMICR toner cartridge for your laser printer.

MICR toner cartridges can cost 20% to 30% more than standard toner cartridges and are not available for all brands or
models of printers. What you can save by printing your own checks usually covers more than the increase in costs for
MICR toner cartridges. However, you will need to determine whether MICR toner is available for your make andmodel of
laser printer.

When you replace the standard toner cartridge with theMICR toner cartridge, remnants of toner from the former cartridge
can remain in your printer. Youmight have to print several test pages before the printer begins using theMICR toner. It is a
good idea to leave theMICR toner cartridge in your printer as constant swapping between cartridges can reduce their life
spans.

MICR suppliers
There are a variety of MICR font and toner suppliers across the United States and . Some companies sell instructions and
calibration routines to positionMICR fonts correctly, while a couple of others will verify placement for you at little or no cost.
Your local bank might also be willing to check the placement for you.

If you have access to the Internet, you can locate quite a few suppliers. Use any popular search engine to search for the
character stringMICR fonts.

You can also contact the following companies:

l Printech, Inc. (305) 592-2838

l Advantage Laser Products (800) 722-2804

About typing MICR characters
To create the proper magnetic stripe, theMICR fonts contain numbers, space, and separator symbols. In Sage 100
Contractor, the separators are created using A, B, C, and D and are compatible with current MICR font standard.

The data printed at the bottom of a check contains two different sets of symbols: (1) separators, which start and end a data
zone; and (2) numbers, which contain routing, bank account, and check numbers.
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Separator character name MICR symbol Letter to type

Transit A

Amount B

On-Us C

Dash D

Each separator has a special meaning for themagnetic or optical reader just as quotes, brackets, and parentheses have for
regular text.

l Transit: The data between two transit symbols indicate the institution from which the funds are drawn.

l Amount:What is between these separators is the amount of the check. This is usually used internally by banks
upon processing, and this field should not be used by customers under normal circumstances.

l On-Us: This symbol tells the reader that the following digits represent the account number and other important
information.

l Dash: This is sometimes used to separate items in the account number and routing information. Some banks
replace it by a simple space.

Numbers (digits) have the samemeaning as usual, occupy their normal place in the ASCII table, and can be typed directly
from the keyboard.

NOTE: When usingMICR fonts, the font must be set to point size 12.

MICR Example

The following is an example of the data that youmight enter in a plain font and how it would appear to you.

012045078A1102 C120D0120450C

What you typed should appear on your check looking very similar to this example.

012045078 1102 120 0120450

13-5 Form/Report Page Design
Every report, document, or letter that you generate uses a form design. A form design is a template for the layout of a page
or pages. With 13-5 Form/Report Page Design, you can edit any of the form designs supplied with Sage 100 Contractor,
or create entirely new forms. You can change the graphic elements and layout of the form, as well as the boilerplate text.
This is especially useful when a company has several different businesses, and needs to use different forms for each
business.

Before creating a report, it is important to understand how 13-3 Report Writer and Form/Report Page Designwork
together.

l In 13-5 Form/Report Page Design, you create the page layout for a single page form or amulti-page form that
includes text, fields, and calculated fields. Form designs also use a detail box, which indicates where the details of
the report will be placed.

l In 13-3 Report Writer, you create the body of the report that appears in the detail box of the form design. In the
design of the report details, you can include text, fields, and calculated fields. In addition, you can control when a
report prints on a new page or on an entirely new form.
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13-5 Form/Report Page Design provides the ability to createmulti-page forms. Suppose that you always send a cover
letter with each proposal to potential clients. You can incorporate both the cover letter and the proposal forms in a single
design. Then when you print proposals, the cover letter always prints with the proposal. A form can have up to 100 pages,
each of which you can format differently.

l Creating new forms

l Creating new forms using existing forms

l Editing existing forms

l Previewing forms

Creating new forms

NOTE: Be aware that sometimes it is quicker to create a new form from an existing form if you only have tomake a
few changes or additions.

To create a new form, open 13-5 Form Report/Page Design. The 13-5 Form Report/Page Designwindow appears and
displays a blank page on which you can begin creating your new form.

Creating new forms using existing forms

It may be easier for you to use an existing form to create a new form. For example, in the 3-2 Report Printingwindow, on
theReport Criteria tab, you see a list of reports. When you click a report in theReport Criteria list, the form upon which
the report is based is displayed in theReport Form drop-down list.

Report Report Form

21—Receivable Invoice System.Invoice_AR

22—Receivable Invoice~with Notes System.Invoice_AR

23—Receivable Invoice~Retention System.Invoice_AR_Retention

24—Receivable Invoice~Retention;
with Notes System.Invoice_AR_Retention

31—Receivable Credit System.Credit_AR

The system forms follow a specific naming pattern, for example, System.Invoice_AR. For the new report to appear in
Sage 100 Contractor in the area in which you would want it to appear, it must be saved with a similar naming scheme. For
example, YourName.Invoice_AR. You do not need to preserve “System” in the name, youmust retain the .Invoice_AR in
the name. The "System" designation is intended to identify the forms that are included with the program installation. Forms
that you create or modify should not include "System" in the name.

NOTE: Form designs are listed alphabetically in the report form list. To see your new forms listed before the
"System" reports, use a name that will appear before the word system.

When you open a system report and save it with a new name, it is saved by default to the \Report Forms folder; however,
you can choose to save it in a different folder. If you save it to a different folder, it will not appear in the program.
To create a new form using an existing form
1 Open, for example, the 3-2 Receivable Invoices/Creditswindow.

2 Click thePrint Records button.

3 On the 3-2 Report Printingwindow, in theReport Form list, click the drop-down arrow and select the form design that
you want to edit.
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4 From theEditmenu, select Form Design.

5 On 13-5 Form/Report Page Design, edit the form.

6 From the Filemenu, select Save.

7 On theSave Filewindow, name the new form and then click Save.
When you need to make a large number of changes, it might be easier to create a new form from scratch in the
13-5 Form/Report Page Design window.

Editing existing forms
To edit an existing form design in 13-5 Form/Report Page Design
1 Open 13-5 Report/Form Page Design.

2 Select File > Open.

3 Do one of the following in the Select a Report Form window:

a Select the [Display Private Report Forms] button to select from a list of forms stored on your local drive that only
you have access to. These forms are stored in the \Users\Username\AppData\Local\Sage\Sage 100
Contractor\Custom Reports folder.

b Select the [Display Shared Report Forms] button to select from a list of forms stored on a shared drive that all users
have access to.

c Select the [Display System Report Forms] button to select from a list of system forms that youmay customize.

4 Select the form design that you want to edit.

5 On the 13-5 Form/Report Page Designwindow, edit the form.

6 Select File > Save and save as a shared form design or as a private form design, depending on your preference.
To edit an existing form design from a Report Printing window
1 Open any Report Printingwindow, for example 3-2 Receivable Invoices/Credits.

2 Click thePrint Records button.

3 Select the form design that you want to edit.

4 From theEditmenu, select Form Design.

5 On the 13-5 Form/Report Page Designwindow, edit the form.

6 Select File > Save and save as a shared form design or as a private form design, depending on your preference.

Previewing forms
To preview a form within 13-5 Form/Report Page Design:
1 From the 13-5 Form/Report Page Designwindow, select Pages > View Page.

To preview a form from within a Report Printing window:
1 Open the report and select the Report Form for preview.

2 Select Edit > Form Design.

3 Select Pages > View Page.

Reducing the document size when previewing forms

When previewing a form, you can reduce the size of a document displayed in theScreen Reviewwindow.
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In theScreen Reviewwindow, select View Options, then select the percentage size (100%, 85%, 70%, or 50%) at which
you want to view the report.

Working with text in 13-5 Form/Report Page Design
You can use the following text options in forms :

l Typing text

l Editing text

l Checking the spelling

l Changing fonts

l Aligning text

To type text
1 In 13-5 Report/Form Page Design, open the form in which you want to type text.

2 Click where you want to place the text.

3 Type the text you want to enter.
To edit text
1 In 13-5 Report/Form Page Design, open the form in which you want to edit text.

2 Double click on the field you want to edit andmake the changes that you want.
To check the spelling
1 In 13-5 Report/Form Page Design, open the form in which you want to check spelling.

2 From theEditmenu, click Spell Check.
To change fonts
1 In 13-5 Report/Form Page Design, open the form in which you want to change fonts.

2 Highlight the field or fields that need font changes.

3 From theEditmenu, click Font.

4 In the Fontwindow, select the Font, Font style, Size, andEffects as needed.

5 Click OK.
To align text
1 In 13-5 Report/Form Page Design, open the form in which you want to align text.

2 Click the text that you want to align.

3 From theEditmenu, click Align Left orAlign Right, as needed.

NOTE: The text aligns itself to where the text begins, and not themargin.

Working with pages in 13-5 Form/Report Page Design
In thePagesmenu, you can do the following page options:

l Adding new pages

l Inserting new pages
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l Copying pages

l Pasting pages

l Removing pages

NOTE: When you add a page, the page is automatically added as the last page. If you want to control where a page is
added, use the Insert Page selection under thePagesmenu.

To add a new page
1 In 13-5 Form/Report Page Design, on thePagesmenu, click Add Page.

2 Click Save.
To insert a new page
1 In 13-5 Form/Report Page Design, display the page above which you want to insert a new page.

2 From thePagesmenu, click Insert Page.

3 Click Save.
To copy a page
1 In 13-5 Form/Report Page Design, select the page you want to copy.

2 From thePagesmenu, click Copy Page.

3 Click Save.
To paste a page
1 In 13-5 Form/Report Page Design, select the page to paste a copied page to.

2 From thePagesmenu, click Paste Page.

3 Click Save.
To remove a page
1 In 13-5 Form/Report Page Design, display the page that you want to remove.

2 On thePagesmenu, click Remove Page.

3 Click Save.

About form and report page design layout
In thePages > Page Format dialog box, you can set the following options:

l Page Size

l Margins

l Snap to Position Setting

l Disable or enable a 1/4 InchGrid to align design elements

To set the page size
1 In 13-5 Form/Report Page Design, on thePagesmenu, click Page Format.

2 UnderPage Size, enter the size of the page on which you want to base your design.

3 Click Save.
To set the page margins
1 In 13-5 Form/Report Page Design, on thePagesmenu, click Page Format.
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2 UnderMargins, enter the values for the pagemargins.

3 Click Save.
To position objects with snap lines
1 In 13-5 Form/Report Page Design, on thePagesmenu, click Page Format.

2 Under the Layout Tools section, next toSize of snap-to-position grid, click the arrows to select the position, up to
10/16".

3 Click Save.
To display a quarter-inch grid
1 In 13-5 Form/Report Page Design, on thePagesmenu, click Page Format.

2 Under the Layout Tools section, click Show ¼" grid in background.

3 Click Save.

Tools for Building Form Designs
You can use the following tools for building form designs:

l Lines

l Boxes

l Logos, Pictures, andObjects

l Fields

NOTE: To undo changes to a form, on theEditmenu, click Undo.

To move a selection:
1 In 13-5 Form/Report Page Design, open the form in which you want to move a selection.

2 Select the item you want to move.

3 Drag the selection to the desired location.

4 Tomovemultiple selections at the same time, hold down the [Ctrl] key and drag themouse over the objects to be
selected.

Lines
To draw a line
1 In 13-5 Form/Report Page Design, open the form in which you want to draw a line.

2 In the Insertmenu, click Line.

3 In the status bar area, select the line width and type of line you want to draw.

4 Click in the grid to draw the line and drag the pointer.
To set the line color
1 In 13-5 Form/Report Page Design, select the line on which to change the color.

2 In theEditmenu, click Color.

3 Click the color you want to use.

4 Click OK.
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Boxes

NOTE: You can insert a text box directly inside a box or detail area box, or drag an existing text box and drop it into a
box or detail area box.

To draw a box
1 In 13-5 Form/Report Page Design, open the form in which you want to draw a box.

2 On the Insertmenu, click Box.

3 Click in the location where you want to place one corner of the box and drag the pointer diagonally to the size you want.
To create a detail area box:

The detail box determines where the body of the report appears on a form design when you generate the report.

1 In 13-5 Form/Report Page Design, open the form in which you want to create a detail area box.

2 On the Insertmenu, click Detail Area.

3 Click in the location where you want to place one corner of the detail area box and drag the pointer diagonally to the size
you want.

Logos, Pictures, and Objects
To insert a picture or logo
1 In 13-5 Form/Report Page Design, open the form into which you want to insert a graphic.

2 On the Insertmenu, click Picture.

3 TheAssign Picture dialog box appears.

4 Select the bitmap file that you want to insert.

5 Click Open.

6 On theEditmenu, click Select Objects, then click the picture andmove to the appropriate area on the form.
To add a company logo to all report forms

This procedure adds a company logo to all report forms that share the same logo. The sample logo available in Sage 100
Contractor calls one specific file from the \Report Forms folder and inserts it in all reports that display a logo. You can
rename your logo file to this name and it will be displayed in those reports automatically.

IMPORTANT: Youmay need to stretch or shrink your logo on the reports.

1 UsingWindows Explorer, navigate to the \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\Report
Forms folder on the local drive where you installed Sage 100 Contractor or the drive from which you print.

2 Rename the existing sample logo from logo.bmp to originallogo.bmp.

3 Copy your own logo file into the folder, and rename it logo.bmp.

4 Your logo will now automatically display in reports that use a logo.

NOTE: If you re-install Sage 100 Contractor, Sage 100 Contractor saves the logo.bmp file with themost recent date.
It will not overwrite your file.

To adjust the proportions of a picture or object
1 In 13-5 Form/Report Page Design, open the form in which you want to reproportion a graphic or object.

2 Drag the picture in the direction that you want to stretch or shrink it.

3 Click the image to change its proportions.
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To delete an object
1 In 13-5 Form/Report Page Design, open the form in which you want to delete an object.

2 Click the object or text block that you want to delete.

3 Right click on the object or text box, then click Delete.

Fields
Fields are special codes that instruct Sage 100 Contractor to replace the field with information from a database. For
example, youmight want to include the job number on a report for payable invoices. You can insert theACPINV.JOBNUM
field in the report design. Then, when you generate the report, Sage 100 Contractor fills in the appropriate information for
you.

With fields, you can create form designs and report designs to automatically add or update information in your reports and
documents. Fields provide you access to data throughout Sage 100 Contractor. Because you can place fields in both report
designs and form designs, you need to determine which fields are necessary and then decide where to insert them. It is a
good idea to placemost all fields in the report design if possible, as this lets you reuse a small number of form designs for a
variety of reports.

Like other objects in a form or report design, you can set object properties for fields. When you generate a report or
document, Sage 100 Contractor inserts the information indicated by the field. If the database does not contain information
requested by the field, Sage 100 Contractor leaves the field blank in the resulting report or document. However, you can set
the property of a field to print a zero rather than leaving the field blank.

NOTES:
l For each field you want to insert, create a new text box.

l You can format text or graphics by setting the object properties.

To insert fields
1 In 13-5 Form/Report Page Design, open the form into which you want to insert fields.

2 On the Insertmenu, click Text.

3 Insert the pointer where you want to place the text.

4 On the Insertmenu, click Fields.

5 In the Tables by Menu section, click the table that you want to use.

6 In the Fields in {table name} section, double-click the field that you want to use.

Saving and naming form/report page design
When you save a form or report page design, Sage 100 Contractor saves it as a file. Form designs use different file name
extensions to organize the forms intomeaningful groups.

The system forms follow a specific naming pattern, for example, System.Invoice_AR. For the new report to appear in
Sage 100 Contractor in the area in which you would want it to appear, it must be saved with a similar naming scheme. For
example, YourName.Invoice_AR. You do not need to preserve “System” in the name, youmust retain the .Invoice_AR in
the name. The "System" designation is intended to identify the forms that are included with the program installation. Forms
that you create or modify should not include "System" in the name.

NOTE: Form designs are listed alphabetically in the report form list. To see your new forms listed before the
"System" reports, use a name that will appear before the word system.
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When you open a system report and save it with a new name, it is saved by default to the \Report Forms folder; however,
you can choose to save it in a different folder. If you save it to a different folder, it will not appear in the program.

13-6 Report & Query Lists

Using the Report Query Wizard
TheQuery Wizard is a series of dialog boxes that you cycle through to create a report query.

To use the Query Wizard:
1 Open 4-2 Payable Invoices/Credits or any window where you can recall existing records.

2 On the toolbar, click the Find Records button.

3 In theQuery Listwindow, press theNew button.

4 Enter a query title in theQuery Title field to be displayed at the top of the report and click Next.

5 To select the fields you want to display, in the Layout the Reportwindow, do the following:

a In the Tables list, select a database table.

b In the Fields list, select the fields you want to display.

6 In the bottom panel, you can do the following actions:

l Add grouping to the report by dragging columns to the group area in the dark gray band. A maximum of three fields
can be used for grouping.

l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in the
main column row by holding the shift key when clicking additional columns.

l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in the
main column row by holding the shift key when clicking additional columns.

l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in the
main column row by holding the shift key when clicking additional columns.

7 Repeat steps a through c until you have selected all the tables and fields you want to display in your query, then click
Next.

8 To select the fields by which you want to sort the data, in theDefine the Selection Criteria dialog box, do the following:

a In the Tables list, select a database table.

b In the Fields list, select the fields by which you want to sort the query results

9 In the bottom panel, you can do the following actions:

l Select the comparison option to set as the default.

NOTE: For example, if you would like the default to be between or equal, you can set that as the default on the report
printing window.

l Lock criteria values to fix those values permanently in the report.
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NOTE: For example, in an invoice report that should exclude voided invoices, lock the invoice status criteria as 'Less
than 5-Void.'

10Repeat steps a through c until you have selected all the tables and fields by which you want to sort your query results,
then click Finish.

11In the Query List window, click the report you want to run, and click Run.

12Enter any values necessary for the selection criteria presented, and click Run.

To create a query:
1 On the Filemenu, click Find.

2 Click New.

3 In theName box, enter the name of the query.

4 Using theQuery Wizard, create the query.

TIP: After you create a query, Sage 100 Contractor automatically saves it.

To run a saved query:
5 On the Filemenu, click Find.

6 In the list, click the query you want.

7 Click Run.

To delete a saved query:
1 On the Filemenu, click Find.

2 In the list, click the query you want.

3 Click Delete.

Using the Query Wizard

TheQuery Wizard is a series of dialog boxes that you cycle through to create a report query.

To use the Query Wizard:

1 Open 4-2 Payable Invoices/Credits or any window where you can recall existing records.

2 On the toolbar, click the Find Records button.

3 In theQuery Listwindow, press theNew button.

4 Enter a query title in theQuery Title field to be displayed at the top of the report and click Next.

5 To select the fields you want to display, in the Layout the Reportwindow, do the following:

a In the Tables list, select a database table.

b In the Fields list, select the fields you want to display.

6 In the bottom panel, you can do the following actions:

l Add grouping to the report by dragging columns to the group area in the dark gray band. A maximum of three fields
can be used for grouping.
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l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in the
main column row by holding the shift key when clicking additional columns.

l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in the
main column row by holding the shift key when clicking additional columns.

l Add sorting by clicking on a column. The number that appears next to the column name is the next consecutive
number after the last group. If no groups are defined, the sort column displays a 1. You can havemultiple sorts in the
main column row by holding the shift key when clicking additional columns.

7 Repeat steps a through c until you have selected all the tables and fields you want to display in your query, then click
Next.

8 To select the fields by which you want to sort the data, in theDefine the Selection Criteria dialog box, do the following:

a In the Tables list, select a database table.

b In the Fields list, select the fields by which you want to sort the query results

9 In the bottom panel, you can do the following actions:

l Select the comparison option to set as the default.

NOTE: For example, if you would like the default to be between or equal, you can set that as the default on the report
printing window.

l Lock criteria values to fix those values permanently in the report.

NOTE: For example, in an invoice report that should exclude voided invoices, lock the invoice status criteria as 'Less
than 5-Void.'

10Repeat steps a through c until you have selected all the tables and fields by which you want to sort your query results,
then click Finish.

11In the Query List window, click the report you want to run, and click Run.

12Enter any values necessary for the selection criteria presented, and click Run.

13-7 Print Database Format
Clicking 13-7 Print Database Format launches the 13-7 Report Printingwindow to be used to for printing Database
Format reports and viewing sample reports.

Report Printing window toolbar

TheReport Printingwindow toolbar buttons providemore versatile tools for working with reports. From right to left:

l Print records- Sends the selected report to the default printer or the printer you select from the printer selection
drop-downmenu.

l Print preview and Drilldown (when available)- Opens the selected report in print preview mode with drill-down
functionality.

l Send report data to Excel—Opens the report in an Excel worksheet.

l Send report to Word—Sends the report to anExport to Filewindow. Click Save to open the report inWord as an
RTF file. The default Save in folder is theReports folder under the company folder.
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l Create a PDF file of this report—Sends the report to anExport to Filewindow. Click Save to open the report in
Adobe Reader as a PDF file. The default Save in folder is theReports folder under the company folder.

l Send report as an Outlook email attachment—Launches Outlook with the report attached to an email message
as a PDF file.

l Email this report—Opens theEmail Distributionwindow which provides themeans to send amessage through
Sage 100 Contractor email functionality.

l Fax this report—Opens the Fax Distributionwindow which provides themeans to send a fax through Sage 100
Contractor faxing functionality. (Requires an installed fax/modem)

l Schedule this report—Opens theReport Schedulingwindow which provides themeans for you to schedule
sending the selected report.

l Set the print orientation to landscape or portrait—Becomes available when printing graphs or charts.

l Enter notes for this record—Opens theNoteswindow, and if the form design contains the field for inserting a
note, the text of the note is inserted in the selected report.

l Enter a new record—Clears the selection criteria and resets the form design to the saved default.

NOTES:
l Printing reports on legal-sized paper is a special condition.

l Printing Gantt charts works differently than other report printing. For example, youmust select a form design
with either portrait or landscape orientation. Paper size and the size of the detail section do not matter because
the program takes the selected form design elements and resizes them to fit the size of the selected printer
page size.

Report Scheduling

About report scheduling
From any Report Printing window, you can open the Report Scheduling window (File > Scheduling). You use this window
to:

l Schedule a report to print at a specific time and at a given frequency

l Specify the output options for the report (print, fax, or email)

l Determine to whom it should be sent.

This powerful tool provides the ability to control andmanage the flow of your messaging and information directly to your
vendors, clients, and employees. In addition, other features also provide a way to send reports andmessages to people
other than those on your distribution lists.

Under Output Options, you find controls for:

l Printer / File check box—Specify that the report will be printed or saved as a file. Selecting the check box activates
the Edit Printer Settings button. Click the button to edit your printer settings.

l Fax check box—Specifies that the report will be faxed. Selecting the check box activates the Edit Fax Settings
button. Click the button to edit your fax settings.

l Email check box—Specifies that the report will be attached to an email message. Selecting the check box activates
the Edit Email Settings button. Click the button to edit your email settings.

Under Frequency Options, you can specify:
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l Daily option

l Weekly option

l Bi-weekly option

l Monthly option

l Time of Day—Select a time of day or type a time of day in the box.

Under RecurrenceOptions, you find controls for:

l Print report such amount of times

l Repeat printing until such a date

l Print report until the schedule is deleted.

UnderWindows Authentication, you find boxes where to enter:

l Windows User ID

l Windows Password

Message for Email / Fax—Type a Subject Line andMessage when emailing and faxing reports.

You can view or edit your scheduled reports in the 7-7 Scheduled Reports Manager and see information about your
scheduled reports each time a scheduled report, fax, or email message is sent.

NOTE: Enter a validWindows User ID andWindows Password as setup in your business for your user profile. If you
do not enter a password or if you enter one that is not valid, the scheduled report will not run. Moreover, under these
conditions, you will not receive any notification that the report failed due to an invalid or missing password. If you
change your password, any previously scheduled reports must be rescheduled using yourWindows User ID and your
new Windows Password.

Scheduling reports

IMPORTANT: Scheduling reports to email, fax or print will not work if the company data is opened exclusively. If you
have a question, youmay review the file SARAEventLog.txt found in Users\username\AppData\Local\Sage\Sage
100 Contractor to see if a scheduled report has been sent or not and if the company was “opened for exclusive access
by another user.”

IMPORTANT: If you try to schedule a report that is non-schedulable–for example, one that prints checks or posts to
the general ledger—you will be prompted upon saving that it is not valid to schedule.

To schedule reports:
1 From any Report Printingwindow, do one of the following:

a From the Filemenu, click Scheduling.

b From the toolbar, click the scheduling button.

2 UnderOutput Options, select one or more of the following:

a Printer/File: Select Change Printer Settings to change any of your default printer settings for this report.

b Fax: Select Edit Fax Settings to select or change the fax recipients for this report.

NOTE: The Fax option is only available if your system successfully recognizes that a fax modem is connected.
Otherwise, the selection button is grayed out.
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c Email: Select Edit Email Settings to select or change the email recipients for this report.

3 Under Frequency Options, in the Time of day drop-down list, select the time of day that you want the report to run.

4 Under Frequency Options, select one of the following:

a Daily to have the report run every day at the time you have specified.

b Weekly to have the report run on a weekly schedule.
UnderPrinting Day(s), select which day(s) of the week that you want the report to run at the specified time.

c Bi-weekly to have the report run every other week. Indicate which day(s) of the week you want the report to be run at
the time you have specified.

5 UnderPrinting Day(s), select which day(s), every other week, that you want the report to run at the specified time.

a Monthly to have the report run on amonthly schedule at the time you have specified. Select one of the following:

b Print on day(#) of each month. Specify which day eachmonth that you want the report to run. For example, you can
specify the report to run the 15th of eachmonth.

c Print on the (occurrence) (day) of each month. Select which occurrence (first, second, third, fourth, or last) of the
month and which day of the week (Sunday throughSaturday) that your report should run. For example, you can
specify the report to run on the thirdWednesday of eachmonth.

6 UnderRecurrence Options, select one of the following:

a Print report (#) time(s). Enter the total number of times you want the report to print for the schedule you have
designated.

b Repeat until date. Enter the last date that you want the report to run.

c Print report until the schedule is deleted. The report runs indefinitely until you delete it from 7-7 Scheduled
Reports Manager.

7 UnderWindows Authentication, complete the following:

CAUTION:
Enter a validWindows User ID andWindows Password as set up for your business in your user profile. If you do
not enter a password or if you enter one that is not valid, the scheduled report will not run. Moreover, under these
conditions, you will not receive any notification that the report failed due to an invalid or missing password.

If you change your password, any previously scheduled reports must be rescheduled using yourWindows User ID
and your newWindows Password.

a Enter yourWindows User ID.

b Enter yourWindows Password.

8 UnderMessage for Email/Fax, complete the following:

a In theEnter Subject Line text box, enter the information to appear in the email or fax subject line.

b In theMessage text box, enter additional text to be included as the email message or the fax cover page.

c Alphanumeric text and characters can be entered into theMessage text box. You can paste text into the text box from
other sources.

9 Click Save Schedule.

10 The report runs as scheduled until it reaches its designatedRecurrence Option or you delete it from 7-7 Scheduled
Reports Manager.

NOTE: When a scheduled report runs, amessage displays on your screen indicating its progress.
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TIP: You can edit or delete an existing schedule from 7-7 Scheduled Reports Manager. Schedules cannot be
edited or deleted from this window.

Updating scheduled reports
To update scheduled reports:
On the Sage 100 Contractor desktop, double-click My Scheduled Reports.

In theRow column, click the number of the report you want to update, and then click theDrill Down button.

When the schedule window opens, enter yourWindows password, and click Save Schedule.

Repeat steps 2 and 3 for every scheduled report.

Updating the schedule and output in scheduled reports
To update the selection criteria in scheduled reports:
1 Open 7-7 Scheduled Reports Manager.

2 Click the report you want to update, and then click the [Edit Schedule/Output]button.

3 When the window opens, update the schedule and output options, and click Save.

4 Repeat steps 2 and 3 for every scheduled report.

Updating the selection criteria in scheduled reports
To update the selection criteria in scheduled reports:
Open 7-7 Scheduled Reports Manager.

Click the report you want to update, and then click the [Edit Selection Criteria]button.

When the window opens, update the selection criteria, and click Save.

Repeat steps 2 and 3 for every scheduled report.

Editing report schedules
To edit a report schedule:
1 Open 7-7 Scheduled Reports Manager.

2 Select the scheduled item by clicking on its row.

3 Make your edits to the report schedule using clicking either [Edit Schedule/Output] or [Edit Selection Criteria].

4 Enter yourWindows User ID andWindows Password.

5 Select Save Schedule.

Deleting report schedules

IMPORTANT: A report schedule can only be deleted through 7-7 Scheduled Reports Manager. You cannot delete
a report schedule in theReport Schedulingwindow.

To delete a report schedule:
1 Open 7-7 Scheduled Reports Manager.

2 Select the scheduled item by clicking on its row.
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3 Click [Delete].

Emailing and Faxing Reports
Using the faxing functionality through the Sage 100 Contractor program requires:

l Installation of theWindows operating system Fax Service component

l A separate installation and setup of a fax modem in your workstation

l Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that camewith your fax
modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing theWindow operating system Fax Service component, see Installing theWindow Fax
Services component.

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing fromWindows. To fax from Sage 100 Contractor, you should download and install the latest
version from http://get.adobe.com/reader/.

Disengage automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disengage the automatic “check for
updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

NOTE: Instructions disengaging automatic “check for updates” differ from version to version of Adobe Reader. Refer
to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple
mail transfer protocol (SMTP) email server.

TheEmail Settingswindow provides a way for you to set up email. You can change the selections to accommodate
different emailing preferences.

You can access theEmail Settingswindow through:

l Any Report Printingwindow by clicking theEmail button on the toolbar to open theEmail Distributionwindows.
Then, click theEmail Settings button to open theEmail Settingswindow.

l 7-9 Alerts Manager

l Click onSettings in the Dispatch Board, then click onEmail Setup.

Sage 100 Contractor and SMTP

IMPORTANT: The SMTP server may be located on your workstation PC, on a server on your company’s network, or
at your Internet service provider (ISP). If the email server is local, youmay need the assistance of an IT professional
to properly identify or set up this capability. If the email server is located at your ISP, youmay need contact your ISP
for assistance.

http://get.adobe.com/reader/
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Using the ISP’s simplemail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user
authentication” at the STMP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication
means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to
verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

l Sage 100 Contractor user name and password

l Network domain user name and password

l Windows system user name and password.

NOTE: Wedo not provide support for setting up or installing an email server. You set up user authentication and your
fax line access dial out number on 7-2 Company Information.

About setting up emailing and faxing through Sage 100 Contractor
Using the faxing functionality through the Sage 100 Contractor program requires:

l Installation of theWindows operating system Fax Service component

l A separate installation and setup of a fax modem in your workstation

l Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that camewith your fax
modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing theWindows operating system Fax Service component, see Installing theWindow
Fax Services component.

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing fromWindows. To fax from Sage 100 Contractor, you should download and install the latest
version from http://get.adobe.com/reader/.

Disable automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disable the automatic “check for
updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

NOTE: Instructions for disabling automatic “check for updates” differ from version to version of Adobe Reader. Refer
to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple
mail transfer protocol (SMTP) email server.

TheEmail Settingswindow provides a way for you to set up email. You can change the selections to accommodate
different emailing preferences.

You can access theEmail Settingswindow through:

http://get.adobe.com/reader/
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l Any Report Printingwindow by clicking theEmail button on the toolbar to open theEmail Distributionwindows.
Then, click theEmail Settings button to open theEmail Settingswindow.

l 7-9 Alerts Manager

l Click onSettings in the Dispatch Board, then click onEmail Setup.

Sage 100 Contractor and SMTP

IMPORTANT: The SMTP server may be located on your workstation PC, on a server on your company’s network, or
at your Internet service provider (ISP). If the email server is local, youmay need the assistance of an IT professional
to properly identify or set up this capability. If the email server is located at your ISP, youmay need contact your ISP
for assistance.

Using the ISP’s simplemail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user
authentication” at the STMP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication
means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to
verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

l Sage 100 Contractor user name and password

l Network domain user name and password

l Windows system user name and password.

NOTE: Wedo not provide support for setting up or installing an email server. You set up user authentication and your
fax line access dial out number on 7-2 Company Information.

Installing the Windows Fax Services component
To fax from Sage 100 Contractor, youmust install theWindows Fax Services component:

Vista:
1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On theWindows Featureswindow, locate theWindows fax and scan check box, then select it.

3 Click [OK].

Windows 7:
1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On theWindows Featureswindow, locatePrint and Document Services, then click on theWindows fax and scan
check box.

3 Click [OK].

Windows 8:
1 Click Start > All apps > Control Panel > Programs > Turn Windows features on or off.

2 On theWindows Featureswindow, locatePrint and Document Services, then click on theWindows fax and scan
check box.

3 Click [OK].
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Windows Server 2012

Detailed information fromMicrosoft

About email settings
TheEmail Settingswindow provides a way for you to set up email. You can change the selections to accommodate
different emailing preferences.

You can access theEmail Settingswindow through:

l Any Report Printingwindow by clicking theEmail button on the toolbar to open theEmail Distributionwindows.
Then, click theEmail Settings button to open theEmail Settingswindow.

l 7-9 Alerts Manager

l Click onSettings in the Dispatch Board, then click onEmail Setup.

You can send email the following ways:

l Send email usingMicrosoft Outlook How?

l Send email using the company's default SMTP connection How?

l Send email using this alternate SMTP connection How?

To send email using Microsoft Outlook:
1 Enter an email address.

To send email using the company's default SMTP connection:
1 Enter the email address.

2 Enter the password.

NOTE: If you have set up an email server, the IP address is shown in theMail Server field, but is not editable. If you
have not set up an email server, theMail Server field is blank. Themail server is set up in the Email/Fax Configuration
tab of 7-2 Company Information. How?

To send email using this alternate SMTP connection:
1 Enter themail server information, and then select whether it Requires authentication and/or Uses SSL.

2 Enter the Port #.

3 Enter the email address.

4 (Optional) Enter the password.

About fax line access selection
The Fax Line Access Selectionwindow provides a way for you to set up an alternate dialout number to access an outside
phone line. You can change the selections to accommodate different dialing preferences for a computer in another location.

You can access the Fax Line Access Selection window through any Report Printingwindow by clicking the Fax button
on the toolbar to open the Fax Distributionwindow. Click theChange button to open the Fax Line Access Selection
window.

http://technet.microsoft.com/en-us/library/jj134193.aspx#BKMK_Step2
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When Fax using the company default dial out number is selected, line access selections default from the setting on 7-
2 Company Information. When you set up and choose Fax using this alternate dial out number, then Sage 100
Contractor uses this setup for line selection.

Changing the email server setup when emailing directly
Sage 100 Contractor provides a way for you to change the email server setup when you are emailing a report directly to a
recipient.

IMPORTANT: Some Internet-based email providers do not support SMTP protocol. For more details, contact the
Internet-based email providers that you use.

To change the email server setup:
1 Open a window that provides the tools for email or faxing, such as 4-1-2 Payable Invoice List (Sample Company used
for examples).

2 Do one of the following:

a From the Filemenu, select Email.

b Click theEmail this report button on the toolbar.

3 TheEmail Distributionwindow appears.

NOTE: If you do not have any email addresses set up in the email distribution lists for clients, or vendors, or
employees, you see amessage box. Click OK to continue.

4 Near the bottom of the window, click Email Settings.

5 On theEmail Settingswindow, do one of the following:

a Select theSend email using Microsoft Outlook option.

i In the Email Address box, enter the email address.

b Select theSend email using the company's default SMTP connection option.

NOTE: Themail server is set up in the Email/Fax Configuration tab of 7-2 Company Information. How? If you have
not set up an email server, theMail Server field will be blank. If you have set up an email server, the IP address is
shown here, but is not editable.

i In the Email Address box, enter the email address.

ii In thePassword box, enter the password.

c Select theSend email using this alternate SMTP connection option.

i In theServer Name text box, type the email server name.

ii In thePort # box, type themail server port number.

iii In theEmail Address box, enter the email address.

iv In thePassword box, enter the password.

6 Click OK.

Changing the fax line access setup when faxing directly
Sage 100 Contractor provides a way for you to change the fax line access setup when you are faxing a report directly to a
recipient.
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To change the fax line access setup:
1 Open a window that provides the tools for faxing, such as 4-1-2 Payable Invoice List (Sample Company used for
examples).

2 From the Filemenu, select Fax.

3 On the Fax Distributionwindow, click the [Change] button.

4 In the Fax Line Access Selectionwindow, click Fax using this alternate dial out number.

5 In theDial text box, enter the numbers or characters necessary to reach an outside line.

6 Click OK.

Changing the email server setup when scheduling delivery
Sage 100 Contractor provides a way for you to change the email server setup when you are scheduling a report to be
emailed to a recipient.

Important

Some Internet-based email providers do not support SMTP protocol. For more details, contact the Internet-based email
providers that you use.

To change the email server setup when scheduling delivery:
1 Open a window that provides the tools for email, such as 4-1-2 Payable Invoice List.

2 (This example uses the Sample Company.) The 4-1-2 Report Printingwindow opens with theReport Criteria tab
displaying a list of reports. The first report, 21-AP Invoice List, is selected automatically.

3 Click File > Scheduling.

4 TheReport Scheduling 4-2-1-21—AP Invoice List window appears. The title bar of each report scheduling window
reflects the report that you are scheduling.

5 UnderOutput Options, select theEmail check box, and then click Edit Email Settings.

6 On theEmail Distributionwindow, click [Email Settings].

7 On theEmail Settingswindow, do one of the following:

a Select theSend email using Microsoft Outlook option.

i In the Email Address box, enter the email address.

b Select theSend email using the company's default SMTP connection option.

NOTE: Themail server is set up in the Email/Fax Configuration tab of 7-2 Company Information. How? If you have
not set up an email server, theMail Server field will be blank. If you have set up an email server, the IP address is
shown here, but is not editable.

i In the Email Address box, enter the email address.

ii In thePassword box, enter the password.

c Select theSend email using this alternate SMTP connection option.

i In theServer Name text box, type the email server name.

ii In thePort # box, type themail server port number.

iii In theEmail Address box, enter the email address.

iv In thePassword box, enter the password.
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8 Click OK.

Changing the fax line access setup when scheduling delivery
Sage 100 Contractor provides a way for you to change the fax line access setup when you are scheduling a report to be
faxed directly to a recipient.

To change the fax line access setup when scheduling delivery:
1 Open a window that provides the tools for email or faxing, such as 4-1-2 Payable Invoice List.

2 From the Filemenu, select Scheduling.

3 On theReport Schedulingwindow underOutput Options, select the Fax option, and then click Edit Fax Settings.

4 On the Fax Distribution window, click [Change].

5 In the Fax Line Access Selection window, click Fax using this alternate dial out number.

6 In theDial text box, enter the numbers or characters necessary to reach an outside line.

7 Click OK.

About fax distribution lists
Fax distribution lists allow you to select contacts from your client, vendor, or employee records, which appear in folders in
the Fax Distributionwindow underContacts. For fax contacts to appear in the folders, each category of contact—client,
vendor, or employee—must have a fax number entered in 3-6 Receivable Clients, 4-4 Vendors, or 5-2-1 Employees.

If you have scheduledmessages to be sent at a certain time, themessages will be faxed to the contacts for each
scheduled occurrence.

You can access the Fax Distributionwindow through any report printing window by clicking the Fax this report button on
the toolbar.

NOTE: If there is no fax contact information entered in 3-6 Receivable Clients, 4-4 Vendors, or 5-2-1 Employees,
amessage will display indicating that there are no records containing the appropriate information.

Editing fax cover pages

NOTE: You cannot edit fax cover pages unless you have a fax modem installed and a faxing service set up in
Windows to send and receive faxes.

As part of your business requirements, youmay want to edit your fax cover page by placing your company’s logo on it.

To edit a fax cover page:
1 If Sage 100 Contractor is open, close it.

2 Click theMy Computer icon on your desktop to open your computer’s file system.

3 Locate the \Users\Username\AppData\Local\Sage\Sage 100 Contractor\ folder or the \Program Files (or Program Files
(x86))\Sage\Sage 100 Contractor\, and double-click it to view the files.

4 Scroll through the file list, and locate SMBfax.cov.

5 Double-click SMBfax.cov to open up the Fax Cover Page Editor.

6 Modify the cover page.

7 After you havemodified the page, from the Filemenu, select Save.
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8 Exit the Fax Cover Page Editor.

9 Launch Sage 100 Contractor again to review your edited fax cover page.

TIP: You can delete the existing graphic from the cover page editor. Then import a graphic into your cover page from a
graphics editing program such as Microsoft Paint. Open the graphic of your choice, then copy and paste it into the
cover page editor.

Faxing reports to clients and vendors and employees

IMPORTANT: If there is no fax contact information entered in 3-6 Receivable Clients, 4-4 Vendors, or 5-2-1
Employees, a message appears indicating that there are no records containing the appropriate information.

To fax a report:
1 In any Report Printingwindow, do one of the following:

2 Click File > Fax.

3 From the toolbar, click Fax this report.

4 In theSubject text box, enter the fax subject line.

5 In the Fax Cover Page Message text box, enter additional text to be included as the fax cover pagemessage.

6 Alphanumeric text and characters can be entered into the Fax Cover Page Message text box. You can also paste text
the text box from other sources.

7 Select the contacts to whom to fax the report:

a Expand theClients, Vendors, orEmployees folders to list each available contact.

b Expand each contact folder.

c Select each desired recipient from the contact folder.

d A red arrow appears when a recipient is selected.

8 In the Fax Sender’s Name text box, enter your name.

9 Under Fax Line Access, confirm that the information is correct or select Change to edit your settings.

10 Select Send Now.

11 A message displayingReport Distribution Progress appears on your screen.

About the Email Distribution window
You can access theEmail Distributionwindow through any Report Printingwindow by clicking theEmail this report
button on the toolbar. You use theEmail Distributionwindow to compose email messages, select recipients from the
distribution list with the intent to send themessage immediately by clickingSend Now.

This window contains all the features that you would expect from an email program. On this window, you can:

l Type a subject

l Type themessage

l Select clients, vendors, and employees from distribution lists

l Send email to additional contacts

l Send a copy of themessage to yourself
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l Request a read receipt

l Set the importance level of themessage to low, normal, or high

l Verify email address being sent from (and access email settings)

NOTE: Setting the importance level and read receipt only work if that functionality is supported by your email
provider.

Email Distribution Lists

Email distribution lists allow you to select contacts from your client, vendor, or employee records, which appear in folders in
theEmail Distribution window underSelect contacts for immediate email distribution. For email contacts to appear
in the folders, each category of contact—client, vendor, or employee—must have an email address entered in 3-6
Receivable Clients, 4-4 Vendors, or 5-2-1 Employees.

NOTES:
l If there is no email contact information entered in 3-6 Receivable Clients, 4-4 Vendors, or 5-2-1 Employees,

a message appears indicating that there are no records containing the appropriate email information.

l If you have scheduledmessages to be sent at a certain time, themessages will be emailed to the contacts for
each scheduled occurrence.

Email from

TheEmail from text box prefills with the email address being sent from, as set up in theEmail Settingswindow. To
change the email address, click [Email Settings].

Emailing reports to clients and vendors and employees
Emailing reports to clients, vendors, and employees is accomplished through theEmail Distributionwindow.

TheEmail Distributionwindow also provides access to email server setup controls. When you click [Email Settings],
you open theEmail Settingswindow which provides set up controls for default connections, alternate connections, and
Microsoft Outlook.

To email a report to a client, a vendor, or an employee:
1 From any Report Printingwindow, do one of the following:

a From the Filemenu, click Email.

b From the toolbar, click the email icon.

2 In theEmail Distributionwindow, in theSubject box, type the email subject line.

3 In theEmail Message box, type amessage.

NOTE: Alphanumeric text and characters can be entered into theEmail Message text box. You can paste text into
the text box from other sources.

4 Select the contacts to whom you want to email the report:

a Expand theClients, Vendors, orEmployees folders to list each available contact.

b Expand each contact folder.

c Select each desired recipient from the contact folder.
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d A red check mark appears when a recipient is selected.

5 In theSend email to these additional contacts box, enter additional email addresses separated by semi-colons. For
example, john_doe1234@john_doe.com; jane_doe5678@john_doe.com, etc.

6 UnderEmail Options, as needed:

a Select Send a copy to my inbox (includes a list of recipients)

b Select Request a read receipt for this message

c Select an Importance option.

7 Do one of the following:

a If you do not need to edit theEmail from, click [Send Now].

b If you need to edit theEmail from, click [Email Settings].

8 On theEmail Settingswindow, do one of the following:

a Select theSend email using Microsoft Outlook option.

i In the Email Address box, enter the email address.

b Select theSend email using the company's default SMTP connection option.

NOTE: Themail server is set up in the Email/Fax Configuration tab of 7-2 Company Information. How? If you have
not set up an email server, theMail Server field will be blank. If you have set up an email server, the IP address is
shown here, but is not editable.

i In the Email Address box, enter the email address.

ii In thePassword box, enter the password.

c Select theSend email using this alternate SMTP connection option.

i In theServer Name text box, type the email server name.

ii In thePort # box, type themail server port number.

iii In theEmail Address box, enter the email address.

iv In thePassword box, enter the password.

9 Click OK.

10 Click [Send Now].

11 A message displayingReport Distribution Progress appears.

Exporting Data to Microsoft Excel
Youmay need to get data out of a Sage 100 Contractor report, Quick Report, Quick Grid, or Find query and into a
Microsoft Excel spreadsheet so that you can add to or reorder the data or combine data from different reports into one
document.

In some situations, a grid may be displaying toomany columns to be viewed in thePrint to screen viewer or to be printed,
even in landscape orientation. It is just situations that exporting toMicrosoft Excel provides a solution. Microsoft Excel has
the capability to capture all the data on any grid in Sage 100 Contractor.

IMPORTANT: If you do not have access rights to any data included in the export action, you are notified and no
export file is created.
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IMPORTANT: If support for Microsoft Excel Object Library is not present on themachine that initiates the export
action, you are notified and no further actions are performed.

The exported data includes the following information:

l Company name

l Report title (grid or query name)

l Selection criteria

l Column headers

l Labels

l Data

l Formulas

l User name

l Report number (for example, 3-5-0-21)

l Date and time

The exported data excludes the following information:

l Graphics, lines, double lines, boxes

l Pagination

l Checks

To export report data to Excel
1 From amain window, for example 4-2 Payable Invoices, on the tool bar, click thePrint Records button.

2 TheReport Printingwindow opens.

3 Select a report that you want to export to Excel.

4 Click theSend report data to Excel button.

5 Your computer launches Excel with a new worksheet populated with the report data.
To export Quick Grid data to Excel
1 Open aQuick Gridwindow.

2 On the toolbar, click thePrint Records button.

3 TheReport Printingwindow opens.

4 Click theSend report data to Excel button.

5 Your computer launches Excel with a new worksheet populated with the quick grid data.
To export Find query data to Excel
1 Open a window that supports Find queries.

2 TheQuery Listwindow opens.

3 Select a query, and click Run.

4 TheRun Querywindow opens.

5 Enter criteria, and click Run.
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6 Your computer displays a quick grid populated with the query data.

7 On the tool bar, click thePrint Records button.

8 TheReport Printingwindow opens.

9 Click theSend report data to Excel button.

10 Your computer launches Excel with a new worksheet populated with the selected data.

Exporting report data to Microsoft Excel
To export report data to Excel:
1 From amain window, for example 4-2 Payable Invoices, on the tool bar, click thePrint Records button.

2 TheReport Printingwindow opens.

3 Select a report that you want to export to Excel.

4 Click theSend report data to Excel button.

5 Your computer launches Excel with a new worksheet populated with the report data.

Exporting Quick Grid data to Microsoft Excel
To export Quick Grid data to Excel:
1 Open aQuick Gridwindow.

2 On the toolbar, click thePrint Records button.

3 TheReport Printingwindow opens.

4 Click theSend report data to Excel button.

5 Your computer launches Excel with a new worksheet populated with the quick grid data.

Exporting Find query data to Microsoft Excel
To export Find query data to Excel:
1 Open a window that supports Find queries.

2 TheQuery Listwindow opens.

3 Select a query, and click Run.

4 TheRun Querywindow opens.

5 Enter criteria, and click Run.

6 Your computer displays a quick grid populated with the query data.

7 On the tool bar, click thePrint Records button.

8 TheReport Printingwindow opens.

9 Click theSend report data to Excel button.

10 Your computer launches Excel with a new worksheet populated with the selected data.
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13-8 Search Reports

About 13-8 Search Reports
Enter keywords in the text box to search for applicable reports.

NOTES:
l The search results match on all entries and are not case sensitive.

l Surround entries by quotes to find literal blocks.

You can show more advanced options by clicking on theShow other search options link.
To search by keywords
1 Open 13-8 Search Reports.

2 Enter a keyword in the Search text box.

3 Click [Search].
To search by specific program area

Sage 100 Contractor searches the first level menu number equivalent to the listed area of the program. If the Include
report forms option is included, Sage 100 Contractor will search the following locations:

l \MB7\Custom Reports\

l \Users\Username\AppData\Local\Sage\Sage 100 Contractor\Custom Reports

l \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\System Reports

1 Open 13-8 Search Reports.

2 Click theShow other search options link.

3 Enter a keyword in the Search text box.

4 In the Limit search to a specific program area list, select the program area.

5 Click [Search].
To search by specific data table
1 Open 13-8 Search Reports.

2 Click theShow other search options link.

3 Enter a keyword in the Search text box.

4 In the Limit search to a specific data table list, select the data table.

5 Click [Search].
Including database fields in search
1 Open 13-8 Search Reports.

2 Click theShow other search options link.

3 In the Tables column, select the table to choose fields from.

4 In the Fields column, select the field and click [OK].

5 Click [Search].
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Search options

When theSearch into calculated fields option is included in the search, amatch is found if the calculated field exists in
the report or form design. The report search is not validating that the calculated field is being used in either the report or form
design.

If the Include report forms option is included in the search, and all search criteria is found in the report design (.rpf file),
then the row on the Search Results list has the .rpf title listed and << Any >> in the Forms column in the list.

If the Include report forms option is not included in the search, then Forms column is not shown in the results list box.

Interpreting report search results
Once youmake your selection criteria, the program searches the System and Custom Report folders (and if selected,
Report Forms folder) and returns a list of all the reports that match. Select the report you want to view and click Run Report.

l Report Design file (rpf) – A Sage 100 Contractor report file that is in menu option 13-3 Report Writer.

l Form Design – A Sage 100 Contractor form design file saved inmenu option 13-5 Form/report Page Design

NOTES:
l If form designs are not included in the search, then Forms column is not shown in the results list box.

l Custom reports are shown after system reports.

If the Include report forms option is included, Sage 100 Contractor will search the following locations:

l \MB7\Custom Reports\

l \Users\Username\AppData\Local\Sage\Sage 100 Contractor\Custom Reports

l \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\Report Forms

l \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\System Reports

A finished report is the combination of the form design which is usually a logo, header and footer and the report design
which is the detail of the report.

If all search criteria is found in the report design (.rpf file), then the row on the Search Results list has the rpf title listed and
<< Any >> in the Form column in the list whichmeans any form design can be used with the report and there will be a
completematch for the search criteria.

If any, but not all, of the criteria is found in the report design, then the form design designated in the rpf is searched, and if
the all of the remaining criteria are found in the form design, then the row on the Search Results list has the rpf title listed
and the form design file name in the Form column in the list. This means that form design can be used with the report and
there will be a completematch for the search criteria.

If the report design uses a *.extension for the form design, then all of the form designs with that extension are examined,
and if more than one form finds all the remainingmatches, then you can right click on the << Right click to view >> to see
all thematching form design file names in a scrollable message box.
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Appendix A: Sage 100 Contractor Features
About Sage 100 Contractor Features
Sage 100 Contractor is flexible, allowing you to tailor functions and features tomeet your business needs. This section
explores selected features of Sage 100 Contractor.

Basic Features

About the Sage 100 Contractor main window and desktop area
The Sage 100 Contractor main window

The Sage 100 Contractor main window consists of the following areas:

l Current open company and user display (bottom left status bar).

l SystemMenu andMy Menu tabs , an expandable and collapsible tree structure

l Sage 100 Contractor Desktop area (right-hand pane containing shortcuts).

l Activity Center tabs

Desktop Area

The Sage 100 Contractor desktop is the right-hand pane on themain screen when you launch Sage 100 Contractor.

The following functions are accessible from the Sage 100 Contractor desktop area:

l Process maps

l User-defined shortcuts

About the Sage 100 Contractor Desktop
Sage 100 Contractor provides a variety of options for navigating to different parts of the program.

Activity Centers

Activity center tabs divide the program into several main sections. Each tab has a drop-downmenu associated with it.
When you click an activity center tab, a drop-downmenu appears, along with a process map in themain desktop.

You can edit the process maps for each activity center, and you can drag and drop

You can hide themenus and use only the activity center tabs to navigate through the program.

Task Icons

Right-click a task icon to display the SystemMenu option name.
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To change the name of a task icon, click theClick here to edit the process map link at the bottom of the activity center,
right-click the task icon, and then edit the text. Click Save after you change the icon name.

Process Maps

You can use the process maps as shortcuts to get to specific tasks. Each user can also customize these process maps to
match their own workflow.

Click theClick here to edit the process map link at the bottom of the activity center you want to edit.

System Menu and My Menu

You can use the SystemMenu tree to navigate to all the programmodules to which you have access.

However, youmight prefer to use theMy Menu tree, which displays only the components for which you have a license and
security access. You can also tailor this menu to your personal workflow, removing items that you have no interest in or do
not use on a regular basis.

Click theCustomize My Menu button at the bottom of theMy Menu tab, and then clear the check marks frommenus or
tasks that you do not want to display on your My Menu tab. Click theSave as My Menu button to save your adjustments.

TIP: Activity Center users can hide thesemenus to get more screen real estate. You can also show themenus if they
have been hidden.

Hide Menu and Show Menu

You can remove themenu tree from the desktop view if you do not use it.

Click Hide Menu below themenu trees. The numberedmenu tree is no longer visible, and the HideMenu button changes
to Show Menu. Click Show Menu to show themenu tree.

Settings

You can also click theSettings button to further customize your activity center tabs and to show your Dashboard when you
log in.

If you do not want to see any of the activity center tabs, select theHide all Activity Centers radio button. Or if you just
want to hide certain activity centers, clear the check boxes for the activity centers you do not want to see on your desktop.
Click Apply to accept your changes, or click Cancel to exit.

Customizing your desktop with additional shortcuts
Add shortcuts to any item from the System Menu

You can create shortcuts on your program desktop from items on the SystemMenu.

Click theClick here to edit the process map link at the bottom of the activity center you want to edit. You can then
simply drag an item from the SystemMenu to the desktop area, and place it where ever you want.

Add shortcuts to any specific report from the Report Printing window

You can create shortcuts on your desktop to a specific report from any report printingmenu. Highlight the report under the
Report Criteria tab and click Create Shortcut on the toolbar. If multiple activity centers are shown on your desktop, you can
select which activity center desktop you want the shortcut to display on from a drop-down list.

NOTE: Desktop configurations are specific to each computer. They are attached to the user name and are consistent
throughout all companies accessed from the computer where they are set up.
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Add shortcuts to external documents

When editing shortcuts, you can drag various types of documents, including Excel, Word, and PDF documents, and drop
them on the Sage 100 Contractor Desktop, where you can easily open them without minimizing Sage 100 Contractor.

To open a document in the associated program, you simply double-click its icon on the activity center desktop. You do not
have to leave Sage 100 Contractor to hunt for and open documents you use regularly for reference!

TIPS:
l While you cannot drop URLs directly on the Desktop, you can copy a bookmark from your browser, save it as a

shortcut on yourWindows desktop, and then drag the shortcut to the Sage 100 Contractor Desktop. You can
view the website in your default browser simply by double-clicking the shortcut.

Make sure you do not delete the shortcut from yourWindows desktop, or the shortcut on the Sage 100
Contractor Desktop will not work.

l You can also drag folders fromWindows Explorer, and drop them on the Desktop.

l As a best practice: On yourWindows desktop, create a folder called "Sage 100 Contractor Shortcuts," and
then save shortcuts to that folder before dragging them to the Sage 100 Contractor desktop. Storing all your
Sage 100 Contractor shortcuts in one place will help you stay organized andmay serve as a reminder not to
delete them.

Editing the desktop
Each user can customize task icons and shortcuts on the desktop to suit their own preferences and workflows.

Click theClick here to edit your shortcuts link at the bottom of the desktop for the activity center you want to edit.
Adding a shortcut to the desktop
1 Click theClick here to edit your shortcuts link on the bottom of the desktop for the activity center you want to edit.

2 Drag an item from the Systemmenu to the desktop.

3 Click the [Save] button in the edit tools.
Auto connecting items on the desktop
1 Click theClick here to edit your shortcuts link on the bottom of the desktop for the activity center you want to edit.

2 Click on the AutoConnect tool.

3 Drag several items from themenu to the desktop.

4 Click the [Save] button in the edit tools.
Manually connecting items on the desktop
1 Click theClick here to edit your shortcuts link on the bottom of the desktop for the activity center you want to edit.

2 Add several tasks to the desktop.

3 Click on themanual connect tool

4 Click on a source target.

5 Click on destination target. Connections aremade according to the following rules:

l Two sides with tasks on the same row result in a straight horizontal line

l Top and bottom with tasks on the same column result in a straight vertical line

l Two sides with tasks on different rows result in a double bend line
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l Top to bottom with tasks in different columns result in a double bend line

l Top or bottom to a side results is a single bend line

6 Click [Save].
Moving connected tasks on the desktop
1 Select a tab that displays connected tasks.

2 Click theClick here to edit your shortcuts link on the bottom of the desktop for the activity center you want to edit.

3 Click on the Select tool.

4 Drag a task with connections to the new position.

5 Click [Save].

NOTE: The line typemay change based on the relative positions of the tasks.

Grouping tasks on the desktop
1 Select a tab that displays connected tasks.

2 Click on the Group tool.

3 Draw a box around two or more tasks. The group box that gets created automatically positions and sizes itself around the
tasks it surrounds.

4 Click [Save].
Deleting tasks on the desktop
1 Select a tab.

2 Click theClick here to edit your shortcuts link on the bottom of the desktop for the activity center you want to edit.

3 Select the Delete tool.

4 Click [Save].
Button Description

Undo Select to undo the last action or continue to click to undomultiple actions.

Clear All Select to clear all objects from the desktop for this processmap.

Restore Select to restore the current processmap to the system’s original map.

Save Select when you have completed all changes to the processmap.

Cancel Select to return back to the desktop and processmap.

Select objects to move around themap.

Manually connect tasks.

Automatically connect tasks as they are added.

Create group boxes.
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Button Description

Draw straight lines to connect groups.

Delete selected objects.

Customizing My Menu
You can customize theMy Menu to remove items that you have no interest in or do not use on a regular basis. Click the
CustomizeMy Menu button at the bottom of theMy Menu tab. You can clear the check marks frommenus or tasks that you
do not want to display on your My Menu tab. Then click the Save as My Menu button to save your adjustments.

About the status bar
The status bar is located at the bottom left of Sage 100 Contractor windows. When your cursor is in an entry box, column,
or grid cell on a window, the status bar displays valuable information about what to enter in the box, column, or grid cell.

For example, when you open 3-5 Jobs (Accounts Receivable), the status bar displays Enter a job number. Next place
your cursor in theShort Name box. The status bar displays Enter a brief name for sorting/finding the job.

In many Sage 100 Contractor windows, there are drop-down text boxes with titles User Def1 andUser Def2, which are
user-defined fields. If you need to include information that does not directly relate to any of the existing entry fields, use the
User Def1 andUser Def2 text boxes for this purpose.

To customize theUser Def1 andUser Def2 description, box prompt, and status bar text, press the F7 key with your cursor
in one of the boxes to open the Field Properties dialog box.

IMPORTANT: Access to set up customize field properties is limited to the supervisor user. You cannot restrict
access to system-required fields.

About user and system prompts
Screen prompts are often overlooked as a great place to get additional information about what data is needed in a specific
field. Click once in any available text box on a window, and then look at the bottom left portion of the window to see the
prompt.

You can change the prompt that appears in the status bar at the bottom of the window. To return to the system prompt,
delete the user prompt.

Data control
Use the data control to select a record from a database. Each button and section has a specific purpose. They are listed in
order from left to right.

l First record button: Moves to the first record in the database. You can also press Alt+Up Arrow.

l Previous record button: Moves to the previous record in the database. You can also press Alt+Left Arrow.

l Record number text box: Displays the record number. Somewindows require you to enter a record number in this
box when creating a new record. To display a specific record, enter the record number in this box.

l Lookup window button: Displays a Lookupwindow, allowing you to select a record.
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l Next record button: Moves to the next record in the database. You can also press Alt+Right Arrow.

l Last record button: Moves to the last record in the database. You can also press Alt+Down Arrow.

Count
Count lets you determine the number of records in a database. You can useCount to verify that the archives contain all the
records from the database.

About Quick Lists
WithQuick Lists, you can create lists of transaction descriptions, names,states,zip codes, and so on, and retrieve the
information for entry. Each list is specific to its associated text box and window.

To Do this

Display a list
Click the blue drop-down arrow next to the text box.

Alternatively, select a text box and press the F5 or
Shift+? keys.

Choose an item Select the item and double-click.

Add an item
Enter the item, and click Add.

Alternatively, enter the item in the text box and press
F5.

Delete an item Select the item in the list, and click Delete.

Searching data with indexed text boxes
When looking at a Sage 100 Contractor window, for example, 4-4 Vendors (Accounts Payable), look for a yellow bar
between the text box label and the text box entry area, which you can see by clicking the [F9] key. The yellow bar indicates
that the text box has been indexed in a database table. Youmay search for data with these indexed text boxes.

In Sage 100 Contractor, the indexed text boxes works like an index in a book. Youmay use them to search for data about
Vendors, Descriptions, Trans#, and so forth. When entering data, such as a name or a number, the search compares
data and looks from left to right for an exact match. Youmay increase or decrease the number of records found in the
search, depending on how much information you provide.

You enter data and conduct a search in an indexed text box with data that is consistent for entries in that specific box. For
example, if the text box requires an “alpha” entry, such as “M” or “Michael,” then youmust enter a letter or a word. If the box
requires a “numeric” entry, then youmust enter a number. In some cases, a box can accept either an alpha or a numeric
entry because it is an alpha-numeric box.

For example, let’s suppose that you want to call your vendor, Michael’s Electrical, and need to get the phone number. On
the 4-4 Vendors (Accounts Payable)window, in theVendor Name box, typeM and press the F9 key. Sage 100
Contractor displays the first vendor whose name begins with anM. Using the Page Down key, you can display the
subsequent vendors until you findMichael’s Electrical. Alternatively, you can search for Michael. The search displays the
first instance of Michael as a vendor name.

On a different window, such as 4-2 Payable Invoices/Creditswindow, to search for a vendor in theVendor text box, you
must type a number and search by vendor number. For example, youmay enter “51” for the hypothetical vendor 51-Hughes
Concrete. In yet another example, such as the 1-3 Journal Transactionswindow, when searching the Trans# box, you
may enter a letter, a number, or a combination of letters and numbers because it is an alpha-numeric box.
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To search for data using an indexed text box:
1 In the indexed text box, enter the information for which you are looking, and then press the F9 key.

2 Sage 100 Contractor then displays the first match.

3 Use the Page Up and the Page Down keys to display other records found in the search.

4 The data is sorted in ascending order based on the indexed text box you searched.

About user-defined fields
In many Sage 100 Contractor windows, there are drop-down text boxes with titles User Def1 andUser Def2, which are
user-defined fields. If you need to include information that does not directly relate to any of the existing entry fields, use the
User Def1 andUser Def2 text boxes for this purpose.

To customize theUser Def1 andUser Def2 description, box prompt, and status bar text, press the [F7] key with your
cursor in one of the boxes to open the Field Properties dialog box.

IMPORTANT: Access to set up customize field properties is limited to the supervisor user. You cannot restrict
access to system-required fields.

About the About Sage 100 Contractor window
TheAbout Sage 100 Contractorwindow is accessible from theSage 100 Contractor Desktop through theHome &
Resources tab > About Sage 100 Contractormenu or inResources menu > About Sage 100 Contractor if you have
hidden the Activity Centers.

For example, theAbout Sage 100 Contractorwindow displays this typical information:

Information Examples Only

Product name and version Sage 100 Contractor version 19.3.279.0

Payroll tax tables version line US payroll tax tables release 2014.1 (01/01/2014)

Copyright line © 2000-2014 Sage. All rights reserved.

Product registration

This product is registered to:

Company Name

Sage Customer ID: xxxxxxxxxx

Authorizedmodules check boxes Estimating, Document Control,
Inventory, Service Receivables, Equipment Management, Plug-in for ACT!

Sage License Server Connection State License use acquired from server

This About Sage 100 Contractorwindow provides access to important information that youmight need to use if you
encounter a problem. For example, if you attempt to log on to a company and find that you cannot do it, it may be that your
computer is disconnected from your local network. A quick look at this window lets you know your connection status.

Sage 100 Contractor Sample Company
About the Sample Company

The Sample Company provides themeans for viewing and working with sample data in Sage 100 Contractor windows.
There are sample accounts, sample employees, sample takeoffs, andmuchmore. By viewing and working with this
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sample data, you can gain an understanding of how different windows interact with the sample data whenmanaging a
construction business with Sage 100 Contractor.

Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor training classes.
We highly recommend that you load the Sample Company during your initial installation.

You can log on to the Sample Company using “Supervisor” as the user name. You do not need a password.

The Sample Company:

l Allows you a safe way to try out new functions as you learn them.

l Is used inmany on-line and recorded classes.

l Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to understandmany
concepts.

l Provides starter lists for many values you'll need to set up: cost codes, cost types, tasks, client status, client type,
employee positions, paygroups, and so on.

l Provides you with live data to investigate the content of Sage 100 Contractor reports.

l Takes very little space on your hard disk drive.

Logging in to the Sample Company

You can log in to the Sample Company using “Supervisor” as theUser Name. You do not need a password.

To log in to the Sample Company:

1 On the Sage 100 Contractor main window, from the Filemenu, select Open Company.

2 On theCompany Listwindow, select theSample Company, and click OK.

3 When theUser Name and Passwordwindow opens, the user name is automatically set toSupervisor. You do not
need a password.

4 On theUser Name and Password window, click OK.

5 TheSample Company opens.

Sage 100 Contractor Dashboard

About the Dashboard
The Sage 100 ContractorDashboard has been designed to show the state of your company’s finances in real time by
displaying information about your company’s financial state.

NOTE: Until you set upDashboard security, theDashboard is only available to the supervisor user.

Showing the Dashboard after Login

You can show the Dashboard every time you log into the company, if you have the access.

1 Click the [Dashboard] button.

2 Select the Options menu, and click on [Show Dashboard After Login].

NOTE: If you need to turn off displaying the Dashboard after you log into the company, use the same steps, then
verify that [Show Dashboard After Login] is not checked.
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Dashboard Sections

The Dashboard is organized into seven sections when first opened. You can add and remove content by clicking the
[Add/Remove Content] link.

l Cash Accounts- Displays up to five cash accounts. You can drill down into each of the accounts to review details.
You can use theEdit feature to choose which accounts are displayed.

l Cash Position -Displays Total Cash andReceivables. YourCash Position is the difference between Total
Cash + Receivables and Less Current Liabilities.

l Outstanding Change Orders -Displays ChangeOrders that have not been approved in Less than 30 Days and
those that have not been approved inMore than 30 Days.

l Receivables -Displays receivable amounts that areDue in 7 Days, Due in 30 Days, Overdue 1-30 days, and
Overdue > 30 (more than 30) days.

l Payables -Displays payable amounts that areDue in 7 Days, Due in 30 Days, Overdue 1-30 days, andOverdue
> 30 (more than 30) days.

l Income from Operations -Displays Income from This Month, This Quarter, and This Year broken down into
three cost categories: Direct/Equip/Shop, Overhead, andAdministrative. The final display totals Income from
Operations by This Month, This Quarter, and This Year.

l Under-Billed Jobs -Displays under-billed jobs in two ways, by amount and by percentage of contract. Youmay
also choose not to display any under-billed jobs.

NOTES:
l TheDashboard displays GAAP-standard financial information.

l All negative amounts are displayed in parentheses.

l Amounts that are shown in red indicate items that may need your special attention.

Refreshing the Dashboard Information

TheDashboard displays the Last refreshed date and time so that you always know if the information is fresh. You can
click theRefresh button to refresh the information. In addition, every time you exit and re-launch theDashboard, Sage 100
Contractor refreshes the information.

You can print the current view of theDashboard by pressing thePrint button on the right side of the toolbar.

TIPS:
l If you have access to the Dashboard, you can display it at any time by clicking the [Dashboard] button.

l Youmay need to set up a separate security group with onemember if you are the only one who is going to view
the Dashboard. You have to be a Supervisor user to set up security groups.

l You can click the [?] link to the right of each section heading to open a detailed Help topic about this area of the
Dashboard.

About the Dashboard Alert Viewer
If you have alerts, you'll see the Description, Type, Date, and Sent From columns. The alerts listed in theMy Alerts section
are from program alerts or custom alerts setup in the 7-9 Alerts Manager.

You can do the following with alerts in this viewer:
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l Mark as Read: Unbolds the alert notification, and the alert will not show up in the Unread Alerts count afterward.

l Mark as Unread: Leaves the alert notification bolded, and the alert will continue to show up in the Unread Alerts
count afterward.

l Delete:  Deletes the alert notification (not the alert itself).

Once you click on an alert, details are visible in the Alert Details section. 

NOTE: Drill down on custom alerts listed in the Dashboard Alert Viewer is not available unless the custom alert
contains a record number field for the table you want to drill down to. You can havemultiple record number fields,
depending on the tables you want to see. For daily payroll custom alerts, theremust be aDate field in order to drill
down.

About Dashboard security
TheDashboard has been created to display and provide access to a great deal of company financial information. It was
designed for the benefit of company owners, company executives, and other selected employees. Such a detailed
presentation of financial information is not meant to be accessible to all your employees in your company, although it can be
set up that way.

Until you set up security, theDashboard is only available to the supervisor user. It is best to set up theDashboard
security at the earliest possible opportunity to be able to share your company’s financial information with selected
employees.

When a supervisor user launches Sage 100 Contractor, theDashboardwindow opens. Upon closing theDashboard
window and until a security option has been selected, Sage 100 Contractor continues to display theDashboard Security
Optionswindow to the supervisor user.

About Setting the Security Options Globally

SelectingSet Dashboard Security in the Options menu opens the Form Level Security window. Selecting one or more
check boxes from the security groups list allows themembers of that security group to view the Dashboard. ClickingOK
sets security for theDashboard.

NOTE: Youmay need to set up a new security group just for the Dashboard. For details, see About Security Groups.

About Setting the Security Options by Dashboard Tab

Clicking on the Add/Remove Content link in theDashboard allows you to set the security by Dashboard tab for the
General Ledger, Payables, Receivables, and Projects tabs. You can go to each tab and click on the Security link to choose
the security groups allowed access to this tab. Clicking the OK button saves the security choice for all panels that are on
the tab currently displayed.

NOTE: Security for adding panels is enforced. If a non-supervisor user tries to add a panel from a tab where they are
not amember of the allowed groups, then a security message is displayed and the dashboard panel is not added.

Changing the Security Settings

As your business grows, youmay need to change your security settings. You can access the Form Level Security
window at any time from theDashboard by pressing the F7 key or by clicking the Security link in the General Ledger,
Payables, Receivables, or Projects tabs for tab level security. Selecting or unselecting check boxes in the Form Level
Securitywindow will change access for members of that security group to view theDashboard.
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Adding and Removing Content on the Dashboard
Clicking theAdd/Remove Content link adds content panels to the Dashboard.

NOTE: Security for adding content panels is enforced. If a non-supervisor user tries to add a panel from a tab where
they are not amember of the allowed groups, a security message appears and the dashboard panel is not added.

You can add content panels from the following tabs:

l General Ledger

l Cash Accounts

l Cash Position

l Income from Operations

l Income and Expenses

l Previous Year IncomeComparison

l Previous Year Expense Comparison

l Budget vs. Actual Income

l Budget vs. Actual Expense

l Department Income and Expense

l Department Budget vs. Actual Income

l Department Budget vs. Actual Expense

l Budgeted Expenses

l Payables

l Payables Aging

l Top Vendors

l Expiring Vendor Discounts

l Credit Card Accounts

l Receivables

l Receivables Aging

l Service Receivables Aging

l Job Receivables Aging

l Top Customers by Billing

l Top Service Customers

l Top Customers by $ Owed

l Top Customers by Contract

l Projects

l Under-Billed Jobs

l Outstanding ChangeOrders
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l Job Costs by Cost Type

l Job Contract, Budget, and Cost to Date

l Job Cash Flow to Date

l Job Uncommitted Budget

l Today's Job Tasks

l Tomorrow's Job Tasks

l Payable Retention by Job

l Receivable Retention

l Job Hours Over Budget

l Alerts

l My Alerts

In each tab, you add or remove the content panel. If the panel type allows multiple instances, theAdd button changes to
Add Another and aRemove All button is displayed above it. If you click the Remove button, the content panel is removed
from the dashboard.

To add a content panel to the Dashboard:
1 Select Dashboard from the View menu.

2 Click theAdd/Remove Content link in the Dashboard.

3 Select the tab with the content panel you want to add.

4 Click [Add].

5 Close theAdd/Remove Dashboard Contentwindow.

6 Move the content panel as necessary. 

NOTE: Youmay need to use the scroll bar to see the new content panel. You canmove the content panel from its
default placement.

To remove a content panel from the Dashboard:
1 Select Dashboard from the View menu.

2 Click theAdd/Remove Content link in the Dashboard.

3 Select the tab with the content panel you want to remove.

4 Click [Remove].

5 Close theAdd/Remove Dashboard Contentwindow.

NOTE: You can remove panels on the Dashboard by clicking the "X". If you use the "X," and havemultiple instances
of the same panel, you can just remove specific instances.

About General Ledger content in the Dashboard
You can add or remove the following content panels from theGeneral Ledger tab by clicking theAdd/Remove Content link
on the Dashboard.
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l Cash Accounts

l Cash Position

l Income from Operations

l Income and Expenses

l Previous Year IncomeComparison

l Previous Year Expense Comparison

l Budget vs. Actual Income

l Budget vs. Actual Expense

l Department Income and Expense

l Department Budget vs. Actual Income

l Department Budget vs. Actual Expense

l Budgeted Expenses

About Cash Accounts on the Dashboard

TheCash Accounts panel displays five selected cash accounts in your list of cash accounts with their balances.

If these five accounts are not the ones you are interested in monitoring, you can click theEdit button to the right of the title
heading and select five accounts from your cash accounts list.

TIP: The bottom line in the list of accounts, All Other Cash Accounts, presents the sum of all other existing cash
accounts in that company.

About Cash Position on the Dashboard

Displays information on five distinct areas for executive financial review.

TheCash Position section displays numbers representing five distinct areas that merit executive review:

l Total Cash—Displays the total for all accounts in theCash Accounts range.

l Receivables—Displays the full balance of the invoices. Because it does not display the net due, it includes
retention.

l Total Cash + Receivables—Displays the sum of Cash Accounts andReceivables.

l Less Current Liabilities—Displays the total for all accounts in theCurrent Liabilities range.

l Cash Position—Displays the difference between Total Cash + Receivables and Less Current Liabilities.

About Income from Operations on the Dashboard

Displays information that summarizes an income statement, excluding theOther Income andAfter Tax Expense
categories.

It displays the information in three ways:

l This Month- Displays information that includes all transactions posted to the current period.

l This Quarter—Displays information that includes all transactions posted to the current quarter.
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NOTE: There is no cutoff within the quarter. If the current period is 4, then activity posted to periods 5 and 6
are included because they are part of the current quarter.

l This Year—Displays information that includes all transactions posted to the current fiscal year.

NOTE: There is no cutoff within the year. Any transaction posted to periods 1 through 12 are included.

About Income and Expenses on the Dashboard

Displays the income and expenses by period for the fiscal year.

About Previous Year Income Comparison on the Dashboard

Compare this year's incomewith last year's income.

About Previous Year Expense Comparison on the Dashboard

Compare this year's expenses with last year's expenses.

About Budget vs. Actual Income on the Dashboard

Compare this year's actual incomewith their budgeted amounts.

About Budget vs. Actual Expense on the Dashboard

Compare this year's actual expenses with their budgeted amounts.

About Edit Selected Departments on the Dashboard

This window is displayed for theDepartment Income and Expenses, Department Budget vs. Actual Income, and
Department Budget vs. Actual Expense panels.

The default selection is All Departments. If you only want to see information for a selected department, click the
[Selected Departments] button.

If you havemore than one content panel, you can put a title in theSelected Depts. Title box to differentiate the panels at a
quick glance. 

About Department Income and Expenses on the Dashboard

View incomes and expenses for ledger accounts with departments. You can add this panel more than once for different
departments.

NOTE: All departments are selected by default, click the Edit button on the Dashboard to select a specific
department. This reports supports multiple instances on the Dashboard.

About Department Budget vs. Actual Income on the Dashboard

Compare this year's actual incomewith the departmental budgeted amounts. You can add this panel more than once for
different departments.

NOTE: All departments are selected by default, click the Edit button on the Dashboard to select a specific
department. This dashboard panel supports multiple instances on the Dashboard.

About Department Budget vs. Actual Expense on the Dashboard

View income and expenses for ledger accounts with departments. You can add this panel more than once for different
departments.
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NOTE: All departments are selected by default, click the Edit button on the Dashboard to select a specific
department. You can add this panel more than once for different departments.

About Budgeted Expenses on the Dashboard

Displays expenses for accounts that have budgets, ranked by percent of budget.

From beginning of the fiscal year through the current accounting period. The budget amount for the current accounting
period is prorated, based on today's date.

NOTE: All future periods are ignored.

About Payables content in the Dashboard
You can add the following content panels from the Payables tab by clicking theAdd/Remove Content link on
the Dashboard.

l Payables Aging

l Top Vendors

l Expiring Vendor Discounts

l Credit Card Accounts

About Payables on the Dashboard

This section of theDashboard displays information on invoices with status of:

l 1-Open—Indicates a record posted to the general ledger.

l 2-Review—Indicates themanagement or bookkeeping staff should review the record.

l 3-Dispute—Indicates a record disputed by the client.

It also displays information about the invoices in four ways:

l Invoices Due in 7 Days—Today is the first of the seven days. If today is Sunday, then this number represents the
total amount due from and including today, which is Sunday through and including the following Saturday.

l Invoices Due in 30 Days—Today is the first of the thirty days. If today is the tenth day of themonth, this number
represents the total amount due from and including today through and including 29more days.

l Invoices Overdue 1-30 (overdue one to thirty days)—This is the same as an aging report.

l Invoices Overdue > 30 (overduemore than thirty days)—This is the same as an aging report. The amount that the
Dashboard presents is the sum of AP Invoice Aging report, 31-60, 61-90, and 91—120+ columns.

When reviewing the information contained in this section, it is important to remember that the amounts are “net due;” that is,
if retention exists, then it is excluded.

About Payables Aging on the Dashboard

Displays information on invoices with status of:

l 1-Open—Indicates a record posted to the general ledger.

l 2-Review—Indicates themanagement or bookkeeping staff should review the record.

l 3-Dispute—Indicates a record disputed by the client.
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It also displays information about the invoices in four ways:

l Invoices Due in 7 Days—Today is the first of the seven days. If today is Sunday, then this number represents the
total amount due from and including today, which is Sunday through and including the following Saturday.

l Invoices Due in 30 Days—Today is the first of the thirty days. If today is the tenth day of themonth, this number
represents the total amount due from and including today through and including 29more days.

l Invoices Overdue 1-30 (overdue one to thirty days)—This is the same as an aging report.

l Invoices Overdue > 30 (overduemore than thirty days)—This is the same as an aging report. The amount that the
Dashboard presents is the sum of AP Invoice Aging report, 31-60, 61-90, and 91—120+ columns.

TIP: Amounts that are shown in red indicate items that may need your special attention.

When reviewing the information contained in this section, it is important to remember that the amounts are “net due.” That
is, if retention exists, then it is excluded.

About Credit Card Accounts on the Dashboard

Displays five selected credit card accounts with their balances.

Displays the first five credit card accounts in your list of credit card accounts. If these five accounts are not the ones you
are interested in monitoring, you can click theEdit button to the right of the title heading and select five accounts from your
credit card accounts list.

TIP: The bottom line in the list of accounts, All Other Card Accounts, presents the sum of all other existing cash
accounts in that company.

About Top Vendors on the Dashboard

Displays the top 6 vendors based on year-to-date activity. Based on billed amounts for the current fiscal year.

About Expiring Vendor Discounts on the Dashboard

Displays the amounts of vendor discounts that are available this week and next week. Each week ends on Saturday.

About Receivables content in the Dashboard
You can add the following content panels from the Receivables tab, once you click theAdd/Remove Content link on
the Dashboard.

l Receivables Aging

l Service Receivables Aging

l Job Receivables Aging

l Top Customers by Billing

l Top Service Customers

l Top Customers by $ Owed

l Top Customers by Contract

About Receivables on the Dashboard

This section provides information about receivable invoices with status of:
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l 1-Open—Indicates a record posted to the general ledger.

l 2-Review—Indicates themanagement or bookkeeping staff should review the record.

l 3-Dispute—Indicates a record disputed by the client.

It also displays information about the invoices in four ways:

l Invoices Due in 7 Days—Today is the first of the seven days. If today is Sunday, then this number represents the
total amount due from and including today, which is Sunday through and including the following Saturday.

l Invoices Due in 30 Days—Today is the first of the thirty days. If today is the tenth day of themonth, this number
represents the total amount due, from today through 29more days (inclusive).

l Invoices Overdue 1-30 (overdue one to thirty days)—This is the same as an aging report. The amount that the
Dashboard presents is the sum of:

l AR Invoice Aging report, 1—30 column

l Service Invoice Aging report, 1—30 column.

l Invoices Overdue > 30 (overduemore than thirty days)—This is the same as an aging report. The amount that the
Dashboard presents is the sum of:

l AR Invoice Aging report, 31-60, 61-90, and 91—120+ columns, and

l Service Invoice Aging report, 31-60, 61-90, and 91+ columns.

When reviewing the information contained in this section, it is important to remember that the amounts:

l Are “net due,” that is, retention, if it exists, is excluded.

l Include both Accounts Receivable and Service Receivable invoices.

TIP: Amounts that are shown in red indicate items that may need your special attention.

About Receivables Aging on the Dashboard

Displays information about receivable invoices with status of 1-Open, 2-Review, and 3-Dispute.

l 1-Open—Indicates a record posted to the general ledger.

l 2-Review—Indicates themanagement or bookkeeping staff should review the record.

l 3-Dispute—Indicates a record disputed by the client.

About Service Receivables Aging on the Dashboard

Displays information about service receivable invoices with status of:

l 1-Open—Indicates a record posted to the general ledger.

l 2-Review—Indicates themanagement or bookkeeping staff should review the record.

l 3-Dispute—Indicates a record disputed by the client.

TIP: Amounts that are shown in red indicate items that may need your special attention.

About Top Customers by Billing on the Dashboard

Displays the total billed for the top 6 customer from job and service billings.
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About Top Service Customers on the Dashboard

Displays the top 6 customers from service billings.

About Top Customers by $ Owed on the Dashboard

Displays the top 6 customer balances for both accounts receivables and service receivables.

About Top Customers by Contract on the Dashboard

Displays the top 6 customers based on contract amounts, including approved change orders.

About Projects content in the Dashboard
You can add or remove the following content panels from the Projects tab, once you click theAdd/Remove Content link
on the Dashboard.

l Under-Billed Jobs

l Outstanding ChangeOrders

l Job Costs by Cost Type

l Job Contract, Budget, and Cost to Date

l Job Cash Flow to Date

l Job Uncommitted Budget

l Today's Job Tasks

l Tomorrow's Job Tasks

l Payable Retention by Job

l Receivable Retention

l Job Hours Over Budget

About Under-Billed Jobs on the Dashboard

Displays the fivemost under-billed jobs ranked by dollar amount or percentage of contract.

This section of theDashboard displays the Job Number and Job Namewith two ranking criteria:

l The dollar amount that is under-billed.

l The percentage of current contract amount that is under-billed.

To be included in theUnder-Billed Jobs display, jobs must have:

l A status of 3-Contract or 4-Current.

l A positive contract amount.

l A budget.

TheUnder-billed Jobs section displays the fivemost under-billed jobs ranked by percentage of contract.

ClickingEdit located to the right of the section heading opens theUnder-Billed Jobswindow.
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ClickingShow all in Report opens a report displaying all under-billed jobs. This link is only available if there aremore than
5 under-billed jobs.

This window provides options to display jobs:

l Ranked by dollar amount

l Ranked by percentage of contract

TIP: Over/under billing is another name for percentage complete accounting. For more information, see the topic
About percentage complete accounting.

About Outstanding Change Orders on the Dashboard

Displays information on change orders that are outstanding Less than 30 days orMore than 30 days. Drilling down into
either one of these areas displays change orders with statuses of:

l 2-Open—The client has not approved the changes yet. (Only thePrime Change List~Land with Aging report and
job status reports reflect the changes.)

l 3-Review—The changes are under review. (Only thePrime Change List~Land with Aging report and job status
reports reflect the changes.)

l 4-Disputed—The change order is in dispute.

TIP: Amounts that are shown in red indicate items that may need your special attention.

About Edit Job Selection on the Dashboard

This window is displayed for the Job Contract, Budget and Cost To Date, Job Cash Flow ToDate, Payable Retention By
Job, Receivable Retention and Job Uncommitted Budget panels.

The default selection is List all Contract, Current and Complete jobs. You can select up to six jobs. You can all list jobs
by supervisor by selecting the List jobs for job Supervisor button.

NOTE: The jobs listed are for statuses three through five. In the Job Contract, Budget, and Cost To Date panel,
the jobmust have a contract amount to be listed.

If you havemore than one content panel for jobs selection, you can put a title in theSelected Jobs Title box to differentiate
the panels at a quick glance. 

About Job Costs by Cost Type on the Dashboard

Compare job costs by cost type. You can add this panel more than once for different jobs.

NOTE: User-defined cost types (6-9) are included in the Other category. Default is All jobs, click Edit on this
dashboard panel in the Dashboard to select specific jobs. You can also view jobs by job supervisor.

About Edit Job Selection for Job Costs by Cost Type on the Dashboard

Compare job costs by cost type. You can add this panel more than once for different jobs.

About Job Contract, Budget and Costs to Date on the Dashboard

Displays the job contract, budget, and costs to date for 6 selected jobs. You can add this panel more than once for different
job contracts.

NOTE: In the Cost to Date column, the number is shown in red if the cost is greater than the budget.
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About Job Cash Flow to Date on the Dashboard

This panel displays the net cash flow to date on 6 selected jobs. You can add this panel more than once for different jobs.

About Job Uncommitted Budget on the Dashboard

Displays budget, actual and committed costs, and remaining budget for 6 selected jobs. You can add this panel more than
once for different job contracts.

This panel allows you to see what the committed costs are on a job. The committed costs aremonies that you’ve
committed to spend but have not spent yet. The report looks to new or unfilled purchase orders, subcontracts, and payroll
records that have not been final-computed. It allows you to determine the percentage of labor burden applied to all open
payroll records. It calculates the remaining budget based on the budget plus changes, less costs to date and committed
costs.

About Today's Job Tasks on the Dashboard

Displays today's tasks from a job schedule for a single job.

NOTE: Based on work days.

About Edit Job Selection for Job Tasks on the Dashboard

The default selection is List all Contract, Current and Complete jobs. You can all list jobs by supervisor by selecting
the List jobs for job Supervisor button. You can select only one job.

If you havemore than one content panel for job tasks, you can put a title in theSelected Job Title box to differentiate the
panels at a quick glance. 

About Tomorrow's Job Tasks on the Dashboard

Displays tomorrow's tasks from a job schedule for a single job.

About Payable Retention by Job on the Dashboard

Displays retention on jobs from payable invoices. You can add this panel more than once for different jobs.

About Receivable Retention on the Dashboard

Displays retention on jobs from receivable invoices.You can add this panel more than once for different jobs.

About Alerts content in the Dashboard
You can add or remove theMy Alerts content panel from the Alerts tab by clicking theAdd/Remove Content link on
the Dashboard.

About My Alerts on the Dashboard

This panel is automatically displayed in the top left when you have alert notifications sent to the Dashboard.

NOTE: If you remove theMy Alerts content panel from the Dashboard, the next time an alert notification is sent to the
Dashboard, theMy Alerts panel will automatically be displayed in the top left position.

All Alerts

The All Alerts count is the count of all read and unread alert notifications in the Dashboard Alert Viewer.
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Unread Alerts

The Unread Alerts count is the count of all unread alert notifications in the Dashboard Alert Viewer.

Working with Grids
When you right-click in a grid cell or column, the grid menu appears.

IMPORTANT: The displayed grid menu shows themost common commands for that item and will differ from column
to column and grid to grid. Depending on the conditions, cells may be unavailable for editing. The grid menus in 9-5
Takeoffs, the Takeoff Details tab offer muchmore functionality than do the grid menus in the rest of the program.

To help you enter data quickly, you can control the direction the cursor moves in the grid when you press the Enter key. For
example, if you want to fill in one column at a time, you can set the cursor to jump to the same cell in the next column to the
right (Enter Key Moves Right) instead of the next cell down in the same column (Enter Key Moves Down).
To set the direction of movement in a grid
1 Right-click in a grid to display the grid menu.

2 Click Enter Key Moves Right orEnter Key Moves Down.

3 The activated direction has a check mark next to it.
To find information in a grid
1 Right-click in a grid to display the grid menu.

2 Click Find on the grid menu.

3 In theGrid Find dialog box, choose the scope of your search by selecting eitherCurrent Column orEntire Grid.

4 In theSearch For cell, type the text string you want to find.

5 Click Find Next to find the next occurrence of the text string.

When you are working in a grid, you can drill down into related records. For example, you can go from 3-2 Receivable
Invoices/Credits to 9-2 Parts. If no record exists, you can create a new one with theAdd Record command.
To display details
1 In the grid, right-click to display the grid menu.

2 Click Display Detail/Add Record.

Selecting cells or rows or columns

To select Do this

A cell Click the cell or press the arrow keys tomove to the
cell.

A column Click the column heading.

A row Click the row heading.

Adjacent rows or
columns

Drag across the row or column headings.
Alternatively, select the first row or column, hold down
the Shift key and select the last row or column.

A range of cells Click the first cell and drag to the last cell.

All cells Click the top left corner of the grid.
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Working with Columns
As part of the defaults for a window, you can hide columns. Hiding does not delete columns, but it does remove the data
from printed reports in Quick Grids.

When you generate a print preview report from data in a grid with hidden columns, all the hidden information appears in the
report. If you drill down into data in the hidden columns, it will not be visible in the grid until you unhide the columns.

IMPORTANT: While you are not restricted from hiding any columns, some require entry to complete a record or
transaction.

To hide columns
1 Right-click in a cell, and from themenu select Show/Hide Columns.

2 TheGrid Viewwindow appears.

3 From themenu, clear the check boxes of the columns you want to hide.

4 Click OK.

TIP: Right-click a grid cell and select Save Current Grid View to save the grid view settings.

Under certain circumstances, columns are hidden from view. Use this procedure to display hidden columns.
To display hidden columns
1 Right-click in a cell, and from themenu select Show/Hide Columns.

2 TheGrid Viewwindow appears.

3 From themenu, select the check boxes of the columns you want to display.

4 Click OK.

TheAutofit All Columns command resizes all columnwidths to fit the column contents.

TIP: To resize one column at a time, position the pointer over the column divider and drag it to the height or width you
want.

Working with Rows
To insert a new row

Click the cell in the row immediately below where you want the new row to appear; or, right-click to display the grid menu,
and then click Insert Row.
To insert multiple rows

Select the rows immediately below where you want the new rows to appear, and then click Insert Rows.
To cut a row
1 In the grid, select the row(s) you want to cut by clicking on the row header(s).

2 Right-click to display the grid menu, then click Cut Row.

CAUTION: You cannot recover data after deleting it.

To delete cells, rows, or columns
1 Select the cells, rows, or columns you want to delete.

2 Press the Delete key.
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TheClear All Rows command clears everything in the grid.

IMPORTANT: This function is not available in every grid to protect certain kinds of data.

To clear all rows in a grid
1 Right-click anywhere in the grid to display the grid menu.

2 Click Clear All Rows.

Working with Text
You canmove text with theCut, Copy, andPaste commands. UsingCut removes the text from its location and stores it
on yourClipboard. UsingCopy does not remove the text from its location but does store it on yourClipboard.

You can then insert the text elsewhere using thePaste command. After the text is placed on theClipboard, you can
continue to paste the text until you cut or copy something else.
To copy and move a section of text
1 Select the text you want to move.

2 Right-click anywhere in the grid to display the grid menu, then do one of the following:

a Click Cut.

b Click Copy.

3 Insert the pointer where you want to insert the text.

4 On the grid menu, click Paste.
To paste a selection
1 Select the text you want to move.

2 Right-click anywhere in the grid to display the grid menu, then do one of the following:

a Click Cut.

b Click Copy.

3 Insert the pointer where you want to insert the text.

4 On the grid menu, click Paste.

The grid menu contains the following commands:

Working With Records

Locking records
Select the Lock Edit check box to prevent accidental changes to a record after saving it. Tomake permanent changes,
clear the Lock Edit check box and save the record.

You can find the Lock Edit check box in budgets, proposals, estimates, purchase orders, change orders, and
subcontracts. In cases where a calculation is being performed, the calculation will include locked data, even though it
cannot be edited.

Use the display properties to allow certain security
groups the ability to clear the check box once a record
is saved.
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Copying records
You can copy existing records to create new records, which saves time and prevents errors that can result from entering
complex transactions.

To copy a record:
1 Using the data control, select the record.

2 From theEditmenu, select Copy.

3 From the Filemenu, select New.

4 From theEditmenu, select Paste.

NOTE: Sage 100 Contractor copies all notes attached to the record.

Deleting records

CAUTION:
Do not delete jobs, vendors, or other records referenced in ledger transactions in the current fiscal year. Deleting such
records can cause problems with the audit trail. It is best to wait until you are closing the books at the fiscal year-end
to delete such records.

Deleting a record permanently removes the record from the database. You cannot recover a record after deletion.

To delete a record:
1 Using the data control, select the record.

2 On theEditmenu, click Delete.

Voiding records
Generally, you can only void a record from its window of original entry. If you have previously posted the transaction to the
general ledger, Sage 100 Contractor reverses the amount from the ledger.

IMPORTANT: Void entries toChecks and Bank Charges, Deposits and Interest, andRecurring Journal
Transactions from the 1-3 Journal Transactionswindow.

To void a record:
1 Open the window in which you originally entered the record.

2 Using the data control, select the record.

3 On theEditmenu, click Void.

Working With Attachments

About file and link Attachments on records

What are attachments?
Attachments provide functionality to attach files and/orWeb links to selected records in Sage 100 Contractor. There are
twomethods for attaching files and links. You can add them individually using theAttachmentswindow (Edit >
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Attachments), or you can simply drag-and-drop files and/orWeb links onto a Sage 100 Contractor window that accepts
attachments.

A few examples of Sage 100 Contractor windows that accept attachments are payable invoices, requests for proposal,
progress bills, change orders, purchase orders, jobs.

How can I use attachments?

Here are a few examples:

l After receiving a hard copy document that you would like to attach to a payable invoice record in 4-2 Payable
Invoices/Credits, you scan the document into your computer to create a file, then attach the file to the payable
invoice record.

l You have several digital photos of work being done on by a subcontractor on a remodel job. You can transfer these
files to your computer, and then attach them to a record in 6-7-1 Subcontracts.

l After sending an RFP to an architect who has aWeb site, you want to attach the architect's web site URL link to the
RFP record. From the open the site in your browser, you drag and drop the link from the browser's Address box onto
the 6-11-1 Requests for Proposal record.

How does attachment functionality work?

You create an attachment as either a “local” attachment or a “link” attachment. Link attachments can either be a file or a
URL (Web site link).

Creating a “local” attachment, associates the a local file (on your local computer) or a copy of a network file (copied from a
network computer) to an Sage 100 Contractor record in your local computer's company data. In this process, the program
creates a local folder and subfolder structure in your local company where the record is located.

Creating a “link” attachment, attaches a link to the remote file (on a network computer) or URL link toWeb page on a remote
computer. The program does not create a local folder and subfolder structure in your local company for linked attachments.

IMPORTANT: For link attachments, do not rename an attachment's file server after attaching a file. Sage 100
Contractor cannot locate a linked file if the file server is renamed or replaced by a server with another name.

Can I drag and drop files to create attachments?

If a record accepts attachments, you can drag and drop files onto the window to create an attachment. This includes
graphic files, Web links, email messages, desktop shortcuts, or any other file type.

NOTE: If you useMicrosoft Outlook, you can drag and drop email messages from your Inbox list directly onto a Sage
100 Contractor record.

Where are attachments located?
First, let's look at what happens when you attach a local file to a record. When you add the attachment and save the record,
the program creates an Attachments folder and folder structure under \MB7\[company]\Attachments. To prevent naming
conflicts between files, each file in placed into a subfolder with a unique name.

For example, let's suppose you are working in Sample Company job Jiminez Burrito #8, and you attach a local graphic file
to record 8 in 6-4-1 Change Order, Floor Tile Upgrade. After saving the record, inWindows Explorer, you will find this
path: \MB7\Sample Company\Attachments\Jobs\ChangeOrders\(unique subfolder name)\(file name).gif.

TIP: Sample Company data can be changed on any computer. The Sample Company data in these examples may
not match the Sample Company data on your computer exactly.
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What is the attachment parent-child structure?

You probably noted that the ChangeOrder folder is a subfolder of Jobs. That's because the program creates Attachments
according to the existing parent-child relationships that already exist in the program for Jobs and ChangeOrders.

For example, the parent record for the change order is the job, 215-Jiminez Burrito #8. If you were to open, 6-6-1
Purchase Orders to record 38, clear the Lock Edit, and add the same graphic file to this record and then look at the folder
structure, you will findMB7\Sample Company\Attachments\Jobs\Purchase Orders\(unique subfolder name)\graphic.gif.
The attachments to the purchase order record and the change order record are both “children” of job 215—Jiminez Burrito
#8, which is located in 3-5 Jobs (Accounts Receivable).

What do I see when opening parent record when children have attachments?

You can attach files to both “parent” records and “child” records. For example, you can attach files and links to job 215-
Jimenez Burrito #8 directly from that job's record in 3-5 Jobs (Accounts Receivable) or to that job through other records
such as ChangeOrders, PurchaseOrders, Subcontracts, and so forth. As described above, you can add attachments to
records that are children of the job.

Because of the parent-child structure of the program, when you open the Attachments window from the parent window 3-5
Jobs (Accounts Receivable) 215-Jimenez Burrito #8, you can select different ways to view the Attachment related to
this job using the box with the title, Show items attached to:

l this job directly. If the parent record has attachments, the attachments would be displayed in this list.

l Purchase Orders for this job. If a “child” purchase order record of this job has attachments, then the attachments
would be displayed in this list.

l Change Orders for this job. If a “child” change order record of this job has attachments, then the attachments
would be displayed in this list.

How does attaching network files work?

When you select a network file to attach to a record, the program recognizes that it isn't a local file and offers two choices,
Copy the file to my company data (my local computer), or Link to the existing file (on a network computer).

If you select toCopy the file to my company data, the programmakes a copy of it and places it in a folder\subfolder
structure under \MB7\(company)\Attachments\ in its parent-child relationship.

If you select to Link to the existing file, the file remains on the network computer. A copy of it is not created, and it does
not appear in a folder under \MB7\(company)\Attachments\. In fact, if you never link to a local file or copy a attachment file
to your computer, you will never see an Attachments folder under the company folder.

What happens if I select “Protect this file from being changed”

After you link to a network file by selectingCopy the file to your company data, you have the option toProtect this file
from being changed. After saving the record, if you were to open the linked file and try to edit it, the program that opens it
displays amessage stating that the file cannot be changed, is read-only, or something similar. Themessage displayed
depends on the program that opens it.

NOTE: If you select the option, Link to the existing file, theProtect this file from being changed option is
unavailable. If you need to prevent an attachment from being changed, select theCopy file to my company data
option.

How do I attach Web links?

When adding a link to aWeb page as an attachment, you are encouraged to copy and paste the contents of your browser's
Address box (a URL—unique resource locator) into the box on the Add Attachment window. You can type the URL in the
box, but it's much easier to copy and paste it to avoid possible errors from typingmistakes.
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TIP: Attachments that areWeb links are always remote and never appear in an Attachments folder under \MB7\
(company name).

How do I know that a record has attachments? Are there visual indicators?

AnAttachment button has been added to the toolbar. It displays a paper clip against a grey background if the record has no
attachments. It displays a paper clip against a white rectangle if the record has attachments. You can click the
Attachments button to open theAttachmentswindow whether the record has attachments or not.

IMPORTANT: To provide room for theAttachments button, theCount button has been removed from the toolbar.
On windows that provide the count files functionality, theCount command is available from themenu bar.

Can I email attachments?

IMPORTANT: Emailing attachment functionality only works if Microsoft Outlook is your default Email client.

Yes, just open anAttachmentswindow, and select one or more attachments. Click Email, and the program opens an
email message with the attachments included in theAttach... box.

Can I print Attachments?

Yes, just open anAttachmentswindow, and select an attachment. Click Print, and the program opens the file in the
program that is controlled by yourWindows settings.

NOTE: Printing from theAttachmentswindow behaves the same as right-clicking the file inWindow Explorer and
selectingPrint from themenu.

Attaching files individually using the Add Attachment window
You can attach files to records individually using theAdd Attachmentwindow. The file can be a local file or a network file.
In the case of a network file, it can be attached as a link to a network file, or a copy of a network file.

To attach a local file using Add Attachment:
1 Open a Sage 100 Contractor window that accepts attachments, such as 3-5 Jobs (Accounts Receivable) and select a
job.

2 Click Edit > Attachments.

3 On theAttachments for Job#window, click Add.

4 On theAdd Attachmentwindow, select I want to attach a file.

5 Click Browse, and locate the file you want to attach, select it, and click Open.

6 Do one of the following:

a If you have selected a local file to attach, follow these steps:

i On theAdd Attachmentwindow, accept or edit the description of the attachment.

ii Accept or clearProtect this file from being changed.

iii Click OK.

b If you have selected a network file to attach, follow these steps, if you have selected the option, Copy file to my
company data:

i On theAdd Attachmentwindow, accept or edit the description of the attachment.

ii Accept or clearProtect this file from being changed.
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iii Click OK.

c If you have selected a network file to attach, follow these steps, if you have selected Link to existing file:

i On theAdd Attachmentwindow, accept or edit the description of the attachment.

ii Click OK.

7 The file is displayed in grid of theAttachments for Job #window.

Attaching Web links individually using the Add Attachment window
You can attachWeb links to records individually using theAdd Attachmentwindow.

To attach a Web link using Add Attachment:
1 Open a Sage 100 Contractor window that accepts attachments, such as 3-5 Jobs (Accounts Receivable) and select a
job.

2 Click Edit > Attachments.

3 On theAttachments for Job#window, click Add.

4 On theAdd Attachmentwindow, select I want to attach a link to a Web page.

5 Launch your browser, and browse to theWeb page that you want to link to the record.

6 Copy theWeb page address, and then on the Add Attachment window, paste into thePaste... box.

7 In the Description... box, type a description.

8 Click OK.

9 TheWeb link is displayed in grid of theAttachments for Job #window.

Dragging and dropping multiple files onto records
You can drag and dropmultiple records onto individual records to create attachments. When you drag and drop the files
onto the window, Windows Explorer is a good source for files.

To drag and drop multiple files onto records:
1 OpenWindows Explorer, and browse to files from which you want to create attachments.

2 Open the Sage 100 Contractor window to a specific record to which you want to attach files.

3 Select any number of files and then drag and drop them on the Sage 100 Contractor window.

4 Save the record, and then recall it.

5 To verify that the attached files are there, on the toolbar, click theAttachments button.

6 The attached file are displayed in the grid of theAttachmentswindow.

Removing attachments from records
You can remove local and linked files as well as Web page links by clicking Remove on theAttachments for... window.

NOTES:
l If you attempt to open a linked network file that has beenmoved or deleted, the program displays amessage

stating that the file cannot be found.

l To delete attachments, youmust belong to a security group that has rights to delete records.
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Emailing files attached to records
Microsoft Outlook is integrated with Sage 100 Contractor through the Attachments window. You can launchOutlook with a
file attached from any window that displays an Attachments button. You can also launchOutlook with an attached file from
any Report Printing window.

IMPORTANT: Emailing attachments only works if Microsoft Outlook is your default email client.

To email a file attached to a record:
1 Open a Sage 100 Contractor window, a record that contains attachments, and on themenu bar click Edit >
Attachments.

2 On theAttachments for... window in the grid, select the row containing the attached file that you want to email, and click
Email.

3 On theUntitled Message email window, proceed with filling in the boxes, and then press Send.

Lookup windows
Lookupwindows help you locate data. Suppose you are entering a payable invoice, but do not remember the vendor
number. You can open a Lookupwindow, find the vendor, and then insert the vendor number in the appropriate box.

Tomake searching easier in the Lookupwindow, use the data control to move through records or use Find to query the
data. After you locate the data, you can insert it in the appropriate text box or cell.

In fields that contain character or alphanumeric data such as descriptions, addresses, and invoice numbers, Sage 100
Contractor sorts data by the value of the first digit. If a field is strictly numeric, then the numbers appear in numerical order.
For example, 1100 would appear before 200.

Click the [Refresh] button to return the list in the Lookupwindow to its original order.

NOTE: Some Lookupwindows have a left and right pane. If theRefresh button is used, the list in the right-hand
pane will return to the original list order for the item selected in the left-hand pane.

The Lookupwindow is split. The left half displays the classes, and the right half displays the contents of the class that you
select.

In the Lookupwindow, click the triangle next to the class you want to open or close. The color of the triangle indicates
whether you can display more subclasses.

Color Description

Red The class cannot be expanded any further (end of the branch).

Blue Currently selected class showing all subclasses.

Green Contains subclasses and can be opened by clicking on the plus
sign (always displays a plus sign).

To display a Lookup window, do any of the following

l Click the drop-down arrow in the data control.

l Click the drop-down arrow next to the text box.

l Right-click in a cell of a column, and then select a window from themenu.
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l Select a cell and press the F5, F6, F8, or SHIFT+? keys.

l Select a cell, enter a word or partial word, and then press F5 or Shift+?. The Lookupwindow displays the first
occurrence found in the database.

l Select a cell, type a wildcard, then enter a word or partial word and press F4. The Lookupwindow displays every
occurrence found in the database.

l Double-click the cell or column title.

l Select the cell or column and click the drop-down arrow in the cell.

TIP: If you delete a column accidentally, or have hidden a column you want to see again, you can right-click on any
column header and click [Show All] to display all columns.

To select an item in a Lookup window

l Click the item

l To pull an item into a grid, double-click it.

To sort a column in ascending order

l Click the arrow in the column title.

Althoughmany Lookup windows have aPrint button, some of them do not. For example, open 1-5 Bank Reconciliation,
click the drop-down arrow at the end of theAccount# box, and the program displays the Ledger Accounts lookup window.
It has noPrint button, but you can create a screen capture of a portion of the Lookup window’s information, paste it into a
Word document, which can then be printed.
To capture and print a Lookup window
1 Open the Lookup window, and click theMaximize button (center button, upper right of the window).

2 To reduce the amount of information displayed, select a portion of the data. For example, instead of displayingAll
Account Types, select one account type, perhaps Cash Accounts.

3 Press Ctrl+Print Screen.

4 LaunchMicrosoft Word, open a blank document, and press Ctrl+V.

5 The screen capture of the lookup window is pasted into theWord document, which can then be printed.

Working with Picklist Windows
A Picklist is a type of Lookupwindow. With aPicklist, you can select a group of items and insert them in the active
window. For example, in thePayable Invoiceswindow you can select and insert a list of parts in the grid.

InReport Printingwindows, it is not necessary to create aPicklist. If you know which record numbers to include in the
report, enter them in thePicklist box. Make sure to separate the record numbers with commas.

IMPORTANT: If you press F8 on a criteria item that displays aPicklist check mark, such as in the 5-2-3 Compute
Payroll window, noPicklistwindow is displayed. The F5 key, however, will display thePicklistwindow.

To display a Picklist window, do one of the following

l From the grid cell of a column that supports Picklist functionality, for examplePart# orAssembly#, right-click a
cell, and click Display Picklist Window.

l A window related to that column opens withPicklist functionality indicated by the check mark button.
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l From the grid cell of a column that supports Picklist functionality, press F8.

l From windows with text boxes that support Picklist functionality, such as 5-2-3 Compute Payroll, click the check
mark button.

To select a group of items in a Picklist window
1 Double-click each item you want to select.

2 To insert the group of items into the grid, click the Insert Selected Items button.
To sort a Picklist window

l In fields that contain character or alphanumeric data such as descriptions, addresses, and invoice numbers, Sage
100 Contractor sorts data by the value of the first digit. If a field is strictly numeric, then the numbers appear in
numerical order. For example, 1100 would appear before 200.

l To sort a column in ascending order, click the arrow in the column title.

Function Keys and Shortcuts

About function keys
The function keys (F keys) provide quick access to functions or features common throughout Sage 100 Contractor.

Key Function

F1 Displays a help topic that is specific to the window in which you are operating.

F2 Displays the calendar.

F3 Displays theCalculator.

F4

Displays data from the selected field (drop-down arrow) in a Lookupwindow by entering a search term in
the field.

To display the first match found, type the search term (or beginning of term) in the field and press Enter.

Enter wildcards with an asterisk (*) before the search term for exact matches, or with an asterisk and space
for all occurrences.

F5

From within the selected field, the F5 key will display data in a Lookupwindow or bring up theQuick List
for the data selected.

If you have a starting point for your search, you can narrow down the search by typing your search in the
text box and pressing the F5 key.

To search for the first instance of a number, type your search in the text box and press the F5 key.

F6 Displays the detail window related to a selected record in your text box. An enabled detail buttonmeans
that the text box has a related window to display. Press F6, or click the detail button.

F7

Displays the Field Properties dialog box, which allows you to set the individual setup and security
properties for a text box, list, check box, or grid column, as well as set security for certain menu commands
from themainmenus. You can also customize the screen, set defaults in specific fields, and set system
user prompts.

The F7 key is only available if you are currently logged in as Supervisor.
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Key Function

F8 Displays aPicklistwindow from a grid cell of a column that supports Picklist functionality, for example,
thePart# andAssembly# columns.

Important:

If you press F8 on a criteria item that displays aPicklist check mark, such as in the 5-2-3 Compute
Payroll window, noPicklistwindow is displayed. The F5 key, however, will display thePicklistwindow.

F9 Retrieves the first matching record for a selected search term from an indexed field (with a yellow bar) and
allows you to press Page Up and Page Down tomove through the records.

F10 Activates keyboard shortcuts for the active window, and the window displays underlinedmenu commands.
For example, Exit becomes EXit. Pressing the X key, closes the window.

Activating keyboard shortcuts with the F10 key
In Sage 100 Contractor, you can activate keyboard shortcuts by pressing the F10 key when in a window.

To activate keyboard shortcuts with the F10 key:
1 Open a Sage 100 Contractor window, for example, 13-3 Report Writer.

2 Press the F10 key.

3 Themenu bar items change so that letters are underlined. For example, Exit becomes Exit,Mode becomes Mode, and
so forth.

4 To open amenu command, press the key corresponding to its underlined letter. Press M, for example, to open theMode
drop-downmenu.

5 The drop-downmenu appears with a list of commands. The commands appear with letters underlined. For example,
Text, Line, Box, Picture, and so forth.

6 To activate any of the drop-downmenu functions in the window, press any of the underlined letters.

Working with the Calendar
Each company uses its own calendar. The calendar lets you schedule employee appointments as well as set the workdays
and non-work days. After an appointment is scheduled, the date appears in red and is underlined.

You can display the calendar frommost windows by pressing the F2 key or by double-clicking a date box or column.
To schedule non-work days in the calendar

For each day that you designate as a non-work day, Sage 100 Contractor displays Off.

To Do this

Set Saturdays off On theOptionsmenu, click Saturdays Off.

Set Sundays off On theOptionsmenu, click Sundays Off.

Set an individual day off Right-click the selected date.

To select a date in the calendar

l In the data control box, type the date (following theMM/DD/YYYY format). Then click [Enter].
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TIP: You can use the data control to move day by day or month by month.

To enter appointments in the calendar
1 On theSage 100 Contractor Desktop, do one of the following:

a Double-click theCalendar icon.

b Press F2.

2 Click the day on which you want to schedule an appointment, then on theEditmenu, click Appointment.

3 In theCalendar Appointmentswindow, in theStart andEnd cells, enter the times when the appointment is to begin
and end.

4 In the Type cell, select the appropriate appointment type.

5 In theEmployee cell, select the employee number for the person who has the appointment.

6 In theClient cell, select the client number of the client with whom you are scheduling an appointment.

7 In theNotes cell, enter any information you wish to add regarding the appointment.

8 Click theSave button.

9 Repeat steps 3–8 for each appointment.
To enter appointment types
1 Open the calendar.

2 On themenu bar, click Appointment Types.

3 In theAppointment# cell, enter the appointment number.

4 In theDescription cell, enter a description for the type of appointment.

5 Repeat steps 3–4 for each type.

6 From the Filemenu, select Save.
To delete an appointment
7 Open the calendar.

8 Select the day of the appointment.

9 On themenu bar, click Edit, then click Appointments.

10Select the appointment.

11Press the Delete key.
To delete all appointments through a certain date
12Open the calendar.

13Click the last date through which you want to delete appointments.

14On theOptionsmenu, click Delete Appointments.

Working with the Calculator
You can display the calculator from any window, cell or box by pressing F3. The calculator displays the results in a list
similar to a calculator tape. When you use the calculator, you can paste the results to the selected cell or box in the active
window.

From within some numeric-entry cells in a grid there are several ways to display the calculator.
To display the calculator, do one of the following
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l Enter a number followed by an operator.

l Press F3.

To perform calculations
1 Select the cell or box in the active window, and open the calculator.

2 Enter the first number in the calculation.

3 Click an operator.

4 Enter the next number in the calculation.

5 Click Enter.
To paste from the calculator, do one of the following

l Click the check mark button next to theEntry,Memory, or Total boxes.

l Use theCopy andPaste commands.

To convert measurements on the calculator
1 Open the calculator.

2 Enter the number you want to convert.

3 On theConversionsmenu, point toStandard, US to Metric,Metric to US, orPitch and select the type of conversion
you want.

To select the number of decimal places

l UnderPlaces, select the option for the number of decimal places you want.

To store a figure in the calculator’s memory for use in future calculations

To Do this

Place a number in memory Click theMemory button.

Recall a number in memory Click theRecall button.

Add a number tomemory Click theM+ button.

Remove a number frommemory Click theM– button.

Working with Notes
You can keep notes with each record, which can prove helpful when reviewing data later. You can save notes with
individual records, as well as with individual rows in a grid. Some notes print with specific reports; other notes function as
memos to a specific topic and can only be printed from the notes window itself.

You can paste a selection of text fromWord or Excel into any Sage 100 Contractor Notes window, for example, the notes
window on 9-5 Takeoffs.

NOTE: When you paste into a Notes window, you are pasting unformatted text from your computer’s clipboard.
Because of that, copying the contents of multiple Excel rows and columns and pasting it into a Notes window
removes all the row and column structure.

To paste a selection of text fromWord or Excel to Sage 100 ContractorNotes
1 InWord or Excel, select text, right-click it, and chooseCopy.
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2 Open a Sage 100 ContractorNoteswindow.

3 Right-click once in the window, and choosePaste.

If you want to move the location where notes print on a document, you canmodify the form design.

IMPORTANT: When you create a note in aReport Printingwindow, the note appears on all documents.

To enter a note
1 On themenu bar, click Notes.

2 Type the note.

3 On the Filemenu, click Save.

NOTE: After creating a note, theCreate Note button changes to theNotepad button.
To view a note

l To view a record note, on themenu bar, click theNotes button.

l To view a grid note, from a grid with aNotes column, double-click theNotes cell.

To print a note

l In theReport Printingwindow, select theNotes orGrid Notes check boxes.

To delete a note
1 On themenu bar, do one of the following:

a For a record note, click theNotes button.

b For a grid note, double-click theNotes cell.

2 Do one of the following:

a On the Filemenu, click New.

b To erase a portion of a note, select the text and press the Delete key.

3 On the Filemenu, click Save.
To insert information into a note

l To insert a date into a note, on the Insertmenu, select Current Date.

l To insert a client’s address into a note, on the Insertmenu, select Client Address.

l To insert an employee address into a note, on the Insertmenu, select Employee Address.

l To insert a vendor’s address into a note, on the Insertmenu, select Vendor Address.

l To insert a field into a note, on the Insertmenu, click Fields.

To check the spelling in a note

l On theEditmenu, select Spell Check.

To enter a note for a line in a grid
1 In theNotes cell, type your note.

2 On the Filemenu, click Save.
To undo changes in a note
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l On theEditmenu, select Undo.

IMPORTANT: You can only undo the last change.

Opening text files

To open a text file:
1 On the Filemenu, click Open.

2 Select the file, and then click OK.

Working with Find queries
Using Find, you can create queries and search for records. When you query a database, Sage 100 Contractor locates all
the records that match the criteria and displays the results in aQuick Reportwindow. You can then select a record for
display.

Queries are specific to the windows in which you create them. Suppose that in theAccounts Payable Invoiceswindow
you create a query titledDisputed Invoices, which searches for payable invoices assigned status 3-Dispute. You can
only find theDisputed Invoices query in theAccounts Payable Invoiceswindow. It will not appear elsewhere in Sage
100 Contractor.

After using Find to query a database, Sage 100 Contractor displays the results in aQuick Reportwindow. You can select
a record and click theDrill Down button to display the record. When you are finished examining the record, close the
window in which it appeared.
To create a query
1 On the Filemenu, click Find.

2 Click New.

3 In theName box, enter the name of the query.

4 Using theQuery Wizard, create the query.

TIP: After you create a query, Sage 100 Contractor automatically saves it.

To run a saved query
1 On the Filemenu, click Find.

2 In the list, click the query you want.

3 Click Run.
To delete a saved query
1 On the Filemenu, click Find.

2 In the list, click the query you want.

3 Click Delete.

About customizing Sage 100 Contractor defaults
You can customizemany different aspects of Sage 100 Contractor. For example, by using security groups, you can grant
or restrict access to specific windows. Within a window, you can customize text boxes, lists, check boxes, and columns to
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increase data entry speed and accuracy. Within each window, you can set up default information, require entries, skip
entries, or even limit access to specific security groups.

For example, in the 1-1 Checks/Bank Chargeswindow, you can set the default ledger account number for your checking
account in theAccount Number box. When you open the window, Sage 100 Contractor automatically inserts the account
number.

Working with Images
You can include images with certain types of records. For example, when you assign the image of an employee to the
employee’s record, Sage 100 Contractor displays a thumbnail view in theEmployeewindow. Sage 100 Contractor
supports the following types of images: .bmp, .jpeg or .jpg, .gif, .emf, .wmf, and .ico files.

Before assigning an image to a record, the image file must follow a specific naming convention. For example, use a word or
words, followed by a space, followed by a number (see below). This lets you keep a series of pictures with a record you can
use the same name but change only the number.

After you assign an image file to a record, you can include other image files with similar names.

Suppose you have been taking pictures of the progress at a job site. The latest photo, fourth in the series, is named BL
Johnson 04.bmp and is assigned to the job record. A thumbnail of the photo appears on the job record. In addition, you can
view the three previous photos, BL Johnson 01.bmp, BL Johnson 02.bmp, and BL Johnson 03.bmp from the Image
window.

You can assign a single image or a series of images to a record. When you include an image in a file, Sage 100 Contractor
saves a copy to the Images folder, which is located in the \MB7\company folder.

For a series of images, the images must use the correct naming convention. Assign each image in the series to the record.
Sage 100 Contractor copies the image files to the appropriate folder for you.
To assign an image to a record
1 Using the data control, select the record to which you want to assign an image.

2 On theEditmenu, click Image.

3 Click Browse.

4 In theAssign Image dialog box, choose the image you want to assign to the record and click Open.

5 Click OK.
To view an image on a record
1 Using the data control, select the record from which you want to view an image.

2 Double-click the small image.

3 On theEditmenu, click Image.
To delete an image
1 Using the data control, select the record from which you want to delete an image.

2 On theEditmenu, click Image.

3 Click Clear.

4 Click OK.
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Working with Templates
Many windows throughout Sage 100 Contractor let you create templates. A template can include any information you want
to provide such as dates, descriptions, or other important information. You can create a template from scratch, or modify an
existing record and save it as a template. Unlike a record, you do not have to complete required fields to create a template.

Suppose that you are building homes in a residential subdivision. The budget and proposal for the base design are
established and do not vary. Using templates in the 6-4 Change Orderswindow, you can create a different template for
each upgrade. When you are informed which upgrades the home buyer wants, you can load the corresponding templates to
create the necessary change orders.

When creating a template, some information is not preserved in the template. For example, Phase information is not saved
in the template when creating a template from 3-5 Jobs (Accounts Receivable); however, you can print a report that
shows that information.
To save a template
1 On the Filemenu, click Save As Template.

2 On theSave Templatewindow, in the Template Name box, type the name of the template.

3 Click OK.
To load a template
1 On the Filemenu, click Load/Delete Template.

2 Select the template you want to load.

3 Click Load.
To delete a template
1 On the Filemenu, click Load/Delete Template.

2 Select the template you want to delete.

3 Click Delete.

4 Click Close.

Working with Document Tracking
IMPORTANT: The program only displays Document Tracking (formerly called Attachments) in specific windows and
only if you have used Document Tracking with those windows previously.

IMPORTANT: Document Tracking tracks file information associated with a record. Its functionality is different from
that of Attachments, in which you attach files and/or links to records directly. For more information about
Attachments, see the topic, About file and link Attachments on records.

Document Tracking provides a way for you to track file information associated with a record. The Document Tracking
functionality keeps track of many different type of files, such as *.doc (Word document, a *.jpg (graphic), a *.pdf (Adobe
portable document format), an *.xls (Excel spreadsheet), and so forth.

A Document Tracking recordmust contain aDescription, andmay contain the following:

l Number of Copies sent

l Return, yes or no?

l Any Notes about the file being tracked.



- 723 -

To enter file information
1 On theOptionsmenu, click Document Tracking.

2 In theDocument column, enter the name of the document.

3 In theCopies column, enter the number of copies sent.

4 In theReturn column, you can indicate whether the document has been returned or not. Type Yes if the document has
been returned, or No if the document is still out.

5 In theNote column, double-click a cell and type a note as required.

6 On the Filemenu, click Save.

Exporting and Importing Files

An overview of moving data into and around Sage 100 Contractor
One of the strengths of Sage 100 Contractor is that you canmove data into and around in Sage 100 Contractor in many
different ways. Some of the data, such as a template, must be used “internally,” that is, within a single Sage 100 Contractor
company. Other data can bemoved from company to company and transferred to another party, for example, as a budget
file. In addition, other data and lists can be imported via special functions and third-party applications.

Sage 100 Contractor provides standard, Microsoft Windows copy and paste functionality. You can copy and paste data
from grid to grid in Sage 100 Contractor.

In somewindows, you can save records as templates that are for use inside a Sage 100 Contractor company. These are
text files, and you cannot email them to an other party to use with a different company. They are for “internal” use within a
specific company. A template can be a shell for maintaining a structure for data, or it can be a shell with some data in its
structure. Consider that a template is the starting point for working with a set of data.

Other examples of data that can bemoved around and into Sage 100 Contractor are referred to as “files” and “grid files.”
These files and grid files can be considered a different type of template. Sage 100 Contractor provides a way for you to
import and export these files from one part of Sage 100 Contractor to another, for example from 9-5 Takeoffs to 6-2
Budgets. Essentially, files and grid files represent work that is in progress to which you can add data at any time.

A file, such as a takeoff file or a budget file, is an entire unit of data, whereas a grid file is a portion of an entire unit of data.
For example, a grid file could be a single phase of a budget or a specific bid item/phase combination of a takeoff. These files
and grid files are created in Sage 100 Contractor for use in Sage 100 Contractor only; however, they can be emailed to
another party or copied from one Sage 100 Contractor company to another.

There are important differences between files and grid files. For example, always import files before entering any other
information in the grid because they overwrite any information that you have already entered in the header and grid cells.
Grid files, in contrast, insert data at the cursor and do not overwrite the existing content. So you can import a grid file at a
certain position in a grid.

You canmove data into Sage 100 Contractor via specialized external imports with such features as adding parts and
updating prices using database update services.

Finally, the Sage 100 Contractor API and third-party applications provide ways to import a variety of specialized data.
Finally, the Sage 100 Contractor API and third-party applications provide ways to import a variety of specialized data. For
more information about the Sage 100 Contractor API, see Appendix G.

Here is a basic list of ways tomove data into and around in Sage 100 Contractor:

l Standard copy and paste

l Templates
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l Specialized templates known as files and grid files

l External imports, for example price updating service

l Third-party applications and the Sage 100 Contractor API.

About exporting files
Depending on the type of work that you perform, youmight need a few files or a large library. Careful thought should go into
the creation of each file that you build. Themark of a good file is one that requires little modification. Themore you have to
change a file to suit a specific situation, the less time it saves you. Remember that a file can include as much or as little
information as you want.

You can either use an existing record as the basis for a file or build a file completely from scratch. When using an existing
record, most of the work is already completed. Simply recall the record, modify it to meet your needs, then export it as a file.
To export a budget file
1 Open 6-2 Budgets.

2 On theOptionsmenu, point toExport, then click Budget File.

3 Name the file, then click Save.

NOTE: Files are specific to the company in which you save them.

To export a proposal file

NOTE: You can create a file from an existing proposal. Sage 100 Contractor only creates a file for the currently
displayed grid. Files are specific to the company in which you save them.

1 Open 6-9 Proposals.

2 In the data control box, enter the job number for the proposal that you want to use.

3 In thePhase list, click the phase, then edit the content of the phase.

4 On theOptionsmenu, point toExport, and then click Proposal File.

5 Name the file, and click Save.

TIP: Instead of using a proposal from an existing job, you can create a new proposal.

To export a unitary proposal file

IMPORTANT: Files are specific to the company in which you save them.

1 Open 6-10 Unitary Proposals.

2 In the data control box, enter the job number for the proposal that you want to use.

3 In thePhase list, click the phase. Edit the content of the phase as needed.

4 On theOptionsmenu, point toExport, and click Proposal File.

5 Name the file, and click Save.

TIP: Instead of using a proposal from an existing job, you can create a new proposal.

To export a takeoff to a file

This functionality is only available if you have purchased the Estimating Add-OnModule.

http://sagemasterbuilder.com/products/p_f_est_estimating.asp
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Consider the following points before exporting takeoffs to files:

l You canmake a file containingmost all the assemblies and parts necessary, or you canmake one containing a
simple outline.

l Instead of using an existing takeoff, you can create a new takeoff for the file.

1 In the Sage 100 Contractor mainmenu tree, double-click 9-5 Takeoffs.

2 In the Takeoff Launchwindow, double-click a job to launch a takeoff.

3 Do the following for each grid:

a Delete any unwanted assemblies or parts.

b Delete any unnecessary values for variables.

c Delete any unnecessary quantities.

4 On theExportmenu, click Takeoff File. TheSave Filewindow opens.

5 Name the file, and click Save.
To export a scheduling grid file

IMPORTANT: Scheduling files cannot contain job numbers or phases.

1 Open 10-3 Schedules.

2 To create a file from a phase in an existing schedule, do the following:

a In the data control box, enter the job number.

b In thePhase list, click the phase.

c Edit the content of the phase.

TIP: Instead of using a schedule from an existing job, you can create a new schedule.

3 On theOptionsmenu, point toExport 10-3, then click Grid File.

4 Name the file, then click OK.

NOTE: Files are specific to the company in which you save them.

About exporting reports to other programs
You can export Sage 100 Contractor documents for use with other word processing or spreadsheet programs. Using the
Generic/Text Only printer driver supplied with your operating system, print the report to a *.prn file (a simple ASCII
formatted file). You can then open the *.prn file in Sage 100 Contractor that you want to use. Most programs now use
wizards to help you convert the file to the appropriate format.

Before you can create a *.prn file, youmust install the Generic/Text Only printer driver using theWindows operating system
CD.
To install the Generic/Text Only printer driver
1 Click theStart button, point toSettings, then click Printers.

2 Double-click theAdd Printer icon.

3 Follow the directions in theAdd Printer Wizard. Be sure to do the following:

a UnderManufacturers, select Generic.
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b UnderPrinters, select Generic/Text Only.

4 Then underAvailable Ports, select File.
To print to file using the Generic/Text only driver
1 On themenu bar, click Print Records.

2 In theReport Type list, click the report that you want to print.

3 In thePrinters list, click Generic/Text Only.

4 In the Form Design list, click the form design that you want.

5 On theSelection Criteria tab, enter the criteria that you want to use for selecting data.

6 To preview the document, click thePreview button.

7 On themenu bar, click Print Records.

About Open Database Connectivity (ODBC)
ODBC allows programs to share database information. The files in Sage 100 Contractor are ODBC-compliant using the
FoxPro version 2.6 database file format. You can access the files using other programs such as Microsoft Excel.

Sage 100 Contractor itself is not ODBC-compliant. Sage 100 Contractor does not let you select an ODBC format other than
FoxPro version 2.6.

Exporting data to PDF format
Adobe® System’s Portable Document Format (.pdf) is a convenient way to control the way your document looks when you
send it electronically (such as via email).

There are two ways to export Sage 100 Contractor Data to PDF format:

l Click the Adobe PDF button in the toolbar

l Export data to the Sage 100 Contractor PDF driver

To export data using the Adobe PDF button
1 On the toolbar, click theAdobe PDF button.

2 Verify the filename and location in the Export to File dialog box.

3 Click the [Save] button.

To export data in PDF format:
1 On themenu bar, click File, then click Print.

2 Click Sage 100 Contractor PDF Export in thePrinter drop-down list.

Exporting data in RTF format
Rich Text Format (.rtf) is a standard file format for word processors and can be sent as an email attachment. Use this
option if you want to export a report or document to Microsoft Word or another word processor.

There are two ways to export Sage 100 Contractor Data to RTF format:

l Click theMicrosoft Word button in the toolbar

l Export data to the Sage 100 Contractor RTF driver
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To export data using the Microsoft Word button
1 On the toolbar, click theMicrosoft Word button.

2 Verify the filename and location in the Export to File dialog box.

3 Click the [Save] button.

To export data in RTF format:
1 Click Sage 100 Contractor RTF Export in thePrinter drop-down list.

2 On themenu bar, click File, then click Print.

3 Verify the filename and location in the Export to File dialog box.

4 Click the [Save] button.
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Appendix B: Sage 100 Contractor Reports
About Sage 100 Contractor Reports
This section provides a complete list of all Sage 100 Contractor reports by menu item.

1-General Ledger Reports

1-1 Checks/Bank Charges

Report Name Locked

21—Cash Checks Yes

1-2 Deposits-Interest

Report Name Locked

21—Deposit Yes

1-3 Journal Transactions

Report Name Locked

21—Journal Transaction Record Yes

1-4 Recurring Journal Transactions

Report Name Locked

21—Recurring Journal Transaction Record No

22—Recurring Journal Transaction Record~with Notes No

31—Recurring Journal Transactions List No
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1-5 Bank Reconciliation

Report Name Locked

21—Bank Reconciliation Yes

1-7 General Ledger Accounts

Report Name Locked

21—General Ledger Account Record No

1-7 Subsidiary Account 

Report Name Locked

21—General Ledger Subaccount Record No

1-8 General Ledger Setup

Report Name Locked

21—General Ledger Setup Yes

1-1 Checks-Bank Charges

Report Name Locked

21—Cash checks Yes

1-2 Deposits-Interest

Report Name Locked

21—Deposit Yes

1-3 Journal Transactions

Report Name Locked

21—Journal Transaction Record Yes

1-4 Recurring Journal Transactions

Report Name Locked

21—Recurring Journal Transaction Record No
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Report Name Locked

22—Recurring Journal Transaction Record~with Notes No

31—Recurring Journal Transactions List No

1-5 Bank Reconciliation

Report Name Locked

21—Bank Reconciliation Yes

1-7 General Ledger Accounts

Report Name Locked

21—General Ledger Account Record No

1-7 Subsidiary Account 

Report Name Locked

21—General Ledger Subaccount Record No

1-8 General Ledger Setup

Report Name Locked

21—General Ledger Setup Yes

2-Accounting Reports

2-1 Trial Balance Reports

Report Name Locked

21—Trial Balance Yes

31—Trial Balance~Working Yes

2-2 Balance Sheet Reports

Report Name Locked

21—Balance Sheet Yes

31—Balance Sheet~This Year/Last Year Comparison Yes
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2-3 Income Statement Reports

Report Name Locked

21—Income Statement Yes

31—Income Statement~Period and YTD Yes

32—Income Statement~This Year/Last Year Comparison Yes

33—Income Statement~Actual/Budget Comparison Yes

34—Income Statement~All Periods
For details about printing this report on legal-sized paper, see
the note in the Help topic, About report printing.

Yes

41—Dept. Income Statement Yes

51—Dept. Income Statement~Period/Year Yes

53—Dept. Income Statement~Actual/Budget Comparison Yes

61—General Ledger Cost Comparison Yes

71—Income Summary~with Subaccount Detail Period
and YTD Yes

2-4 General Ledger Reports

Report Name Locked

21—General Ledger Yes

31—General Ledger~Land Yes

41—General Ledger~Summary Yes

51—Subsidiary Ledger Yes

53—Subsidiary Ledger~Land Yes

61—Subsidiary Summary Yes

2-5 General Journal Reports

Report Name Locked

21—General Journal Yes

31—Journal Summary Yes
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2-6 Check Register Reports

Report Name Locked

21—Check Register~ChecksOnly Yes

31—Check Register Yes

41—Check Register~Deposits Only Yes

2-7 Chart of Accounts Reports

Report Name Locked

21—Chart of Accounts No

22—Chart of Accounts~with Notes No

31—Chart of Subsidiary Accounts No

41—Subsidiary Account Balances No

2-8 Financial Reports

Report Name Locked

21—Financial Report Yes

2-9 Statement of Cash Flows Reports

Report Name Locked

21—Statement of Cash Flows Yes

2-1 Trial Balance Reports

Report Name Locked

21—Trial Balance Yes

31—Trial Balance~Working Yes

2-2 Balance Sheet Reports

Report Name Locked

21—Balance Sheet Yes

31—Balance Sheet~This Year/Last Year Comparison Yes
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2-3 Income Statement Reports

Report Name Locked

21—Income Statement Yes

31—Income Statement~Period and YTD Yes

32—Income Statement~This Year/Last Year Comparison Yes

33—Income Statement~Actual/Budget Comparison Yes

34—Income Statement~All Periods
For details about printing this report on legal-sized paper, see
the note in the Help topic, About report printing.

Yes

41—Dept. Income Statement Yes

51—Dept. Income Statement~Period/Year Yes

53—Dept. Income Statement~Actual/Budget Comparison Yes

61—General Ledger Cost Comparison Yes

71—Income Summary~with Subaccount Detail Period
and YTD Yes

2-4 General Ledger Reports

Report Name Locked

21—General Ledger Yes

31—General Ledger~Land Yes

41—General Ledger~Summary Yes

51—Subsidiary Ledger Yes

53—Subsidiary Ledger~Land Yes

61—Subsidiary Summary Yes

2-5 General Journal Reports

Report Name Locked

21—General Journal Yes

31—Journal Summary Yes

2-6 Check Register Reports

Report Name Locked

21—Check Register~Checks Only Yes

31—Check Register Yes
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Report Name Locked

41—Check Register~Deposits Only Yes

2-7 Chart of Accounts Reports

Report Name Locked

21—Chart of Accounts No

22—Chart of Accounts~with Notes No

31—Chart of Subsidiary Accounts No

41—Subsidiary Account Balances No

2-8 Financial Reports

Report Name Locked

21—Financial Report Yes

2-9 Statement of Cash Flows Reports

Report Name Locked

21—Statement of Cash Flows Yes

3-Accounts Receivable Reports

3-1-1 Receivable List

Report Name Locked

21—Job List No

22—Job List~by Client No

23—Job List~with Notes No

26—Job List~Alpha No

27—Job List~by Client; Alpha No

28—Job List~Alpha; with Notes No

31—Job List~Long No

32—Job List~Long; by Client No

41—Contracts No

42—Contracts~by Client No

43—Contracts~Alpha No
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Report Name Locked

45—Contracts~by Client; with Notes No

51—Job Liens No

53—Job Liens~with Notes No

61—Job Balances No

62—Job Balances~by Job Type No

63—Job Balances~by Job Type; with Notes No

3-1-2 Receivable Invoice List

Report Name Locked

21—AR Invoice List No

22—AR Invoice List~with Notes No

23—AR Invoice List~with Payments No

31—AR Invoice List~by Job No

32—AR Invoice List~by Job; with Notes No

33—AR Invoice List~by Job; with Payments No

36—AR Invoice List~Alpha; by Job No

37—AR Invoice List~Alpha; by Job; with Notes No

38—AR Invoice List~Alpha; by Job; with Payments No

41—AR Invoice List~by Client/Job No

42—AR Invoice List~by Client/Job; with Notes No

43—AR Invoice List~by Client/Job; with Payments No

46—AR Invoice List~Alpha; by Client/Job No

47—AR Invoice List~Alpha; by Client/Job; with Notes No

48—AR Invoice List~Alpha; by Client/Job; with Payments No

51—AR Invoice List~Long No

52—AR Invoice List~Long; with Notes No

53—AR Invoice List~Long; with Payments No

61—AR Invoice List~Long; by Job No

62—AR Invoice List~Long; by Job; with Notes No

66—AR Invoice List~Long; Alpha; by Job No

67—AR Invoice List~Long; Alpha; by Job; with Notes No
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Report Name Locked

71—AR Invoice List~Long; by Client/Job No

72—AR Invoice List~Long; by Client/Job; with Notes No

73—AR Invoice List~Long; by Client/Job; with Payments No

76—AR Invoice List~Long; Alpha; by Client/Job No

77—AR Invoice List~Long; Alpha; by Client/Job; with Notes No

78—AR Invoice List~Long; Alpha; by Client/Job; with
Payments No

3-1-3 Receivable Aging

Report Name Locked

21—AR Invoice Aging Yes

26—AR Invoice Aging~Land Yes

31—JobCurrent Aging No

32—JobCurrent Aging~Alpha No

36—JobCurrent Aging~Land No

37—JobCurrent Aging~Land; Alpha No

41—Job Period Aging No

42—Job Period Aging~Alpha No

46—Job Period Aging~Land No

47—Job Period Aging~Land; Alpha No

3-1-4 Receivable Journal-Ledger

Report Name Locked

21—Receivable Journal Yes

31—Receivable Journal~Cash Receipts Yes

41—Receivable Journal~Income Yes

51—Receivable Ledger Yes
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3-1-5 Receivable Call Sheet

Report Name Locked

21—A/R Call Sheet No

22—A/R Call Sheet~with Client Notes No

23—A/R Call Sheet~with Job Notes No

24—A/R Call Sheet~with Client and Job Notes No

26—A/R Call Sheet~Alpha No

27—A/R Call Sheet~Alpha; with Client Notes No

28—A/R Call Sheet~Alpha; with Job Notes No

29—A/R Call Sheet~Alpha; with Client and Job Notes No

31—A/R Call Sheet~with Invoice Detail No

32—A/R Call Sheet~with Invoice Detail and Client Notes No

33—A/R Call Sheet~with Invoice Detail and Job Notes No

34—A/R Call Sheet~with Invoice Detail, Client and Job
Notes No

36—A/R Call Sheet~Alpha; with Invoice Detail No

37—A/R Call Sheet~Alpha; with Invoice Detail and Client
Notes No

38—A/R Call Sheet~Alpha; with Invoice Detail and Job
Notes No

39—A/R Call Sheet~Alpha; with Invoice Detail, Client and
Job Notes No

41—A/R Aged Call Sheet No

42—A/R Aged Call Sheet~with Client Notes No

43—A/R Aged Call Sheet~with Job Notes No

44—A/R Aged Call Sheet~with Client and Job Notes No

46—A/R Aged Call Sheet~Alpha No

47—A/R Aged Call Sheet~Alpha; with Client Notes No

48—A/R Aged Call Sheet~Alpha; with Job Notes No

49—A/R Aged Call Sheet~Alpha; with Client and Job Notes No

51—A/R Aged Call Sheet~with Invoice Detail No

52—A/R Aged Call Sheet~with Invoice Detail and Client
Notes No
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Report Name Locked

53—A/R Aged Call Sheet~with Invoice Detail and Job
Notes No

54—A/R Aged Call Sheet~with Invoice Detail, Client and
Job Notes No

56—A/R Aged Call Sheet~Alpha; with Invoice Detail No

57—A/R Aged Call Sheet~Alpha; with Invoice Detail and
Client Notes No

58—A/R Aged Call Sheet~Alpha; with Invoice Detail and
Job Notes No

59—A/R Aged Call Sheet~Alpha; with Invoice Detail, Client
and Job Notes No

3-1-6 Client List

Report Name Locked

21—Client List No

22—Client List~with Notes No

31—Client List~Alpha No

32—Client List~Alpha; with Notes No

41—Client List~Long No

42—Client List~Long; Alpha No

3-1-7 Client Documents

Report Name Locked

31—Client Mail Label~Sheet No

41—Client Mail Label~Tractor Feed No

3-1-8 Job Documents

Report Name Locked

31—JobMail Label~Sheet No

41—JobMail Label~Tractor Feed No
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3-1-9 Overdue Receivable Reminders

Report Name Locked

21—Overdue Receivable Reminders No

3-1-10 Pre-Lien Notices

Report Name Locked

21—Pre-Lien Notice No

31—Pre-Lien Notice~CA Public Works No

3-1-11 Sales Tax Report

Report Name Locked

21—Sales Tax Report No

31—Sales Tax Report~with Invoice Detail No

3-2 Receivable Invoices/Credits

Report Name Locked

21—Receivable Invoice No

22—Receivable Invoice~with Notes No

23—Receivable Invoice~Retention No

24—Receivable Invoice~Retention; with Notes No

26—Receivable Invoice~Paid No

27—Receivable Invoice~Paid with Notes No

31—Receivable Credit No

32—Receivable Credit~with Notes No

36—Receivable Credit~Paid No

37—Receivable Credit~Paid with Notes No

3-3-1 Cash Receipts

Report Name Locked

21—Cash Receipts~Land Yes

31—Cash Receipts Yes
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3-3-2 Electronic Receipts

Report Name Locked

21—Cash Receipts~Land Yes

31—Cash Receipts Yes

3-4 Statements

Report Name Locked

21—Job Statements Yes

22—Client Service Statements Yes

23—Client Contract Statements Yes

24—Combined Statements Yes

3-5 Jobs (Accounts Receivable)

Report Name Locked

21—JobRecord No

31—JobRecord~With Notes No

41—JobContact List No

51—JobContact List~With Notes No

3-6 Receivable Clients

Report Name Locked

21—Client Record No

31—Client Record~With Notes No

3-7 Progress Billing

Report Name Locked

21—Progress Billing~by Cost Code No

22—Progress Billing~by Cost Code; Rounded No

23—Progress Billing~by Cost Code; with Description No
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Report Name Locked

24—Progress Billing~by Cost Code; with Description;
Rounded No

31—Progress Billing~by Division No

32—Progress Billing~by Division; Rounded No

33—Progress Billing~by Division; with Description No

34—Progress Billing~by Division; with Description;
Rounded No

41—Progress Billing~with Description No

42—Progress Billing~with Description; Rounded No

51—AIA Form Fill~by Cost Code No

52—AIA Form Fill~by Cost Code; Rounded No

56—AIA Form Fill~with Description No

57—AIA Form Fill~with Description; Rounded No

61—Progress Sheet~by Cost Code; Rounded No

62—Progress Sheet~by Cost Code; with Description;
Rounded No

71—Progress Sheet~by Division; Rounded No

72—Progress Sheet~by Division; with Description;
Rounded No

81—Progress Sheet~with Description; Rounded No

3-8 Loan Draw Requests

Report Name Locked

21—Loan Draw Request No

26—Loan Draw Request~Description No

31—Loan Draw Request Sheet No

36—Loan Draw Request Sheet~Description No

3-9 Unitary Billing

Report Name Locked

21—Unitary Billing No

31—Unitary Sheet No
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3-10-1 T & M Billing Setup

Report Name Locked

21—T&M Billing Setup No

3-10-3 Print T&M Invoices

Report Name Locked

21—T&M Invoice~by Cost Type No

22—T&M Invoice~by Cost Type; with Employee No

23—T&M Invoice~by Cost Type; with Employee and Hours No

26—T&M Invoice~by Cost Type; with Taxable No

27—T&M Invoice~by Cost Type; with Taxable and
Employee No

28—T&M Invoice~by Cost Type; with Taxable, Employee
and Hours No

31—T&M Invoice~by Cost Code No

32—T&M Invoice~by Cost Code; with Employee No

33—T&M Invoice~by Cost Code; with Employee and Hours No

36—T&M Invoice~by Cost Code; with Taxable No

37—T&M Invoice~by Cost Code; with Taxable and
Employee No

38—T&M Invoice~by Cost Code; with Taxable, Employee
and Hours No

41—T&M Invoice~Land; by Cost Type; with Taxable No

42—T&M Invoice~Land; by Cost Type; with Taxable and
Employee No

43—T&M Invoice~Land; by Cost Type; with Taxable,
Employee and Hours No

51—T&M Invoice~Land; by Cost Code; with Taxable No

52—T&M Invoice~Land; by Cost Code; with Taxable and
Employee No

53—T&M Invoice~Land; by Cost Code; with Taxable,
Employee and Hours No

61—T&M Parts Invoice Detail Addendum Yes

91—T&M~Detail Worksheet~with Total Markup Percentage No

92—T&M~Detail Worksheet~with Gross Margin Percentage No
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3-10-5 T&M Wage Rates

Report Name Locked

21—T&MWageRates No

31—T&MWageRates~with Notes No

3-10-6 T&M Equipment Rates

Report Name Locked

21—T&M Equipment Rates No

31—T&M Equipment Rates~with Notes No

3-10-7 T&M Journal

Report Name Locked

21—T&M Journal No

22—T&M Journal~IncludeOpen Billing Status No

26—T&M Journal~with Notes No

27—T&M Journal~IncludeOpen Billing Status; with Notes No

31—T&M Journal~by Job No

32—T&M Journal~by Job; IncludeOpen Billing Status No

36—T&M Journal~by Job; with Notes No

37—T&M Journal~by Job; IncludeOpen Billing Status; with
Notes No

41—T&M Journal~by Cost Code No

42—T&M Journal~by Cost Code; IncludeOpen Billing
Status No

46—T&M Journal~by Cost Code; with Notes No

47—T&M Journal~by Cost Code; IncludeOpen Billing
Status; with Notes No

51—T&M Journal~by Cost Type No

52—T&M Journal~by Cost Type; IncludeOpen Billing
Status No

56—T&M Journal~by Cost Type; Include Notes No

57—T&M Journal~by Cost Type; IncludeOpen Billing
Status; with Notes No
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3-10-8 T&M Summary

Report Name Locked

21—T&M Summary Yes

26—T&M Summary~by Division Yes

31—T&M Summary~Land Yes

36—T&M Summary~Land; by Division Yes

3-1-1 Receivable List

Report Name Locked

21—Job List No

22—Job List~by Client No

23—Job List~with Notes No

26—Job List~Alpha No

27—Job List~by Client; Alpha No

28—Job List~Alpha; with Notes No

31—Job List~Long No

32—Job List~Long; by Client No

41—Contracts No

42—Contracts~by Client No

43—Contracts~Alpha No

45—Contracts~by Client; with Notes No

51—Job Liens No

53—Job Liens~with Notes No

61—Job Balances No

62—Job Balances~by Job Type No

63—Job Balances~by Job Type; with Notes No

3-1-2 Receivable Invoice List

Report Name Locked

21—AR Invoice List No

22—AR Invoice List~with Notes No

23—AR Invoice List~with Payments No
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Report Name Locked

31—AR Invoice List~by Job No

32—AR Invoice List~by Job; with Notes No

33—AR Invoice List~by Job; with Payments No

36—AR Invoice List~Alpha; by Job No

37—AR Invoice List~Alpha; by Job; with Notes No

38—AR Invoice List~Alpha; by Job; with Payments No

41—AR Invoice List~by Client/Job No

42—AR Invoice List~by Client/Job; with Notes No

43—AR Invoice List~by Client/Job; with Payments No

46—AR Invoice List~Alpha; by Client/Job No

47—AR Invoice List~Alpha; by Client/Job; with Notes No

48—AR Invoice List~Alpha; by Client/Job; with Payments No

51—AR Invoice List~Long No

52—AR Invoice List~Long; with Notes No

53—AR Invoice List~Long; with Payments No

61—AR Invoice List~Long; by Job No

62—AR Invoice List~Long; by Job; with Notes No

66—AR Invoice List~Long; Alpha; by Job No

67—AR Invoice List~Long; Alpha; by Job; with Notes No

71—AR Invoice List~Long; by Client/Job No

72—AR Invoice List~Long; by Client/Job; with Notes No

73—AR Invoice List~Long; by Client/Job; with Payments No

76—AR Invoice List~Long; Alpha; by Client/Job No

77—AR Invoice List~Long; Alpha; by Client/Job; with Notes No

78—AR Invoice List~Long; Alpha; by Client/Job; with
Payments No

3-1-3 Receivable Aging

Report Name Locked

21—AR Invoice Aging Yes

26—AR Invoice Aging~Land Yes

31—JobCurrent Aging No
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Report Name Locked

32—JobCurrent Aging~Alpha No

36—JobCurrent Aging~Land No

37—JobCurrent Aging~Land; Alpha No

41—Job Period Aging No

42—Job Period Aging~Alpha No

46—Job Period Aging~Land No

47—Job Period Aging~Land; Alpha No

3-1-4 Receivable Journal-Ledger

Report Name Locked

21—Receivable Journal Yes

31—Receivable Journal~Cash Receipts Yes

41—Receivable Journal~Income Yes

51—Receivable Ledger Yes

3-1-5 Receivable Call Sheet

Report Name Locked

21—A/R Call Sheet No

22—A/R Call Sheet~with Client Notes No

23—A/R Call Sheet~with Job Notes No

24—A/R Call Sheet~with Client and Job Notes No

26—A/R Call Sheet~Alpha No

27—A/R Call Sheet~Alpha; with Client Notes No

28—A/R Call Sheet~Alpha; with Job Notes No

29—A/R Call Sheet~Alpha; with Client and Job Notes No

31—A/R Call Sheet~with Invoice Detail No

32—A/R Call Sheet~with Invoice Detail and Client Notes No

33—A/R Call Sheet~with Invoice Detail and Job Notes No

34—A/R Call Sheet~with Invoice Detail, Client and Job
Notes No

36—A/R Call Sheet~Alpha; with Invoice Detail No

37—A/R Call Sheet~Alpha; with Invoice Detail and Client
Notes No
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Report Name Locked

38—A/R Call Sheet~Alpha; with Invoice Detail and Job
Notes No

39—A/R Call Sheet~Alpha; with Invoice Detail, Client and
Job Notes No

41—A/R Aged Call Sheet No

42—A/R Aged Call Sheet~with Client Notes No

43—A/R Aged Call Sheet~with Job Notes No

44—A/R Aged Call Sheet~with Client and Job Notes No

46—A/R Aged Call Sheet~Alpha No

47—A/R Aged Call Sheet~Alpha; with Client Notes No

48—A/R Aged Call Sheet~Alpha; with Job Notes No

49—A/R Aged Call Sheet~Alpha; with Client and Job Notes No

51—A/R Aged Call Sheet~with Invoice Detail No

52—A/R Aged Call Sheet~with Invoice Detail and Client
Notes No

53—A/R Aged Call Sheet~with Invoice Detail and Job
Notes No

54—A/R Aged Call Sheet~with Invoice Detail, Client and
Job Notes No

56—A/R Aged Call Sheet~Alpha; with Invoice Detail No

57—A/R Aged Call Sheet~Alpha; with Invoice Detail and
Client Notes No

58—A/R Aged Call Sheet~Alpha; with Invoice Detail and
Job Notes No

59—A/R Aged Call Sheet~Alpha; with Invoice Detail, Client
and Job Notes No

3-1-6 Client List

Report Name Locked

21—Client List No

22—Client List~with Notes No

31—Client List~Alpha No

32—Client List~Alpha; with Notes No

41—Client List~Long No

42—Client List~Long; Alpha No



- 749 -

3-1-7 Client Documents

Report Name Locked

31—Client Mail Label~Sheet No

41—Client Mail Label~Tractor Feed No

3-1-8 Job Documents

Report Name Locked

31—JobMail Label~Sheet No

41—JobMail Label~Tractor Feed No

3-1-9 Overdue Receivable Reminders

Report Name Locked

21—Overdue Receivable Reminders No

3-1-10 Pre-Lien Notices

Report Name Locked

21—Pre-Lien Notice No

31—Pre-Lien Notice~CA Public Works No

3-1-11 Sales Tax Report

Report Name Locked

21—Sales Tax Report No

31—Sales Tax Report~with Invoice Detail No

3-2 Receivable Invoices-Credits

Report Name Locked

21—Receivable Invoice No

22—Receivable Invoice~with Notes No

23—Receivable Invoice~Retention No

24—Receivable Invoice~Retention; with Notes No

26—Receivable Invoice~Paid No

27—Receivable Invoice~Paid with Notes No

31—Receivable Credit No
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Report Name Locked

32—Receivable Credit~with Notes No

36—Receivable Credit~Paid No

37—Receivable Credit~Paid with Notes No

3-3-1 Cash Receipts

Report Name Locked

21—Cash Receipts~Land Yes

31—Cash Receipts Yes

3-4 Statements

Report Name Locked

21—Job Statements Yes

22—Client Service Statements Yes

23—Client Contract Statements Yes

24—Combined Statements Yes

3-5 Jobs (Accounts Receivable)

Report Name Locked

21—JobRecord No

31—JobRecord~With Notes No

3-6 Receivable Clients

Report Name Locked

21—Client Record No

31—Client Record~With Notes No

3-7 Progress Billing

Report Name Locked

21—Progress Billing~by Cost Code No

22—Progress Billing~by Cost Code; Rounded No

23—Progress Billing~by Cost Code; with Description No

24—Progress Billing~by Cost Code; with Description;
Rounded No
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Report Name Locked

31—Progress Billing~by Division No

32—Progress Billing~by Division; Rounded No

33—Progress Billing~by Division; with Description No

34—Progress Billing~by Division; with Description;
Rounded No

41—Progress Billing~with Description No

42—Progress Billing~with Description; Rounded No

51—AIA Form Fill~by Cost Code No

52—AIA Form Fill~by Cost Code; Rounded No

56—AIA Form Fill~with Description No

57—AIA Form Fill~with Description; Rounded No

61—Progress Sheet~by Cost Code; Rounded No

62—Progress Sheet~by Cost Code; with Description;
Rounded No

71—Progress Sheet~by Division; Rounded No

72—Progress Sheet~by Division; with Description;
Rounded No

81—Progress Sheet~with Description; Rounded No

3-8 Loan Draw Requests

Report Name Locked

21—Loan Draw Request No

26—Loan Draw Request~Description No

31—Loan Draw Request Sheet No

36—Loan Draw Request Sheet~Description No

3-9 Unitary Billing

Report Name Locked

21—Unitary Billing No

31—Unitary Sheet No

3-10-1 T & M Billing Setup

Report Name Locked

21—T&M Billing Setup No
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3-10-3 Print T&M Invoices

Report Name Locked

21—T&M Invoice~by Cost Type No

22—T&M Invoice~by Cost Type; with Employee No

23—T&M Invoice~by Cost Type; with Employee and Hours No

26—T&M Invoice~by Cost Type; with Taxable No

27—T&M Invoice~by Cost Type; with Taxable and
Employee No

28—T&M Invoice~by Cost Type; with Taxable, Employee
and Hours No

31—T&M Invoice~by Cost Code No

32—T&M Invoice~by Cost Code; with Employee No

33—T&M Invoice~by Cost Code; with Employee and Hours No

36—T&M Invoice~by Cost Code; with Taxable No

37—T&M Invoice~by Cost Code; with Taxable and
Employee No

38—T&M Invoice~by Cost Code; with Taxable, Employee
and Hours No

41—T&M Invoice~Land; by Cost Type; with Taxable No

42—T&M Invoice~Land; by Cost Type; with Taxable and
Employee No

43—T&M Invoice~Land; by Cost Type; with Taxable,
Employee and Hours No

51—T&M Invoice~Land; by Cost Code; with Taxable No

52—T&M Invoice~Land; by Cost Code; with Taxable and
Employee No

53—T&M Invoice~Land; by Cost Code; with Taxable,
Employee and Hours No

61—T&M Parts Invoice Detail Addendum Yes

91—T&M~Detail Worksheet~with Total Markup Percentage No

92—T&M~Detail Worksheet~with Gross Margin Percentage No

3-10-5 T&M Wage Rates

Report Name Locked

21—T&MWageRates No

31—T&MWageRates~with Notes No
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3-10-6 T&M Equipment Rates

Report Name Locked

21—T&M Equipment Rates No

31—T&M Equipment Rates~with Notes No

3-10-7 T&M Journal

Report Name Locked

21—T&M Journal No

22—T&M Journal~IncludeOpen Billing Status No

26—T&M Journal~with Notes No

27—T&M Journal~IncludeOpen Billing Status; with Notes No

31—T&M Journal~by Job No

32—T&M Journal~by Job; IncludeOpen Billing Status No

36—T&M Journal~by Job; with Notes No

37—T&M Journal~by Job; IncludeOpen Billing Status; with
Notes No

41—T&M Journal~by Cost Code No

42—T&M Journal~by Cost Code; IncludeOpen Billing
Status No

46—T&M Journal~by Cost Code; with Notes No

47—T&M Journal~by Cost Code; IncludeOpen Billing
Status; with Notes No

51—T&M Journal~by Cost Type No

52—T&M Journal~by Cost Type; IncludeOpen Billing
Status No

56—T&M Journal~by Cost Type; Include Notes No

57—T&M Journal~by Cost Type; IncludeOpen Billing
Status; with Notes No

3-10-8 T&M Summary

Report Name Locked

Yes

Yes

Yes

Yes
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4-Accounts Payable Reports

4-1-1 Vendor List

Report Name Locked

21—Vendor List No

22—Vendor List~by Vendor Type No

23—Vendor List~Alpha No

26—Vendor List~with Notes No

27—Vendor List~by Vendor Type; with Notes No

28—Vendor List~Alpha; with Notes No

31—Vendor List~Long No

32—Vendor List~Long; by Vendor Type No

33—Vendor List~Long; Alpha No

36—Vendor List~Long; with Notes No

37—Vendor List~Long; by Vendor Type; with Notes No

38—Vendor List~Long; Alpha; with Notes No

41—Insurance Report No

42—Insurance Report~by Vendor Type No

43—Insurance Report~Alpha No

46—Insurance Report~with Notes No

47—Insurance Report~by Vendor Type; with Notes No

48—Insurance Report~Alpha; with Notes No

51—Vendor Balances No

52—Vendor Balances~Alpha No

53—Vendor Balances~by Vendor Type No

54—Vendor Balances~by Vendor Type; with Notes No

4-1-2 Payable Invoice List

Report Name Locked

21—AP Invoice List No

22—AP Invoice List~with Notes No

23—AP Invoice List~with Payments No
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Report Name Locked

31—AP Invoice List~by Vendor No

32—AP Invoice List~by Vendor; wth Notes No

33—AP Invoice List~by Vendor; with Payments No

36—AP Invoice List~Alpha; by Vendor No

37—AP Invoice List~Alpha; by Vendor; with Notes No

38—AP Invoice List~Alpha; by Vendor; with Payments No

41—AP Invoice List~by Vendor/Job No

42—AP Invoice List~by Vendor/Job; with Notes No

43—AP Invoice List~by Vendor/Job; with Payments No

44—AP Invoice List~Alpha; by Vendor/Job No

45—AP Invoice List~Alpha; by Vendor/Job; with Notes No

46—AP Invoice List~Alpha; by Vendor/Job; with Payments No

47—AP Invoice List~Alpha; by Job/Vendor No

48—AP Invoice List~Alpha; by Job/Vendor; with Notes No

49—AP Invoice List~Alpha; by Job/Vendor; with Payments No

51—AP Invoice List~Land No

52—AP Invoice List~Land; with Notes No

53—AP Invoice List~Land; with Payments No

61—AP Invoice List~Land; by Vendor No

62—AP Invoice List~Land; by Vendor; with Notes No

63—AP Invoice List~Land; by Vendor; with Payments No

66—AP Invoice List~Land; Alpha; by Vendor No

67—AP Invoice List~Land; Alpha; by Vendor; with Notes No

68—AP Invoice List~Land; Alpha; by Vendor; with
Payments No

71—AP Invoice List~Land; by Vendor/Job No

72—AP Invoice List~Land; by Vendor/Job; with Notes No

73—AP Invoice List~Land; by Vendor/Job; with Payments No

74—AP Invoice List~Land; Alpha; by Vendor/Job No

75—AP Invoice List~Land; Alpha; by Vendor/Job; with
Notes No

76—AP Invoice List~Land; Alpha; by Vendor/Job; with
Payments No
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Report Name Locked

77—AP Invoice List~Land; Alpha; by Job/Vendor No

78—AP Invoice List~Land; Alpha; by Job/Vendor; with
Notes No

79—AP Invoice List~Land; Alpha; by Job/Vendor; with
Payments No

81—AP Invoice List~Long No

82—AP Invoice List~Long; with Notes No

83—AP Invoice List~Long; with Payments No

84—AP Invoice List~Long; by Vendor No

85—AP Invoice List~Long; by Vendor; with Notes No

86—AP Invoice List~Long; by Vendor; with Payments No

87—AP Invoice List~Long; Alpha; by Vendor No

88—AP Invoice List~Long; Alpha; by Vendor; with Notes No

89—AP Invoice List~Long; Alpha; by Vendor; with
Payments No

96—AP Ledger Distribution No

97—AP Ledger Distribution~with Detail No

99—AP Job Cost Audit Yes

4-1-3 Payable Aging

Report Name Locked

21—AP Invoice Aging Yes

26—AP Invoice Aging~Land Yes

31—Vendor Current Aging No

32—Vendor Current Aging~Alpha No

36—Vendor Current Aging~Land No

37—Vendor Current Aging~Land; Alpha No

41—Vendor Period Aging No

42—Vendor Period Aging~Alpha No

46—Vendor Period Aging~Land No

47—Vendor Period Aging~Land; Alpha No
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4-1-4 Payable Journal-Ledger

Report Name Locked

21—Payable Journal Yes

31—Payable Invoice Journal Yes

41—Payable Journal~Checks Yes

51—Payable Ledger Yes

4-1-5 Vendor Payment Journal

IMPORTANT: The 4-1-5-31 Vendor Worker's Comp Report requires that theWorkers’ Compensation insurance
certificate information be in Row 1 of theCertificateswindow grid. To verify that Workers’ Compensation insurance
certificate information is in Row 1, see this topic for entering vendor certificate information.

Report Name Locked

21—Vendor Payments Yes

31—VendorWorkers CompReport Yes

41—Job Payments No

42—Job Payments~Alpha No

51—Payable Check Details~Alpha by Vendor No

52—Payable Check Details~Job; by Vendor Alpha No

4-1-6 Vendor Documents

Report Name Locked

31—Vendor Mail Label~Sheet No

41—Vendor Mail Label~Tractor Feed No

51—Expired Certificates Letter No

4-2 Payable Invoices-Credits

Report Name Locked

21—Payable Invoice No

22—Payable Invoice~With Notes No

4-3-2 Check Report

Report Name Locked

21—CheckTransmittal Report Yes
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4-3-5 Checks

Report Name Locked

21—Open Stub Yes

22—Formatted Stub Yes

23—No Job Stub Yes

4-3-3 Lien Waivers

Report Name Locked

21—LienWaiver No

22—LienWaiver~Hide Discount No

26—LienWaiver~By Alpha No

27—LienWaiver~By Alpha, Hide Discount No

31—LienWaiver 2 No

36—LienWaiver 2~By Alpha No

41—LienWaiver 4 No

46—LienWaiver 4~By Alpha No

4-3-1 Set to Pay Report

Report Name Locked

21—Set to Pay Report No

31—Set to Pay Report~by Vendor/Job No

41—Set to Pay Report~by Job/Vendor No

51—Set to Pay~Vendor Totals No

56—Set to Pay~Vendor Totals; Alpha No

61—Set to Pay~Job Totals No

66—Set to Pay~Job Totals; Alpha No

4-3-4 Voucher

Report Name Locked

21—Voucher Yes
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4-4 Vendors (Accounts Payable)

Report Name Locked

21—Vendor Record No

31—Vendor Record~with Notes No

41—Vendor Contact List No

51—Vendor Contact List~with Notes No

4-5 Vendor 1099

Report Name Locked

21—1099 Form No

31—Vendor 1099 Report No

32—Vendor 1099 Report~Alpha No

4-6 Recurring Payables

Report Name Locked

21—Recurring Payable Record No

22—Recurring Payable Record~with Notes No

31—Recurring Payable List No

32—Recurring Payable List~with Notes No

4-7-3 Credit Card Receipts

Report Name Locked

21—Credit Card Receipt No

4-7-4 Enter Recurring Charges

Report Name Locked

21—Recurring Charges Record No

22—Recurring Charges Record~with Notes No

31—Recurring Charges List No

32—Recurring Charges List~with Notes No

4-7-5 Reconcile Credit Card Statements

Report Name Locked

21—Credit Card Reconciliation Yes
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5-Payroll Reports

5-1-1 Employee List

Report Name Locked

21—Employee List No

22—Employee List~with Pay Rates No

23—Employee List~by Position No

26—Employee List~with Earnings No

27—Employee List~with Earnings and Pay Rates No

31—Employee List~Alpha No

32—Employee List~Alpha; with Pay Rates No

36—Employee List~Alpha; with Earnings No

37—Employee List~Alpha; with Earnings and Pay Rates No

41—Employee Licenses No

46—Employee Licenses~Alpha No

51—Employee Training Report No

56—Employee Training Report~Alpha No

5-1-2 Payroll Check Register

Report Name Locked

21—Payroll Check Register~with Calculations Yes

36—Payroll Check Register~by Employee No

37—Payroll Check Register~by Position/Employee No

39—Payroll Check Register~Alpha No

41—Payroll Check Register~Totals Page Yes

51—Payroll Check Register~Long No

56—Payroll Check Register~Long; by Employee No

57—Payroll Check Register~Long; by Position/Employee No

59—Payroll Check Register~Long; Alpha No
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5-1-3 Federal Tax Report

Report Name Locked

21—Federal Tax Report Yes

31—Federal Tax Report~Long Yes

5-1-4 State Tax Report

Report Name Locked

21—State Tax Report Yes

31—State Tax Report~Long Yes

41—Local Tax Report No

46—Local Tax Report~with Differential No

51—Local Tax Report~City Detail; by Site No

53—Local Tax Report~City Detail; by Residence No

56—Local Tax Report~City Totals; by Site No

58—Local Tax Report~City Totals; by Residence No

61—State Quarterly Wage Report Yes

66—Quarterly Earnings Yes

5-1-5 Workers Comp Report

Report Name Locked

21—Workers’ CompReport Yes

57—Workers’ CompReport~Delaware Yes

82—Workers’ CompReport~Nevada Yes

83—Workers’ CompReport~New York Yes

84—Workers’ CompReport~Ohio Yes

86—Workers’ CompReport~Oregon Yes

87—Workers’ CompReport~Pennsylvania Yes

93—Workers’ CompReport~Utah Yes

96—Workers’ CompReport~Washington Yes

99—Workers’ CompReport~Wyoming Yes
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5-1-6 Certified Payroll Report

Report Name Locked

21—Certified Payroll Report Yes

26—Certified Payroll Report~NoWork No

31—Department of Labor Yes

36—Department of Labor~NoWork No

41—Minority Report Yes

51—Alaska Certified Payroll Yes

56—Alaska Certified Payroll~NoWork No

5-1-7 Union Reports

Report Name Locked

21—Union Report Yes

26—Weekly Union Report Yes

31—Union Paygroup Report Yes

36—Paygroup Summary Yes

5-1-8 Hours Report

Report Name Locked

21—Employee Hours No

22—Employee Hours~by Position No

31—Employee Hours~Alpha No

32—Employee Hours~Alpha; by Position No

41—JobHours No

51—JobHours~Alpha No

61—Paygroup Hours No

71—Paygroup Hours~Alpha No

5-1-9 Ytd-Qtd Earnings

Report Name Locked

21—Quarter One Earnings No

22—Quarter Two Earnings No



- 763 -

Report Name Locked

23—Quarter Three Earnings No

24—Quarter Four Earnings No

26—Quarter One Earnings~Skip 0 Earnings No

27—Quarter Two Earnings~Skip 0 Earnings No

28—Quarter Three Earnings~Skip 0 Earnings No

29—Quarter Four Earnings~Skip 0 Earnings No

31—YTD Earnings No

33—YTD Earnings~Alpha No

41—YTD/QTD Earnings~Long No

43—YTD/QTD Earnings~Alpha; Long No

5-1-10 Employee Documents

Report Name Locked

21—Employee Label~Sheet No

31—Employee Label~Tractor Feed No

5-2-1 Employees

Report Name Locked

21—Employee Record No

22—Employee Record~with Notes No

26—Employee Contact List No

27—Employee Contact List~with Notes No

31—Employee Record~with Earnings No

32—Employee Record~with Earnings and Notes No

41—Employee Record~Calculations No

51—Employee Direct Deposit Accounts No

52—Employee Direct Deposit Prenotification No

5-2-2 Payroll Records

Report Name Locked

21—Payroll Record No

22—Payroll Record~with Timecard Details No

23—Payroll Record~with Calculations No
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Report Name Locked

26—Payroll Record~with Timecard Details and Calculations No

31—Payroll Record~by Employee No

32—Payroll Record~by Employee; with Timecard Details No

33—Payroll Record~by Employee; with Calculations No

36—Payroll Record~by Employee, with Timecard Details
and Calculations No

42—Payroll Record~Land; with Timecard Details No

5-2-4 Payroll Checks

Report Name Locked

21—Payroll Checks Yes

22—Payroll Checks~Direct Deposit Yes

31—Payroll Checks~with Paygroup Year to Date Yes

32—Payroll Checks~Direct Deposit with Paygroup Year to
Date Yes

36—Payroll Checks~with Paygroup Compensation Yes

37—Payroll Checks~Direct Deposit with Paygroup
Compensation Yes

5-2-5 Direct Deposit File Manager

Report Name Locked

21—Direct Deposit File Report Yes

5-2-7 Compensation Slips

Report Name Locked

21—Compensation Slip No

31—Compensation Slip~Alpha No

5-2-8 Timecard Journal

Report Name Locked

21—Timecard Journal No

22—Timecard Journal~with Notes No

31—Timecard Journal~by Employee No

32—Timecard Journal~by Employee; with Notes No
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Report Name Locked

41—Timecard Journal~by Alpha No

42—Timecard Journal~by Alpha; with Notes No

51—Timecard Journal~Long No

52—Timecard Journal~Long; with Notes No

61—Timecard Journal~Long; by Employee No

62—Timecard Journal~Long; by Employee; with Notes No

71—Timecard Journal~Long; Alpha No

72—Timecard Journal~Long; Alpha; with Notes No

5-3-1 Payroll Calculations

Report Name Locked

21—Calculation List No

31—Payroll Calculations~Long No

41—Payroll Calculations~with Detail No

5-3-4 Paygroups

Report Name Locked

21—Paygroup List No

22—Paygroup List~with Benefits No

31—Paygroup List~with Notes No

32—Paygroup List~with Benefits and Notes No

5-5-1 Daily Payroll Entry

Report Name Locked

21—Daily Payroll Report No

26—Daily Payroll Report~with Notes No

31—Daily Payroll Report~by Employee No

36—Daily Payroll Report~by Employee; with Notes No

41—Daily Payroll Report~by Job No

46—Daily Payroll Report~by Job; with Notes No
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5-5-2 Daily Job Reports

Report Name Locked

21—Daily Job Report Yes

5-5-3 Daily Labor Reports

Report Name Locked

21—Daily Labor Report No

26—Daily Labor Report~with Notes No

31—Daily Labor Report~by Employee No

36—Daily Labor Report~by Employee; with Notes No

41—Daily Labor Report~by Job No

46—Daily Labor Report~by Job; with Notes No

5-5-4 Daily Equipment Reports

Report Name Locked

21—Daily Equipment Report No

26—Daily Equipment Report~with Notes No

6-Project Management Reports

6-1-1 Job Status Report

Report Name Locked

21—Job Status Report Yes

31—Job Status Report~Land Yes

6-1-2 Job Cost Journal

Report Name Locked

21—JobCost Journal No

22—JobCost Journal~(separate reports) No

23—JobCost Journal~with Notes No

24—JobCost Journal~with Notes (separate reports) No

31—JobCost Journal~by Job No
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Report Name Locked

32—JobCost Journal~by Job (separate reports) No

33—JobCost Journal~by Job; with Notes No

34—JobCost Journal~by Job; with Notes (separate reports) No

41—JobCost Journal~by Job/Cost Code No

42—JobCost Journal~by Job/Cost Code (separate reports) No

43—JobCost Journal~by Job/Cost Code; with Notes No

44—JobCost Journal~by Job/Cost Code; with Notes
(Separate Reports) No

47—JobCost Journal~Actual/Budget; by Cost Code
(Separate Reports) 06-01-02-47

Note: This report was formerly entitled Job Cost Journal~by
Cost Code; with Budget (Separate Report) 06-01-02-47

Yes

48—JobCost Journal~by Job/Cost Code with Hours No

49—JobCost Journal~by Job/Cost Code with Hours and
Notes No

51—JobCost Journal~by Job/Phase/Cost Code No

52—JobCost Journal~by Job/Phase/Cost Code (separate
reports) No

53—JobCost Journal~by Job/Phase/Cost Code; with Notes No

54—JobCost Journal~by Job/Phase/Cost Code; with Notes
(separate reports) No

61—JobCost Journal~by Vendor No

62—JobCost Journal~by Vendor (separate reports) No

63—JobCost Journal~by Vendor; with Notes No

64—JobCost Journal~by Vendor; with Notes (separate
reports) No

6-1-3 Job Labor Journal

Report Name Locked

21—Job Labor Journal No

22—Job Labor Journal~by Job No

23—Job Labor Journal~by Job/Cost Code No

24—Job Labor Journal~by Job/Phase/Cost Code No

26—Job Labor Journal~with Notes No
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Report Name Locked

27—Job Labor Journal~by Job; with Notes No

28—Job Labor Journal~by Job/Cost Code; with Notes No

29—Job Labor Journal~by Job/Phase/Cost Code; with
Notes No

31—Job Labor Totals~by Job No

32—Job Labor Totals~by Job/Cost Code No

33—Job Labor Totals~by Job/Phase/Cost Code No

41—Job Labor Hours Actual/Budget~With Uncomputed
Payroll by Cost Code Yes

6-1-4 Job Summary Report

Report Name Locked

21—JobCost Summary Yes

31—JobCost Summary~Long Yes

41—JobCost Summary~by Phase Yes

51—Job Billing Summary Yes

61—Job Profitability~Combined Contract and Service Yes

71—Job Income Statement Yes

6-1-4-61 Job Profitability Report information

IMPORTANT: A client must be entered in theClient text box on the 3-5 Jobs (Accounts Receivable)window for
the service receivable invoice to be included in the Service Billing. If you use a specific client in the report selection
criteria that is not included on the 3-5 Jobs window, youmay get themessage “NoMatching Records Found.”

NOTE: Service billing and contract billing do not include sales tax.

6-1-4-71 Job Income Statement Report information
This report provides a job-by-job profit and loss (gross profit) view of each of your jobs and phases. It lists total accounts
receivable and service billing by job, and then subtracts related job costs by cost type. The report foots to gross profit per
job and also shows the percentage profit each job and phase contributes to the total for all jobs. The following lists some of
its features:

l Lists job costs by cost type

l Lists gross profit and percentage profit for each job and phase

l Lists Accounts Receivable and Service Receivable billing

l If a specific period isn't selected, then the report displays periods 0-12
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l Each job is a separate page

l Each phase is a separate page (if phase is a criteria)

6-1-5 Current Cost Summary

Report Name Locked

21—Current Cost Summary Yes

31—Buy Out Report~PO’s Only Yes

36—Buy Out Report~PO’s and Subcontracts Yes

6-1-6 Job Cost Totals

Report Name Locked

21—JobCost Totals~Land; by Job No

26—JobCost Totals~Land; Alpha; by Job No

31—JobCost Totals~Land; by Job/Division No

36—JobCost Totals~Land; Alpha; by Job/Division No

41—JobCost Totals~Land; by Job/Phase No

46—JobCost Totals~Land; Alpha; by Job/Phase No

6-1-7 Over-Under Billing Report

Report Name Locked

21—Over/Under Billings Yes

31—Over/Under Billings~Extended Yes

6-1-8 Bonding Report

Report Name Locked

21—Bonding Report Yes

6-1-9 Budgets

Report Name Locked

21—Budget~Land (separate reports) No

22—Budget~Land; by Division (separate reports) No

26—Budget~Land; with Notes (separate reports) No

27—Budget~Land; by Division; with Notes (separate reports) No

31—Budget~(separate reports) No
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Report Name Locked

32—Budget~by Division (separate reports) No

36—Budget~with Notes (separate reports) No

37—Budget~by Division; with Notes (separate reports) No

6-1-10 Budget Totals

Report Name Locked

21—Budget Totals No

31—Budget Totals~by Division No

41—Labor Budget No

46—Labor Budget~by Division No

51—Hours Budget No

56—Hours Budget~by Division No

6-1-11 Proposals

Report Name Locked

21—Proposal~Land No

22—Proposal~Land; by Division No

23—Proposal~Land; by Phase No

24—Proposal~Land; by Phase/Division No

31—Proposal~Land; with Notes No

32—Proposal~Land; by Division; with Notes No

33—Proposal~Land; by Phase; with Notes No

34—Proposal~Land; by Phase/Division; with Notes No

41—Proposal No

42—Proposal~by Division No

43—Proposal~by Phase No

44—Proposal~by Phase/Division No

51—Proposal~Totals No

52—Proposal~Totals; by Division No

53—Proposal~Totals; by Phase No

54—Proposal~Totals; by Phase/Division No

63—Proposal~Totals; by Phase; with Notes No



- 771 -

Report Name Locked

64—Proposal~Totals; by Phase/Division; with Notes No

6-1-12 Committed Cost Report

Report Name Locked

21—Committed Costs Yes

31—Committed Costs~Land Yes

41—Committed Costs~Totals Yes

51—Committed Costs~Developer Yes

61—Committed Costs~With Cost To Complete Yes

6-1-13 Home Builder Reports

Report Name Locked

21—Committed Budget/Cost Variance~by Cost Code Yes

26—Committed Budget/Job Cost Variance~ Jobs by Cost
Code Yes

31—Completed Jobs SqFt Comparison~by Cost Code Yes

41—Job Settlement~by Cost Code Yes

51—Gross Profit~by Job Yes

52—Profit Analysis~by Job No

6-3 Job Costs

Report Name Locked

21—JobCost Record No

31—JobCost Record~with Notes No

6-4-2 Print Change Orders

Report Name Locked

21—PrimeChangeOrder~Requested No

22—PrimeChangeOrder~Requested; with Notes No

31—PrimeChangeOrder~Approved No

32—PrimeChangeOrder~Approved; with Notes No
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6-4-3 Print Subcontract Orders

Report Name Locked

21—Subcontract ChangeOrder No

31—Subcontract ChangeOrder~with Notes No

6-4-4 Prime Change List

Report Name Locked

21—PrimeChange List No

22—PrimeChange List~with Detail No

23—PrimeChange List~with Notes No

24—PrimeChange List~with Detail and Notes No

26—PrimeChange List~Alpha No

27—PrimeChange List~Alpha; with Detail No

28—PrimeChange List~Alpha; with Notes No

29—PrimeChange List~Alpha; with Detail and Notes No

31—PrimeChange List~Land No

32—PrimeChange List~Land; with Detail No

33—PrimeChange List~Land; with Notes No

34—PrimeChange List~Land; with Detail and Notes No

36—PrimeChange List~Land; Alpha No

37—PrimeChange List~Land; Alpha; with Detail No

38—PrimeChange List~Land; Alpha; with Notes No

39—PrimeChange List~Land; Alpha; with Detail and Notes No

51—PrimeChange List~Land; with Aging No

52—PrimeChange List~Land; Alpha; with Aging No

6-4-5 Subcontract Change List

Report Name Locked

21—Subcontract Change List No

23—Subcontract Change List~with Notes No

26—Subcontract Change List~Alpha No

28—Subcontract Change List~Alpha; with Notes No



- 773 -

6-4-6 Prime Contract Audit

Report Name Locked

21—PrimeContract Audit Yes

6-6-1 Purchase Orders

Report Name Locked

21—PurchaseOrder No

26—PurchaseOrder~Land No

31—PurchaseOrder~with Notes No

36—PurchaseOrder~Land; with Notes No

6-6-2 Purchase Order List

Report Name Locked

21—PurchaseOrder List No

22—PurchaseOrder List~with Detail No

23—PurchaseOrder List~with Notes No

24—PurchaseOrder List~with Detail and Notes No

31—PurchaseOrder List~by Job No

32—PurchaseOrder List~by Job; with Detail No

33—PurchaseOrder List~by Job; with Notes No

34—PurchaseOrder List~by Job; with Detail and Notes No

36—PurchaseOrder List~Alpha; by Job No

37—PurchaseOrder List~Alpha; by Job; with Detail No

38—PurchaseOrder List~Alpha; by Job; with Notes No

39—PurchaseOrder List~Alpha; by Job; with Detail and
Notes No

41—PurchaseOrder List~by Job/Vendor No

42—PurchaseOrder List~by Job/Vendor; with Detail No

43—PurchaseOrder List~by Job/Vendor; with Notes No

44—PurchaseOrder List~by Job/Vendor; with Detail and
Notes No

46—PurchaseOrder List~Alpha; by Job/Vendor No

47—PurchaseOrder List~Alpha; by Job/Vendor; with Detail No
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Report Name Locked

48—PurchaseOrder List~Alpha; by Job/Vendor; with Notes No

49—PurchaseOrder List~Alpha; by Job/Vendor; with Detail
and Notes No

51—PurchaseOrder List~by Vendor No

52—PurchaseOrder List~by Vendor; with Detail No

53—PurchaseOrder List~by Vendor; with Notes No

54—PurchaseOrder List~by Vendor; with Detail and Notes No

56—PurchaseOrder List~Alpha; by Vendor No

57—PurchaseOrder List~Alpha; by Vendor; with Detail No

58—PurchaseOrder List~Alpha; by Vendor; with Notes No

59—PurchaseOrder List~Alpha; by Vendor; with Detail and
Notes No

61—PurchaseOrder List~Land No

62—PurchaseOrder List~Land; with Details No

63—PurchaseOrder List~Land; with Notes No

64—PurchaseOrder List~Land; with Details and Notes No

71—PurchaseOrder List~Land; by Job No

72—PurchaseOrder List~Land; by Job; with Details No

73—PurchaseOrder List~Land; by Job; with Notes No

74—PurchaseOrder List~Land; by Job; with Details and
Notes No

76—PurchaseOrder List~Land; Alpha; by Job No

77—PurchaseOrder List~Land; Alpha; by Job; with Details No

78—PurchaseOrder List~Land; Alpha; by Job; with Notes No

79—PurchaseOrder List~Land; Alpha; by Job; with Details
and Notes No

81—PurchaseOrder List~Land; by Job/Vendor No

82—PurchaseOrder List~Land; by Job/Vendor; with Details No

83—PurchaseOrder List~Land; by Job/Vendor; with Notes No

84—PurchaseOrder List~Land; by Job/Vendor; with Details
and Notes No

86—PurchaseOrder List~Land; Alpha; by Job/Vendor No
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Report Name Locked

87—PurchaseOrder List~Land; Alpha; by Job/Vendor; with
Details No

88—PurchaseOrder List~Land; Alpha; by Job/Vendor; with
Notes No

89—PurchaseOrder List~Land; Alpha; by Job/Vendor; with
Details and Notes No

91—PurchaseOrder List~Land; by Vendor No

92—PurchaseOrder List~Land; by Vendor; with Details No

93—PurchaseOrder List~Land; by Vendor; with Notes No

94—PurchaseOrder List~Land; by Vendor; with Details and
Notes No

96—PurchaseOrder List~Land; Alpha; by Vendor No

97—PurchaseOrder List~Land; Alpha; by Vendor; with
Details No

98—PurchaseOrder List~Land; Alpha; by Vendor; with
Notes No

99—PurchaseOrder List~Land; Alpha; by Vendor; with
Details and Notes No

6-6-3 Purchase Order Audit

Report Name Locked

21—PurchaseOrder Audit Yes

31—PurchaseOrder Audit~Land Yes

41—PurchaseOrder Audit~Totals Yes

51—Invoices by PurchaseOrder Yes

6-6-4 Purchase Order Materials

Report Name Locked

21—PurchaseOrder Material List No

22—PurchaseOrder Material List~by Job No

23—PurchaseOrder Material List~by Vendor No

24—PurchaseOrder Material List~by Job/Vendor No

31—PurchaseOrder Material List~Alpha; by Job No

32—PurchaseOrder Material List~Alpha; by Vendor No

33—PurchaseOrder Material List~Alpha; by Job/Vendor No
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Report Name Locked

41—PurchaseOrder Material List~Remaining No

42—PurchaseOrder Material List~Remaining; by Job No

43—PurchaseOrder Material List~Remaining; by Vendor No

44—PurchaseOrder Material List~Remaining; by
Job/Vendor No

51—PurchaseOrder Material List~Remaining; Alpha; by Job No

52—PurchaseOrder Material List~Remaining; Alpha; by
Vendor No

53—PurchaseOrder Material List~Remaining; Alpha; by
Job/Vendor No

81—PurchaseOrder Material List~Land No

82—PurchaseOrder Material List~Land; with Notes No

6-7-2 Print Subcontracts

Report Name Locked

21—Subcontract No

22—Subcontract~with Notes No

6-7-3 Subcontract List

Report Name Locked

21—Subcontract List No

22—Subcontract List~with Details No

23—Subcontract List~with Notes No

24—Subcontract List~with Details and Notes No

31—Subcontract List~by Job No

32—Subcontract List~by Job; with Details No

33—Subcontract List~by Job; with Notes No

34—Subcontract List~by Job; with Details and Notes No

36—Subcontract List~Alpha; by Job No

37—Subcontract List~Alpha; by Job; with Details No

38—Subcontract List~Alpha; by Job; with Notes No

39—Subcontract List~Alpha; by Job; with Details and Notes No

41—Subcontract List~by Vendor No
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Report Name Locked

42—Subcontract List~by Vendor; with Details No

43—Subcontract List~by Vendor; with Notes No

44—Subcontract List~by Vendor; with Details and Notes No

46—Subcontract List~Alpha; by Vendor No

47—Subcontract List~Alpha; by Vendor; with Details No

48—Subcontract List~Alpha; by Vendor; with Notes No

49—Subcontract List~Alpha; by Vendor; with Details and
Notes No

51—Subcontract List~Long No

52—Subcontract List~Long; with Details No

53—Subcontract List~Long; with Notes No

61—Subcontract List~Long; by Job No

62—Subcontract List~Long; by Job; with Details No

63—Subcontract List~Long; by Job; with Notes No

64—Subcontract List~Long; by Job; with Details and Notes No

66—Subcontract List~Long; Alpha; by Job No

67—Subcontract List~Long; Alpha; by Job; with Details No

68—Subcontract List~Long; Alpha; by Job; with Notes No

69—Subcontract List~Long; Alpha; by Job; with Details and
Notes No

71—Subcontract List~Long; by Vendor No

72—Subcontract List~Long; by Vendor; with Details No

73—Subcontract List~Long; by Vendor; with Notes No

74—Subcontract List~Long; by Vendor; with Details and
Notes No

76—Subcontract List~Long; Alpha; by Vendor No

77—Subcontract List~Long; Alpha; by Vendor; with Details No

78—Subcontract List~Long; Alpha; by Vendor; with Notes No

79—Subcontract List~Long; Alpha; by Vendor; with Details
and Notes No
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6-7-4 Subcontract Audit

Report Name Locked

21—Subcontract Audit Yes

31—Subcontract Audit~Land Yes

41—Subcontract Audit~Summary Yes

6-8-1 Cost to Complete

Report Name Locked

21—Cost to Complete Report~Land No

6-8-2 Hours to Complete

Report Name Locked

21—Hours to Complete Report~Land No

6-8-3 Units to Complete

Report Name Locked

21—Units to Complete Report~Land No

6-10 Unitary Proposals

Report Name Locked

21—Unitary Proposal No

31—Unitary Proposal~with Notes No

6-11-1 Requests for Proposal

Report Name Locked

21—Request for Proposal No

22—Request for Proposal~with Notes No

31—Requests For Proposal List~by Job No

41—Requests For Proposal List~by Vendor No

43—Requests For Proposal List~by Vendor Type No
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6-11-2 Requests for Information

Report Name Locked

21—Request for Information No

26—Request for Information~with Notes No

31—Request for Information List~by Job No

36—Request for Information List~by Job; with Notes No

41—Request for Information List~by Vendor No

46—Request for Information List~by Vendor; with Notes No

51—Request for Information List~by Client No

56—Request for Information List~by Client; with Notes No

6-11-3 Transmittals

Report Name Locked

21—Transmittal No

26—Transmittal~with Notes No

31—Transmittal List~by Job No

36—Transmittal List~by Job; with Notes No

41—Transmittal List~by Vendor No

46—Transmittal List~by Vendor; with Notes No

51—Transmittal List~by Client No

56—Transmittal List~by Client; with Notes No

6-11-4 Submittals

Report Name Locked

21—Submittal No

26—Submittal~with Notes No

31—Submittal List~by Job No

36—Submittal List~by Job; with Notes No

41—Submittal List~by Vendor No

46—Submittal List~by Vendor; with Notes No

51—Submittal List~by Client No

56—Submittal List~by Client; with Notes No
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6-11-5 Plan Records

Report Name Locked

21—Plan Records No

31—Plan Records List~by Job No

41—Plan Records Distribution No

6-11-6 Daily Field Reports

Report Name Locked

21—Daily Field Report Yes

22—Daily Field Report~Meetings Only Yes

6-11-7 Punch Lists

Report Name Locked

21—Punch List~to Complete; with Notes No

31—Punch List~to Approve; with Notes No

41—Punch List~Final; with Notes No

6-11-8 Correspondence

Report Name Locked

21—Correspondence No

31—Correspondence List~by Job No

41—Correspondence List~by Vendor No

51—Correspondence List~by Client No

6-12 Project Work Center

Report Name Locked

21—Project Work Center Yes

8-Equipment Management Reports
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8-1-1 Equipment List

Report Name Locked

21—Equipment List No

22—Equipment List~by Type No

26—Equipment List~Alpha No

27—Equipment List~Alpha; by Type No

31—Equipment Payment List No

32—Equipment Payment List~with Notes No

36—Equipment Payment List~Alpha No

37—Equipment Payment List~Alpha; with notes No

41—Equipment Cost Recovery Data No

42—Equipment Cost Recovery Data~with Notes No

46—Equipment Cost Recovery Data~Alpha No

47—Equipment Cost Recovery Data~Alpha; with Notes No

51—Equipment Cost/Rental Rates No

52—Equipment Cost/Rental Rates~with Notes No

56—Equipment Cost/Rental Rates~Alpha No

57—Equipment Cost/Rental Rates~Alpha; with Notes No

61—Equipment License List No

62—Equipment License List~with Notes No

66—Equipment License List~Alpha No

67—Equipment License List~Alpha; with Notes No

71—Equipment Depreciation List No

72—Equipment Depreciation List~with Notes No

76—Equipment Depreciation List~Alpha No

77—Equipment Depreciation List~Alpha; with Notes No

8-1-2 Equipment Cost Journal

Report Name Locked

21—Equipment Cost Journal No

26—Equipment Cost Journal~by Cost Code No

31—Equipment Cost Journal~by Equipment No
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Report Name Locked

36—Equipment Cost Journal~by Equipment/Cost Code No

41—Equipment Cost Journal~Land No

46—Equipment Cost Journal~Land; by Cost Code No

51—Equipment Cost Journal~Land; by Equipment No

56—Equipment Cost Journal~Land; by Equipment/Cost
Code No

8-1-3 Equipment Journal-Ledger

Report Name Locked

21—Equipment Journal Yes

31—Equipment Ledger Yes

8-1-4 Equipment Management Reports

Report Name Locked

21—Equipment Management Report No

22—Equipment Management Report~With Period Select No

26—Equipment Management Report~by Type No

27—Equipment Management Report~by Type; With Period
Select No

31—Equipment Management Report~Operated Only No

32—Equipment Management Report~Operated Only; With
Period Select No

36—Equipment Management Report~Operated Only; by
Type No

37—Equipment Management Report~Operated Only; by
Type; With Period Select No

8-1-5 Equipment Maintenance Reports

Report Name Locked

21—Equipment Maintenance No

26—Equipment Maintenance~with Notes No

31—Equipment Maintenance~Service Past Due No

36—Equipment Maintenance~Service Past Due; with Notes No
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8-1-7 Equipment Revenue Journal

Report Name Locked

21—Equipment Revenue Journal No

22—Equipment Revenue Journal~with Notes No

31—Equipment Revenue Journal~by Equipment No

32—Equipment Revenue Journal~by Equipment; with Notes No

36—Equipment Revenue Journal~by Equipment/Job No

37—Equipment Revenue Journal~by Equipment/Job; with
Notes No

46—Equipment Revenue Journal~by Job/Equipment No

47—Equipment Revenue Journal~by Job/Equipment; with
Notes No

8-2 Equipment Costs

Report Name Locked

21—Equipment Cost Record No

31—Equipment Cost Record~with Notes No

8-3 Equipment

Report Name Locked

21—Equipment Record No

31—Equipment Record~with Notes No

8-4 Equipment Allocation

Report Name Locked

21—Equipment Allocation Yes

8-5 Equipment Payments

Report Name Locked

21—Equipment Checks Yes

8-6 Equipment Depreciation

Report Name Locked

21—Equipment Depreciation Yes
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8-7 Equipment Revenue

Report Name Locked

21—Equipment Revenue Record No

31—Equipment Revenue Record~with Notes No

9-Estimating Reports

9-1-1 Parts List

Report Name Locked

21—Part List No

22—Part List~with Notes No

26—Part List~with Vendors No

27—Part List~with Vendors and Notes No

31—Part List~by Class No

32—Part List~by Class; with Notes No

36—Part List~by Class; with Vendors No

37—Part List~by Class; with Vendors and Notes No

41—Part List~Land No

42—Part List~Land; with Notes No

46—Part List~Land; with Vendors No

47—Part List~Land; with Vendors and Notes No

51—Part List~Land; by Class No

52—Part List~Land; by Class; with Notes No

56—Part List~Land; by Class; with Vendors No

57—Part List~Land; by Class; with Vendors and Notes No

9-1-2 Assembly List

Report Name Locked

21—Assembly List No

22—Assembly List~with Notes No

31—Assembly List~with Details No

32—Assembly List~with Details and Notes No
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9-1-3 Takeoff List

Report Name Locked

21—Takeoff List No

22—Takeoff List~with Notes No

31—Takeoff List~Long No

32—Takeoff List~Long; with Notes No

9-1-4 Takeoff Parts

Report Name Locked

21—Takeoff Parts No

26—Takeoff Parts~(separate reports) No

31—Takeoff Parts~by Vendor No

36—Takeoff Parts~by Vendor (separate reports) No

41—Takeoff Parts~by Task No

46—Takeoff Parts~by Task (separate reports) No

51—Takeoff Parts~by Phase No

56—Takeoff Parts~by Phase (separate reports) No

61—Takeoff Parts~by Bid Item No

66—Takeoff Parts~by Bid Item (separate reports) No

9-1-5 Takeoff Assemblies

Report Name Locked

21—Takeoff Assemblies List No

23—Takeoff Assemblies List~with Notes No

31—Takeoff Assemblies List~by Phase No

33—Takeoff Assemblies List~by Phase; with Notes No

41—Takeoff Assemblies List~by Bid Item No

43—Takeoff Assemblies List~by Bid Item; with Notes No

51—Takeoff Assembly Budget Costs~by Job No

56—Takeoff Assembly Budget Costs~by Job (separate
reports) No

61—Takeoff Assembly Budget Costs~by Phase No
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Report Name Locked

66—Takeoff Assembly Budget Costs~by Phase (separate
reports) No

71—Takeoff Assembly Budget Costs~by Bid Item No

76—Takeoff Assembly Budget Costs~by Bid Item (separate
reports) No

9-1-6 Takeoff Bid Requests

Report Name Locked

21—Takeoff Bid Request Yes

9-1-7 Takeoff Recaps

Report Name Locked

21—Takeoff Details Recap~by Cost Code (separate
reports) No

31—Takeoff Details Recap~by Task (separate reports) No

41—Takeoff Details Recap~by Vendor (separate reports) No

51—Takeoff Details Recap~by Phase (separate reports) No

61—Takeoff Details Recap~by Bid Item Type No

71—Takeoff Details Recap~by Bid Item/Cost Code
(separate reports) No

81—Takeoff Details Recap for Cost Type~by Bid
Item/Phase Yes

9-1-8 Takeoff Bid

Report Name Locked

21—Takeoff Bid Ext. Price~by Cost Code No

31—Takeoff Bid Ext. Price~by Phase No

36—Takeoff Bid Ext. Price~by Phase/Cost Code No

37—Takeoff Bid Ext. Price~by Phase/Bid Item No

41—Takeoff Bid Ext. Price~by Bid Item No

46—Takeoff Bid Ext. Price~by Bid Item Type/Bid Item No
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9-1-9 Takeoff Vendor Lists

Report Name Locked

21—Takeoff Vendor List No

31—Takeoff Vendor List~by Vendor Type No

41—Takeoff Vendor List~Alpha No

51—Minority Vendor List~(separate reports) No

9-2 Parts

Report Name Locked

21—Part Record No

31—Part Record~with Notes No

9-3 Assemblies

Report Name Locked

21—Assembly Record No

31—Assembly Record~with Notes No

9-4 Part-Assembly Classes

Report Name Locked

21—Part Classes No

31—Assembly Classes No

9-5 Takeoffs

Report Name Locked

21—Takeoff Worksheet No

22—Takeoff Worksheet~with Notes No

24—Takeoff Worksheet~with Summary Tab Amounts No

25—Takeoff Worksheet~with Summary Tab Amounts and
Notes No

31—Takeoff Worksheet~by Phase No

32—Takeoff Worksheet~by Phase; with Notes No

41—Takeoff Worksheet~by Bid Item No

42—Takeoff Worksheet~by Bid Item; with Notes No
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Report Name Locked

46—Takeoff Worksheet~by Phase/Bid Item No

47—Takeoff Worksheet~by Phase/Bid Item; with Notes No

71—Bid Summary Yes

10-Scheduling Reports

10-1-1 Subcontract Notices

Report Name Locked

21—Subcontract Notice Yes

10-1-2 Scheduled Tasks

Report Name Locked

21—Scheduled Tasks Yes

22—Scheduled Tasks~by Phase Yes

10-1-3 Schedule Resource Reports

Report Name Locked

21—Resource Report~Subcontractors Yes

31—Resource Report~Employees Yes

41—Resource Report~Equipment Yes

10-1-4 Subcontract Call Sheet

Report Name Locked

21—Call Sheet Yes

10-1-5 Gantt Chart

Report Name Locked

21—Gantt Chart Yes

10-1-6 Original-Actual Report

Report Name Locked

21—Original/Actual~by Job No
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Report Name Locked

31—Original/Actual~by Job; with Notes No

41—Schedule Variance~by Job Yes

46—Schedule Detail~by Phase Yes

47—Schedule Detail with Resources~by Phase Yes

10-1-7 Scheduled Cash Flow

Report Name Locked

21—Cash Flow Yes

10-1-8 Critical Path Report

Report Name Locked

21—Critical Path Report~(separate reports) No

31—Critical Path Report~with Float (separate reports) No

10-3 Schedules
Select checkboxes on the Report Printing to generate the report with the following options: Notes, Predecessors,
Equipment Resources, Subcontract Resources, and Employee Resources.

Report Name Locked

21—ScheduleWorksheet~(Separate Reports) Yes

11-Service Reports

11-1-1 Client List

Report Name Locked

21—Client List No

22—Client List~with Notes No

31—Client List~Alpha No

32—Client List~Alpha; with Notes No

41—Client List~Long No

42—Client List~Long; Alpha No

51—Client Balances No

52—Client Balances~Alpha No

53—Client Balances~by Client Type No

54—Client Balances~by Client Type; with Notes No
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11-1-2 Service Invoice List

Report Name Locked

21—Service Invoice List No

22—Service Invoice List~with Notes No

23—Service Invoice List~with Payments No

31—Service Invoice List~by Client No

32—Service Invoice List~by Client; with Notes No

33—Service Invoice List~by Client; with Payments No

36—Service Invoice List~Alpha; by Client No

37—Service Invoice List~Alpha; by Client; with Notes No

38—Service Invoice List~Alpha; by Client; with Payments No

41—Service Invoice List~by Client/Location No

42—Service Invoice List~by Client/Location; with Notes No

43—Service Invoice List~by Client/Location; with Payments No

46—Service Invoice List~Alpha; by Client/Location No

47—Service Invoice List~Alpha; by Client/Location; with
Notes No

48—Service Invoice List~Alpha; by Client/Location; with
Payments No

61—Service Invoice Profitability~by Client No

62—Service Invoice Profitability~by Client/Job No

71—Service Invoice Profitability~by Invoice Type/Job No

72—Service Invoice Profitability~by Salesperson/Job No

91—EstimatedWork Order Profitability Yes

11-1-3 Service Aging

Report Name Locked

21—Service Invoice Aging Yes

26—Service Invoice Aging~Land Yes

31—Client Current Aging No

32—Client Current Aging~Alpha No

36—Client Current Aging~Land No

37—Client Current Aging~Land; Alpha No



- 791 -

Report Name Locked

41—Client Period Aging No

42—Client Period Aging~Alpha No

46—Client Period Aging~Land No

47—Client Period Aging~Land; Alpha No

11-1-4 Service Journal-Ledger

Report Name Locked

21—Service Journal Yes

31—Service Journal~Income Yes

41—Service Journal~Cash Receipts Yes

51—Service Ledger Yes

11-1-5 Service Call Sheet

Report Name Locked

21—Service Call Sheet No

22—Service Call Sheet~with Client Notes No

26—Service Call Sheet~Alpha No

27—Service Call Sheet~Alpha; with Client Notes No

31—Service Call Sheet~with Invoice Detail No

32—Service Call Sheet~with Invoice Detail and Client
Notes No

36—Service Call Sheet~Alpha; with Invoice Detail No

37—Service Call Sheet~Alpha; with Invoice Detail and
Client Notes No

41—Service Aged Call Sheet No

42—Service Aged Call Sheet~with Client Notes No

46—Service Aged Call Sheet~Alpha No

47—Service Aged Call Sheet~Alpha; with Client Notes No

51—Service Aged Call Sheet~with Invoice Detail No

52—Service Aged Call Sheet~with Invoice Detail and Client
Notes No

56—Service Aged Call Sheet~Alpha; with Invoice Detail No

57—Service Aged Call Sheet~Alpha; with Invoice Detail
and Client Notes No
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11-1-6 Service Employee Reports

Report Name Locked

21—Service Employee Report No

11-1-7 Service Advertising Reports

Report Name Locked

21—Service Advertising Report Yes

11-1-8 Service Resource Reports

Report Name Locked

21—Service Resource Report~by Part No

22—Service Resource Report~by Work Order No

26—Service Resource Report~by Employee/Part No

27—Service Resource Report~by Employee/Work Order No

31—Service Resource Value Report~by Part No

32—Service Resource Value Report~by Work Order No

11-1-9 Client Documents

Report Name Locked

31—Client Mail Label~Sheet No

41—Client Mail Label~Tractor Feed No

11-1-10 Service Tax Report

Report Name Locked

21—Service Tax Report No

31—Service Tax Report~with Invoice Detail No

11-1-11 Overdue Service Reminders

Report Name Locked

21—Overdue Service Reminders No
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11-1-12 Service Route Sheet

Report Name Locked

21—Service Route Sheet No

26—Service Route Sheet~with Notes No

31—Service Route Sheet~with Address No

36—Service Route Sheet~with Address; and Notes No

11-1-13 Service Price Book

Report Name Locked

21—Service Price Book No

22—Service Price Book~with Notes No

31—Service Price Book~with Tech Data No

32—Service Price Book~with Tech Data and Notes No

41—Service Price Book~with AddOns No

42—Service Price Book~with AddOns and Notes No

46—Service Price Book~with AddOns and Tech Data No

47—Service Price Book~with AddOns, Tech Data and
Notes No

51—Service Price Book~Show Parts No

52—Service Price Book~Show Parts; with Notes No

61—Service Price Book~Show Parts; with Tech Data No

62—Service Price Book~Show Parts; with Tech Data and
Notes No

71—Service Price Book~Show Parts; with AddOns No

72—Service Price Book~Show Parts; with AddOns and
Notes No

76—Service Price Book~Show Parts; with AddOns and
Tech Data No

77—Service Price Book~Show Parts; with AddOns, Tech
Data and Notes No

11-2 Work Orders-Invoices-Credits

Report Name Locked

21—Service Invoice No
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Report Name Locked

22—Service Invoice~with Notes No

23—Service Invoice~with Equipment No

24—Service Invoice~with Equipment and Notes No

26—Service Invoice~Hide Assembly Parts No

27—Service Invoice~Hide Assembly Parts; with Notes No

31—Service Invoice~Land No

32—Service Invoice~Land; with Notes No

33—Service Invoice~Land; Hide Assembly Parts No

34—Service Invoice~Land; Hide Assembly Parts; with Notes No

36—Service Invoice~Land; with Equipment No

37—Service Invoice~Land; with Equipment and Notes No

41—ServiceWork Order No

42—ServiceWork Order~with Notes No

46—ServiceWork Order~with Equipment No

47—ServiceWork Order~with Equipment and Notes No

51—Service Quote No

52—Service Quote~with Owner Notes No

53—Service Quote~withWork Order Notes No

56—Service Quote~Hide Assembly Parts No

57—Service Quote~Hide Assembly Parts; with Owner Notes No

58—Service Quote~Hide Assembly Parts; withWork Order
Notes No

61—Service Credit No

62—Service Credit~with Notes No

12-Inventory Reports

12-1-1 Allocation List

Report Name Locked

21—Allocation List No

22—Allocation List~with Details No
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Report Name Locked

23—Allocation List~with Notes No

24—Allocation List~with Details and Notes No

31—Allocation List~Land No

32—Allocation List~Land; with Details No

33—Allocation List~Land; with Notes No

34—Allocation List~Land; with Details and Notes No

12-1-2 Quantity on Hand

Report Name Locked

21—Quantity on Hand No

22—Quantity on Hand~with Location No

31—Quantity on Hand~Land No

32—Quantity on Hand~Land; with Location No

41—WAC Value Report~Land No

42—WAC Value Report~Land; with Location No

43—LIFO/FIFO Value Report~by Part No

12-1-3 Inventory Journal-Ledger

Report Name Locked

21—Inventory Journal~by Entry Yes

31—Inventory Journal~by Part Yes

41—Inventory Ledger Yes

51—Inventory Ledger~Land Summary Yes

61—Inventory Variance No

71—LIFO/FIFO Inventory Detail No

72—LIFO/FIFO Inventory Detail~with Remaining Quantity No

12-1-4 Inventory Order Report

Report Name Locked

21—Material Order Report Yes

31—Material Order Report~Long Yes

41—Material Order Report~by Location Yes



- 796 -

12-2 Inventory Allocation

Report Name Locked

21—Packing Slip No

31—Packing Slip~Land No

12-4 Purchase Order Receipts

Report Name Locked

21—POReceipt Yes

13-Review and Reporting Reports

13-6 Report-Query Lists Reports

Report Name Locked

21—Report List~by Menu Yes

26—Query List~by MenuOption Yes
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Appendix C: Timetable of Office Procedures
About office procedures
Establishing routine accounting procedures for a company is extremely important. Themanagement, controller, and
bookkeeping staff should agree on the procedures and routines.

If your company has not established a routine for accounting procedures, use the following routines as a guide.

l Using daily routines in Sage 100 Contractor

l Using weekly routines in Sage 100 Contractor

l Usingmonthly routines in Sage 100 Contractor

l Using quarterly routines in Sage 100 Contractor

Daily Routines

Using daily routines in Sage 100 Contractor
We recommend that you perform the following tasks on a daily basis. Be aware, however, that youmay need to customize
your list of daily accounting tasks to fit your company’s specific needs.

To perform daily accounting tasks:
1 Sort and open the daily mail. Write the cost codes on receipts and invoices as necessary.

2 Perform the followingGeneral Ledger tasks:

a In the 1-1 Checks/Bank Chargeswindow, post handwritten field checks.

b In the 1-2 Deposits/Interestwindow, post non job-related deposits.

c In the 1-4 Recurring Journal Transactionswindow, post recurring journal transactions.

3 Perform the followingAccounts Receivable tasks:

a In the 3-2 Receivable Invoices/Creditswindow, prepare contract invoices and credits.

b File copies awaiting payment.

c In the 3-3-1 Cash Receiptswindow, deposit and post any cash receipts.

d In the 3-3-2 Electronic Receiptswindow, enter and post any electronic receipts.

e Indicate the job and invoice number on the deposit slip.

f In the 3-11 Recurring Receivableswindow, post recurring receivables.

4 Perform the followingService Receivables tasks:

a In the 11-2 Work Orders/Invoices/Creditswindow, enter work orders and requests for quotes, including new client
information.

b In the 11-2 Work Orders/Invoices/Creditswindow, schedule the work orders.
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c In the 11-2 Work Orders/Invoices/Creditswindow, prepare the service invoices and credits.

d In the 11-2 Work Orders/Invoices/Creditswindow, post work orders.

e File the copies awaiting payment.

f In the 3-3-1 Cash Receiptswindow, deposit and post any cash receipts.

NOTE: Indicate the client and invoice number on the deposit slip.

g In the 3-3-2 Electronic Receiptswindow, enter and post any electronic receipts.

5 Perform the followingAccounts Payable tasks:

a Stamp and code invoices with vendor, general ledger account, job, and cost code numbers.

b In the 4-2 Payable Invoices/Creditswindow, post the invoices and credits.

c Assign status 2-Review if sending to the owner or project supervisor for approval.

d In the 4-2 Payable Invoices/Creditswindow, review the entries with a batch report.

e Make duplicate invoices required for time andmaterials projects and fixed-asset tax information.

f File copies awaiting payment.

g In the 4-6 Recurring Payableswindow, post recurring payables.

6 Perform the followingDaily Payroll tasks:

a In the 5-5-1 Daily Payroll Entrywindow, enter daily payroll timecards for:

i Labor

ii Equipment use.

b Print and review the following reports:

i 5-5-2 Daily Job Report

ii 5-5-3 Labor Report

iii 5-5-4 Equipment Report

7 In the company calendar, enter the sick and vacation days for employees for whom you are not paying for the time off
(F2).

8 Make a daily backup of the company data.

Monthly Routines

Using monthly routines in Sage 100 Contractor
We recommend that you perform the following tasks on amonthly basis. Be aware, however, that youmay need to
customize your list of monthly accounting tasks to fit your company’s specific needs.

To perform monthly accounting tasks:
1 Perform the followingGeneral Ledger tasks:

a In the 1-1 Checks/Bank Chargeswindow, post service charges from the bank statement.

b In the 1-2 Deposits/Interestwindow, post interest earned on bank accounts.

2 Reconcile checksby doing the following:
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a In the 1-5 Bank Reconciliation window, print the preliminary check reconciliation report.

b In the 1-5 Bank Reconciliation window, print the final check reconciliation report and file it with the bank statement.

3 Manually reconcile petty cash.

4 In the 1-3 Journal Transactionswindow, post journal transactions to adjust the general ledger.

5 In the 6-1-7 Over/Under Billing Reportwindow, make any applicable billing adjustments.

6 Enter fixed assets depreciation.

7 In the 1-6 Period/Fiscal Year Management > Change Period window, chance the posting period.

8 Make amonthly backup of company data.

9 Try to repair any errors that may exist.

10 If errors persist, call Customer Support.

11 Generate the following accounting reports:

a In the 2-2 Balance Sheetwindow, print and review theBalance Sheet.

b In the 2-3 Income Statementwindow, print and review the 31-Income statement—Period and YTD report.

12 Perform the followingAccounts Receivable tasks:

a In the 3-7 Progress Billingwindow, prepare and update the progress billing.

b Submit the invoices for approval.

c After approval, in the 3-7 Progress Billingwindow, post the invoices to the general ledger.

d In the 3-8 Loan Draw Requestswindow, prepare and update the loan draw requests.

e In the 3-9 Unitary Billingwindow, prepare and update the unitary billing.

f Submit the invoices for approval.

g After approval, in the 3-9 Unitary Billingwindow, post the invoices to the general ledger.

13 Prepare statements by doing the following:

a In the 3-4 Statementswindow, print statements without finance charges.

b In the 3-4 Statementswindow, print statements that include finance charges.

c In the 3-5 Jobs (Accounts Receivable)window, change the job status for completed jobs.

14 Perform the following collections tasks:

a In the 3-1-3 Receivable Agingwindow, print and review aging reports.

b In the 3-1-5 Receivable Call Sheetwindow, print the receivable call sheet.

c Contact any overdue accounts to request payment.

d In the 3-1-9 Overdue Receivable Reminderwindow, print overdue receivable reminders.

15 Perform the followingService Receivables tasks:

a Prepare statements by doing the following:

i In the 3-4 Statementswindow, print statements without finance charges.

ii In the 3-4 Statementswindow, print statements that include finance charges.

b Perform the following collections tasks:

i In the 11-1-3 Service Agingwindow, print and review aging reports.
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ii In the 11-1-5 Service Call Sheetwindow, print the service receivable aged call sheet.

c Contact any overdue accounts to request payment.

d In the 11-1-11 Overdue Service Reminderwindow, print overdue service receivable reminders.

16 Perform the followingAccounts Payable tasks:

a In the 4-1-3 Payable Agingwindow, print and review aging reports.

b In the 4-1-1 Vendor Listwindow, print and review the 41-Vendor Insurance report to determine which vendors have
expired insurance.

c If applicable, in the 4-1-6 Vendor Documentswindow, print andmail notification letters for expired insurance.

17 Perform the followingPayroll tasks:

a If your company makes monthly tax deposits, prepare the 941 and state tax deposit payments by doing the following:

i In the 5-1-4 State Tax Reportwindow, print the state tax report.

ii In the 5-4-1 Federal Forms window, calculate the 941 tax liability.

b If applicable, manually update line 14-Total deposits for quarter.

c In the 1-1 Checks/Bank Chargeswindow:

i Enter the checks.

ii Print the checks.

d If applicable, in the 1-3 Journal Transactionswindow, enter a general ledger transaction for telephone/automatic
payments.

e In the 5-1-5 Workers Comp Reportwindow, print the applicableWorkers’ Compensation report.

f In the 5-1-7 Union Reportswindow, print union reports.

18 Perform the followingProject Management tasks:

a In the 6-8-1 Cost to Completewindow, prepare theCost to Complete report.

b If applicable, in the 6-4-1 Change Orderswindow, adjust job budgets via change orders.

c In the 6-1-7 Over/Under Billing Reportwindow, print the over/under billing report for open jobs.

d In the 6-1-8 Bonding Reportwindow, print the bonding report.

19 In the 8-6 Equipment Depreciationwindow, post the equipment depreciation.

20 Make amonthly backup of company data.

Quarterly Routines

Using quarterly routines in Sage 100 Contractor
We recommend that you perform the following tasks on a quarterly basis. Be aware, however, that youmay need to
customize your list of quarterly accounting tasks to fit your company’s specific needs.

To perform quarterly accounting tasks:
1 Perform the following Payroll tasks:

a In the 5-3-7 Payroll Auditwindow, run a payroll audit.

b If errors exist, do the following:



- 801 -

i Back up your data.

ii In the 5-3-7 Payroll Auditwindow, repair the balances.

iii In the 5-3-7 Payroll Auditwindow, print the audit report.

c If errors still exist, call Customer Support.

2 In the 5-4-1 Federal Formswindow, print and prepare the 941 report.

3 In the 5-4-2 State Quarterlywindow, print and prepare theState Unemployment report.

4 In the 5-1-3 Federal Tax Reportwindow, print the Federal tax reports.

5 Prepare the 940 Federal Unemployment deposit.

6 In the 5-1-4 State Tax Reportwindow, print the 5-1-4 State Tax Report tax reports.

7 Prepare the required 5-1-4 State Tax Reportreports.

a In the 5-1-8 Hours Reportwindow, print the quarter-to-date earnings report.

b In the 2-2 Balance Sheetwindow, review and reconcile payroll tax liability.

c In the 1-3 Journal Transactionswindow, post adjusting journal transactions.

8 Make a quarterly backup of company data.

Weekly Routines

Using weekly routines in Sage 100 Contractor
We recommend that you perform the following tasks on a weekly basis. Be aware, however, that youmay need to
customize your list of weekly accounting tasks to fit your company’s specific needs.

To perform weekly accounting tasks:
1 Perform the followingAccounts Payable tasks:

a In the 4-3 Vendor Paymentswindow, select the invoices for payment.

b In the 4-3 Vendor Paymentswindow, verify the selected invoices by doing the following:

i Review the vendor totals.

ii Print and review theSet to Pay report.

c In the 4-3 Vendor Paymentswindow, print the Lien Waivers.

d In the 4-3 Vendor Paymentswindow, prepare the vendor payments by doing the following:

i Print payment vouchers.

ii Print the check report.

iii Print vendor checks.

e File copies of vouchers and checks with the original invoices being paid in vendor files.

2 Perform the followingPayroll tasks:

a In the 5-2-1 Employeeswindow, enter new employees andmodify existing employee information as needed.

b In the 5-5-1 Daily Payroll window, process the daily payroll.

c In the 5-2-2 Payroll Recordswindow, enter weekly timecards.

d In the 5-2-3 Compute Payroll window, trial-compute the payroll records.
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3 Verify the records by doing the following:

a In the 5-2-8 Timecard Journal window, print the 21-Timecard Journal report.

4 Submit the report to the owner or project supervisor for approval.

5 In the 5-1-2 Payroll Check Registerwindow, print the payroll check register and review the calculations.

6 In the 5-2-2 Payroll Recordswindow, enter the corrections to timecards or calculations.

7 In the 5-2-3 Compute Payroll window, final-compute the payroll records.

8 In the 5-2-4 Payroll Checkswindow, print payroll checks.

9 In the 5-2-7 Compensation Slipswindow, print compensation slips for prevailing-wage projects.

10 In the 5-1-2 Payroll Check Registerwindow, print the payroll check register.

11 In the 5-2-6 Post Payroll to GLwindow, post the payroll to the general ledger.

12 If your company makes weekly tax deposits, prepare the 941 and state tax deposit payments by doing the following:

a In the 5-4-1 Federal Formswindow, calculate the 941 tax liability.

b In the 5-4-2 State Formswindow, print the state tax report.

13 In the 1-1 Checks/Bank Chargeswindow, enter and print the check.

14 If applicable, in the 1-3 Journal Transactionswindow, enter a general ledger transaction for telephone/automatic
payments.

15 In the 5-1-6 Certified Payroll Reportwindow, print certified payroll reports.

16 Perform the followingAccounts Receivable tasks:

a In the 3-10-2 Compute T&M Invoiceswindow, compute the time andmaterials billing.

b In the 3-10-1 T&M Billing Setupwindow, set up new time andmaterials jobs.

c In the 3-10-5 T&M Wage Rates and 3-10-6 T&M Equipment Rateswindows, assign the wage and equipment rate
tables as applicable.

d In the 3-10-3 Print T&M Invoiceswindow, print the time andmaterials invoices.

e In the 3-10-4 Post T&M Invoiceswindow, post the time andmaterials invoices to the general ledger.

17 In the 8-5 Equipment Paymentswindow, prepare the equipment payments.

18 Make a weekly backup of company data.

Year-End Routines
Use the procedures in the year-end checklists to help simplify year-end processing.

Use the Archive Data wizard when you need to archive data for a previous year.
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Appendix D: Tax Setup Information
Federal, City, and State Tax Setup Information

About tax setup information
This section provides information about state, federal, and city tax setup information. In addition, you will find information
about settingWorkers’ Compensation for several specific areas.

Alabama State Tax
IMPORTANT: For each employee claiming S, M, H, or MS on the Alabama A-4Withholding Exemption Certificate, a
corresponding table numbermust be entered for each employee. If the table number is left blank the employee will be
taxed as if they are claiming No Exemptions. Employee's claiming “0” on the Alabama A-4 Form are not allowed to
claim any dependents, and Sage 100 Contractor will ignore dependents entered in theStd Allow cell.

NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Employees should use the Alabama Form A-4 Employee's Withholding Exemption Certificate.

Enter the appropriate number in the Table# column to identify the employee's W-4 selection.

W-4 Selection Table # Description

O 0 (zero or blank) No exemptions

S 1 Single

M 2 Married

H 3 Head of Family

MS 4 Married Separate

To set up payroll calculations on an employee for Alabama State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theAlabama Income Tax row, enter the appropriate marital status number.

NOTE: This is a required field; however, themarital status has no affect on the amount of state withholding.

5 In the Table# column, in the cell of theAlabama Income Tax row, enter the corresponding number from the table above.

6 In theStd Allow column, in the cell of theAlabama Income Tax row, enter the number of dependents claimed on the
Alabama A-4 form, if allowed.
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7 On the Filemenu, click Save.

Alaska State Tax
IMPORTANT: Even though the State of Alaska does not have state income tax, the state income tax calculation
needs to be set up in the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax calculation needs to
be set up so that state wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding, and no state tax will be computed.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Alaska State Tax:
1 Open 5-2-1 Employees.

2 Using data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theAlaska Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theAlaska Income Tax row, enter the number of exemptions/allowances
claimed, as required.

6 On themenu bar click File, then click Save.

Arizona State Tax
Arizona is now using a percentage of gross taxable wages for state withholding. Employers should update their rates on the
5-2-1 EmployeesCalculations tab for the Arizona State Tax Calculation from the revised Form A-4, which is effective for
wages paid after June 30, 2010.

For your convenience, if Sage 100 Contractor finds one of the previously allowed Arizona rates on the 5-2-1 Employees
Calculations tab for the Arizona State Tax Calculation in the left column below, it will use the corresponding new rate from
the right column below during the payroll compute. If any other rates are found, Sage 100 Contractor will use these rates to
compute taxes using the new Arizona process.

For example, if the old rate as a percentage of federal was 10.7%, the new rate of 1.3% is used to calculate the state taxes.
The program calculates with any percentages entered in 5-2-1 Employees.

Old Arizona rates % of
Federal Tax

New Arizona Rates % of
Taxable Wages

0 0
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Old Arizona rates % of
Federal Tax

New Arizona Rates % of
Taxable Wages

10.7 1.3

20.3 1.8

24.5 2.7

26.7 3.6

33.1 4.2

39.5 5.1

NOTE: As of January 1, 2011, an additional rate is available on the A-4 form for Arizona.

Sage 100 Contractor requires amarital status on all state tax calculations in 5-2-1 EmployeesCalculations tab, even
though Sage 100 Contractor does not usemarital status when calculating Arizona state withholding taxes. Use the status
that applies to each employee below. Themarital status has no affect on the amount of state withholding.

Marital Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separately

5-Married/Jointly Married Joint

Payroll Calculation
Setting up payroll calculations in Arizona requires some special provisions.

To set up payroll calculations on an employee for Arizona State Tax:

CAUTION: Do not include any rates or maximums in the payroll calculation.

1 Open 5-3-1 Payroll Calculations.

2 In the Tax Type list, click State Income Tax.

3 In theState box, type AZ.

4 After setting up the payroll calculation and updating it to the employee records, enter each employee’s rate in the
employee records.

To set up employee rates for Arizona State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theArizona Income Tax row, enter the correspondingmarital status number.

5 In theRate cell of theArizona State Tax row, enter the employee’s rate declared on Form A-4.
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6 On themenu bar click Filemenu, then select Save.

Arkansas State Tax
For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor calculates state
income tax using the published flat-rate.

Employees should use the Arkansas Form AR4EC Employee's Withholding Exemption Certificate.

There is no distinction for marital status for employees who work in Arkansas.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Arkansas State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theArkansas Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theArkansas Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

California State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

California recommends the use of California’s Form DE-4 Employee’s Withholding Allowance Certificate.

IMPORTANT: The Federal FormW-4 is applicable for California withholding purposes if you want to claim the same
marital status, number of allowances, and/or the same additional dollar amount to be withheld for State and Federal
purposes. However, federal tax brackets and withholdingmethods do not reflect state personal income tax
withholding tables.

The state tax rules governingmarital status in California are as follows:
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Status Description

1-Single Single/Dual Income, Married/Married with Multiple
employers

2-Married Married

3-HeadOf
House Head of Household

4-
Married/Separate

Single/Dual Income, Married/Married with Multiple
employers

5-Married/Joint Single/Dual Income, Married/Married with Multiple
employers

To set up payroll calculations on an employee for California State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theCalifornia Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theCalifornia Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar click File, then click Save.

Colorado State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Colorado does not have its ownW-4 form. The employer should rely on the federal withholding exemption certificates
(Federal FormW-4). Colorado payroll taxes are rounded to the nearest dollar.

Employees who work in Colorado can select from the followingmarital status options.

Status Description

1-Single Single

2-Married Married

3-Head of Household Single

4-Married/Separate Single

5-Married/Joint Married

To set up payroll calculations on an employee for Colorado State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theColorado Income Tax row, enter the correspondingmarital status number.
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5 In theStd Allow column, in the cell of theColorado Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar click File, then click Save.

Connecticut State Tax
Connecticut uses specific tax tables to help compute state income tax. Connecticut incorporates the filing status in the tax
tables. Marital status is still required as a standard field for income tax calculations, but has no bearing since CT uses a
separate table for each filing status. The table indicator is entered in the Table# column of theCalculations tab of the 5-2-1
Employee Recordswindow.

Refer to line 1 on the CT-W4 form for each employee, then consult the table below.

For table Enter this

A (Married filing separately OR filing jointly, but the
combined income is less than the current amount on
the CT-W4, Employee’s Withholding Certificate)

1

B (Head of Household) 2

C (Married filing jointly—spouse not employed) 3

D (Married filing jointly—spouse is employed) 4

F (Single) 5

E (Exempt) 6 (or blank)

To set up payroll calculations on an employee for Connecticut State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In the Table# cell of theConnecticut Income Tax row, enter the tax table number.

IMPORTANT: If you do not enter a number from the above table, Sage 100 Contractor does not compute CT income
tax as no entry signifies a filing status of Category E (for Exempt).

5 On themenu bar, click File, then click Save.

Delaware State Tax
Employees who work in Delaware can select one of threemarital status options.

Status Description

1-Single Single/Head of Household

2-Married Married, Married/Joint

4-Married/Separate Married filing separate
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To set up payroll calculations on an employee for Delaware State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theDelaware Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow cell enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

District of Columbia Income Tax
Employees should use Form D-4 Employee’s Withholding Allowance for the District of Columbia.

The tax rules governingmarital status in the District of Columbia are as follows:

Marital Status Tax Table Used

1-Single Single or Married Persons Filing Jointly

2-Married Single or Married Persons Filing Jointly

3-Head of Household Married Persons Filing Separate Returns, or
Separately on the SameReturn

4-Married Separate Married Persons Filing Separate Returns, or
Separately on the SameReturn

5-Married Joint Single or Married Persons Filing Jointly

To set up payroll calculations on an employee for District of Columbia Income Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theDistrict of Columbia Tax row, enter themarital status.

5 In theStd Allow cell, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Federal Income Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates federal income tax using the published flat-rate.

Every employer must obtain a Form W-4, Employee’s Withholding Allowance Certificate, for each employee.

The Federal rules governingmarital status are as follows:

Marital Status Tax Table Used

1-Single Single (Includes Head of Household)
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Marital Status Tax Table Used

2-Married Married

3-Head of Household Single (Includes Head of Household)

4-Married Separate Single (Includes Head of Household)

5-Married Joint Married

To set marital status on an employee for Federal Income Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Federal Income Tax row, enter themarital status.

5 On themenu bar, click File, then click Save.

Florida State Tax
IMPORTANT: Even though the State of Florida does not have state income tax, the state income tax calculation
needs to be set up in the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax calculation needs to
be set up so that state wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Florida State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Florida Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of the Florida Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.
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Georgia State Tax
The followingmarital status options correlate to the tax tables used as specified by the State of Georgia Employers Tax
Guide (revised November 2012). Additionally, themarital status determines the amount for the Standard Deduction defined
in Table E.

Marital Status Tax Table

1-Single Table H—Single Individual

2-Married Table F—Married Filing Joint Return (with one spouse having income) or Head of House-
hold

3-Head of House-
hold

Table F—Married Filing Joint Return (with one spouse having income) or Head of House-
hold

4-Mar-
ried/Separate

Table G—Married Filing Joint Return (both spouses having income) or Married Filing
Separate Return

5-Married/Joint Table G—Married Filing Joint Return (both spouses having income) or Married Filing
Separate Return

To set up payroll calculations on an employee for Georgia State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theGeorgia Income Tax row, enter themarital status.

5 In theStd Allow column, enter [1] if you are claiming a personal allowance.

6 In theAdd Allow column, enter the number of dependent allowances plus any additional allowances. For example, if
you have 2 dependents plus 1 additional allowance, enter [3].

7 On themenu bar, click File, then click Save.

Hawaii State Tax
Employees should use Form HW-4 Employee’s Withholding Allowance and Status Certificate.

The state tax rules governingmarital status in Hawaii are as follows:

Marital Status Tax Table Used

1-Single Single, Head of Household

2-Married Married

To set up payroll calculations on an employee for Hawaii State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theHawaii Income Tax row, enter themarital status.
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5 In theStd Allow cell, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Idaho State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Idaho does not have its ownW-4 form. The employer should rely on the federal withholding exemption certificate (Federal
FormW-4). Idaho payroll taxes are rounded to the nearest dollar. Employees who work in Idaho can select from the
followingmarital status options.

Status Description

1-Single/Head of Household Single/Head of Household

2-Married Married

3-Single/Head of Household Single/Head of Household

4-Single/Head of Household Single/Head of Household

5-Married Married

To set up payroll calculations on an employee for Idaho State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Idaho Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of the Idaho Income Tax row, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Illinois State Tax
Employees should use the Illinois Form IL-W-4 Employee's Withholding Exemption Certificate.

There is no distinction for marital status for employees who work in Illinois.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint
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To set up payroll calculations on an employee for Illinois State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Illinois Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of the Illinois Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Indiana State Tax
The State of Indiana differentiates between the exemptions that an employee claims for him or herself (and spouse), and
the exemptions that an employee claims for dependents. To calculate the withholding correctly in Sage 100 Contractor,
enter the exemptions from theWH-4 Employee’s Withholding Exemption Certificate separately in the employee record.

To set up payroll calculations on an employee for Indiana State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theStd Allow cell of the Indiana Income Tax row, enter the number from line 4 of the IndianaWithholding Exemption
Certificate.

5 In theAdd Allow cell of the Indiana Income Tax row, enter the number from line 5 of the IndianaWithholding
Exemption Certificate.

6 On themenu bar, click File, then click Save.

Iowa State Tax
Employees should use the Iowa Form IA-W4 Employee's Withholding Exemption Certificate.

There is no distinction for marital status for employees who work in Iowa. Iowa payroll taxes are rounded to the nearest
dollar.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Iowa State Tax:
1 Open 5-2-1 Employees.
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2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Iowa Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of the Iowa Income Tax row, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Kansas State Tax
IMPORTANT: In the past, Kansas has accepted the Federal FormW-4. Due to differences between State and
Federal withholding policies, however, the Kansas Department of Revenue has developed the K-4 state employee
withholding allowance certificate form for state withholding tax purposes. This form must be used for employees hired
after January 1, 2008. Employees hired before January 1, 2008 are not required to fill out the K-4 unless they want to
adjust their withholding.

NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Employees who work in Kansas can select from the followingmarital status options.

Status Description

1-Single Single/Head of Household

2-Married Married

3-Head of Household Single/Head of Household

4-Married/Separate Single/Head of Household

5-Married/Joint Married

To set up payroll calculations on an employee for Kansas State Tax:
1 Using the data control, select the employee.

2 Click theCalculations tab.

3 In theMarital column, in the cell of theKansas Income Tax row, enter the correspondingmarital status number.

4 In theStd Allow column, in the cell of theKansas Income Tax row, enter the number of exemptions/allowances
claimed.

5 On themenu bar, click File, then click Save.

Kentucky State Tax
Employers should use the Kentucky K-4 EmployeeWithholding Exemption Certificate.

Sage 100 Contractor does not usemarital status when calculating Kentucky state withholding taxes. Instead, a credit for
each exemption claimed on the Kentucky K-4 form is used. Nevertheless, Sage 100 Contractor still requires amarital
status on the state tax calculation. Use the status that applies to each employee below. Themarital status will have no
effect on the amount of state withholding.
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Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing separate

5-Married/Joint Married Two Incomes

To set up payroll calculations on an employee for Kentucky State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theKentucky Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow cell enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Louisiana State Tax
The State of Louisiana differentiates between the exemptions an employee claims for him or herself (and spouse) and the
exemptions an employee claims for dependents. An employee can use Block A and Block B of the L-4 worksheet to
determine how many exemptions to claim on the L-4 form.

l Block A: An employee can select from three exemptions (0-No Exemptions, 1-Yourself, 2-Yourself & Spouse).

l Block B: An employee can enter the total number of dependants, excluding the employee and spouse.

Block A:
Select one of the three exemptions:

l Enter “0” if you claim neither yourself nor your spouse. Youmay enter “0” if you aremarried and have a working
spouse or more than one job to avoid having too little tax withheld.

l Enter “1” if you claim yourself, provided you do not claim this exemption in connection with other employment or if
your spouse has not claimed your exemption. Enter “1” to claim one personal exemption or if you will file as head of
household.

l Enter “2” if you claim yourself and your spouse.

Block B:
l Enter the number of dependents, not including yourself and your spouse, whom you will claim on your tax return. If

no dependents are claimed, enter “0.”

Sage 100 Contractor determines the Louisiana table to use for the calculation by the number you enter in the Louisiana row
under theAdd Allow (additional allowances) column. The following table shows the criteria for entering Louisiana state tax
on 5-2-1 Employees, theCalculations tab, in theAdd Allow column:
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Add Allow Column Table Used

0 or 1
Always uses the Single or Married claiming 0
or 1 personal exemptions table.

2
Always uses theMarried with 2 personal
exemptions table.

Although Sage 100 Contractor does not usemarital status when calculating Louisiana state withholding taxes, the program
still requires that you enter amarital status for each employee’s state tax calculation. Use the following table to determine
marital status.

Status Description

1-Single

2-Married

3-Head of household

4-Married/Separate

5-Married/Joint

To set up payroll deductions on an employee for Louisiana State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of the Louisiana Income Tax row, enter amarital status number from the table above (1 through 5).

5 In theStd Allow cell of the Louisiana Income Tax row, type the number contained on line 7 of the L-4 Employee’s
Withholding Exemption Certificate.

6 Refer to the first table in this topic, and in theAdd Allow cell of the Louisiana Income Tax row, type the number
contained on line 6 of the L-4 Employee’s Withholding Exemption Certificate.

7 On themenu bar, click File, then click Save.

Maine State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Employees who work in Maine can select one of twomarital status options. This information is available on the FormW-
4ME EmployeeWithholding Allowance Certificate.

Status Description

1-Single Single

2-Married Married

3-Head of household Single

4-Married/Separate Single

5-Married/Joint Married
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To set up payroll calculations on an employee for Maine State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theMaine Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theMaine Income Tax row, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Maryland residents working in Delaware
This topic explains how to set up Sage 100 Contractor so that Maryland taxes can be computed for employees who live in
Maryland and work in Delaware. Maryland residents working in Delaware need to have both Delaware andMaryland taxes
calculated on the Delaware earnings. Following are the setup requirements:

l State Income Tax calculations must be set up for bothMD (Maryland) and DE (Delaware) in 5-3-1 Payroll
Calculations.

l A locality must be set up for Maryland with theState set toMD, and a second locality for Delaware with theState
set toDE in menu 5-3-6 Local Payroll Tax.

l Each employeemust have the table number representing the county they live in entered in the Table# cell of the
employees Maryland State calculation on theCalculations tab in 5-2-1 Employees.

l The State represented on the payroll record should be the employee residence—MD (Maryland).

l Employees’ timecard lines must be entered with the appropriate localities depending on where they worked during
the pay period. If they are salaried, they must have one line for each locality, and the total hours must be applied to
each line.

NOTE: When a payroll record lists MD as the State, and the timecard line(s) contains localities that haveDE as their
Tax State, an additional amount of Maryland state tax will be computed along with the normal Delaware state tax.
Sage 100 Contractor calculates Maryland tax using the “Maryland Residents Working in Delaware” table published by
the state of Maryland.

Maryland State Tax
CAUTION: If you do not provide the number for the corresponding local area rate, Sage 100 Contractor does not
calculate the county taxes and add them to the state tax.

Employers should use Form MW 507, Employee’s Maryland Withholding Certificate.

Maryland residents are subject to a county tax in addition to the state income taxes. Maryland County taxes are calculated
as a percentage of taxable income. To calculate the county taxes, set up the employee record of eachMaryland resident to
compute the correct local tax.

For example, if the local area is Allegany, enter 70 in theCalculation tab in the 5-2-1 Employeeswindow.

County Tax Rate Table #

Allegany 3.05% Code 70

Anne Arundel 2.60% Code 50
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County Tax Rate Table #

Baltimore City 3.20% Code 78

Baltimore County 2.85% Code 55

Calvert 2.80% Code 51

Caroline 2.65% Code 53

Carroll 3.05% Code 66

Cecil 2.80% Code 64

Charles 2.90% Code72

Dorchester 2.65% Code 52

Frederick 3.00% Code 74

Garrett 2.65% Code 54

Harford 3.10% Code 76

Howard 3.20% Code 48

Kent 2.85% Code 49

Montgomery 3.20% Code 56

Prince George’s 3.20% Code 58

Queen Anne’s 3.20% Code 68

St. Mary’s 3.00% Code 80

Somerset 3.15% Code 60

Talbot 2.40% Code 35

Washington 2.80% Code 62

Wicomico 3.20% Code 82

Worchester 1.25% Code 20

Non-resident 1.25% No code

Use the status that applies to each employee.

Status Description

1-Single Single includingMarried Filing
Separately or Dependent

2-Married Married Filing Joint or Head of
Household

3-Head of Household Married Filing Joint or Head of
Household
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Status Description

4-Married/Separate Single includingMarried Filing
Separately or Dependent

5-Married/Joint Married Filing Joint or Head of
Household

To set up payroll calculations on an employee for Maryland State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theMaryland Income Tax row, enter the correspondingmarital status number.

5 In the Table# column, in the cell of theMaryland Income Tax row, enter the correspondingMaryland local tax number
from the table above.

6 On themenu bar, click File, then click Save.

Massachusetts State Tax
Employees should use Form M-4 Massachusetts Employee’s Withholding Exemption Certificate.

No distinction is made for marital status, except for marital status 3-Head of Household. For employees filing as Head of
Household the table calculates an additional tax credit.

To set up payroll calculations on an employee for Massachusetts State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theMassachusetts Income Tax row, enter themarital status.

5 In theStd Allow cell enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Michigan State Tax
IMPORTANT: Every employer must obtain anMI-W4withholding Exemption Certificate from each employee.

NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

There is no distinction for marital status for employees who work in Michigan. More information is available on the formMI-
W4 EmployeeWithholding Exemption Certificate.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.
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Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Two Incomes

To set up payroll calculations on an employee for Michigan State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theMichigan Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theMichigan Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Minnesota State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Minnesota does not have its ownW-4 form. The employer should rely on the federal withholding exemption certificates
(Federal FormW-4).

Status Description

1-Single Single

2-Married Married

3-Head of Household Single

4-Married/Separate Single

5-Married/Joint Married

To set up payroll calculations on an employee for Minnesota State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theMinnesota Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theMinnesota Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.
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Mississippi State Tax
CAUTION: Do not include the standard deduction amount with the exemption amount. Sage 100 Contractor
automatically adds the standard deduction amount for you.

While most states use a fixed amount for exemptions, Mississippi allows variable amounts for exemptions. To claim a
variable exemption, Mississippi residents can complete Form 62-420 Employee’s Withholding Exemption Certificate. An
employee with a working spouse can check line 2B of Form 62-420 and claim an exemption not to exceed $12,000 between
the employee AND spouse. On line 2B, an employee enters the amount he or she wants to claim by increments of $500.

Sage 100 Contractor cannot automatically enter a fixed exemption amount based onmarital status for Mississippi because
the employee and spouse determine the amount.

To set up payroll calculations on an employee for Mississippi State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theRate cell of theMississippi Income Tax row, enter the exemption amount claimed on line 6 of Form 62-420.

5 On themenu bar, click File, then click Save.

Missouri State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

The State of Missouri uses theMOW-4 form for determining the EmployeeWithholding Allowances.

IMPORTANT: Missouri uses the annual Federal Income Tax deduction amount as part of the State Income Tax
deduction.

l Individuals filing a separateMissouri Income Tax return are entitled to deduct amaximum of $5,000.

l Individuals filing a combinedMissouri Income Tax return (Self and Spouse) are entitled to deduct amaximum
of $10,000.

Sage 100 Contractor determines the federal deductionmaximum for an employee based on the employee’s marital status.
When you enter amarital status for an employee, Sage 100 Contractor computes the deductionmaximum as follows:

Marital Status MO W-4 Filing Status

1-Single Single

2-Married Married Filing Combined

3-Head of Household Head of Household

4-Married/Separate Single

5-Married/Jointly Married Filing Combined

To set up payroll calculations on an employee for Missouri State Tax:
1 Open 5-2-1 Employees.
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2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theMissouri Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theMissouri Income Tax row, enter the number of exemptions/allowances
claimed.

IMPORTANT: When entering amounts, it is required that you round to the nearest dollar.

6 On themenu bar, click File, then click Save.

Montana State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Montana does not have its ownW-4 form. The employer should rely on the federal withholding exemption certificates
(Federal FormW-4). Montana payroll taxes are rounded to the nearest dollar.

There is no distinction for marital status for employees who work in Montana.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Montana State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital Column, in the cell of theMontana Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theMontana Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Nebraska State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.
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Nebraska does not have its ownW-4 form. The employer should rely on the federal withholding exemption certificates
(Federal FormW-4). Employees who work in Nebraska can select from the followingmarital status options.

Status Description

1-Single Single/Head of Household

2-Married Married

3-Head of Household Single/Head of Household

4-Married/Separate Married

5-Married/Joint Married

To set up payroll calculations on an employee for Nebraska State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theNebraska Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theNebraska Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Nevada State Tax
IMPORTANT: Even though the State of Nevada does not have state income tax, the state income tax calculation
needs to be set up in 5-3-1 Payroll Calculations. Additionally, the state income tax calculation needs to be set up so
that state wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be
computed.

Status Description

1-Single Single/Head of Household

2-Married Married

3-Head of Household Single/Head of Household

4-Married/Separate Married

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Nevada State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theNevada Income Tax row, enter the correspondingmarital status number.
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5 In theStd Allow column, in the cell of theNevada Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Nevada Workers' Compensation
IMPORTANT: Even though the State of Nevada does not have state income tax, the state income tax calculation
needs to be set up in 5-3-1 Payroll Calculations so that the Nevada worker’s compensation report prints correctly.
Additionally, the state income tax calculation needs to be set up so that W2 forms calculate correctly.

Nevada calculates Workers’ Compensation differently frommost states; refer to the guidelines below.

Payroll Calculation
1 In thePayroll Calculationswindow, the payroll calculation for Nevada workers' compensationmust include the
following for it to function correctly:

a In theDefault Max box, enter themaximum amount of wages. Sage 100 Contractor stops computing when the
maximum is reached.

b In theMaximum Type list, select 4-Wages/Year.

c In theState box, enter NV.

Workers’ Compensation Codes

In theWorkers’ Compensation Codeswindow, include the state abbreviationNV in theState cell for each Nevada
Workers’ Compensation Code you enter.

New Hampshire State Tax
IMPORTANT: Even though the State of New Hampshire does not have state income tax, the state income tax
calculation needs to be set up in 5-3-1. Additionally, the state income tax calculation needs to be set up so that state
wages can be tracked for other purposes.

Sage 100 Contractorstill requires amarital status on the state tax calculation. Use the status that applies to each employee
below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be computed.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married Separate Single Filing Separate

5-Married Joint Married Joint

To set up payroll calculations on an employee for New Hampshire State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.
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4 In theMarital column, in the cell of theNew Hampshire Income Tax row, enter the correspondingmarital status
number.

5 In theStd Allow column, in the cell of theNew Hampshire Income Tax row, enter the number of
exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

New Jersey State Tax
New Jersey uses five tax tables to compute the state tax withholding for residents. Tables A and B are standard although
employees can choose to use tables C, D, or E, depending on their marital status.

If you receive a New Jersey Form NJ-W4 Employee’s Withholding Allowance Certificate from an employee, youmay need
to enter a different tax table for withholding in Sage 100 Contractor.

In Sage 100 Contractor, marital status options 1-Single and 4-Married/Separate use table A and cannot use a different
table. Marital status options 2-Married, 3-Head of Household, and 5-Married Joint use table B unless a table number is
entered on the calculations tab. It is not necessary to enter a table number for employees that use the standard tables.

IMPORTANT: There is an exception. When an employee indicates amarital status option of 2-Married, 3-Head of
Household, or 5-Married/Joint in Sage 100 Contractor, the employee can select a different tax table. If the employee
meets the criteria on the NJ-W4 and indicated a table other than table B, enter the appropriate table number in the
Calculations tab.

For table Enter this

A 1

B 2

C 3

D 4

E 5

To set up payroll calculations on an employee for New Jersey State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In the Table# column, in the cell of theNew Jersey Income Tax row, enter the tax table number.

5 On themenu bar, click File, then click Save.

New Mexico State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Employees who work in New Mexico can select one of fivemarital status options. New Mexico uses the Federal W-4 form
for determining the EmployeeWithholding Allowances.
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Status Description

1-Single Single/Head of Household

2-Married Married

3-Head of Household Single/Head of Household

4-Married Separate Single/Head of Household

5-Married Joint Married

To set up payroll calculations on an employee for New Mexico State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theNew Mexico Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theNew Mexico Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

New York City and Yonkers City Tax
CAUTION: After setting up the local tax district and the associated payroll calculation, enter the local district number
in the employee files for New York City or Yonkers residents. Sage 100 Contractor will apply the non-resident rate to
all other employees working in Yonkers.

NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

While most cities use a flat tax rate, New York City and Yonkers use tax tables to determinemunicipal taxes. Companies
that operate in New York City or Yonkers can set up local payroll tax districts to compute these taxes.

To calculate the resident and non-resident taxes using the appropriate New York City or Yonkers tax table, do not enter any
tax rates in theRate columns. New York City only taxes residents, Yonkers taxes both residents and non-residents.

You do need to enter the tax state and a description. In theDescription column, indicate which tax table you want to use.
Separate from any other descriptive text, enter NYC for the New York City tax or YNK for the Yonkers tax. Be sure to
capitalize the description; otherwise, Sage 100 Contractor will not compute any taxes.

After setting up the local payroll tax, set up a payroll calculation with tax type 13-Local Income Tax and calculationmethod
17-Tables.

To set up payroll calculations on an employee for New York City/Yonkers City Tax:
1 Open 5-3-6 Local Payroll Tax.

2 In theDistrict# column, in the correct cell, enter the district number.

3 In theDistrict Name column, in the corresponding cell, enter a brief statement about the district, and then type a space.

4 If the district is for Yonkers, type YNK.

5 If the district is for New York City, type NYC.
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6 In the Tax State box, type NY.

7 On the Filemenu, click Save.

8 Open 5-3-1 Payroll Calculations.

9 Set up the associated payroll calculation.

10 Be sure to include the following in the payroll calculation:

a In the Tax Type list, click 13-Local Income Tax.

b In theCalculation Method list, click 17-Tables.

c In the Tax Locale list, click the local payroll tax district for New York City or Yonkers that you just set up.

11 On themenu bar, click File, then click Save.

New York State Tax
NOTE: Residents of the State of New York do not have to withhold New York cities local tax. Only residents of New
York City are required to withhold local New York City taxes.

Employers in the State of New York should have employees fill out the form IT_2104 EmployeeWithholding Allowance
Certificate. Employees can select from one of twomarital status options.

Status Description

1-Single Single/Head of Household

2-Married Married

3-Head of House Single/Head of Household

4-Married/Separate Single/Head of Household

5-Married/Joint Single/Head of Household

To set up payroll calculations on an employee for New York State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theNew York State Income Tax row, enter the correspondingmarital status
number.

5 In theStd Allow column, in the cell of theNew York State Income Tax row, enter the number of
exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

NOTE: Residents of the State of New York do not have to withhold New York City local tax. Only residents of New
York City are required to withhold local NYC taxes.

New York Workers' Compensation
New York calculates workers’ compensation differently frommost states. See New York workers’ compensation section
below.
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Payroll Calculation
1 In the 5-3-1 Payroll Calculationswindow, the payroll calculation for New York Workers’ Compensationmust include
the following for it to function correctly:

a In the Tax Type box, select 11-Workers’ Compensation.

b In theCalc Method list, select 17-Tables.

c In theMax Type box, select 1-Wages/Check.

d In the Tax State box, select NY.

New York workers' compensation
Sage 100 Contractor looks first to the settings in 5-2-1 Employees. If a maximum is set on the New York W/C calculation
on theCalculations tab, it uses that maximum during the compute. Otherwise, it uses themaximum setting in 5-3-2
Workers’ Compensation.

Set up the rate andmax (if any) in the workers’ compensation table for each classification. Corporate officers (or others to
whom a different wage limit for that classification applies) should have the wage limit entered in 5-2-1 Employees on the
Calculations tab in theNY Workers Comp Insurance row.

The employees must be paid weekly for the subject wagemaximums to work correctly. In 5-2-1 Employees, on the
Compensation tab, set the pay period to 1-Weekly.

Salary only employees’ payroll records need to have a timecard line with at least these three entries: Pay Type, Hours, and
Comp Code.

For theWorkers’ Compensation to calculate correctly, employees cannot jump between comp codes during a given week.

Comp codes that have aMaximummust be listed prior to comp codes that do not have aMaximum for Sage 100
Contractor to compute and report the workers’ compensation correctly.

To ensure accuracy, only one comp code with aMaximum can be used per check unless the other comp codes have an
exact matchingMaximum.

North Carolina State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Employees who work in North Carolina can select one of threemarital status options. This information is available on the
form NC-4 EmployeeWithholding Allowance Certificate.

Status Description

1-Single Single

2-Married Married

3-Head of House Head of Household

4-Married/Separate Married

5-Married/Joint Married
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To set up payroll calculations on an employee for North Carolina State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theNorth Carolina Income Tax row, enter themarital status.

5 In theStd Allow cell, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

North Dakota State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

North Dakota now uses tax tables to figure the state income tax to be withheld. Employers should obtain a Federal Form
W-4, Employee’s Withholding Allowance Certificate for each employee.

The state tax rules governingmarital status in North Dakota are as follows:

Marital Status Tax Table Used

1-Single Single (includes Head of Household)

2-Married Married

3-Head of House Single

4-Married/Separate Single

5-Married/Joint Married

To set up payroll calculations on an employee for North Dakota State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theNorth Dakota Income Tax row, enter the correspondingmarital status number.

5 On themenu bar, click File, then click Save.

Ohio State Tax
Employees should use the Ohio Form IT-4 Employee's Withholding Exemption Certificate.

There is no distinction for marital status for employees who work in Ohio.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person
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Status Description

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Ohio State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theOhio Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theOhio Income Tax row, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Ohio Workers' Compensation
Ohio calculates Workers’ Compensation differently frommost states. SeeOhioWorkers’ Compensation section below.

Payroll calculation
1 In the 5-3-1 Payroll Calculationswindow, the payroll calculation for OhioWorkers’ Compensation has to include the
following for it to function correctly:

a In the Tax Type box, select 11-Workers’ Compensation.

b In theCalc Method list, select 17-Tables.

c In theMax Type box, select 1-Wages/Check.

d In the Tax State box, select OH.

Ohio Workers’ Compensation
Sage 100 Contractor looks first to the settings in 5-2-1 Employees. If a maximum is set in the OhioW/C calculation on the
Calculations tab, it uses that maximum during the compute. Otherwise, it uses themaximum set in 5-3-2 Workers’
Compensation.

Set up the rate andmax (if any) in the workers comp table for each classification. Corporate officers (or others to whom a
different wage limit for that classification applies) should have the wage limit entered in 5-2-1 Employees on the
Calculations tab in the row you have namedOH Workers Comp Insurance.

The employees must be paid weekly for the subject wagemaximums to work correctly. In 5-2-1 Employees, on the
Compensation tab, set the pay period to 1-Weekly.

Salary only employees’ payroll records need to have a timecard line with at least these three entries: Pay Type, Hours, and
Comp code.

For theWorkers’ Compensation to calculate correctly, employees cannot jump between comp codes during a given week.
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There are occasional rounding variances both with the CompWage and CompGross on theOhioW/C report. This should
not be a problem, since on the actual report Ohio sends in to its W/C Board, the total Subject Wage is rounded to the
nearest dollar anyway.

Oklahoma State Tax
Employees must use the Federal FormW-4 Employee’s Withholding Allowance Certificate. The number of withholding
allowances claimed on the Federal W-4must be used for Oklahoma employees.

If an employee has checked the box “Married, but withhold at higher single rate” on the Federal FormW-4, use the
appropriate Oklahoma SingleWithholding Table.

Oklahoma payroll taxes are rounded to the nearest dollar.

Use one of the two tax tables, Single or Married, by selecting the appropriate marital status in Sage 100 Contractor as
follows:

Marital Status Tax Table Used

1-Single Single

2-Married Married

3-Head of Household Single

4-Married/Separate Single

5-Married/Joint Married

To set up payroll calculations on an employee for Oklahoma State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theOklahoma Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow cell, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Oregon State Tax
For records on 5-2-2 Payroll Records that have the Payroll Type of 2—Bonus, Sage 100 Contractor cal-
culates state income tax using the published flat-rate.

The state tax rules governingmarital status in Oregon are as follows:

Marital Status Allowances

1-Single Single (Less than three allowances)

2-Married Married or Single (With three or more
allowances)

To set up payroll calculations on an employee for Oregon State Tax:
1 Open 5-2-1 Employees.
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2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theOregon Income Tax row, enter themarital status.

5 On themenu bar, click File, then click Save.

Oregon State Workers' Compensation
Oregon calculates Workers’ Compensation differently frommost states.

IMPORTANT:

Set up 5-3-2 Workers’ Compensation with theEmployer
%, Employee, andEmployer Hourly rates.

Time cards must have hours on the grid even for the salaried
employees because the calculations are set up on a per
hour basis.

To set up payroll calculations for Oregon State Workers’ Compensation:
1 Open 5-3-1 Payroll Calculations.

2 Set up theEmployer %Workers’ Compensation calculation as follows:

a Tax Type: 11-Workers’ Compensation

b Calc Type: 3-Employer Cost

c Calc Method: 17-Tables

d BasedOn: 0-None

e Max Type: 0-None

3 Set up the employee hourly Workers’ Compensation payroll calculation as follows:

a Tax Type: 11-Workers’ Compensation

b Calc Type: 1-Deduct from Employee

c Calc Method: 8-Per Hour (all hours)

d BasedOn: 0-None

e Max Type: 0-None

4 Set up the employer hourly Workers’ Compensation payroll calculation as follows:

a Tax Type: 11-Workers’ Compensation

b Calc Type: 3-Employer Cost

c Calc Method: 8-Per Hour (all hours)

d BasedOn: 0-None

e Max Type: 0-None
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Pennsylvania State Tax
There is no distinction for marital status for employees who work in Pennsylvania.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Pennsylvania State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of thePennsylvania Income Tax row, enter the correspondingmarital status number.

5 On themenu bar, click File, then click Save.

Pennsylvania Local Tax Setup

Setting up local taxes for Pennsylvania
Starting January 1, 2012, Pennsylvania requires employers to withhold the higher of the employee's resident earned income
tax amount or employee's non-resident earned income tax amount, unless the tax district is Philadelphia. For more
information refer to Pennsylvania Act 32.

IMPORTANT: Salaried Employees—Time card lines are required for salaried employees unless they work in the
same district they live in. Minimum timecard lines requires four fields to be filled in to function as expected: Locale,
Pay Type, Hours, andComp Code.

Act 32 Definitions

Act 32 reduces Pennsylvania’s number of Earned Income Tax (EIT) collectors from 560 to 21. The appointment of
collection responsibility falls on countywide committees made up of representatives from local municipalities and school
districts. The committees established tax collection districts and elected tax officers to collect the EIT. Act 32 requires
uniform withholding of earned income taxes and remittance to a single local collector or Tax Officer.

a. All employers, located in Pennsylvania, must withhold the non-resident tax rate for employees living outside of
Pennsylvania, if one exists.

b. For employees living within Pennsylvania, the employer is required to withhold at the higher rate of either the
employee’s resident rate or the non-resident rate in which the employer (job) is located.

http://www.newpa.com/node/6711
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c. Employers located in political subdivisions who do not have a tax in place will be required to withhold taxes for all
employees who are residents of Pennsylvania who have a resident tax for the locality in which they live and remit
them to the Tax Officer.

d. Philadelphia has special rules.

5-3-6 Local Payroll Tax Setup

IMPORTANT: Do not set up combined Local Payroll Tax Districts. Pennsylvania cannot use combined localities.
Separate Local Payroll Tax Districts must exist for each tax collection district where your employees reside or work.
You can use your existing Pennsylvania Local Payroll Tax Districts provided they have not been set up as combined
Local Payroll Tax items. If you have set up combined Pennsylvania Local Payroll Tax Districts, youmust create a
separate Local Payroll Tax District for each tax collection district where your employees reside or work.

Follow the steps below to set up the Local Payroll Tax Districts.

1. Open 5-3-6 Local Payroll Tax.

2. In theDistrict# cell, enter a district number for the locale.

IMPORTANT: For the city of Philadelphia, enter 510101 to theDistrict# cell. Sage 100 Contractor uses this
number as an identifier for the City of Philadelphia local tax district.

3. In theDistrict Name cell, enter a description of the district.

4. In theResident Rate cell, enter the rate paid by residents.

5. In theNon-resident Rate cell, enter the rate paid by non-residents.

IMPORTANT: If the district does not make a distinction between residents and non-residents, enter the same
rate in theResident Rate andNon-resident Rate cells.

6. In the Tax State cell, enterPA for the state abbreviation.

7. Repeat steps 2–6 for each tax district.

8. On the Filemenu, click Save.

9. Set up the 5-3-1 Payroll Calculation for each district created.

5-3-1 Payroll Calculation Setup

A separate 5-3-1 Payroll Calculationmust exist for each Local Payroll Tax district that your employees reside or work in.

Follow the steps below to set up a Payroll Calculation for a local payroll tax district.

1. Open 5-3-1 Payroll Calculations.

2. In the data control box, enter the record number you want to assign to the new calculation.

3. In theDescription box, enter a brief statement about the calculation.

4. In the Tax Type list, click 13-Local Income Tax.

5. In theCalculation Method list, select 17-Tables. The payroll calculation uses the rates from 5-3-6 Local Payroll
Taxes.

6. In the Tax Locale drop-down box, select the Local Payroll Tax district that this calculation is for.

7. In theCredit Acct cell, enter the ledger account that you want to credit.

8. On the Filemenu, click Save.
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5-2-1 Employee Setup

Complete the following steps for each employee.

1. Open 5-2-1 Employees.

2. In the data control text box, enter the employee record number.

3. In thePayroll Locale field, select the appropriate local payroll tax item for the district the employee resides in.
Leave this field blank if no tax district applies to the employee's residence.

4. On the Filemenu, click Save.

3-5 Job Setup

Complete the following steps if:

a. Your company is not based in Pennsylvania but the Job is in a Pennsylvania tax collection district and you are
required to withhold the local tax.

OR

b. Your company is based in Pennsylvania and the Job tax collection district should be withheld instead of the tax
district your company is based in.

1. Open 3-5 Jobs (Accounts Receivable)

2. In the data control text box, enter the job number.

3. If the job is in a local payroll tax district, select the correct district in thePayroll Locale text box.

4. On the Filemenu, click Save.

How Pennsylvania Local Taxes will Calculate

1. An employee resides in a Pennsylvania tax district but works outside of Pennsylvania:
Resident Pennsylvania tax will be calculated for the locality in the employee record.

2. An employee works in a Pennsylvania tax district but does not reside in Pennsylvania:
Non-residence Pennsylvania tax will be calculated for the locality on the time card line.

3. An employee lives in a Pennsylvania tax district (not Philadelphia) and works in the same Pennsylvania
tax district (not Philadelphia):
Resident Pennsylvania locality tax will be calculated since the employee works in the same district as they live.

4. An employee works in a Pennsylvania tax district (not Philadelphia) and resides in another Pennsylvania
tax district (not Philadelphia):
The higher of the two rates is used, the non-resident Rate of the local tax district associated with the timecard line
OR the resident rate associated with the employee. The amount is associated and paid to the district they work in.

5. An employee works in Philadelphia and resides in Pennsylvania (not Philadelphia):
The non-resident Philadelphia tax will calculate.

6. An employee works Pennsylvania (not Philadelphia) and resides in Philadelphia:
The resident Philadelphia tax will calculate.

7. An employee works in Philadelphia and resides in Philadelphia.:
The resident Philadelphia tax will calculate.

8. An employee lives in Philadelphia and works in another state.:
The resident Philadelphia tax will calculate.

No Localities entered on Timecard Lines
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If no localities are entered on the timecard lines for records with timecard lines or for salaried records, local tax will calculate
using the resident rate that is on the 5-2-1 Employees record. This is the same for records with or without timecard lines.

Pennsylvania State Tax Setup

Puerto Rico Income Tax
Employees should use thePuerto Rico 499R-4.1 Withholding Exemption Certificate.

Marital Status Allowances

1-Single Individual Taxpayer and claims all of the personal exemption

2-Married Married Person filing jointly and claiming all of the personal exemption for withholding purposes

3-Head of
Household

Married Person filing jointly and claiming half of the personal exemption for withholding purposes or
Married Person living with spouse, who chooses the optional computation of tax and claims all of the
personal exemption for withholding

4-
Married/Separate

Married Person filing jointly and claiming half of the personal exemption for withholding purposes or
Married Person living with spouse, who chooses the optional computation of tax and claims all of the
personal exemption for withholding

5-Married/Joint Person claiming none of the personal exemption for withholding

To set up payroll calculations on an employee for Puerto Rico Income Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of thePuerto Rico Income Tax row, enter themarital status.

5 In theStd Allow cell enter the number of dependents claimed.

6 In theAdd Allow cell of thePuerto Rico Income Tax row, enter the number for eachAllowance Based on
Deductions from theWithholding Exemption Certificate Form 499 R4.1.

7 On themenu bar, click File, then click Save.

NOTES:
l If choosing the Optional Computation of Tax in the case of married individuals (Marital Status 2) living together

and filing a joint return, enter 1 in the Table# cell of the Puerto Rico Income Tax row.

l If claiming the Special Deduction for Certain Individuals on theWithholding Exemption Certificate Form
499 R-4.1, enter 2 in the Table# cell of the Puerto Rico Income Tax row.

l If both the Optional Computation of Tax and the Special Deduction for Certain Individuals are selected on the
Withholding Exemption Certificate Form 499 R4.1, enter 3 in the Table# cell of the Puerto Rico Income
Tax row.

l Veterans that qualify should add 3 allowances to the number of total allowances claimed on the Add Allow cell
of the Puerto Rico Income Tax row. This will provide them the equivalent value of adding one additional
personal exemption for Veterans or 1,500 annually.
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Rhode Island State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

The employer should rely on the federal withholding exemption certificate (Federal Form W-4).

Rhode Island does not require employers to obtain a separate certificate showing the number of dependents or other
personal exemptions claimed by an employee.

Marital Status Allowances

1-Single Single/Head of Household

2-Married Married

3-Head of Household Single/Head of Household

4-Married/Separate Single/Head of Household

5-Married/Joint Married

To set up payroll calculations on an employee for Rhode Island State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theRhode Island Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow cell enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

South Carolina State Tax
Use the “W-4 Personal AllowanceWorksheet” to record personal exemptions.

Standard deduction amounts will automatically be calculated from the number of personal exemptions claimed.

There is no distinctionmade for marital status for South Carolina.

The results are rounded to the nearest dollar.

To set up payroll calculations on an employee for South Carolina State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 Type the Line 5 information from theW-4 into the South CarolinaStd Allow box.

5 Type the Line 6 information from theW-4 into theAdd W/H box.

6 On themenu bar, click File, then click Save.
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South Dakota State Tax
IMPORTANT:

Even though the State of South Dakota does not have state income tax, the state income tax calculation needs to be set up
in the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax calculation needs to be set up so that state
wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be
computed.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for South Dakota State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theSouth Dakota Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theSouth Dakota Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Tennessee State Tax
IMPORTANT:

Even though the State of Tennessee does not have state income tax, the state income tax calculation needs to be set up in
the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax calculation needs to be set up so that state
wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be
computed.

Status Description

1-Single Single Person

2-Married Married
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Status Description

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Two Incomes

To set up payroll calculations on an employee Tennessee State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Tennessee Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of the Tennessee Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Texas State Tax
IMPORTANT: Even though the State of Texas does not have state income tax, the state income tax calculation
needs to be set up in the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax calculation needs to
be set up so that state wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be
computed.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Texas State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of the Texas Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of the Texas Income Tax row, enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.
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Utah State Tax
The state tax rules governingmarital status in Utah are as follows:

Marital Status Tax Table Used

1-Single Single

2-Married Married

Head of House Single

Married/Separated Single

Married/Joint Single

To set up payroll calculations on an employee for Utah State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theUtah Income Tax row, enter themarital status.

5 In theStd Allow cell, enter the number of exemptions/allowances claimed.

6 On the Filemenu, click Save.

7 On themenu bar, click File, then click Save.

Utah Workers' Compensation
Based on changes to UtahWorkers’ Compensation rules for all policies written or renewed after June 1, 2008, overtime pay
will be excluded from payroll calculations. To accommodate the changes, a new menu option has been added to the 5-3-2
Workers’ Compensation window.

The program enables the option, Calculation for Utah excludes extra pay for overtime, if these conditions aremet:

l You have logged in to the company as the supervisor user

l At least one line in the 5-3-2 Workers' Compensation grid has UT in the State column and the 5-3-2 Workers'
Compensation record has been saved.

IMPORTANT:

The option is by default not selected. To start excluding the
extra pay subject to workers' compensation, you have to
select the option.

Because this option should only need to be changed one
time, only the Supervisor user canmake this change.

When computing payroll for UtahWorkers’ Compensation, the program looks at the value of this option. If it is not selected,
theWorkers’ Compensation forUT is calculated as it has been calculated previously; all overtime and premium wages are



- 841 -

included in the pay that’s subject toWorkers’ Compensation. If the option is selected, then the overtime differential is
subtracted from pay that is subject toWorkers’ Compensation.

Under the oldmethod (the option is not selected), we recommend that you use the Utah-specific Workers’ Compensation
report 5-1-5-93 Worker’s Comp Report~Utah. When you switch over to the new method (the option is selected),
Calculations for Utah excludes extra pay for the overtime differential, you should consider using the 5-1-5-21
Worker’s Comp report because it includes more information.

This link is provided for reference only. Sage 100 Con-
tractor is not responsible for the content of external
Web sites.

Vermont State Tax
NOTE: For records on 5-2-2 Payroll Records that have thePayroll Type of 2—Bonus, Sage 100 Contractor
calculates state income tax using the published flat-rate.

Employees who work in Vermont can select one of twomarital status options. Employees should use theW-4VT
Employee’s Withholding Allowance Certificate if withholding is to be based onW-4 information which is different from the
Federal W-4.

Status Description

1-Single Single

2-Married Married

3-Head of House Single

4-Married/Separate Single

5-Married/Joint Married

To set up payroll calculations on an employee for Vermont State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theVermont Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theVermont Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Virginia State Tax
Employees should use the Virginia Form VA-4 Employee's Withholding Exemption Certificate.

There is no distinction for marital status for employees who work in Virginia.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The status has no affect on the amount of state withholding.
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Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Virginia State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theVirginia Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theVirginia Income Tax row, enter the number of exemptions/allowances
claimed.

6 In theAdd Allow column, in the cell of theVirginia Income Tax row, enter the number of Exemptions for Age or
Blindness claimed from Virginia Form VA-4.

7 On themenu bar, click File, then click Save.

Washington State Tax
IMPORTANT: Even though the State of Washington does not have state income tax, the state income tax
calculation needs to be set up in the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax
calculation needs to be set up so that state wages can be tracked for other purposes.

Sage 100 Contractor requires amarital status on the state tax calculation. Use the status that applies to each employee
below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be computed.

Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Washington State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theWashington Income Tax row, enter the correspondingmarital status number.
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5 In theStd Allow column, in the cell of theWashington Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Washington State Workers' Compensation
Washington calculates Workers’ Compensation differently frommost states.

IMPORTANT:

Set up 5-3-2 Workers’ Compensation with Employee and Employer Hourly rates. You do not need to use the column for
Employer %.

Time cards must have hours on the grid even for the salaried employees because the calculations are set up on a per hour
basis.

To set up payroll calculations for Washington State Workers’ Compensation:
1 Open 5-3-1 Payroll Calculations.

2 Set up the employee hourly Workers’ Compensation payroll calculation as follows:

a Tax Type: 11-Workers’ Compensation

b Calc Type: 1-Deduct from Employee

c Calc Method: 8-Per Hour (all hours)

d BasedOn: 0-None

e Max Type: 0-None

3 Set up the employer hourly Workers’ Compensation payroll calculation as follows:

a Tax Type: 11-Workers’ Compensation

b Calc Type: 3-Employer Cost

c Calc Method: 8-Per Hour (all hours)

d BasedOn: 0-None

e Max Type: 0-None

West Virginia State Tax
Employees who work inWest Virginia can select from the followingmarital status options. This information is available on
the formWV/IT-104 “Employee’s Withholding Allowance Certificate.”

Single andMarried use the same tax table, except when using the new “two earner percentagemethod,” as follows:

Status Description

1-Single Single/Married

2-Married Married with two incomes

3-Head of Household Single/Married

4-Married/Separate Single/Married (Married with one income)

5-Married/Joint Married with two incomes
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To set up payroll calculations on an employee for West Virginia State Tax:
1 pen 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital cell of theWest Virginia Income Tax row, enter the employee's marital status.

5 In theStd Allow cell enter the number of exemptions/allowances claimed.

6 On themenu bar, click File, then click Save.

Wisconsin State Tax
Employees who work inWisconsin can select from the followingmarital status options.

Status Description

1-Single Single

2-Married Married

3-Head of Household Single

4-Married/Separate Single

5-Married/Joint Single

To set up payroll calculations on an employee for Wisconsin State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theWisconsin Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theWisconsin Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.

Wyoming State Tax
IMPORTANT:

Even though the State of Wyoming does not have state income tax, the state income tax calculation needs to be set up in
the 5-3-1 Payroll Calculationswindow. Additionally, the state income tax calculation needs to be set up so that state
wages can be tracked for other purposes.

Sage 100 Contractor still requires amarital status on the state tax calculation. Use the status that applies to each
employee below. The statemarital status has no affect on the amount of state withholding, and no state taxes will be
computed.
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Status Description

1-Single Single Person

2-Married Married

3-Head of Household Head of Household

4-Married/Separate Married Filing Separate

5-Married/Joint Married Joint

To set up payroll calculations on an employee for Wyoming State Tax:
1 Open 5-2-1 Employees.

2 Using the data control, select the employee.

3 Click theCalculations tab.

4 In theMarital column, in the cell of theWyoming Income Tax row, enter the correspondingmarital status number.

5 In theStd Allow column, in the cell of theWyoming Income Tax row, enter the number of exemptions/allowances
claimed.

6 On themenu bar, click File, then click Save.
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Appendix E-Transaction Sources
About transaction sources
When you journalize a transaction, its source is recorded. You can use the transaction source to determine where a record
was originally entered.

Transaction sources by menu

Number Transaction Source

1 1-1 Checks/Bank Charges

2 1-2 Deposits/Interest

3 1-3 Journal Transactions

4 1-4 Recurring Transactions

5 3-2 Receivable Invoices/Credits

6 3-11 Recurring Receivables

7 3-7 Progress Billing

8 3-9 Unitary Billing

9 3-10-4 Post T&M Invoices

10 3-3-1 Cash Receipts

11 4-2 Payable Invoices/Credits

12 4-6 Recurring Payables

13 12-4 PurchaseOrder Receipts

14 4-3-2 Payable Checks

15 4-3-2 Payable Vouchers

16 5-2-6 Post Payroll

17 5-2-6 Post Payroll—Summary

18 5-5-1 Daily Payroll

19 8-4 Equipment Allocation

20 8-5 Equipment Payments

21 8-6 Equipment Depreciation

22 11-2 Service Invoices/Credits
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Number Transaction Source

23 12-2 Inventory Allocation

24 12-5 Inventory Audit (or possibly 4-2 Payable
Invoices/Credits or 11-2Work Orders/Invoices/Credits)

25 4-3-2 Payable Credit Cards

26 4-7-3 Enter Credit Card Receipts

27 4-7-4 Enter Recurring Charges

28 4-7-6 Pay Credit Cards

29 4-3-2 Payable Direct Deposit

30 3-3-2 Electronic Receipts

31 6-3 Job Costs

32 8-2 Equipment Costs

33 8-7 Equipment Revenue
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Appendix F: Sage 100 Contractor API
About the Sage 100 Contractor API Administration window
The Sage 100 Contractor API Administration window displays several areas, buttons, andmenu items.

l API Status area—Displays whether the API is Not Accepting Requests or is Accepting Requests. Before the
API can accept requests, it must be initialized. Clicking [Start] initializes the API.

l Configuration area - Three configurations that are controlled by MB Data Drive.

By default, the API is set to your local drive, for example, C: . The API accesses company data on that drive.

When you click the drop-down arrow, you see a list of mapped drives. If you select one of these drives, the API accesses a
company database on that drive.

CAUTION: You can specify only one drive, mapped drive, or network location for the company databases.

l File > Logging—When this command is selected, (check-mark indicator) the API creates anmbapi.log file in the
\MB7\Programs folder. It logs instances of:

l Database table locking

l Failure to request or check in a license use

l File > Exit—Exit the program.

l Edit > Security—Opens Sage 100 Contractor API Security Settingwindow where you select the objects you
want to be available for API applications.

l Help > About the API version.

API installation and company access
The Sage 100 Contractor and the API component are installed on the same computer and drive automatically. During
installation, a shortcut for the API is placed in theWindows Start > Programs list underSage 100 Contractor > Sage 100
Contractor API.

The Sage 100 Contractor application program interface (API) allows you to use third-party programs to perform the same
tasks that you would perform when using different Sage 100 Contractor windows as a typical user. The API allows the
third-party program to insert, as well as delete, modify, or retrieve data from one or more existing Sage 100 Contractor
company databases.

IMPORTANT: Using the Sage 100 Contractor API to access Sage 100 Contractor company data requires a license
use. That is why youmust set up an API security group using 7-3-1 Security Groups. Then you have to assign a user
to the API security group using 7-3-2 User List.

When you are using the API to access Sage 100 Contractor company data, the Sage 100 Contractor program does not
have to be running. The API simply needs some of its files. Similarly, if the target company databases are on another
system connected to your system via a network connection, Sage 100 Contractor need not be present or running on those
remote systems, although it can be.
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You have to perform several steps in the other program before you can import and export data between programs using the
API. For example, youmay have to:

l Specify a job cost interface type for databases and/or estimates files as Sage 100 Contractor

l Identify a specific Sage 100 Contractor company

l Enter a user name

l Enter a password

Configuring the API security settings
By default, the API service has all Sage 100 Contractor object types disabled. You need to launch the API Administration
window and select the objects that you want to enable for SDK access. A good general policy is to be as restrictive as
possible.

The selections are specific to themachine that you are configuring. The settings will be the same for all company
databases that are accessed via the API Administration window.

To configure the API service:
1 Launch the Sage 100 Contractor API.

2 On theSage 100 Contractor API Administration window, from the Edit menu, click Security.

3 On theSage 100 Contractor API Security Settingswindow, select the Sage 100 Contractor objects to which you want
to allow access.

4 Click Save Settings.

IMPORTANT: While a Sage 100 Contractor customer is actively configuring the security settings for objects that
can be accessed by the API, no requests can be processed by the API program.

Notice that this settingmerely enables access at the API service-level. That is, it does not override any security settings in
Sage 100 Contractor itself. Any form-level, field-level, or user-level restrictions set there will still be in effect.

This configuration enables the selected objects at the API service. Youmust also activate SDK access at Sage 100
Contractor as described in the next section.

Notice that these instructions are provided to help you configure your system during development and testing. You cannot
enforce any particular settings at your customer’s installation, but must inform the customer which settings are required.

For complete information about configuring the API Service, see theSage 100 Contractor SDK Developer Guide. For more
information about joining the Sage 100 Contractor Developer Network Program, browse to this link:

http://na.sage.com/sage-construction-and-real-estate/resources/development-partner-locator

Launching the API and starting the API service
CAUTION: You can specify only one drive/mapped drive, or network location for the company databases.

The first time you launch the API Administration program, it registers itself in theWindows registry.

Youmust launch the API Administration program and start the servicemanually in order for requests from the program to be
processed.

http://na.sage.com/sage-construction-and-real-estate/resources/development-partner-locator
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To launch API and start the API service:
1 UsingWindows Explorer, locate and double-click [Installation Drive]:\MB7\Programs\MBAPI.exewhere [Installation
Drive] is the drive on which you installed the application programming interface (API).

2 TheSage 100 Contractor API Administration window appears.

3 By default, Sage 100 Contractor expects the company databases to be on drive C. If the company databases are on
another hard drive or mapped network drive, click the drop-down list button for theMB Data Drive text box and select the
appropriate drive.

4 Click Start to start theAPI service.

5 If you have not already configured the API security settings, do so now. By default, API access to Sage 100 Contractor
objects is disabled until you configure the API security settings.

IMPORTANT:

l By default, API access to Sage 100 Contractor objects is disabled until you configure the program.

l “Service” in the Sage 100 Contractor API does not mean the same thing as it did inWindows XP Professional
system service.

States of the API
There are three distinct states of the API:

l The API has not been launched.

l The API has been launched, but the API service has not started.

l The API has been launched and the API service has been started.

In the first case, if the application tries to access the API, an error message will be returned to the application stating that
there has been an automation error.

In the second case, if the application tries to access the API, an error message will be returned to the application stating
that it is not accepting requests.

IMPORTANT:

l By default, API access to Sage 100 Contractor objects is disabled until you configure the program.

l “Service” in the Sage 100 Contractor API does not mean the same thing as it did inWindows XP Professional
system service.

System requirements for Sage 100 Contractor API
If you are using the Sage 100 Contractor API, theminimum and recommended system requirements may vary. These
requirements must be considered in addition to the recommended system requirements for running Sage 100 Contractor.

It may be necessary to increase the processor speed, memory and/or disk space of your system depending upon the
requirements of the third-party application using the API. Please consult with your third-party vendor to determine what
changes, if any, should bemade to your hardware configuration in order to meet your desired performance criteria.
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Appendix G: System Requirements and
Configuration
This section provides information about system requirements along with general and specific configuration options.

More information about system requirements and configuration is available in theSage 100 Contractor Installation and
License Administration Guide.

Configuring Windows Regional and Short Date Format:
1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select English (United States).

4. UnderDate and time formats, from the Short date format drop-down list, selectMM/dd/yyyy

5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Hardware Requirements
This section provides information about system requirements along with general and specific configuration options.

More information about system requirements and configuration is available in theSage 100 Contractor Installation and
License Administration Guide.

Server hardware specifications
We cannot recommend server hardware specifications for your network, as this depends on your specific requirements,
such as the number of users on your network, or other programs that might use server resources, such as firewalls,
software applications, mail systems, and so forth. We can, however, recommend a set of minimum hardware
requirements.

NOTE: When you have a network with three or more users, a dedicated file server increases performance and
reliability.

With any computer system, there is the possibility for failure and loss of data.

CAUTION: Use a backupmethod and device suitable for your business requirements. We strongly recommend that
youmaintain a routine backup schedule and store your data in a safe environment that is separate from your server,
preferably off site.

Server hardware requirements
The following table shows the operating systems that are supported for the server computers running Sage 100 Contractor.
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NOTE: Theminimum processor requirements for servers listed in the table below are based on theMicrosoft®
Windows® Server 2003® operating system family. When updating or purchasing servers running newer operating
systems such as Windows Server 2012 Standard, Windows Server 2012 Essential, Windows Server 2008®, Small
Business Server® 2008, and Server 2008 R2 Standard, we recommend that you also refer to Microsoft system
requirements.

Server Hardware Minimum Recommended

Processor Intel® Pentium® 4 or comparable, 1 GHz Intel®Dual Core/Quad Core™ or comparable, 2 GHz+

RAM 2GB 4GB+

Free Disk Space 10GB 40GB+

DVD-ROMDrive DVD-ROMDrive DVD-ROMDrive

Printers For highest quality printing, we recommend laser or inkjet printers.

IMPORTANT: Theseminimum recommendations include the 600MB required for runningMicrosoft .NET
Framework 4.0 software. The recommended free disk space is based on the installation of a single program and the
average size of a Sage 100 Contractor company database. Allow at least 50MB for each additional company
database that you create.

Client and workstation hardware requirements
The following table shows the hardware requirements for client and workstation computers running Sage 100 Contractor.

Hardware Minimum Recommended

Vista/Windows 7/Windows 8 processor 1 GHz 2GHz+

RAM (except Vista/Windows 7/Windows 8) 1GB 2GB+

Vista/Windows 7/Windows 8 workstation RAM 2GB 4GB+

Free Disk Space 16GB 20GB+

CD-ROMDrive 2X CD-ROM DVD-ROM

Printers For highest quality printing, we recommend laser or inkjet printers.

NOTE: Theseminimum recommendations include the 600MB required for runningMicrosoft .NET Framework 4.0 on
client workstations. The recommended free disk space is based on the installation of a single program and the
average size of a Sage 100 Contractor company database. Allow at least 50MB for each additional company
database that you create.

Operating Systems Requirements

Operating systems
Use one of the supported operating systems below for a smooth and successful installation experience.
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Supported Operating Systems

Server Operating Systems

Microsoft Windows Server 2012 Standard

Microsoft Windows Server 2012 Essentials

Microsoft Windows Small Business Server 2011 Standard

Microsoft Windows Server 2008 R2 Standard

Microsoft Windows Small Business Server 2008

Microsoft Windows Server 2008

Client/Workstation Operating Systems

Microsoft Windows 8 Professional

Microsoft Windows 8 Enterprise

Microsoft Windows 7 Professional

Microsoft Windows 7 Ultimate

Microsoft Windows Vista Business

Unsupported Operating Systems

NOTE: Sage 100 Contractor and/or its components do not run on or do not support some operating systems. Do not
install Sage 100 Contractor to computers running theseMicrosoft Windows operating systems:

l Apple operating system, any version

l Microsoft Windows 95

l Microsoft Windows 98

l Microsoft Windows NT Server

l Microsoft Windows NTWorkstation

l Microsoft Windows 2000

l Microsoft Windows 2000 Server

l Microsoft Windows 2003 Server

l Microsoft Windows XP Professional (32-bit and 64-bit editions)

l Microsoft Windows XP Home

l Microsoft Windows Vista Home Basic

l Microsoft Windows Vista Home Premium
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IMPORTANT: Microsoft .NET Framework 4must be installed to all computers running Sage 100 Contractor and
License Administration. During installation, bothMicrosoft .NET Framework 3.5 Service Pack 1 andMicrosoft
.NET Framework 4 are installed on your computer automatically if they are not already installed. Be sure that all server
and client computers meet both .NET Framework requirements and Sage 100 Contractor requirements.

Supported Web Browsers
Sage 100 Contractor supports Internet Explorer 9 and later.

Network Configuration Requirements

Server network configuration requirements
The following table shows the server network configuration requirements for server computers running Sage 100
Contractor.

IMPORTANT: Youmust allow HTTPS outgoing traffic on port 443 to the outside Internet. This is a requirement of the
licensing and entitlement service and for Sage Construction Anywhere connectivity.

Process Required

Network Protocol TCP/IP

Minimum Network Speed—LAN 10/100/1000Mbps

Minimum Network Speed—WAN +/- 1.5Mbps receiving data (downstream)
+/- 384 Kbps sending data (upstream)

NOTE: Sage 100 Contractor typically runs in a local area network (LAN) environment. Sage 100 Contractor can run in
a wide area network (WAN) using Citrix or Terminal Services. Contact your Sage business partner for more
information.

CAUTION: We recommend that you do not attempt to run Sage 100 Contractor over a wireless network.

Client and workstation network configuration
The following table shows the server network configuration requirements for client and workstation computers running Sage
100 Contractor.

IMPORTANT: The Sage 100 Contractor Hosting Framework servicemust be unblocked from accessing incoming
connections. This is done automatically when using theWindows Firewall, but other firewalls running on the server
may require additional configuration.

Process Required

Network Protocol TCP/IP

Minimum Network Speed—LAN 10/100/1000Mbps

Minimum Network Speed—WAN 128 Kbps Broadband

NOTE: For information about running Sage 100 Contractor in a wide area network (WAN) using Citrix and Terminal
Services, contact your business partner.
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CAUTION: We recommend that you do not attempt to run Sage 100 Contractor over a wireless network.

Microsoft .NET Framework 4.0 Requirements

About installation and Microsoft .NET Framework
When you install Sage 100 Contractor software, you will also install theMicrosoft .NET Framework 4.0, if it is not already
installed. It is important that youmake sure that both your client and server computers meet theminimum requirements for
installing both Sage 100 Contractor software andMicrosoft .NET Framework 4.0.

IMPORTANT: If the Sage 100 Contractor installation requires an installation of Microsoft .NET Framework 4.0, the
Sage 100 Contractor installation process may continue automatically after the .NET Framework installation is
completed. If you are prompted to restart your computer after the .NET Framework installation, however, youmust do
it to continue the Sage 100 Contractor installation.

About installing .NET Framework 4.0 and Operating Systems

NOTE: If Microsoft .NET Framework 4.0 is not already installed on your computers, that installation alonemay take
up to 20 minutes per computer.

The following operating systems are supported for .NET Framework 4.0:

Server Operating Systems

Microsoft Windows Server 2012 Standard

Microsoft Windows Server 2012 Essentials

Microsoft Windows Small Business Server 2011®

Microsoft Windows Server 2008 Standard Edition

Microsoft Windows 2008® Small Business Server

Microsoft Windows Server 2008®R2Standard Edition

Client/Workstation Operating Systems

Microsoft Windows 8 Professional

Microsoft Windows 8 Enterprise

Microsoft Windows 7 Professional

Microsoft Windows 7 Ultimate

Microsoft Windows Vista Business

Viewing and verifying system information
ForWindows Vista, Windows 7, andWindows 8, useMSinfo32.exe to open theSystem Informationwindow to view your
system information.
To view and verify system information on Windows Vista, Windows 7, and Windows 8:
1 Click [Start], then type [Run].
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2 The [Run] dialog box opens.

3 In the [Open] text box, typeMSinfo32.exe, and then press the Enter key.

TheSystem Information window opens displaying a list of your system information.

.NET Framework Requirements for Server Computers
Minimum requirements for Microsoft .NET Framework 4.0 on servers

Component Required

Hard disk space at installation 800MB

Video card 800x600, 256 colors

.NET Requirements for Client Computers
Minimum requirements for the Microsoft .NET Framework 4.0 on clients

Component Required

Hard disk space at installation 600MB

Video card 800x600, 256 colors

Verifying that Microsoft Internet Explorer 6.0 Service Pack 1 is installed

Youmust haveMicrosoft Internet Explorer 6.0 Service Pack 1 installed to client computers to meet minimum requirements
for running Sage 100 Contractor software. This is also a requirement for Microsoft .NET Framework 3.5 Service Pack 1.

To verify that Microsoft Internet Explorer 6.0 Service Pack 1 is installed:

1 Launch Internet Explorer.

2 On the Internet ExplorerHelpmenu, click [About].

3 In theAbout Internet Explorer dialog box, verify that the version number is 6.0 Service Pack 1 or later, and then click
[OK].

NOTE: To download Service Pack 1 for of Microsoft Internet Explorer 6.0, visit the followingMicrosoft Web site:
http://www.microsoft.com/windows/ie/ie6/downloads/critical/ie6sp1/default.mspx

Verifying that Microsoft Windows Installer 3.1 or higher is installed

Sage 100 Contractor and the License Administration Tool require Microsoft .NET Framework 3.5 Service Pack 1 to run.
Microsoft .NET Framework 3.5 Service Pack 1 requires theWindows Installer 3.1 to be installed. When you install Sage
100 Contractor software, you will also install theWindows Installer 3.1 automatically, if it is not already installed. Many
newer operating systems are integrated withWindows Installer 3.1 already.

To verify that Microsoft Windows Installer 3.1 is installed on earlier operating systems:

1. Click Start, and then click Run.

2. In theOpen text box, typemsiexec /?, and then press Enter or click OK.

3. In theWindows Installer dialog box, verify that the version number is 3.1, and then click OK.

http://www.microsoft.com/windows/ie/ie6/downloads/critical/ie6sp1/default.mspx
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Special Configurations—Operating Systems and Services

Network Configuration and Licensing
About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations
can potentially disable the communication:

l File sharing on computers running theWindows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012
operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on the local
computer.

l Software firewalls running on the local computer can be configured to block processes from opening TCP ports,
which will prevent communication through the TCP Remoting Channel.

Configuring Sage 100 Contractor Hosting Framework TCP port number

By default, Sage 100 Contractor uses the TCP starting port number 48750. This number can be configured using an XML
file, Sage.CRE.HostingFramework.Service-InstanceConfig.xml, located under: Programs (x86)\Sage\Sage
100 Contractor.

If you need to change the default port numbers for the Sage 100 Contractor Hosting Framework using the
Sage.CRE.HostingFramework.Service-InstanceConfig.xml file, youmust change it on every computer on the network
where Sage 100 Contractor is installed. In addition, after making this change, the Sage 100 Contractor Hosting Framework
on each computer running Sage 100 Contractor must be restarted.

NOTE: Consult with your IT administrator for alternative port numbers.

To change the port numbers:

1 InWindow Explorer, locate the Sage.CRE.HostingFramework.Service-InstanceConfig.xml under this path:
Programs (x86)\Sage\Sage 100 Contractor.

2 Right-click Sage.CRE.HostingFramework.Service-InstanceConfig.xml, and open it with a text editor, such as Notepad.

3 Near the end of the file between the <StartingPort> </StartingPort> tags, locate the port number and change it.

4 Save and close the file.

5 Repeat steps 1-4 on every computer running Sage 100 Contractor.

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured automatically to
allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you
may need tomanually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100 Contractor
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party
firewall products.
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To configure the Windows Firewall:

1. ForWindows Vista or Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security

ForWindows 8, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selectingAdd Program, then
browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. You can refine this setting
by selecting theChange Scope button. Be aware that restricting the scope incorrectly can cause the computer to be
unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor
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l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor
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l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011, 2012

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data
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Windows 8 Professional and Server 2012 Standard Operating Systems
Windows 8 Professional and Server 2012 Standard "Sleep Mode" prevents computers from
obtaining a license use

If a computer running theWindows 8 Professional or Server 2012 Standard operating system is used as a license server,
when it goes into sleepmode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > All apps > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8 Professional orWindows 8 Enterprise operating systems. If the service stops, the program displays amessage
advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file

If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2012, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click the [Security] tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2012 operating systemmust be
enabled. To enable file sharing, follow the instructions in theWindows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems
Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard "Sleep Mode"
prevents computers from obtaining a license use

If a computer running theWindows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a
license server, when it goes into sleepmode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer toNever.
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To set the Sleep Mode to “Never”:

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 7
Professional and Server 2008 R2 Standard

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 7 Professional or Server 2008 R2 Standard operating systems. If the service stops, the program displays a
message advising you to take further action to resolve this issue.

Solution for Server 2008 R2 error message about mb7.kpr file

If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2008 R2, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2008 R2 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2008 R2 operating systemmust
be enabled. To enable file sharing, follow the instructions in theWindows Server 2008 R2Help.

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license use

If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the workstations
cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in
place of Vista or Server 2008.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to "Never":

1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.

3 From thePut computer to sleep list, select Never.



- 865 -

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Vista, Windows 7,
Windows 8, or Server 2008

IMPORTANT: Read this information if you are running Vista or Server 2008 operating systems on your office
computers.

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Vista,
Windows 7, Windows 8, or Server 2008 operating systems. If the service stops, the program displays amessage advising
you to take further action to resolve this issue.

Solution for Server 2008 error message about mb7.kpr file

If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2008, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click the [Security] tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Vista, Windows 7, and Server 2008 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File sharing on computers running the Vista, Windows 7, or Server 2008 operating system
must be enabled. To enable file sharing, follow the instructions in the Vista, Windows 7, or Server 2008 Help.

Vista, Windows 7, and Server 2008 and changing the Sage License Server computer

On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the commandmay fail to generate a list of network computer
names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the
server computer in the box.

Windows Server 2008 R2 and Microsoft .NET 3.5.1

Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows Server 2008 R2
machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it
automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the followingmessage during the
licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you click [OK], the installation
continues, but the services have not been installed so Sage 100 Contractor cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above
message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1 Click theStart button in the lower left corner of the display.

2 Highlight Administrative Tools and select Server Manager.
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3 In theServer Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that
.NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click [Install].

5 Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.

Citrix and Terminal Servers
Using Citrix and Terminal Server with Sage 100 Contractor

Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If Sage 100
Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, then youmay log on to the
computer running Citrix or Terminal Server with your laptop and work in Sage 100 Contractor on your LAN. This enables
you to work from home, from a job site, or from any number of other remote locations.

We recommend that you use DOS commands to change the operatingmode from “execute” to “install” and then back to
“execute.”When using the DOS commands to install, youmay install the Sage 100 Contractor software as you would on
any desktop orWindows server operating system that meets Sage 100 Contractor requirements.

Installing on computers running Citrix and Terminal Server using DOS commands

To install using DOS commands:

1 Click [Start], thenRun.

2 On theRunwindow, in theOpen drop-down box, type cmd, and press the Enter key.

3 The \Windows\...\cmd.exewindow appears.

4 At the prompt, type change user /install, and press the Enter key.

5 This enables the install mode.

6 Install the Sage 100 Contractor software as you would on a typical workstation orWindows Server.

7 At the end of the installation process, choose to launch the License Administration Tool.

8 Using the License Administration Tool window, manage your license and activate it.

9 After activation, click [Start], then [Run].

10 On theRunwindow, in theOpen drop-down box, type cmd, and press the Enter key.

11 The \Windows\...\cmd.exewindow appears.

12 At the prompt, type change user /execute.

13 This enables the executemode, which is the default mode for running Citrix and Terminal Server.

14 Exit theRunwindow.

15 Restart the server.



- 867 -

IMPORTANT: If this message appears: “Install mode does not apply to a terminal server configured for remote
administration,” then it is not necessary to enable the install mode. Youmay install the Sage 100 Contractor software
as you would on a typical workstation.
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Appendix H: User Interface Reference
Activity Center Icons

Icon Description Icon Description

Administration Inventory and Equipment

Banking Ledger Inventory

Clients Projects

Service and Clients Purchasing

Equipment Reports

Estimating & Scheduling Scheduling

Home

Shortcut Icons
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AlertsManager Pay Vendors

Assemblies Payable Invoices and Credits

BankReconciliation Payroll Audit

Budgets Payroll Checks

ChangeOrders Payroll Records

Period / Fiscal Year Management Post Payroll to GL

CheckRegister Post T & M Invoices

Checks and BankCharges Print T & M Invoices

Compute Payroll Progress Billing

Compute T & M Invoices Proposals

ChangeOrders PurchaseOrder Receipts

Contact Manager PurchaseOrders

Daily Payroll Entry Receivable Clients
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Deposits and Interest Reports

Direct Deposit File Manager Request for Proposals

Dispatch Board Schedules

Employees Select Invoices to Pay

Enter Credit Card Receipts Statements

Equipment Subcontracts

Equipment Payments Takeoffs

Inventory Allocation Unitary Billing

Job Costs

Jobs

Parts
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Appendix I: Working with the ACT! Plug-in
Setting up ACT! Integration
The powerful combination of ACT! and Sage 100 Contractor provides an organized view of the people you do business
with. Using the ACT! plug-in, you can:

l Create clients, jobs, and vendors in Sage 100 Contractor from ACT! companies.

l Create clients and jobs from ACT! opportunities.

l Efficiently manage the transfer of information from your salespeople to accounting and project management staff.

To integrate Sage 100 Contractor with ACT!, your systemmust meet the following requirements:

l Sage 100 Contractor must be installed.

l ACT! Premium or ACT! PRO (version 2011 or later) must be installed.

NOTE: Sage 100 Contractor and ACT! must be installed on the sameworkstation.

l The ACT! plug-in must be installed. For steps on installing the plug-in, see See "Installing the ACT! Plug-in".

IMPORTANT: You require an ACT! plug-in license. The plug-in is licensed through the License Administration
program, but is provided at no charge. Contact the Sage Sales team at 1-800-526-5805 to obtain your license.

In addition, an API user must be set up for any companies that are to be integrated.

l In Sage 100 Contractor, in 7-3-1 Security Groups, an API security groupmust exist with the appropriate save
permissions. See Setting up an API security group and an API user in Sage 100 Contractor to set up the API group.

l Sage 100 Contractor, in 7-3-2 User List, a user that is amember of the API groupmust be set up.

NOTE: A password for the user is recommended but not required.

Installing the ACT! Plug-in
To install the ACT!plug-in:

1. Navigate to the drive where Sage 100 Contractor is installed (for example, C:/ > Program Files (x86) > Sage >
Sage 100 Contractor).

2. In the Plug-ins folder, double-click theACTPluginSetup.exe file.

IMPORTANT: If you uninstall Sage 100 Contractoror ACT!, you will need to run the ACTPluginSetup.exe again.
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Setting up an API security group and an API user in Sage 100
Contractor
Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The 7-3-
1 Security Groups window in Sage 100 Contractor contains a grid with numbered rows on the left and eight columns:

l Group# (User input is required to save the record.)

l Group Name (User input is required to save the record.)

l Save

l Delete

l Void

l Chg Period

l Print Checks

l Notes

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will
have rights toSave, Delete, andVoid records, as well as to change the accounting period and print checks. Youmay use
the Notes column to add any pertinent information about each group.

Youmust create an API security group that is named exactly API. At least one user must be added to the API security
group. You have to set rights to save, void, and so on.

IMPORTANT: If you use security groups for the tasks performed by the employee in Sage 100 Contractor, make
sure the API security group has access to 3-Accounts Receivable, 3-5 Jobs (Accounts Receivable), 3-6
Receivable Clients, 4-Accounts Payable, 4-4 Vendors (Accounts Payable), 5-Payroll, and 5-2-1 Employees.

To set up a security group for using the API
1 Open 7-3-1 Security Groups.

2 In theGroup# cell, type a group number, such as 51.

3 In theGroup Name cell, type API and do the following:

IMPORTANT: The API security groupmust be named exactly API.

a In theSave cell, type Yes.

b In theDelete cell, if you want to allow the users of the API group to delete records, type Yes. If not, type No.

c In theVoid cell, type Yes. If not, type No.

d In theChg Period cell, type Yes. If not, type No.

e In thePrint Checks cell, type Yes. If not, type No.

f To store information that may be relevant or important to that specific group, type a note in theNotes cell.

4 On the Filemenu, click Save.



- 875 -

TIPS:
l Before you can use the API security group to access Sage 100 Contractor company data, you have to assign a

user to the API security group.

l Security is set up for each individual company, not for the entire program. Each company can use different user
names and passwords. If you havemore than one company, you have to set up passwords for multiple
companies.

Then you have to assign a user to the API security group using 7-3-2 User List.

The 7-3-2 User List window controls major features dealing with users and program security.
To assign a user to the API security group
1 Open 7-3-2 User List.

2 In theUser Name cell, enter a user name, such as APIUser.

3 In thePassword cell, enter a password.

4 In theGroup 1 cell, click once in the cell, and from the drop-down list, select the API group.

5 Repeat steps 3–5 for each API user.

6 Click File > Save.

IMPORTANT: The API will not accept “supervisor” as a user name.

Restricting employee access to Sage 100 Contractor
You can use one of the two following scenarios as an alternate way to provide the access to send information to Sage 100
Contractor from ACT!.

Scenario 1: Have a system administrator enter the API user and password on a workstation

If you would like the user to be able to select a salesperson when creating clients in Sage 100 Contractor, but not give the
user the ability to log into Sage Sage 100 Contractor, use this method.

A single API user/password can be entered by a system administrator on one or more workstations, allowing the user the
ability to create vendors, clients, and jobs without gaining these additional permissions when logging into Sage 100
Contractor. Essentially, this means users will not be able to log into Sage 100 Contractor using the API credentials, but will
be able to send information to Sage 100 Contractor.
To set up security for Scenario 1
1 Create the API security group and API user and password as usual in Sage 100 Contractor.

2 Open ACT!.

3 Go to each workstation with the ACT! integration and do the following:

a In the Tools menu, select Sage 100 Contractor Company Settings….

b Click to enable the company the user can access.

c In the User Name field, enter the API username.

d In the Password field, enter the API user password.

e Click [OK].

The individual work station users will not be able to log into Sage 100 Contractor and access employees.
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Scenario 2: Restrict menu level security access to 5-2-1 Employees so employee cannot select a
salesperson

If you would like to give each user their own username and password for the API, but not allow the user to select a
salesperson when creating clients in Sage 100 Contractor, use this method.

You can choose to restrict menu level security access in Sage 100 Contractor to 5-2-1 Employees for an ACT! user that
has access to the API user login and password.
To set up menu level security for the API user
1 Open Sage 100 Contractor.

2 Create the API security group and API user and password as usual in Sage 100 Contractor.

3 In the SystemMenu tab, select 5-2-1 Employees.

4 Click [F7] .

5 Uncheck the box for API in theMenu Level Security dialog box.

6 Click [Save].

IMPORTANT: Users will not be able to select a salesperson if you restrict access to 5-2-1 Employees in Sage 100
Contractor.
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Setting up companies in ACT!
In order to transfer information from ACT! to Sage 100 Contractor, Sage 100 Contractor companies need to be set up. This
is accomplished via the Tools > Sage 100 Contractor Company Settings... option in ACT!

If you havemultiple Sage 100 Contractor companies, you can set up each company in ACT!.

In the Sage 100 Contractor—Company Settings window, the following attributes of each company are displayed:
Column
Name Description

Enable Whether or not the company is enabled for integration with ACT!. Only companies that are
checked will be available when sending information from an ACT! company or opportunity.

Drive (Read only) Drive where the Sage 100 Contractor company is located.

Company (Read only) Company name

User
Name User name of the API user. This field is required for enabled companies.

Password Password of the API user. This field will be visible while typing but will subsequently be hidden
using password characters.

IMPORTANT: Do not copy and paste a password after typing it in the Password field. Because the password is
hidden by password characters after typing, pasting a copied password only pastes asterisks in the Password field.

To set up a company in ACT!
1 Log into ACT!.

2 In the Tools menu, click [Sage 100 Contractor Company Settings...].

3 Click [Enable] for the company in Sage 100 Contractor you want to set up in ACT!.

4 In the User Name column, type in the user name of the API user set up in 7-3-2 User List inSage 100 Contractor.

5 In the Password column, type in the password of the API user set up in 7-3-2 User List inSage 100 Contractor.

6 Click [OK].
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Creating a Sage 100 Contractor Client from an ACT! Company

To create a client in Sage 100 Contractor from an ACT! company
1 In the ACT! Company record, select the Sage 100 Contractor tab.

2 Click the [Create client...] button.

NOTES:
l If theCreate client... button is not visible, click and drag the splitter bar (located above the tabs) until you see

the button.

l If more than one company is enabled in the Company Settings window, click to enable the correct one.

3 (Required) Select theClient status.

4 (Optional) Select the Lead source.

5 (Optional) Select theSalesperson.

IMPORTANT: You cannot select a salesperson if you restrict access to 5-2-1 Employees in Sage 100 Contractor.

6 Enter aClient ID, or leave blank to automatically assign aClient ID number.

7 If necessary, change the ACT! company name in theClient name field.

8 If necessary, change the ACT! company name in theClient short name field.

9 Click [OK].

Once the client is created in Sage 100 Contractor, ACT! keeps track of that client to prevent the same client from being
created twice in the same company.

The fields associated with the ACT! company are written to the appropriate client record in Sage 100 Contractor.

ACT! Company Field Client Field

Company Client Name/Short Name

Street Address Address 1, Address 2

City City

State State

Zip Zip

N/A Source

N/A Salesperson

Billing Address Bill Address 1, Bill Address 2

Billing City Bill City

Billing State Bill State

Billing Zip Bill Zip
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ACT! Company Field Client Field

Shipping Address Ship Address 1, Ship Address 2

Shipping City Ship City

Shipping State Ship State

Shipping Zip Ship Zip

N/A Client Status

The contacts associated with the ACT! company are written to the appropriate client record in Sage 100 Contractor.
ACT! Contact Field Client Field

Contact Contact Name

Title Job Title

Phone Phone

Ext Ext

Email Email

Mobile Cell Phone

Fax Fax

Alternate Other

N/A Other Description

When an ACT! Company is opened in Detail View, the tab row at the bottom contains a Sage 100 Contractor tab. This tab
contains a list of current Sage 100 Contractor entities for this company.

NOTE: This information only appears after the creation of the client and remains until the association is removed.

Associations in Sage 100 Contractor:
Field Description

Drive The drive that the company is located on.

Sage 100 Contractor Company The Sage 100 Contractor company name.

Type Entity type: Client

Number Client ID

Name Client name
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Creating a Sage 100 Contractor Job from an ACT! Company

To create a job in Sage 100 Contractor from an ACT! company
1 In the ACT! Company record, select the Sage 100 Contractor tab.

2 Click the [Create job...] button.

NOTES:
l If theCreate job... button is not visible, click and drag the splitter bar (located above the tabs) until you see the

button.

l If more than one company is enabled in the Company Settings window, click to enable the correct one.

3 (Required) Select the Job status.

4 (Required) Select the Job type.

5 Enter a Job ID, or leave blank to automatically assign a Job ID number.

6 If necessary, change the ACT! company name in the Job name field.

7 If necessary, change the ACT! company name in the Job short name field.

8 Click [OK].

Once the job is created in Sage 100 Contractor, ACT! keeps track of that job to prevent the same job from being created
twice in the same company.

The fields associated with the ACT! company are written to the appropriate job record in Sage 100 Contractor, as shown in
the table below.

ACT! Company Field Job Field

N/A Job Status

N/A Job Type

Company Job Name/Short Name

Address Address 1, Address 2

City City

State State

Zip Zip

The contacts associated with the ACT! company are written to the appropriate job record in Sage 100 Contractor.
ACT! Contact Field Job Contact Field

Contact Contact Name

Title Job Title

Phone Phone

Ext Ext
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ACT! Contact Field Job Contact Field

Email Email

Mobile Cell Phone

Fax Fax

Alternate Other

N/A Other Description

When an ACT! Company is opened in Detail View, the tab row at the bottom contains a Sage 100 Contractor tab. This tab
contains a list of current Sage 100 Contractor entities for this company.

NOTE: This information only appears after the creation of the job and remains until the association is removed.

Associations in Sage 100 Contractor:
Field Description

Drive The drive that the company is located on.

Sage 100 Contractor Company The Sage 100 Contractor company name.

Type Entity type: Job

Number Job ID

Name Job name
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Creating a Sage 100 Contractor Client/Job from an ACT! Opportunity
NOTE: To create a client/job in Sage 100 Contractor from an ACT! opportunity, the opportunity status must be
Closed-Won.

The client and job are created from an opportunity unless the client already exists. You cannot create the job without an
associated client. The ACT! company must be associated with a Sage 100 Contractor client to create the job from the
ACT! opportunity.
To create a client/job in Sage 100 Contractor from an ACT! company
1 In the ACT! Opportunity record, select the Sage 100 Contractor tab.

2 Click the [Create job...] button.

NOTE: If theCreate job... button is not visible, click and drag the splitter bar (located above the tabs) until you see
the button.

a If the opportunity is associated with more than one ACT! company, select the company to associate with this job, and
then click [OK].

b If the ACT! company is not associated with a Sage 100 Contractor client, create a client now by clicking [Yes], then
filling out the requested information.

IMPORTANT: The ACT! company must be associated with a Sage 100 Contractor client to continue creating the job
from the ACT! opportunity.

c In the Sage 100 Contractor—Client Information window, do the following:

i (Required) Select theClient status.

ii (Optional) Select the Lead source.

iii (Optional) Select theSalesperson.

NOTE: You cannot select a salesperson if you restrict access to 5-2-1 Employees in Sage 100 Contractor.

iv Enter aClient ID, or leave blank to automatically assign aClient ID number.

v If necessary, update the value in theClient name field.

vi If necessary, update the value in theClient short name field.

vii Click [OK].

3 (Required) Select the Job status.

4 (Optional) Select the Job type.

5 Enter a Job ID, or leave blank to automatically assign a Job ID number.

6 If necessary, update the value in the Job name field.

7 If necessary, update the value in the Job short name field.

8 Click [OK].

Once the job is created in Sage 100 Contractor, ACT! keeps track of that job to prevent the same job from being created
twice in the same company.

The fields associated with the ACT! company are written to the appropriate job record in Sage 100 Contractor, as shown in
the table below.
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ACT! Company Field Job Field

N/A Job Status

N/A Job Type

Opportunity Name Job Name/Short Name

Associated Company's Client Client

Actual Closed Date Contract Signed

OpenDate Bid Opening

Total Contract Amount

The contacts associated with the ACT! company are written to the appropriate record in Sage 100 Contractor.
ACT! Contact Field Job Contact Field

Contact Contact Name

Title Job Title

Phone Phone

Ext Ext

Email Email

Mobile Cell Phone

Fax Fax

Alternate Other

N/A Other Description

When an ACT! Opportunity is opened in Detail View, the tab row at the bottom contains a Sage 100 Contractor tab. This tab
contains a list of current Sage 100 Contractor entities for this company.

NOTE: This information only appears after the creation of the client and remains until the association is removed.

Associations in Sage 100 Contractor:
Field Description

Drive The drive that the Sage 100 Contractor company is located on.

Sage 100 Contractor Company The Sage 100 Contractor company name.

Job Number Job ID

Job Name Job Name

Client Number Client ID

Client Name Client Name
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Creating a Sage 100 Contractor Vendor from an ACT! Company
To create a vendor in Sage 100 Contractor from an ACT! company
1 In the ACT! Company record, select the Sage 100 Contractor tab.

2 Click the [Create vendor...] button.

NOTES:
l If theCreate vendor... button is not visible, click and drag the splitter bar (located above the tabs) until you see

the button.

l If more than one company is enabled in the Company Settings window, click to enable the correct one.

3 (Required) Select theVendor type.

4 Enter aVendor ID, or leave blank to automatically assign aVendor ID number.

5 If necessary, change the ACT! company name in theVendor name field.

6 If necessary, change the ACT! company name in theVendor short name field.

7 Click [OK].

Once the vendor is created in Sage 100 Contractor, ACT! keeps track of that vendor to prevent the same vendor from being
created twice in the same company.

The fields associated with the ACT! company are written to the appropriate vendor record in Sage 100 Contractor.
ACT! Company Field Vendor Field

Company Vendor Name/Short Name

Address Address 1, Address 2

City City

State State

Zip Zip

N/A Vendor Type

The contacts associated with the ACT! company are written to the appropriate vendor record in Sage 100 Contractor.
ACT! Contact Field Vendor Contact Field

Contact Contact Name

Title Job Title

Phone Phone

Ext Ext

Email Email

Mobile Cell Phone

Fax Fax

Alternate Other
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ACT! Contact Field Vendor Contact Field

N/A Other Description

When an ACT! Company is opened in Detail View, the tab row at the bottom contains a Sage 100 Contractor tab. This tab
contains a list of current Sage 100 Contractor entities for this company.

NOTE: This information only appears after the creation of the vendor and remains until the association is removed.

Associations in Sage 100 Contractor:
Field Description

Drive The drive that the company is located on.

Sage 100 Contractor Company The Sage 100 Contractor company name.

Type Entity type: Vendor

Number Vendor ID

Name Vendor name

Removing associations in ACT! and deleting the entry in Sage 100
Contractor
You can remove an association from a job, client, or vendor, if you want to link to or create a different entity or accidentally
created an association. If you remove an association in ACT!, the corresponding vendor, client, or job in Sage 100
Contractor is not removed. If you need to remove the job, client, or vendor, you will need to remove it manually from within
Sage 100 Contractor.

If you delete a job, client, or vendor in Sage 100 Contractor first, you still need to remove the association in ACT!. There is
no synchronization between Sage 100 Contractor and ACT!.

NOTE: Removing the job association from theOpportunities tab does not remove the client association from the
ACT! company.

To remove an association in ACT!
1 Open ACT!.

2 Locate the association in the Sage 100 Contractor tab.

NOTE: If you are going to delete the associated job, vendor, or client in Sage 100 Contractor, note the corresponding
ID number to use in the data control field in Sage 100 Contractor.

3 Right-click the association you want to remove.

4 Click [Yes] to remove the association.

To remove associations when created from an ACT! opportunity
1 Open ACT!.

NOTE: If you are going to delete the associated job in Sage 100 Contractor, note the corresponding job number to use
in the data control field in Sage 100 Contractor.

2 In the Opportunities area, locate the job association in Sage 100 Contractor tab.
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3 Right-click and select Remove Association and click [Yes] to remove the job association.

NOTE: If you also need to remove the client association, go to the Companies area, locate the client association in
the Sage 100 Contractor tab, then right-click to remove the association.

4 (Optional) Delete the job in Sage 100 Contractor.

5 (Optional) Delete the client in Sage 100 Contractor.

NOTE: You do not have to remove the association with the client.

To delete the job in Sage 100 Contractor
1 Open Sage 100 Contractor.

2 Go to 3-5 Jobs (Accounts Receivable).

3 Enter the job number in the data control.

4 Verify that the Job Status selection is 2—Refused or 6—Closed.

5 Click the [Delete this record] button in the toolbar.

6 Click [Yes] to continue deleting the record.

To delete the vendor in Sage 100 Contractor
1 Open Sage 100 Contractor.

2 Go to 4-4 Vendors (Accounts Payable).

3 Enter the vendor number in the data control.

4 Click the [Delete this record] button in the toolbar.

5 Click [Yes] to continue deleting the record.

To delete the client in Sage 100 Contractor
1 Open Sage 100 Contractor.

2 Go to 3-6 Receivable Clients.

3 Enter the vendor number in the data control.

4 Click the [Delete this record] button in the toolbar.

5 Click [Yes] to continue deleting the record.
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Appendix J: Working with Sage Construction
Anywhere
Additional required software

l The Sage Construction Anywhere Connector should be installed on at least one computer running Sage 100
Contractor software that connect to Sage Construction Anywhere, but can also be installed to a separate server.
See the "Installing the Sage Construction Anywhere Connector Software section in the Getting Started Guide at
http://help.sageconstructionanywhere.com/docs/Default.htm. The Sage Construction Anywhere Connector
connects your back office software to your Sage Construction Anywhere site. The connector installation includes
the Sage Construction Anywhere Connector software and its required prerequisite software.

l An Internet connection using a compatible web browser. See "Appendix A: System Requirements" for supported
browsers in the Getting Started Guide at http://help.sageconstructionanywhere.com/docs/Default.htm.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.

Duration of the installation process
Plan on at least five to tenminutes per computer to install the Sage Construction Anywhere Connector software. The
duration of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. Installation to
older computers may takemore time.

Pre-installation information
In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must be installed
and set up:

l Sage 100 Contractor 2013 Version 18.3 or later must be installed

l Supported version of Sage Construction Anywhere

For more information on Sage Construction Anywhere and the Sage software versions supported, do the following:

1 Go to http://help.sageconstructionanywhere.com/docs/Default.htm.

2 Click on the Getting Started Guide link.

3 View Appendix A: System Requirements for the currently supported software versions.

Setting up an API security group and an API user in Sage 100
Contractor
Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The 7-3-
1 Security Groups window in Sage 100 Contractor contains a grid with numbered rows on the left and eight columns:

http://help.sageconstructionanywhere.com/docs/Default.htm
http://help.sageconstructionanywhere.com/docs/Default.htm
http://help.sageconstructionanywhere.com/docs/Default.htm
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l Group# (User input is required to save the record.)

l Group Name (User input is required to save the record.)

l Save

l Delete

l Void

l Chg Period

l Print Checks

l Notes

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will
have rights toSave, Delete, andVoid records, as well as to change the accounting period and print checks. Youmay use
the Notes column to add any pertinent information about each group.

Youmust create an API security group that is named exactly API. At least one user must be added to the API security
group. You have to set rights to save, void, and so on.

IMPORTANT: If you use security groups for the tasks performed by the employee in Sage 100 Contractor, make
sure the Sage Construction Anywhere user has access to all areas of Sage 100 Contractor.

To set up a security group for using the API
1 Open 7-3-1 Security Groups.

2 In theGroup# cell, type a group number, such as 51.

3 In theGroup Name cell, type API and do the following:

IMPORTANT: The API security groupmust be named exactly API.

a In theSave, Delete, Void, Chg Period, andPrint Checks cells, typeYes.

b To store information that may be relevant or important to that specific group, type a note in theNotes cell.

4 On the Filemenu, click Save.

TIPS:
l Before you can use the API security group to access Sage 100 Contractor company data, you have to assign a

user to the API security group.

l Security is set up for each individual company, not for the entire program. Each company can use different user
names and passwords. If you havemore than one company, you have to set up passwords for multiple
companies.

Then you have to assign a user to the API security group using 7-3-2 User List.

The 7-3-2 User List window controls major features dealing with users and program security.

NOTE: The user name and password created are for administrative use only. This information is for use by the Sage
Construction Anywhere Connector program only, and is not needed by the individual employee(s) using Sage
Construction Anywhere.

To assign a new user to the API security group
1 Open 7-3-2 User List.
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2 In theUser Name cell, enter a user name, such as SCAUser.

3 In thePassword cell, enter a password.

4 In theGroup 1 cell, click once in the cell, and from the drop-down list, select the API group.

5 Click File > Save.

IMPORTANT: The API will not accept “supervisor” as a user name.

To assign an existing user to the API security group
1 Open 7-3-2 User List.

2 Find theUser Name for the person who will use Sage Construction Anywhere.

3 In theGroup 1, Group 2, Group 3, Group 4, orGroup 5 cell, click once in the cell, and from the drop-down list, select
the API group.

4 Click File > Save.

Setting up Sage Construction Anywhere Integration
In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must be installed
and set up:

l Sage 100 Contractor 2013 Version 18.3 or later must be installed

l Supported version of Sage Construction Anywhere

In addition, an API user needs to be set up for any companies that are to be integrated.

l In Sage 100 Contractor, in 7-3-1 Security Groups, an API security groupmust exist with the appropriate save
permissions. See See "Setting up an API security group and an API user in Sage 100 Contractor" to set up the
API group.

l In Sage 100 Contractor, in 7-3-2 User List, a user that is amember of the API groupmust be set up.
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managing bad debt 99

payment history 99

reversing credit 104

startup procedures

entering invoices and credits 178

entering partially paid items 177
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historical record entry 177

Accrued Sick box 261

Accrued Vacation box 261

ACH

about 284

act 873, 889

ACT 873, 889

setting up integration 873

ACT! 873

setting up companies 877

setting up the API security group 874

setting up the API user and password 874

add-onmodules

about 8

adding 526

content panels in Dashboard 696

global calculated fields 625-626

new cost codes to existing structure 367

parts 526

adjusting travel time 583, 592

advance fiscal year

what happens in the program 36

advances 271

about 271

recovering 258

AIA Certificates 147

Alabama

state tax 803

Alaska

state tax 804

Alaska domicile information 257

alert notifications 704

analysis

query 637, 663-664

report writer 627-628, 650

AP credits

apply to AP invoice 204

API 437, 849

Administration window 849

configure service 850

installation 849

launch 850

security group 434

start API service 850

states 851

system requirements 851

user and password 437

appending costs 161

to loan draw applications 161

appointment 580, 583

adjusting time 580, 583

displaying properties 580

duration 580, 583

appointments 144, 578, 580-581

assigning to technicians 578, 580

entering 144

rescheduling 581

archive

company 40, 441, 446

payroll 325

verify 326

verifying 690

archive company

security 446
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archive data wizard 44-45

general maintenance | 0In-
troduction.YearEndChecklist | [4] 44

overview 41

archives

payroll 326

archiving data 41, 44-45

remove jobs 44

Arizona

state tax 804

Arkansas

state tax 806

assemblies 475, 484-485

about 484

classes

locating in 491

entering 485

flat rate details 487

markups 486

hiding parts 488

more information 484

notes 488

part connections

changing 488

creating 487

updating part costs 484

assembly estimating 475

assigning time off

Dispatch Board 582

Attachments

about 708

attach files individually 711

attachWeb links 710, 712

drag and drop files 709, 712

email 713

functionality 709

network files 710

parent-child 710

printing 711

remove 712

uses 709

audit

errors

about 39

inventory 49, 59, 603

procedures 603

payroll 53, 60

about 324

changing check dates 325

procedures 324

repairing balances 324

audit books

about window 38

audit errors

handling 36

audit history 40

view 40

Autofill Pay Rate 270

autostart

Windows 7/Server 2008 R2 863-864

B
backup 55

about 453
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daily backup process 455

data 41, 51, 54, 61, 326, 454-455

file selection 454

monthly backup process 455

bad debt

managing in accounts payable 190

managing in accounts receivable 99

balances

customer 702

bands

about 617

properties 455, 617

bank charges

entering outstanding 12

bank reconciliation

accounts and statements 25

errors

about 28

common 28

incorrect beginning balance 27

locating specific amounts 28

transactions

clearing outstanding 27

comparing with statements 27

trial

reconciliation-in-process check box 26

saving 26

barcodes

about 482

changing part numbers into 483

creating form designs for printing 649

format

selecting 441, 446, 483

viewing 483

printing as labels 649

batches

direct deposit

creating 286

retracting 290

invoices

changing numbers 236-237

totals 237

viewing entry lists 236-237

viewing prior lists 237

purchase orders

issuing 375

retracting 375

beginning balances

incorrect 27

benefits

calculations 318

entering 319

payroll calculations 312

updating 319

bid 115

bid items

about 128

creating proposals from 388

entering 130

examples of 128

overhead and profit rates in takeoffs 503

types 129

using with phases 129
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bid totals

adjusting with overrides 506

controlling 505

hiding in takeoffs 511

billing

receivable retention 125

top customers 701

billing amounts

adjusting with markups 569

adjusting with overrides 569

overridden 570

posting invoices 570

bonding

including costs in takeoffs 503

bonus checks 273

bonuses 273

about 273

entering 273

for salaried employees 274

including in timecards 274

browse for an existing report 615

browsers, supported 856

budget

Budgeted Expenses 699

set 342

setting original 342

versus Actual Expense 698

versus Actual Income 698

budgets

about 341

checking for cost overruns 342

creating 341

deleting 347

display a recap 346

display cost code recap 347

display phases recap 347

effect of change orders on 356

exporting

from takeoffs 520

grids 348

generating proposals from 388

verification 181

C
calculated fields 623, 625, 627

adding calculations to 626

copying 627

creating 625

deleting 628

editing 627

expressions 628

global 625, 627

inserting

in form designs 625

in reports 624

text boxes for 627

pre-defined 623

variables in 630

calculations 510

adding 262, 301

available in formulas 510

benefits 312

budget verification 267

check box options 310
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creating standard 299, 309

defaults 307

in employee records 260, 300

deleting 264

updating 264

in payroll records

about 277

overriding 278

including in T-4 forms 312

including inW-2 forms 312

local payroll 323

paygroup benefits 318

posting account setup 310

pre-built standard 298, 308

prevailing-wage jobs

and non-union shops 262

entering offset credits for 263

setup 299, 306

taxes

areas 311

reviewing rates 311

tables 301, 311

types 302, 305

1-Deduct from Employee 302

2-Add to Gross 304

3-Employer Cost 304

4-Add-Deduct 305

5-Accrued Hours 305

unions 312

calculator

displaying 717

calendar

about 716

and scheduling 546

changing workdays and non-workdays 547

recalculating schedules 547

calendar-year

close 53

California

state tax 806

Cash Accounts

Dashboard 697

Cash Position

Dashboard 697

cash receipts 572, 750

receivable

about 106

entering payments and applying credits to
invoices 102

entering two-party checks 105

reversing 104

service receivables 572

cash receipts report 740

certificates and licenses

vendor 213, 223

entering 224

certified payroll reports 249

cha 152

change orders 365

about 355

about subcontract change order 361

add subcontract change order 362

and takeoffs 502
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appending costs

to loan draw applications 161

to progress bills 152

automatic numbering 357

creating

invoices from 363

purchase orders from 363

deleting 365

effect on budgets and proposals 356

enter budget sub changes 360

entering

about 356

in takeoffs 502

prime and sub changes 358

prime changes 359

exporting from takeoffs 523

outstanding 703

status 363

subcontracts

displaying descriptions 365

reviewing 381

types 364

updating costs

automatically in loan draw applications 160

automatically in progress bills 151

in loan draw applications 159

in progress bills 150

manually in loan draw applications 160

manually in progress bills 151

upgrade option 355

viewing lists of 365

change period

about window 37

chart of accounts

pre-built 69, 75, 81

ranges 66, 69

Check 21

about 651

formatting requirements 651

check dates

changing on payroll records 325

check transmittals

report 205

checks

about Check 21 651

and bank charges 11

bonus 273

cancelling check numbers 14

changing date on payroll records 325

checking accounts

entering direct transfers 19

transferring funds among

about 17

entering outstanding 12

form designs

about 650

creating custom 653

printing 652

general ledger

entering 11

printing 13

reprinting 13

reversing prior year transactions 15
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voiding 14

hand-computed 275

joint 229, 233

MICR

fonts 653

viewing sample checks 652

payroll 284

bonus 273

correcting previously issued 279

hand-computed 275

printing vendor 202-203

refund 98

reprinting

accounts payable 189

previously posted payroll 279

unposted payroll 278

reverse prior year 193

two-party 229, 233

unprinted 16, 49, 59

verify 49, 59

Citrix servers 866

DOS cmd installation 866

classes

about 488

creating structure 489

deleting 490

expanding tree 490

indenting 490

inserting 491

locating parts or assemblies in 491

lumber

board footage 534, 609

entering new cost and billing amounts 534

setup 492

outdenting 491

Part-Assembly Classes menu 489

positioning 491

renaming 491

clearing account 18, 33

entering transfers 18, 33

clearing accounts

about 17

zeroing out

about 22

client

leadmanagement 145

client lead sources 145

setting up 145

client workstation

.NET requirements 858

clients

about 134

accounts receivable 134

documents 141

entering 134

product discounts 138

product lines 138

sizes 137

status 136

types 137

close

jobs

multiple 446
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payroll

about 53, 325

archive 325

delete employee records 326

verify archive 326

year 325

close books 43, 46

fiscal year 40

window 138, 441, 446

Colorado

state tax 807

columns 518

communication ports

configure 859

companies

create new 425

setting up state tax ID numbers 431

company 418, 441, 446

about creation 422

create new from existing 426

company folder 454

company information 286, 428

entering 428

company list

window 138, 418, 441, 446

Company List 418, 441

active companies 418

archive companies 418

computer name

determine 415

concepts

accounting-related

department 88-89

subaccount 72

job-related

cost code 741, 743-744, 750, 752-753

cost type 743-744, 752-753

division 742, 751

job 744, 753, 757

overhead 80, 87

Connecticut

state tax 808

connection state 417

view 417

constants 631

constraints 538

contact manager 445-446

managing contacts frommultiple companies 446

resolving conflicts with records 447

sorting by column 446

sorting by company 446

sorting contacts 446

contact record 445, 447

contacts 445-446

contract 575

entering 575

contract balances 115

contract terms 114

controlling accounts

about 67, 70

setup 72
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correspondence

about 406

creating 406

deleting 407

types 407

cost code

numbering systems

about 370

cost code structure 367

cost codes 367, 609

adding new to existing structure 367

cost codes and divisions

about 366

cost to complete

about 383

apply labor burden 385

entering

costs 384

percentage of work completed 384

reports

deleting 385

updating 385

cost type 703

job costs 703

costs

adjusting balances with hand-computed checks 276

billing status

changing 175

for time andmaterials invoices 175

codes

creating proposals from 389

CSI (Construction Specifications Institute) 371

entering 366

for general contractors 370

for subcontractors 370

importing 368

editing for time andmaterials invoices 175

equipment

for time andmaterials billing 173

historical record entry 460, 462

jobs

about 348

changing taxability of records 354

committed cost reports 354

entering 351

entering historical records 351

historical record entry methods 349

salaried employees 272

voiding 352

labor

entering 172

for time andmaterials billing 172

parts

updating 499

updating by average cost 499

updating by billing amount 501

updating by lowest price 500

updating using preferred vendor 499

updating using takeoff vendor 501

updating vendor prices in takeoffs 500

payroll budget verification 267

takeoffs

bonding 503

hiding totals 512
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liability insurance 504

types 368

default taxability for jobs 114

overhead and profit rates in takeoffs 503

creating 148

new loan draw applications automatically 158

new loan draw applications manually 158

new progress bills manually 149

new unitary bills manually 164

newunitary bills using Unitary Proposal 163

progress bills for jobs 148

time andmaterials invoices by phase 169

creating a new report using the wizard 614

credit card

add 243

add issuer account 242

create account

about 242

edit 243

edit account

about 242

edit issuer account 243

enter receipt 244

enter recurring charges 245

pay 246

reconcile 246

Credit Card Accounts

Dashboard 700

credit cardmanagement

about 241

credit invoice 571

entering 571

credits 550

apply check to 192

payable

about 190

applying to invoices 203

entering and applying to invoices 191

entering open 192

historical record entry methods 180

receivable

about 98

applying to invoices 103, 109

historical record entry methods 177

recalculating 98

critical path

viewing 544

customer support

knowledgebase 5

customers

contract 702

cycle

symbols 610-611

cycle symbols

##DY 23, 208, 221

##MO 23, 208, 221

##TH 23, 208, 221

D
daily field reports

about 402

about incidents 403

creating 402

deleting 405
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field orders 404

importing into timecards 338

incidents

entering 403

types 404

meetings 403

daily payroll

about 335

creating timecards 338

entering 335

employee time 336

equipment time 337

importing field reports 338

viewing totals 338

Dashboard 695, 697-704

about 692

adding and removing content 695

adding content panels 696

Budget vs. Actual Expense 698

Budget vs. Actual Income 698

Budgeted Expenses 699

Cash Accounts 697

Cash Position 697

content panels 695

Credit Card Accounts 700

Department Budget vs. Actual Expense 698

Department Budget vs. Actual Income 698

Department Income and Expenses 698

edit job selection 703

edit job selection for job costs by cost type 703

edit job selection for job tasks 704

edit selected departments 698

Expiring Vendor Discounts 700

Income and Expenses 698

Income from Operations 697

Job Contract, Budget, and Costs to Date 703

Job Costs by Cost Type 703

Job Uncommitted Budget 704

Outstanding ChangeOrders 703

Payable Retention by Job 704

Payables 699

Payables Aging 699

Previous Year Expense Comparison 698

Previous Year IncomeComparison 698

Receivable Retention 704

Receivables 700

Receivables Aging 701

removing content panels 696

security 446, 694

Service Receivables Aging 701

Today's Job Tasks 704

Tomorrow's Job Tasks 704

Top Customers by $ Owed 702

Top Customers by Billing 701

Top Customers by Contract 702

Top Service Customers 702

Top Vendors 700

Under-billed Jobs 702

data

backup

about 453

file selection 454

backupmethods 454-455
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maintenance

general 455-456

indexing database 442

repair 443

moving into and around Sage 100 Contractor 723

data control 689

first record button 689

last record button 689-690

lookup window button 689

next record button 689-690

previous record button 689

record number text box 689

database

counting records 690

indexing 442

repair 443

date constraints 538

date format 853

Davis-Bacon Act 249, 262

dedicated accounts 79, 84

Default Max 55, 63

defaults

customize 720

set new account 13

Delaware

state tax 808

deleting 560, 563

jobs 117

service records 560

work orders 563

department

income and expenses 698

ledger accounts 66, 70, 72

departments 88-90, 609, 698

about 89

assigning 90

creating 88-89

dependencies

about 537

drawing between tasks 538

entering 537

lead and lag time 537

start-finish 545

deposits

on jobs 17

depreciation 472

details 497, 522, 555-556

accounting

audit 603

general contractor 75, 82

home builder 75, 82

remodeler 75, 82

subcontractor 75, 82

direct deposit 286

about 284

create pre-note 288

Direct Deposit File Manager 286

employee setup 287

file 284, 457, 726, 819, 822-823

files

creating 286

retracting 290

information options

account number 292
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account status 291

account type 65, 69

rate 292

rate type 292

routing number 292

Use Direct Deposit check box 291

process pre-note 288

processing 289

setup 285

direct deposit report

reprint 284, 291

direct expense 465

discount available 565

discounts

product 138

dispatch board 588

preferences 588

Dispatch Board 581-584, 587, 590, 592

assigning time off 582

creating new work orders 581, 584

refreshing 592

removing dispatches 581

setting up employee list 584, 590

view-only mode 583, 587

dispatches 581

removing 581

District of Columbia

state tax 809

divisions

entering 367

importing 369

document control

features 393

incidents 403

Document Tracking

about 722

documents

client 141

employee 258, 743, 752

equipment 459

job 126

printing 640, 643

vendor 225

DOS cmd installation

Citrix servers 866

Terminal servers 866

drill down 446

cash accounts 697

cash position 697

Dashboard 692

income from operations 697

outstanding change orders 703

payables 699

program-wide 644, 646

receivables 700

single contact record 445-446

under-billed jobs 702

E
earnings

viewing employee 255

editing

global calculated fields 627
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electronic receipts

receivable

about 110

entering payments and applying credits to
invoices 107-108

voiding 21

electronic receipts report 741

Electronic Receipts window 107

email

settings 673

technicians

work orders 581, 585

employee 584, 590

list 138, 441, 455, 584, 590

status and removal 54, 61, 326

employee compensation 261

employee license

add type 255

track 256

employee list 584, 590, 760

setting up for the Dispatch Board 584, 590

employee loans 271

employee positions

about 315

employee training

add type 256

track 257

employees 555, 586, 590

adjusting deduction balances with hand-computed
checks 275

assigning to schedules 542

benefits 319

documents 258

payroll calculations

deleting 264

updating 264

records

about 252

Alaska domicile information 257

delete 326

direct deposit setup 287

entering 253

images included with 267

salaried

bonuses for 274

entering wages 271

job costing 272

viewing earnings 255

workingmultiple positions 132

entering 551-552, 554, 556-558, 563, 571, 575-576

accounts payable invoices and credits 181

appointments 144

company information 428

contracts 575

credit invoice 571

credits 571

equipment owned by client 144

insurance recovery information 557

invoice details for service calls 563

job-specific paygroups 132

locations 558, 576

methods for service receivable records 551-552

quotes or work orders or invoices 554, 556

routes 575

service contracts for clients 142
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service locations 143

entering setup data

unitary bills 163

equipment

assigning to schedules 542

documents 459

entering

client-owned 144

time 337

historical record entry

costs 460, 462

revenue 462, 473

posting account setup 79, 86

rates for time andmaterials billing 173

records 401

about 463

deleting 464

entering 463

revenue

about 473

voiding records 473

types 464

equipment costs

about 459

allocation 469

depreciation

about 472

posting 472

distribution 460

entering 460

for jobs 471

for time andmaterials billing 470

maintenance 456, 468

recovery and rental rates 467

repair work 470

to determine recovery rates 466

estimated use 467

of operation 464

of ownership 468

payments

about 471

selecting for 472

recovery

about 465

using expense pools 469

rental units 465

resource consumption 467

voiding 460

equipment depreciation

post specific pieces 472

equipment management

features 459

estimating

assembly estimating 475

features 475

HomeBuilder’s Data

about 476

account setup 476

Remodeler’s Data

about 477

account setup 477

Excel 679

exclusive access

about 441
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clearing 441

setting 441

expense pools 469

expenses

budgeted 699

comparison 698

expiring

vendor discounts 700

exporting

about 390, 723-724

budgets

about 347

from takeoffs 520

grids 348

procedures 347

change orders from takeoffs 523

grids

proposal 390

scheduling 548

unitary proposal 392

proposals 390

about 347

from takeoffs 520

unitary 392

purchase orders from takeoffs 520

reports 725

RFPs from takeoffs 523

service work orders from takeoffs 522

subcontracts from takeoffs 521

takeoffs

about 518

grids to files 519

grids to work orders 521

to files 518

toMicrosoft Excel

about 679

from Find queries 681

from Quick Grids 681

from reports 681

to PDF format 726

to RTF format 726

unitary proposals 347

expressions 628

about 628

constants 631

functions 631

operators 629

{D} 631

{N} 631

{S} 630

between 638

If()Then()Else 630

inner join 638

parentheses 629

Structured Query Language

about 637

syntax 637-638

variables in calculated fields 630

F
fax line access selection 673

fax service component

Windows 672
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features

About Sage 100 Contractor window 691

accounts payable 179

add-onmodules 8

estimating 475

inventory 593

count 690

document control 393

equipment management 459

estimating 475

new 1

payroll 249

Quick Lists 690

Sage 100 Contractor Desktop

about 685

shortcuts 686, 716

Sample Company 691

scheduling 535

searching with indexed text boxes 690

user-defined fields 691

user and system prompts 689

utilities 413

federal tax

income 809

field properties

locked fields 434

set new account 13

fields 614

locked 434, 740-745, 749-754, 756-773, 775-776,
778-796

properties

about 434

file server

hardware 853

finance charges 568

setting up for service work 568

financial reports

about 87

printing 88

financial reviews

ratios 610

Financial Reviews

trends 610

find

about 720

queries

exporting toMicrosoft Excel 681

firewall

configure 859

fiscal year

close 40

fiscal year-end

and posting periods 76, 82

remove jobs 44

fiscal year end

preparation 49

flat rate 118, 121

entering retention 118, 121

flat rate details 487

Florida

state tax 810

folder

MB7 454

Report Forms 454
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form designs

assigning reports to 615

checks

about 650

creating custom 653

printing 652

creating

using existing forms 656

drawing

boxes 441

editing

existing 657

inserting

calculated fields 625

labels

about 648

for laser printers 648

for tractor printers 648

modifying 615, 647

pages

about format 659

previewing 657

reducing display size 657

format 483, 648-649

forms

check 8, 757

tax 8

formulas

about 506

expression 631

solving 509

Total Labor Units (TLU) 508

types of calculations performed in 510

freight cost

variances 196

function keys 715

functional details

user name 436, 441

functions 631

G
GAAP-standard reports 607

Gantt views

about 543

printing 543

general ledger

close 40

deposits

on jobs 17

ledger accounts

about 68

setup

about 81

considerations 74, 80

Generic-Text Only printer driver

installing 457

printing to file using 457

Georgia

state tax 811

global calculated fields 624-627

creating 625

editing 627

working with 624
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glossary

account 72

bid 115

expression 631

journal 744, 753

network 418

passwords 436

task 609

user name 436, 441

graphics

about including with records 721

assigning to records 268

grid cell menu

Takeoff Details tab 513, 515

grid columns menu

Takeoff Details tab 515-516

Grid Views menu

Takeoff Details tab 514, 516

grids

cells

selecting 441, 446, 705

columns

selecting 441, 446, 705

exporting

budget 348

estimating 519

proposal 390

scheduling 548

grid menu 513, 705

importing takeoff 526

printing 640, 643

rows

selecting 441, 446, 705

setting the direction of movement 705

guides

printing 5

Sage 100 Contractor and Your Business 4

User 441

User Guide 4

H
hand-computed checks 275

about 275

entering

to adjust cost balances 276

to adjust deduction balances 275

handling audit errors 36

hardware 853

file server 853

Hawaii

state tax 811

historical records

entering

equipment cost 460, 462

equipment revenue 473

job cost 351

payroll 297

initial entry methods

accounts payable 180

accounts receivable 177

equipment cost 460

equipment revenue 462

job cost 349
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payroll 296

holdback

create invoice 122

final invoice 122

HomeBuilder’s estimating data

about 476

account setup 476

hours to complete

about 385

deleting reports 386

entering

percentage of hours completed 386

remaining hours 385

updating reports 386

I
Idaho

state tax 812

Illinois

state tax 812

images

about including with records 721

assigning to records 268

included with employee records 267

importing

about 390, 723

budgets 348

ODBC-compliant data 726

proposals 391

unitary 393

schedules 545

takeoffs 525

about 525

grids 526

using Takeoff Launch 525

tasks into schedules 545

unitary proposals 165

income

comparison 91, 698, 732, 734

federal tax 809

income tax

federal 809

Puerto Rico 836

indexed text boxes 690

indexes

rebuild 49, 51, 55, 62, 326

Indiana

state tax 813

install 887

.NET 857

.NET framework 857

component

documentation 4

duration 887

insurance 304, 557, 754

costs

including in takeoffs 504

recovery 557

insurance recovery

service work 557

integration

ACT plug-in 873

Sage Construction Anywhere 889
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Internet Explorer 6.0 SP1

verify 858

inventory

about 593

allocation 595

audit

about 603

procedures 603

entering startup 594

features 593

locations

moving stock among 601

setup 601

offset account 594

parts

about 481

data 482

viewing 481

viewing serial numbers by location 482

records

customer sales 599

internal consumption 598

revaluation 600

shrinkage 599

stock used on contracts 600

status 596

stock

placing on hold 597

verifying availability 598

variance reconciliation 595

invoice 187, 563, 565, 740, 749

entering details 563

invoices 550, 554, 556, 560, 565, 569-570

creating from change orders 363

creating partial invoices 565

credits

applying 203

entering and applying to payable invoices 191

entering open 192

entering 554, 556

payable

about 181

changing status 204

credit 190, 740, 749

entering 182

historical record entry methods 180

including job numbers 181

managing old debt 190

options for saving 187

partially paid items 180

payment history 190

purchase order sales tax 196

release retention 235-236

reprinting checks 189

reverse prior year 194

status 187

types 187

use taxes 197, 216, 226

verifying contract balances 188

Workers’ Compensation costs 215, 226

posting

payable account setup 79, 86

receivable account setup 80, 87

time andmaterials 171
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posting with billing amount markups 569

posting with overridden billing amounts 570

receivable

about 95

applying credits to 102-103, 107-109

creating based on contract balance 97

entering 96

historical record entry methods 177

partially paid items 177

recalculating 98, 568

releasing retention on 122

status 95

types 96

voiding 97

reviewing subcontract 381

subcontract line 183

time andmaterials

about 170

computing 170

creating by phase 169

editing costs 174

processing 171

voiding 169

void payable 195

Iowa

state tax 813

IP Address

definition 416

determine 415

J
job

status and removal 50, 60

job cost 354

job cost distribution 354

job costs

about reconciling 353

reconcile 354

jobs

about 111

change retention 118, 120

close

multiple 446

contract balances 115

contract terms 114

cost types 114

costs

about 348

billing status 175

changing taxability of records 354

committed cost reports 354

editing 175

editing for time andmaterials invoices 174

entering 351

entering for equipment 471

entering historical records 351

equipment 173

historical record entry methods 349

labor 172

salaried employees 272

voiding 352
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creating new progress bills 148

creating purchase orders 371

deleting 117

displaying takeoff hours 540

documents 126

entering 112

numbering

including on payable invoices 181

opening schedules when PO dates change 377

paygroups

job-specific 132

progress billing 147

releasing retention 118, 121

status 115

types 115

updating retention 125

joint checks 228-230, 232-234

Journal Transaction

status query 33

journal transactions 23

records

changing status 21

editing 20

voiding 21

voiding electronic receipts 21

recurring 23

reversing in next period 21

WIP adjustments 21

K
Kansas

state tax 814

Kentucky

state tax 814

keyboard shortcuts

activating 716

L
labels 647, 649

about 648

creating form designs for barcodes 649

for laser printers 648

for tractor printers 648

printing barcodes as 649

labor burden

cost to complete 385

payroll calculations 260

language 853

leadmanagement

about 145

client mail lists 145

entering

referral leads 146

referral sources 146

setting up lead sources 145

ledger accounts

about 68

account ranges 66, 69

add new 68, 74

clearing 17

combining 67, 73

controlling 67, 70, 72

creating 86

deleting 68, 74
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departments 66, 70, 88-90

equipment expense 79, 86

numbering 69

posting

payable invoices 79, 86

receivable invoices 80, 87

pre-built chart of accounts 69, 75, 81, 83

renaming 69

setup

financial activity entry methods 78, 85

starting balances 77, 84

subsidiary 65, 69, 72, 92, 732, 734

summary 65, 67, 69, 73, 92, 732, 734, 745, 753

ledger balances 39

liability 304

license server

change server computer 865

license use

returned 723

licensing

TCP Remoting Channel 859

lien waivers

about 205

entering 205

printing 206

report 205

loan draw application 158

creating automatically 158

creatingmanually 158

loan draws

about 157

appending costs from change orders 161

applications

automatically creating new 158

manually creating new 158

preparing next 159

processing 162

voiding 162

updating costs

automatically 161

updating costs from change orders

about 159

automatically 160

manually 160

local payroll taxes

about 302, 320

about multistate SUI 263

calculations

setup 323

creating table of states 322

districts

combining 322

entering 321

reciprocal agreements 323

setting up like state tax 323

viewing details 321

multistate SUI 263

Pennsylvania 833

locations 558, 576

entering 558, 576

inventory

moving stock among 601

setup 601
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locked

check box 434

columns 434

fields 434

text boxes 434, 441

Lookup window

about 713

display 441, 446

sort 622

Louisiana

state tax 815

lumber

board footage 534, 609

class setup 492

entering new cost and billing amounts 534

M
mail list

about 134

set up 138, 145

mailing labels 647

options for printing 647

mailing list

about 134

set up 138, 145

Maine

state tax 816

maintaining database

general maintenance 456

indexing 442

repair 443

manage contacts 445-446

markups 568-569

billing amount 569

controlling billing amounts 568

for assemblies 486

posting invoices 569

Maryland

state tax 817

working in Delaware 817

Massachusetts

state tax 819

materials costs

freight cost 196

variances 196

meeting types 404

menu-level security

about 440

access rights 441

methods

backup 454

calculation 302, 304-305

Michigan

state tax 819

MICR

checks

creating 653

printing 652

fonts 654

suppliers 654

toner cartridges 654

typing characters 654

viewing sample checks 652
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Microsoft Excel

exporting to

from Find queries 681

from Quick Grids 681

from reports 681

Minnesota

state tax 820

Minority

report 250

Mississippi

state tax 821

Missouri

state tax 821

Montana

state tax 822

N
Nebraska

state tax 822

network 418

connectivity 726

network configuration 856

client and workstation 854, 856

licensing 859

server 856

Nevada

state tax 823

Workers’ Compensation 824

New Hampshire

state tax 824

New Jersey

state tax 825

New Mexico

state tax 825

New Report Launch window 613

New York

state tax 827

Workers’ Compensation 827

non-union shops 262

North Carolina

state tax 828

North Dakota

state tax 829

notes 577

about 718

assembly 488

exporting from takeoffs 524

opening text files 720

owner notes 577

shop notes 577

O
ODBC 726

Ohio

state tax 829

Workers’ Compensation 830

Oklahoma

state tax 831

open a recent report 615

operating system

fax service component 672

operating systems

system requirements 854
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operators

{D} 631

{N} 631

{S} 630

about 629

between 638

If(Then)Else 630

inner join 638

SQL query syntax 637

Oregon

state tax 831

Workers’ Compensation 832

Outlook 445, 447, 670-671, 673, 709

syncing contacts with 445

Over-the-Counter Sales 573

overbudget warning

enable 342

PurchaseOrder Over Budget Warning 344

overrides 568-569

billing amount on time andmaterials invoices 174-
175

controlling billing amounts 568

in payroll record calculations 278

P
partially paid items

on payable invoices 180

on receivable invoices 177

parts 475, 526

9-2 Parts check box options 480

about 478

adding 526, 528

about 526

file types 527

recalling templates for 528

saving templates for 527

assembly connections

changing 488

creating 487

databasemaintenance

about 531

deleting ranges of parts 533

procedures 533

displayingmanufacturer details in takeoffs 497

entering 478

labor

creating records 481

hiding 513

prices

simultaneously updating-adding new parts 530

updating 529

records

about creating for non-material items 480

assigning specifications files to 480

updating

by average cost 499

by billing amount 501

by lowest price 500

costs 499

costs using takeoff vendor 501

in takeoffs and grids 498

using preferred vendor 499

vendor prices in takeoffs 500

updating prices 484

about 526
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file types 527

recalling templates for 528

saving templates for 527

passwords 436

displaying 438

for multiple companies 438

setup 436

support

for database repair 443

pay period

change 264, 441

payable invoice 699

about voiding 195

void 195

paygroups 316

benefits 305, 319

entering 317

job-specific

about 132

employees workingmultiple positions 132

entering 132

updating pay rates 317

payment history 573

payments

by voucher 206

equipment

about 471

selecting for 472

history

accounts receivable 99

payable 190

vendor

about 199

applying credits to invoices 203

changing invoice status 204

printing checks 202

reports 205

separate checks 203

payroll

advances 271

bonuses 273

calculate

labor burden 260

calculations

budget verification 267

types 302, 305

calendar year-end close 53, 325

checks

reprinting previously posted 279

reprinting unposted 278

correct record 280

employee loans 271

entering wages 271

features 249

hand-computed 275

pay types 266

paygroups 316

per diem payments 270

piece pay 271

post 293

posting 293

processing

computing records 283
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direct deposit 289

procedures 295

records

about 265

entering 268

entering historical 297

errors 36, 267

historical entry methods 296

status 265

types 265

voiding 279

reverse record 280

taxes

certified payroll reports 249

types 305

third-party sick pay 276

timecards

absences 270

Autofill Pay Rate 270

entering 268

importing service records 270

unions 319

use higher rate option 318

payroll calculation

assign special 333

payroll calculations

advance earned income credit 313

change pay period 264

create 299, 309

EIC calculation 313

update 55, 63, 309

payroll checks 284

report printing 284

payroll report

Minority 250

payroll reports

5-1-10 Employee Documents 648, 763

5-1-2 Payroll Check Register 760

5-1-6 Certified Payroll Report 762

5-1-8 Hours Report 762

5-1-9 Ytd-Qtd Earnings 762

5-2-1 Employees 763, 823

5-2-2 Payroll Records 763

5-2-4 Payroll Checks 764

5-2-5 Direct Deposit File Manager 764

5-2-7 Compensation Slips 764

5-2-8 Timecard Journal 764

5-3-1 Payroll Calculations 765

5-3-4 Paygroups 133, 765

5-5-1 Daily Payroll Entry 765

5-5-2 Daily Jobs Reports 766

5-5-3 Daily Labor Reports 766

5-5-4 Daily Equipment Reports 766

Payroll year end

verification 55

PDF 726

exporting data to 726

Pennsylvania

local tax 833

state tax 833

per diem payments 270

percentage complete accounting 198



- 921 -

phases

about 126

creating time andmaterials invoices by 169

displaying takeoff hours 540

entering 127

usingminimum quantities in takeoffs 498

using with bid items 129

Picklist windows

about 714

sorting 622

piece pay 271

plan records

about 401

deleting 402

tracking 401

distribution 401

port numbers

TCP Remoting Channel 859

positions

setup 316

post

equipment depreciation 472

post payroll

change account 293

posting 562, 578

equipment

account setup 79, 86

depreciation 472

invoices

payable 79, 86

time andmaterials 171

multiple work orders 562

payroll 293

about 293

account setup 310

in detail 293

in summary 294

periods

about 76, 82

locking access 38

period 0 archive 38

receivable invoices 80, 87

recurring journal transactions

multiple 24, 176, 241, 446

single 24, 176

service contracts 578

verifying

date 68, 73

period 68, 73

posting invoices 569

posting period

change 37, 441

set 59

pre-built chart of accounts 69

about 75, 81

selecting 75, 83, 441, 446

pre-built standard payroll calculations 298, 308

pre-lien notice

print 131

pre-lien notices

about 131

entering 131

preferences 588
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prevailing-wage jobs

and non-union shops 262

certified payroll report 249

entering offset credits for 263

previous year 698

expense comparison 698

income comparison 698

prices 526, 529

updating 526

prime change 365

prime change list 365

prime contract 366

prime contract audit 366

print

pre-lien notice 131

print change orders 365

print preview

reports 641, 644

print subcontracts 383

printers

drivers

changing default 457

errors 457

installing 457

installing 456

saving settings 644

printing

1099 balances 239

checks

general ledger 13

vendor 202-203

documents 640, 643

errors 457

Gantt views 543

grids 640, 643

lien waivers 206

prime change lists 365

prime contract audit reports 366

print subcontracts reports 383

purchase order audit reports 378

purchase order list reports 378

purchase order materials reports 378

reports 640, 643

about 641

defaults 640, 643

financial 88

saving settings 644

subcontract audit reports 383

subcontract change list reports 365

subcontract list reports 383

to file 457

prioritizing

employees 555, 586, 590

work orders 555, 586, 590

processing 28

loan draw applications 162

prior year reconciliation items 28

product lines 138

product updates

receiving automatic notifications 1

progress billing

about 147

AIA Certificates 147

appending costs from change orders 152
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applications

creating new 148-149

preparing next 155

processing 154

voiding 157

retention 152

releasing 153

setup 148

updating costs from change orders

about 150

automatically 151

manually 151

progress bills 153-154, 157

appending costs from change orders 152

creatingmanually 149

updating costs from change orders
automatically 151

updating costs from change orders manually 151

project costs 161

Project Hot List

about 407

displaying 408

removing records 408

Project Reviews

statistics 611

Project Values tab

about grid menus 517

grid cell menu 517

grid columnmenu 518

show-hide columns 518

Project Work Center

about 409

customizingmenu tree 410

job contact and financial information 410

prompts 689

proposals

about 388

creating 388

from bid items 388

from budgets 388

from cost codes 389

deleting 390

displaying a recap 389

effect of change orders on 356

exporting 390

about 347

from takeoffs 520

grids 390

exporting and importing 390

importing 391

rounding up amounts 389

setting original 389

Puerto Rico

income tax 836

punch lists

about 405

creating 405

deleting 406

hiding items on 406

purchase order 378

PurchaseOrder Over Budget Warning 344

purchase order audit 378

purchase order list 378

purchase order materials 378
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PurchaseOrder Over Budget Warning

settings 344

purchase orders 371, 560

about 371

canceling ordered items 376

closing

automatically 374

manually 374

creating

for jobs 371

from change orders 363

from RFPs 395

creating from work orders or invoices 560

deleting 376

exporting from takeoffs 520

includingmanufacturer details 371

issuing 374

batches 375

master

about 377

creating 377

creating individual POs from 377

opening schedules when dates change 377

over-balance warning 188

receipts

about 602

entering 602

retracting 375

batches 375

sales tax on payable invoices 196

status 373

types 374

voiding 376

warnings 210, 223

Q
quarterly 797, 800

queries

find

about 720

Quick Grids

exporting toMicrosoft Excel 681

Quick Lists 690

quotes 554, 556

entering 554, 556

R
recalculate 39, 119, 156

Recalculate Balances 39

receivable clients 134

entering 134

setting up client product discounts 138

setting up client product lines 138

setting up client size 137

setting up status 136

setting up types 137

receivable invoices 122

releasing retention 122

reconciliation 28, 595

prior year 28

prior year into next fiscal year 28

record counts

print 50

records 401, 560, 721

about including graphics with 721
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assigning images to 268

copying 708

deleting 708

deleting service records 560

locking 707

service 551-552, 560, 573

voiding 708

recurring journal transactions

examples of 23

posting

multiple 24, 176, 241, 446

setting up automatic reminders 24

single 24, 176

setup 23

recurring payables

about 240

setup 240

recurring receivables

about 175-176

refund

checks 98

releasing retention 153, 166

for jobs 118, 121

for progress bills 153

for unitary bills 166

receivable invoices 122

Remodeler’s estimating data

about 477

account setup 477

removing

closed purchase orders 371

content panels from Dashboard 696

paid and void invoices 181

paid, void, or completed service invoices 550

repairing balances 39

report 613, 729

6-1-4-61 768

6-1-4-71 768

blank report 615

browse for existing report 615

creating new report using the wizard 614

direct deposit 284

New Report Launch window 613

open a recent report 615

report printing 91, 174, 732, 734

fax line access selection 673

Report Query Wizard 663-664

report scheduling 666

reports 91-93, 95, 339, 365-366, 378, 383, 613, 731-735

accounting 91

assigning to form designs 615

calculated fields in 624

certified payroll 249

changing fax line access when scheduling 676

changing fax line for direct delivery 674

check transmittals 205

committed cost 354, 771

Cost to Complete

deleting 385

updating 385

creating

new 612

shortcuts to 609

Daily Equipment 339
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Daily Labor 339

drawing

boxes 441

drill down 644

edit for drill down 646

emailing and faxing

fax cover pages 676

fax distribution lists 676

faxing reports 677

exporting

about 725

toMicrosoft Excel 681

faxing and emailing

changing email server for direct delivery 674

changing email server when scheduling 675

email distribution lists 677

setup 670-671

form and page breaks

about 618

GAAP-standard 607

Hours to Complete

deleting 386

updating 386

lien waivers 205

locked 91-93, 729-735, 740-745, 749-754, 756-773,
775-776, 778-796

modify design 615

modify existing 612

modify locked 615

modifying

about 615

print 50

print preview 641, 644

print to screen 641, 644

print year-end 56, 63

printing 640, 643

about 641

defaults 640, 643

financial 88

printing change order 365

printing prime change lists 365

printing prime contract audit 366

printing print subcontracts 383

printing purchase order audit 378

printing purchase order list 378

printing purchase order materials 378

printing subcontract audit 383

printing subcontract change list 365

printing subcontract list 383

printing subcontract orders 365

Query Wizard 663-664

saving and naming 662

scheduling

critical path 544

deleting schedules 669

editing schedules 669

Gantt views 543

procedures 667

Scheduled Report Event Viewer 444

task summaries 544

updating schedules 669

selection criteria 607, 613, 622

Set to Pay 205
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Units to Complete

deleting 387

updating 387

updating schedule and output 669

updating selection criteria 669

vendor payments 205

viewing

samples 608

requests for information

about 396

deleting 398

types 397

requests for proposal

about 393

creating purchase orders from 395

deleting 396

exporting from takeoffs 523

types 395

rescheduling 581

appointments 581

resetting

password 441

retention 114, 120, 153, 165-166, 704

accounts receivable 120

by job 704

change for jobs 118, 120

entering as a flat rate 118, 121

flat-rate 118, 121

flat rate 188

payable

about 234-235

paying 235

releasing 235-236

receivable 704

about 120

billing 125

editing statements to create invoices for 125

progress billing 152

releasing for progress bills 153

releasing on invoices 122

release 119, 156, 235-236

release and print statement 119, 156

release for jobs 118, 121

release when complete 119, 156

releasing 153

releasing for subcontracts 382

unitary billing

about 165

releasing 166

update 125

retention rates 118, 120

changing for jobs 118, 120

revenue

equipment

about 473

historical record entry 473

historical record entry methods 462

voiding records 473

reversing 104

accounts payable checks 193

accounts payable from prior year 194

AR credit 104

review and reporting 605

overview 605
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RFI

create 396

numbering 393

RFP

about 393

create 394

numbering 393

Rhode Island

state tax 837

routes 574-575, 577

entering 575

setting up service routes 574

routines 797-798, 800-801

daily 668, 797

monthly 668, 797-798

quarterly 797, 800

weekly 668, 797, 801

RTF 726

exporting data to 726

S
Sage 100 Contractor 1

connected 416

Desktop

about 685

shortcuts 686

Sage 100 Contractor Hosting Framework 865

autostart 863-865

Sage Advisor Update 1

Sage Construction Anywhere 889

setting up integration 889

setting up the API security group 887

setting up the API user and password 887

Sage CRE

cheques 8

forms 8

Sage Exchange

installing 2

overview 2

Sage Exchange Vault

about using to store client information 2

Sage license server 413, 417

change 414, 441

connection state 417

IP Address 414

name 404, 414-415, 441, 723

select 414

specifying 413

Sage Virtual Terminal 3

salaried employees

bonuses for 274

entering wages 271

job costing 272

sales and use taxes

including in takeoffs 505

sales tax rate 141

changing 141

Sample Company

features 691

log in 692

schedule 669

schedule and output 669

updating in scheduled reports 669

Scheduled Report Event Viewer 444
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scheduled reports

updating schedule and output 669

updating selection criteria 669

schedules

accelerating 546

company calendar

about 546

recalculating with 547

creating 541

starter schedules from takeoffs 540

date constraints 538

deleting 548

displaying takeoff hours by job or phase 540

examining 546

exporting grids 548

importing 545

tasks 535, 545

management tips 539

recap

about 547

displaying 547

resource assignments

avoiding conflicts 542

employees 542

equipment 542

subcontractors 543

setting original 545

start-finish dependency 545

scheduling 537

about 539

changing workdays and non-workdays 547

features 535

opening schedules when PO dates change 377

reports

Gantt views 543

screen prompts 689

secondary payees

about 230

invoices

adding to existing 229, 233

decreasing payable amounts 230, 234

entering 228, 232

increasing payable amounts 230, 233

security

access rights 440

archive company 52, 56, 63

copying user defaults

about 439

procedures 439

Dashboard 694

features 431

field properties

about 434

group

API 434

groups

about 432

setup 433

menu-level

about 440

access rights 441

passwords

displaying 438

for multiple companies 438
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setup 436

supervisor user 438

takeoffs

hiding bid totals 511

hiding cost totals 512

user names

about 436

setup 436

window-level

about 440

access rights 441

window andmenu-level 440

setup 440

selection criteria 669

updating in scheduled reports 669

server 572

definition 416

network configuration 856

Server 2008

change license server 865

sleepmode 864

TCP Remoting Channel 859

Server 2008 R2

sleepmode 863

TCP Remoting Channel 864

Server 2012

TCP Remoting Channel 863

server hardware

system requirements 853

server requirements

.NET 858

service areas 574

setting up 574

service contracts 578

appointments 144

entering 142

entering client-owned equipment 144

posting 578

service areas 143

service locations 143

types 142

service contracts for clients 142

service credits 570

service invoice 553-554, 565-567

status 554, 567

types 553, 565-566

service invoices 570

voiding 570

service jobs 550-551

service locations 143

entering 143

service receivable 551-552

records 401, 551-552

service receivables 549-552, 561, 570, 572

aging 701

and cash receipts 572

entering 550, 552

managing bad debts 561

service records 560

deleting 560

service routes 574, 577

posting 577
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service work 568, 573

displaying payment history 573

setting up finance charges 568

set to pay

report 205

setting up 566, 568, 574, 584, 590

client lead sources 145

client mail lists 145

client service areas in regions 143

company information for direct deposit 286

finance charges 568

job-specific paygroups 132

job types 115

meeting types 404

product discounts 138

receivable client product lines 138

receivable client sizes 137

receivable client status 136

receivable client types 137

service areas 574

service contract types 142

service invoice types 566

service routes 574

sick time 261

tax districts 139

tax entities 140

time andmaterials jobs 169

vacation 261

settings 457, 725

email 673

Sick Method 261

Sick Rate 261

sick time 261

sick timemethods

Accrued Sick box 261

Sick Method 261

Sick Rate 261

simplemail transfer protocol 670-671

sleepmode

Server 2008 864

Server 2008 R2 863

Vista 864

Windows 7 863

SMTP 670-671

social security number 254

software 887

additional required software 887

sorting 446, 622

by column in 7-8 Contact Manager 446

by company in 7-8 Contact Manager 446

South Carolina

state tax 837

South Dakota

state tax 838

special configuration

Windows 7/Server 2008 R2

autostart 863-864

SQL see Structured Query Language 637

starting balances

about 77, 84

dedicated accounts 79, 84

entering 77, 84

state tax

Alabama 803
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Alaska 804

Arizona 804

Arkansas 806

California 806

Colorado 807

Connecticut 808

Delaware 808, 817

District of Columbia 809

Florida 810

Georgia 811

Hawaii 811

Idaho 812

Illinois 812

Indiana 813

Iowa 813

Kansas 814

Kentucky 814

Louisiana 815

Maine 816

Maryland 817

Massachusetts 819

Michigan 819

Minnesota 820

Mississippi 821

Missouri 821

Montana 822

Nebraska 822

Nevada 823

New Hampshire 824

New Jersey 825

New Mexico 825

New York 826-827

North Carolina 828

North Dakota 829

Ohio 829

Oklahoma 831

Oregon 831

Pennsylvania 833

Rhode Island 837

South Carolina 837

South Dakota 838

Tennessee 838

Texas 839

Utah 840

Vermont 841

Virginia 841

Washington 842

West Virginia 843

Wisconsin 844

Wyoming 844

statement

reconcile balances 31

statements

editing to create invoices for retention 125

states

API program 851

statistics

Project Reviews 611

status 554, 567

service invoice 554, 567

subcontract 379

status bar

about 689
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Structured Query Language (SQL)

about 637

syntax 637-638

subcontract 379

status 379

subcontract audit 383

subcontract change 365

subcontract change list 365

subcontract list 383

subcontract orders 365

printing 365

subcontractors

assigning to schedules 543

subcontracts 383, 709

about 378

deleting 383

displaying descriptions 365

entering 379

exporting from takeoffs 521

releasing retention 382

reviewing 381

change orders 381

invoices 381

types 382

Workers’ Compensation

charging for on payable invoices 190

rate setup 215, 226

submittals

about 400

creating 400

deleting 401

types 400

subsidiary accounts

automatic generation 71

setup 72

transferring balances to 72

summary accounts 67, 73

supervisor user 438

suspense

accounts 19

syncing 445

contacts with Outlook 445

system configuration

language and date 853

system information

viewing 857

system requirements

API 851

client hardware 854

operating systems 853-854

server hardware 853

web browser 856

workstation hardware 854

T
T-4 forms

codes 312

payroll calculations in 312

T andM Invoices 171

posting 171

print 170

T andM Journal 174

T andM Summary 174



- 934 -

Takeoff Details tab

about grid menus 513

add new views 515

delete grid view 516

grid cell menu 515

grid columns menu 515

Grid Views menu 514

restore default views 516

save columnwidths 517

show-hide columns 516

show-hiding columns 516

Views menu 514

takeoffs

9-5 Takeoffs tab descriptions 493

about 492

and change orders 502

compensating for materials waste 510

costs

bonding 503

liability insurance 504

taxes 505

creating 495

deleting 496

displaying hours by job or phase 540

entering change orders 502

exporting

about 518

budgets 520

change orders 523

grids to files 519

grids to work orders 521

notes 524

proposals 520

purchase orders 520

RFPs 396, 523

service work orders 522

subcontracts 521

to files 518

importing 525

about 525

grids 526

using Takeoff Launch 525

locking rows 497

minimum part quantities 498

in phases 498

overhead and profits

about 502

for bid items 503

for cost types 503

parts

cost defaults 497

displayingmanufacturer details 497

selecting pricing 497

security

hiding bid totals 511

hiding cost totals 512

setting automatic save reminders 496

sorting 497, 622

Takeoff Launch window 495

updating

part costs 501

parts 498

vendor prices 500

viewing recaps 494
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task 535, 609

tasks 535

about 535

dependencies

about 537

drawing between 538

entering 537

lead and lag time 537

start-finish 545

importing into schedules 545

lists 536

moving 544

resizing 544

summaries 544

today 704

tomorrow 704

types 536

tax desctiption

assign special 333

tax districts 139

about 139

setting up 139

tax entities 139-141

about 139

opening 141

setting up 140

tax entity limit types 140

about 140

tax rate

change tax entity

change rate 141

tax setup 803

taxes

Alaska domicile information 257

changing taxability of job cost records 354

districts and entities

about 139

entity limit types 140

opening entities 141

setting up districts 139

setting up entities 140

including in takeoffs 505

payroll

certified payroll reports 249

tax areas 311

types 305

sales and use

on payable invoices 197

payable invoice setup 216, 226

purchase order sales tax 196

setting up state ID numbers 431

tables

reviewing rates 311

setup 301, 311

vendor 1099s 56, 64

TCP Remoting Channel

licensing 859

port numbers 859

technicians 578, 580-581, 585

emailing

work orders 581, 585

removing dispatches 581

templates

about 722
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for adding parts-updating prices

recalling 528

saving 527

saving 662, 722

Tennessee

state tax 838

Terminal servers 866

DOS cmd installation 866

Texas

state tax 839

third-party sick pay

about 276

entering 277

time andmaterials billing

about 168

billing status

about 175

changing 175

costs

editing 174-175

entering for equipment 470

equipment rates

about 173

entering 173

invoices

about 170

computing 170

creating by phase 169

posting 171

processing 171

voiding 169

parts details addendum report 171

setup 169

wage rates

about 172

entering 172

time andmaterials invoices 170

timecards

absences 270

Autofill Pay Rate 270

creating

daily 338

from daily field reports 338

entering 268

daily payroll 335

importing service records 270

including bonuses 274

pay types 266

TLU see Total Labor Units 508

Total Labor Units 508

training 8

getting started 8

transaction sources

about 847

by menu 847

transactions 573

cash 573, 611

entering 36

Over-the-Counter Sales 573

transferring funds

among checking accounts 17

entering direct transfers 19

transmittals

about 398
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creating 398

deleting 399

routing slips 399

types 399

trends

Financial Reviews 610

trial reconciliations

reconciliation-in-process check box 26

saving

about 26

two-party checks 228-230, 232-234

entering receivable 105

types 187, 404

meeting types 404

payable invoice 187

service invoice 566

setting up service contract 142

U
unions

calculations 312

payroll 319

unitary billing

about 162

applications

creating new manually 164

creating new using Unitary Proposal 163

preparing next 167

processing 167

voiding 167

changing 166

importing proposals 165

retention

about 165

releasing 166

setup 163

updating from field reports 165

unitary bills 163, 166

changing unitary bills 166

creating new manually 164

creating new using Unitary Proposal 163

entering setup data 163

voiding 167

unitary proposals 163

about 391

creating 391

deleting 392

displaying a recap 392

exporting 392

about 347

grids 392

importing into Unitary Billing 165

units to complete

about 387

entering estimated units remaining 387

reports

deleting 387

updating 387

unprinted checks

find 16

updates

receiving automatic notification about 1

updating costs 159-161

from change orders 159
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updating prices 526

updating retention

for jobs 125

updating total quantity 165

upgrade

change orders 355

user-defined

cost types 703

user-defined fields 691

user name 436, 441

user names

about 436

setup 436

users

about copying defaults 439

copying defaults

procedures 439

supervisor 435, 438

Utah

state tax 840

workers’ compensation 840

utilities

features 413

overview 413

V
vacation 261

vacationmethods

Accrued Vacation box 261

VacationMethod 261

Vacation Rate box 261

valuationmethods

about 596

First In-First Out (FIFO) 597

Last In-First Out (LIFO) 597

setting up with offset account 596

Weighted Average Cost 597

variables

about 507

for waste factors 510

in calculated fields 630

reserved 509

values

declaring 508

project 508

variances

inventory 595

materials 196

vendor

verify information 54, 61

vendor check

apply to credit 192

vendor discounts

expiring 700

vendor invoices

select 200

vendor pricing

about 483

entering 484

lists

replacing existing 532

setup 532
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updating 533

in takeoffs 500

vendors 207, 216, 700

certificates and licenses

about 213, 223

entering 224

documents 225

payments 201

about 199

applying credits to invoices 203

changing invoice status 204

printing checks 202

reports 205, 678

select invoice to pay 201

separate checks 203

records

deleting 215, 225

entering 216

financial information 208, 221

invoice defaults 208, 221

other defaults 209, 222

purchase order warnings 210, 223

remittance setup 215, 225

types 210, 223

verification

after-close 54, 61

backup 53, 59

job removal 45

tasks 52, 55, 62

Vermont

state tax 841

Views menu

Takeoff Details tab 514

Virginia

state tax 841

Vista

change license server 865

sleepmode 864

TCP Remoting Channel 859

voiding 570

loan draw applications 162

service invoices 570

time andmaterials invoices 169

unitary bills 167

vouchers

paying by 206

W
W-2 forms

codes 312, 824

payroll calculations in 312

Washington

state tax 842

Workers’ Compensation 843

waste

compensating for in takeoffs 510

web browser

system requirements 856

Web browsers, supported 856

West Virginia

state tax 843

window-level security

about 440
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access rights 441

window andmenu-level security

access rights 440

setup 440

Windows

fax service component 672

regional and short date format 853

Windows 7

sleepmode 863

Windows Installer 3.1

verify 858

WIP

about 197

accounting 197

adjusting journal transactions 21

verification 198, 348

Wisconsin

state tax 844

work orders 550, 554-556, 559-560, 562-563, 571, 580-
581, 584, 586, 590

assigning tomultiple technicians 580

creatingmultiple 559

deleting 563

deposits 562

emailing 581, 585

entering 554, 556

entering credit invoice 571

exporting grids from takeoffs 521

multiple 446, 562

posting 562

postingmultiple 562

prioritizing 555, 586, 590

service

exporting from takeoffs 522

single 562

technicians

email 581, 585

Workers’ Compensation

calculations 313

codes

about 366

entering 314

Nevada 824

New York 827

Ohio 830

on payable invoices

charging for 190

Oregon 832

rates

setup for payable invoices 215, 226

split rates 315

subcontractors 315

Washington 843

Wyoming

state tax 844

Y
year-end close (archiving)

fiscal-year checklist 40

general ledger 40

payroll 54, 62

preparation 53, 59

vendor 1099s 56, 64

verification 62
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year-end wizard 43, 46

finish closing tasks 46

preparation for closing books 43

year end

calendar year 35

general ledger 51, 61

more about 35

preparation 49

verify job removal 45
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